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HP Software Integrations, Solutions and Best Practices
Visit the Integrations and Solutions Catalog at https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01702710 to explore how the
products in the HP Software catalog work together, exchange information, and solve business needs.
Visit the Cross Portfolio Best Practices Library at https://hpln.hp.com/group/best-practices-hpsw to access a wide variety of best practice documents and materials.
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Introducing SiteScope
HP SiteScope is an agentless monitoring solution designed to help you ensure the availability and
performance of distributed IT infrastructure and applications. SiteScope monitors collect server and
application health across physical, virtual and cloud infrastructures through a web-based architecture
that does not require installing data collection agents on your production systems. For details, see
"SiteScope Overview" on page 10.
Tip: You can view a guided and narrated overview of the SiteScope application in the HP Video
Gallery: http://h20621.www2.hp.com/video-gallery/us/en/sss/20308EBD-0975-4C42-9671DF922B64E6D2/r/video/.
In addition to the full edition, SiteScope is also available in the following editions:
l

l

SiteScope Failover. This edition enables you to implement failover capability for infrastructure
monitoring. It automatically switches the functions of a primary system to a standby server if the
primary system fails or is temporarily taken out of service. For details, see "SiteScope Failover
Overview" on page 16.
SiteScope for Load Testing. This edition, which is provided with HP LoadRunner and HP
Performance Center, enables LoadRunner and Performance Center users to define and use
SiteScope monitors on a LoadRunner or Performance Center application. For details, see
"Integrating with HP Load Testing Products" on page 238.
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SiteScope monitors collect key performance measurements and report topology on a wide range of
back-end infrastructure components. The monitors are individually configured to automatically test
performance and availability of systems and services in the network environment.
SiteScope monitoring includes alerting and reporting capabilities, along with a dashboard for a real-time
picture of the monitored environments. SiteScope can be configured to send alerts whenever it detects
a problem in the IT infrastructure. In addition, SiteScope can create reports for monitors or monitor
groups that display information about how the servers and applications you are monitoring have
performed over time. For details, see "SiteScope Monitoring Model" below.
To help you deploy monitors with similar monitoring configuration criteria across the enterprise, you can
define templates, or use preconfigured SiteScope solution templates. The use of templates enables
you to develop and maintain a standardized set of monitor types and configurations in a single structure
that can be repeatedly deployed and easily updated using global change and replace capabilities,
without having to update each object individually.
SiteScope also includes alert template types that you can use to communicate and record event
information in a variety of media. You can customize alert templates to meet the needs of your
organization.
For a list of features in SiteScope, see "Key Features of SiteScope" on the next page.
Tip: You can view a guided and narrated overview of the SiteScope application in the HP Video
Gallery: http://h20621.www2.hp.com/video-gallery/us/en/sss/20308EBD-0975-4C42-9671DF922B64E6D2/r/video/.

SiteScope Monitoring Model
SiteScope's Web-enabled architecture enables the creation and ongoing administration of a
centralized, scalable monitoring environment.
It consists of the following key components:
l

l

l

l

Browser-based interface. Manages end user status information requests, configuration change
requests, and access control.
Scheduler. Coordinates the running of monitors, alert creation, and report generation.
Groups. A group is a container for monitoring assets. Groups may contain subgroups and are used
to organize monitors. Groups are created prior to monitors.
Monitors. A monitor collects performance and availability information about the system being
monitored. It checks the status of server components, key application processes, log files, or
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network devices, to name a few. It also collects data based on selected metrics and displays a
status of good, warning, or error with respect to the configured thresholds.
l

l

Alerts. An alert is an action triggered by a change in the status of a monitored asset. Alerts notify
required users when negative events or failures occur. An alert can be sent to a variety of media
including email, pager, Short Message Service (SMS) messages, or an SNMP trap.
Reports. A report is a historical representation of monitored data for trending and analysis
purposes. SiteScope offers a variety of reports from quick monitor reports to detailed management
reports. Reports enable you to track trends and operational performance and to troubleshoot
problems.

Key Features of SiteScope
SiteScope has the following features:

Agentless, Enterprise-Ready Architecture
l

l

l

Enterprise-ready architecture. SiteScope provides simultaneous monitoring of a large number of
systems, and support for secure connections.
Agentless monitoring. SiteScope monitors without the deployment of agent software on the
servers to be monitored. This function makes deployment and maintenance of SiteScope relatively
simple compared to other performance monitoring solutions.
Simple installation and deployment. SiteScope is installed on a single server running as a
service or a process. This results in quick installation and easy monitoring configuration.

Web-Based User Interface
l

l

Intuitive administration. SiteScope reduces the time spent managing a monitoring environment
by providing a user friendly browser-based interface for viewing and administering of the monitoring
platform. For details, see "Navigate SiteScope" on page 22.
Unified Console. The Unified Console simplifies the management of large, distributed
environments and accelerates your ability to identify and resolve issues. It is also ideal for
displaying enterprise-wide monitoring status in a network operations setting. The Unified Console
contains the following views:
n

Event Console. Enables you to track the real time status of your monitored environment,
prioritize and dispatch events, and manage the event lifecycle from a single interface. You can
also see details of historical events, which is useful for tracking the resolution of previous
issues, and for identifying trends and hidden patterns. For details, see "Event Console" on page
1062.
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n

Multi-View. Enables you to see the status of everything that is being monitored in your IT
infrastructure in a single view, without losing the relationship between the data. You can group
objects in various different ways to fit the perspective of different personas. Multi-View is ideal
for displaying enterprise-wide monitoring status in a network operations setting. For details, see
"Multi-View" on page 1089.

n

Ops View. Combines Multi-View and the Event Console in a single view. Working side-by-side
helps you isolate and diagnose problems by enabling you to identify events associated with a
selected monitor or monitor group, or a monitor associated with a selected event, and to drill
down and perform troubleshooting. For details, see "Ops View" on page 1114.

n

Manage. Provides self-service monitoring to non-admin users, and reduces the amount of
monitoring support required from the SiteScope administrator or monitoring team. After being
granted the necessary permissions by the SiteScope administrator, the application owner can
perform common administration actions such as deploy templates, update monitor
configurations, run monitors, view associated alerts, and enable/disable monitors, groups, and
alerts. For details, see "Manage View" on page 1116.

Standardized Monitor Deployments and Updates Using Templates
l

l

l

User-defined templates. SiteScope supports the ability to create and publish reusable templates,
enabling you to set up and deploy multiple IT elements with similar monitoring configuration criteria.
Using the Publish Template Changes wizard, you can rapidly update your monitoring environment
across the entire enterprise, without the need for extensive manual updates. For details, see
"Create Templates" on page 782.
Solution Templates. SiteScope offers solution templates that feature built-in domain expertise in
the form of specialized monitors, default metrics and thresholds, proactive tests, and best practices
for a given application or component being monitored. For details, see "Deploy Solution Templates"
on page 896.
Automated deployment with XML. SiteScope enables you to bypass the user interface and
deploy templates using an XML file. This saves your IT organization time and money by enabling
the introduction of a large number of monitors in a single operation. For details, see "Deploy
Templates Automatically Using an XML File" on page 861.

Infrastructure Performance and Availability Monitoring
l

l

Out-of-the-box monitors. SiteScope provides more than 100 out-of-the-box monitors covering
aspects such as utilization, response time, usage, and resource availability. For details, see
"Monitors and Groups" on page 244.
Customizable monitors. SiteScope provides custom monitors that enable you to extend your
SiteScope environment by creating new monitor types and customizing existing monitors. By using
custom monitors, HP customers and partners have the ability to develop solutions for environments
not supported by existing SiteScope monitors. Custom monitors can also be shared with other
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users by publishing them to the HP SiteScope community on the HP Live Network. For details, see
"Create Custom Monitors" on page 319.
l

l

l

l

Elastic configuration. Elastic configuration is a way to automatically adjust the SiteScope
monitoring configuration based on changes that are happening in your IT environment. SiteScope
provides various dynamic monitors that automatically update themselves over time by adding and
removing counters and thresholds as virtual machines move from one host system to another. In
addition, baselining is supported, where thresholds are dynamically changed based on historical
monitoring data. Dynamic monitors include VMware Host Monitors, VMware Datastore Monitor,
Generic Hypervisor Monitor, Hadoop Monitor, HP Vertica JDBC Monitor, KVM Monitor, Dynamic
Disk Space Monitor and Dynamic JMX Monitor.
Baseline management. SiteScope can be used to create baselines and schedule specific
thresholds based on a time period or date. The baseline calculated for your configuration can be
tested against actual performance conditions to view the errors and warnings that would have been
reduced by the calculated baseline. Graphs can be used to compare your calculated baseline with
current threshold settings to determine potential performance improvements. For details, see "Set
Monitor Thresholds Using a Baseline" on page 326.
Customization capabilities. SiteScope permits the display of customizations of groups and
monitors by using custom data fields and HTML-sensitive description tags. In addition, SiteScope
permits the customization of alert text and report configurations by using templates and userdefined variables. For details, see "Properties Available in Alerts, Templates, and Events" on page
1305.
Self-monitoring. SiteScope monitors key aspects of its own operability and identifies monitor
configuration problems and critical server load. It also monitors its own integration and data events
when configured to report to Business Service Management. For details, see "SiteScope Server
Health Monitors" on page 1149.

Alerts, Notifications,and Reports
l

l

Proactive alerting. Provides alerting capabilities, based on customizable thresholds, so that you
can fix problems before end users experience them. Alerts are sent to IT administrators based on
configured thresholds and defined schedules. There are several types of alert actions, such as
sending email messages, Simple Network Management Protocol (SNMP) traps, or executing a
script. For details, see "Configure SiteScope Alerts" on page 1243.
Server-based reporting. SiteScope can collect multiple pre-selected metrics from a specific
server and combine them into a single graph—giving you quick access to key performance
monitoring data for any server in your environment. One of the key benefits of server-based
reporting is the ability to drill down into reports to troubleshoot server related issues. For details, see
"Reports" on page 1319.

Predictive Analytics
Predictive Analytics. Predictive Analytics helps protect businesses from the impact of IT issues by

HP SiteScope (11.31)

Page 13 of 1395

Using SiteScope
Chapter 1: SiteScope Overview

predicting potential problems in critical applications and informing you of issues that can affect the
business flow. SiteScope uses baseline and correlation calculations to analyze system problems and
provide details to assist with root cause analysis so that you can anticipate issues before business
flows are impacted. For details, see "Configure Predictive Analytics" on page 1375.

Integration With a Wide Variety of HP Software and Third Party Products
SiteScope can be integrated with a variety of HP software and third party products, including:
l

l

l

l

l

HP Business Service Management. SiteScope can be used as a data collector for HP Business
Service Management (BSM). BSM receives data about end-users, business processes, and
systems and uses the data in reports and analysis. SiteScope monitor data can be sent to BSM for
all monitors, or for selected monitors only. For details, see " Connecting to a BSM Server" on page
207.
HP Operations Manager and Operations Management: combining agentless and agentbased monitoring. SiteScope can be used in conjunction with HP Operations Manager (HPOM) or
Operations Management (OMi), such that a single console acts as a central repository for all
discovered events.SiteScope collects events and then logs it to an agent data store using the HP
Operations agent which must be installed on the SiteScope server. This information is then
forwarded to HPOM/Operations Management. For details, see Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help.
HP Performance Manager and Performance Graphing: view both agentless and agentbased data when monitoring performance. Using the HP Operations agent that resides on the
SiteScope server or a profile database in BSM (for reporting to Performance Graphing only), you
have visibility of SiteScope metrics in HP Performance Manager as well as the graphing component
of Operations Management. For details, see Integrating SiteScope with HP Operations Manager
Products in the SiteScope Help.
Other HP software products. Data integration enables SiteScope reports to be displayed and the
SiteScope user interface to be hosted—all within HP Performance Center. You can also view
SiteScope system level performance and availability information within HP Diagnostics. Other
integrations include the ability to send SiteScope events and metrics to Network Node Manager
(NNMi) and the automatic creation of monitors in SiteScope through its integration with HP
Operations Orchestration. SiteScope also integrates with HP Application Lifecycle Management
(ALM) to share monitoring data and templates from the production environment to enable load
testing engineers to plan performance tests and application deployment. Lastly, SiteScope serves
as the monitoring foundation for HP LoadRunner and Performance Center software, to better
identify bottlenecks during the load testing phase. For details, see "Integrations Overview" on page
193.
Amazon CloudWatch. SiteScope can be used to report SiteScope monitor measurement data to
an Amazon CloudWatch service. This integration enables customers who use SiteScope for
monitoring their AWS-hosted applications to report any SiteScope metrics to Amazon CloudWatch
service. SiteScope metrics data can be used for AWS AutoScaling, reporting, and alerting. For
details, see "Amazon CloudWatch Integration Preferences" on page 660.
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For a diagram illustrating the various SiteScope integrations, see "Integrating with Other Applications"
on page 196.

Mobile Access
Monitor IT health from anywhere. You can access SiteScope from a mobile device using
SiteScope’s free downloadable apps (supported on iPhone, iPad, iPod touch, and Android phones or
tablets). With this capability, you can search HP SiteScope servers to view individual monitors and
group statistics, perform actions on search results to mitigate issues, respond to email alerts when a
problem is detected in the IT infrastructure, add selected monitors and groups to a favorites list, and
generate ad hoc reports for monitors, groups, or alerts for specific time periods. For details, see
"SiteScope Mobile Apps" on page 172.

Failover Capability for Monitoring Mission-Critical Applications in High Availability
Environments
Failover capabilities. SiteScope offers failover support to give you added redundancy and automatic
failover protection if a SiteScope server experiences availability issues. When the primary HP
SiteScope server becomes unavailable, a secondary server takes over, providing uninterrupted
monitoring. This capability does not require additional hardware and takes advantage of mirroring
operations that enables rollback capabilities in the event of interruption. For details, see "SiteScope
Failover Overview" on page 16.

Embraces Industry Standards and Government Certification Programs
HP SiteScope is committed to providing industry-leading infrastructure monitoring software that
embraces industry standards and government certification programs.
l

l

Common Criteria Certification. SiteScope is in the process of Common Criteria certification with
Evaluation Assurance Level (EAL) 2+. Common Criteria is an internationally recognized ISO
standard for the evaluation of Information Technology (IT) products.
FIPs 140-2 Compliancy. SiteScope can be configured to work in FIPS 140-2 compliant mode.
FIPS 140-2 is a cryptographic module validation program, administered by the National Institute of
Standards and Technology (NIST), that specifies the security requirements for cryptographic
modules.

For details, see the Running SiteScope Securely section of the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).
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The SiteScope Failover solution enables you to implement failover capability for infrastructure
monitoring by provisioning for backups, redundancy, and failover mechanisms. It automatically
switches the functions of a primary system to a standby server if the primary system fails or is
temporarily taken out of service.
SiteScope Failover provides the following:
l

l

l

Automated, periodic mirroring of monitoring configurations from the primary SiteScope server to the
SiteScope Failover server.
Automated monitoring of the availability of the primary SiteScope server.
Automated enabling and disabling of mirrored monitors based on the availability of the primary
SiteScope.

A separate Failover license is required to enable the SiteScope instance to act as a failover for another
SiteScope installation (the Failover Edition license is provided with the Premium, Ultimate, and System
Collector editions at no additional cost).
For details on installing and using SiteScope Failover, see the HP SiteScope Failover Guide (available
from <SiteScope root directory>\sisdocs\pdfs\SiteScopeFailover.pdf).
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Part 1: Getting Started
This section explains how to access SiteScope ("Log into SiteScope" on page 18) and how to navigate
the SiteScope user interface ("Navigate SiteScope" on page 22). It also provides a recommended flow
for setting up and administering your monitoring solution ("Set Up and Administer SiteScope" on page
60).
To help you get started with SiteScope, see the suggested workflows on manually creating a
monitoring structure and creating a monitoring structure using a template in "Start Using SiteScope" on
page 67.
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You can access SiteScope from any computer with a network connection (intranet or Internet) to the
SiteScope server using a supported Web browser or from the Start menu on Windows platforms.
Alternatively, you can use a silent login URL which enables you to go directly to the specified
SiteScope server without showing the SiteScope login page (for details, see "Silent Login" below).
For details on browser requirements, as well as minimum requirements to successfully view
SiteScope, see the System Requirements section in the SiteScope Deployment Guide (<SiteScope
root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Learn About
Silent Login
You can access SiteScope using a silent login URL. This enables you to skip the login page and
directly open the user account for the given user name and password using the silent login address.
In addition, you can use silent login in conjunction with a page option view that you saved in your
browser's list of Favorites to open SiteScope directly to a particular group or view. For details on
configuring a favorite page option view, see Page Options in "Common Toolbar" on page 24.
To start SiteScope using silent login, you must encrypt the user login name and password using the
SiteScope Encryption Tool, and enter the encrypted information in the silent login URL. For task
details, see "How to access SiteScope using silent login" on the next page.

Notification Message Displayed When Logging in to SiteScope
The SiteScope Administrator can enable SiteScope to display a customized message that is displayed
in the login screen when a user logs on to SiteScope. The administrator can determine the text of the
message. For example, the administrator might want to notify users that they are about to log in to a
secure system.
If a notification message is displayed, click OK to confirm the message, before you can proceed to use
SiteScope.
For details on enabling and configuring the login notification message, see the Hardening section of the
SiteScope Deployment Guide.

HP SiteScope (11.31)

Page 18 of 1395

Using SiteScope
Chapter 3: Log into SiteScope

Tasks
How to access SiteScope from a browser or from the Start menu
To access SiteScope from a browser, enter the SiteScope address in a Web browser. The default
address is: http://<server name>:8080/SiteScope.

l

To access SiteScope from the Start menu (Windows platforms only), click Start > Programs > HP
SiteScope > Open HP SiteScope.

l

The first time SiteScope is deployed, there is a delay for initialization of the interface elements. When
you connect to a SiteScope, the SiteScope opens to the Dashboard view.
Tip:
l

l

To restrict access to this account and its privileges, you should edit the Administrator account
profile to include a user login name and login password. SiteScope then displays a login page
before SiteScope can be accessed. If no user name and password are defined for the
Administrator user, SiteScope skips the login page and automatically logs in. For details on
editing the Administrator account profile, see "User Management Preferences" on page 732.
It is also recommended to change the Integration Viewer account profile to include a user login
name and login password.

How to access SiteScope using silent login
This task describes how to create a silent login URL, and how to access the specified SiteScope
server directly without showing the SiteScope login page.
1.

Create a user profile
In the Preferences context, click the User Management Preferences menu and create a user
account.
For user interface details, see "User Management Preferences Page" on page 736.
Note:
n

The Administrator account is the default account that is active when the product is
installed. To create other accounts, you must first edit the Administrator account profile to
include a user login name and password.
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n

Silent login is not supported for users that contain any of the following special characters in
the password: ‘ (quote), “ (double quote), / (slash), \ (backslash) and ’ (apostrophe).

Example:
A user profile with the displayed name Regular User was added with login name Regular
and password Regular.

2.

Configure user permissions - optional
Configure the user action permissions in the Permissions section of the New/Edit User dialog
box. By default, a new user has full permissions except for the permission to modify or delete
other user preferences.
For user interface details, see "Permissions" on page 744.

3.

Encrypt the user profile
Encrypt the user login name and password.
a. In a command prompt, run the following command for the login name:
<SiteScope root directory>\tools\AutoDeployment\
encrypt_password.bat <login name>
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For example:
C:\SiteScope\tools\AutoDeployment\encrypt_password.bat Regular
The encrypted value for Regular is (sisp)uq1zrGl1Ims=.
b. Encode any non-standard URL characters as required. Information about encoding nonstandard URL characters is available from many publicly available web sites. Note that URL
encoding of a character consists of a % symbol, followed by the two-digit representation for the
character.
In this example, = is a reserved character, and should be replaced by %3D. Thus, the encoded
value for Regular is (sisp)uq1zrGl1Ims%3D.
c. Save the encrypted value so that you can add it to the silent login URL.
d. Repeat the encryption process for the login password (if different from the login name).
4.

Enter the SiteScope silent login URL in a browser
Create a SiteScope silent login URL for the user profile, and enter the URL in a Web browser. The
URL should be in the format:
http://<server_name>:8080/SiteScope?sis_silent_login_type=encrypted&login=
<encrypted_login_name>&password=<encrypted_password>
where <encrypted_login_name> and <encrypted_password> are replaced by the encrypted
login name and password.
Note: To force SiteScope to reject URL encrypted login, you need to set the _
rejectCredentialsInURL property in <SiteScope root directory>\groups\master.config
file to true. However, when you use this option, all URLs which provide drill down
functionality and contain encrypted login properties will stop working.

5.

Results
SiteScope skips the login page and directly opens the user account for the given user name and
password.
Note: If values entered for the login name and password parameters do not exist, are not
found, or if authentication fails, then the SiteScope login page is displayed.

HP SiteScope (11.31)

Page 21 of 1395

Chapter 4: Navigate SiteScope
When you connect to a SiteScope, the SiteScope opens to the Dashboard view as shown below. If you
enter a user name to log on to SiteScope, it appears on the upper-right side of the window.

Learn About
This section contains:
l

"Key Navigation Elements" below

l

"Navigating and Performing Actions in the Context Tree" on the next page

l

"SiteScope Keyboard Shortcuts" on the next page

Key Navigation Elements
The SiteScope window contains the following key elements:
l

l

l

SiteScope common toolbar. Provides access to page options, documentation, and additional
resources. This toolbar is located on the upper part of the window. For more details, see "Common
Toolbar" on page 24.
SiteScope context toolbar. Contains buttons for frequently-used commands in the selected
SiteScope context. For more details, see "Context Toolbar Buttons" on page 25.
SiteScope context tree. Enables you to create and manage SiteScope objects in a tree structure.
For details, see "Monitor Tree" on page 29, "Remote Server Tree" on page 40, and "Template Tree"
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on page 41.
l

SiteScope context buttons. Provide access to the SiteScope Monitors, Remote Servers,
Templates, Preferences, Server Statistics, and Diagnostic Tools. For more details, see "Context
Buttons" on page 29.
Note: The SiteScope Classic interface that was available in earlier SiteScope versions using
the URL http://<sitescope_host>:8888 is no longer available for managing SiteScope. For
more information, see SiteScope Classic Interface in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Navigating and Performing Actions in the Context Tree
There are several ways to navigate the context tree, perform actions, and edit object properties.
You can perform actions using the context toolbar, or you can select any object within the context tree
itself, and right-click the object to access a menu of options for that object. For example, if you rightclick the SiteScope node in the monitor tree, you select from a menu listing only those actions that can
performed on the SiteScope node. You can also perform actions on multiple groups and monitors. For
details, see "Perform Actions on Multiple Groups and Monitors" on page 84.
For details of the context tree objects and context menu options available for each object in the tree,
see "Monitor Tree" on page 29, "Remote Server Tree" on page 40, "Template Tree" on page 41,
"Preferences Menu" on page 50, "Server Statistics Menu" on page 52, and "Tools Menu" on page 54.

SiteScope Keyboard Shortcuts
You can perform the following commands in the monitor tree, template tree, and remote server tree by
pressing the corresponding shortcut keys:
Shortcut
Key

Description

CTRL+A

Opens the New Alert dialog box, enabling you to create a new alert. For user interface
details, see "New/Edit Alert Dialog Box" on page 1267.

CTRL+C

Copies the selected item and puts it on the Clipboard.

CTRL+D

Deletes the selected item.

CTRL+F

Opens the New Filter dialog box, enabling you to create a new filter. For user interface
details, see "Filter Objects in the SiteScope View" on page 74.

CTRL+G

Opens the New Group dialog box, enabling you to create a new group. For user interface
details, see "New SiteScope Group Dialog Box" on page 249.
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Shortcut
Key

Description

CTRL+J

Opens the Select Template/Group dialog box, enabling you to select the template that
you want to deploy or the group to which you want to deploy a template. For details on
the Select Template user interface, see "Select Template Dialog Box" on page 317. For
details on the Select Group user interface, see "Select Group Dialog Box" on page 855.

CTRL+M

Opens the New Monitor dialog box, enabling you to add a new monitor. For user
interface details, see "New Monitor Dialog Box" on page 265.

CTRL+R

Clears the filter configured in the Filter dialog box. For user interface details, see "Filter
Objects in the SiteScope View" on page 74.

CTRL+V

Pastes the contents of the Clipboard to the selected location.

CTRL+X

Cuts the selected item and puts it on the Clipboard.

DELETE

Deletes the selection.

F5

Refreshes the tree.

UI Descriptions
Common Toolbar
The SiteScope common toolbar, located at the top of the SiteScope window, is accessible from all
contexts, and contains the following buttons:
UI Element

Description
Enables you to select the following page options:
l

l

Add to Favorites. Enables you to add the current SiteScope view to your list
of Favorites in your browser.
Save Layout to User Preferences. Enables you to save the current view as
the default layout for the specific SiteScope user.

Enables you to access SiteScope Help, context-sensitive help for specific
windows, and other additional online resources.
You can also see descriptions of user interface elements in most pages or dialog
boxes. To enable this feature, click the Quick Help
button in the specific
page or dialog box, and rest the mouse pointer on the element box to display a
Tool Tip description. To make this feature unavailable, click the Quick Help
button again.
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UI Element

Description
Logs you out of your SiteScope session.

You can customize your view of the monitor tree to list only those SiteScope elements with which you
are working. You can also assign search/filter tags to your groups, monitors, reports, and alerts to
further refine your selection. For details on this topic, see "Filter Objects in the SiteScope View" on
page 74.
SiteScope enables you to change monitor configurations across multiple monitors, groups, or multiple
SiteScopes using Global Replace. For details on the Global Replace user interface, see "Global Search
and Replace" on page 89.

Context Toolbar Buttons
The context toolbar, which is displayed above the upper left pane, enables you to perform common
functions in the Monitors, Remote Servers, and Templates views.
Some toolbar buttons are not available in all SiteScope views. For more details on each view, see
"Monitor Tree" on page 29, "Remote Server Tree" on page 40, "Template Tree" on page 41.
UI
Element

Description
New. Adds SiteScope objects (groups, monitor, alerts, remote servers, and templates) to
the relevant tree. The objects that you can add depend on the context.
Edit. Enables you to select one of the following editing options:
l

Copy. Makes a copy of the selected object.

l

Paste. Copies or moves an object to the selected location in the tree.

l

Cut. Moves the selected object to another location in the tree.

l

Delete. Deletes the selected object from the tree.

Delete. Deletes the selected remote server from the tree.
Note: Available in the remote server tree toolbar only.
Test. Tests the connection to the server.
Note: Available in the remote server tree toolbar only.
DetailedTest. Runs a test that displays the result of running commands on the remote
server. This enables checking the permissions for the defined user.
Note: Available in the remote server tree toolbar for UNIX servers only.
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UI
Element

Description
Filter. Filters the monitor tree to display only those SiteScope objects that meet the
criteria that you define.
Select a filter option:
New Filter. Opens the New Filter dialog box which enables you to create a filter. For
user interface details, see "Filter Objects in the SiteScope View" on page 74.

l

Clear Filter. Clears the filter settings.

l

<List of existing filters>. Displays a list of existing filters. The following options are
available:

l

n

Apply. Applies the filter to the left tree pane.

n

Edit. Opens the Edit Filter dialog box which enables you to edit the filter. For user
interface details, see "Filter Objects in the SiteScope View" on page 74.

n

Delete. Deletes the filter from the filter list.

Note: Available in the monitor tree toolbar only.
Manage Monitors and Groups. Enables you to perform an action (copy, move, delete,
run monitors, enable/disable monitors, enable/disable associated alerts) on multiple
groups and monitors in the monitor tree. You can also filter the list of objects in the
monitor tree. For details on the Manage Monitors and Groups dialog box, see "Perform
Actions on Multiple Groups and Monitors" on page 84.
Note: Available in the monitor tree toolbar only.
Collapse All. Collapses all branches in the tree.
Note: Available in the monitor and template tree toolbar only.
Expand All. Expands all branches in the tree.
Note: Available in the monitor and template tree toolbar only.
Refresh. Refreshes the data in the tree.
Show all. Displays hidden toolbar buttons.

HP SiteScope (11.31)

Page 26 of 1395

Using SiteScope
Chapter 4: Navigate SiteScope

UI
Element

Description
Quick Search. Enables you to search configuration objects (groups, monitors, remote
servers, templates, or counters) for a specific name or value in the monitor, template,
remote server, or counters tree (in the monitor properties for some browsable counter
monitors).
Click the left end of the box to open the drop-down menu of filter options:
l

l

l

l

l

l

l

Select Case sensitive to search for the filter string exactly as entered. Select Case
insensitive to ignore the case of the filter string.
Select Use wild cards to use the wildcard symbol * in the filter string. Enables you to
use asterisk (*) characters in your search string in order to type only part of the item.
Select Match from start to search for the filter string at the beginning of a property
name or value. Select Match exactly to search for the exact filter string. Select
Match anywhere to search for the filter string anywhere in the properties.
Select Match leaf node only to search for the filter string in leaf nodes (monitors and
empty groups only) in the tree. Clear to search all nodes.
Select Hide nodes without children to hide groups that have no leaf nodes that
match the filter string (empty groups).
Select Keep the children if any of their ancestors match to display all child nodes
of groups that match the filter string, even though the child does not match the search
string.
Select Use auto filter to search automatically after a letter is entered in the search
text field. You can configure a delay before the auto filter runs in Preferences >
Infrastructure Preferences > General Settings > Quick search auto filter delay
(milliseconds). The default delay is 800 milliseconds (0.8 seconds). If Use auto
filter is not selected, you must press the Enter key every time you want to run the
search.
Tip: In a loaded environment, it is recommended to increase the delay time in Quick
search auto filter delay time, or to disable the Use auto filter option.

Note: If a filter is applied to a tree, the search is restricted to the records currently
displayed.
Show/Hide Pane. (Between left and right panes) Shows or hides the tree, and expands
or contracts the right pane.
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UI
Element

Description
(Below context menus) Click to configure the context button display. The following
options are available:
l

l

l

l

Show More Buttons. Click to show the next highest ranking SiteScope context
button in the left pane. This button is available only if not all the context buttons are
displayed.
Show Fewer Buttons. Click to hide the lowest ranking SiteScope context button
from the left pane. This button is available only if at least one context button is
displayed.
Option. Choose the order in which the SiteScope context buttons are displayed. Use
the Move Up and Move Down buttons to rearrange the order. To hide a button from
the left pane, clear the check box for the context. By default, all the context buttons
are selected (displayed in the left pane).
Add or Remove Buttons. Shows the show/hide status of the context buttons. By
default, all the context buttons are selected (displayed in the left pane). To hide a
button, clear the check mark for the context.

Context Trees and Menu Options
l

"Monitor Tree" on the next page

l

"Remote Server Tree" on page 40

l

"Template Tree" on page 41

l

"Preferences Menu" on page 50

l

"Server Statistics Menu" on page 52

l

"Tools Menu" on page 54

Tabs
l

Dashboard Tab (see "View and Manage Data in the SiteScope Dashboard" on page 1034)

l

Properties Tab (see "Common Monitor Settings" on page 283)

l

"Analytics Tab / New Predictive Analytics Dialog Box" on page 1390

l

"Alerts Tab" on page 57
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l

"Reports Tab" on page 58

Context Buttons
SiteScope has the following contexts that are available from the left pane:
UI Element

Description
Enables you to create and manage SiteScope groups and monitors in a
hierarchy represented by a monitor tree. For user interface details, see
"Monitor Tree" below.
Enables you to set up the connection properties so that SiteScope can
monitor systems and services running in remote Windows and UNIX
environments. For user interface details, see "Remote Server Tree" on page
40.
Enables you to use templates to deploy a standardized pattern of monitoring
to multiple elements in your infrastructure. You can use preconfigured
SiteScope solution template or create and manage your own templates. For
user interface details, see "Template Tree" on page 41.
Enables you to configure specific properties and settings related to most of
the administrative tasks within SiteScope. For user interface details, see
"Preferences Menu" on page 50.
Enables you to view key SiteScope server performance metrics. For user
interface details, see "Server Statistics Menu" on page 52.
Displays diagnostic tools that can help you troubleshoot problems in
SiteScope and facilitate monitor configuration. For details on the available
tools, see "SiteScope Tools" on page 105.

Monitor Tree
The monitor tree represents the organization of systems and services in your network environment.
The tree includes containers and objects within your infrastructure. The shortcut menu options include
descriptions of the context menu options available for each object in the monitor tree.
To access
Important
information

Select the Monitors context. The monitor tree appears in the left pane.
l

l
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The root node of the tree is the SiteScope container. Only one SiteScope node
exists in the monitor tree. You add all other elements to the tree under the
SiteScope node.
You can search for objects in the monitor tree by selecting a node and typing the
characters you want to search in the popup search box. Click the ESC key to close
the search box.
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See also

"Monitors and Groups" on page 244

Monitor Tree Objects
User interface elements are described below:
UI
Element Description
Represents an individual SiteScope server.
Parent: Enterprise node or container.
Add to tree by: Importing or adding an empty SiteScope profile.
Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
If an alert has been set up for the monitor group or subgroup, the alert
next to the group icon.

symbol appears

If a Management report has been set up for the monitor group or subgroup, the report
symbol appears next to the group icon.
Parent: SiteScope or SiteScope group.
Add to tree by: Creating, or importing with a SiteScope that has groups defined.
Represents a SiteScope monitor (enabled/disabled).
If an alert has been set up for the monitor, the alert
icon.

symbol appears next to the monitor

If a Management report has been set up for the monitor, the report symbol appears next
to the monitor icon.
Parent: SiteScope group or subgroup, template, or solution template.
Add to tree by: Creating, or importing with a SiteScope that has monitors configured.
Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScope monitors.
Parent: SiteScope.
Add to tree by: Automatically added with SiteScope object.
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SiteScope Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z)

Description

Baselining

Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for all
monitors under SiteScope.
l

l

l

l

Calculate. Enables you to select monitors, and specify
the relevant time and schedule to be used for calculating
the baseline. It also enables you to select and fine-tune the
baseline adherence level and define boundaries.
Review & Activate. Displays a summary of calculated
monitors and baseline data. It also enables you to save the
current monitor configuration, view and retry failed
operations, view baseline measurement graphs, and apply
the baseline configuration.
Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been
calculated.
Status Report. Displays information about the baseline
status for all monitors under SiteScope.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 326.
Deploy Template

Opens the Select Template dialog box that enables you to
select a template to deploy to the group. For user interface
details, see "Select Template Dialog Box" on page 317.

Deploy Template Using CSV

Opens the Select Template dialog box which enables you to
select a template to deploy to the group using a CSV file. For
user interface details, see "Select Template Dialog Box" on
page 317.

Expand All

Opens all the subtrees under SiteScope.

Global Search and Replace

Opens the Global Search and Replace Wizard, which enables
you to run a global search and replace for monitor, alert, group,
preferences, alert action, and report properties. For details on
this topic, see "Global Search and Replace" on page 89.
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Menu Item (A-Z)

Description

Monitor Deployment Wizard

This menu item is available only to those users accessing
SiteScope from System Availability Management (SAM)
Administration in BSM. Opens the Monitor Deployment
Wizard. For details on this topic, see "Monitor Deployment
Wizard" in the BSM Application Administration Guide in the
BSM Help.

New > Alert

Opens the New Alert window which enables you to define a
new alert for SiteScope. For details on this topic, see
"Configure SiteScope Alerts" on page 1243.

New > Group

Opens the New Group window which enables you to define a
new SiteScope group. For user interface details, see "New
SiteScope Group Dialog Box" on page 249.

Paste

Pastes the selected SiteScope object (that was previously
copied or cut) to the SiteScope node.

Paste from other SiteScope

This menu item is available only through SAM Administration
when there is more than one SiteScope connected to BSM.
Pastes the selected SiteScope object (that was previously
copied or cut) from another SiteScope to the SiteScope node.

Reports >
Enables you to select the type of SiteScope report you want to
Management/Quick/Monitor/Alert define. For details on these reports, see "Create SiteScope
Reports" on page 1320.
Reports > Server-Centric

Enables you to generate a Server-Centric report for any
remote server being monitored by a Microsoft Windows
Resources or UNIX Resources monitor, provided the monitor
has the Enable Server-Centric Report check box selected.
For details, see "Create Server-Centric Reports" on page
1365.

Reports > BSM Configuration
Changes

This menu item is available only through SAM Administration
when the SiteScope is connected to BSM. Displays a log of
configuration changes made to BSM. For details, see "Create
SiteScope Reports" on page 1320.

Tools

Available when configuring or editing specific monitors
(provided you are an administrator in SiteScope, or a user
granted Use monitor tools permissions). If a tool is
available, click to open and run the tool with the monitor's
existing data as its input. The test results appear in the
Results pane. For details on the available tools, see
"SiteScope Tools" on page 105.
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Group Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z)

Description

Baselining

Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for all
monitors in the group.
l

l

l

l

Calculate. Enables you to select monitors from the group
and specify the relevant time and schedule to be used for
calculating the baseline. It also enables you to select and
fine-tune the baseline adherence level and define
boundaries.
Review & Activate. Displays a summary of calculated
monitors and baseline data for the group. It also enables
you to save the current monitor configuration, view and
retry failed operations, view baseline measurement
graphs, and apply the baseline configuration.
Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been
calculated.
Status Report. Displays information about the baseline
status for all monitors in the group.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 326.
Copy

Copies the group and its contents (monitors, alerts, and
reports) to a monitor group or template.
Note: When copying a group that contains monitors with
baseline thresholds, the baseline thresholds are replaced with
static thresholds (which are the current percentile values), and
the monitors are no longer in baseline mode.
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Menu Item (A-Z)

Description

Copy to other SiteScope

This menu item is available only through SAM Administration
when there is more than one SiteScope connected to BSM.
Copies the group and its contents (monitors, alerts, and
reports) from another SiteScope to a monitor group or template
in the SiteScope node.
Note: When copying several monitors which have
dependencies between them to other SiteScopes, copy them
together with the group container in case it is required to keep
the dependency between them.

Copy to Template

Copies the group and its contents (monitors, alerts, and
reports) to a template group. For details on this topic, see
"How to Create a Template by Copying Existing
Configurations" on page 801.

Cut

Moves the group and its contents (monitors, alerts, and
reports) or a monitor and its contents (alerts and reports) to a
monitor group.
Note: When moving a group that contains monitors with
baseline thresholds, the baseline thresholds are replaced with
static thresholds (which are the current percentile values), and
the monitors are no longer in baseline mode.

Delete

Deletes the group.
Note: You cannot delete a group if it has dependent alerts or
reports at the container level. To delete a group with
dependencies, you must remove the group from Alert Targets
and Report Targets for each dependency, and then delete the
group. You can delete groups that have dependencies at the
child level.

Deploy Template

Opens the Select Template dialog box that enables you to
select a template to deploy to the group. For user interface
details, see "Select Template Dialog Box" on page 317.

Deploy Template Using CSV

Opens the Select Template dialog box which enables you to
select a template to deploy to the group using a CSV file. For
user interface details, see "Select Template Dialog Box" on
page 317.

HP SiteScope (11.31)

Page 34 of 1395

Using SiteScope
Chapter 4: Navigate SiteScope

Menu Item (A-Z)

Description

Enable/Disable Monitor

Opens the Enable/Disable Monitors in Group dialog box which
enables you to enable or disable monitors in the group,
regardless of the setting in the monitor properties. If you select
Disable, the monitors are disabled until you return to this
dialog box and select Enable. For details on the
Enable/Disable Monitor user interface, see "Enable/Disable
Monitors in Group Dialog Box" on page 1049.

Expand All

Opens all the subtrees under the group.

Global Search and Replace

Opens the Global Search and Replace Wizard, which enables
you to run a global search and replace for monitor, alert, group,
preferences, alert action, and report properties. For details on
this topic, see "Global Search and Replace" on page 89.

Monitor Deployment Wizard

This menu item is available only to those users accessing
SiteScope from SAM Administration in BSM. Opens the
Monitor Deployment Wizard. For details on this topic, see
"Monitor Deployment Wizard" in the BSM Application
Administration Guide in the BSM Help.

New > Alert

Opens the New Alert window which enables you to define a
new alert for the group. For details on this topic, see
"Configure SiteScope Alerts" on page 1243.

New > Group

Opens the New Group window which enables you to define a
new SiteScope group. For user interface details, see "New
SiteScope Group Dialog Box" on page 249.

New > Monitor

Opens the New Monitor window which enables you to define a
new SiteScope monitor. For user interface details, see "New
Monitor Dialog Box" on page 265.

Paste

Pastes the selected group and its contents (monitors, alerts,
and reports) or a monitor and its contents (alerts and reports)
to the specified monitor group.

Paste from other SiteScope

This menu item is available only through SAM Administration
when there is more than one SiteScope connected to BSM.
Pastes the selected group and its contents (monitors, alerts,
and reports) or a monitor and its contents (alerts and reports)
from another SiteScope to the specified monitor group.

Reports >
Enables you to select the type of SiteScope report you want to
Management/Quick/Monitor/Alert define. For details on this topic, see "Create SiteScope
Reports" on page 1320.
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Menu Item (A-Z)

Description

Reports > Server-Centric

Enables you to generate a Server-Centric report for any
remote server being monitored by a Microsoft Windows
Resources or UNIX Resources monitor within the specified
monitor group, provided the monitor has the Enable ServerCentric Report check box selected. For details, see "Create
Server-Centric Reports" on page 1365.

Run Monitors

Runs any monitors configured in the group, and opens an
information window with the results.
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Monitor Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z)

Description

Baselining

Enables you to create a baseline for monitoring variations in
response times and performance in the infrastructure for the
specific monitor.
l

l

l

l

Calculate. Enables you to select the monitor and specify
the relevant time and schedule to be used for calculating
the baseline. It also enables you to select and fine-tune the
baseline adherence level and define boundaries.
Review & Activate. Displays a summary of the
calculated monitor's baseline data. It also enables you to
save the current monitor configuration, view and retry
failed operations, view baseline measurement graphs, and
apply the baseline configuration.
Remove. Enables you to remove the baseline threshold or
recalculate the baseline after a baseline has been
calculated.
Status Report. Displays information about the monitor's
baseline status.

For details on this topic, see "Set Monitor Thresholds Using a
Baseline" on page 326.
Copy

Copies the monitor and its contents (alerts and reports) to a
monitor group or template.
Note: When copying a monitor with baseline thresholds, the
baseline thresholds are replaced with static thresholds (which
are the current percentile values), and the monitor is no longer
in baseline mode.

Copy to other SiteScope

This menu item is available only through SAM Administration
when there is more than one SiteScope connected to BSM.
Copies the monitor and its contents (alerts and reports) from
another SiteScope to a monitor group or template.
Note: When copying several monitors which have
dependencies between them to other SiteScopes, copy them
together with the group container in case it is required to keep
the dependency between them.

HP SiteScope (11.31)

Page 37 of 1395

Using SiteScope
Chapter 4: Navigate SiteScope

Menu Item (A-Z)

Description

Copy to Template

Copies the monitor and its contents (alerts and reports) to a
template group. For details on this topic, see "How to Create a
Template by Copying Existing Configurations" on page 801.

Cut

Moves the monitor and its contents (alerts and reports) to a
monitor group.
Note: When moving a monitor with baseline thresholds, the
baseline thresholds are replaced with static thresholds (which
are the current percentile values), and the monitor is no longer
in baseline mode.

Delete

Deletes the monitor.
Note: You cannot delete a monitor if it has dependent alerts or
reports at the container level. To delete a monitor with
dependencies, you must remove the monitor from Alert
Targets and Report Targets for each dependency, and then
delete the monitor. You can delete monitors that have
dependencies at the child level.

Enable/Disable Monitor

Opens the Enable/Disable Monitors in Group dialog box which
enables you to enable or disable the monitor, regardless of the
setting in the monitor properties. If you select Disable, the
monitor is disabled until you return to this dialog box and
select Enable. For details on the Enable/Disable Monitor user
interface, see "Enable/Disable Monitors in Group Dialog Box"
on page 1049.

Global Search and Replace

Opens the Global Search and Replace Wizard, which enables
you to run a global search and replace for monitor, alert, group,
preferences, alert action, and report properties. For details on
this topic, see "Global Search and Replace" on page 89.

New > Alert

Opens the New Alert window which enables you to define a
new alert for the monitor. For details on this topic, see
"Configure SiteScope Alerts" on page 1243.

Paste

Pastes the selected monitor context object to the specified
monitor.

Paste from other SiteScope

This menu item is available only through SAM Administration
when there is more than one SiteScope connected to BSM.
Pastes the selected monitor context object from another
SiteScope to the specified monitor.
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Menu Item (A-Z)
Predictive Analytics

Description
l

l

New Predictive Analytics. Enables you to configure
analytics for the selected monitor. This menu item is
available only if:
n

Analytics is enabled in Infrastructure Preferences >
Analytics Settings > Analytics enabled (this is the
default setting).

n

The monitor is not of an excluded type that is listed in
Infrastructure Preferences > Analytics Settings >
Excluded monitor types.

Delete Predictive Analytics. Enables you to remove
predictive analytics from the selected monitor. This menu
item is available only if analytics have been configured for
the selected monitor.

For details on this topic, see "Configure Predictive Analytics"
on page 1375.
Reports >
Enables you to select the type of SiteScope report you want to
Management/Quick/Monitor/Alert define. For details on this topic, see "Create SiteScope
Reports" on page 1320.
Reports > Server-Centric

Enables you to generate a Server-Centric report for any
remote server being monitored by a Microsoft Windows
Resources or UNIX Resources, provided the monitor has the
Enable Server-Centric Report check box selected. For
details, see "Create Server-Centric Reports" on page 1365.

Run Monitor

Runs the monitor and opens an information window with the
results.
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SiteScope Health Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z) Description
Disable
Logging

Disables logging SiteScope server health data to the daily log file. For details on
SiteScope server health, see "SiteScope Server Health Monitors" on page 1149.

Enable Logging Enables logging SiteScope server health data to the daily log file. For details on
SiteScope server health, see "SiteScope Server Health Monitors" on page 1149.
Expand All

Opens all the subtrees under SiteScope Health.

New > Alert

Opens the New Alert window which enables you to define a new alert for Health.
For details on this topic, see "Configure SiteScope Alerts" on page 1243.

New > Group

Opens the New Group window which enables you to define a new SiteScope
group. For user interface details, see "New SiteScope Group Dialog Box" on
page 249.

New > Monitor

Opens the New Monitor window which enables you to define a new SiteScope
monitor. For user interface details, see "New Monitor Dialog Box" on page 265.

Paste

Pastes monitors and monitor groups into the Health container.

Recreate
missing health
monitors

Enables you to restore health monitors that have been deleted from the Health
container.

Reports

Enables you to select the type of SiteScope report you want to define. For details
on this topic, see "Create SiteScope Reports" on page 1320.

Run Monitors

Runs the health monitors and opens an information window with the results.

Remote Server Tree
The remote server tree represents the remote servers configured in your network environment. The
shortcut menu options include descriptions of the context menu options available for each object in the
remote server tree.
To access

Select the Remote Servers context. The remote server tree appears in the left pane.

See also

"Remote Servers Properties Page" on page 539
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Remote Server Tree Objects
User interface elements are described below:
UI Element

Description
Represents the Windows/UNIX remote server container in the remote server view.
Represents a Windows/UNIX remote server.
Parent: Windows/UNIX Remote Server container.
Add by: Creating in the Windows/UNIX Remote Server container or template tree.

Remote Servers Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z)

Description

New Microsoft
Windows/UNIX Remote
Server

Opens the New Server window which enables you to define a new
Microsoft Windows or UNIX server.

Remote Server Shortcut Menu Options
User interface elements are described below:
Menu
Item
(A-Z)

Description

Copy to
Template

Copies the remote server to a template group. For details on this topic, see "How to
Create a Template by Copying Existing Configurations" on page 801.

Delete

Deletes the remote server

Detailed
Test

Enables you to test the running commands on the remote host and check the
permissions for the defined user. Available for UNIX servers only.

Test

Enables you to test the connection to the remote server.

Template Tree
The template tree represents user-defined templates, SiteScope solution template sets, template
examples, and Monitor Deployment Wizard templates that are available for deployment to monitor
groups. The shortcut menu options include descriptions of the context menu options available for each
object in the template tree.
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To access
See also

Select the Templates context. The template tree appears in the left pane.
l

"Create Templates" on page 782

l

"Deploy Solution Templates" on page 896

l

"SiteScope Templates Page" on page 806

l

"Templates Tree - Alerts Tab" on page 809

Template Tree Objects
User interface elements are described below:
UI
Element

Description
Represents an individual SiteScope server.
Parent: Enterprise node or container.
Add to tree by: Importing or adding an empty SiteScope profile.
Represents a solution template container (available/unavailable). Only licensed
solution templates that have the available icon are configurable solution templates.
Parent: SiteScope.
Represents a template container. A template container is used to organize
configuration deployment templates.
Parent: SiteScope.
Add to template tree by: Creating, or importing with a SiteScope that has template
containers defined.
Represents a template configuration for deploying SiteScope objects.
Parent: Template container.
Add to template tree by: Creating.
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UI
Element

Description
Represents a SiteScope template group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
If an alert has been set up for the template group or subgroup, the alert
appears next to the group icon.

symbol

If a Management report has been set up for the template group or subgroup, the report
symbol appears next to the group icon.
Parent: Template.
Add to tree by: Creating, or importing with a SiteScope that has template groups
defined.
Represents a SiteScope template monitor (enabled/disabled).
If an alert has been set up for the template monitor, the alert
the monitor icon.

symbol appears next to

If a Management report has been set up for the template monitor, the report symbol
appears next to the monitor icon.
Parent: Template group or subgroup, template, or solution template.
Add to tree by: Creating, or importing with a SiteScope that has template monitors
configured.
Represents a Windows/UNIX remote server.
Parent: Template.
Add by: Creating in the remote server tree or template tree.
Represents a variable used as placeholder to prompt for input when deploying a
template.
Parent: Template.
Add to template tree by: Creating.

SiteScope Root - Shortcut Menu Options
User interface elements are described below:
Menu
Item (A-Z) Description
Expand
All

Opens all the subtrees under SiteScope.
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Menu
Item (A-Z) Description
Import >
Template

Opens the Template Import window which enables you to import a template file. For
details, see "Template Import Dialog Box" on page 844.

Import >
Content
Package

Opens the Import Content Package window which enables you to import a content
package that can include one or more templates and their dependencies (for example,
templates.os files, .jar files, and .conf files). Content packages are required for sharing
Custom monitors, or monitors with extension files like scripts or alert files, with other
SiteScope users. For details, see "Import Content Package Dialog Box" on page 845.

New >
Opens the New Template Container window which enables you to define a new
Template template container.
Container
Paste

Pastes a template container under the SiteScope root.

Solution Template Container - Shortcut Menu Options
User interface elements are described below:
Menu Item (A-Z)

Description

Expand All

Expands the solution templates container to display all the solution
templates within the container.

Solution Template - Shortcut Menu Options
User interface elements are described below:
Menu
Item (A-Z)

Description

Copy

Copies a solution template. You can paste the solution template to a template container
in the template tree.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to
deploy the solution template. For user interface details, see "Select Group Dialog Box"
on page 855.

Deploy
Template
Using
CSV

Opens the Select Group dialog box which enables you to select the group to which to
deploy the template using a CSV file. For user interface details, see "Select Group
Dialog Box" on page 855.

Expand
All

Expands the solution templates container to display all the solution templates within the
container.
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Menu
Item (A-Z)
Generate
XML

Description
Opens the Generate Auto Deployment XML window which enables you to create an
XML file to use for automatically deploying the solution template. For details, see
"Deploy Templates Automatically Using an XML File" on page 861.

Template Container - Shortcut Menu Options
User interface elements are described below:
Menu
Item (A-Z) Description
Copy

Copies the template container and its contents. You can paste the template container
under the SiteScope root or a selected template container in the template tree.

Cut

Moves the template container and its contents. You can paste the template container
under the SiteScope root or a selected template container in the template tree.

Delete

Deletes the template container.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to
deploy one or multiple templates. For user interface details, see "Select Group Dialog
Box" on page 855.

Expand
All

Expands the templates container to display all the template objects within the
container.

Export >
Template

Opens the Export Template window which enables you to export a template file. For
details, see "Export Template Dialog Box" on page 837.

Export >
Content
Package

Opens the Export Content Package Wizard which enables you to export one or more
templates and their dependencies to a content package file. Content packages are
required for sharing Custom monitors, or monitors with extension files like scripts or
alert files, with other SiteScope users. For details, see "Export Content Package
Wizard" on page 838.

Generate
XML

Opens the Generate Auto Deployment XML window which enables you to create an
XML file to use for automatically deploying the templates in the container.

Import

Opens the Content Import dialog box which enables you to import a template file, or a
content package that can include one or more templates and their dependencies (for
example, templates.os files, .jar files, and .conf files). For details, see "Template Import
Dialog Box" on page 844.

New >
Template

Opens the New Container window which enables you to define a new template.
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Menu
Item (A-Z) Description
New >
Opens the New Template Container window which enables you to define a new
Template template container.
Container
Paste

Pastes a template or template container into the template container.

Template - Shortcut Menu Options
User interface elements are described below:
Menu
Item
(A-Z)

Description

Copy

Copies the template and its contents. You can paste the template to a template
container in the template tree.

Cut

Moves the template and its contents. You can paste the template to a template
container in the template tree.

Delete

Deletes the template.

Deploy
Template

Opens the Select Group dialog box which enables you to select the group to which to
deploy the template. For user interface details, see "Select Group Dialog Box" on page
855.

Deploy
Template
Using
CSV

Opens the Select Group dialog box which enables you to select the group to which to
deploy the template using a CSV file. For user interface details, see "Select Group
Dialog Box" on page 855.

Expand
All

Opens all the subtrees under the template.

Export >
Template

Opens the Export Template window which enables you to export a template file. For
details, see "Export Template Dialog Box" on page 837.

Export >
Content
Package

Opens the Export Content Package Wizard which enables you to export one or more
templates and their dependencies to a content package file. Content packages are
required for sharing Custom monitors, or monitors with extension files like scripts or
alert files, with other SiteScope users. For details, see "Export Content Package
Wizard" on page 838.
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Menu
Item
(A-Z)
Export to
OM

Description
Exports the template to Operations Manager (HPOM). This enables SiteScope
templates and monitors to be configured through the HPOM policy assignment and
deployment. For more details, see the section on Centralized Template Management
from HPOM in Integrating SiteScope with HP Operations Manager Products in the
SiteScope Help. You can check the HP Software Integrations site for the latest version
of this guide.
Note: This menu option is available only if:
l

l

l

New >
Group

HPOM and SiteScope are installed on the same machine, and SiteScope is
connected to a supported version of HPOM. For the HPOM versions supported in
this SiteScope release, refer to the HP SiteScope Support Matrices section in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).
The HP Operations agent is installed on the SiteScope server. For details on
installing the agent, see the Integrating SiteScope with HP Operations Manager
Products Guide available on the HP Software Integrations site.
HP Operations Manager integration is configured in SiteScope and the Enable
exporting templates to HP Operations Manager check box is selected in HP
Operations Manager Integration Main Settings.

Opens the New Group window, which enables you to define a new template group. For
user interface details, see "New SiteScope Group Dialog Box" on page 249.
Note: This menu item is available only if the template does not already contain a
template group.

New >
UNIX
Remote
Server

Opens the New UNIX Remote Server window, which enables you to define a new
remote UNIX template.

New >
Variable

Opens the New Variable window, which enables you to define a new template variable.

New >
Microsoft
Windows
Remote
Server

Opens the New Microsoft Windows Remote Server window, which enables you to
define a new remote Windows template.

Paste

Pastes a template group, monitor, or alert to a template.

Note: This menu item is available only if the template does not already contain a remote
server.

Note: This menu item is available only if the template does not already contain a remote
server.
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Menu
Item
(A-Z)
Publish
Changes

Description
Opens the Publish Template Changes wizard, which enables you to check deployed
groups for template compliancy and to update SiteScope objects deployed by templates
whenever the template is updated.

Template Variable - Shortcut Menu Options
User interface elements are described below:
Menu Item
(A-Z)

Description

Copy

Copies the template variable. You can paste the template variable to a template in
the template tree.

Cut

Moves the template variable. You can paste the template variable to a template in
the template tree.

Delete

Deletes the template variable.

Template Remote - Shortcut Menu Options
User interface elements are described below:
Menu
Item
(A-Z)
Copy

Description
Copies the template remote server. You can paste the template remote server to a
template in the template tree.
Note: You can add only one template remote server to a template. This does not apply
to templates created in older versions of SiteScope.

Cut

Moves the template remote server. You can paste the template remote server to a
template in the template tree.
Note: You can add only one template remote server to a template. This does not apply
to templates created in older versions of SiteScope.

Delete

Deletes the template remote.
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Template Group - Shortcut Menu Options
User interface elements are described below:
Menu
Item
(A-Z)

Description

Copy

Copies the template group and its contents (monitors, alerts, and subgroups). You can
paste the template group to a template in the template tree.

Cut

Moves the template group and its contents (monitors, alerts, and subgroups). You can
paste the template group to a template in the template tree.

Delete

Deletes the template group.

Expand
All

Opens all the subtrees under the template group.

New >
Alert

Opens the New Alert window which enables you to define a new alert for the template
group. For details on this topic, see "Configure SiteScope Alerts" on page 1243.

New >
Group

Opens the New Group window which enables you to define a new template subgroup. For
user interface details, see "New SiteScope Group Dialog Box" on page 249.

New >
Opens the New Monitor window which enables you to define a new SiteScope monitor for
Monitor the template group. For user interface details, see "New Monitor Dialog Box" on page 265.
Paste

Pastes the selected template group and its contents (monitors, alerts, and subgroups) to a
template.
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Template Monitor - Shortcut Menu Options
User interface elements are described below:
Menu
Item
(A-Z)

Description

Copy

Copies the template monitor and its contents (alerts). You can paste the template monitor
to a template group in the template tree.

Cut

Moves the template monitor and its contents (alerts). You can paste the template monitor
to a template group in the template tree.

Delete

Deletes the template monitor.

New >
Alert

Opens the New Template Alert window which enables you to define a new alert for the
template monitor. For details on this topic, see "Configure SiteScope Alerts" on page
1243.

Paste

Pastes the selected template monitor and its contents (alerts) to a template group.

Preferences Menu
The Preferences menu represents the preference types that enable you to configure specific properties
and settings related to most of the administrative tasks available within SiteScope.
To access

Select the Preferences context. The Preferences menu options are displayed in the
left pane.

Important
Only an administrator, or a user granted Edit <preference type> permissions, can
information create or make changes to SiteScope Preferences. For details on user permissions,
see "User Management Preferences" on page 732.
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UI Element
<Preference
types>

Description
l

l

l

l

l

l

l

l

l

l

l

l

l
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Certificate Management. Use to add and remove server certificates and reload
the keystore, without having to restart SiteScope after each certificate change
operation. For details, see "Certificate Management" on page 542.
Common Event Mappings. Use to create event mapping instances between
SiteScope runtime data and the event attribute values that are sent to the
HPOM/BSM server. For details, see "Common Event Mappings" on page 547.
Credential Preferences. Use to create and manage credentials for SiteScope
resources. For details, see "Credential Preferences" on page 561.
Email Preferences. Use to define email server settings and profiles for
SiteScope emails alert and status reports. For details, see "Email Preferences"
on page 568.
Event Console Preferences. Use to define filters for forwarding alerts triggered
from an Event Console alert action to different groups of users. For details, see
"Event Console Preferences" on page 574.
General Preferences. Use to perform post-configuration tasks, such as enter
standard and optional SiteScope license keys, control display functions, and set
security options. For details, see "General Preferences" on page 578.
HTTP Preferences. Use to define settings that are used by SiteScope when
sending event data to management consoles using the Generic Events
integration. For details, see "HTTP Preferences" on page 590.
High Availability Preferences. Use to configure behavior for SiteScope
Failover, a separate installation of SiteScope that is designed to automatically
assume the functions of a SiteScope system if the system fails or is temporarily
taken out of service. For details, see "High Availability Preferences" on page 597.
Infrastructure Preferences. Use to define the values of global settings in
SiteScope. For details, see "Infrastructure Preferences" on page 608.
Integration Preferences. Use to configure SiteScope as a data collector for
BSM. For details, see "Integration Preferences" on page 660.
Log Preferences. Use to controls the accumulation and storage of monitor data
logs. For details, see "Log Preferences" on page 700.
Pager Preferences. (Deprecated) Use to configure settings and additional pager
profiles that SiteScope uses for sending Pager alerts. For details, see "Pager
Preferences (Deprecated)" on page 707.
Schedule Preferences. Use for customizing the operation of SiteScope monitors
and alerts to run only at specific times or during specific time periods. For details,
see "Schedule Preferences" on page 712.
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UI Element

Description
l

l

l

Search/Filter Tags. Use to manage the Search/Filter tags defined in SiteScope.
You can assign tags to one or more items in the context trees and preference
profiles, and then use the tags as an object for a filter. For details, see
"Search/Filter Tags" on page 718.
SNMP Preferences. Use to define settings that are used by SiteScope SNMP
Trap alerts when sending data to management consoles. For details, see "SNMP
Preferences" on page 723.
User Management Preferences. Use to define and manage user login profiles
that control how others access SiteScope. For details, see "User Management
Preferences" on page 732.

Server Statistics Menu
The Server Statistics menu enables you to view an overview of several key SiteScope server
performance statistics. This includes the load on the SiteScope server, a list of currently running
monitors and the most recently run monitors, perfex pool summary and statistics, WMI statistics, SSH
connections, Telnet connections, and dynamic monitoring statistics. It also displays the SiteScope log
files.
To access

Select the Server Statistics context. The Server Statistics menu options appear in
the left pane.

Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176
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User interface elements are described below:
UI
Element

Description

<Menu
The following are the available monitor performance data options in SiteScope:
options>
l
Dynamic Monitoring. Displays statistics when using the dynamic monitoring
mechanism to automatically update dynamic monitoring counters and thresholds. For
details of the user interface, see "Dynamic Monitoring Page" on page 1181.
l

l

l

l

l

l

l

l

General. Displays SiteScope server statistics, including the load on the SiteScope
server (number of running monitors, waiting monitors, monitor runs per minute), and a
list of running monitors by type. For details, see "General Page" on page 1183.
Log Files. Displays the list of log files in SiteScope that are useful for understanding
SiteScope performance issues, for troubleshooting monitor and alert problems, and
for reviewing SiteScope management actions. For details of the user interface, see
"Log Files Page" on page 1184.
Perfex Processes Pool. Displays the process manager summary, and pool
statistics and status tables for each pool. For details, see "Perfex Process Pool
Page" on page 1190.
PowerShell Process Pool. Displays the PowerShell pools which are used by the
Microsoft Exchange Base monitor. For details, see "PowerShell Process Pool Page"
on page 1192.
Running Monitors. Displays a list of which SiteScope monitors are running, and
which monitors have run recently, at what time, and what was the returned status.
For details, see "Running Monitors Page" on page 1193.
SSH Connections. Displays Secure Shell (SSH) statistics and a summary of SSH
connections when using SSH to connect to remote UNIX or Windows servers. For
details, see "SSH Connections Page" on page 1195.
Telnet Connections. Displays telnet statistics when using telnet to connect to
remote UNIX or Windows servers. For details of the user interface, see "Telnet
Connections Page" on page 1196.
WMI Statistics. Displays the process manager summary for Windows Management
Instrumentation (WMI) statistics. For details, see "WMI Statistics Page" on page
1198.
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Tools Menu
The Tools menu displays a list of diagnostic tools that can help you troubleshoot problems in SiteScope
and facilitate monitor configuration.
To access

Select the Tools context. The Tools menu options are displayed in the left pane.
You can select tools from the following categories: "Application Tools" below,
"Common Utility Tools" on the next page, "Database Tools" on the next page,
"Mail Tools" on the next page, "Network Tools" on the next page, "Operating
System Tools" on page 56, "SNMP Tools" on page 56, "Web Tools" on page 57.

Important
information

To view or use the tools in the Tools context in the left pane, you must be an
administrator in SiteScope, or a user granted Use tools permissions. For
details on user permissions, see "User Management Preferences" on page
732.

l

Some tools are also available when configuring or editing specific monitors
(provided you are an administrator in SiteScope, or a user granted Use
monitor tools permissions). If a tool is available when configuring or editing a
monitor (see "Testing Monitor Configuration Using Diagnostic Tools" on page
1036), you can access the tool by:

l

l

See also

n

Clicking the Use Tool
button in the new monitor dialog box when
configuring a new monitor, or in the monitor Properties tab when configuring
an existing monitor.

n

Clicking the Tools button in the SiteScope Dashboard toolbar when running
the test tool for an existing monitor. This opens and runs the tool with the
monitor's existing data as its input, and displays test results in the Results
pane.
To avoid character set problems when the SiteScope client uses a multibyte
locale different from the SiteScope server, set the value in the <SiteScope
root directory>\groups\master.config file for the _httpCharset setting to
UTF-8. By default, the _httpCharset value is empty, which means that the
default server locale is used.

"SiteScope Tools" on page 105

Application Tools
UI Element

Description

News Server
Tool

Checks whether a News Server is operational. For more information, see "News
Server Tool" on page 129.
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Common Utility Tools
UI Element

Description

Regular
Expression
Tool

Tests a regular expression for content matching against a sample of the content
you want to monitor. For more information, see "Regular Expression Tool" on
page 134.

XSL
Tests custom XSL transformation of XML data to be monitored with the
Transformation Browsable XML Monitor. For more information, see "XSL Transformation Tool" on
Tool
page 157.
Log Analysis
Tool

Analyze patterns in a log file and provides a list of all reoccurring patterns. Each
pattern can be transferred into a regular expression that can be used in the Log
File monitor. For more information, see "Log Analysis Tool" on page 123.

SiteScope Log
Grabber Tool

Retrieves and displays the SiteScope log and configuration files. For more
information, see "SiteScope Log Grabber Tool" on page 137.

Database Tools
UI Element

Description

Database
Connection
Tool

Checks connectivity and configuration of JDBC or ODBC database connections.
For more information, see "Database Connection Tool" on page 109.

Database
Information
Tool

Retrieves and displays database server metadata such as product and driver
version, SQL compatibility level information, and supported SQL functions. For
more information, see "Database Information Tool" on page 112.

LDAP
Tests an LDAP server by requesting a user authentication. For more information,
Authentication see "Link Check Tool" on page 119.
Status Tool

Mail Tools
UI Element

Description

Mail Round
Trip Tool

Tests a mail server by sending and retrieving a test message. For more
information, see "Mail Round Trip Tool" on page 125.

Network Tools
UI Element

Description
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DNS Tool

Tests a DNS server to verify that it can resolve a domain name. For more
information, see "DNS Tool" on page 113.

Network
Status Tool

Displays the server's network interface status and active connections. For more
information, see "Network Status Tool" on page 128.
Note: This tool is not supported on SiteScopes installed on UNIX platforms.

Ping Tool

Performs a round-trip Ping test across the network. For more information, see "Ping
Tool" on page 132.

Trace Route
Tool

Performs a traceroute from your server to another location. For more information, see
"Trace Route Tool" on page 146.

Operating System Tools
UI Element

Description

Event Log
Tool

Displays portions of the Windows Event Log locally or on a remote server. For
more information, see "Event Log Tool" on page 114.
Note: This tool is not supported on SiteScopes installed on UNIX platforms.

Performance
Counters Tool

Checks connectivity to and values in Windows Performance Counter registries.
For more information, see "Performance Counters Tool" on page 130.
Note: This tool is not supported on SiteScopes installed on UNIX platforms.

Processes
Tool

Shows a list of currently running processes either locally or on a remote server. For
more information, see "Processes Tool" on page 133.

Services Tool

Shows a list of currently running Windows Services. For more information, see
"Services Tool" on page 136.
Note: This tool is not supported on SiteScopes installed on UNIX platforms.

SNMP Tools
UI Element

Description

SNMP
Browser
Tool

Browses an SNMP MIB and displays available OIDs. For more information, see
"SNMP Browser Tool" on page 139.

SNMP Tool Performs a SNMP get command to a specified SNMP host to retrieve a list of OIDs.
For more information, see "SNMP Tool" on page 141.
SNMP Trap Displays the log of SNMP Traps received by SiteScope from SNMP-enabled devices.
Tool
For more information, see "SNMP Trap Tool" on page 145.
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Web Tools
UI
Element

Description

FTP
Tool

Checks the availability of an FTP server and whether a file can be retrieved. For more
information, see "FTP Tool" on page 116.

Link
Check
Tool

Checks the availability of all internal and external links on a Web page to ensure that they
can be reached. For more information, see "Link Check Tool" on page 119.

URL
Tool

Requests a URL from a server and prints the returned data. For more information, see
"URL Tool" on page 147.

Web
Service
Tool

Tests the availability of SOAP enabled Web Services. For more information, see "Web
Service Tool" on page 152.

Alerts Tab
The Alerts tab displays information about the alerts associated with the selected monitor or group. Use
this tab to add, edit, or delete alert definitions.
The Alerts tab shortcut menu options include descriptions of the context menu options available for
alerts.
To access

Select the Monitors or Templates context, and then click the Alerts tab in the
right pane.

See also

"Configure SiteScope Alerts" on page 1243

User interface elements are described below:
Menu Item
(A-Z)

Description

Copy

Copies the alert to the selected location in the monitor tree.
Note: Available for alerts in the Alerts on Monitor/Group table only.

Copy to
other
SiteScope

This menu item is available only through SAM Administration when there is more than
one SiteScope connected to BSM. Copies the alert from another SiteScope to the
selected location in the monitor tree.

Delete

Deletes the alert.
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Menu Item
(A-Z)

Description

Disable
Alert

Disables the alert.

Edit Alert

Opens an editing window for the alert, which enables you to edit its settings.

Enable
Alert

Enables the alert.

New Alert

Opens the New Alert dialog box, which enables you to create a new alert definition.
For details on how to perform this task, see "Configure SiteScope Alerts" on page
1243.
Note: Available for alerts in the Alerts on Monitor/Group table only.

Paste

Pastes the selected alert.
Note: Available for alerts in the Alerts on Monitor/Group table only.

Show All
Displays all descendent alerts of the selected node.
Descendant
Alerts
Show Child Displays only those alerts that are direct children of the selected node.
Alerts
Test

Opens the Test Alert dialog box which enables you to test the alert.

Reports Tab
The Reports tab displays information about the reports defined in SiteScope. Use this page to add, edit,
or delete report definitions.
The Reports tab shortcut menu options include descriptions of the options available for Management
reports in the monitor tree.
To access

Select the Monitors or Templates context, and then click the Reports tab in the
right pane.

See also

"Create SiteScope Reports" on page 1320

User interface elements are described below:
Menu Item (A-Z)

Description

Clear Selection

Clears the selection.
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Menu Item (A-Z)

Description

Copy Report

Copies the report to the selected location in the monitor tree.
Note: Available for reports in the Reports on Monitor/Group table only.

Create New
Report

Enables you to select the type of SiteScope report you want to create. For
details on this topic, see "SiteScope Report Types" on page 1320.
Note:
l

Available for reports in the Reports on Monitor/Group table only.

l

Only Management reports are added to the Reports tab.

Delete Report

Deletes the report.

Edit Report

Opens an editing window for the report, which enables you to edit its settings.

Generate Report

Generates the report.

Paste Report

Pastes the selected report.
Note: Available for reports in the Reports on Monitor/Group table only.

Select All

Selects all the listed reports.

Show All
Descendant
Reports

Displays all descendent reports of the selected node.

Show Child
Reports

Displays only those reports that are direct children of the selected node.
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This task describes a suggested working order for preparing to use SiteScope.
Note:
l

l

1.

If you need to configure SiteScope to require a secure connection (https), refer to the hardening
section of the SiteScope Deployment Guide (available from <SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
If you are using SiteScope Failover to provide backup infrastructure monitoring availability, see
the HP SiteScope Failover Guide (available from <SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm) for a suggested working order.

Log on to SiteScope
Enter the SiteScope address in a Web browser. The default address is:
http://localhost:8080/SiteScope.

2.

Enter your SiteScope license
If you did not enter your SiteScope license information during installation, enter it in Preferences >
General Preferences > Licenses.
For user interface details, see "Licenses" on page 582.

3.

Create a SiteScope user account - optional
The Administrator account is the default account that is active when the product is installed. It has
full privileges to manage SiteScope and is the account that all users who access the product use
unless you restrict the account. Therefore, it is recommended to create and configure other user
accounts based on the requirements of the organization. For task details, see "How to Create a
SiteScope User Profile" on page 735.
Note:

4.

n

If no user name and password are defined for the administrator user, SiteScope skips the
login page and automatically logs in.

n

You can restrict access to the SiteScope user interface for a given IP address or host
name. For details, see "Restrict Access to SiteScope" on page 62.

Configure SiteScope preferences (as required)
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Configure specific properties and settings related to administrative tasks within SiteScope.
a. Configure the SiteScope Email Preferences server. Configure an administrators email
address and specify a mail server that SiteScope can use to forward email messages and
alerts to users. For user interface details, see "Email Preferences Page" on page 569.
b. Adjust Log Preferences. Set the number of days of monitor data that are retained on the
SiteScope server. By default, SiteScope deletes logs older than 40 days. If you plan to have
monitor data exported to an external database, prepare the database, the necessary drivers,
and configure the Log Preferences as applicable. For user interface details, see "Log
Preferences" on page 700.
c. Configure credentials for SiteScope objects. Use Credential Preferences to store and
mange credentials for SiteScope objects that require user authentication. For task details, see
"Credential Preferences" on page 561.
d. In addition, you can configure any of the other SiteScope preferences as required. For details,
see "Preferences Menu" on page 50.
5.

Configure SiteScope to integrate with other applications - optional
SiteScope can be used as a data collector for various other applications, including:
n

HP Business Service Management (BSM). Enables logging of SiteScope monitor data and
topology reporting to BSM. For task details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.

n

Operations Manager (HPOM). Enables sending SiteScope events and reporting metrics data to
HPOM and BSM products. For task details on enabling SiteScope to send events to HPOM or
OMi, and enabling SiteScope to report metrics using the HP Operations agent, see Integrating
SiteScope with HP Operations Manager Products in the SiteScope Help. You can check the
HP Software Integrations site for the latest version of this guide.

n

HP Network Node Manager i (NNMi). Enables sending SiteScope events and reporting metrics
data to NNMi. For task details, see Integrating SiteScope with HP NNMi in the SiteScope
Help. You can check the HP Software Integrations site for the latest version of this guide.

n

HP Diagnostics. Enables you to see a more complete view of the application servers that are
monitored by Diagnostics. For user interface details, see Integrating SiteScope with HP
Diagnostics in the SiteScope Help. You can check the HP Software Integrations site for the
latest version of this guide.

n

Generic data integration. Enables forwarding SiteScope metrics to an application for which a
direct integration does not exist. For user interface details, see "Generic Data Integration
Preferences" on page 684.

n

Generic event integration. Enables forwarding events to a third-party application or
management console for which a direct integration does not exist. For user interface details,
see "Generic Event Integration Preferences" on page 689.
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6.

Configure connection profiles for remote servers
Specify the connection method for the remote servers you want to monitor in accordance with your
security requirements.
For details on enabling SiteScope to monitor data on remote Windows servers, see "Configure
SiteScope to Monitor Remote Windows Servers" on page 470.
For details on enabling SiteScope to monitor data on remote UNIX servers, see "Configure
SiteScope to Monitor Remote UNIX Servers" on page 492.

7.

Install middleware drivers (if required)
Install middleware drivers for connectivity with remote databases and applications for those
monitors that require drivers.
For details, see the help for the specific monitor.

8.

Enable JMX server password protection - optional
To prevent unauthorized entry to the JMX server embedded in SiteScope, enable JMX password
authentication. For details, see "How to Enable Authentication for the JConsole" on the next page.
For details on using the JMX Console, see "How to Use the JMX Console" on the next page.

9.

Start using SiteScope
You are now ready to use SiteScope.
For details on creating a monitoring structure, see the suggested workflows in "Configure
SiteScope for monitoring" on page 67.

Restrict Access to SiteScope
This task describes how to restrict access to the SiteScope user interface for a given IP address or
host name.
1. Open the server.xml file that is located in the <SiteScope root directory>\Tomcat\conf
directory.
2. Locate the RemoteAddrValve and RemoteHostValve Valves, uncomment and configure them to
allow or deny IP addresses or host names as required. For details on configuring these values, see
the explanations and examples in the server.xml file. By default, any host is allowed access.
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3. To log the IP addresses and host names from which requests are sent to SiteScope through the
user interface (and the access status of these hosts), uncomment the
FastCommonAccessLogValve Valve.
4. To restrict access to SiteScope's reports on port 8888, set the following properties in the
<SiteScope root directory>\groups\master.config file:
n

_checkAddressAndLogin. Set the value to =true.

n

_authorizedIP. Provide a comma-separated list of all IP addresses that are allowed to access
the reports. By default, any host is allowed access to the SiteScope reports.

How to Use the JMX Console
SiteScope includes the Java monitoring and management instrumentation (JConsole) tool. This tool
uses Java Management Extension (JMX) technology to provide information on performance and
resource consumption of applications running on the Java platform.
You can use JConsole to perform remote management operations, view performance of processes,
and troubleshoot problematic areas of SiteScope. This tool may help in debugging difficult issues
related to memory consumption, threading, and other issues in the production environment.

How to Access the JConsole Tool
1. To access the JConsole tool, run <SiteScope root directory>\java\bin\jconsole.exe on
Windows platforms (and <SiteScope root directory>/java/bin/jconsole binary file on UNIX
platforms).
2. Depending on which SiteScope you want to monitor, select Local, or Remote with port 28006 (the
default JMX port).
Note:
l

l

Because access to the JMX server is not password protected (JConsole password
authentication is disabled by default in SiteScope), we recommend that you enable JMX
password authentication to prevent unauthorized entry. For details, see "How to Enable
Authentication for the JConsole" below.
We recommend not changing any other JConsole settings.

How to Enable Authentication for the JConsole
1. Create property files to configure users, passwords, and access roles (for Windows/UNIX/Linux
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platforms).
a. Create a property file named password.properties that contains users and passwords, and
copy it to the <SiteScope root directory>\conf folder:
# specify actual password instead of the text password
userLogin1=password
userLogin1=password
b. Create a property file named access.properties that contains users and access roles, and
copy it to the <SiteScope root directory>\conf folder:
# The "monitorRole" role has readonly access.
# The "controlRole" role has readwrite access.
userLogin1=readonly
userLogin2=readwrite
c. Change access permissions to both files. Allow only read access to current user and remove
all others.
o

You can find additional information on the Oracle website:
http://docs.oracle.com/javase/7/docs/technotes/guides/management/agent.html.

o

For more information on how to Secure a Password File on Microsoft Windows Systems,
see http://docs.oracle.com/javase/6/docs/technotes/guides/management/securitywindows.html.

o

On UNIX/Linux systems, you can set the file permissions for the password file by running
the following command:
chmod 600 jmxremote.password

2. Perform the following for SiteScope installed on Windows platform:
n

If you start SiteScope using the go.bat file, perform the following:
i. Open the <SiteScope root directory>\conf\go.bat file for editing.
ii. Find the string that starts ..\java\bin\SiteScope, and add the following parameters to
the end of this string:
-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties
iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its
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value from false to true.
iv. Save changes.
n

If you start SiteScope using the HP SiteScope service, perform the following:
i. Open the registry editor, regedit.exe.
ii. Locate and then click the following registry subkey:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\HP
SiteScope\serviceParam
iii. Add the following parameters to the end of the default value:
-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties
iv. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its
value from false to true.
v. Save changes.

3. Perform the following for SiteScope installed on a UNIX/Linux platform:
n

If you start SiteScope using the go.sh file, perform the following:
i. Open the <SiteScope root directory>/bin/go.sh file for editing.
ii. Find the string that starts ../java/bin/SiteScope, and add the following parameters to
the end of this string:
-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties
iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its
value from false to true.
iv. Save changes.

n

If you start SiteScope using the start command in the SiteScope bin folder, perform the
following:
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i. Open the <SiteScope root directory>/bin/start-monitor file for editing.
ii. Find the string that starts ../java/bin/SiteScope, and add the following parameters to
the end of this string:
-Dcom.sun.management.jmxremote.password.file=../conf/password.properties
-Dcom.sun.management.jmxremote.access.file=../conf/access.properties
iii. Find the parameter -Dcom.sun.management.jmxremote.authenticate and change its
value from false to true.
iv. Save changes.
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This provides an overview of how to get started with SiteScope.
1.

Log on to SiteScope
You can access SiteScope from a browser or from the Start menu.
Alternatively, you can use silent login to skip the initial login page and go directly to a SiteScope
client.
For details, see "Log into SiteScope" on page 18.
Note: You can manage large and dynamic environments from the command line on a
Windows or UNIX platform using the SiteScope Configuration API. For details, see "SOAPbased APIs" on page 159.

2.

Configure SiteScope for monitoring
To monitor the availability and performance of your IT infrastructure and applications, you can
manually create a monitoring structure in SiteScope, or you can create your own templates or use
SiteScope solution templates.
Tip: Templates are a more efficient method for monitoring different IT elements in your
enterprise and for deploying monitors in mass deployments. By standardizing a set of monitor
types and configurations into a single structure, you can repeatedly deploy a group of
monitors targeting multiple elements of the monitored environments that share similar
characteristics.
a. Manually Create a Monitoring Structure.
Use this workflow for creating a simple monitoring structure in SiteScope.

For task details, see "How to Create and Deploy a Monitor" on page 262.
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b. Create a Monitoring Structure Using a Template.
Templates are used to standardize a set of monitor types and configurations into a single
structure. This structure can then be repeatedly deployed as a group of monitors targeting
multiple elements of the monitored environments that share similar characteristics.
Creating a monitoring structure using templates involves the steps in the image below:

For task details, see "How to Create a Monitoring Structure Using a Template" on page 794
3.

Run SiteScope and view monitoring data in the Unified Console or the Dashboard
You can view current performance data for the infrastructure elements being monitored by
SiteScope in the Unified Console or in the SiteScope Dashboard.

4.

n

Unified Console. Use the Unified Console (a modern and intuitive Java-free interface) to
simplify the management of large, distributed environments, and to accelerate your ability to
isolate and diagnose problems. This is an HTML-based user interface that contains a
lightweight Event Console for managing the event lifecycle, Multi-View for viewing the realtime performance status of everything being monitored in a single view, and Manage view
which extends template deployment and the ability to update monitor configuration to nonadmin users. For details, see "Unified Console" on page 1061.

n

Dashboard. The Dashboard provides a real-time picture of system availability and
performance. It displays a table of groups and monitors for the element highlighted in the
monitor tree hierarchy. You can customize the monitor information that is displayed in the
Dashboard, and use the Dashboard links and menus to navigate through the hierarchy of
monitor elements, manually run monitors, disable monitors, and access alert definitions. For
details, see "View and Manage Data in the SiteScope Dashboard" on page 1034.

Use filters and tags to find and display the monitors you want to track - optional
Use the filter and tagging features to help manage and track monitors in SiteScope. This enables
you to more easily find and display only the monitors you need to see.
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Filter Option /
Description

How To Use:
Select one of the predefined status filters from the
Status list in Multi-View, or from the Favorites filter
in the SiteScope Dashboard context toolbar. (No
configuration is required.)

Where Do I
Get More
Details?
"How to
Select and
Configure a
View" on
page 1095

Tip: We recommend using Multi-View since it
Status Filter: Use to filter displays the status of all groups and monitors
without losing the hierarchical relationship between
by monitor status, such
as Error, Warning, Good, the data.
or Disabled.
a. Create filter using the Filter
in the
SiteScope Dashboard context toolbar.
b. View results in:
o Multi-View (click the filters drop-down list
Configuration (Custom)
and select a filter)
Filter: Use to filter by
o Dashboard (select the filter you want to use
various criteria such as
from the drop-down filter list)
monitor name, monitor
type, target server, and
Tip: We recommend using Multi-View since it
by monitors that have a
displays the status of all groups and monitors
specific tag value
without losing the hierarchical relationship between
assigned to them.
the data.
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Filter Option /
Description

Filter by Search/Filter
Tags: Filter by keyword
tags assigned to
monitors. This enables
grouping monitors to fit
the perspective of
different personas
viewing SiteScope data.

5.

How To Use:

Where Do I
Get More
Details?

a. Create tags in Search/Filter Tags
preferences, and assign to monitors from
Monitor properties (Search/Filter Tag panel).

"Search/Filter
Tags" on
page 718

b. View results in:

"How to Filter
the View
Using
Search/Filter
Tags" on
page 76

o

Multi-View (select Tags in the views dropdown list)

o

Dashboard (create a filter and select the
tags by which you want to filter in the Tags
field)

Tip: We recommend using Multi-View since it
enables you to group SiteScope monitors based on
monitor tags; each monitor is displayed under a
new group according to its tags. This lets you see
the status of your system in several ways. You can
drill down on tags or tag values to display only the
monitors to which these tags or tag values have
been assigned

Access SiteScope from a mobile device - optional
You can use SiteScope's free downloadable mobile apps to keep track of your monitored IT
infrastructure and perform monitoring specific actions while you are away from your computer. For
details, see "SiteScope Mobile Apps" on page 172.
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This section includes:
l

l

l

Using the SiteScope search and filter ("Quick Search" on page 72, "Filter Objects in the SiteScope
View" on page 74)
Performing mass operations on SiteScope objects ("Perform Actions on Multiple Groups and
Monitors" on page 84)
Copying/moving SiteScope objects to different locations ("Copy and Move SiteScope Objects" on
page 87)

l

Global Search and Replace ("Global Search and Replace" on page 89)

l

SiteScope diagnostic tools ("SiteScope Tools" on page 105)

l

Using SiteScope configuration and data acquisition APIs ("SOAP-based APIs" on page 159)

l

SiteScope mobile apps ("SiteScope Mobile Apps" on page 172)

l

Using regular expressions ("Regular Expressions" on page 175)
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You can use the quick search to search for SiteScope configuration objects such as groups, monitors,
remote servers, templates, and counters in the monitor, template, remote server, and counters tree.

To access
In the monitor, template, remote server, or counters tree (in the monitor properties for some browsable
counter monitors), enter the characters you want to search in the search box or in the Quick Search
box.

Learn About
Quick Search Overview
Use the quick search to search configuration objects for a specific property name or value. Quick
search is available in the monitor, template, remote server, and counters tree (in the monitor properties
for some browsable counter monitors). Enter a string in the Quick search box to filter the property
names and values. The tree expands all nodes containing the given string text.
The quick search provides options that enable filtering the search by case sensitivity, wild cards,
match options, and node/child options. It also includes an automatic filter that if selected, enables the
search to be performed automatically after typing the search word, without having to press the Enter
key every time you want to run the search.
For task details, see "How to use the quick search" below.

Tasks
How to use the quick search
To configure the search options, click the left end of the Quick Search
box to open the dropdown menu, and select the required options. For details on the quick search options, see "Quick
Search" on the next page.
Enter a string in the Quick Search box to filter the property names and values. The tree expands all
nodes containing the given string text.
Related tasks: "Filter Objects in the SiteScope View" on page 74
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UI Descriptions
Quick Search
UI
Element

Description
Quick Search. Enables you to search configuration objects (groups, monitors, remote
servers, templates, or counters) for a specific name or value in the monitor, template,
remote server, or counters tree (in the monitor properties for some browsable counter
monitors).
Click the left end of the box to open the drop-down menu of filter options:
l

l

l

l

l

l

l

Select Case sensitive to search for the filter string exactly as entered. Select Case
insensitive to ignore the case of the filter string.
Select Use wild cards to use the wildcard symbol * in the filter string. Enables you to
use asterisk (*) characters in your search string in order to type only part of the item.
Select Match from start to search for the filter string at the beginning of a property
name or value. Select Match exactly to search for the exact filter string. Select
Match anywhere to search for the filter string anywhere in the properties.
Select Match leaf node only to search for the filter string in leaf nodes (monitors and
empty groups only) in the tree. Clear to search all nodes.
Select Hide nodes without children to hide groups that have no leaf nodes that
match the filter string (empty groups).
Select Keep the children if any of their ancestors match to display all child nodes
of groups that match the filter string, even though the child does not match the search
string.
Select Use auto filter to search automatically after a letter is entered in the search
text field. You can configure a delay before the auto filter runs in Preferences >
Infrastructure Preferences > General Settings > Quick search auto filter delay
(milliseconds). The default delay is 800 milliseconds (0.8 seconds). If Use auto
filter is not selected, you must press the Enter key every time you want to run the
search.
Tip: In a loaded environment, it is recommended to increase the delay time in Quick
search auto filter delay time, or to disable the Use auto filter option.

Note: If a filter is applied to a tree, the search is restricted to the records currently
displayed.
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The SiteScope filter enables you to filter the display to show only those SiteScope monitors that meet
the criteria that you define. Filters can be defined with different criteria that can be applied for viewing
the data from different user perspectives, including filtering by monitor name, monitor type, target
server, keyword tags, enabled/disabled status of monitors or alerts, and BSM reporting settings.
You can also filter SiteScope monitors in Multi-View by using the filters defined in the SiteScope
monitor tree, or using predefined status filters to see all monitors that are in a particular status. For
details on using Multi-View, see "Multi-View" on page 1089.
Tip: You can view a guided and narrated demonstration on managing and tracking monitors using
filters and tags on YouTube: http://hpsw.co/r5D4GxA.

To access
In the Monitor tree context toolbar (above the left pane), click the Filter
button. You can select
a predefined filter, create a new filter, or edit values in an existing filter. You can view and manage all
filters from the Filter Manager dialog box.
In the New/Edit Filter dialog box, click the Browse
server, or Tags to access the required filter dialog box.

button next to Monitor type, Target

Tip: The filter options are also available when performing operations on multiple SiteScope objects
from the Manage Monitors and Groups dialog box. For details, see "Perform Actions on Multiple
Groups and Monitors" on page 84.

Learn About
Filtering Overview
When administrating monitor deployment, extensive trees displaying every object added to them could
prove difficult to manage. SiteScope enables you to select which monitors you want to view, based on
filter criteria. You can define multiple filters with different conditions that can be applied for varying
configuration tasks.
For example, you can create a filter to display only SiteScope monitors that are monitoring CPU
utilization and Disk Space. The result of this filter displays a tree with all CPU and Disk Space monitor
types directly under the enterprise node.
For task details, see "How to Filter the View Using a Configuration Filter" on the next page.
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Note: To create a filter based on specific common properties, use Global Search and Replace. For
details, see "Global Search and Replace" on page 89.

Filtering Using Search/Filter Tags
Keyword tags are used to search and filter SiteScope monitors. You can assign tags to any monitor in
SiteScope, and use those tags to search or filter the display. You define the tags and their values, and
assign these to the different elements in your enterprise.
For example, you could define a tag called Priority with the possible values of Critical, High,
Medium, and Low. You assign these tag values to different monitors in the infrastructure. Monitors of
Web servers and databases that support 24x7 customer access could be assigned a category value of
Priority: Critical. While adding a new filter setting, you select Tags in the Filter Options section,
enter Priority:Critical as the value of the object, and click Save. This filter displays only those
elements to which you assigned this tag and value.
Tags can also be used in alert templates using the <tag> attribute. Using the <tag:[tagName]>
property, you can include values in the filter tag as parameters in alerts. This provides similar
functionality to the custom properties mechanism that was removed in SiteScope 10.00. For example,
you have a tag named AppServer with value Apache assigned to a monitor, and you include
<tag:AppServer> in the alert template configured for that monitor. If an alert is triggered, the new
property is replaced with Apache in the alert text. For details on alert template properties, see
"Properties Available in Alerts, Templates, and Events" on page 1305.
For task details, see "How to Filter the View Using Search/Filter Tags" on the next page.

Tasks
How to Filter the View Using a Configuration Filter
This task describes the steps involved in filtering the monitors in the monitor tree and in Multi-View.
1. Create a new filter or select an existing filter.
In the Monitor tree context toolbar (above the left pane), click the arrow next to the Filter
button.
n

To view and manage all filters from one convenient table, select Manage Filters.... This
enables you to add, edit, and delete filters. For user interface details, see "Filter Manager
Dialog Box" on page 83.

n

If you have any filters defined, they appear in the drop-down filter list above the monitor tree.
Select the filter you want to use.

n

To create a new filter, select New Filter, and configure the filter to search for specific object
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types and property values in SiteScope in the New/Edit Filter dialog box. For user interface
details, see "New/Edit Filter Dialog Box" on page 79.
After you select a predefined filter from the list or create a new filter, the tree displays only those
objects defined in your filter selection. After applying a filter, the filter icon appears as

.

To clear a filter selection and display all objects in the monitor tree, click Clear Filter. After
clearing the filter, the

icon is displayed.

2. Filtering in Multi-View.
When working in SiteScope Multi-View, you can:
n

Filter monitors by selecting any of the filters defined in the SiteScope monitor tree. In
SiteScope Multi-View, click the filters drop-down list (to the right of the Monitors/Servers/Tags
drop-down), and select a filter.

n

Use the predefined status filters to see the groups and monitors that meet a particular status
criteria. For example, you can view all monitors in error or disabled status. Click the status
drop-down list (to the right of the filters drop-down), and select the status criteria to display.
Tip: You can apply the status filter to a filter selected in the filters drop-down to view only
those monitors that meet the filter criteria and have a particular status.

For details on using Multi-View, see "Multi-View" on page 1089.

How to Filter the View Using Search/Filter Tags
This task describes the steps involved in defining a Search/Filter tag and assigning it to one or more
monitors, and then using those tags to search or filter the display.
1. Prerequisites.
n

To be able to view Search/Filter tags, you must be an administrator in SiteScope, or a user
granted View tags permissions.

n

To be able to add, edit, or delete search/filter tags and tag values, you must be an administrator
in SiteScope, or a user granted Add, edit or delete tags permissions.

For details on user permissions, see "Permissions" on page 744.
2. Create a search/filter tag.
In SiteScope Preferences > Search/Filter Tags, create search/filter tags for use in filtering the
display. You define the tags and their values. For example, you could define a tag called
Application with the possible values of HR, CRM, and Online Banking.
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Example: Create a tag indicating the type of operating system on which the monitors are
running. The tag Platform might have values such as Windows 2008, Windows XP, Solaris,
Linux, and so forth.

For user interface details, see "New/Edit Tag Dialog Box" on page 721.
3. Assign search/filter tags to SiteScope monitors.
a. In the SiteScope monitor tree, select the monitor you want to tag.
b. In the Properties tab, expand the Search/Filter Tags panel, and assign a tag and tag values
to the monitor.
c. Repeat for all monitors to which you want to assign this tag and value.
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Example: To assign the tag to a monitor, open the Search/Filter Settings for the monitor, and
select the appropriate tag value under the Platform tag.

Using this new tag, you could define a filter setting to display only those monitors running on a
particular platform.
4. Filter SiteScope monitors by tags.
After you have assigned the tag to one or more monitors, you can use the tag as an object for a
filter.
a. In the context menu, click the arrow next to the Filter
button, and create a filter that
includes the tag values you want to see. For user interface details, see "New/Edit Filter Dialog
Box" on the next page.
b. In the Tags field, enter tag values, or click the Browse button and select the tag values by
which you want to filter in the Tags list. For details on the Filter Tags user interface, see "Filter
Tags Dialog Box" on page 83.
c. After you create a filter, the tree displays only those monitors that have the selected tag
values assigned to them.
5. View monitors grouped by tags in Multi-View.
Multi-View provides a new grouping option to fit the perspective of different personas viewing
SiteScope data. It enables you to group SiteScope monitors based on monitor tags; each monitor
is displayed under a new group according to its tags. This lets you see the status of your system in
several ways. You can drill down on tags or tag values to display only the monitors to which these
tags or tag values have been assigned.
For details on Multi-View, see "Multi-View" on page 1089.
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UI Descriptions
This section includes:
l

"New/Edit Filter Dialog Box" below

l

"Filter Monitor Types Dialog Box" on page 82

l

"Filter Target Servers Dialog Box" on page 82

l

"Filter Tags Dialog Box" on page 83

l

"Filter Manager Dialog Box" on page 83

New/Edit Filter Dialog Box
The Filter button is located in the context toolbar of the Monitor Tree.
User interface elements are described below:
UI Element

Description

General Settings
(This panel does not appear when accessing the filter from the Manage Monitors and Groups dialog
box)
Filter name

This name appears in the list of available filters when you click the Filter arrow.

Filter
description

Description for the filter. This description appears only when editing the filter.

Public filter

Describes the permissions of the filter. If the filter is public, all users can see, use,
and edit the filter, but only the public filter owner can change this filter to a private
filter.

Note: This field is optional.

If the filter is not public, only the current user can see and use it.
Filter Options
Regular
expression

Enables using standard regular expressions to filter the monitor tree.
When selected, you cannot select monitor names, monitor types, or tag values
from the filter lists. The filter uses the POSIX regular expression format when the
check box is cleared.
Default value: Selected
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UI Element

Description

Monitor name

To filter the objects appearing in the tree by the monitor name, type a monitor
name.
l

l

The monitor name is the string entered in the Name box in the General
Settings panel during monitor configuration.
You can enter a regular expression to widen the filter. This is done by using
wild card ("*") and or expressions to filter SiteScope objects appearing in the
tree by the monitor name.

The monitor tree displays only those monitors, within their groups, matching the
string entered and only those groups containing these monitors.
Example: The expression /URL Monitor.* \.gov/ matches all monitor names
containing the string URL Monitor with addresses containing the domain .gov.
Note: This field is case sensitive.
Monitor type

To filter the objects appearing in the tree by the monitor type, enter the monitor
type, or click the Browse
button and select the monitor types by which
you want to filter in the Monitors list.
For example, you can define a filter that includes all CPU monitors, regardless of
their properties. In this view, the monitor tree lists all the CPU monitors defined in
the SiteScope.
For details on the Filter Monitor Types user interface, see "Filter Monitor Types
Dialog Box" on page 82.
Note:
l

When entering multiple monitors, separate them with a comma (",").

l

When entering a monitor type, you can enter a regular expression.

Example: SAP* or CPU*
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UI Element

Description

Target server

To filter the objects appearing in the tree by the target server, type a server name
or click the Browse
button and select the remote servers by which you
want to filter from the Targets list.
l

l

The target is the string entered in the Server box in the Monitor Settings panel
during monitor configuration.
You can enter a regular expression to widen the filter.

The tree displays only those monitors, within their groups, whose target server
matches the string entered and only those groups containing these monitors.
For details on the Filter Target Server user interface, see "Filter Target Servers
Dialog Box" on the next page.
Note: When entering multiple targets, separate them with a comma (",").
Tags

Enables you to define a filter that includes all SiteScope objects that have a
specific tag value. For example, if there is a platform tag with values Windows,
Linux, AIX, and Solaris, you can filter for all objects that have the AIX tag value
assigned to them.
Enter tag values, or click the Browse
button and select the tag values
by which you want to filter in the Tags list. For details on the Filter Tags user
interface, see "Filter Tags Dialog Box" on page 83.
Note:
l

l

When entering multiple tag values, separate them with a comma (",").
You can use the wild card character ("*") and the and or or expressions to filter
tag values.

Enable/Disable Enables you to define a filter that includes only enabled or disabled SiteScope
Monitor
monitors.
Default value: None
Enable/Disable Status (enabled/disabled) of associated alerts by which you want to filter.
Associated
Default value: None
Alerts
HP BSM
Logging

Enables you to define a filter that includes monitors based on their settings for
reporting data to BSM.
For details on the logging options, see "HP Integration Settings" on page 297.
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Filter Monitor Types Dialog Box
This dialog box enables you to select the monitor type by which you can filter SiteScope objects.
UI
Element

Description

Available
Monitor
Types

Displays the available monitor types.

Selected
Monitor
Types

Displays the monitor types currently selected for this filter.

Select the monitor types you want to include in the filter and click the Move to
Selected Monitor Types button. The selected monitor types are moved to the
Selected Monitor Types list.

To remove monitor types from this list, select the monitor types and click the Move to
Available Monitor Types button. The measurements are moved to the Available
Monitor Types list.

Filter Target Servers Dialog Box
This dialog box enables you to filter SiteScope objects by the selected server targets configured in
SiteScope.
UI
Element

Description

Available
Target
Servers

Displays the remote servers available in SiteScope.

Selected
Target
Servers

Displays the remote servers currently selected for this filter.

Select the remote servers you want to include in the filter and click the Move to
Selected Target Servers button. The selected remote servers are moved to the
Selected Target Servers list.

To remove remote servers from this list, select the remote servers and click the Move
to Available Target Servers button. The measurements are moved to the Available
Target Servers list.
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Filter Tags Dialog Box
This dialog box enables you to select the tag values by which you can filter SiteScope objects.
UI Element

Description

<Tag name
and values>

Displays the tag names and tag values if tags have been created. Select the check
box next to the tags that you want to include in the filter, and click Save.
For details on creating search/filter tags, see "New/Edit Tag Dialog Box" on page
721.

Tree Filter

Select an operator to define tag tree filter conditions:
l

and. Displays all objects that have all the tags selected.

l

or. Displays all objects that have at least one of the tags selected.

Note: You can select only one type of operator (mixed conditions cannot be used).

Filter Manager Dialog Box
Filter Manager enables you to view and manage all your filters in one table.
UI Element

Description
New Filter. Opens the New Filter dialog box enabling you to configure a filter. For
user interface details, see "New/Edit Filter Dialog Box" on page 79.
Edit Filter. Opens the Edit Filter dialog box enabling you to edit the properties of the
selected filter. For user interface details, see "New/Edit Filter Dialog Box" on page 79.
Delete Filter. Deletes the selected filters from the filters list.

Filter Name Displays the name of each filter.
You can change the order of the listed filters, by clicking the column header. An arrow
is displayed to indicate the sort order (ascending or descending).
Filter
Displays the description for the filter (if added when creating the filter).
Description
You can change the order of the listed filters, by clicking the column header. An arrow
is displayed to indicate the sort order (ascending or descending).
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You can perform mass operations on one or multiple SiteScope objects using the Manage Groups and
Monitors feature. Using the Manage Monitors and Groups dialog box, you can select one or more
groups, monitors, or both from an expandable hierarchical view of the organization, and select the
action you want to perform (copy, move, delete, run monitors, enable/disable monitors, enable/disable
associated alerts).
You can also use the filter options to create a filtered list of groups and monitors based on a filter
criterion, or select an existing filter previously defined in the monitor tree filter.

To access
Select the Monitors context. In the monitor tree toolbar, click the Manage Monitors and Groups
button.

UI Descriptions
Manage Monitors and Groups Dialog Box
Important
information

Relevant tasks
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l

The toolbar actions are available according to the user permissions and the
objects selected.

l

The Health container cannot be deleted.

l

"How to Manage a Group" on page 247

l

"How to Create and Deploy a Monitor" on page 262

l

"Filter Objects in the SiteScope View" on page 74
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User interface elements are described below:
UI Element

Description
Filter. Enables you to filter the monitor tree to display only those SiteScope objects
that meet the criteria that you define. After applying a filter, the name of the filter is
displayed in the button (custom, if the filter was created in the Manage Monitors
and Groups dialog box; otherwise, the name of the filter defined in the monitor tree
filter).
Click the Filter button arrow and select a filter option:
l

l

l

New Filter. Opens the New Filter dialog box which enables you to create a
filter. For user interface details, see "Filter Objects in the SiteScope View" on
page 74.
Clear Filter. Clears the filter settings.
<List of existing filters>. Displays a list of existing filters previously defined in
the monitor tree filter.

Select All. Selects all listed SiteScope objects.
Clear Selection. Clears the selection.
Cut. Moves the selected objects to the destination group.
Note:
l

l

l

Any alerts defined for a specific monitor are transferred with the monitor.
Moving a monitor restarts its history and any reports generated for the monitor
are started from the time that the monitor was moved. The history data is still in
the log files, but it is inaccessible from the reports for the monitor after it has
been moved. Moving groups has no effect on history.
Moving a monitor may break group-to-monitor dependencies. If you have one or
more groups dependent on the status of the monitor you are moving, update that
dependency after moving the monitor.

Copy. Makes a copy of the selected objects for pasting to the destination group.
Paste. Pastes the selected objects to the destination group. If you make a copy of a
SiteScope object and it has the same name as an existing object in the container,
SiteScope automatically adds a suffix (number) to the end of the object's name.
Example: If you create a copy of monitor Mail Flow and paste it in the same
monitor group, SiteScope automatically renames it Mail Flow(1).
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UI Element

Description
Delete. Deletes the selected objects from the monitor tree.
Run Monitors. Runs the monitor or any monitors configured in the group. This
opens an information window with the results.
Enable/Disable Monitor. Opens the Enable/Disable Monitor dialog box which
enables you to enable or disable the monitor or all the monitors in the group,
regardless of the setting in the monitor properties. If you select Disable, the
monitors are disabled until you return to this dialog box and select Enable. For user
interface details, see "Enable/Disable Monitors in Group Dialog Box" on page 1049.
Enable/Disable Associated Alerts. Open the Enable/Disable Associated Alerts
dialog box which enables you to enable or disable all alerts associated with the
monitor or all monitors in the group. For more details, see "Enable/Disable
Associated Alerts" on page 310.

<SiteScope
objects>

Actions are applied to all monitors and groups that are selected using the check box
selections in the tree. The display of the tree is saved across visits to the dialog box
and the actions associated with it.
l

l

To select an object, select the check box to the left of the object name. Any
combination of groups or monitors can be selected. A icon displayed to the
left of a group indicates that not all monitors and subgroups contained within that
group have been selected.
To select a destination for copying or moving an object, click the object name
(not the check box).

Default value: The top level groups are shown, but no objects are selected.
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You can copy SiteScope objects to different locations within a context tree. In addition, you can copy
SiteScope objects to templates. You can also move monitors and groups, together with their contents,
to different groups in the monitor tree.
To enable you to differentiate between objects, object names must be unique within the parent
container. For instance, when you copy or move SiteScope objects, you cannot create two monitors
within the same group with exactly the same name. If you make a copy of a SiteScope object and it has
the same name as an existing object in the container, SiteScope automatically adds a suffix (number)
to the end of the object's name. For example, if you create a copy of monitor Mail Flow and paste it in
the same monitor group, SiteScope automatically renames it Mail Flow(1).
You can copy or move the following SiteScope objects:
SiteScope
Object
Action and Description
Group

Copy/Paste. Copy a monitor group, including its subgroups, monitors, alerts, and
reports, to the same or a different monitor group.
Cut/Paste. Move a monitor group, including its subgroups, monitors, alerts, and
reports, to a different monitor group.
Copy to Template. Copy a monitor group, including its monitors, alerts, and reports, to
a template.
Note:
l

l

l

You cannot move or copy a monitor group to its subgroup.
If you move a group that is targeted by an alert or report without also moving the
alert or report, the group is removed from the alert or report target.
Baseline thresholds are not copied or moved with a monitor whose thresholds were
set using the baseline.

HP SiteScope (11.31)

Page 87 of 1395

Using SiteScope
Chapter 10: Copy and Move SiteScope Objects

SiteScope
Object
Action and Description
Monitor

Copy/Paste. Copy a monitor, including its alerts and reports, to the same or a different
monitor group.
Cut/Paste. Move a monitor, including its alerts and reports, to a different monitor group.
Copy to Template. Copy a monitor, including its alerts and reports, to a template.
Note:
l

l

l

If you move a monitor that is targeted by an alert or report without also moving the
alert or report, the monitor is removed from the alert or report target.
After copying a monitor, you normally need to change the system or application that
the monitor is targeting, otherwise the copied monitor duplicates the monitoring
actions of the original monitor instance.
Baseline thresholds are not copied or moved with a monitor whose thresholds were
set using the baseline.

Remote
Server

Copy to Template. Copy a remote server profile to a template.

Template
Container

Copy/Paste. Copy a template container and paste it to another template container or to
the SiteScope root.

Template

Copy/Paste. Copy a template including its groups, monitors, alerts, and report, to a
template container.

Template
Group

Copy/Paste. Copy a template group including its subgroups, monitors, alerts, and
reports to a template (provided the template does not already contain a template group)
or to a template group.

Template
Monitor

Copy/Paste. Copy a template monitor including its alerts and reports to a template
group.

Alert

Copy/Paste. Copy an alert definition (from the Alerts tab) to the same or a different
location (group or monitor) in the monitor tree or template tree.

Report

Copy/Paste. Copy a report definition (from the Reports tab) to the same or a different
location (group or monitor) in the monitor tree or template tree.

Note: You can also move or copy multiple monitors and groups to a target group by clicking the
Manage Monitors and Groups
button in the monitor tree toolbar. For details, see "Perform
Actions on Multiple Groups and Monitors" on page 84.
For details on copying or moving SiteScope objects, expand the context menu option for the relevant
SiteScope view in "Context Trees and Menu Options" on page 28.
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The Global Search and Replace Wizard enables you to make changes to monitor, alert, alert action,
group, preferences, and report properties. You can select an object based on object type, and globally
replace any of the selected object's properties across a SiteScope or across multiple SiteScopes when
working in SAM Administration.
For example, when upgrading BSM, use the Global Search and Replace Wizard to configure all the
SiteScopes reporting data to BSM to the upgraded version.

To access
l

l

In SiteScope, right-click SiteScope root or the group or monitor in the monitor tree to which you want
to perform the global replace. To replace Preferences objects, right-click the SiteScope root. To
replace alert objects, right-click the SiteScope root, or the relevant group or monitor object. Select
Global Search and Replace from the context menu.
In BSM, select Admin > System Availability Management. Below the SiteScope Summary
table in the right pane, click the Global Search and Replace button.

Learn About
Filter Affected Objects
Use the Filter Affected Options option to further refine your selected object for the search operation.
You can select specific properties and select or enter values pertaining to your object. This enables you
to limit the selected objects but not the value to replace.
When performing the replace operation, only the value to replace is replaced and only on those objects
that match the properties selected in the Filter Affected Options page. For example, select all monitors
with frequency set to 5 minutes and replace the monitor dependency setting for all of those monitors, or
select only those monitors monitoring a specific server and replace the threshold settings for only those
monitor instances matching the value of the server entered in the filter.

Replace or Find and Replace
Use the replace method to search for a field value and replace it with a new value. For example, change
the default monitor run frequency setting for the selected monitors by selecting the Frequency check
box in the Monitor Run Settings panel, and updating the frequency value from 10 to 15 minutes.
Use the find and replace method to search for specific settings and property values and replace only
those objects with the entered setting or value. You can search a string, value, or regular expression
pattern and replace only that string. Replacements are made only if the filter criteria match. For
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example, search for all monitors whose name value includes a server name that is no longer in use.
Replace the string representing the old server with a new string representing the updated server.

Threshold Settings
Tip: We recommend using the Publish Changes feature to replace thresholds, since incorrect
threshold names can sometimes appear when changing Threshold Settings with GSAR. See
"Publish Changes to Templates" on page 877.
When replacing threshold settings for monitors, by default you replace only those settings that share all
of the following:
l

Have the same condition (Error if, Warning if, or Good if).

l

Are configured for the same schedule.

l

Use the same operator type (< <=, > >=, ==, !=, contains, !contains).
Note: < (less than) and <= (less than and equal to) are considered the same operator type, as
are > (greater than) and >= (greater than and equal to).

You also have the option to override all the existing threshold settings that have the same condition
(Error if, Warning if, or Good if) regardless of the operator used and the schedule configured. The
option is called Override Category and appears in the Choose Changes page of the wizard under the
Threshold Settings panel if you selected Monitor in the Select Type page of the wizard.
For example, you want to change the Error if threshold settings for all CPU monitors to greater than
85%. In the wizard, you select Monitor in the Select Type page, CPU in the Select Subtype page, and
expand the Threshold Settings panel in the Choose Changes page.
If you select the Override Category option when selecting greater than 85% as the New Error if
status condition, all the existing Error if settings for all CPU monitors are overwritten and changed to
greater than 85% when you complete the wizard.
If you leave the option cleared, the greater than 85% Error if setting you select in the wizard replaces
only those Error if settings that use the > (greater than) and >= (greater than and equal to) operators
and were configured for the same schedule for all CPU monitors.
For details on setting thresholds, see "Setting Status Thresholds" on page 259.
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Tasks
How to Perform a Global Search and Replace
This task describes how to perform a global search and replace for objects, using the Global Search
and Replace Wizard.
1.

Begin running the Global Search and Replace Wizard
Right-click SiteScope root or the group or monitor in the monitor tree to which you want to perform
the global replace. To replace Preferences objects, right-click SiteScope root. To replace alert
objects, right-click SiteScope root, or the relevant group or monitor object. Select Global Search
and Replace from the context menu.
For user interface details, see the UI Descriptions section below.

2.

Select SiteScope (in SAM only)
Note: This step is only applicable when you access the Global Search and Replace wizard
from SAM.
In the Select SiteScope page, select one or more SiteScopes on which to run the search and
replace.

3.

Select object type
In the Select Type and Select Subtype page, select the object and, if relevant, the subtype on
which you want to make a replacement.
For user interface details, see "Global Search and Replace Wizard - Select Type Page" on page
96 and "Global Search and Replace Wizard - Select Subtype Page" on page 97.
Example: To change the threshold boundaries for all CPU monitors, select Monitor as the
object type.
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Select CPU as the specific monitor type.

4.

Search and replace objects
In the Replace Mode page, select the type of replacement. Select Replace to globally replace the
object or select Find and Replace to replace specific instances of the object. Optionally, you can
open the Advanced Filter dialog box to filter by the object properties. Here you select on which
objects to perform the replace operation. In the Choose Changes page, you select what
properties or values to replace.
For user interface details, see "Global Search and Replace Wizard - Replace Mode Page" on page
97 and "Global Search and Replace Wizard - Choose Changes Page" on page 98.
Example: Reducing the Frequency of a Monitor Run on a Specific Server.
To reduce the frequency of how often a monitor runs on a specific server in your company,
filter your selection in the Monitor Settings panel in the Choose Changes page to include
only those monitors monitoring the specified server.
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In the Monitor Run Settings panel, enter a new frequency of once a day, to monitor the
specified server.
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Example: Setting Up Alert Action to Send Alert Messages to Specified Email Addresses.
If one of the email addresses you configured to receive alerts has changed, you can update
the email address that has changed. In the Select Type page, select Alert Action as the
object type, and in the Replace Mode page select Find and Replace.

In the Choose Changes page, enter the old email address in the Find field and the new email
address in the and replace with field.

5.

Check affected objects
In the Affected Objects page, view the affected objects and, if necessary, clear or select objects
for the replacement operation. Optionally, you can open the Filter Affected Objects dialog box to
filter by the object properties. Here you select on which objects to perform the replace operation.
For user interface details, see "Global Search and Replace Wizard - Affected Objects Page" on
page 101.
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Example: Reducing the Frequency of a Monitor Run on a Specific Server.
You want to reduce the frequency of how often a monitor runs on a specific server in your
company.
If you had selected Replace in the Replace Mode page, in the Choose Changes page, you
then enter a new frequency of once a day, to monitor the specified server.

The affected objects are displayed in the Affected Objects page.
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You can filter your selection in the Filter Affected Objects page to include only those monitors
monitoring the specified server.

6.

Review replaced objects
In the Review Summary page, review the results of the replacement operation and click Finish to
complete the wizard. You can view a summary of the changes in the Summary page to see which
changes were implemented successfully and in which errors occurred.
For user interface details, see "Global Search and Replace Wizard - Review Summary Page" on
page 103 and "Global Search and Replace Wizard - Summary Page" on page 103.

UI Descriptions
Global Search and Replace Wizard - Select SiteScope Page
This wizard page enables you to select the SiteScope on which to make replacements.
Note: This page appears only when you are working in System Availability Management
Administration.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<SiteScope
machines>

Select one or more SiteScopes on which to run the search and replace.
Note: Only SiteScopes running version 9.0 and later and whose connection status
permits configuration changes from SAM are listed.

Global Search and Replace Wizard - Select Type Page
This wizard page enables you to select the object type on which you want to make replacements.
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User interface elements are described below:
UI Element

Description

<object type>

You can select only one object type for each replace operation. Only those
types of objects available for the node you selected are listed.

(Alert, Alert Action,
Group, Monitor,
Preference, Report)

When performing Global Search and Replace from SAM Administration,
group, monitor, alert, alert action, and preferences appear only if they exist
on at least one SiteScope selected in the previous page.

Global Search and Replace Wizard - Select Subtype Page
This wizard page enables you to select the properties of the object type on which you want to make
replacements.
User interface elements are described below:
UI Element

Description

<Object
Displays properties of the object type. For example, if you selected Monitor as the
type
object type, it lists all monitor types for the selected SiteScopes.
properties>
Note: This page is not available if you selected the object type Group, Alert, or
Report in the "Global Search and Replace Wizard - Select Type Page" on the
previous page of the wizard.

Global Search and Replace Wizard - Replace Mode Page
This wizard page enables you to select the type of replacement: global replacement or replacement
based on filter criteria.
User interface elements are described below:
UI
Element Description
Replace

Globally replaces all matching objects with the new string or value.
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UI
Element Description
Find
and
Replace

Searches the target objects for properties that match a string or regular expression and
replaces only the matching pattern with the replacement value.
This method of replacement includes a search for specific settings and property values
and replaces only those objects with the entered setting or value. You can select only a
partial value and replace only that string.
Note:
l

l

If you select this option, only settings whose values can contain a string are available
in the settings area of the Choose Changes page and can be selected for the find and
replace action.
Use this setting to determine the selection and the value to replace. It differs from the
Advanced Filter option, which is a way to limit the selected objects but not the value
to replace.

Example: Search for all monitors whose name value includes a server name that is no
longer in use. Replace the string representing the old server with a new string
representing the updated server.

Global Search and Replace Wizard - Choose Changes Page
This wizard page enables you to select what to replace for the global replace. The wizard displays only
the settings and properties that may be changed for the object type selected in the previous pages. The
filter criteria is built from your selections in the Type, Subtype, and Advanced Filter pages.
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Important
information

l

The subtype's properties may appear differently from how they appear when
editing a monitor, alert, preference, and so forth in SiteScope.
Examples: Mail Preferences is a text box in Global Search and Replace utility
rather than a drop-down list, and the Depends on property does not appear in the
Global Search and Replace utility.

l

l

l

The Server property is available only when monitors from the following group are
selected: CPU, Disk Space, Memory, Microsoft Windows Performance Counter,
Web Server, and Service monitor. For other monitors, you can only change the
server attribute by selecting that specific monitor subtype in the Select Subtype
page. For example, if a CPU monitor is selected with a Web Server monitor, the
server property is available. If a monitor not from this group is also selected, the
server property is not available.
Note for users of SiteScope within SAM Administration: If the SiteScopes
selected for the replace operation are not all the same version, the subtypes of the
SiteScopes may have different properties.
Using GSAR to replace values in URL Sequence monitors that do not all contain
the same number of steps (x), might result in monitors with less than x steps
containing irrelevant values.

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element
Find
Replace
With

Description
If you chose the Find and Replace option in the Replace Mode page, the text boxes
Find and Replace With are added to the top of this page.
l

l

In the Find box, enter the search string, value, or regular expression pattern for the
setting or property you want to replace.
In the Replace With box, enter the string or value to which you want all matching
patterns to be changed.

Note: If you select Frequency in the Monitor Run Settings, the values you enter in the
Find and Replace With text boxes must be in seconds. For example, you want to find
monitors with a frequency of 10 minutes and change the frequency to 20 minutes. In the
Find text box, enter 600 and in the Replace With text box enter 1200.
If no objects are found that meet the filter criteria, an error message appears. Reselect
your filter criteria.
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UI
Element

Description

<Settings This area includes the settings for the object you selected. For details about these
area>
settings, refer to the selected object's settings page.
l

l

If you selected Find and Replace in the Replace Mode page, you select only the
setting in the settings area. Enter the old and new values to replace in the
Find/Replace with boxes.
If you selected Replace in the Replace Mode page, you select the setting and the
new value in the settings area.

For details about some of the areas:

Threshold Settings Area
l

l

The Threshold Settings area appears only if you select Monitor in the Select Type
page, and one monitor in the Select Subtype page. It is not displayed if you select
more than one monitor in the Select Subtype page, and one of the monitors does not
include threshold definitions.
The Override Category option is displayed only if you selected Monitor in the
Select Type page:
n

When this option is selected, you can override the threshold settings of the same
threshold condition (Error if, Warning if, or Good if) for the selected monitor
instances with the settings you enter here for the replace operation.

n

When this option is cleared, the settings you enter here replace only those
settings with the same operator type (< <=, > >=, !=, ==, contains,
doesNotContain)) and the same configured schedule for the monitor instances.
Any other settings for the same condition but with a different operator type or a
different schedule remain. For details on this option and an example, see
"Threshold Settings" on page 90.

Filter Settings Area
If you selected Alert in the Select Type page, the Monitor type match field in the Filter
Settings is not displayed and its values cannot be replaced in the wizard.

Server Settings Area
The Server Settings area appears only if you select Monitor in the Select Type page,
and one monitor in the Select Subtype page. It is not displayed if you select more than
one monitor in the Select Subtype page, and these monitors do not belong to the same
family, as listed below:
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UI
Element

Description
l

l

SAP monitors: SAP CCMS, SAP CCMS Alerts, SAP Java Web Application Server,
SAP Performance, SAP Work Processes.
Server monitors: CPU, Disk Space, Memory, Microsoft Windows Performance
Counter, Service, UNIX Resources, Web Server.

l

SNMP monitors: Cisco, F5 Big-IP, Network Bandwidth, SNMP by MIB.

l

URL monitors: URL, URL List, URL Content, URL Sequence.

l

Windows Counter monitors: ASP, Citrix, ColdFusion, Microsoft Hyper-V, Microsoft
IIS Server, Microsoft SQL Server, Microsoft Windows Media, Real Monitor.

Global Search and Replace Wizard - Affected Objects Page
This wizard page enables you to view the objects that you selected to change. The page displays the
selected objects in tree format. You can clear or select objects in the Affected Objects tree for the
replacement operation.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description
Filter. Optionally, click to open the dialog box if you want to further refine your
selections. For user interface details, see "Global Search and Replace Wizard - Filter
Affected Objects Dialog Box" on the next page.
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UI
Element

Description

<Affected The Affected Objects tree includes all objects that are matched against the filter criteria
Objects
selected in the previous pages of the wizard.
tree>
Select or clear objects as required for the replace operation.
Note:
When using Global Search and Replace from SAM Administration, a tree is
displayed for each SiteScope selected.

l

The objects displayed depend on whether the user has change permissions on those
objects.

l

l

n

In SAM Administration, the permissions are set in BSM's Permissions
Management (Admin > Platform > Users and Permissions).

n

In SiteScope standalone, the permissions are set in Preferences > User
Management Preferences.
If you selected Find and Replace in the Replace Mode page, replacements are
made only if the filter criteria are matched. If you selected Replace, replacements
are made in all selected objects.

Global Search and Replace Wizard - Filter Affected Objects Dialog Box
This dialog box enables you to select objects based on their specific settings and not only based on
object type. For example, you can select all alerts that have a defined category of critical and replace
any setting for those alerts. You can also select all groups with a dependency set to a specific monitor
or group and replace any setting for those groups.
To access, click the Filter
Page" on the previous page.

button in the "Global Search and Replace Wizard - Affected Objects

Note: Using this option only refines your selection for the replace and does not determine what to
replace.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description

<Settings The setting areas pertinent to the object you selected appear. For details about these
areas>
settings, refer to the selected object's settings page. Select the properties and enter the
values by which to filter the selected objects.
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Global Search and Replace Wizard - Review Summary Page
This wizard page enables you to preview the objects on which the replacement operation is performed.
When working with multiple SiteScopes in SAM Administration, a table appears for each SiteScope
and the name of the SiteScope appears above the table.
Important
information

l

l

l

The number of objects that are affected by the global replacement is displayed
above the table.
Each table column can be sorted in ascending or descending order by rightclicking the column title. An up or down arrow indicates the sort order.
Once you click Apply in this page, you cannot undo the replacement operation.

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description
Change the sort order in the columns by clicking the up and down arrow in
the column title.
Default: The Full Name column is in alphabetical order, from top to bottom.

Full Name

Displays a tree of the server name, group, monitor name, and the monitor's
properties whose value is being replaced.

<property>

The box name that you marked in the Choose Changes page that changes
as a result of the replace operation.

Previous Value

The current value that changes as a result of the replace operation.
Note: If the value being replaced is a check box that was cleared and is
now being selected, you may not see the previous value (cleared) for the
check box.

New Value

The new value that you entered in the Choose Changes page.

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties against the
remote servers on which the changes are being made.
Default value: Selected
Note: When this option is selected, it takes more time to make changes
due to the remote connections.

Global Search and Replace Wizard - Summary Page
The Summary page reports the changes that were implemented successfully and those in which errors
occurred. The page displays the changes in table format. When working with multiple SiteScopes in
SAM Administration, a table is displayed for each SiteScope and the name of the SiteScope appears at
the top of the table.
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Important
information

l

l

l

There is no way to undo changes made by the replace operation.
The number of objects affected by the global replacement is given above the
table.
Each table column can be sorted in ascending or descending order by rightclicking the column title. An up or down arrow indicates the sort order.

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description
Change the sort order in the columns by clicking the up and down arrow in the column
title.
Default: The Full Name column is in alphabetical order, from top to bottom.
Click to open a report of the results in a PDF file.
Note: This option is available only to users accessing Global Search and Replace
from SAM Administration.
Click to open a report of the results in a CSV format file.
Note: This option is available only to users accessing Global Search and Replace
from SAM Administration.
Print. Click to print the table. This icon appears for each table in the summary.

Full Name

Displays a tree of the server name, group, monitor name, and the monitor's properties
whose value is being replaced.

<property> The box name that you marked in the Choose Changes page that changes as a result
of the replace operation.
Previous
Value

The value that was replaced in the global replace operation.

New Value

The new value that resulted from the global replace operation.

Apply

Closes the wizard.
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SiteScope provides a number of diagnostic tools that are useful to test the monitoring environment. You
can use these tools before configuring a monitor to uncover issues and facilitate monitor configuration,
and after configuring a monitor to troubleshoot and diagnose problems.

To access
l

l

Select the Tools context. The Tools menu options are displayed in the left pane (provided you are
an administrator in SiteScope, or a user granted Use tools permissions).
Some tools are also available when configuring or editing specific monitors (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions). If a tool is available
when configuring or editing a monitor (see "Testing Monitor Configuration Using Diagnostic Tools"
on page 1036), you can access the tool by:
n

Clicking the Use Tool
button in the new monitor dialog box when configuring a new monitor,
or in the monitor Properties tab when configuring an existing monitor.

n

Clicking the Tools button in the SiteScope Dashboard toolbar when running the test tool for an
existing monitor. This opens and runs the tool with the monitor's existing data as its input, and
displays test results in the Results pane.

Learn About
SiteScope Tools Overview
Use these tools to make a variety of requests and queries of systems you are monitoring and to view
detailed results of the action. Requests may include testing network connectivity or verifying login
authentication for accessing an external database or service.
Some tools are available when configuring specific monitor types to help you configure the monitor
settings. You enter data into the tool fields, and SiteScope tests the data. After SiteScope tests the
data , you can apply the tested data directly to the monitor configuration form. For example, before
configuring a DNS monitor, you can use the DNS Tool to translate a domain name to an IP address.
After the name has been translated, SiteScope can apply the data to the new monitor.
For the list of SiteScope tools that are available and tool descriptions, see "Tools Menu" on page 54.
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Tasks
How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor
This task describes the steps involved in using a SiteScope tool to assist you to configure or
troubleshoot a monitor.
1. Prerequisites
n

To view and use the tools in the Tools context in the left pane, you must be a SiteScope
administrator user, or a user granted Use tools permissions.

n

To use the tools that are available when configuring specific monitors, you must be a
SiteScope administrator user, or a user granted Use monitor tools permissions.

2. Add and configure a monitor
Select New > Monitor, and add a new monitor from the New Monitor dialog box. If a tool is
available to help you configure the monitor, click the Use Tool button at the bottom of the new
monitor dialog box.
3. Configure and run the test
Enter the required information in the tool dialog box, and run the tool. Any server-side validation
errors are displayed in the result pane.
4. Apply the tested data to the monitor fields
After the configuration data has been successfully tested, click the Apply to New Monitor button
(or Apply to Monitor button when editing an existing monitor) to have SiteScope apply the data to
the monitor configuration.
5. Use a tool to edit or test monitor properties - optional
You can also use SiteScope tools, where available, to edit or test configuration properties for
existing monitors.
n

To edit monitor configuration properties, click the Use Tool button in the monitor Properties
tab, and complete the two previous steps.

n

To open and run the tool with the monitor's existing data as its input, click the Tools
button
in the SiteScope Dashboard toolbar. The test results appear in the Results pane. To save the
results to a file, click the Save to File button.
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How to Use the Log Analysis Tool – Use-Case Scenario
This task describes the steps involved in using the Log Analysis Tool when you want to configure a Log
File monitor.
The administrator wants to create a Log File monitor for the most common problems or situations that
are described in the log to be monitored. Once he selects the situation and creates the corresponding
Log File monitor, the monitor runs as soon as a line corresponding to the selected situation is added to
the log.
1. Prerequisites
n

To view and use the tool in the Tools context in the left pane, the administrator must be a
SiteScope administrator user, or a user granted Use tools permissions.

n

To use the tools that are available when configuring specific monitors, the administrator must
be a SiteScope administrator user, or a user granted Use monitor tools permissions.

2. Copy the log to analyze
The administrator copies the log he wants to analyze to the local SiteScope machine.
3. Run the Log Analysis Tool on that log
a. The administrator selects Tools > Common Utility Tools > Log Analysis Tool.
b. In the Log Analysis Tool dialog box, the administrator enters:
o

File location. The location of the log copied to the local SiteScope server. To analyze
several files at the same time, copy the files to the designated folder and create a regular
expression that matches the file names of the log files to be analyzed.

o

Message position. The number of blocks (separated by blanks) that are to the left of the
message to analyze for patterns.
For example, in the log structure that follows, the part of the log entry you are interested in
is the message that starts after the 7th blank space (the space inside the date format is not
included as it is part of the date format).
2010-11-02 11:49:02,738 [SiteScope Main Thread]
(SiteScopeHeartbeatManager.java:53) INFO - The Heartbeat Scheduler was
started. 2010-11-02 11:49:02,786 [SiteScope Main Thread]
(ServiceController.java:82) INFO - Registering service: Host DNS
Resolution Service

o

Location of the date in the pattern. The order of the block of text where the date is
located. In the example above, the date is part of the first block of text.

o

Date format. In the example above, the date format follows the default. The default
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includes blanks.
o

The administrator clicks Run Tool.
The Results box, in the Log Analysis Tool dialog box, displays the Regular Expression
patterns found in the log and the number of instances of the pattern.

c. The administrator selects the relevant pattern and clicks the Create New Log File Monitor
button. In the Select group dialog box that opens, the administrator can select an existing
group or create a new group by clicking the New Group button.
The New Log File Monitor dialog box opens, with the selected regular expression displayed
in the Content match box.
d. In that dialog box, the administrator enters the rest of the information needed to run the Log
File monitor, including the path to the "real" log you want to analyze.
e. The administrator clicks Save to save the new Log File monitor.
4. Results
The Log File monitor watches for specific entries added to the monitored log file that contain the
selected regular expression. Depending on the monitor configuration, the administrator or the user
can be notified of these conditions that you may have otherwise been unaware of until something
more serious happened.
The new Log File monitor tool the administrator created is listed in the selected group in the
monitor tree.
For details on the user interface, see "Log Analysis Tool" on page 123.
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For details on the Log File monitor, see Log File Monitor in the SiteScope Monitor Reference
Guide.

Tips/Troubleshooting
Notes and Limitations
To avoid character set problems when the SiteScope client uses a multibyte locale different from the
SiteScope server, set the value in the <SiteScope root directory>\groups\master.config file for the
_httpCharset setting to UTF-8. By default, the _httpCharset value is empty, which means that the
default server locale is used.

Database Connection Tool
This tool enables you to test and verify connectivity between SiteScope and an external ODBC or
JDBC compatible database. This diagnostic tool checks to see if:
l

The supplied database driver can be found and loaded.

l

A connection can be made to the database.

l

An optional SQL query can be run and the results displayed.

l

The database connection and resources can be closed.

This tool can be useful in verifying connection parameter values needed to set up database monitors,
database alerts, and database logging.
To access

l

l
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Select Tools context > Database Tools > Database Connection Tool (you
must have Use tools permissions)
Also available when configuring or viewing the Database Counter monitor,
Database Query monitor, DB2 JDBC monitor, or Technology Database
Integration monitor (provided you are an administrator in SiteScope, or a user
granted Use monitor tools permissions):
n

Click the Use Tool button in the new monitor dialog box when configuring a
new monitor, or in the monitor Properties tab when configuring an existing
monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.
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Important
information

l

l

Relevant
tasks
See also

If exceptions or errors occur during the test, the information is printed along with
suggested actions to help with troubleshooting.
When using the Database Connection Tool to apply properties to the Database
Query monitor or Technology Database Integration monitor, you must enter the
credential data manually (if you select a credential profile the credential data is
lost).

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Database
connection
URL

Database connection URL used when setting up the monitor. When using the Oracle
thin driver, the database connection URL has the form of:
jdbc:oracle:thin:@<server name or IP address>:<port>:
<database sid>.
Example: To connect to the ORCL database on a machine using port 1521, enter
jdbc:oracle:thin:@206.168.191.19:1521:ORCL. The colon (:) symbol must be
included as shown. For other examples of common database connection URLs, see
the "Setup Requirements and User Permissions" section for the relevant database
monitor.
Note: If you want to access the database using Windows authentication, enter
jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;
AuthenticationMethod=type2 as the connection URL, and
com.mercury.jdbc.sqlserver.SQLServerDriver as your database driver. Leave
the User Name and Password boxes empty so that the credentials of the currently
logged on Windows user (the account from which SiteScope service is running) are
used to establish a connection to the database.

Database
driver

JDBC or ODBC driver that SiteScope should use. The .jar file or library containing the
.class file must be installed in the <SiteScope root directory>\WEB-INF\lib
directory. To use a database other than jdbc:odbc:orders, you must install the
driver files into the proper directory before SiteScope can use them.
Default value: sun.jdbc.odbc.JdbcOdbcDriver
Example: For examples of common database driver strings, see the "Setup
Requirements and User Permissions" section for the relevant database monitor.
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UI Element

Description

Credentials Option for authorizing credentials if the database specified requires a name and
password for access:
l

l

Use user name and password. Select this option to manually enter user
credentials. Enter the user name and password to access the database in the
User name and Password box.
Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the database
(default option). Select the credential profile to use from the Credential profile
drop-down list, or click Add Credentials and create a new credential profile. For
details on how to perform this task, see "How to Configure Credential
Preferences" on page 563.

Query

(Optional) SQL query to run on the database. If you do not supply a SQL query string,
the driver is loaded and the connection to the database is tested but no query is run.

Result set
maximum
columns

Maximum number of columns to display in the query result set if you entered a SQL
Query.

Result set
maximum
rows

Maximum number of rows to display in the query result set if you entered a SQL
Query.

Run Tool

Runs the connection test. Connection results are displayed in the Results pane.

Save to
File

Saves the results to a file.

Default value: 10

Default value: 10

Example
The following is an example of the data returned from a successful database connection with a SQL
query (limited to one row).

serverName
10.0.0.157

group
ID
master.
config

HP SiteScope (11.31)

frameIndex

frame
ID

setting
Name

1

_config

_database
Max
Summary

settingLine

line
Chunk

chunkValue

1

1

200
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Database Information Tool
This tool enables you to view database server metadata such as product and driver version, SQL
compatibility level information, and supported SQL functions.
To access

Select Tools context > Database Tools > Database Information Tool (you
must have Use tools permissions)

Important
information

Different database drivers and user names can significantly change what
information is displayed.

See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Database
connection
URL

Database connection URL used when setting up the monitor. When using the Oracle
thin driver, the database connection URL has the form of:
jdbc:oracle:thin:@<server name or IP address>:<port>:<database sid>.
Example: To connect to the ORCL database on a machine using port 1521, enter
jdbc:oracle:thin:@206.168.191.19:1521:ORCL. The colon (:) and the (@) symbols
must be included as shown. For other examples of common database connection
URLs, see the "Setup Requirements and User Permissions" section for the relevant
database monitor.

Database
driver

JDBC or ODBC driver that SiteScope should use. The .jar file or library containing the
.class file must be installed in the <SiteScope root directory>\WEB-INF\lib
directory. To use a database other than jdbc:odbc:orders, you must install the
driver files into the proper directory before SiteScope can use them.
Default value: sun.jdbc.odbc.JdbcOdbcDriver
Example: For examples of common database driver strings, see the "Setup
Requirements and User Permissions" section for the relevant database monitor.

HP SiteScope (11.31)

Page 112 of 1395

Using SiteScope
Chapter 12: SiteScope Tools

UI Element

Description

Credentials Option for authorizing credentials if the database specified requires a name and
password for access:
Use user name and password. Select this option to manually enter user
credentials. Enter the user name and password to access the database in the
User name and Password box.

l

Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the database
(default option). Select the credential profile to use from the Credential profile
drop-down list, or click Add Credentials and create a new credential profile. For
details on how to perform this task, see "How to Configure Credential
Preferences" on page 563.

l

Run Tool

Runs the tool and displays database information. Test results are displayed in the
Results pane.

Save to
File

Saves the results to a file.

DNS Tool
This tool enables you to look up names from a Domain Name Server and show you the IP address for a
domain name. It also shows you information about the name servers for a domain.
You can use this utility to verify that your DNS server is returning the correct addresses for your own
servers. You can also use it to verify that it can look up the addresses for external domains.
To
access

Select Tools context > Network Tools > DNS Tool (you must have Use tools
permissions)

l

Also available when configuring or viewing the DNS monitor (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI
Element Description
DNS
server

IP address or host name of a DNS server. If left empty, the local DNS server is used.

Host
name to
resolve

Domain name that you want translated into an IP address.

Run
Tool

Runs the test. The tool sends the request to the DNS server entered in the DNS server
box and displays the IP address for the host name entered in the Host name to resolve
box. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Event Log Tool
This tool enables you to view portions of the Windows event log locally or on a remote server.
To access

l

l

Important
information

l

l

Relevant
tasks
See also

Select Tools context > Operating System Tools > Event Log Tool (you must
have Use tools permissions)
Also available when configuring or viewing the Microsoft Windows Event Log
monitor (provided you are an administrator in SiteScope, or a user granted Use
monitor tools permissions):
n

Click the Use Tool button in the new monitor dialog box when configuring a
new monitor, or in the monitor Properties tab when configuring an existing
monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Different database drivers and user names can significantly change what
information is displayed.
This tool is not supported on SiteScopes installed on UNIX platforms.

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI
Element
Server

Description
The server on which you want to monitor event logs. Select a server from the server list
(only those remote servers that have been configured in SiteScope are displayed).
Alternatively, click the Browse Servers button to select a server from the local domain,
or Add Remote Server to add a new server.
Default value: SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Select the server to be monitored:
l

l

Browse servers. Select a server from the drop-down list of servers visible in the
local domain.
Enter server name. If the server you want to monitor does not appear in the
Servers list because it has not been identified in the network or has not been
configured in Remote Servers, enter the IP address or name of the server to monitor.
A double slash ("\\") is automatically prefixed to any machine name supplied in the
Enter server name box.

Note: You must have domain privileges or authenticated access to the Windows
remote server. For details on how to configure a remote Windows server, see
"Configure SiteScope to Monitor Remote Windows Servers" on page 470.
Add
Remote
Server

Add and configure the remote server. For user interface details, see "New/Edit
Microsoft Windows Remote Server Dialog Box" on page 475.

Log
name

Select the type of log file you want to view:
l

Application

l

Directory Service

l

DNS

l

File Replication Service

l

Security

l

System

Default value: System
Number
Number of entries to list for this event log. The most recent entries in the log are
of events displayed first.
displayed
Default value: 10
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UI
Element

Description

Run Tool

Runs the test and refreshes the log entry listing. Log entries are displayed in the Results
pane.

Save to
File

Saves the results to a file.

FTP Tool
This tool enables you to access an FTP server and view the interaction between SiteScope (acting as
an FTP client) and the FTP server. For example, if you receive an alert from SiteScope indicating that
your FTP server is not working properly, the first step is to use this tool to help track down the problem.
To
access

l

l

Select Tools context > Web Tools > FTP Tool (you must have Use tools
permissions)
Also available when configuring or viewing the FTP monitor (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions):
n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI
Element

Description

Basic FTP Settings
FTP
server

IP address or the name of the FTP server that you want to test.
Example: 206.168.191.22 or ftp.thiscompany.com
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UI
Element

Description

File

File name to retrieve.
Example: /pub/docs/mydoc.txt

User
name

Name used to log on to the FTP server.

Password Password used to log on to the FTP server.
File
encoding

If the file content to be monitored uses an encoding that is different than the encoding
used on the server where SiteScope is running, enter the encoding to use. This may be
necessary if the code page which SiteScope is using does not support the character
sets used in the target file. This enables SiteScope to match and display the encoded
file content correctly.
Default value: windows-1252

Passive
mode

SiteScope uses a passive FTP connection. This is commonly required to access FTP
servers through a firewall.

HTTP Proxy Settings
HTTP
proxy

Proxy name or IP address if you want to use a proxy server for the FTP test.

Proxy
user
name

Name used to log into the proxy server.

Proxy
password

Password used to log into the proxy server.

Run Tool

Runs the test. Check The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Example
The following is a sample output from the FTP tool. In this case, the FTP server enabled us to log
on without a problem, indicating that the server is running and accepting requests. The failure is
caused when the server was unable to locate the file that was requested: file.txt. Correcting this
particular problem may be as easy as replacing the missing file or verifying the file location.
Received:
Sent:
Received:
Sent:
Received:
Sent:
Received:

220 public Microsoft FTP Service (Version 2.0).
USER anonymous
331 Anonymous access allowed, send identity (e-mail name) as password.
PASS anonymous
230 Anonymous user logged in.
PASV
227 Entering Passive Mode (206,168,191,1,5,183).
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Connecting to server 206.168.191.1 port 1463
Sent:
RETR file.txt
Received: 550 file.txt: The system cannot find the file specified.
Sent:
QUIT
Received: 221

LDAP Authentication Status Tool
This tool enables you to verify that a Lightweight Directory Access Protocol (LDAP) server can
authenticate a user by performing a simple authentication.
To access

Select Tools context > Database Tools > LDAP Authentication Status Tool
(you must have Use tools permissions)

l

Also available when configuring or viewing the LDAP monitor or Active Directory
Replication monitor (provided you are an administrator in SiteScope, or a user
granted Use monitor tools permissions):

l

Relevant
tasks
See also

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI
Element
Security
principal

Description
The constant that holds the name of the environment property for specifying the identity
of the principal that authenticates the caller to the service. The format of the principal
depends on the authentication scheme. If this property is unspecified, the behavior is
determined by the service provider. This should be in the format:
uid=testuser,ou=TEST,o=mydomain.com.
Note: SiteScope does not support users that contain one or more of the following
character inside the users name: equal ("="), semicolon (";"), inverted commas (""").
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UI
Element

Description

Security
The constant that holds the name of the environment property for specifying the
credential credentials of the principal for authenticating the caller to the service. The value of the
property depends on the authentication scheme. For example, it could be a hashed
password, clear-text password, key, certificate, and so on. If this property is
unspecified, the behavior is determined by the service provider.
LDAP
service
provider

The constant that holds the name of the environment property for specifying
configuration information for the service provider to use. The value of the property
should contain a URL string. This property may be specified in the environment, an
applet parameter, a system property, or a resource file. If it is not specified in any of
these sources, the default configuration is determined by the service provider.
Example: ldap://<somehost>:389

Object
query

An object query to look at a LDAP object other than the default user dn object. You
must enter a valid object query in this text box if you are using a LDAP filter. For details
about the search filter, see the description below.
Example: Enter the mail object to check for an email address associated with the dn
object entered above.

LDAP
filter

Searches LDAP using the filter criteria. The LDAP filter syntax is a logical expression in
prefix notation meaning that logical operator appears before its arguments.
Example: The item sn=Freddie means that the sn attribute must exist with the
attribute value equal to Freddie.
Multiple items can be included in the filter string by enclosing them in parentheses, such
as (sn=Freddie) and combined using logical operators such as the & (the conjunction
operator) to create logical expressions.
Example: The filter syntax (& (sn=Freddie) (mail=*)) requests LDAP entries that
have both a sn attribute of Freddie and a mail attribute.

Run Tool

Runs the test. LDAP Authentication test results are displayed in the Results pane.

Save to
File

Saves the results to a file.

Link Check Tool
This tool enables you to verify all the internal and external links on a Web page to ensure that they can
be reached. It checks the URL specific parameters, such as Web page availability, size, content type,
and average time for retrieving a page.
Each time you run the tool, results are displayed in the Results pane. You can export the results to an
Excel of PDF file.
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To access

Select Tools context > Web Tools > Link Check Tool (you must have Use
tools permissions)

l

Also available when configuring or viewing the Link Check monitor (provided you
are an administrator in SiteScope, or a user granted Use monitor tools
permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Important
information

Depending on data type, the data in the table can be sorted in ascending or
descending order, or it can be filtered by time, size, type, internal/external data, or
count.

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106

See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

Link Check Tool Panel
User interface elements are described below:
UI Element

Description

Main Settings
URL

URL that is the starting point for checking links. The link tool retrieves the page for
this URL and reads the URLs for any links on the page. It continues until it has
checked all of the links on the site. It checks links to other servers, but it does not
check all the links of those other servers.
Example: http://demo.thiscompany.com

Pause
Delay, in milliseconds, between each link check. Larger numbers lengthen the total
(milliseconds) time to check links but decrease the load on the server.
Default value: 15 milliseconds
Timeout
(seconds)

Amount of time, in seconds, that the tool should wait for a page to begin
downloading before timing-out. Once this time period passes, the URL monitor
logs an error and reports an error status.
Default value: 5 seconds
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UI Element

Description

Maximum
links

Maximum number of links this tool checks. When the maximum number of links is
reached the monitor stops and reports the results of those links that were checked.
Increase this number if you have a large site and want to check every link on the
site.
Default value: 100

Use monitor
run result
data

If selected, the tool displays link check result data from the last monitor run.
Note: This check box is available if the tool is run from the Dashboard only (it is not
available if run from the Tools panel).
Default value: Selected

Authorization Settings
Authorization
user name

User name to access the URL if required.

Authorization
password

Password to access the URL if required.

Proxy Settings
HTTP proxy

Domain name and port of an HTTP Proxy Server if a proxy server is used to
access the URL.

Proxy server
user name

Proxy server user name if the proxy server requires a name to access the URL.
Technical note: your proxy server must support Proxy-Authenticate for these
options to function.

Proxy server
password

Proxy server password if the proxy server requires a name to access the URL.

Run Tool

Runs the test and displays the results in the Results pane. Each link in the URL is
displayed on a separate line with the followed information. For details, see
"Results Panel" below.

Note: Your proxy server must support Proxy-Authenticate for these options to
function.

Results Panel
User interface elements are described below:
UI
Element

Description
Export to Excel/PDF. Enables you to save link check results by exporting them to an
Excel or PDF file.
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UI
Element

Description

Edit the filter. Enables filtering the data displayed in the table.
Operator. Click the down-arrow to select the operator (= Equals, != Not the same as, <
Less than, <= Less than or equal to, > Greater than, >= Greater than or equal to, In contains the value entered).
Apply current filter. Click the green check to apply the filter.
Clear current filter. Click the trash can to clear the filter.
Change visible columns. Enables you to select the columns you want to display in
the table.
The Status and Time columns are always displayed.
Status

The status of the link in the URL:
l

ok

l

error

If error status displayed, an error description is included.
For example, bad request, unauthorized, unable to connect, timed out
reading.
Size (K
bytes)

The size of the Web page available from the link.

Time

Response time for the link in the URL.

Est. time Estimated time in seconds.
(seconds)
Content
Type

The content type of the link in the URL.

URL

The URL of the link. Click the hyperlink to open the link page.

Source
Page

The source page of the link. Click the hyperlink to open the source page.

External

Indicates whether the link is external (yes) or internal (no) .

Count

The number of links to get to the URL page.
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Log Analysis Tool
This tool enables you to scan a log file to indicate recurring patterns in the file. Once the tool has listed
the patterns, you can have the tool create a SiteScope Log File monitor to monitor that pattern in the
log.
To access

Important
information

Select Tools context > Common Utility Tools > Log Analysis Tool (you must
have Use tools permissions)
l

l

l

If the structure of the log you want to analyze is not consistent, you cannot use
this tool.
After you have created the Log File monitor for a pattern discovered by the Log
Analysis Tool, the new monitor is listed in the monitor tree.
To tell the Log Analysis Tool where the text you want to analyze is located in the
log file, you can provide a regular expression or the number of blocks of text before
the text you want to analyze.

Limitation: The size of the log file you want to analyze should not be more than 10
MB.
Relevant
tasks

See also

l

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on
page 106

l

"How to Use the Log Analysis Tool – Use-Case Scenario" on page 107

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Log Analysis Tool Area
Folder
location on
SiteScope
Server

Enter the path of the folder, on the SiteScope server, where the log files to be
analyzed are located.

File name

Enter the name of the log file to be analyzed. To analyze several files at the same
time, copy the files to the designated folder and create a regular expression that
matches the file names of the log files to be analyzed.
Example: enter /error/ to analyze the error123.log and error345.log at the same
time.
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UI Element

Description

Use regular
expression

You can provide a regular expression or the number of blocks of text before the text
you want to analyze.
Select this option to use a regular expression to find the text you want to analyze in
the log file.

Regular
expression

Enter the regular expression you want the tool to use to find the text you want to
analyze. The regular expression must be entered between slashes (/).
This field is enabled only when you select the Use regular expression option.
Example: For examples of regular expressions, see "Examples of Regular
Expressions" on the next page.

Number of
blocks
before
message

Log files include lots of information. The Log Analysis Tool is looking for patterns in
the message (for example, the message after INFO or ERROR).
This field is not enabled when you select the Use regular expression option.
To indicate to the tool where the message to analyze starts, you must specify the
number of blocks of text (strings) separated by blank spaces that appear in each line
of the log, before the start of the message you want to analyze. Ignore the blanks in
the date if the date format includes blanks (see Date format below).
Note: Logs that do not have a consistent structure cannot be analyzed by this tool.

Order of
block where
date is
located

Enter the order of the block of text where the date is located counting from the left.
The number of the first block is 1.

Date format

Select the date format used in the log.

This field is disabled when you select the Use regular expression option.

Default format:yyyy-mm-dd HH:mm:ss,SSS
Tool
timeout (in
seconds)

Amount of time, in seconds, to wait for the Log Analysis tool to run before timing out.

Run Tool

Runs the test. A list of all recurring message patterns is displayed in the Results
box.

Default value: 30 seconds

Results Area
Create New
Log File
Monitor

Select a pattern and click the button to open the Select group dialog box where you
can select a existing group or create a new group by clicking the New Group button.
The New Log File Monitor dialog box opens, with the selected regular expression
displayed in the Content match box.

Message
Pattern

Displays a list of patterns found in the log.
The list is ordered according to the number of occurrences of the patterns.
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UI Element

Description

Number of
Displays the number of instances of each pattern.
Occurrences
The list is ordered according to the number of occurrences of the patterns.

Examples of Regular Expressions
Use the following regular expression:
\d*-\d*-\d*\s\d*.*,\d*\s\[\w.*\]\s\(\w.*\)\s\w.*\s\-\s
where d indicates a digit, w indicates a word, s indicates a space, and * indicates any character, for a
log with the following structure:
2010-11-02 11:49:02,738 [SiteScope Main Thread]
(SiteScopeHeartbeatManager.java:53) INFO - The Heartbeat Scheduler was started.
2010-11-02 11:49:02,786 [SiteScope Main Thread] (ServiceController.java:82) INFO
- Registering service: Host DNS Resolution Service
2010-11-02 11:49:02,951 [SiteScope Main Thread] (ServiceController.java:82) INFO
- Registering service: Monitor History Event Sink Service
2010-11-02 11:49:03,035 [SiteScope Main Thread] (ServiceController.java:82) INFO
- Registering service: Alert Action Execution Counter Registry Service
2010-11-02 11:49:03,035 [SiteScope Main Thread] (ServiceController.java:82)
ERROR - Connection Error while trying to connect
2010-11-02 11:49:03,037 [SiteScope Main Thread] (ServiceController.java:82) INFO
- Registering service: Alert Open Status Registry Service
2010-11-02 11:49:03,277 [SiteScope Main Thread] (SiteScopeSupport.java:655) INFO

Use the following regular expression:
\d*\s\w*\s\w*\s\**\d*\**\s\-\s
where d indicates a digit, w indicates a word, s indicates a space, and * indicates any character, for a
log with the following structure:
123 Error starts
123 Error starts
123 Error starts
Service
123 Error starts
Counter Registry
123 Error starts
Counter Registry

*****12**** - The Heartbeat Scheduler was started.
*****23**** - Registering service: Host DNS Resolution Service
*****34**** - Registering service: Monitor History Event Sink
*****45**** - Registering service: Alert Action Execution
Service
*****45**** - Registering service: Alert Action Execution
Service

Mail Round Trip Tool
This tool enables you to check a Mail Server by using the network to verify that the mail server is
accepting requests and that a message can be sent and retrieved. It does this by sending a standard
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mail message using SMTP and then retrieving that same message by using a POP user account. Each
message that SiteScope sends includes a unique key which it checks for to ensure that it does not
retrieve the wrong message and return a false OK reading.
To
access

Select Tools context > Mail Tools > Mail Round Trip Tool (you must have Use
tools permissions)

l

Also available when configuring or viewing the Mail monitor (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Basic Mail Settings
Action

Select the action to take:
l

l

l

Send and receive. Enables you to send a test message to an SMTP server
and then receive it back from the POP3 or IMAP4 server to check that the mail
server is up and running. (Default option)
Receive only. Checks the incoming POP3 or IMAP4 mail servers for a
message that was sent previously. This check is done by matching the content
of the previously-sent message.
Send only. Checks that the receiving mail server has accepted the message.

Sending
email server
(SMTP)

Host name of the SMTP mail server to which the test mail message should be
sent.

Send to
address

Mail address to which the test message should be sent.
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UI Element

Description

Receiving
protocol

Protocol used by the receiving mail server. Select one of the following options:
l

IMAP4 to use an IMAP4 mail server for receiving mail.

l

IMAP4S to use a secure IMAP4 mail server for receiving mail.

l

POP3 to use a POP3 mail server for receiving mail.

l

POP3S to use a secure POP3 mail server for receiving mail.

Default value: POP3
Receiving
email server

Host name of the POP mail server that should receive the test message.
This can be the same mail server to which the test message was sent.
Example: mail.thiscompany.com

Receiving
email server
user name

POP user account name. A test email message is sent to this account and the logs
in to the account to verify that the message was received. No other mail in the
account is touched. You can use your own personal mail account or another
existing account for this purpose.
Note: If you use an email reader that automatically retrieves and deletes
messages from the server, there is a chance that the Mail Round Trip Tool never
sees the mail message and reports an error.

Receiving
email server
password

Password, if necessary, for the test mail account.

Receive only
String of text to match against the contents of the incoming message. If the text is
content match not contained in the incoming message, the Mail Round Trip reports an error. This
is for the receiving only option (for example, Subject:MySubject). The search is
case sensitive.
HTML tags are part of a text document, so include the HTML tags if they are part of
the text you are searching for (for example, "< B> Hello< /B> World"). This
works for XML pages as well.
You can perform a regular expression match by enclosing the string in forward
slashes, with an i after the trailing slash indicating case-insensitive matching. An
example might be "/href=Doc\d+\.html/" or "/href=doc\d+\.html/i".
If you want a particular piece of text to be saved and displayed as part of the
status, use parentheses in a regular expression (for example, /Temperature:
(\d+)/ ). This returns the temperature as it appears on the page.
Advanced Mail Settings
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UI Element

Description

Timeout
(seconds)

Number of seconds to wait for a mail message to be received before timing-out.

POP check
delay
(seconds)

After SiteScope sends the test message, it immediately logs into the mail account
to verify that the message has been received. If the message has not been
received, SiteScope automatically waits 10 seconds before it checks again. You
can adjust this wait time by indicating an alternate number of seconds to wait in
this box.

Default value: 300 seconds

Default value: 10 seconds
SMTP user

User name required for SMTP authentication if the SMTP server requires
authentication before sending messages.

SMTP
password

Password for the SMTP authentication (if required).

NTLM
NTLM version (version 1 or 2) if NTLM authentication is used by the email server.
authentication
Default value: none
SMTP
SSL/TLS

Enables sending emails securely via SSL/TLS SMTP servers. When selected, the
monitor sends all mails via SSL/TLS.
Note: By default, mail is sent via port 465 of the SMTP mail server unless you
specify a different port in Custom SMTP Port (see below).
Default value: Not selected

Custom
SMTP Port

Enables sending emails via a user-specified port. If this box is left empty, the
default port for sending mail is used (465 for the SMTP mail server).

Show details

Displays details of the round trip test.

Run Tool

Runs the test. Check mail server test results are displayed in the Results pane.

Save to File

Saves the results to a file.

Network Status Tool
This tool reports the current network interface statistics and lists the active network connections. This
information can be useful to determine the health of you network interface. You can also use this tool to
track down problems, where network connections are being left open, or runaway conditions, where an
increasing number of connections are being opened without being closed.
To access
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Important
information

This tool is not supported on SiteScopes installed on UNIX platforms.

Relevant tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on
page 106

See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI
Element

Description

Run Tool

Runs the Network Status Tool and reports the network information. The data appears in
the Results pane.

Save to
File

Saves the results to a file.

News Server Tool
This tool enables you to access a News server and view the NNTP interaction between SiteScope
(acting as a news client) and the News server.
To
access

Select Tools context > Application Tools > News Server Tool (you must have
Use tools permissions)

l

Also available when configuring or viewing the News monitor (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI Element

Description

News server

Name of the News server in the format
news.sitescope.com or news.sitescope.com:7777.

News
groups

(Optional) News group names. Separate multiple news group names by commas
(",").

User name

User name if the News server specified above requires a name and password for
access.

Password

Password if the News server specified above requires a name and password for
access.

Run Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to File

Saves the results to a file.

Performance Counters Tool
This tool enables you to check performance counters on a specific machine in a Windows network. It
provides an interface to the perfex.exe executable supplied as part of SiteScope.
To access

Select Tools context > Operating System Tools > Performance Counters
Tool (you must have Use tools permissions)

l

Also available when configuring or viewing the CPU monitor, Dynamic Disk
Space monitor, Memory monitor, or Microsoft Windows Performance Counter
monitor (provided you are an administrator in SiteScope, or a user granted Use
monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Important
This tool is not supported on SiteScopes installed on UNIX platforms.
information
Relevant
tasks
See also

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI Element

Description

Performance Counters Tool Area
Server

The server where the Windows performance counter objects you want to monitor are
running. Select a server from the server list (only those remote servers that have been
configured in SiteScope are displayed). Alternatively, click the Browse Servers
button to select a server from the local domain, or Add Microsoft Windows Remote
Server to add a new server.
Default value: SiteScope Server (the server on which SiteScope is installed)
Admin User Account/ Password
Enter the administrative user name and password for the machine you want to query.
This is only necessary if you running SiteScope under an account that does not have
administrative privileges to access performance counters for the domain or workgroup
to which you are trying to connect.
If the test indicates you are required to supply a password, it means that the remote
machine requires authorization to access the performance counter registry.
Tip: If you see the message "(NO COUNTERS OBJECTS AVAILABLE using this
username and password)" in the drop down list for Counter objects and you have not
supplied a user name and password, follow one of the suggestions below to ensure
that you have access to the remote machine's registry that you are setting up:
l

l

Browse
Servers

Setup a SiteScope Windows remote connection to the remote machine that has
local administrator privileges.
Run the SiteScope service as a user that has access to your remote machines.

Opens the Select Server dialog box, enabling you to select the server to be monitored:
l

l

Browse servers. Select a server from the drop-down list of servers visible in the
local domain.
Enter server name. If the server you want to monitor does not appear in the
Servers list because it has not been identified in the network or has not been
configured in Remote Servers, enter the IP address or name of the server to
monitor. A double slash ("\\") is automatically prefixed to any machine name
supplied in the Enter server name box.

Note: You must have domain privileges or authenticated access to the Windows
remote server. For details on how to configure a remote Windows server, see
"Configure SiteScope to Monitor Remote Windows Servers" on page 470.
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UI Element

Description

Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote
you want to add (Windows or UNIX), and enter the configuration details.
For details on the Microsoft Windows Remote Servers user interface, see "New/Edit
Microsoft Windows Remote Server Dialog Box" on page 475.
For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote
Server Dialog Box" on page 495.

Counters

Select a counter object to display the individual performance counters and
corresponding values for the selected counter object.

Run Tool

Runs the tool and displays the individual Windows performance counters and
corresponding values for the selected counter object. This information appears in the
Results pane.

Save to
File

Saves the results to a file.

Results
Counter
Name

Performance counter name.

Counter
Value

Value for the performance counter object.

Counter
Description of the performance counter.
Description
PERF Type

Description of the counter type.

Ping Tool
This tool displays the round trip time along a path. It sends a packet to another location and back to the
sender. When there is a problem with the network, ping can tell you if another location can be reached.
The Ping tool does a ping from the current server to another location.
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To
access

Select Tools context > Network Tools > Ping Tool (you must have Use tools
permissions)

l

Also available when configuring or viewing the Ping monitor or Port monitor (provided
you are an administrator in SiteScope, or a user granted Use monitor tools
permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Host name to
resolve

Domain name or IP address of the host you want to ping.

Run Tool

Pings the domain name or IP address. The results of the test are displayed in
the Results pane.

Save to File

Saves the results to a file.

Example: demo.thiscompany.com or 206.168.112.53

Processes Tool
This tool displays processes running on the server where SiteScope is installed. This can be useful to
confirm that critical processes are available.
To access

Select Tools context > Operating System Tools > Processes Tool (you must have
Use tools permissions)

Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106

See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI
Element Description
Server

The server where the processes you want to monitor are running. Select a server from the
server list (only those remote servers that have been configured in SiteScope are
displayed). Alternatively, click the Browse Servers button to select a server from the
local domain, or Add Remote Server to add a new server.
Default value: SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Opens the Select Server dialog box, enabling you to select the server to be monitored:
l

l

Browse servers. Select a server from the drop-down list of servers visible in the local
domain.
Enter server name. If the server you want to monitor does not appear in the Servers
list because it has not been identified in the network or has not been configured in
Remote Servers, enter the IP address or name of the server to monitor. A double
slash ("\\") is automatically prefixed to any machine name supplied in the Enter
server name box.

Note: You must have domain privileges or authenticated access to the Windows remote
server. For details on how to configure a remote Windows server, see "Configure
SiteScope to Monitor Remote Windows Servers" on page 470.
Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote you
want to add (Windows or UNIX), and enter the configuration details.
For details on the Microsoft Windows Remote Servers user interface, see "New/Edit
Microsoft Windows Remote Server Dialog Box" on page 475.
For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote
Server Dialog Box" on page 495.

Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Regular Expression Tool
This tool enables you to perform a regular expression match.
To access

Select Tools context > Common Utility Tools > Regular Expression Tool (you
must have Use tools permissions)
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Relevant
tasks
See also

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI
Element
Text

Description
Copy and paste a portion of text containing the string or values on which you want to
perform a regular expression match into this box.
For efficiency in developing regular expressions, include all of the content that would
precede the target data or pattern that you want to match. For example, when
developing a regular expression for content matching on a Web page, use the "URL
Tool" on page 147 to retrieve the entire HTTP content including the HTTP header.

Regular
Enter a regular expression between the slashes //, to match some part of the text you
expression entered.
Note: For content with multiple lines with carriage returns and line feeds, consider
adding the s search modifier to the end of the expression to have the content treated
as a single line of text.
Example: /value:\W[\d]{2,6}/s
Run Tool

Runs the test. The results of the match test are displayed in the Results pane. If there
is a problem with your regular expression, an error message appears.

Save to
File

Saves the results to a file.

Parsed Parentheses and Matches Table
This section includes a table that displays any matches requested as retained values or back
references by pairs of parentheses inside the regular expression. If your expression does not include
parentheses, this table is empty. The columns of the parsed parentheses table are:
UI Element

Description

Parentheses Displays any patterns in the regular expression delimited by parentheses as counted
counted
from the left-hand side of the expression.
from left
Matching
text

Displays the text that matched the parenthesis marked patterns listed in the column
to the left.
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UI Element

Description

Whole
Match
Between
Slashes

This is the text area below the table. It echoes the entire content entered in the Your
Text that will be matched box. The content that matched the pattern in your regular
expression is highlighted within this content, normally using a blue font. This is useful
for showing possible problems with wildcard expressions like the .* pattern that
match too much content. It can also uncover problems of duplicate patterns within
the content that require you to add other unique patterns to your expression to match
the desired portion of the content.

Services Tool
This tool displays services running on the server where SiteScope is installed. This can be useful to
confirm that critical services are available. If Remote UNIX machines have been defined, they are
listed in a drop-down menu.
To access

Select Tools context > Operating System Tools > Services Tool (you must
have Use tools permissions)

l

Also available when configuring or viewing the Service monitor (provided you are
an administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Important
This tool is not supported on SiteScopes installed on UNIX platforms.
information
Relevant
tasks
See also

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI
Element Description
Server

The server where the services you want to monitor are running. Select a server from the
server list (only those remote servers that have been configured in SiteScope appear).
Alternatively, click the Browse Servers button to select a server from the local domain,
or Add Remote Server to add a new server.
Default value:SiteScope Server (the server on which SiteScope is installed)

Browse
Servers

Opens the Select Server dialog box, enabling you to select the server to be monitored:
l

l

Browse servers. Select a server from the drop-down list of servers visible in the local
domain.
Enter server name. If the server you want to monitor does not appear in the Servers
list because it has not been identified in the network or has not been configured in
Remote Servers, enter the IP address or name of the server to monitor. A double
slash ("\\") is automatically prefixed to any machine name supplied in the Enter
server name box.

Note: You must have domain privileges or authenticated access to the Windows remote
server. For details on how to configure a remote Windows server, see "Configure
SiteScope to Monitor Remote Windows Servers" on page 470.
Add
Remote
Server

Opens the Add Remote Server dialog box, enabling you to select the type of remote you
want to add (Windows or UNIX), and enter the configuration details.
For details on the Microsoft Windows Remote Servers user interface, see "New/Edit
Microsoft Windows Remote Server Dialog Box" on page 475.
For details on the UNIX Remote Servers user interface, see "New/Edit UNIX Remote
Server Dialog Box" on page 495.

Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

SiteScope Log Grabber Tool
This tool enables you to collect the SiteScope log and configuration files. In addition, it can be used to
gather the following data:
l

Thread dump of SiteScope

l

Results of system commands (such as "netstat", "dir", and so on)
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l

Information about JVM

l

Windows event log entries

You can use the default configuration file (default.loggrabber.conf.xml) or create your own
configuration files, for example, to create a scheduled backup of the SiteScope configuration.
Note: You can use the SiteScope Log Grabber tool manually by running the LogGrabber.bat
script (LogGrabber.sh for UNIX) from the <SiteScope root
directory>\tools\LogGrabberSiteScope folder. In this mode, the configuration file should be
used as a parameter: LogGrabber.bat full.loggrabber.conf.xml.
You can use this tool from either the Script alert (for example, to collect data for troubleshooting if CPU
utilization is greater than 90%, or if a critical error is found in the log), or from the Script monitor (to
collect regular data using the scheduler). The name of the configuration file should be transferred in the
script as a parameter.
To access

Select Tools context > Common Utility Tools > SiteScopeLog Grabber Tool
(you must have Use tools permissions)

Important
Since the SiteScope configuration can contain valuable data such as encoded
information passwords, make sure that the Download SiteScope Log Grabber run results
permission (in Preferences > User Management Preferences > Permissions >
Other) is not granted to untrusted users. For details on user permissions, see
"Permissions" on page 744.
Relevant
tasks

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106

See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

SiteScope Log Grabber Tool Area
Configuration
File

Select the configuration file to use.

Folders

Select the folders and/or files to be checked for runtime changes.

Run Tool

Runs the tool. The results are displayed in the Results box.

Default value: default.loggrabber.conf.xml

Results
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UI Element

Description

Download file

Enables downloading a file containing the last run results.
Note: You must have Download Log Grabber run results permissions to
download the run results file.

File

Lists all the result files (in .zip format). Click to open a file and download the results
for a selected file.

Size

The size of the results file.

Last Modified

Date and time that the results file was last modified.
Export to Excel/PDF. Enables you to save collected log file results by exporting
them to an Excel or PDF file.

SNMP Browser Tool
This tool provides details of an SNMP agent's MIB. It can be used to verify the connection properties of
an SNMP agent and to gain more information about the SNMP agent's counters.
To access

Select Tools context > SNMP Tools > SNMP Browser Tool (you must have
Use tools permissions)

l

Also available when configuring or viewing the Cisco Works monitor, F5 Big-IP
monitor, or SNMP by MIB monitor (provided you are an administrator in
SiteScope, or a user granted Use monitor tools permissions):

l

Important
information

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

l

l

Relevant
tasks

This tool operates by traversing all of the OIDs on a given agent and then using the
MIB information in the <SiteScope root directory>\templates.mib directory to
display the OID, counter names, type, and values in a table.
If MIBs are not listed in the MIB file drop-down box after adding MIB files to the
templates.mib directory when creating an SNMP by MIB monitor, see the
Troubleshooting MIB Compilation steps in SNMP by MIB Monitor in the
SiteScope Monitor Reference Guide.

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
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See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

SNMP Settings
Server

Host name or IP address of the device on which the SNMP agent is running that
you want to monitor.

Port

Port on which the SNMP agent is listening.
Default value: 161

MIB file

MIB that you want to view. If you select All MIBs, then all data obtained during the
MIB traversal appears. If you select a specific MIB, then only the OIDs within that
MIB appear. This list of MIBs can be updated or extended by placing new MIB files
in the <SiteScope root directory>\templates.mib directory.
Default value: All MIBs

Starting OID

Use this option when selecting counters for this monitor. When the monitor
attempts to retrieve the SNMP agent's tree, it starts with the OID value that is
entered here. The default value is 1, which is commonly used and applicable to
most applications. Edit this box only when attempting to retrieve values from an
application that does not handle OIDs starting with 1. If the default value of 1 did
not enable retrieving any counters, then you may have to enter a different value.

SNMP Connection Settings
Timeout
(seconds)

Total time, in seconds, that SiteScope should wait for all SNMP requests
(including retries) to complete.
Default value: 5 seconds

Number of
retries

Number of times each SNMP GET request should be retried before SiteScope
considers the request to have failed.
Default value: 1

Community

Community string to use when connecting to the SNMP agent for version 1 or 2
connections.
Default value: public

SNMP version

Version of SNMP which the tool should use when connecting to the agent.
SiteScope supports SNMP version 1, version 2, and version 3. Selecting V3
enables you to enter version 3 settings in the fields below.
Default value: V1
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UI Element

Description

Authentication Authentication algorithm to use for a version 3 connection.
algorithm
Default value: MD5
Note: This field is available only if SNMP V3 is selected.
User name

User name for a version 3 connection.
Note: This field is available only if SNMP V3 is selected.

Password

Password to use for authentication in a version 3 connection.
Note: This field is available only if SNMP V3 is selected.

Privacy
algorithm

The privacy algorithm used for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES). Leave blank if you do not want privacy.
Default value: DES
Note: This field is available only if SNMP V3 is selected.

Privacy
password

Password to use for DES privacy encryption in a version 3 connection. Leave
blank if you do not want privacy.
Note: This field is available only if SNMP V3 is selected.

Context name

Context Name to use for this connection. This is applicable for SNMP V3 only.
Note: This field is available only if SNMP V3 is selected.

Context
engine ID

Hexidecimal string representing the Context Engine ID to use for this connection.
This is applicable for SNMP V3 only.
Note: This field is available only if SNMP V3 is selected.

Run Tool

Runs the test. The results of the test appear in the Results pane.

Save to File

Saves the results to a file.

SNMP Tool
This tool lets you query a SNMP Management Information Base (MIB) and retrieve a set of OIDs.
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To
access

Select Tools context > SNMP Tools > SNMP Tool (you must have Use tools
permissions)

l

Also available when configuring or viewing the SNMP monitor (provided you are an
administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Host name

IP address of the server that hosts the SNMP MIB you want to query.

Port

Port to use when requesting data from the SNMP agent.
Default value: 161
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UI Element

Description

Object ID

Select the Object ID setting:
l

Commonly used values. Select the Object ID mnemonic from the drop-down
list. (This is the default option with system.sysDescr set as the default value.)
Enter the index of the SNMP object. Values for an OID come as either scalar
or indexed (array or table) values.
n

For a scalar OID, the index value must be set to 0.

n

For an indexed or table value, you must provide the index (a positive
integer) to the element that contains the value you want. The index value for
Commonly used values is set to ifSpecific.ifInOctets.
Default value: 0

l

Other values. Enter the Object Identifier (OID) for the SNMP value you want
to retrieve. The OID specifies which value should be retrieved from the device.
Example: 1.3.6.1.2.1.4.3

Tip: To troubleshooting basic connectivity to the device and to confirm that the
SNMP agent is active, select the system.sysDescr object from the drop-down list
if other objects cannot be found.
Note: SiteScope supports SNMP versions 1.0, 2.0, and 3.0.
If you receive the error message error - noSuchName, it means SiteScope was
able to contact the device but the OID given is not known by the device. You must
provide an OID that is valid to the device to obtain a value.
If you have a MIB file for the device you want to monitor, you can copy the *.mib
(or *.my) file into the <SiteScope root directory>\templates.mib subdirectory
and use the MIB Help utility to compile the MIB and browse the OIDs for the
device. To use the MIB Helper tool, select Tools > MIB Browser and enter the
connection details. After copying a new MIB file to SiteScope, you must restart
SiteScope. Select the MIB file to browse using the drop-down list. Click the
browse button to show the OIDs from the selected MIB file. A tree that represents
the chosen MIB on the specified server appears. You can browse that tree to find
the OID that you want to monitor.
It is not necessary to browse a MIB file with the SiteScope MIB Helper to monitor
a device. The MIB Helper is provided simply as a tool to help you discover OIDs
available on a device, but it is not the only tool available. You can find other
alternative tools on the Web (for example, MG-SOFT or iReasoning).
Number of
records to get
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UI Element

Description

SNMP Connection Settings
Timeout
(seconds)

Amount of time, in seconds, that SiteScope should wait for an SNMP request.

Number of
retries

Number of SNMP request retries before SiteScope considers the monitor to have
failed.

Default value: 5 seconds

Default value: 1
Community

Community string for the SNMP device.
The Community string provides a level of security for a SNMP device. Most
devices use public as a community string. However, the device you are going to
monitor may require a different Community string to access it.
If you try to monitor an SNMP agent through specific community, you must make
sure that the SNMP agent is familiar with that community. For example, if you try
to monitor a Windows 2003 server through public community, you must make sure
that the SNMP agent has this community configured. Otherwise, the monitor
cannot connect to the agent.
Default value: public
Note: The field is valid only for version 1 or 2 connections.

SNMP version

SNMP version used by the SNMP host you want to monitor. SiteScope supports
SNMP version 1, version 2, and version 3.
Default value: V1

Authentication Authentication algorithm used for SNMP V3. You can select MD5, SHA, or None.
algorithm
Note: This field is available only if SNMP V3 is selected.
User name

User name to be used for authentication if you are using SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Password

Password to be used for authentication if you are using SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Privacy
algorithm

The privacy algorithm used for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES).
Default value: DES
Note: This field is available only if SNMP V3 is selected.
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UI Element

Description

Privacy
Password

The privacy password used for authentication for SNMP version 3. Leave blank if
you do not want privacy.
Note: This field is available only if SNMP V3 is selected.

Context Name

The context name of SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Context
Engine ID

The context engine ID of SNMP version 3.

Run Tool

Runs the test. The results of the test are displayed in the Results pane.

Note: This field is available only if SNMP V3 is selected.

Results
Save to File

Saves the results to a file.

SNMP Trap Tool
This tool enables you to view SNMP Traps received by SiteScope's SNMP listener. The tool is only
enabled if you have already created one or more SNMP Trap monitors. Creating an SNMP Trap Monitor
enables the SiteScope SNMP Trap Log.
To access

Select Tools context > SNMP Tools > SNMP Trap Tool (you must have Use
tools permissions).

l

Also available when configuring or viewing the SNMP Trap monitor or Technology
SNMP Trap Integration monitor (provided you are an administrator in SiteScope,
or a user granted Use monitor tools permissions).

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Important
The message Receiving SNMP Traps is not active appears at the top of the tool
information page if the SNMP Trap Log is not currently active.
Relevant
tasks
See also

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI
Element Description
Content
match

Optional text string or regular expression to be used to match entries in the SNMP Trap
Log. Content matching can be done for data from any of the columns of the log such as
OID, Community, Agent, and so on.
The SNMP traps in the SiteScope SNMP Trap Log appear in the SNMP Trap Log table.
The number of traps matching the search criteria appears in the SNMP Trap Log table title
displayed in the lower part of the page.

Traps to Number of SNMP Traps to list. The number of traps is calculated, based on average trap
show
length. If the trap text is longer or shorter than average, the number of traps shown can be
different from the selected value. The most recent SNMP Traps received by SiteScope
appear first.
Default value: 10
Run
Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to
File

Saves the results to a file.

Trace Route Tool
This tool shows you the network path between two locations and how long it takes to get to each hop in
the path. When there is a problem with the network, traceroute can often be used to narrow down where
the problem is occurring. This tool performs a traceroute from your server to another location.
You can use this utility to verify connectivity of a host and to determine how the host is connected to
the Internet. You can also determine the path taken from your server to the specified host. This helps
you to determine where packet loss may be occurring when you attempt to connect to hosts elsewhere
on the Internet.
To access

Select Tools context > Network Tools > Trace Route Tool (you must have Use
tools permissions)

Important
You can use this tool to perform a traceroute on Windows platforms only. For UNIX,
information you must stop the SiteScope process, add the path of the traceroute utility (for
example /usr/sbin/traceroute) to the Traceroute command box in Infrastructure
Preferences, and then restart SiteScope.
Relevant
tasks
See also

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54
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User interface elements are described below:
UI Element

Description

Host name to resolve

Domain name or IP address of the other location to resolve.
Example: demo.thiscompany.com or 206.168.112.53

Run Tool

Runs the test. The results of the test are displayed in the Results pane.

Save to File

Saves the results to a file.

URL Tool
This tool enables you to retrieve an item from a Web server. The URL specifies the server to contact
and the item to return. Because SiteScope displays the content of the requested URL, this tool also
functions to check URL Content. You can use this utility to verify that a given URL can be accessed
from a Web server. You can also use it to see how long it takes for the page to be returned.
To
access

Select Tools context > Web Tools > URL Tool (you must have Use tools
permissions)

l

Also available when configuring or viewing the URL monitor, URL Content monitor, or
Oracle 9i Application Server monitor (provided you are an administrator in SiteScope,
or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Main Settings
URL

URL that you want to test.
Example: http://demo.company.com
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UI Element

Description

Match
content

String of text to check for in the returned page or frame set. If the text is not
contained in the page, the content match fails. The search is case sensitive. HTML
tags are part of a text document, so you must include the HTML tags if they are part
of the text you are searching for (for example, "< B> Hello< /B> World").

Match
content for
error

String of text to check for in the returned page or frame set. If the text is contained
in the page, the test indicates an error condition. The search is case sensitive.

Timeout
(seconds)

Amount of time, in seconds, to wait for a page to complete downloading before
timing-out. Once this time period passes, the URL monitor logs an error and reports
an error status.
If you have selected the Retrieve images or Retrieve frames option, SiteScope
waits for these items to be retrieved before considering the page to be fully
downloaded.
Default value: 60 seconds

Retries

Number of times (between 0-10) that SiteScope should retry the request if a
recoverable error was encountered. A timeout of the request is a recoverable error.
Default value: 0

HTTP Settings
Request
headers

Header request lines sent by the HTTP client to the server. Headers should be
linebreak separated. The standard list of HTTP1.1 request headers can be found in
http://www.w3.org/Protocols/rfc2616/rfc2616-sec14.html#sec14.
Note: Although this field is optional, some Web pages behave unexpectedly when
the request header is missing (such as performing endless redirects, providing
wrong content, and so forth).

URL content
encoding

URL content encoding is the encoding in which the content is written. The encoding
can be found in any of the following:
l

l

l

HTTP headers: Content-Type: text/html; charset=UTF-8
HTML meta tag <meta http-equiv="Content-Type" content="text/html;
charset=US-ASCII">
XML: <?xml version="1.0" encoding="ISO-8859-1"?>

Select the encoding type from the drop down list.
Examples: UTF-8, UTF-16, US-ASCII, ISO-8859-1
Default value: Encoding from server response
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UI Element

Description

POST data

If the URL is for a POST request, enter the post variables, one per line as
name=value pairs.
This option is used to verify that a form is working correctly by performing the same
request that occurs when a user submits a form. See also the Match content item
for a way to verify that the correct form response was received.
If this item is blank, a GET request is performed.
The POST data can be used to send cookie data. To send cookies with the request,
use the format Set-cookie: cookieName=cookieValue.
To change the content type of a post, use the format
Content-Type: application/my-format.
To substitute values in the POST data, add a line to the master.config file, such
as:
_private=_name=mysecret _value=rosebud
_private=_name=mypassword _privateValue=sesame
and then use the following form in the POST data:
s|username=$private-mysecret$|
s|password=$private-mypassword$|
and SiteScope substitutes the values from the master.config into the POST data.

POST data
encoding

Determines if the POST data is encoded. Select from the following options:
l

Error if
redirected

Use content type. Encodes the POST data by the content type header. If the
header equals urlencoded then encode, otherwise do not encode.

l

Force URL encoding. Always encodes the post data.

l

Do not force URL encoding. Does not encode the POST data.

Generates an error (and notifies you) if a URL is redirected.
Default value: Not selected

HTTP version HTTP version for SiteScope to use for style request headers (HTTP version 1.1 or
1.0).
Default value: 1.1
Retrieve
images

SiteScope lists the images such as graphics, logos, and so on linked to the URL
being requested.
Default value: Not selected
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UI Element

Description

Retrieve
frames

SiteScope displays the HTML code of a frame linked to the URL being requested.

Use WinInet

WinInet is used as an alternative HTTP client for this monitor.

Default value: Not selected

Select this option to use WinInet instead of Java (Apache) when:
l

l

The Apache HTTP client does not support a specific technology required to
access the server you are monitoring. For example, Kerberos authentication is
not supported by the Apache library, and is supported by WinInet. WinInet also
supports trusted client-side certificates such as SSLv3, while Apache does not.
You tried running this monitor and the Apache server returned errors. Using
WinInet may solve these errors.

Default value: Not selected
Note: WinInet functionality is available on Windows versions of SiteScope only.
For troubleshooting WinInet functionality, see "URL Tool" on page 147.
Proxy Settings
HTTP proxy

Address or domain name and port of an HTTP Proxy Server used to access the
URL.

Proxy server
user name

Name used to log on to the proxy server.

Proxy server
password

Password used to log on to the proxy server.

Proxy NTLM
V2

Proxy uses NTLM (Windows NT LAN Manager) version 2 to authenticate user
logon.

Authentication Settings
Credentials

Option for authorizing credentials if the URL specified requires a name and
password for access:
l

l
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Use user name and password. Select this option to manually enter user
credentials. Enter the user name and password to access the URL in the User
name and Password box.
Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the URL (default
option). Select the credential profile to use from the Credential profile dropdown list, or click Add Credentials and create a new credential profile. For
details on how to perform this task, see "Credential Preferences" on page 561.
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UI Element

Description

Pre-emptive
authorization

Option for sending authorization credentials if SiteScope requests the target URL:
l

l

Use global preference. Select to have SiteScope use the setting specified in
the Pre-emptive authorization section of the General Preferences page.
Authenticate first request. Select to send the user name and password on the
first request SiteScope makes for the target URL.
Note: If the URL does not require a user name and password, this option may
cause the URL to fail.

l

Authenticate if requested. Select to send the user name and password on the
second request if the server requests a user name and password.
Note: If the URL does not require a user name and password, this option may be
used.

All options use the User name and Password entered for this monitor instance. If
these are not specified for the individual monitor, the Default authentication user
name and Default authentication password specified in the Main section of the
General Preferences page are used, if they have been specified.
Note: Pre-emptive authorization does not control if the user name and password
should be sent, or which user name and password should be sent.
Client side
certificate

The certificate file, if you need to use a client side certificate to access the target
URL. Normally, this is a .pfx (.p12) type certificate, which usually requires a
password. You enter the password for the certificate in the Client side certificate
password box.
Note: Client side certificate files must be copied into the <SiteScope root
directory>\templates.certificates directory.

Client side
certificate
password

Password if you are using a client side certificate and that certificate requires a
password.

Authorization Domain for Windows NT LAN Manager (NTLM) authorization if required to access
NTLM
the URL.
domain
Accept
untrusted
certificates
for HTTPS

If you are accessing a target URL using Secure HTTP (HTTPS) and SiteScope
does not have the required server certificates, you can either select this option or
import the related certificates. For details on importing server certificates, see SSL
Connectivity in "URL Monitor" in the SiteScope Monitor Reference Guide.

Accept
invalid
certificates
for HTTPS

Select this option if you are accessing a target URL using Secure HTTP (HTTPS)
and SiteScope has invalid server certificates. This may happen, for example, if the
current date is not in the date ranges specified in the certificate chain.
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UI Element

Description

NTLM V2

Select if the URL you are accessing requires authentication using NTLM version 2.

Preferred
protocols

Select the preferred protocol option to use for the handshake process.
l

l

Any supported protocol. Enables any supported protocol to be used for the
handshake process (this is the default setting). Since this option uses SSL
protocols, SSL must be enabled on the Web server to use this option.
Prefer SSL to TLS. Select if the URL you are accessing cannot handle
authentication using TLS. This enables encrypted handshake messages to be
sent using SSL.
Note: This option is ignored (if selected) when SiteScope is running in FIPS
140-2 mode, since authentication using TLS is mandatory with FIPS 140-2. For
details on FIPS 140-2, see the Running SiteScope Securely section of the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).

l

Prefer TLS to SSL. Select if you prefer to use TLS for encrypting handshake
messages or if the URL you are accessing cannot handle authentication using
SSL. TLS is the latest cryptographic protocol. TLS 1.0, 1.1, and 1.2 are
supported.

Run Tool

Runs the test. The results of the test are displayed in the Results pane. The results
include statistics on the URL retrieval as well as a text representation of the URL
content.

Save to File

Saves the results to a file.

Web Service Tool
This tool enables you to check Simple Object Access Protocol (SOAP) enabled Web services for
availability, stability, or to see what an actual SOAP response looks like. It is also useful for diagnosing
a Web service request failure, or for picking out match strings for use with a specific Web Service
Monitor. The Web Service Test sends a SOAP request to the server and checks the HTTP response
codes to verify that the service is responding. The actual SOAP response appears, but no further
verification occurs on this returned message.
SOAP is a way for a program running under one operating system to communicate with another
program running under the same or different operating system (such as a Windows 2003 program
talking to a Linux-based program). SOAP uses the Hypertext Transfer Protocol (HTTP) and Extensible
Markup Language (XML) for information exchange with services in a distributed environment.
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To access

Select Tools context > Web Tools > Web Service Tool (you must have Use
tools permissions)

l

Also available when configuring or viewing the Web Service monitor (provided you
are an administrator in SiteScope, or a user granted Use monitor tools
permissions):

l

Important
information

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

l

l

Relevant
tasks
See also

The following specification features are currently supported: WSDL 1.2, SOAP
1.1, Simple and Complex Types based on XML Schema 2001, SOAP binding with
the HTTP(s) protocol only. SOAP with Attachments is not supported.
SOAP and WSDL technologies are evolving. As a result, some WSDL documents
may not parse accurately and some SOAP requests may not interact with all Web
service providers.

"How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page
106
l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

WSDL Settings
WSDL
location

Select the WSDL location:
l

l

File. Select the WSDL file to be used. This list reflects the files found by
searching on <SiteScope root directory>\templates.wsdl/*.wsdl. Your
WSDL files must have an extension of .wsdl.
URL. Enter the URL of the Web service to be tested.

Get Data

Retrieves and analyzes the specified WSDL file for method arguments. The Result
page displays the measurements available.

Service name

Name of the service to be invoked. During initial setup, this is extracted from the
WSDL file.
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UI Element

Description

Port name

Name of the port to be invoked. During initial setup, this is extracted from the
WSDL file.

Method name

Name of the method to be invoked. During initial setup, this is extracted from the
WSDL file.

Method name
space

The XML name space for the method in the SOAP request. During initial setup this
value is extracted from the WSDL file.

Schema
name space

The XML name space for the schema in the SOAP request. During initial setup, this
value is extracted from the WSDL file.

SOAP action

The SOAP action URL in the header of the SOAP request to the Web Service.
During initial setup, this is extracted from the WSDL file.

Name of
arguments

Arguments to the method specified above and their types. Specify simple type
parameters in the format
parm-name(parm-type) = value, where the <param-name> and <param-type>
must match the service method specifications of its WSDL file exactly. The
<value> must agree with the <param-type>, otherwise the request fails. Strings
with embedded spaces should be enclosed in double quotes (" "). Each parameter
must be on a separate line by adding a carriage return at the end of each value.
Example: stockSymbol (string) = MERQ
numShares (int) = 10
A complex type parameter must be represented as one long string (line breaks are
for readability purposes only):
stocksymbol[COMPLEX] =
<stocksymbol xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:fw100="urn:ws-stock"
xsi:type="fw100:getQuote">
<ticker xsi:type="xsd:string">MERQ
</ticker>
</stocksymbol>
Note: SiteScope does not perform any validation on your input parameter lists, so
make sure that the complex type values are valid and well-formed XML strings. Do
not add any carriage returns within a complex type parameter—only at the end.
If the Web service method does not take any parameters, the text box should be
left empty.

Use userdefined
SOAP XML

HP SiteScope (11.31)

Use the XML in the User SOAP XML box. This enables you to use XML that has
been manually defined.

Page 154 of 1395

Using SiteScope
Chapter 12: SiteScope Tools

UI Element

Description

User SOAP
XML

Displays the SOAP XML for the selected Web service extracted from the WSDL
file. You can make changes to the default XML, and use the manually defined XML
in this box by selecting the Use User-Defined SOAP XML check box.

Main Settings
Request's
schema

The request schema. Currently SiteScope only supports SOAP.

Timeout
(seconds)

Total time, in seconds, that SiteScope should wait for the Web service request to
complete.
Default value: 30 seconds

Use .NET
SOAP

Select if the Web service is based on Microsoft .NET.

Content
match

Text to check for in the returned page or frameset. If the text is not contained in the
page, the tool displays the message no match on content.
HTML tags are part of a text document, so include the HTML tags if they are part of
the text you are searching for. This works for XML pages as well.
Example: "< B> Hello< /B> World"
You may also perform a regular expression match by enclosing the string in forward
slashes, with an i after the trailing slash to indicate that the search is not case
sensitive.
Example: /href=Doc\d+\.html/ or /href=doc\d+\.html/i
If you want a particular piece of text to be saved and displayed as part of the status,
use parentheses in a Perl regular expression.
Example: /Temperature: (\d+)
Note: The search is case sensitive.

HTTP Settings
Web service
server URL

Displays the URL of the Web service server to be checked.

HTTP user
agent

HTTP user agent for the SOAP request.

HTTP content Content type of the HTTP request.
type
Proxy Settings
HTTP proxy
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UI Element

Description

Proxy server
user name

User name if the proxy server requires a name and password to access the URL.

Proxy server
password

Password if the proxy server requires a name and password to access the URL.

Note: Your proxy server must support Proxy-Authentication for these options to
function.

Note: Your proxy server must support Proxy-Authentication for these options to
function.

Login Settings
NTLM
domain

NTLM domain if the Web service requires NTLM / Challenge Response
authentication as part of your credentials (as well as a user name and password
below).

Authorization User name if the Web service requires a user name and password for access
user name
(Basic, Digest, or NTLM authentication), enter the user name.
Alternately, you can leave this entry blank and enter the user name in the Default
authentication user name box on the General Preferences page. You use this
alternate method to define common authentication credentials.
Authorization Password if the Web service requires a user name and password for access
password
(Basic, Digest or NTLM authentication), type the password.
Alternately, you can leave this entry blank and enter the password in the Default
authentication password box on the General Preferences page. You use this
alternate method to define common authentication credentials.
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UI Element

Description

Run Tool

Runs the test. The results of the test are displayed in the Results pane.
The possible status values returned by the test are:

Save to File

l

OK

l

unknown host name

l

unable to reach server

l

unable to connect to server

l

timed out reading

l

content match error

l

document moved

l

unauthorized

l

forbidden

l

not found

l

proxy authentication required

l

server error

l

not implemented

l

server busy

Saves the results to a file.

XSL Transformation Tool
This tool enables you to test a user-defined XSL file that can be used to transform an XML file or output.
This might be a file from a Web application that contains performance metrics data. The use of an XSL
transformation may be necessary to process XML data into an acceptable format for use by the
browsable XML Monitor.
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To
access

Select Tools context > Common Utility Tools > XSL Transformation Tool (you
must have Use tools permissions)

l

Also available when configuring or viewing the XML Metrics monitor (provided you are
an administrator in SiteScope, or a user granted Use monitor tools permissions):

l

n

Click the Use Tool button in the new monitor dialog box when configuring a new
monitor, or in the monitor Properties tab when configuring an existing monitor.

n

To run the test tool for an existing monitor, click the Tools
button in the
SiteScope Dashboard toolbar. This opens and runs the tool with the monitor's
existing data as its input, and displays the test results in the Results pane.

Relevant "How to Use SiteScope Tools for Configuring or Troubleshooting a Monitor" on page 106
tasks
See also

l

"SiteScope Tools" on page 105

l

"Tools Menu" on page 54

User interface elements are described below:
UI Element

Description

Main Settings
XML URL

URL of the XML file that is the input for the transformation.

XSL file

Path to the XSL file you want to test. This path must be relative to
SiteScope root folder.
Example: <SiteScope root
directory>\templates.applications\XmlApp1.xsl

Authentication Settings
Authorization user
name

User name needed to access the content if access to the target XML file
requires authentication.

Authorization
password

Password needed to access the content if access to the target XML file
requires authentication.

Proxy server

Proxy server address if you are using a proxy server to access the target
XML content.

Proxy server user
name/password

User name and password required to use the proxy if you are using a
proxy to access the target XML content.

Run Tool

Runs the test. The results of the test appear in the Results pane.

Save to File

Saves the results to a file.
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SiteScope public APIs enable you to run various scenarios automatically without using the SiteScope
user interface. For example, you can:
l

Import, export and deploy templates.

l

Enable, disable or delete monitors, groups or alerts.

SiteScope provides "SOAP-based APIs" below and "REST APIs" on page 170 to perform these tasks.
For details on the APIs included with SiteScope, see HP SiteScope Public API Reference Guide
(available from <SiteScope installation>\sisdocs\pdfs\SiteScope_API_Reference.pdf).

SOAP-based APIs
SOAP-based APIs can be invoked by any known Web Services framework such as Axis or WSIF, or
by any SOAP client application. This provides a powerful set of tools for managing and automating
large environments and implementing complex business logics.

Learn About
SiteScope SOAP-based APIs Overview
SiteScope SOAP-based APIs can be divided in to two core categories: Configuration API and Data
Acquisition API.
l

l

Configuration API is responsible for template management, deployment and monitors running. It
also provides powerful management tools for downtime and decommission.
The Data Acquisition API enables you to retrieve historical monitor run data and VMware
reconciliation topology data.

SiteScope API examples are available from the
<SiteScope installation directory>\examples\integrations\api directory.
API examples include the following content:
l

lib folder - All jars required to start using SiteScope API and build you own client application

l

bin folder - The scripts (*.bin, *.sh) execute provided examples

l

src folder - Code examples show how to use SiteScope APIs
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l

doc folder - Java documentation (in JavaDoc format) of all available public SiteScope APIs
methods and data structures.

API Reference Guides
For details on the APIs included with SiteScope, see the following guides:
l

l

HP SiteScope API Reference. Contains the complete list of SiteScope API packages, including
exceptions, snapshots, and error codes. To open the guide, extract the contents of the javadoc.zip
file available from <SiteScope installation>\examples\integrations\api\doc and double-click the
index.html file.
HP SiteScope Public API Reference Guide. Contains detailed information on the SiteScope
Configuration and Data Acquisition API packages, and provides a use-case scenario on configuring
SiteScope APIs calls. This guide is available from <SiteScope
installation>\sisdocs\pdfs\SiteScope_API_Reference.pdf.

SiteScope Configuration APIs
SiteScope configuration APIs provide services for working with SiteScope templates, groups,
monitors, alerts, remote servers, server health, search/filter tags, and configuration. The following
actions are supported using the SiteScope configuration API:
SiteScope
Object
Templates

Action
l

l

l

Template management (create/delete template, create/delete template container,
import/export template, import templates and override them if they already exist
in the given path, get snapshot of all templates)
Template deployment (monitor, group, alert, remote server creation), deploy a
single template that gets back details of the deployment
Publish template changes (groups, monitors, alerts, remote server); update
templates deployed without a root (updates only a single monitor with new
variables)

Groups

Enable/disable groups, delete groups, search groups by specific criteria

Monitors

Enable/disable monitors, delete monitors, run monitors, run tools, search monitors
by specific criteria

Alerts

Enable/disable alerts

Remote
Servers

Create remote server (on Windows and UNIX), delete remote server preferences

Status

Get SiteScope server status (active monitoring, booting) statistics
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SiteScope
Object
Tags

Configuration

Action
Create tags, add tag values, edit tag description, edit tag values (name, description),
delete tags
l

Get SiteScope configuration

l

Import an SSH key file to a remote SiteScope machine

For task details, see "How to Use SiteScope Configuration API Calls" on the next page.
For a user-case scenario, see "How to Use SiteScope API Calls - Use-Case Scenario" on the next
page.
For details on the SiteScope Configuration APIs included with SiteScope, see HP SiteScope Public
API Reference Guide (available from <SiteScope installation>\sisdocs\pdfs\SiteScope_API_
Reference.pdf).

SiteScope Data Acquisition APIs
The following data acquisition actions are supported using the SiteScope API:
SiteScope Object

Action

getData

Retrieves historical metrics data for monitor runs matching the
specified query parameters.

getDataWithTopology

Retrieves historical metrics data for monitor runs matching the
specified query parameters and VMware reconciliation
topology collected by VMware monitors currently running on
SiteScope.
l

l

getMonitorTypesWithMetricNames

Supports given time interval, credentials, and filter (monitor
type(s), name, etc…)
Returns XML similar to the XML sent with generic data
integration that contains the (historical) metrics data

Scans all the monitors in this SiteScope instance for which the
user has view permissions, and returns a list of their types
together with the metric names per monitor type. The list of
metric names is merged from all the monitors of each type
(repeated occurrences are removed). Where
enabledMonitorsOnly is true, it scans enabled monitors only.
Where enabledMonitorsOnly is false, it scans all monitors
(enabled/disabled) in the SiteScope instance.

The data for these APIs is taken from the SiteScope daily log.
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Note: The data acquisition API is intended for querying limited amount of historical data (up to 20
MB). For consumption of near real-time SiteScope data, use Generic Data Integration. For details,
see "Generic Data Integration Preferences" on page 684.
For task details, see "How to Use the Data Acquisition API" on the next page.
For details on the SiteScope Data Acquisition APIs included with SiteScope, see HP SiteScope Public
API Reference Guide (available from <SiteScope installation>\sisdocs\pdfs\SiteScope_API_
Reference.pdf).

Tasks
How to Use SiteScope Configuration API Calls
This task describes how to use API calls which enable you to run various scenarios automatically
without using the SiteScope user interface.
Tip: For a use-case scenario on using API calls, see "How to Use SiteScope API Calls - UseCase Scenario" below.
1. Create your own Java project.
2. Add all SiteScope client jars into the project (these jars are located in
<SiteScope installation>\examples\integrations\api\lib).
3. Connect to SiteScope using the SiteScopeCommandLineUtil.java file located in
<SiteScope installation>\examples\integrations\api\src. In the createConnection method
section, enter the required login information:
// SiteScope connection properties creation
SiteScopeConnectionPropertiesForExternal props = new
SiteScopeConnectionPropertiesForExternal(hostName, port, login, password,
isUseSSL);
// SiteScope API Connector creation
SiteScopeExternalAPIConnector siteScopeExternalAPIConnector = new
SiteScopeExternalAPIConnector();
// Get the API instance using connection properties
IAPIConfiguration apiConfiguration =
siteScopeExternalAPIConnector.getAPIConfiguration(props);

4. Run the required API methods. For example: apiConfiguration.getConfigurationSnapshotEx
(login, password);

How to Use SiteScope API Calls - Use-Case Scenario
SiteScope APIs enable you to run various scenarios automatically without using the SiteScope user
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interface. For example, you can create and deploy templates, enable and disable monitors, groups, and
alerts, and delete monitors, groups, and remote servers.
1. Initial set up
Install SiteScope.
Create a template container using the createTemplateContainer API method (done only once).
2. Create or import a template
Create a template in the SiteScope user interface, or import it using the importTemplate API
method.
3. Deploy a template and run monitors
Deploy the template for a remote server using the
deploySingleTemplateWithConnectToServer API method.
Use the getConfigurationSnapshotEx API method to get all deployed monitors, groups, and
alerts.
Use the runExistingMonitorEx API method to run deployed monitors.
4. Downtime
Use the disableAlertEx, disableMonitorEx, or disableGroupFullPathEx API method to disable
an alert, monitor, or group for a downtime period.
5. Decommission
Use the deleteGroupEx, deleteMonitorEx, or deleteRemote API method to delete a group,
monitor, or remote server.

How to Use the Data Acquisition API
1. When running in SiteScope standalone mode (when SiteScope is not connected to a BSM server),
select the Enable topology collection in standalone deployment check box in Preferences >
Infrastructure Preferences > General Settings. This enables SiteScope to collect topology in
the background, and not when request is made. You must restart SiteScope for this change to
take effect.
2. Optionally, you can modify the following data acquisition settings (you must restart SiteScope for
these changes to take effect):
n

Topology resolving frequency (minutes). Amount of time, in minutes, to wait between
checking the topology of the server being monitored. This applies to non-dynamic monitors
only; for dynamic monitors, frequency can be configured per instance in the user interface. If
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this time is exceeded during a monitor run, when running in SiteScope standalone mode the
topology is saved in SiteScope; when SiteScope is integrated with BSM the topology is
created again in BSM's RTSM. The default value is 60 minutes.
n

Data acquisition API single request size (MB). The maximum memory size, in megabytes,
allocated for fetching data from the daily log in a single data acquisition API request. Loading
too much data from the daily log to process a request might have a negative performance
impact on SiteScope, because the memory allocated for the data is out of SiteScope’s
available memory pool. The default value is 20 MB.

n

Data acquisition API total request size (MB). The maximum memory size, in megabytes,
allocated for fetching data from the daily log in all simultaneous data acquisition API requests.
Loading too much data from the daily log to process requests might have a negative
performance impact on SiteScope, because the memory allocated for the data is out of
SiteScope’s available memory pool. The default value is 100 MB.

n

To include deleted monitors in data acquisition API results, select the Include deleted
monitors in data acquisition API results option in Preferences > Infrastructure
Preferences > General Settings.

3. When specifying monitor types for which to get data in the data acquisition API, you must use the
"topaz name" of the monitor.
The following lists the monitor topaz name to use when specifying a monitor type query:
Monitor Display Name

Monitor Topaz Name

Active Directory Replication
(created from the Active Directory Solution
template only)

Active Directory Replication

Amazon Web Services

AmazonCloudWatch

Apache Server

Apache

BAC Integration Configuration

BAC Integration Configuration

BAC Integration Statistics

BAC Integration Statistics

BroadVision Application Server

BroadVision

CheckPoint

CheckPoint

Cisco Works

Cisco Works

Citrix

Citrix MetaFrame Presentation Server

ColdFusion Server

MS ColdFusion Server

COM+ Server

COM+
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Monitor Display Name

Monitor Topaz Name

Composite

Composite

Connection Statistics Monitor

Connection Statistics Monitor

CPU

CPU

Custom

Custom Monitor

Custom Database

Custom Database Monitor

Custom Log File

Custom Log Monitor

Custom WMI

Custom WMI Monitor

Database Counter

DatabaseCounter

Database Query

SQL Query

DB2 JDBC

DB28x

DHCP

DHCP

Directory

Directory

DNS

DNS

Dynamic Disk Space

Dynamic Disk Space

Dynamic Monitoring Statistics

Dynamic Monitoring Statistics

eBusiness Transaction

Ebus Chain Monitor

F5 Big-IP

F5

File

File

Formula Composite

Bandwidth

FTP

FTP Monitor

Generic Hypervisor

Generic Hypervisor

HAProxy

HAProxy Monitor

Health of SiteScope Server

Health Server Load Monitor

HP iLO

HP iLO

HP NonStop Event Log

NonStop Event Log

HP NonStop Resources

NonStop Resources
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Monitor Display Name

Monitor Topaz Name

HP Service Manager

HP Incidents

IPMI

IPMI

JMX

JMX Monitor

KVM

KVM

LDAP

LDAP Monitor

License Usage Monitor

License Usage

Link Check

Link Monitor

Log Event Checker

Log Event Health Monitor

Log File

Log Monitor

Mail

E-mail Monitor

MAPI

mapimon

Memcached Statistics Monitor

Memcached Stats

Memory

Memory

Microsoft A/V Archiving Server

Microsoft Lync Server 2010 Archiving monitor

Microsoft A/V Conferencing Server

Microsoft Lync Server 2010 A/V Conferencing
monitor

Microsoft ASP Server

MS Active Server Pages

Microsoft Director Server

Microsoft Lync Server 2010 Director monitor

Microsoft Edge Server

Microsoft Lync Server 2010 Edge monitor

Microsoft Exchange 2007 Message Traffic
Microsoft Exchange 2007 Message Traffic
Microsoft Exchange

Microsoft Exchange 2007

Microsoft Exchange Base

Microsoft Exchange Base

Microsoft Front End Server

Microsoft Lync Server 2010 Front End monitor

Microsoft Hyper-V

HyperVMonitor

Microsoft IIS Server

MS IIS Server

Microsoft Mediation Server

Microsoft Lync Server 2010 Mediation monitor
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Monitor Display Name

Monitor Topaz Name

Microsoft Monitoring and CDR Server

Microsoft Lync Server 2010 Monitoring and
CDR monitor

Microsoft Registrar Server

Microsoft Lync Server 2010 Registrar monitor

Microsoft SQL Server

MS SQL Server

Microsoft Windows Event Log

Microsoft Windows Event Log

Microsoft Windows Media Server

MS Winodws Media Server

Microsoft Windows Performance Counter

Browsable NT Counters

Microsoft Windows Performance Counter

Windows Performance

Microsoft Windows Resources

Windows Resources

Microsoft Windows Services State

Windows Services State

Monitor Load Checker

Monitor Load Monitor

Multi Log

Multi Log

NetScout Event

NetScout Event

Network Bandwidth

Network Bandwidth Monitor

News

NNTP

Oracle 10g Application Server

Oracle10gAS

Oracle Database

Oracle

Oracle 9i Application Server

Oracle9iAS HTTP Server

Ping

Ping

Port

Port

Radius

Radius

Real Media Server

Real Media Server

SAP CCMS

CCMS SAP

SAP CCMS Alert

SAP CCMS Alerts

SAP Java Web Application Server

SAP Java Web Application Server

SAP Performance

SAP Performance
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Monitor Display Name

Monitor Topaz Name

SAP Work Processes

SAP Work Processes

Script

Script

Service

Service

Siebel Application Server

Siebel Application Server

Siebel Log

Siebel Log

Siebel Web Server

Siebel Web Server

SNMP

SNMP

SNMP by MIB

SNMP by MIB Monitor

SNMP Trap

SNMP Trap

Solaris Zones

Solaris Zones

SSL Certificates State in Health

SSL Certificates Status

SunONE Web Server

SunONE

Sybase

Sybase

Syslog

Syslog Monitor

Technology Database Integration

EMS Database

Technology Log Integration

EMS Log Monitor

Tuxedo

Tuxedo

UDDI Server

UDDI Server

UNIX Resources

Unix Resources

URL

URL Monitor

URL Content

URL Content

URL List

URL List

URL Sequence

URL Sequence Monitor

VMware Datastore

VMware Datastore Monitor

VMware Host CPU

VMware Host CPU Monitor

VMware Host Memory

VMware Host Memory Monitor
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Monitor Display Name

Monitor Topaz Name

VMware Host Network

VMware Host Network Monitor

VMware Host State

VMware Host State Monitor

VMware Host Storage

VMware Host Storage Monitor

VMware Performance

VMware

Web Script

Web Script

Web Server

Web Server

Web Service

Technology Web Service

Web Service

Web Service

WebLogic Application Server

BEA WebLogic 6.0

WebSphere Application Server

WebSphere

WebSphere MQ Status

MQStatusMonitor

WebSphere Performance Servlet

WebSphereServlet

XML Metrics

XML Metrics

Tips/Troubleshooting
SiteScope API Calls - Notes and Limitations
l

l

l

l

Most API methods require a SiteScope user and password as part of the method invocation. Before
using these methods, change the Access controlled property in Preferences > Infrastructure
Preferences > Custom Settings to true. The user and password can be in plain text or encrypted.
To encrypt a string, use <SiteScope installation>\tools\AutoDeployment\encrypt_
password.bat.
All API methods that do not have a user name and password will be deprecated in future versions of
SiteScope. All analogous API methods with user and password authentication have been renamed
and now have an Ex suffix (for example, enableGroupEx) to avoid the same method names being
used with different parameters.
The access level of the SiteScope user affects the behavior of the methods. For example, when
calling getConfigurationSnapshot and getFullConfigurationSnapshot, the returned maps
contain only those entities that the user is privileged to access.
To use applications created with previous versions of this API, set _accessControlled=false and

HP SiteScope (11.31)

Page 169 of 1395

Using SiteScope
Chapter 13: SiteScope Public APIs

use the deprecated APIs. These deprecated methods will not be supported in a future version and
you will have to port your application to use the secure versions of the API methods.
l

l

l

l

l

Attempting to use the deprecated forms of the methods when _accessControlled=true or to use
the secure methods when _accessControlled=false results in an exception.
The .bat files (.sh files for UNIX) are examples only and not intended as production scripts. You can
change the scripts to fit your requirements.
Special characters are not supported in the parameter values.
The disable alerts API is not supported when the Disable alerts temporarily permission is not
selected in Preferences > User Management Preferences > Permissions > Alerts.
Some API operations can be disabled on the server. This supports a read-only mode, such that the
configuration cannot be changed remotely using the API.

REST APIs
SiteScope supports a set of REST APIs that enable running of various scenarios automatically without
using the SiteScope user interface. SiteScope REST APIs can be invoked using any known REST
CLient framework or tool.
Common characteristics of SiteScope REST APIs are as follows:
l

l

l

All SiteScope REST endpoints are accessed by sending an HTTP request to the SiteScope server.
The server response contains either the data requested, or the status indicator, or both.
All endpoints are located in a hierarchy starting from http(s)://<<SiteScope_Host>>:<<SiteScope_
Port>>/api/
All endpoints may return different HTTP status codes. The most common status codes and their
description are as follows:
Status
Code

Description

200

Success with the response containing requested data.

204

Success response where no data is expected to be returned.

400

Bad request; A message with details of the error condition is returned along with
the response.

500

Error condition on the server along with a message indicating the details of the
error condition.
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l

All SiteScope REST endpoints allow authentication through the following ways:
n HTTP basic authentication by including the user name and password in the request header.
n

Client certificate authentication by sending a certificate along with the request when SiteScope
APIs are configured for client certificate authentication as per hardening instructions available in
the SiteScope Deployment Guide.

SiteScope Configuration APIs
SiteScope configuration APIs provide services for working with SiteScope templates, groups,
monitors, and alerts. The following actions are supported using the SiteScope configuration API:
SiteScope
Object
Action
Templates

l

l

l

Template management (create/delete template, create/delete template container,
import/export template, import templates and override them if they already exist in
the given path, get snapshot of all templates)
Template deployment (monitor, group, alert, remote server creation), deploy a single
template that gets back details of the deployment
Publish template changes (groups, monitors, alerts, remote server); update
templates deployed without a root (updates only a single monitor with new
variables)

Groups

Enable/disable groups, delete groups, search groups by specific criteria

Monitors

Enable/disable monitors, delete monitors, run monitors, run tools, search monitors by
specific criteria

Alerts

Enable/disable alerts

For details on the SiteScope Configuration APIs included with SiteScope, see HP SiteScope Public
API Reference Guide (available from <SiteScope installation>\sisdocs\pdfs\SiteScope_API_
Reference.pdf).
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SiteScope provides free downloadable apps that enable you to keep track of your monitored IT
infrastructure while you are away from your computer. SiteScope mobile apps connect your company's
people and information by giving your team access to SiteScope through the use of smartphone
devices.
Tip: You can view a guided and narrated demonstration for using the SiteScope Mobile App on
YouTube: http://www.youtube.com/watch?v=MuLAmO322nI.

Learn About
SiteScope Features Supported on Mobile Apps
SiteScope mobile apps enable your SiteScope staff to have 24/7 mobile access while out of the office
so that they can:
l

l

l

l

l

Receive email notifications about problems related to your organization's monitored applications
and take corrective action (rerun the monitors, view monitor report, acknowledge alerts,
enable/disable associated alerts, view acknowledgment logs).
Review group and monitor states to verify availability issues ahead of time, so that you can solve
them before they affect your business.
Use the search to gain access to monitor statistics, and perform actions on the search results to
mitigate issues (view monitor details, enable/disable monitors, run monitors, set alert actions).
Create ad hoc reports for monitors, groups, and alerts that display how the servers and applications
have performed over time.
Add selected monitors and groups to a favorites list.

For more details on using SiteScope on a mobile device, refer to the help supplied with the SiteScope
mobile app. For additional information on how to use the features that are available on the SiteScope
mobile app, see the relevant topic in the SiteScope Help.
Tip: You can also access SiteScope data on supported iPad and Android tablets using the
"Unified Console" on page 1061. This is an HTML-based user interface that contains a lightweight
Event Console for managing the event lifecycle, Multi-View for viewing the real-time performance
status of everything being monitored in a single view, and Manage view which extends template
deployment and the ability to update monitor configuration to non-admin users granted the
necessary permissions. Note that the Unified Console is not supported on the SiteScope mobile
app.
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Supported Devices
SiteScope mobile apps are supported on the following devices:
l

l

iPhone, iPad, or iPod touch. The SiteScope iPhone mobile app is available from the Apple store
(http://itunes.apple.com/us/app/hp-sitescope/id410294629?mt=8#).
Android phone or tablet. The SiteScope Android mobile app is available from Google Play Store
(https://play.google.com/store/apps/details?id=com.hpe.sitescope.mobile.android_app).
Note: You must uninstall the currently installed app, and then download the latest app from the URL
provided. Since configurations cannot be migrated across from the old app to the new app, you need
to reconfigure the new app before you can start using it.

Check the SiteScope mobile app download page for the list of operating system versions that are
supported.

Supported SiteScope Versions
SiteScope mobile apps are supported for the following SiteScope versions:
l

SiteScope 10.13 (with patch SIS_108 for Linux or SIS_110 for Windows) or later.

l

SiteScope 11.01 (with patch SIS_00114 for Linux or SIS_00116 for Windows) or later.

l

SiteScope 11.10 or later.

Tasks
How to Configure Alerts to be Sent to a Mobile Device
Use the MobileAppMail template in the <SiteScope root directory>\ templates.mail folder, as this
template contains a link that can be used to open the app from your email.

How to Include HTML Content in Mail Templates Sent to a Mobile Device
When an email alert is triggered and sent to a mobile device, HTML content is not displayed as an
active link.
For the HTML to be converted to an active link in the email, set the value for the _
defaultMailAlertContentType property to =text/html in the <SiteScope
root directory>\groups\master.config file, and then restart SiteScope.

How to Use SiteScope in Secure Mode on a Mobile Device
In Preferences > Infrastructure Preferences > Custom Settings, change the Access controlled
property to true. Otherwise, the SiteScope user name and password are ignored.
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Tips/Troubleshooting
Notes and Limitations
l

l

l

l

l

l

Make sure the mobile device is set to the correct local time.
Monitors that are disabled temporarily (regardless of whether they were disabled in the SiteScope
user interface or from a mobile device) appear in the monitor details summary according to server
time.
When deleting a SiteScope user account from your mobile device, any monitors or groups that are
saved to favorites under that account are also removed.
When changing SiteScope user account settings (for example, changing a profile's protocol from
http to https, or changing the SiteScope port), all monitors related to that profile disappear from the
favorites list.
If you encounter insufficient memory resource messages when generating a report, free up memory
on the mobile device (for example, by closing running apps). You can increase or decrease the
memory required by SiteScope reports by moving the Minimum memory for reports (MB) slider
in the iPhone or Android Settings under HP SiteScope.
If you are unable to connect the mobile app to SiteScope using a 3G signal but you can connect
using a wireless network (WiFi), try changing the SiteScope port to 80, as the service provider
might be blocking some ports (such as the default SiteScope port, 8080).
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SiteScope makes use of regular expressions to match text content. Several SiteScope monitors
enable for content matching on the text returned from a monitor's request or action. This chapter
includes information on using regular expressions to match text content in SiteScope monitors.
Regular expressions is a name given to a text parsing tool that was developed for use with scripting
languages such as Awk and Perl, as well as several programming environments, such as Emacs,
Visual C++, and Java. Regular expressions themselves are not a programming language. They do,
however, make use of many special combinations of characters and symbols that often make them
more difficult to interpret than some programming languages. The many different combinations of these
special characters, known as metacharacters, make regular expressions a very powerful and flexible
tool for parsing and isolating specific text within a larger body of text.
Including a regular expression in the Match content text box of a monitor instructs SiteScope to parse
the text returned to the monitor when it is run and look for content that satisfies the pattern defined by
the regular expression. This document presents an overview of the syntax and metacharacters used in
regular expressions for use in matching content for SiteScope monitors.

Define a Regular Expression
The element of a match content expression in SiteScope is the forward slash (/) character. Entries in
the Match content text box of a SiteScope monitor must start and end with a forward slash to be
recognized as regular expressions. For example, entering the expression /website/ into the Match
content box of a monitor instructs SiteScope to search the text content received by the monitor for the
literal text string: website. If a match is not found, the monitor reports an error status. When a match is
found, the monitor reports a good status, as long as all other monitor status threshold conditions are
also met. If you enter text or other characters into the Match content box without delimiting the entry
with forward slashes, the entry is either ignored or reported as a content match error by SiteScope.
Adding parentheses ( ) within the forward slashes surrounding the regular expression is another very
useful function for regular expressions in SiteScope. The parentheses are used to create a "back
reference." As a back reference, SiteScope retains what was matched between the parentheses and
displays the text in the Status field of the monitor detail page. This is very useful for troubleshooting
match content. This is also a way to pass a matched value from one monitor to another, or from one
step of a URL Sequence Monitor to the next step of the same transaction. Parentheses are also used
to limit alternations, as discussed below.
Generally, it is best to use an iterative approach when building regular expressions for content matching
within SiteScope. The following are some general steps and guidelines for developing regular
expressions for content matches:
l

Create a regular expression using literal characters to match a single sample of the data you want to
monitor. For example, /value: 1022.5/.
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l

l

l

Iteratively replace literal characters with character classes and metacharacters to generalize the
literal into a pattern. For example, the literal in the example above could be changed to:
/value:\s\d\d\d\d\.\d/ to match any four digits, a decimal point, and one more digit.
Consider that the pattern of the data you want to match may vary. Adjust your pattern to match
expected or possible variations in the target data. Continuing with the example used above, the
expression /value:\s\d\d\d\d\.\d/ might become /value:\s[\d]{1, 8}\.[\d]{1,2}/. This
pattern enables variation in the number of digits to the left of the decimal point and the number of
digits to the right of the decimal point. It expects that there is a decimal point. See the following
sections for more information about the character classes used here.
Consider that the literal string or pattern you want to match may appear more than once in the
content. Identify unique content that precedes the content you want to match, and add regular
expression patterns to make sure that the expression matches that unique content before it tries to
match the content you are trying to monitor. In the example used here, the pattern may match the
first of several entries that have a similar /value: numbers/ pattern. Adding a literal to the pattern,
that matches some static content that delimits the particular data, can be used to be sure the match
is made for the target data. For example, if the data you want to match is preceded by the text Open
Queries, this literal can be added to the pattern, along with a pattern for any intervening content:
/Open Queries[\s\W]{1,5} value:\s[\d]{1, 8}\.[\d]{1,2}/.

Match String Literals
Finding and matching an exact or literal string is the simplest form of pattern matching with regular
expressions. In matching literals, regular expressions behave much as they do in search/replace in
word processing applications. The example above matched the text Web site. The regular expression
/Buy Now/ succeeds if the text returned to the monitor contains the characters Buy Now, including the
space, in that order.
Note that regular expressions are, by default, case sensitive and literal. This means that the content
must match the expression in case and order, including non-alphanumeric characters. For example, a
regular expression of /Website/, without any modifiers, succeeds only if the content contains the
string Website exactly but fails even if the content on the page is website, WEBSITE, or Web site. (In
the last case the match fails because there is space between the two words but not in the regular
expression.)
There are cases where you may want to literally match certain non-alphanumeric characters which are
special "reserved" metacharacters used in regular expressions. Some of these metacharacters may
conflict with important literals that you are trying to match with your regular expression. For example,
the period or dot symbol (.), the asterisk (*), the dollar sign ($), and back slash (\) have special
meanings within regular expressions. Because one of these characters may be a key part of a
particular text pattern you are looking for, you must "escape" these characters in your regular
expression so that the regular expression processing treats them as literal characters rather than
interpreting them as special metacharacters. To force any character to be interpreted as a literal rather
than a metacharacter, add a back slash in front of that character.
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Example - Matching a Literal String
For example, if you wanted to find the string 4.99 on a Web page you might create a regular expression
of /4.99/. While this matches the string 4.99, it would also match strings like 4599 and 4Q99 because
of the special meaning of the period character. To have the regular expression interpret the period as a
literal, escape the period with a forward slash as follows: /4\.99/. You can add the back slash escape
character in front of any character to force the regular expression processing to interpret the character
following the back slash as a literal. In general, use this syntax whenever you want to match any
punctuation mark or other non-alphanumeric character.

Using Alternation
Alternation enables you to construct either/or matches where you know that one of two or more strings
should appear in the content. The alternation character is the vertical pipe symbol ("|").
The vertical pipe is used to separate the alternate strings in the expression. For example, the regular
expression /(e-mail|e-mail|contact us)/ succeeds if the content contains any one of the three
strings separated by the vertical pipes. The parentheses are used here to delimit alternations. In this
example, there are no patterns outside of the alternation that must be matched. In contrast, a regular
expression might be written as /(e-mail|e-mail|contact) us/. In this case, the match succeeds
only when any of the three alternates enclosed in the parentheses is followed immediately by a single
white space and the word us. This is more restrictive than the previous example, but also shows how
the parentheses limit the alternation to the three words contained inside them. The match fails even if
one or more of the alternates are found but the word "us" is not the next word.

Match Patterns with Metacharacters
Often you may not know the exact text you need to match, or the text pattern may vary from one
session or from one day to another. Regular expressions have a number of special metacharacters
used to define patterns and match whole categories of characters. While matching literal alphanumeric
characters seems trivial, part of the power of regular expressions is the ability to match nonalphanumeric characters as well. Because of this, it is important to keep in mind that your regular
expressions need to account for the presence of non-alphanumeric characters in the content you are
searching. This means that characters such as periods, commas, hyphens, quotation marks, and even
white spaces, must be considered when constructing regular expressions.
This section contains the following topics:
l

"Metacharacters Used in Regular Expressions" on the next page

l

"Defining Character Classes" on the next page

l

"Using Quantifiers" on page 179
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Metacharacters Used in Regular Expressions
Metacharacter Description
\s

Matches generic white space (that is, the Spacebar key). This metacharacter is
particularly useful when combined with a quantifier to match varying numbers of
white space positions that may occur between words that you are looking to match.

\S

Matches characters that are not white space. Note that the \S is capitalized as
opposed to the small \s which is used to match white space.

.

This is the period or dot character. Generally, it matches all characters. Because
SiteScope considers the dot as a form of character class on its own, do not include
it inside the square brackets of a character class.

\n

Matches the linefeed or newline character.

\r

Matches the carriage return character.

\w

Matches non-white space word characters, the same as what is matched by
character class [A-Za-z0-9_]. It is important to note that the \w metacharacter
matches the underscore character but not other punctuation marks such as
hyphens, commas, periods, and so forth.

\W

Matches characters other than those matched by \w (lowercase). This is
particularly useful for matching punctuation marks and non-alphabetic characters,
such as ~!@#$%^&*()+={[}]:; and including the linefeed character, carriage return,
and white space. It does not match the underscore character, which is considered
a word constituent matched by \w.

\d

Matches digits only. This is equivalent to the [0-9] character class.

\D

Matches non-numeric characters (what \d does not match) plus other characters.
Similar to \W but also matches on alphabetic characters. In SiteScope, this
generally matches everything, including multiple lines, until it encounters a digit.

\b

Requires that the match have a word boundary (usually a white space) at the
position indicated by the \b.

\B

Requires that the match not have a word boundary at the position indicated.

Defining Character Classes
An important and very useful regular expression construct is the character class. Character classes
provide a set of characters that may be found in a particular position within a regular expression.
Character classes may be used to define a range of characters to match a single position or, with the
addition of a quantifier, may be used to universally match multiple characters and even complete lines
of text.
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You form character classes by enclosing any combination of characters and metacharacters in square
brackets: [ ]. Character classes create an "any-or-all-of-these" group of characters that may be
matched. Unlike literals and metacharacters outside character classes, the physical sequence of
characters and metacharacters within a character class has no effect on the search or match
sequence. For example, the class [ABC0123abc] matches the same content as [0123abcABC].
The hyphen is used to further streamline character classes to indicate a range of letters or numbers. For
example, the class [0-9] includes all digits from zero to nine inclusive. The class [a-z] includes all
lowercase letters from a to z. You can also create more restrictive classes with the hyphen, such as [etE-T], to match upper or lowercase letters from E to T, or [0-5] to match digits from zero to five only.
You can use the caret character (^) within a character class as a negation or to exclude certain
characters from a content match.
Example Character Classes
Example Description
[a-zA-Z]

This matches any alphabetic character, both upper case and lowercase, from the letter a
to the letter z. To match more than one character, append a quantifier after the character
class as described below.

[0-9]

This matches any digit from 0 to 9. To match more than one digit, append a quantifier
after the character class as described below.

[0-9A-Za- This matches any alphanumeric character, excluding the underscore.
z]
[\w\s]

This matches any alphanumeric character, any white space, or both.

Using Quantifiers
Another set of metacharacters used in regular expressions provides character counting options. This
adds a great deal of power and flexibility in content matching. Quantifiers are appended after the
metacharacters and character classes described above to specify against which positions the
preceding match character or metacharacter should be matched. For example, in the regular
expression /(contact|about)\s+us/, the metacharacter \s matches on a white space. The plus sign
quantifier following the \s means that there must be at least one white space between the words
contact (or about) and us.
The following table describes the quantifiers available for use in regular expressions. The Quantifier
applies to the single character immediately preceding it. When used with character classes, the
quantifier is placed outside the closing square bracket of the character class. For example: [a-z]+ or
[0-9]*.
Quantifier

Description

?

The question mark means the preceding character or character class may appear once,
but is optional and not required to appear in the position indicated.
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Quantifier

Description

*

The asterisk requires that any number of the preceding character or character class
appear in the designated position. This includes zero or more matches.
Note: Care must be used in combining this quantifier with the dot (.) metacharacter or a
character class including the \W metacharacter, as these are likely to "grab" more
content than anticipated and cause the regular expression engine to use up all of the
available CPU time on the SiteScope server.

+

The plus sign requires that the preceding character or character class appear at least
once.

{min,max} Using curly braces creates a quantifier range. The range enumerator digits are
separated by commas. This construct requires that the preceding character or
character class appear at least as many times as specified by the min enumerator up
to but no more than the value of the max enumerator. The match succeeds as long as
there are at least as many matches as specified by the min enumerator. However, the
matching continues up to the number of times specified by the max enumerator or until
no more matches are found.
Match content in SiteScope is run against the entire HTTP response, including the HTTP header,
which is not normally viewable by using the browser. The HTTP header usually contains several lines
of text including words coupled with sequences of numbers. This may cause failure of some otherwise
simple content matching on short sets of numbers and letters. To avoid this, identify a unique sequence
of characters near the text you are trying to match and include them as literals, where applicable, in the
regular expression.

Search Mode Modifiers
Regular expressions used in SiteScope may include optional modifiers outside of the slashes used to
delimit the expression. Modifiers after the ending slash affect the way the matching is performed. For
example, regular expression of /website/i with the i search modifier added makes the match content
search insensitive to upper and lowercase letters. This would match either website, Website,
WEBSite, or even WEBSITE.
With the exception of the i modifier, some metacharacters and character classes can override search
mode modifiers. In particular, the dot (.) and the \W metacharacters can override the m and s modifiers,
matching content across multiple lines despite the modifier.
More than one modifier can be added by concatenating them together after the closing slash of the
regular expression. For example: /matchpattern/ic combines both the i and c modifiers.
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Regular Expression Match Mode Modifiers
Mode
Modifier Description
/i

Ignore case mode. This makes the search insensitive to upper case and lowercase
letters. This is a useful option especially when searching for matches in the text content
of Web pages.

/c

The matched pattern may NOT appear anywhere in content that is being searched. This
is a "complement" match, returning an error if the pattern IS found, and succeeding if the
pattern is NOT found.

/m

Match across multiple lines WITHOUT ignoring intervening carriage returns and
linefeeds. With this modifier you may still need to account for possible linefeeds and
carriage returns with a character class such as [\w\W]* or [\s\S\n\r]*. The .* does not
match carriage returns or linefeed characters with this modifier.

/s

Consider the content as being on a single line, ignoring intervening carriage returns and
linefeed characters. With this modifier, both the [\w\W]* character class and the .* pattern
match across linefeeds and carriage returns.

Retain Content Match Values
Some monitors, like the URL Monitor and URL Sequence Monitor, have a content match value that is
logged and can be used to set error status thresholds. Another purpose of the parentheses /(match
pattern)/ used in regular expression syntax is to determine which text is retained for the Content Match
Value. You use this function to use content match values directly as thresholds for determining the
error threshold of a URL monitor or URL Sequence monitor.
For example, if the content match expression was:
/Copyright (\d*)/
and the content returned to the monitor by the URL request included the string:
... Copyright 2007 by HP
then the match is made and the retained content match value would be:
2007
Under the error-if option at the bottom of the monitor set up page, you could then change the error-if
condition from the default of status != 200 to content match, then specify the relational operator as !=,
and then specify the value 2008. This sets the error threshold for this monitor so that whenever the year
in the string Copyright is other than 2008, the monitor reports an error. This mechanism could be used
to watch for unauthorized content changes on Web pages.
Checking a Web page for links to other URLs can be an important part of constructing URL Sequence
Monitors. The following regular expression can be used to match the URL text of a link on a Web page:
/a href="?([:\/\w\s\d\.]*)"?/i
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This expression matches the href="protocol://path/URLname.htm" for many URLs. The question mark
modifiers enable the quotation marks around the HREF= attribute to be optional. The i modifier enables
the match pattern to be case-insensitive.
Retained or remembered values from content matches can be referenced and used as input for
subsequent steps in a URL Sequence Monitor. See the Match content section of the URL Sequence
Monitor for the syntax used for Retaining and Passing Values Between Sequence Steps.

SiteScope Date Variables
SiteScope uses specially defined variables to create expressions that match the current date or time.
These variables can be used in content match fields to find date-coded content. The General Date
Variables are useful for matching portions of date formats. The Language/Country Specific Date
Variables enable you to automatically extend the language used for month names and weekday names
to specific countries, based on ISO codes.
This section contains the following topics:
l

"General Date Variables" below

l

"Language/Country Specific Date Variables" on the next page

l

"Special Substitution for Monitor URL or File Path" on page 184

General Date Variables
The following table lists the general variables:
Variable

Range of Values

$hour$

0 - 23

$minute$

0 - 59

$month$

1 - 12

$day$

1 - 31

$year$

1000 - 9999

$shortYear$

00 - 99

$weekdayName$

Sun - Sat

$fullWeekdayName$

Sunday - Saturday

$0hour$

00 - 23

$0minute$

00 - 59
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Variable

Range of Values

$0day$

01 - 31 (two-digit day format)

$0month$

01 - 12 (two-digit month format)

$monthName$

Jan - Dec (three-letter month format in English)

$fullMonthName$

January - December

$ticks$

milliseconds since midnight, January 1, 1970

For example, if the content match search expression was defined as:
/Updated on $0month$\/$0day$\/$shortYear$/
and the content returned by the request includes the string:
Updated on 06/01/98
then the expression would match when the monitor is run on June 1, 1998. The match fails if the
content returned does not contain a string matching the current system date or if the date format is
different than the format specified.
If you want the time to be before or after the current time, you can add a $offsetMinutes=mmmm$ to
the expression, and this offsets the current time by mmmm minutes (negative numbers are permitted
for going backwards in time) before doing the substitutions.
For example, if the current day is June 1, 2007, and the search expression is:
/$offsetMinutes=1440$Updated on $0month$\/$0day$\/$shortYear$/
the content string that would match would be:
Updated on 06/02/07
Note: The date is one day ahead of the system date.

Language/Country Specific Date Variables
The following table lists the SiteScope special variables for use with international day and month name
matching. The characters LL and CC are placeholders for two-letter ISO 639 language code characters
and two-letter ISO 3166 country code characters (see the notes below the table for more details).
Information about these codes is available from many publicly available web sites.
Variable

Range of Values

$weekdayName_LL_
CC$

Abbreviated weekday names for the language (LL) and country (CC)
specified (see notes below).

$fullWeekdayName_
LL_CC$

Full weekday names for the language (LL) and country (CC) specified.
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Variable

Range of Values

$monthName_LL_
CC$

Abbreviated month names for the language (LL) and country (CC) specified.

$fullMonthName_LL_
CC$

Full month names for the language (LL) and country (CC) specified.

CC - an uppercase 2-character ISO-3166 country code. Examples are: DE for Germany, FR for France,
CN for China, JP for Japan, BR for Brazil.
LL - a lowercase 2-character ISO-639 language code. Examples are: de for German, fr for French, zh
for Chinese, ja for Japanese, pt for Portuguese.
For example, if the content match expression was defined as:
/$fullWeekdayName_fr_FR$/i
and the content returned by the request includes the string:
mercredi
then this expression would match when the monitor was run on Wednesday.
If you are not concerned with the country-specific language variations, it is possible to use any of the
above variables without including the country code. For example:
/$fullWeekdayName_fr$/
could be used to match the same content as /$fullWeekdayName_fr_FR$/.

Special Substitution for Monitor URL or File Path
SiteScope Date Variables are useful for matching content as part of a regular expression. The date
variables can also be used as a special substitution to dynamically create URLs or file paths for
specific monitors. This is useful for monitoring date-coded files and directories where the URL or file
path is updated automatically based on system date information. SiteScope is an example of an
application that creates date-coded log files. The log file names include some form of the year, month,
and day as part of the file name, such as File2001_05_01.log, where the year, month, and date are
included.
Based on this example, a new file is created each day. Monitoring the creation, size, or content of the
current days file would normally require the file path or URL of the monitor to be manually changed each
day. Using the SiteScope date variables and special substitution, SiteScope can automatically update
the file path to the current day's log file. By knowing the pattern used in naming the files, you can
construct a special substitution string similar to a regular expression that substitutes portions of the
system date properties into the file path.
For example if the absolute file path to the current day's log file in a file monitor is:
D:/Production/Webapps/Logs/File2001_05_01.log
the log file for the following day would be:
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D:/Production/Webapps/Logs/File2001_05_02.log
You can construct a special substitution expression to automatically update the file path used by the
monitor, with the following syntax:
s/D:\/Production\/Webapps\/Logs\/File$year$_$0month$_$0day$.log/
The substitution requires that the expression start with a lower-case s and that the expression is
enclosed by forward slashes /.../. Forward slashes that are part of the file path must be escaped by
adding the back slash (\) character as shown. The SiteScope date variables are separated by the
underscore character literals. SiteScope checks the system time properties each time the monitor runs
and substitutes with applicable values into the file path or URL before accessing the file.
SiteScope monitor types that support the special substitution are:
l

e-Business Transaction monitor

l

File monitor

l

FTP monitor

l

Log File monitor

l

URL monitor

l

URL Sequence Monitor

l

Web server monitor

While the special substitution syntax is similar in syntax to the substitution syntax used in regular
expressions, they are not the same. While all of the SiteScope date variables can be used in match
content regular expressions, the special substitution discussed here can not be used as part of a match
content expression.

Examples for Log File Monitoring
SiteScope's Log File Monitor and File Monitor check for entries in files created by other applications.
These files may be data files created by a third-party application or they may be logs created by a
custom system specially designed for your environment. Where the logs or files are written with a
known, predictable format, SiteScope can be configured to regularly check the files for new entries and
match on specific content strings. The following are several examples of log file entries and simple
regular expression patterns that can be used to check the entries. You can use these examples or
modify them to work with a specific case.
Note: All regular expressions must be entered on a single line in SiteScope. Some of the examples
below may break across more than one line to fit on this page.
This section contains the following topics:
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l

"Searching Paths for Log Files" below

l

"Matching Comma-Separated Values" on the next page

l

"Matching Space Separated Values" on the next page

l

"Matching and Retaining the Numbers in a Line of Text and Numbers" on page 188

l

"Matching Integers and Floating-point Numbers (Positive or Negative)" on page 188

l

"Matching Date and Time-Coded Log Entries" on page 188

Searching Paths for Log Files
UNIX and Windows operating systems treat the case ("N" and "n") of file names in incompatible ways.
Windows operating systems are case insenstive which means that when a file is being searched, its
case is ignored. UNIX operating systems are case sensitive which means that the case of a name is
significant at all times. To avoid log file errors when using regular expressions to search for path names
on UNIX operating systems, use markers to change the character case in the path expression.
Marker

Description

$L

Enables changing characters between the $L marker and the $E marker to lowercase.

$U

Enables changing characters between the $U marker and the $E marker to upper case.

$E

The end marker used for changing character case.

Example:
If you define the following path expression:
s/\/tmp\/logs\/arcv.log.$weekdayName$/
for the /tmp/logs/arcv.log.tue log file on a Linux machine, you get a log file error because
SiteScope tries to find tmp/logs/arcv.log.Tue, and Linux is case sensitive.
To resolve this problem, define the path expression as follows:
s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

The monitor converts the characters between $L and $E to lowercase, /tmp/logs/arcv.log.tue.
Conversely, use $U and $E to enable SiteScope to change the characters between the markers to
upper case. For example, if you define the path expression:
s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

the monitor converts the path to /tmp/logs/arcv.log.TUE.
You can use $L and $U multiple times in a path expression, and you can use them both in the same
expression.
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For example:
s/\/tmp\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/

converts the path to /tmp/logs-tue/arcv.log.TUE
s/\/tmp.$L$monthName$$E\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/
converts the path to /tmp.mar/logs-tue/arcv.log.TUE

Matching Comma-Separated Values
The following is an example of log file entries that are comma-separated strings of digits and letters:
new,open,changed,12,alerts
new,open,changed,13,alerts
new,open,changed,13,alerts
new,open,changed,14,alerts

A regular expression to match on log file entries that are comma-separated strings of digits and letters.
/([\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+)[\n\r]?/
Note: If the file entries include punctuation marks such as an underscore or a colon, add that
character explicitly to the [\w\d] class pattern. For example, to include a colon character, change
each of the [\w\d] patterns to [\w\d:].

Matching Space Separated Values
The following is an example of log file entries that are a sequence of strings and digits separated by
spaces:
requests
requests
requests
requests
requests

12
12
11
12
10

succeeded
succeeded
succeeded
succeeded
succeeded

12
12
11
12
10

failed
failed
failed
failed
failed

The following is a regular expression to match on log file entries that are a sequence of strings and
digits separated by spaces.
/([\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+)[\n\r]?/

Note: The use of the + character forces the match to include the number of sequences per line
included in the match pattern: in this example, five word or number sequences per line of the log
file. If the sequences include punctuation marks such as an underscore or colon, add that
character explicitly to the [\w\d] class pattern. For example, to include a colon character, change
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each of the [\w\d] patterns to [\w\d:].

Matching and Retaining the Numbers in a Line of Text and Numbers
The following is an example of log file entries that are comma separated strings that combine digits and
letters:
request handle number 12.56, series 17.5, sequence reported 97.45, 15.95 and
19.51
request handle number 15.96, series 27.5, sequence reported 107.45, 25.95 and
19.52
request handle number 11.06, series 36.5, system codes 9.45, 35.95 and 19.53
log reference number 12.30, series 17.5, channel reset values 100.45, 45.95 and
19.54

The following is a regular expression to match on log file entries that are comma-separated strings that
combine digits and letters and retain the decimal numeric data:
/[,\w\s]+(\d+\.\d+)[,\w\s]+(\d+\.\d+)[,\w\s]+(\d+\.\d+)[,\w\s]+
(\d+\.\d+)[,\w\s]+(\d+\.\d+)[\n\r]?/.

Note: If the file entries include punctuation marks such as an underscore or colon, add that
character explicitly to the [,\w\s] class pattern. For example, to include a colon character that
appears embedded in the text sequences, change each of the [,\w\s] patterns to [,:\w\s].

Matching Integers and Floating-point Numbers (Positive or Negative)
The following is an example of log file entries that are a sequence of integers and floating point numbers
that may be negative or positive:
12.1987
13.2987
14.3987
15.4987

-71
-72
-73
-74

-199.1
-199.2
-199.3
-199.4

145
245
345
445

-1.00716
-1.00726
-1.00736
-1.00746

The following is a regular expression to match on log file entries that are a sequence of 5 integers and
floating point numbers that may be negative or positive. The numbers in each entry must be separated
by one or more spaces.
/(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+
(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\n\r]?/

Matching Date and Time-Coded Log Entries
Many log files include some form of date and time data with each entry. The following is an example of
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log file entries that include date and time information together with string data separated by commas:
20/04/2003 14:29:22,ERROR,request failed
20/04/2003 14:31:09,INFO,system check complete
20/04/2003 14:35:46,INFO,new record created
The following is a regular expression to match on log file entries that are date- and time-coded followed
by comma-separated strings of letters and digits. This example uses the SiteScope date variables to
match only on entries that were created on the same day, month, and year as indicated by the system
clock of the server where SiteScope is running.
/$0day$\/$0month$\/$year$\s+\d+:\d+:\d+,[\w\d]+,[\w\d]+/
The following example uses the SiteScope date variables to match on a more restricted set of entries
that were created on the same day, month, year, and within the same hour as indicated by the system
clock of the server on which SiteScope is running.
/$0day$\/$0month$\/$year$\s+$0hour$:\d+:\d+,[\w\d]+,[\w\d]+/

Problems Working with Regular Expressions
This section contains problems encountered when working with regular expressions.
This section contains the following topics:
l

l

l

"Using the .* construct presents a very large number of possible matches on any page of content"
below
"Text matching is done against code lines of the script (instead of against the browser's output from
the script) for URLs containing client side-scripts, such as JavaScript" on the next page
"Regular expression match succeeds as soon as the minimum match requested is satisfied" on the
next page

l

"Forgetting to account for non-alphanumeric content" on the next page

l

"Use of excessive metacharacters can be problematic" on the next page

l

"Example Regular Expression Syntax" on page 191

Using the .* construct presents a very large number of possible matches on any page of
content
The use of the .* construct is known to cause the regular expression-matching engine used by
SiteScope to take over all available CPU cycles on the SiteScope server. If this occurs, SiteScope is
unable to function and must be restarted each time the monitor with the offending regular expression is
run, until the expression has been corrected.
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Note: Regular expression matching is run against the entire text content returned to the SiteScope
monitor request. This includes HTTP headers that are normally not viewable in the browser
window (for example, not visible using the View > Source option). This also means that you must
account for other information that may not be displayed in the browser view. This includes text in
META tags used by Internet search engines as well as client side-scripts.

Text matching is done against code lines of the script (instead of against the browser's
output from the script) for URLs containing client side-scripts, such as JavaScript
This means that if the script dynamically writes or replaces text on the Web page with values
calculated by the script, it may not be possible to match this content with regular expressions. If the
script is only changing text, you may be able to match the corresponding text strings that appear in the
script code. A further pitfall would be that you are trying to check that a certain condition was met in the
browser but the matching text string appears in the script content regardless of any user action.

Regular expression match succeeds as soon as the minimum match requested is satisfied
After a match is made, no further matching is performed. Therefore, regular expressions are not well
suited to count the number of occurrences of a repeating text pattern. For example, if you want to check
a Web page with a catalog list of items and each item has a link next to it saying Buy Now! and you
want to make sure that at least five items are listed, a regular expression of /Buy Now!/ would
succeed in matching only the first Buy Now!. Likewise, if your regular expression searches the word
catalog on the main browser screen, the match may succeed if the word appears as a META tag in the
HTML header section or if it appears as a hyperlink in a site navigation menu that appears in the content
before the occurrence you intend to match.

Forgetting to account for non-alphanumeric content
Regular expressions need to be written to account for all of the characters that are and may be present.
This includes white space, linefeed, and carriage returns. This is not normally a problem when
matching a single-word literal. It can be a challenge when you need to create a match of several words
separated by unknown amounts of white space and other non-alphanumeric characters and possibly
span more than one line. The [\s\n\r]+ character class can be useful between words used in the
expression. Always check the format of the content you are trying to match to look for patterns and
special characters, such as periods, commas, and hyphens, that may cause a seemingly simple match
to fail.

Use of excessive metacharacters can be problematic
In some cases, overly generous quantifiers combined with the . or \W metacharacters can grab content
that you were intending to match with a literal string elsewhere in your regular expression resulting in a
match failure. For example, the following might be used to match the URL content of the hyperlink
anchor reference: /a href="([\W\w\s]*)"/. When the monitor performs the check for this regular
expression, however, the match grabs the first occurrence of the pattern /a href="... and continues
matching multiple lines of text up to the last quotation mark found on the page. Without some other
unique ending delimiter, the [\W\w\s]* class and quantifier combination is too excessive. A more
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successful syntax that narrows the class of expected characters would be: /a href="?
([:\/\w\s\d\.]*)"?/

Example Regular Expression Syntax
The following are some examples of syntax for use in regular expressions:
Example
Expression

Description

/CUSTID\s?=\s? This example matches an ID string that is made of 20 or more digits and upper([A-Z0-9]
case letters with no spaces or other non-alphanumeric characters. The \s?
construct permits a white space on either side of the equals sign. Using the
{20,48})/
parentheses around the character class instructs SiteScope to retain this value
(up to the maximum of 48 characters) as a content match value and the matched
value is displayed in the monitor detail status column.
/a href="?
This example matches the URL string in an HTML hyperlink. The "? construct
([:\/\w\s\d\.] makes a quotation mark on either end of the URL string optional. Using the
parentheses instructs SiteScope to retain this value as a content match value
*)"?/i
and the value is displayed in the monitor status. The i modifier tells the search to
treat upper- and lower-case letters equally.
/"[^"]*"/

This example matches text sequences that are contained between quotation
marks. Note the use of the negation caret (^) to define a character class of all
characters other than the quotation mark.

As with programming and scripting languages, there is almost always more than one way to construct a
regular expression to accomplish a particular match. There is not one right way to build regular
expressions. You should plan to test and modify regular expressions as necessary until you get the
results you need.
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Part 3: Integrations
SiteScope can be integrated with a wide variety of HP software and third party products, including HP
Business Service Management (BSM), HP Operations Manager (HPOM), HP Network Node Manager i
(NNMi), HP LoadRunner, HP Performance Center, HP Operations Orchestration (OO), HP Application
Lifecycle Management (ALM), HP Diagnostics, HP Continuous Delivery Automation (CDA), and
Amazon CloudWatch.
For more details on SiteScope integrations, see "Integrations Overview" on page 193.
For a diagram illustrating the various integrations available, what each integration gives you, and how
the integration works, see "Integrating with Other Applications" on page 196.
For the versions of HP software that are supported in this release, refer to the SiteScope Support
Matrices section in the SiteScope Deployment Guide (available from <SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
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SiteScope can be integrated with the following applications:

HP Business Service Management (BSM)
SiteScope can be used as a data collector for HP Business Service Management (BSM) 8.x or 9.x.
BSM receives data about end-users, business processes, and systems and uses the data in reports
and analysis. You can configure SiteScope monitor data to be sent to BSM for all monitors, or for
selected monitors only. For details, see Connecting SiteScope to a BSM Server.

HP Operations Manager Products (HPOM/Operations Management (OMi) in BSM 9.x)
SiteScope can work together with HP Operations Manager products to provide a combination of
agentless and agent-based infrastructure management.
l

l

Event Integration. SiteScope uses the HP Operations agent to forward event data to Operations
Manager (HPOM) or to Operations Management (OMi) in BSM 9.x. This enables a more
comprehensive and detailed overview of the health of your IT operation. To forward event data to
OMi10, see "HP Operations Manager i 10 (OMi10)" below.
Metrics Integration.
n

To report metrics for use in Performance Manager (a reporting component of HPOM), SiteScope
uses the HP Operations agent to act as data storage for metrics collected data by SiteScope.

n

To report metrics for use in Performance Graphing in BSM's Operations Management,
SiteScope uses either the profile database in BSM (the recommended option) or the HP
Operations agent.

For more details on configuring these integrations, see the Integrating SiteScope with HP Operations
Manager Products Guide in the SiteScope Help Guide (check the HP Software Integrations site for the
latest version of this guide).
Tip: For best practices and troubleshooting for using and configuring the integration of SiteScope
with BSM and HPOM products, see Integration with BSM and HPOM Best Practices Overview.

HP Operations Manager i 10 (OMi10)
SiteScope can be used as a data collector for HP Operations Manager i 10 (OMi10); this is a separate
product from BSM and HP Operations Manager. SiteScope forwards events and topology to OMi 10.
OMi’s embedded graphing allows you to visualize performance data collected by SiteScope in near
real-time. In addition, SiteScope Multi-View is available in the OMi workspace.
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OMi10 can also import SiteScope templates to create sets of monitors that can be assigned to CIs
based on dynamic updates to the RTSM. These monitors can be deployed out to multiple SiteScope
servers, based on user-configured criteria.
For details on configuring the integration with OMi 10, see the Operations Manager i - HP SiteScope
Integration section of the OMi Integrations Guide 10.00.

HP Network Node Manager i (NNMi)
SiteScope can be used as a data collector for HP Network Node Manager i (NNMi), which is an event
console used for network monitoring. SiteScope monitors the application side of the system that NNMi
is monitoring, and uses SNMP Traps to forward event data from SiteScope monitors to NNMi.
SiteScope can also report metrics data to NNMi. For details, see Integrating SiteScope with NNMi in
the SiteScope Help (check the HP Software Integrations site for the latest version of this guide).

HP LoadRunner/HP Performance Center
SiteScope can be used with an HP LoadRunner or HP Performance Center installation to enable users
to define and use SiteScope monitors on a LoadRunner or Performance Center application. SiteScope
provides additional monitoring that complements the native LoadRunner and Performance Center
monitors. To integrate SiteScope with LoadRunner or Performance Center, the HP SiteScope for Load
Testing setup type must be installed. For details, see "Integrating with HP Load Testing Products" on
page 238.

HP Operations Orchestration (OO)
The HP Operations Orchestration (OO) SiteScope integration enables OO administrators to connect
specific events or alerts in SiteScope to the execution of OO flows. The administrator builds OO flows
using SiteScope operations (which use SiteScope API calls) in OO Studio. For example, an OO
administrator can create flows that automatically create monitors in SiteScope when a new server is
added, or delete monitors when the server is decommissioned. For details, see the HP Operations
Orchestration SiteScope Integration Guide in the OO documentation set.

HP Application Lifecycle Management (ALM)
SiteScope integrates with HP Application Lifecycle Management (ALM) to share monitoring data and
templates from the production environment to enable load testing engineers to plan performance tests
and application deployment. For details, see the "Application Lifecycle Management Integration" page
in the BSM Application Administration Guide in the BSM Help.

HP Diagnostics
HP Diagnostics monitors application servers using SiteScope. SiteScope forwards data about these
application servers to Diagnostics, providing an insight into the infrastructure components onto which
the application servers are deployed. Diagnostics presents the data in its reports and graphs. For
details, see Integrating SiteScope with HP Diagnostics in the SiteScope Help (check the HP Software
Integrations site for the latest version of this guide).
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HP Service Health Reporter (SHR)
HP Service Health Reporter (SHR) is business service driven IT reporting software that provides
reporting on data collected from multiple sources. SiteScope can be configured as one of the data
source for SHR. The SiteScope-SHR integration enables SiteScope to forward metrics data collected
by various SiteScope monitors to SHR. These metrics can be used to analyze the load and efficiency
of the infrastructure, forecast the performance, and plan the capacity and usage. This integration works
with SHR 9.4 version or higher. For details, see the SHR documentation on the HP Software
Integrations site.

Amazon CloudWatch
SiteScope can be used to report SiteScope monitor measurement data to an Amazon CloudWatch
service. This integration enables customers who use SiteScope for monitoring their AWS-hosted
applications to report any SiteScope metrics to Amazon CloudWatch service. SiteScope metrics data
can be used for AWS AutoScaling, reporting, and alerting. For details, see "Amazon CloudWatch
Integration Preferences" on page 660.

Generic Data integrations
SiteScope can be used to forward metrics to other applications that can receive XML files. These files
contain information about the status of SiteScope groups, monitors, and measurements. For details,
see "Generic Data Integration Preferences" on page 684.

Generic Event integrations
SiteScope can be used to forward events to a third-party application or management console. The
event that is sent contains information regarding the monitor and its measurement, including the status
change that triggered the event. For details, see "Generic Event Integration Preferences" on page 689.
For a diagram illustrating the various integrations available,what each integration gives you, and how
the integration works, see "Integrating with Other Applications" on page 196.
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You can integrate SiteScope with the various different applications as listed in the following sections:
l

"Integrating with BSM and Operations Manager Products" below

l

"Integrating with Other HP Products" on page 202

Integrating with BSM and Operations Manager Products
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Integration

What the Integration Gives You

How the Integration Works

(1)
SiteScope
events ->
BSM events
and health
indicators.

If you have an Event
Management Foundation
license, the events
corresponding to SiteScope
metrics status changes and
alerts are displayed in the Event
Browser in Operations
Management.

If SiteScope is configured as a data
collector for BSM's Operations
Management, SiteScope sends
data about SiteScope metrics
status changes and alerts to
Operations Management using the
HP Operations agent technology.

If the SiteScope events have
corresponding event type
indicators (ETIs), the health
indicators affect the status of the
relevant CIs in BSM applications
such as Service Health and
Service Level Management
(regardless of whether you have
an Event Management
Foundation license).

Where to Get
the Details
l

l

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-toend flow)
Note: Check
the
HP Software
Integrations
site for the
latest version
of this guide.

l

HP SiteScope (11.31)

For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the BSM User
Guide in the
BSM Help

Page 197 of 1395

Using SiteScope
Chapter 17: Integrating with Other Applications

Integration

What the Integration Gives You

How the Integration Works

(2)
SiteScope
events ->
HPOM
events.

Events generated from
SiteScope metrics status
changes and alerts are
displayed in HPOM.

If SiteScope is configured to report
events to HPOM, SiteScope sends
data about SiteScope metrics
status changes and alerts to HPOM
using the HP Operations agent
technology.

Where to Get
the Details
l

l

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-toend flow)
Note: Check
the
HP Software
Integrations
site for the
latest version
of this guide.

l
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For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the BSM User
Guide in the
BSM Help
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Integration

What the Integration Gives You

How the Integration Works

(3)
SiteScope
events ->
BSM events
and health
indicators
using HPOM.

If you have an Event
Management Foundation
license, events generated from
SiteScope metrics status
changes and alerts are sent to
Operations Management using
HPOM.

If SiteScope is configured to report
events to HPOM, SiteScope sends
data about SiteScope metrics
status changes and alerts to HPOM
using the HP Operations agent
technology.

If the SiteScope events have
corresponding event type
indicators (ETIs), the health
indicators affect the status of the
relevant CIs in BSM applications
such as Service Health and
Service Level Management
(regardless of whether you have
an Event Management
Foundation license).

Where to Get
the Details
l

l

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-toend flow)
Note: Check
the
HP Software
Integrations
site for the
latest version
of this guide.

l
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For
information
on the
Operations
Management
(OMi)
licensing
structure, see
Licensing in
the BSM User
Guide in the
BSM Help
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Integration

What the Integration Gives You

How the Integration Works

(4)
SiteScope
metrics ->
BSM metrics
and health
indicators.

If the SiteScope metrics have
health indicators assigned to
them, these health indicators
affect the status of the relevant
CIs in BSM applications such as
Service Health, Service Level
Management, and Service
Health Analyzer.

SiteScope sends metrics to BSM
over HTTP/HTTPS.

SiteScope collects metrics data,
and logs it to the data source.
The data source depends on
which integrations are enabled.
l

l

When a user draws or designs a
graph in Performance Graphing
in Operations Management,
Performance Graphing collects
metrics data from the data source
for the selected CI, which is
monitored by SiteScope, and
draws the graph.

HP SiteScope (11.31)

Data source used:
l

If only the BSM integration is
enabled, data is logged to the
Profile database.
If both BSM and HP
Operations Manager metrics
integration are enabled,
SiteScope logs the data to
the HP Operations agent data
store installed on the
SiteScope host.

l

l

If the SiteScope metrics have
health indicators assigned to
them, these health indicators
affect the status of the relevant
CIs in BSM applications such as
Service Health and Service
Level Management. SiteScope
metrics are also used in Service
Health Analyzer.
(5)
SiteScope
metrics ->
Performance
Graphing
(BSM).

Where to Get
the Details

l

Profile database: SiteScope
reports metrics data to the
profile database in BSM. To use
this data source, SiteScope
must be connected to a BSM
server and reporting monitor
metrics to BSM should be
enabled.
HP Operations agent:
SiteScope uses the HP
Operations agent to make its
metrics data available to
Performance Graphing. To
enable SiteScope to report
metrics, the agent must be
installed on the SiteScope
server, and metrics reporting
must be enabled for each
monitor instance you want to
report.

l

l

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
"How to
Configure
SiteScope to
Communicat
e with BSM"
on page 219

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-toend flow)
Note: Check
the
HP Software
Integrations
site for the
latest version
of this guide.

Page 200 of 1395

Using SiteScope
Chapter 17: Integrating with Other Applications

Integration

What the Integration Gives You

How the Integration Works

(6)
SiteScope
metrics ->
Performance
Manager
graphs
(HPOM).

SiteScope collects metrics data,
and logs it to the Operations
agent data store, which is
installed on the SiteScope host.

SiteScope uses the HP Operations
agent to make its metrics data
available to Operations Manager
(Performance Manager). To enable
SiteScope to report metrics, the HP
Operations agent must be installed
on the SiteScope server.

When a user in Performance
Manager draws or designs a
graph, Performance Manager
collects metrics data from the
Operations agent data store for
the selected node in
Performance Manager that is
monitored by SiteScope, and
draws the graph.

Where to Get
the Details
l

l

Integration
with BSM and
HPOM Best
Practices
Guide in the
SiteScope
Help
Integrating
SiteScope
with HP
Operations
Manager
Products in
the
SiteScope
Help (End-toend flow)
Note:Check
the
HP Software
Integrations
site for the
latest version
of this guide.

HP SiteScope (11.31)

Page 201 of 1395

Using SiteScope
Chapter 17: Integrating with Other Applications

Integrating with Other HP Products
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Integration

What the
Integration
Gives You

How the Integration
Works

(7) SiteScope
metrics -> HP
Diagnostics
data.

SiteScope
forwards
metrics to HP
Diagnostics,
displaying a
more complete
view of the
performance of
the application
server that is
monitored by
Diagnostics.
The metrics
can provide
insight into the
infrastructure
components
onto which the
application
servers are
deployed.

SiteScope forwards
metrics to HP
Diagnostics using
Diagnostics
Integration
Preferences.

(8) SiteScope
events ->
NNMi.

The SiteScopeNNMi event
integration
enables
SiteScope to
forward events
from SiteScope
monitors
(events
generated from
alerts), and
displays the
event data in
the NNMi
incident
console.
(SiteScope
11.10 and
NNMi 9.10 or
later are
required)

SiteScope sends
SNMP traps to NNMi.
The SNMP traps are
converted to NNMi
incidents. From the
resulting incidents, an
NNMi console user
can launch SiteScope
in the context of that
monitor (using the
URL in the SNMP
trap sent to the NNMi
server).
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Where to Get the Details
Integrating SiteScope with HP Diagnostics in
the SiteScope Help (End-to-end flow)
Note: Check the HP Software Integrations site
for the latest version of this guide.

l

Integrating SiteScope with HP NNMi in the
SiteScope Help (End-to-end flow)
Note: Check the HP Software Integrations
site for the latest version of this guide.

l

You can view a guided and narrated
demonstration for the SiteScope-NNMi
integration on YouTube:
https://www.youtube.com/watch?v=21VSL
3_I7oM
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Integration
(9) SiteScope
metrics ->
NNMi.

(10) Run
SiteScoperelated
actions in
Operations
Orchestration
(OO).

What the
Integration
Gives You

How the Integration
Works

The SiteScopeNNMi metrics
integration
enables
SiteScope to
forward metrics
data from
SiteScope
monitors
(metrics status
changes and
alerts) to NNMi.
(SiteScope
11.10 and
NNMi 9.10 or
later are
required)

The HP NNMi-HP
SiteScope System
Metrics integration
populates the NNM
iSPI Performance for
Metrics Network
Performance Server
(NPS) with system
metrics data collected
by SiteScope
monitors using the
Generic Data
Integration.

The HP
Operations
Orchestration
(OO)
SiteScope
integration
enables
administrators
to build OO
flows that are
integrated with
HP SiteScope.

The administrator
builds OO flows using
SiteScope operations
(which use SiteScope
API calls) in OO
Studio. For example,
you can create flows
that automatically
create monitors in
SiteScope when a
new server is added,
or delete monitors
when the server is
decommissioned.
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Where to Get the Details
l

Integrating SiteScope with HP NNMi in the
SiteScope Help (End-to-end flow)
Note: Check the HP Software Integrations
site for the latest version of this guide.

l

You can view a guided and narrated
demonstration for the SiteScope-NNMi
integration on YouTube:
https://www.youtube.com/watch?v=21VSL
3_I7oM

HP Operations Orchestration - SiteScope
Integration Guide in the OO documentation

Page 204 of 1395

Using SiteScope
Chapter 17: Integrating with Other Applications

Integration

What the
Integration
Gives You

How the Integration
Works

(11)
SiteScope
metrics and
configuration
-> ALM/PAL.

SiteScope
integrates with
Application
Lifecycle
Management
(ALM)
/Performance
Application
Lifecycle (PAL)
to share
monitoring
data and
templates from
the production
environment to
enable load
testing
engineers to
plan
performance
tests and
application
deployment.

You can export
SiteScope related
data (metrics,
templates, and
topology) from BSM
to ALM and vice
versa. Exporting data
to ALM enables you
to plan scripts and
load tests that
resemble your
production
environment, and
importing data from
ALM enables you to
use scripts and
SiteScope
configurations that
have already been
tested. You perform
this from the
Application Lifecycle
Management
Integration page in
BSM.

(12)
SiteScope
metrics ->
LoadRunner
/Performance
Center.

Performance
metrics
collected by
SiteScope can
be utilized by
load testing
analysis
products and
solutions, for
example, by
HP
LoadRunner
and HP
Performance
Center.

To integrate
SiteScope with
LoadRunner or
Performance Center,
the HP SiteScope for
Load Testing setup
must be installed. The
integration should be
configured in the
respective load
testing product.

HP SiteScope (11.31)

Where to Get the Details
l

l

l

l

l

"Integrating with HP Application Lifecycle
Management" on page 241
Application Lifecycle Management
Integration Page in the BSM Application
Administration Guide in the BSM Help

"Integrating with HP Load Testing Products"
on page 238
HP LoadRunner Controller User's Guide
which is available from the HP Software
Integrations site.
HP Performance Center Administrator
Guide which is available from the
HP Software Integrations site.
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Integration

What the
Integration
Gives You

How the Integration
Works

(13)
SiteScope
events ->
CDA
(Continuous
Delivery
Automation).

HP Continuous
Delivery
Automation
(CDA)
integrates with
SiteScope to
deploy
SiteScope
monitors and
receive events
from them.
Monitoring
status based
on the events
received is
available in the
CDA user
interface.

SiteScope forwards
events to CDA using
an out-of-the-box
template that is
specially configured
for CDA. The
template is available
from Preferences >
Common Event
Mappings.

(14)
SiteScope
metrics -> HP
Service
Health
Reporter
(SHR)
(not on
diagram)

HP Service
Health
Reporter
(SHR) is
business
service driven
IT reporting
software that
provides
reporting on
data collected
from multiple
sources.
SiteScope can
be configured
as one of the
data source for
SHR.

The SiteScope-SHR
integration enables
SiteScope to forward
metrics data collected
by various SiteScope
monitors to SHR.
These metrics can be
used to analyze the
load and efficiency of
the infrastructure,
forecast the
performance, and
plan the capacity and
usage. This
integration works with
SHR 9.4 version or
higher.
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Where to Get the Details
l

l

"How to Configure SiteScope Generic Event
Integration" on page 691
HP Continuous Delivery Automation
documentation

Check the SHR documentation on the
HP Software Integrations site.
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SiteScope can be used as a data collector for BSM. BSM uses data about end-users, business
processes, and systems. When configured as a data collector for BSM, the metrics and topology data
collected by SiteScope monitors can be passed on to BSM for analysis and for use in reports. Monitor
data can be sent for all monitors or for selected monitors only.
The following diagram illustrates the use of SiteScope as a data collector for BSM:

Note: The BSM integration should not be confused with the integration using the HP Operations
agent, which is required for displaying metrics data in Performance Graphing (in BSM's Operation
Management) and in Performance Manager (a reporting component of HPOM). For details on
collecting metrics using the HP Operations agent, see Integrating SiteScope with HP Operations
Manager Products in the SiteScope Help. You can check the HP Software Integrations site for the
latest version of this guide.
BSM includes a System Availability Management (SAM) Administration page, that enables you to
manage SiteScope monitor configurations for one or more SiteScope servers through a central console.
After activating the BSM integration, SiteScope data flows to BSM regardless of whether you manage
SiteScopes through SAM Administration or the SiteScope standalone user interface.
For the BSM versions supported in this release, refer to the SiteScope Support Matrices section in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

HP SiteScope (11.31)

Page 207 of 1395

Using SiteScope
Chapter 18: Connecting to a BSM Server

Tip: For best practices and troubleshooting for reporting metrics data to BSM and HPOM, see
Integration with BSM and HPOM Best Practices Overview in the Integration with BSM and HPOM
Best Practices Guide in the SiteScope Help.

Troubleshooting/Limitations
This section includes:
l

"Reporting Data to BSM" below

l

"Disabling the Data Reduction Mechanism to Troubleshoot Data Flow Problems" on the next page

l

l

"SiteScope Reports the IP Address Instead of the Hostname Configured in the Monitor" on the next
page
"Additional Troubleshooting" on the next page

Reporting Data to BSM
l

l

l

SiteScope reports numeric metric values only to BSM. It does not report metrics containing string
values.
Unable to register SiteScope in an HP SaaS environment if its BSM SaaS user contains special
characters, such as the @ sign. The BSM user account should contain alphabetic and/or numeric
characters only.
Due to the complexity of some monitoring deployments and network communications, SiteScope
may be temporarily unable to communicate with the BSM server. SiteScope Health monitoring
includes several monitors for watching connectivity and data transfers to the BSM server.
If SiteScope is unable to connect to the BSM Server, SiteScope continues to record and store
monitor data files locally. After the number of data files exceeds a specified threshold, SiteScope
saves the data files in a cache folder with the syntax <SiteScope root
directory>\cache\persistent\topaz\data<index>.old. It also saves the heartbeat samples to
bus_<index>.old and configuration samples to config_<index>.old. You can configure the
number of data.old folders to keep by modifying the _topazMaxOldDirs property in the
<SiteScope root directory>\groups\master.config file.
Note: By default, the threshold number of data files is set to 1,000 files. You can change this
setting by modifying the _topazMaxPersistenceDirSize property in the master.config file.
After the connection between SiteScope and the Agent Server is restored, you must manually
copy the files from these folders to the <SiteScope
root directory>\cache\persistent\topaz\data folder.
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We recommend that you only copy these files when the data folder is empty to avoid
overloading the system with large amounts of data to upload. When the number of data.old
folders exceeds a specified threshold, by default 10 folders, the oldest folders are deleted.

Disabling the Data Reduction Mechanism to Troubleshoot Data Flow Problems
By default, SiteScope uses a data reduction mechanism which reduces the sample load from
SiteScope to BSM by up to 80%. This is done by sending special samples only when there is some
change in the data reading rather than repeating the same sample each monitor run.
Note: The SiteScope Heartbeat sample (ss_heartbeat) indicates that SiteScope is functioning
properly and that its integration with BSM is healthy. The sample is only sent if SiteScope is in
data reduction mode (in which case the sample is sent every minute).
It is possible to disable this mechanism for troubleshooting data flow problems by setting the property _
topazEnforceUseDataReduction= to false in the <SiteScope root
directory>\groups\master.config file. However, it is not recommended to change this default setting.

SiteScope Reports the IP Address Instead of the Hostname Configured in the Monitor
When reverse DNS lookup is either not configured or is faulty for the monitored remote server,
SiteScope reports the IP address of the host to BSM instead of the hostname configured in the monitor
Workaround: You can force the monitor to send the hostname instead of the IP address to BSM by
setting the _disableHostDNSResolution property to “=true” in the <SiteScope root
directory>\groups\master.config file.

Additional Troubleshooting
For additional troubleshooting issues related to SiteScope-BSM metrics integration, CI topology
reporting, and CI downtime,see Troubleshooting SiteScope Integration Issues in the Integration with
BSM and HPOM Best Practices Guide in the SiteScope Help.

Configure the Connection
To enable the connection between SiteScope and BSM, the SiteScope must be configured as a data
collector for BSM. This involves adding a SiteScope to the SAM Administration page in the BSM. For
details on this task, see "How to Configure SiteScope to Communicate with BSM" on page 219.
For information about troubleshooting reporting data to BSM, see " Connecting to a BSM Server" on
page 207.
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Using a Secure Connection for SiteScope-BSM Communication
You can use a secure connection to transmit data from SiteScope to the BSM server. If you have
installed a certificate signed by a root Certificate Authority on the BSM server, no additional setup is
required on the SiteScope server.
If you are using a self-signed certificate on the BSM server and want to use that certificate for secure
communication with SiteScope, you must perform the steps as described in "Configure SiteScope to
connect to a BSM server that requires a client certificate or a secure connection (recommended for
enterprise security)" on page 221.

Changing the Gateway Server to Which SiteScope Sends Data
You can change the Gateway Server to which a SiteScope reports its data. Generally, this is only
applicable if you are working with a BSM deployment with components installed on more than one
server (in the case of a distributed deployment where the BSM Gateway Server is installed on a
different machine from the Data Processing Server).
For details on making this change, see "Change the Gateway Server to which SiteScope sends data optional" on page 221.

Integrate SiteScope Data with BSM's Configuration Items
When a monitor instance is added to a SiteScope reporting data to BSM, that monitor creates a
corresponding configuration item (CI) in Run-time Service Model (RTSM). For details on understanding
configuration items, see the introduction section in the RTSM Administration Guide in the BSM Help.
The SiteScope monitors that populate RTSM include both actual monitors and the groups in which they
are created.
l

l

Actual monitors instances are represented in RTSM as monitor CIs. Monitor CIs receive data from
the corresponding SiteScope monitor instance and use the data, along with health indicators (HIs)
and event type indicators (ETIs) that are assigned to SiteScope monitor metrics, to calculate key
performance indicator status. These indicators provide a more detailed view of the health of a CI.
For details on understanding indicators, see "Health Indicators and KPIs - Overview" in the BSM
User Guide in the BSM Help.
SiteScope groups are represented as group CIs in RTSM and receive KPI status from the monitor
CIs created by the monitors they are running.

Monitor Types and Topology Reporting
SiteScope reports different levels of topology data to RTSM depending on the type of monitor and the
options selected for the monitor. SiteScope forwards the topology to create or update a CI under the
following conditions:
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l

l

When the CI is created in SiteScope for the first time as a result of the monitor retrieving data,
regardless of whether the CI exists in RTSM.
If there were any changes to any of the CI's properties.

This prevents overloading RTSM with CI updates coming from the monitor.
When working with specific monitors, you do not select a topology and the topology is preconfigured
with the necessary data for the integration.
The types of monitors are as follows:
l

l

Technology Integration Monitors. These monitors report data based on the topology settings
script you select and edit for the monitor. The data they report is tightly integrated with BSM. You
can create a custom topology or use a predefined script to forward the relevant data. For details on
these monitors and how to work with their topology settings, see "Topology Settings for Technology
Integration Monitors" on page 383.
Monitors of Supported Environments. For these supported environments, SiteScope acts like a
discovery probe when the monitor is created or its configuration is changed. When topology
reporting is enabled, SiteScope automatically discovers the application's topologies and populates
RTSM with the relevant CIs and monitor CIs. For details and a list of supported environments, see
"Report Discovered Topologies to BSM" on page 215.
You can create a custom topology for monitors of a supported environment (except for monitors
where the CI type is per metric as described in "Monitors Reporting CI Per Metric" on page 237). For
details on creating a topology, see "How to Configure Topology Reporting" on page 225.

l

Monitors Not Reporting Topology Data By Default. SiteScope includes monitors that do not
report hosts or servers and, therefore, it is not possible to know the CI type that is being monitored
in advance. To include topology data for these monitors when reporting to BSM, you must select the
CI type, define CI type key attributes, and map metrics related to the monitor type to specific
indicators. SiteScope then creates a CI for the monitor in RTSM and forwards monitor CI data to
BSM. For the list of monitors that do not have a default topology defined, see "Monitors Not
Reporting Topology Data By Default" on page 236. For details on how to create a topology for these
monitors, see "How to Configure Topology Reporting" on page 225.

Creating Relationships Between Monitors and CIs
You can also create relationships between SiteScope monitor CIs and existing CIs in RTSM. This
relationship enables the monitor to pass HI status information to the CI to which it is attached, even if
that CI was not created from a topology forwarded by SiteScope.
You can create these relationships in SiteScope or in SAM Administration. For details, see task step
"Create relationships between SiteScope monitors and existing CIs in RTSM - optional" on page 222.

Aging of CIs in RTSM
In RTSM, CIs that have had no activity over a period of time are removed from the database. The CIs
created from SiteScope data are also subject to this aging policy. To prevent the aging policy from
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acting on CIs that SiteScope has sent to BSM, SiteScope synchronizes the data it sends to BSM. The
synchronization refreshes the data for those CIs and creates activity on the CIs.
For details on setting the time interval for topology synchronization, see Topology Settings in the BSM
Application Administration Guide in the BSM Help. For details on the aging mechanism, see Working
with CIs in the Modeling Guide in the BSM Help.
Note:
l

l

l

Synthetic monitors and groups created by the EMS integration monitors that use Measurement
field mapping are subject to the aging process regardless of the synchronization.
To prevent CIs for EMS integration monitors being removed from RTSM when aging is
enabled, EMS topology is resent during a hard synchronization of SiteScope. In addition, you
can enable topology resending as part of an anti-aging process by adding the property _
reportEmsCIsAsPartOfAntiAging=true to the
<SiteScope root directory>\groups\master.config file.
If you delete a CI from RTSM you must perform a resynchronization or a hard synchronization
of SiteScope (in Integration Preferences), or you must wait for a restart of SiteScope so the CI
is restored to RTSM. This is due to the CI cache in SiteScope that prevents SiteScope from
sending an unchanged CI twice. For details, see the section on BSM Integration Preferences.

Managing Indicator Assignments in System Availability Management
Note: This section is relevant only to those users connecting SiteScope with BSM 9.00 or later.
SiteScope metrics that are mapped to indicators, are stored and managed in the Indicator Assignments
repository in SAM Administration. The repository provides the following benefits:
l

l

l

Centralized management of metric mappings in BSM, which makes it easier to manage large
numbers of SiteScope and monitors. The Indicator Assignments repository is available for editing in
the Metrics and Indicators tab in SAM Administration.
Metrics are mapped from different SiteScope monitors to indicators, per monitor type. You can
create, edit, and delete indicator assignments for specific monitor types.
If new indicator assignments are added or existing assignments are modified in the Indicator
Assignments repository, these changes can be published to all SiteScopes that are connected to
BSM. This ensures that new monitor instances created in SiteScope have indicators according to
the latest centralized assignments. You can restore the default assignments included in your
current version of SiteScope by clicking the Reset to Default button in HP Integration Settings >
Indicator Settings section of the monitor properties.
Note: Where indicator assignments have been modified on a local SiteScope server (mappings

HP SiteScope (11.31)

Page 212 of 1395

Using SiteScope
Chapter 18: Connecting to a BSM Server

for monitor metrics were changed):

l

l

n

These assignments are not overridden by the centralized assignments when SiteScope
downloads the updated mappings.

n

If an assignment is deleted from the Indicator Assignments repository, the local assignment
is not automatically deleted and SiteScope keeps sending the old indicator value to BSM. In
this case, a different indicator assignment should be selected for the monitor metric.

n

If an indicator is deleted from the Indicator repository, a different indicator assignment
should be selected for monitor metrics that used the mapping.

The central repository ensures compatibility with earlier versions of SiteScope by mapping metrics
from earlier SiteScopes to indicators.
When a hard synchronization is performed on SiteScope, all the indicator mappings are downloaded
from BSM.

For details on editing the centralized Indicator Assignments in SAM Administration, see "Indicator
Assignment Settings" in the BSM Application Administration Guide in the BSM Help.

Assigning SiteScope Metrics to Indicators
Note: This section is relevant only to those users connecting SiteScope with BSM 9.00 or later.
When configuring monitor instances, you can also map a metric to an indicator. SiteScope monitor
metrics are mapped to indicators on a monitor type basis as follows:
l

l

Monitors of supported environments and monitors that have a defined topology have indicators
assigned to metrics by default. For details of these monitors, see "Monitor Types and Topology
Reporting" on page 210. For the list of default indicator assignments, see Indicator Mapping
Alignment in the BSM User Guide in the BSM Help.
For SiteScope monitors that do not have a defined topology, there are no default indicator
mappings, since these monitors can be linked to different CI types, and a single mapping cannot be
set. For these monitors, you can map metrics to the appropriate indicators for the CI type linked to
the monitor. For a list of monitors that do not have a defined topology, see "Monitors Not Reporting
Topology Data By Default" on page 236.

You can change the default metrics mappings in SiteScope. If indicator mappings are modified locally
in SiteScope, these mappings are not overridden by the centralized repository mappings when
SiteScope downloads the latest mappings from BSM. This enables you to:
l

Override indicators for a monitor instance or some metrics of a monitor.

l

Configure non-default indicators in templates. Note that the CI type for custom topology and metric
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mappings is not configurable through variables in templates (they should be predefined in a
template).
l

Configure indicators for alerts. Since the CI type of a triggered alert is not always known when
configuring an alert for groups or for monitors reporting a CI per metric (see "Monitors Reporting CI
Per Metric" on page 237), you can manually enter the indicator and indicator state for an alert. For
details, see "HP Operations Manager Integration Settings" on page 1272.

For task details on mapping SiteScope metrics to indicators, see "Map Indicators to metrics" on page
226.
For user interface details, see "Indicator Settings" on page 303.

When are Health Indicators Created?
l

l

Events in SiteScope are based on SiteScope monitor metric status changes and alerts being
triggered. Events are created after the first event arrives to the CI. For more details, see Integrating
SiteScope with HP Operations Manager Products. You can check the HP Software Integrations
site for the latest version of this guide.
Metrics are created when the monitor topology is reported to RTSM. For more details, see "Report
Discovered Topologies to BSM" on the next page.

Discovery Scripts and the Package Manager
Note: This section applies to users integrating with Business Availability Center/BSM 8.00 or
later. When integrating topology data with earlier versions of BSM, SiteScope uses legacy scripts
which are stored on the SiteScope server.
The scripts that enable SiteScope to act as a discovery probe are stored on the BSM server in the
SiteScope package. When SiteScope is configured to discover an application's topology, SiteScope
downloads the appropriate script from the BSM server. It then uses the script to perform the discovery
while monitoring the application.
The SiteScope package includes scripts and other SiteScope-related RTSM resources, such as views
and enrichments. You can access this package in BSM in Admin > RTSM Administration >
Administration > Package Manager. The package is a factory package, meaning that the out-of-thebox configurations for the package enable it to perform the discoveries in SiteScope. For details on
working with packages, see Package Administration in the Modeling Guide in the BSM Help.
Note: Advanced users may want to modify the topology scripts within the package. Be warned
that the SiteScope package uses scripts from other packages which may be shared by SiteScope
and Data Flow Management. Any changes made to the scripts in the package can also affect Data
Flow Management.
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Any changes made to the topology script that influence the way a topology is reported to BSM can
affect all the applications that use those topologies, including BSM applications and Operations
Management.

Topology Script Properties File
If you are working in a secure BSM installation that has a certificate, you may have to insert the
following line into the <SiteScope root directory>\discovery\discovery_agent.properties file:
appilog.agent.Probe.BasicAuth.Realm=authRealm.
Where authRealm is a variable for Basic Authentication Realm. If you want to find out what realm a
given URL belongs to, you can open the URL with a Web browser and see the first line in the popup
box.
Note: When you modify the discovery_agent.properties, you must restart SiteScope to enable
your changes to take effect.

Topology Reporting Limitation
The number of characters in SiteScope group and monitor descriptions that can be reported to BSM is
limited to 600 characters. If a group or monitor description contain more than this number, SiteScope
truncates the description to the first 600 characters.

Report Discovered Topologies to BSM
SiteScope can act as a discovery probe and discover the hierarchy of the monitored entities of selected
environments. These hierarchies are represented by topologies that SiteScope reports to BSM. The
CIs within the topologies correspond to the hosts, servers, and applications that SiteScope monitors,
and are created in BSM's RTSM. Monitor and measurement CIs are also created and SiteScope
reports their status to BSM. The relationships between the CIs are defined by the topology reported by
SiteScope.
You enable this feature by selecting the Report monitor and related CI topology option under the
HP Integration Settings panel when creating or configuring a monitor instance. If this option is
cleared, the CIs that were created in RTSM are not automatically deleted. If there is no activity on the
CI, they are eventually removed from the database through aging or they must be manually deleted.
For details on the Topology Settings user interface, see Topology Settings in the BSM Application
Administration Guide in the BSM Help.
For troubleshooting problems involving topology reporting, see Business Service Management
Topology Issues in the Integration with BSM and HPOM Best Practices Guide.
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Supported Environments
This direct connection between SiteScope and BSM is available for selected environments only and
with specific versions of BSM. SiteScope reports specific topologies for the following monitors
(documentation for these monitors is available from the SiteScope Monitor Reference Guide in the
SiteScope Help):
Environment/
Monitor Type
Monitors
Reporting
Node
Topology

Monitors
This includes all monitors that report the status of a host or server (other than
Technology Integration monitors and the supported environments listed below) that
can forward topology data to BSM using a predefined CI type such as Node,
Computer, or some other child CI type derivative. When topology reporting is
enabled, SiteScope forwards the topology along with monitor CI data to BSM. For
details on this option, see "HP Integration Settings" on page 297.
Note: This does not include monitors that do not monitor the status of a host or
server, since it is not possible to know the CI type that is being monitored in
advance. For the list of monitors without host data, see "Monitors Not Reporting
Topology Data By Default" on page 236.

Database
(Available when integrating with Business Availability Center version 8.00 or later.)
Environments
l
Database Counter Monitor

Big Data
Environments
ERP/CRM
Application
Environments
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l

Database Query Monitor

l

DB2 JDBC Monitor

l

Microsoft SQL Server Monitor

l

Oracle Database Monitor

l

Hadoop Monitor

l

HP Vertica JDBC Monitor

l

SAP CCMS Monitor

l

SAP MAI Alerts Monitor

l

SAP Work Processes Monitor

l

Siebel Application Server Monitor

l

Siebel Web Server Monitor
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Environment/
Monitor Type

Monitors

Server
(Available when integrating with BSM 9.0 or later.)
Environments
Dynamic Disk Space Monitor
SOA
Web Service Monitor
Environments
Virtualization (Available when integrating with Business Availability Center/BSM 8.02 or later.)
Environments
l
Solaris Zones Monitor

Web server
Environments

l

VMware Datastore Monitor

l

VMware Host Monitors

l

VMware Performance Monitor

l

Microsoft IIS Server Monitor

l

l

WebLogic Application Server Monitor, using the JMX Monitor or Dynamic JMX
Monitor
WebSphere Application Server Monitor

CI Downtime
Note: This section is relevant only to those users connecting SiteScope with BSM 9.00 or later.
Downtimes are defined and managed in BSM using the Downtime Management page in Platform
Administration. For details about configuring downtime, refer to Downtime Management in the BSM
Platform Administration Guide in the BSM Help.
SiteScope is affected by downtime if a SiteScope monitor or measurement CI is directly linked to a CI
that BSM detects is in downtime. SiteScope is also affected by downtime if a Business Application CI,
Business Service CI, Infrastructure Service CI, or a CI Collection linked to a SiteScope Group CI is in
downtime.
Monitors affected by a CI that is currently in downtime do not go into downtime immediately. The time
that it takes for the monitors to go into downtime is affected by two configuration parameters:
l

l

The interval between SiteScope queries to BSM for downtime requests (the default downtime
retrieval frequency value is 15 minutes). This can be modified in SiteScope in Preferences >
Infrastructure Preferences > General Settings > BSM downtime retrieval frequency
(minutes).
The interval between updating the SiteScope downtime cache in BSM (the default value is 5
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minutes). This can be modified in BSM in Admin > Platform > Setup and Maintenance >
Infrastructure Settings. Select Applications > End User/System Availability Management. In
the Downtime table, locate SiteScope Downtime Cache Update Interval. Change the value to
the required cache update interval.
The action that is taken in SiteScope during the downtime depends on the downtime configuration in
BSM. Downtime can be enforced on the following:
l

Alerts. No alerts are sent for any of the CIs associated with the downtime.

l

Reports. Reports are not updated and display the downtime for the CI.

l

l

KPIs. KPIs attached to the CI are not updated and display the downtime for the CI in Service
Health.
Monitoring. SiteScope monitoring stops for any of the CIs associated with the downtime.

A monitor that is in downtime is indicated in the SiteScope Dashboard Summary column by "disabled
by <Downtime Name> from BSM". Details of downtimes that are associated with the monitor and are
currently taking place are displayed in the Monitor Downtime table in the Enable/Disable Monitor
panel. For details, see "Enable/Disable Monitor" on page 309.
If the monitor is affected by a CI that is currently in downtime and the downtime applies to associated
alerts of the monitor, downtime details are displayed in the Associated Alerts Downtime table in the
Enable/Disable Associated Alerts panel. For details, see "Enable/Disable Associated Alerts" on
page 310.

Notes and Limitations
l

l

l

l

When SiteScope queries BSM for downtime requests, it gets the downtimes for the downtime
period (up to a maximum of 24 hours). A record is written to <SiteScope root
directory>\logs\audit.log which includes new downtimes, changes to existing downtimes, and
deleted downtimes.
When SiteScopeis connected to BSM 9.00 or later, the downtime mechanism is enabled by default.
To change the default setting, clear the Enable downtime mechanism check box in SiteScope's
Preferences > Infrastructure Preferences > General Settings.
Downtime is not supported for SAP, Siebel, or SOA topologies (regardless of whether the
Application Management for Siebel/SAP license is installed).
For monitors that report the CI per metric, when a CI connected to a metric is in downtime, this
sends the monitor to which the metric belongs into downtime. This is applicable to the VMware
Performance Monitor and Solaris Zones Monitor.

l

Downtime information is not available in System Availability Management reports.

l

When SiteScope is connected to BSM 9.10, downtime on the SiteScope profile is upgraded to
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downtime on the hosts and software elements that are monitored by the SiteScope profile monitors
and measurements.
l

For additional troubleshooting relating to CI downtime, see Business Service Management CI
Downtime Issues in the Integration with BSM and HPOM Best Practices Guide.

How to Configure SiteScope to Communicate with BSM
This task describes how to configure SiteScope to be used as a data collector for BSM.
1.

Prerequisites
n

Before starting the integration, check the Support matrix for the list of BSM versions supported
in this release. For details, see the HP Business Service Management Integration Support
Matrix in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

n

To integrate SiteScope with BSM, you must be a SiteScope administrator user. For details on
user permissions, see "User Management Preferences" on page 732.

n

Prepare a plan that maps out the specific IT infrastructure resources whose data you want to
collect. Include information about the business processes that are affected by the specified
infrastructure components. For example, business processes being monitored by Business
Process Monitor, that are running on an application server against which you plan to run
SiteScope monitors.

n

If smart card authentication is configured in BSM and you want to integrate SiteScope with
BSM, you must configure SiteScope smart card authentication to authenticate the BSM client
certificate. For details, see Smart Card Authentication in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

n

On the BSM side:
o

Make sure BSM has a valid System Availability Management license (in Admin
> Platform > Setup and Maintenance > License Management), which is required to
enable the SiteScope integration.

o

Check that System Availability Management is enable in the Server Deployment page (in
Admin > Platform > Setup and Maintenance > Server Deployment); otherwise you will
not see the SAM menu in BSM.

Note: When connecting SiteScope with BSM 9.x, the HPOprInf, HPOprMss, HPOprOra,
and HPOprJEE content packs are required (they are installed by default, so you generally do
not need to do anything). If you do not have these content packs, you need to import them as
described in "How to Create and Manage Content Packs" in the BSM Platform Administration
Guide in the BSM Help.
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2.

Download and install SiteScope (if not already installed)
In BSM, navigate to Admin > Platform > Setup and Maintenance, and click Downloads.
Download and save the SiteScope installation files (for Windows or Solaris) to a local or network
drive.
Install SiteScope on machines designated to run the SiteScope data collector. You can run
multiple SiteScopes from multiple platforms. For more information, see the Installing SiteScope
section in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

3.

Install the HP Operations Agent on the SiteScope server (required for sending events
and metrics to BSM's Operations Management)
The agent is required for displaying metrics data in Performance Graphing in BSM's Operation
Management, and for sending events to BSM for use in Operations Management (OMi).
Install HP Operations Agent 11.14 on the SiteScope server. For details, see Integrating SiteScope
with HP Operations Manager Products in the SiteScope Help. You can check the HP Software
Integrations site for the latest version of this guide.

4.

Connect the installed SiteScope with BSM
In BSM, navigate to Admin > System Availability Management, and add the SiteScope to
SAM Administration. For user interface details, see New SiteScope Page in the BSM Application
Administration Guide in the BSM Help.
After the integration has completed successfully, the SiteScope Profile is added to the left pane in
SAM Admin. The profile status is blue (not up-to-date) because SiteScope has not yet sent any
data or samples to BSM. In SiteScope, the BSM host is added to Preferences > Integration
Preferences, and the HP Integration Settings panel is displayed in the monitor Properties page.
n

To change logging options, edit a specific monitor and select the relevant option in the HP
Integration Settings panel of the monitor Properties page. For details, see "HP Integration
Settings" on page 297. You can use the Global Search and Replace wizard to update the
logging options on those monitors created before the integration was established. For details on
the wizard, see Global Search and Replace Wizard in the BSM Application Administration
Guide in the BSM Help.

n

Monitors created in SiteScope before registration to BSM have their logging option set to
Disable reporting to BSM. After you configure SiteScope as a data collector reporting to
BSM, the default for new monitors created in SiteScope is to log their monitoring data to BSM.
Note:
o

If you are working with a SiteScope that is not accessible to BSM (for example in HP
Software-as-a-Service), the procedure for the connection includes creating an empty
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profile in SAM Administration and creating an Integration Preference for BSM in
SiteScope. For task details, see "How to Configure SiteScope-BSM Integration
Preferences for Inaccessible Profiles" on page 667.

5.

o

A SiteScope server can be integrated with one BSM server only. However, multiple
SiteScope servers can be integrated with a BSM server.

o

When working under high load, suspend all monitors before connecting to BSM for the
first time.

Configure SiteScope to connect to a BSM server that requires a client certificate or a
secure connection (recommended for enterprise security)
If the BSM server requires a secure connection, you must perform the appropriate step below:

6.

n

For a BSM server that requires a secure connection, see "How to Connect SiteScope to a BSM
Server That Requires a Secure Connection" on page 224.

n

For a BSM server that requires a client certificate, see Configuring SiteScope to Connect to a
BSM Server That Requires a Client Certificate in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Change the Gateway Server to which SiteScope sends data - optional
You can change the Gateway Server to which a SiteScope reports its data. Generally, this is only
applicable if you are working with a BSM deployment with components installed on more than one
server.
n

In SiteScope's BSM Integration Preferences, enter the required Gateway Server name or IP
address in the Business Service Management machine name/IP address box. For user
interface details, see "BSM Integration Preferences" on page 665.

n

In SAM Administration, update the SiteScope settings with the Gateway Server name in
Distributed Settings. For user interface details, see New/Edit SiteScope Page in the BSM
Application Administration Guide in the BSM Help.
Note: This can only be used for changing the Gateway Server for a SiteScope that is
already registered with a given BSM installation. It cannot be used to add a new
SiteScope, or to connect a SiteScope to a different BSM system.

7.

Create a monitoring structure in SiteScope
a. Create groups and subgroups to organize the monitors to be deployed, and then create
monitors in these groups. When configuring monitors, verify that BSM data logging and
topology settings are set as required.
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For details on creating a monitoring structure, see the suggested workflows in "Configure
SiteScope for monitoring" on page 67.
b. Configure SiteScope to send metrics, events, and topology data to BSM.
In addition, SiteScope can also store metrics data to the HP Operations agent data store
which is installed on the SiteScope host, or in the profile database in BSM (when graphing
metrics data for use in Performance Graphing in Operations Management).
Tip: The profile database in BSM is the recommended option, since it is a more robust
and scalable data source, and does not require configuration of the HP Operations
Integration.

8.

o

Metrics and Topology (using the classic SiteScope-BSM Integration). For details, see
"HP Integration Settings" on page 297.

o

Events and Metrics (using the HP Operations agent or Profile DB in BSM). For details,
see Integrating SiteScope with HP Operations Manager Products in the SiteScope Help.
You can check the HP Software Integrations site for the latest version of this guide.

Create relationships between SiteScope monitors and existing CIs in RTSM - optional
You can create relationships to enable a monitor to pass HI status information to the CI to which it
is attached (even if that CI was not created from a topology forwarded by SiteScope):
n

In SiteScope, you can customize the relationship between SiteScope monitor CIs and existing
CIs in HP Integration Settings by manually selecting the CI type option when editing a
monitor instance. The CI type is defined by default for monitors of supported environments and
monitors that have a defined topology. For task details, see "Select the CI type" on page 225.

n

In SAM Administration, by using the Monitor Deployment Wizard which uses the existing CI
property data in RTSM to deploy SiteScope monitors, groups, and remote servers. This
creates in RTSM a monitored by relationship between the monitored CI and the created
monitor. For concept details, see Monitor Deployment Wizard in the BSM Application
Administration Guide in the BSM Help.

Once defined, the SiteScope and its groups and monitors are added as CIs to RTSM and are
automatically attached to the relevant monitor views, from where they can be added to other
views. When editing a monitor in SAM Administration, you can associate the monitor with existing
CIs using HP Integration Settings. For example, you can attach the CPU monitor to an existing
logical CI representing a machine whose CPU is being monitored.
The data from the SiteScope is available in Service Health and Service Level Management.
9.

Map SiteScope metrics to indicators - optional
In SiteScope, you can add mappings for monitors that do not have default indicator metric
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mappings, or modify settings for existing mappings (monitors of supported environments and
monitors that have indicators mapped to metrics by default).
For task details, see "Map Indicators to metrics" on page 226.
10.

Assign permissions in BSM
In BSM, navigate to Admin > Platform > Users and Permission, and click User Management.
For each defined user, assign permissions to view SiteScope groups and their subgroups in SAM
reports and custom reports. For details, see the User Management Operations section in the BSM
Application Administration Guide in the BSM Help.
For details on how permissions are applied, see Accessing SiteScope and Building Permissions
Model in the BSM Application Administration Guide in the BSM Help.

11.

Modify the connection settings - optional
After you have created the connection, you can modify the settings either in SiteScope or in BSM,
depending on the setting that you are modifying.
n

In BSM, select Admin > System Availability Management. In the list of SiteScopes, rightclick the relevant SiteScope and select Edit SiteScope from the context menu. For user
interface details, see New/Edit SiteScope Page in the BSM Application Administration Guide
in the BSM Help.

n

In SiteScope, open the Preferences context and select Integration Preferences. Edit the
BSM Integration Preference. For user interface details, see "BSM Integration Preferences" on
page 665.
Tip:
o

To secure the connection to BSM (since the BSM user name and password are not
used for authentication), it is recommended to configure either Basic Authentication in
SiteScope or use two-way SSL. If BSM is configured to use Basic Authentication, the
same user name and password entered in the Authentication user name and
Authentication password fields in SiteScope are used for reporting both data and
topology to BSM. If BSM is not configured to use Basic Authentication, the credentials
sent are ignored.

o

To enable data to be compressed before being sent from the SiteScope server to BSM,
set _topazCompressDataInGzip=true in the <SiteScope root
directory>\groups\master.config file. When enabled, SiteScope monitor (ss_
monitor_t) and SiteScope metric (ss_t) samples are compressed in gzip before being
sent to BSM (where it is decompressed). Data compression can be used only when
SiteScope is reporting to BAC/BSM 8.05 or later.
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How to Configure SiteScope to Send Bulk Data to the RunTime Service Model
SiteScope results can be sent to BSM’s Run-time Service Model (RTSM) either zipped or unzipped.
The request includes a parameter that indicates to RTSM whether the results being sent are in zipped
or unzipped format.
To send SiteScope results in a zipped format:
1. Open the following file: <SiteScope root directory>\discovery\discovery_agent.properties.
2. Locate the line beginning appilog.agent.probe.send.results.zipped. If the line does not
exist, add it to the file.
3. Change the value to =true.
4. Restart SiteScope. SiteScope results are zipped before being sent to RTSM.

How to Connect SiteScope to a BSM Server That Requires a
Secure Connection
This task describes the steps involved in enabling secure communication between SiteScope and
BSM when the BSM server requires a secure connection.
1. Prepare SiteScope to use a secure connection. For details, see the section on configuring
SiteScope to use a secure connection in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
2. Import the CA or BSM server certificate into SiteScope using Certificate Management in the
SiteScope user interface. For task details, see "How to Import Server Certificates Using
Certificate Management" on page 543.
Note: The machine name in the certificate must be a fully qualified domain name that is
exactly the same name (including case sensitive) as the one used in the New SiteScope page
in System Availability Management Administration.
3. In BSM, select Admin > System Availability Management Administration, and click the New
SiteScope button to add the SiteScope instance. In the New SiteScope page, make sure the
following settings are configured:
n

Distributed Settings: Check that the Gateway Server name/IP address contains the correct
server name and port (default 443).
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n

Profile Settings: Select the BSM Front End Use HTTPS check box (in versions of BSM
earlier than 9.20, select the Web Server Use SSL check box).

How to Configure Topology Reporting
Note: Only advanced users with a thorough knowledge of CIs and indicators should attempt to edit
the indicator mappings or to add mappings to metrics.
This task describes how to configure topology settings for monitors. It also describes how to select or
modify the CI type and map metrics to indicators.
1.

2.

Prerequisites
n

If BSM requires a client certificate, you must configure the topology discovery agent in
SiteScope to report topology to the BSM server. For details, see Configuring the Topology
Discovery Agent in SiteScope When BSM Server Requires a Client Certificate in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

n

For SiteScope to forward the host topology along with monitor CI data to BSM, the Report
monitor and related CI topology option must be selected under the HP Integration
Settings panel in the monitor properties. By default, this option is selected for monitors of
supported environments and monitors that have a CI type defined by default. For user interface
details, see "BSM Integration Data and Topology Settings" on page 299.

Select the CI type
For monitors that report a topology by default (the default CI type associated with the monitor is
displayed in parenthesis in the CI type list), you can use the default selection, or override the
selection by modifying the CI type and entering key attributes.
For monitors that do not report a topology by default, select the CI type for the monitor in the BSM
Integration Data and Topology Settings section, and enter values for the CI type key
attributes. For the list of monitors that do not report a topology by default, see "Monitors Not
Reporting Topology Data By Default" on page 236.
Note: For monitors where the CI type is per metric (for the list of monitors, see "Monitors
Reporting CI Per Metric" on page 237), the CI type cannot be modified and CI key attributes
are not displayed.

Tip: It is recommended to perform a resynchronization of SiteScope if BSM is restarted
within 10 minutes after making changes to a monitor's topology settings. To do so, select
Preferences > Integration Preferences > BSM Integration > BSM Preferences
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Available Operations, and click Re-Synchronize.
For user interface details, see "BSM Integration Data and Topology Settings" on page 299.
3.

Map Indicators to metrics
When a CI type is selected, the table in the Indicator Settings section is filtered to show indicator
settings for the selected CI type. Monitors of supported environments and monitors that have a
defined topology have indicators mapped to metrics by default. You can add new metric mappings
or edit settings for existing mappings.
For monitors that do not have default indicator metric mappings, you can map metrics to the
appropriate indicators for the CI type linked to the monitor. For the list of default indicator
assignments, see Indicator Mapping Alignment in the BSM Application Administration Guide in the
BSM Help.
For concept details, see "Assigning SiteScope Metrics to Indicators" on page 213.
For user interface details, see "Indicator Settings" on page 303.

4.

Select a preference for influencing BSM Service Health when events and metrics are
reported to BSM - optional
Since SiteScope events and metrics can affect BSM's Service Health, select the preference for
influencing Service Health when both data types are reported. Select the preference in the BSM
Service Health Preferences section of HP Integration Settings. For user interface details, see
"BSM Service Health Preferences" on page 307.
This preference is relevant only when:
n

Both BSM and Operations Manager integrations are active.

n

The Operations Manager event integration is connected to the BSM server—not the HPOM
server.

n

The following settings are selected in the monitor's HP Integration Settings:
o

In the BSM Integration Data and Topology Settings section: Enable reporting monitor
status and metrics or Enable reporting monitor status and metrics with thresholds.

o

In the HP Operations Manager Integration Settings section: Send events.

Note:
n

The preference can also be set globally for each newly-created monitor in Integration
Preferences > HP Operations Manager Integration > HP Operations Manager
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Integration Main Settings by selecting Prefer events over metrics in BSM Service
Health (global preference). For user interface details, see "HP Operations Manager
Integration Main Settings" on page 679.
n

5.

For more information on choosing which preference to use, see Integrating SiteScope with
Business Service Management Applications.

Results
After configuring the topology settings click Save. SiteScope creates a CI for the monitor in RTSM
and forwards monitor CI data to BSM.

How to Configure Topology Reporting for a Custom
Monitor
This task describes how to configure topology settings, select or modify the CI type, and map metrics
to indicators for a custom monitor type.
1.

Prerequisites
If BSM requires a client certificate, you must configure the topology discovery agent in SiteScope
to report topology to the BSM server. For details, see Configuring the Topology Discovery Agent in
SiteScope When BSM Server Requires a Client Certificate in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

2.

Select the CI type
In the BSM Integration Data and Topology Settings section of HP Integration Settings,
configure the topology reporting settings that define how SiteScope reports CIs to BSM.
You can report the following types of CI topology data:
n

User-defined CI type topology. In the CI type list, select a CI type and define the key
attribute values for the selected CI type. For details on key attribute values, see "<CI type key
attributes>" on page 303.

n

Custom topology script. Select the Custom topology setting option, and create the
topology script which defines how to report CIs to BSM. Only select this option if you are
familiar with the Jython language, because you must create the topology script in Jython
yourself. For task details, see "How to Configure Custom Topology for a Custom Monitor" on
page 229.

n

If you do not want to report topology for the monitor, you can choose to report the monitor CI
only. In the CI type list, select Default(None). This is the default setting.
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Note: If you do not want to report topology for a custom monitor, but you want to map its
metrics to CIs with a custom CI hint and map metrics to indicators in the user interface,
you must perform the following:
i. Select the Custom topology setting option.
ii. In the Data Processing Script box, enter the following (empty) script:
from
from
from
from

java.lang import *
java.util import *
appilog.common.system.types.vectors import ObjectStateHolderVector
appilog.common.system.types import ObjectStateHolder

def DiscoveryMain(Framework):
OSHVResult = ObjectStateHolderVector()
return OSHVResult

For user interface details, see "BSM Integration Data and Topology Settings" on page 299.
3.

Map Indicators to metrics
Map indicators to metrics for the selected CI type.
n

When a CI type is selected, the table in the Indicator Settings section is filtered to show
indicator settings for the selected CI type. You can add new metric mappings or edit settings
for existing mappings.

n

When Custom topology setting is selected, configure the indicator mappings using the HIs
you used in your HI assignment (see "Define an HI Assignment" on page 230).
Unlike for regular monitors, the CI Type can be edited in Indicator Settings when creating a
custom topology script for a custom monitor. When adding an indicator setting, select the CI
type from the CI Type list, and SiteScope displays the appropriate indicators for the CI type.
Note: Do not define more than one indicator mapping with different CI types that match
the same metric.

n

When CI type Default(None) is selected, indicator mappings are not available.

For concept details, see "Assigning SiteScope Metrics to Indicators" on page 213.
For user interface details, see "Indicator Settings" on page 303.
4.

Select a preference for influencing BSM Service Health when events and metrics are
reported to BSM - optional
Since SiteScope events and metrics can affect BSM's Service Health, select the preference for
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influencing Service Health when both data types are reported. Select the preference in the BSM
Service Health Preferences section of HP Integration Settings. For user interface details, see
"BSM Service Health Preferences" on page 307.
This preference is relevant only when:
n

Both BSM and Operations Manager integrations are active.

n

The Operations Manager event integration is connected to the BSM server—not the HPOM
server.

n

The following settings are selected in the monitor's HP Integration Settings:
o

In the BSM Integration Data and Topology Settings section: Enable reporting monitor
status and metrics or Enable reporting monitor status and metrics with thresholds.

o

In the HP Operations Manager Integration Settings section: Send events.

Note:

5.

n

The preference can also be set globally for each newly-created monitor in Integration
Preferences > HP Operations Manager Integration > HP Operations Manager
Integration Main Settings by selecting Prefer events over metrics in BSM Service
Health (global preference). For user interface details, see "HP Operations Manager
Integration Main Settings" on page 679.

n

For more information on choosing the preference to use, see Integrating SiteScope with
BSM in the Integration with BSM and HPOM Best Practices Guide.

Results
After configuring the topology settings click Save. SiteScope creates the topology according to
your definition, and forwards monitor data to BSM.

How to Configure Custom Topology for a Custom Monitor
This task describes the steps involved in creating a custom monitor with a custom topology script.
1.

Change the CI Resolver TQL (only if SiteScope is connected to a version of BSM earlier
than 9.20)
a. In BSM, select Admin > Platform > Infrastructure Settings.
o

Select Applications.

o

Select End User/System Availability Management.
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o

In the End User/System Availability Management - SiteScope CI Resolver Settings,
check if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is,
change it to OMiAutoView.

b. Restart BSM to apply the change.
Note: This TQL does not support models with a large number of CIs (it may cause
performance problems in such models).

2.

Define an HI Assignment
You need to define an HI assignment that will assign the HI to a CI. The assignment also defines
which data samples will be captured by this HI and which business rule will be used to calculate
the status of the HI according to the data samples.
For more information on HI assignments in Service Health, see "Health Indicator Assignments
Page" in the BSM Application Administration Guide in the BSM Help. For more information on HI
assignments in SLM, see "Health Indicator Assignments Page" in the BSM Application
Administration Guide in the BSM Help.
To define an HI assignment:
a. In BSM, select Admin > Service Health / Service Level Management > Assignments >
Health Indicator Assignments.
b. From the CI type hierarchy in the left pane, select the CI type which you are going to report
from your topology script. The assigned indicators for the CI type are displayed in the
Indicators pane. When you select an indicator, its details are displayed in the right pane.
c. Create a new HI assignment. For details on how to create the assignment, see "How to
Define a KPI or HI Assignment" in the BSM Application Administration Guide in the BSM
Help.
o

In the Monitored By property in the Condition area, enter a value that enables you to
distinguish between the CIs reported by this monitor and CIs of the same type which are
reported by other monitors. The condition of the assignment should correspond with the
CIs you report in the topology script (see "Create the custom topology script" on page 234).
Tip: It is recommended that the CI has the value "SiteScope" in the Monitored By
property, and that it has a unique value to enable you to differentiate between this CI
and CIs of the same type reported by other monitors. For this purpose, we recommend
using the Note property of the CI.

o

When you create the topology script for the monitor, enter the monitored_by attribute with
this value on the CI you report. For more details on topology scripts, see "Create the
custom topology script" on page 234.
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o

Choose the business rule to use for the HI calculation. We recommend using the
SiteScope Worst Status Rule. You can also use the SiteScope Consecutive Worst
Status Rule or SiteScope Best Status Rule.

o

In the selector, enter the following:
l

eti_id = (Binary) <<Health Indicator Type ID>>

l

ci_id = (Binary) <<CI ID>>

l

sampleType = (String) ss_t

The custom monitor sends metrics samples (ss_t) that contain the same eti_id as the HI
used in the assignment, and the same CI ID as the CI's.
Example: Indicator assignment for CI Type Computer in Service Health
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Example: Indicator configuration and selector settings in Service Health

3.

Define the custom monitor
In SiteScope, create the custom monitor and add the required data for the monitor settings in the
Main Settings, Advanced Settings, and Timeout Settings sections. You can choose from the
following custom monitors: Custom Monitor, Custom Database Monitor, Custom Log File Monitor,
Custom WMI Monitor.
For details on configuring these monitors, see the SiteScope Monitor Reference Guide.
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Example: Settings for a Custom Log File monitor

The complete strings used in the example are:
Content match: /([a-z])=([0-9]+),*([a-z])*=*([0-9]+)*,*([a-z])*=*([0-9]+)*,*([a-z])*=*([0-9]+)*,*
([a-z])*=*([0-9]+)*/
Match value labels: disk1,val1,disk2,val2,disk3,val3,disk4,val4,disk5,val5
4.

Create the data processing script
In the Data Processing Script section of the Custom Monitor Settings panel, enter the script for
processing the collected data.
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In the script, supply the CI resolution hint for the different metrics by using setCIHint method. For
an explanation on the format to use for the hint, see "CI Resolution Hint Formats" on page 389.
Note: An example data processing script is available in a text file attached to this PDF. To
view the attachment, select View > Navigation Panels > Attachments, and select
Custom_Monitor_Data_Processing_Script.txt.
When working in template mode with a template containing a custom monitor with the
example data processing script, you also need to define a variable SERVER_NAME. When
deploying the template, you need to enter a value for the server name.

5.

Create the custom topology script
In the HP Integration Settings panel, create the topology script that defines how to report CIs to
BSM.
a. In the BSM Integration Data and Topology Settings section, select the Custom topology
script option and develop a custom topology script that reports the CIs defined in the HI
assignment.
For the monitored_by attribute of the CI, you must enter SiteScope. This is the same value
you used in the HI assignment in "Define an HI Assignment" on page 230.
Note: An example custom topology script is available in a text file attached to this PDF.
To view the attachment, select View > Navigation Panels > Attachments, and select
Custom_Monitor_Topology_Script.txt.
In the example, you need to replace <IP Address>, <name>, and <Server DNS name>
with the relevant values.

Tip: It is recommended to perform a resynchronization of SiteScope if BSM is restarted
within 10 minutes after making changes to a monitor's topology settings. To do so, select
Preferences > Integration Preferences > BSM Integration > BSM Preferences
Available Operations, and click Re-Synchronize.
b. In the Indicator Settings section, configure the HI mappings using the HIs you used in the HI
assignment in "Define an HI Assignment" on page 230.
Note: Do not define more than one indicator mapping with different CI types that match
the same metric. For details on defining indicator mappings in SiteScope, see "Map
Indicators to metrics" on page 226. Alternatively, you can define the mappings in BSM in
Admin > System Availability Management > Metrics and Indicators and click
Publish Changes. The mappings are then downloaded to SiteScope and displayed in
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the user interface. For details on defining mappings in BSM, see How to Create and
Manage Indicator Assignments in the BSM Application Administration Guide in the BSM
Help.

Example: Indicator Mappings for Computer CI Type

6.

View Results
After you have configured the HI assignments in BSM and the monitor settings including the
topology script in SiteScope, you can run the monitor. After the monitor run has finished,you can
view the results in BSM's Service Health.
We recommend creating a view that shows the reported CIs for this monitor. After you save the
monitor and the monitor has run, you can see the results in BSM's Service Health in the view that
you created.
Example: View Created for CIs Reported for this Monitor in Service Health

Example: Indicator Status Results on the Monitored Machine in Service Health
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Monitors Not Reporting Topology Data By Default
Following is a list of monitors that do not monitor the status of a host or server.
Note: For these monitors to report CI information to BSM, you must select the CI type, enter the
required CI key attributes, and select an indicator relevant for the CI type linked to the monitor. For
task details, see "How to Configure Topology Reporting" on page 225.

l

Composite Monitor

l

Custom Log/Database/WMI Monitors

l

Directory Monitor

l

Dynamic JMX Monitor (when not monitoring WebLogic)

l

e-Business Transaction Monitor

l

File Monitor

l

Formula Composite Monitor

l

HP NonStop Event Log Monitor

l

JMX Monitor (when not monitoring WebLogic)

l

Link Check Monitor

l

Log File Monitor

l

Multi Log Monitor

l

Script Monitor
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l

SNMP Trap Monitor

l

Syslog Monitor

l

URL Monitor

l

URL Content Monitor

l

URL List Monitor

l

URL Sequence Monitor

l

XML Metrics Monitor

Monitors Reporting CI Per Metric
Following is a list of monitors that report CI per metric. Because these monitors have multiple CIs, you
cannot modify the CI for these monitors and you can modify the indicator mappings for these monitor
types from BSM only (in the SAM Admin > Metrics and Indicators tab).
l

SAP CCMS Monitor

l

SAP Work Processes Monitor

l

Siebel Application Server Monitor

l

Siebel Web Server Monitor

l

Solaris Zones Monitor

l

VMware Host CPU Monitor

l

VMware Host Memory Monitor

l

VMware Host Network Monitor

l

VMware Host State Monitor

l

VMware Host Storage Monitor

l

VMware Performance Monitor
Note: You can define a custom topology Node for the monitor and specify a host name for it. If
there is a remote server in any SiteScope connected to this BSM, this CI is automatically changed
to Unix or Windows CI type, depending on the environment of the remote server.
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Products
Performance metrics collected by SiteScope can be utilized by load testing analysis products and
solutions, for example, by HP LoadRunner and HP Performance Center. When running a load testing
scenario, it is sometimes necessary to correlate the behavior of the application under test with various
software and hardware performance metrics available from the system where the application is
running.

Learn About
This section includes:
l

"Supported SiteScope Installations/License Editions" below

l

"Supported LoadRunner/Performance Center Versions" below

l

"Differences Between SiteScope and SiteScope for Load Testing" on the next page

Supported SiteScope Installations/License Editions
The integration with LoadRunner or Performance Center is supported using either:
l

l

A regular SiteScope installation, using the Premium, Ultimate, or System Collector edition license.
A SiteScope for Load Testing installation, using the SiteScope for Load Testing license. This is a
free, non-IP locked license, that is instantly activated after a SiteScope for Load Testing
installation. This license provides a limited capacity of 25 OS instances and 25 URLs.

For details on SiteScope editions and licensing, see the SiteScope Editions and SiteScope Licensing
sections of the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

Supported LoadRunner/Performance Center Versions
For the list of supported LoadRunner and Performance Center versions supported in this release, refer
to the HP Integrations site:
l

l

HP LoadRunner: https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01695208
HP Performance Center: https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01695224
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Note: Access requires an HP Passport login (register for an HP Passport at
http://h20229.www2.hp.com/passport-registration.html).

Differences Between SiteScope and SiteScope for Load Testing
When using LoadRunner or Performance Center, you can choose a performance data collection option
through a native solution available in the products or through SiteScope. In a variety of cases,
SiteScope provides more monitoring options and deeper performance coverage of systems and
applications.
SiteScope for Load Testing is an installation option of SiteScope which is optimized for load testing
scenarios and provided for LoadRunner and Performance Center users. This installation type is not
meant to monitor production environments. As a result, some options which are available in a regular
SiteScope installation are not available in SiteScope for Load Testing.
The main differences between regular SiteScope and SiteScope for Load Testing are:
SiteScope for Load
Testing

SiteScope

Minimum run frequency for SiteScope
monitors

1 second*

15 seconds

Default run frequency (available when a
new monitor is created)

5 seconds*

10 minutes

SiteScope Reports

Not available

Available

Analytics

Not available

Available

Integration with BSM

Not supported

Supported

Description

*The Minimum run frequency for SiteScope for Load Testing monitors and the default run frequency
apply only for API executions.

Note: The integration between SiteScope and LoadRunner or Performance Center should be
configured in the respective load testing product and not in SiteScope. For more information, see
"How to Set Up the Monitoring Environment - Workflow", "Configuring Monitors User Interface",
and "SiteScope Resource Monitoring" in the HP LoadRunner Controller User Guide, and "Adding
Hosts" in the HP Performance Center Administrator Guide.

Tips/Troubleshooting
l

To enable SiteScope to integrate with LoadRunner, user authentication must be disabled in
SiteScope. For details, see "User Management Preferences" on page 732.
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l

To use LoadRunner or Performance Center with a regular SiteScope installation, you must set the
value for Minimal monitor run interval (seconds) in Preferences > Infrastructure Preferences
> Server Settings to 1 (second) to avoid frequency validation errors.

l

Integration between SiteScope for Load Testing and BSM is not supported.

l

The Dashboard Monitor History view is not supported in SiteScope for Load Testing.

l

The integration between SiteScope and LoadRunner does not support user authentication when
using a version of LoadRunner earlier than 12.00.
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You can export SiteScope related data from BSM to Application Lifecycle Management (ALM) and vice
versa. Exporting data to ALM enables you to plan scripts and load tests that resemble your production
environment, and importing data from ALM enables you to use scripts and SiteScope configurations
that have already been tested.

To access
In BSM, select Admin > Integrations > Application Lifecycle Management Integration.

Learn About
This section also includes:
l

"Export Data from BSM (SiteScope) to ALM" below

l

"Import Data from ALM to BSM (SiteScope)" below

Export Data from BSM (SiteScope) to ALM
You can export SiteScope configuration data for a single application. The exported data includes
information about the SiteScope metrics, templates, and topology data. Sharing such information
between operations and development assists you in planning your scripts and load tests in ALM, so
that they better resemble your production environment.

Import Data from ALM to BSM (SiteScope)
You can import data from ALM that includes SiteScope configuration templates. Sharing such
information between development and operations enables you to use SiteScope configurations that
have already been tested and fine tuned. Imported SiteScope configuration templates are stored in the
SiteScope template tree for each SiteScope registered to BSM. A default directory called
AutoSyncContainer is created in the SiteScope root folder, and for each application for which a
template is imported, a sub-directory is created with the application name.

Tasks
How to export data from BSM to ALM
For details, see the Application Lifecycle Management Integration page in the BSM Application
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Administration Guide in the BSM Help.

How to import data from ALM to BSM (SiteScope)
1. Prerequisites
n

The SiteScope Administrator user must be configured with a user name and password (it
cannot be left blank).

n

The passphrase string for all HP software applications integrated using LW-SSO must be
identical. Make sure that LW SSO Init String in SiteScope Preferences > General
Preferences > LW SSO Settings matches the string in BSM.

2. In Performance Center, design and create a performance test. For details, refer to the task on how
to design a performance test in the HP ALM Performance Center User and Administrator Guide.
3. Import the .zip file from ALM that includes the SiteScope configurations
a. In BSM, select Admin > Integrations > Application Lifecycle Management Integration >
Import from ALM.
b. In the Select File box, enter the path to the .zip file you want to import, or click Browse to
open a dialog box in which you can browse to the required .zip file.
For details on creating the .zip file for importing, refer to the ALM documentation.
c. Click Upload Content to upload the content of the selected .zip file. The upload status is
displayed.
Note:
n

If you previously imported data from ALM, the data is deleted and replaced with the latest
.zip file. To avoid losing changes made to previously imported templates, rename the
templates to avoid these changes being lost.

n

If you have already deployed monitors from synchronized templates and then import
another .zip package that does not contain the necessary templates, these monitors will
be unlinked from the templates that should be deleted.

For more details, see the Application Lifecycle Management Integration page in the BSM Help.
4. Edit and publish changes to templates in SiteScope - optional
Imported SiteScope configuration templates are copied to the following location within each
SiteScope registered to BSM:
Templates > SiteScope root folder > AutoSyncContainer > < application name>
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You can make changes to the templates, and manually deploy the templates. For details on
deploying templates, see "Deploy Templates" on page 847.
Tip: It is recommended to rename any imported templates that you modify in order to avoid
these changes being overwritten the next time data is imported from ALM.
You can also publish changes to templates using the Publish Template Changes Wizard. For
details, see "Publish Changes to Templates" on page 877.
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Group containers help you organize the monitor instances that you create. Monitor instances that you
create must be added within a SiteScope monitor group container. For details, see "Create Groups in
SiteScope" on page 245.
SiteScope monitors are tools for automatically connecting to and querying different kinds of systems
and applications used in enterprise business systems. The different monitor types provide the generic
capabilities for performing actions specific to different systems. You create one or more instances of a
monitor type to instruct SiteScope how to monitor specific elements in your IT infrastructure. For
details, see "Create Monitors in SiteScope" on page 252.
You can create custom monitors to broaden the capabilities of regular SiteScope monitors by
developing your own solutions for environments that are not supported by predefined SiteScope
monitors. For details, see "Create Custom Monitors" on page 319.
You can create baselines and schedule specific thresholds based on a time period or date. Baselines
enable you to understand how your applications typically perform and determine whether a performance
problem is an isolated incident or a sign of a significant downward performance trend. For details, see
"Set Monitor Thresholds Using a Baseline" on page 326.
You can also configure thresholds based on calculated metrics—a metric produced by performing an
arithmetic function or logical operation on existing SiteScope metrics. For details, see "Create
Calculated Metrics" on page 359.
SiteScope provides various dynamic monitors that automatically update themselves over time by
adding and removing counters as changes occur in your IT environment. For details, see "Dynamic
Monitoring Mechanism" on page 370.
SiteScope also includes the capability to monitor XML documents. For details, see "Monitor XML
Documents" on page 373.
Tip:
l

l

For details on monitor settings for a specific SiteScope monitor, including supported versions
and platforms, and a list of counters or metrics that can be configured for the monitor, see the
monitor type in the SiteScope Monitor Reference Guide.
You can also use the SiteScope API when working with monitors. For details, see "SOAPbased APIs" on page 159.

HP SiteScope (11.31)

Page 244 of 1395

Chapter 21: Create Groups in SiteScope
You create group containers to make the deployment of monitors and associated alerts manageable
and effective for your environment and organization. It is also useful to group monitors that should
generate similar alerts.

To access
Select the Monitors context. In the monitor tree, right-click the SiteScope container or an existing
monitor group, and select New > Group.

Learn About
This section includes:
l

"SiteScope Groups Overview" below

l

"Copying or Moving Existing Groups" on the next page

l

"Creating Group Alerts and Reports" on the next page

SiteScope Groups Overview
You create groups that reflect your environment, and for organizing your monitors in SiteScope. A group
is a collection of one or more monitors. It might contain several of one type of monitor, such as URL
monitors, or several different monitors that track a specific part of your Web environment, such as a
Web server, URL, and network parameters related to a specific transaction.
Each SiteScope monitor instance that you create must belong to a SiteScope group, either a top level
group or a subgroup nested within other group containers.
For example, if you intend to monitor a large number of processes running on your system, you may
want all of them to be in a single group named Processes. If you are monitoring processes on several
machines using remote monitors, you could create a primary group called Processes with several
subgroups named after each of the remote machines that you are monitoring.
When you add a new monitor you either add it to an existing group, or you must first create a group for
it. You can add groups individually to SiteScope, or you can deploy groups along with multiple monitors
by using templates. For details on templates, see "Create Templates" on page 782.
You can perform mass operations on group objects using the Manage Groups and Monitors feature.
This enables you to perform move, copy, delete, run monitors in group, enable/disable monitors, and
enable/disable associated alert actions on multiple SiteScope objects. For details, see "Perform
Actions on Multiple Groups and Monitors" on page 84.
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Note: You can also use the SiteScope API when working with groups. For details, see "SOAPbased APIs" on page 159.

Copying or Moving Existing Groups
In addition to creating groups, you can copy or move existing groups to a new location within the
SiteScope tree. Copying or moving a group duplicates the configuration settings for the group and all
monitors within the group. After copying or moving a group, you normally need to edit the group and the
configuration properties for each individual monitor within the group to direct the monitors to a unique
system or application. Otherwise, the monitors in the group duplicate the monitoring actions of the
original group.
Tip: Instead of copying groups which can lead to redundant monitoring, use templates to more
efficiently replicate common group and monitor configuration patterns. For more information about
working with templates, see "Create Templates" on page 782.

Note:
l

l

To avoid group identity problems within SiteScope, object names must be unique within the
parent group. If you copy or move a group to another group in which there is group with exactly
the same name, SiteScope automatically adds a suffix (number) to the end of the
copied/moved group's name.
You cannot move or copy a monitor group to its subgroup.

Creating Group Alerts and Reports
After creating a group, you can create alerts and reports for the group. By default, group alerts and
reports are associated with all monitors within the group.
You create an alert by adding an alert definition to a group container. This means that when any one
monitor in the group reports the status category defined for the alert (for example, error or warning),
the group alert is triggered. You can configure a group alert to exclude one or more of the monitors in the
group by using the Alert targets selection tree. For details on this topic, see "Configure SiteScope
Alerts" on page 1243.
You create a group report by adding a report definition to a group container. You can configure a group
report to exclude one or more of the monitors in the group by using the Monitors and groups to report
on selection tree. For details on this topic, see "Reports" on page 1319.
If you delete a group, SiteScope removes the applicable monitor actions and disables any alert actions
associated with the group.
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Tasks
How to Manage a Group
1.

Create SiteScope groups and subgroups
Create groups according to the monitor hierarchy which you want to implement. For example, you
can create groups of locations, server types, network resources, and so forth.
n

Create a new group. Right-click the SiteScope or group container in which to create the
group, and select New > Group. For user interface details, see the UI Descriptions section
below.

n

Create a group by copying or moving an existing group.
o

Right-click the group you want to copy, and click Copy. Right-click the location in the
monitor tree where you want to copy the group container, and click Paste.

o

Right-click the group you want to move, and click Cut. Right-click the location in the monitor
tree where you want to move the group container, and click Paste.

o

To copy or move multiple monitors and groups to a target group, click the Manage Monitors
and Groups
button in the monitor tree toolbar. Select the objects for copying or moving
and click Copy/Cut. Select the destination group and click Paste. For details, see "Perform
Actions on Multiple Groups and Monitors" on page 84.

2.

Add URL links to group descriptions - optional
You can add additional information to describe a group, and include HTML tags for hyperlinks to
enable you to access URLs from the SiteScope Dashboard.
a. To add a hyperlink, open the Properties tab for the selected group.
b. Expand the General Settings panel and enter the URL in the Group description field. For
example, <a href="http://www.hp.com">My Link</a>.
c. Click the Dashboard tab. A URL is displayed in the Description field for the selected group.
To open the URL, click the group's Description field, and then click the link.
Tip: To automatically adjust the row height to make all cell contents visible in the
Dashboard, select the Wrap text option in Dashboard Settings. For details, see
"Dashboard Settings Dialog Box" on page 1046.
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3.

Create monitor instances
Select the monitor instances you want to add to the group.
For task details, see "How to Create and Deploy a Monitor" on page 262.

4.

Set group dependencies - optional
You can set group dependencies to make the running of monitors in this group dependent on the
status of another monitor.
For concept details, see "Monitoring Group Dependencies" on page 255.
Example: The monitors in the group being configured run normally as long as the monitor
selected in the Depends on box reports the condition selected in the Depends condition
box. In this example, the group being configured is enabled only when the Service monitor
reports a status of Good.

5.

Set up group alerts - optional
Create alerts to send notification of an event or change of status in some element or system in
your infrastructure.
To create an alert for the group, right-click the group and select New > Alert. For each alert
scheme, you can create one or more alert actions. In the New Alert dialog box, click New Alert
Action to start the Alert Action wizard.
For task details, see "How to Configure an Alert" on page 1247.

6.

Set up group reports - optional
Create reports to display information about how the servers and applications you are monitoring
have performed over time.
To create a report for the group, right-click the group and click Reports. Select a report type and
configure the report settings.
For task details, see "Create SiteScope Reports" on page 1320.

7.

Results
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The monitor group, including its monitors, alerts, and reports, is added to the monitor tree.

UI Descriptions
New SiteScope Group Dialog Box
The New SiteScope Group dialog box enables you to define a new group for SiteScope, or a subgroup
for an existing monitor group.
Important
information

l

l

l

Only a SiteScope administrator user, or a user granted the appropriate
permissions can edit, refresh, or disable groups. For details on user permissions,
see "Permissions" on page 744.
You cannot delete a monitor group if it has dependent alerts or reports at the
container level. To delete a monitor group with dependencies, you must remove
the monitor group from Alert Targets and Report Targets for each dependency,
and then delete the monitor group. You can delete monitor groups that have
dependencies at the child level.
You can also use the SiteScope API when working with groups. For details, see
"SOAP-based APIs" on page 159.

The following elements are found throughout the New SiteScope Group dialog box:

General Settings
UI Element

Description

Group
name

Name that describes the content of the group, or the purpose of the monitors added to
the group. For example, <host_name> or <business_unitresource_name> or
<resource_type>.
Note:
l

l
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UI Element

Description

Group
Description of the group. This can include the most common HTML tags for text
description styling, such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed
only when viewing or editing the group's properties in the SiteScope Dashboard. For
details on adding a hyperlink, see "Add URL links to group descriptions - optional" on
page 247.
Note:
l

l

This field does not support JavaScript/iframes/frames or other advanced features.
HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than
one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected. The following is prohibited HTML content:
n

Tags: script, object, param, frame, iframe.

n

Any tag that contains an attribute starting with on is declined. For example,
onhover.

n

Any attribute with javascript as its value.

If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Source
template

Displays the path of the source template if the group was created from a template. If
you are using deployed templates created in older versions of SiteScope, enables you
to manually associate the root groups with the source template by entering the path of
the source template.

Clear

Removes the source template associated with the root group.

Dependencies
UI
Element
Depends
on

Description
The monitor on which you want to make the running of this monitor group dependent.
Click the Depends on
button to open the Select Depends On Monitor dialog box,
and select the monitor on which you want to create a dependency. For user interface
details, see "Select Depends On Monitor Dialog Box" on page 316.
For concept details, see "Monitoring Group Dependencies" on page 255.
Default: No dependency is set for a monitor group.
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UI
Element

Description

Depends The Depends condition that the Depends on monitor should have for the current
condition monitor group to run normally. If the selected condition is not satisfied then the monitor
selected in the Depends on box is automatically disabled. The conditions are:
l

Good

l

Error

l

Available

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
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SiteScope collects data samples from components in your infrastructure using out-of-the-box monitors
and custom monitors. These are tools that connect to and query different kinds of systems and
applications. You configure monitors to collect the data from remote servers you want to monitor.

To access
Select the Monitors context. In the monitor tree, right-click a group and select New > Monitor.

Learn About
This section includes:
l

"Monitor Types" below

l

"Monitoring Remote Servers" on page 255

l

"Monitoring Group Dependencies" on page 255

l

"Setting Status Thresholds" on page 259

Monitor Types
SiteScope monitors are grouped according to classes that indicates their availability and category that
reflect their function. When you select to add a new monitor to a SiteScope agent, the list of available
monitor types for that agent are displayed both alphabetically and divided by category in the product
interface. The availability of the monitor category is dependent on the class of monitor.
Note: User permissions and credentials are needed to access each monitor. For details on the
required permissions and credentials, and the corresponding protocol used by each monitor, see
Monitor Permissions and Credentials in the SiteScope Monitor Reference Guide.
This section describes the monitor classes and the category listing formats. To see the list of monitors
contained in each monitor category, see "Monitor Categories List" on page 269.

Standard Monitors
Standard monitor categories represent the monitor categories available with a general SiteScope
license. These monitor categories include many of the general purpose monitor categories.
l

Application Monitors. Monitors in this category monitor third-party applications. These monitors
enable SiteScope to access and retrieve data from the monitored applications.
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l

l

l

l

Big Data. Monitors in this category monitor Big Data platforms to gain real-time visibility and insight
into the health and performance of the big data infrastructure.
Database Monitors. Monitors in this category monitor different types of database applications.
There are monitors that access data from specific database applications and generic monitors that
can be configured to monitor any database application.
Generic Monitors. Monitors in this category monitor different types of environment. These
monitors can monitor networks, applications, and databases depending on how they are configured.
Media Monitors. Monitors in this category monitor applications that play media files and stream
data.

l

Network Monitors. Monitors in this category monitor network health and availability.

l

Server Monitors. Monitors in this category monitor server health and availability.

l

l

Virtualization and Cloud Monitors. Monitors in this category monitor virtualized environments
and cloud infrastructures.
Web Transaction Monitors. Monitors in this category monitor web-based applications.

Customizable Monitors
Custom monitors broaden the capabilities of regular SiteScope monitors for tracking the availability and
performance of your infrastructure systems and applications. Using custom monitors, you can develop
your own solutions for environments that are not supported by predefined SiteScope monitors.
You can create your own monitor that collects data, and define a script that processes the collected
data and creates metrics. Each time the custom monitor runs, it updates the metrics and returns a
status for the metrics defined in the script.
Custom monitors can be published to the HP Live Network for sharing with other SiteScope users. For
more details on using Custom monitors, see "Create Custom Monitors" on page 319.

Dynamic Monitors
Dynamic monitors automatically adjust the SiteScope monitoring configuration based on changes that
are happening in your IT environment.
SiteScope provides various dynamic monitors that automatically update themselves over time by
adding and removing counters and thresholds as virtual machines move from one host system to
another. In addition, baselining is supported, where thresholds are dynamically changed based on
historical monitoring data.
Dynamic monitors include:
l

Dynamic Disk Space Monitor

l

Dynamic JMX Monitor
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l

Generic Hypervisor Monitor

l

Hadoop Monitor

l

HP Vertica JDBC Monitor

l

KVM Monitor

l

VMware Datastore Monitor

l

VMware Host Monitors

Integration Monitors
Integration monitors are used to capture and forward data from third-party domain managers or
applications (typically Enterprise Management Systems (EMS)) into BSM.
These monitor types require additional licensing and may only be available as part of another HP
product. For more information about Integration Monitor capabilities, see "Integration Monitors
Overview" on page 377.

Solution Template Monitors
Solution template monitor types are a special class of monitors that enable new monitoring capabilities
for specific applications and environments. As part of a solution template, these monitor types are
deployed automatically together with other, standard monitor types to provide a monitoring solution that
incorporates best practice configurations. After deploying solution templates, you can edit or delete
them using the same steps as with other monitor types. For more information, see "Deploy Solution
Templates" on page 896.
SiteScope provides the following solution templates that include standard SiteScope monitor types and
solution-specific monitors:
l

Active Directory (with and without Global Catalog)

l

AIX Host

l

Apache Cassandra

l

Apache Tomcat

l

Hadoop

l

HP Quality Center

l

HP Service Manager

l

HP Vertica

l

JBoss Application Server

HP SiteScope (11.31)

Page 254 of 1395

Using SiteScope
Chapter 22: Create Monitors in SiteScope

l

Linux Host (OS )

l

Microsoft Exchange

l

Microsoft IIS Server

l

Microsoft Lync Server

l

Microsoft SharePoint

l

Microsoft SQL Server

l

Microsoft Windows Host

l

.NET

l

Oracle Database

l

SAP Application Server

l

Siebel Application/Gateway/Web Server (for UNIX and Windows)

l

VMware Capacity Management

l

VMware Host CPU/Memory/Network/State/Storage

l

VMware Host For Performance Troubleshooting

l

WebLogic Application Server

l

WebSphere Application Server

Monitoring Remote Servers
The requirements for monitoring services and applications that are running on remote servers vary
according to the application and network policies in your environment. Some SiteScope monitors use
Internet protocols to test Web systems and applications. Other SiteScope monitors use network file
system services and commands to monitor information on remote servers.
For information about how SiteScope monitors connect to remote systems, see "How to Configure
SiteScope to Monitor a Remote Microsoft Windows Server" on page 470 and "Configure SiteScope to
Monitor Remote UNIX Servers" on page 492.

Monitoring Group Dependencies
To prevent redundant alerting from multiple monitors that are monitoring different aspects of a single
system, select one monitor to check the basic availability of the system and then create other monitors
that perform more detailed tests of that system. This creates a dependency relationship that enables
you to make the running of a monitor group dependent on the status of a selected monitor.
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When creating dependencies in templates, you can enter the full path or a relative path to a dependent
monitor in the Dependencies panel. You can also have SiteScope ignore dependency changes when
publishing template changes.
For information about configuring dependency settings, see "Depends On" below and "Depends
Condition" on the next page.

Depends On
You can use this option to make the running of a monitor dependent on the status of another monitor.
This can be used to prevent redundant alerting from multiple monitors that are monitoring different
aspects of a single system. You can create a simple system monitor to check the basic availability or
heartbeat of a system, and then create other monitors that perform more detailed tests of that system.
The figure below shows an example dependency relationship where three system monitors have been
made dependent on a Service Monitor instance.

You can make the detailed test monitors dependent on the status of the heartbeat monitor by selecting
that monitor. This means the dependent monitors run as long as the dependency condition is satisfied.
If the heartbeat monitor detects that the target system has become unavailable, the dependency
relationship automatically disables the other monitors. This has the effect of disabling any alerts that
would have been generated by those monitors. The figure below shows the example monitors are
disabled because the monitor on which they depend is reporting an error condition.
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By default, no dependency is set for a monitor instance. To make the running of the monitor dependent
on the status of another monitor, expand the node in the SiteScope tree containing the monitor to which
to you want to create dependence, and select the check box next to the required monitor. To remove
dependence on a monitor, clear the required check box.

Depends Condition
If you choose to make a monitor dependent on the status of another monitor (by using the Depends on
setting), you use this option to select the status category or condition that the Depends on monitor
should have for the current monitor to run normally.
The status categories include:
l

Good

l

Error

l

Available

l

Unavailable

The monitor being configured is run normally as long as the monitor selected in the Depends on box
reports the condition selected in this box. If you have selected Unavailable and the Depends on
monitor reports this status, the current monitors are not disabled.
For example, by selecting Good, this monitor is only enabled as long as the monitor selected in the
Depends on box reports a status of Good. The current monitor is automatically disabled if the monitor
selected in the Depends on box reports a category or condition other than the condition selected for
this setting. See the examples for "Depends On" on the previous page.

Dependencies When Configuring Template Monitors and Groups
When deploying monitors and groups using a template, monitor and group dependencies are also
published. This enables the template to automatically write the groups and monitors into their proper
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place in the tree and automatically create any number of dependencies, without you having to do this
manually.
If a change is required to a template monitor dependency, you can update the template once and
publish the changes to all deployed groups without having to update each monitor individually. For
details, see "Publish Changes to Templates" on page 877.
Alternatively, if you do not want dependency settings for selected monitors and groups in the source
template to overwrite dependency settings in deployed template objects, select the Ignore
dependencies when publishing changes check box in the Dependencies panel. When template
changes are published to the deployed objects, dependency settings for the selected template monitors
and groups are ignored and the existing dependency settings in the deployed objects are preserved.
When configuring a template, you can create monitor and group dependencies to existing monitors that
are not part of the current template. This avoids having to recreate the tree structure within the
template. You do this in the Depends on box of the monitor or group template, by entering the full or
relative path to the monitor in the monitor tree.
For example, you can enter:
l

Full path:
<group name>\<group name>\<monitor name>

l

Relative path:
..\..\<group name>\<monitor name>

Template Dependency Recommendations:
Use Case

Template Dependency Recommendations

All depended on monitors are in a heartbeat
monitor group.

Use the full path to the depended on monitor.

Templates are deployed in the same structure
for a given host.

Use the relative path to the depended on monitor.

For a given host, you have monitor groups
(such as a basic system monitors template,
application template, etc) and a heartbeat
monitors group; both are located under the
host group.
Inside the template dependency (existed
before SiteScope 11.20).
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Use Case

Template Dependency Recommendations

Self Managed dependency.

If monitor dependencies were set in the monitors
view, use the Ignore dependencies when
publishing changes option so as not to override
them when publishing template changes to
deployed groups.

Setting Status Thresholds
When you configure a monitor, you can determine whether its performance thresholds are determined
by static thresholds (specific threshold values that you configure), or are calculated using baselines
based on historical transaction data.
Tip: Having SiteScope calculate thresholds using baselines instead of setting thresholds
manually is useful to indicate data volatility, where current monitor readings significantly deviate
from monitor previous runs. For details, see "Set Monitor Thresholds Using a Baseline" on page
326.
You can set thresholds manually by setting logic conditions that determine the reported status of each
monitor instance. The status is based on the results or metrics returned by the monitor action on the
target system as compared to the thresholds set for the monitor.
You can set status threshold criteria for each monitor instance to determine an Error, Warning, and
Good status. Each status threshold consists of a metrics parameter, a logic comparison operation, and
a metrics value that you may specify. The parameter and the value depend on the monitor type. For
example, the metrics parameter for a CPU monitor is CPU utilization (%).
You can set up one or more status threshold criteria for each status condition. Most monitor types
include one default setting for each of the three status conditions. Default thresholds of the monitor
appear when you first configure the monitor. When the monitor is not available, it is assigned a status
that is based on the user definition in the If Unavailable drop-down list. A monitor can have a state of
Unavailable as well as a status of Good, Warning, or Error. Alerts are triggered according to
availability, status, or both availability and status.
For dynamic monitors (such as Disk Space or VMware Host), you can display thresholds for all regular
expression patterns that are translated to actual current counters. Patterns enable the monitor to
automatically configure itself with counters on the relevant dynamic environment components. For
more details, see Dynamic Monitoring Mechanism in the SiteScope Monitor Reference Guide.
This section includes:
l

"Scheduling" on the next page

l

"Impact of Threshold Status" on the next page

l

"Setting Multiple Thresholds" on the next page

l

"Indicator Mappings when Reporting Topology to BSM" on the next page
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Scheduling
You can select a schedule to determine the status of the monitor instance if you want to define when to
check the monitor run result against the threshold. This is useful if you want to restrict checking the
monitor run results against the threshold to certain days or hours only. For example, you may want the
monitor status to be based on results gathered during business hours only. At times outside the
threshold schedule period, the monitor is assigned the predefined status in the Default status box. By
default, monitor run results are checked against the threshold on an Every day, all day schedule.

Impact of Threshold Status
A change of status can have the following impact:
l

l

l

It signals an event and acts as a trigger for alerts associated with the monitor or the group to which
the monitor belongs. For example, if the monitor detects that the system has become unavailable,
the status change from Good to Error is used to trigger an alert on error.
It can affect the state of a dependency between monitors. For example, a monitor that detects a
change that results in an Error status may be a trigger to disable one or more other monitors that are
dependent on the system. For information about dependency settings, see "Monitoring Group
Dependencies" on page 255.
It can affect the status of the monitor in the SiteScope Dashboard. When viewing SiteScope data in
the Current Status tab of Dashboard, you can drill down in the monitor tree to view monitor and
measurement status and availability. The status is displayed by color and a status icon in the
SiteScope Dashboard. For information on measurement status and availability in the Dashboard
user interface, see "SiteScope Dashboard - Current Status View" on page 1051.

Setting Multiple Thresholds
The individual threshold criteria results are combined as logical OR relationships when more than one
threshold condition is defined for any of the three settings. When one or more of the conditions (for
example when two conditions for Error if setting) are met for a status setting the monitor status is set
to the corresponding status condition. If status conditions are met for more than one status condition
setting the status of the monitor is set to the highest valued status condition.
For example, if one condition selected as Error if and another condition selected as Warning if are
both met, the status would be reported as an Error, with Error being the highest value, Warning the
next highest, and Good the lowest value.

Indicator Mappings when Reporting Topology to BSM
When SiteScope is reporting data to BSM, indicators provide a more detailed view of the health of a
configuration item (CI). For details on understanding indicators, see "Health Indicators, KPIs, and KPI
Domains" in the BSM User Guide in the BSM Help.
When configuring thresholds for a monitor metric, monitors that have a defined topology and a default
mapping have an indicator state and severity value assigned to the metric status by default.
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Every indicator can have several states. For example, when measuring CPU Load, the indicator
state might be Bottlenecked or Busy, whereas when measuring Memory Load, the indicator state
might be Paging or Starving for Memory.

l

Indicator severity is the severity corresponding to the indicator state. The available indicator
severity levels are Critical, Major, Minor, Warning, Normal, and Unknown.

l

Indicator states are assigned to the metric status according to the closest available severity that exists
in the states for the indicator associated with the metric. The selected severity is shown in the
SiteScope threshold.
Example:
l

l

When measuring percent used on a Memory monitor, the metric is mapped to Major severity
in the Error threshold, since Critical severity is not available for the Memory Load indicator.
When measuring round trip time on a Ping monitor, the closest severity level in the
Warning threshold is Major, since the Minor severity level does not exist for this indicator
state.

The Good threshold is always mapped to the Normal severity level.
The association between the indicator state and severity cannot be changed on the local SiteScope
server.
If you select a different indicator mapping in the HP Integration Settings panel for the monitor, the
indicator state and severity values are updated in the Threshold Settings.
Note: If the Indicator State and Severity box is empty, the metric is not colored in Service
Health, except for always (default) which is automatically assigned.
The default indicator assignments (mappings) are stored in the Indicator Assignment Settings in SAM
Administration. For details, see "Indicator Assignment Settings" in the BSM User Guide in the BSM
Help.
When there is a change to an assignment in the Indicator Assignment Settings, SiteScope detects the
change and downloads the updated assignments. If indicator assignments have been changed on a
local SiteScope server, these assignments are not overridden by the Indicator Assignment Settings.
This includes indicator states where the state selected in the user interface is the same as the default
value.
Note:
l

If overlapping thresholds have been set (for example, Error if cpu utilization > 80% and
Error if cpu utilization > 90%), the indicator state and severity value that is mapped to
the closest threshold value is sent. In this example, if the actual metric value is 95%, then the
indicator value that is mapped to Error if cpu utilization > 90% is sent. This is
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applicable only to thresholds where the values are numeric.
l

Indicator state and severity are not displayed in SiteScope reports.

"Reference Information: Monitors" on page 268

Tasks
How to Create and Deploy a Monitor
This task describes the steps involved in deploying a monitor.
1.

Prerequisites
n

Check if there are setup requirements and user permissions that need to be obtained for the
monitor before configuring the monitor. For details, see the help for the specific monitor in the
SiteScope Monitor Reference Guide.

n

Monitors must be created in a group in the monitor tree. For task details, see "Create
SiteScope groups and subgroups" on page 247.
Note: To enable SiteScope to monitor data on remote servers, you must configure remote
servers. For details on configuring a Windows remote server, see "Configure SiteScope to
Monitor Remote Windows Servers" on page 470. For details on configuring a UNIX remote
server, see "Configure SiteScope to Monitor Remote UNIX Servers" on page 492.

2.

Create monitor instances
a. To create a new monitor instance, right-click the group into which you want to add the monitor
instance, and select New > Monitor. For user interface details, see "New Monitor Dialog
Box" on page 265.
Note: Alternatively, you can create a new monitor instance by copying or moving existing
monitor instances to the group in the monitor view. For details, see "Copy and Move
SiteScope Objects" on page 87.
b. Select the monitor you want to add from the New Monitor dialog box, and configure the
settings for the specific monitor. For a description of the monitor settings, see the help for the
specific monitor in the SiteScope Monitor Reference Guide.
c. You can configure other properties that affect the monitor. For example:
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o

In the Monitor Run Settings panel, you can set how often SiteScope attempts to run the
action defined for the monitor instance. You can also set the range schedule if you want the
monitor to run on certain days or on a fixed schedule. For user interface details, see
"Monitor Run Settings" on page 287.

o

In the Dependencies panel, you can set monitor dependencies to make the running of this
monitor dependent on the status of another monitor. For user interface details, see
"Dependencies" on page 289.
Example:
The monitor being configured is run normally as long as the monitor selected in the
Depends on box reports the condition selected in the Depends condition box. In this
example, the monitor being configured is enabled only when the Service monitor reports
a status of Good.

o

In the Calculated Metrics panel, you can manually configure calculated metrics to
calculate the relation between two or more metrics for one or more monitors. For user
interface details, see "Calculated Metrics Settings" on page 363.

o

In the Threshold Settings panel, you can manually set logic conditions that determine the
reported status of each monitor instance. For user interface details, see "Threshold
Settings" on page 291.
Alternatively, you can set thresholds for one or multiple monitors using a baseline. For task
details, see "How to Set Monitor Thresholds Using a Baseline" on page 327.
Example:
The following shows the default threshold settings for a disk space monitor:
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Disk space of less than 95 percent full results in a good status; disk space greater than
95 percent full but lower than 98 percent full results in a warning status; disk space
greater than 98 percent full or "n/a" results in an error status.

3.

o

In the Logging Settings panel, you can create a dedicated log file for the selected monitor
instance and view that file from this panel. You can also enable debugging for perfex
process. For user interface details, see "Logging Settings" on page 314.

o

In the Search/Filter Tags panel, define a keyword search/filter tag, assign it to one or
more monitors, and then use the tag to search or filter the display so that only the monitors
you want to see are displayed. For details, see "Filter Objects in the SiteScope View" on
page 74.

o

For details of the other common monitor properties, see "Common Monitor Settings" on
page 283.

Set up monitor alerts - optional
Create alerts to send notification of an event or change of status in some element or system in
your infrastructure.
To create an alert for the monitor, right-click the monitor and select New > Alert. For each alert
scheme, you can create one or more alert actions. In the New Alert dialog box, click New Alert
Action to start the Alert Action wizard.
For task details, see "Configure SiteScope Alerts" on page 1243.
Note:
n

You can disable alerts associated with specific groups and monitors in the SiteScope tree
from the Enable/Disable Associated Alerts panel in the monitor Properties tab, or by
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clicking the Enable/Disable Associated Alerts
icon in the Dashboard and selecting
the required disable option. Note that this disables only the triggers that come from that
specific monitor. If an alert is assigned to more the one monitor, the alerts on the other
monitors are unaffected and keep working. When an associated alert is disabled from the
Properties tab, the alert itself is still enabled in the Alerts tab.
n

You can filter the SiteScope tree to show all groups and monitors with associated alerts
enabled or disabled by clicking the Filter
button in the tree toolbar, and selecting
Enabled or Disabled from the Enable/Disable Associated Alerts list in the Filter
Options section. The results of this filter appear in the monitor tree.

4.

Set up monitor reports - optional
Create reports to display information about how the servers and applications you are monitoring
have performed over time.
To create a report for the monitor, right-click the monitor and click Reports. Select a report type
and configure the report settings.
For task details, see "Create SiteScope Reports" on page 1320.

5.

Configure analytics - optional
Configure analytics which enables SiteScope to anticipate potential problems on business
monitors and alert users of issues in critical applications before they occur. Analytics is also able
to provide details to assist with root cause analysis to help expedite problem resolution.
For details. see "Configure Predictive Analytics" on page 1375.

6.

Results
The monitor is added to the monitor group in the monitor tree with the configuration settings that
you specified displayed in the Properties tab.

UI Descriptions
New Monitor Dialog Box
The New Monitor dialog box enables you to define a new monitor in a monitor group.
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User interface elements are described below:
UI Element

Description

Quick
Search

Enter a monitor name in the Quick Search box. You can select the following settings
to help you with your search:
l

All. Search for matches in all columns.

l

Monitor. Search for matches in the Monitor column only.

l

Category. Search for matches in the Category column only.

l

Case sensitive. Search for matches that are case sensitive.

l

Case insensitive. Search for matches that are not case sensitive.

l

l

l

l

Use wild cards. Enables you to use wild card characters in your search. For
example, use an asterisk wildcard (*) to represent a string of characters, or a
question mark wild card (?) to represent one character only.
Match from start. Search for monitors/monitor categories that match the search
text from the start.
Match exactly. Search for monitors/monitor categories that exactly match the
search text.
Match anywhere. Search for monitors/monitor categories that contain the search
text somewhere in the name.

Recently
Used
Monitors

Displays the five most recently selected monitors. Click a link to create a new monitor
for the selected monitor type.

Monitor

Displays the list of SiteScope monitors. Select a monitor from the list by clicking the
monitor link. A grayed-out link indicates that the monitor is not available.

Note: The displayed monitors may change as more selections are made.

You can change the order of the listed monitors, by clicking the column header. An
arrow is displayed to indicate the sort order (ascending or descending).
You can also select a monitor by clicking the arrow to the right of the Monitor heading,
and selecting a monitor from the list, or you can choose (Custom...), which enables
you to customize the monitor filter using various conditions.
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UI Element

Description

Category

Displays the list of monitor categories.
You can change the order of the listed categories, by clicking the column header. An
arrow is displayed to indicate the sort order (ascending or descending).
To select a monitor by category, click the arrow to the right of the Category heading,
and select a category from the list detailed below.
l

l

(All) - This is the default setting.
(Custom...) - Enables you to customize the category filter using various
conditions.

l

Application

l

Customizable

l

Database

l

Generic

l

Integration

l

Media

l

Network

l

Server

l

Virtualization and Cloud

l

Web Transaction

For the monitors in each category, see "Monitor Categories List" on page 269.
Availability Displays the monitor availability status (Available/Not Available).
You can change the availability status order, by clicking the column header. An arrow
is displayed to indicate the sort order (ascending or descending), or by clicking the
arrow to the right of the Availability heading, and selecting a status.
Other Related UI Pages: "SiteScope Monitors User Interface" on page 282
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Tips/Troubleshooting
General Notes and Limitations
l

l

l

Monitors can be created only in a SiteScope group.
Only a SiteScope administrator user, or a user granted the appropriate permissions can create, edit,
refresh, disable, or acknowledge monitors. For details on user permissions, see "Permissions" on
page 744.
To avoid leaving hanging groups when deleting monitors (if no other monitors are deployed in the
group), use the following SiteScope APIConfiguration method to identify if one of the groups has
monitor in it:
APIConfiguration#getGroupsConfigurationSnapshot(String[], boolean, String,
String)

l

l

l

l

You cannot delete a monitor if it has dependent alerts or reports at the container level. To delete a
monitor with dependencies, you must remove the monitor from Alert Targets and Report Targets
for each dependency, and then delete the monitor. You can delete monitors that have dependencies
at the child level.
The Monitor description field supports HTML tags (HTML version 3.2) including the most common
tags for text styling, such as <BR>, <HR>, and <B>, and hyperlinks. It does not support
JavaScript/iframes/frames or other advanced features.
You can also use the SiteScope API when working with monitors. For details, see "SOAP-based
APIs" on page 159.
If a monitor fails to complete its actions before it is scheduled to run again, see "Skipped Monitor
Events" on page 1150 for troubleshooting information.

Reference Information: Monitors
You can find additional reference information on SiteScope monitor in the following sections:
l

"Monitor Categories List" on the next page

l

"Monitors Supported in SiteScopes Installed on Windows Environments Only" on page 275

l

"Monitors Supporting Windows Management Instrumentation (WMI)" on page 275

l

"Server Monitors that Support Monitoring Amazon EC2 Instances From SiteScopes Not Installed
on EC2" on page 275
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l

"Ports Used for SiteScope Monitoring" on page 276

l

"List of Deprecated SiteScope Monitors" on page 281

Monitor Categories List
This section displays the SiteScope monitors in each monitor category. For information about the
usage and configuring each monitor type, see the monitor type in the SiteScope Monitor Reference
Guide.
l

"Application Monitors" below

l

"Big Data" on page 271

l

"Customizable Monitors" on page 271

l

"Database Monitors" on page 271

l

"Generic Monitors" on page 272

l

"Integration Monitors" on page 272

l

"Media Monitors" on page 273

l

"Network Monitors" on page 273

l

"Server Monitors" on page 273

l

"Virtualization and Cloud Monitors" on page 274

l

"Web Transaction Monitors" on page 274

Application Monitors
l

Active Directory Replication Monitor

l

Apache Server Monitor

l

BroadVision Application Server Monitor

l

Check Point Monitor

l

Cisco Works Monitor

l

Citrix Monitor

l

ColdFusion Server Monitor
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l

COM+ Server Monitor

l

Dynamic Docker Monitor

l

F5 Big-IP Monitor

l

HAProxy Monitor

l

Mail Monitor

l

MAPI Monitor

l

Memcached Statistics Monitor

l

Microsoft ASP Server Monitor

l

Microsoft Exchange Monitor

l

Microsoft Exchange Base Monitor

l

Microsoft Exchange 2000*/2003*/2007 Message Traffic Monitor (*Deprecated)

l

Microsoft Exchange 5.5 Message Traffic Monitor (Deprecated)

l

Microsoft Exchange 2003 Mailbox Monitor (Deprecated)

l

Microsoft Exchange 2003 Public Folder Monitor (Deprecated)

l

Microsoft IIS Server Monitor

l

News Monitor

l

Oracle 9i Application Server Monitor

l

Oracle 10g Application Server Monitor

l

Radius Monitor

l

SAP CCMS Monitor

l

SAP CCMS Alerts Monitor

l

SAP Java Web Application Server Monitor

l

SAP MAI Alerts Monitor

l

SAP Performance Monitor

l

SAP Work Processes Monitor
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l

Siebel Application Server Monitor

l

Siebel Log File Monitor

l

Siebel Web Server Monitor

l

SunONE Web Server Monitor

l

Tuxedo Monitor (Deprecated)

l

UDDI Monitor

l

WebLogic Application Server Monitor

l

Web Server Monitor

l

WebSphere Application Server Monitor

l

WebSphere MQ Status Monitor

l

WebSphere Performance Servlet Monitor

Big Data
l

Hadoop Monitor

l

HP Vertica JDBC Monitor

Customizable Monitors
l

Custom Monitor

l

Custom Database Monitor

l

Custom Log File Monitor

l

Custom WMI Monitor

Database Monitors
l

Database Counter Monitor

l

Database Query Monitor

l

DB2 JDBC Monitor

l

LDAP Monitor
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l

Microsoft SQL Server Monitor

l

Oracle Database Monitor

l

Sybase Monitor (Deprecated)

Generic Monitors
l

Composite Monitor

l

Directory Monitor

l

Dynamic JMX Monitor

l

File Monitor

l

Formula Composite Monitor

l

JMX Monitor

l

Log File Monitor

l

Multi Log Monitor

l

Script Monitor

l

Syslog Monitor

l

Web Service Monitor

l

XML Metrics Monitor

Integration Monitors
l

HP OM Event Monitor

l

HP Service Manager Monitor

l

NetScout Event Monitor

l

Technology Database Integration Monitor

l

Technology Log File Integration Monitor

l

Technology SNMP Trap Integration Monitor

l

Technology Web Service Integration Monitor

HP SiteScope (11.31)

Page 272 of 1395

Using SiteScope
Chapter 22: Create Monitors in SiteScope

Media Monitors
l

Microsoft Lync Server 2010 Monitors (Microsoft A/V Conferencing Server, Microsoft Archiving
Server, Microsoft Director Server, Microsoft Edge Server, Microsoft Front End Server, Microsoft
Mediation Server, Microsoft Monitoring and CDR Server, and Microsoft Registrar Server)

l

Microsoft Windows Media Player Monitor (Deprecated)

l

Microsoft Windows Media Server Monitor

l

Real Media Player Monitor (Deprecated)

l

Real Media Server Monitor

Network Monitors
l

DNS Monitor

l

FTP Monitor

l

Microsoft Windows Dial-up Monitor (Deprecated)

l

Network Bandwidth Monitor

l

Ping Monitor

l

Port Monitor

l

SNMP Monitor

l

SNMP Trap Monitor

l

SNMP by MIB Monitor

Server Monitors
l

Browsable Windows Performance Counter Monitor

l

CPU Monitor

l

Disk Space Monitor (Deprecated)

l

DHCP Monitor

l

Dynamic Disk Space Monitor

l

HP iLO (Integrated Lights-Out) Monitor
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l

HP NonStop Event Log Monitor

l

HP NonStop Resources Monitor

l

IPMI Monitor

l

Memory Monitor

l

Microsoft Windows Event Log Monitor

l

Microsoft Windows Performance Counter Monitor

l

Microsoft Windows Resources Monitor

l

Microsoft Windows Services State Monitor

l

Service Monitor

l

UNIX Resources Monitor

Virtualization and Cloud Monitors
l

Amazon Web Services Monitor

l

Generic Hypervisor Monitor

l

KVM Monitor

l

Microsoft Hyper-V Monitor

l

Solaris Zones Monitor

l

VMware Datastore Monitor

l

l

VMware Host Monitors (VMware Host CPU, VMware Host Memory, VMware Host Network,
VMware Host State, and VMware Host Storage)
VMware Performance Monitor

Web Transaction Monitors
l

e-Business Transaction Monitor

l

Link Check Monitor

l

URL Monitor

l

URL Content Monitor
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l

URL List Monitor

l

URL Sequence Monitor

l

Web Script Monitor

Monitors Supported in SiteScopes Installed on Windows
Environments Only
The following is a list of the monitors supported in SiteScopes that are running on Windows versions
only. Where relevant, the monitors can monitor remote servers running on any platform/operating
system.
l

MAPI Monitor

l

Microsoft Exchange Monitor

l

Microsoft Exchange Base Monitor

Monitors Supporting Windows Management Instrumentation (WMI)
For the list of the monitors that support the Windows Management Instrumentation (WMI) method for
collecting data, see "Configure the WMI Service for Remote Windows Monitoring" on page 488.

Server Monitors that Support Monitoring Amazon EC2 Instances
From SiteScopes Not Installed on EC2
Supported protocols for monitoring Amazon EC2 instances using SiteScope deployed in a private
customer network:
Required
configuration in
Amazon
security group

Required
configuration in
OS

Protocol

Windows

UNIX

NetBIOS

Supported

Not supported

Enable 443, 445
tcp ports

Enable incoming
requests in
Windows Firewall

WMI

Not supported

Not supported

N/A

N/A

SSH

Supported

Supported

Enable 22 tcp port

Configure
standard sshd

Telnet

Not supported

Supported

Enable telnet port
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The following is a list of the SiteScope server monitors that support monitoring Amazon EC2 instances
from outside EC2:
l

CPU Monitor

l

Microsoft IIS Server Monitor

l

Directory Monitor

l

Microsoft SQL Server Monitor

l

Disk Space Monitor (Deprecated)

l

Microsoft Windows Event Log Monitor

l

Dynamic Disk Space Monitor

l

Microsoft Windows Media Server Monitor

l

File Monitor

l

l

HP Vertica JDBC Monitor

l

Log File Monitor

l

Memory Monitor

l

Microsoft ASP Server Monitor

l

Microsoft Hyper-V Monitor

l

Citrix Monitor

l

ColdFusion Server Monitor

Microsoft Windows Performance Counter
Monitor

l

Microsoft Windows Services State Monitor

l

Real Media Server Monitor

l

Script Monitor

l

Service Monitor

l

Siebel Log File Monitor

l

Syslog Monitor

l

Web Server Monitor

Ports Used for SiteScope Monitoring
The following table lists the network ports that are generally used for SiteScope monitoring. In many
cases, alternate ports may be configured depending on the security requirements of your environment.
Note: All monitors that support perfex—SiteScope's internal application that connects to Windows
APIs—may use port 135, in addition to other ports.
Monitor Type

Ports Used

Apache Server Monitor

Port which Apache Server Admin pages located.
Configurable by using server configuration file.

BroadVision Application Server Monitor

Uses the Object Request Broker (ORB) port
number for the BroadVision server you are trying
to monitor.

Check Point Monitor

SNMP monitor. Default is port 161. This is
configurable.

HP SiteScope (11.31)

Page 276 of 1395

Using SiteScope
Chapter 22: Create Monitors in SiteScope

Monitor Type

Ports Used

Cisco Works Monitor

Cisco Works resources are usually available by
using port 161 or 162 (SNMP), depending on the
configuration of the server.

Citrix Monitor

Ports 137, 138, and 139 (NetBIOS).

ColdFusion Server Monitor

Ports 137, 138, and 139 (NetBIOS).

CPU Monitor

For local CPU, no ports required.
For CPUs on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).
For CPUs on remote servers (Solaris/Linuxbased systems): ports 22 (SSH), 23 (telnet), or
513 (rlogin).

Database Query Monitor

This is configurable and depends on ODBC or
JDBC driver and DB configuration.

DB2 JDBC Monitor

Default is port 50000. This is configurable.

DHCP Monitor

Default is port 68.

Directory Monitor

For local directory, no ports required.
For directories on remote servers (Windowsbased systems): ports 137, 138, and 139
(NetBIOS).
For directories on remote servers (Solaris/Linuxbased systems): ports 22 (SSH), 23 (telnet), or
513 (rlogin).

Disk Space Monitor (Deprecated)

For local disk space, no ports required.

Dynamic Disk Space Monitor

For disk space on remote servers (Windowsbased systems): ports 137, 138, and 139
(NetBIOS).
For disk space on remote servers (Solaris/Linuxbased systems): ports 22 (SSH), 23 (telnet), or
513 (rlogin).
Note that diskperf -y must be enabled , and the
monitored client requires a reboot.

DNS Monitor

Default is port 53.

F5 Big-IP Monitor

Uses SNMP. This is configurable.

HP SiteScope (11.31)

Page 277 of 1395

Using SiteScope
Chapter 22: Create Monitors in SiteScope

Monitor Type

Ports Used

File Monitor

Local disk. No ports required.
For files on remote servers (Windows-based
systems): ports 137, 138, and 139 (NetBIOS).
For files on remote servers (Solaris/Linux-based
systems): ports 22 (SSH), 23 (telnet), or 513
(rlogin).

FTP Monitor

Default is port 21. This is configurable.

Generic Hypervisor Monitor

Ports 22 (SSH), 23 (telnet), or 513 (rlogin).

HAProxy Monitor

The default is port 80. This is configurable.

HP Vertica JDBC Monitor

The default is port 5433. This is configurable.

KVM Monitor

Ports 22 (SSH), 23 (telnet), or 513 (rlogin).

LDAP Monitor

The default is port 389. This is configurable.

Link Check Monitor

The default is port 80. This is configurable.

Log File Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems.
Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Mail Monitor

Port 110 for POP3, port 25 for SMTP, port 143 for
IMAP.

MAPI Monitor

MAPI uses the Name Service Provider Interface
(NSPI) on a dynamically assigned port higher
than 1024 to perform client-directory lookup.

Memory Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems, ports 22 (SSH), 23 (telnet), or
513 (rlogin) for Solaris/Linux based systems.

Memcached Statistics Monitor

Default is port 11211. This is configurable.

Microsoft Exchange Base Monitor

If “Test-ImapConnectivity” counters are selected,
monitor checks IMAP4 service on Exchange
Server using port 993 for SSL, or 143 for Plain
Text/TLS.
If “Test-PopConnectivity” counters are selected,
monitor checks POP3 service on Exchange
Server using port 995 for SSL, or 110 for Plain
Text/TLS.
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Monitor Type

Ports Used

Microsoft Lync Server 2010 Monitors (Microsoft
A/V Conferencing Server, Microsoft Archiving
Server, Microsoft Director Server, Microsoft
Edge Server, Microsoft Front End Server,
Microsoft Mediation Server, Microsoft
Monitoring and CDR Server, and Microsoft
Registrar Server)

Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft Hyper-V Monitor

Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft IIS Server Monitor

Windows Performance Counters over ports 137,
138, and 139 (NetBIOS).

Microsoft SQL Server Monitor

Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Event Log Monitor

Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Media Server Monitor

Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Performance Counter
Monitor

Ports 137, 138, and 139 (NetBIOS).

Microsoft Windows Resources Monitor

Ports 137, 138, and 139 (NetBIOS).

Multi Log Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems.
Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Network Bandwidth Monitor

No ports required; monitors only the local
machine.

News Monitor

Default is port 144. This is configurable.

Oracle Database Monitor

This is configurable. Depends on target DB.
Default is port 1521.

Oracle 9i Application Server Monitor

This is configurable. Port which Webcaching
admin page located.

Oracle 10g Application Server Monitor
Ping Monitor

Default is port 7.

Port Monitor

Monitors any port.
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Monitor Type

Ports Used

Radius Monitor

Currently supports Password Authentication
Procedure (PAP) authentication but not the
Challenge Handshake Authentication Protocol
(CHAP) or Microsoft Challenge Handshake
Authentication Protocol (MS-CHAP). The
RADIUS servers must be configured to accept
PAP requests.
Default is port 1645. In recent changes to the
RADIUS spec, this may be changed to 1812. The
monitor is configurable.

Real Media Server Monitor

Ports 137, 138, and 139 (NetBIOS).

SAP CCMS Monitor

Uses SAP Client software (SAP Front End) to
run certain SAP transactions. Therefore, same
ports as SAP.

Script Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems.
Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Service Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems.
Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

SNMP Monitor

Default is port 161. This is configurable.

SNMP Trap Monitor

Uses port 162 for receiving traps. This is
configurable.

SunONE Web Server Monitor

URL to the stats-xml file on the target SunONE
server. The port is configurable.

Sybase Monitor

Monitor requires Sybase Central client on the
machine where SiteScope is running to connect
to the Adaptive Server Enterprise Monitor Server.
Port number the same as Sybase client.

Syslog Monitor

Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Tuxedo Monitor

The default port for the TUXEDO workstation
listener is port 65535. This is configurable.

URL Monitor

Generally port number 80. This is configurable.
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Monitor Type

Ports Used

Web Server Monitor

Ports 137, 138, and 139 (NetBIOS) for Windows
based systems.
Ports 22 (SSH), 23 (telnet), or 513 (rlogin) for
Solaris/Linux based systems.

Web Service Monitor

This is configurable.

WebLogic Application Server Monitor

Oracle WebLogic Application Server monitor
uses the Java JMX interface. Port is
configurable.

WebSphere Application Server Monitor

Same port as the IBM WebSphere
Administrator's Console.

WebSphere Performance Servlet Monitor

WebSphere Performance Servlet. Port is
configurable.

List of Deprecated SiteScope Monitors
In recent versions of SiteScope, a number of monitors were deprecated and are no longer supported.
The following table lists the deprecated monitors and, where available, the respective monitors that can
replace them:
Deprecated Monitor

Recommended Alternative Monitor

Active Directory Performance

N/A

Asset

N/A

Astra Load Test

Web Script Monitor

DB2

DB2 JDBC Monitor

Disk Space

Dynamic Disk Space Monitor

Dynamo

N/A

IPlanet Application Server

SunONE Web Server Monitor

IPlanet Server

SunONE Web Server Monitor

IPlanet Web Server

SunONE Web Server Monitor

Microsoft Exchange 2003 Mailbox

Microsoft Exchange Monitor

Microsoft Exchange 2003 Public Folder

Microsoft Exchange Base Monitor

Microsoft Exchange 5.5, 2000, 2003 Message Traffic
Microsoft Windows Dial-Up
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Deprecated Monitor

Recommended Alternative Monitor

Microsoft Windows Media Player

N/A

Network

Network Bandwidth Monitor

Quick Test Pro

Web Script Monitor

Real Media Player Monitor

N/A

RTSP

N/A

SAP

SAP Performance Monitor

SAP Portal

SAP CCMS Monitor

SilverStream Server

N/A

Sybase

N/A

Tuxedo

N/A

WebLogic 5.x Application Server

N/A

SiteScope Monitors User Interface
This section includes:
l

"New Monitor Dialog Box" on page 265

l

"Common Monitor Settings" on the next page
n

"General Settings" on page 285

n

"Monitor Run Settings" on page 287

n

"Dependencies" on page 289

n

"Calculated Metrics Settings" on page 363

n

"Threshold Settings" on page 291

n

"HP Integration Settings" on page 297

n

"Event Mapping Settings" on page 308

n

"Enable/Disable Monitor" on page 309

n

"Enable/Disable Associated Alerts" on page 310
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n

"Search/Filter Tags" on page 312

n

"Baseline Settings" on page 313

n

"Logging Settings" on page 314

l

"Select Depends On Monitor Dialog Box" on page 316

l

"Select Template Dialog Box" on page 317

l

"Copy to Template Tree Dialog Box" on page 317

Common Monitor Settings
The common monitor settings enable you to configure settings for a new monitor.
To
access

Select the Monitors context.
l

l

For new monitors: In the monitor tree, right-click a group, select New > Monitor, and
select a monitor from the New Monitor dialog box. In the right pane, click the
Properties tab.
For existing monitors: In the monitor tree, expand the group folder that contains the
monitor, and select the monitor. In the right pane, click the Properties tab.

Relevant "How to Create and Deploy a Monitor" on page 262
tasks
See also

"Monitor Tree" on page 29

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element

Description

Properties The following setting panel in the monitor Properties tab are common to all monitors.
Tab
For details on the settings for a specific SiteScope monitor, see the user interface page
for the monitor type.
l

l

"General Settings" on the next page
<Monitor Name> Monitor Settings. For a description of monitor settings and details
on how to configure each monitor, see the specific monitor in the SiteScope Monitor
Reference Guide.
Note: The following special characters are not supported in this field: " ' > <.

l

"Monitor Run Settings" on page 287

l

"Dependencies" on page 289

l

"Calculated Metrics Settings" on page 363

l

"Threshold Settings" on page 291

l

l

"HP Integration Settings" on page 297 (displayed when SiteScope is integrated with
BSM, or with Operations Manager (HPOM) and event or metrics integration is
enabled)
"Event Mapping Settings" on page 308 (displayed when SiteScope is integrated
with HPOM and event integration is enabled, or when a Generic Event Integration is
configured in Integration Preferences)

l

"Enable/Disable Monitor" on page 309

l

"Enable/Disable Associated Alerts" on page 310

l

"Search/Filter Tags" on page 312

l

"Baseline Settings" on page 313

l

"Logging Settings" on page 314

Note: The Link Monitor to CI settings panel was removed in SiteScope 11.00 and the
functionality was replaced by the report custom topology feature in the HP Integration
Settings panel.
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UI
Element
Verify &
Save

Description
Verifies the correctness of the monitor configuration locally and on the remote server to
be monitored, before saving the settings. If SiteScope fails to connect to the remote
server, or if there is an invalid property in the configuration settings, verification fails
and an error message is displayed.
Tip: Performance is not as fast if you use Verify & Save instead of Save, because
SiteScope needs to establish a connection to the remote server to verify the settings.
For bulk operations such as Publish Template Changes and Global Search and
Replace, we recommend using the Save option only

Save

Performs a local verification of the configuration settings, and saves the settings
(without verifying the correctness of the monitor configuration on the remote server).
Tip: Performance is faster if you use Save instead of Verify & Save, because
SiteScope does not need to establish a connection to the remote server to verify the
settings. For bulk operations such as Publish Template Changes and Global Search
and Replace, we recommend using the Save option only.
Note: When saving a customizable monitor type, Save has the same affect as Verify
& Save. SiteScope verifies the correctness of the monitor configuration both locally
and on the remote server to be monitored, before saving the settings.

General Settings
The General Settings panel enables you to create a name and description for the monitor instance.
To access

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select General Settings.
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Important
information

l

l

l

l

Relevant
tasks

HTML code entered in the name and description fields is checked for validity and
security, and corrective action is taken to fix the code (for example, code is
truncated if it spans more than one line). If malicious HTML code or JavaScript is
detected, the entire field is rejected. The following is prohibited HTML content:
n

Tags: script, object, param, frame, iframe.

n

Any tag that contains an attribute starting with on is declined. For example,
onmouseover.

n

Any attribute with javascript as its value.

If the name or description fields contain an ampersand (&), less than (<), or greater
than (>), they are automatically escaped, for example, &amp;, &lt;, or &gt;.
To automatically adjust the row height to make all cell contents visible in the
Dashboard, select the Wrap text option in Dashboard Settings. For details, see
"Dashboard Settings Dialog Box" on page 1046.
For buttons common to all panes, see "Common Monitor Settings" on page 283.

"How to Create and Deploy a Monitor" on page 262

User interface elements are described below:
UI Element

Description

Name

Name that describes the element or system being monitored. Use a useful naming
convention for all monitors to make creating view filters and category assignments
more effective.
Example: <hostname:resource_type> or <business_unit
name monitored_element>

resource_

Default value: If this field is left empty, SiteScope creates a default name based on
the host, system, and/or URL being monitored or the default name defined for the
monitor type. If the automatic name creation operation detects escape characters, it
prompts the user to manually enter a valid monitor name.
Note: The monitor name cannot contain any of the following characters: ` " < >
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UI Element

Description

Monitor
description

Additional information to describe a monitor. This can include the most common
HTML tags for text styling, such as <BR>, <HR>, and <B>. The description is
displayed only when viewing or editing the monitor's properties in the SiteScope
Dashboard.
You can also include HTML tags to enable you to access URLs from the SiteScope
Dashboard. To add a hyperlink, enter the URL (UNC path is supported for Windows
remotes). For example, <a href="http://www.hp.com">My Link</a>. The URL is
displayed in the Description field for the selected monitor in the SiteScope
Dashboard.
Note: This field does not support JavaScript/iframes/frames or other advanced
features.

Report
Optional description for this monitor to make it easier to understand what the monitor
Description does. This description is displayed on each bar chart and graph in Management
Reports.
Example: Network traffic or main server response time.

Monitor Run Settings
The Monitor Run Settings panel enables you to configure settings for the monitor run.
To access

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Monitor Run Settings.

Important
For buttons common to all panes, see "Common Monitor Settings" on page 283.
information
Relevant
tasks

"How to Create and Deploy a Monitor" on page 262

See also

"Schedule Preferences" on page 712
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User interface elements are described below:
UI
Element

Description

Frequency How often SiteScope attempts to run the action defined for the monitor instance. Each
monitor run updates the status of the monitor. Use the drop-down list to specify
increments of seconds, minutes, hours, or days.
Default value: 10 minutes
Minimum value: 15 seconds
Note: When configuring this setting in a template, the variable value can only be in time
units of seconds.
Error
frequency

Monitoring interval for monitors that have reported an error condition.
Example: You may want to run the monitor every 10 minutes normally, but as often as
every 2 minutes if an error has been detected. When the monitor's status is no longer in
error, the monitor reverts to the run interval specified in the Frequency setting.
Note:
l

l

Verify
error

Increasing the monitor run frequency affects the number of alerts generated by the
monitor.
When configuring this setting in a template, the variable value can only be in time
units of seconds.

Automatically runs the monitor again if it detects an error. It runs the monitor
immediately after the regular run returned an error to make sure that the first error was
not a false alert. If the error is returned again, it is reported as a result of the monitor run,
and the next run takes place according to the monitor schedule.
To change monitor scheduling while the monitor is in error status, see the Error
frequency setting. This is a preferred and recommended setting over Verify error,
especially for large SiteScope environments.
The status returned by the Verify error run of the monitor replaces the status of the
originally scheduled run that detected an error. The data from the verify run may be
different than the initial error status, causing the loss of important performance data.
Tip: We recommend using this option in small monitoring environments only.
Significant monitoring delays may result if multiple monitors are rescheduled to verify
errors at the same time.
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UI
Element
Monitor
schedule

Description
Range schedule if you want the monitor to run only on certain days or on a fixed
schedule. The range schedules created in Schedule Preferences appear in the dropdown list. For more information about creating monitor schedules, see "Schedule
Preferences" on page 712.
Default value: Every day, all day
Note: If you select a threshold schedule in the Threshold Settings, at least one
threshold schedule must coincide with the monitor run schedule (at least one minute of
the monitor run schedule must be covered by one of the threshold schedules).

Show run
results on
update

Whenever a change is made to a monitor's configuration settings, the monitor is run.
Displays the results of that monitor run in a popup dialog box.
Note: The updated run results are always displayed in the applicable Dashboard views
for the monitor.

Dependencies
The Dependencies panel enables you to create a dependency relationship that enables you to make the
running of this monitor dependent on the status of another monitor.
To access

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Dependencies.

Important
For buttons common to all panes, see "Common Monitor Settings" on page 283.
information
Relevant
tasks

"How to Create and Deploy a Monitor" on page 262

See also

"Monitoring Group Dependencies" on page 255
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User interface elements are described below:
UI Element
Depends on

Description
Click Depends on
to open the Select Depends On Monitor dialog box, and
select the monitor on which you want to make the running of this monitor
dependent. For details on the Select Depends On Monitor dialog box, see "Select
Depends On Monitor Dialog Box" on page 316.
Use this option to prevent redundant alerting from multiple monitors that are
monitoring different aspects of a single system.
Example: Create a system monitor to check the basic availability of a system and
then create other monitors that perform more detailed tests of that system. Set the
detailed test monitors to be dependent on the status of the monitor checking basic
availability.
If the system monitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also
disables any alerts that would have been generated by the dependent monitors.
Default value: No dependency is set for a monitor instance.
Note when working in template mode: This field is cleared and is not available
when Ignore dependencies when publishing changes is selected.

Depends
condition

If you make this monitor dependent on the status of another monitor (by using the
Depends on setting), use this option to select the status condition of the Depends
on monitor for the current monitor to run normally.
The status categories include:
l

Good

l

Error

l

Available

l

Unavailable

The monitor being configured is run normally as long as the monitor selected in the
Depends on box reports the condition selected in this box.
Example: Select Good and this monitor is enabled only when the monitor selected
in the Depends on box reports a status of Good. The current monitor is
automatically disabled if the monitor selected in the Depends on box reports a
category or condition other than Good. You can also enable dependent monitors
specifically for when a monitor detects an error.
Default value: Good
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UI Element

Description

Ignore
dependencies
when
publishing
changes
(available in
Template
mode only)

When template changes are published to the deployed objects, dependency
settings for the selected template group are ignored and the existing dependency
settings in the deployed objects are preserved. For details, see "Dependencies
When Configuring Template Monitors and Groups" on page 257.
Default value: Not selected
Note: When selected, the Depends on field is cleared and is not available.

Threshold Settings
The Threshold Settings panel enables you to set conditions that determine the reported status of each
monitor instance. The status result is based on the results or metrics returned by the monitor action on
the target system during a specified period of time.
Status threshold criteria for each monitor instance can be set for the Error if, Warning if, and Good if
status conditions. You can also set monitor thresholds using a baseline to provide a comparison for
establishing acceptable or expected threshold ranges. For details, see "Setting Status Thresholds" on
page 259.
To access

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Threshold Settings.
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Important
information

l

l

l

l

Relevant
tasks

See also

You can apply multiple status threshold criteria for each status condition per
monitor instance. A single monitor instance may have one or more criteria used to
determine Error status, one or more conditions to determine Warning status, and
one or more conditions to indicate Good status. Most monitor types include one
default setting for each of the three status conditions.
When setting a baseline threshold, you can only change certain threshold
conditions during the baseline calculation and after the baseline is activated. For
details on the threshold changes that are allowed, see "Changing Threshold
Settings" on page 297.
When working with Global Search and Replace, if you select to replace threshold
settings, the Override Category option appears. When selected, all the threshold
settings for the selected monitor instances are overridden with the settings you
entered for the replace operation. If this option is cleared and you selected to
replace threshold settings, the settings you entered are added to the existing
threshold settings for the monitor instances.
If an alert was defined for unavailable status, it results in two alerts being sent
when the monitored system or application is unavailable—an unavailable alert,
and an alert showing the status assignment when the monitor is not available
(either Good, Warning, or Error).

l

For buttons common to all panes, see "Common Monitor Settings" on page 283.

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Set Monitor Thresholds Using a Baseline" on page 327

l

"How to Create a Calculated Metrics Expression" on page 361

l

"How to Set Combined Threshold Calculated Metrics" on page 362

"Set Monitor Thresholds Using a Baseline" on page 326

User interface elements are described below:
UI Element

Description
New. Creates additional thresholds that determine the Error/Warning/Good status.
For each threshold, select the metric and operator, and enter a value for the metric.
By default, two thresholds are displayed for the Error status when you first configure
the monitor, and one threshold for the Warning and Good status.
Delete. Deletes the selected threshold.
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UI Element

Description

If
Status assignment for when the monitor is not available from the following options:
unavailable
l
Set monitor status according to thresholds. The monitor gets a new status
according to the thresholds.
l

l

l

Set monitor status to Good. The monitor's status is set to Good when it is
unavailable without thresholds being checked.
Set monitor status to Warning. The monitor's status is set to Warning when it
is unavailable without thresholds being checked.
Set monitor status to Error. The monitor's status is set to Error when it is
unavailable without thresholds being checked.

Note: A monitor instance can have a status of Unavailable as well as a status of
Good, Warning, or Error. Alerts are triggered according to availability, status, or
both availability and status, depending on how the alert is configured. For details, see
"Configure SiteScope Alerts" on page 1243.
Default
status

Monitor status (Good, Warning, or Error) if the threshold criteria for the monitor
instance are not met.
Default value: Good

On internal
error

Monitor status assignment if a configuration or internal error occurs:
l

l

l

l

l
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Set monitor status according to Thresholds. The monitor's status is set
according to its current thresholds if a configuration or internal error occurs (default
setting). It is unreliable to rely on the threshold since there is no way of knowing at
what point the error occurred (and whether the threshold is based on old data,
updated data, or both). For example, a monitor may remain in its current status
even though the monitor did not run; change status if thresholds were defined that
were not applicable; or trigger false alerts as if a remote was not available, when in
fact, the remote was not contacted.
Set monitor status to Error. The monitor's status is set to Error if a
configuration or internal error occurs without thresholds being checked.
Set monitor status to Warning. The monitor's status is set to Warning if a
configuration or internal error occurs without thresholds being checked.
Set monitor status to Good. The monitor's status is set to Good if a configuration
or internal error occurs without thresholds being checked.
Treat monitor as unavailable. The monitor is treated as being Unavailable if a
configuration or internal error occurs without thresholds being checked.
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UI Element

Description

Add
Default
Thresholds

Adds default threshold settings to the monitor instance, for the applicable status
categories. Default thresholds are indicated by the (default) label. Default thresholds
are editable only after selecting a condition from the Condition field (the default
condition can be selected). After any criteria of the default threshold is changed, the
(default) label is removed.

Remove
Default
Thresholds

Deletes the default threshold settings (those indicated by the (default) label) from the
monitor instance. Default settings that were added and were subsequently modified,
are not removed.

Threshold
Preview

Opens the Threshold Preview dialog box that displays a preview of thresholds for
static counters and for regular expression patterns translated to actual current
counters. Patterns enable the monitor to automatically configure itself with counters
and thresholds on the relevant dynamic environment components (currently available
for VMware Host monitors).
The table also displays an Indicator State and Severity value for each current
counter translated from a pattern (this value is not available for patterns in Threshold
Settings).
For more details on dynamic monitors, see "Dynamic Monitoring Mechanism" on page
370.
Example: The pattern /.*/VirtualMachine/.*/cpu/usage.average\[\]/ displays
the average CPU usage threshold condition for each VM currently being monitored.

Error if

Conditions for the monitor instance to report an Error status.

Condition

Metrics parameter for determining the status of this monitor instance. The list of
metrics is dynamically updated based on the type of monitor you are configuring.
Default value: Default metrics exist for many monitor types and differ according to
monitor type. For many default metrics, there are corresponding defaults for the
operator and value boxes that are not editable.
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UI Element

Description

Operator

Metrics operator for determining the status of this monitor instance. The following
operators are available:
l

>= Greater than or equal to

l

> Greater than

l

== Equals

l

!= Not the same as

l

<= Less than or equal to

l

< Less than

l

contains Contains the value entered

l

!contains Does not contain the value entered

Note: To indicate data volatility (where current monitor readings significantly deviate
from previous runs), set status thresholds using a baseline. For details, see "Set
Monitor Thresholds Using a Baseline" on page 326.
Value

Value applicable to the metrics parameter.
Note:
l

If a monitor has an activated baseline, its metrics values are non-editable and the
Percentiles Table
button is displayed. You can change baseline threshold
values by clicking the button and changing the current percentile value from the
Percentiles Table. For user interface details, see "Percentile Range Mapping
Table" on page 343.

l

Schedule

You cannot change the metrics value, operator or schedule for a baseline
threshold condition.

Range schedule to determine the status of this monitor instance if you want to define
when to check the monitor run result against the threshold. This is useful, for
example, if you want to check the monitor run result against the threshold only on
certain days or during peak hours. The range schedules created in Schedule
Preferences appear in the drop-down list. For more information about creating monitor
schedules, see "Schedule Preferences" on page 712.
Default value: Every day, all day
Note: When selecting threshold schedules, at least one threshold schedule must
coincide with the Monitor schedule in the Monitor Run Settings (at least one minute
of the monitor run schedule must be covered by one of the threshold schedules).
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UI Element

Description

Indicator
State and
Severity

State of the indicator (for example, Bottlenecked), and the severity corresponding to
the indicator state (for example, Critical).
Every indicator can have several states. For example, when measuring CPU Load,
the indicator state might be Bottlenecked or Busy, whereas when measuring
Memory Load, the indicator state might be Paging or Starving for Memory.
Indicator state and severity level are mapped to metric status according to the closest
available severity that exists in the states for the indicator associated with the metric.
The indicator state and severity values are updated when a different indicator mapping
is selected in the HP Integration Settings panel.
For more information on indicator mappings, see "Indicator Mappings when Reporting
Topology to BSM" on page 260.
Note:
l

l

l

l

l

l

SiteScope must be connected to BSM 9.00 or later for the Indicator State and
Severity column to be displayed.
Indicator state and severity values are not displayed in SiteScope reports.
If the Indicator State and Severity box is empty, the metric is not colored in
Service Health, except for always (default) which is automatically assigned.
To display the Indicator State and Severity value for each current counter for a
dynamic monitor (these are the actual counters translated from a regular
expression pattern), click the Threshold Preview button. The indicator state and
severity value is displayed for each actual counter in the Threshold Preview dialog
box.
The association between the indicator state and severity cannot be changed on
the local SiteScope server.
When there are several indicator states of the same severity associated with a
given metric and threshold, the default state is taken (as it is configured in BSM's
Service Health CI Indicator Repository). If no default state is defined, an arbitrary
state is chosen. For example, if the Host Disk Utilization indicator is mapped
to the MB free metric and the indicator has two Critical severity states Higher
than normal and Lower than normal (and neither is defined as default), either
one of these states can be used as the indicator state assigned to this threshold.

Warning if

Conditions for the monitor instance to report a Warning status. For each threshold,
select the measurement and operator, and enter a value for the metric.

Good if

Conditions for the monitor instance to report a Good status. For each threshold, select
the measurement and operator, and enter a value for the metric.
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Changing Threshold Settings
You can make changes to threshold conditions according to the baseline status of the monitor
instance.
Monitor
Baseline
Status

Change Threshold Condition

Add/Delete
Threshold
Condition

Not baselined

You can change any condition of any threshold.

Allowed

In calculating/ You can only change the measurement value for static
activating
thresholds.
process
For example, Error if CPU >= 70 every day, all day,
you can only change the value 70 to another value.

Not allowed

Baselined

Allowed for static
thresholds only

l

l

You can change any condition for static thresholds.
You can change the percentile value only for baseline
thresholds.

HP Integration Settings
The HP Integration Settings panel enables you to control what data a monitor forwards to the
applications integrated with SiteScope.
To access

Important
information

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select HP Integration Settings.
l

l

l

l

l
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The HP Integration Settings panel is displayed only when SiteScope is integrated
with BSM, or when SiteScope is integrated with Operations Manager (HPOM) and
event or metrics integration is enabled. It is not displayed for EMS Integration
monitors.
The custom topology is available only if SiteScope is connected to BSM version
9.00 or later.
The indicator settings are available only if SiteScope is connected to BSM version
9.00 or later or to HPOM.
The HP Operations Manager integration settings are available only if an HPOM
integration has been configured and SiteScope is connected to HPOM. For details
on configuring the HPOM Integration, see "HP Operations Manager Integration
Preferences" on page 677.
For buttons common to all panes, see "Common Monitor Settings" on page 283.
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Relevant
tasks
See also

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure SiteScope to Communicate with BSM" on page 219

"Integration Preferences" on page 660

HP SiteScope (11.31)

Page 298 of 1395

Using SiteScope
Chapter 22: Create Monitors in SiteScope

BSM Integration Data and Topology Settings
This section enables you to select BSM logging options and topology reporting settings for the monitor
instance.
Important
information

The BSM logging options are available only if BSM integration is enabled.

l

After upgrading to BSM 9.2x, monitors configured to report status changes no
longer affect BSM's Service Health (except for System Monitors view). This
occurs because status change event samples are sent per monitor which does not
correlate with the measurement-to-indicator mappings. If you were using status
change event samples in Service Health, do the following:

l

n

Switch to metrics reporting if you do not have an SLM for these events.

n

If both Service Health and SLM are being used for status change event samples,
we recommend upgrading to SiteScope 11.x and switching to event reporting in
addition to reporting status change samples.

l

l

l

l

Relevant
tasks

See also

The Enable reporting changes in status option was removed due to the
introduction of event management in BSM. This option can be enabled for
backward compatibility by changing the property Allow sending monitor status
only to BSM 9.x to =true in Preferences > Infrastructure Preferences >
Custom Settings.
BSM logging selection should be based on how much data is relevant to report to
BSM for this monitor and how much space the BSM database has for this data.
Publishing changes to custom topology is not supported when working in template
mode (it does not affect the monitor's custom topology in BSM). To modify
topology settings in deployed template monitors, use Global Search and Replace
instead. For details, see "Global Search and Replace" on page 89.
For troubleshooting problems involving topology reporting, see BSM Topology
Issues in the Integration with BSM and HPOM Best Practices Guide in the
SiteScope Help.

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure SiteScope to Communicate with BSM" on page 219

l

"How to Configure Topology Reporting" on page 225

l

"Integration Preferences" on page 660

l
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" Connecting to a BSM Server" on page 207 (for BSM integration data reporting
issues)
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User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

BSM Logging Options
Disable
reporting
metrics to
BSM

Prevents the status information or metrics for this monitor being transferred to BSM
or temporarily disables reporting this monitor to BSM.

Enable
reporting
monitor
status and
metrics

Sends all monitor data to BSM for each time that the monitor runs. This option
enables the largest data transfer load.

Enable
reporting
monitor
status (no
metrics)

Sends only monitor category (error, warning, good), status string, and other basic
data for each time that the monitor runs. No information on specific performance
counters is included.

Enable
reporting
monitor
status and
metrics with
thresholds

Sends monitor data to BSM for only those metrics counters that have configured
thresholds (for example, Error If, Warning If, Good if). The data is sent for
each time that the monitor is run.

Default value: Selected

Note: This option is supported only for backward compatibility with legacy SLM,
and not for Service Health.

Topology Settings
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UI Element

Description

Report
monitor and
related CI
topology

SiteScope reports monitor and related CI topology data to BSM's RTSM (Run-time
Service Model). The data that SiteScope forwards depends on the monitor type.
This option enables SiteScope to:
l

l

l

Discover topologies and forward specific CI data for the monitors that monitor
applications from among a group of supported environments. For details and a
list of these supported environments, see "Report Discovered Topologies to
BSM" on page 215.
Report Computer CI data for those monitors that monitor hosts (SiteScope
sends Computer CI type for each monitored host). If this option is selected, the
monitor creates a topology that includes the host as a CI in BSM's RTSM.
Report CI data based on the user-defined CI type and key attribute values.

If this option is cleared, the monitor and related CI topology data is not reported to
BSM, and the Indicator Settings section is unavailable.
For details on how SiteScope reports data to RTSM, see "Integrate SiteScope Data
with BSM's Configuration Items" on page 210.
Note: If SiteScope is connected to BSM (and you have an Event Management
Foundation license), and sending events is enabled, hosts are reported to BSM
through Operations Management.
Default value:
l

l
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Selected for monitors of supported environments and monitors that have a CI
type defined by default.
Cleared for monitors that do not have a topology defined by default. For a list of
these monitors, see "Monitors Not Reporting Topology Data By Default" on page
236.
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UI Element

Description

CI type

The monitor's topology that is used for reporting data to BSM's RTSM. You can link
between this monitor instance and any existing, logical configuration item type (CIT)
in BSM's RTSM. This link or relationship enables the monitor to pass KPI status to
the CI to which it is linked.
The CI type indicates the following:
l

Default (<CI type>). The default CI type for the monitor (for most monitors, the
default CI type is Computer). For a list of monitors where the default CI type is
not Computer, see "Report Discovered Topologies to BSM" on page 215.
CI types include BusinessApplication, BusinessService, DB2,
InfrastructureService, JBoss AS, Node, Oracle, Oracle iAS, SQL Server,
Sybase, Unix, WebLogic AS, WebSphere AS, and Windows.
Added support for the generic Running Software CI type when SiteScope 11.23
(or later) is integrated with BSM 9.23 (or later). This CI type can reconcile with
any of its descendant CI types such as Database, Application Server, Web
Server and so forth (for the full list of descendant CI types, see the RTSM
documentation).

l

l

Default (Multiple). The monitor has multiple CIs (this is where the CI type is per
metric). The CI type for these monitors is fixed and cannot be modified. For a list
of these monitors, see "Monitors Reporting CI Per Metric" on page 237.
None. The monitor instance is not linked to a CI type. For a list of these
monitors, see "Monitors Not Reporting Topology Data By Default" on page 236.
You can select a CI type from an RTSM view to link to this monitor instance. For
details on selecting and working with views, see "Working with the CI Selector"
in the Modeling Guide in the BSM Help.

Note:
l

l
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This setting is active only when Report monitor and related CI topology is
selected.
After a CI type is selected, the Indicator Settings table is filtered to show
mappings that exist for the selected CI type only.
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UI Element

Description

<CI type key
attributes>

CI type key attributes are displayed according to the CI type selected for the monitor
instance. Enter the key attribute values for the selected CI type:
l

l

l

l

Server. Container CI for the selected CI. This attribute is required for DB2,
JBoss AS, Oracle, Oracle iAS, SQL Server, Sybase, WebLogic AS, WebSphere
AS, and Windows CI types.
Name. Name of the CI (for BusinessApplication, BusinessService, Computer,
DB2, InfrastructureService, JBoss AS, Oracle, Oracle iAS, SQL Server,
Sybase, WebLogic AS, and WebSphere AS CI types).
Organization Type. Identifier used to differentiate levels within an organization.
This attribute is required for BusinessApplication, BusinessService, and
InfrastructureService CI types.
Organization Name. Name of the organization. This attribute is required for
BusinessApplication, BusinessService, and InfrastructureService CI types.

Note:
l

l

l

This setting is active only when Report monitor and related CI topology is
selected.
CI key attributes are not available for monitors where the CI type is per metric.
For a list of these monitors, see "Monitors Reporting CI Per Metric" on page 237.
When upgrading to SiteScope 11.23 or later, SiteScope is unable to update
custom topology for a monitor that had BusinessElement CIs if there was an
error in the Organization Type field, such as a spelling mistake or the wrong
parameter was defined. There will be an empty value in this field.
Workaround: After performing the upgrading, select the required Organization
type from the drop down list.

Indicator Settings
This section displays the metrics for the SiteScope monitor type and the health indicators (HIs) and
event type indicators (ETIs) to which the metric is assigned. Indicators provide a more detailed view of
the health of a configuration item (CI) when the monitor's topology is reported to BSM's RTSM. The
Indicator Settings table is filtered to show mappings for the monitor instances that exist for the selected
CI type only.
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Important
information

Indicator Settings are available only if Operations Manager event integration or
BSM integration is enabled, and:

l

n

The Report monitor and related CI topology setting is selected in BSM
Integration Data and Topology Settings section.

n

The monitor has default metric-to-indicator mappings. For a list of monitors that
do not have default indicator mappings, see "Monitors Not Reporting Topology
Data By Default" on page 236.

l

l

l

l

Relevant
tasks
See also

Indicator mappings for monitors that report CI type per metric (where CI type is
displayed as Default (Multiple)) cannot be added/deleted from the Indicator
Settings panel. Mappings for these monitor types can only be added/deleted from
BSM (SAM Admin > Metrics and Indicators tab). For a list of these monitors,
see "Monitors Reporting CI Per Metric" on page 237.
The indicator assignments table in SiteScope might contain assignments that do
not exist in the Indicator Assignments repository in BSM. This is because
mappings that are incorrectly defined in BSM are not validated when they are
downloaded to SiteScope (whereas they are validated, and therefore, not
displayed in BSM).
Only advanced users with a thorough knowledge of CIs and indicators should
attempt to edit any of the indicator mappings or to add mappings to metrics.
If any of the settings in the indicator mapping table are modified by a user, a note
to indicate this is displayed below the table.

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure Topology Reporting" on page 225

"Integrate SiteScope Data with BSM's Configuration Items" on page 210

User interface elements are described below:
New. Enables you to add a metric-to-indicator mapping to a monitor instance based on
the monitor type.
Note: This button is not available for monitors that have multiple CI types (see "Monitors
Reporting CI Per Metric" on page 237). Indicator mappings for these monitors can only
be added from BSM (SAM Admin > Metrics and Indicators tab).
Delete. Deletes the selected metric-to-indicator mapping.
Note: This button is not available for monitors that have multiple CI types (see "Monitors
Reporting CI Per Metric" on page 237). Indicator mappings for these monitors can only
be removed from BSM (SAM Admin > Metrics and Indicators tab).
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Reset to Default. Resets the metric-to-indicator mapping for the monitor type to the
default mappings included in your current version of SiteScope. Indicators mappings are
stored in a central repository in System Availability Management (SAM) in BSM.
SiteScope checks every 5 minutes to see if the mappings in SAM have changed, and if
they have, downloads the latest mappings.
If indicator mappings on a local SiteScope server have been modified, these mappings
are not overridden by the centralized mappings when the topology is next reported to
BSM.
For details on modifying the centralized mappings, see "Indicator Assignments
Overview" in in the BSM Application Administration Guide in the BSM Help.
Move Down. Enables you to change the sort order of the indicator mappings by moving
the selected indicator mapping down the list. If the mapping order is changed locally, the
local mapping order is not overridden when mapping changes are downloaded from the
Indicator repository in SAM Administration.
Move Up. Enables you to change the sort order of the indicator mappings by moving the
selected indicator mapping up the list. If the mapping order is changed locally, the local
mapping order is not overridden when mapping changes are downloaded from the
Indicator repository in SAM Administration.
Metric
Pattern

Displays the metrics name, or a regular expression pattern based on the metric name,
mapped to the indicator of this monitor instance. You can modify an existing mapping or
create a new one. Where there is more than one CI type for the same regular expression,
they are displayed in different rows. For details on using regular expressions, see
"Regular Expressions" on page 175.
Note: The list of available metrics is dynamically updated based on the type of monitor
you are configuring. Default metrics exist for many monitor types and differ from one
type to another.

CI Type

Displays the CI type selected for the monitor instance (the Indicator Settings table is
filtered to show mappings that exist for the selected CI type only).
Note: This field is not editable.

Indicator Displays the indicator mapping for the metric. In the drop-down list, health indicators are
displayed above the divider line, and event type indicators below the line.

HP Operations Manager Integration Settings
This section enables you to configure SiteScope to send events and report metrics to the
HP Operations agent. The agent is required for sending events to HPOM and BSM's Operations
Management, and for reporting metrics to Performance Manager (a reporting component of HPOM) and
Performance Graphing (in Operations Management). It also enables you to select the event preference
mapping that is used for sending events for the monitor instance.
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Important
These settings are available only if the HP Operations agent is installed and
information connected to an HPOM server, and event/metrics integration is enabled in the
Operations Manager Integration dialog box.
Relevant
tasks

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure Common Event Mappings for HPOM or BSM" on page 548

l

See also

For details on how to enable SiteScope to send events to HPOM or Operations
Management, or how to enable SiteScope to report metrics using the HP
Operations agent, see Integrating SiteScope with HP Operations Manager
Products in the SiteScope Help. You can check the HP Software Integrations site
for the latest version of this guide.

l

"Integration Preferences" on page 660

l

"Common Event Mappings" on page 547

User interface elements are described below:
Report
metrics to
HP
Operations
agent

Enables SiteScope to report metrics for the monitor instance to the HP Operations
agent, from which HPOM and Operations Management (in BSM) can collect the data.
Note: Monitor metrics are sent to the agent only if metrics integration is enabled in the
Operations Manager Integration dialog box. For user interface details, see "HP
Operations Manager Integration Main Settings" on page 679.
Default value: Selected if metrics integration is enabled (otherwise this setting is not
available).

Send
events

Enables sending events to HPOM or Operations Management (in BSM) when there is
a change of a counter/metric status (Good, Warning, Error, Unavailable) for the
monitor instance. Status change is only applicable on counters or metrics that are
configured in the monitor's Threshold Setting.
Note: This setting is available only if the HP Operations agent is installed and
connected to an HPOM or BSM server, and event integration is enabled in the
Operations Manager Integration dialog box. For user interface details, see "HP
Operations Manager Integration Main Settings" on page 679.
Default value: Selected if event integration is enabled (otherwise this setting is not
available).
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Manually
send first
event

When creating a new monitor in a SiteScope connected to BSM, it is possible that the
first event is triggered before the topology is reported to BSM, and the event is lost
from the Service Health perspective (it is still shown in the Operations Management
Event Browser). Select this option to avoid waiting for the next event to be sent. The
event is resent during the next monitor run, regardless of the monitor's metrics
reaching their status change conditions.
Default value: Not selected
Note:
l

This option is automatically disabled after the monitor run.

l

You can configure this setting globally using Global Search and Replace.

BSM Service Health Preferences
This section enables you to configure the preference for influencing BSM's Service Health when both
SiteScope events and metrics are reported to BSM.
Important
This setting is available only when:
information
l
Both BSM and Operations Manager integrations are active, and are connected to
the same BSM server (the BSM server is used instead of the HPOM server).
The following settings are selected in the monitor's HP Integration Settings:

l

n

In BSM Integration Data and Topology Settings: Enable reporting monitor
status and metrics or Enable reporting monitor status and metrics with
thresholds, and

n

In HP Operations Manager Integration Settings: Send events.

Note:
l

l

l
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If only Send events is selected, the BSM Service Health affected by preference
is set to Events.
If only Report monitor and related CI topology is selected, the BSM Service
Health affected by preference is set to Metrics.
If both are selected, Metrics is the default preference.
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Relevant
tasks

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure Topology Reporting" on page 225

l

"How to Enable SiteScope to Send Events to HPOM or Operations Management"
in Integrating SiteScope with HP Operations Manager Products in the SiteScope
Help. You can check the HP Software Integrations site for the latest version of
this guide.

User interface elements are described below:
BSM
Select the preference (events or metrics) for influencing BSM's Service Health when both
Service SiteScope events and metrics are reported to Service Health (since indicators for
Health
SiteScope events and metrics both affect CIs).
affected
l
Metrics. If selected, each SiteScope metric affects CIs in BSM (status change events
by
reported by SiteScope do not have any influence on CIs in Service Health).
l

Events. If selected, only status change events affect CIs in BSM's Service Health
(SAM reports for the monitored CIs are still based on metrics).

For more information on choosing the preference to use, see Integrating SiteScope with
BSM in Integration with BSM and HPOM Best Practices in the SiteScope Help.
Default value: Metrics
Note: You can also configure a global default preference (events or metrics) for all new
monitors created when configuring the Operations Manager integration. For details, see
Prefer events over metrics in BSM Service Health (global preference) in "HP
Operations Manager Integration Main Settings" on page 679.

Event Mapping Settings
The Event Mapping Settings panel is used for selecting a template for mapping SiteScope runtime data
to the attribute values that are used for sending events for the monitor instance.
To access

Important
information

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Event Mapping Settings.
l

l
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The Event Mapping Settings panel is available only if the HP Operations agent is
installed and connected to an HPOM or BSM server, and event integration is
enabled in the HP Operations Manager Integration dialog box, or when a Generic
Event Integration is configured in Integration Preferences. For user interface
details, see "HP Operations Manager Integration Preferences" on page 677.
For buttons common to all panes, see "Common Monitor Settings" on page 283.
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Relevant
tasks
See also

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure SiteScope Generic Event Integration" on page 691

l

"Generic Event Integration Preferences" on page 689

l

"HTTP Preferences" on page 590

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description

Event
Select the desired event mapping template, or use the default mapping. Click New or
mapping Edit to open the Common Event Mappings dialog box and configure a new event
preference or modify an existing one. For user interface details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 551 and "New/Edit Event Mappings Dialog
Box - Custom Attributes Tab" on page 557.
Note: When editing an event mapping from here, it changes the event pattern for all
monitors using this template. We recommend creating a new event mapping if you want
a specific monitor to report different attributes.

Enable/Disable Monitor
The Enable/Disable Monitor panel enables you to set the status (enabled/disabled) for the selected
monitor.
To access

Important
information

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Enable/Disable Monitor.
l

l

l

l

Relevant
tasks

HTML code entered in the monitor description fields is checked for validity and
security, and corrective action is taken to fix the code (for example, code is
truncated if it spans more than one line). If malicious HTML code or JavaScript is
detected, the entire field is rejected.
The Monitor Downtime table is displayed only when SiteScope is connected to
BSM if the selected monitor is affected by a CI currently in downtime. For details,
see "CI Downtime" on page 217.
When publishing changes to a template that contains a custom monitor, the
monitor is temporarily disabled before changes are published, and is restored to
the enabled state after changes have been made.
For buttons common to all panes, see "Common Monitor Settings" on page 283.

"How to Create and Deploy a Monitor" on page 262
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See also

"Enable/Disable Monitors in Group Dialog Box" on page 1049

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Enable monitor

Enables the monitor if the monitor was previously disabled.
Default value: Selected

Disable monitor

Disables the monitor. When a monitor has been disabled, SiteScope continues
to schedule the monitor to run based on the Frequency setting for the monitor
but the monitor action is not run. SiteScope records a monitor data log entry for
the monitor when it was scheduled to be run but reports the monitor status as
disabled in the place of metrics data.

Disable monitor
for the next
<time period>

Time period that the monitor should remain disabled. Select Seconds, Minutes,
Hours, or Days to define the disable time period as applicable.

Disable monitor
on a one time
schedule from
<time> to
<time>

Temporarily disables the monitor for a time period in the future. The time period
can span more than one day.

Disable
description

Optional descriptive text that appears as part of the monitor status in the
monitor group display. The disable status text also includes a string indicating
which disable option is in force for the monitor, for example Disabled
manually indicates that the monitor was disabled using the Disable monitor
option.

Enter or select the start time and end time for the disable period using the
format: hh:mm:ss mm/dd/yyyy.

Monitor Downtime Table
(This table is displayed only when SiteScope is connected to BSM if the selected monitor is affected
by a CI currently in downtime. For details, see "CI Downtime" on page 217.)
Downtime Name

The name of the downtime as configured in the BSM Downtime wizard.

Downtime
Description

A description of the downtime if entered in the BSM Downtime wizard.

Current
Occurrence End
Date

Date and time that the current downtime occurrence is scheduled to end.

Enable/Disable Associated Alerts
The Enable/Disable Associated Alerts panel enables you to set the status (enabled/disabled) for
associated alerts.
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To access

Important
information

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Enable/Disable Associated Alerts.
l

l

Relevant
tasks
See also

HTML code entered in the monitor description fields is checked for validity and
security, and corrective action is taken to fix the code (for example, code is
truncated if it spans more than one line). If malicious HTML code or JavaScript is
detected, the entire field is rejected.
The Associated Alerts Downtime table is displayed only when SiteScope is
connected to BSM if the monitor is affected by a CI that is currently in downtime,
and the downtime applies to associated alerts of the monitor. For details, see "CI
Downtime" on page 217.

l

For buttons common to all panes, see "Common Monitor Settings" on page 283.

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Configure an Alert" on page 1247

"Configure SiteScope Alerts" on page 1243

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Enable all associated alerts

Enable the alerts if the alerts associated with this monitor were
previously disabled.
Default value: Selected

Disable all associated alerts
indefinitely

Prevents SiteScope from executing the alert action even if the
alert condition is met until this radio button is cleared and the alert
definition is updated.
Note: Use of this option may result in loss of expected alert
capability if the alert is disabled to accommodate a temporary
condition. It is important to review this status at a later time, and to
manually enable the alert definition as necessary.
Default value: Not selected

Disable all associated alerts
for the next <time period>

Time period that the associated alerts should remain disabled.
Select Seconds, Minutes, Hours, or Days to define the disable
time period as applicable.
Default value: Not selected
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UI Element

Description

Disable all associated alerts
on a one time schedule from
<time> to <time>

Temporarily disables the associated alerts for a time period in the
future. The time period can span more than one day.
Enter the start time and end time for the disable period using the
format: hh:mm:ss mm/dd/yyyy.
Default value: Not selected

Disable description

Optional descriptive text.

Associated Alerts Downtime Table
(This table is displayed only when SiteScope is connected to BSM if the monitor is affected by a CI
that is currently in downtime, and the downtime applies to associated alerts of the monitor. For
details, see "CI Downtime" on page 217.)
Downtime Name

The name of the downtime as configured in the BSM Downtime
wizard.

Downtime Description

A description of the downtime if entered in the BSM Downtime
wizard.

Current Occurrence End
Date

Date and time that the current downtime occurrence is scheduled
to end.

Search/Filter Tags
The Search/Filter Tags panel enables you to define a keyword search/filter tag, assign it to one or more
monitors, and then use the tag to search or filter the display.
If no tags have been created for the SiteScope, this section appears but is empty. If tags have been
created, they are listed here and you can select them as required.
To access

Important
information

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Search/Filter Tags.
l

l

l
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If no tags have been created for the SiteScope, this section appears but is empty.
If tags have been created, they are listed here and you can select them as
required.
You can edit existing tags in the Preferences context (Preferences >
Search/Filter Tags). For details on this topic, see "Search/Filter Tags" on page
718.
For buttons common to all panes, see "Common Monitor Settings" on page 283.
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Relevant
tasks
See also

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Filter the View Using Search/Filter Tags" on page 76

"Filter Objects in the SiteScope View" on page 74

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description

<Tag
name
and
values>

Displays the tag names and tag values if tags have been created. Select the tags or tag
values that you want to assign to the monitor. If no tags have been created for the
SiteScope, this section appears but is empty.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.

Baseline Settings
The Baseline Settings panel displays the baseline status for the selected monitor.
To access

Important
information

Relevant
tasks
See also

Select the Monitors context. In the monitor tree, expand the group folder that
contains the monitor, and select the monitor. In the right pane, click the Properties
tab, and select Baseline Settings.
l

Baseline Settings are not available for monitors that use the dynamic monitoring
mechanism to update thresholds settings.

l

For buttons common to all panes, see "Common Monitor Settings" on page 283.

l

"How to Create and Deploy a Monitor" on page 262

l

"How to Set Monitor Thresholds Using a Baseline" on page 327

"Set Monitor Thresholds Using a Baseline" on page 326
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User interface elements are described below:
UI
Element

Description

Baseline The monitor's baseline status. The following statuses are available:
status
l
Monitor not selected for baselining. The monitor has not been selected for
baselining.
l

Calculating baseline.SiteScope is in the process of calculating the baseline.

l

Calculation failed.SiteScope was unable to calculate a baseline.

l

Calculated, not activated. A baseline was calculated for the monitor, but it has not
yet been activated.

l

Activating baseline.SiteScope is in the process of activating the baseline.

l

Activation failed.SiteScope was unable to activate the baseline.

l

Baseline activated. The baseline has been activated for the monitor.

The Baseline mode check box is selected if the baseline status is anything other than
Monitor not selected for baselining.
For details on using the baseline threshold, see "Set Monitor Thresholds Using a
Baseline" on page 326.
Remove Removes the baseline threshold. The baseline thresholds are removed and the static
Baseline threshold value is used to create a threshold. To recalculate a baseline, you must first
remove the existing baseline (even if the calculation failed).
For details on this topic, see "Set Monitor Thresholds Using a Baseline" on page 326.

Logging Settings
The Logging Settings panel enables you to create a dedicated log file with a specified log level for each
monitor instance and view that log file.
To
access

Select the Monitors context. In the monitor tree, expand the group folder that contains
the monitor, and select the monitor. In the right pane, click the Properties tab, and select
Logging Settings.

Relevant "How to Create and Deploy a Monitor" on page 262
tasks
See also

l

"Log Files Page" on page 1184

l

"Log Preferences" on page 700
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User interface elements are described below:
UI
Element
Enable
separate
log for
this
monitor

Description
Enables sending log data to a dedicated log file for that monitor instance in the
<SiteScope root directory>\logs\monitor_runs folder. This folder contains one file
per monitor instance. The format of log file names is determined according to the
monitor path in the SiteScope tree, as follows: SiteScope_<monitorGroup>_
<monitorName>.log. After each monitor run, this log file appears on the Log File page.
For details, see "Log Files Page" on page 1184.
When this is disabled, log data for the selected monitor is not sent to the dedicated
monitor log file. However, log data is still sent to general log files (for example,
error.log or RunMonitor.log), together with log data from all other monitors.
Note:
l

l

Log level

To enable a separate log for this monitor (and for all other monitors where monitor
instance logging is enabled), the Disable separate logging for monitors check
box must be cleared in Preferences > Log Preferences (the setting is cleared by
default). If the separate logging for monitors option is disabled in Log Preferences,
a warning is displayed in the Logging Settings panel when you enable logging for a
monitor instance, and you must first clear the Disable separate logging for
monitors check box in Log Preferences.
The <SiteScope root directory>\logs\monitor_runs folder contains log data
from the last run of the monitor instance. Historical monitor instance log data is
stored in general log files.

Select DEBUG, INFO, WARN, ERROR, or FATAL. Your selection determines which
log messages for this monitor instance are sent both to the dedicated log file for the
selected monitor instance and to the general log files. For more details about log
levels, see "Log Levels" below.
You can select a log level only if Enable separate log for this monitor is enabled. If
Enable separate log for this monitor is disabled, the log level for all monitors is
determined by the log4j.properties file.

Enable
Enables debugging for perfex process. For details about perfex process, see "Perfex
debugging Process Pool Page" on page 1190.
for perfex
You can enable debugging for perfex process only if Enable separate log for this
process
monitor is enabled.
View Log

Click to view the log. The log appears only if there is data for the selected log level.

Log Levels
Log levels operate hierarchically, meaning that some log levels also produce results for other log levels,
as follows:
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Log level writes messages for the following
log levels:

DEBUG INFO WARN

DEBUG

X

INFO
WARN

ERROR

FATAL

X

X

X

X

X

X

X

X

X

X

X

X

X

ERROR
FATAL

X

Select Depends On Monitor Dialog Box
This dialog box enables you to make the running of this monitor or monitor group dependent on the
status of another monitor.
To
access

Select the Monitors context. In the monitor tree, select a monitor, and click the
Properties tab. Expand the Dependencies tab, and click Depends on
monitor on which to you want to create a dependency.

. Select the

Relevant "How to Create and Deploy a Monitor" on page 262
tasks
See also

l

"Monitoring Group Dependencies" on page 255

l

"Monitor Tree" on page 29

User interface elements are described below:
UI
Element Description
Represents an individual SiteScope server.
Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
If a group alert has been set up for the monitor group or subgroup, the alert
appears next to the group icon.

symbol

Represents a SiteScope monitor (enabled/disabled).
If an alert has been set up for the monitor, the alert
icon.

symbol appears next to the monitor

Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScope monitors.
Parent: SiteScope.
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Select Template Dialog Box
This dialog box enables you to select the templates you want to deploy to the monitor group.
To access

Select the Monitors context. In the monitor tree, right-click the group into which you
want to deploy a template, and select Deploy Template or Deploy Template Using
CSV.

Important
information

l

l

Relevant
tasks
See also

Templates that do not contain any child objects (subgroups, monitors, variables,
or a remote server) are not displayed in the template tree.
Solution templates are not displayed in the Select Template dialog box and can be
deployed from the Template context only. For details, see "How to Deploy a
SiteScope Solution Template" on page 903.

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Publish Changes to Templates" on page 877

l

"Deploy Solution Templates" on page 896

l

"Monitor Tree" on page 29

l

"Template Tree" on page 41

User interface elements are described below:
UI
Element Description
Represents the SiteScope root group.
Represents a template container. A template container is used to organize configuration
deployment templates. Expand to display the templates.
Represents a template configuration for deploying SiteScope objects. Select the
templates that you want to deploy. You can select multiple templates using the CTRL or
SHIFT keys.

Copy to Template Tree Dialog Box
This dialog box enables you to copy a SiteScope object (group, monitor, or remote server) and its
contents (monitors, alerts, and reports) to a template or template group.
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To access

In the monitor or remote server tree, right-click the object you want to copy to a
template, and select Copy to Template. In the Copy to Template Tree dialog box,
select the destination to which to copy the template object.

Important
information

You can copy a group and its contents to a template provided the template does
not already contain a group.

l

When copying a server monitor to a template, SiteScope replaces the server
name with the $$SERVER_LIST$$ variable.

l

Tip: We recommend creating a remote server in the template after copying the
monitor to the template, and replacing the $$SERVER_LIST$$ variable with this
remote server.
l

Relevant
tasks
See also

The Web Script Monitor is not supported in template mode.

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Monitor Tree" on page 29

l

"Template Tree" on page 41

User interface elements are described below:
UI
Element Description
Represents an individual SiteScope server.
Represents a template container. A template container is used to organize configuration
deployment templates.
Template containers can hold templates only.
Represents a template configuration for deploying SiteScope objects.
You can copy a template group (provided the template does not already contain a group),
or a remote server to a template group.
Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
You can copy a template group or monitor to a template group.
If a group alert has been set up for the monitor group or subgroup, the alert
appears next to the group icon.
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Custom monitors broaden the capabilities of regular SiteScope monitors for tracking the availability and
performance of your infrastructure systems and applications. Using custom monitors, you can develop
your own solutions for environments that are not supported by predefined SiteScope monitors. This
provides you with greater flexibility that is not available in existing monitors.
Tip: You can view guided and narrated demonstrations for using the WMI Custom monitor on
YouTube:
l

l

Custom WMI Monitor Creation Process and Packaging http://www.youtube.com/watch?v=bB6NlTGdd88
Custom WMI Monitor Data Processing Script http://www.youtube.com/watch?v=GIw3JVnunWE

To access
Select the Monitors context. In the monitor tree, right-click a group, select New > Monitor, and select
one of the custom monitors (see "List of Custom Monitors" on page 321).

Learn About
Custom Monitor Overview
You can use the Custom monitors to:
l

Collect data that is not available in existing monitors
You can create your own customized monitor that collects data and processes the results of the
collected data to create new metrics.

l

Process the collected data
The collected data is processed using a script you defined in the monitor. Each time the monitor
runs, the script extracts and processes the results of the collected data, and updates and returns a
status for the metrics defined in the script.
For example, you can define metrics based on data collected from a database, and perform
mathematical operations on it. When creating a script, you can use Java code developed by
yourself or by a third-party to process the data.
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Tip:

l

n

Sample scripts for all the custom monitors are available from the sample content package
located in the <SiteScope installation directory>\examples\
monitors\custom folder. CustomMonitorSamplePackage.zip contains examples for
SiteScope 11.20, and CustomMonitorsExamples_11_21.zip contains updated examples
including a Custom Database monitor with a dynamic query, a manifest file created using
the Export Content Package Wizard, and template mail and template mail subject files, To
use these scripts, you need to import the custom monitor content package and then deploy
the custom monitor template. For details, see "How to import and use a customizable
monitor" for the specific custom monitor in the SiteScope Monitor Reference Guide.

n

For details on the methods and classes that are available in the script, see the HP
SiteScope Custom Monitor API Reference (available from <SiteScope installation
directory>\examples\monitors\custom\doc\javadoc.zip).

Debug custom monitors remotely on a local machine
You can perform offline debugging of a custom monitor script using a remote debugging server. This
makes the script development process easier, since it enables you to complete the code and see
the debugged data inside the script during the data processing stage. For details, see "Debug
Custom Monitors on a Local Machine" on page 324.

l

Collect data dynamically (for query-based custom monitors)
You can include dynamically-defined queries in the data processing script. These queries are
executed while the script is running, in contrast to predefined queries, which are executed before
the script is run.
Dynamically-executed queries provide the added benefit of enabling you to create queries based on
values that are not in the monitored entity data store (for example, timestamp), create queries based
on previous query results or calculations, and include variables in queries. For details, see "Data
Processing Script with Dynamic Queries" on page 323.

l

Customize how results are displayed
You can determine how results are displayed. For example, whether result data is displayed in
megabytes or kilobytes.

After developing the monitor, you can:
l

Define thresholds for new metrics
Since some metrics are only defined during a script run, you cannot define thresholds for them in
advance. Once the script has run for the first time and metrics have been defined, you can define
thresholds for these metrics. This provides more advanced data processing options than regular
monitors.
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Note that metrics can change between script runs, for example, where variables are used in metric
names. Thresholds using a metric that does not exist after the monitor run are removed
automatically.
l

Share the monitor with other SiteScope users
After developing the monitor, you can export the monitor to a template, add external jars and/or
classes if the monitor depends on them, and create a content package. For details on creating
content packages, see "Create Content Packages" on page 825.
The content package can then be sent to specific users, or shared with other SiteScope users by
publishing it to the HP Live Network (https://hpln.hp.com/group/sitescope) community. For details,
see "Share SiteScope Content on the HP Live Network" on page 892.
By sharing knowledge with other SiteScope users, you can benefit from extended SiteScope
monitor coverage and the development of new monitors outside the SiteScope release cycle.

This section also includes:
l

"List of Custom Monitors" below

l

"Topology Reporting" on the next page

l

"Indicator Settings" on the next page

l

"Data Processing Script" on the next page

l

"Data Processing Script with Dynamic Queries" on page 323

l

"Debug Custom Monitors on a Local Machine" on page 324

l

"Tips/Troubleshooting" on page 324

List of Custom Monitors
Monitor
Name

Description

Custom
Monitor

You can create your own monitor by developing a script that collects data using custom
Java or JavaScript code, and then processes the data and creates metrics.

Custom
Database
Monitor

You can create your own database monitor by developing queries (static or dynamicallydefined) that collect data, and a script that processes the collected data and creates
metrics.

Custom
Log File
Monitor

You can create your own Log File monitor that scans for matches in the form of text
phrases or regular expressions, and a script that processes the collected data and
creates metrics.
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Monitor
Name

Description

Custom
WMI
Monitor

You can create your own WMI monitor by developing WMI Query Language (WQL)
queries (static or dynamically-defined) that collect data, and a script that processes the
collected data and creates metrics.

For details on custom monitors, see the specific monitor in the SiteScope Monitor Reference.

Topology Reporting
You can enable SiteScope to report monitor and related CI topology data to BSM's RTSM by selecting
Report monitor and related CI topology in the HP Integration Settings panel for the custom monitor,
and configuring the topology reporting settings in the BSM Integration Data and Topology Settings
section. This defines how SiteScope reports CIs to BSM.
You can report the following types of CI topology data:
l

l

l

User-defined CI type topology. You select a CI type and define the key attribute values for the
selected CI type. For details on key attribute values, see "<CI type key attributes>" on page 303.
Custom topology script. You create the topology script which defines how to report CIs to BSM.
Only select this option if you are familiar with the Jython language, because you must create the
topology script in Jython yourself. For task details, see "How to Configure Custom Topology for a
Custom Monitor" on page 229.
If you do not want to report topology for the monitor, you can choose to report the monitor CI only.

For more details on configuring topology reporting settings, see "How to Configure Topology Reporting
for a Custom Monitor" on page 227.

Indicator Settings
The table in the Indicator Settings section of HP Integration Settings displays indicator settings for the
selected CI type. Indicators provide a more detailed view of the health of a CI when the monitor's
topology is reported to BSM's RTSM. You can add new metric mappings or edit settings for existing
mappings. For task details, see "How to Configure Topology Reporting" on page 225.

Data Processing Script
In the script you develop, you can use Java code developed by yourself or by a third-party. You can
store Java objects in the monitor storage.
For details on the methods and classes that are available in the script, see the HP SiteScope Custom
Monitor API Reference (available from <SiteScope installation
directory>\examples\monitors\custom\doc\javadoc.zip).
For details on the monitor configuration properties, including how to access them, and the monitor
storage and metrics names, see "How to Access the Monitor Configuration Parameters Exposed in the
Script" for the specific custom monitor (in the SiteScope Monitor Reference Guide).
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Note: When working in template mode, you can use template variables in a data processing script.

Sample Scripts
SiteScope provides a sample data processing script in the Data Processing Script box for each
custom monitor. You need to uncomment the script in order to use it.
Sample scripts for all the custom monitors are available from CustomMonitorSamplePackage.zip
and CustomMonitorsExamples_11_21.zip in the <SiteScope installation
directory>\examples\monitors\custom\ folder. To use these scripts, you need to import the custom
monitor content package and then deploy the custom monitor template. For details, see "How to
Develop a Custom Monitor" for the specific custom monitor (in the SiteScope Monitor Reference
Guide).

Script Log File
SiteScope provides a custom monitor log which you can use for script debugging purposes. The log file
(custom_monitor.log) is located in <SiteScope root directory>\logs\custom_monitors. This log
can be used for info, warning, error, and debug messages from running the script.

Data Processing Script with Dynamic Queries
Note: This section is applicable to the Custom Database and Custom WMI monitors only.
When creating query-based custom monitors, you can include dynamically-defined queries in the data
processing script. Dynamic queries are executed while the script is running, in contrast to predefined
queries which are executed before the script is run. Dynamically-defined queries have the same syntax
and structure as the queries predefined in the queries table.
Using dynamically-defined queries provides the following benefits:
l

You can create queries based on values that are not in the monitored entity data store. For example,
timestamp.

l

You can create queries based on previous query results.

l

You can include variables in queries.

Flow of a monitor run with dynamic queries
When a custom monitor with dynamic queries is run, the following sequential flow takes place:
1. The predefined queries in the queries table are executed by the monitor, and the data returned is
passed to the script engine.
2. The script engine starts to execute the script.
3. If a query is encountered in the script, the script engine hands it over to the monitor to execute, and
stops the script execution.
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4. The monitor executes the query on the monitored entity, and returns the data to the script engine.
5. The script engine resumes the script execution.

Sample Script with Dynamic Queries
For a sample data processing script containing dynamic queries, see the sample content package,
CustomMonitorsExamples_11_21.zip in the <SiteScope installation
directory>\examples\monitors\custom folder. To use these example scripts, you need to import the
custom monitor content package and then deploy the custom monitor template. For details, see "How
to Develop a Custom Monitor" for the specific custom monitor (in the SiteScope Monitor Reference
Guide).

Debug Custom Monitors on a Local Machine
You can perform offline debugging of a custom monitor script using a remote debugging server. This
makes the script development process easier, since it enables you to complete the code and see the
debugged data inside the script during the data processing stage. Offline debugging provides full
simulation of the remote system code execution without the need for an open connection to the
debugged system. As a result, there is minimal impact on the remote machine CPU and memory
resources.
To perform offline debugging, you must install and configure the Custom Monitor Debugger Eclipse
project on a local machine. The debugger project is available from <SiteScope root
directory>\examples\monitors\custom\CustomMonitorDebuggingEclipseProject or from the HP
Live Network.
For task details, see "How to Debug a Custom Monitor Offline" for the specific custom monitor in the
SiteScope Monitor Reference Guide.

Tasks
See the Tasks section for the relevant custom monitor in the SiteScope Monitor Reference.

Tips/Troubleshooting
General Tips/Limitations
l

l

If a user-defined or imported Java package has the same name as an existing SiteScope or
standard Java package, SiteScope ignores the user-defined/imported Java package.
When setting custom monitor metrics with a string (non-numeric) value, the maximum and average
values in the Measurement Summary table of the Management Report are shown as 'n/a'. This also
occurs if you change the metric value type, for example, if you set the metric with a numeric value,
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and later change it to a string value or vice versa.
l

l

l

l

When deploying a custom monitor using a template, clearing the Verify monitor properties with
remote server check box in the Deployment Values dialog box has no effect, because the monitor
configuration properties in the template must be checked against the remote server on which the
template is being deployed.
When publishing changes to a template that contains a custom monitor, we recommend using the
Disable custom monitors while publishing changes option (selected by default) in
Preferences > Infrastructure Preferences > Custom Monitor Settings. The monitor is
temporarily disabled before changes are published and is restored to the enabled state after
changes have been made.
Setting status thresholds using a baseline is not supported on user-defined metrics.
You can use third-party .jar files without removing the JVM security from the registry by adding the _
scriptSandboxRuntimePermissions property to the <SiteScope root directory>;\groups\
master.config file, and specifying the permitted jar files. For example, to use signed libraries
jopcagtbase.jar and jopcagtmsg.jar, configure the parameter as follows: _
scriptSandboxRuntimePermissions=loadLibrary.jopcagtbase, loadLibrary.jopcagtmsg.
For the types of runtime permissions that can be used, see Runtime Permission class in the Java
API documentation (http://docs.oracle.com/javase/7/docs/api/java/lang/RuntimePermission.html).

Custom Monitor Troubleshooting
l

l

Errors in the monitor (including errors in the script) are written to the SiteScope logs in the same way
as for any other monitor. Check the error.log and RunMonitor.log files.
Error messages from the script are displayed in the custom_monitor.log file located in
<SiteScope root directory>\logs\custom_monitors. This log can be used for info, warning, error,
and debug messages from running the script.
To change the log level to DEBUG mode, in <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties, change ${loglevel} to DEBUG in
the following paragraph:
# Custom monitors category
log4j.category.CustomMonitor=${loglevel},custom.monitor.appender
log4j.additivity.CustomMonitor=false change

l

For query-based custom monitors: If running a dynamic query from within a data processing script
fails, an exception is thrown.
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Creating a baseline enables you to learn the normal performance of your applications. Knowing how an
application typically performs enables you to determine whether a performance problem is an isolated
incident or a sign of a trend. This section provides information about baselines and how to set monitor
thresholds using a baseline.

Learn About
Baseline Overview
Baselines enable you to understand how your applications typically perform and determine whether a
performance problem is an isolated incident or a sign of a significant downward performance trend.
Baseline data is gathered from monitor performance metrics over a period of time and is used to provide
a comparison for establishing acceptable or expected threshold ranges. When the monitor's
performance exceeds that range by some value (or does not reach that range, for example, in the case
of Free Disk Space), the monitor can signal an error or warning. The acceptable threshold range of a
monitor is determined by how far the current performance is from the baseline.
Baselines are updated periodically as new metrics data are received.

Calculating the Baseline
To enable SiteScope to begin calculating baselines, you select the groups, monitors, or both, to be
used for collecting baseline data. You can also select the schedule ranges used for collecting baseline
threshold data. This enables you to restrict to certain days or hours of the week the periods during
which SiteScope collects data for the baseline calculation. For example, you may want the monitor
status to be based on results gathered during peak business hours only.
You can also select the adherence level used for determining the extent to which values for the
baseline calculation affect the threshold values and set threshold boundaries for all monitor
measurements. For details, see "Baseline Adherence Level" on page 335 and "Good and Error
Boundaries" on page 335.
The baseline engine calculates the baseline for each schedule using measurements collected from the
monitors during the data collection period. SiteScope uses a percentile algorithm in the baseline
calculation, in which a percentile value is used to determine the value of the baseline. For details on
how baseline thresholds are calculated, see "Baseline Threshold Values" on page 336.

Activating the Baseline
After the baseline is calculated, you can review a summary of calculated monitors and analyze the
baseline data in the Activate Baseline dialog box. The dialog box lists all the monitor instances for
which a baseline was calculated, the date of the baseline calculation, and the reduction in the number
of error and warning statuses that would have been generated for a monitor if the baseline thresholds
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were applied. If SiteScope is unable to calculate a baseline for a monitor, it lists a reason for calculation
failure.
You can also view a graph that displays the current thresholds, the baseline thresholds, and historical
data of all baseline-related monitor measurements over a 24-hour time period for each monitor
measurement. The graph includes an annotation tool that enables you to annotate a snapshot of the
graph you are viewing, to highlight important areas. You can save, print, or email an annotation graph.
For user interface details, see "Annotation Tool" on page 348.
After reviewing the baseline data, you can activate baseline threshold configuration. This applies the
baseline values to the thresholds for the selected monitors. You can also activate the baseline for
monitors that failed for the reason Insufficient data by using the limited measurement samples that
were collected.
Before activating the baseline threshold, consider saving the current monitor configuration, because
you cannot undo threshold configuration changes (and go back to the previous settings) after the
baseline has been activated.
When the baseline is activated, the baseline thresholds are displayed in the Threshold Settings panel
for each monitor. The baseline value is recalculated each day according to the history samples
collected for the measurement and the current day's readings, and the baseline threshold values are
recalculated and updated accordingly.
At any time, you can create a baseline summary report showing the baseline status and baseline status
description for each monitor in the selected context.

Tasks
How to Set Monitor Thresholds Using a Baseline
This task describes the steps involved in setting monitor thresholds using a baseline.
1.

Configure baseline setting preferences - optional
You can view and define the values of global SiteScope baseline settings in Infrastructure
Preferences. This includes calculation and activation priority settings, the number of days of
historical data to include in baseline calculations, and the offset for calculating the error boundary.
For user interface details, see "Baseline Settings" on page 641.

2.

Calculate the baseline
Define thresholds on the monitor measurements for which the baseline should be calculated.
a. Select the monitor instances you want to baseline. For user interface details, see "Select
Monitors for Baseline Calculation" on page 340.
b. Select one or more schedule ranges to be used for collecting baseline data, or accept the
default schedule (Every day, all day). For user interface details, see "Schedule" on page 340.
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c. Select the global baseline adherence level that is used for determining the extent to which
values for the baseline calculation affect the threshold values for all monitor measurements.
For user interface details, see "Adherence Level" on page 341.
d. Additionally, you can click the Fine-Tune Adherence Levels/Set Boundary button to:
o

Individually fine-tune the baseline adherence level for any monitor measurement.

o

Define a good boundary for each monitor measurement. A measurement within this
boundary is not in error status, even though it should report an error according to existing
baseline percentiles.
For user interface details, see "Fine-Tune Adherence Levels/Set Boundary Dialog Box" on
page 341.

e. Click Calculate to perform the baseline threshold calculation.
Example: Calculate Baseline dialog box - only monitors that the user is eligible to see
according to their user permissions are displayed

Example: Fine-Tune Adherence Levels/Set Boundary dialog box
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3.

Review the baseline settings
Review the summary of calculated monitors and baseline data in the Activate Baseline dialog box.
Only the monitors that the user is eligible to see according to their user permissions are displayed.
For user interface details, see "Activate Baseline Dialog Box" on page 355.
Example: Activate Baseline dialog box - only monitors that the user is eligible to see
according to their user permissions are displayed
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4.

View the baseline monitor measurements graphs
You can view a graphical display of each monitor's baselined measurements to analyze the
baseline data for a selected day. You can also use the annotation tool to create a snapshot of the
graph you are viewing and highlight important areas.
For user interface details, see "Baseline Monitor Measurement Graphs Dialog Box" on page 345.
Note: The data displayed in the graphs is an aggregate of the measurement data and as such,
the time periods may not accurately reflect the time the data was collected.

Example: Baseline Monitor Measurements Graph
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5.

Activate the baseline settings
Select the monitors for which you want to set thresholds using a baseline, and click Activate. You
can select all monitors with a successfully calculated baseline, and those that failed with the
reason Insufficient data (indicated by Yes in the Can Be Activated column). The monitor
thresholds are configured according to the baseline calculation, and are set to change status when
the thresholds settings are exceeded.
For user interface details, see "Activate Baseline Dialog Box" on page 355.
Note: If you want to revert to the current monitor threshold configuration, save the current
monitor configuration before activating the baseline configuration.

6.

View baseline properties in the Baseline Status Report
You can create an ad hoc report showing information about each monitor in the selected context,
including each monitor's baseline status and baseline status description. For user interface
details, see "Baseline Status Report" on page 353.
You can also track the baseline status for a monitor in the monitor's Baseline Settings. For user
interface details, see "Baseline Settings" on page 313.
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Example: Baseline Status Report

7.

View and modify baseline thresholds
In the Threshold Settings, you can view the baseline thresholds and manually fine-tune the
thresholds by changing the percentile value from which the threshold value is derived.
For user interface details, see "Threshold Settings" on page 291.
Example: Monitor's baseline threshold settings
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In the example, the Error if percent used threshold value is >= 42.81 and the Warning if
percent used threshold value is >= 40.77 (both these values are non-editable). To change the
threshold values, you must change the percentile value from which the threshold values are
derived. To help you understand what the new threshold value is after you change the
percentile value, click the Percentiles Table
button to open the percentile table that
shows the threshold value that is mapped to each percentile range.
Note: The Error if percent used (default)> 90 threshold is the error boundary. This is the
value of a measurement considered to be in error status, even though according to existing
baseline percentiles it should not report an error. For example, if the baseline threshold were
updated to Error if percent used (%)>= 96, all measurements greater than 90 are in error
status, even if the calculated baseline error threshold of 96 is not exceeded. For details on this
topic, see "Good and Error Boundaries" on page 335.

Tips/Troubleshooting
Notes and Limitations
l

Only an administrator in SiteScope, or a user granted Add, edit or delete monitors or Edit or
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delete monitors only permissions, can use the baseline feature to set monitor thresholds, and
only for the monitors that are in the users allowed groups list. Any user can view the Baseline
Status Report regardless of edit permissions.
l

l

l

l

l

l

l

l

l

l

You cannot add or delete thresholds or measurements, or copy or move monitors during the
baseline calculation process (up until the point that the monitor baseline is activated).
If you add, edit, or delete threshold measurements from browsable monitors after the baseline is
activated for a monitor, the monitor needs to be recalculated and reactivated as a baseline monitor.
Baseline thresholds are not copied or moved along with the other group or monitor objects when
copying or moving a group or monitor with an activated baseline.
If SiteScope is restarted before the remove baseline process is complete, the process is not
continued after the restart, and you must run the remove baseline process again.
If SiteScope is restarted before the baseline calculation or activation process is complete, it
automatically continues the process after the restart. Monitors with any other baseline status
(Calculated, not activated; Activation failed; Calculation failed; Baseline activated) are not
affected by the restart.
Before the baseline is calculated, the monitors should be enabled and permitted to run for a period
long enough for SiteScope to accumulate sufficient data to calculate the baseline. This period
depends on the Minimum number of days required for baselining and Minimum number of
samples required for baselining settings in Preferences > Infrastructure Preferences >
Baseline Settings. For details, see "Baseline Settings" on page 641. The baseline can still be
calculated and activated even if the monitor has insufficient data, although the calculation may not
be accurate.
After you define a set of counters for a browsable monitor and the monitor runs with these counters
for some time, if you later change the counters (for example, remove existing counters and/or add
new counters), and then you attempt to calculate baseline, the calculation results may be incorrect.
This can occur because old data, possibly for counters that no longer exist, interferes with the new
data. The calculation may also be incorrect for counters that have not changed since the monitor
was created. To avoid this problem, do not make any changes to a monitor's browsable counters
during the minimum number of days period required for calculating the baseline.
You can change threshold related properties using Global Search and Replace, regardless of
whether the threshold was created using a baseline or manually. However, you cannot activate a
baseline threshold for a monitor using Global Search and Replace.
During the baseline calculation and after the baseline is activated, only certain baseline threshold
changes are supported. The same restrictions apply when you change threshold related properties
using Global Search and Replace. For details on the threshold changes that are allowed, see
"Changing Threshold Settings" on page 297.
Memory consumption increases for each monitor threshold set using a baseline. To reduce memory
consumption, you can set the Interval for saving accumulated baseline data to disk settings in
the Baseline Settings. For details, see "Baseline Settings" on page 641.
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Additional Information: Understanding Baseline
Calculations
This section includes:
l

"Baseline Adherence Level" below

l

"Good and Error Boundaries" below

l

"Baseline Threshold Values" on the next page

l

"How SiteScope Calculates Thresholds" on page 337

l

"How SiteScope Calculates the Error Boundary" on page 337

Baseline Adherence Level
You can select the baseline adherence level used for determining the threshold value. This is the extent
to which values for the baseline calculation affect the threshold values for all monitor measurements.
You can select High adherence, Medium adherence, or Low adherence. The higher the adherence
level, the closer the threshold range is to the monitor measurement baseline values. Conversely, the
lower the adherence level, the further the threshold range is from the monitor measurement baseline
values.
In addition to selecting the adherence level, you can also fine-tune the adherence level for individual
monitor measurements by configuring adherence percentiles separately for each monitor
measurement. Adherence levels are based on adherence percentiles—a measurement value that
determines when a measurement is in error or warning. For browsable monitor measurements, you can
configure only one set of adherence percentiles that is used by all browsable monitors.
To manually fine-tune the adherence level, you need to understand how the threshold values are
created. For details on this topic, see "Baseline Threshold Values" on the next page.

Good and Error Boundaries
Configuring good and error boundaries is useful to avoid setting off errors and warnings unnecessarily
when using baseline thresholds. You can manually set a good boundary for each monitor measurement
and the browsable monitor counters. SiteScope automatically configures the error boundary for each
monitor measurement.
Note: To set good boundaries, it is important to understand how baseline threshold values are
created. For details on this topic, see "Baseline Threshold Values" on the next page.
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Good Boundary
This is the value of a measurement that is not considered to be in error status, even though according to
existing baseline percentiles it should report an error. For example, consider a low load system where
CPU utilization measurements are constantly below 3%. Based on these measurements, SiteScope
might calculate a baseline threshold with a 5% error threshold. Because this is not an accurate
measure of CPU load error, you may want to define 70% CPU utilization as the good boundary to avoid
generating false errors. Provided CPU utilization remains below this limit (even though it is above the
baseline error threshold), the monitor is not in error status.
You manually set the Good Boundary in the Fine Tune Adherence Levels /Set Boundary dialog box. For
user interface details, see "Fine-Tune Adherence Levels/Set Boundary Dialog Box" on page 341.
Error Boundary
This is the value of a measurement that is considered to be in error status, even though according to
existing baseline percentiles it should not report an error. This can occur when a measurement value
grows slowly over a period of time, for example, due to a slow memory leak. Because the baseline
threshold is recalculated and updated every day as the measurement average increases, the
measurement value does not cross the new threshold.
To overcome this problem, SiteScope automatically sets the error boundary for each monitor
measurement. It does this by setting a limit that triggers errors when monitor measurements exceed a
specified value, regardless of the baseline. For example, if SiteScope sets an error boundary of 80%
CPU utilization, values over 80% CPU utilization are in error status even if the calculated baseline error
threshold is not exceeded.
For information on how the error boundary is calculated, see "Baseline Threshold Values" below.

Baseline Threshold Values
To help you fine-tune the percentile value used in the baseline calculation at each adherence level and
to set the "Good and Error Boundaries" on the previous page, it is important to understand:
l

The types of threshold values.

l

How they are applied to metrics.

l

How metrics are used to calculate baseline thresholds and boundaries.

Baseline thresholds are added or updated dynamically to the monitor configuration for each
measurement the monitor had before the baseline was calculated. Baseline thresholds are added for
each schedule selected for collecting baseline data.
In general, there are two types of thresholds: baseline thresholds and static thresholds. Baseline
thresholds have a percentile value that is used to determine when a measurement is in error or warning
status, while static thresholds have an actual fixed value. Baseline threshold metrics have a condition
of either >= or <= depending on the direction of the measurement.
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Baseline thresholds are changed, added, or deleted on metrics provided the following two conditions
are met:
The measurement can be used in the baseline calculation. To be used in the baseline calculation, a
measurement must be numeric and it must have a direction. An example of a measurement that
cannot be used in the baseline calculation is a URL 404 error code (it is numeric, but it has no
direction).

l

The measurement has a static threshold defined for any schedule and any status category (Good,
Warning, Error) prior to the baseline calculation.

l

Metrics that do not adhere to these conditions are not affected (in terms of the thresholds defined on
them), and a baseline is not calculated for these metrics.

How SiteScope Calculates Thresholds
When SiteScope calculates the baseline, it creates a percentile value for each baselinable threshold
measurement for each schedule. SiteScope makes an adjustment for extreme metrics by discarding,
by default, 2% of the most extreme samples (considered "noise" metrics), and calculates the
percentiles on the remaining metrics. For example, if most monitor run results on a server show CPU
utilization of no more than 20% and one peak value of 50%, the peak value is not used to determine the
baseline. You can change the percentage of discarded measurement samples in the Baseline Settings.
The baseline engine uses a sliding-window approach to calculate thresholds. This means that newer
data samples have more influence on the baseline calculation than older samples, and that after a
period of time (by default 30 days), the historical data becomes obsolete. You can set the number of
days to include in the calculation in the Baseline Settings.
For information about configuring Baseline Settings, see "Infrastructure Preferences" on page 608.

How SiteScope Calculates the Error Boundary
SiteScope uses the percentile value to create an error boundary for each measurement. This is the
value of a measurement that is considered to be in error status, even though according to existing
baseline percentiles it should not report an error. For details, see "Good and Error Boundaries" on page
335.
SiteScope calculates the error boundary in one of the following ways:
If the measurement has a static error threshold for the specific schedule, the percentile value of the
baseline threshold is calculated into an actual value and this value is then compared to the value of
the static threshold as follows:

l

n

If the static error threshold value is more extreme than the baseline threshold value, the static error
threshold value is used as the error threshold boundary for that measurement.
Example:
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If the static error threshold is 100% CPU utilization and the computed baseline threshold is 67%
CPU utilization, the static error threshold value (100% CPU utilization) is used as the error
boundary.
If the baseline threshold value is more extreme than the static error threshold value, then the offset
value is used. The offset is a percentage value that SiteScope adds to the baseline threshold
value (or subtracts from, depending on the direction of the measurement), and the resulting value
is used as the error boundary for that measurement. You can determine the offset value in the
Baseline Settings panel of Infrastructure Preferences.

n

Example:
If the static error threshold for a schedule is 60% CPU utilization and the computed baseline
threshold value is 65% CPU utilization, the error boundary is calculated as:
65% CPU utilization * 130% (using the default offset value of 0.3) = 84.5% CPU utilization.
l

If there is no error threshold value for the measurement with the specific schedule prior to
calculating the baseline (the measurement has a warning or good threshold value but no error
threshold value), and the Automatically create an error boundary if no error thresholds are
defined option is selected in the Baseline Settings, the percentile value of the baseline threshold is
calculated into an actual value and the offset value is added to/subtracted from the baseline
threshold value (depending on the direction of the measurement). The resulting value is used as the
error boundary for the measurement.
Note: An error boundary is not created if:
n

There is no error threshold value for the measurement with the specific schedule prior to
calculating the baseline (for example, the measurement has a warning or good threshold value
but no error threshold value), and

n

The Automatically create an error boundary if no error thresholds are defined option is
not selected.

For details on defining the offset value and automating error boundary creation, see "Infrastructure
Preferences" on page 608.

Baseline Thresholds User Interface
This section includes:
l

"Calculate Baseline Dialog Box" on the next page

l

"Fine-Tune Adherence Levels/Set Boundary Dialog Box" on page 341

l

"Percentile Range Mapping Table" on page 343
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l

"Backup Configuration Dialog Box" on page 344

l

"Baseline Monitor Measurement Graphs Dialog Box" on page 345

l

"Annotation Tool" on page 348

l

"Remove Baseline Dialog Box" on page 352

l

"Baseline Status Report" on page 353

l

"Activate Baseline Dialog Box" on page 355

Calculate Baseline Dialog Box
This dialog box enables you to select the groups, monitors, or both, to include in the baseline
calculation, select the time range schedule for collecting baseline data, select and fine-tune the
adherence level to determine the extent that monitor measurement sample values have on the
threshold values, and calculate the baseline threshold.
To access

Important
information

Select the Monitors context. In the monitor tree, right-click the SiteScope container,
a group, or a monitor, and select Baselining > Calculate.
l

l

l

Only an administrator in SiteScope, or a user granted Add, edit or delete
monitors or Edit or delete monitors only permissions can use the baseline
feature to set monitor thresholds, and only for the monitors that are in the users
allowed groups list. Monitors in groups for which the user does not have
permissions are not displayed in the dialog box. For details on user permissions,
see "User Management Preferences" on page 732.
The amount of time required to calculate the baseline thresholds depends on the
speed of the SiteScope server and the number of monitors selected for baselining.
If SiteScope needs to restart before the calculation process is complete,
SiteScope automatically continues the process after the restart.
Enable the monitors run for a period that is long enough for SiteScope to
accumulate sufficient data to calculate the baseline. This period depends on the
Minimum number of days required for baselining and Minimum number of
samples required for baselining settings in Infrastructure Preferences. For
details, see "Infrastructure Preferences" on page 608. The baseline can still be
calculated and activated even if the monitor has insufficient data, although the
calculation is unlikely to be accurate.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326
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Select Monitors for Baseline Calculation
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<List of
available groups
and/or
monitors>

Groups, monitors, or both, to include in calculating the baseline threshold. The
list includes the currently selected container and all of the child containers that
are in the users allowed groups list.
Default value: The current container and all child elements are selected.
Note: You cannot select a monitor instance if:
l

l

Its baseline has already been activated. In such cases, the selection check
box is not displayed.
There is another monitor in SiteScope with the same name (the file path,
group name, and monitor name are identical). In such cases, Duplicate
name appears next to the monitor name.

Schedule
User interface elements are described below:
UI
Element

Description

Schedule Schedule ranges used for collecting baseline threshold data. This enables you to restrict
Range
to certain days or hours of the week the periods during which monitor data is collected
Name
for the baseline calculation. The baseline thresholds that are created are only effective
for the same schedule range period. The range schedules displayed are created in
Schedule Preferences. For more information about creating range schedules, see
"Schedule Preferences" on page 712.
Note: You can select multiple ranges using the CTRL or SHIFT keys.
Default value: If no schedule range is selected, baseline threshold data is collected all
day, every day.
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Adherence Level
User interface elements are described below:
Description Enables you to select the adherence level that determines the extent to which monitor
measurement sample values used in calculating the baseline affect the threshold
values. The adherence level is based on a percentile value that is applied to all
monitor measurements to determine when a measurement is in error or warning. You
can also fine-tune the adherence level for individual monitor measurements, and set
the Good Boundary.
To access: In the monitor tree, right-click the SiteScope container, a group, or a
monitor, and select Baselining > Calculate. Expand the Adherence Level panel.
Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Additional Information: Understanding Baseline Calculations" on page 335

User interface elements are described below:
UI
Element

Description

Low
adherence

The further the values used to update the thresholds are from the values calculated by
the baseline. Select this option if you are more tolerant to extreme measurement
values having an effect on the baseline.

Medium
adherence

The values used to update the thresholds are at a mid-range from the values calculated
by the baseline (default setting).

High
adherence

The closer the values used to update the thresholds are to the values calculated by the
baseline. Select this option if you are less tolerant to extreme measurement values
having an effect on the baseline.

Fine-Tune
Adherence
Levels/Set
Boundary

Opens the Fine-Tune Adherence Levels/Set Boundary dialog box, enabling you to finetune the baseline adherence level and define a good boundary for any measurement of
any monitor type within the selected context. For user interface details, see "FineTune Adherence Levels/Set Boundary Dialog Box" below.

Fine-Tune Adherence Levels/Set Boundary Dialog Box
This dialog box displays the percentile value used in the baseline calculation at each adherence level
and the good boundary (if configured), for each monitor measurement in the selected context. This
enables you to fine-tune the baseline adherence level and set good boundaries for any measurement of
any monitor type.
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To access

Select the Monitors context. In the monitor tree, right-click the SiteScope container,
a group, or a monitor, and select Baselining > Calculate. Expand the Adherence
Level panel, and click the Fine-Tune Adherence Levels/Set Boundary button.

Important
You can set adherence level percentile values to over 100%. This enables you to
information raise the threshold level above the level that would have been set, based on the
sample measurements collected. For example, if measurements collected for CPU
Utilization are between 10%-60%, and you only want to get errors above 80% CPU
Utilization, set the Error Percentiles Low value to a percentile that raises the error
threshold level to the desired level. In this instance, set the percentile to 134% (60%
CPU Utilization * 134% = 80.4% CPU Utilization).
Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326

User interface elements are described below:
UI Element

Description
Reset. Restores the default error and warning threshold adherence level values for
the monitor measurement and to remove the Good Boundary.
Select All. Selects all listed monitor measurements.
Clear Selection. Clears the selection.

Monitor
Name:
Measurement
Name

For each monitor in the selected context, displays the measurements that are
used in the baseline calculation. It also displays one measurement that represents
the measurements for all browsable monitors (at the bottom of the list).

Warning
Percentiles

Displays the Low, Medium, and High adherence level percentile value that is
used to calculate the warning baseline threshold. For more details on this topic,
see "Baseline Adherence Level" on page 335.
Default value: Low 110; Medium 93; High 90

Error
Percentiles

Displays the Low, Medium, and High adherence level percentile value that is
used to calculate the error baseline threshold. For more details on this topic, see
"Baseline Adherence Level" on page 335.
Default value: Low 120; Medium 98; High 95

Good
Boundary

Displays the actual value for the Good Boundary for each monitor measurement
type. This is the value of a measurement that is not considered to be in error
status, even though according to existing baseline percentiles it should report an
error. For more details on this topic, see "Good and Error Boundaries" on page 335.
Default value: No value
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UI Element

Description

All browsable Displays the Low, Medium, and High adherence level percentile value that is
monitor
used to calculate the warning and error baseline threshold for all browsable monitor
measurements measurements.
Default Warning values: Low 110; Medium 93; High 90
Default Error values: Low 120; Medium 98; High 95

Percentile Range Mapping Table
This table displays the actual value that is mapped to each percentile range. SiteScope uses the
percentile value to define the baseline error and warning thresholds. Use this table to view the actual
value that corresponds to the percentile value, and to manually change the percentile value.
To access

Select the Monitors context. In the monitor tree, select a monitor with an activated
baseline (you can check whether a monitor has an activated baseline by right-clicking
a group or monitor, and select Baselining > Status Report). Expand the monitor's
Threshold Settings, and click the Percentiles Table button.

Important
This table is available for monitors with an activated baseline only.
information
Relevant
tasks
See also

"How to Set Monitor Thresholds Using a Baseline" on page 327

l

"Set Monitor Thresholds Using a Baseline" on page 326

l

"Threshold Settings" on page 291

User interface elements are described below:
UI Element Description
Percentiles Percentile range that correlates to the actual value used for defining the baseline error
Range
and warning thresholds. You can set the number of percentile ranges displayed in the
table from the SiteScope Preferences (Preferences > Infrastructure Preferences >
Baseline Settings).
Note: The left-hand value is exclusive and the right-hand value is inclusive. This
means that for a percentile range of 33-100, all values above 33 (but not 33 itself) up to
100 are included in the range. The value 33 falls into the previous range and 100.01
falls into the next range.
Actual
Value

The actual value that is mapped to the percentile range.
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UI Element Description
Current
Percentile

Percentile value that correlates to the actual value that is used to define the baseline
thresholds.
Note:
l

l

You can set the current percentile to a value over 100%. This enables you to raise
the threshold level above the level that would have been set, based on the sample
measurements collected. For example, if measurements collected for CPU
Utilization are between 10%-60%, and you only want to get errors above 80% CPU
Utilization, set the percentile value to a percentile that raises the error threshold
level to the desired level. In this instance, set the percentile to 134% (60% CPU
Utilization x 1.34 = 80.4% CPU Utilization).
SiteScope calculates the percentile range as follows:
n

For ranges below 100%, percentiles represent the amount of samples in each
range. So the 80th percentile is the range that 80 percent of the CPU Utilization
values are smaller than or equal to.

n

Ranges above 100%: The 110th percentile is calculated as the 100th percentile
x 1.1 (66.42 x 1.10 = 73.06); the 120th percentile is calculated as the 100
percentile x 1.2 ( 66.42 x 1.2 = 79.7), and so forth.

Backup Configuration Dialog Box
This dialog box enables you to save the current monitor threshold configuration before activating the
baseline threshold. You use the Configuration Tool to restore the configuration settings. For details on
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the Configuration Tool, see the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
group, or a monitor and select Baselining > Review & Activate. Click the Backup
Configuration button.

Important
Create a backup configuration before activating the baseline configuration, since you
information cannot undo threshold configuration changes after the baseline has been activated.
Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326

User interface elements are described below:
UI
Element

Description

Enter
target
directory

Target directory where the backup configuration file is saved or use the default
SiteScope installation directory.

Enter the
backup
file name

Name for the configuration backup file. By default, the file is named using the format:
SiteScope_<MM_DD_YYYY>_<HH_MM_SS>. SiteScope saves a backup file in zip format
to the specified location.

Default value: C:\SiteScope

Example: SiteScope__11_05_2008_08_24_06

Baseline Monitor Measurement Graphs Dialog Box
This dialog box displays a graph per measurement, for all the measurements of the monitor. The default
date selected for displaying the graph is the day with the maximum error reduction. Each graph shows
the current warning and error thresholds, the baseline warning and error thresholds, and historical data
of all baseline-related monitor measurements over a 24-hour time period (from 00:00-23:59).
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To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
group or a monitor container, and select Baselining > Review & Activate. In the
Successfully Calculated Monitors panel, select a monitor with calculated baseline
data, and click the View Graph button.

Important
The data displayed in the monitor measurement graphs is an aggregate of the
information measurement data and as such, the time periods may not accurately reflect the time
the data was collected.
Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326
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Graph Settings
User interface elements are described below:
UI
Element Description
Annotation Tool. Creates a snapshot of the graph you are viewing and highlight
important areas of the graph by drawing shapes, lines, and adding text to the snapshot.
For user interface details, see "Annotation Tool" on the next page.
Collapse Report Filter. Click to collapse or expand the report filter.
Tooltip: When the collapsible report filter closes, the icon's tooltip displays details about
the selections you made in the filter.
Run. After you have specified the report setup, click to run the report for the date
displayed in the date link.
Historic
date
<date
link>

Opens the calendar, enabling you to select the date for which you want to create monitor
measurement graphs. The calendar contains the following buttons:
l

Revert. Returns to the previously selected report date.

l

Current. Selects today's date in the calendar.

l

OK. Updates the date link for the selected date and closes the calendar.

l

Cancel. Closes the calendar without making any changes.

Graph Content
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<Legend>

Describes the color coding used in the graph.

Measurement
name

Name of the measurement appears above the graph.

Date

Time and date on which the graph was generated.

<Data points>

Displays for each 2 hour period of time on the Time axis, the value for the selected
monitor measurement.
Tooltip: The measurement value.
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UI Element

Description

<Measurement Displays the monitor measurement type.
Type> <yaxis>
Hours <xaxis>

Time division units for the date specified when generating the report (from 0-24
hours).

Baseline Error
Threshold

Displays the baseline threshold line that determines Error status. Measurements
beyond this line exceed the error baseline status threshold for the monitor. This is
displayed on the graph as a solid red line.

Baseline
Warning
Threshold

Displays the baseline threshold line that determines Warning status.
Measurements beyond this line exceed the warning baseline status threshold for
the monitor. This is displayed on the graph as a solid orange line.

Current Error
Threshold

Displays the threshold line that determines Error status. Measurements beyond
this line exceed the error status threshold for the monitor. This is displayed on the
graph as a dashed black line.

Current
Warning
Threshold

Displays the threshold line that determines Warning status. Measurements
beyond this line exceed the warning status threshold for the monitor. This is
displayed on the graph as a dashed blue line.

Annotation Tool
This tool enables you to annotate a snapshot of the report you are viewing, to highlight important areas.
The Annotation Tool is available when viewing Baseline Monitor Measurements Graphs. The
Annotation Options enable you to customize your snapshot.
The Annotation Menu Bar contains elements that enable you to:
l

Change the appearance of the snapshot.

l

Save, print, or email an annotation report.

l

Customize the appearance of text annotated onto your snapshot. These elements are enabled only
when the Text Tool
To access

button is selected.

Click the Annotate

button on the right side of the page.

Important
To use the Annotation Tool, the Sun JRE plug-in 1.6.0_x (latest version
information recommended) must be installed on your machine. If the plug-in is not installed on
your machine, you are prompted to install it.
See also

"Set Monitor Thresholds Using a Baseline" on page 326
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Annotation Options
User interface elements are described below:
UI Element
(A–Z)

Description
Pan Tool. Click to navigate the snapshot.
Select Tool. Click to select a specific area of the snapshot.
Shape Tool. Click to add a shape to the snapshot. Clicking the shape tool button
enables the following shape buttons:
Rectangle. Click to mark an area of the snapshot with a rectangle.

l

Filled Rectangle. Click to mark an area of the snapshot with a filled
rectangle.

l

l

Oval. Click to mark an area of the snapshot with an oval.

l

Filled Oval. Click to mark an area of the snapshot with a filled oval.
Rounded Rectangle. Click to mark an area of the snapshot with a round
rectangle.

l

Filled Rounded Rectangle. Click to mark an area of the snapshot with a
filled round rectangle.

l

Customization. After selecting this button, you can customize your line
appearance through the following parts of the interface:
Line Type. Choose the type of line you want to add. Options include:

l

l
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n

Solid Line

n

Jagged Line
Line Width. Select the width of the line, in pixels, in the annotation.

Page 349 of 1395

Using SiteScope
Chapter 24: Set Monitor Thresholds Using a Baseline

UI Element
(A–Z)

Description
Line Tool. Click to enable the line tool, which marks the selected area of the
snapshot with a line.
Customization. After selecting this button, you can customize your line
appearance through the following parts of the interface:
Line Style. Choose the style of line you want to add. Options include:

l

n

Regular line

n

Line with endpoints

n

Line with arrows
Line Type. Choose the type of line you want to add. Options include:

l

l

n

Solid Line

n

Jagged Line
Line Width. Select the width of the line, in pixels, in the annotation.

Text Tool. Click to add text to the snapshot.
Example: Add the syntax This is the problematic transaction above a line
marking an area of the report.
Border and
Fill Colors

Select the relevant square to choose the color of the border and fill of your
annotations. The available squares are:
l

l

Upper Square. Click to choose the color of lines, as generated by the line tool
and displayed in unfilled shapes.
Lower Square. Click to choose the color to fill shapes.

Clicking either of the squares generates a dialog box with the following tabs where
you choose the color:
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l

Swatches

l

HSB

l

RGB
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UI Element
(A–Z)
Opacity

Description
Slide the opacity bar to choose the darkness level of the selected shape line, text
line, or shape color in the annotation.
Note:
l

l

A higher opacity percentage means that the selection appears darker. A lower
opacity percentage means that the selection appears lighter.
This field is enabled when either the shape tool, line tool, or text tool button is
selected.

Annotation Menu Bar
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element
(A–Z)
Description
Save. Saves the snapshot on your local machine.
Note:
l

l

The snapshot is saved in .png format.
You cannot select the New Folder
directory or any of its subdirectories.

icon when saving in the My Documents

Select All. Selects all of the annotations added to your snapshot.
Clear Selected. Clears all annotations.
Undo. Rolls back the most recent action performed on the snapshot.
Redo. Cancels the roll back of the most recent action performed on the snapshot.
Zoom In. Brings the snapshot view closer.
Zoom Out. Sets the snapshot view further away.
Restore original size. Restores the snapshot to its original size.
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UI
Element
(A–Z)
Description
Print. Prints the snapshot.
Send E-mail. Click to send the snapshot via email.
Save to repository. Uploads the snapshot to Report Manager. For details on Report
Manager, see "Report Manager Overview" in the BSM User Guide in the BSM Help.
Note: This option is not available when accessing the Annotation Tool from SiteScope.
Help. Displays online documentation help for the page you are currently viewing.
Bold. Bolds the text.
Note: This field is enabled only when selecting the Text Tool

button.

Italic. Italicizes the text.
Note: This field is enabled only when selecting the Text Tool

button.

Underline. Underlines the text.
Note: This field is enabled only when selecting the Text Tool

button.

Anti-aliasing. Adjusts the pixel reading of text or annotation lines so that they appear
smoother.
Note: This field is only enabled when selecting the Text Tool
<Font
Family>

Select the font for the text in the report.
Note: This field is only enabled when selecting the Text Tool

<Font
Size>

button.

button.

Select the size of the font in the report.
Note: This field is only enabled when selecting the Text Tool

button.

Remove Baseline Dialog Box
This dialog box enables you to select the groups, monitors, or both from which to remove the baseline.
You must remove a monitor's existing baseline calculation before you can recalculate the monitor's
threshold baseline.
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To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
group, or a monitor and select Baselining > Remove.

Important
Only an administrator in SiteScope, or a user granted Add, edit or delete monitors
information or Edit monitors only permissions can remove a baseline, and only for the monitors
that are in the users allowed groups list. Monitors in groups for which the user does
not have permissions are not displayed in the dialog box. For details on user
permissions, see "User Management Preferences" on page 732.
Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<List of
groups
and/or
monitors>

Groups, monitors, or both, from which you want to remove baseline threshold
calculation. The list includes all groups and/or monitors in the currently selected
container, and all child containers in the users allowed groups list.
Default value: The current container and all child elements are selected.

Baseline Status Report
This report displays information about the baseline status for all monitors in the selected context.

To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
group, or a monitor and select Baselining > Status Report.
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Important
information

l

l

l

This is an ad hoc report that is not saved to the SiteScope configuration data for
later use.
You can sort monitor types in ascending or descending order by clicking the
column header. An arrow is displayed showing the sort order direction.
You can filter the display for Monitor Type and Baseline Status by clicking the
down arrow
and selecting a monitor type or baseline status by which to filter.
To clear the filter, select (All).

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326

User interface elements are described below:
UI
Element

Description

Monitor
Name

Name and path of the SiteScope monitor depending on the context.

Monitor
Type

The type of SiteScope monitor.

Note: Only monitors in groups or subgroups that a user has permissions to access are
displayed in the report.

Baseline The monitor's baseline status. The following statuses are available:
Status
l
Monitor not selected for baselining. The monitor has not been selected for
baselining.
l

Calculating baseline. SiteScope is in the process of calculating the baseline.

l

Calculation failed.SiteScope was unable to calculate a baseline.

l

Calculated, not activated. A baseline was calculated for the monitor, but it has not
yet been activated.

l

Activating baseline.SiteScope is in the process of activating the baseline.

l

Activation failed.SiteScope was unable to activate the baseline.

l

Baseline activated. The baseline has been activated for the monitor.
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UI
Element

Description

Baseline Displays additional details for monitors with the following status:
Status
l
Calculating baseline. Displays the baseline calculation stage for the monitor.
Details
l

Refresh

Calculation failed. Displays the reason that the baseline calculation failed
(Insufficient data, No measurements to baseline). Monitors that failed due to
insufficient data are selected by default for automatic baseline calculation after the
monitors have run for a period that is sufficient for SiteScope to accumulate data for
the baseline period. For details, see "Activate Baseline Dialog Box" below.

Click during the calculation process to update the data in the status report.

Activate Baseline Dialog Box
This dialog box displays a summary of the calculated monitor's baseline data, and enables you to save
the current monitor configuration, view baseline measurement graphs, view failed operations, and
activate baseline threshold configuration. For monitors that SiteScope is unable to calculate a baseline,
it includes the reason for the failure.
To access

Important
information

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
group, or a monitor and select Baselining > Review & Activate.
l

l

l

Only an administrator in SiteScope, or a user granted Add, edit or delete
monitors or Edit or delete monitors permissions can use the baseline feature to
set monitor thresholds, and only for the monitors that are in the users allowed
groups list. Monitors in groups for which the user does not have permissions are
not displayed in the dialog box. For details on user permissions, see "User
Management Preferences" on page 732.
To revert to the current monitor configuration, you must create a backup
configuration before activating the baseline configuration.
The amount of time required to activate the baseline threshold depends on the
speed of the SiteScope server and the number of monitors selected for baselining.
If SiteScope needs to restart before the activation process is complete, SiteScope
automatically continues the process after the restart.

Relevant
tasks

"How to Set Monitor Thresholds Using a Baseline" on page 327

See also

"Set Monitor Thresholds Using a Baseline" on page 326
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User interface elements are described below:
UI Element

Description

Successfully Calculated Monitors
View Graph. Displays a graphical representation of baseline data for all the
measurements of the monitor. For details, see "Baseline Monitor Measurement
Graphs Dialog Box" on page 345.
Select All. Selects all listed monitors.
Clear Selection. Clears the selection.
Monitor Name

Name of the SiteScope monitor selected for baselining.

Calculation
Date

Date on which the baseline was calculated.

Error Status
Reduction

Reduction in the number of error statuses for a monitor if the baseline threshold
were applied. A negative number indicates an increase in the number of error
statuses for a monitor if the proposed baseline thresholds were applied.
Example: Suppose you manually configure the threshold status for CPU
Utilization to Error if >= 65% and there are 5 error statuses for the CPU
monitor (of which 3 errors are for data samples between 65%-70%, and 2 errors
for above 70%). If you have SiteScope calculate the threshold using a baseline
and the threshold is set to Error if >= 70%, Error Status Reduction would be
3.
Note: The Error Status Reduction value is based on collected data on the
calculation date.
Tip: If more than three days have elapsed since the calculation date, we
recommend that you recalculate the baseline.
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UI Element

Description

Warning Status
Reduction

Reduction in the number of warning statuses for a monitor if the baseline
threshold were applied. A negative number indicates an increase in the number
of warning statuses for a monitor if the proposed baseline thresholds were
applied.
Example: Suppose you manually configure the threshold status for CPU
Utilization to Warning if >= 55% and there are 3 warning statuses for the CPU
monitor (of which 2 warnings are for data samples between 55%-60%, and 1
warnings for above 60%). If you have SiteScope calculate the threshold using a
baseline and the threshold is set to Warning if >= 60%, Warning Status
Reduction would be 2.
Note: The Warning Status Reduction value is based on collected data on the
calculation date.
Tip: If more than three days have elapsed since the calculation date, we
recommend that you recalculate the baseline.

Failed Monitors
Select All. Selects all listed failed monitors.
Clear Selection. Clears the selection.
Monitor Name

Name of the monitor for which SiteScope was unable to calculate a baseline.

Reason for
Failure

Reason that SiteScope was unable to calculate a baseline value for the monitor.
They include:
l

l

l

l
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Insufficient data. The monitor has not run for a sufficient period of time to
collect data to produce a meaningful baseline threshold. This period depends
on the Minimum number of days required for baselining and Minimum
number of samples required for baselining settings in Infrastructure
Preferences. For details on configuring the Baseline Settings, see "Baseline
Settings" on page 641.
No measurements to baseline. The monitor has no measurements that can
be used in the baseline calculation. You cannot select the monitor for
baseline activation.
No samples for the requested schedule. No data samples were collected
for the range schedule specified. You cannot select the monitor for baseline
activation.
Unknown. The reason for baseline calculation failure is unknown. You
cannot select the monitor for baseline activation.
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UI Element

Description

Can Be
Activated

Indicates whether a baseline can be activated even if the monitor baseline
calculation failed.
Displays No if the baseline calculation failed for any reason other than
Insufficient data.
Displays Yes if the baseline calculation failed with the reason Insufficient data.
SiteScope uses the limited measurement samples that were collected to
calculate the baseline.
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A calculated metric is a metric produced by performing an arithmetic function or logical operation on
existing SiteScope metrics. The calculated metric then appears in the Thresholds Settings panel,
enabling you to configure thresholds based on that metric.
For example, you can create a calculated metric to calculate the average of two or more existing
metrics for a monitor instance, and then configure a threshold that triggers an alert if that average
exceeds a certain number.

To access
Select the Monitors context. In the monitor tree, expand the group folder that contains the monitor, and
select the monitor. In the right pane, click the Properties tab, and select the Calculated Metrics
Settings panel.

Learn About
This section includes:
l

"Calculated Metrics Overview" below

l

"Examples of Calculated Metrics" on the next page

l

"Calculated Metrics for Dynamic Monitors" on the next page

Calculated Metrics Overview
Use calculated metrics to:
l

Analyze metrics that are constantly changing, making it difficult to define status thresholds.

l

Define new arithmetic or logic metrics based on SiteScope regular metrics.

l

l

Enable you to run operations on monitor metrics using out-of-the-box operators, such as sum,
average, minimum, maximum, frequency, and previous.
Enhance the business impact of certain SiteScope metrics.

To create a new calculated metric, you create an expression that consists of metrics, operators, and
values. You can check the validity of the expression at any time while creating the expression. To
enable you to distinguish between the metrics, operators, and values within an expression, they are
separately color-coded.
You can also create calculated metrics when you create a template monitor instance. For details on
creating template monitors, see "How to Create a Monitoring Structure Using a Template" on page 794.
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SiteScope calculates the results for calculated metrics, and the results appear in the SiteScope
Dashboard and in the monitor's status summary.

Examples of Calculated Metrics
Example 1:
You want to calculate the percentage of the page reads/sec to pages/sec for the Microsoft
Windows Performance Counter monitor. Create a calculated metric on the Microsoft Windows
Performance Counter monitor using the following expression:
(<<Memory: Page Reads/sec>> / <<Memory: Pages/sec>>)*100

Example 2:
You want to calculate the maximum CPU usage on a CPU Monitor. Create a calculated metric on
the CPU Monitor using the following expression:
#max(<<CPU Utilization # 1>>, <<CPU Utilization # 2>>, <<CPU Utilization # 3>>,
<<CPU Utilization # 4>>)

Example 3:
You want to check the maximum utilization of vCenter environments. Create the following
calculated metric expression:
#max(<</labm3esx01/HostSystem/cpu/coreUtilization.average*/>>)

Calculated Metrics for Dynamic Monitors
Dynamic monitors automatically update metrics and thresholds according to a metrics pattern that
specifies the metrics you want to monitor. When creating a calculated metric expression, you can use
only those regular expressions that are part of the dynamic monitors’ configured patterns.
For example, the Dynamic Disk Space monitor tracks how much disk space is currently in use on your
server. When dynamic monitoring is configured, the metrics and thresholds are automatically updated
as disks are added to or removed from the server. This enables you to configure the monitor once, and
leave it to detect disks and file system changes.
You can configure calculated metrics for dynamic monitors based on a common function, such as
average or sum.
Example:
To calculate the total free space for all disks, create a calculated metric expression that is the sum
of all metrics created from /.*/MB free/ as follows:
SUM(<</.*/MB free/>>)

Note: You can use only one regular expression per calculated metric that is not part of a function
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(that is, a calculated metric that returns only one result).
For more details on dynamic monitors, see Dynamic Monitoring Mechanism in the SiteScope Monitor
Reference Guide.

Tasks
How to Create a Calculated Metrics Expression
1. Prerequisites
n

Only a SiteScope administrator, or a SiteScope user granted Add, edit or delete monitors or
Edit or delete monitors permissions, can use the calculated metrics feature, and only for the
monitors that are in the user's allowed groups list. If a user does not have permissions to a
group of monitors, those monitors do not appear in the Calculated Metrics Settings panel. For
details on user permissions, see "User Management Preferences" on page 732.

n

To configure calculated metrics to perform some arithmetic functions, there must be at least
one previous value of the selected metric. For example, you cannot calculate a previous
function without at least one previous run of the monitor.

2. Create a calculated metric expression
a. Select the monitor for which you want to create a calculated metric expression, and open the
Calculated Metrics Settings panel in the monitor properties. For user inerface details, see
"Calculated Metrics Settings" on page 363.
b. Configure the calculated metric expression to include metrics, operators, and values.
To insert a metric or operator in the Expression field, double-click the metric or operator, or
drag and drop it into the Expression field. You can also manually enter it in the Expression
field. The selected metric or operator appears in the Expression field in purple.
o

Metrics. The list of metrics is dynamically updated based on the type of monitor that you
are configuring. For example, for a Disk Space monitor, the available metrics are
<<percent full>> and <<MB free>>.

o

Operators. Defines the relation between the metric and the value. Operators contain
functions. For details about operators, see "Operators" on page 364.

o

Values. A number or numerical expression applicable to the metrics parameter. For
relational or Boolean operations, enter 1 or 0. For SiteScope functions, enter values in the
inside parentheses of the operator. For example, to calculate the average of the numbers
7, 9, and 11, enter those numbers inside the operator parentheses as follows: #Average
(7, 9, 11).
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Note:
l

Calculated metric expressions involving the following features cannot be
calculated:
l

l

A number divided by 0.
A non-numerical string divided by a number. For example, the expression
<<Overlicensed status>>/100 for a License Usage Monitor cannot be
calculated because <<Overlicensed status>> is non-numerical.

For such calculated metrics, n/a appears in the Summary column of the
Dashboard for the relevant calculated metric.
For more details about available operations when creating calculated metric
expressions, see "Available Data Processing Operations" on page 390.
l

l

l

You can include nested functions in expressions. For example, #average(#max
(<<access permitted>>.length,<<directory exists>>.length),2).
For monitors, the Summary column in the Dashboard displays the most recent
measurement results reported by the monitor. This may include more than one
measurement, depending on the monitor type. For monitor groups, the summary
displays the number of monitors within the group and the number of monitors, if
any, that are reporting an error status.
Owing to a limitation of the JavaScript engine, calculated metric expressions
cannot include values greater than 252. For more details, see http://ecmainternational.org/ecma-262/5.1/.

3. Check the validity of the expression - optional
To enable you to distinguish between the metrics, operators, and values within an expression,
they are separately color-coded. If any character is missing from a metric or operator, the metric or
operator remains black.
To check the validity of the expression at any time while creating the expression, click Validate.

How to Set Combined Threshold Calculated Metrics
You can create calculated metrics which include logical expressions that can be used in thresholds.
To do this, configure two calculated metrics in the Expression field in the New/Edit Calculated Metrics
dialog box, and insert an operator between those two calculated metrics.
Example:
(utilization cpu#11==3)&(utilization cpu#12==5)
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UI Descriptions
Calculated Metrics Settings
UI Element

Description
New. Enables you to creates a new calculated metric in the New/Edit Calculated
Metrics dialog box. For details, see "New/Edit Calculated Metric Dialog Box" below.
Delete. Deletes the selected calculated metric.
Edit. Enables you to edit the selected calculated metric.
For details, see "New/Edit Calculated Metric Dialog Box" below.

Name

Name that describes the calculated metric.

Expression

Defines the calculated metric. Expressions include metrics, operators, and values.
For details, see "New/Edit Calculated Metric Dialog Box" below.

Description Optional description of the calculated metric to make it easier to understand what the
calculated metric does.

New/Edit Calculated Metric Dialog Box
This dialog box enables you to create a new calculated metric or edit an existing calculated metric.
UI Element

Description

Calculated Metric Panel
Name

Name that describes the calculated metric. The name should be unique, to
distinguish it from the names of other calculated metrics.
If you do not enter a name, the default name is Calculated Metric, followed by the
number of the calculated metric. For example, if there already exists one calculated
metric for a monitor and you create an additional calculated metric for that monitor,
the default name of the additional calculated metric is Calculated Metric 2.
Note: The following special characters are not supported in this field: " ' > <

Description Optional description of the calculated metric to make it easier to understand what the
calculated metric does.
Expression

Calculated metric expressions include metrics, operators, and values.
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UI Element

Description

Validate

Checks the validity of the syntax of the expression in the Expression field. If the
expression is valid, the ok test icon appears. If the expression is invalid, an Error
dialog box opens indicating that the expression could not be calculated.

Clear

Deletes the expression in the Expression field.

Metrics

Metrics to insert in the Expression field. The list of metrics is dynamically updated
based on the type of monitor that you are configuring. For example, for a Disk Space
monitor, the available metrics are <<percent full>> and <<MB free>>.
To insert a metric in the Expression field, double-click the metric, or drag and drop
the metric into the Expression field. You can also manually enter the metric in the
Expression field. The selected metric appears in the Expression field in purple. If
any character is missing from a metric, the metric remains black; if you click
Validate, it appears highlighted.

Operators

Operators define the relation between the metric and the value. Operators contain
functions. For more details about operators, see "Operators" below.
To insert an operator in the Expression field, double-click the operator, or drag and
drop the operator into the Expression field. You can also manually enter the operator
in the Expression field. The selected operator appears in the Expression field in
blue. If any character is missing from an operator, the operator remains black; if you
click Validate, it appears highlighted.

Integration Panel
Monitored
Entity

Displays the name of the monitored entity for the current calculated metric. If
SiteScope is connected to Business Service Management (BSM), the Integration
Panel displays the CI that is reported to BSM. For more details about monitored
entities, see "Monitored Entity" on page 367.
Note: If you have selected a CI in the CI Type field in the HP Integrations Settings
panel, this CI Type appears as the monitored entity in the Calculated Metric
Integration Panel. For more information about the HP Integrations Settings panel, see
"HP Integration Settings" on page 297.

Operators
Operators include:
l

Arithmetic operators. +, -, *, /, (, ).

l

Boolean operators.
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Logical

Binary

and

&

&&

or

|

||

not

~

!

Note: You can use the operator | followed by zero (that is, |0) at the end of an expression to
determine whether the expression is true or false. For example, if the metric <<utilization
cpu #1>> is greater than the metric <<utilization cpu #2>>, the expression
(<<utilization cpu #1>> > <<utilization cpu #2>>)|0 returns the result 1, indicating
that the expression is true. If the expression is false, it returns the result 0.

l

Relational operators. <, >, ==, !=, <=, >=.

l

JavaScript String Object Methods:

l

.length

.charAt()

.concat()

.indexOf()

.lastIndexOf()

.match()

.replace()

.search()

.split()

.slice()

.substr()

.substring()

toLowerCase()

.toUpperCase()

.valueOf()

SiteScope functions:
n

#Average() - Calculates the average (mean) value among a series of numbers or value of
numerical expressions, separated by commas. For example, #Average(value 1, value 2,
value 3) calculates the average of value 1, value 2, and value 3.
This function works only if Java version 7 is installed on each client side user station.

n

#Frequency() - Returns the value of the monitor running frequency in seconds. For example, if
the running frequency of a monitor is set at one minute, #frequency() returns the result 60.0.

n

#longToDate() - Converts a time stamp in numerical format to a regular readable format. The
function receives a number (Long) and converts it to a date string according to the date format in
the second parameter: #longToDate(Long, Date Format). The returned timestamp is the
number of milliseconds since January 1, 1970 00:00:00.000 GMT. If GMT on the SiteScope
server machine is set to +6 for example, then the “start date” will be 1st January 1970
06:00:00.000

n

#Max() - Returns the maximum value among a series of numbers or value of numerical
expressions, separated by commas. For example, #Max(value 1, value 2, value 3)
calculates the maximum value of value 1, value 2, and value 3.
This function works only if Java version 7 is installed on each client side user station.
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n

#maxMetric() - Returns the name of the metric which has the maximum value. It works only if
the expression includes regular expressions.
For example, if the value of the metric <<Zone/l2sun23-z1/mem/%memory>> is greater than the
value of the metric <<Zone/l2sun23-z2/mem/%memory>>, then #maxMetric(<<Zone/l2sun23z1/mem/%memory>>,<<Zone/l2sun23-z2/mem/%memory>>) returns <<Zone/l2sun23z1/mem/%memory>> (but not its value).
This function works only for dynamic monitors.

n

#Min() - Returns the minimum value among a series of numbers or value of numerical
expressions, separated by commas. For example, #Min(value 1, value 2, value 3)
calculates the minimum value of value 1, value 2, and value 3.
This function works only if you have installed Java version 7.

n

#minMetric() - Returns the name of the metric which has the minimum value. It works only if the
expression includes regular expressions.
For example, if the value of the metric <<Zone/l2sun23-z1/mem/%memory>> is less than the
value of the metric <<Zone/l2sun23-z2/mem/%memory>>, then #minMetric(<<Zone/l2sun23z1/mem/%memory>>,<<Zone/l2sun23-z2/mem/%memory>>) returns <<Zone/l2sun23z1/mem/%memory>> (but not its value).
This function works only for dynamic monitors.

n

#Previous() - Returns the value of a metric from the previous monitor run. For example, if the
MB free value of a memory monitor on its last run was 7828 MB and its current run is 7821 MB,
#previous(<<MB free>>) returns the result 7828.0.

n

#Sum() - Returns the sum of a series of numbers or value of numerical expressions, separated
by commas. For example, #Sum(value 1, value 2, value 3) calculates the sum of value 1,
value 2, and value 3.
This function works only if Java version 7 is installed on each client side user station.

n

#valueOf() - Returns the value of the metric. The metric name should be inserted inside
parentheses, without angle brackets.
For example, you enter the expression #valueOf(#maxMetric(/(.)/cpu*1/) + "cpuClick").
If the value of the regular expression (/(.)/cpu*1) is VM1/cpuBla1, then the returned value is
VM1.

n

#numberOfRuns() - Returns the sequential number of a monitor run 1,2,3… taken from the
monitor property with the name “sample”. This enables you to switch the monitor status for every
run between two states of the metric. For example, (#numberOfRuns()/2 + "").indexOf
('.').
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Monitored Entity
Most SiteScope monitors report one monitored CI to BSM. This CI automatically appears as the
monitored entity in the Monitored Entity field. For monitors that report separate CI for each metric, the
calculated metric is connected to CIs according to the following table:
Note: After you have created a calculated metric with a particular monitored entity, you cannot
later select another monitored entity for that calculated metric. In that case, you need to delete the
calculated metric and create a new one with the desired monitored entity.
Monitor
Name

CI Type

Dynamic
Disk Space
Monitor

Always a computer.

SAP CCMS
Monitor

SAP System

SAP Work
Processes
Monitor

SAP ABAP Application Server

Siebel Web
Server
Monitor

Siebel Web Server Extension

Siebel
Application
Server
Monitor

Siebel Application Server

Note: If a SAP CCMS monitor is not connected to BSM, or you do not have the
license required to enable this monitor type, NODE appears in the Monitored Entity
field.

Note: If a SAP Work Processes monitor is not connected to BSM, or you do not have
the license required to enable this monitor type, NODE appears in the Monitored
Entity field.

Note: If a Siebel Web Server Extension monitor is not connected to BSM, or you do
not have the license required to enable this monitor type, NODE appears in the
Monitored Entity field.

Note: If a Siebel Application Server monitor is not connected to BSM, or you do not
have the license required to enable this monitor type, NODE appears in the Monitored
Entity field.
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Monitor
Name
Solaris
Zones
Monitor

CI Type
In regular mode:
You must select a monitored entity by clicking the Monitored Entities
and selecting a monitored entity from the monitored entity tree.

button

In template mode:
If the calculated metric includes a free regular expression, the "Monitored Entity is set
by regular expression" message appears in the Monitored Entity field. This means
that the monitored entity is calculated automatically during the template deployment.
VMware
Performance However, you may still select a monitored entity by clicking the Monitored Entities
Monitor
button and selecting a monitored entity from the monitored entity tree.
If the calculated metric does not include a free regular expression, you must select a
monitored entity from the monitored entity tree.
For information about free regular expressions, see "Free regular expressions" below.
VMware
Host
Monitors

VMware
Datastore
Monitor

If the calculated metric includes a free regular expression, the "Monitored Entity is set
by regular expression" message appears in the Monitored Entity field. This means
that the monitored entity is calculated automatically for each calculated metric that
results from the calculated metric. However, you may still select a monitored entity
by clicking the Monitored Entities
the monitored entity tree.

button and selecting a monitored entity from

If the calculated metric does not include a free regular expression, you must select a
monitored entity from the monitored entity tree.
For information about free regular expressions, see "Free regular expressions" below.

Free regular expressions
A free regular expression is a regular expression that is not inside a function. For more details about
regular expressions, see "Regular Expressions" on page 175.
For example, the following is a free regular expression:
/.*VirtualMachine/.*/cpu/usagemhz.average[]/

This is calculated into four different calculated metrics, as follows:
labm3esx01/VirtualMachine/sisqavm01/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm02/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm03/cpu/usagemhz.average[]
labm3esx01/VirtualMachine/sisqavm04/cpu/usagemhz.average[]
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Each of these calculated metrics has its own monitored entity according to the virtual machine name,
as follows:
sisqavm01
sisqavm02
sisqavm03
sisqavm04

Tips/Troubleshooting
Troubleshooting/Limitations
l

l

l

The Calculated Metrics Settings panel does not appear for custom monitors. You can create
calculated metrics in custom monitors inside their data processing script.
You can create calculated metrics when you create a template monitor instance. For details on
creating template monitors, see "How to Create a Monitoring Structure Using a Template" on page
794.
You can limit the number of calculated metrics per monitor that can be displayed in the Dashboard
(default is 100). In the case of dynamic monitors, the number of calculated metrics per monitor is
calculated after SiteScope has evaluated all dynamic monitors regular expressions. You can
change the maximum number of calculated metrics per monitor in Preferences > Infrastructure
Preferences > Calculated Metrics Settings. For details, see "Calculated Metrics Settings" on
page 635.
Note: If you reduce the maximum number of calculated metrics to less than the number of
calculated metrics already configured for that monitor, the number of calculated metrics that
appear in the Dashboard and in the calculated metrics table for that monitor is the new
maximum number of calculated metrics and an error is written to RunMonitor.log.

l

l

The Arithmetic Counters feature was deprecated and replaced by Calculated Metrics. If you created
Arithmetic Counters in an earlier version of SiteScope and performed a SiteScope upgrade, you
need to recreate the counters in the Calculated Metrics panel, and then delete the Arithmetic
Counters.
When you run a CPU Monitor on a server that has no metrics, the calculated metric result that
appears in the SiteScope Dashboard is n/a. If you then select a server that has metrics and run the
monitor again, the calculated metric result remains n/a. To obtain a calculated metric result for the
monitor that has metrics, you need to create a new calculated metric for that monitor.
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Elastic or dynamic configuration is a way to automatically adjust the SiteScope monitoring
configuration based on changes that are happening in your IT environment. SiteScope provides various
dynamic monitors that automatically update themselves over time by adding and removing counters as
changes occur in the system (for example, as disks/MBeans are added to or removed from the server,
as datastores and virtual disks are added or removed from the VMware Datacenters, or as virtual
machines move from one host system to another). In addition, you can select counter patterns to be
used as threshold conditions. In this way, thresholds are also updated automatically when the counters
are updated.

Learn About
This section includes:
l

"List of Dynamic Monitors" below

l

"Dynamic Monitoring Mechanism" below

l

"Calculated Metrics for Dynamic Monitors" on page 372

List of Dynamic Monitors
The following dynamic monitors are available in SiteScope:
l

Dynamic Disk Space Monitor

l

HP Vertica JDBC Monitor

l

Dynamic JMX Monitor

l

KVM Monitor

l

Generic Hypervisor Monitor

l

VMware Datastore Monitor

l

Hadoop Monitor

l

VMware Host Monitors

For task details, UI description, and tips/troubleshooting, see the specific dynamic monitor in the
SiteScope Monitor Reference guide.

Dynamic Monitoring Mechanism
The dynamic monitoring mechanism works as follows:
l

Define Counter Patterns
To enable the monitor to dynamically update counters, you define the counter patterns you want to
monitor using regular expressions. SiteScope uses Perl regular expressions for pattern matching.
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For example, if you enter /cpu.*/ or cpu, any counters with cpu in their name match this pattern
and are added to the counters list.
Examples:
Dynamic Disk Space monitor: If you enter the pattern /.*/.*platform.*/MB free/, the
monitor retrieves the MB free counters on disks that contain the word platform in their file
system's name.
Dynamic JMX, Hadoop monitor: If you enter the pattern /java.lang/ClassLoading/.*/,
the monitor retrieves all the ClassLoading counters in the JMX application, such as
TotalLoadedClassCount, UnloadedClassCount, LoadedClassCount, ObjectName.
KVM/Generic Hypervisor monitor: If you enter the pattern /.*/Domains
Information/.*/Used Memory/, the monitor retrieves the Used Memory counter for all VMs.
VMware Datastore monitor: If you enter the pattern /.*/.*/accessible/, the monitor
retrieves the accessible counter for all datastores.
VMware Host monitor: If you enter the pattern
/.*/VirtualMachine/.*/cpu/usage.average\[\]/, the monitor retrieves the
usage.average[] counter for all VMs.
l

Set Update Frequency
You set the frequency of the dynamic update mechanism at the monitor level. This is the frequency
that SiteScope uses to update the counters retrieved from the server. This enables running the
update mechanism at a frequency that is appropriate for the monitor type. The update frequency
should not be less than the monitor run frequency in Monitor Run Settings. For example, if the
monitor runs every 10 minutes, the dynamic update frequency should be at least 10 minutes.

l

Use Counter Patterns as Threshold Conditions
You can also select counter patterns to be used as threshold conditions. In this way, thresholds are
also updated automatically when the counters are updated. For example, in the Dynamic JMX
example above, you could set an error threshold based on the /java.lang/ClassLoading/.*/
counter pattern.
The thresholds list always contains the counter patterns that were defined in the counters pattern
table (not the final counters that were found). The values in this list are updated according to
changes you make in the counter patterns table.

l

Update Mechanism
During each update, the monitor connects to the server and automatically updates the status of
each counter that matches the pattern defined by the regular expression as follows:
n

It adds counters that match the patterns defined by the regular expression, and updates the
status of each counter.
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n

If the Continue displaying counters that no longer exist after update option is cleared, it
removes counters that no longer exist (avoids errors unnecessarily being logged). If this option is
selected (the default setting), counters are only added; not deleted.

n

If you also defined a threshold using a counter pattern, then thresholds are added or removed
according to the counters available on server that match the pattern.

In this way, the monitor automatically configures itself with counters on the relevant dynamic
environment components.
If there are no counters that match the monitor patterns and no static counters, then the changes
are not saved since the monitor must have counters.
Note: When you define static counters (with no regular expression), these counters are never
removed from the monitor, even if they are no longer available on the server.

Calculated Metrics for Dynamic Monitors
A calculated metric is a metric produced by performing an arithmetic function or logical operation on
existing SiteScope metrics. The calculated metric then appears in the Thresholds Settings panel,
enabling you to configure thresholds based on that metric. For example, you can create a calculated
metric to calculate the average of two or more existing metrics for a monitor instance, and then
configure a threshold that triggers an alert if that average exceeds a certain number. For more details on
calculated metrics, see "Create Calculated Metrics" on page 359.
When creating a calculated metric expression for dynamic monitors, you can use both static metrics
(for which you can use calculated metrics normally, without using patterns), and you can use regular
expressions that are part of the dynamic monitor’s configured patterns.
For example, the Dynamic Disk Space monitor tracks how much disk space is currently in use on your
server. When dynamic monitoring is configured, the metrics and thresholds are automatically updated
as disks are added to or removed from the server. This enables you to configure the monitor once, and
leave it to detect disks and file system changes.
You can configure calculated metrics for dynamic monitors based on a common function, such as
average or sum.
Example:
To calculate the total free space for all disks, create a calculated metric expression that is the sum
of all metrics created from /.*/MB free/ as follows:
SUM(<</.*/MB free/>>)

Note: You can use only one regular expression per calculated metric that is not part of a function
(that is, a calculated metric that returns only one result).
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SiteScope's content matching capabilities is an important function in monitoring networked information
systems and content. For SiteScope monitors that provide content matching, the basic content
matching is available through the use of Perl regular expressions.
SiteScope also includes the capability of matching document content by traversing XML documents.
For example, you can include an XML match content string using the URL Monitor and Web Services
Monitor to match an XML element name, an attribute of an XML element, or the content of an element.
You can use this to check for content in XML based Web pages, SOAP or XML-RPC documents, and
even WML pages served to WAP-enabled devices.

Learn About
Content Matching for XML Documents
The syntax of XML match content strings reflects the hierarchal structure of the XML document. Match
content strings that start with "xml" are recognized as element names within an XML document. The
element names are added, separated by periods, in the order of their relationship to the root element.
For example, in the document weather.xml the root element is <weather>. This element includes child
elements named <area>, <skies>, <wind>, <forecast>, and so forth. To access the content of these
XML elements or their attributes, you would use a syntax like xml.weather.area.
To check that specific content or value is present, add an equals sign after the element name whose
content you are testing and then add the value of the content. If there are multiple instances of an
element name in the document, you can check a particular instance of that element by adding the
number indicating the order of the element in the document in square brackets (see the example in the
table below). You can also test for multiple elements or values by separating individual search strings
with commas. The table below gives several examples of the syntax used to match content in XML
documents.
Example Match Content

Description

xml.weather.temperature

Succeeds if any <weather> node in the document contains one or
more <temperature> elements. The content of the <temperature>
elements is returned by the monitor. If no <temperature> element is
found within the <weather> node, an error is returned.
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Example Match Content

Description

xml.weather.temperature=20

Succeeds if any <weather> node in the document contains one or
more <temperature> elements where the content of the
<temperature> element equals 20. The content of the
<temperature> element is not returned by the monitor if the match is
found. An error is returned if no <temperature> element is found
within the <weather> node or if no <temperature> element contains
the value 20.

xml.weather.forecast.
[confidence]

Succeeds if any <weather> node in the document contains a
<forecast> element that has an attribute called confidence. The
value of the confidence attribute is returned by the monitor if the
match is found. An error is returned if no <forecast> element is found
within the <weather> node or if no confidence attribute is found.

xml.weather.forecast[3].
[confidence]=50

Succeeds if any <weather> node in the document contains three or
more <forecast> elements where the third <forecast> element has a
confidence attribute with a value of 50. An error is returned if the
<weather> node has fewer than three <forecast> elements or if the
value of the confidence attribute is not equal to 50.

xml.weather.temperature=20,
xml.weather.skies=rain

Succeeds if any <weather> node in the document contains one or
more <temperature> elements where the content of the
<temperature> element equals 20 and if any <weather> node
contains one or more <skies> elements where the content of the
<skies> element equals rain. Returns an error if either of the
matches fails.

xml.wml.card.p.table.tr.td.
anchor=Home Page

Checks the content of <anchor> elements in the designated path of
a WML document. Succeeds if any <card> node containing table
cells with one or more <anchor> elements where the content of
any of the <anchor> elements equals "Home Page."

XML Content Match Values in Monitor Configurations
Monitors like the URL Monitor have a content match value that is logged to the SiteScope monitor data
log and can also be used to set error and warning status thresholds for the monitor. The values of the
XML names are saved as the content match values for the monitor.
For example, if the match content expression was xml.weather.temperature and the document was
the contents of the file weather.xml, then the content match value would be 46.
You can then set the error, warning, and good status thresholds in the Advanced Options section for the
monitor to compare your specific thresholds to the value returned by the content match.
For example, if you are monitoring temperature values and want to be alerted when the temperature
value drops below 72 degrees, you could set the monitor status thresholds as follows:
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Error if

content match < 72

Warning if

content match = 72

Good if

content match > 72

With this configuration, the monitor checks the content of the temperature element and then compares
it to the error and warning thresholds. In the example above, the status of the monitor would be error
because the temperature value is 46, which is less than 72.
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Part 5: Integration Monitors
Integration monitors are used to capture and forward data from third-party domain managers or
applications (typically Enterprise Management Systems (EMS)) into BSM. These monitor types require
additional licensing and may only be available as part of another HP product.
This section describes the following:
l

l

l

l

l

l

An overview of integration monitors, which includes integration monitor categories and a list of
integration monitors, field mapping scripts to map the data the monitors collect to a format
recognizable by BSM, event handler structure, topology script for reporting topology to BSM, and
instructions on deploying integration monitors and migrating existing integration monitors from
SiteScope to BSM Connector. For details, see "Integration Monitors Overview" on page 377.
How to configure generic integration monitors to collect time-based metrics data. For details, see
"Configure Integration Monitors to Collect Metrics Data" on page 401.
How to configure generic integration monitors to collect common or legacy event-based data.
Common events data is used to integrate events collected from third-party domain managers or
applications to BSM 9.x. Legacy events are used to collect data on specific events in BAC 8.x and
earlier (retained for backward compatibility). For details, see "Configure Integration Monitors to
Collect Event Data" on page 438.
How to configure generic integration monitors to collect incidents and events from ticketing
systems. Data collected by integration monitors that use the ticketing data type is integrated into
BSM and can be viewed in Service Health and Service Level Management. For details, see
"Configure Integration Monitors to Collect Ticketing Data" on page 457.
How to report the topology discovered by the SiteScope Technology Integration monitors, without
reporting the data. For details, see "Report Topology Without Data" on page 465.
How to forward event data from Network Node Manager (NNM) to BSM. For details, see "Network
Node Manager Integration" on page 467.
Note: Since EMS functionality was moved to BSM Connector, a free HP application that provides
more functionality and coverage of third-party data, not all EMS monitors are available (check the
specific monitor for details). HP recommends using BSM Connector for all new third-party data
integrations. Note that BSM Connector works with BSM 9.20 and later only. For details on BSM
Connector, see the BSM Application Administration Guide in the BSM Help.
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Integration monitors are run by the SiteScope data collector and are used to capture and forward data
from third-party domain managers or applications (typically Enterprise Management Systems (EMS))
into BSM. There are two levels of configuration for collecting the data and forwarding that data to BSM:
l

l

Required: The monitors must be configured to properly map to the monitored system and collect
the required data samples, whether in the form of events, metrics, or tickets. The field mapping from
the monitored system is done by selecting a data type in the Field Mapping setting and editing the
corresponding script in a text editor.
Optional: The data can also be mapped to a topology to forward data to the correct CI hierarchy in
BSM. This enables the monitor to accurately report status to the required CIs within BSM for use by
the different applications in the product. The topology settings are configured using a topology script
that is loaded depending on the type of topology you want to create.
Note: You can have SiteScope report only the topology discovered by the SiteScope
Technology Integration monitors, without reporting the data. For details, see "Report Topology
Without Data" on page 465.

Learn About
This section also includes:
l

"Integration Monitor Categories" below

l

"Field Mapping Data Types" on page 379

Integration Monitor Categories
Integration monitors can be divided into two categories: Application-Specific monitors and Generic
Integration monitors.
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Category

Description

Application- These integration monitors are designed for use with specific EMS applications.
Specific
These monitors are predefined with the required field mapping and topology settings.
Monitors
The monitors include:
l

HP OM Event Monitor

l

HP Service Manager Monitor

l

NetScout Event Monitor

Note:
l

l
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The HP OM Event monitor is not available when SiteScope is connected to BSM
version 9.00 or later (unless the monitor was created in an earlier version of
SiteScope that was upgraded to SiteScope 11.20). OM events can be forwarded to
BSM 9.00 from the HPOM Server, provided you have an Event Management
Foundation license and an integration is configured between Operations Manager
and BSM.
Topology Settings are not available for the NetScout Event Monitor.
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Category

Description

Generic
Integration
Monitors

Technology Integration Monitors designed for use with most EMS applications that
support extraction of data from a database, log file, SNMP trap, or Web service
interface. The field mapping and topology settings for these monitors must be
configured by loading the applicable scripts and editing them in a separate text editor
during monitor creation. The monitors include:
l

Technology Database Integration Monitor

l

Technology Log File Integration Monitor

l

Technology SNMP Trap Integration Monitor

l

Technology Web Service Integration Monitor

Note:
l

l

l

l

If you are using SiteScope 11.30 or earlier, and SiteScope is connected to BSM
9.20 or later, you can only use previously created Generic Integration monitors.
To block the creation of this monitor in the SiteScope user interface, change the _
enableEMSMonitors property value to false in the <SiteScope root
directory>\groups\master.config file, and restart SiteScope (by default, the
value is set to true).
For all new third-party data integrations, HP recommends using BSM Connector.
BSM Connector provides more functionality and coverage regarding the types of
third-party data that can be collected than Technology Integration monitors. Note
that BSM Connector works with BSM 9.20 and later only. For details on BSM
Connector, see the BSM Application Administration Guide in the BSM Help.
Generic Integration monitors are not available in the user interface when using
Community or Load Testing edition.

For monitor details on Integration monitors, see the Integration Monitors section of the SiteScope
Monitor Reference Guide in the SiteScope Help.

Field Mapping Data Types
The integration monitors use field mapping scripts to correctly map the data they collect to a format
recognizable by BSM. You use the field mapping scripts that come prepackaged with SiteScope as a
basis for creating a customized configuration required for your specific environment. When you
configure an integration monitor, you select the data type to load the required script and edit the script to
collect the data you want to forward to BSM.
l

For generic integration monitors, you can configure and customize the mapping as required. When
you select a field mapping type, you can use the script editor provided, or you can copy the script
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into your preferred text editor, make your changes, and then copy the script back into the field
mapping text box.
l

For application-specific monitors, the mapping are not editable while configuring the monitor, and
we recommend that you use the out-of-the-box integration mapping already configured for those
monitors.

You can select from the following types of sample scripts (when configuring the generic integration
monitors):
Data
Type
Metrics

Description
Used to collect time-based data. Data collected by Integration Monitors that use the
metrics data type is integrated into BSM as typical SiteScope data and can be viewed in all
contexts that support viewing SiteScope data (for example, Service Health, Service Level
Management, SAM, user reports, and so on). For more details, see "Configure Integration
Monitors to Collect Metrics Data" on page 401.
For details on customizing the field mapping scripts, see "Integration Monitor Field
Mapping for Metrics Samples" on page 401.

Events

l

l

Common Events. Used to integrate events collected from third-party domain
managers or applications to BSM 9.x. Unlike the legacy EMS events, the Common
Event integration allows you to manage the events in Operations Management event
sub system and the Service Health console. In addition, the common event channel
provides the option to report topology to BSM without reporting the data. For more
details, see "How to Configure Integration Monitors to Collect Data on Common
Events" on page 449.
Legacy Events. Used to collect data on specific events in BAC 8.x and earlier
(retained for backward compatibility). Data collected by Integration Monitors that use
the event data type is integrated into BSM using the UDX framework and can be
viewed in contexts that support the display of UDX data (Event Log, Service Health,
trend reports). The data can also be accessed using the BSM API. For more details,
see "How to Configure Integration Monitors to Collect Data on Legacy Events" on page
452.
For details on customizing the field mapping scripts, see "Integration Monitor Field
Mapping for Event Samples" on page 438.
Note: Events sent by EMS applications are event samples. They are not the same
as Operations Management events in BSM.
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Data
Type

Description

Tickets

Used to collect incidents and events from ticketing systems. Data collected by integration
monitors that use the ticketing data type is integrated into BSM and can be viewed in
Service Health and Service Level Management. For more details, see "How to Configure
Integration Monitors to Collect Ticketing Data" on page 461.
For details on customizing the field mapping scripts, see "Integration Monitor Field
Mapping for Ticketing Samples" on page 457.

Troubleshooting/Limitations
This section describes troubleshooting and limitations when working with SiteScope Integration
Monitors.
l

"Integration Monitor Logs" below

l

"Other Log and Troubleshooting Issues" on the next page

l

"Additional Troubleshooting Information" on the next page

Integration Monitor Logs
Integration Monitor activity is logged to <SiteScope root directory>\logs\
RunMonitor.log and <SiteScope root directory>\logs\bac_integration\bac_integration.log.
You can modify the level and type of information reported to the log file by changing the log file settings
in the <SiteScope root directory>\conf\core\
Tools\log4j\PlainJava\log4j.properties file. You can instruct the logging mechanism to:
l

Report logged information in less or greater detail than is reported by default.

l

Log all samples sent by Integration Monitors to BSM.

l

Log all received events from external EMS systems.

To modify log settings:
1. Open the log4j.properties file in a text editor.
2. To specify that samples sent by Integration Monitors to BSM be logged:
a. Locate the following lines in the file:
log4j.category.EmsSamplePrinter=${loglevel}, integration.appender
log4j.additivity.EmsSamplePrinter=false
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b. Change the argument of log4j.category.EmsSamplePrinterfrom ${loglevel} to DEBUG, as
follows:
log4j.category.EmsSamplePrinter=DEBUG, integration.appender
c. Save the file. It may take a few seconds for the changes to take effect.
The results are logged to the bac_integration.log file.
3. To specify that all received events from external EMS systems be logged:
a. Locate the following lines in the file:
log4j.category.EmsEventPrinter=${loglevel}, monitors.appender
log4j.additivity.EmsEventPrinter=false
b. Change the argument of log4j.category.EmsEventPrinter from ${loglevel} to DEBUG, as
follows:
log4j.category.EmsEventPrinter=DEBUG, monitors.appender
c. Save the file. It may take a few seconds for the changes to take effect. The results are logged
to the RunMonitor.log file.

Other Log and Troubleshooting Issues
l

l

l

Look for errors in <SiteScope root directory>\logs\error.log and in <SiteScope root
directory>\logs\bac_integration\bac_integration.log.
If samples are created and sent from SiteScope but cannot be seen in BSMService Health, Event
Log, or SiteScope reports, search for the string ERROR or WARN in the wde.logl and loader.logl files
in the <BSM root directory>\log\mercury_wde\ directory to make sure the samples were not
dropped due to missing fields or values.
Increase the level of Service Health logging in <BSM
root directory>\conf\core\Tools\log4j\EJB\ble.properties file to verify that Service Health is
receiving samples. Locate the following parameter and change the log level status to DEBUG:
log4j.category.Trinity.BLE_SAMPLES=DEBUG, trinity.samples.appender

The results are logged to the <BSM root directory>\log\EJBContainer\TrinitySamples.log.
Tip: After you have determined the cause of the problem, we recommend that you set log levels to
their default settings so as not to overload the system.

Additional Troubleshooting Information
Additional troubleshooting information is located in the HP Software Self-solve Knowledge Base
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(https://softwaresupport.hp.com/group/softwaresupport/search-result) (you must log on to the
knowledge base with your HP Passport ID) and in the following sections of the documentation:
l

l

l

l

For troubleshooting the Technology Database Integration monitor, see Technology Database
Integration Monitor in the SiteScope Monitor Reference Guide.
For troubleshooting the Technology Log File monitor, see Technology Log File Integration Monitor in
the SiteScope Monitor Reference Guide.
For troubleshooting the Technology SNMP Trap monitor, see Technology SNMP Trap Integration
Monitor in the SiteScope Monitor Reference Guide.
For troubleshooting the Technology Web Service Integration monitor, see Technology Web Service
Integration Monitor in the SiteScope Monitor Reference Guide.

Topology Settings for Technology Integration Monitors
To report topology to BSM, you can select an out-of-the-box topology script for your integration monitor.
You do this while creating an integration monitor in the Topology Settings panel.
Jython language is used for developing topology scripts. For details on how to work in Jython, refer to
http://www.jython.org and http://www.python.org.

Selecting a Topology
When working with generic integration monitors, you can select from the following topology settings
(the topology scripts that are available depend on the field mapping type selected):
l

Computer. Creates a topology with a Computer CI. It is available for Common Events data type
only.
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l

l

Computer - Running Software. Creates a topology with a Computer CI and a Running Software
CI connected to it with a Composition relationship. It is available for Common Events data type
only. The following illustrates the topology created for the Computer - Running Software integration
type which retrieves events data from a third-party system:

Custom. You create your own topology if you want the retrieved data to be forwarded to specific
CIs and not one of predefined topology scripts. It is available for all field mapping types. You should
only select Custom if you are familiar with the Jython language, because no topology script is
loaded and you must create the topology script in Jython yourself. We recommend that you begin
with one of the predefined scripts.
Tip: When selecting a topology setting, you can have it report only the topology discovered by the
SiteScope Technology Integration monitors, without reporting the data. For task details, see
"Report Topology Without Data" on page 465.

Legacy Topology Scripts
The following are legacy topology scripts:
l

"Node Topology" below

l

"Node - Running Software Topology" on the next page

l

"Tickets" on the next page

Node Topology
Creates a Node CI with an EMS monitor CI connected to it with Monitored By relationship. The EMS
Monitor CI propagates status onto the Node CI.
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Node - Running Software Topology
Creates a topology with a Node CI and a Running Software CI connected to it with a Composition
relationship, and an EMS monitor CI which can be connected to either the Node CI or the Running
Software CI with Monitored By relationship.
In this integration type, there are two types of data that can be retrieved from a third-party system:
events related to Running Software and events related to Nodes.
The following table illustrates the topology created for each type of event:
Topology Created for Running Software-Related
Events

Topology Created for Node-Related
Events

You can configure which events are related to Running Software and which are related to Node by
editing the topology script as follows:
Search for the following string in the topology script:
if (subject != "system"):
The variable subject represents the subject field in the event. The value system is an example of
possible values representing the data that is considered related to Node and not forwarded to the
Running Software CI.

Tickets
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Creates a Business Service CI with an EMS monitor CI connected to it with Monitored By
relationship. The EMS Monitor CI propagates status onto the Business Service CI. It is available for
Tickets data type only.

For more information on the legacy integration types, see "Understanding Node, Tickets, or Node Running Software Integration Types" in the BSM section of the Integrations tab in the HP Software
Integrations site.

Editing the Topology Script
To configure the topology, you can edit the topology script that appears in the Topology Settings panel
when creating an integration monitor. You can use the script editor provided, or use any other script
editor.
You can choose one of the predefined topologies which are already configured with the necessary
information. Following are the guidelines for editing the script if you want to create your own topology.

General Script Editing Guidelines
l

The Jython language is sensitive to spaces and tabs. For more information on Jython, see
http://wiki.python.org/moin/HowToEditPythonCode.

l

You must leave the import section of the predefined topology scripts as is and only add to it.

l

The main body of the script is mandatory and consists of:
def DiscoveryMain(Framework)
This main function is responsible for creating Object State Holder Vector (OSHV) results. It holds
the CI and CI relationship data, and how to map the incoming samples to the CIs.

l

Use the built-in "logger" to debug the topology scripts when samples arrive. You do this by
modifying the level and type of information reported to the log file:
a. Add the logger import statement before system_lib import statement to the topology script, for
example:
import logger
…
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import system_lib
b. Change the log file settings in the <SiteScope root
directory>/conf/core/Tools/log4j/PlainJava/bac_integration.properties file as follows:
Open the bac_integration.properties file in a text editor and locate the following lines in the
file:
# Jython logger
log4j.category.PATTERNS_DEBUG=${loglevel}, discovery.appender
Change the argument of log4j.category.PATTERNS_DEBUG from ${loglevel} to DEBUG,
as follows:
log4j.category.PATTERNS_DEBUG=DEBUG, discovery.appender
c. Save the file. It may take a few seconds for the changes to take effect.
The debug data is written to the <SiteScope root directory>/log/discovery.log file.

Guidelines Relating Specifically to Integration Monitors
l

When using field mapping, you can use the field mapping fields as an input for the topology script.
For example, if using common event mapping, you can access the value of the Category field in the
following way:
category = Framework.getDestinationAttribute("Category").
In addition, you can access values of the "monitor variables", such as group0, group1, and so
forth, from Technology Log File Integration monitor, or the names of database columns in
Technology Database Integration monitor, or other variables in the other integration monitors. For
example, you can access the value of the group1 variable, in the following way:
group1 = Framework.getDestinationAttribute("group1")

l

l

If you report an EMS monitor CI in your script, each CI should not have more than one EMS monitor
CI as a leaf node.
For legacy event scripts, the following expressions must appear as the last lines in the script:
Framework.setUserObject("result_object",monitoredCiType)
return OSHVResult
The variable monitoredCiType is a type of CI being monitored by the EMS Monitor CI that receives
the event.
If the script creates more than one EMS Monitor CI for one retrieved event, you must determine to
which of the CIs that event belongs and passes status. You do this by assigning the correct value
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to the monitoredCiType. For example, if the script creates one EMS Monitor CI for a Running
Software CI and one for a Node CI, and you want the event to pass status to the Node CI, the value
of the variable monitoredCiType should be "node".

Additional Documentation
For general information on topology scripts, see "Create Jython Code" and "Developing Jython
Adapters" in the RTSM Developer Reference Guide in the BSM Help.
For information about Java classes that can be used in topology scripts, see "HP Data Flow
Management API Reference" in the RTSM Developer Reference Guide in the BSM Help.

Notes and Limitations
l

l

The script for EMS topology from SiteScope 10.x is displayed in SiteScope in the previous content
language format, even if SiteScope is connected to BSM 9.00. For example, the Host CI type
appears in the script instead of Node.
If SiteScope is connected to BSM versions earlier than 9.00, the Hosts and Host-Software
elements topology script are displayed in the topology script list for the monitor instead of
Computer,Computer - Running Software, Node, and Node - Running Software.

Field Mapping Structure
The field mapping contains instructions on how to process the data as it arrives at the integration
monitors. The instructions that constitute the field mapping are grouped into event handlers—
independent sections that contain instructions relevant to specific data. Each event handler contains a
matching condition by which SiteScope can determine whether to use a particular event handler for
an arriving event.
When an event or metrics data arrives at the integration monitor, it iterates over the different event
handlers in the field mapping, in the order that they appear, testing the matching condition of each
handler. If a matching handler is found, the monitor uses the instructions within that handler to process
the event and perform the action defined for this handler (for example, forward it to BSM or discard). No
further sections are checked after the first match. If no matches are found, the event is discarded.
In addition to the event handlers, the field mapping can contain special entries that affect the integration
monitor engine as a whole. These values are grouped into the [$DEFAULT_PARAMETERS$] section. This
section defines default values for tags that are common for all handlers. Any tag can be set in this
section of the field mapping. It is used to create a reported value unless overridden in the matched
event handler. For each incoming event, this event handler is always run prior to the matched event
handler.
For details on event handler structure, see "Event Handler Structure and Syntax" on the next page.
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CI Resolution Hint Formats
You can use the following formats for CI resolution hints:
Format

Description

Example

Standalone CIs
that do not exist
in the context of
Node and
descendant CI
types

For example, Business Application, Business
Service, or Siebel Enterprise. CI resolution
hint should be a CI name.

For a Business Service CI
named
myBusinessService, the
CI resolution hint would
be:
MeasurementCIHint(1)
="myBusinessService".
Note: The CI name must
be unique in RTSM.

Node topology
and descendant
CI types

CI resolution hint should be a fully qualified domain
name or an IP address of a node.

To report a node with IP
address 12.34.56.78, the
CI resolution hint would
be:
"12.34.56.78" or
"<MachineName>".

CIs which exist
in the context of
Node and
descendant CI
types

For example, CIs which belong to CI types that
inherit from Running Software, Node Element, or
Network Entity. You must specify in the hint both
the Node/descendant CI and the CI connected to
the Node/descendant CI, separated by @@.

For an Oracle Database CI
connected to the
Node/descendant CI, the
CI resolution hint should
be in the format:
"<oraclesid>:<product
name>@@<fqdnhostname>"
.

Event Handler Structure and Syntax
Each event handler has the following structure:
[name]Matching condition
Action directive
Tags

The names of Matching condition, Action directive, and additional directives start with the dollar
sign symbol ($). The names of tags should not start with the dollar sign.
Comments are permitted in the field mapping. The comment starts with either #, !, or ; character and
continues to the end of the line.
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Note: Use only the mandatory and optional fields defined in the scripts when working with the field
mapping. See the tables in the following sections for more information.
This section also includes:
l

"Matching Condition" below

l

"Available Data Processing Operations" below

l

"Conditional Expression" on page 396

l

"Action Directive" on page 396

l

"Tags" on page 397

l

"Integration Monitor Field Mapping Examples" on page 397

Matching Condition
The Match Condition must be a valid boolean expression. The expression can contain calls to the
operators and functions defined below. The expression can access the contents of the data that is
being processed using the dollar sign ($) notation. For example, if the incoming data is SNMP Trap,
then its enterprise OID can be accessed as $oid. For names specific to a monitor, refer to the
documentation of the relevant monitor type:
l

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference Guide)

l

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference Guide)

l

l

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)
Technology Web Service Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)
Note: The Match Condition expression is limited to 4,000 characters.

The matching condition has the form:
$MATCH=Boolean expression
where the Boolean expression is a combination of one of the expressions listed in "Available Data
Processing Operations" below. The value of the expression, which can be either true or false,
determines whether the event handler is be used to process the event or not.

Available Data Processing Operations
The language used in the field mapping is a simplified version of Java programming language, which
allows the following operations only.
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Expressions and
Functions

Description

+

String concatenation.
Example: "trap type is " + $trap

<, <=, > , >=, ==, !=

Checks the numerical correctness of the expression. Can be used with
numeric values.
Example: $MATCH=$numberOfLines == 100

&&, ||

To be used to combine any of the above boolean expressions.
Example: $MATCH=$status.equals("ERROR") || ($numberOfLines ==
100)

true, false

Constant Boolean values.
Example: $MATCH=true

boolean contains
(String str)

Returns true if and only if this string contains the specified sequence of
char values.
For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#contains(java.lang.CharSequence).
Example: MonitorName=$group0.contains("monitor")? $group0 : $group0
+ "monitor"

boolean endsWith
(String suffix)

Tests if this string ends with the specified suffix.
For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#endsWith(java.lang.String).
Example: MonitorName=$group1.endsWith("Operations")? $group1 :
$group1 + "Operations"

boolean equals
(String anotherString)

Compares this string to another string.
For more details, see
http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equals(java.lang.Object).
Examples:
$MATCH="ERROR".equals($status)
or
$MATCH=$status.equals("ERROR")
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Expressions and
Functions
boolean
equalsIgnoreCase
(String anotherString)

Description
Compares this String to another String, ignoring case considerations.
For more details, see
http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equalsIgnoreCase%28java.lang.String%29.
Examples:
$MATCH="ERROR".equalsIgnoreCase($status)
or
$MATCH=$status.equalsIgnoreCase("ERROR")

boolean exists(String
property)

Checks for an existence of a property in the processed event and make
sure that it is not an empty value.
Example: $MATCH=exist($status)

String getToken
(String str, String
delimiterRegular
Expression,int
zeroBasedTokenIndex
)

Splits input string according to a supplied delimiter (in regular expression
format), and returns one of the result strings according to a specified zerobased index.

int indexOf
(String str)

Returns the index within this string of the first occurrence of the specified
substring.

Example: getToken($var, "/", 1) will produce "y" if $var equals "x/y/z"

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(int).
Example: Severity=$group0.lastIndexOf("Critical")>-1? "Critical" :
"Normal"
int indexOf
(String str, int
fromIndex)

Returns the index within this string of the first occurrence of the specified
substring, starting at the specified index.
For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(java.lang.String,%20int).
Example: Severity=$group0.indexOf("Critical",3)>-1? "Critical" : "Normal"

boolean isDouble
(String number)

HP SiteScope (11.31)

Checks if the input string can be interpreted as a double number.
Example: $MATCH=isDouble($size)

Page 392 of 1395

Using SiteScope
Chapter 28: Integration Monitors Overview

Expressions and
Functions

Description

boolean isEmpty()

Tests for an empty string (length() == 0).
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#isEmpty().
Example: Description=$group1.isEmpty()?$group0 :$group1

boolean isInt
(String number)

Checks if the input string can be interpreted as an integer number.

int lastIndexOf (String
str, int fromIndex)

Returns the index within this string of the last occurrence of the specified
substring, searching backward starting at the specified index.

Example: $MATCH=isInt($size)

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#lastIndexOf(java.lang.String,%20int).
Example: Severity=$group0.lastIndexOf("Critical",2)>-1? "Critical" :
"Normal"
int lastIndexOf
(String str)

Returns the index within this string of the rightmost occurrence of the
specified substring.
For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#lastIndexOf(java.lang.String).
Example: Severity=$group0.lastIndexOf("Critical")>-1? "Critical" :
"Normal"

int length()

Returns the length of this string.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#length().
Example: Description=$group1.length() <10 ? $group0+$group1 :$group1

boolean matches
(String regex)

Tells whether or not the string matches the given regular expression.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#matches(java.lang.String).
Example: Severity=$group0.matches("(.*)Critical(.*)")? "Critical" :
"Normal"

double parseDouble
(String number)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.
Note: Calling this function on a string that cannot be interpreted as a
number causes an error and the incoming data is dropped.
Example: $MATCH=parseDouble($size) > 10
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Functions

Description

int parseInt
(String number)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.
Note: Calling this function on a string that cannot be interpreted as a
number causes an error and the incoming data is dropped.
Example: $MATCH=parseInt($size) > 10

String resolveHostIP
(String hostName)

Performs DNS resolution from a server to its IP address.
If the DNS resolution fails, the function returns the value unknown host.
Example: target_ip=resolveHostIP($host)

String
resolveHostName
(String hostIP)

Performs DNS resolution from an IP address to a fully qualified domain
name.
If the DNS resolution fails,
the function returns the original input host name.
Example: target_name=resolveHostName($host)

boolean startsWith
(String prefix)

Tests if this string starts with the specified prefix.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#startsWith(java.lang.String).
Example: MonitorName=$group1.startsWith("Operations")? $group1 :
"Operations"+$group1

boolean startsWith
(String prefix, int
offset)

Tests if the substring of this string beginning at the specified index starts
with the specified prefix.
For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#startsWith(java.lang.String,%20int).
Example: MonitorName=$group1.startsWith("Operations",2)? $group1 :
"Operations" + $group1
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Expressions and
Functions
long str_to_seconds
(String dateTime,
String format)

Description
Calculates the timestamp (in seconds, since January 1, 1970 format) held
in the first String using the format in the second string.
True if the date specified in $time in yyyy-MM-dd HH:mm:ss.SSS format is
later than the current time.
For more details, see http://download.oracle.com/javase/7/docs/
api/java/text/SimpleDateFormat.html.
Example: $MATCH=str_to_seconds ($time,"yyyy-MM-dd
HH:mm:ss.SSS") > time()
Note: Use the following symbols to represent time:
Year - `y'; Month - `M"; Day of month - `d'; Hour - `H'; Minute - `m'; Second `s'

String substring
(int beginIndex)

Returns a new string that is a substring of this string. The substring begins
with the character at the specified index and extends to the end of this
string.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#substring(int).
Example: Title=$group0.substring(2)

String substring
(int beginIndex, int
endIndex)

Returns a new string that is a substring of this string.
For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#substring(int).
Example: Title=$group0.substring(2,9)

int time()

Returns the current time, in seconds, since January 1, 1970 format.
Example: $MATCH=$timeStampField > (time()-600)
True if the value of the $timeStampField is newer than ten minutes ago (in
seconds, since January 1, 1970 format).

String toLowerCase()

Converts all of the characters in this to lower case using the rules of the
default locale.
Example: Title=$group0.toLowerCase()
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String toUpperCase()

Description
Converts all of the characters in this to upper case using the rules of the
default locale.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#toUpperCase().
Example: Title=$group0.toUpperCase()

String trim()

Returns a copy of the string, with leading and trailing whitespace omitted.
For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#trim().
Example: Category=$group3.trim()

Conditional Expression
One conditional expression is supported; the ? operator. This operator can be used to compose three
expressions into one. For example:
<Conditional part> ? <if true part> : <if false part>)

Action Directive
The action directive has the form:
$ACTION= SEND or DISCARD
TOPAZ_BUS_POST is the equivalent of SEND, which is used only for backwards compatibility.
The value of the Action directive defines whether the event is processed and forwarded to BSM, or
discarded. This value takes effect only if the matching condition within the handler had been evaluated
to positive value (that is, to true). The table below describes the effect of the different actions.
Action

Description

For Use With

SEND(event)

Send the event to the BSM bus and database.

BSM

SEND(ss_t)

Send the metrics to RTSM as SiteScope Data.

BSM

DISCARD

Do not send the data to BSM.

events you want to filter out

Note: If you are using the metrics mapping, SEND(ss_t), the data is sent to the BSM database as
SiteScope data, and thus saved to the database. For details on metrics mapping, see "Configure
Field Mapping for Metrics Samples" on page 402.
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Tags
In addition to directives, the event handler contains tags. Each tag represents a field if it is forwarded to
BSM. The tag's value can be evaluated when the event arrives to the integration monitor.
The general format of a tag is:
name[:type]=value
The <name> is any string without spaces or dollar signs ($). The <type> specifies the type of field as
reported to BSM. It can be either INT, DOUBLE or STRING. The default type is STRING. You can
view available data processing operations in "Available Data Processing Operations" on page 390.
By defining a tag, you can customize event forwarding to BSM. Thus getting more value from the
external applications that create those events. For example, if the monitor pulls out data from a
database table column called AlertText, which contains a textual description of an alert, it is possible
to send that data to BSM by adding the following line to an event handler section:
[event handler]
$MATCH=true
$ACTION=SEND(event)
text=$AlertText
Note: When adding tags, always add them after the $MATCH and $ACTION.

Integration Monitor Field Mapping Examples
Example 1: Universal Event Handler
[post them all]
$MATCH=true
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL
szAlarmText:STRING="post them all handler received an event"
Note that the $MATCH directive in the handler is set to true. This causes every event to match the
handler and therefore every event is sent to the BSM bus.
Example 2: Different Event Handlers for Different Severities
[Error Handler]
$MATCH= $status.equals("ERROR")
$ACTION=SEND(event)
severity:INT=SEVERITY_CRITICAL
[Info Handler]
$MATCH= $status.equals("INFO")
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL
[post them all]
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$MATCH=true
$ACTION=SEND(event)
severity:INT=SEVERITY_INFORMATIONAL
In this example, an incoming event is matched against the Error Handler event handler. If the
handler's condition is true (that is, the value in the status field equals ERROR), then an event with a
field called severity, whose value is SEVERITY_CRITICAL, is sent to BSM. An event can be matched
only by a single handler. The first match stops the processing and therefore once an event is matched
by a section, it is not processed by the next handler.
If the event was not matched by the first handler, the second handler comes into action and its match
(which looks for status of INFO) is used to decide whether the second handler needs to take action.
Finally, if the event does not match the second handler, the third universal handler is evaluated.

How to Migrate Technology Integration Monitors to BSM
Connector
You can migrate existing technology integration monitors from SiteScope to BSM Connector. The
export downloads a technology integration monitor from SiteScope and converts it to the BSM
Connector format for import to BSM Connector. Such imported policies can be maintained and further
customized in BSM Connector. Exporting technology integration monitors for use in BSM Connector
enables you to use BSM Connector for all your third party integrations.
Note: The Export to BSM Connector policy functionality is relevant only where BSM Connector
9.22 (or later) is integrated with BSM version 9.20 or later.

Supported SiteScope Technology Integration Monitors
Only the following technology integration monitors with a metrics, common events, or legacy events
field mapping data type are supported for export in SiteScope:
l

Technology Database Integration Monitor

l

Technology Log File Integration Monitor

l

Technology Web Service Integration Monitor
Note: The Technology SNMP Trap Integration Monitor, HP OM Event Monitor, HP Service
Manager Monitor, and NetScout Event Monitor do not support export to BSM Connector policies.
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Migrate Technology Integration Monitors to BSM Connector Policies
1. In SiteScope, export the technology integration monitor that you want to migrate to BSM
Connector
a. In SiteScope, open the monitor properties for the technology integration monitor that you want
to export, and expand the Export to BSM Connector panel.
b. In the Export to BSM Connector panel, click the Export button, and select a folder on the
client file system in which to save the policy files, and then click Open.
c. The export process is performed, and a popup message displays the results (success/error).
In case of an error, a detailed error message is written in <SiteScope root
directory>\logs\error.log.
The SiteScope monitor is converted to a policy data and a header file. The files are saved to
the selected location on the client machine in the format:
o

<policy_id>_data for the policy data file

o

<policy_id>_header.xml for the header file

where the policy_id is a generated UUID for the new policy.
2. Transfer the generated policy files to the BSM Connector system.
3. Import the migrated integration monitor to BSM Connector
Import the policy data file and the header file to a BSM Connector machine using the BSM
Connector's import policy mechanism. For details, see the BSM Connector online help system
(available from the toolbar of the BSM Connector user interface).
After importing the files, the policy can then be activated in BSM Connector like any other policy.

How to Deploy Integration Monitors
Note: You can deploy integration monitors while working in:
l

A standalone SiteScope that reports to BSM

l

Directly in SAM Administration

The steps involved in configuring the integration depend on the type of sample data being captured
(metrics, events, or tickets), and on whether the data is mapped to a topology (in order to forward it to
the correct CI hierarchy in BSM).
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Collect metrics samples
Select the Metrics field mapping data type to forward metrics data to BSM, and choose from the
following topology scripts:
l

l

l

Computer - Monitor. SiteScope reports this data to the Computer CI, a descendant of the Node
CI. For task details, see "How to Configure Integration Monitors to Collect Metrics Data With
Computer - Monitor Topology" on page 404.
Custom. Enables you to create your own topology. For task details, see "How to Configure
Integration Monitors to Collect Metrics Data With Custom Topology" on page 412.
No Topology. Select if you do not want to send any topology (although data is still sent). For task
details, see "How to Configure Integration Monitors to Collect Metrics Data With No Topology" on
page 424.

Collect event samples
Select the Common Events or Legacy Events field mapping data type to integrate events collected
from third-party domain managers or applications to BSM. Unlike the legacy EMS events, the Common
Event integration allows you to manage the events in Operations Management event sub system and
the Service Health console. In addition, the common event channel provides the option to report
topology to BSM without reporting the data.
l

l

For task details on using the common event integration, see "How to Configure Integration Monitors
to Collect Data on Common Events" on page 449.
For task details on using the legacy event integration, see "How to Configure Integration Monitors to
Collect Data on Legacy Events" on page 452.

Collect ticketing samples
Select the Tickets field mapping data type to forward ticketing data to BSM,
For task details on collecting incidents and events from third-party ticketing systems, see "How to
Configure Integration Monitors to Collect Ticketing Data" on page 461.
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When configuring the generic integration monitors, you can select the metrics data type to collect timebased data. Data collected by Integration Monitors that use the metrics data type is integrated into
BSM as typical SiteScope data and can be viewed in all contexts that support viewing SiteScope data.

Integration Monitor Field Mapping for Metrics Samples
You can enable capturing metrics data from Enterprise Management Systems (EMS), automated
support systems, and other management applications by configuring integration monitors and their field
mapping scripts.
Integration monitors depend on the field mapping you customize within the user interface in the settings
for the monitor. The mapping defines the processing of incoming data and defines the output sample
forwarded to BSM.
Integration Monitors designed for use with specific EMS applications (these currently include HP OM,
HP Service Center, and NetScout) can be configured without editing their field mapping script. The
mapping is predefined by HP and requires modification only if specific customizations are required. For
details on editing these field mapping scripts, see the description for the field mapping element in the
user interface pages for the monitor you are deploying.
For Technology Integration Monitors (Technology SNMP Trap, Technology Log File, and Technology
Database monitors), you must select the data type and the required script is loaded directly into the
field mapping text box. You must edit the field mapping script to suit your organization's needs. The
Technology Web Service Integration Monitor field mapping may also need to be customized.
When you select the Metrics data type to forward metrics data to BSM, and you want to integrate to
BSM using topology settings, you can select from the following predefined topology scripts:
l

l

l

Computer - Monitor. Select to send SiteScope topology (monitors). This is the default setting.
SiteScope reports this data to the Computer CI, a descendant of the Node CI.
No Topology. Select if you do not want to send any topology (although data is still sent).
Custom. Enables you to create your own topology. Only select this option if you are familiar with
the Jython language, because you must create the topology script in Jython yourself.

For details on selecting a topology setting, see "Topology Settings for Technology Integration Monitors"
on page 383.
Note: SiteScope uses indicator definitions for monitor CIs created by the integration that are
defined in BSM (and that are applicable for Computer CI type). If a different ETI is specified in the
monitor's field mapping, it overrides the default indicator definition.
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Configure Field Mapping for Metrics Samples
You use metrics data type to extract metrics collected by external systems and import them to BSM.
When configuring an integration monitor's field mapping, select the Metrics data type to load the
metrics script. You can then copy the contents of the Field Mapping text box and paste it into a text
editor to make your configuration changes. When you are done, copy the contents back into the Field
Mapping text box.
For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page
389.
For CI resolution hint formats, see "CI Resolution Hint Formats" on page 389.
This section also includes:
l

"Mandatory Values for the Metrics Script" below

l

"Optional Values for the Metrics Script" on the next page

l

"Metrics Script Example" on page 404

Mandatory Values for the Metrics Script
The table below lists mandatory values for the metrics script.
Field Name

Type

TimeStamp

DOUBLE Time stamp in the seconds
since Jan 1st 1970 format.

TimeStamp:DOUBLE=time()

Quality

INT

Quality in SiteScope terms.
Possible values are:
QUALITY_ERROR,
QUALITY_WARNING,
QUALITY_GOOD.

Quality:INT= QUALITY_ERROR

MonitorName

STRING

Logical monitor name.

MonitorName="NT cpu
Monitor"

MonitorState

STRING

The monitor status, for
example, N\A, Good, Error, and
so on.

MonitorState="Received " +
$count + " events"

MonitorType

STRING

The monitor type.

MonitorType="System
Monitor"

TargetName

STRING

The target of this monitor (e.g.
name of host machine).

TargetName=$Device
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Field Name

Type

MeasurementName STRING
(N)
Value(N)

Description

Example

Name the Nth metric.

MeasurementName(1)="CPU
Temperature"

DOUBLE Value of Nth metric.

Value
(1):DOUBLE=$CPUTemperature

Optional Values for the Metrics Script
The table below lists optional values for the metrics script.
Field Name

Type

Description

MeasurementETI

STRING The display name of the ETI.
Note: When using BSM 9.00, add the
relevant indicator names to the integration
field mapping (otherwise the system KPI is
used instead), or configure the indicator in
SAM Administration. For details, see
Indicator Assignment Settings in the BSM
User Guide in the BSM Help.

MeasurementCI
Hint

STRING CI resolution hint that is used to identify
monitored CIs and relate metrics to them.
SiteScope sends an out-of-the-box CI
resolution hint in the format based on the
monitor's internal IDs.

Example
MeasurementETI(1)=
"Indicator display
name"

MeasurementCIHint
(1)=
"SCDAM038.testlab"

For EMS metric field mapping, you might
want to send a custom CI resolution hint
when:
l

l

Sending a custom topology without
monitor CIs using a custom topology
script.
You only want to forward third-party
metrics and connect them to an existing
topology. In this case, you create a field
mapping, provide CI resolution hints, and
select the No Topology option in the
integration monitor's Topology Settings.

The CI resolution hint must be specified in a
format recognizable in BSM, as described in
"Field Mapping Structure" on page 388.
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Metrics Script Example
Note: The metrics script example is available in a text file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and select Metrics_Script_
Example.txt.
When specifying more than one metric in the script, a separate sample is sent with each of the metrics.
Note: When specifying multiple metrics per file, the metric numbering must be consecutive.
In the case of failure, errors appear in the RunMonitor.log but the error does not affect the monitor
status.

How to Configure Integration Monitors to Collect Metrics
Data With Computer - Monitor Topology
This task describes the steps involved in designing and implementing the EMS metrics flow using the
Computer - Monitor topology script. The topology describes a Computer CI connected to a SiteScope
monitor CI with a Monitored By link.
Note: For an example of this task, see "Example – Create a Metrics Flow With Computer - Monitor
Topology" on page 408.

1.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.

2.

Select the SiteScope
Select the SiteScope server from which you want to deploy the integration monitor:

3.

n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
Administration Page" in the BSM User Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
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Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

4.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)

You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)

5.

n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)

Plan the topology flow
Before you start, plan the following:

6.

n

The type of the monitor and the metrics you will have.

n

The HIs you want to be created on the Computer CI you will report in topology.

n

For most of the default HIs, there are already HI and KPI assignments, and there is no need to
create new ones.

n

The metrics you want to map to the HIs.

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
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a. In the Field Mapping panel, select the Metrics field mapping script, and click Load File.
b. Map the script values to the corresponding field mapping group in which they appear in the
entity (database, log file, SNMP trap, or Web service) from which you want to extract data.
o

For mandatory script values, see "Mandatory Values for the Metrics Script" on page 402.

o

For optional script values, see "Optional Values for the Metrics Script" on page 403.
Note: Integration field mapping should be configured in such a way that assures that
each monitor CI created by the integration is connected to a single monitored CI (such
as Computer). Avoid creating monitor CIs connected to multiple Computer CIs. To
achieve this, it is recommended to use a value for the TargetName field as part of a
MonitorName. For example:
Recommended:
MonitorName="Disk usage on " + $group0
TargetName=$group0
Avoid:
MonitorName="Disk usage on my computer"
TargetName=$group0

c. The indicator mapping fields can be configured in either the Field Mapping panel in SiteScope
or in SAM Administration. For details, see the following step.
Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

7.

Map metrics to indicators
Define the mapping of your metrics to HIs. There are two ways to define the indicator mappings:
n

In System Availability Management (SAM) Administration. Use this option to create a general
mapping for your monitor type, or if you want to use regular expressions for the measurements
in the mapping. For details, see "How to Create and Manage Indicator Assignments" and
"Create New Monitor Dialog Box" in the BSM User Guide in the BSM Help.

n

In the Field Mapping of the technology integration monitor. Use this option for simpler cases.
For example, if you want to define a mapping between a metric to an HI without using regular
expressions. For details, see the previous step ("Edit the monitor's field mapping" on the
previous page).
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To map metrics to indicators:
a. If you use SAM Administration to define the indicator mapping, enter the monitor name you
used in the indicator mapping in SAM Administration for the MonitorType value in the Field
Mapping panel.
b. If you already defined a mapping between the metric and the indicator in SAM Administration
for the MeasurementETI(x) value, this field should not be set in the Field Mapping panel (keep
it commented out). Otherwise, it should be uncommented and you should enter the label
(display name) of one of the existing indicators that is defined on the Computer CI that suits
your requirements. For example, CPU Load, for a measurement that checks CPU usage.
c. The MeasurementCIHint(x) value should not be set (keep it commented out), since
SiteScope sets the CI hint automatically.
8.

Select a Topology Script
In the Topology Settings section of the integration monitor, select Computer - Monitor from the
Topology script list. You do not need to fill any topology script.
Note: The Computer - Monitor topology integration requires that the names or IP addresses
of the nodes that it adds to RTSM are accessible through DNS resolution. To successfully
populate a Node CI specified in the TargetName field to RTSM, SiteScope must be able to
resolve the node's fully qualified domain name and IP address through a DNS service.

9.

Assign group permissions if using SAM reports
If you configure a generic integration monitor with a Metrics field mapping, you must assign for
each defined user, permissions to view SiteScope groups and their subgroups in System
Availability Management reports and custom reports. For more information, see the section on
Permissions in the BSM Platform Administration Guide in the BSM Help.

10.

Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
tests the following:

11.

n

Checks the field mapping and topology script syntax.

n

Displays the mapping results.

n

Displays the topology results if a topology script has been configured.

View Integration Results
After defining metrics assignments and configuring the monitor in SiteScope (including field
mapping and topology script), you can view the results in the following applications:
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In Service Health:
a. In BSM, select Applications > Service Health > Top View.
b. In the drop down list, select:
o

System Hardware Monitoring to view the status of the Computer CI.

o

System Monitors view to view the monitor and its status.

In SAM Reports:
You can also view the data of your integration in SAM reports. In the different reports, specify a
filter for the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping (see "Edit
the monitor's field mapping" on page 405):
n

Target: Select a value that was defined in the TargetName field in the Integration Monitor Field
Mapping.

n

Monitor type: Select a value that was defined in the MonitorType field in the Integration
Monitor Field Mapping.

n

Monitor title/name: Select a value that was defined in the MonitorName field in the Integration
Monitor Field Mapping.

n

Measurement: Select a value that was defined in the MeasurementName(x) field in the
Integration Monitor Field Mapping.

Example – Create a Metrics Flow With Computer - Monitor Topology
This example describes how to create an integration monitor to capture and forward metrics samples
from a third-party system that monitors different disks to BSM using the Computer - Monitor topology
script.
Note: For a task related to this example, see "How to Configure Integration Monitors to Collect
Metrics Data With Computer - Monitor Topology" on page 404.

1.

Design stage
You have a third-party application that writes to a log file. It writes to the log the disk usage of
different computers.
Since the application writes to log files, create a Technology Log File Integration monitor for the
integration in SiteScope. Use the Metrics field mapping and the Computer - Monitor topology
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script, and select the Host Disk Utilization indicator. There is no need to create assignments
for this HI or KPI since there are existing assignments for them.
Entries in the log file:

2.

n

labamrnd42,disk,d,65,warning

n

labamrnd42,disk,d,70,warning

n

labamrnd42,disk,d,70,warning

Map Metrics to Indicators in SAM Administration
Create a new monitor type in BSM > Admin > System Availability Management > Metrics
and Indicators.

My Disk Usage is the monitor type and Custom is the category.
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Now, define a new indicator mapping for the monitor:

This is how the table looks when you save it:

3.

Define the Field Mapping
Note: The field mapping script to use is available in a text file attached to this PDF. To view
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the attachment, select View > Navigation Panels > Attachments, and select Metrics_
Computer_Monitor_Topology_Field_Mapping.txt.
In the field mapping script, you can see that the MonitorType value is My Disk Usage (as defined
in the indicator mapping in SAM Administration).
The measurement matches the regular expression defined in the indicator mapping:
MeasurementName(1)="disk " +$group2 + " utilization".
MeasurementETI(1) is commented out since you already defined a mapping in SAM
Administration.
MeasurementCIHint(1) is commented out since SiteScope sets the hint automatically.
4.

Select a Topology Script
In the Topology Settings section of the integration monitor, select the Computer - Monitor script
from the Topology script list.

5.

View Integration Results
In BSM, select Applications > Service Health and view the target computer being monitored
(labamrnd42) in the System Hardware Monitoring view.

These are the results of the indicator status on the monitored machine:
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How to Configure Integration Monitors to Collect Metrics
Data With Custom Topology
This task describes the steps involved in creating an integration for metrics samples using the custom
topology flow.
Note: For an example of this task, see "Example – Create a Metrics Flow With Custom Topology"
on page 416.

1.

Change the CI Resolver TQL (only if SiteScope is connected to a version of BSM earlier
than 9.20)
a. In BSM, select Admin > Platform > Infrastructure Settings.
o

Select Applications.

o

Select End User/System Availability Management.

o

In the End User/System Availability Management - SiteScope CI Resolver Settings,
check if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is,
change it to OMiAutoView.

b. Restart BSM to apply the change.
Note: This TQL does not support models with a large number of CIs (it may cause
performance problems in such models).

2.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
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with BSM" on page 219.
3.

Select the SiteScope
Select the SiteScope server from which you want to deploy the integration monitor:

4.

n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
Administration Page" in the BSM User Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

5.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)

You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)
n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)
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6.

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
a. In the Field Mapping panel, select the Metrics field mapping script, and click Load File.
b. Enter the details you want to send in the ss_t sample file.
o

For the MeasurementETI value, enter the label of the HI you chose previously in "How to
Configure Integration Monitors to Collect Metrics Data With Custom Topology" on page
412.

o

Enter a hint for the CI in MeasurementCIHint. This hint helps the CI resolver in BSM to
recognize the CI to which the sample should be attached.
For details on values for the metrics script, see "Configure Field Mapping for Metrics
Samples" on page 402.

Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

7.

Design the topology flow
When planning the design strategy for the custom topology flow, you need to consider the
following:
n

CIs for topology
Consider the entities that you want to report to BSM. For these entities, you might also want to
report data and to view the health status of these entities in BSM's Service Health.
For example, you have a third-party application named TPA that writes to a database. The
entries in this database contain performance data on CPU and network usage of different
computers. In this case, you will probably want to create a topology that reports Computer CIs
to BSM.

n

Data that you want to be reported for these CIs
Consider what data you have for these CIs and how it can be attached to the CIs. What is the
relevant health indicator (HI) for the data being reported? If there is no such indicator, consider
creating a new HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such
assignments exist, consider creating your own.

8.

Create the custom topology script
Finally you create the topology script. The script defines how to report CIs to BSM. For details on
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the topology script, see "Topology Settings for Technology Integration Monitors" on page 383.
For the monitored_by attribute of the CI, enter the identifier for this integration. This is the same
value you used in the HI assignment in "How to Configure Integration Monitors to Collect Metrics
Data With Custom Topology" on page 412.
Note:
n

When using field mapping, you can use the field mapping fields as an input for topology
script. For example, if using common event mapping, you can access the value of the
Category field in the following way:
category = Framework.getDestinationAttribute("Category")

n

In addition, you can access values of the "monitor variables", such as group0, group1,
and so forth, from Technology Log File Integration monitor, or the names of database
columns in Technology Database Integration monitor, or other variables in the other
integration monitors. For example, you can access the value of the group1 variable, in the
following way:
group1 = Framework.getDestinationAttribute("group1")

Tip: To troubleshoot topology issues, see BSM Topology Issues in the Integration with BSM
and HPOM Best Practices Guide.

9.

Assign group permissions if using SAM reports
If you configure a generic integration monitor with a Metrics field mapping, you must assign for
each defined user, permissions to view SiteScope groups and their subgroups in SAM reports and
custom reports. For more information, see the section on Permissions in the BSM Platform
Administration Guide in the BSM Help.

10.

Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
tests the following:

11.

n

Checks the field mapping and topology script syntax.

n

Displays the mapping results.

n

Displays the topology results if a topology script has been configured.

View Integration Results
After configuring the HI and KPI assignments in BSM and the monitor in SiteScope (including field
mapping and topology script), you can view the results.
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n

Create a view in RTSM to view the results of the integration in BSM's Service Health or
Service Level Management application. The view should describe the topology you defined in
"Create the custom topology script" on page 414.
For details on creating the view, see "Modeling Studio Page" in the Modeling Guide in the BSM
Help.
If you defined the integration for SLM as well, you can view the integration results in SLM
reports. For more information on SLM and on the reports, see "Working with the Service Level
Management Application" in the BSM User Guide in the BSM Help.

n

You can also view the integration data in System Availability Management reports. In the
different reports, specify a filter for the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping in "Edit
the monitor's field mapping" on page 414:
o

Target: Select a value that was defined in the TargetName field in the Integration Monitor
Field Mapping.

o

Monitor type: Select a value that was defined in the MonitorType field in the Integration
Monitor Field Mapping.

o

Monitor title/name: Select a value that was defined in the MonitorName in the Integration
Monitor Field Mapping.

o

Measurement: Select a value that was defined in the MeasurementName(x) field in the
Integration Monitor Field Mapping.

Example – Create a Metrics Flow With Custom Topology
This example describes how to create an integration monitor to capture and forward metrics samples
from a third-party system that monitors different Oracle databases to BSM using the custom topology
script. This script enables you to create your own topology.
Note: For a task related to this example, see "How to Configure Integration Monitors to Collect
Metrics Data With Custom Topology" on page 412.

1.

Design Stage
You have an application named My Oracle Monitoring. This application writes measurements
from Oracle databases running on different computers to a log file.
Since the application writes to log files, create a Technology Log File Integration monitor for the
integration. The topology that you want to report includes Oracle CIs, and you will create a HI on
these CIs. You will focus on one indicator and one measurement that you are interested in.
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Entries in the log file:
n

amrnd153,27,1,good

n

amrnd153,82,1,warning

n

amrnd153,80,1,warning

The Technology Log File Integration monitor in SiteScope:

2.

Select an Indicator
In BSM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use the CPU Usage by SQL (Database) indicator. This indicator reports
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SQL as well as Oracle usage.

This indicator is defined on the Oracle CI type (the CI that will be reported), and is appropriate for
the measurement being read from the log. This measurement describes the amount of CPU that
Oracle uses.
3.

Define an HI Assignment
In BSM, select Admin > Service Health > Assignments > Health Indicator Assignments
and create the indicator assignment.
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In the Monitored by property, manually enter My Oracle Monitoring integration. This value
helps you distinguish Oracle CIs reported by this integration from other Oracle CIs that are being
reported. This assigns the CPU Usage by SQL indicator on the Oracle CIs that are reported by this
integration only.
If you edit the indicator in this assignment, you get this:
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The CPU Usage by SQL indicator is calculated using the SiteScope Worst Status Rule. The
selector defines that samples of type ss_t (the metrics data type) with the same ci_id and eti_
id as the current CI and ETI are captured by this indicator on this Oracle CI. You do not want other
samples to be captured.
4.

Define a KPI Assignment
Since you used a default indicator, you do not need to create a KPI assignment as there is an
existing Service Health KPI assignment on Oracle CIs.
In BSM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI
Type tree select Oracle and choose Oracle KPI Assignment.
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Select the Software Performance KPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator which
you used.
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5.

Configure Field Mapping
Note: The field mapping script to use is available in a text file attached to this PDF. To view
the attachment, select View > Navigation Panels > Attachments, and select Metrics_
Custom_Topology_Field_Mapping.txt.
In the field mapping script, you can see that you defined a new monitor type: My Oracle.
The monitor name is My Oracle mon on $group0 where $group 0 is also the target computer on
which the Oracle database is running.
The measurement name is oracle cpu usage and its value is taken from the log file. The quality
that is sent is conditional and depends on what is written in the log file.
The ETI to which the measurement is mapped is CPU Usage by SQL.
The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint helps the CI
Resolver in BSM to find the CI to which this data sample should be attached.

6.

Create the Custom Topology Script
Note: The custom topology script to use is available in a text file attached to this PDF. To
view the attachment, select View > Navigation Panels > Attachments, and select
Metrics_Custom_Topology_Script.txt.
In the custom script, you can see that:

7.

n

system_lib.createNode(Framework) creates the node on which the database is running.

n

modeling.createDatabaseOSH creates the Oracle CI.

n

mainInstance is the SID of the Oracle you used.

n

My Oracle Monitoring integration is the monitored_by attribute which is the condition
you gave in the indicator assignment (see "Define an HI Assignment" on page 418).

View Integration Results
In BSM, select Applications > Service Health and manually create a view for the integration.
For example, here we created a view named My Oracle Monitoring (it is also displayed in
System Software Monitoring view):
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These are the results of the indicator status on the monitored machine:

The state and value are the same as you assigned in the field mapping.

How to Configure Integration Monitors to Collect Metrics
Data With No Topology
This task describes the steps involved in designing and implementing the EMS metrics flow using the
No Topology script.
Use this flow to use integration monitors to send metrics samples for an already existing topology in
BSM. In this flow, SiteScope sends data without sending topology.
Note: For an example of this task, see "Example – Create a Metrics Flow With No Topology" on
page 430.

1.

Change the CI Resolver TQL (only if SiteScope is connected to a version of BSM earlier
than 9.20)
a. In BSM, select Admin > Platform > Infrastructure Settings.
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o

Select Applications.

o

Select End User/System Availability Management.

o

In the End User/System Availability Management - SiteScope CI Resolver Settings,
check if the value of the TQL Queries parameter is CIs Monitored by SiteScope. If it is,
change it to OMiAutoView.

b. Restart BSM to apply the change.
Note: This TQL does not support models with a large number of CIs (it may cause
performance problems in such models).

2.

Select an Indicator
To view the status of a CI, you need an HI which provides a fine-grained measure of the health of
the CI. In most cases, you want to view the HI in BSM's Service Health. The HI is also used in
Service Level Management (SLM). For details on HIs, see "Health Indicators and KPIs Overview" in the BSM User Guide in the BSM Help.
Note: For alignment reasons, we recommend using an out-of-the-box HI; only create your
own HI if you do not find an existing HI that fits your needs.
To select an existing HI or create a new HI:
a. In BSM, select Admin > Service Health / Service Level Management > Repositories >
Indicators.
b. Select a CI type.
c. Check if you already have an existing HI that fits your requirements. If you do not, create a
new one. For details on how to create HIs, see "How to Create or Edit an ETI or HI Template
in the Indicator Repository" in the BSM User Guide in the BSM Help.
d. If you create a new HI, publish the changes to SiteScope. In BSM, select Admin > System
Availability Management > Metrics and Indicators and click Publish Changes. The
changes should reach SiteScope within no more than 5 minutes.

3.

Define an HI Assignment
After you select an HI, you need to define an HI assignment that will assign the HI to a CI. The
assignment also defines which data samples will be captured by this HI and which business rule
will be used to calculate the status of the HI according to the data samples.
For more information on HI assignments, see the BSM Application Administration Guide in the
BSM Help.
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To define an HI assignment:
a. In BSM, select Admin > Service Health / Service Level Management > Assignments >
Health Indicator Assignments.
b. Select a CI type.
c. Create a new HI assignment. For details on how to create the assignment, see "How to
Define a KPI or HI Assignment" in the BSM Application Administration Guide in the BSM
Help.
o

In the Condition area, enter a unique value for your integration in the Monitored By
property. This enables you to distinguish between the CIs reported by your integration to
other CIs of this type which are not reported by the integration.

o

Select the HI you chose in "Select an Indicator" on the previous page.

o

Choose the business rule to use for the HI calculation. We recommend using the
SiteScope Worst Status Rule. You can also use the SiteScope Consecutive Worst Status
Log or SiteScope Best Status Rule.

o

In the selector, enter the following:
l

eti_id = (Binary) <<Health Indicator Type ID>>

l

ci_id = (Binary) <<CI ID>>

l

sampleType = (String) ss_t
The integration monitor sends metrics samples (ss_t) that contain the same eti_id as your
ETI and same CI ID as the CI's.
The eti_id in the sample is sent by SiteScope according to your field mapping entry for the
monitor in "Edit the monitor's field mapping" on page 428.
The ci_id is found by the CI resolver in BSM. For it to find the CI, it uses the CI hint sent by
SiteScope in the sample, according to your field mapping entry for the monitor in "Edit the
monitor's field mapping" on page 428.
For details on field mapping for metrics samples, see "Configure Field Mapping for Metrics
Samples" on page 402.

4.

Define a KPI Assignment for each CI type
Verify whether you have an appropriate KPI assignment, or create one if one does not already
exist. The assignment determines which KPI to assign to the CI and for which HIs.
If you use one of the default HIs then there should already be a default KPI assignment for your HI
and you do not need to create one.
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For more information on KPI assignments, see the BSM Application Administration Guide in the
BSM Help.
To create a KPI assignment:
a. In BSM, select Admin > Service Health > Repositories > Indicators.
b. Choose the type of your CI.
c. Create a new KPI assignment. For details, see "How to Define a KPI or HI Assignment" in the
BSM User Guide in the BSM Help.
d. In the KPI assignment, the related HI should be the one you chose in "Select an Indicator" on
page 425.
Note: If you also want to view the integration results in Service Level Management
(SLM), you need to define the Service Level Agreement (SLA). For more information on
SLAs, see "Agreements Manager Page" in the BSM User Guide in the BSM Help.

5.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.

6.

Select the SiteScope
Select the SiteScope server from which you want to deploy the integration monitor:

7.

n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
Administration Page" in the BSM User Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

8.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
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n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)

You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)

9.

n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
a. In the Field Mapping panel, select the Metrics field mapping script, and click Load File.
b. Enter the details you want to send in the ss_t sample file.
o

For the MeasurementETI value, enter the label of the HI you chose previously in "Select
an Indicator" on page 425.

o

Enter a hint for the CI in MeasurementCIHint. This hint helps the CI resolver in BSM to
recognize the CI to which the sample should be attached.
For details on values for the metrics script, see "Configure Field Mapping for Metrics
Samples" on page 402.

Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

10.

Plan the no topology flow
When planning the design strategy for the no topology flow, you need to consider the following:
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n

CIs for topology
Since you are using the No Topology option, you probably already have CIs in the RTSM to
which you want to report data using EMS monitors.

n

Data that you want to be reported for these CIs
Consider what data you have for these CIs and how it can be attached to the CIs. What is the
relevant health indicator (HI) for the data being reported? If there is no such indicator, consider
creating a new HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such
assignments exist, consider creating your own.
For example, if you have data on CPU usage and network usage, you can use the CPU Load
and Interface Utilization HIs that are defined for the Computer CI type, and you can use
the System Performance KPI. Check if there are HI and KPI assignments that meet your
needs, and if not, consider creating them.

11.

Assign group permissions if using SAM reports
If you configure a generic integration monitor with a Metrics field mapping, you must assign for
each defined user, permissions to view SiteScope groups and their subgroups in SAM reports and
custom reports. For more information, see the section on Permissions in the BSM Platform
Administration Guide in the BSM Help.

12.

View Integration Results
After configuring the HI and KPI assignments in BSM and the monitor in SiteScope (including field
mapping), you can view the results.
n

Create a view in RTSM to view the results of the integration in BSM's Service Health or
Service Level Management application. The view should describe the CIs you want to view.
For details on creating the view, see "Modeling Studio Page" in the Modeling Guide in the BSM
Help.
If you defined the integration for SLM as well, you can view the integration results in SLM
reports. For more information on SLM and on the reports, see "Working with the Service Level
Management Application" in the BSM User Guide in the BSM Help.

n

You can also view the integration data in System Availability Management reports. In the
different reports, specify a filter for the data that you want to be displayed in the graphs.
Configure the filter to include the following values that you defined in the field mapping in step
9:
o

Target: Select a value that was defined in the TargetName field in the Integration Monitor
Field Mapping.

o

Monitor type: Select a value that was defined in the MonitorType field in the Integration
Monitor Field Mapping.
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o

Monitor title/name: Select a value that was defined in the MonitorName field in the
Integration Monitor Field Mapping.

o

Measurement: Select a value that was defined in the MeasurementName(x) field in the
Integration Monitor Field Mapping.

Example – Create a Metrics Flow With No Topology
This example describes how to create an integration monitor to capture and forward metrics samples
from a third-party system that monitors different Oracle databases to BSM using the No Topology flow.
This flow is used to send metric samples when a topology already exists in BSM, and there is no need
to report the CIs.
Note: For a task related to this example, see "How to Configure Integration Monitors to Collect
Metrics Data With No Topology" on page 424.

1.

Design Stage
You have an application named My Oracle Monitoring. This application writes various
measurements from Oracle databases running on different computers to a log file.
Since the application writes to log files, you need to create a Technology Log File Integration
monitor for the integration. The measurements will be assigned to Oracle CIs that already exist in
RTSM; therefore the CIs do not need to be reported. The data is assigned to HIs on the CIs. You
will focus on one indicator and one measurement that you are interested in.
Entries in the log file:
n

amrnd153,27,1,good

n

amrnd153,82,1,warning

n

amrnd153,80,1,warning
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The Technology Log File Integration monitor in SiteScope:

2.

Select an Indicator
In BSM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use the CPU Usage by SQL (Database) indicator. This indicator reports
SQL as well as Oracle usage.
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This indicator is defined on Oracle CI type and is appropriate for the measurement being read from
the log. This measurement describes the amount of CPU that Oracle uses.
3.

Define an HI Assignment
In BSM, select Admin > Service Health > Assignments > Health Indicator Assignments
and create the indicator assignment.
The assignment condition should match the Oracle CIs on which you want to define the indicators
(and not other Oracle CIs that do not belong to this integration). In the indicator assignment, select
the CPU Usage by SQL indicator.
If you edit the indicator in this assignment, you get this:
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The CPU Usage by SQL indicator is calculated using the SiteScope Worst Status Rule. The
selector defines that samples of type ss_t (the metrics data type) with the same ci_id and eti_
id as the current CI and ETI are captured by this indicator on this Oracle CI. You do not want other
samples to be captured.
4.

Define a KPI Assignment
Since you used a default indicator, you do not need to create a KPI assignment as there is an
existing Service Health KPI assignment on Oracle CIs.
In BSM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI
Type tree select Oracle and choose Oracle KPI Assignment.
In the Monitored by property, manually enter My Oracle Monitoring integration. This value
helps you distinguish Oracle CIs reported by this integration from other Oracle CIs that are being
reported. This assigns the CPU Usage by SQL indicator on the Oracle CIs that are reported by this
integration only.
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Select the Software Performance KPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator
which you used.
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5.

Define the Field Mapping
Note: Thefield mapping script to use is available in a text file attached to this PDF. To view
the attachment, select View > Navigation Panels > Attachments, and select Metrics_No_
Topology_Field_Mapping.txt.
In the field mapping script, you can see that a new monitor type was defined: My Oracle.
The monitor name is My Oracle mon on$group0 where $group 0 is also the target computer on
which the Oracle database is running.
The measurement name is oracle cpu usage and its value is taken from the log file. The quality
that is sent is conditional and depends on what is written in the log file.
The ETI to which the measurement is mapped is CPU Usage by SQL.
The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint helps the CI
Resolver in BSM to find the CI to which this data sample should be attached.

6.

View Integration Results
In BSM, select Applications > Service Health and manually create a view for the integration.
For example, here we created a view named My Oracle Monitoring (it is also displayed in
System Software Monitoring view):
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These are the results of the indicator status on the monitored machine:

The state and value are the same as you assigned in the field mapping.
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When configuring the generic integration monitors, you can select the event data type to collect
common or legacy event-based data. Common events data is used to integrate events collected from
third-party domain managers or applications to BSM 9.x. Legacy events are used to collect data on
specific events in BAC 8.x and earlier (retained for backward compatibility).

Troubleshooting/Limitations
General Notes/Limitations
This section describes troubleshooting and limitations for Integration Monitor field mapping.
For event samples, the monitor_id of the reported EMS monitor is built in the following way:

l

l

n

For Events samples and Computer topology, the monitor_id is:
< target_name>

n

For Events samples and Computer - Running Software topology (where subject is not equal to
system), the monitor_id is:
<subject (running software name)>

n

For Events samples and Computer - Running Software topology (where subject equals
system), the monitor_id is:
< target_name>
Do not use XML special characters (",',<,>,&) in the fields used to create the monitor_id, since
these characters causes problems for these samples in BSM.

Integration Monitor Field Mapping for Event Samples
You can enable capturing event data from Enterprise Management Systems (EMS), automated support
systems, and other management applications by configuring integration monitors and their field
mapping scripts.
Integration monitors depend on the field mapping you customize within the user interface in the settings
for the monitor. The mapping defines the processing of incoming data and defines the output sample
forwarded to BSM.
Integration Monitors designed for use with specific EMS applications (these currently include HP OM,
HP Service Center, and NetScout) can be configured without editing their field mapping script. The
mapping is predefined by HP and requires modification only if specific customizations are required. For
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details on editing these field mapping scripts, see the description for the field mapping element in the
user interface pages for the monitor you are deploying.
For Technology Integration Monitors (Technology SNMP Trap, Technology Log File, and Technology
Database monitors), you must select the data type and the required script is loaded directly into the
field mapping text box. You must edit the field mapping script to suit your organization's needs. The
Technology Web Service Integration Monitor field mapping may also need to be customized.
You can select the Common Events or Legacy Events data type to integrate events collected from
third-party domain managers or applications to BSM 9.x. Unlike the legacy EMS events, the Common
Event integration allows you to manage the events in Operations Management event sub system and
the Service Health console. In addition, the common event channel provides the option to report
topology to BSM without reporting the data.
When you select the Common Events data type to forward event data to BSM, and you want to
integrate to BSM using topology settings, you can select from the following predefined topology scripts:
Computer. Select to create a topology with a Computer CI.

l

Computer - Running Software. Select to create a topology with a Computer CI and a Running
Software CI connected to it with a Composition relationship.

l

Custom. Select to create your own topology script, if you want the retrieved data to be sent to
specific CIs instead of the Computer or Running Software CIs. Only select this option if you are
familiar with the Jython language, because you must create the topology script in Jython yourself.

l

When you select the LegacyEvents data type to forward event data to BSM, and you want to integrate
to BSM using topology settings, you can select from the following topology scripts:
Node. Creates a Node CI with an EMS monitor CI connected to it with Monitored By relationship.

l

Node - Running Software. Creates a topology with a Node CI and a Running Software CI
connected to it with a Composition relationship, and an EMS monitor CI which can be connected to
either the Node CI or the Running Software CI with Monitored By relationship.

l

Custom. Select to create your own topology script, if you want the retrieved data to be sent to
specific CIs instead of the Computer or Running Software CIs. You must be familiar with the
Jython language, since you must create the topology script yourself.

l

Note:
l

l

l

Events sent by EMS applications are event samples. They are not the same as Operations
Management events in BSM.
When SiteScope version 11.10 or earlier is connected to BSM 9.00, the Hosts-Applications
topology script is no longer available in the topology script list for the monitor. Only existing
integrations that report Hosts-Applications (created in SiteScope connected to BSM 8.x)
continue reporting to BSM 9.00. You cannot create new integrations using this script type.
SiteScope uses indicator definitions for monitor CIs created by the integration that are defined
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in BSM (and that are applicable for Computer CI type). If a different ETI is specified in the
monitor's field mapping, it overrides the default indicator definition.
For details on selecting a topology setting, see "Topology Settings for Technology Integration Monitors"
on page 383.
Note: Use only the mandatory and optional fields defined in the scripts when working with the field
mapping. For more information, see the tables for each data type.

Configure Field Mapping for Common Event Samples
The events data type is used for extracting events collected by external systems and importing them to
BSM. When configuring an integration monitor's field mapping, select the CommonEvents data type
to load the events script. You can then copy the contents of the Field Mapping text box and paste it
into a text editor to make your configuration changes. When you are done, copy the contents back into
the Field Mapping text box.
For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page
389.
For CI resolution hint formats, see "CI Resolution Hint Formats" on page 389.
This section also includes:
l

"Mandatory Values for the Common Events Script" below

l

"Mandatory Values When Reporting Topology Without Data" on the next page

l

"Optional Values for the Common Events Script" on the next page

l

"Common Events Script Example" on page 443

Mandatory Values for the Common Events Script
The table below lists mandatory values for the common events script. Map the values to the
corresponding field mapping group in which they appear in the log file from which you want to extract
data.
Field
Name

Description

Title

Summary of the event.
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Field
Name
Severity

Description
Severity of the event. Possible values are: Normal, Warning, Minor, Major, and
Critical.

SourceHint Information about the monitoring application and the corresponding probe/agent that is
responsible for creating the event.

Mandatory Values When Reporting Topology Without Data
The following values are mandatory when reporting only the topology discovered by the SiteScope
Technology Integration monitors, without reporting the data:
For
Topology
Script
l

l

Computer
Computer
- Running
Software

Field
Name

Description

target_ Name of the host or machine that generated the event. This can be added
manually or taken from:
name
Framework.getDestinationAttribute("<someAttribute>")
Examples:
Technology Log File Integration monitor:
Framework.getDestinationAttribute("group0") where group0 is the value
of the first pattern matching group.
Technology Database Integration monitor:
Framework.getDestinationAttribute("NAME") where NAME is the name
of a database column.
Technology Web Service Integration monitor:
Framework.getDestinationAttribute(“Host") where HOST is the key in the
SOAP request <key>Host</key>.

l

l

Computer
Computer
- Running
Software

Computer Running
Software

target_ IP of the host or machine. This can be added manually, or calculated
using:
ip
HostIPCachingManager.getIPByHostName(target_name)
where target_name represents a valid host or machine, or you can use:
HostIPCachingManager.getIPByHostName("<someAttribute>")
name

Name of Running Software. This can be added manually, or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Optional Values for the Common Events Script
The table below lists optional values for the common events script. Map the values to the
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corresponding field mapping group in which they appear in the log file from which you want to extract
data.
Field Name

Description

CiHint

Information about a CI that is related to the event. For details of the formats for CI
resolution hints, see "Field Mapping Structure" on page 388.

EtiHint

Event Type Indicator hint in the format:
[ETI Name]:[ETI Value]:[Metric Value]
Example: CPULoad:Critical:50
For more information on BSM indicators, see "Health Indicators and KPIs" in the
BSM User Guide in the BSM Documentation Library.

ComponentCi Information used to identify a subcomponent of a CI. This CI subcomponent is used
to calculate an aggregated status within BSM's Service Health for selected CIs.
If an HI is populated by events from multiple components, you can specify a
component name in this field in order to ensure the correct calculation of the HI
state.
Example: If you have a Computer CI with two CPUs, cpu #1 and cpu #2, events
from both CPUs will be sent to the same CPU Load HI. By default, the events will
override each other and create an incorrect HI state. To prevent this, you can
populate ComponentCi with values "cpu #1" and "cpu #2" which will cause the HI
state to be calculated as an aggregated state between the two events.
HostHint

Information about a CI of type Node that is hosting the CI related to the event. This
field is mandatory when reporting topology which includes Node CIs.

Description

Additional information describing the event.

Category

Name of a logical group to which the event belongs. An event category is similar to a
message group in HPOM.
Example (from log file): Database, Security, Network

SubCategory

Name of a logical subgroup (category) to which the event belongs.
Example (from log file): Oracle (database), Accounts (security), Routers
(network))

Key

A unique string representing the type of event that occurred. Two events can have
the same key if both events represent the same situation in the managed
environment. Events with the same key are treated as duplicates.
Example (from log file): foohost:barhost:CPULoad:Critical
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Field Name

Description

CloseKey

Enables the event that is sent to close all events whose Key attribute matches the
CloseKey pattern expression. You can use wildcards (*) if necessary.
Example (from log file): barhost:CPULoad<*>

LogOnly

This field allows submitting an event that goes directly into the history event browser
as a closed event. Such an event goes though the complete event processing (CI
Resolution, updating HIs, and so forth), but has its Life Cycle State set to closed
from the beginning. For details on CI Resolution, see "CI Resolution" in the BSM
User Guide in the BSM Documentation Library.
Typical examples of events having this attribute set to "True" are events that will
result in resetting a Health Indicator to a "Normal" or "Good" state, or an event
signaling that a previous problem no longer exists (where the problem was reported
in another event).
Possible values are:
l

True. Logs all events automatically on arrival.

l

False. Events are not logged automatically.

l

True for normal severity. Automatically logs events with Normal severity only.

Default value: False
Attributes
#cma1=

Use these attributes to send any custom attributes in the event.

#cma2=

Note: Only the predefined custom mapping attributes are supported. You cannot
change a custom attribute name (cma1-cma5) or add a new one.

#cma3=
#cma4=
#cma5=

Common Events Script Example
The example below shows a section of the Common Events script with script values mapped to the
corresponding field mapping group ($group<#>) in which they appear in the log file.
[$DEFAULT_PARAMETERS$]
############################################
# NOTE: the following fields are mandatory #
############################################
# Brief summary of the event
Title=$group0
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# Severity of the event. Possible values are: "Normal", "Warning", "Minor",
"Major",
and "Critical"
Severity=$group2
# Information about the monitoring application and the corresponding probe/agent
that
is responsible for creating the event
# If the field is left empty then it will be auto filled with SiteScope@@
[SiteScope Node FQDN]
SourceHint=$group8
############################################
NOTE: the following fields are optional
#
# An unfilled field must remarked with '#' #
#############################################
# Information about a CI that is related to the event. For more information, see
"Preferences" > "Common Event Mappings" > "New/Edit Event Mapping Dialog Box" in
the
SiteScope documentation
CiHint=$group6
# Event Type Indicator hint in the format: [ETI Name]:[ETI Value]:[Metric
Value].
Example: CPULoad:Critical:50
EtiHint=$group5
# Information used to identify a subcomponent of a CI. This CI subcomponent is
used
to calculate an aggregated status within BSM Service Health for selected CIs
#ComponentCi=

Configure Field Mapping for Legacy Event Samples
The events data type is used for extracting events collected by external systems and importing them to
BSM. When configuring an integration monitor's field mapping, select the Legacy Events data type to
load the events script. You can then copy the contents of the Field Mapping text box and paste it into
a text editor to make your configuration changes. When you are done, copy the contents back into the
Field Mapping text box.
For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page
389.
For CI resolution hint formats, see "Field Mapping Structure" on page 388.
This section also includes:
l

"Mandatory Values for the Legacy Event Script" on the next page

l

"Optional Values for the Legacy Event Script" on page 446
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l

"Conditional Expression Example 1" on page 447

l

"Conditional Expression Example 2" on page 447

l

"Event Script Example" on page 448

Mandatory Values for the Legacy Event Script
The table below lists mandatory values for the legacy event script.
Field Name

Type

Description

time_stamp

DOUBLE Time stamp in seconds since Jan
1 1970.

Example
time_stamp:DOUBLE=str_to_
seconds($time,"yyyy-MM-dd
HH:mm:ss.SSS").
time_stamp:DOUBLE=int time()
For details on int time(), see
"Available Data Processing
Operations" on page 390.

severity

INT

target_name STRING

Can be one of the following
severity:INT=SEVERITY_MINOR
preconfigured severities (based on
applicable integer):
0:SEVERITY_UNKNOWN
1:SEVERITY_INFORMATIONAL
2:SEVERITY_WARNING
3:SEVERITY_MINOR
4:SEVERITY_MAJOR
5:SEVERITY_CRITICAL
Name of device or host machine
that generated the event.

target_name=$hostName
target_name=String
resolveHostName(String
hostIP)
For details on String
resolveHostName(String
hostIP), see "Available Data
Processing Operations" on page
390.

status

STRING

Status of event in external EMS
terminology.

status="OPEN"
status="ASSIGNED"
status="CLOSED"
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Field Name

Type

Description

Example

subject

STRING

Subject of event (e.g. CPU, SAP
application, Hard Disk),
middle/high level hierarchy
describing the event source.

subject="DISK"

instance

STRING

Instance of subject that generated instance="E:\\"
the event (e.g D:\). Lowest level of
hierarchy describing the event
source.

description STRING

Textual description of event.

description="free space on
drive e is below 10%"

data_source STRING

System that generated the event.

data_source="HP OVO"

Optional Values for the Legacy Event Script
The table below lists optional values for the legacy event script.
Field Name

Type

Description

Example

target_ip

STRING

IP of device or host machine that
generated the event.

target_ip=$IPString

object

STRING

Optional level in the hierarchy
describing the event source.

object="OS"

event_id

STRING

Unique identifier of this event.

event_id=$id

logical_group STRING

Logical grouping of this event.

logical_group="error
messages"

Monitor group that reported this
event.

monitor_group="log
monitors on \\hostname"

STRING
orig_
severity_name

Severity in external EMS
terminology.

orig_severity_name
="Cleared"

acknowledged_ STRING
by

Name of user that acknowledged
this event.

acknowledged_by =$username

Name of user who owns this event.

owner="admin"

monitor_
group

STRING

owner

STRING

value

DOUBLE Use to transfer numerical values
from the event.

value=$thresholdViolated

attr1

STRING

attr1=$history
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Field Name

Type

Description

Example

attr2

STRING

Extra data slot.

attr2=$moreHistory

attr3

STRING

Extra data slot.

attr3="Design"

attr4

STRING

Extra data slot.

attr4=$MonitorOutput

attr5

STRING

Extra data slot for long strings.

attr5=$Longhistory

Host DNS Resolution for Event Sample
Both the FQDN (fully qualified domain name) and valid IP address are necessary for the fields that are
used to create Node CIs in the BSM integration.
If you do not know the FQDN, IP address, or both, then you can use the following functions in the field
mapping to resolve the names and access them from the source of the integration:
target_name=resolveHostName($SomeHost)
target_ip=resolveHostIP($SomeHost)

Note: The variable $SomeHost must be replaced by a variable from the integration source.
These functions are not necessary if:
l

l

The FQDN, IP address, or both, are available from the source that the integration is accessing. In
this case, input the value for target_name= as a FQDN and the value for the target_ip= without the
function.
It is not possible for the SiteScope server to resolve the FQDN, IP address, or both, for the servers
from the source that the integration is accessing. In this case, the functions may not provide the
valid values.

Conditional Expression Example 1
severity:INT=$var6.equals("red") ? SEVERITY_CRITICAL
: SEVERITY_INFORMATIONAL
In this example, the value of sixth variable binding is compared to string red. If the variable binding is
indeed equal to string red, then the value of the severity tag is set to SEVERITY_CRITICAL, otherwise it
is set to SEVERITY_INFORMATIONAL.

Conditional Expression Example 2
severity:INT=$var6.equals("red") ? SEVERITY_CRITICAL :
$var6.equals("green") ? SEVERITY_INFORMATIONAL : $var6.equals("yellow")
? SEVERITY_MINOR : SEVERITY_WARNING
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This example chains the conditional operator into a decision chain. If the sixth variable binding holds
string red, then severity tag has the value SEVERITY_CRITICAL. If the sixth variable binding holds
string green, then severity tag has the value SEVERITY_INFORMATIONAL. If the variable binding holds
string yellow, the tag has the value SEVERITY_MINOR. If none of the above conditions are true, then the
tag has the value SEVERITY_WARNING.

Event Script Example
In the example below, two types of events are sent: the first are events of status "OPEN" and the
second are events cleared by a user. The data is retrieved from incoming event fields using the $
notation. All other events are discarded by the last handler.
[$DEFAULT_PARAMETERS$]
################################################
# NOTE: the following parameters are mandatory #
################################################
time_stamp:DOUBLE=str_to_seconds($time,"yyyy-MM-dd HH:mm:ss.SSS")
severity:INT= SEVERITY_UNKNOWN
target_name=$Device
status=$Status
subject="EMS X Events"
instance=$target
description=$description
data_source="EMS X"
#send an open event with the value in value fields and with the event id
[OPEN events]
$MATCH="OPEN".equals($Status)
$ACTION=SEND(event)
value:DOUBLE=parseDouble($threshold)
event_id=$uid
#send clear events with the event id and acknowledging username
[clear events]
$MATCH="CLEAR".equals($Status)
$ACTION=SEND(event)
event_id=$uid
acknowledged_by=$ClearedBy
[event sink]
$MATCH=true
$ACTION=DISCARD
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How to Configure Integration Monitors to Collect Data on
Common Events
This task describes the steps involved in configuring the common event integration, which is used to
collect data on specific events, and to make the data available for use in BSM's Operations
Management event sub system, the Service Health console, and Service Level Management.
1.

Plan the integration strategy
Review the Integration Monitor types. Consider the type of information you want to view in BSM
from your EMS system. Determine whether one of the specific Integration Monitors meets your
organization's needs or whether a generic Integration Monitor (Technology Log File, Database,
SNMP Trap, Web Service) is required.
For concept details, see "Integration Monitors Overview" on page 377.

2.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.

3.

Configure HP Operations Manager event integration
Follow the steps for configuring the event integration. For details, see "How to enable SiteScope
to send events to HPOM or OMi" in Integrating SiteScope with HP Operations Manager Products.
You can check the HP Software Integrations site for the latest version of this guide.
Note:

4.

n

You do not need to select Enable sending events in the HP Operations Manager
Integrations Main Settings panel (the "Enable SiteScope to send events to HPOM or
BSM" step), because this step applies only to sending events for regular SiteScope
monitors. Events for integration monitors are automatically sent when the integration
monitor is configured to use the Common Events sample mapping script.

n

The "Enable/Disable sending events for monitor instances and alerts" step is not relevant
when sending events for integration monitors.

n

You do not need to select the Enable HP Operations Manager metrics integration
check box in the HP Operations Manager Metrics Integrations panel.

Select the SiteScope server
Select the SiteScope server from which you want to deploy the integration monitor:
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5.

n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
Administration Page" in the BSM User Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

6.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)

You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)

7.

n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
a. In the Field Mapping panel, select the Common Events field mapping script, and click Load
File. A template script is displayed in the Field mapping box.

HP SiteScope (11.31)

Page 450 of 1395

Using SiteScope
Chapter 30: Configure Integration Monitors to Collect Event Data

b. Edit the script to enable SiteScope to retrieve the data from the monitored application that you
want to forward to BSM by mapping the script values to the corresponding field mapping group
in which they appear in the log file from which you want to extract data. For details on the file
structure and syntax, see "Event Handler Structure and Syntax" on page 389.
For mandatory script values, see "Mandatory Values for the Common Events Script" on page
440.
For optional script values, see "Optional Values for the Common Events Script" on page 441.
Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

8.

Map the data to a topology script - optional (required when reporting topology to BSM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI
hierarchy in BSM:
n

Computer. Select to create a topology with a Computer CI.
Note: Information about Computer CI is taken from the HostHint field.

n

Computer - Running Software. Select to create a topology with a Computer CI and a
Running Software CI connected to it with a Composition relationship.
Note: Information about Node CI is taken from the HostHint field and the name of the
Running Software CI is taken from the Category field.

n

Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary
values to forward data to the required CIs in BSM's RTSM. For concept details, see "Topology
Settings for Technology Integration Monitors" on page 383.
Note:
o

When using field mapping, you can use the field mapping fields as an input for topology
script. For example, if using common event mapping, you can access the value of the
Category field in the following way:
category = Framework.getDestinationAttribute("Category").

o

In addition, you can access values of the "monitor variables", such as group0, group1,
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and so forth, from Technology Log File Integration monitor, or the names of database
columns in Technology Database Integration monitor, or other variables in the other
integration monitors. For example, you can access the value of the group1 variable, in
the following way:
group1 = Framework.getDestinationAttribute("group1")

9.

Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
tests the following:
n

Checks the field mapping and topology script syntax.

n

Displays the mapping results.

n

Displays the topology results if a topology script has been configured.

The test does not forward events or topology to BSM.
10.

Results
When events are gathered from a third-party system and processed by integration monitors,
common events are generated, and SiteScope writes the event data to the
HPSiteScopeOperationsManagerIntegration.log file in the <SiteScope root directory>\logs
directory. Each event is written as a separate line in the log. The log file policy instructs the agent
to read this file and create event messages that are sent to BSM.
You can view the event in the Operations Management Event Browser (if you have an Event
Management Foundation license). If Operations Management is not part of your BSM installation,
you can view events that affect CI status using a health indicator in Service Health.

How to Configure Integration Monitors to Collect Data on
Legacy Events
This task describes the steps involved in configuring the legacy event integration, which is used to
collect data on specific events, and to make the data available for use in BSM's Service Health, Event
Log, and trend reports.
1.

Plan the integration strategy
Review the Integration Monitor types. Consider the type of information you want to view in BSM
from your EMS system. Determine whether one of the specific Integration Monitors meets your
organization's needs or whether a generic Integration Monitor (Technology Log File, Database,
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SNMP Trap, Web Service) is required.
For concept details, see "Integration Monitors Overview" on page 377.
2.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.
Note: You do not need to configure the HP Operations Manager event integration when the
integration monitor is configured to use the Legacy Events sample mapping script.

3.

Select the SiteScope server
Select the SiteScope server from which you want to deploy the integration monitor:

4.

n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
Administration Page" in the BSM User Guide in the BSM Help.

n

When in EMS Integrations Administration, click the New Integration or Edit Integration
button. In the Edit Integration dialog box, click the link in the System Availability Management
panel to open SAM Administration window where you can select a SiteScope server. For user
interface details, see "Edit Integration Dialog Box" in the BSM Application Administration
Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

5.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)
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You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)

6.

n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
a. In the Field Mapping panel, select the Legacy Events field mapping script, and click Load
File.
b. Edit the script to enable SiteScope to retrieve the data from the monitored application that you
want to forward to BSM by mapping the script values to the corresponding field mapping group
in which they appear in the log file from which you want to extract data. For details on the file
structure and syntax, see "Event Handler Structure and Syntax" on page 389.
For mandatory script values, see "Mandatory Values for the Legacy Event Script" on page
445.
For optional script values, see "Optional Values for the Legacy Event Script" on page 446
Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

7.

Map the data to a topology script - optional (required when reporting topology to BSM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI
hierarchy in BSM:
n

Node. Select to create a Node CI with an EMS monitor CI connected to it with Monitored By
relationship.

n

Node - Running Software. Select to create a topology with a Node CI and a Running
Software CI connected to it with a Composition relationship, and an EMS monitor CI which
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can be connected to either the Node CI or the Running Software CI with Monitored By
relationship.
Note: Information about Computer CI is taken from the HostHint field and the name of the
Running Software CI is taken from the Category field.
n

Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary
values to forward data to the required CIs in BSM's RTSM. For concept details, see "Topology
Settings for Technology Integration Monitors" on page 383.
Note:
o

When using field mapping, you can use the field mapping fields as an input for topology
script. For example, if using legacy event mapping, you can access the value of the
Subject field in the following way:
subject = Framework.getDestinationAttribute("Subject")

o

In addition, you can access values of the "monitor variables", such as group0, group1,
and so forth, from Technology Log File Integration monitor, or the names of database
columns in Technology Database Integration monitor, or other variables in the other
integration monitors. For example, you can access the value of the group1 variable, in
the following way:
group1 = Framework.getDestinationAttribute("group1")

8.

Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
tests the following:
n

Checks the field mapping and topology script syntax.

n

Displays the mapping results.

n

Displays the topology results if a topology script has been configured.

The test does not forward events or topology to BSM.
9.

Configure the EMS Integrations application in BSM
In addition to configuring the monitor, you need to configure the EMS Integrations application in
BSM. For details, see the remaining steps in "Create an EMS integration (for Event or Ticket
Samples)" in "How to Integrate Data from Third-Party Sources (EMS Data) into HP Business
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Service Management" in the BSM Application Administration Guide in the BSM Help.
Note: If you are configuring a metrics integration, do not need to go to BSM's SAM
Administration and configure a new integration. You just need to create a monitor and select
the Report topology option.

10.

Results
When events are gathered from a third-party system and processed by integration monitors, the
events are generated and the event data is written to the
HPSiteScopeOperationsManagerIntegration.log file in the <SiteScope root directory>\logs
directory. Each event is written as a separate line in the log. The log file policy instructs the agent
to read this file and create event messages that are sent to BSM.
You can view events in Service Health, System Availability Management Event Logs, and trend
reports.
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Ticketing Data
When configuring the generic integration monitors, you can select the ticketing data type to collect
incidents and events from ticketing systems. Data collected by integration monitors that use the
ticketing data type is integrated into BSM and can be viewed in Service Health and Service Level
Management.

Troubleshooting/Limitations
General Troubleshooting/Limitations
This section describes troubleshooting and limitations for Integration Monitor field mapping.
l

For Tickets samples and Tickets topology, the monitor_id of the reported EMS monitor is:
<data_source>_<target_name>

l

Do not use XML special characters (",',<,>,&) in the fields used to create the monitor_id, because
these characters causes problems for these samples in BSM.

Integration Monitor Field Mapping for Ticketing Samples
You can enable capturing event and metrics data from Enterprise Management Systems (EMS),
automated support systems, and other management applications by configuring integration monitors
and their field mapping scripts.
Integration monitors depend on the field mapping you customize within the user interface in the settings
for the monitor. The mapping defines the processing of incoming data and defines the output sample
forwarded to BSM.
Integration Monitors designed for use with specific EMS applications (these currently include HP OM,
HP Service Center, and NetScout) can be configured without editing their field mapping script. The
mapping is predefined by HP and requires modification only if specific customizations are required. For
details on editing these field mapping scripts, see the description for the field mapping element in the
user interface pages for the monitor you are deploying.
For Technology Integration Monitors (Technology SNMP Trap, Technology Log File, and Technology
Database monitors), you must select the data type and the required script is loaded directly into the
field mapping text box. You must edit the field mapping script to suit your organization's needs. The
Technology Web Service Integration Monitor field mapping may also need to be customized.

HP SiteScope (11.31)

Page 457 of 1395

Using SiteScope
Chapter 31: Configure Integration Monitors to Collect Ticketing Data

When you select Tickets and you want to integrate to BSM using topology settings, you can select the
following topology script: Tickets or Custom (only if you are familiar with the Jython language, since
you must create the Jython topology script yourself).
For details, on selecting a topology setting, see "Topology Settings for Technology Integration
Monitors" on page 383.
Note: Use only the mandatory and optional fields defined in the scripts when working with the field
mapping. For more information, see the tables for each data type.

Configure Field Mapping for Ticket Samples
The ticket data type is used for extracting events collected by external systems and importing them to
BSM.
To configuring an integration monitor's field mapping:
1. Select the Tickets data type to load the tickets script.
2. Copy the contents of the Field Mapping text box and paste it into a text editor to make your
configuration changes.
3. Copy the contents back into the Field Mapping text box.
For details on event handler structure and syntax, see "Event Handler Structure and Syntax" on page
389.
This section also includes:
l

"Mandatory Values for the Ticket Script" below

l

"Optional Values for the Ticket Script" on the next page

l

"Conditional Expression Example" on page 460

l

"Ticket Script Example" on page 461

Mandatory Values for the Ticket Script
The table below lists mandatory values for the ticket script.
Field
Name
time_
stamp

Type

Description

DOUBLE Time stamp in
seconds since Jan 1
1970.
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Field
Name

Type

Description

Example

severity

INT

Can be one of the
following
preconfigured
severities (based on
applicable integer):
SEVERITY_
UNKNOWN
SEVERITY_
INFORMATIONAL
SEVERITY_
WARNING
SEVERITY_MINOR
SEVERITY_MAJOR
SEVERITY_
CRITICAL

4".equals($severity) ? "Low" : ("3".equals
($severity) ? "Average" : ("2".equals
($severity) ? "High" : ("1".equals
($severity) ? "Critical" : "Unknown")))

target_
name

STRING

Name of the entity
(usually a service)
that generated the
ticket.

target_name="mail service" (Do not enter
static string here, should be retrieved dynamically
from the ticket.)

data_
source

STRING

System that
generated the ticket.

data_source="ticketing" (This string should not
be edited for HP ServiceCenter integration and must
be edited for a generic technology integration
monitor.)

ticket_id

STRING

ID of the ticket.

ticket_id=112233

ticket_
state

STRING

One of the states in
the incident lifecycle
as defined in the
ticketing system.

"Open" / "Closed"

ticket_
type

STRING

Type of the incident
as defined in the
ticketing system.

"Incident"

orig_
STRING
severity_
name

Severity in external
EMS terminology.

orig_severity_name ="Cleared"

Optional Values for the Ticket Script
The script includes comments describing the optional values available for the ticket script. They
include those listed here:
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Field
Name

Type

Description

Example

subject

STRING Middle/High level hierarchy describing the event
source.

CPU, SAP
application, hard
disk

instance

STRING Instance of subject that generated the event. The
lowest level hierarchy describing the event source.

D:\\

object

STRING Optional level in the hierarchy describing the ticket
source.

object="OS"

logical_
group

STRING Logical grouping of this ticket.

logical_
group="error
messages"

monitor_
group

STRING Monitor group that reported this ticket.

monitor_group="log
monitors on
\\hostname"

elapsed_
time

STRING Elapsed time of the ticket.

orig_
STRING Severity name as defined in the ticketing system.
severity_
name
attr1

STRING Extra data slot.

attr1=$history

attr2

STRING Extra data slot.

attr2=$moreHistory

attr3

STRING Name of organization which owns a business
service (if used in the Business Service integration
topology flow).

Attr3="XYZ Inc"

attr4

STRING Type of organization which owns a business
service (if used in the Business Service integration
topology flow).

Attr4="department"

attr5

STRING Extra data slot for long strings. Use for values up to
2000 chars.

attr5=$Longhistory

Conditional Expression Example
This example configures the severity of the ticket sample. It matches between the status terms used in
the ticketing system to those used in BSM.
4".equals($severity) ? "Low" : ("3".equals($severity) ? "Average" :
("2".equals($severity) ? "High" : ("1".equals($severity) ? "Critical" :

HP SiteScope (11.31)

Page 460 of 1395

Using SiteScope
Chapter 31: Configure Integration Monitors to Collect Ticketing Data

"Unknown")))

Ticket Script Example
[$DEFAULT_PARAMETERS$]
time_stamp:DOUBLE=$time_stamp
ticket_id=$ticket_id
ticket_state=$ticketStatus
severity:INT=$severity
target_name=$target_name
data_source="ticketing"
ticket_type="Incident"
orig_severity_name="4".equals($severity) ? "Low" : ("3".equals($severity)
? "Average" : ("2".equals($severity) ? "High" : ("1".equals($severity)
? "Critical" : "Unknown")))

How to Configure Integration Monitors to Collect Ticketing
Data
This task describes the steps involved in configuring SiteScope to collect incidents and events from
third-party ticketing systems, and to import the data samples into BSM.
1.

Plan the integration strategy
Review the Integration Monitor types. Consider the type of information you want to view in BSM
from your EMS system. Determine whether one of the specific Integration Monitors meets your
organization's needs or whether a generic Integration Monitor (Technology Log File, Database,
SNMP Trap, Web Service) is required.
For concept details, see "Integration Monitors Overview" on page 377.

2.

Configure BSM integration
Integrate SiteScope and BSM. For details, see "How to Configure SiteScope to Communicate
with BSM" on page 219.

3.

Select the SiteScope server
Select the SiteScope server from which you want to deploy the integration monitor:
n

For SiteScope standalone, select and open a SiteScope instance.

n

When in SAM Administration, select the SiteScope server from which you want to deploy the
integration monitor. For user interface details, see "System Availability Management
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Administration Page" in the BSM Application Administration Guide in the BSM Help.
n

4.

When in EMS Integrations Administration, click the New Integration or Edit Integration
button. In the Edit Integration dialog box, click the link in the System Availability Management
panel to open SAM Administration window where you can select a SiteScope server. For user
interface details, see "Edit Integration Dialog Box" in the BSM Application Administration
Guide in the BSM Help.

Create a group for the integration monitor
For user interface details, see "New SiteScope Group Dialog Box" on page 249.
Tip: We recommend that you create special groups for the integration monitors. This enables
you to more easily recognize the data that is reported to BSM as coming from the integrations.

5.

Add the integration monitor
Configure the integration monitor and add the required data for the monitor's settings. You can
choose from the following application-specific integrations:
n

HP OM Event Monitor (for details, see the SiteScope Monitor Reference Guide)

n

HP Service Manager Monitor (for details, see the SiteScope Monitor Reference Guide)

n

NetScout Event Monitor (for details, see the SiteScope Monitor Reference Guide)

You can choose from the following generic integration monitors (note that generic integration
monitors are supported for BSM 9.1x and earlier versions only; for all new third-party data
integrations in BSM 9.2x, use BSM Connector as described in the BSM Application Administration
Guide in the BSM Help.)

6.

n

Technology Database Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Log File Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology SNMP Trap Integration Monitor (for details, see the SiteScope Monitor Reference
Guide)

n

Technology Web Service Integration Monitor (for details, see the SiteScope Monitor
Reference Guide)

Edit the monitor's field mapping
The mapping defines the processing of incoming data and the output sample forwarded to BSM.
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a. In the Field Mapping panel, select the Tickets field mapping script, and click Load File.
b. Edit the script to enable SiteScope to retrieve the data from the monitored application that you
want to forward to BSM by mapping the script values to the corresponding field mapping group
in which they appear in the log file from which you want to extract data.
For mandatory script values, see "Mandatory Values for the Ticket Script" on page 458.
For optional script values, see "Optional Values for the Ticket Script" on page 459.
Note: The Field Mapping settings are not available when the Report topology without data
check box is selected in the Topology Settings panel. For details on reporting topology
without data, see "Report Topology Without Data" on page 465.

7.

Map the data to a topology script - optional (required when reporting topology to BSM)
In the Topology Settings panel, select a topology script to forward the data to the correct CI
hierarchy in BSM:
n

Tickets. Select to create a Business Service CI with an EMS monitor CI connected to it with
Monitored By relationship. The EMS Monitor CI propagates status onto the Business Service
CI.
Note: The topology script must include the EMS monitor CI as the lowest leaf in the
topology created by the integration

n

Custom. Select to create your own topology script.
Edit the topology settings. The topology scripts are specially configured with the necessary
values to forward data to the required CIs in BSM's RTSM.
Note:
o

When using field mapping, you can use the field mapping fields as an input for topology
script. For example, if using legacy event mapping, you can access the value of the
Subject field in the following way:
subject = Framework.getDestinationAttribute("Subject")

o

In addition, you can access values of the "monitor variables", such as group0, group1,
and so forth, from Technology Log File Integration monitor, or the names of database
columns in Technology Database Integration monitor, or other variables in the other
integration monitors. For example, you can access the value of the group1 variable, in
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the following way:
group1 = Framework.getDestinationAttribute("group1")

8.

Test the field mapping script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
tests the following:

9.

n

Checks the field mapping and topology script syntax.

n

Displays the mapping results.

n

Displays the topology results if a topology script has been configured.

Configure the EMS Integrations application in BSM
In addition to configuring the monitor, you need to configure the EMS Integrations application in
BSM. For details, see the remaining steps in "Create an EMS integration (for Event or Ticket
Samples)" in "How to Integrate Data from Third-Party Sources (EMS Data) into HP Business
Service Management" in the HP Software Integrations site.
Note: If you are configuring a metrics integration, do not need to go to BSM's SAM
Administration and configure a new integration. You just need to create a monitor and select
the Report topology option.

10.

Results
When events are gathered from a third-party system and processed by integration monitors, the
events are generated and the event data is written to the
HPSiteScopeOperationsManagerIntegration.log file in the <SiteScope root directory>\logs
directory. Each event is written as a separate line in the log. The log file policy instructs the agent
to read this file and create event messages that are sent to BSM.
You can view events in Service Health, System Availability Management Event Logs, and trend
reports.
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You can enable SiteScope to report only the topology discovered by the SiteScope Technology
Integration monitors, without reporting the data.

Tasks
How to Report Topology Without Data
This task describes how to enable reporting topology discovered by the SiteScope Technology
Integration monitors without sending data.
1. Configure the Technology Integration monitor
a. When configuring a Technology Integration monitor, in the Topology Settings panel, select the
Report topology without data check box.
Note: When this option is selected, the Field Mapping area is not available.
b. Select a topology script from the following options:
o

Computer. Select to create a topology with a Computer CI.

o

Computer - Running Software. Select to create a topology with a Computer CI as the
parent CI and a Running Software CI under it.

o

Custom. Select to create your own topology script, if you want the retrieved data to be
sent to specific CIs instead of the Computer or Running Software CIs.

c. Map the data discovered by the monitor to the relevant attributes in the topology settings. The
topology scripts are specially configured with the necessary values for reporting topology only
to BSM.
For mandatory script values, see "Configure Field Mapping for Common Event Samples" on
page 440.
Note:
o

Computer and Computer - Running Software are out-of-the-box topology scripts
that are available for the report topology without data type flow.
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o

The Computer and Computer - Running Software scripts are available only when
SiteScope is connected to BSM versions 9.x or later.

Note: You can access values of the "monitor variables", such as group0, group1, and so
forth, from the Technology Log File Integration monitor, or the names of database
columns in the Technology Database Integration monitor, or other variables in the other
integration monitors. For example, you can access the value of the group1 variable, in
the following way:
group1 = Framework.getDestinationAttribute("group1")
2. Test the script - optional
In the Topology Settings panel, click Test Script to test the script before running the monitor. This
displays the topology results.
The test does not forward topology to BSM.
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BSM can accept events from HP Network Node Manager (NNM). You can forward event data from
Network Node Manager (NNM) by configuring NNM to run a script for each event that you want
forwarded to BSM. The script that you write and associate with NNM can do one of the following
actions:
l

Write the NNM data to a log file.

l

Send an SNMP trap with the NNM data to a SiteScope server.

If your script writes the data to a log, you then use a Technology Log File Integration Monitor to read the
data and forward it to BSM. If you use a script to send an SNMP trap to a SiteScope server, you use an
Technology SNMP Trap Integration Monitor configured to receive it and forward to BSM.

Learn About
Scripts to Export Network Node Manager Data
The script you use should accept data from NNM as a command line argument, and process the data
so that it can be forwarded to BSM. The following sections describe example scripts that can be used
to export NNM data.
Sample Script for Writing to a Log File
The following Perl script receives data from the command line and writes it to a log file as a comma
separated vector of values that can be parsed by the Log File Integration Monitor:
#!/usr/bin/perl
open LOG, ">>log1.log" or die;
print LOG (join ',', @ARGV) . "\n";
close LOG;

Sample Script for Sending SNMP Trap Data
The following Perl script receives data from the command line and sends it as a message in an SNMP
trap (using SNMP data generated by Network Node Manager) that can be caught by a Technology
SNMP Trap Integration Monitor. It accepts the host name to which the trap is sent as the first
parameter and a string description of the alert as the second parameter.
#!/usr/bin/perl
$host = $ARGV[0];
$message = $ARGV[1];
system("snmptrap $host \"\" \"\" 6 0 5 system.sysDescr.0 " . "octetstringascii $message");
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Tasks
How to Configure Events in Network Node Manager
Use the following steps to configure NNM 7.x to run a script for the requested events in NNM.
Note: For later versions of NNM and NNMi, refer to the NNMi documentation.
1. From the Options menu, choose Event Configuration.
2. Select the requested enterprise and event from the Event Configuration dialog box.
3. Select the Actions tab from the Edit > Events > Modify Events dialog box.
4. Enter the command line for the script in the Command for Automatic Action text box. You may
use NNM variables to pass data to the command line.
5. Click OK to close the Modify Events dialog box.
6. From the File menu in the Event Configuration dialog box, select Save.

HP SiteScope (11.31)

Page 468 of 1395

Part 6: Remote Servers
You configure monitors to collect the data from remote servers you want to monitor. This means
selecting a remote server, and configuring connection properties so that SiteScope can monitor
systems and services running in remote environments.
This section describes the following:
l

l

l

l

l

How to configure SiteScope to monitor remote Windows and UNIX servers ("Configure SiteScope
to Monitor Remote Windows Servers" on page 470, "Configure SiteScope to Monitor Remote UNIX
Servers" on page 492).
How to configure SiteScope to monitor remote Windows servers using Windows Management
Instrumentation (WMI) ("Configure the WMI Service for Remote Windows Monitoring" on page
488).
How to create and customize adapter files for UNIX monitoring ("Extend UNIX Monitoring Using
Operating System Adapters" on page 502).
How to enable SiteScope to prefer IPv6 addresses over IPv4 when connecting to remote servers
("Enable SiteScope to Prefer IP Version 6 Addresses" on page 510).
How to use Secure Shell (SSH) connection for remote monitoring ("Configure Remote Monitoring
Using Secure Shell (SSH)" on page 516).
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Microsoft Windows Remote server options are used to set up the connection properties, such as
credentials and protocols, so that SiteScope can monitor systems and services running in remote
environments. You can then create monitors to watch the resources and performance counters for that
server. Multiple monitors can use the same connection profile. You can also create multiple remote
servers for the same host machine.

To access
Select the Remote Servers context. In the remote servers tree, click the Microsoft Windows
Remote Servers container.

Learn About
Remote Server Overview
SiteScope must be able to establish a connection to the servers you want to monitor.
It must also be authenticated as a user having account permissions to access the Windows
performance registry on the Microsoft Windows remote machine, and to run command line tools on the
UNIX remote machine as a remote user.
Monitoring remote Windows servers also requires that a supported operating system is running on the
remote server (see the list of supported operating systems for remote Windows servers below).

Operating Systems Supported for Monitoring Remote Windows Servers
The following operating systems are supported for monitoring remote Windows servers:
l

Windows Server 2003, 2003 R2

l

Windows Server 2008, 2008 R2

l

Windows Server 2012, 2012 R2

Tasks
How to Configure SiteScope to Monitor a Remote Microsoft Windows Server
This task describes the steps involved in configuring SiteScope to monitor data on remote Windows
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servers.
1.

Prerequisites (for Windows Server 2008, 2008 R2, 2012, and 2012 R2 remote servers)
n

Only an administrator in SiteScope, or a user granted Add, edit or delete remote servers
permissions can view or edit the Remote Servers page. For details on user permissions, see
"User Management Preferences" on page 732.

n

SiteScope supports monitoring on Microsoft Windows Server 2008/2008 R2/2012/2012 R2
remote servers with User Account Control (UAC) enabled or disabled. Where UAC is enabled,
you must make the following registry changes on the remote server so as to avoid access
issues or problems getting data on perfex monitors (such as CPU, Memory, Disk Space,
Microsoft Windows Resources, Microsoft Windows Event Log, Microsoft Windows
Performance Counter, Services, Microsoft IIS Server, Microsoft SQL Server) when using the
WMI or NetBIOS protocol.
i. Click Start, click Run, type regedit, and then press ENTER.
ii. Locate and then click the following registry subkey: HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windows\
CurrentVersion\Policies\System
iii. If the LocalAccountTokenFilterPolicy registry entry does not exist, follow these steps:
l

On the Edit menu, select New >DWORDValue.

l

Type LocalAccountTokenFilterPolicy, and then press ENTER.

iv. Right-click LocalAccountTokenFilterPolicy, and then click Modify.
v. In the Value data box, type 1, and then click OK.
vi. Exit Registry Editor.
n

2.

To remotely monitor on a Windows Server 2008 or 2012 machine, you must enable the Remote
Event Log Management exception in the Windows Firewall Settings on the remote server to
which you want to connect. Otherwise, when you try to use the session handle, the call will
result in a RPC_S_SERVER_UNAVAILABLE error.

Enable SiteScope to monitor data on remote Windows servers
To enable SiteScope to monitor data on remote Windows servers, you must perform one of the
following steps:
n

Define an individual remote Windows server connection profile for each server.
Monitoring remote Windows server data requires authenticated access to the remote server. A
Windows server connection profile provides the necessary address and login credentials for
SiteScope to log on to a remote server and to access the Windows performance registry on
that remote machine.
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To log on to a remote server using the Windows server connection profile, either:

n

o

Log on to the remote server as a user with administrator privileges, or

o

Create or modify a user account on the remote server that corresponds with the connection
method and login permissions used in the SiteScope connection profile for that server.

Set domain access privileges to permit SiteScope to access remote servers.
SiteScope for Windows automatically generates a list of servers visible in the local domain.
These servers are listed in the Servers list for monitor types where a server must be specified.
SiteScope running on Windows may be able to use this list to monitor remote Windows servers
without having to create individual connection profiles for each server.
To set domain privileges, use one of the following methods:
o

Set the SiteScope service to run as a user in the Domain Admin group.
By default, SiteScope is installed to run as a "Local System account". However, we
recommend setting the SiteScope service to log on as a user with domain administration
privileges since the "Local System account" may not have sufficient privileges (the local
system account has domain administrator user privileges in a domain environment, and
build-in administrator user privileges in a non-Domain environment). This gives SiteScope
access privileges to monitor server data within the domain.
To change the user account of the SiteScope service:
A. In Administrative Tools, open Services, and select SiteScope from the list of
services. The SiteScope Properties dialog box opens.
B. Click the Log On tab, and in the Log on as area, enter an account that can access
the remote servers.
C. Click OK to save your settings and close the SiteScope Properties dialog box.
D. Right-click SiteScope. Click Stop to stop the SiteScope service.
E. Click Start. The SiteScope service now uses the new account.

o

Add the server where SiteScope is running to the Domain Admin group in
ActiveDirectory (for Windows 2003 or later).
With this option, the SiteScope service is set to log on as a Local System account, but
the machine where SiteScope is running is added to a group having domain administration
privileges.

o

Edit the registry access permissions for all machines in the domain to enable nonadmin access.
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This option requires changes to the registry on each remote machine that you want to
monitor. This means that while the list of servers in the domain includes all machines in the
domain, only those remote machines whose registry has been modified can be monitored
without use of a connection profile.
Note: If you configure the SiteScope service to run as a domain user, SiteScope uses this
account for all Windows-related authorization. You must ensure that this account has the
necessary privileges across the domain.

3.

Configure user permissions for remote monitoring
For SiteScope to collect performance measurements on a remote Windows machine, SiteScope
must have permission to access the remote machine.
Note:
n

Microsoft Best Practice recommends giving permissions to groups instead of to users.

n

Back up the registry before making any registry changes.

To configure user permissions on the SiteScope machine:
a. On the SiteScope machine, select Start > Run. In the Open text box, enter Regedt32.exe.
The Registry Editor dialog box opens.
b. In the HKEY_LOCAL_MACHINE window, select SOFTWARE > Microsoft > Windows
NT > CurrentVersion > Perflib.
c. Click Edit in the Registry Editor tool bar and select Permissions. The Permissions for Perflib
dialog box opens.
d. In the Name pane, select the user SiteScope uses to access the remote machine. In the
Permissions pane, select the Allow check box for Read. Click OK to save the configuration
and close the Permissions for Perflib dialog box.
e. In the HKEY_LOCAL_MACHINE window, select SYSTEM > CurrentControlSet >
Control > SecurePipeServers > winreg. Click Security in the Registry Editor tool bar and
select Permissions. The Permissions for winreg dialog box opens.
f. In the Name pane, select the user that SiteScope uses to access the remote machine. In the
Permissions pane, select the Allow check box for Read. Click OK to save the configuration
and close the Permissions for winreg dialog box.
g. In the Registry Editor tool bar, click Registry and select Exit to save the configuration and
exit.
h. Restart the SiteScope machine.
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4.

Configure and test the settings for the Windows remote server
a. Configure the remote Windows server in the remote server tree. For user interface details, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on the next page.
Note:
o

If you are configuring remote Windows Servers for SSH monitoring with SiteScope,
see "How to Configure Remote Windows Servers for SSH monitoring" on page 525.

o

If WMI is selected as the connection method for gathering management data from
remote servers (in the Method field in Main Settings), the WMI service must be
configured on the remote machine. For task details, see "How to Configure the WMI
Service for Remote Monitoring" on page 489.

o

When configuring the WMI connection type method for monitoring on the localhost
machine (the machine where SiteScope is running), the User name and Password
must be left blank in the Credentials section.

o

If specifying a literal IPv6 address as the name for the remote monitored server when
using the NetBIOS connection method, the IPv6 address must be customized by:
1. Replacing any colon (":") characters with a dash ("-") character.
2. Appending the text .ipv6-literal.net to the IP address.
For example, the IPv6 address: 2004:DB8:2a:1005:230:48ff:fe73:982d
would be: 2004-DB8-2a-1005-230-48ff-fe73-982d.ipv6-literal.net
Alternatively, you can switch to the WMI connection method (where supported), and
avoid having to make changes to the IPv6 address.

b. After defining the Microsoft Windows remote server definition for SiteScope, click the Test
button for the applicable server to test the connection.
Note: If an "unable to connect to remote machine" error message opens when
trying to view remote counters, refer to the Microsoft Knowledge Base
(http://support.microsoft.com/search/).

5.

Results
The server is added to the list of remote Windows Remote servers in the remote server tree. You
can then create monitors to watch the resources and performance counters for that server.
Multiple monitors can use the same connection profile.
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Note: For information about troubleshooting and limitations of SiteScope monitoring of remote
servers, see "Tips/Troubleshooting" on page 481.

UI Descriptions
New/Edit Microsoft Windows Remote Server Dialog Box
Important
information

l

l

l

See also

You cannot delete a server from the list of remote servers if the server is
referenced by a monitor. Select a different server in the Server box of the Monitor
Settings panel for each monitor that references the remote server, and then delete
the remote server from the remote server list.
Remote server passwords support empty spaces and the following special
characters: \ " & | > < ^
When configuring a Microsoft Windows remote server in template mode, the
Method value must be entered using the same case that follows, otherwise
verification does not work properly: NetBIOS, WMI, or ssh (or SSH)

l

"Remote Server Tree" on page 40

l

"Remote Servers Properties Page" on page 539

The following elements are included:
UI Element

Description

Save

Saves the settings without verifying the correctness of the configuration on the
remote server.
Tip: Performance is faster if you use Save instead of Save & Test, because
SiteScope does not need to establish a connection to the remote server to verify
the settings.
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UI Element

Description

Save & Test

Saves the settings and verifies the correctness of the configuration on the remote
server. If SiteScope fails to connect to the remote server, or if there is an invalid
property in the configuration settings, an error message is displayed.
Tip: Performance is slower if you use Save & Test instead of Save, because
SiteScope needs to establish a connection to the remote server to verify the
settings.

General Settings
Name

Name by which the remote machine should be known in SiteScope. This name
appears in the Server list of monitors that can use this connection profile.
Note when working in template mode:
l

l

Description

For each template monitor that requires this remote server, you must enter this
same value in the Servers box for the template monitor.
Names must be unique, otherwise the deployment fails.

Description for the remote Windows server. This text appears only when editing
the remote's properties.

Main Settings
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UI Element

Description

Server

Real IP address or UNC name of the monitored Windows server. Network address
translation (NAT) is not supported for SiteScope monitors that require a remote
host definition. SiteScope is unable to determine if an external (real IP) or internal
IP (NAT) is used when you configure a monitor with an IP address or host. To
monitor servers in a NAT environment, we recommend placing SiteScope inside
the firewall. Virtual IPs can be used in monitors which do not collect host specific
information, such as in the URL monitor or other similar monitors.
An IP host name also works if the SiteScope server can translate this common
name into an IP address by using a hosts file, DNS, or WINS/DNS integration.
You can create multiple remote servers for the same host machine. For example,
you can create one remote server that uses the NetBIOS protocol and another that
uses WMI for the same host machine, provided the name in General Settings is
unique.
To use the same login credentials to configure multiple servers at the same time,
enter the server names or addresses separated by a comma (","), semicolon (";"),
or a space. For example, \\server1,\\server2,\\.
Note: In the list of Windows Remote Servers, click the Test
connectivity after the profiles have been added.

button to test

Note when working in template mode: Name of a template variable that
represents the remote server name, for example, %%host%%. This enables you to
add each server as you deploy the template when asked to enter the required
information for the variables. Each time you enter a server name for the variable, a
monitor instance is created for that server and the server is added to the remote
server tree. If the host name does not match a server name at that time, the
monitor fails.
If the remote servers onto which you want to deploy monitor templates already
exist under Remote Servers, you can reference these servers within the monitor
template. You do this by referencing the system variable $$SERVER_LIST$$
which identifies the servers accessible to the SiteScope. For details, see "Syntax
for System Variables" on page 791.
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UI Element

Description

Credentials

Option for providing the user name and password for the remote Windows server:
Use user name and password. Select this option to manually enter user
credentials.

l

l

Trace

n

User name. Enter the user name for the remote server or use a template
variable that represents the user login name (for example, %%user%%).
Note: If the server is within the same domain as the SiteScope machine,
include the domain name in front of the user login name. For example:
<DOMAIN>\<username>. If using a local machine login account for machines
within or outside the domain, include the machine name in front of the user
login name. For example: <machinename>\<username>.

n

Password. Enter the password for the remote server or the passphrase for
the SSH key file, or use a template variable that represents the password (for
example, %%password%%). When using SSH authentication with public/private
key based authentication enter the passphrase for the identity file here.
Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the server
(selected by default). Select the credential profile to use from the Credential
profile drop-down list, or click Add Credentials and create a new credential
profile. For details on how to perform this task, see "Credential Preferences" on
page 561.

Traces messages to and from the subject server, and records them in the
SiteScopeRunMonitor.log file.
Default value: Not selected
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UI Element

Description

Method

Connection types for monitoring Windows server resources:
l

NetBIOS. The default server-to-server communication protocol for Microsoft
Windows networks.
Note:SiteScopes running on Windows platforms need to be running under an
account that has the necessary administrative security privileges to access
performance counter data from remote servers when the NetBIOS connection
is used and the Trace option is selected. If the servers you want to monitor are
in a different domain, are governed under a different policy, or require a unique
login different than the account SiteScope is running under, then you must
define the connection to these servers under the Microsoft Windows Remote
Servers option in the remote server view.

l

l

SSH. Secure Shell, a more secured communication protocol that can be
installed on Microsoft Windows networks. This connection method normally
requires installing SSH libraries on each server to be connected, unless you are
using agentless Windows SSH. For the list of monitors that support Windows
SSH (agentless or using the SiteScope remote Windows SSH files), see
"Monitors Supporting Windows SSH (Agentless or Using the SiteScope
Remote Windows SSH Files)" on page 520. For more information on SSH
requirements, see "Configure Remote Monitoring Using Secure Shell (SSH)"
on page 516.
WMI. Windows Management Instrumentation, a more secured communication
protocol than NetBIOS, supports Windows server monitors that use perfmon to
gather performance data. For the list of monitors that support WMI and details
on how to configure the WMI service for remote monitoring, see "Configure the
WMI Service for Remote Windows Monitoring" on page 488.
Note:

Remote
server
encoding

n

Remote servers that have been configured with the WMI method are not
displayed in the list of available remote servers when configuring a monitor
that does not support WMI.

n

When configuring the WMI connection type method for monitoring Windows
server resources on the localhost machine (the machine where SiteScope is
running), the User name and Password must be left blank in the
Credentials section.

Encoding for the remote server, if the remote server is running an operating system
version that uses a different character encoding than the server on which
SiteScope is running. This enables SiteScope to display encoded content
correctly.
Default value: Cp1252 encoding
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UI Element

Description

Advanced Settings
SSH port
number

Port on which the remote SSH server is listening.

Connection
limit

Number of open connections that SiteScope permits for this remote. If there are
many monitors configured to use this connection, set the number of open
connections high enough to relieve a potential bottleneck.

Default value: 22

Default value: 3
Note: This setting does not effect running tests for a remote server. Tests always
create a new connection.
Disable
connection
caching

Turns off connection caching for this remote. By default, SiteScope caches open
connections.
Default value: Not selected

SSH
Authentication method to use for SSH connections:
authentication
l
Password. Authenticates using a password (default setting).
method
l

Key File. Authenticates using public/private key authentication. When this
option is selected SiteScope uses the private key in the file
<SiteScope root directory>\groups\identity to authenticate. The
corresponding public key must be listed in the authorized_keys file on the
remote host.

For information about SSH requirements, see "Configure Remote Monitoring Using
Secure Shell (SSH)" on page 516.
Key file for
SSH
connections

Path and name of the file that contains the private key for this connection. The
default key file is <SiteScope root directory>\groups\identity. This setting
applies only when the authentication method is Key File.

SSH version
2 only

Forces SiteScope to use SSH protocol version 2 only.

SSH keep
alive
mechanism

Engages a keep alive mechanism for SSH version 2 sessions. This option applies
only when using the integrated Java Client. SSH keepalive packets are sent every
55 seconds.

Default value: Not selected

Default value: Not selected
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UI Element

Description

SSH using
preinstalled
SiteScope
remote
Windows
SSH files

Uses preinstalled SiteScope remote Windows SSH files. For the list of monitors
that support Windows SSH using SiteScope SSH files, see "Monitors Supporting
Windows SSH (Agentless or Using the SiteScope Remote Windows SSH Files)"
on page 520.
Default value: Selected

Search/Filter Tags
Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created
for the SiteScope, this section appears but is empty. If tags have been created,
they are listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Other Related UI Pages: "Remote Servers Properties Page" on page 539

Tips/Troubleshooting
This section describes troubleshooting and limitations when working with remote servers.
l

"General Issues Monitoring Windows Remote Servers" on the next page

l

"Recommended Network Settings for Monitoring Windows Servers" on the next page

l

"Understanding Error Codes When Testing Windows Remote Servers" on page 483

l

"Microsoft Windows Event Log Access on Remote Windows Servers" on page 483

l

"Viewing Data Returned when SiteScope is Trying to Access the Remote Registry" on page 484

l

l

l

"System Encoding Used When Displaying System Resources for Remote Hosts Connected
Through NETBIOS" on page 486
"SiteScope Uses the Wrong Credentials for Remote Windows Connections Using Perfex" on page
486
"Perfex-Based Monitors Fail When Selecting a Remote Server Using the Browse Servers Button"
on page 486

l

"Perfex-Based Monitors Fail with Error 1219" on page 487

l

"WMI Issues" on page 487
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Troubleshooting/Limitations
General Issues Monitoring Windows Remote Servers
The following is additional information relating to setting up and troubleshooting SiteScope monitoring
of remote Windows servers.
l

l

l

l

l

Connect to the remote machine using PERFMON. If a connection cannot be made using this tool,
there is probably a problem with the user access permissions granted to the SiteScope account on
the remote server. SiteScope requires certain administrative permissions to be able to monitor
server statistics.
If multiple Windows remote servers are configured for the same host machine using the NetBIOS
method, the connection fails. This is because Windows does not permit multiple connections to a
server or shared resource by the same user, using more than one user name (System error 1219).
For security reasons, SiteScope may not be permitted to use the permissions of a full administrator
account. SiteScope can be granted restricted monitoring access by editing certain Windows
Registry Keys. For information about restricting access to the registry from a remote machine, refer
to the Microsoft Knowledge Base (http://support.microsoft.com/kb/q153183/).
When you need to monitor a server which is a standalone server or not part of a domain already
visible to the SiteScope server, try entering the machine name followed by a slash and then the
login name in the Login box. For example, loneserver\sitescope.
To remotely monitor a Windows Server 2008 or 2012 machine, you must enable the Remote Event
Log Management exception in the Windows Firewall Settings on the remote server to which you
want to connect. Otherwise, when you try to use the session handle, the call will result in a RPC_
S_SERVER_UNAVAILABLE error.
Note:
n

For additional information on how to secure performance data in Windows operating systems,
refer to the Microsoft Knowledge Base (http://support.microsoft.com/kb/q146906/).

n

For information about troubleshooting performance monitor counter problems, refer to the
Microsoft Knowledge Base (http://support.microsoft.com/kb/152513/).

Recommended Network Settings for Monitoring Windows Servers
When monitoring Windows-based servers, it is recommended to disable NetBIOS over TCP/IP on
networks where WINS in not enabled to avoid network-related errors such as "System error: 53 - The
network path was not found".
1. Open Network Connections.
2. Right-click the network connection you want to configure, and then click Properties.
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3. On the General tab, click Internet Protocol (TCP/IP), and then click Properties.
4. Click Advanced, click the WINS tab, and then select the Disable NetBios over TCP/IP option.

Understanding Error Codes When Testing Windows Remote Servers
Problem:
In the remote server test results, the status string does not contain descriptive error codes.
Resolution:
Use the net helpmsg command to help explain Windows network messages and provide problemsolving information.
Run the following:
net helpmsg <error code number>
For example, entering net helpmsg 53 returns "The network path was not found."

Microsoft Windows Event Log Access on Remote Windows Servers
Problem:
When viewing Remote Windows event logs or getting alerts relating to monitoring a remote Windows
machine, the following message is displayed:
"The description for Event ID ( XXXX ) in Source ( XXXX ) could not be found. It
contains the following insertion string(s):
The operation has completed successfully."

Cause:
If the required registry keys (and referenced files) are not present on the remote computer, SiteScope is
unable to format the data when viewing the event log on a computer from a remote computer; hence it
displays the data in a generic format.
Resolution:
The required registry entries and DLL files must be copied to the remote computer on which the event
viewer application is being run.
To get the remote registry entries and DLL files onto the local SiteScope machine:
1. Locate on the remote machine which event you are not getting properly in SiteScope by finding the
entry in the Event Viewer. Write down the information for the source, event id, and description. For
example:
Source: MSExchangeSA, Event ID: 5008, Description: The message tracking log file
C:\exchsrvr\tracking.log\20020723.log was deleted.
2. Open the registry setting HKEY_LOCAL_
MACHINE\System\CurrentControlSet\Services\EventLog
\Application and click the source (for example, MSExchangeSA).
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3. Click EventMessageFile and write down the data for where that DLL is located (for example,
C:\EXCHSRVR\bin\madmsg.dll).
4. Locate the DLL on the remote and copy it to the SiteScope machine. You can perform the copy in
one of two ways:
n

Use the Initlog.exe utility, in the BackOffice Resource Kit, Second Edition, to copy the required
registry entries from the Exchange Server computer to the remote computer. This utility can also
copy the required DLL files if you are logged on to Windows with an account that has
Administrator privilege on the Exchange Server computer (see Microsoft Article Q184719).

n

Use FTP, mail, and so forth, to get the file to your local drive.

5. SiteScope uses the data from the EventMessageFile field in step 3 to determine where to find the
DLL on the local machine. You must create the same folder structure as in this step and place the
file in that directory.
Alternatively, you can change the directory structure to say c:\Windows\System32 (SiteScope
looks in the ADMIN$ by default on the remote machine), and places the DLL in that folder, but you
must have this structure and the DLL on both machines. If you do this, you must update the
registry in step 3 to reflect the directory in which the DLL is located.

Viewing Data Returned when SiteScope is Trying to Access the Remote Registry
Use the following steps to view that data is being returned when SiteScope is trying to access the
remote registry:
1. Open a command window on the SiteScope server.
2. Change the directory to <SiteScope root directory>\tools.
3. Enter the following in a command line:
perfex \\MACHINE -u username -p password -d -elast "Application"
This command gives you the number of entries in your Application log. For example:

4. List only the last 10 or 12 events to find the one you are looking for. For this example, the
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command is:
perfex \\MACHINE -u username -p password -d -elog "Application" 2355 | more
5. Look through each entry until you find the one you need. Note the Record id for easier searching
next time when using the command in Step 3.
6. This output tells you what data SiteScope is receiving. In the example given, the following is an
example of the data that typically would be returned:
Type: Information
Time: 02:00:24 08/01/102
Source: MSExchangeMTA
ID: 298
Category: 1
Record: 2342
Machine: EX-SRV
FILE=C:\EXCHSRVR\res\mtamsg.dll
REMOTE FILE=
String 835050d is: MTA
Next String 835054d is: OPERATOR
Next String 83505dd is: 34
Next String 835060d is: 0
Next String 835062d is:
File: C:\EXCHSRVR\res\mtamsg.dll
Remote Path:
calling FormatMessage()
Formatted Message 142 bytes long
Raw message is: The most current routing information has been loaded by the
MTA, and a text copy was saved in the fileGWART0.MTA. [MTA OPERATOR 34 0]
(12) Message: The most current routing information has been loaded by the
MTA, and a text copy was saved in the file GWART0.MTA.[MTA OPERATOR 34 0]
(12)
The file path is where the remote file is being found. If you copy the DLL to the
WINDOWS\SYSTEM, the file and remote file path like this:
Type: Information
Time: 03:15:00 08/01/102
Source: MSExchangeIS Public
ID: 1221
Category: 6
Record: 2350
Machine: EX-SRV
FILE=C:\WINNT\SYSTEM32\mdbmsg.dll
REMOTE FILE=\\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dll
String 835054d is: 0
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Next String 835056d is:
File: C:\WINNT\SYSTEM32\mdbmsg.dll
Remote Path: \\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dll
LOADING LIB REMOTE: \\ex-srv\ADMIN$\SYSTEM32\mdbmsg.dllcalling
FormatMessage()Formatted Message 89 bytes long
Raw message is: The database has 0 megabytes of free spaceafter online
defragmentation has terminated.Message: The database has 0 megabytes of free
space afteronline defragmentation has terminated.

System Encoding Used When Displaying System Resources for Remote Hosts Connected
Through NETBIOS
This limitation affects all server monitors that use encoding of the remote host to display received data.
SiteScope uses default system encoding when displaying system resources information for the remote
hosts connected through NETBIOS. The Remote server encoding field (available in the remote
server's Main Settings) is not used. For example, if system encoding is ASCII and remote encoding is
Unicode, the ASCII characters are displayed correctly and the Unicode symbols are not supported.

SiteScope Uses the Wrong Credentials for Remote Windows Connections Using Perfex
Problem:
SiteScope ignores the credentials provided for specific remotes and tries to run monitoring commands
and actions for perfex-based monitors (such as CPU, Memory, and Windows monitors) using
credentials that are used to start the SiteScope service.
Resolution:
For perfex-based monitors to work correctly with Windows remote servers, you must add optionalSetupConnection to Perfex options in Preferences > Infrastructure Preferences >
Monitor Settings, or to the _perfexOptions= property in the <SiteScope root
directory>\groups\master.config file. Use a single space as a separator if other strings have already
been added to this property.
For example:
_perfexOptions=-wrmUiTimeout 300 -optionalSetupConnection
Note: When the SiteScope service user has no network permissions and -optionalSetupConnection
is set, the connection method will be at the host level instead of process level for file-based monitors
(File, Directory, Log File).

Perfex-Based Monitors Fail When Selecting a Remote Server Using the Browse Servers
Button
Problem:
When using the Browse Servers button in monitor properties, all perfex-based monitors (such as
CPU, Memory, and so forth) fail.
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Resolution:
1. Create a new credential profile for the SiteScope service in Preferences > Credential
Preferences (for example, named Service).
2. Enter the credential name (Service) in the Default credentials name field in Preferences >
Infrastructure Preferences > Server Settings.
3. Restart SiteScope.

Perfex-Based Monitors Fail with Error 1219
If you encounter Error 1219 (session credentials conflict) when using perfex-based monitors (such as
CPU, Memory, Service, and so forth), add the property -ignoreError1219 to Perfex options in
Preferences > Infrastructure Preferences > Monitor Settings, or to the _perfexOptions= property
in the <SiteScope root directory>\groups\master.config file.
When this option is used and perfex encounters Error 1219, the monitor ignores the error and
reestablishes the already active connection using credentials that this connection is using.

WMI Issues
For tips and troubleshooting for WMI issues, see "Configure the WMI Service for Remote Windows
Monitoring" on page 488
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You can use SiteScope to monitor data on remote Windows servers using Windows Management
Instrumentation (WMI). WMI is a more secure communication method than NetBIOS for gathering
management data from remote servers running on Windows servers.
Using WMI, you can access system counter data from objects in the performance libraries. This is the
same performance data that appears in the Perfmon utility.

Learn About
Monitors Supporting WMI
The following is a list of the monitors that support the WMI method for collecting data.
l

Citrix Monitor

l

ColdFusion Server Monitor

l

CPU Monitor

l

Disk Space Monitor (Deprecated)

l

Dynamic Disk Space Monitor

l

Memory Monitor

l

Microsoft Lync Server 2010 Monitors (Microsoft A/V Conferencing Server, Microsoft Archiving
Server, Microsoft Director Server, Microsoft Edge Server, Microsoft Front End Server, Microsoft
Mediation Server, Microsoft Monitoring and CDR Server, and Microsoft Registrar Server)

l

Microsoft ASP Server Monitor

l

Microsoft Hyper-V Monitor

l

Microsoft IIS Server Monitor

l

Microsoft SQL Server Monitor

l

Microsoft Windows Event Log Monitor

l

Microsoft Windows Media Server Monitor
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l

Microsoft Windows Resources Monitor

l

Microsoft Windows Services State Monitor

l

Real Media Server Monitor

l

Service Monitor

Tasks
How to Configure the WMI Service for Remote Monitoring
This task describes the steps involved in configuring SiteScope to monitor data on remote Windows
servers using WMI. For the list of monitors that support the WMI protocol, see "Monitors Supporting
WMI" on the previous page.
Note: This task is part of a higher-level task. For details, see "Configure SiteScope to Monitor
Remote Windows Servers" on page 470.
1. Prerequisites
SiteScope must be installed on a Windows machine.
2. Configure the WMI service on the remote server
The following are requirements for using SiteScope to collect performance measurements on a
remote machine using WMI:
n

The WMI service must be running on the remote machine. For details, refer to the Windows
Management Instrumentation documentation (http://msdn.microsoft.com/enus/library/aa826517(VS.85).aspx).

n

The user entered on the WMI remote server must have permissions to read statistics remotely
from WMI namespace root\CIMV2. For details, refer to
http://support.microsoft.com/kb/295292.

n

The monitoring user must be added to the Performance Monitor Users group on the target
server, and have DCOM remote launch and activation permissions (see
http://msdn.microsoft.com/en-us/library/Aa393266.aspx).

For information about troubleshooting WMI service problems, see "Tips/Troubleshooting" on the
next page.
3. Configure WMI preference settings in SiteScope - optional
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You can configure the connection type for monitoring Windows server resources on the local host
machine and the WMI timeout settings in Preferences > General Preferences > WMI
Preferences. For user interface details, see "WMI Preferences" on page 586.
4. Configure a monitor
Add a WMI supported monitor, and configure the monitor settings.
Note: When configuring the WMI connection type method for monitoring Windows server
resources on the localhost machine (the machine where SiteScope is running), the User
name and Password must be left blank in the Credentials section.

Tips/Troubleshooting
WMI Limitations
It is not recommended to have more than 4000 monitors using WMI.
When a counter or object is shared between resources, SiteScope is unable to receive data for the
counters and the query fails. If other counters are referenced in the same query, they also fail to receive
data. For details and troubleshooting information, refer to http://support.microsoft.com/kb/836802.

WMI Fails to Retrieve Counters
In some cases, WMI shows n/a for counters while perfmon gives the value 0 for the same counters.
This is the behavior for counters that are also not selectable using the perfmon utility. The reason that
perfex can get values for these counters is that it bypasses perfmon and accesses them through the
registry.

WMI Data Not Synchronized
WMI data relies on being synchronized with the Perfmon utility. If WMI data is not synchronized,
perform the following:
1. Check that the WMI service is started on the target machine. For details, refer to
http://msdn.microsoft.com/en-us/library/aa826517(VS.85).aspx.
2. Check that the namespace root\CIMV2 is configured to enable remote access to the user
specified in the SiteScope WMI remote server. For details, refer to
http://support.microsoft.com/kb/295292.
3. On the target machine, run the command perfmon and verify that the required perfmon objects
appear. For details, refer to http://msdn.microsoft.com/en-us/library/aa645516(VS.71).aspx.
For details on how to rebuild these libraries, refer to http://support.microsoft.com/?kbid=300956.
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4. On the target machine, run the command perfmon /wmi and verify that the required perfmon
objects appear. For details, refer to http://msdn.microsoft.com/en-us/library/aa645516
(VS.71).aspx.
If the required perfmon objects do not appear, run the command perfmon wmiadap /f. For details,
refer to http://msdn.microsoft.com/en-us/library/aa394528(VS.85).aspx.
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UNIX Remote server options are used to set up the connection properties, such as credentials and
protocols, so that SiteScope can monitor systems and services running in remote environments. You
can then create monitors to watch the resources and performance counters for that server. Multiple
monitors can use the same connection profile. You can also create multiple remote servers for the
same host machine.
Tip: You can use SiteScope UNIX operating system adapters to extend SiteScope to connect to,
and remotely monitor versions of UNIX that are not supported by default. For details, see "Extend
UNIX Monitoring Using Operating System Adapters" on page 502.

To access
Select the Remote Servers context. In the remote servers tree, click the UNIX Remote Servers
container.

Learn About
UNIX Remote Server Overview
SiteScope can monitor systems and services running on remote UNIX servers for certain statistics
(such as CPU, Disk Space, Memory, and Processes) without the installation of agent software on
each server. Select the servers to display when configuring UNIX monitors. SiteScope creates a new
remote connection profile for each server address in the list.

Tasks
How to Configure SiteScope to Monitor a Remote UNIX Server
This task describes the steps involved in configuring SiteScope to monitor data on remote UNIX
servers.
1. Enable SiteScope to monitor data on remote UNIX servers
n

Only an administrator in SiteScope, or a user granted Add, edit or delete remote servers
permissions can view or edit the Remote Servers page. For details on user permissions, see
"User Management Preferences" on page 732.
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n

Monitoring remote UNIX server data requires authenticated access to the remote server. A
UNIX server connection profile provides the necessary address and login credentials for
SiteScope to log on to a remote server.
To log on to a remote server using the UNIX server connection profile, either:
o

Log on to the remote server as a user with administrator privileges, or

o

Create or modify a user account on the remote server that corresponds with the connection
method and login permissions used in the SiteScope connection profile for that server.

You need to define an individual remote UNIX server connection profile for each remote UNIX
server you want SiteScope to monitor.
2. Configure and test the settings for the UNIX remote server
a. Configure the remote UNIX server in the remote server tree.
b. Test the settings for the applicable server.
o

Click the Test

button to test the connection to the server.

o

Click the Detailed Test
button to test the running commands on the remote host and
check the permissions for the defined user.

3. Results
The server is added to the list of UNIX Remote Servers in the remote server tree. You can then
create monitors to watch the resources and performance counters for that server. Multiple
monitors can use the same connection profile.

Note: For information about troubleshooting and limitations of SiteScope monitoring of remote
servers, see "Tips/Troubleshooting" on page 501.
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How to Configure SiteScope to Monitor Secure Shell (SSH) Login on Sun Fire ILOM X64
Servers
This task describes the steps involved in configuring SiteScope to monitor SSH login on Sun Fire ILOM
X64 remote servers.
1. Create a Sun Fire X64 ILOM remote server.
Select Remote Servers > New UNIX Remote Server, and configure a remote server with the
following settings:
n

n

Main Settings:
o

Operating system: Sun Fire X64 ILOM

o

Method: SSH

Advanced Settings:
o

Disable connection caching: Selected. This turns off connection caching for this remote.

For additional details on configuring SiteScope to monitor data on remote UNIX servers, see the
task above.
2. Create a Script monitor as described in Script Monitor in the SiteScope Monitor Reference Guide,
and select the following:
n

Server: Select the Sun Fire X64 ILOM remote server configured in the previous step.

n

Remote script command file: sun-ilom.txt.

3. Save and run the monitor.
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UI Descriptions
New/Edit UNIX Remote Server Dialog Box
Important
information

l

l

l

l

See also

You cannot delete a remote server from the list of remote servers if the server is
referenced by a monitor. Select a different server in the Server box of the Monitor
Settings panel for each monitor that references the remote server, and then delete
the remote server from the remote server list.
The HTTP method for connecting to a remote server is no longer supported.
Remote server passwords support empty spaces and the following special
characters: \ " & | > < ^
When configuring a remote server in template mode, the Method and Operating
system values must be entered using the same case that is displayed below,
otherwise verification does not work properly:
n

Method. telnet, http, rlogin, or ssh

n

Operating System. AIX, CentOSLinux, FreeBSD, HP, HP-UX, HP64, Linux,
MacOSX, OPENSERVER, RHESLinux, SCO, SGI, Sun, SunOS, ILOM,
Tru64, Tru64_4.x, UbuntuLinux.

l

"Remote Server Tree" on page 40

l

"Remote Servers Properties Page" on page 539

The following elements are included:
UI Element

Description

Save

Saves the settings without verifying the correctness of the configuration on the
remote server.
Tip: Performance is faster if you use Save instead of Save & Test, because
SiteScope does not need to establish a connection to the remote server to verify
the settings.

Save & Test

Saves the settings and verifies the correctness of the configuration on the remote
server. If SiteScope fails to connect to the remote server, or if there is an invalid
property in the configuration settings, an error message is displayed.
Tip: Performance is slower if you use Save & Test instead of Save, because
SiteScope needs to establish a connection to the remote server to verify the
settings.
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UI Element

Description

General Settings
Name

Name by which the remote machine should be known in SiteScope. This name
appears in the Server list of monitors that can use this connection profile.

Description

Description for the remote UNIX server. This text appears only when editing the
remote's properties.

Main Settings
Server

Real IP address or host name of the monitored server. Network address translation
(NAT) is not supported for SiteScope monitors that require a remote host definition.
SiteScope is unable to determine if an external (real IP) or internal IP (NAT) is used
when you configure a monitor with an IP address or host. To monitor servers in a
NAT environment, we recommend placing SiteScope inside the firewall. Virtual
IPs can be used in monitors which do not collect host specific information, such as
in the URL monitor or other similar monitors.
To use the same login credentials to configure multiple servers at the same time,
enter the server names or addresses separated by a comma (","), semicolon (";"),
or a space.
Example: If using NetBIOS to connect to other servers, enter a comma-separated
string of server addresses such as:
serveraddress1,serveraddress2,serveraddress3
When completing the other required entries on the form, SiteScope creates a new
remote connection profile for each server address in the list.
Note: To test connectivity after the host is added, click the Test
button in the
table listing the UNIX Servers. This tests only the connection to the server. Click
the Detailed Test
button to run a test that displays the result of running
commands on the remote host. This enables checking the permissions for the
defined user.
Note when working in template mode: Enter the name of a template variable
that represents the remote server name, for example, %%host%%. Each time you
enter a server name for the variable, a monitor instance is created for that server
and the server is added to the remote server tree.
If the remote servers onto which you want to deploy monitor templates already
exist under Remote Servers, you can reference these servers within the monitor
template. You do this by referencing the system variable $$SERVER_LIST$$
which identifies the servers accessible to the SiteScope. For details, see "Syntax
for System Variables" on page 791.
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UI Element

Description

Credentials

Option for providing the user name and password for the remote UNIX server:
Use user name and password. Select this option to manually enter user
credentials.

l

l

Trace

n

User name. Enter the user name for the remote server or use a template
variable that represents the user login name (for example, %%user%%).

n

Password. Enter the password for the remote server or the passphrase for
the SSH key file, or use a template variable that represents the password (for
example, %%password%%). When using SSH authentication with public/private
key based authentication enter the passphrase for the identity file here.
Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the server
(selected by default). Select the credential profile to use from the Credential
profile drop-down list, or click Add Credentials and create a new credential
profile. For details on how to perform this task, see "Credential Preferences" on
page 561.

Traces messages to and from the remote server in the RunMonitor.log file.
Default value: Not selected

Operating
system

Operating system that is running on a remote server. This is required so that the
correct information can be obtained from that server. Select an operating system
from the list.
The following operating systems are supported when defining UNIX remote
servers: AIX, CentOS, FreeBSD, HP iLO, HP-UX, HP/UX, HP/UX64-bit, Linux,
MacOSX, NonStopOS, OPENSERVER, Red Hat Enterprise Linux, SCO, SGI
Irix, Solaris Zones, Sun Fire X64 ILOM, Sun Solaris, SunOS, Tru64 5.x,Tru64 Pre
4.x (Digital), and Ubuntu Linux. For servers running versions of UNIX which are not
included in the list, see "Extend UNIX Monitoring Using Operating System
Adapters" on page 502.
Note:
l

l
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UI Element

Description

Method

Connection types for monitoring UNIX server resources:
l

l

Rlogin. Logs in to the remote server using the Rlogin protocol. You can set up
your remote servers to require a password for rlogin, or to enable access
without a password (like "rsh"). SiteScope supports either case.
SSH. Logs in to the remote server using Secure Shell, a more secured
communication protocol. This may require additional software and setup
depending on the version of UNIX.
For Solaris, using the SSH access method requires that an SSH client is
installed on the SiteScope machine and the SSH server installed on the servers
you are monitoring. The path to the SSH client on the machine where
SiteScope is running should be /usr/local/bin/ssh or /usr/bin/ssh. For
information about SSH requirements, see "Configure Remote Monitoring Using
Secure Shell (SSH)" on page 516.
Using SSH requires that digital certificates be installed on each of the servers
to which you are connecting.

l

Telnet. Logs in to the remote server using Telnet. Telnet is a popular method for
connecting to remote UNIX servers. You can set up your remote servers to
require a password for telnet, or to enable access without a password (like
"rsh"). SiteScope handles either case.

Prompt

Prompt output when the remote system is ready to handle a command.

Login prompt

Prompt output when the system is waiting for the login to be entered.

Password
prompt

Prompt output when the system is waiting for the password to be entered.

Secondary
prompt

Secondary prompts if the telnet connection to the remote server causes the remote
server to prompt for more information about the connection. Separate multiple
prompt string by commas (,).
Example: For Telnet connections to some remote servers, the remote server may
ask what terminal type should be emulated for the connection. In this case, enter
Terminal type? as the secondary prompt. The response to the secondary prompt
is entered in the Secondary Response box below.

Mask
secondary
response

Hides the secondary response behind asterisks. If you subsequently clear the
check box, the hidden data is deleted.

Secondary
response

Responses to any secondary prompts required to establish connections with this
remote server. Separate multiple responses with commas (,).
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UI Element

Description

Initialize shell
environment

Shell commands to be run at the beginning of the session. Separate multiple
commands with a semicolon (;). This option specifies shell commands to be run on
the remote machine directly after a Telnet or SSH session has been initiated.
These commands can be used to customize the shell for each SiteScope remote.
Some examples include:
l

l

The remote shell may not have the correct path set for SiteScope scripts to run.
The following command adds the directory /usr/local/bin into the PATH of the
current shell on the remote machine: export PATH=$PATH:/usr/local/sbin
The remote shell may not be initializing the pseudo terminal correctly. Enter the
following command to increase the terminal width to 1024 characters: stty
cols 1024;${SHELL}

Note: Commands after a shell invocation are not run.
l

l

l

Remote
server
encoding

There have been cases where the remote Telnet Server does not echo back the
command line properly. This may cause strange behavior for monitors that rely
on this behavior. Enter the following command to force the remote terminal to
echo: stty echo
Certain UNIX shells have been known to behave erratically with SiteScope.
This includes bash, ksh, and csh. Enter the following command to change the
shell to sh for the SiteScope connection: /bin/sh
To enable the UNIX Resources monitor to retrieve Network Interface object
counters when monitoring a remote Solaris server, you need to enter the
following command: /bin/bash. This enables the monitor to get counters for
vnet*, eri*, qfe*, ce*, bge*, xge*, and e1000g* network adapters (NICs).

Encoding for the remote server if the remote server is running an operating system
version that uses a different character encoding than the server on which
SiteScope is running. This enables SiteScope to display encoded content
correctly.
Default value: Cp1252 encoding

HP NonStop Shell Settings
Shell choice
prompt

(For NonStopOS only) Prompt output when the system is waiting for the shell to be
selected.
Default value: >

Shell name

(For NonStopOS only) Shell name to be executed.
Default value: OSS

Advanced Settings
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UI Element

Description

SSH port
number

Port on which the remote SSH server is listening.

Connection
limit

Number of open connections that SiteScope permits for this remote. If there are
many monitors configured to use this connection, set the number of open
connections high enough to relieve a potential bottleneck.

Default value: 22

Default value: 3
Note: This setting does not effect running tests for a remote server. Tests always
create a new connection.
SSH
Authentication method used for SSH connections:
authentication
l
Password. Authenticates using a password (default setting).
method
l

Disable
connection
caching

Key File. Authenticates using public/private key authentication. When this
option is selected, SiteScope uses the private key in the file
<SiteScope root directory>\groups\identity to authenticate. The
corresponding public key must be listed in the authorized_keys file on the
remote host. For information about SSH requirements, see "Configure Remote
Monitoring Using Secure Shell (SSH)" on page 516.

Turns off connection caching for this remote. By default, SiteScope caches open
connections.
Default value: Not selected
Note: This option must be selected for Sun Fire X64 ILOM. All other types of
remotes works fine with caching.

Key file for
SSH
connections

Path and name of the file that contains the private key for this connection. The
default key file is <SiteScope root directory>\groups\identity. This setting
applies only when the authentication method is Key File.

SSH version
2 only

Forces SiteScope to use SSH protocol version 2 only.

SSH keep
alive
mechanism

Engages a keep alive mechanism for SSH version 2 sessions. This option applies
only when using the integrated Java Client. SSH keepalive packets are sent every
55 seconds.

Default value: Not selected

Default value: Not selected

Search/Filter Tags
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UI Element

Description

<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created
for the , this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "How to Filter the View Using Search/Filter Tags" on page
76.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.

Other Related UI Pages: "Remote Servers Properties Page" on page 539

Tips/Troubleshooting
Troubleshooting Remote UNIX Servers
l

Remote UNIX Servers Not Configured for an English Locale
Problem: The File monitor and Directory monitor may fail when using UNIX remote servers that are
not configured by default for an English locale or language.
Resolution: Add "LANG=C; export LANG" to the Initialize shell environment property of the
problematic UNIX remote server.

l

UNIX Resources Monitor Not Getting all Counters For a Non-English Locale
Problem: The UNIX Resources monitor is unable to get counters for file systems or inode cache
objects when monitoring a UNIX remote server running on a Linux operating system with a nonenglish locale.
Resolution: Enter export LANG=en_EN.UTF-8 in the Initialize shell environment field for the
UNIX remote server.
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You can use SiteScope UNIX operating system adapters to extend SiteScope to connect to, and
remotely monitor other UNIX platforms, in addition to those supported by default. This is done by
configuring an adapter file to support the particular UNIX platform you want to monitor.

Learn About
UNIX Adapters Provided with SiteScope
SiteScope uses adapter files to describe the commands that are needed to retrieve a variety of system
resource information from servers running different platforms of the UNIX operating system. These
adapter files are written in plain text and are stored in the <SiteScope root directory>/templates.os
directory. For a list of the default UNIX adapters that are provided with SiteScope, see "UNIX Adapters
Provided with SiteScope" above.
You can modify existing adapter files to adjust for specific system requirements in your environment, or
you can create your own adapter files.
The default UNIX adapters that are provided with SiteScope, include:
Filename

Description

AIX.config

Adapter file for IBM AIX

CentOS.config

Adapter file for CentOS Linux

Digital.config

Adapter file for Digital Tru64 UNIX (Pre 4.x)

FreeBSD.config

Adapter file for FreeBSD 3.x

HP.config / HP-UX.config

Adapter file for Hewlett-Packard HP/UX

HP64.config

Adapter file for Hewlett-Packard HP/UX 64-bit

ILO.config

Adapter file for Hewlett-Packard Integrated Lights-Out

Linux.config

Adapter file for Linux (Red Hat and others)

MacOSX.config

Adapter file for Apple MacIntosh OS X

NonStopOS.config

Adapter file for Hewlett-Packard NonStop Operating System

OPENSERVER.config

Adapter file for SCO OpenServer
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Filename

Description

RedHatEnterpriseLinux.config

Adapter file for Red Hat ES Linux

SCO.config

Adapter file for SCO UNIXWare

SGI.config

Adapter file for Silicon Graphics Irix

Sun.config / SunOS.config

Adapter file for Sun Microsystems Solaris

Tru64.config

Adapter file for Compaq Tru64 UNIX 5.x

Ubuntu.config

Adapter file for Ubuntu Linux

Adapter File Format
Each UNIX platform supported for remote monitoring by SiteScope has an adapter file in the
<SiteScope root directory>/templates.os directory. These files use SiteScope's standard setting file
format.
The first group of settings (those settings before the first # sign line) describe the platform:
id=yourPlatform
name=your Platform Name

The id is theSiteScope internal ID for the OS. This ID must be unique, contain no spaces, and can be
alphanumeric.
Tip: We recommend that you use the name of the adapter file as the ID name. For example, if the
name of your adapter file is linux.config, your ID would be linux.
The name is the name you want displayed in the Operating system drop-down list when adding or
editing remote servers.
The rest of the template file contains groups of settings representing a single command, separated by a
line of # characters. For example, the following settings represent the disk space command:
id=disks
command=/usr/bin/df -k
mount=6
name=1

where:
id=disks is the id that SiteScope uses to look up a command. This must be one of the set of
SiteScope commands (see "Adapter Command List" on the next page). This entry is case sensitive.
For example:
command=/usr/bin/df -k means that the usr/bin/df -k command is run to get the information
about the disks.
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mount=6 and name=1 mean that the mount name is in column 6 and the name of the mount or file
system is in column 1. The data names vary from command to command and are documented below.
Applying the above for the following command output:
Filesystem kbytes used avail capacity Mounted on /proc 0 0 0 0%/proc
/dev/dsk/c0t3d0s0 73049 42404 23341 65% /
where the disks command automatically skips lines not starting with (/dev) reads column 1
(/dev/dsk/c0t3d0s0) as the name of the file system, and column 6 ("/") as the mount name.

Adapter Command List
SiteScope requires settings for each the following commands to operate properly. Each command
description requires an ID and a command, one or more fields to specify where the data is being read
from, and optionally a set of modifiers that are used to filter the output of the command to eliminate
certain sets of lines (such as header lines).
Where the variable column is used below, it means the number of the column in which the data
appears, where columns are space delimited sets of data.
In addition, there are certain fields that can be optionally applied to any command description. For
details, see "Optional Adapter Command Details" on page 507.
This section includes:
l

"Disk Listing" on the next page

l

"Disk Information" on the next page

l

"Memory" on the next page

l

"Page Faults" on page 506

l

"CPU Usage" on page 506

l

"Process List" on page 506

l

"Process List with Details" on page 507

l

"Log File Processing" on page 507

l

"Optional Adapter Command Details" on page 507
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Disk Listing
ID

Description

Used
by

disks

Returns a list of the file systems on the system. The
/usr/bin/df -k command is the standard way to get this data.
Lines returned that do not start with /dev are automatically
skipped.

Disk
name. The
Space column of the
Monitor name of the file
system.

Fields

mount. The
column of the
name of the
mount.

Disk Information
ID

Description

Used by

Fields

disk

Takes a disk as an argument and returns the
total, free, and percent used for the disk.

Disk
Space
Monitor

total. The column of the total
kilobytes capacity of the file
system.
free. The column of the free
kilobytes of the file system.

Memory
ID

Description

Used by

Fields

memory

The amount of swap space
used and available.

Memory
Monitor

swapUnit. The multiplier applied to used, free,
or total swap space to give bytes.
used. The amount of swap space used.
free. The amount of swap space free.
total. The amount of total swap space.
Note: Only two of used, free, and total fields
need to read. The other is computed.
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Page Faults
ID

Description

pageFault The number of page
faults/sec. If multiple
page faults lines are
matched, they are
added up.

Used
by

Fields

Memory
Monitor

pageFaults. The column of the number of page
faults.
inPageFaults. The column of the number of page in
faults.
outPageFaults. The column of the number of page
out faults.
units. pages (default), pages/sec, or k/sec units
for the paging data.
pageSize. If units are k/sec, the pageSize is used
to compute the number of pages. Otherwise it is
ignored.
Note: Either use pageFaults, if there is a single
column of data, or inPageFaults and
outPageFaults, if there are two columns of page
fault data. inPageFaults and outPageFaults are
added together to get the total page faults.

CPU Usage
ID

Description

Used by

Fields

cpu

Returns the wait and idle % of the
CPU.

CPU
Monitor

idle. The idle % for the CPU.
wait. The wait % for the CPU
(optional).

Process List
ID

Description

Used
by

Fields

process

A list of processes with long process names.
Typically this is /usr/bin/ps -ef

Service
Monitor

name. The column of the
names of the processes.
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Process List with Details
ID

Description

processDetail A list of processes with size of
the process. Typically this is
/usr/bin/ps -el

Used by

Fields

Service Monitor
(with Check Memory
option enabled)

name. The column of the
names of the processes
size. The column of the
size of the processes.
pageSize. Page size on
the system (optional). The
default is 8192.

Log File Processing
ID

Description

Used by

Fields

fileExists

Checks that the log file exists.

Log File monitor
(on Windows or
Linux)

match. The text to match
in the log entries.

filesize

Returns the file size to ascertain if the
file changed.

Log File monitor
(on Windows or
Linux)

size. The number in the
size column in the
command output.

tail

Reads the file content for local file
processing (not supported for serverside processing).

Log File monitor
(on Windows or
Linux)

match

Performs server-side processing with
perl or awk.

Log File Monitor
(on Linux)

Optional Adapter Command Details
The following fields can optionally be applied to any command description:
Process List with Details
ID

Description

startLine

The line number where the command starts looking for data.

endLine

The line number where the command ends looking for data.

skipLine

The pattern that if matched, skips the line.

matchLine

The pattern that if matched, looks for data in that line.
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ID

Description

startMatch

The pattern that if matched, starts the command looking for data.

endMatch

The pattern that if matched, ends the command looking for data.

reverseLines

If true, the command output lines are reversed and read back to front. This is useful if
there is data at the end of the command and it is too difficult to work out when to start
reading.

If a field name has the format, fieldnameColumnName=COLUMN, the adapter searches the headers (first
line) for COLUMN and records the columns containing the data, and then use those settings to read the
fieldname field. This is useful where the width of the columns varies, and the data has spaces in it.
For example, to read the my data information from the following command output:
MEM NAME DESC12K my data some of my data
you would specify the name field in the command description as:
nameColumnName=NAME
The adapter reads the header line, finds NAME, and records where the previous column ends (MEM in this
case) and where the specified column ends (NAME), and uses that to read, in this case, the text in
character columns 6 through 22.
To see an example of the ColumnName reading in action, look at the process and processDetail
commands for the supported UNIX platforms. They use this method to get the process name and the
size of the process.

Tasks
How to Add an Adapter
This task describes the steps involved in adding an adapter to specific versions of UNIX.
1. If the UNIX platform to which you want to add support is similar to one of the default SiteScopesupported UNIX platforms, make a copy of the adapter file for that UNIX platform and use that as
a starting point for your adapter.
2. Modify the adapter file to match the command line requirements for the UNIX platform to which
you want SiteScope to connect.
3. Save your adapter file to the <SiteScope root directory>/templates.os directory. The filename
must use the .config extension.
4. Restart the SiteScope service.
5. Open the installation SiteScope to which you have added the new adapter file.
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6. In the left pane, click Remote Servers to display the remote servers view.
7. In the remote servers tree, right-click UNIX Remote Servers, and select New UNIX Remote
Server. The New UNIX Remote Server dialog box opens.
8. In the Operating system box, select the name of the UNIX adapter that you have created.
9. Click OK. SiteScope uses the new adapter file to try and retrieve that applicable data from the
remote server.
10. If you make changes to the adapter file after you have configured one or more server connection
profiles to use the adapter, you can use the Detailed Test option in the UNIX Remote Servers to
test your adapter. After adding the remote server, the Detailed Test displays the output of the
command that SiteScope is running remotely, along with SiteScope's parsing of the output.
The amount of work required to modify a particular template depends on how different the new UNIX
platform is from the supported UNIX platforms.
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Addresses
By default, SiteScope connects to remote servers using IPv4 addresses. If you want your environment
to resolve host names to IPv6, you need to enable SiteScope to prefer IPv6 addresses over IPv4 when
connecting to remote servers. Using IPv6 solves many of the problems of IPv4 such as address
depletion, security, auto-configuration, and extensibility.
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Learn About
Resolving Host Names to IPv6 Overview
The level of support for IPv6 depends on the operating system on which SiteScope is installed.
Windows Server 2008 has full-featured support for IPv6, which is installed and enabled by default. As a
result, IPv6 is supported by most SiteScope monitors when SiteScope is installed on Windows Server
2008 or later versions. Support for IPv6 on Windows Server 2003 is limited, as many core services and
networking components do not support it. IPv6 is also fully supported when SiteScope is installed on
UNIX operating systems that provide full support for IPv6.
For your environment to resolve host names to IPv6, select the Prefer IP version 6 addresses option
in SiteScope Infrastructure Settings. When this option is selected, the following must occur for the
IPv6 over IPv4 preference to take effect:
A host name must be specified for the remote server. If an IP address is specified, the prefer IPv6
setting has no effect on the host since the IP address determines the IP version that is used.

l

The host name resolves to both an IPv4 and an IPv6 address. If the host name resolves only to an
IPv4 address, then the IPv4 address is used.

l

Note:
l

l

If a host name is specified and the host name resolves to both an IPv4 and an IPv6 address,
but the monitor does not support IPv6, the monitor will not work. For details on how to resolve
this issue, see "Working in a Mixed IPv4 and IPv6 Environment" below. For the list of monitors
supporting IPv6, see "Monitors Supporting IP Version 6 Addresses" on the next page.
When specifying a literal IPv6 address as the name for the remote monitored server when
using the NetBIOS connection method, the IPv6 address must be customized by:
1. Replacing any colon (":") characters with a dash ("-") character.
2. Appending the text .ipv6-literal.net to the IP address.
For example, the IPv6 address: 2004:DB8:2a:1005:230:48ff:fe73:982d
would be: 2004-DB8-2a-1005-230-48ff-fe73-982d.ipv6-literal.net
Alternatively, you can switch to the WMI connection method (where supported), and avoid
having to make changes to the IPv6 address.

Working in a Mixed IPv4 and IPv6 Environment
When working in a mixed environment where both IPv4 and IPv6 are used, the DNS server might return
both an IPv4 and an IPv6 address for a host name. To instruct SiteScope which IP address to use for
each resolved host name, you can:
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Select the Prefer IP version 6 addresses option, and perform one of the following (for the hosts
that you want to use the IPv4 protocol):

l

n

Enter the IP address instead of the host name for the specified remote server.

n

Configure the DNS server so that the host name resolves to the IP address that you want to use
for the remote server. You can do this by removing the IPv6 address from the DNS server for the
specified host.

Clear the Prefer IP version 6 addresses option, and perform the following (for the hosts that you
want to use the IPv6 protocol):

l

n

Enter the IP address instead of the host name for the specified remote servers.

n

Configure the DNS server so that the host name resolves to the IP address that you want to use
for the specified remote servers. You can do this by removing the IPv4 address from the DNS
server for the specified hosts.

Supported Protocols
The following protocols are supported when IPv6 is used in SiteScopes installed on Windows and
UNIX platforms:

Target

SiteScope Installed on Windows
Platform

SiteScope Installed on UNIX
Platform

Windows

NetBios

SSH

WMI
UNIX

Not supported

SSH

Note:
l

SiteScope installed on Windows platforms can monitor Windows machines only.

l

NetBIOS and WMI are supported when SiteScope is installed on Windows platforms only .

l

SSH is supported only when SiteScope is installed on UNIX machines. For the list of
Windows-based monitors supporting IPv6 in SiteScopes running on UNIX using SSH, see
"Monitors Supporting IP Version 6 Addresses" below.

Monitors Supporting IP Version 6 Addresses
The following lists the monitors that support IPv6. A check mark indicates that the monitor requires
additional IPv6 address customization in SiteScope.
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Monitors Supporting IPv6 Addresses

Windows-Based
Monitors
Supporting IPv6
Additional
in SiteScopes
Configuration Running on
Required
UNIX Using SSH

Cisco Works Monitor
Citrix Monitor

a

a

ColdFusion Server Monitor

a

a

CPU Monitor

a

a

Custom Database Monitor
Database Counter Monitor
Database Query Monitor
DB2 JDBC Monitor
Disk Space Monitor (Deprecated)

a

Dynamic Disk Space Monitor

a

F5 Big-IP Monitor
HAProxy Monitor

a

Log File Monitor

a

a

Memory Monitor

a

a

Microsoft ASP Server Monitor

a

a

Memcached Statistics Monitor

a

Microsoft Hyper-V Monitor
Microsoft IIS Server Monitor

a

Microsoft Lync Server 2010 Monitors (Microsoft A/V
Conferencing Server, Microsoft Archiving Server, Microsoft
Director Server, Microsoft Edge Server, Microsoft Front End
Server, Microsoft Mediation Server, Microsoft Monitoring and
CDR Server, and Microsoft Registrar Server)

a

Microsoft SQL Server Monitor

a

a

Microsoft Windows Event Log Monitor

a

a
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Monitors Supporting IPv6 Addresses

Windows-Based
Monitors
Supporting IPv6
Additional
in SiteScopes
Configuration Running on
Required
UNIX Using SSH

Microsoft Windows Media Server Monitor

a

Microsoft Windows Resources Monitor

a

a

Microsoft Windows Services State Monitor

a

a

Real Media Server Monitor

a

a

Service Monitor

a

a

Network Bandwidth Monitor
Oracle Database Monitor
Ping Monitor
Port Monitor

SNMP Monitor
SNMP by MIB Monitor
SNMP Trap Monitor
Technology SNMP Trap Integration Monitor
UNIX Resources Monitor
URL Monitor

a

URL Content Monitor

a

URL List Monitor

a

URL Sequence Monitor

a

Web Service Monitor

a

Tasks
How to Enable SiteScope to Prefer IP Version 6 Addresses
This task describes how to enable SiteScope to prefer IPv6 addresses over IPv4 when connecting to
remote servers.
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1. Enable SiteScope to prefer IPv6 addresses
In Preferences > Infrastructure Preferences > Server Settings, select Prefer IP version 6
addresses.
For user interface details, see "Server Settings" on page 620.
Note:
n

You must restart SiteScope before changes to this setting can take effect.

n

If a host name is specified and the host name resolves to both an IPv4 and an IPv6
address, but the monitor does not support IPv6, the monitor will not work. For details on
how to resolve this, see "Working in a Mixed IPv4 and IPv6 Environment" on page 511.

2. Customize IPv6 address as the name for the remote monitored server (for specific monitors only)
Some monitors have additional customization requirements or limitations when using IPv6
addressing.
For monitors that require additional IPv6 address customization, see "Monitors Supporting IP
Version 6 Addresses" on page 512.
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SiteScope supports a number of security capabilities. One of these is support for remote server
monitoring using Secure Shell (SSH) connections. You can use SSH to connect to a server and
automatically send a command, so that the server runs that command and then disconnects. This is
useful for creating automated processing and scripting.

Learn About
This section includes:
l

"SSH Overview" below

l

"Integrated Java SSH Client" on the next page

l

"SSH Connectivity Options" on page 518

l

"Monitoring Remote Windows Servers Using SSH" on page 519

l

l

"Monitors Supporting Windows SSH (Agentless or Using the SiteScope Remote Windows SSH
Files)" on page 520
"SSH Guidelines" on page 521

SSH Overview
Secure Shell (SSH), sometimes known as Secure Socket Shell, is a UNIX-based command interface
and protocol for securely accessing a remote computer. It is widely used by network administrators to
remotely control Web and other kinds of servers. SSH commands are encrypted and secure in several
ways. Both ends of the client/server connection are authenticated using a digital certificate, and
passwords are protected by encryption. Secure Shell client machines make requests of SSH daemons
or servers on remote machines.
Monitoring with SiteScope over SSH has the following basic requirements:
1. The servers that you want to have monitored by SiteScope using SSH must have an SSH daemon
(or server) installed and active.
2. The SiteScope server has an integrated Java SSH client. SiteScope includes an SSH client
written in Java and native to the SiteScope application code. For details, see "Integrated Java
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SSH Client" on the next page.
Note: MindTerm is the only connection client available for SSH connections.

Integrated Java SSH Client
If you need to use Secure Shell (SSH) to connect to remote UNIX or Windows servers, SiteScope
must be able to access a SSH client to make the connection and transmit data. This section contains
some of the client configuration possibilities and issues involved in using SSH for SiteScope
monitoring.
SiteScope provides an SSH client written in Java that is integrated into the SiteScope application. This
client significantly reduces the required system resources used by SiteScope when connecting to
servers using SSH. The Java client supports both SSH version 1 (SSH1) and version 2 (SSH2)
protocols as well as both password-based and key-based authentication. The SiteScope configuration
for the client is identical for UNIX, Linux, and Windows SiteScope.
Working with the Integrated SSH Client
While SSH1 and SSH2 are both Secure Shell protocols, they are considered to be two different
protocols and are not compatible with each other. Some security vulnerabilities have been found in
SSH1 that has resulted in SSH2 being considered the current standard. Most SSH software supports
both protocols. To be sure that a request for an SSH connection uses SSH2 instead of SSH1, it is
necessary to configure SSH clients and SSH hosts to use the same protocol version between them to
communicate. In many cases, SSH1 is the default version used for connections, as it is considered the
lowest common denominator between an SSH client and an SSH host.
There are two ways to force SSH2 connections:
l

Configure all SSH daemons or servers to accept only SSH2 connection requests.
This is the most secure option but may be the most time- consuming unless each server was
configured for this option when it was installed and activated.

l

Configure the SSH client on the SiteScope server to only make SSH2 requests.
Requires changes only to the client on the SiteScope server. For the integrated Java SSH client,
this can be controlled by a setting in the Advanced Settings section on the remote server setup
page. Making the change on the SiteScope machine may be easier than having to reconfigure a
large number of remote SSH servers.

Setting Up Key-Based Authentication
Another part of SSH security is authentication. The integrated SSH client for SiteScope can be
configured to use one of two authentication options:
l

Password Authentication. Password Authentication is the default method for SSH connections in
SiteScope.
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l

Key-Based Authentication. Key-Based Authentication adds an additional level of security through
the use of a passphrase and a public-private key authentication.

To use Key-Based Authentication for SSH remote servers, you must first create a pair of public/private
keys. The public key resides on the remote and the private key is kept on the SiteScope machine. Both
Cygwin OpenSSH and OpenSSH for Windows come with a key generation tool called ssh-keygen. The
ssh-keygen tool enables you to create both protocol version 1 and version 2 keys. For details on how to
set up key-based authentication for SSH connections, see "How to Set Up Key-Based Authentication"
on page 535.
When setting up a UNIX or Windows remote server using the Internal Java Libraries Client, use the key
generation tool called MindTerm to create a public/private key pair for RSA (version 1 and version 2)
and DSA (version 2).

SSH Connectivity Options
The following tables outline the SSH connectivity options currently supported with SiteScope. For
important information about configuring and managing SSH connectivity, see "SSH Guidelines" on
page 521.
SiteScope Installed on Windows Platform:

Target
Windows

SiteScope Relevant
Client
Target
Options
Servers
SiteScope
integrated
Java SSH
Client

SSH
server
(Cygwin
OpenSSH)

Comments
l

l

UNIX/
Linux

SiteScope
integrated
Java SSH
Client

HP SiteScope (11.31)

Agentless SSH. The RemoteNTSSH package is not
required for monitors that support agentless SSH. For a
list of agentless SSH supported monitors, see "Monitors
Supporting Windows SSH (Agentless or Using the
SiteScope Remote Windows SSH Files)" on page 520.
SSH using the SiteScope remote Windows SSH files.
The RemoteNTSSH package should be installed under
the home user directory on the remote server. For details,
see "Install SiteScope Remote Windows SSH Files" on
page 534.

SSH host
daemon
(sshd either
proprietary
or
OpenSSH)
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SiteScope Installed on UNIX or Linux Platform:

Target
Windows

SiteScope Client
Options
l

l

SiteScope
integrated Java
SSH Client

Relevant
Target
Servers
SSH
server
(Cygwin
OpenSSH)

Comments
l

SSH client
(/usr/local/bin/ss
h or usr/bin/ssh)
l

UNIX/
Linux

l

l

SiteScope
integrated Java
SSH Client
SSH client
(/usr/local/bin/ss
h or usr/bin/ssh)

Agentless SSH. The RemoteNTSSH package
is not required for monitors that support
agentless SSH. For a list of agentless SSH
supported monitors, see "Monitors Supporting
Windows SSH (Agentless or Using the
SiteScope Remote Windows SSH Files)" on the
next page.
SSH using the SiteScope remote Windows
SSH files. The RemoteNTSSH package should
be installed under the home user directory on the
remote server. For details, see "Install
SiteScope Remote Windows SSH Files" on
page 534.

SSH host
daemon
(sshd either
proprietary
or
OpenSSH)

Monitoring Remote Windows Servers Using SSH
NetBIOS is the default remote connection method used by SiteScope for Windows-to-Windows
connectivity and monitoring in Windows networks. While this provides easier connectivity, it does have
several disadvantages; it is relatively vulnerable in terms of network security, and it does not support
remote execution scripts. Running commands on remote servers requires that scripts be run locally,
with commands to the remote machine being written using the UNC syntax of remote servers. Even
then, some parameters are not returned from the remote server by using NetBIOS. (SiteScope also
supports the Windows Management Instrumentation (WMI) protocol which is a more secured
communication protocol than NetBIOS for gathering data from remote servers running on Windows
servers. For details, see "Configure the WMI Service for Remote Windows Monitoring" on page 488.)
SiteScope supports monitoring of remote Windows servers using SSH. This technology has been
tested with the OpenSSH binaries from Cygwin (available at http://www.cygwin.com/) installed as the
SSH server on the remote server. It has also been tested with the server available from F-Secure. You
can also try OpenSSH for Windows (formerly Network Simplicity "OpenSSH on Windows") which is
available on SourceForge (available at http://sshwindows.sourceforge.net/).
The following is a comparison overview of two of the packages.
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OpenSSH
Package

Advantages

Disadvantage

Cygwin
OpenSSH

1. Provides access to either Windows or UNIXstyle scripting on a Windows machine.

Complicated setup procedure.

2. Provides access to UNIX-style system tools
and utilities.
3. SiteScope can access the remote server both
as a Windows Remote and /or a UNIX Remote.
OpenSSH
for
Windows

Simple setup procedure.

Only provides access to Windows
commands, scripts, and utilities.

Note:
l

l

OpenSSH for Windows and the Cygwin SSH implementations are incompatible with each
other. They should not be installed on the same machine.
If there is more than one version of the Cygwin utilities or more than one SSH server installed
on a machine, there may be conflicts that prevent the SSH connections from working. An error
message such as "could not find entry point" is an indication of this kind of conflict. If you
suspect this error, search the machine for multiple copies of cygwin1.dll. It may be necessary
to remove all versions of the utilities and then reinstall only a single installation to resolve this
problem.

For details on configuring remote Windows servers for SSH monitoring, see "How to Configure Remote
Windows Servers for SSH monitoring" on page 525.

Monitors Supporting Windows SSH (Agentless or Using the SiteScope Remote Windows SSH
Files)
The following lists the monitors that support agentless Windows SSH, or Windows SSH using the
SiteScope's remote Windows SSH files. All the monitors that support Windows SSH using
SiteScope's SSH files are supported in SiteScopes running on UNIX platforms.

Monitor

Supports Windows SSH
Using SiteScope's Remote
Windows SSH Files

Supports Agentless
Windows SSH

Citrix Monitor

a

a

ColdFusion Server Monitor

a

a

CPU Monitor

a

a

HP SiteScope (11.31)

Page 520 of 1395

Using SiteScope
Chapter 39: Configure Remote Monitoring Using Secure Shell (SSH)

Monitor

Supports Windows SSH
Using SiteScope's Remote
Windows SSH Files

Directory Monitor

a

Disk Space Monitor

a

a

Dynamic Disk Space Monitor

a

a

Log File Monitor

a

Memory Monitor

a

a

Microsoft Lync Server 2010
Monitors

a

a

Microsoft ASP Server Monitor

a

a

Microsoft Hyper-V Monitor

a

a

Microsoft IIS Server Monitor

a

a

Microsoft SQL Server Monitor

a

a

Microsoft Windows Event Log
Monitor

a

Microsoft Windows Media Server
Monitor

a

Microsoft Windows Performance
Counter Monitor

a

Microsoft Windows Resources
Monitor

a

Microsoft Windows Services State
Monitor

a

Multi Log Monitor

a

Real Media Server Monitor

a

Script Monitor

a

Service Monitor

a

Supports Agentless
Windows SSH

a

a

a

SSH Guidelines
l

There are two different versions of the SSH protocol: version 1 and version 2. Version 1 and version
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2 are different protocols and are not compatible with each other. This means that the SSH clients
and SSH hosts must be configured to use the same protocol version between them to
communicate. In many cases, SSH version 1 (SSH1) is the default version used. Some security
vulnerabilities have been found in SSH version 1. Also, the SSH1 protocol is not being developed
anymore and SSH2 is considered the current standard.
Tip: We recommend using SSH version 2 (SSH2) for all SSH connections.

l

l

l

l

If SiteScope is configured to run in FIPS 140-2 mode (a U.S. government computer security
standard used to accredit cryptographic module), you must use SSH2 for all SSH connections. For
details, see the Common Criteria Certification section in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).
The release version number of the SSH utilities and libraries you have installed must not be
confused with the version of the SSH protocol that you want to be using. For example, OpenSSH
release 3.5 supports both SSH1 and SSH2 protocols. The release version 3.5 does not mean that
the libraries use an SSH version 3.5 protocol. You must configure the OpenSSH software to use
either SSH1 or SSH2.
If you have set up SiteScope remote monitoring using SSH connections and then make
configuration changes or upgrades to the SSH daemon or server software deployed on remote
servers in the environment, it may be necessary to reconfigure the SSH connectivity between the
machine on which SiteScope is running and the remote servers that are being monitored.
We do not recommend creating more than 1000 monitors that use an SSH connection (assuming
the default parameter settings, such as run frequency, number of connections, and so forth, are
used). If you need to monitor more than 1000 monitors using SSH, you should add another
SiteScope server.

Tips/Troubleshooting
This section contains troubleshooting and limitations when monitoring using SSH.
l

"Windows SSH Using the SiteScope remote SSH Files is Not Working" on the next page

l

"Unable to Create an SSH Connection When OpenSSH 6.7 is Used" on the next page

l

"Skips in Windows SSH Based Monitors on Red Hat Linux 5" on the next page

l

"Agentless Windows SSH is Not Working" on the next page

l

"Agentless SSH Fails to Retrieve Counters" on page 524

l

"Error: "resize: unknown character exiting"" on page 524
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Windows SSH Using the SiteScope remote SSH Files is Not Working
Check that the prerequisites for Windows SSH monitoring using the SiteScope SSH files have been
met. For details, see "Install SiteScope Remote Windows SSH Files" on page 534.

Unable to Create an SSH Connection When OpenSSH 6.7 is Used
Unable to create an SSH connection between SiteScope and the Windows machine when OpenSSH
6.7 is used. This is because OpenSSH 6.7 supports another set of key exchange algorithms by default.
Workaround:
1. Open C:\cygwin\etc\sshd_config in a text editor and add any one, or all, of the following
algorithms to the end of the file:

diffie-hellman-group1-sha1, diffie-hellman-group1-sha14, diffiehellman-group-exchange-sha1
Example:
KexAlgorithms
diffie-hellman-group1-sha1,diffie-hellman-group1-sha14,diffie-hellman-group-exchangesha1,curve25519-sha256@libssh.org,ecdh-sha2-nistp256,ecdh-sha2nistp384,ecdhsha2-nistp521,diffie-hellman-group-exchange-sha256,diffie-hellmangroup14-sha1
2. Restart the sshd service.

Skips in Windows SSH Based Monitors on Red Hat Linux 5
If you encounter skips in Windows SSH based monitors running on Red Hat Linux 5 platforms, in the
opt/SiteScope/java/lib/security/java.security file, change:
"securerandom.source=file:/ dev/urandom"
to
"securerandom.source=file:///dev/urandom"

Agentless Windows SSH is Not Working
If Windows SSH is working using the SiteScope remote Windows SSH files, but agentless Windows
SSH is not, perform the following:
l

Check that perfmon is working correctly. On the target machine, run the command perfmon and
verify that the required perfmon objects appear. For details on how to rebuild these libraries, refer to
http://support.microsoft.com/?kbid=300956.
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Check that the remote machine has a working typeperf command (sample command to test) by
entering the following in the command line:

l

typeperf "\Processor(_Total)\% Processor Time"
For details, refer to http://technet.microsoft.com/en-us/library/cc753182.aspx.

Agentless SSH Fails to Retrieve Counters
In some cases, agentless SSH shows n/a for counters while perfmon gives the value as 0 for the same
counters. This is the behavior for counters that are also not selectable using the perfmon utility. The
reason that SSH using the SiteScope remote Windows SSH files can get values for these counters is
because it bypasses perfmon and accesses them through the registry.

Error: "resize: unknown character exiting"
If SiteScope fails to create a connection using SSH and the error.log or runMonitor.log contain a
server error message similar to "resize: unknown character exiting", this is probably caused by an
invalid bash-related command. SiteScope supports basic bash environments only. Bash commands
are usually found in the .bashrc file under the user default directory.

How to Configure Remote UNIX Servers for SSH monitoring
SiteScope for Solaris or Linux supports remote monitoring by using SSH. This task describes the steps
involved in configuring remote UNIX Servers for SSH monitoring with SiteScope.
Note: Setting up the SSH hosts on the remote servers you want to monitor in the UNIX
environment can be very complex and is beyond the scope of this document. Some suggested
resources on installation of the OpenSSH daemon are http://sunfreeware.com/introduction.html
(for Solaris) and http://docs.redhat.com/docs/en-US/Red_Hat_Network_
Satellite/5.4/html/Reference_Guide/sect-Reference_Guide-Monitoring-RHN_Monitoring_
Daemon_rhnmd.html#sect-Reference_Guide-RHN_Monitoring_Daemon_rhnmd-Configuring_
SSH (for Red Hat Linux).

1.

Prerequisites
The following are requirements for configuring remote UNIX servers for SSH monitoring with
SiteScope in a UNIX environment:
n

Secure Shell daemons or servers (sshd) must be installed on each remote server you want to
monitor with SiteScope.

n

The SSH daemons on the remote servers must be running and the applicable communication
ports must be open. For example, the default for SSH is port number 22.
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n

A SSH client must be installed on the server where SiteScope is running. The SiteScope
integrated Java SSH client fills this requirement.

2. Verify SSH connectivity
Verify SSH client-to-server connectivity from the machine where SiteScope is running to the
remote machine you want to monitor. Check SSH connectivity outside of the SiteScope
application before setting up remote server connections using SSH in SiteScope. For example, if
SiteScope is running on Solaris or Linux, use the following command line to request an SSH
connection using SSH2 to the server <remotehost>:
ssh -2 <remotehost>
This normally returns text information that indicates the version of SSH protocol that is being
used. Also, this attempts to authenticate the current user. Use the -l username switch to request
a login as a different user.
3.

Configure the integrated java SSH client to connect to the remote servers
After you have set up SSH servers or daemons on remote servers, you must configure the
integrated Java SSH client that SiteScope uses to connect to the remote servers.
a. Select an authentication option for SSH connections:
o

Password authentication. This is the default method for SSH connections in SiteScope.

o

Key-based authentication. This adds an additional level of security through the use of a
passphrase and a public-private key authentication. For details on configuring key-based
authentication, see "How to Set Up Key-Based Authentication" on page 535.

b. If SSH2 connections are required, configure the SiteScope java client to use SSH2
connections by selecting the SSH version 2 only check box (in Advanced Settings of the
Microsoft Windows/UNIX Remote Servers dialog box).
4.

Configure UNIX remote settings to use the SSH connection method
After you have confirmed SSH connectivity, create or configure UNIX Remote settings in
SiteScope to use SSH as the connection method.
For user interface details, see "New/Edit UNIX Remote Server Dialog Box" on page 495.

How to Configure Remote Windows Servers for SSH
monitoring
This task describes the steps involved in configuring remote Windows Servers for SSH monitoring with
SiteScope.
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1.

Install and configure a SSH server
Install and configure a SSH server on each remote server to which you want SiteScope to
connect. There are two software packages generally available that enable SSH capability:
n

Cygwin environment available from http://www.cygwin.com/. For task details, see "Install
Cygwin OpenSSH on Windows" on the next page.

n

OpenSSH for Windows available at OpenSSH for Windows. For task details, see "Install
OpenSSH for Windows" on page 532.
Note: These setup steps must be performed for each server that runs the SSH daemon or
server.

2.

Enable Windows SSH monitoring using preinstalled SiteScope SSH files - optional
Depending on the monitor that you are using, you can choose to use preinstalled SiteScope SSH
files or agentless Windows SSH for monitoring the remote server (for the list of supported
monitors, see "Monitors Supporting Windows SSH (Agentless or Using the SiteScope Remote
Windows SSH Files)" on page 520.
n

Using preinstalled SiteScope remote Windows SSH files. To enable SSH monitoring of
the remote server using the preinstalled SSH files, you must install the SiteScope remote
Windows SSH files on each remote server to enable commonly used server monitoring
functions. For task details, see "Install SiteScope Remote Windows SSH Files" on page 534.

n

Agentless SSH. If you are using agentless Windows SSH, you do not need to install
SiteScope remote Windows SSH files on the remote Windows server.
Tip: If a monitor supports both preinstalled SiteScope SSH files and agentless Windows
SSH, we recommend using agentless Windows SSH.

3.

Configure the integrated java SSH client to connect to the remote servers
After you have set up SSH servers or daemons on remote servers, you must configure the
integrated Java SSH client that SiteScope uses to connect to the remote servers using (in
Advanced Settings of the Microsoft Windows/UNIX Remote Servers dialog box).
a. Select an authentication option for SSH connections:
o

Password authentication. This is the default method for SSH connections in SiteScope.

o

Key-based authentication. This adds an additional level of security through the use of a
passphrase and a public-private key authentication. For details on configuring key-based
authentication, see "How to Set Up Key-Based Authentication" on page 535.
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b. If SSH2 connections are required, configure the SiteScope java client to use SSH2
connections by selecting the SSH version 2 only check box (in Advanced Settings of the
Microsoft Windows/UNIX Remote Servers dialog box).
4.

Configure Windows remote settings to use the SSH connection method
After confirming SSH connectivity between SiteScope and the remote server, set up Windows
remote server settings in SiteScope as follows:
n

In Main Settings, select SSH as the connection method. You can then configure monitors to
use the SSH connectivity.

n

To enable SSH monitoring of the remote server using the preinstalled SiteScope SSH files,
make sure SSH using preinstalled SiteScope remote Windows SSH files is selected in
the Advanced Settings panel (this is the default setting).

n

To monitor using agentless Windows SSH, clear the SSH using preinstalled SiteScope
remote Windows SSH files check box in the Advanced Settings panel.

For user interface details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on page
475.

Install Cygwin OpenSSH on Windows
This task describes the steps involved in installing and configuring a Cygwin OpenSSH server on
Windows servers.
Note:
l

l

l

This task is part of a higher-level task. For details, see "How to Configure Remote Windows
Servers for SSH monitoring" on page 525.
The following instructions assume that no other Cygwin or other SSH utilities are installed on
the machine and that the machine has Internet access.
The user login account used to install and run the SSH daemon needs adequate permissions to
install the necessary programs, configure several file options, and control Windows services. It
does not need to be the account that SiteScope uses to connect to the subject server, although
that account must be configured within the Cygwin installation before you can monitor that
server with SiteScope.

Supported versions
Cygwin 1.7.x (the latest certified Cygwin version is 1.7.7)
To install and configure a Cygwin OpenSSH server on Windows servers:
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1. Create a new System Environment variable with the following definition: CYGWIN = ntsec tty.
2. Add the string ;C:\cygwin\bin to your PATH variable. Save the changes to the variables.
3. Download the Cygwin setup program into a temporary folder. For example: C:\temp. The setup
program is used to select, download, and install different packages and components available with
Cygwin.
4. Run the downloaded setup program and choose the Install from Internet option when prompted
to Choose A Download Source. Click Next to continue.
5. If prompted, select a root install directory where the Cygwin package should be installed. This is
where the SSH daemon and related files are installed. For example, C:\cygwin. Click Next to
continue.
6. If prompted, select a temporary directory where the Cygwin installation files should be stored. For
example, C:\temp. Click Next to continue.
7. If prompted, select an Internet Connection option. Normally, you can use Direct Connection.
Click Next to continue.
8. Select a suitable mirror site from which to retrieve the files using the selection list when prompted.
Click Next to continue.
9. The Setup program queries the mirror site for the packages available and displays a hierarchy tree
of package categories. To view and select the packages to download, click on the plus (+) symbol
to the left of the category name to expand any of the package trees. Packages that are selected
for download and installation display a version number in the New column. If a version number is
not displayed for a particular package, it is not downloaded and installed. Click Skip to the left of
package name to select the package for download.
Note: Many of the development (Devel) and database (Database) tools that may be selected
by default for download are not necessary to run the SSH daemon and can be deselected to
reduce download time and installation space.
Select each of the following packages for download and installation:
n

cygrunsrv from the Admin branch

n

cygwin-doc from the Doc branch

n

pdksh from the Shells branch

n

openssh and openssl from the Net branch

n

your choice of UNIX-style text editor from the Editors branch (for example: vim or emacs)

Then click to download the files as prompted.
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10. Depending on your installation options, the Cygwin setup downloads and installs the selected
packages. You may be prompted to choose to have a shortcut to the Cygwin terminal window
added to the Desktop or Program Start menu. Click to continue and complete the installation.
11. After the Cygwin setup is complete, open a Cygwin terminal window by clicking on the Cygwin
desktop shortcut or Program Start menu item.
Note: Depending on the user profile in the Windows system, the default directory that opens
in the terminal window may not be within the root Cygwin installation tree. Use the pwd
command to display the current directory. Typing in the command string cd / normally
changes the directory to the Cygwin root, which by default corresponds to the Windows
C:\cygwin directory.
Update the default Cygwin group file with the group names in use on the machine and on your
network. Use the mkgroup utility to update the default Cygwin group file with the groups defined on
the server and in your domain. Examples of the commands to use are as follows:
mkgroup -l >> ../etc/group mkgroup -d >> ../etc/group
Note:
n

To have Cygwin recognize both domain and local group accounts, run the mkgroup utility
twice, once for local users (-l option) and once for domain users (-d option). Remember to
use >> syntax and not just >, to append entries to the file.

n

If you use both the local and domain options, you must manually edit the /etc/group file
(using the UNIX style text editor you downloaded) to remove any duplicate group entries.
You may also want to remove group entries that are not needed for monitoring or should
not have access to this machine.

Update the default Cygwin user (passwd) file with the users defined on the local machine plus any
individual domain users you want to grant access to Cygwin on this machine. Use the mkpasswd
utility to update the default Cygwin user file.
Examples of the commands to use are as follows:
mkpasswd -l >> ..\etc\passwd mkpasswd -d -u username >> ..\etc\passwd (domain
users)
Note:
n

By default, Cygwin is set to run the OpenSSH daemon as the local user called SYSTEM. To
have Cygwin recognize both domain and local machine user accounts, run the mkpasswd
using the -l option to add all local users, and run it with the -d and -u options to add
individual domain users. Remember to use >> syntax and not just >, to append entries to
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the file.
n

If you use both the local and domain options, you must manually edit the /etc/passwd file
(using the UNIX style text editor you downloaded) to remove any duplicate user entries.
You may also change the default /home path and default shell for individual users. This
may be necessary to install the RemoteNTSSH package in the
/home/sitescopeaccount/ directory of the user account to be used by SiteScope.

12. Change the active directory to the /bin directory by typing cd /bin.
13. Create a symbolic link in the /bin directory that points to the Windows Command (CMD) shell by
entering the following command line (be sure to include the trailing space and period):
ln -s /cygdrive/c/winnt/system32/cmd.exe .
14. We recommend that you change permissions and ownership of several Cygwin files and
directories. Also create a log file for the SSH daemon. Enter the following command lines in the
Cygwin terminal command line and press ENTER after each command line entered:
cd /
chmod -R og-w .
chmod og+w /tmp
touch /var/log/sshd.log
Note:
n

Exact syntax is required, including spaces.

n

Inconsistent and incorrectly assigned file and directory permissions can be one reason
that the SSH daemon can not be started or that SiteScope is unable to connect to and run
commands or scripts on the remote server.

15. Configure the SSH daemon to run as a Windows service by entering the following command:
ssh-host-config -y
When presented with the CYGWIN= prompt, type ntsec tty to match the environment variable you
set at the beginning of this procedure. Normally, this configures the SSH daemon or service to
restart automatically if the server needs to be restarted.
16. Configure the encryption keys and files for the SSH daemon using the following command:
ssh-user-config -y.
Enter required passphrases for several keystore files when prompted. The program asks you to reenter the passphrase for confirmation.

HP SiteScope (11.31)

Page 530 of 1395

Using SiteScope
Chapter 39: Configure Remote Monitoring Using Secure Shell (SSH)

17. You must change the ownership of several files and folders for use by the SSH daemon. The
program does not normally run if the permissions on these files enable them to be changed or run
by group or "world" level users. Enter the following command strings to restrict access to these
files:
chown SYSTEM:Users /var/log/sshd.log /var/empty /etc/ssh_h*
chmod 755 /var/empty
18. Check the installation by starting and then stopping the CYGWIN sshd service using the
Programs > Administrative Tools > Services panel.
Note: Cygwin includes a server utility to start the SSH daemon. However, there have been a
number of situations where this method failed to start the server, whereas using the Windows
Services panel was able to start the server.
19. Configure the default shell or command environment for the user account you use for monitoring
with SiteScope. The shell you select effects what types of scripts or commands can be run
remotely using the SSH connection. Use the UNIX-style text editor and edit the /etc/passwd file.
Find the entry for the SiteScope login account you intend to use and change the shell from
/bin/bash to the shell you want to use as described below. This is normally the last entry in the
line for that account entry.
n

If you chose to have SiteScope interact with the remote server using the Windows Command
shell, change the default shell entry to /bin/cmd. Use this option when you plan to use
Windows-style batch files and scripts You must also include the symbolic link to the Windows
cmd.exe kernel in the /bin directory as described in a previous step of this procedure.

n

If you chose to have SiteScope interact with the remote Windows server using a Cygwin UNIX
shell, change the default shell entry to be /bin/pdksh. The SiteScope SSH client may not
accurately parse Cygwin's default bash shell. You must also configure a Remote UNIX server
connection to this (Windows) server that connects to the Cygwin SSH daemon.
Save the changes to the file.

20. Edit the PATH and the default prompt commands in the /etc/profile file to make sure that
Cygwin can find certain files and that SiteScope can parse the output from the remote shell. Use
the UNIX-style text editor and edit the /etc/profile file. Find the PATH definition entry near the
top of the file. For example:
PATH=/usr/local/bin:/usr/bin:/bin:$PATH
Change this to include the following:
PATH=.:/usr/local/bin:/usr/bin:/bin:$PATH
21. To change the default prompt commands, edit the /etc/profile file, and find the section similar
to the following:
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;;
sh | -sh
| */sh |\
sh.exe | -sh.exe
| */sh.exe )
#Set a simple prompt
PS1='$ '
;;
Immediately under this entry, add the following:
;;
pdksh | -pdksh
| */pdksh |\
pdksh.exe | -pdksh.exe
| */pdksh.exe )
#Set a simple prompt
PS1='> '
;;
22. Save the changes to the file.
23. Change the active directory to the home directory of the user you have created for SiteScope
monitoring.
After making these changes and starting the SSH daemon, you should be able to connect to the
server using an SSH client.
Note: Any time you run the mkpasswd -l /etc/passwd command (for example, when adding
a new user), edit the /etc/passwd file again to make sure that the default shell for that user is
set to the required value for any account being used by SiteScope.

Install OpenSSH for Windows
This task describes the steps involved in installing and configuring an OpenSSH server on Windows
servers.
The OpenSSH for Windows package is an alternative to the Cygwin SSH package and can be easier to
install. Like most products, the Cygwin product and the Open SSH for Windows are subject to change.
There are cases where some versions of the Cygwin SSH server have not returned the data needed for
SiteScope monitoring. If the OpenSSH for Windows package can solve this problem, use this package
in place of the Cygwin package.
Note: This task is part of a higher-level task. For details, see "How to Configure Remote Windows
Servers for SSH monitoring" on page 525.
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How to install and configure an OpenSSH for Windows server on Windows
servers:
1. Download and install the OpenSSH for Windows package.
2. Open a command prompt and change to the installation directory (C:\Program Files\OpenSSH is
the default installation path).
3. Change the active directory to the OpenSSH\bin directory.
4. You must update the default group file with the group names in use on the machine and in your
network. Use the mkgroup utility to update the default OpenSSH group file with the groups defined
on the server and in your domain. Examples of the commands to use are as follows:
mkgroup -l >> ..\etc\group mkgroup -d >> ..\etc\group
Note:
n

To have OpenSSH recognize both domain and local group accounts, run the mkgroup
utility twice, once for local users (-l option) and once for domain users (-d option).
Remember to use >> syntax and not just >, to append entries to the file.

n

If you use both the local and domain options, you must manually edit the /etc/group file
(using the UNIX style text editor you downloaded) to remove any duplicate group entries.
You may also want to remove group entries that are not needed or should not have access
to this machine.

5. You must update the default OpenSSH user (passwd) file with the users defined on the local
machine plus any domain user you want to grant access to the SSH server on this machine. Use
the mkpasswd utility to update the default user file. Examples of the commands to use are as
follows:
mkpasswd -l >> ..\etc\passwd
mkpasswd -d -u username >> ..\etc\passwd
Note:
n

To have OpenSSH recognize both domain and local machine user accounts, run the
mkpasswd utility using the -l option to add all local users and run it with the -d and -u
options to add individual domain users. Remember to use >> syntax and not just >, to
append entries to the file.

n

If you use both the local and domain options, you must manually edit the /etc/passwd file
(using the UNIX style text editor you downloaded) to remove any duplicate user entries.
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You may also change the default /home path and shell for individual users (see instructions
below).
6. Check the installation by starting the OpenSSH Server service using the Programs >
Administrative Tools > Services panel.

Install SiteScope Remote Windows SSH Files
This task describes the steps involved in installing SiteScope remote Windows files on each remote
Windows server according to the SSH package you are working with.
Note:
l

l

This task is part of a higher-level task. For details, "How to Configure Remote Windows
Servers for SSH monitoring" on page 525.
SiteScope remote Windows files do not need to be installed on remote Windows server
monitors that support agentless SSH. For a list of monitors that support agentless SSH, see
"Monitors Supporting Windows SSH (Agentless or Using the SiteScope Remote Windows
SSH Files)" on page 520.

How to Install the SiteScope SSH Files on Cygwin Installations
1. Verify that a \sitescope_login_account_name directory exists within the <install_
drive>:\cygwin\home directory on each machine that is monitored by SiteScope using SSH.
Replace sitescope_login_account_name with the user account name you use to connect to the
machine using the SSH server.
2. One of the advantages of using SSH on Windows is that it enables SiteScope to run scripts on the
remote server running the SSH daemon. To be able to use the Script Monitor to run remote scripts,
create a scripts subdirectory in the /home/sitescope_login_account_name directory. Scripts
you create for execution by the SiteScope Script Monitor must be placed inside this directory.
3. On the machine where SiteScope is installed, find the file called RemoteNTSSH.zip in the
<SiteScope root directory>\tools directory.
Note: All .exe and .dll files in RemoteNTSSH.zip should have executable permissions. Use
the command chmod +x * to grant executable permissions to the relevant files.
4. Copy this file to the <install_drive>:\cygwin\home\sitescope_login_account_name directory
on each of the remote Windows servers where you have installed the SSH server or daemon
software.
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5. Unzip the RemoteNTSSH.zip file on the remote server. Place the contents of the zip file into the
<install_drive>:\cygwin\home\sitescope_login_account_name directory. This should create a
<install_drive>:\cygwin\home\sitescope_login_account_name\scripts subfolder. You use
this subfolder to hold scripts that can be run by the SiteScope Script Monitor.
Note: If the RemoteNTSSH.zip file is from a version of SiteScope earlier than 11.10, you
must reinstall the zip file from <SiteScope 11.10 root>\tools directory on all monitored
remote servers.
6. Start the CYGWIN sshd service on the remote server.

How to Install the SiteScope SSH Files on OpenSSH for Windows Installations
1. On the machine where SiteScope is installed, find the file called RemoteNTSSH.zip in the
<SiteScope root directory>\tools directory.
2. Copy this file to the user home directory where the user is automatically directed after logging on
to the machine using the SSH server that was previously installed. This is the directory on each of
the remote Windows servers where you have installed the SSH server or daemon software.
3. Unzip the RemoteNTSSH.zip file on the remote server into the user home directory. This should
create a <user home directory>\scripts subfolder. You use this subfolder to hold scripts that can
be run by the SiteScope Script Monitor.
Note: If the RemoteNTSSH.zip file is from a version of SiteScope earlier than 11.10, you
must reinstall the zip file from <SiteScope root directory>\tools directory on all monitored
remote servers.
4. Start the OpenSSH server service on the remote server.

How to Set Up Key-Based Authentication
This task describes the steps involved in setting up key-based authentication for SSH remote servers.
You can copy a SiteScope SSH key to the remote server, or take the remote server key from a remote
server and copy it to SiteScope.
To use Key-Based Authentication for SSH remote servers, you must first create a pair of public/private
keys. The public key resides on the remote and the private key is kept on the SiteScope machine. Both
Cygwin OpenSSH and OpenSSH for Windows come with a key generation tool called ssh-keygen. The
ssh-keygen tool enables you to create both protocol version 1 and version 2 keys.
Tip: It is recommended to maintain one key file on the SiteScope server and copy it to the remote
servers instead of generate a file for each machine and copy them to the SiteScope machine.
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Creating a Key on the SiteScope Server
To create a public or private key pair on the SiteScope server:
1. Open a command window on the SiteScope server, and run the following command to launch
MindTerm:
<SiteScoperoot directory>\java\bin\java -jar c:\<SiteScope root directory>\
WEB-INF\lib\mindterm.jar
2. In MindTerm, select File > Create Keypair > DSA (or RSA). Also select OpenSSH .pub
format.
3. The key pair is written to the <USER_HOME>\mindterm directory.
4. Copy the private key (file not ending in *.pub) to the <SiteScope root directory>\groups
directory.
5. Copy the identity.pub file to the <USER_HOME>/.ssh directory on the remote machine and
rename it authorized_keys (or authorized_keys2 for SSH2). You also can add content of
identity.pub to existing authorized_keys/authorized_keys2 file if you want to allow a number of
different users to connect to the server with different keys files.
6. On the remote machine, run the command chmod 744 authorized_keys in the <USER_
HOME>/.ssh directory, and make sure that User has read, write, and execute permissions, and
that Group and Other have read permissions on the authorized_keys file.
7. Create a remote connection in SiteScope for the remote server using key file authentication and
Internal Java Libraries.
The public key goes in the <USER_HOME>/.ssh/authorized_keys file on the remote machines.
The private key file can be put into the <SiteScope root directory>\groups directory, and
renamed identity, which enables SiteScope to automatically take it without having to specify the
file path in Advanced Settings of the remote server. Alternatively, you can put the private key in
any other SiteScope directory, or outside of SiteScope.
The key generated from MindTerm is in Openssh format.
Note: You must verify that the server key and the MindTerm key are at the same level. For
example, if the server key is 768 bit and the MindTerm key is 1024 bit, the authentication
procedure fails.
To find out what your server is using:
1. Stop the sshd service on the remote server. On a Red Hat Linux server, run the command:
/etc/rc.d/init.d/sshd stop
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2. Start the sshd service in debug mode on the remote server. On a Red Hat Linux server, run the
command:
/usr/sbin/sshd -d
You should see output similar to Generating 768 bit RSA key.
Note: When using the Key File for SSH connections box in SiteScope, if there is a trailing
space after the information entered, this causes an "unknown error (-1)" failure. Remove the
trailing space to fix the problem.
To convert the openSSH key to SEC SSH format:
1. Create a RSA key in MindTerm (which is an openSSH key pair).
2. Run the following command on the remote server to convert the openSSH key to SEC SSH
format:
ssh-kegen -e -f <public key>
3. Leave the private key on the SiteScope server in the openSSH format.
Note: When using Key-Based authentication, the Key File supplied must be a version 2
private key.

Creating a Key on a UNIX Remote Server and Copying it to the SiteScope Server
To set up a connection by taking the remote machine key and put it into SiteScope:
1. Log on to your UNIX remote server as the user that has root permissions.
2. To generate a public/private RSA key pair for protocol version 1, run the following command:
$> ssh-keygen -t rsa
If you want to generate key pair for version 2, run the command:
$> ssh-keygen -t dsa
The possible output is:
Enter file in which to save the key (~/.ssh/id_rsa):
Enter passphrase* (empty for no passphrase):
Enter same passphrase again:

where the passphrase is the password used to decode your private key file; it can be left blank.
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Your identification is saved in ~/.ssh/id_rsa and the public key in ~/.ssh/id_rsa.pub (protocol
version 1); or ~/.ssh/id_dsa and ~/.ssh/id_dsa.pub for protocol version 2.
3. The corresponding public key must be listed in the authorized file on the remote host. Add the
content of generated public key to this file (the default authorized_keys file location is the ~/.ssh
directory).
To do this run the commands:
$> chmod 700 .ssh
$> cd .ssh
$> touch authorized_keys (for ver. 2: touch authorized_keys2)
$> chmod 600 authorized_keys (for ver. 2: chmod 600 authorized_keys2)
$> cat id_rsa.pub >> authorized_keys (for ver. 2: cat id_dsa.pub >> authorized_
keys2)
$> rm id_rsa.pub (for ver. 2: rm id_dsa.pub)

4. Copy the identification file, private key, to the SiteScope machine.
5. In SiteScope, create a new UNIX remote server with the following in the Main Settings:
n

User name. This must be the name of a user that you want to connect to the remote server.

n

Password. The password is the passphrase of the generated private key.

n

Method. SSH.

6. Set the Advanced Settings as follows:

7. Test the remote server connection.
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This page displays information about the remote servers configured in your network environment. Use
this page to add, edit, or delete remote server profiles.
To access

Important
information

Select the Remote Servers context. In the remote servers tree, click the Microsoft
Windows Remote Servers or UNIX Remote Servers container.
l

l

l

Relevant
tasks

l

l

See also

Only an administrator in SiteScope, or a user granted Add, edit or delete remote
servers permissions can view or edit the Remote Servers page. For details on
user permissions, see "User Management Preferences" on page 732.
You cannot delete a server from the list of remote servers if the server is
referenced by a monitor. Select a different server in the Server box of the Monitor
Settings panel for each monitor that references the remote server, and then delete
the remote server from the remote server list.
You can create multiple remote servers for the same host machine.
"How to Configure SiteScope to Monitor a Remote Microsoft Windows Server" on
page 470
"How to Configure SiteScope to Monitor a Remote UNIX Server" on page 492

"Remote Server Tree" on page 40

User interface elements are described below:
UI Element

Description
New Microsoft Windows/UNIX Remote Server. Opens the New Microsoft
Windows/UNIX Remote Server dialog box enabling you to configure a remote server
and add it to the tree. For details, see "New/Edit Microsoft Windows Remote Server
Dialog Box" on page 475 or "New/Edit UNIX Remote Server Dialog Box" on page
495.
Edit Remote Server. Enables you to edit the properties of the selected remote
server.
Delete Remote Server. Deletes the selected server from the tree.
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UI Element

Description
Test. Tests the connection to one or multiple servers.
l

l

When testing the connection to a single remote server, the test results are
displayed in a popup window.
When testing the connection for multiple remote servers, the test is performed in
the background so you can continue to use SiteScope. The test results are
displayed in Server Statistics > Log Files > Other Logs in the remotes_multi_
test.log.

Detailed Test. Runs a test that displays the result of running commands on UNIX
remote servers. This enables checking the permissions for the defined user.
Select All. Selects all listed remote servers.
Clear Selection. Clears the selection.
<Remote
servers
list>

Lists the remote servers that have been configured in SiteScope. Double-click a
remote server to open the Edit Remote Server page for the selected remote server
type.

Name

Name by which the remote server is known in SiteScope.

Server

IP address or name of the monitored remote server. You can create two remote
servers with the same host name.

Status

Connection status of the remote server. If SiteScope is unable to connect to the
remote server, a reason for the connection failure is provided.

Last Test

The date and time that the remote server connection was last tested.

Operating
System

Operating system that is running on the remote server.

Method

Connection type for monitoring the server resources (NetBIOS, WMI, and SSH for
Windows; Rlogin, Telnet, and SSH for UNIX).

Description Description of the remote server that was assigned when creating or editing the
remote server.
Associated
Monitors

Number of monitors used by each remote server. This enables sorting the table by the
number of monitors used by each remote server, and removal of unused remote
servers (those with 0 associated monitors can subsequently be deleted).
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The Preferences menu represents the preference types that enable you to configure specific properties
and settings related to most of the administrative tasks available within SiteScope.
You can configure the following preference types within SiteScope:
l

"Certificate Management" on page 542

l

"Common Event Mappings" on page 547

l

"Credential Preferences" on page 561

l

"Email Preferences" on page 568

l

"Event Console Preferences" on page 574

l

"General Preferences" on page 578

l

"HTTP Preferences" on page 590

l

"High Availability Preferences" on page 597

l

"Infrastructure Preferences" on page 608

l

"Integration Preferences" on page 660

l

"Log Preferences" on page 700

l

"Pager Preferences (Deprecated)" on page 707

l

"Schedule Preferences" on page 712

l

"Search/Filter Tags" on page 718

l

"SNMP Preferences" on page 723

l

"User Management Preferences" on page 732

Other sections related to preferences:
l

"Internationalization in SiteScope" on page 761

l

"Authentication Strategies" on page 768
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When monitoring a remote server, if the target server uses a self-signed certificate, the certificate must
be added to a trusted keystore. If you are monitoring a URL, a WebSphere Application Server, or a
VMware-based server using a secure connection, you can manage self-signed certificates from the
Certificate Management page.
Note: You can still import certificates using the keytool method if preferred. For details on
manually importing certificates, see the documentation for the specific monitor type.

To access
Select Preferences > Certificate Management.
l

To view certificate details, double-click a certificate (opens the Certificate Details dialog box).

l

To add certificates, click the Import Certificates button (opens the Import Certificates dialog box).
Note: To view the Certificate Management page, you must be an administrator in SiteScope, or a
user granted View certificates list permissions. Edit certificates list permissions are required to
manage certificates using the Certificate Management page. For details on this topic, see "User
Management Preferences" on page 732.

Learn About
Benefits of Certificate Management
l

l

l

l

Certificates do not need to be managed using the standard JVM tools (keytool). This avoids the
requirement for a desktop/shell session to the SiteScope machine.
Provides visual keystore management (add and remove certificates) and enables dynamic keystore
reload, without having to restart SiteScope after each certificate change operation.
Monitors are bound to the keystores that they are using. For URL, WebSphere Application Server,
and VMware monitors, the following keystore is used:
<SiteScope root directory>\java\lib\security\cacerts. Other keystores are ignored.
If you use a self-generated Certificate Authority (CA) certificate to sign all the server certificates,
you only need to import the CA certificate once.
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Tasks
How to Import Server Certificates Using Certificate Management
This task describes the steps involved in importing self-signed certificates using Certificate
Management.
1. Prerequisites
n

Certificate Management can be used to import server certificates that are required when
configuring secure connections for the SiteScopeURL, WebSphere Application, and VMware
monitors.

n

Only a SiteScope administrator user, or a user with View/Edit certificates list permissions,
can view, add, or make changes to the certificates keystore on the Certificate Management
page. For details on user permissions, see "Permissions" on page 744.

2. Import the server certificate
If the Web server on which you are monitoring has an https:// prefix, it is a secure, encrypted
connection, and you need to import the server certificate.
a. Select Preferences > Certificate Management, and click the Import Certificates
button. Select File or Host, and enter the details of the source server. For user interface
details, see "Import Certificates Dialog Box" on the next page.
b. From the Loaded Certificates table, select the server certificates to import and click Import.
The imported certificates are listed on the Certificate Management page. For user interface
details, see "Certificate Management Page" on the next page.
3. Configure the monitor properties
After importing the required server certificates, you can create a monitor with a secured
connection.

UI Descriptions
This section includes:
l

"Certificate Management Page" on the next page

l

"Import Certificates Dialog Box" on the next page

l

"Certificate Details Dialog Box" on page 545
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Certificate Management Page
This page is used for managing certificates used with SiteScope URL, WebSphere Application, and
VMware monitors. The Certificate Management page enables you to add, remove, and refresh keystore
contents.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description
Import Certificates. Opens the Import Certificates dialog box and add certificates
to the Certificate Management keystore list. For user interface details, see "Import
Certificates Dialog Box" below.
Remove Certificates. Deletes the selected certificates from the Certificate
Management keystore list.
ReloadCertificate List. Reloads the keystore certificates from the <SiteScope
root directory>\java\lib\security\cacerts files on the remote server. This enables
you to manually reload keystore changes without having to restart SiteScope.
Select All. Selects all listed certificates.
Clear Selection. Clears the selection.

<certificates> Lists the server certificates that have been imported. Double-click a certificate to
open the Certificate Details dialog box and display the certificate's properties and
values. For user interface details, see "Certificate Details Dialog Box" on the next
page.
Alias

Certificate alias name.
Note: Alias names of imported certificates cannot be modified (they can be
modified only during the import certificate step).

Issuer

Name of the certificate issuer.

Valid Until

Time and date until which the certificate is valid.

Version

Certificate version number.

Import Certificates Dialog Box
This dialog box is used for adding certificates to the Certificate Management list keystore. You can
change the sort order in the columns by clicking the arrow in the column title. A small down or up arrow
is displayed indicating the column is sorted in ascending or descending order.
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User interface elements are described below:
UI
Element Description
Source Selection
Host

Select this option to add certificates from a host server. Enter the real IP address or host
name of the monitored server.

Port

Port number of the host machine (available only if the Host option is selected).
Default Port value: 443

Load

Loads certificates for the machine specified in the Host field. The certificates are
displayed in the Loaded Certificates table.

File

Select this option to add certificates from a file.

Select

Use to navigate to the file from which you want to import certificates, and click Open.
Add the required certificates to the Certificate Management list.

Loaded Certificates
Select All. Selects all listed certificates.
Clear Selection. Clears the selection.
Alias

Certificate alias name. You can modify a certificate alias during the import certificate step
by entering a new alias in the Alias column.
Note: An alias name cannot be modified after the certificate has been imported.

Issuer

Name of the certificate issuer.

Valid
Until

Time and date until which the certificate is valid.

Version

Certificate version number.

Import

Select the certificates to import from the Loaded Certificates table, and click Import. The
imported certificates are displayed in the Certificate Management page.

Certificate Details Dialog Box
This dialog box displays properties and values for the selected server certificate. Double-click a
certificate in the Certificate Management page to open this dialog box.
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User interface elements are described below:
UI Element

Description

Alias

Certificate alias name.

Certificate Properties
Fingerprint

The certificate's fingerprint.

Type

The certificate type.

Version

Version number of the certificate.

Issuer principal

Name of the certificate issuer.

Serial number

Serial number of the certificate.

Signature algorithm name

Name of the signature algorithm of the certificate.

Valid from

Time and date from which the certificate is valid.

Valid until

Time and date until which the certificate is valid.
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Chapter 42: Common Event Mappings
This page is used to define event mappings and settings. It enables you to configure mappings
between SiteScope runtime data and the attribute values of the event to be sent. Common event
mappings are used when configuring the Operations Manager event integration, the Generic Event
integration, and the SiteScope Event Console.

To access
Select Preferences > Common Event Mappings, and click the New Event Mapping
select an existing event and click the Edit Event Mapping

button, or

button.

You can also access the New/Edit Event Mappings dialog box when:
l

l

l

Configuring alerts from the Alerts tab, New/Edit Alert > HP Operations Manager Integration
Settings > Event mapping.
Configuring a monitor instance from monitor Properties tab, Event Mapping Settings, provided
the HP Operations agent is installed and connected to an HPOM or BSM server, and Event
Integration is enabled in the HP Operations Manager Integration dialog box, or Generic Event
Integration is configured in Integration Preferences.
Configuring an Event Console alert action from the Alerts tab, New/Edit Alert > Alert Actions
> Event Console > Event Mapping.
Note: You must be an administrator in SiteScope, or a user granted View common event
mappings permissions to be able to view Common Event Mappings. Add, edit or delete
common event mappings permissions are required to create or edit Common Event Mappings.
For details on this topic, see "User Management Preferences" on page 732.

Learn About
Common Event Mappings Overview
You can configure SiteScope to send events directly to Operations Manager (HPOM) or to Operations
Management in BSM. You do this by using Common Event Mappings to create event mapping
instances between SiteScope runtime data and the event attribute values that are sent to the HPOM or
BSM Gateway Server. Common event mappings are also used for sending events to the SiteScope
Event Console, and when configuring the Generic Event integration for sending events to other
management consoles.
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When the event trigger condition is met, the event template is used to map the SiteScope runtime data
to the event attributes. These attributes have values that are passed to the event subsystem to create
the corresponding event (for example, the template translates the runtime data into an event in HPOM
or BSM). The event is then sent to HPOM, BSM, or the specified management console.
You can do this by using the default event mapping associated with the monitor or alert, select a
different event mapping (if any exist), or create a new event mapping in Common Event Mappings.
Alternatively, for alerts, you can use the event mapping template associated with the monitor that
triggered the alert. For details on creating event mappings for an event in HPOM or BSM, see "How to
Configure Common Event Mappings for HPOM or BSM" below.
SiteScope contains the HP CDA Event Mapping template, an out-of-the-box template that is specially
configured for CDA (Continuous Delivery Automation). CDA is a policy-based platform that provides
infrastructure provisioning in hybrid cloud environments. CDA integrates with SiteScope to deploy
SiteScope monitors and receive events from them. Monitoring status based on the events received is
available in the CDA user interface. For more details on CDA, refer to the CDA documentation.
For details on configuring SiteScope to report events directly to the Operations Manager server,
see "How to Enable SiteScope to Send Events to HPOM or Operations Management" in Integrating
SiteScope with HP Operations Manager Products in the SiteScope Help. You can check the
HP Software Integrations site for the latest version of this guide.
For details on creating event mappings to report events to a management console using the Generic
Event integration, see "How to Configure SiteScope Generic Event Integration" on page 691.
For details on how to configure event mappings for the SiteScope Event Console, see "Event Console"
on page 1062.
For details on event mapping attribute properties, see "Properties Available in Alerts, Templates, and
Events" on page 1305.
Tip: It is recommended to disable any existing event integrations and to configure new integrations
when upgrading from versions of SiteScope earlier than 11.00 and versions of BSM earlier than
9.00. Although integrations work after an upgrade, events are used only in the BSM Event
Browser.

Tasks
How to Configure Common Event Mappings for HPOM or BSM
This task describes how to use Common Event Mappings to configure event mappings for monitors
and alerts. This is the mapping between SiteScope run time data and the values of event attributes that
will be sent.
1. Prerequisites
n

To create or make changes to event mappings, you must be an administrator in SiteScope, or a
user granted Add, edit or delete common event mappings permissions. For details on user
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permissions, see "User Management Preferences" on page 732.
To select an event mapping when configuring an alert or a monitor instance, the HP Operations
agent must be installed and connected to an HPOM or BSM server, and event integration must
be enabled in the HP Operations Manager Integration dialog box (Preferences > Integration
Preferences > HP Operations Manager Integration). For task details, see "How to Enable
SiteScope to Send Events to HPOM or Operations Management" in Integrating SiteScope with
HP Operations Manager Products in the SiteScope Help. You can check the HP Software
Integrations site for the latest version of this guide.

n

2. Configure the alerts or monitor instances
You configure the alerts or monitor instances that, where triggered, create the relevant events in
the event system.
For task details on creating SiteScope alerts, see "Configure SiteScope Alerts" on page 1243.
For task details on creating monitor instances, see "How to Create and Deploy a Monitor" on page
262.
For task details on configuring Event Console alert actions, see "How to Configure and Manage
the Event Console (SiteScope Administrator)" on page 1069.
3. Configure the event mappings for an alert, Event Console, or monitor instance
You configure an event mapping to map an alert or monitor instance to the corresponding event
attributes. You can create several mappings for each type of alert or monitor.
n

You configure alerts from the Alerts tab > New/Edit Alert > HP Operations Manager
Integration Settings > Event mapping.

n

You configure a monitor instance from monitor Properties tab > Event Mapping Settings.

n

You configure an Event Console alert action from the Alerts tab, New/Edit Alert > Alert
Actions > Event Console > Event Mapping.

For each alert, or monitor instance, you can select an existing event mapping, or create a new
event mapping in Common Event Mappings. For user interface details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 551 and "New/Edit Event Mappings Dialog Box Custom Attributes Tab" on page 557.
Note:
n

The event mapping settings are only available when SiteScope is integrated with HPOM
and event integration is enabled (Enable sending events is selected in the
HP Operations Manager Integration Main Settings panel of the HP Operations Manager
Integration dialog box), or when a Generic Event Integration is configured in Integration
Preferences.
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n

You cannot delete a common event mapping if it is referenced by a monitor or an alert
action. You must change the event mapping referenced by the monitor or alert before you
can delete the mapping.

4. Results
You can view the events corresponding to the triggered alerts or changes in a monitor's metric
status in the HPOM Console, or in Operations Management in BSM (if you have an Event
Management Foundation license). If Operations Management is not part of your BSM installation,
you can view events that affect CI status using a health indicator in Service Health.
You can see events corresponding to triggered Event Console alerts in the SiteScope Event
Console. For details, see "Event Console" on page 1062.

How to Configure Event Mappings for the SiteScope Event Console
For details on how to configure event mappings for the SiteScope Event Console, see "Event Console"
on page 1062.
Related Task: "How to Configure SiteScope Generic Event Integration" on page 691

UI Descriptions
This section includes:
l

"Common Event Mappings Page" below

l

"New/Edit Event Mappings Dialog Box - General Tab" on the next page

l

"New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 557

Common Event Mappings Page
User interface elements are described below:
UI Element

Description
New Event Mapping. Creates a new event mapping. For user interface details, see
"New/Edit Event Mappings Dialog Box - General Tab" on the next page and
"New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 557.
Edit Event Mapping. Enables editing the event mapping. For user interface details,
see "New/Edit Event Mappings Dialog Box - General Tab" on the next page and
"New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page 557.
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UI Element

Description
Delete Event Mapping. Deletes the selected event mapping from Common Event
Mapping list.
Select All. Selects all listed events.
Clear Selection. Clears the selection.

Default
Settings

Click the arrow next to Default Settings, and select an option:
l

l

l

Edit Default Monitor Event Mapping. Opens the Edit Event Mapping dialog box
which enables you to change the default monitor event mappings settings.
Edit Default Alert Event Mapping. Opens the Edit Event Mapping dialog box
which enables you to change the default alert event mappings settings.
Edit Default Console Event Mapping. Opens the Edit Event Mapping dialog
box which enables you to change the default event mapping settings for the
SiteScope Event Console.

For user interface details, see "New/Edit Event Mappings Dialog Box - General Tab"
below and "New/Edit Event Mappings Dialog Box - Custom Attributes Tab" on page
557.
Title

Title string assigned to the setting profile when you create a new event.
The HP CDA Event Mapping template is included by default in the Common Event
Mappings. This template is used by CDA (Continuous Delivery Automation). For
details, see "Common Event Mappings Overview" on page 547.

Description Description of the mapping that was assigned when creating or editing the event.

New/Edit Event Mappings Dialog Box - General Tab
This dialog box enables you to create new common event mappings or edit existing mappings between
SiteScope runtime data and the attribute values that are used for sending events. These mappings are
used when configuring the Operations Manager event integration, the Generic Event integration, and
the SiteScope Event Console.
User interface elements are described below:
UI Element

Description

Main Settings
Name

The name used to identify the common event.
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UI Element

Description

Main Settings
Description

Description of the common event.

Common Event Model Settings
General
Title

Descriptive text describing the occurrence represented by the event. This should
include information about what threshold has been crossed (or other trigger
conditions), and the current values.
Default value:
l

l

l

For metric status change: Metric '<<metric>>' changed status from
'<<oldStatus>>' to '<<newStatus>>'
For alerts: Alert '<<alertName>>' was fired on monitor '<<fullMonitorName>>'
status change
For console events: Console Event was triggered due to alert '<<alertName>>'
being fired on monitor '<<fullMonitorName>>'

Tip: Since the text is typically shown within a single line in the event browser, it is
recommended to put the most relevant information at the beginning.
Description

Additional information describing the event.
Default value:
l

l

l

For metric status change: Metric '<<metric>>' crossed '<<thresholdCrossed>>'
with value '<<metricValue>>'
For alerts: Monitor '<<fullMonitorName>>' changed status from '<<oldStatus>>'
to '<<newStatus>>'
For console events: Monitor '<<fullMonitorName>>' changed status from
'<<oldStatus>>' to '<<newStatus>>'

Tip: When configuring console event mappings and using Predictive Analytics, we
recommend adding the <alertShortAnalyticsResults> attribute to the description to
provide a correlation that shows the monitor status of the 5 highest counters of the
Analytics Target monitors. This property is supported for alert events (monitor status
change only) in the SiteScope Event Console and OMi. It is not supported in Generic
Event Integration or for metrics status changes events (monitor events).

HP SiteScope (11.31)

Page 552 of 1395

Using SiteScope
Chapter 42: Common Event Mappings

UI Element

Description

Main Settings
Severity

Severity of the occurrence related to the event. The severity level can be Unknown,
Normal, Warning, Minor, Major, or Critical.
Default value: <<severity>>.
l

l

Category

For metric status change and alerts: It is taken from the severity mapping in the
HP Operations Manager Integration Advanced Settings panel (in Preferences >
Integration Preferences > HP Operations Manager Integration).
For console events: It is taken from the severity mapping in Event Console
Preferences. For details, see "Severity Mapping Preferences Dialog Box" on
page 577.

Value used for organizing or grouping events by monitor type.
Default value: <<monitorType>>
Examples: Database, Application, J2EE

Subcategor
y

Value used for organizing or grouping events that have the same category.
Default value:
l

For metric status change: <<metric>>

l

For alerts: <<fullMonitorName>>

l

For console events: <<fullMonitorName>>

Example: Oracle
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UI Element

Description

Main Settings
Log only

l

l

If False is selected, events are not written to the Event History view or to the
event history log file.
If True is selected, enables submitting an event that goes directly into the history
event browser in HPOM/OMi, or into the Event History view in the SiteScope
Event Console, as a closed event. Such an event goes through the complete
event processing, but has its Life Cycle State set to closed from the beginning.
These events are not displayed in the HPOM/OMi history event
browser/SiteScope Event Console.
Typical examples are events that result in resetting an indicator to a normal or
good state, or an event signaling that a previous problem no longer exists (where
the problem was reported in another event).

l

If True for normal severity is selected, all messages forwarded from SiteScope
to HPOM/SiteScope Event Console/external applications are sent to the
Acknowledged message browser/console (instead of the Active message
browser) if their severity is normal. This prevents the Active message browser
becoming unnecessarily cluttered with normal severity messages.

Default value:
l

For metric status change: False

l

For alerts: False

l

Event Type
Indicator

For console events: True for normal severity (this means that events triggered for
a monitor in normal severity (fired when the monitor status changes to Good), are
sent or written directly to history as closed events (they are available in the
history log and Event History view).

Link between the event and the indicator so that information about the indicator can
be updated as a result of submitting the event.
Default value:
l

For metric status change: <<etiType>>:<<etiValue>>:<<metricValue>>

l

For alerts: <<etiType>>:<<etiValue>>

l

For console events: no value

Example of metric status change: CPU Load:High:90
Note: This field is mandatory for updating the indicator. It is not recommended to
change the template value of this attribute.
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UI Element

Description

Main Settings
Correlation
Key

A unique string representing the type of event that occurred. Two events can have
the same key if both events represent the same situation in the managed
environment (the two events are duplicates). Duplicate events are discarded after
the number of duplicate events is increased in the "Number of Duplicates" count.
Default value:
l

l

l

For metric status change:
<<siteScopeHost>>:<<monitorUUID>>:<<metric>>:<<etiValue>>:<<severit
y>>
For alerts:
<<siteScopeHost>>:<<monitorUUID>>:<<alertName>>:<<etiValue>>
For console events:
<<siteScopeHost>>:<<monitorUUID>>:<<alertName>>:<<severity>>

Example of metric status change:
labmachine1:OMEventIntegration:CPU Utilization on SiteScope
Server:utilization:Good
Submit
close key
condition

Enables the close key pattern to be evaluated by the event subsystem. If selected,
enter the pattern in the Close key pattern box below.
Default value: Selected
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UI Element

Description

Main Settings
Close key
pattern

(This box is available only if Submit close key condition is selected.) Enables the
event that is sent to automatically close all the events whose key attribute matches
this expression. It is recommended that this field contain the same value as in the
Key field.
Note: SiteScope event integration policy always adds "<*>" to the end of your close
key pattern. The "<" and ">" signs cannot be used here since they cannot be
interpreted by the log file policy.
Default value:
l

For metric status change:
<<siteScopeHost>>:<<fullgroupid>>:<<monitorName>>:<<metric>>

l

For alerts: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>

l

For console events: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>

Example of metric status change:
labmachine1:OMEventIntegration:CPU Utilization on SiteScope
Server:utilization<*>
Advanced Parameters
CI hint

Information about the CI that is related to the event. This attribute is used for
providing hints to enable the event processing to find the correct related CI (RTSM
ID of the related CI).
Default value:
l

l

Host hint

<<ciHint>>. The value in this field varies, depending on whether SiteScope is
connected to BSM or HPOM. This field is not editable.
For console events: <<targetHost>>

The target host being monitored by the monitor that triggered the event. The value is
translated to the legacy node attribute in HPOM. If the node does not exist in HPOM,
the event will be lost.
Default value: <<targetHost>>
Examples:
l

IPv4: 15.15.12.13,

l

DNS: host1.hp.com
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UI Element

Description

Main Settings
Generating
source hint

Information about the monitoring application and the corresponding probe/agent that
is responsible for creating the event.
Default value: SiteScope@@<<siteScopeHost>>
Example: SiteScope@@host1.hp.com

Attributes
<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by dragging
it from the Attributes list to the selected text box, or select the cell in which to copy
the selected attribute, and click Ctrl+I.
For a description of the available attribute variables, see "Alerts, Alert Template, and
Event Properties" on page 1305.

New/Edit Event Mappings Dialog Box - Custom Attributes Tab
Use this tab to add custom attributes. Custom attributes can be used to provide additional information
about the event that is not provided in any of the other common event attributes.
l

l

l

Make sure that the name of the attribute you are defining is unique and does not already exist in the
list of factory attributes.
A custom attribute consists of a key and a value (both are strings). The value can be any string and
is used by the common event mapping as any other value.
You cannot rename any of the predefined custom mapping attributes (cma1-cma5).

User interface elements are described below:
UI Element Description
Enables creating a new custom attribute for the event. Each event can have any
number of custom attributes.
l

l

New Key. Adds a new line to the table, enabling you to add a name and value for
the attribute.
Known Key. Opens a submenu with the known keys as options. You can select
the relevant key. A new row opens in the Name/Value table, with the name of the
selected key in the Name column. You can then enter the value of the key in the
corresponding Value column.

Delete Custom Attribute. Deletes the selected custom attribute from the table.
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UI Element Description
Name and
Value

Each event can have any number of custom attributes. Custom attributes can be used
to provide additional information with the event that is not provided in any of the other
common event attributes or that is contained in any of the other attributes. Each
custom attribute is a Name-Value pair, where you enter the name of the attribute in
the Name field and the value of the attribute in the Value field.
This feature may be used when you manage the environment of multiple customers
using one instance of the product. The multiple customers might be handled by a
custom attribute object.
Example: Name = "cma1" ; Value = "XYZ Company"

Attributes
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UI Element Description
<Attributes Displays the list of available attribute variables. You can add an attribute by dragging it
list>
from the Attributes list to the selected box, or select the cell in which to copy the
selected attribute, and click Ctrl+I.
For a description of the available attribute variables, see "Alerts, Alert Template, and
Event Properties" on page 1305.
Default Console Event Mappings:
The following attributes are included in the Custom Attributes tab for the Default
Console Event Mapping template which is included by default in Common Event
Mappings:
l

l

l

<<monitorServiceId>>. Enables customizing the service name that is sent from
SiteScope events to the Event Console by entering the value of the monitor
service ID. This is useful for relating the SiteScope monitor with the HPOM
Service Name.
<<monitorDrilldownURL>>. Creates a hyperlink in the event to the monitor from
which the event was triggered.
<<unifiedConsoleUrl>>. Creates a hyperlink in the event to the Event Console in
the Unified Console.

HP CDA Event Mappings:
The following attributes are included in the Custom Attributes tab for the HP CDA
Event Mapping template which is included by default in Common Event Mappings (for
details on CDA, see "Common Event Mappings Overview" on page 547):
l

l

l

l
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<<TemplateDeployPath>>. Displays the full path to the template group from
which the monitor was deployed.
<<monitorServiceId>>. Enables customizing the service name that is sent from
SiteScope events to HPOM by entering the value of the monitor service ID. This is
useful for relating the SiteScope monitor with the HPOM Service Name.
<<monitorDrilldownURL>>. Creates a hyperlink in the event to the monitor
URL.
<<newStatus>>. Current status of the metric.
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Tips/Troubleshooting
Known Issues
l

l

l

You cannot delete a common event mapping if it is referenced by a monitor or an alert action. You
must change the event mapping referenced by the monitor or alert before you can delete the
mapping.
SiteScope might not be able to send events if a long description is entered, or if changes are made
to fields in common event mappings that result in field names being too long.
Do not use apostrophes ('') for custom mapping attribute values. For example, use <<alertName>>
instead of '<<alertName>>'.
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Credential Preferences provide centralized credential management for SiteScope resources. It enables
you to input user names and passwords for SiteScope monitors, templates, and remote hosts once as
a credential profile, and then have SiteScope automatically supply that information when you configure
those resources.

To access
Select Preferences > Credential Preferences.
To view or edit a credential profile, click the New/Edit Credential Profile button.
Note: You must be an administrator in SiteScope, or a user granted View credential list
permissions to be able to view Credential Preferences. Add, edit or delete credential
preferences permissions are required to create or edit Credential Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Learn About
Benefits of Credential Preferences
Using Credential Preferences enables you to:
l

l

l

l

l

Create and manage your credentials. You can add, modify, and delete credentials from one central
location.
Update credentials. If credentials for a resource expire or need to be updated, the credential profile
can be updated and the changes are applied to all usages of the resource within SiteScope. This
saves having to find and manually update all usages of the resource in SiteScope.
Keep user credentials secure. All passwords stored in Credential Preferences are encrypted. Only
an administrator, or a user granted Add, edit or delete credential preferences permissions, can
make changes to the credentials.
Search and replace by credential properties, and replace credentials with other credentials using
Global Search and Replace.
Copy monitors in SiteScope with their credential settings. You can also copy monitors to other
SiteScopes when there is more than one SiteScope connected to BSM (only available through SAM
Administration). If a credential profile does not exist in the SiteScope to which the monitor is copied,
the credential profile is created in that SiteScope.
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Supported Monitors
You can use Credential Preferences to store credentials for the following monitors:
Monitor Category
Application

Database

Server

Web Transaction

Virtualization and Cloud
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Monitor
l

COM+ Server Monitor

l

SAP CCMS Monitor

l

SAP CCMS Alerts Monitor

l

SAP Java Web Application Server Monitor

l

SAP Performance Monitor

l

SAP Work Processes Monitor

l

Siebel Application Server Monitor

l

WebSphere Application Server Monitor

l

Database Counter Monitor

l

DB2 JDBC Monitor

l

Oracle Database Monitor

l

HP NonStop Event Log Monitor

l

IPMI Monitor

l

URL Monitor

l

URL Content Monitor

l

URL List Monitor

l

VMware Datastore Monitor

l

VMware Host Monitors

l

VMware Performance Monitor
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Tasks
How to Configure Credential Preferences
This task describes the steps involved in configuring and managing credentials for SiteScope objects
that require user authentication.
1. Prerequisites
To create or make changes to the credentials, you must be an administrator in SiteScope, or a
user granted Add, edit or delete credential preferences permissions.
For details on user permissions, see "Permissions" on page 744.
2. Create a credential profile
Configure a credential profile in Credential Preferences for each SiteScope resource that requires
user authentication. For user interface details, see "Credential Preferences Page" on page 565.
For a list of supported monitors, see "Supported Monitors" on the previous page.
3. Configure SiteScope resources using credential profiles
When you configure a SiteScope resource that has a credential profile, select the profile in the
Credentials box in the resource's settings area.
n

For user interface details when configuring a monitor, see the Monitor Settings for the specific
monitor.

n

For user interface details when configuring a remote server, expand Main Settings in:
o

"New/Edit Microsoft Windows Remote Server Dialog Box" on page 475.

o

"New/Edit UNIX Remote Server Dialog Box" on page 495.

4. Update credential profiles
If credentials for a resource change, you can update the credential profile without having to find all
usages of the resource and update each resource separately in SiteScope. To change a profile,
select the profile in Credential Preferences, click Edit Credential Profile, and make the
necessary changes.
Note: You cannot delete a credential profile if it is referenced by a monitor. You must remove
the profile from each dependency before you can delete the profile.
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5. Results
SiteScope authenticates the login and password for the resource using the credentials supplied in
Credential Preferences.
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UI Descriptions
Credential Preferences Page
This page provides centralized credential management for SiteScope resources. This enables you to
add, update, and delete credentials that are used in configuring SiteScope monitors, templates, and
remote hosts.
User interface elements are described below:
UI Element

Description
New Credential Profile. Creates a new credential profile. For user interface details,
see "New/Edit Credential Profile Dialog Box" below.
Edit Credential Profile. Enables editing a credential profile. For user interface
details, see "New/Edit Credential Profile Dialog Box" below.
DeleteCredential Profile. Deletes the selected credential profile from Credentials
Preferences.
Select All. Selects all listed credential profiles.
Clear Selection. Clears the selection.

Name

Name string assigned to the setting profile when you create a new credential profile.

Login

User name to access the resource using this credential profile.

Description Description of the setting profile that was assigned when creating or editing the
credential profile.

New/Edit Credential Profile Dialog Box
This dialog box enables you to create a new credential profile or edit an existing profile. You use
credential profiles for storing and managing authentication credentials for SiteScope resources. This
page opens in view mode or edit mode depending on your user permissions.
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User interface elements are described below:
UI Element

Description

Main Settings
Name

Descriptive name for the credential profile.
Maximum length: 50 characters

Domain

Domain for the credential. During the connection, the domain is added to the login in
the format: <domain>\<login>.

Login

User name to access the resource using this credential profile.

Password

Password to access the resource using this credential profile.
All SiteScope passwords are encrypted using 3DES (also known as TDES or Triple
Data Encryption Algorithm). For more information, refer to Hardening the SiteScope
Platform in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

Confirm
password

Confirmation of the password entered in the Password box. This is used when
creating a new credential or changing the password of an existing credential.

Advanced Settings
Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Search/Filter Tags
<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.
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Tips/Troubleshooting
General Notes/Limitations
l

l

l

Copying credential settings to other SiteScopes is not supported when copying monitors to older
versions of SiteScope.
You cannot delete a credential profile if it is referenced by a monitor or a remote host. You must
remove the credential profile from each dependency before you can delete the credential profile.
If a credential that is used in a template remote host or template monitor has been deleted, you must
add the missing credential to Credential Preferences or manually enter credentials for the resource
in the template object before deploying the template.

Monitoring Credential Profiles
If user credentials expire or change, the monitors using these credentials fail and are in Error status. To
avoid this situation, you can create a monitor for each credential profile that checks the authentication,
and makes all monitors of the monitor type dependent on the test monitor.
For example, you can create an IPMI monitor, IPMI_test_credentials, and manually configure the
server login and password. When you configure your IPMI monitors, in the Dependencies panel, enter
IPMI_test_credentials in the Depends on box and select Available as the Depends condition. If
the IPMI_test_credentials monitor becomes unavailable for any reason, the IPMI monitors are
automatically disabled.
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Use this page to configure the settings SiteScope needs to communicate with an external email server.
These are the default settings that SiteScope uses to send event alerts as email messages.

To access
Select Preferences > Email Preferences.
Note: You must be an administrator in SiteScope, or a user granted View email, pager, HTTP
and SNMP lists permissions to be able to view Email Preferences. Add, edit or delete email,
pager, HTTP and SNMP preferences permissions are required to create or edit Email
Preferences. For details on this topic, see "User Management Preferences" on page 732.

Learn About
Email Preferences Overview
The Email Preferences page displays the defined custom Email Recipient profiles to send email alert
messages to recipients. The Email Recipient profile can be associated with one or more Email alerts by
editing the applicable alert definition.
Email is the default media for sending event alerts when a problem has been detected by SiteScope (in
addition to the visual icons and status messages displayed in the SiteScope interface). Use the Email
Preferences to indicate the SMTP mail server, recipient addresses, and other settings that SiteScope
should use when sending email alerts and other SiteScope messages (such as enabling SiteScope to
send emails securely via SSL SMTP servers).

UI Descriptions
This section includes:
l

"Email Preferences Page" on the next page

l

"New/Edit Email Recipient Dialog Box" on the next page

l

"Email Preferences Default Settings Dialog Box" on page 571
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Email Preferences Page
User interface elements are described below:
UI Element

Description
New Email Recipient. Creates a new Email Recipient profile. For user interface
details, see "New/Edit Email Recipient Dialog Box" below.
Edit Email Recipient. Enables editing the Email Recipient profile. For user interface
details, see "New/Edit Email Recipient Dialog Box" below.
Delete Email Recipient. Deletes the selected Email Recipient profile from Email
Preferences.
Test Email Recipient. Tests that you can send a message to the Email address.
Enter a message in the Email dialog box, and click Test.
Select All. Selects all listed Email Recipient profiles.
Clear Selection. Clears the selection.

Default
Settings

Click the arrow next to Default Settings, and select an option:
l

l

Name

Edit. Opens the Email Preferences Default Settings dialog box which enables you
to change the default settings displayed in the New Email Recipient dialog box.
For details on the settings, see "Email Preferences Default Settings Dialog Box"
on page 571.
Test. Test that you can send an email to the selected addresses. Select the email
recipients you want to test from the list of Available Recipients, or enter email
addresses in the Email addresses box.

Name string assigned to the setting profile when you create a new Email Recipient.

Description Description of the setting profile that was assigned when creating or editing the
profile.
Email

Email address to which the alert is to be sent.

Enabled

Status of the email alert. If the status is No, email alerts are stopped from being sent
to these email addresses.

New/Edit Email Recipient Dialog Box
This dialog box enables you to create a new Email Recipient profile or edit an existing profile.
SiteScope uses Email Recipient profiles for sending email alerts.
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Note: You must be an administrator in SiteScope, or a user granted View email, pager, HTTP
and SNMP lists permissions to be able to view Email Preferences. Add, edit or delete email,
pager, HTTP and SNMP preferences permissions are required to create or edit Email
Preferences. For details on this topic, see "User Management Preferences" on page 732.
User interface elements are described below:
UI Element

Description

Main Settings
Name

Name for the Email Recipient profile definition that is used to identify the profile in the
product display.

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.
Note: HTML code entered here is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans). If malicious
HTML code or JavaScript is detected, the entire field is rejected. The following is
prohibited HTML content:
l

l

l

Email to

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Email addresses to which you want to send the alert.
Example:test@mycompany.com
You can enter multiple email addresses by separating the email addresses with
commas.
Example:test@mycompany.com, sysadmin@thiscompany.com
Note: Emails can be sent securely via SSL SMTP servers if SMTP SSL is selected
in the "Email Preferences Default Settings Dialog Box" on the next page.

Disabled

Stops email alerts from being sent to these email addresses. Use this option to
temporarily disable a particular email without editing every alert that contains this
email setting.

Advanced Settings
Template

Template defining the email alert settings. Once a setting is defined, a single alert is
sent to people and pagers. Use the ShortMail template for pagers.
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UI Element

Description

Main Settings
Schedule

Specifies when email settings should be enabled. You may select a more restricted
schedule from the names schedules in the drop-down menu.
Default value: Every day, all day

Search/Filter Tags
<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.

Email Preferences Default Settings Dialog Box
This dialog box enables you to configure the default Email Recipient settings.
User interface elements are described below:
UI Element

Description

Email server
domain name

Domain name of the SMTP mail server that SiteScope should use when sending
email messages.
Example:mail.thiscompany.com
If you are unsure of your mail server's domain name, check with your System
Administrator.

Administrator
email address

Email address to which SiteScope should send status messages.

Daily status

SiteScope sends a brief daily status message to the administrator's email address.
This email is scheduled to be generated at 7:07 AM every day. The subject of email
sent includes SiteScope daily status. The email content includes the number of
active monitors and groups, along with a URL link to the applicable SiteScope
main page plus the version number of SiteScope installation.
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UI Element

Description

SiteScope
starts/restarts

SiteScope sends a brief message each time that SiteScope restarts. Restarts may
be an indication of a monitor run problem. For more information, see "SiteScope
Server Health Monitors" on page 1149.
Note:SiteScope no longer automatically restarts itself once a day.

From email
address

Email address used as the From Address for mail generated by SiteScope.
Specifying an email address may make it easier to browse and sort email sent by
SiteScope. If nothing is entered, the From email address stays the same as the
address where the mail is sent from.
Example:sitescope@mycompany.com
Note: If the mail server being used required NTLM authentication (see below), the
email address entered here must be a valid email address.

Backup email
server
domain name

Domain name of the SMTP mail server that SiteScope should use whenever the
primary mail server cannot be reached. If unsure of backup mail server's domain
name, check with the System Administrator.
Example:gateway.mycompany.com.

Login

Username required by the SMTP server. This user name is used for both the
primary and backup mail servers.
Note: You must restart SiteScope if you change this setting.

Password

Password required by the SMTP server. This password is used for both the
primary and backup mail servers.
Note: You must restart SiteScope if you change this setting.

NTLM
Select an NTML authentication option from the drop-down list:
authentication
l
none. Select if the mail server does not require NTLM authentication.
l

l

NTLMv1. Select if the mail server requires authentication using NTLM
version 1.
NTLMv2. Select if the mail server requires authentication using NTLM version

Note: You must restart SiteScope if you change this setting.
Default value: none
Timeout
(seconds)

Amount of time, in seconds, to wait for a response from the SMTP server. If a
response from the primary mail server is not received within the timeout period,
SiteScope switches to use the backup mail server.
Default value: 60 seconds
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UI Element

Description

SMTP SSL

Enables sending emails securely via SSL SMTP servers. When selected,
SiteScope sends all mails via SSL, except for the Mail monitor and Mail Round Trip
Tool which have their own SMTP mail setting.
Note: By default, mail is sent via port 465 of the SMTP mail server unless you
specify a different port in Custom SMTP Port (see below).
Default value: Not selected

Custom
SMTP Port
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Enables sending emails via a user-specified port. If this box is left empty, the
default port for sending mail is used (465 for the SMTP mail server).
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Event Console Preferences enable the SiteScope administrator to configure filters to allow different
group of users to focus on the events they need to see. For example, a NOC operator might need to see
events filtered by status or priority, whereas an application support expert might need to see events
associated to specific server monitors only.
For more details, see "Event Console" on page 1062.

To access
Select Preferences > Event Console Preferences.

Tasks
How to Configure Event Filters
This task describes the steps involved in configuring a filter to determine which events are displayed in
the Event Console.
1. Prerequisites
You must be an administrator in SiteScope, or a user granted the View and edit event console
preferences permission to be able to view and edit Event Console Preferences. For details on
permissions, see "User Management Preferences" on page 732.
2. Configure an event filter (based on the requirements of specific users or user groups)
a. Select Preferences > Event Console Preferences, and click New/Edit Event Filter to open
the New/Edit Event Filter dialog box.
b. Type a name and description for the filter in the General Settings pane.
c. In the Settings area of the Event Filters pane, select the event attribute values by which to
filter. For details, see "New/Edit Event Filter Dialog Box" on page 576.
Note: At least one check box must be selected for each group of event attributes (status,
severity, assigned to, lifecycle state, priority).
d. (Optional) You can also filter by event title, description, category, subcategory, or target of the
event you want to filter. To do so, type a regular expression to match against the event
attribute in the appropriate box.
3. Results
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Users can filter events in the Event Console by clicking the Filter
button and selecting any
of the predefined filters. For details, see "Event Console" on page 1062.

UI Descriptions
This section includes:
l

"Event Console Preferences Page - Event Filters" below

l

"New/Edit Event Filter Dialog Box" on the next page

l

"Severity Mapping Preferences Dialog Box" on page 577

Event Console Preferences Page - Event Filters
User interface elements are described below:
UI Element

Description
New Event Filter. Creates a new filter for displaying events sent to the Event
Console. For user interface details, see "New/Edit Event Filter Dialog Box" on the
next page.
Edit Event Filter. Enables editing the selected event filter. For user interface details,
see "New/Edit Event Filter Dialog Box" on the next page.
Delete Event Filter. Deletes the selected event filter from Event Console
Preferences.
Select All. Selects all listed event filters.
Clear Selection. Clears the selection.

Default
Settings

Click the arrow next to Default Settings, and select Edit Severity Settings. Opens
the Severity Mapping Preferences dialog box which enables you to change the default
severity mapping related to the event (see the Severity description in the "New/Edit
Event Mappings Dialog Box - General Tab" on page 551).
For details on the Severity Mapping Preferences dialog box, see "Severity Mapping
Preferences Dialog Box" on page 577.

Name

Name string assigned to the event filter for the Event Console.

Description Description for the event filter, which appears only when editing or viewing its
properties.
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New/Edit Event Filter Dialog Box
This dialog box enables you to create custom event filters to show only those SiteScope Event
Console events that meet the criteria that you define.
Note: If a regular expression used in the Title, Description, Category, Subcategory, or Target field
does not match any events, the full list of events is displayed in the Event Console. You can use
the Regular Expression Tool to check your regular expressions. For details, see "Regular
Expression Tool" on page 134.
User interface elements are described below:
UI Element

Description

General Settings
Name

Name string assigned to the event filter for the Event Console.

Description

Description for the event filter, which appears only when editing or viewing its
properties.

Event Filters
Settings

Create an event filter by selecting at least one setting from each of the following
groups:
l

l

l

l

l

Status: The monitor threshold status in SiteScope that corresponds to the
console event. The status can be Good, Error, or Warning.
Severity: Severity of the occurrence related to the event. The severity level can
be Unknown, Normal, Warning, Minor, Major, or Critical.
Assigned To: User who is responsible for solving the problem. This value can
be Me, Others, or None.
Lifecycle State: The state used to describe the lifecycle of the event. The
values can be Open, In progress, Resolved, or Closed.
Priority: The importance attached to the selected event. The values can be
None, Lowest, Low, Medium, High, or Highest.

Note: Severity mappings correlate the monitor threshold status in SiteScope to the
severity level in console events. If required, you can customize the event severity
mappings in the Severity Mapping Preferences dialog box in Preferences > Event
Console Preferences > Default Settings > Edit Severity Settings. For details,
see "Severity Mapping Preferences Dialog Box" on the next page.
Title
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UI Element

Description

Description

To filter events by description, type a regular expression to match against the
description.

Category

To filter events by category, type a regular expression to match against the
category.

Subcategory

To filter events by subcategory, type a regular expression to match against the
subcategory.

Target

To filter events by target, type a regular expression to match against the target.

Severity Mapping Preferences Dialog Box
This dialog box enables you to customize event severity mappings. Severity mappings correlate the
monitor threshold status in SiteScope to the severity level in console events. For details on the severity
levels, see the Severity description in the "New/Edit Event Mappings Dialog Box - General Tab" on
page 551.
User interface elements are described below:
UI Element

Description

Error

Mapping between the Error status threshold for each monitor instance in SiteScope
and the severity level in the console event.
Default value: Critical

Warning

Mapping between the Warning status threshold for each monitor instance in
SiteScope and the severity level in the console event.
Default value: Minor

Good

Mapping between the Good status threshold for each monitor instance in
SiteScope and the severity level in the console event.
Default value: Normal

Unavailable

Mapping between the Unavailable status threshold for each monitor instance in
SiteScope and the severity level in the console event.
Default value: Unknown
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Use this page to enter and view licensing information, and other general display functions, optional
functions, and access options for SiteScope. You can also configure SSH, WMI, JDBC, LW-SSO
(authentication), and Dashboard settings.
Note: For information on general preferences relating to internationalization issues, see
"Internationalization in SiteScope" on page 761.
To access
Select Preferences > General Preferences.
Note: You must be an administrator in SiteScope, or a user granted View general preferences
permissions to be able to view General Preferences. Edit general preferences permissions are
required to edit General Preferences. For details on this topic, see "User Management
Preferences" on page 732.

Learn About
Using Default Authentication Credentials
You can use this section to enter default authentication credentials that SiteScope uses to log into
certain applications and systems. This user name and password are used if the following conditions are
met:
l

l

No other authentication credentials are entered as part of an individual monitor configuration.
The target application or system requires authentication credentials. The URL monitor, URL
Sequence monitor, and Web Service monitor can use this function.

Suspending Monitor Processes
In large and complex monitoring environments, it is possible that SiteScope can become heavily loaded
with a large number of monitors running and the responsiveness may become slow. This may be due to
some monitors being configured to monitor too aggressively or systems that are becoming overloaded.
If monitoring actions are slowing the performance of SiteScope, it can be useful to temporarily suspend
monitoring actions to make configuration changes. You can temporarily suspend monitors to reduce the
time required to complete large configuration operations such as a global search and replace operation.
The Suspend all monitors option provides this function.
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Web Script Monitor Files Directory
The Web Script Monitor runs VuGen scripts to monitor performance and content on Web applications.
The VuGen scripts used by the monitor can be stored in the default directory for these scripts,
<SiteScope root directory>\templates.webscripts, or you can define a different directory in General
Preferences.
Note: The Web Script monitor is available only to users accessing SiteScope directly and not to
users accessing SiteScope by using SAM Administration in BSM.

UI Descriptions
Search Options
User interface elements are described below:
UI
Element
Find

Description
Enables you to search for a specific string in preference settings. Type the string you
want to find in the box. The search filter runs automatically after a letter is entered in the
box, and highlights the first matching result. If there are no matches, the box is
displayed in red.
The search automatically looks for the string in the first word of each setting label. To
check for the string anywhere else in the setting label, type an asterisk wildcard (*)
before the search string.
You can also use the question mark wild card (?) to represent one character only.
To clear the Find box, click the

button.

Find
Next

Finds the next occurrence of the string for which you are searching.

Find
Previous

Finds the previous occurrence of the string for which you are searching.

Highlight Highlights all occurrences of the search phrase for which you are searching.
Match
Case

Select to search for the filter string exactly as entered. Clear this option to ignore the
case of the filter string.
Default value: Not selected
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General Settings
User interface elements are described below:
UI Element

Description

VuGen scripts A directory to store the zip files of VuGen scripts for use by the Web Script
path root
Monitor. The files in the directory you enter here appear in the list of available
scripts when configuring the Web Script Monitor. If you do not enter a value here,
the files in the default directory
<SiteScope root directory>\templates.webscripts appear when configuring the
monitor.
For details on working with the monitor, see Web Script Monitor.
Default
Default user name to be used for authentication with remote systems. Both
authentication <username> and <DOMAIN>\<username> are valid formats. SiteScope uses this
user name
user name unless a different user name is entered explicitly as part of the monitor
configuration.
Default
Default password used for authentication with remote systems. SiteScope uses
authentication this password for the URL, URL Sequence, and Web Service monitor types unless
password
a different password is entered explicitly as part of the monitor configuration.
Pre-emptive
authorization

Displays the option used for authenticating the default user credentials when
SiteScope requests the target URL.
l

l

Authenticate first request. Sends the username and password on the first
request SiteScope makes for the target server.
Authenticate if requested. Sends the username and password on the second
request if the server requests a username and password.

Default value: Authenticate first request
SiteScope
restart
schedule

Enables selecting a schedule for restarting SiteScope (Off, Every 24 hours
after restart), or a schedule defined in Absolute Schedule Preferences. For
details on defining a schedule, see "Absolute Schedule Page" on page 714.
Default value: Off
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UI Element

Description

Number of
backups per
file

Displays the number of SiteScope configuration file backups to be kept. This
function helps preserve important monitor, alert, and general SiteScope
configuration information. This number represents the number of backups per file
that is maintained. SiteScope uses a naming convention of filename.bak.1,
filename.bak.2, filename.bak.#, where 1 is the latest backup file.
Example: You can backup files containing general SiteScope configuration
information in <SiteScope root directory>\groups.
Default value: 1

Localespecific date
and time

Displays dates and times in a format that is applicable to a certain locale, country,
or culture. To use a different locale setting, modify the SiteScope configuration file
to include the codes for the desired locale and select this option in the General
Preferences Settings. For details on how to perform this task, see "How to
Configure SiteScope for a Non-English Locale" on page 763.
Default value: Selected (the default is United States format)

International
version

Enables international character sets. When this option is selected, SiteScope
honors all character encoding. Use this option to instruct SiteScope to
simultaneously handle character encoding from multiple sources and operating
systems (for example, foreign language Web pages).
If not selected, only the default character set of the operation system where
SiteScope is installed is supported. The exceptions are all the URL monitor types,
the Log File Monitor, and the File Monitor. These monitor types support multiple
character encoding regardless of the International Version option setting. For
details on how to perform this task, see "How to Configure SiteScope for a NonEnglish Locale" on page 763.
Default value: Selected

Suspend all
monitors

Temporarily suspends the execution of all monitors. Use to make configuration
changes across your monitoring infrastructure. To reactivate monitoring, clear the
option.
Note: This option disables all monitors currently defined for this SiteScope
installation. If setting Suspend Monitors and later clearing this option to re-enable
the monitors, the individual monitors that were set as disabled prior to the Suspend
Monitors action, retain their original disabled state.
Using this option may affect reports. Monitors that would have run during the time
that monitoring was suspended may display blanks for that period in reports.
Warning: There is currently no visual indication in the interface that SiteScope is
in a suspended monitor state. When the Suspend all monitors option is enabled,
the following message is displayed: SiteScope is in Suspended mode; no
monitors are currently running.
Default value: Not selected
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Licenses
The Licenses panel enables you to view the license edition, status, and capacity type details for all
installed licenses. It also enables you to import a license file to SiteScope, and to try the free 30-day
Trial Edition when using the Community edition.
To access
Important
information

Select Preferences > General Preferences > Licenses
l

l

l

To use SiteScope, you must have a valid license. SiteScope comes with the
Community edition license that is automatically activated after performing a
regular SiteScope installation. It enables partial functionality of SiteScope for an
unlimited period of time. To obtain full SiteScope functionality, you need to
purchase a commercial edition license. For license purchase inquiries (or if you
require additional capacity), contact your HP sales representative or use the
“Contact Us” link in the HP SiteScope Product page. If you own a license and
require a license key file, use the HP Licensing for Software Portal.
After upgrading to SiteScope 11.30, it might take a short period of time before the
Licensing panel is updated with the current licenses.
If you upgrade the license of a SiteScope for Load Testing installation to Premium
edition, you must perform the following changes to get the full functionality of
Premium edition:
a. Select Preferences > Infrastructure Preferences > Custom Settings, and
set the values of the following properties to:
o

disableRepeatedSchedules=false

o

disableReports=false

o

MultiViewDashboardEnabled=true

b. Restart SiteScope.
Note: Alternatively, you can remove the _
disableRepeatedSchedules=true, _disableReports=true, _
MultiViewDashboardEnabled=false properties from the <SiteScope root
directory>\groups\master.config file, and then restart SiteScope.
See also

SiteScope Licenses and Editions section in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element

Description

<License
summary>

Displays the active SiteScope edition, and a summary of the capacity type
(availability and usage).
The edition can be:
l

l

l

l

l

l

Community. This edition is instantly available upon a regular SiteScope
installation. It enables partial functionality of SiteScope for an unlimited period of
time, for free. The license has a fixed capacity for monitoring up to 25 Operating
System instances (OSi) and 25 URLs (the capacity cannot be increased).
Trial. Enables the full functionality of SiteScope during a free 30-day trial period
(the number of days remaining is displayed on the license). When activated from
Community edition, the Trial license includes a capacity for monitoring up to 25 OS
instances, 25 URLs, and 10 transactions.
Premium/Ultimate. Enables full functionality of SiteScope (there is a difference in
the integrations that are supported in Premium edition). All capacity types (OSi,
URL, Transaction) are supported in these editions; the quantity is determined by
the user.
System Collector. A version of SiteScope provided with HP Operations Manager
Integration that enables SiteScope monitors to be used on HPOM applications.
This edition is available for monitoring OS instances only (the quantity is
determined by the user).
Load Testing. This edition is automatically activated after installing the HP
SiteScope for Load Testing setup type, a version of SiteScope provided with HP
LoadRunner/Performance Center that enables users to define and use SiteScope
monitors on a LoadRunner or Performance Center application. The license
includes a fixed capacity for monitoring up to 25 OS instances and 25 URLs (the
capacity cannot be increased).
Failover. Enables functionality of SiteScope Failover when the primary SiteScope
server is down. The Failover license must be imported after installing SiteScope
Failover (the Failover license is provided with the Premium, Ultimate, and System
Collector editions at no additional cost).

The license can include the following capacity types:
l
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OSI (Operating System Instance). Used by the majority of monitors except URLtype, Web Script, Web Service, Link Check, XML Metrics, and free monitors. This
license model is calculated according to the number of hosts or operating system
instances being monitored. SiteScope consumes one OS instance per monitored
host, regardless of the number of monitors that are monitoring this host. OS
instances are not aggregated between different editions, because the cost of an
OS instance license differs for each edition type. However, OS instances are
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UI
Element

Description
aggregated between OS licenses of the same edition (for example if you have
multiple Premium edition licenses each containing OS instances).
l

l

URL. Used by all URL-type monitors, Web Service, Link Check, and XML Metrics
monitors. Each monitored URL or URL step consumes one URL license instance.
URL licenses are aggregated from all editions, except from the Community, Trial,
and Load Testing edition which have their own URL license.
Transaction. Used by Web Script monitors to monitor VuGen script transactions.
Each monitored transaction consumes one Transaction license instance.
Transaction licenses are aggregated from all editions, except from the Community
and Load Testing editions which do not support transaction monitoring.

License
file

Enter the path to your SiteScope license file, or click the Select button, and select the
license file.

Import

Imports the licenses from the selected license file.

Remove
License

Deletes the selected license.

Trial
License

Activates the 30-day free trial license, that enables you to use SiteScope with full
functionality.

Installed Licenses
Show only
active
licenses

Select to include only active licenses in the table.

Edition:
Capacity
Type

Lists the installed edition licenses grouped by capacity type. Click the expand (+) icon
to show all licenses for the selected capacity type. For a description of the SiteScope
editions and capacity types, see "<License summary>" on the previous page.
For more details, see the SiteScope Licenses section in the SiteScope Deployment
Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Capacity

The total capacity for each capacity type.
If you expand OSI/URL/TRANSACTION (Total), you can see the total capacity of
the selected capacity type for each license edition.
Note: The Transaction capacity type is not available in Community, System Collector,
or Load Testing edition. The URL capacity type is not available in System Collector
edition.
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UI
Element

Description

Used

The total number of instances being used by each capacity type.
If you expand OSI/URL/TRANSACTION (Total), you can see the total number of
instances that are being used by each edition for the selected capacity type.

Remaining The total number of unused instances for each capacity type.
If you expand OSI/URL/TRANSACTION (Total), you can see the total number of
available instances in each edition for the selected capacity type.
Expires

The expiration date of the first license to expire for each capacity type.
If you expand OSI/URL/TRANSACTION (Total), you can see the expiration date of
each edition for the selected capacity type.

Status

The status of the license (Active, Expired, Suspended). Only one license can be
active at a time.
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SSH Preferences
This panel enables you to configure preferences for securely accessing a remote computer.
To access

Select Preferences > General Preferences > SSH Preferences

User interface elements are described below:
UI Element

Description

SSH V2 connect
timeout (seconds)

Total number of seconds SiteScope should wait for a successful reply.
When the time is exceeded, the connection is automatically closed.
Default value: 30 seconds

SSH V2 hello timeout
(seconds)

Handshake timeout (in seconds).

SSH V2 key exchange
timeout (seconds)

Total number of seconds SiteScope should wait for SSH key exchange.

SSH V2 authentication
phase timeout
(seconds)

Total number of seconds SiteScope should wait for SSH authentication.

Default value: 30 seconds

Default value: 30 seconds

Default value: 30 seconds

WMI Preferences
This panel enables you to configure preferences for using Windows Management Instrumentation
(WMI) to access a remote computer. WMI is a more secure communication method than NetBIOS for
gathering data from remote servers running on Windows servers.
To access

Select Preferences > General Preferences > WMI Preferences

Relevant tasks

"Configure the WMI Service for Remote Windows Monitoring" on page 488

Important
information

"Monitors Supporting Windows Management Instrumentation (WMI)" on
page 275

User interface elements are described below:
UI Element

Description

SiteScope NT
Localhost method

Connection type method (NetBIOS or WMI) for monitoring Windows server
resources on the localhost machine.
Default value: NetBIOS
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UI Element

Description

WMI query timeout
(seconds)

WMI query timeout, in seconds, for each monitor run. If this box is empty,
the timeout is 120 seconds.
Default value: 120 seconds

Dashboard Monitor History View Options
This panel enables you to configure Monitor History settings to view monitor history on all monitors and
monitor groups.
To access

Select Preferences context > General Preferences > Dashboard Monitor History
View Options

Important
In the Dashboard layout, you can then use a filter to further limit the monitors
information displayed to those that meet selected criteria. Your preferences are saved with the
Dashboard filter settings. For details, see "Customizing the SiteScope Dashboard"
on page 1034.
User interface elements are described below:
UI Element

Description

Enable monitor
history view

Enables Monitor History in Dashboard. Disabling this option after it has been
enabled deletes all the view data displayed in the history view.
Default value: Not selected

Collect monitor
Time frame for displaying past runs. Older runs are dropped. This setting
history data
overrides any dashboard filtering. To change dashboard filter settings, see
during time period "Monitor History Settings" on page 1046.
Default value: Past 1 hour
Collect monitor
run statuses

Displays the required run status. Runs with other statuses are dropped. This
setting overrides any dashboard filtering.
Default value: Any

Maximum number
of runs to display

Number of rows of data to keep in memory.
Default value: 100000
Minimum value: 1000
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JDBC Global Options
This panel enables you to apply global JDBC options to the SiteScope database logger, the Database
Connection and Database Information tools, Database alerts, and Database monitors (Oracle
Database, Database Counter, Database Query, DB2 JDBC, Technology Database Integration).
To access

Select Preferences > General Preferences > JDBC Global Options

User interface elements are described below:
UI Element

Description

Connection Amount of time, in seconds/minutes/hours/days, to wait for a new SQL connection to
timeout
be made. Not all SQL drivers have this function. If your SQL driver does not support
this function, this parameter is ignored.
Default value: 5 minute
Driver trace Creates a driver trace log file for troubleshooting database drivers. To create the log
log file
file, enter the full path or UNC name of the driver trace file (for example,
e:\mydir\myfile.log).
Note: The target log file can contain login information, table names and queries.
Tip: We recommend using this option for troubleshooting purposes only (it is empty
by default).

LW SSO Settings
This panel enables you to change the Lightweight Single Sign-On (LW-SSO) authentication string in
SiteScope.
To access

Select Preferences context > General Preferences > LW SSO Settings
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User interface elements are described below:
UI
Element Description
LW
SSO
Init
String

Must contain a shared string that is used by all trusted applications integrating with HP's
Lightweight Single Sign On (LW-SSO).
Tip: We recommend using at least 12 characters for the passphrase parameter. You can
use any Unicode character, excluding the surrogate blocks, FFFE, and FFFF.
Note: The default SiteScope passphrase string is not secured. To use a secured string,
change the default passphrase value in SiteScope and for all HP software applications
that are integrated using LW-SSO.
For details on LW-SSO, see "How to change the LW-SSO string in SiteScope" on page
772.
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You can use HTTP Preferences to configure the settings SiteScope needs to communicate with HTTP
connectors, which are used for reporting not only data and events, but also for monitors that use HTTP
preferences. SiteScope uses the SiteScope HTTP recipient to integrate with HTTP-based network
management systems and to send generic event data to third-party applications and management
consoles.

To access
Select Preferences > HTTP Preferences.
l

To create a new HTTP recipient, click the New HTTP Recipient button.

l

To edit an existing recipient, click the Edit HTTP Recipient button .
Note: You must be an administrator in SiteScope, or a user granted View email, pager, HTTP
and SNMP lists permissions to be able to view HTTP Preferences. Add, edit or delete email,
pager, HTTP and SNMP preferences permissions are required to create or edit HTTP
Preferences. For details on this topic, see "User Management Preferences" on page 732.

Tasks
Related Task: "How to Configure SiteScope Generic Event Integration" on page 691

UI Descriptions
This section includes:
l

"HTTP Preferences Page" below

l

"New/Edit HTTP Recipient Dialog Box" on the next page

HTTP Preferences Page
The HTTP Preferences page displays the defined custom HTTP recipients or templates to send data to
hosts. HTTP recipients can be associated with connectors in the Generic Events integration, when
configuring connection type. For details, see "Generic Event Integration Preferences" on page 689.
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User interface elements are described below:
UI Element

Description
New HTTP Recipient. Creates a new HTTP recipient. For user interface details, see
"New/Edit HTTP Recipient Dialog Box" below.
You must be an administrator in SiteScope, or a user granted Add, edit or delete
email, pager, HTTP and SNMP preferences to be able to create or edit HTTP
Preferences. For details on this topic, see "User Management Preferences" on page
732.
Edit HTTP Recipient. Enables editing the HTTP recipient. For user interface details,
see "New/Edit HTTP Recipient Dialog Box" below.
You must be an administrator in SiteScope, or a user granted Add, edit or delete
email, pager, HTTP and SNMP preferences to be able to create or edit HTTP
Preferences. For details on this topic, see "User Management Preferences" on page
732.
Delete HTTP Recipient. Deletes the selected HTTP recipient from HTTP
Preferences.
Note: You cannot delete an HTTP recipient if it is referenced by a Generic Event
Integration. You must change the HTTP recipient in the Generic Event Integration
before you can delete the HTTP recipient.
Test HTTP Recipient. Tests that you can send a message to the HTTP recipient.
Enter a message in the Test HTTP recipient dialog box, and click Test.
Select All. Selects all listed HTTP recipients.
Clear Selection. Clears the selection.

Name

Name string assigned when you create a new HTTP recipient.

Description Description that was assigned when creating or editing the HTTP recipient.
URL

Endpoint URL to be used for data or event reporting and in monitors that will use
HTTP preferences.

New/Edit HTTP Recipient Dialog Box
This dialog box enables you to create a new HTTP recipient or edit an existing recipient.
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User interface elements are described below:
UI Element

Description

General Settings
Name

Name string assigned when creating a new HTTP recipient.

Description

Description for the HTTP recipient, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags
to control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire
field is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

HTTP Preferences Settings
URL

Endpoint URL of the application that receives all HTTP messages.
If secure connection (SSL), then enter https.
Syntax:http or https://<fully qualified domain name of the receiving
server>:<port number receiving data>/<path>

Request
headers

Header request lines sent by the HTTP client to the server. Headers should be
linebreak separated. The standard list of HTTP1.1 request headers can be found in
http://www.w3.org/Protocols/rfc2616/rfc2616-sec14.html#sec14.
Note: Although this field is optional, some Web pages behave unexpectedly when
the request header is missing (such as performing endless redirects, providing
wrong content, and so forth).

URL content
encoding

SiteScope retrieves the correct encoding from the server response. The default
value appearing here should not be edited.
Default value: Encoding from server response
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UI Element

Description

General Settings
POST data
encoding

Determines if the POST data is encoded. Select from the following options:
l

HTTP version

Use content type. Decide to encode the POST data by the content type
header. If the header equals urlencoded then encode, otherwise do not
encode.

l

Force URL encoding. Always encode the post data.

l

Do not force URL encoding. Do not encode the POST data.

HTTP version for SiteScope to use for style request headers (HTTP version 1.1 or
1.0).
Default value: 1.1

Use WinInet

WinInet is used as an alternative HTTP client for this monitor.
Select this option to use WinInet instead of Apache when:
l

l

The Apache HTTP client does not support a specific technology required to
access the server you are monitoring. For example, Kerberos authentication is
not supported by the Apache library, and is supported by WinInet. WinInet also
supports trusted client-side certificates while Apache does not.
You tried running this monitor and the Apache server returned errors. Using
WinInet may solve these errors.

Default value: Not selected
Note: WinInet functionality is available on Windows versions of SiteScope only.
Error on
redirect

Generates an error (and notifies you) if a URL is redirected.

Request
timeout
(seconds)

Amount of time, in seconds, to wait for the HTTP requests (including retries) to
complete. A timeout value of zero is interpreted as an infinite timeout.

Connection
timeout
(seconds)

Amount of time, in seconds, to wait until a connection is established. A value of
zero means the timeout is not used.

Number of
retries

Number of times each HTTP request should be retried before SiteScope considers
the request to have failed.

Default value: Not selected

Default value: 120

Default value: 120

Default value: 3
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UI Element

Description

General Settings
Authentication If selected, authentication (when requested) is done using the Web Server user
when
name and password.
requested
Default value: Selected
Web Server Security Settings
Credentials

Option to use for authorizing credentials if the URL specified requires a name and
password for access:
l

l

Pre-emptive
authorization

Use user name and password. Select this option to manually enter user
credentials. Enter the user name and password to access the URL in the User
name and Password box.
Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the URL
(default option). Select the credential profile to use from the Credential profile
drop-down list, or click Add Credentials and create a new credential profile.
For details on how to perform this task, see "Credential Preferences" on page
561.

Option for sending authorization credentials if SiteScope requests the target URL:
l

l

Use global preference. Select to have SiteScope use the setting specified in
the Pre-emptive authorization section of the General Preferences page.
Authenticate first request. Select to send the user name and password on
the first request SiteScope makes for the target URL.
Note: If the URL does not require a user name and password, this option may
cause the URL to fail.

l

Authenticate if requested. Select to send the user name and password on
the second request if the server requests a user name and password.
Note: If the URL does not require a user name and password, this option may be
used.

All options use the User name and Password entered for this monitor instance. If
these are not specified for the individual monitor, the Default authentication user
name and Default authentication password specified in the Main section of the
General Preferences page are used, if they have been specified.
Note: Pre-emptive authorization does not control if the user name and password
should be sent, or which user name and password should be sent.
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UI Element

Description

General Settings
Client side
certificate

The certificate file, if you need to use a client side certificate to access the target
URL. Normally, this is a .pfx (.p12) type certificate, which usually requires a
password. You enter the password for the certificate in the Client side certificate
password box.
Note: Client side certificate files must be copied into the <SiteScope root
directory>\templates.certificates directory.
Default value: none

Client side
certificate
password

Password if you are using a client side certificate and that certificate requires a
password.

Authorization
NTLM domain

Domain for Windows NT LAN Manager (NTLM) authorization if required to access
the URL.

Default value: Empty

Default value: Empty
Accept
untrusted
certificates for
HTTPS

If you are accessing a target URL using Secure HTTP (HTTPS) and SiteScope
does not have the required server certificates, you can either select this option or
import the related certificates. For details on importing server certificates, see SSL
Connectivity in "URL Monitor" in the SiteScope Monitor Reference Guide.
Default value: Not selected

Accept invalid
certificates for
HTTPS

Select this option if you are accessing a target URL using Secure HTTP (HTTPS)
and SiteScope has invalid server certificates. This may happen, for example, if the
current date is not in the date ranges specified in the certificate chain.
Default value: Not selected

NTLM V2

Select if the URL you are accessing requires authentication using NTLM version
2.
Default value: Not selected

Proxy Server Settings
Address

Address of the proxy server, if applicable.

User name

Proxy server user name if the proxy server requires a user name to access the
URL.
Note: Your proxy server must support Proxy-Authenticate for these options to
function.
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UI Element

Description

General Settings
Password

Proxy server password if the proxy server requires a user name to access the
URL.
Note: Your proxy server must support Proxy-Authenticate for these options to
function.

Search/Filter Tags
<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created
for the SiteScope, this section appears but is empty. If tags have been created,
they are listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag
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Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.
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You use High Availability Preferences to configure SiteScope Failover behavior. SiteScope Failover is
a separate installation of SiteScope that is designed to automatically assume the functions of a
SiteScope system (referred to as the primary system) if the system fails or is temporarily taken out of
service.
For details on SiteScope Failover, see "SiteScope Failover Overview" on page 16.

To access
Select Preferences > High Availability Preferences.
Note: You must be an administrator in SiteScope, or a user granted View high availability
preferences permissions to be able to view High Availability Preferences. Edit high availability
preferences permissions are required to edit High Availability Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Tasks
How to Configure a SiteScope Failover Profile
This task describes how to use SiteScope Failover Preferences to configure a SiteScope Failover
profile.
1. Prerequisites
You must be an administrator in SiteScope, or a user granted Edit high availability preferences
permissions, to be able to create or make changes to the SiteScope Failover profile.
For details on user permissions, see "User Management Preferences" on page 732.
2. Create or edit a profile
In the SiteScope Failover user interface, select Preferences > High Availability Preferences,
and build a new profile or modify an existing profile. (From the primary SiteScope user interface,
you can only test or delete profiles.)
For user interface details, see "New/Edit Failover Profile Dialog Box" on page 599.
Note: The Lightweight single sign-on authentication authentication strategy is required for
SiteScope Failover. See "Authentication Strategies" on page 768.
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UI Descriptions
This section includes:
l

"High Availability Preferences Page" below

l

"New/Edit Failover Profile Dialog Box" on the next page

l

"Default Failover Server Settings Dialog Box" on page 606

High Availability Preferences Page
This page enables you to manage SiteScope Failover profiles. It provides different commands
depending on whether it is accessed from the primary SiteScope user interface or the SiteScope
Failover user interface.
User interface elements are described below:
UI
Element

Description
New Failover Profile. Opens the New Failover Profile dialog box. For user interface
details, see "New/Edit Failover Profile Dialog Box" on the next page.
Note: This is available on the SiteScope Failover server only.
Edit Profile. Opens the Edit Failover Profile dialog box. For user interface details, see
"New/Edit Failover Profile Dialog Box" on the next page.
Note: This is available on the SiteScope Failover server only.
Delete Profile. Deletes the selected profile from High Availability Preferences. This
can be performed from either the primary SiteScope or SiteScope Failover. If the
remote SiteScope (for instance, SiteScope Failover if you are on primary SiteScope) is
not accessible at the time of deletion, the profile is deleted only from the local
SiteScope. You must then manually delete the profile from the remote SiteScope user
interface.
Tip: You can disable a profile instead of deleting it. See Main Settings > Profile
disabled in the Edit Failover Profile Dialog Box.
Select All. Selects all listed profiles.
Clear Selection. Clears the selection.
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UI
Element
Default
Settings

Description
On the primary SiteScope server, click the arrow next to Default Settings, and select:
Test. Tests the profile and checks access to remote SiteScope Failover.

l

On the SiteScope Failover server, click the arrow next to Default Settings, and select
an option:
l

l

Test. Displays the Test High Availability dialog box. Using the dialog box, you can
first test an email address of a notification recipient by entering the email address in
the Send email to field and clicking Send Test Notification. The recipient can
verify that the notification is received in their email, to ensure that future
notifications will be delivered correctly.
You can then click the Test button to test the profile and verify access to the
primary SiteScope.
Edit. to change the default settings used for sending email notifications from the
Failover server. For details on the settings, see "Default Failover Server Settings
Dialog Box" on page 606.

Profile
Type

Indicates whether the High Availability Preferences page is being accessed on a
primary SiteScope or SiteScope Failover server.

Remote
Host

On the primary SiteScope, the remote host is the SiteScope Failover host. On the
SiteScope Failover host, the remote host is the primary SiteScope host.

Enabled

Indicates whether the profile is enabled (Yes/No). To disable or enable a profile, access
it from the SiteScope Failover user interface.

New/Edit Failover Profile Dialog Box
This dialog box enables you to create a new high availability profile or edit an existing profile. This
dialog box is available on the SiteScope Failover server only.
Note:
l

l

Only an administrator in SiteScope, or a user granted Edit high availability preferences
permissions can create or make changes to High Availability Preferences. For details on this
topic, see "User Management Preferences" on page 732.
The LW-SSO authentication strategy is required for SiteScope Failover. See "Authentication
Strategies" on page 768.
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User interface elements are described below:
UI Element

Description

Main Settings
Host

Enter the name or IP address of the server that is to be the primary server
for this SiteScope Failover server.
The SiteScope Failover checks the availability of the primary SiteScope
and mirrors the monitoring configurations from it.
Note: For an SSL environment, make sure that the primary SiteScope
host name is identical to that used in the server certificate (the name is
case sensitive), otherwise the connection will fail due to an SSL error.

Port

Enter the port of the user interface for the primary SiteScope Server host
specified above.
Default value: 8080

Secure connection

Enables SSL on the SiteScope Failover server. Using SSL has the
following requirements:
l

l

l

The primary SiteScope and the SiteScope Failover must either be
both enabled for SSL or both disabled. That is, you cannot have one
enabled for SSL and one using standard protocol.
The Port field above must specify the SSL-specific port.
Certificates must already be imported to the SiteScope Failover host
before the profile is created.

For more information, see "Add Certificates to SSL-Enabled SiteScope
Failover" in the HP SiteScope Failover Guide.
Default value: Not selected
Profile disabled

Disable the profile, which stops all monitoring and mirroring of the primary
by this instance of the SiteScope Failover.
Default value: Not selected

Run Settings
Primary availability
every (seconds)

Choose the frequency of checking the availability of the primary
SiteScope server; specify an integer in the range 15-10000.
Default value: 60 seconds
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UI Element

Description

Main Settings
Mirror every (minutes)

Choose the frequency of copying configuration data from the primary
SiteScope server to the SiteScope Failover server; specify an integer in
the range 15-10000. This setting keeps the SiteScope Failover server
synchronized with the same updates and changes to the monitoring
configuration on the primary SiteScope server.
Default value: 240 minutes (4 hours)

Pause (minutes)

Choose the delay in automatically switching the SiteScope Failover
server to active mode when the primary SiteScope server begins a
planned shutdown. Enter an integer in the range 0-20. A planned
shutdown is one of the following:
l

A scheduled restart occurs

l

A restart requested through the user interface occurs

Default value: 3 minutes
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UI Element

Description

Main Settings
Schedule

Choose the schedule for mirroring and checking availability of the primary
SiteScope. Schedules must be specified in Preferences > Schedule
Preferences > Failover Schedule Preferences before they can be
chosen here.
If you choose an absolute schedule, mirroring occurs as determined by
the schedule; the Mirror every (minutes) setting above is ignored. For
example, if the absolute schedule specifies mirroring happens at 6:00 AM
every day then mirroring happens only at 6:00 AM regardless of the
Mirror every (minutes) setting.
An absolute schedule does not affect the frequency of checking
availability of the primary SiteScope. That frequency is determined by the
Primary availability every (seconds) setting.
If you choose a range schedule, it is combined with the frequencies
specified by the Primary availability every (seconds) and Mirror every
(minutes) settings above. For example assume the profile has the
following values:
Schedule: a range schedule enabled between 1 PM and 5 PM
Primary availability every (seconds): 3600 seconds
Mirror every (minutes): 240 minutes
The resulting mirroring and primary availability checking:
1 PM availability check
1 PM mirroring
2 PM availability check
3 PM availability check
4 PM availability check
5 PM availability check
5 PM mirroring

Last mirror time

The time and date of the most recent mirroring operation.

Next mirror time

The time and date of the next scheduled mirroring operation based on the
specified Primary availability every (seconds) and Schedule values in
the profile.
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UI Element

Description

Main Settings
Click to begin mirroring of the primary SiteScope.
The SiteScope Failover instance restarts when the mirroring operation is
complete. After the restart, refresh your Web browser or redirect it to the
SiteScope Failover URL.
After mirroring, a copy of all of the groups from the primary SiteScope
should display in the SiteScope Failover instance's Monitor context.
Their status is disabled until the SiteScope Failover is activated.
Notification Settings
Emails on primary
restored

Enter one or more email addresses to receive notification when the
primary SiteScope server becomes available after a period of being
unavailable. Separate multiple entries with commas.
Note: Emails are sent securely via SSL SMTP servers if SMTP SSL is
selected in the "Email Preferences Default Settings Dialog Box" on page
571.

Emails on primary
unavailable

Enter one or more email addresses to receive notification when the
SiteScope Failover becomes active.
Note:
l

l

If primary SiteScope performs a planned shutdown and is restored
within the time specified by the Pause field value, the SiteScope
Failover does not become active.
Emails are sent securely via SSL SMTP servers if SMTP SSL is
selected in the "Email Preferences Default Settings Dialog Box" on
page 571.

Advanced Settings
Number of backups

Number of backups with the primary SiteScope configuration.
Default value: 2

Mirroring
configuration

Predefined settings that describe the mirroring strategy.

Disable BSM
Integration

Select if you do not want SiteScope Failover to report to BSM.

Default value: default

Note: You must restart the SiteScope Failover server for changes to this
setting to take effect.
Default value: Not selected
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UI Element

Description

Main Settings
Merge back *.dyn files

If selected, sends the *.dyn files created when SiteScope Failover was
active back to the primary SiteScope when it becomes active.
SiteScope uses internal files with the .dyn suffix to store data on which
consecutive monitor run counts and monitor states are based. For some
monitor types, it is important to have the *.dyn file include data from when
an active SiteScope Failover took over the monitor runs. You can choose
to have the *.dyn file data from an active SiteScope Failover merged
back to the primary SiteScope *.dyn files when primary SiteScope is
restored. This ensures that all monitor runs, both primary and failover,
contribute to the data.
This setting is relevant for Microsoft Windows Event Log Monitor, Log
File Monitor, and other monitor types.
Default value: Not selected
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UI Element

Description

Main Settings
Merge back
configuration

If selected, sends configuration data created when SiteScope Failover
was active back to the primary SiteScope when it becomes active.
Merge back configuration overwrites changes performed on the primary
SiteScope after the last mirroring operation, resulting in the loss of those
changes. To reduce the risk of losing this information, it is recommended
that you schedule the interval between mirroring operations to be as short
as possible.
Before performing a merge back configuration, SiteScope backs up the
existing configuration on the primary SiteScope to a folder in <SiteScope
root directory>\high_availability\snapshots named based on the time
of the backup operation. To restore a backed up configuration, run the
script restore.bat (restore.sh on Unix) and restart SiteScope. Backups
expire after 30 days.
Example: The last mirroring operation was performed at 10 AM. The
primary SiteScope failed at 11 AM and was restored at 3 PM. As a result
of merge back configuration, configuration data changes on the primary
SiteScope between 10 AM and 11 AM have been lost. You can restore
the changes made on the primary SiteScope between 10 AM and 11 AM
from the relevant backup file. If you do this, changes made on the
SiteScope Failover between 11 AM and 3 PM will be lost from the active
primary SiteScope. However, these changes are also backed up in
<SiteScope root directory>\high_availability\snapshots and can be
restored.
Note:
l

l

l
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Perform merge back configuration only if you plan to modify monitors
on the SiteScope Failover. This is to prevent possible mismatching of
data between the primary SiteScope and the SiteScope Failover.
You do not need to enable merge back configuration in advance; it
can be enabled on the SiteScope Failover server even when the
primary SiteScope is down.
All merge back operations occur when the primary SiteScope restarts
after a failure and the SiteScope Failover is in active mode at that
time. If merge back operations cannot be performed in real time for
technical reasons (for example, SiteScope Failover is disabled or
unavailable due to network issues), merge back operations cannot be
performed, either at that time or in the future. This is to prevent
possible mismatching of data between the primary SiteScope and the
SiteScope Failover.
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UI Element

Description

Main Settings
Default value: Not selected
Merge back daily log
files

If selected, sends the daily log files that were created when SiteScope
Failover was active back to the primary SiteScope when it is restored.
These files are used for reports.
Default value: Not selected

Default Failover Server Settings Dialog Box
This dialog box enables you to configure the default notification settings. This dialog box is available on
the SiteScope Failover server only.
Note: Only an administrator in SiteScope, or a user granted Add, edit or delete email, pager,
HTTP and SNMP preferences permissions can create or make changes to Email Preferences.
For details on user permissions, see "User Management Preferences" on page 732.
User interface elements are described below:
UI Element

Description

Email server
domain name

Domain name of the SMTP mail server that SiteScope should use when sending
email messages.
Example:mail.thiscompany.com
If you are unsure of your mail server's domain name, check with your System
Administrator.
Note: Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in
the "Email Preferences Default Settings Dialog Box" on page 571.

From email
address

Email address used as the From Address for mail generated by SiteScope.
Specifying an email address may make it easier to browse and sort email sent by
SiteScope. If nothing is entered, the From email address stays the same as the
address where the mail is sent from.
Example:sitescope@mycompany.com
Note: If the mail server being used required NTLM authentication (see below), the
email address entered here must be a valid email address.

Login

Username required by the SMTP server. This user name is used for both the
primary and backup mail servers.
Note: You must restart SiteScope if you change this setting.
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UI Element

Description

Password

Password required by the SNTP server. This password is used for both the primary
and backup mail servers.
Note: You must restart SiteScope if you change this setting.

NTLM
Select an NTML authentication option from the drop-down list:
authentication
l
none. Select if the mail server does not require NTLM authentication.
l

l

NTLMv1. Select if the mail server requires authentication using NTLM
version 1.
NTLMv2. Select if the mail server requires authentication using NTLM version

Note: You must restart SiteScope if you change this setting.
Default value: none
Timeout
(seconds)

Amount of time, in seconds, to wait for a response from the SMTP server. If a
response from the primary mail server is not received within the timeout period,
SiteScope switches to use the backup mail server.
Default value: 60 seconds

Notification
Subject

Select the subject field template for the email notification sent when the primary
SiteScope is unavailable.
Default value: default template
Note: This template can be customized or localized. The template is located at
<SiteScope Failover installation directory>\templates.ha\mail.subject.

Notification
template

Select the template for the email notification sent when the primary SiteScope is
unavailable.
Default value: default template
Note: This template can be customized or localized. The template is located at
<SiteScope Failover installation directory>\templates.ha\mail.
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Infrastructure Preferences enable you to view and define the values of global SiteScope settings that
determine how SiteScope runs.

To access
Select Preferences > Infrastructure Preferences.
Note: You must be an administrator in SiteScope, or a user granted View infrastructure
preferences permissions to be able to view Infrastructure Preferences. Edit infrastructure
preferences permissions are required to edit Infrastructure Preferences. For details on this topic,
see "User Management Preferences" on page 732.

Learn About
Infrastructure Preferences Overview
Infrastructure Preferences are sorted and grouped into the following categories: General Settings,
Server Settings, Monitor Settings, Skip Monitor Settings, Dynamic Monitoring Settings, Calculated
Metrics Settings, Custom Monitor Settings, Alert Settings, Multi-View Settings, Template Settings,
Persistency Settings, Report Settings, Baseline Settings, Analytics Settings, Event Console Settings,
and Custom Settings.
After you edit setting values in Infrastructure Preferences, SiteScope validates that all input data is in
the correct format and warns you if restarting SiteScope is required. You can restart SiteScope from the
Infrastructure Preferences page.
Note: You can also view and define infrastructure settings from the <SiteScope
root directory>\groups\master.config file.

UI Descriptions
This section includes:
l

"Search Options" on the next page

l

"General Settings" on page 610

l

"Server Settings" on page 620
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l

"Monitor Settings" on page 622

l

"Skip Monitor Settings" on page 634

l

"Dynamic Monitoring Settings" on page 634

l

"Calculated Metrics Settings" on page 635

l

"Custom Monitor Settings" on page 636

l

"Alert Settings" on page 637

l

"Multi-View Settings" on page 638

l

"Template Settings" on page 639

l

"Persistency Settings" on page 639

l

"Report Settings" on page 640

l

"Baseline Settings" on page 641

l

"Analytics Settings" on page 644

l

"Event Console Settings" on page 649

l

"Custom Settings" on page 650

Search Options
User interface elements are described below:
UI
Element
Find

Description
Enables you to search for a specific string in preference settings. Type the string you
want to find in the box. The search filter runs automatically after a letter is entered in the
box, and highlights the first matching result. If there are no matches, the box is
displayed in red.
The search automatically looks for the string in the first word of each setting label. To
check for the string anywhere else in the setting label, type an asterisk wildcard (*)
before the search string.
You can also use the question mark wild card (?) to represent one character only.
To clear the Find box, click the
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UI
Element

Description

Find
Next

Finds the next occurrence of the string for which you are searching.

Find
Previous

Finds the previous occurrence of the string for which you are searching.

Highlight Highlights all occurrences of the search phrase for which you are searching.
Match
Case

Select to search for the filter string exactly as entered. Clear this option to ignore the
case of the filter string.
Default value: Not selected

General Settings
User interface elements are described below:
UI Element

Description

Accept
untrusted SSL
certificates

Enables SiteScope to accept any untrusted certificate when SSL is used.
Otherwise, only certificates specified in the keystore file or that have a trust chain
leading to a registered CA certificate are accepted.
Default value: Not selected
Property name: _sslAcceptAllUntrustedCerts

BSM
downtime
retrieval
frequency
(minutes)

Amount of time, in minutes, that SiteScope waits between querying BSM for
downtime requests.

Data
acquisition
API single
request size
(MB)

The maximum memory size, in megabytes, allocated for fetching data from the
daily log in a single data acquisition API request.

Default value: 15 minutes

Loading too much data from the daily log to process a request might have a
negative performance impact on SiteScope, because the memory allocated for the
data is out of SiteScope’s available memory pool.
Default value: 20 MB
Note: You must restart SiteScope if you change this setting.
Property name: _dataAcquisitionAPISingleRequestSizeMB
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UI Element

Description

Data
acquisition
API total
request size
(MB)

The maximum memory size, in megabytes, allocated for fetching data from the
daily log in all simultaneous data acquisition API requests.
Loading too much data from the daily log to process requests might have a
negative performance impact on SiteScope, because the memory allocated for the
data is out of SiteScope’s available memory pool.
Default value: 100 MB
Note: You must restart SiteScope if you change this setting.
Property name: _dataAcquisitionAPITotalRequestsSizeMB

Default
collection
method for
Microsoft
Windows
Resources
monitor

Default collection method (pdh or registry) used for the Microsoft Windows
Resources monitor when the Use global setting option is selected in the
Collection method field of the monitor settings. For details, see Microsoft
Windows Resources Monitor Settings.

Delay between
host
resolution
requests
(milliseconds)

Delay, in milliseconds, between successive calls to the DNS server.

Destroy
process by
external
command

Default value: Not selected

Disable
quotes for
cmd.exe

Avoids wrapping parameters in quotes when running cmd.exe for specific tasks.

Default value: pdh

Default value: 0 milliseconds

Default value: Not selected
Property name: _disableDoubleQuotesInTemplates

DNS name
tags

A comma-separated list of values considered by DNS-related functionality as the
DNS "name" tag.
Default value: Name:,Nombre:,Navn:,Nome:,Nom :,Nom\u00FF:
Property name: _dnsNameTags

DNS server
tags

A comma-separated list of values considered by DNS-related functionality as the
DNS "server" tag.
Default value: Server:,Servidor:,Serveur:,Serveur\u00FF:
Property name: _dnsServerTags
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UI Element

Description

Don't check
default
thresholds

Checks monitor results against user selected thresholds only and not against the
default SiteScope monitor thresholds.
Default value: Selected
Property name: _noCheckDefaultThresholds

Email
character set

Character set for email generated by SiteScope in Email Preferences and Email
alerts.
Default value: If no value is entered, UTF-8 is used.
Property name: _mailCharSet

Email subject
character set

Subject character set for email generated by SiteScope in Email Preferences and
Email alerts.
Default value: If no value is entered, UTF-8 is used.
Property name: _mailSubjectCharSet

Enable
downtime
mechanism

Enables the CI downtime mechanism when SiteScope is connected with BSM.
SiteScope is affected by downtime if a SiteScope monitor, measurement, group,
or profile CI is directly linked to a CI that BSM detects is in downtime.
Default value: Selected
Property name: _downtimeEnable

Enable report
credentials to
BSM

If selected, SiteScope sends the credentials of any host to BSM.
Default value: Not selected
Property name: _sendCredentials

Enable
topology
collection in
standalone
deployment

Enables SiteScope to collect topology when running in standalone mode (when
SiteScope is not connected to a BSM server). This setting should be enabled
when using the Data Acquisition API.
Default value: Not selected
Note: You must restart SiteScope if you change this setting.
Property name: _CollectTopologyInStandaloneMode

Frequency of
VM
configuration
retrieval from
vCenter
(hours)
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Frequency that VM configuration data is retrieved from vCenter and saved to the
cache. This enables supporting VM changes such as change of IP or host name in
the vCenter.
Default value: 4 hours
Property name: _vmwareRetrieveConfFrequencyHours
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UI Element

Description

Include
deleted
monitors in
data
acquisition
API results

Data acquisition API includes data on deleted monitors in results.

LDAP binary
attributes

SiteScope uses the names of all known binary LDAP attributes for configuration
requests and responses (this affects the format of LDAP query's output).

Default value: Not selected
Property name: _dataAcquisitionAPIIncludeDeletedMonitorsData

Default value: audio, auditingPolicy, authorityRevocationList, cACertificate,
certificateRevocationList, crossCertificatePair, dSASignature, extensionData,
javaSerializedData, jpegPhoto,msExchIMACL, msExchMailboxGuid,
msExchMailboxSecurityDescriptor, mSMQDigests, mSMQSignCertificates,
objectGUID, objectSid, personalSignature, photo, replicationSignature,
thumbnailLogo, thumbnailPhoto, userCertificate, userParameters, userPassword,
x500UniqueIdentifier
Property name: _ldapBinaryAttributes
Log enabled
monitors only

SiteScope does not log monitor runs in the daily log files for monitors that have not
been enabled. This option also affects Management and Quick reports. If
selected, monitors that have been disabled are not included in Management and
Quick reports.
Default value: Not selected
Property name: _onlyLogEnabledMonitors

Maximum idle
threads per
pool

Maximum number of idle threads per thread pool.
Default value: 100
Note: You must restart SiteScope if you change this setting.
Property name: _threadPoolMaxIdle

Maximum idle
time (ms) for a
thread in the
pool

Amount of time, in milliseconds, to wait before SiteScope cleans idle thread pools.
Default value: 600000 milliseconds (10 minutes)
Note: You must restart SiteScope if you change this setting.
Property name: _threadPoolMaxIdleTime

Maximum idle
time for perfex
process in
minutes

Amount of time, in milliseconds, to wait before SiteScope cleans idle perfex
processes. Cleaning processes improves the memory footprint on the SiteScope
machine.
Default value: 60 minutes
Property name: _perfexProcessMaxIdleTime
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UI Element

Description

Maximum
processes per
pool

Maximum number of processes per process pool.
Default value: 200
Note: You must restart SiteScope if you change this setting.
Property name: _processPoolMaxPerPool

Maximum size
of data
integration
sample's
queue

Upper limit of the data integration sample's queue. When this limit is reached, old
samples are discarded.

Maximum
SSH
connection
attempts

Maximum number of attempts to make an SSH connection.

Monitor delay
between
refresh
(milliseconds)

Amount of time, in milliseconds, to wait before running a monitor after it has
already been run since startup.

Default value: 1000
Property name: _dataSamplesQueueMaxSize

Default value: 1
Property name: _numberOfRepeatExecForSSHConnection

Default value: 1000 milliseconds
Property name: _monitorDelayBetweenRefresh

NT SSH
timeout
(seconds)

Amount of time, in seconds, to wait for an SSH connection to remote Windows
servers before timing out.
Default value: 60 seconds
Property name: _NTSSHTimeout

Number of
Maximum number of attempts to open a reserved port in the 811-1024 range for
open port tries rlogin and rsh remote access methods.
Default value: 25
Note: You must restart SiteScope if you change this setting.
Property name: _localPortRetryCount
Number of
repeated
attempts for
Telnet
connection
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Maximum number of repeated attempts to make a Telnet connection.
Default value: 1
Property name: _numberOfRepeatExecForTelnetConnection
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UI Element

Description

Number of
samples to
discard if
queue max
size reached

The number of samples to discard if the queue size maximum has been reached.

Numeric
values format

Format of numeric values when converting to string representation.

Default value: 500
Property name: _dataSamplesQueueDiscardSamples

The 0 symbol shows a digit, or 0 if no digit is present.
The # symbol shows a digit, or nothing if no digit is present.
Examples:
l

For 000000.00 format:
-1234.567 is written as -001235.57
1.1 is written as 000001.10

l

For #.###### format:
-1234.567 is written as -1234.567
1234 is written as 1234

l

For #.000000 format:
-1234.567 is written as -1234.567000

Note: If you enter 0.000000000 format, all numbers are written in rounded form,
including numeric-like values such as PID number, user ID, and process ID. The
report production system is unable to differentiate between numeric and numericlike values.
Default value: #.##
Property name: _noScientificNotation
Perfex timeout
(seconds)

Amount of time, in seconds, to wait for perfex to attempt to make a connection or
to attempt to run a monitor before timing out.
Default value: 120 seconds
Property name: _perfexTimeout
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UI Element

Description

Power Shell
execute
command

To enable use of the Microsoft Exchange monitor on a 64-bit version of Windows
Server 2003 or Windows Server 2008 (since a 32-bit application cannot access the
system32 folder on a computer that is running a 64-bit version of Windows Server
2003 or 2008), perform the following:
l

l

(For Windows 2003) Apply the Microsoft hotfix available from
https://support.microsoft.com/en-us/kb/942589 (not required when using the
Microsoft Base monitor)
Enter the PowerShell execute command. For example:
C:\Windows\Sysnative\WindowsPowerShell\v1.0\powershell.exe

In some cases when using the Microsoft Exchange Base monitor, you might also
need to enter the PowerShell execute command (without installing the Microsoft
hotfix).
Note: Symlink Sysnative is not available by default on Windows 2003.
Default value: PowerShell
PowerShell
pool:
maximum
number of
active
processes (per
key)

Maximum number of active PowerShell processes per key (connection).

PowerShell
pool:
maximum
number of idle
processes (per
key)

Maximum number of idle PowerShell processes per key (connection).

PowerShell
pool:
maximum
number of
processes

Maximum number of PowerShell processes which can be in the pool
simultaneously (all idle processes and all active processes).

Default value: 20
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolMaxActive

Default value: 8
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolMaxIdle

Default value: 20
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolMaxTotal
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UI Element

Description

PowerShell
pool:
maximum wait
time until new
or idle
process is
available
(milliseconds)

Maximum wait time, in milliseconds, until a new or idle PowerShell process is
available.

PowerShell
pool:
minimum idle
time for
processes
(milliseconds)

Minimum amount of time, in milliseconds, that an object can sit idle in the pool
before it is eligible for eviction due to idle time. If set to a negative (-) number, no
object will be dropped from the pool due to idle time alone. This setting has no
effect unless PowerShell pool: time between eviction runs (milliseconds) >
0.

Default value: 1000 milliseconds (1 second)
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolMaxWait

Default value: 300000 milliseconds (5 minutes)
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolMinEvictableIdleTimeMillis

PowerShell
pool: time
between
eviction runs
(milliseconds)

Interval, in milliseconds, between eviction thread runs for closing idle PowerShell
processes. When a negative (-) number is set, no eviction thread is launched.
Default value: 900000 milliseconds (15 minutes)
Note: You must restart SiteScope if you change this setting.
Property name: _powerShellPoolTimeBetweenEvictionRunsMillis

Processes
wait for server
timeout in
multithreading

If selected, a separate thread is opened for each process that is waiting for a
server timeout to close the connection, or for an answer to return the process to
the pool. This setting increases the thread count and used memory if many
servers are down. When this setting is cleared (recommended), SiteScope uses
only one thread to manage such processes.
Default value: Not selected

Process pool
kill timeout
(milliseconds)

Amount of time, in milliseconds, to wait before SiteScope kills a non-responsive
process. This is to avoid killing processes on every timeout.
Default value: 60000 milliseconds (the maximum recommended value is 180000
milliseconds)
Note: You must restart SiteScope if you change this setting.
Property name: _processPoolKillTimeout
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UI Element

Description

Quick search
auto filter
delay
(milliseconds)

Amount of time to wait before the auto filter runs. If set to -1, the ENTER key must
be pressed to run the search. For details on quick search, see "Quick Search" on
page 73.
Default value: 800 milliseconds
Note: You must restart SiteScope if you change this setting.

Recursive
'depends on'

Enables recursion in the monitor Depends on box. This means that subgroups
become disabled when the parent group is disabled because of a dependency. By
default, only the immediate group impacted by the dependency is disabled.
Default value: Not selected
Note: You must restart SiteScope if you change this setting.
Property name: _dependsOnRecursive

Report
VMware
Performance
monitor
metrics to OA
metrics
classes

The VMware Performance monitor reports each metric to a specific table with its
ESX host server, VM, or resource pool target, according to its metrics class. To
report all VMware Performance monitor metrics to one table, clear this check box.

Send remote
server display
name to BSM

Sends the remote server display name to BSM instead of the remote server host
name. It is preferable to use this setting when DNS resolution is disabled.

Default value: Selected
Property name: _omReportNewVmwareMetricClasses

Default value: Not selected
Property name: _sendRemoteServerDisplayNameToBAC

SiteScope
sleep delay
(milliseconds)

Amount of time, in milliseconds, of the sleep interval in the main thread.
Default value: 180 milliseconds
Note: You must restart SiteScope if you change this setting.
Property name: _monitorProcessCheckDelay

SiteScope tree
refresh rate
(seconds)

Amount of time, in seconds, to wait between refreshing the SiteScope tree. The
minimum value is 30 seconds.
Default value: 60 seconds
Property name: _sisTreeRefreshRateSecs
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UI Element

Description

Sleep interval
on error
(milliseconds)

Amount of time, in milliseconds, to wait before rerunning a monitor using the
Verify error option.
Default value: 5000 milliseconds
Property name: _verifySleepDuration

SSH
connection
repeats
number

Maximum number of attempts to make an SSH connection.

SSH prompt
timeout
(milliseconds)

Amount of time, in milliseconds, for SiteScope to wait for an SSH connection
prompt to finish before running the first command.

Default value: 1

Default value: 3000 milliseconds
Property name: _waitSshPromptTimeout

Timeout
proxied query
drivers list

A comma-separated list of database drivers that have timeout problems.
Database queries processed with the drivers listed here exceed the timeout
specified in the monitor's Query timeout field. These drivers are queried
separately with a monitor-based timeout.
Default value: org.postgresql.Driver
Property name: _timeoutProxiedDrivers

Time period
for cleaning
idle SSH
connections
from pool
(minutes)

Amount of time, in minutes, for cleaning idle SSH connections from the SSH
connections pool.

Time zone
offset

Manually sets the time zone offset, in hours, from Greenwich Mean Time (GMT).
You can enter both positive and negative, integer and non-integer values.

Default value: 10 minutes
Property name: _SSHConnectionIdleCleanTimeMinutes

Default value: -999 (no offset)
Example: In Eastern US (EST), where the time zone offset is GMT -5, enter the
value 5. In central Europe, where the time zone offset is GMT +2, enter the value 2.
Note: You must restart SiteScope if you change this setting.
Property name: _timeZoneOffset
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UI Element

Description

Topology
resolving
frequency
(minutes)

Amount of time, in minutes, to wait between checking the topology of the server
being monitored. This applies to non-dynamic monitors only; for dynamic
monitors, frequency can be configured per instance in the user interface.
If this time is exceeded during a monitor run:
l

l

In SiteScope standalone, the topology is saved in SiteScope.
When SiteScope is integrated with BSM, the monitor creates the topology
again in BSM's RTSM.

Default value: 120 minutes
Note: You must restart SiteScope if you change this setting.
Property name: _topologyResolvingFrequencyInMinutes
Traceroute
command

(For Unix) Path to the traceroute command to override the default for the platform.
Default value: No value
Property name: _tracerouteCommand

Wait for SSH
connection
prompt

SiteScope waits for the end of the SSH connection prompt before it starts to run
the first command. Select this setting if the SSH remote server has a long start
prompt.
Default value: Not selected
Property name: _readUntilPromptFound

Server Settings
User interface elements are described below:
UI Element

Description

Default credentials
name

Use a default credential name for a remote connection.
Default value: No value
Property name: _defaultServiceCredentialsName

Host name
override

Overrides the SiteScope host name for BSM.
Default value: No value
Property name: _sisHostNameOverride
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UI Element

Description

Kill processes

Kills child processes when the SiteScope process is stopped.
Default value: Selected
Property name: _killProcesses

Maximum monitor
processes

Maximum number of monitor processes in the process pool.
Default value: 100
Note: You must restart SiteScope if you change this setting.
Property name: _maxMonitorProcesses

Maximum monitor
running

Maximum number of running monitor processes in the queue.
Default value: 400
Note: You must restart SiteScope if you change this setting.
Property name: _maxMonitorsRunning

Minimal monitor
run interval
(seconds)

Minimal possible monitor frequency. If you try to create a monitor with
frequency less then this frequency, a validation error is displayed.
Note: You must restart SiteScope if you change this setting.
Default value: 15
Property name: _monitorMinInterval

Prefer IP version 6
addresses

If a host is resolved to both IPv6 and IPv4, IPv6 is used. For details on
support for IPv6 in SiteScope, see "Enable SiteScope to Prefer IP Version 6
Addresses" on page 510.
Note: You must restart SiteScope if you change this setting.
Default value: Not selected
Property name: _preferIPV6Address

SiteScope
heartbeat restart
timeout (minutes)

Maximum time, in minutes, before SiteScope restarts itself when no
heartbeat events are detected.
Note: You must restart SiteScope if you change this setting.
Default value: 5 minutes
Property name: _heartbeatRestartTimeout

SiteScope restart
timeout (minutes)

Maximum time for SiteScope to restart itself.
Default value: 15 minutes
Property name: _restartTimeout
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UI Element

Description

SiteScope
shutdown timeout
(seconds)

Amount of time, in seconds, that SiteScope should wait to shutdown before
timing out.
Default value: 60 seconds
Property name: _shutdownTimeout

Startup script

Runs this script whenever SiteScope starts up, regardless of the platform or
procedure used to start SiteScope. (Empty=none)
Default value: No value
Property name: _startupScript

Monitor Settings
User interface elements are described below:
UI Element

Description

Additional error
tokens

Additional list of keywords that should be handled as signs of failure during
server output parsing.
Default value: Failed to .* Error code:
Property name: _scriptMonitorErrorMsgs2

Additional event
log name

Enables the Microsoft Windows Event Log monitor to monitor event logs other
than the standard logs, by entering additional log names.
Default value: No value
Property name: _additionalEventLogNames

Additional event
types

Enables the Microsoft Windows Event Log monitor to monitor event types
other than the standard application, system, or security logs, by entering
additional event type categories.
Default value: No value
Property name: _additionalEventTypes
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UI Element

Description

Allow all request
headers in URL
specific monitors

Allows all request headers in URL specific monitors.
Default value: Not selected
Property name: _urlOtherHeader=
Allow all request headers in URL specific monitors
If selected, enables all request header types in URL specific monitors to be
allowed. The request header types that are allowed include: Custom-Content,
Custom-Header, Content-Type, Host, User-Agent, Set-Cookie, Method,
Protocol, Action, and sslgetOptions. When the setting is cleared, only custom
headers are allowed.
Default value: Not selected
Property name: _allowAllRequestHeaders

Browsable EXE
timeout
(milliseconds)

Maximum amount of time, in milliseconds, to wait for retrieving counter
information and for running the monitor. This setting only applies to
executable-based browsable monitors, such as SAP, Sybase, and DB2
JDBC monitors.
Default value: 45000
Property name: _browsableExeTimeout

Browsable
monitors - If in
error, send status
of all counters to
BSM

When a browsable monitor is in error status, SiteScope only sends the list of
counters in error and their current values to BSM. At other times (when the
monitor is in good status), SiteScope forwards all the counter names and
values to BSM.
If selected, SiteScope sends all the counters (the ones in error, and the ones
with good status) and their values to BSM even during error.
Default value: Not selected
Property name: _isSendStatusOfAllBrowsableCountersToBAC

CPU error at 100%

CPU monitor switches to the default error status when CPU utilization
reaches 100% on the target machine.
Default value: Selected
Property name: _cpuEnableErrorAt100

CPU maximum
units

Maximum number of CPU units supported by the CPU monitor.
Default value: 16
Property name: _cpuMaxProcessors
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UI Element

Description

DB maximum
columns

Maximum number of columns processed by DB monitors.
Default value: 10
Property name: _databaseMaxColumns

DB maximum
rows

Maximum number of rows processed by DB monitors.
Default value: 1
Property name: _databaseMaxRows

DB maximum
value length

Maximum length, in characters, of the data processed by DB monitors.
Default value: 200
Property name: _databaseMaxSummary

Default frequency
for new monitors
(seconds)

Default frequency which is set in all new monitors for running the monitor
instance (unless a different frequency is set by manually editing the frequency
value for a monitor instance).
Default value: 600 seconds (10 minutes) in SiteScope; 5 seconds in
SiteScope for Load Testing.
Property name: _defaultMonitorRunFrequency

Default precision

The default precision for floating-point values processed by some monitors.
Default value: 0 (disabled)
Property name: _defaultPrecision

Description
Enables you to make adding a description a required field when enabling or
mandatory when
disabling an alert or monitor.
enabling/disabling
Default value: Not selected
alert or monitor
Property name: _enableDisableDescriptionMandatory
Dynamic Docker:
Delete monitors
created by
discovery
mechanism when
Docker monitor
deleted
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UI Element

Description

Dynamic Docker:
Enable automatic
application
discovery

Enables the application discovery mechanism used with the Dynamic Docker
monitor. This mechanism searches for applications running in new containers
on the Docker node or cluster, and automatically creates a new monitor or set
of monitors using a predefined template.
Default value: Selected
Property name: _dynamicDockerAppDiscoverEnabled

Dynamic JMX
connection pool:
maximum active
connections in
pool (per key)

The maximum number of active connections that can be open in the
connection pool at the same time per key. (The connection pool is a set of
pools per key. A key is the combination of a JMX URL, a user, and a
password).

Dynamic JMX
connection pool:
maximum idle
connections in
pool (per key)

The maximum number of idle connections in the connection pool (per key).
(The connection pool is a set of pools per key. A key is the combination of a
JMX URL, a user, and a password). When this value is exceeded, the number
of unused connections that exceed this value are closed rather than kept in
the connection pool.

Default value: 10

Default value: 5
Dynamic JMX
connection pool:
minimum
evictable idle time
(milliseconds)

The minimum time that a connection must be idle before the eviction thread
can evict it. Note that the actual amount of time a connection will be idle
depends on when the eviction thread runs (Dynamic JMX connection pool:
time between eviction runs (milliseconds)).

Dynamic JMX
connection pool:
time between
eviction runs
(milliseconds)

Interval between eviction thread runs for closing idle connections.

Dynamic JMX
connection pool:
total number of
connections for
whole pool

The total number of dynamic JMX connections available for the JMX
connection pool (for all the keys together). When this number is exceeded, the
number of connections that exceed this value are closed.

Dynamic JMX
connection pool:
waiting for
connection
timeout
(milliseconds)

The amount of time to wait for a connection from the JMX connection pool
before timing out.
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UI Element

Description

Empty last line
reading

Includes the last empty line in the Script monitor output.
Default value: Not selected
Property name: _enable_script_monitor_non_empty_last_line_reading

Enable JDBC
logging

Enables JDBC search results logging for the Link Check monitor.
Default value: Not selected
Property name: _linkMonitorJdbcEnabled

Error tokens for
Script monitor

List of keywords that should be handled as signs of failure during server
output parsing.
Default value: not found, Not Found, denied, Denied, cannot execute such
file or directory
Property name: _scriptMonitorErrorMsgs

Event log
messages to save

Number of Microsoft Windows Event Log descriptions to save when saving
diagnostic text for alerts.
Default value:10
Property name: _eventLogMessagesToSave

Force rerun of
heartbeat monitor
that has
dependent
monitors

Forces a rerun of the heartbeat monitor when the heartbeat monitor status is
not in error and the dependent monitor status is in error. This is to make sure
that the heartbeat monitor is not the cause of the problem (to check that the
heartbeat monitor is not currently in error).
Default value:Selected
Property name: _runOkDependsOnError

FTP content
match maximum
size

Maximum size of the buffer used to match FTP content.
Default value: 50000
Property name: _ftpContentMatchMax

FTP download
limit

Maximum number of bytes downloaded from each file to match.
Default value: -1 (no limit)
Property name: _ftpDownloadLimit

FTP maximum
threads

Maximum number of simultaneous FTP worker threads.
Default value: 1
Property name: _ftpMaxThreads
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UI Element

Description

HTTP content
match display
limit

Maximum number of bytes to display for URL monitor content match.
Default value: 150
Property name: _urlContentMatchDisplayMax

HTTP content
match limit

Maximum number of bytes to check for URL monitor content match.
Default value: 50000
Property name: _urlContentMatchMax

Initial monitor
delay (seconds)

The time, in seconds, over which to randomly schedule monitor updates after
a SiteScope restart.
When changing a monitor's frequency so that its next run occurs immediately
(for example, if a monitor has not run in 5 minutes, and you change the
frequency to less than 5 minutes), SiteScope randomly schedules the next
run during the specified period.
Default value: 600 seconds
Property name: _initialMonitorDelay

JMX thread pool
core size

Number of threads to keep in the JMX pool that can be created for JMX tasks,
even if they are idle.
Default value: 10

JMX thread pool
idle time
(seconds)

When the number of threads is greater than the core, this is the maximum
time that excess idle threads will wait for new JMX tasks before timing out.

JMX thread pool
maximum size

Maximum number of threads to allow in the pool. If the number of threads in
the pool is greater than the core but less than the maximum and the queue is
full, then new threads will be created for the JMX tasks until the maximum
number of threads in pool is reached.

Default value: 30 seconds

Default value: 200
JMX thread pool
queue size

Maximum number of JMX tasks that can be added to the queue. If all the core
threads are busy now, the new tasks will be added to queue until the max
queue size is reached.
Default value: 400
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UI Element

Description

Mail attachment
content support
base64

Supports mail attachment content-transfer-encoding with base64 for the Mail
monitor.
Default value: Not selected
Note: You must restart SiteScope if you change this setting.
Property name: _mailAttachmentBase64Support

Maximum
browsable
counters to be
selected

Maximum number of browsable counters that can be selected from the
browsable tree. If you create or edit a monitor so that it has more counters
than this value, only the number of counters up to this value is saved.
Note: When a browsable monitor is deployed in a template, the number of
counters that match the selected patterns are limited by the _
maxCountersForRegexMatch parameter in the <SiteScope
root directory>\groups\master.config file. If, during deployment, the
number of counters that match the patterns exceeds this value, only the
number of counters up to this value is saved. Therefore, we recommend using
the same value for this setting and the _maxCountersForRegexMatch
parameter. The default value for both of these parameters is 1000.
Default value: 1000
Property name: _browsableContentMaxCounters

Maximum
counters for
application
monitors

Maximum number of counters that can be selected for application monitors.

Maximum
counters for
SNMP by MIB
monitor

Maximum number of counters supported by the SNMP by MIB monitor.

Maximum
Windows
Performance
Counter monitor
counters

Maximum number of counters for each instance of a Microsoft Windows
Performance Counter monitor.

Microsoft
Windows Media
Server monitor
service names

Service names to monitor using the Microsoft Windows Media Server
monitor.

Default value: 100
Property name: _ApplicationMonitorMaxCounters=100

Default value: 32
Property name: _maxSNMPbyMIBCounters

Default value: 8
Property name: _NTCounterMonitorMaxCounters

Default value: Windows Media Services (this includes Windows Media
Station Service and Windows Media Unicast) Service)
Property name: _counterObjectsWindowsMediaMonitor
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UI Element

Description

MQ Server CCSID

Default WebSphere MQ server CCSID in SiteScope.
Default value: No value
Property name: _mqServerCCSID=

MS Media Player 9
account blocked

Select this option and add the account directory path to the MS Media Player
9 account directory box if your Media Player account stops working with a
17999 error.
Default value: Not selected
Property name: _MediaPlayer9AccountBlocked

MS Media Player 9
account directory

Enter the Media Player account directory if you get a 17999 error for the Media
Player monitor.
Default value: No value
Example:C:\Documents and Settings\<USER>\Local
Settings\Application Data\Microsoft\Windows Media\9.0
Property name: _MediaPlayer9AccountBlockedDir

Network
Bandwidth
monitor sanity
check
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UI Element

Description

Oracle Database
session counters

The set of session counters used for each session. Use to avoid a Java Heap
Space error on the applet side where the current Oracle Database has a large
number of sessions.
Select from:
l

None. All Oracle session counters are disabled.

l

FullList. All Oracle session counters are enabled.

l

l

l

DefaultList. By default, only the following Oracle session counters which
exist for the current Oracle Database are enabled:
n

recursive calls

n

db block gets

n

consistent gets

n

physical reads

n

redo size

n

bytes sent via SQL*Net to client

n

bytes received via SQL*Net from client

n

SQL*Net roundtrips to/from client

n

sorts (memory)

n

sorts (disk)

n

rows processed

DefaultList,counter1_name,counter2_name,...,counterN_name. Only
the default Oracle session counters, and counters which were defined
after the DefaultList value are enabled. For example,
DefaultList,logons current,logons cumulative.
counter1_name,counter2_name,...,counterN_name. Only counters
which were defined in the current setting are enabled. For example,
logons current,logons cumulative.

Default value: DefaultList
Note: If this setting is an empty string, only the default Oracle session
counters which exist for the current Oracle Database are enabled.
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UI Element

Description

Perfex options

The options which are used to fine-tune perfex settings:
l

l

-wrmTimeout 300. Amount of time, in seconds, to wait when creating a
Microsoft Windows Resources monitor with many counters on a loaded
network environment before timing out.
-optionalSetupConnection. This option forces perfex to use
ImpersonateLoggedOnUser Microsoft API when authenticating. It allows
SiteScope to set up optional way to connect to the remote workstation
when monitoring using a secure connection. For details, see "Configure
Remote Monitoring Using Secure Shell (SSH)" on page 516.

Default value: -wrmUiTimeout 300
Property name: _perfexOptions
Real Media Server
monitor service
names

Service names to monitor using the Real Media Server monitor.
Default value: RMServer
Property name: _counterObjectsRealMonitor

Run script
through perfex
tool

Runs the script through the perfex tool.
Default value: Selected
Property name: _scriptRunThroughPerfex

SAP Java
Connector version

The version of the SAP Java Connector libraries used by the SAP monitors to
connect to the SAP R/3 system.
Default value: 2.x
Property name: _jCoVersion

Script monitor
output limit

Number of lines to save from Script output after launching the Script monitor.
Default value: 25
Property name: _scriptMonitorLinesToSave

Script monitor
replacement
strings

Stores a list of space-separated strings which are parameter tags in the
remote script. When the Script monitor is run, it replaces parameters tags
from the script command with actual parameter values from monitor
preferences.
Default value: $ %
Property name: _scriptMonitorReplacementChars
Example: If the script command is test $ %, replacement chars are $ %, and
parameters are Param1 Param2, the monitor runs the following command:
test Param1 Param2.
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UI Element

Description

Simultaneously
running DNS
monitors

Maximum number of DNS monitors that can run simultaneously. This is
relevant only when using the roundTripTime counter. The NSLookup
operation can load the operating system and affect the values.
Default value: 0 (0 means that the number of simultaneous DNS monitors is
unlimited)
Note: You must restart SiteScope if you change this setting.
Property name: _maxDnsMonitorsRunning

SNMP monitors
maximum number

Maximum number of SNMP monitors that can run at any given time.
Default value: 10
Note: You must restart SiteScope if you change this setting.
Property name: _snmpMonitorMaximum

SNMP session
closure timeout
(milliseconds)

Maximum amount of time, in milliseconds, that SiteScope waits before
closing the SNMP session.
Default value: 30000
Property name: _maxSNMPCloseSessionTimeMillis

SNMP Trap
encoding

SNMP Trap encoding for the SNMP Trap monitor (used for send and receive
traps). Empty=ISO8859-1.
Default value: ISO8859-1
Property name: _snmpTrapEncoding

SNMP Trap
monitor log limit

Maximum number of lines to look through SNMP Trap log for the SNMP Trap
monitor. This box is filled only if Run Alerts is set to Once, after all SNMP
Traps have been checked in the SNMP Trap monitor page.
Note: Setting a high limit may increase the size of the SiteScope.log or
RunMonitor.log.
Default value: 1000
Property name: _SNMPTrapMonitorDetailsMax

Use DNS Java
library

Activates Java DNS functionality instead of using the default perfex setting.
In some cases, DNS response times are faster than the perfex response.
Default value: Not selected
Property name: _useDNSJava
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UI Element

Description

Use sequence of
requests for
SNMP by MIB

Activates a new mode of requests for the SNMP by MIB monitor. Using this
option, SiteScope executes a separate request to the remote server for each
OID counter from the monitor.
Default value: Not selected
Property name: _sequenceSNMP

Web Script
monitor queue
size

The size of the Web Script monitor queue.
Default value: 20 (maximum value: 40)
Property name: _maxWebScriptMonitorsRunning

Web Script
monitor queue
timeout (seconds)

The amount of time, in seconds, for the Web Script monitor to wait in the
queue before timing out.
Default value: 120 seconds
Property name: _webScriptMonitorsWaitingInQueueTimeout

Web Service
monitor maximum
read length (bytes)

Maximum amount of data, in bytes, to read from the log file for the Web Server
monitor.
Default value: 50000 bytes
Property name: _maxAmountToRead

Web Service
monitor timeout
(seconds)

Maximum amount of time in seconds for the Web Server monitor to run.
Default value: 30 seconds
Property name: webServiceTimeout=30

Web Service
Monitor use
common content
match

Content match behavior was changed for the Web Service monitor in
SiteScope 10.12. This setting enables Web Service monitors defined prior to
SiteScope 10.12 to match the correct value. This means that Web Service
monitors behave in the same way as other monitors where content matching
is used. Clear the setting to revert to the old content match behavior.
Default value: Selected
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Skip Monitor Settings
User interface elements are described below:
UI Element

Description

Disable period of skip
monitor (seconds)

The period of time, in seconds, that a monitor is disabled after the
maximum number of monitor skips (defined in Maximum monitor
skips) has been exceeded.
Default value: 360 seconds
Property name: _monitorDisablePeriodOnSkip

Maximum monitor skips

Maximum number of consecutive monitor skips before a monitor is
disabled.
Default value: 10
Note: You must restart SiteScope if you change this setting.
Property name: _maxMonitorSkips

Send email to
administrator if monitor
is disabled after a skip

SiteScope sends an email to the administrator if a monitor is disabled
after the maximum number of consecutive monitor skips has been
exceeded.
Default value: Not selected
Property name: _emailSkipNotification

Shutdown on monitor
skips

SiteScope shuts down with an error if a monitor exceeds its maximum
skip count.
Default value: Not selected
Property name: _shutdownOnSkips

Dynamic Monitoring Settings
User interface elements are described below:
UI Element

Description

Dynamic
monitoring core
thread pool size

Number of threads in pool that will be created for new dynamic monitors
changes check tasks.
Default value: 5
Note: You must restart SiteScope if you change this setting.
Property name: _dynamicMonitoringCoreThreadPoolSize
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UI Element

Description

Dynamic
monitoring
maximum
queue size

Maximum number of new dynamic monitors changes check tasks that can be
added to the queue. If all the core threads are busy, the new tasks are added to
the queue until the maximum queue size is reached.
Default value: 5000
Note: You must restart SiteScope if you change this setting.
Property name: _dynamicMonitoringMaxQueueSize

Dynamic
monitoring
maximum
thread pool size

Maximum number of threads in pool that will be created for new dynamic
monitors changes check tasks. These extra threads are created only if all the
core threads are busy and the maximum queue size has been reached.
Default value: 30
Note: You must restart SiteScope if you change this setting.
Property name: _dynamicMonitoringMaxThreadPoolSize

Calculated Metrics Settings
User interface elements are described below:
UI Element

Description

Maximum number of calculated
metrics

Maximum number of calculated metrics that can be created for
a monitor.
Default value: 100
Note: You must restart SiteScope if you change this setting.
Property name: _customCalculatedCounters
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Custom Monitor Settings
User interface elements are described below:
UI Element

Description

Allow network
access

Enable this setting if your custom monitor needs to open a network connection
to another server from the data processing script or the Java code that is called
from the script. Clear the selection to block network access.
Default value: Not selected
Note: You must restart SiteScope if you change this setting.
Property name: _customMonitorAllowNetworkAccess

Disable custom
monitors while
publish changes

Disables deployed custom monitors while publish changes runs. The monitor is
temporarily disabled before changes are published and is restored to the enabled
state after changes have been made.
Default value: Selected
Property name: _disableForPublish

Enable custom
monitor
debugging

Enables sending debugging logs for custom monitors to a remote debugging
server. Note that custom monitor debugging must also be enabled for the
specific custom monitor instance in the monitor settings.
<SiteScope>\logs\custom_monitors\custom_monitor.log
Default value: Not selected
Property name: _customMonitorEnableDebugging

Maximum
number of
counters

Maximum number of counters that can be created in a custom monitor.
Default value: 1000
Note: You must restart SiteScope if you change this setting.
Property name: _customMonitorMaxNumOfCounters

Maximum
number of
queries

Maximum number of queries that can be added to the queries table to querybased custom monitors.
Default value: 10
Note: You must restart SiteScope if you change this setting.
Property name: _customMonitorMaxNumOfQueries
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UI Element

Description

Reload classes
and jars on each
monitor run

Checks for any changed classes and jar files on each monitor run, and reloads
them. Enabling this option saves having to restart SiteScope if you add or
modify jars/classes after the first monitor run.
Default value: Not selected
Note: This option should only be used be during script development, and should
be cleared in the production stages since it impacts performance.
Property name: _customMonitorReloadClassLoaderFiles

Alert Settings
User interface elements are described below:
UI Element

Description

Alert attempt delay
(seconds)

Amount of time, in seconds, to wait between each attempt to send a Post
Alert.
Default value: 120 seconds
Property name: _postAttemptDelay

Maximum alert
threads

Maximum number of alert threads in the pool.
Default value: 100
Property name: _threadPoolAlertMaxThreads

Maximum runs for
Post action

Maximum number of attempts to send a Post Alert.
Default value: 4
Property name: _postAttempts

Maximum script alert Maximum number of Script Alert processes that can run simultaneously.
processes
Default value: 25
Property name: _maxScriptAlertProcesses
Maximum sound
alert length
(milliseconds)

Maximum length of time, in milliseconds, of the Sound Alert sound.
Default value: 0
Property name: _AudioSleepTime
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UI Element

Description

Pager delay
(seconds)

(Pager Alerts were deprecated; this setting remains for backward
compatibility purposes only.) Delay between pager signals when using a
Pager Alert.
Default value: 5
Property name: _delayBetweenPages

Multi-View Settings
User interface elements are described below:
UI Element

Description

Configuration
change refresh
frequency
(seconds)

Amount of time, in seconds, to wait between refreshing the configuration
changes in Multi-View. Configuration data includes adding, deleting, or
moving a group or monitor, and changing a group or monitor name.
Note: You must restart SiteScope if you change this setting.
Default value: 60 seconds (this is also the minimum value you can enter)

Runtime data
refresh frequency
(seconds)

Amount of time, in seconds, to wait between refreshing the runtime data in
Multi-View. Runtime data includes monitor or group status changes and
enable/disable information.
Note: You must restart SiteScope if you change this setting.
Default value: 5 seconds (this is also the minimum value you can enter)

Maximum number
of Multi-Views

The maximum number of Multi-Views that can be open simultaneously. Once
the maximum number of open Multi-Views has been reached, a popup
window is displayed informing the user, and no additional Multi-Views can be
opened.
This number is dependent on the caching frequency; increasing the cache
clearing interval reduces the number of views that can be open
simultaneously.
Note: You must restart SiteScope if you change this setting.
Default value: 20 (must be a value between 1 and 20)
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UI Element

Description

Interval before
clearing view
cache since last
used (seconds)

Amount of time, in seconds, to wait since a view was last used, before
clearing the cache.
This number impacts the number of Multi-Views that can be open
simultaneously; increasing the cache clearing interval reduces the number of
views that can be open simultaneously.
Note: You must restart SiteScope if you change this setting.
Default value: 120 seconds (5 seconds is the minimum value)

Template Settings
User interface elements are described below:
UI Element

Description

Allow creation of template monitors
directly under a template entity

Enables adding a monitor directly under a template
without creating a group in the template.
Note:
l

l

You must restart SiteScope if you change this
setting.
Monitors added directly under a template are not
supported by the Publish Template Changes Wizard.

Default value: Not selected
Property name: _
allowTemplateMonitorDirectlyUnderTemplate

Persistency Settings
User interface elements are described below:
UI Element

Description

Maximum
changes per
persistency delta
file

Maximum number of persistency changes kept in each persistency delta file.
Default value: 51
Note: You must restart SiteScope if you change this setting.
Property name: _PersistencyMaxChangesInDeltaFile
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UI Element

Description

Maximum
persistence
history items

Maximum number of history items kept in persistence.
Default value: 1000
Property name: _PersistencyMaxHistoryItems

Maximum
persistence
history size

Maximum size, in bytes, of persistence history.
Default value: 20000
Note: You must restart SiteScope if you change this setting.
Property name: _PersistencyMaxHistorySize

Maximum
persistency delta
files

Maximum number of delta files kept in persistence. After this number is
reached, a new snaphot (.ssf) file is created with all the persistency objects. All
old .ssf files are moved to the history folder.
Default value: 100
Property name: _PersistencyMaxDeltaFiles

Maximum temp
directory size

Maximum size, in kilobytes, of the temp directory.
Default value: 10000
Note: You must restart SiteScope if you change this setting.
Property name: _tempDirMaxSize

Report Settings
User interface elements are described below:
UI Element

Description

Default time length for report
(hours)

Default time period for including monitoring data in a Quick or Alert
report.
Default value: 1 hour
Property name: _quickReportDefaultTimePeriod

Include alert.log.old in report

Includes the alert.log.old file in the Alert Report.
Default value: Selected
Property name: _includeAlertLogOld
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UI Element

Description

Maximum errors in monitor
history report

Maximum number of errors shown in the monitor history report.
Default value: 100
Property name: _maxReportErrors

Maximum samples in the
history report

Maximum number of samples (readings or lines) in the history
report.
Default value: 100
Property name: _reportMaxBuckets

Maximum warnings in
monitor history report

Maximum number of warnings shown in the monitor history report.
Default value: 100
Property name: _maxReportWarnings

Use advanced sampling
algorithm in report

Defines the time between samples in the report as the minimum
of all reported monitor frequencies.
Default value: Not selected
Property name: _useReportAdvancedSamplingAlgorithm

Baseline Settings
User interface elements are described below:
UI Element

Description

Activation
thread priority

Priority assigned to the activation thread. The priority, if specified, must be
between 1-10, inclusive. If not specified, the priority is set to 1. Generally, the
higher the priority, the faster the baselines are activated. Keep the priority as low
as possible, so as not to interfere with SiteScope online functionality.
Default value: 1 (low priority)
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningActivationThreadPriority

Automatically
create an error
boundary if no
error
thresholds are
defined

Automatically creates a baseline threshold using the error boundary offset value
when no error thresholds have been defined for a monitor.
Default value: Selected
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningAutomateUpperBoundCreation
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UI Element

Description

Calculation
thread priority

Priority assigned to the calculation thread. The priority, if specified, must be
between 1-10 inclusive. If not specified, the priority is set to 1. Generally, the
higher the priority, the faster the baseline calculations take to complete. Keep the
priority as low as possible, so as not to interfere with SiteScope online
functionality.
Default value: 1 (low priority)
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningCalculationThreadPriority

Failed parsings Priority assigned to the failed parsing thread handler. The priority, if specified,
handler thread must be between 1-10 inclusive. If not specified, the priority is set to 1. Generally,
priority
the higher the priority, the faster the baseline calculations take to complete. Keep
the priority as low as possible, so as not to interfere with SiteScope online
functionality.
Default value: 1 (low priority)
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningFailedParsingHandlerThreadPriority
Include today's
data in
calculation

Specifies whether to include the current day's data in the baseline calculation.
Default value: Selected
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningCalculationIncludesToday

Interval for
saving
baseline data
to disk
(minutes)

Interval, in minutes, used by SiteScope to save baseline data accumulated in the
memory to the disk. A shorter interval reduces the memory consumption, but
increases the vulnerability to failures and reduces performance.
Default value: 30 minutes
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningSaveAccumulatedDataIntervalMinutes

Maximum
number of
days to include
in calculation

Number of days of historical data that are included in baseline calculations. The
higher the number, the more precise the baseline result, but the calculation takes
more time and uses more disk space. Data that is older than this value is not
included in the calculation. For more details on the calculation model, see
"Baseline Threshold Values" on page 336.
Default value: 30 days
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningDaysToIncludeInCalculation
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UI Element

Description

Maximum
number of
percentile
ranges

Limits the number of percentile ranges displayed in the Percentile Ranges
Mapping Table.
Default value: 8
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningMaxNumberOfPercentilesRanges

Minimum
number of
days required
for baselining

Minimum number of days that the monitors must have run for SiteScope to
calculate the baseline.
Default value: 14 days
Minimum value: 1 (if you enter a value of less than 1, the default value is used
instead).
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningMinimumNumberOfDays

Minimum
number of
samples
required for
baselining

Minimum number of samples required for SiteScope to calculate the baseline.
Default value: 2016 (the number of samples produced for a monitor running over
a two week period, where the monitor runs every 10 minutes)
Minimum value: 1 (if you enter a value of less than 1, the default value is used
instead).
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningMinimumNumberOfSamples

Offset for
calculating
error boundary

Offset value to use for calculating the error boundary. The baseline threshold is
multiplied by this value when:
l

l

The Automatically create Error Threshold Boundary if no error
thresholds are defined option is selected (see below), or
The current most extreme error threshold is less extreme than the calculated
baseline threshold.

Default value: 0.3
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningUpperBoundOffset
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UI Element

Description

Parsing chunk
size

Number of monitors that are handled simultaneously by the log file parser. The
higher the number, the faster the baselining calculation, but more file handlers are
used.
Default value: 100
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningParsingChunkSize

Parsing thread
priority

Priority assigned to the parsing thread. The priority, if specified, must be between
1-10 inclusive. If not specified, the priority is set to 1. Generally, the higher the
priority, the faster the baseline calculations take to complete. Keep the priority as
low as possible, so as not to interfere with SiteScope online functionality.
Default value: 1 (low priority)
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningParsingThreadPriority

Percentile of
discarded
samples

Percentile of the most extreme samples (considered "noise" measurement
samples) that are not included in the baseline calculation.
Default value: 2.0
Note: You must restart SiteScope if you change this setting.
Property name: _baseliningNoiseMarginPercentile

Analytics Settings
User interface elements are described below:
UI Element

Description

Analytics
enabled

Enables the predictive analytics mechanism in SiteScope. If this setting is cleared,
the analytics calculation engines are stopped and analytics is disabled in the user
interface.
Default value: Selected
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsEnableDisableCalculation
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UI Element

Description

Automatic
tagging

SiteScope automatically generates an analytics tag value for each analytics
configuration which it assigns to the business monitor. The tag value is in the format
analytics_<monitor_name>, followed by a number in parenthesis if there is more
than one monitor with the same name.
Default value: Selected
Note: You must restart SiteScope if you change this setting.
Property name: _enableAnalyticsAutoTagging

Baseline
calculation:
core thread
pool size

Maximum number of threads to create in the analytics baseline calculation thread
pool. Additional threads are created (up to the maximum) only if all the core threads
are busy and the maximum queue size has been reached.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 1
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineCalculatorThreadPoolSize

Baseline
calculation:
maximum
queue size

Maximum number of analytics baseline calculation tasks that can be added to the
queue when the thread pool is at full capacity.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 5000
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineCalculatorMaxQueueSize

Baseline
calculation:
maximum
thread pool
size

Maximum number of threads in the analytics baseline calculation thread pool. More
threads than the core number are created only if all the core threads are busy and
the maximum queue size has been reached.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 1
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineCalculatorMaxThreadPoolSize
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UI Element

Description

Baseline
calculation:
monitors per
thread

Maximum number of monitor baseline calculations to run by a single thread. A larger
number requires more physical memory. A smaller number prolongs the calculation.
Default value: 100
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineCalculationMonitorPerThread

Baseline
calculation
data period
(millisecond
s)

Time period (in milliseconds) of historical data over which the analytics baseline
calculation is performed. Data older than this value is excluded from the calculation.
Default value: 2592000000 milliseconds (equivalent to 1 month)
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineCalculationPeriod

Baseline
calculation
frequency
(millisecond
s)

Frequency that the baseline calculation is performed.
Default value: 604800000 milliseconds (1 week)
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineTaskRepeatePeriod

Baseline
results aging
period
(millisecond
s)

Period of time that baseline results created from SiteScope data have been
inactive, before removing them from persistency.
Default value:432000000 milliseconds (5 days)
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineResultAgingPeriod

Baseline
sleeve
coefficient

The coefficient is the number of standard deviations above or below the mean. A
metric is considered to be abnormal if its value is higher or lower than the mean plus
or minus the baseline standard deviation multiplied by the coefficient.
By default, the baseline sleeve is calculated using a coefficient of + or - 3 times the
standard deviation from a metric's mean value.
This means that a metric is considered abnormal if its value is greater than the
mean value plus 3 times the standard deviation, or less than the mean value minus
3 times the standard deviation.
Default value: 3
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsBaselineBandWidth
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UI Element

Description

Correlation
calculation:
core thread
pool size

Number of threads to create in the analytics correlation calculation thread pool.
Additional threads are created (up to the maximum) only if all the core threads are
busy and the maximum queue size has been reached.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 5
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationCalculatorThreadPoolSize

Correlation
calculation:
maximum
queue size

Maximum number of analytics correlation calculation tasks that can be added to the
queue when the thread pool is at full capacity.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 5000
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationCalculatorMaxQueueSize

Correlation
calculation:
maximum
thread pool
size

Maximum number of threads in the analytics correlation calculation thread pool.
More threads than the core number are created only if all the core threads are busy
and the maximum queue size has been reached.
For additional details on thread pools, see the Oracle Java documentation,
http://docs.oracle.com/javase/7/docs/api/java/util/concurrent/ThreadPoolExecutor
.html.
Default value: 30
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationCalculatorMaxThreadPoolSize

Correlation
data
retention
period
(hours)

Time period (in hours) of historical data over which the analytics correlation
calculation is performed. Data older than this value is excluded from the calculation.
Default value: 10 hours
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationCalculationTimePeriod
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UI Element

Description

Correlation
result aging
period
(millisecond
s)

The period of time, in milliseconds, after which a correlation calculation is
considered as old enough to be re-calculated in case a new analytics alert is fired.
Default value: 3600000 (1 hour)
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationAgingMillis

Correlation
The value, as a percentage, above which two metrics are considered correlated.
score
Any two metrics with a score lower than this value are not considered correlated.
threshold (%) The score determines what results are displayed in the Correlation Results panel
and in the analytics alert.
Default value: 60
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsCorrelationScoreThreshold
Excluded
monitor
types

Lists the monitor types that are not available for analytics (generally system
monitors). You can add or remove monitor types from this list as required. If you add
monitor types to this list, you must use the "topaz name" of the monitor as listed in
"How to Use the Data Acquisition API" on page 163.
Default value: AmazonCloudWatch;CPU;Disk
Space;Memory;Ping;Composite;DHCP;Directory;DNS;Dynamic Disk
Space;File;FTP Monitor;Generic Hypervisor;HP iLO;NonStop
Resources;IPMI;KVM;HyperVMonitor;NT Dialup;Browsable NT
Counters;Dynamic Microsoft Windows Resources;Windows Services
State;Network Bandwidth Monitor;Port;SAP Performance;Service;SNMP;SNMP
by MIB Monitor;SNMP Trap;Unix Resources;VMware Datastore Monitor;VMware
Host CPU Monitor;VMware Host Memory Monitor;VMware Host Network
Monitor;VMware Host State Monitor;VMware Host Storage
Monitor;Vmware;Radius;Solaris Zones;Siebel Log;HAProxy
Monitor;DatabaseCounter;Log Event Health Monitor;Monitor Load Monitor;BAC
Integration Statistics;Health Server Load Monitor;BAC Integration
Configuration;SSL Certificates Status;Connection Statistics Monitor;Dynamic
Monitoring Statistics;License Usage
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsNotSupportedMonitorTypes
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UI Element

Description

Maximum
number of
target
monitors

The maximum number of monitors that can be designated as targets of a given
monitor for correlation matching.
Default value: 700
Note: You must restart SiteScope if you change this setting.
Property name: _analyticsMaxMonitors

Stop all
baseline
calculations

If selected, stops all baseline calculations. Use to temporarily stop background
calculations without disrupting access to analytics in the user interface. Clear this
setting to resume baseline calculations.
Default value: Not selected
Property name: _analyticsCorrelationAndBaselineCalculationStop

Event Console Settings
User interface elements are described below:
UI
Element

Description

Event
Console
enabled

When selected, new events triggered from Event Console alert actions are displayed in
the Event Console. When the setting is cleared, no new events are triggered from Event
Console alert actions.
Default value: Selected
Property name: _eventConsoleEnabled

Event
Console
UI
logging
enabled

Enables sending errors from the Event Console user interface to the event_console_
ui.log on the SiteScope server.
Default value: Selected
Property name: _eventConsoleUiLoggingEnabled
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UI
Element
Maximum
number
of
historical
events

Description
The maximum number of historical events that can be retrieved from the server logs for
display in the Event History view of the Event Console. This value cannot exceed 5000.
Once the display limit is reached, the oldest events are removed from the Event History
view, but they are still available in the event_console_history.log files (events are
never removed from a log file). The number of history files saved is 40 (one per day).
When the 41st day is reached, the oldest file is deleted.
Default value: 1000
Property name: _eventConsoleMaxHistorcalEvents

Maximum
number
of LDAP
users to
retrieve

Maximum number of LDAP users to retrieve from the LDAP server when loading the
users list to the Event Console. This value cannot exceed 1000.
Note: If you have an Active Directory domain that exceeds this number of users, you
cannot assign an event to an LDAP user that is not listed in the results retrieved from
the LDAP server, even if you manually enter the email address of the user.
Default value: 400
Property name: _eventConsoleMaxLdapUsers

Maximum
number
of live
events

The maximum number of live (non-closed) events to store on the server and display in
the Event Console (this value cannot exceed 5000). Once this limit is reached, the
oldest events are automatically closed and displayed in the Event History view, and are
written to the event_console_history.log with (CLOSED BY AUTOMATIC PURGE)
message enabling you to identify these events. Events are never removed from the log
files. You can configure the number of logs files that can be saved via the
log4j.properties file.
Default value: 1000
Property name: _eventConsoleMaxLiveEvents

Number
of
previous
hours of
historical
events to
retrieve

The number of previous hours of historical events to retrieve from the server logs for
display in the Event History view of the Event Console. This value cannot exceed 168
hours (1 week).
Default value: 48 hours
Property name: _eventConsoleMaxHistoryHours

Custom Settings
This table contains some of the more commonly-used custom settings.
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User interface elements are described below:
UI Element

Description

Access controlled

SiteScope is used in secure mode. To use auto
template deployment when SiteScope is in
secure mode, see "Deploy Templates
Automatically Using an XML File" on page 861.
Default value: true
Property name: _accessControlled

Analytics Min Data Days For Seasonality

The minimum number of days of data required for
the baseline to calculate seasonality. If the
number of data days is less than this value, no
seasonality calculation will occur.
Default value: 4
Property name: _
analyticsMinDataDaysForSeasonality

Analytics Min Distinct Values No For
Seasonality

The minimum number of data points required for
the baseline to calculate seasonality. If the
number of data points is less than this value, no
seasonality calculation will occur.
Default value: 10
Property name: _
analyticsMinDistinctValuesNoForSeasonality

Analytics Min Distinct Values No For Trend

The minimum number of data points required for
the baseline to calculate the trend. If the number
of data points is less than this value, no trend
calculation will occur.
Default value: 10
Property name: _
analyticsMinDistinctValuesNoForTrend

Analytics Min Samples In Bucket Length

The minimum number of data points a bucket
(internal algorithm terminology) must have in
order to be taken into the calculation.
Default value: 2
Property name: _
analyticsMinSamplesInBucketLength
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UI Element

Description

Analytics Min Samples No For Baseline

The minimum number of data points that is
required for the baseline to be calculated. If the
number of data points is less than this value, no
baseline calculation will occur.
Default value: 50
Property name: _
analyticsMinSamplesNoForBaseline

Analytics Min Samples No For Seasonality

The minimum number of data points that is
required for seasonality to be calculated. If the
number of data points is less than this value, no
seasonality calculation will occur.
Default value: 50
Property name: _
analyticsMinSamplesNoForSeasonality

Analytics Min Samples No For Trend

The minimum number of samples for enabling the
trend calculation. This is a parameter that
impacts internal algorithms. We do not
recommend changing this value without first
consulting with HP Software support.
Default value: 5
Property name: _
analyticsMinSamplesNoForTrend

Analytics Outlier Removal Coef

The number of standard deviations used to
validate if outlier removal should be done (outlier
is data that is outside the predictive analytics
baseline sleeve). This parameter impacts internal
algorithms. We do not recommend changing this
value without first consulting with HP Software
support.
Default value: 3
Property name: _analyticsOutlierRemovalCoef
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UI Element

Description

Analytics Outlier Removal Confidence Diff
Thres

The number of standard deviations used to set
the threshold if outlier removal should be done
(outlier is data that is outside the predictive
analytics baseline sleeve). This parameter
impacts internal algorithms. We do not
recommend changing this value without first
consulting with HP Software support.
Default value: 4
Property name: _
analyticsOutlierRemovalConfidenceDiffThres

Analytics Outlier Removal Min Confidence

The minimum value, below which, outlier (data
that is outside the predictive analytics baseline
sleeve) is removed from the results. This
parameter impacts internal algorithms. We do not
recommend changing this value without first
consulting with HP Software support.
Default value: 95
Property name: _
analyticsOutlierRemovalMinConfidence

Analytics Season Significance Threshold

The significance of seasonality in which a
season found is used. This parameter impacts
internal algorithms. We do not recommend
changing this value without first consulting with
HP Software support.
Default value: 0.03
Property name: _
analyticsOutlierRemovalMinConfidence

Analytics Trend Significant P Value

The Statistical P value for which the trend is
being assumed to exist. This parameter impacts
internal algorithms. We do not recommend
changing this value without first consulting with
HP Software support.
Default value: 0.001
Property name: _
analyticsTrendSignificantPValue
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UI Element

Description

Analytics Trend Significant R Square

The Statistical R Square value in which trend is
being assumed to exist for. This parameter
impacts internal algorithms. We do not
recommend changing this value without first
consulting with HP Software support.
Default value: 0.7
Property name: _
analyticsTrendSignificantRSquare

Auto Deployment Check Frequency
(seconds)

Time interval in seconds that the auto template
deployment xml files in the
persistency\autodeployement directory are
deployed. For details, see "Deploy Templates
Automatically Using an XML File" on page 861.
Default value: 120
Property name: _
autoDeploymentCheckFrequency

Custom monitor maximum number of script
parameters

Maximum number of parameters allowed in the
table. When the maximum number of rows is
reached, no additional rows can be added.
Default value: 10
Property name: _
customMonitorMaxNumOfScriptParams
Note: You must restart SiteScope if you change
this setting.

DockerMinimumContainerRunningTimeInMi
nutes

Minimum amount of time, in minutes, that
containers must be running before they are
monitored. This is used to avoid unnecessarily
monitoring containers (those that are dropped
after a short period of time).
Default value: 1 minute
Minimum value: 1 minute
Property name: _
DockerMinimumContainerRunningTimeInMinute
s
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UI Element

Description

dynamicDockerAppDiscoverCheckContainer
sExistencesRateInMinutes

Amount of time, in minutes, to wait before
checking for the existence of groups that were
deployed on containers that no longer exist. This
can occur when the Continue displaying
counters that no longer exist after update
check box is selected, since the monitor
continues to display counters although the
containers were already deleted. When a
container no longer exists, the discovery
mechanism automatically deletes any groups
deployed on the container.
Default value: 1440 minutes (24 hours)
Minimum value: 5 minutes
Property name: _
dynamicDockerAppDiscoverCheckContainersE
xistencesRateInMinutes

dynamicDockerAppDiscoverConfigFilesSam
pleRateInSeconds

Frequency, in seconds, for checking the config
file directory for changes. If a new config file is
added, or an existing file is deleted, the config file
list is updated.
Default value: 30 seconds
Minimum value: 30 seconds
Property name: _
dynamicDockerAppDiscoverConfigFilesSample
RateInSeconds

dynamicDockerAppDiscoverDeployTemplate The number of attempts to redeploy templates or
Attempts
publish template changes on some container.
This variable influences the _
dynamicDockerAppDiscoverReDeployTempl
atesRateDueToConfigFileChangesInMinutes
and _
dynamicDockerAppDiscoverDeployTemplate
RetriesRateInMinutes schedulers.
Default value: 3 attempts
Minimum value: 1 attempt
Property name: _
dynamicDockerAppDiscoverDeployTemplateAtt
empts
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UI Element

Description

dynamicDockerAppDiscoverDeployTemplate Amount of time, in minutes, to wait before
RetriesRateInMinutes
attempting to deploy template or publish template
changes after the previous attempt failed. The
mechanism attempts to deploy the template on
this container the number of times specified in
the _
dynamicDockerAppDiscoverDeployTemplate
Attempts parameter. If all attempts fail, the
container is removed from the waiting list.
Default Value: 30 minutes
Minimum value: 5 minutes
Property name: _
dynamicDockerAppDiscoverDeployTemplateRe
triesRateInMinutes
dynamicDockerAppDiscoverReDeployTempl
atesRateDueToConfigFileChangesInMinutes

Amount of time, in minutes, to wait between
checking whether the config files were updated.
If config files were updated, the discovery
mechanism searches for all groups that were
deployed by the config files and attempts to
redeploy templates or publish template changes.
Default value: 15 minutes
Minimum value: 5 minutes
Property name: _
dynamicDockerAppDiscoverReDeployTemplate
sRateDueToConfigFileChangesInMinutes

dynamicDockerAppDiscoverThreadPullSize

Amount of thread handlers that handle Docker
monitor deletion, application group deletion, and
docker monitor configuration updates from
Dynamic Docker monitors.
Default value: 15 thread handlers
Minimum value: 1 thread handler
Property name: _
dynamicDockerAppDiscoverThreadPullSize
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UI Element

Description

Generic Event Integration save data to zip

Indicates whether the data is saved to the cache
as a .zip file. SiteScope creates a folder named
after the integration’s ID, and within that folder, a
file for each sample cache file in the format:
l

l

(<numberOfEvents>EC_<timestamp>.<CacheSuffix>
<numberOfEvents>EC_<timestamp>.<CacheSuffix>.zipped (for zipped
files)

Default value: true
Property name: _
genericEventIntegrationGDSaveZipped
Generic Event Integration resend cache file
interval (minutes)

The interval between each resending of cache
files.
Default value: 5 minutes
Property name:
_genericEventIntegrationGDIntervalMinutes

Generic Event Integration file count to delete

When the cache folder reaches its maximum
size, SiteScope deletes X files from the cache
according to this value. If the value is -1,
SiteScope deletes half of the files in the cache
folder (deleting the oldest files first).
Default value: -1
Property name:
_genericEventIntegrationGDFileCountToDelete

Generic Event Integration maximum cache
size (MB)

Indicates the maximum size of the cache in
megabytes. When the cache reaches this value,
SiteScope deletes files from the cache
(according to the
_
genericEventIntegrationGDFileCountToDelet
e parameter).
Default value: 10 MB (this value must be an
integer)
Property name:
_genericEventIntegrationGDCacheMaxSizeMB
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UI Element

Description

Microsoft Windows Event Log monitor WMI
query hour range in first run

If the Microsoft Event Log monitor fails to get
data from Windows remote servers with large
amounts of log items when using the WMI
connection type, change the query hour range of
the first monitor run.
Default value: 168 hours (7 days).
Property name: _
ntEventLogWMIQueryHourRangeFirstRun

Save copy of content package with extended
files only

Content packages that contain a template with
no Custom monitors (for example, a template
with CPU monitor only), are no longer saved to
the <SiteScope root
directory>\packages\imported folder. You can
override this setting if necessary and save a
copy of the package by changing this property to
true.
Default value: false
Property name: _
saveCopyOfContentPackageWithExtendedFile
sOnly

Script monitor allow symbolic link

Enables support for symbolic links when
executing scripts on remote UNIX servers.
When enabled, the symbolic link appears in the
list of available scripts when configuring a Script
monitor to monitor a UNIX remote.
Default value: false
Property name: _
scriptMonitorAllowSymbolicLink

Siebel connect command

Enables you to customize the command for
connecting to the Siebel server. For details, see
Siebel Application Server Monitor in the
SiteScope Monitor Reference Guide.
Default value: $PARAM_PATH$/srvrmgr /g
$PARAM_GATEWAY$ /e $PARAM_
ENTERPRISE$ /s $SERVER$ /u $PARAM_
USERNAME$ /p $PARAM_PASSWORD$ /k
%%%
Property name: _siebelConnectCommand
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UI Element

Description

System log match regular expression

Enables you to determine how regular expression
strings are combined for the Syslog monitor.
Default value: /^[0-9A-Za-z ]*[0-9:9\.\,]+[ ]+[^ ]+[
]+{process}:{message}$/
Property name: _sysLogMatchRegExp

VMware maximum idle connections in pool

The maximum number of idle connections in the
pool.
Default value: 60
Property name: _
vmWareConncectionPoolMaxIdlePervCenterKe
y

VMware connection active connections in
pool

The maximum number of active connections in
the pool.
Default value: 60
Property name: _
vmWareConnectionPoolMaxSizePervCenterKe
y

VMware connection timeout (minutes)

Connection timeout in minutes.
Default value: 30
Property name: _vmWareConnectionTimeOut
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Using the Integration Preferences interface, you can create integration instances, enabling SiteScope
to report monitoring data to the following applications:
l

Amazon CloudWatch
For more details on the integration, see "Amazon CloudWatch Integration Preferences" below.

l

HP Business Service Management
For more details on the integration, see "BSM Integration Preferences" on page 665.

l

Diagnostics
For more details on the integration, see "Diagnostics Integration Preferences" on page 672.

l

HP Operations Manager
For more details on the integration, see "HP Operations Manager Integration Preferences" on page
677.

l

Generic Data Integration (metrics)
For more details on the integration, see "Generic Data Integration Preferences" on page 684.

l

Generic Event Integration
For more details on the integration, see "Generic Event Integration Preferences" on page 689.

Amazon CloudWatch Integration Preferences
This dialog box enables you to create a new Amazon CloudWatch integration or to edit an existing
integration. This enables customers who use SiteScope for monitoring their AWS-hosted applications
to report SiteScope metrics to Amazon CloudWatch service.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select Amazon CloudWatch Integration, or

l

Select an existing Amazon CloudWatch integration, and click Edit Integration.
Note: You must be an administrator in SiteScope, or a user granted View integration
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preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Learn About
Amazon CloudWatch Integration Overview
Amazon CloudWatch is a Web service that provides monitoring for Amazon Web Services (AWS)
cloud resources, starting with Amazon EC2. It provides visibility into resource utilization, operational
performance, and overall demand patterns—including metrics such as CPU utilization, disk reads and
writes, and network traffic.
This integration enables customers who use SiteScope for monitoring their AWS-hosted applications to
report any SiteScope metrics to Amazon CloudWatch service. After running the Amazon Web
Services monitor, SiteScope reports data to Amazon CloudWatch. This data can then be used for
AWS AutoScaling, reporting, and alerting. For details on configuring the monitor, see Amazon Web
Services Monitor in the SiteScope Monitor Reference Guide.
To enable SiteScope to report data to Amazon CloudWatch, you must configure the integration using
the Amazon CloudWatch Integration Preferences dialog box.

UI Descriptions
Amazon CloudWatch - General Settings
User interface elements are described below:
UI Element

Description

Name

Name by which to identify this integration in the SiteScope interface.
Note: This is a required field.

Description Description of the integration. This could include information on the application
receiving the data from SiteScope. This description appears only in the Integration
Preferences page in SiteScope.
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Amazon CloudWatch - Integration Preferences Settings
User interface elements are described below:
UI Element

Description

Namespace

The namespace corresponding to the service of interest. This is a required field.
Note:
l

l

You cannot specify a namespace that begins with "AWS/". Namespaces
that begin with "AWS/" are reserved for other Amazon Web Services
products that send metrics to Amazon CloudWatch.
Namespace is limited to a maximum of 250 characters.

Default value: HP/SiteScope
Encoding

Encoding used by the receiving application.
Default value: UFT-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the next
period SiteScope begins sending data. This is a required field.

Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the server
receiving SiteScope data, SiteScope can periodically report the time that is
registered on its server. The receiving server can then synchronize the time of
the data samples coming from SiteScope with the time on its own server so that
there is no discrepancy between the time of the SiteScope data and the
application's own data.

Default value: 60 seconds

Select in minutes how often you want SiteScope to report to the time of the
SiteScope server to the server receiving SiteScope data.
Default value: 10 minutes
Request
timeout
(seconds)

Timeout, in seconds, until a connection is established with the server. A value of
zero means there is no timeout used.
Note: This is a required field.
Default value: 120 seconds

Connection
timeout
(seconds)
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UI Element

Description

Number of
retries

Number of times SiteScope attempts to establish a connection.

Disable
integration

SiteScope does not forward data to the server. The integration preference setting
remains. Use when temporarily disabling the integration.

Default value: 3

Default value: Not selected

Amazon CloudWatch - Security Settings
User interface elements are described below:
UI
Element

Description

AWS
Access
Key ID

An alphanumeric token that uniquely identifies you as the party responsible for service
requests. This ID is associated with your AWS Secret Access Key.

AWS
Secret
Key

The secret key assigned to you by AWS when you sign up for an AWS account. Used for
request authentication.

Region

The Amazon EC2 region that is used to get or store measurements.
Amazon EC2 is currently available in the following regions: US East (Northern Virginia),
US West (Oregon), US West (Northern California), EU (Ireland), Asia Pacific
(Singapore), Asia Pacific (Sydney), Asia Pacific (Tokyo), South America (Sao Paulo),
and AWS GovCloud.

Get
Opens the Get Regions dialog box, enabling you to select the Amazon EC2 region used
Regions to get or store measurements.

Amazon CloudWatch - Proxy Server Settings
User interface elements are described below:
UI Element

Description

NTLM V2 Proxy

Select if the proxy requires authentication using NTLM version 2.
Default value: Not selected

Address

Proxy server address if applicable.

User name

Username for the proxy server.

Password

Password for the specified server.

HP SiteScope (11.31)

Page 663 of 1395

Using SiteScope
Chapter 50: Integration Preferences

Amazon CloudWatch - Reporting Tags
User interface elements are described below:
UI
Element Description
<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to the
receiving application. You must select at least one tag for each integration. That same tag
must be selected for the groups, subgroups, and monitors whose data you want
forwarded to the receiving application.
When selecting an integration tag for an object, the tag propagates to that object's
children. If you tag a group with this Integration tag, all its subgroups and monitors report
their status to the receiving application.
Example: Create a tag called Integration_ACW and select it here. For each group,
monitor, or both, whose status you want to report to the receiving application, select this
tag under the Search/Filter Tags setting for the object.
Note:
l

l

l

Add
Tag

You can select multiple tags for each integration preference. You can select multiple
Integration tags for the objects to be reported.
The selected reporting tag must contain a tag value description.
SiteScope is unable to send metrics to the Amazon CloudWatch service if default
reporting tags (from the Monitor Deployment Wizard group) are used.

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
Tip: Use the word Integration_<integration identifier> when creating an
integration tag, since this tag appears along with all other Search/Filter tags created for
the SiteScope. This helps you to identify which tag to select for enabling a group or
monitor for the integration.
Note:
l

l

The selected reporting tag must contain a tag value description.
SiteScope is unable to send metrics to the Amazon CloudWatch service if default
reporting tags (from the Monitor Deployment Wizard group) are used.
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Tips/Troubleshooting
Notes/Limitations
l

l

l

l

l

l

l

SiteScope is able to report numeric counters only to Amazon CloudWatch, and they must have a
minimum length of 1 character and a maximum length of 255 characters.
Amazon CloudWatch does not allow names of counters which contain non-ASCII characters. As a
result, if a counter contain non-English characters in name, Amazon rejects all the monitor's
counters.
Amazon CloudWatch truncates values with very large and very small exponents; values with base10 exponents greater than 126 (1 x 10^126), and values with less than -130 (1 x 10^-130) are
truncated.
The Amazon CloudWatch integration cannot send more than 20 metrics to the Amazon
CloudWatch service in one request.
Allow up to 15 minutes for the metric to appear in Amazon CloudWatch.
It is currently not possible to delete SiteScope metrics reported to the Amazon CloudWatch
service. As a result, metrics are automatically removed from Amazon after two weeks if they are
not updated.
By default, SiteScope gets data from AWS-hosted applications at a 2-minutes interval. You can
customize the period for receiving data from Amazon by adding the _
amazonCloudWebServiceMonitorPeriod property (and a value in minutes) to the <SiteScope
root directory>\groups\master.config file. For example, _
amazonCloudWebServiceMonitorPeriod=10 means that SiteScope gets the average values of
metrics for the last 10 minutes.

BSM Integration Preferences
This dialog box enables you to modify BSM integration settings and to create a new BSM integration for
a profile that was created in SAM Administration but when the SiteScope was inaccessible.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select BSM Integration, or

l

Select an existing BSM integration, and click the Edit Integration button.
Note: You must be an administrator in SiteScope, or a user granted View integration
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preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Learn About
This section contains the following topics:
l

"BSM Integration Preferences Overview" below

l

"Using a Secure Connection for SiteScope-BSM Communication" below

l

"Changing the Gateway Server to Which SiteScope Sends Data" on the next page

l

"Compressing SiteScope Data Sent to BSM" on the next page

BSM Integration Preferences Overview
To enable logging of SiteScope monitor data to BSM, the SiteScope must be configured as a data
collector for BSM. This involves adding a SiteScope to the System Availability Management (SAM)
Administration page in the BSM. After the SiteScope is added and a connection is established, a BSM
Integration Preference appears in the Integration Preferences page that includes the relevant
configurations as entered in the New SiteScope Page in SAM Administration.
You use the Integration preference to:
l

Modify the available integration settings.

l

Disable logging all data to BSM. This includes topology reporting.

l

Create an integration for an empty SiteScope profile. If when adding the SiteScope to SAM
Administration, the SiteScope was not accessible to BSM (for example, when working in HP
Software-as-a-Service), you add a SiteScope with an Inaccessible profile to SAM Administration.
You then configure the connection and the integration in the Integration Preferences. For details on
this task, see "How to Configure SiteScope-BSM Integration Preferences for Inaccessible Profiles"
on the next page.

If the BSM Server to which you are connecting is on a different machine than the BSM Server that
SiteScope reports data, you must provide connection information for both servers under the Main
Settings in SiteScope's Integration Preferences, or in the Distributed Settings in SAM
Administration's New SiteScope Page.

Using a Secure Connection for SiteScope-BSM Communication
You can use a secure connection to transmit data from SiteScope to the BSM server. If you have
installed a certificate signed by a root Certificate Authority on the BSM server, no additional setup is
required on the SiteScope server. If you are using a self-signed certificate on the BSM server and want
to use that certificate for secure communication with SiteScope, you must perform the appropriate step
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below:
l

l

For BSM server that requires a secure connection, see "How to Connect SiteScope to a BSM
Server That Requires a Secure Connection" on page 224.
For BSM server that requires a client certificate, see Configuring SiteScope to Connect to a BSM
Server That Requires a Client Certificate in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
Note:
n

You only need to specify these settings if the certificate installed on the BSM machine is not
signed by a root Certificate Authority (CA). For example, if you are using a certificate signed
by a Certificate Authority such as Verisign, you do not need to change these settings.

n

You can import the self-signed certificate into the same keystore file used for other SiteScope
monitors but that is not required. You can create a separate keystore for the BSM server
certificate.

Changing the Gateway Server to Which SiteScope Sends Data
You can change the Gateway Server to which a SiteScope reports its data. Generally, this is applicable
only if you are working with a BSM deployment with components installed on more than one server.
You make this change by entering the required Gateway Server name or IP address in the Business
Service Management machine name/IP address box in the Integration Preferences page. You must
also update the SiteScope settings with the Gateway Server name in SAM Administration.
Note: This function can only be used for changing the Gateway Server for a SiteScope that is
already registered with a given BSM installation. It cannot be used to add a new SiteScope, or to
connect a SiteScope to a different BSM system.

Compressing SiteScope Data Sent to BSM
By default, when data is sent from the SiteScope server to BSM it is sent uncompressed. To enable
data compression of SiteScope monitor (ss_monitor_t) and SiteScope metric (ss_t) samples, set the
property _compressDataInGzipFormat= to true in the <SiteScope root
directory>\groups\master.config file. When this setting is enabled, SiteScope data is compressed in
gzip before it is sent to BSM (where it is decompressed). Note that data compression can be used only
when SiteScope is reporting to BAC 8.05 or later, or BSM 9.01 or later.

Tasks
How to Configure SiteScope-BSM Integration Preferences for Inaccessible Profiles
This task describes the steps involved in configuring SiteScope as a data collector for BSM when the
SiteScope is inaccessible to the BSM, for example when working in HP Software-as-a-Service.

HP SiteScope (11.31)

Page 667 of 1395

Using SiteScope
Chapter 50: Integration Preferences

1. Add a SiteScope profile to BSM
In BSM, create an empty profile for the SiteScope in SAM Administration's New SiteScope page
by selecting Inaccessible profile.
For user interface details, see the New/Edit SiteScope Page in the BSM User Guide in the BSM
Help.
2. Specify connection parameters to BSM servers
In SiteScope, add a new BSM Integration Preference to the Integration Preferences. Enter the
values for the BSM integration. When adding the integration, click the Get Available Profile
button and select the empty profile you created in BSM.
For user interface details, see "BSM Integration Main Settings" below.
3. Configure a secure connection for SiteScope-BSM communication
If you are using a self-signed certificate on the BSM server and want to use that certificate for
secure communication with SiteScope, you must perform the appropriate step below:
n

For a BSM server that requires a secure connection, see "How to Connect SiteScope to a BSM
Server That Requires a Secure Connection" on page 224.

n

For a BSM server that requires a client certificate, see Configuring SiteScope to Connect to a
BSM Server That Requires a Client Certificate in the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Related tasks: "How to Configure SiteScope to Communicate with BSM" on page 219, "How to
Configure Topology Reporting" on page 225

UI Descriptions
BSM Integration Main Settings
User interface elements are described below:
UI Element

Description

Business
Machine name or IP address of the BSM server to which you want this SiteScope to
Service
connect.
Management
Note: This is a required field.
machine
name/IP
address
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UI Element

Description

SiteScope
agent
machine
location

Location of the SiteScope server that you are connecting to BSM. You can specify
any value that helps you identify the location of this specific SiteScope server.
Note: This is a required field.

Disable all
Stops SiteScope from sending metrics and data to BSM. Clear the check box to
logging to
enable logging and data flow.
Business
Note:
Service
Management
l
This does not disable topology reporting.
l

If SiteScope is configured to send data to BSM and your SiteScope license
edition (Premium, Ultimate, or System Collector) expires, SiteScope stops
sending all data (including topology) to BSM. When you renew the SiteScope
license, you must clear this check box to enable logging and data flow to BSM,
since SiteScope automatically disables logging to BSM on license expiration.

Default value: Not selected
<profile>

SiteScope profile in which BSM stores the data collected by SiteScope.
Note: The profile must previously have been configured in BSM's SAM
Administration.

Get
Available
Profiles

Displays a list of available profiles. Use this button only if registering the SiteScope
to an empty profile (Inaccessible Profile) that was created in SAM Administration.

Business
Username of a BSM administrator-level user.
Service
Management
user name
Business
Password for the specified user.
Service
Management
user
password

Web Server Security Settings
User interface elements are described below:
UI Element

Description

Authentication user
name

User name to access the server if the BSM server is configured to use
basic authentication.
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UI Element

Description

Authentication
password

Password to access the server if the BSM server is configured to use
basic authentication.

Use SSL (HTTPS
protocol)

Select if the BSM server is configured to use the HTTPS protocol.
Default value: Not selected

Proxy Server Settings
User interface elements are described below:
UI Element

Description

Address

Proxy server address if applicable.

User name

Username for the proxy server.

Password

Password for the specified server.

Topology Reporting Settings
User interface elements are described below:
UI Element

Description

Topology
resynchronization
time interval
(days)

Number of days for SiteScope to synchronize topology data with BSM.
The topology information SiteScope reports to BSM is synchronized when
SiteScope restarts after this time interval has been reached.
Default value: 7 days
Minimum value: 1 day
Note: All topologies created by SiteScope and stored in RTSM are subjected
to the aging process. To prevent aging, see "Integrate SiteScope Data with
BSM's Configuration Items" on page 210.

Default topology
probe domain

Default domain of the SiteScope topology probe.
Default value: DefaultDomain
Note: You must restart SiteScope if you change this setting.

Topology receiver
port

Topology receiver port used in BSM.
Default value: 80
Note: You must restart SiteScope if you change this setting.
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UI Element

Description

Topology receiver
SSL port

Topology receiver SSL port used in BSM.
Default value: 443
Note: You must restart SiteScope if you change this setting.

Topology antiaging offset
(minutes)

Offset from midnight, in minutes, for running the anti-aging process. For
details on anti-aging, see "Integrate SiteScope Data with BSM's Configuration
Items" on page 210.
Default value: 0
Note: You must restart SiteScope if you change this setting.
Example: To run anti-aging at 1:30 am, enter an offset of 90.

BSM Preferences Available Operations
User interface elements are described below:
UI Element

Description

Reset

Deletes all the BSM related settings from the SiteScope server and all SiteScope
configurations are deleted from BSM. This also sends a message to the applicable
BSM server to release the SiteScope agent from the corresponding profile.
Note: If you choose to reset the current settings, you have to create or use a
different profile to reconnect SiteScope with BSM. BSM does not enable you to
select a previously used connection profile.

ReForces SiteScope to resend all its configuration data to BSM. This data consists of
Synchronize all the group and monitor definitions. Re-synchronize also forces SiteScope to
resend all topology data to BSM.
Note: If you upgrade to BSM 9.10 or later, you should manually resynchronize
SiteScope instead of waiting for topology data to be sent to BSM based on the
Topology resynchronization time interval value.
Hard ReForces SiteScope to resend all its configuration data and topology data to BSM. For
Synchronize configuration data, it also deletes the existing monitor and group data from BSM for
this SiteScope profile.

Tips/Troubleshooting
Notes/Limitations
l

To secure the connection to BSM (since the BSM user name and password are not used for
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authentication), it is recommended to configure either Basic Authentication in SiteScope or use twoway SSL. If BSM is configured to use Basic Authentication, the same user name and password
entered in the Default authentication user name and Default authentication password fields in
SiteScope (Preferences > General Preferences > General Settings) are used for reporting both
data and topology to BSM. If BSM is not configured to use Basic Authentication, the credentials
sent are ignored.
l

By default, data sent from the SiteScope server to BSM is sent uncompressed. For details on
enabling data compression, see "Compressing SiteScope Data Sent to BSM" on page 667.

Troubleshooting
For troubleshooting on reporting data to BSM, see " Connecting to a BSM Server" on page 207.

Diagnostics Integration Preferences
SiteScope forwards data to Diagnostics enabling you to see a more complete view of the application
servers that are monitored by Diagnostics. The data can provide insight into the infrastructure
components onto which the application servers are deployed.
For example, integrating data from the SNMP by MIB monitor can help determine problems with the
infrastructure on which the application server runs.SiteScope forwards data on groups, monitors, and
measurements. Diagnostics can read the data sent from SiteScope and present the data in its reports
and graphs.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select Diagnostics Integration, or

l

Select an existing Diagnostics integration, and click the Edit Integration button.
Note: You must be an administrator in SiteScope, or a user granted View integration
preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Learn About
Units of Measurements in Diagnostics
SiteScope generates a file <SiteScope root directory>/conf/ integration/data_integration_
uom.xml that controls the mappings of SiteScope monitors to Diagnostics metrics and the units of
measurement used for the metrics. Diagnostics accepts data from SiteScope only if the data is
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associated with a unit of measurement that Diagnostics can recognize. SiteScope units are captured
from the monitored source and may need to be mapped to the appropriate Diagnostics unit of
measurement. The units of measurements used by SiteScope monitors vary, depending on the type of
data being monitored. For example, the unit of measurement used for the CPU monitor is a percentage
and the unit of measurement used for the Disk Space monitor is number of bytes. It is therefore
recommended that you modify the xml file as needed so that Diagnostics recognizes the unit of
measurement to use for the monitor data coming from SiteScope.
When new monitors are added to the SiteScope that report data to Diagnostics, it is recommended that
you edit the Diagnostics Integration Preference and click the Generate UOM XML button. SiteScope
generates a list of currently deployed monitors and their corresponding metrics. This list merges with
the <SiteScope root directory>/conf/ integration/data_integration_uom.xml file and updates only
those values in the xml file that were not manually changed. If any values were manually changed in
the xml file, those values are not updated and are preserved. This merge of information on units of
measurements occurs when you click this button and on each SiteScope restart.
For a reference detailing the XML tags, elements, and attributes included in the integration file that
SiteScope forwards to Diagnostics, see "XML Tag Reference for Generic Data and Diagnostics
Integrations" on page 695.

Tasks
How to Integrate SiteScope with HP Diagnostics
For an end-to-end flow on integrating SiteScope with Diagnostics, see Integrating SiteScope with HP
Diagnostics in the SiteScope Help. You can check the HP Software Integrations site for the latest
version of this guide.

UI Descriptions
Diagnostics Integration - General Settings
User interface elements are described below:
UI Element

Description

Name

Name by which to identify this integration in the SiteScope interface.
Note: This is a required field.

Description Description of the integration. This could include information on the Diagnostics
server receiving the data from SiteScope. This description appears only in the
Integration Preferences page in SiteScope.
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Diagnostics Integration - Preferences Settings
User interface elements are described below:
UI Element

Description

Receiver URL

URL of the Diagnostics server to receive the SiteScope data. This must be a full
URL including server, port where diagnostics receives data, and path. The path
must always include /metricdata/siteScopeData.
If secure connection (SSL), then enter https.
Syntax: http or https://<fully qualified domain name of the receiving
server>:<port number receiving data>/metricdata/siteScopeData
Example: http://DiagnosticsServer1.hp.net:2006/metricdata/siteScopeData

Encoding

Encoding used by the Diagnostics application.
Default value: UTF-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the
Diagnostics server to the next period SiteScope sends data. This time interval
can prevent communication delays between the servers as it is an interval of
time when no data is sent.
Default value: 60 seconds

Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the Diagnostics
server, SiteScope periodically reports the time that is registered on its server.
Diagnostics then synchronizes the time of the data samples coming from
SiteScope with the time on its own server so that there is no discrepancy
between the time of the SiteScope data and the Diagnostics data.
Select in minutes how often you want SiteScope to report to Diagnostics the
time of the SiteScope server.
Default value: 10 minutes

GZIP
compression

Compresses the sample data sent to the Diagnostics server. If the data is
compressed, then performance is improved because the time to send data is
reduced. The Diagnostics application can handle compressed data. Select or
clear this field depending on the amount of data being sent.
Default value: Selected
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UI Element

Description

Include
additional data

If cleared, SiteScope reports the status of the following SiteScope objects:
l

groups

l

monitors

l

counters

If selected, the status of these objects are reported along with the status string,
which includes the descriptions of each object.
Default value: Not selected
Tip: It is recommended not to include additional data as it slows performance,
and the status string repeats the status data that is sent by default.
Error on
redirect

SiteScope returns an error status if the target URL is redirected.

Request
timeout
(seconds)

Socket timeout, in seconds, which is the timeout for waiting for data. A timeout
value of zero is interpreted as an infinite timeout.

Connection
timeout
(seconds)

Timeout, in seconds, until a connection is established. A value of zero means
the timeout is not used.

Number of
retries

Number of times SiteScope attempts to establish a connection.

Authentication
when requested

SiteScope sends user name and password credentials if requested. If cleared,
SiteScope does not forward credentials.

Default value: Not selected

Default value: 120 seconds

Default value: 120 seconds

Default value: 3

Default value: Selected
Disable
integration

SiteScope does not forward data to the Diagnostics server. The integration
preference settings remain. Use when temporarily disabling the integration.
Default value: Not selected
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UI Element

Description

Generate UOM
XML

Generates a unit of measurement xml file to merge with the <SiteScope root
directory>/conf/ integration/data_integration_uom.xml file. This file enables
Diagnostics to read the SiteScope data and apply the appropriate unit of
measurement to the data. It is recommended that you click this button when a
monitor instance is added that reports data to Diagnostics. If any values were
manually changed in the data_integration_uom.xml file, those values remain
and are not updated by this merge file. This merge file is also generated and
updates the xml file on every SiteScope restart. For details, see "Units of
Measurements in Diagnostics" on page 672.

Diagnostics Integration - Web Server Security Settings
User interface elements are described below:
UI Element

Description

Authentication user
name

Username to access the server if the server is configured to use basic
authentication.

Authentication
password

Password to access the server if the server is configured to use basic
authentication.

Diagnostics Integration - Proxy Server Settings
User interface elements are described below:
UI Element

Description

Address

Proxy server address if applicable.

User name

Username for the proxy server.

Password

Password for the specified server.

Diagnostics Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description
<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to
Diagnostics. You can select more than one tag for each integration. The tag must be
selected for the groups, subgroups, and monitors whose data you want forwarded to
Diagnostics.
When selecting an Integration tag for an object, the tag propagates to that object's
children. If you tag a group with this Integration tag, all its subgroups and monitors report
their status to Diagnostics.
Example: Create a tag called Diagnostics_Integration1 and select it here. For each
group, monitor, or both, whose status you want to report to Diagnostics, select this tag
under the Search/Filter Tags setting.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
Tip: Use the word Integration when creating an Integration tag. Because the
Integration tags appear along with all other Search/Filter tags created for the SiteScope,
this helps you identify which tag to select for enabling a group or monitor for the
integration.

HP Operations Manager Integration Preferences
Use the HP Operations Integration to enable SiteScope to send common events and metrics data to
HPOM and BSM products. The HP Operations Integration uses the HP Operations agent, which must
be installed and configured on the SiteScope server, to provide visibility of SiteScope servers and
monitors to HPOM and Operations Management in BSM. For details on installing the agent and
configuring the integration, see the Integrating SiteScope with HP Operations Manager Products Guide
available on the available on the HP Software Integrations site.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select HP Operations Manager Integration, or

l

Select an existing HPOM integration, and click the Edit Integration button.
Note: You must be an administrator in SiteScope, or a user granted View integration
preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
topic, see "User Management Preferences" on page 732.
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Learn About
HP Operations Manager Integration Overview
To provide visibility of SiteScope servers and monitors to Operations Manager (HPOM) and Operations
Management in BSM, the HP Operations agent must be installed and configured on the SiteScope
server. The HP Operations agent sends events to the HPOM management server and to Operations
Management. It also acts as a data storage for metrics data collected by SiteScope. The agent must be
connected to the HPOM/BSM Server, and event or metrics integration with HP Operations Manager
must be enabled.
l

l

Event Integration. SiteScope events are triggered when there is a change in SiteScope monitor
metric status (good/warning/error) or when a SiteScope alert is triggered. SiteScope sends events
by writing them to a log file which is monitored by the HP Operations agent. The agent reads the
data and converts it to events, which it forwards to the HPOM/BSM server.
Metrics Integration. SiteScope reports metrics data to the HP Operations agent for use in HPOM
(Performance Manager) and OMi (Performance Graphing). Metrics integration with Operations
Manager can be activated regardless of the connection status between the HP Operations agent
and the HPOM/BSM server, since metrics are collected by the agent.
Note: While the HP Operations agent is supported as a data source for Performance Graphing
in BSM, HP plans to stop supporting the agent for Performance Graphing, and recommends
that you use the profile database in BSM as the data source instead. For details, see
Integrating SiteScope with HP Operations Manager Products in the SiteScope Help. You can
check the HP Software Integrations site for the latest version of this guide.

Tasks
How to Integrate SiteScope with HP Operations Manager Products
For an end-to-end flow on how to enable SiteScope to send events to HPOM or OMi, or how to enable
SiteScope to report metrics using the HP Operations agent, see Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help. You can check the HP Software Integrations site
for the latest version of this guide.
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UI Descriptions
HP Operations Manager Integration Main Settings
User interface elements are described below:
UI Element

Description

Connection Settings
HP Operations
Agent
installation
path

Path to the HP Operations agent installation on the SiteScope machine.
l

l

On Windows platforms, the installation path is automatically resolved from
the HP Operations agent InstallDir key in the registry, and displayed in this
field. The default path is C:\Program Files\HP\HP BTO Software\. If the
key is not found, the field is left empty, and you must manually enter the agent
installation path.
On UNIX platforms: SiteScope checks to see if the HP Operations agent is
installed in the default /opt/OV path. If it is not there, the field is left empty,
and you must manually enter the agent installation path.

Click the Resolve Path button to restore the default installation path found by
SiteScope if you manually entered a different path.
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UI Element

Description

HP Operations
Manager/BSM
server

Enter the name or IP address of the HPOM/BSM server to which you want to
connect. Click the Connect button to connect the agent and the HPOM/BSM
host machine.
If you are connecting to a BSM distributed environment, enter the BSM Gateway
Server name or IP address. If your BSM Gateway Servers are behind a load
balancer:
l

l

For BSM data/topology integration: Enter the name or IP address of the load
balancer that is configured for users.
For OM event integration (Operations Management in BSM): Enter the name
or IP address of the load balancer that is configured for data collectors.

For task details, see "How to Enable SiteScope to Send Events to HPOM or
Operations Management" > "Configure the connection request to be passed to
the Data Processing Server if BSM is installed on a distributed environment, or
BSM Gateway Servers are behind a load balancer" in Integrating SiteScope with
HP Operations Manager Products in the SiteScope Help. You can check the
HP Software Integrations site for the latest version of this guide.
If there are connection problems, click the Analyze button to perform problem
analysis and to check the status of the agent and the certificate request.
After a connection request is sent, the HPOM/BSM server must grant the
certificate request (unless the HPOM/BSM server was configured to accept this
client automatically).
After the certificate request has been granted on the HPOM/BSM server, click
Install Policies to install and sign the preconfigured log file policy file on the
HP Operations agent.
Note: You cannot disconnect or change the connection to another HPOM/BSM
server from SiteScope after the certificate request has been granted on the
HPOM/BSM server. Contact your HPOM/BSM administrator for assistance.
Configuration Settings
Enable sending Enables sending events from SiteScope to the HPOM/BSM server.
events
Default value: Not selected
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UI Element

Description

Connect
directly to BSM

When the agent is connected to Operations Management in BSM, select to
automatically deactivate the node discovery policy if it was installed and enabled
on the SiteScope server.
When this option is selected:
l

l

The Enable node discovery policy option is not available, and the node
discovery policy is disabled if it was installed and enabled on the SiteScope
server.
The Prefer events over metrics in BSM Service Health (global
preference) option is automatically selected.

When this option is cleared:
l

l

The Enable node discovery policy option is automatically selected.
The Prefer events over metrics in BSM Service Health (global
preference) option is automatically cleared.

Default value: Selected
Prefer events
over metrics in
BSM Service
Health (global
preference)

The global default preference for influencing BSM's Service Health when both
SiteScope events and metrics are reported to Service Health (since indicators for
SiteScope events and metrics both affect CIs). This is relevant only when both
BSM and Operations Manager integrations are active, and are connected to the
same BSM server (the BSM server is used instead of the HPOM server).
If selected, the Events option is set as the default preference for every new
monitor created (in HP Integration Settings > BSM Service Health
Preferences). If not selected, Metrics is the default preference for reporting data
to BSM.
For more information on choosing the preference to use, see Integrating
SiteScope with Business Service Management Applications in the Integration
with BSM and HPOM Best Practices Guide.
Default value: Selected
Note:
l

l

HP SiteScope (11.31)

This option is automatically selected if Connect directly to BSM is selected.
This setting does not override the preference set for individual monitor
instances in HP Integration Settings > BSM Service Health Preferences.

Page 681 of 1395

Using SiteScope
Chapter 50: Integration Preferences

UI Element

Description

Enable node
discovery
policy

SiteScope enables the node discovery policy (if installed) on the SiteScope
server. This option is automatically selected when the Connect directly to BSM
option is cleared. For details on Node discovery, see "Discovery Scripts and the
Drill Down User For Viewing HPOM Events" in Integrating SiteScope with HP
Operations Manager Products in the SiteScope Help. You can check the
HP Software Integrations site for the latest version of this guide.
Default value: Not selected

Enable
exporting
templates to
HP Operations
Manager

Enables exporting all templates from SiteScope and importing them to HPOM as
policies (only when SiteScope and HPOM are installed on the same system),
which you can later on assign and deploy from HPOM. For details on the
template integration with HPOM, see "Centralized Template Management from
HPOM" in Integrating SiteScope with HP Operations Manager Products in the
SiteScope Help. You can check the HP Software Integrations site for the latest
version of this guide.
Default value: Selected

HP Operations Manager Integration Advanced Settings
User interface elements are described below:
UI Element

Description

Event Integration Settings
Test message

Checks that the HP Operations agent is connected to
the HPOM/BSM server and can send a message.
Type a test message to send to the HPOM/BSM
server and click the Send Test Message button.
Note: To run the test, the opcmsg log policy must be
deployed, signed, and installed either manually or
after activating the events integration.

Send Test Event

Sends a test event to the HPOM/BSM server.

Default Severity Mappings
Severity mappings correlate the severity level in HPOM/BSM to the monitor threshold status in
SiteScope. They are sent in events triggered by SiteScope alerts when SiteScope is not connected
to BSM, or where the indicator state and severity value are missing. You can use the default severity
mappings or customize the mappings.

HP SiteScope (11.31)

Page 682 of 1395

Using SiteScope
Chapter 50: Integration Preferences

UI Element

Description

Error

Mapping between the Error status threshold for each
monitor instance in SiteScope and the HPOM/BSM
server.
Default value: Critical

Warning

Mapping between the Warning status threshold for
each monitor instance in SiteScope and the
HPOM/BSM server.
Default value: Minor

Good

Mapping between the Good status threshold for each
monitor instance in SiteScope and the HPOM/BSM
server.
Default value: Normal

Unavailable

Mapping between the Unavailable status threshold for
each monitor instance in SiteScope and the
HPOM/BSM server.
Default value: Unknown

Use default severity

When selected, the default mappings are sent in:
l

Events created by a triggered alert.

l

When SiteScope is not connected to BSM.

l

In any case where the indicator state and severity
value is missing. For example, when using
monitors that do not have a defined topology.

Note:
l

l

This option is not available when SiteScope is
connected to BSM (and the default global severity
mappings cannot be sent).
By default, the Warning state is mapped to Minor
(not Warning).

Default value: Not selected.
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HP Operations Manager Metrics Integration
User interface elements are described below:
UI Element

Description

Enable HP
Operations
Manager
metrics
integration

Enables SiteScope to report metrics to the HP Operations agent, from which HPOM
and the BSM reporting products are able to collect the data.
Note: You must enable each monitor instance that you want to send data to the HP
Operations agent, by selecting Report metrics to HP Operations agent in monitor
properties (HP Integration Settings > HP Operations Manager Integration
Settings). For details, see "HP Integration Settings" on page 297.
Default value: Not selected

Enable
Enables SiteScope to report metrics to the HP Operations agent for all newlymetrics
created monitors.
reporting for
Default value: Not selected
new
monitors
Enable
Automatically enables reporting metrics for all existing Memory, CPU, Disk Space,
metrics
and Windows Resources monitors without having to select Report metrics to HP
reporting for Operations agent in the monitor properties for each monitor instance.
specific
monitors

Generic Data Integration Preferences
Use Generic Integrations to create a new generic data integration to forward data (metrics) to another
application for which a direct integration does not exist. That application must be able to receive the
XML files that SiteScope forwards. These files contain information regarding the status of the
SiteScope's groups, monitors, and measurements.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select Data Integration, or

l

Select an existing Data integration, and click the Edit Integration button.
Note: You must be an administrator in SiteScope, or a user granted View integration
preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
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topic, see "User Management Preferences" on page 732.

Learn About
Delivering Data Using HTTP Request
The receiving application must be enabled to receive the data from SiteScope. This means that the
application should be able to receive the http request from the SiteScope server and to decipher the
XML file when it arrives.
The http request includes the following header:
Content-Type: text/xml
If you selected to zip the contents of the XML file, then the http request includes the following header:
Content-Type: text/xml
Content-Encoding: gzip
You select whether to zip the data in the Data Integration Preferences dialog box when creating the
integration in SiteScope. If you select to zip the data, your application must be able to unzip the file
SiteScope sends.

Time Synchronization
You can synchronize the time of the SiteScope server with your application's server by enabling
SiteScope to forward a separate time synchronization XML file. This file is sent in the same way as the
data XML and at an interval you select in the Time synchronization interval field in the Data
Integration Preferences dialog box when creating the integration in SiteScope. If you enter a value in
this field, SiteScope forward the date stamp of its server to the application receiving its data at the
interval specified. For details on this option, see the Time synchronization interval (minutes) field in
Data Integration Preferences Settings below. For details on the contents of this XML file, see "XML
Tag Reference for Generic Data and Diagnostics Integrations" on page 695.

UI Descriptions
Data Integration - General Settings
User interface elements are described below:
UI Element

Description

Name

Name by which to identify this integration in the SiteScope interface.
Note: This is a required field.
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UI Element

Description

Description Description of the integration. This could include information on the application
receiving the data from SiteScope. This description appears only in the Integration
Preferences page in SiteScope.

Data Integration - Preferences Settings
User interface elements are described below:
UI Element

Description

Receiver URL

URL of the application server to receive the SiteScope data. This must be a full
URL including server, port, and path.
If secure connection (SSL), then enter https.
Syntax: http or https://<fully qualified domain name of the receiving
server>:<port number receiving data>/<path>

Encoding

Encoding used by the receiving application.
Default value: UFT-8

Reporting
interval
(seconds)

Time in seconds between when SiteScope finishes sending data to the next
period SiteScope begins sending data.

Time
synchronization
interval
(minutes)

To synchronize between the time of the SiteScope server and the server
receiving SiteScope data, SiteScope can periodically report the time that is
registered on its server. The receiving server can then synchronize the time of
the data samples coming from SiteScope with the time on its own server so that
there is no discrepancy between the time of the SiteScope data and the
application's own data.

Default value: 60 seconds

Select in minutes how often you want SiteScope to report to the time of the
SiteScope server to the server receiving SiteScope data.
Default value: 10 minutes
GZIP
compression

Compresses the sample data sent to the receiving server. If the data is
compressed, then performance is improved because the time to send data is
reduced. Select or clear this field depending on the amount of data being sent
and whether the receiving application can handle compressed data.
Default value: Not selected
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UI Element

Description

Include
additional data

If cleared, SiteScope reports the status of the following SiteScope objects:
l

groups

l

monitors

l

counters

If selected, the status of these objects are reported along with the status string,
which includes the descriptions of each object.
Default value: Not selected
Tip: It is recommended not to include additional data as it slows performance,
and the status string repeats the status data that is sent by default.
Error on
redirect

SiteScope returns an error status if the target URL is redirected.

Request
timeout
(seconds)

Timeout, in seconds, until a connection is established with the server. A value of
zero means there is no timeout used.

Connection
timeout
(seconds)

Socket timeout, in seconds, to wait for data. A timeout value of zero means there
is no timeout used.

Number of
retries

Number of times SiteScope attempts to establish a connection.

Authentication
when requested

SiteScope sends user name and password credentials if requested. If cleared,
SiteScope does not forward credentials.

Default value: Not selected

Default value: 120 seconds

Default value: 120 seconds

Default value: 3

Default value: Selected
Disable
integration

SiteScope does not forward data to the server. The integration preference setting
remains. Use when temporarily disabling the integration.
Default value: Not selected
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Data Integration - Web Server Security Settings
User interface elements are described below:
UI Element

Description

Authentication user
name

Username to access the server if the server is configured to use basic
authentication.

Authentication
password

Password to access the server if the server is configured to use basic
authentication.

Data Integration - Proxy Server Settings
User interface elements are described below:
UI Element

Description

Address

Proxy server address if applicable.

User name

User name for the proxy server.

Password

Password for the specified server.

Data Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

SiteScope uses the tag selected here to determine what data is forwarded to the
receiving application. You must select at least one tag for each integration. That same tag
must be selected for the groups, subgroups, and monitors whose data you want
forwarded to the receiving application.
When selecting an integration tag for an object, the tag propagates to that object's
children. If you tag a group with this Integration tag, all its subgroups and monitors report
their status to the receiving application.
Example: Create a tag called Integration_metrics and select it here. For each group,
monitor, or both, whose status you want to report to the receiving application, select this
tag under the Search/Filter Tags setting for the object.
Note: You can select multiple tags for each integration preference. You can select
multiple Integration tags for the objects to be reported.
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UI
Element Description
Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
Tip: Use the word Integration_<integration identifier> when creating an
integration tag, since this tag appears along with all other Search/Filter tags created for
the SiteScope. This helps you to identify which tag to select for enabling a group or
monitor for the integration.

Generic Event Integration Preferences
Use Generic Event Integrations to create a new generic event integration to forward SiteScope events
to a third-party application or management console for which a direct integration does not exist. The
event that is sent contains information regarding the monitor and its measurement, including the status
change that triggered the event.
SiteScope uses the SiteScope HTTP recipient to integrate with HTTP-based network management
systems and to send generic events to management consoles.

To access
Select Preferences > Integration Preferences. In the Integration Preferences page:
l

Click the New Integration button, and select Generic Event Integration, or

l

Select an existing generic event integration, and click the Edit Integration button.
Note: You must be an administrator in SiteScope, or a user granted View integration
preferences permissions to be able to view Integration Preferences. Edit integration
preferences permissions are required to create or edit Integration Preferences. For details on this
topic, see "User Management Preferences" on page 732.

Learn About
Generic Event Format
The format of the event attributes that are sent to the third-party application or management console is
determined using an event mapping template. The template maps SiteScope runtime data to the event
attribute values that are sent when an event is triggered. The Generic Event Integration uses Common
Event Mappings with custom attributes. For details on event mappings, see "Common Event
Mappings" on page 547.
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Multiple Target Destinations
The Generic Event Integration enables you to configure multiple event integrations. This differs from
the Operations Manager integration which supports only one integration to either the HPOM
management server or to Operations Management in BSM.

Delivery Using HTTP Request
The receiving application must be enabled to receive the event from SiteScope. This means that the
application should be able to receive the http request from the SiteScope server and to decipher the
XML over HTTP response when it arrives. You configure the settings SiteScope needs to
communicate with HTTP connectors in the New/Edit HTTP Recipient dialog box.
The http request (that submits the event) includes the following header:
Content-Type: text/xml
If you selected to zip the contents of the XML file, then the http request includes the following header:
Content-Type: text/xml
Content-Encoding: gzip
You select whether to zip the event in the Generic Event Integration Preferences dialog box when
creating the integration in SiteScope. If you select to zip the event, your application must be able to
unzip the file SiteScope sends.

Support for Guaranteed Event Delivery
Generic Event Integration supports guaranteed event delivery. This means that if SiteScope is unable
to send an event (for example, if there is a network problem, or the receiver is down), SiteScope tries to
send the event again, or it stores the event for future transmission. This prevents the loss of information
if events are initially unable to reach their destination.
You can change the guaranteed event delivery settings in Preferences > Infrastructure Preferences
> Custom Settings or in the <SiteScope root directory>\groups\master.config file.
l

l

l

l

Generic Event Integration save data to zip. Indicates whether the data is saved to the cache as
a .zip file.
Generic Event Integration resend cache file intervals (minutes). The interval between each
resending of cache files.
Generic Event Integration file count to delete. When the cache folder reaches its maximum
size, SiteScope deletes the specified number of files from the cache.
Generic Event Integration maximum cache size (MB). The maximum size of the cache in
megabytes, before SiteScope deletes files from the cache.

For more details on these settings, see the above-listed properties in "Custom Settings" on page 650.
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Tasks
How to Configure SiteScope Generic Event Integration
This task describes the steps involved in configuring SiteScope to forward events to a third-party
application or management console. These files contain information regarding the status of the
SiteScope's groups, monitors, and measurements.
1. Prerequisites
You must be an administrator in SiteScope, or have the following user permissions:
n

Add, edit or delete common event mappings. Required to create or make changes to event
mappings.

n

Add, edit or delete email, pager, HTTP and SNMP preferences. Required to make
changes to HTTP Preferences.

For details on user permissions, see "User Management Preferences" on page 732.
2. Configure HTTP preferences
Select Preferences > Integration Preferences > HTTP Preferences, and configure the HTTP
settings that SiteScope uses when sending events or data to management consoles. This
involves creating an HTTP recipient that SiteScope uses to send events or data to an endpoint
URL.
For user interface details, see "New/Edit HTTP Recipient Dialog Box" on page 591.
3. Configure the Generic Event Integration
Select Preferences > Integration Preferences, click New and then select Generic Event
Integration.
a. In the General Settings panel, enter a name and description for the integration.
b. In the Generic Event Integration Preferences panel, select a connector instance to use for
receiving events.
c. In the Reporting Tags panel, select a reporting tag (this is used later in step 5). SiteScope
uses this to determine which tags report this configured integration when an event is triggered
by a metrics status change. All monitors that have this tag will report events via this
integration.
You must select at least one tag for each integration.
For details on these settings, see the UI Descriptions section below.
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4. Configure a monitor instance and select an event mapping
Configure a monitor instance. In the Event Mapping Settings panel of monitor properties, select
an event mapping template, or create a new event mapping. The template contains the mappings
between SiteScope runtime data and the attribute values that are used for sending events to the
management console when a metrics status change event is triggered. For user interface details,
see "New/Edit Event Mappings Dialog Box - General Tab" on page 551.
Note: The Event mapping list is available only if SiteScope is integrated with HPOM and
event integration is enabled, or when a Generic Event Integration is configured in Integration
Preferences. The list is editable if you have Add, edit or delete common event mappings
permissions.
You can use the HP CDA Event Mapping template when integrating with CDA (Continuous
Delivery Automation), a policy-based platform that provides infrastructure provisioning in hybrid
cloud environments. CDA integrates with SiteScope to deploy SiteScope monitors and receive
events from them. Monitoring status based on the events received is available in the CDA user
interface.
5. Select reporting tags for the monitor
In the Search/Filter Tags panel of monitor properties, select one or more of the reporting tags
(selected in step 3c) for each monitor instance for which you want to trigger metrics status change
events. SiteScope uses the tags selected to determine what data is forwarded to the receiving
application when a metrics status change event is triggered.
For user interface details, see "Search/Filter Tags" on page 312.
6. Configure guaranteed event delivery settings - optional
If SiteScope is unable to send an event (for example, if there is a network problem, or the receiver
is down), SiteScope tries to send the event again, or it stores it for future transmission.
You can determine the guaranteed event delivery setting values using the following settings in
Preferences > Infrastructure Preferences > Custom Settings:
n

Generic Event Integration save data to zip Indicates whether the data is saved to the cache
as a .zip file.

n

Generic Event Integration resend cache file intervals (minutes). The interval between
each resending of cache files.

n

Generic Event Integration file count to delete. When the cache folder reaches its maximum
size, SiteScope deletes the specified number of files from the cache.

n

Generic Event Integration maximum cache size (MB). The maximum size of the cache in
megabytes, before SiteScope deletes files from the cache.
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For more details on these settings, see "Custom Settings" on page 650.
7. Results and troubleshooting
When there is a change in a monitor's metric status, an event is created, based on the format in
the event mapping template. The event is sent to the HTTP connector instance (this is the
endpoint URL of the application that receives all HTTP messages).
Details of events that were successfully sent are displayed in the generic_event_integration.log
file, available from Server Statistics > Log Files.
Event error data is written to the error.log file which is found in the <SiteScope root
directory>\logs directory.
If you encounter an error, open the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties.debug file in SiteScope in debug
mode and copy the Generic Event integration strings to the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties file.

UI Descriptions
Generic Event Integration - General Settings
User interface elements are described below:
UI Element

Description

Name

Name by which to identify this integration in the SiteScope interface.
Note: This is a required field.

Description Description of the integration. This could include information on the application
receiving the data from SiteScope. This description appears only in the Integration
Preferences page in SiteScope.

Generic Event Integration - Preferences Settings
User interface elements are described below:
UI Element

Description

Connector

The target instance used for receiving the events. Select from the list of connectors,
which are configured in Preferences > HTTP Preferences. For details, see "HTTP
Preferences Page" on page 590.
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UI Element

Description

Disable
integration

Disables the integration and no events are sent to the receiver. The settings in this
integration are preserved and can be used again when the integration is enabled.
Default value: Not selected

GZIP
Compresses the events before sending it to the receiving server. Compressing data
compression improves performance because the time to send data is reduced. Using this option
depends on the amount of data being sent and whether the receiving application can
handle compressed data.
Default value: Not selected

Generic Event Integration - Reporting Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Tags are used to associate monitor instances which trigger an event with a particular
event integration. All monitors that have this tag will report events via this integration.
SiteScope uses the tag selected here to determine the event forwarded to the receiving
application. You must select at least one tag for each integration.
Example: Create a tag called Integration_events and select it here. Select this tag
under the Search/Filter Tags setting for each monitor instance that you want to report to
the receiving application.
In the Search/Filter Tags panel of monitor properties, select one or more reporting tags
for each monitor instance for which you want to trigger metrics status change events.
SiteScope uses the tags selected to determine what data is forwarded to the receiving
application when a metrics status change event is triggered.
Note: You can select multiple tags for each integration preference. You can select
multiple Integration tags for the objects to be reported.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
Tip: Use the word Integration_<integration identifier> when creating an
integration tag, since this tag appears along with all other Search/Filter tags created for
the SiteScope. This helps you to identify which tag to select for enabling a group or
monitor for the integration.

HP SiteScope (11.31)

Page 694 of 1395

Using SiteScope
Chapter 50: Integration Preferences

XML Tag Reference for Generic Data and Diagnostics
Integrations
When SiteScope forwards data for generic data or diagnostics integrations, it does so using the XML
files whose elements and attributes are described below. For details on creating the integration, see
"Generic Data Integration Preferences" on page 684 and "Diagnostics Integration Preferences" on page
672.
This section also includes:
l

"Data XML Elements and Attributes Table" below

l

"Time Synchronization XML" on page 697

Data XML Elements and Attributes Table
Parent
Element

Description of
Element

Attribute

Description

performance The parent element of
Monitors
the XML. Includes all
group elements within
it.

collectorHost

SiteScope Host

collector

Application collecting the data,
which is always SiteScope

group

name

Group name as defined by the user

desc (optional)

Group description if entered for the
group

previousName
(optional)

Previous name of the group if
existed

Represents the
SiteScope group and
is parent element to
group and monitor
element
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Parent
Element

Description of
Element

monitor

Represents the
SiteScope monitor
and parent element to
the counter element

Attribute

Description

type

Monitor type (as displayed in New
Monitor dialog box)

name

Monitor name as defined by the
user

target

Remote server being monitored

targetIP

IP address of the remote server
being monitored

time

Time of the measurement

quality

Status as determined by the
monitor's thresholds
Possible values:
l

0 - no data (no thresholds
defined)

l

1 - informational (good)

l

2 - warning

l

3 - critical

previousName
(optional)

Previous name of the monitor if
existed

desc (optional)

Monitor description if entered for the
monitor

sourceTemplateName Name of the source template if the
monitor was created from a
template or solution template.
statusDesc
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Parent
Element

Description of
Element

counter

Represents the
measurements
gathered by the
monitor

Attribute

Description

name

Counter name

value

Counter value

quality

Status of the counter as determined
by the counter's threshold
Possible values:
l

0 - no data (no thresholds
defined)

l

1 - informational (good)

l

2 - warning

l

3 - critical

desc (optional)

Monitor description if entered for the
monitor

status (optional)

If this attribute appears with a value
of 0, the counter is not available.
This attribute is not sent by
SiteScope and not included in the
XML if the counter is available.
Possible value: 0 - counter not
available

units (optional)

Units of measurements for the
counter if relevant

Time Synchronization XML
If you enter a value in the Time synchronization interval field when creating the data integration,
SiteScope sends this XML to synchronize the time of the SiteScope server with that of the receiving
application.

Parent Element
performanceMonitors
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Attribute

Attribute Description

collectorHost SiteScope host
collector

Application collecting the data,
which is always SiteScope
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Parent Element
timeStamp

Description of
Element
Provides the time of the
SiteScope server

Attribute

Attribute Description

timestamp

Time stamp, calculated as the
seconds since January 1st 1970

Integration Preferences Page
This page enables you to configure settings when integrating SiteScope with BSM, HPOM,
Diagnostics, or other applications.
To access

Select Preferences > Integration Preferences.
To open the Integration Preferences Type dialog box which enables you to select the
type of integration preference you want to configure, click the New Integration
button.

Important
Only an administrator in SiteScope, or a user granted Edit integration preferences
information permissions can create or make changes to Integration Preferences. For details on
user permissions, see "User Management Preferences" on page 732.
Relevant
tasks

l

l

See also

"How to Configure SiteScope to Communicate with BSM" on page 219
"How to Configure SiteScope-BSM Integration Preferences for Inaccessible
Profiles" on page 667

l

"Integration Preferences" on page 660

l

" Connecting to a BSM Server" on page 207

User interface elements are described below:
UI Element

Description
New Integration. Creates a new integration in SiteScope.
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UI Element

Description
Edit Integration. Enables editing an existing integration in SiteScope. The Edit
Integration dialog box opens according to the integration type selected.
l

l

l

l

l

l

Amazon CloudWatch Integration. Enables users who use SiteScope for
monitoring their AWS-hosted applications to report any SiteScope metrics to
Amazon CloudWatch service. For user interface details , see "Amazon
CloudWatch Integration Preferences" on page 660.
BSM Integration. Use to configure SiteScope as a data collector for BSM. For
user interface details, see "BSM Integration Preferences" on page 665.
Data Integration. Use to create a generic data integration. For user interface
details, see "Generic Data Integration Preferences" on page 684.
Diagnostics Integration. Use to create a diagnostics integration. For user
interface details, see "Diagnostics Integration Preferences" on page 672.
Generic Event Integration. Use to create a diagnostics integration. For user
interface details, see "Generic Event Integration Preferences" on page 689.
HP Operations Manager Integration. Use to configure SiteScope to send
events and report metrics to HPOM and BSM servers. For user interface details,
see "HP Operations Manager Integration Preferences" on page 677.

Delete Integration. Deletes the selected integration from Integration Preferences.
Select All. Selects all listed integrations.
Clear Selection. Clears the selection.
Detach
SiteScope

(Available from the shortcut menu only) Detaches SiteScope from LoadRunner
integrations. This enables you to delete the current LoadRunner integration from the
SiteScope side. When SiteScope is attached, monitors can be defined from the
LoadRunner user interface.
Note: This is available only when SiteScope is integrated with LoadRunner.

Integration
Name

Name string assigned to the integration when you create a new Integration
Preference.

Integration Description of the integration that was assigned when creating or editing the
Description Integration Preference.
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This page enables you to configure SiteScope Log Preferences. Effective system availability
monitoring requires that monitoring data be recorded and stored for a required interval of time.
SiteScope Log Preferences controls the accumulation and storage of monitor data.

To access
Select Preferences > Log Preferences.
Note:
l

l

You must be an administrator in SiteScope, or a user granted Edit log preferences
permissions to be able to create or make changes to Log Preferences. For details on this topic,
see "User Management Preferences" on page 732.
Changes to Log Preferences have an impact only after SiteScope is restarted.

Learn About
This section contains the following topics:
l

"Log Preferences Overview" below

l

"SiteScope Log Database Table Structure" on the next page

Log Preferences Overview
Log Preferences enable you to select how much monitor data is accumulated and maintained on the
SiteScope server. It also configures SiteScope to export monitor data to an external database.
By default, SiteScope saves monitor results, alert data, error data, and other readings returned by
monitors into log files. For monitor data results, a date-coded log file is created for each 24-hour period
of monitoring. This data is stored as tab delimited text. SiteScope uses the log files to create
management reports on system availability and performance over time.
Storing data logs can become a problem over time. However, you can limit how much log information
SiteScope saves to the local file system by setting the number of days to maintain log files or by setting
a maximum data log file size. You can also send monitoring data to an external database application.
This helps reduce the data storage capacity required on the SiteScope server and makes the
monitoring data available to other reporting tools. For details on how to customize the way SiteScope
logs monitoring data in the database, see he HP Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM304952).
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Note: To create SiteScope Management Reports the monitoring log information for the desired
time period of the report must be available on the SiteScope server file system. For details on
creating management reports, see "Management Report" on page 1351.

SiteScope Log Database Table Structure
When database login is enabled, monitor data is contained in a single table called SiteScopeLog. The
first nine fields of each database record are the same for all monitors. The next ten fields contain
different measurements depending on the kind of monitor supplying the data. All the fields in the table
use the VARCHAR(255) data type. A description of the fields in the log database record are shown in the
table below along with their default field names:
Field Name

Example Data

Description

datex

1999-01-20 11:54:54

The first field contains the date that the monitor ran.

serverName

demo.sitescope.com The second field contains the name of the server where
SiteScope is running.

class

URLMonitor

The third field contains the type of the monitor.

sample

23

The fourth field contains the sample number of this monitor.

category

good

The fifth field contains the category name of the monitor.

groupName

URLs

The sixth field contains the group name of the monitor.

monitorName Home Page

The seventh field contains the name of the monitor.

status

1.01 seconds

The eighth field contains the status of the monitor.

monitorID

10

The ninth field contains the ID of the monitor.

value1,
value2, ...
value10

(variable)

The tenth through nineteenth fields contain the monitor
specific data as described in the Log Columns page (see
"Monitor Specific Log Column Content" on page 1206). The
first variable field (value1) corresponds to the value listed as
column 7 in the log files.
Note: Field names change dynamically according to your
SiteScope monitor configuration. To manually generate a list
of field names for data logged to a database, see "How to
Generate Field Names for Data Logged to a Database" on
the next page.

The SQL statement that is used for database logging can be changed by editing the parameter _
logJdbcInsertSiteScopeLog= in the <SiteScope root directory>\groups\master.config file. A
stored procedure can be called by replacing the insert statement with a call statement. For example,
call logit(?,?,?) would call the stored procedure named logit passing it the first three
parameters.
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Tasks
How to Generate Field Names for Data Logged to a Database
Monitor field names change dynamically according to your SiteScope monitor configuration settings,
and as such, the field names may not be written to the database.
Tip: You can see the list of static monitor fields in "Monitor Specific Log Column Content" on page
1206.
This task describes the steps involved in manually generating the field names.
1. Check which port the Tomcat server is using
Open <SiteScope root directory>\Tomcat\conf\server.xml and search for the string
<Connector port= to determine the port which this Tomcat version is using.
2. Create a new generic data integration
In SiteScope, select Preferences > Integration Preferences, click the New Integration button,
and select Data Integration. Create a new data integration as described in "Generic Data
Integration Preferences" on page 684.
a. In the Data Integration Preferences Settings panel, enter the URL of the Tomcat server in the
Receiver URL box, and use the same port number from the previous step. (The URL should
be in the format: http://<Tomcat Server>:<port number receiving data>/<receiver
path>
where <receiver path> is the location where you get the samples under the <Tomcat root
directory>\webapps folder.
b. In the Reporting Tags panel, add a tag name and value for the integration and select it in the
tags tree.
3. Select reporting tags for the monitor
In the Search/Filter Tags panel of each relevant monitor for which you want counter names, select
the same reporting tag that you added in the previous step. SiteScope uses the tags selected to
determine what data is forwarded to the receiving application.
4. Run the monitor
Run the monitors for which you want counter names.
5. Results
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After the monitors have run, SiteScope forwards the column names and values to the Tomcat
server in XML format. These XML files are located in the <Tomcat root directory>\webapps
folder and the path is specified in step 2a.
Example:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<performanceMonitors collectorHost="JBROWN" collector="SiteScope">
<group desc="" name="g">
<monitor quality="1" time="1321445972863" targetIP="16.53.61.95" target="My_Lab_Machine"
type="Memory"
previousName="Memory on My_Lab_Machine" name="Memory on My_Lab_Machine">
<counter quality="0" value="0" name="percent used"/>
<counter quality="0" value="3953" name="MB free"/>
<counter quality="0" value="0.0" name="pages/sec"/>
<counter quality="1" value="0" name="swap space used %"/>
<counter quality="0" value="3953" name="swap space MB free"/>
<counter quality="0" value="16" name="physical memory used %"/>
<counter quality="0" value="3390" name="physical memory MB free"/>
</monitor>
</group>
</performanceMonitors>
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UI Descriptions
Log Preferences Page
User interface elements are described below:
UI
Element

Description

SiteScope Log File Preferences
Daily logs
to keep

Number of daily log files of monitoring data to keep. Once a day, SiteScope deletes
any logs that exceed the specified number of logs to keep.
Default value: 40
Note:
l

l

The last two logs (today's and yesterday's) are always preserved, regardless of the
number of logs or maximum log size specified.
Keeping monitor data logs for long periods can cause a data storage problem for
the SiteScope server depending on the total number of monitors configured and
how often the monitors run per day. You should monitor the size of the log files in
the <SiteScope root directory>\logs directory to estimate the data accumulation
rate, and adjust this setting or server resources as necessary.

Maximum
size of
logs (MB)

Maximum size for all monitoring logs. Once a day, SiteScope checks the total size of
all monitoring logs and removes any old logs that are over the maximum size.

Disable
separate
logging
for
monitors

When this is selected, log data for a monitor is not sent to a dedicated monitor log file,
but to general log files (for example, error.log or RunMonitor.log), together with log
data from all other monitors. For more details, see "Logging Settings" on page 314.

Default value: 0 (the log size is not checked)

Default value: Not selected

Database Logging Preferences
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UI
Element

Description

SiteScope Log File Preferences
Database
connectio
n URL

URL to a database connection. The easiest way to create a database connection is to
use ODBC to create a named connection to a database.
Example: First use the ODBC control panel to create a connection called
SiteScopeLog. Then, enter jdbc:odbc:SiteScopeLog as the connection URL.
Note for using Windows Authentication: If you want to access the database using
Windows authentication, enter:
l

l

l

Database
driver

Database connection URL: jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;AuthenticationMethod=typ
e2
Database driver: com.mercury.jdbc.sqlserver.SQLServerDriver
Database user name and Database password: Leave these boxes empty, since
the Windows user credentials of the account from which the SiteScope service is
running are used to establish a connection to the database.

Database driver SiteScope should use to connect to the database. The driver should
be a JDBC driver. To have SiteScope use another driver the driver must also be
installed in the <SiteScope root directory>\WEB-INF\lib directory and the path and
filename must be entered in this box.
Default value: sun.jdbc.odbc.JdbcOdbcDriver

Database
user name

User name to log on to the database. If using Microsoft SQL server, leave this blank
and choose Windows Authentication when setting up the ODBC connection. With
Windows Authentication, you cannot specify a user name as SiteScope connects
using the login account of the SiteScope service.
Note for using Windows Authentication: The user that is running SiteScope must
be able to access the database to which you are connecting. If SiteScope is running
under a Local Systems Account, it attempts to connect using the name of the server.

Database
password

Password to log on to the database. If using Microsoft SQL server, leave this blank
and choose Windows Authentication when creating the ODBC connection. With
Windows Authentication, you cannot specify a password as SiteScope connects
using the login account of the SiteScope service.
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UI
Element

Description

SiteScope Log File Preferences
Backup
database
connectio
n URL

URL to a backup database. Use this option to provide failover of SiteScope database
logging if the primary database becomes unavailable.
Note:
l

l

The same database table definition, database driver, user name, and password are
applied to both database connections.
After saving changes to the Database Logging preferences, stop and restart the
SiteScope service for the changes take effect.

Tips/Troubleshooting
Troubleshooting - Database Logging
When Database logging is active and working correctly, see the table named SiteScopeLog in your
database and a record added to the table every time a monitor runs. The data is sent to the database as
a single table in a flat-file format.
If the SiteScopeLog table is not created or is empty, check the <SiteScope
root directory>\logs\RunMonitor.log and <SiteScope root directory>\logs\Error.log files for log
messages starting with "jdbc" or "odbc". When Database logging is working correctly, see a set of
messages in RunMonitor.log that looks like this:
jdbc
jdbc
jdbc
jdbc
jdbc
jdbc
jdbc
jdbc

log,
log,
log,
log,
log,
log,
log,
log,

reconnect seconds=600
loading, driver=sun.jdbc.odbc.JdbcOdbcDriver
connecting, url=jdbc:odbc:SiteScopeLog,
logged in
checking log table
created log table
prepare insert, 19, INSERT INTO SiteScopeLog...
connected

If these entries do not appear in the log file there is a problem with the database interface or
configuration of the database connection. You should also check the Database Connection URL you
entered. This parameter is case sensitive. Check the spelling and letter case of the connection URL
and make sure there are no leading or trailing spaces present in the text box.
You can also check the HP Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=) for other information
relating to database logging. To enter the knowledge base, you must log on with your HP Passport ID.
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This page is used to define pager recipient profiles and settings that SiteScope uses for sending Pager
alerts to individuals or groups. It lists all the currently defined Pager Recipient profiles. Pager alerts can
be used to send an automated notification to system administrators who may not have immediate
access to email, or to send alert escalations or notify support personnel who may be away from the
office.
Note: Pager Preferences was deprecated, and HP plans to remove support for it in the next
version of SiteScope. For backward compatibility, this preference type can be enabled by adding
the property _enableDeprecatedAlertActions=pager to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated
by a comma if other values are listed.

To access
Select Preferences > Pager Preferences.
Note: You must be an administrator in SiteScope, or a user granted View email, pager, HTTP
and SNMP lists permissions to be able to view Pager Preferences. Add, edit or delete email,
pager, HTTP and SNMP preferences permissions are required to create or edit Pager
Preferences. For details on this topic, see "User Management Preferences" on page 732.

Learn About
Pager Preferences Overview
You can use Pager Preferences to configure the settings SiteScope needs to communicate with an
external electronic paging service. These are the default settings that SiteScope uses to send alerts to
an electronic pager.
The Pager Preferences page displays the defined custom Pager Recipient profiles. These profiles can
be associated with one or more Pager alerts by editing the applicable alert definition.
You define Pager Recipient profiles in the New/Edit Pager Recipient page. The preferred pager
connection option is Modem to modem connection. When this connection is used, SiteScope can
verify that the message was sent successfully and can receive messages describing any
communication problem. The other connection options generally send messages to automated voice
response systems using touch tone dialing. The touch tone dialing method is limited to numeric
messages and SiteScope cannot confirm that your paging service correctly received the message.
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UI Descriptions
This section includes:
l

"Pager Preferences Page" below

l

"New/Edit Pager Recipient Dialog Box" on the next page

Pager Preferences Page
User interface elements are described below:
UI Element

Description
New Pager Recipient. Creates a new Pager Recipient profile. For user interface
details, see "New/Edit Pager Recipient Dialog Box" on the next page.
Note: Only an administrator in SiteScope, or a user granted Add, edit or delete
email, pager, HTTP and SNMP preferences permissions can create or make
changes to Pager Preferences. For details on user permissions, see "User
Management Preferences" on page 732.
Edit Pager Recipient. Enable editing the Pager Recipient profile. For user interface
details, see "New/Edit Pager Recipient Dialog Box" on the next page.
Note: Only an administrator in SiteScope, or a user granted Add, edit or delete
email, pager, HTTP and SNMP preferences permissions can create or make
changes to Pager Preferences. For details on user permissions, see "User
Management Preferences" on page 732.
Delete Pager Recipient. Deletes the selected Pager Recipient profile from Pager
Preferences.
Note: You cannot delete a Pager Recipient profile if it is referenced by an alert action.
You must change the recipient in the alert before you can delete the profile.
Test Pager Recipient. Tests that you can send a message to the pager. Enter a
message in the Test Pager dialog box, and click Test. You can enter a prefix that can
be added to the pager message. If you are sending the message to a numeric pager,
do not enter more than 32 digits.
Select All. Selects all listed Pager Recipient profiles.
Clear Selection. Clears the selection.
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UI Element

Description

Default
Settings

Click the arrow next to Default Settings, and select an option:
l

l

Name

Edit. Opens the Pager Preferences Default Settings dialog box which enables
you to change the default settings displayed in the New Pager Recipient dialog
box. For details on the settings, see "New/Edit Pager Recipient Dialog Box"
below.
Test. Opens the Test Pager dialog box which enables you to test that you can
send a message to the default pager. Enter a message in the Message box, and
click Test. You can enter a prefix that can be added to the pager message. If you
are sending the message to a numeric pager, do not enter more than 32 digits.

Name string assigned to the setting profile when you create a new pager recipient.

Description Description of the setting profile that was assigned when creating or editing the
profile.

New/Edit Pager Recipient Dialog Box
This dialog box enables you to create a new Pager Recipient profile or edit an existing profile.
SiteScope uses Pager Recipient profiles for sending Pager alerts.
User interface elements are described below:
UI Element

Description

Main Settings
Name

Name string assigned to the setting profile when you create a new pager recipient.

Modem
port

Communications port that the modem is connected to on the SiteScope server. For
SiteScope on Solaris or Linux, enter the path and device name for the modem. On
Microsoft Windows platforms, SiteScope uses COM port numbers for both RS-232C
type serial ports as well as for USB modem ports.
If you are using a USB type modem, select the COM port associated with the USB
port to have SiteScope use the USB modem. To find the COM port number for the
USB modem, use the Settings > Network and Dial-up Connections menu. Rightclick the desired modem, and then click Properties. The properties should show the
COM port number that is associated to the modem.
Default value: COM1

Connection Modem speed used for connections to the paging service from the drop-down list.
speed
Default value: 1200 bit/sec
(bit/sec)
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UI Element

Description

Main Settings
Pager
connection
options

Option for sending a message to your paging service:
l

l

l

l

Modem to modem connection (Preferred). Select if you have an alphanumeric
pager and use an alphanumeric paging service.
Dial and enter message. Select to dial a direct phone number to send a page.
Dial, enter command and enter message. Select if you have a direct number,
but need to enter a command before sending a page.
Custom modem connection. Select if your paging company does not use any of
the previous connection choices.

For details of the information required for the selected option, see below:
l

l

l

Modem number. Phone number to use for sending alphanumeric pages to the
paging service modem.
Modem pin number. Last seven digits of the PIN number for your alphanumeric
pager. If you use an alphanumeric paging service, you must enter the phone
number to use for sending alphanumeric pages to the paging service modem. This
number is provided by your paging service. The paging service sometimes refers
to this as the TAP/IXO number.
Phone number. Phone number exactly as you would dial it from your telephone,
including other numbers you may need, such as a number to get an outside line.
You can use dashes to make the number easier to read. Use commas to separate
the portions of the phone number. Each comma causes the modem script to
pause for a few seconds before dialing the rest of the number.
Example: If you are dialing your pager from your office, and you have to dial 9 to
get an outside line, enter: 9, 555-6789.

l

l

Send page command. Page command exactly as you would dial it from your
touch tone telephone.
Custom modem command. Entire modem command including the phone
number to dial, any additional digits, and $message. SiteScope replaces
$message with the message you specified for each alert.
Example: If the number for the pager company is 123-4567, your pager PIN is
333-3333, and your pager company requires that you follow each command with
the # key, the command might look like this:
ATDT 123-4567,,333-3333#,,$message#
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UI Element

Description

Main Settings
Note: For SiteScope running on UNIX, enter the device path for your modem in
the Modem Path box. To see a list of devices using Solaris, use the ls
/dev/term/* command.
l

Disabled. Temporarily disables a particular pager without editing every alert that
contains this persons pager.

Advanced Settings
Schedule

Specifies when pager settings should be enabled. A more restricted schedule can be
selected from the drop-down list.
Default value: Every day, all day

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Search/Filter Tags
<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.
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SiteScope monitors, alerts, and reports are enabled 24 hours a day, 7 days a week, 365 days a year, by
default. This means that as long as a monitor is enabled, it runs according to the update frequency
specified in the individual monitor configuration. For example, if a monitor is configured to run every 30
seconds, SiteScope attempts to run the monitor every 30 seconds throughout the day. If SiteScope
detects an error condition, any alert associated with the monitor is triggered as well, regardless of the
time of day.
In some situations, it is useful to enable certain SiteScope actions to correspond with a single event or
a particular time of day. For example, you may want to use this type of scheduling for monitors, such as
the Link Checking monitor, which you want to run only once a day at a time when the server generally
has a lighter load. You use Absolute Schedules to do this.
You may also want to disable certain SiteScope actions based on the schedules of the individuals or
groups responsible for the servers and systems being monitored. You use Range Schedules to instruct
SiteScope to enable or disable monitors according to time periods that you define.

To access
1. Select Preferences > Schedule Preferences to open the Schedule Preferences page.
2. In the Schedule Preferences toolbar, click the New Schedule button, and select New Absolute
Schedule or New Range Schedule.
Note:
l

l

You must be an administrator in SiteScope, or a user granted View schedule list permissions
to be able to view Schedule Preferences. Add, edit or delete schedule preferences
permissions are required to create or edit Schedule Preferences. For details on this topic, see
"User Management Preferences" on page 732.
You cannot delete a Schedule profile if it is referenced by an alert action, report, monitor, or
monitor threshold. You must remove the profile from each dependency before you can delete
the profile.

Learn About
This section also includes:
l

"Absolute Schedules" on the next page

l

"Range Schedules" on the next page
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Absolute Schedules
Absolute Scheduling lets you set specific times that a monitor is run on a weekly basis. Absolute
schedules are reset at the end of the week and repeated each week. Absolute Schedules trigger a
monitor to run only once at each time specified in the schedule.
Absolute Schedules are inactive until they are explicitly associated with a monitor instance. To
associate Absolute Schedules with a monitor, use the Monitor schedule field in the Monitor Run
Settings panel for the monitor that you want to schedule.
Note: Absolute Schedules are associated to alerts indirectly by way of the monitors associated
with the alert. Any alerts associated with the monitors disabled by Absolute Schedules are
effectively unavailable for the period during which those monitors are disabled. However, if an alert
is associated with other monitors that are not controlled by the same schedule, that alert is still
triggered if the other monitors report an error condition.

Range Schedules
You can use Range Scheduling to specify a time range during which SiteScope either enables or
disables particular monitors. If you specify an enabled time range for a monitor (in the Monitor
schedule field of the Monitor Run Settings panel for the specific monitor), SiteScope only runs the
monitor during that range. For example, if you create a range of 8AM-9PM, Monday through Friday, any
monitors that have that range schedule associated with them are run only during those times.
A common use of range scheduling is to set up different pager alerts associated with monitors running
at times that coincide with work shifts when different administrators are on call. The schedule helps
prevent pager alerts being sent to individuals at an inappropriate time of day relative to the work
schedule of that individual.
Range Schedule Preferences are inactive until they are explicitly associated with a monitor instance.
You use the Monitor Run Settings panel of a monitor configuration page to associate Range Schedule
Preferences with a monitor.
Note: Range Schedules are associated to alerts indirectly by way of the monitors associated with
the alert. Any alerts associated with the monitors disabled by Range Schedules are effectively
unavailable for the period during which those monitors are disabled. However, if an alert is
associated with other monitors that are not controlled by the same schedule, that alert is still
triggered if the other monitors report an error condition.

UI Descriptions
This section includes:
l

"Absolute Schedule Page" on the next page

l

"Range Schedule User Page" on page 715
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Absolute Schedule Page
This page is used for customizing the operation of SiteScope monitors and alerts to run only at specific
times.
User interface elements are described below:
UI Element

Description

General Settings
Name

Name for the Absolute Schedule. The name is used to identify the Absolute Schedule
in the product display.

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Absolute Schedule Settings
<days of
the week>

Time or times that the monitor needs to run in the boxes next to the day of the week.
Time values for absolute schedules must be limited to the 24-hour period of a
standard day for each day. To enter multiple times for a single day, separate the times
by a comma (,).
Example:01,02:30,23:30 runs the monitor at 1:00 AM, 2:30 AM, and 11:30 PM

Related Entities
Name

Lists the name of each entity (monitor, alert action) that is running under that
schedule. This is useful when editing a monitor schedule, for example, to show which
monitors are running under that schedule.

Entity Type

Entity type, such as monitor, alert action, or SiteScope restart.

Path

The path of the entity type.

Search/Filter Tags
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UI Element

Description

General Settings
<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.

Range Schedule User Page
This page is used for customizing the operation of SiteScope monitors and alerts to run only during
specific time periods.
Note: When using SiteScope Failover, an additional table (Failover Schedule Preferences) is
displayed beneath the General Schedule Preferences table. It contains schedules that are used for
mirroring and checking availability of the primary SiteScope.
User interface elements are described below:
UI Element

Description

General Settings
Name

Name for the Range Schedule.

Description

Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags
to control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it
spans more than one line). If malicious HTML code or JavaScript is detected,
the entire field is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Range Schedule Settings
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UI Element

Description

General Settings
<days of the
week>

Days and times the monitor needs to run. Time values for range schedules must
be limited to the 24 hour period of a standard day for each day. Select Enabled
to run monitors during the specified time range only, or Disabled to run monitors
during all hours of the applicable day, except during the time range.
Note: The range schedule uses a 24 hour time format only.
Example: To disable monitors from 6:00 PM on Thursday evening until 8:00 AM
the following morning, enter a From value of 18 and a To value of 24 for
Thursday and then enter a From value of 0 and a To value of 8 for Friday. If you
enter a From value of 18 and a To value of 8 on the Thursday schedule, the
schedule becomes invalid.
To enter multiple times for a single day, separate the times by a comma (,). For
example, to disable from 2-3AM and 7-8AM, in the From box enter 2:00,7:00
and in the To box enter 3:00,8:00.
Default value: Enabled (no time values specified). See the table below for more
information.
Enabled
Setting
(Enabled
/
Time Range
Disabled) (From /To)

Time Range
(From /To)

Enabled

From and To
time values
specified

Monitors are enabled to run only during the From
and To time range.

Enabled

(no time
values
specified)

Monitors are enabled to run during all hours of
the applicable day. This is the default setting for
24-hour operation.

Disabled

From and To
time values
specified

Monitors are enabled to run during all hours of
the applicable day, except during the From and
To time range.

Disabled

(no time
values
specified)

Monitors are disabled during all hours of the
applicable day.

Failover Schedule Preferences
This table contains schedules that are used for mirroring and checking availability of the primary
SiteScope. It is available on the SiteScope Failover server only.
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UI Element

Description

General Settings
Name

Name for the Failover Schedule which is selected in the Run Settings of the
Failover Profile dialog box. For details, see "New/Edit Failover Profile Dialog
Box" on page 599.

Description

Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags
to control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it
spans more than one line). If malicious HTML code or JavaScript is detected,
the entire field is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Search/Filter Tags
<Tag name and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been
created for the SiteScope, this section appears but is empty. If tags have been
created, they are listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag
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You use Search/Filter Tag Preferences to manage the Search/Filter Tags defined in SiteScope. You
can assign keyword tags to one or more monitors, and then use the tags as an object for a filter. You
can add, edit, or delete tags from this page.
Tags can also be used in alert templates using the <tag> attribute. For details, see "Properties
Available in Alerts, Templates, and Events" on page 1305.
Tip: You can view a guided demonstration on how to manage and track monitors using filters and
tags on YouTube: http://hpsw.co/r5D4GxA.

To access
Select Preferences > Search/Filter Tags.

Tasks
How to filter monitors using Search/Filter Tags
This task describes the steps involved in defining a tag, assigning it to one or more monitors, and then
using the tag to search or filter the display.
1. Prerequisites.
You must be an administrator in SiteScope, or a user granted View tags permissions to be able to
view Search/Filter tags. To create or edit Search/Filter tags, you must have Add, edit or delete
tags permissions. For more details on user permissions, see "Permissions" on page 744.
2. Create a Search/Filter Tag.
In Preferences > Search/Filter Tags, create tags for use in filtering the display. You define the
tags and their values. For user interface details, see "New/Edit Tag Dialog Box" on page 721.
Example: Create a tag indicating the type of operating system on which monitors are running.
The tag Operating Systems might have values such as Windows 2008, Windows XP, AIX,
Solaris, Linux, and so forth.
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3. Assign Search/Filter Tags to SiteScope monitors.
a. In the SiteScope monitor tree, select the monitor you want to tag.
b. In the Properties tab, expand the Search/Filter Tags panel, and assign a tag and tag values
to the monitor.
c. Repeat for all monitors to which you want to assign this tag and value.
Example: To define a filter to display only those monitors running on a particular platform,
select the appropriate Platform tag value to assign to the monitor.
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4. Use the tag as an object for a filter.
n

In Multi-View:
i. Open SiteScope Multi-View, and select Tags in the views drop-down list.
ii. Drill down on tags or tag values to display only the monitors to which the selected tag
item has been assigned. For example, you can filter for all monitors that have the
Platform tag with the AIX tag value assigned to them. For details on using Multi-View,
see "Multi-View" on page 1089.

n

In the SiteScope Dashboard:
i. In the Monitors context menu, click the arrow next to the Filter
button, and create
a filter that includes the tag values you want to see. For user interface details, see "Filter
Objects in the SiteScope View" on page 74.
ii. In the Tags field, enter tag values, or click the Browse button and select the tag values
by which you want to filter in the Tags list. For details on the Filter Tags user interface,
see "New/Edit Tag Dialog Box" on the next page.
iii. After you create a filter, the tree displays only those monitors that have the selected tag
values assigned to them.

UI Descriptions
This section includes:
l

"Search/Filter Tags Page" below

l

"Search/Filter Tags" on page 718

Search/Filter Tags Page
User interface elements are described below:
UI Element

Description
New Tag. Creates a new search/filter tag. For user interface details, see "New/Edit
Tag Dialog Box" on the next page.
Edit Tag. Enable editing a search/filter tag. For user interface details, see "New/Edit
Tag Dialog Box" on the next page.
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UI Element

Description
DeleteTags. Deletes the selected tag from Search/Filter Tag Preferences.
Note: You cannot delete a Search/Filter tag or tag value if it is referenced by a
SiteScope object. You must remove the tag or tag value from all SiteScope objects
before you can delete it.
Select All. Selects all listed search/filter tags.
Clear Selection. Clears the selection.

Name

Name string assigned to the setting profile when you create a new search/filter tag.

Description Description of the setting profile that was assigned when creating or editing the
search/filter tag.

New/Edit Tag Dialog Box
User interface elements are described below:
UI Element

Description
New. Adds a tag value. A new row is added at the bottom of the list of tag values.
Delete. Deletes the selected value from the tag.
Note: You cannot delete a Search/Filter tag or tag value if it is referenced by a
SiteScope object. You must remove the tag or tag value from all SiteScope objects
before you can delete it.
Move up tag value. Moves the selected tag value up the list of tag values. This
enables you to sort the tag values order, instead of ordering alphabetically.
Move down tag value. Moves the selected tag value down the list of tag values.
This enables you to sort the tag values order, instead of ordering alphabetically.

Tag name

The name of the search/filter tag.
Maximum length: 255 characters

Tag
description

Description of the search/filter tag.

Values

Values included in the tag.

Value
Name

Name for the value to be included in the tag. Each tag must include at least one value.
Each value appears as a child object of the tag name when defining or editing tag
settings for all objects in the monitor tree.
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UI Element

Description

Value
Description for each value. This description appears only when editing the tag.
Description
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You use SNMP Preferences to configure the settings SiteScope needs to communicate with an
external SNMP host or management console. These are the default SNMP parameters for use with
SNMP Trap alerts.

To access
Select Preferences > SNMP Preferences. In the SNMP Trap Preferences page:

l

l

Click the New SNMP Trap
button in the Send/Receive SNMP Traps Preferences section to
create a new profile for sending or receiving SNMP Traps, or
Select an existing trap profile in the Send/Receive SNMP Traps Preferences section, and click the
Edit SNMP Trap

button.

Note: You must be an administrator in SiteScope, or a user granted View email, pager, HTTP
and SNMP lists permissions to be able to view SNMP Preferences. Add, edit or delete email,
pager, HTTP and SNMP preferences permissions are required to create or edit SNMP
Preferences. For details on this topic, see "User Management Preferences" on page 732.

Learn About
SNMP Preferences Overview
SNMP Preferences enable you to define settings that are used by SiteScope SNMP Trap alerts when
sending data to management consoles. It also enables you to define SNMP Trap receivers, and listen
to multiple local addresses and ports at the same time. SiteScope uses the SiteScope SNMP Trap
Alert type to integrate with SNMP-based network management systems.
The SNMP Preferences page displays the defined custom SNMP Trap profiles or templates to send
traps to hosts. The SNMP Trap profile can be associated with one or more SNMP Trap alerts by editing
the applicable alert definition.
You can use the SNMP trap monitor to see if a trap was sent to SiteScope. For details, see SNMP Trap
Monitor in the SiteScope Monitor Reference Guide.
Note: The template export and import flow does not contain SNMP Trap Preferences. Therefore,
when exporting and importing a template that contains references to SNMP trap preferences, you
should manually create these preferences, and manually update the SNMP Traps in the imported
template.
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UI Descriptions
This section includes:
l

"SNMP Preferences Page" below

l

"New/Edit SNMP Trap Dialog Box" on the next page

l

"New/Edit SNMP Trap Receiver Dialog Box" on page 730

SNMP Preferences Page
This page displays the defined custom SNMP Trap profiles for sending and receiving traps.
Note: Only an administrator in SiteScope, or a user granted Add, edit or delete email, pager,
HTTP and SNMP preferences permissions can create or make changes to SNMP Preferences.
For details on this topic, see "User Management Preferences" on page 732.
User interface elements are described below:
UI Element

Description

Send/Receive SNMP Traps Preferences
New SNMP Trap. Creates a new profile for an SNMP Trap/receiver. For user
interface details, see "New/Edit SNMP Trap Dialog Box" on the next page and
"New/Edit SNMP Trap Receiver Dialog Box" on page 730.
Edit SNMP Trap. Enables editing the SNMP Trap/receiver profile. For user interface
details, see "New/Edit SNMP Trap Dialog Box" on the next page and "New/Edit
SNMP Trap Receiver Dialog Box" on page 730.
Delete SNMP Trap. Deletes the selected SNMP Trap profile from SNMP
Preferences.
Note: You cannot delete an SNMP Trap profile if it is referenced by an alert action.
You must change the SNMP Trap in the alert before you can delete the SNMP Trap
profile.
Test SNMP Trap. Tests that you can send a message to the SNMP trap. Enter a
message in the Test SNMP Trap dialog box, and click Test.
Select All. Selects all listed send/receive SNMP Trap profiles.
Clear Selection. Clears the selection.
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UI Element

Description

Send/Receive SNMP Traps Preferences
Default
Settings

Click the arrow next to Default Settings, and select an option:
l

l

Edit. Opens the SNMP Trap Preferences Default Settings dialog box which
enables you to change the default settings displayed in the New SNMP Trap
dialog box. For details on the settings, see "New/Edit SNMP Trap Dialog Box"
below.
Test. Opens the Test SNMP Trap dialog box which enables you to test that you
can send a message to the default SNMP trap. Enter a message in the Test
SNMP Trap dialog box, and click Test.

Note: The SNMP Trap test does not send a full trap with all varbinds. It sends the
SNMP Trap with the configured trap OID and message only.
Name

Name string assigned to the setting profile when you create a new SNMP
trap/receiver profile.

Host

Domain name or IP address of the machine that receives all SNMP trap messages.

Port

SNMP port to which the trap is sent.

Description Description of the setting profile that was assigned when creating or editing the
profile.

New/Edit SNMP Trap Dialog Box
This dialog box enables you to create SNMP Trap profiles or edit existing ones.
User interface elements are described below:
UI Element

Description

General Settings
Name
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UI Element

Description

Description

Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags
to control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire
field is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Preferences Settings: Main Settings Area
Send to host

Domain name or IP address of the machine that receives all SNMP trap
messages. This machine must be running an SNMP console to receive the trap
message.
Examples: snmp.mydomain.com or 206.168.191.20.

SNMP port

SNMP port to which the trap is sent.
Default value: 162

Preferences Settings: SNMP Connection Settings Area
Timeout
(seconds)

Amount of time, in milliseconds, to wait for the SNMP trap requests (including
retries) to complete.
Default value: 5

Number of
retries

Number of times each SNMP trap GET request should be retried before SiteScope
considers the request to have failed.
Default value: 1

Community

Default SNMP community name used for sending traps. The community string
must match the community string used by the SNMP management console.
Default value: public

SNMP version

Default SNMP protocol version number to use. SNMP V1 and V2c are currently
supported.
Default value: V1
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UI Element

Description

Authentication Authentication algorithm used for SNMP V3. You can select MD5, SHA, or None.
algorithm
Note: This field is available only if SNMP V3 is selected.
User name

User name to be used for authentication if you are using SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Password

Password to be used for authentication if you are using SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Privacy
algorithm

The privacy algorithmused for authentication for SNMP version 3 (DES,128-Bit
AES,192-Bit AES, 256-Bit AES).
Default value: DES
Note: This field is available only if SNMP V3 is selected.

Privacy
password

The privacy password used for authentication for SNMP version 3. Leave blank if
you do not want privacy.
Note: This field is available only if SNMP V3 is selected.

Context name

The context name of SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Context
engine ID

The context engine ID of SNMP version 3.
Note: This field is available only if SNMP V3 is selected.

Preferences Settings: Advanced Settings Area
SNMP trap ID

Select the type of trap to send. There are several predefined ID types for common
conditions:
l

l

Generic SNMP trap ID. Select a generic SNMP type from the drop-down list.
Enterprise-Specific SNMP trap ID. To use an enterprise specific SNMP ID
type, enter the number of the specific trap type in the box.

Note: When integrating SiteScope with NNMi, you must select EnterpriseSpecific SNMP trap ID, and enter 1. SiteScope sends a different notification ID
for each SNMP version:
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SNMP V2: .1.3.6.1.4.1.11.15.1.4.1
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UI Element

Description

SNMP object
ID

Identifies to the console the object that sent the message.
l

l

Preconfigured SNMP object IDs. Select one of the predefined objects from
the drop-down list.
Other SNMP object ID. To use another object ID, enter the other object ID in
the box.

Note:
l

l

Add System
OID as a
prefix to
SNMP Trap
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In SiteScope version 11.20 and later, all logged traps have an object ID that
starts with a dot (“.”). For example, oid=.1.3.6.1.2.1.0.1.3.6.1.4.1.11.2.17.1.
When integrating SiteScope with NNMi, select Preconfigured SNMP object
IDs and choose HP SiteScope Event from the list.

Adds the default system OID (1.3.6.1.2.1) as a prefix to all SNMP Trap OIDs.
Clear the check box if you do not want to use this prefix.
Default value: Selected
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UI Element

Description

SNMP source

The SNMP trap source: SiteScope Server or the monitor target server.
Default value: Monitored Host
Note:
l

l

l

The following monitors do not have a target remote server: Composite, eBusiness Transaction, Formula Composite, SNMP Trap, URL List.
The following monitors report the SiteScope host as Monitored Host: Custom,
Custom Database, DHCP, Microsoft NetScout Event, Technology SNMP
Trap Integration, Technology Web Service Integration.
While some monitors report the target remote as the Monitored Host, you need
to type the target remote manually for the following monitors:
n

Database Counter monitor: Reports the SiteScope host as the Monitored
Host when the Database machine name field is empty..

n

Database Query monitor: Reports the SiteScope host as the Monitored
Host when the Database machine name field is empty.

n

WebLogic Application Server monitor: Reports the address of the server
where WebLogic is running as the Monitored Host when the Target field is
empty.

n

WebSphere Application Server monitor: Reports the name of the server you
want to monitor as the Monitored Host when the Target field is empty. On
UNIX servers, enter the full path of the server.

Search/Filter Tags
<Tag name
and values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created
for the SiteScope, this section appears but is empty. If tags have been created,
they are listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag
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New/Edit SNMP Trap Receiver Dialog Box
This dialog box enables you to create SNMP Trap receiver profiles or edit existing ones, and listen to
multiple local addresses and ports at the same time. When an SNMP Trap receiver session has v3
properties, it is still able to listen and receive SNMP v1 and v2 traps.
User interface elements are described below:
UI Element

Description

General Settings
Name

Name string assigned to the setting profile when creating a new SNMP receiver.

Description Description for the setting profile, which appears only when editing or viewing its
properties. You can include HTML tags such as the <BR>, <HR>, and <B> tags to
control display format and style.
Note: HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire field
is rejected. The following is prohibited HTML content:
l

l

l

Tags: script, object, param, frame, iframe.
Any tag that contains an attribute starting with on is declined. For example,
onhover.
Any attribute with javascript as its value.

Preferences Settings
Host

Select the host option:
l

l

Port

Host. Select the host name or IP address of the local SNMP address to bind from
the drop-down list.
Other. Enter the host name or IP address of the local SNMP address to bind.

UDP port used for collecting traps.
Default value: 162

V3 Trap Settings
User Name

User name used for SNMP authentication.

Auth. Type

Type of SNMP authentication used (MD5, SHA, or None).

Auth.
Password

Password used for SNMP authentication.
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UI Element

Description

Privacy
Type

The privacy protocol used for SNMP authentication (DES,128-Bit AES,192-Bit AES,
256-Bit AES).

Privacy
Password

The privacy password used for SNMP authentication.

Context
Engine ID

The SNMP context engine ID.

Search/Filter Tags
<Tag name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors,
remote servers, templates, and preference profiles). If no tags have been created for
the SiteScope, this section appears but is empty. If tags have been created, they are
listed here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user
interface details, see "New/Edit Tag Dialog Box" on page 721.
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You manage SiteScope user accounts from the User Management Preferences page. This page
enables you to administer the users that are allowed access to SiteScope.
Note: User Management Preferences are available only to users accessing SiteScope directly
and not to users accessing SiteScope using SAM Administration in BSM. For details on how
SiteScope permissions interact with BSM, see "Accessing SiteScope and Building Permissions
Model" in the BSM Application Administration Guide in the BSM Help.

To access
Select Preferences > User Management Preferences
Note:
l

l

Only an administrator in SiteScope, or a user granted Add, edit or delete user preferences
permissions can create or make changes to user settings and permissions for the current user
or for other users. By default, a regular user does not have Add, edit or delete user
preferences permissions, which means that they can view only their own user properties.
The Administrator account is the default account that is active when the product is installed. To
create other accounts, you must first edit the Administrator account profile to include a user
login name and login password. The data provided by SiteScope can be made available to
multiple users without granting full administrative privileges to all users.

Learn About
User Profiles Overview
As a client-server based architecture, a single SiteScope user profile can be accessed by multiple
users simultaneously. You can define multiple SiteScope user accounts that provide different views
and edit permissions for different audiences. For example, you can create a user profile that enables
users to view monitor status and reports but does not enable the users to add or edit monitor
configurations or alerts.
A user profile limits access to SiteScope to those users that enter a correct user name and password.
Optionally, user authentication can be handled by submitting a query to an LDAP database. This
enables you to manage users from an external LDAP server by storing authentication information (user
names and passwords) for all SiteScope users in a central repository, and using the LDAP server to
verify a user's credentials. For more details, see "LDAP Authentication and Authorization" on page 771.
A user profile has two main components:
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l

User authentication information and access permission

l

Action permissions

Configure these settings for each user profile in the applicable User Profile container. For details on
creating a SiteScope user profile, see "How to Create a SiteScope User Profile" on page 735.

User Types and User Role Types
SiteScope provides the following user types and user role types:
User Types:
l

l

l

l

l

Administrator. SiteScope provides a single administrator by default. An administrator can view
and change anything in SiteScope. It has other special properties as well, such as being allowed to
create other users and to change their profiles in the User Management Preferences page. The
administrator account cannot be disabled or deleted.
Super User (Power user). This is a regular user that has been granted user management
permissions. A power user can create, edit, or delete other users, except the administrator. A power
user can also edit, but not delete, himself. Both an administrator and a power user can create a
power user. There may exist any number of power users. For details about enabling this user type,
see "New/Edit User Profile Dialog Box" on page 741.
Regular User. A regular user cannot create, delete, or edit any user, including itself. It has all the
permissions defined for it by the administrator or power user. By default, a regular user is granted all
permissions except Add, edit or delete user preferences (under User Management
Preferences). This limits the user to being able to view their own user properties and the root groups
for which they have permissions. A regular user cannot view or edit settings and permissions of
other users.
Inherited from <user role>. Displayed in the User Type field for the selected user to which a user
role has been assigned. For more details, see User Role Types below.
Integration Viewer. By default, SiteScope provides an Integration Viewer user that is used for
drilling down from HPOM events. This is a regular user that has been granted view permissions,
and permissions to refresh groups and monitors. For more details, see Integrating SiteScope with
HP Operations Manager Products in the SiteScope Help. You can check the HP Software
Integrations site for the latest version of this guide.

User Role Types: Used to manage groups of SiteScope users when using an external LDAP server.
l

l

Super User Role. This is a regular user role that has been granted user management permissions
(Add, edit or delete user preferences). Users of this type can create, edit, or delete other users,
except the administrator. They can also edit, but not delete, their own user role. Both an
administrator and a power user can create a super user role. There may exist any number of super
user roles.
Regular User Role. A user of this type cannot create, delete, or edit any user, including itself. It
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has all the permissions defined for it by the administrator or power user. By default, a regular user
role is granted all permissions except Add, edit or delete user preferences (under User
Management Preferences). This limits the user to being able to view their own user properties and
the root groups for which they have permissions. A regular user role cannot view or edit settings and
permissions of other users. There may exist any number of regular user roles.
Note: When a user role is assigned to a user profile (in the Assign user role field in from the User
Profile dialog box), Inherited from <user role> is displayed in the User Type field for the selected
user. The user inherits the same permissions as the user role.
For details about enabling user role types when using an LDAP server, see "How to enable SiteScope
to use LDAP authentication" on page 773.
For more details about LDAP authentication, see "LDAP Authentication and Authorization" on page
771.

User Permissions
When setting up SiteScope user accounts, the administrator in SiteScope or a power user can
configure the permissions required for different users. Permissions limit the areas in SiteScope that a
user can access, and control the types of action a user can perform on SiteScope objects, such as
groups, monitors, alerts, reports, preferences, remote servers, templates, and Dashboard.
Note: By default, a regular user can view their own user properties and the root groups for which
they have permissions only. If a regular user is granted Add, edit or delete user preferences
permissions (thereby making the user a power user), the user can edit its own settings and
permissions, and create and make changes to the settings and permissions of other users.
User permissions have been extended in SiteScope so that there are specific view, edit, and test
permissions for each preference type, and view, edit, and test permissions for remote servers. This
enables the administrator or power user to restrict access for selected users to specific preference
types and to remote server properties. Where a user does not have view permissions to a specific
preference, the tab for that preference is unavailable.
When selecting permissions for an action type, it is important to understand that there are dependency
relationships between certain permissions. Edit and test permissions are always dependent on the
corresponding view permission. For example, if you select the Add, edit or delete remote servers or
Test remote servers permission, the View remote servers permission is automatically selected.
Conversely, if you clear the View remote servers permission, the Add, edit or delete remote
servers and Test remote servers permissions are automatically cleared.
You configure user permissions from the Permissions panel of the New/Edit User Profile dialog box.
For details on SiteScope user permissions, see "New/Edit User Profile Dialog Box" on page 741.

Password Requirement Parameters
You can configure password requirements by setting the following parameters in <SiteScope root
directory>\groups\master.config:
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Parameter

Description

_adminMinimumLength = x

The password length must be at least xcharacters.

_adminRequireAlpha = (1,0)

_adminRequireNumber = (1,0)

_adminRequirePunctuation = (1,0)

l

0. Password does not require an alphabetic character.

l

1. Password must contain an alphabetic character.

l

0. Password does not require a numeric character.

l

1. Password must contain a numeric character.

l

0. Password does not require punctuation.

l

1. Password must contain punctuation.

Tasks
How to Create a SiteScope User Profile
This task describes the steps involved in creating a SiteScope user profile.
1. Prerequisites
You must be an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions to be able create or make changes to SiteScope user management
settings and permissions. A regular user does not have Add, edit or delete user preferences
permissions by default.
For details on user permissions, see "New/Edit User Profile Dialog Box" on page 741.
2. Create a SiteScope user profile
a. In the User Management Preferences page, click the arrow next to the New User
button, and select New User.
b. In the Main Settings panel, enter the user name, login name and password, and select the
groups that can be accessed by this user profile.
For user interface details, see "New/Edit User Profile Dialog Box" on page 741.
3. Assign permissions to the user - optional
Select the permissions granted to this user in the Permissions panel, or use the default
permissions (all permissions are granted except Add, edit or delete user permissions).
Click OK. The new user profile is added to the User Management Preferences list.
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4. Log on to SiteScope
Log on to SiteScope using the new user profile. For details, see "Log into SiteScope" on page 18.
Note: The SiteScope login password is case sensitive.
SiteScope opens to the Dashboard view and the relevant user permissions are ascribed to the
user.
5. Changing a User's Password - optional
a. To change a user password, right-click the user profile in the User Management Preferences
page, and select Edit User.
b. In the Edit User Profile dialog box, enter a new password and confirm the password. For
details, see "New/Edit User Profile Dialog Box" on page 741.
If the new password does not comply with password configuration rules, an error message is
displayed and the password is not changed. For password configuration rules, see "Password
Requirement Parameters" on page 734.
Related tasks: "How to enable SiteScope to use LDAP authentication" on page 773, "How to Configure
Silent Login When Using LDAP Authentication" on page 775

UI Descriptions
User Management Preferences Page
This page enables you to create multiple user accounts that provide different view and edit permissions
for different audiences.
UI Element Description
New. Click the arrow next to the button, and select:
l

l

New User. Creates a new user profile. For user interface details, "New/Edit User
Profile Dialog Box" on page 741.
New User Role. Creates a new user role profile. For user interface details,
"New/Edit User Role Profile Dialog Box" on page 756.

Edit. Enables editing the selected user or user role profile. For user interface details,
see "New/Edit User Profile Dialog Box" on page 741 and "New/Edit User Role Profile
Dialog Box" on page 756.
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UI Element Description
Delete User/User Role. Deletes the selected user or user role profiles.
Copy to User Role. Enables coping an existing SiteScope user's permissions to a
new user role.
Note:SiteScope users still need to have a user login and a security group assigned to
them on the LDAP server. (LDAP users have their own LDAP user name and
password for logging on to SiteScope.)
Select All. Selects all listed user and user role profiles.
Clear Selection. Clears the selection.
Default
Settings

Click the arrow next to Default Settings, and select an option:
Edit. Opens the User Management Settings dialog box which enables you to
change the default LDAP authentication settings.

l

Test. Tests the connection to the LDAP server and the authentication of user.

l

Save allowed LDAP users to CSV. Enables saving a list of all LDAP users that
have permissions to log on to SiteScope to a CSV file. For details, see "Save
SiteScope LDAP Users in CSV File Dialog Box" on page 758.

l

Note: This option is available to SiteScope administrators only
Displayed
Name

The title for the user or user role profile that was provided in the Displayed user name
or Displayed user role name box.
Note: When configuring a user profile, if a user name is not provided, the Login name
value is used instead.

Login
Displays the login name for a user profile, and the LDAP context for a user role.
Name/User
Role
Context
Login
Disabled

Displays the login status. If the check box is cleared, access to SiteScope using the
user profile is enabled. If the check box is selected, access to SiteScope with this
user profile is not allowed.

User Type

Type of user. For details on the different user types, see "User Types and User Role
Types" on page 733.
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Other User Management UI Pages:
l

"User Management Settings Dialog Box" on the next page

l

"New/Edit User Profile Dialog Box" on page 741

l

"New/Edit User Role Profile Dialog Box" on page 756

l

"Save SiteScope LDAP Users in CSV File Dialog Box" on page 758

l

"Select User's Allowed Groups Dialog Box" on page 759

Tips/Troubleshooting
Upgrade - Notes/Limitations
The user preference permissions in SiteScope are not supported in SAM Administration when the
SiteScope is reporting to Business Availability Center version 8.00 or earlier.

l

When upgrading from versions of SiteScope earlier than 10.10, the permission values are
determined as follows:

l

n

View <preference type> permission is selected by default for all preference types (since there
was no corresponding preference permission in earlier versions of SiteScope).

n

Edit <preference type> permission for all preference types is determined according to the Edit
Preferences permission in the earlier version of SiteScope.

n

Test <preference type> permission for all preference types is determined according to the Test
Preferences permission in the earlier version of SiteScope.

User Accounts - Notes/Limitations
l

The Administrator account is the default account used when accessing SiteScope. This means that
anyone requesting the server address and port number where SiteScope is running is, by default,
logged in on the administrator account. To restrict access to this account and its privileges, you
must edit the administrator account profile to include a user login name and login password.
SiteScope then displays a login dialog before SiteScope can be accessed.
It is also recommended to change the Integration Viewer account profile to include a user login
name and login password.

l

You can create a named user account that does not require a user login name and password. You
do this by creating a new user profile in the standard format (providing a Displayed user name), but
leave the Login name and Password boxes blank. With this configuration, users accessing
SiteScope are presented with an authentication dialogue. They may be authenticated as this named
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user by leaving the Login Name and Password boxes blank and clicking the Log In button. This
user is displayed as guest on the upper right side of the SiteScope user interface.
l

l

You should restrict the permissions on regular user accounts to avoid unauthorized changes to your
SiteScope configuration.
User login name and password must be in English characters.

User Management Settings Dialog Box
This dialog box enables you to configure the default LDAP user management settings.
To access

Important
information

Select Preferences > User Management Preferences. In the User Management
Preferences toolbar, select Default Settings > Edit.
l

l

Relevant
tasks
See also

Only an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions can create or make changes to LDAP user
management settings and permissions. By default, a regular user does not have
Add, edit or delete user preferences permissions, which means that they can
view only their own user properties.
We recommend that you contact your LDAP server administrator for assistance
when configuring LDAP server settings.

l

"How to enable SiteScope to use LDAP authentication" on page 773

l

"How to Configure Silent Login When Using LDAP Authentication" on page 775

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

LDAP User Management Settings
User interface elements are described below:
UI Element

Description

Enable LDAP Enables using an external LDAP server for authenticating SiteScope users.
authentication
Default value: Not selected

HP SiteScope (11.31)

Page 739 of 1395

Using SiteScope
Chapter 56: User Management Preferences

UI Element

Description

LDAP server
URL

URL of the applicable LDAP server to access the SiteScope service using a
centralized LDAP authentication rather than the SiteScope specific password.
This way, password authentication for access to SiteScope can be performed by
LDAP.
Example: ldap://ldap.mydomain.com:389 or
ldaps://ldap.mydomain.com:636 (when using an SSL connection).

LDAP
credentials

Option for providing LDAP server authentication credentials:
l

Use user name and password. Select this option to manually enter user
credentials. Enter the user name and password used to access the LDAP
server in the User name and Password box. This enables SiteScope to run
search queries in LDAP. The user should be an administrator in LDAP, or a
user that has been granted search permissions in LDAP.
Example: The user name can be in the format [Domain]/[user_name] or
[user_name]@[Domain].

l

Enable viewer
permissions
for all LDAP
users

Select predefined credentials. Select this option to have SiteScope
automatically supply a predefined user name and password for the LDAP
server (default option). Select the credential profile to use from the Credential
profile drop-down list, or click Add Credentials and create a new credential
profile. For details on how to perform this task, see "Credential Preferences" on
page 561.

Enables viewer permissions for all users in the specified LDAP context, even for
users that have not been assigned to a specific SiteScope user role.
Default value: Not selected

LDAP context
New LDAP context. Adds a new row at the bottom of the LDAP context table,
enabling you to add a new LDAP context.
Delete LDAP context. Deletes the selected LDAP context.
Move Up. Enables you to change the order of the LDAP context list by moving the
selected LDAP context up the list.
Move Down. Enables you to change the order of the LDAP context list by moving
the selected LDAP context down the list.
Context

Displays the LDAP root node for the context to search inside of LDAP.
Example: DC=ldap,DC=server where DC refers to domain component.
Note: We recommend that you contact your LDAP server administrator for
assistance when configuring these settings.
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LDAP User Management Advanced Settings
User interface elements are described below:
UI Element

Description

All default values in LDAP User Management Advanced Settings are relevant for an Active Directory
system. If you are using a different server type, contact your LDAP server administrator for the
relevant setting values.
LDAP user objectClass

Query value used for the LDAP user role name.
Default value: user

LDAP user identification
attribute name

Query value used for LDAP users with login identification attributes.

LDAP group objectClass

Query value used for the LDAP group (role context).

Default value: sAMAccountName

Default value: Group
LDAP activation key
identification attribute

LDAP identity attribute for silent login authentication. This field is used
with an activation key authentication configuration only. You can enter
a unique attribute for identifying the LDAP user, or leave it blank, in
which case, the userPrincipalName attribute is used.
For more on silent login with an activation key, see Silent
Authentication under "LDAP Authentication and Authorization" on
page 771.

New/Edit User Profile Dialog Box
This dialog box enables you to create a new user profile or edit an existing profile.
To access

Select Preferences > User Management Preferences. In the User Management
Preferences page:

l

Click the arrow next to the New User

button, and select New User, or

l

Select an existing user profile and click the Edit

button.

Important
Only an administrator in SiteScope, or a user granted Add, edit or delete user
information preferences permissions can create or make changes to user settings and
permissions for the current user or for other users. By default, a regular user does not
have Add, edit or delete user preferences permissions, which means that they can
view only their own user properties.
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Relevant
tasks
See also

l

"How to Create a SiteScope User Profile" on page 735

l

"How to enable SiteScope to use LDAP authentication" on page 773

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

Main Settings
User interface elements are described below:
UI
Element

Description

Displayed Title for the user profile. The title is displayed in the list of users. If you do not enter a
user name title, the Login name value is used as the displayed name.
Login
name

SiteScope login name to access SiteScope using this profile.
Alternatively, users can log into SiteScope using LDAP authentication by entering a
value in the relevant LDAP cells.
Allowed characters: Latin alphanumeric.
Note: Entering characters other than the allowed characters does not cause an error
when creating the user profile. However, the user cannot log on to SiteScope using that
login name.

Password

SiteScope login password for this user.
If using LDAP for user authentication, there is no need to enter a password here. Users
enter their LDAP password in the SiteScope login dialog box when they log on to their
user account.
For information about password requirements, see "Password Requirement
Parameters" on page 734.
All SiteScope passwords are encrypted using 3DES (also known as TDES or Triple
Data Encryption Algorithm). Although the TDES key is stored in SiteScope, it cannot
be modified. For more information, refer to Hardening the SiteScope Platform in the
SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).
Note:
l

l
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UI
Element

Description

Confirm
password

Confirmation of the password entered in the Password box. This is used when creating
a new user profile or changing the password of an existing user profile.

LDAP
service
provider

URL of the applicable LDAP server to access the SiteScope service using a
centralized LDAP authentication rather than the SiteScope specific password. This
way, password authentication for access to SiteScope can be performed by LDAP.
You can specify multiple LDAP service providers by entering either the host name
and/or the IP address of each LDAP service provider separated by a semicolon (";").
SiteScope reads the list of LDAP service providers and searches for the available
provider from the list.'
Example: ldap://ldap.mydomain.com:389.
Note:
l

l

LDAP
security
principal

Users still need to have a SiteScope login name defined.
Users can use LDAP to access SiteScope, but they must have a user login and
security principal assigned to them on the LDAP server.

Security Principal for this user when using LDAP authentication to access the
SiteScope service.
Example: uid=testuser,ou=TEST,o=this-company.com
Note: Users may be defined with special characters on the LDAP server. However,
SiteScope does not support users that contain the following characters in their user
name: equal ("="), semicolon (";"), inverted commas ("""). A user name containing
invalid characters is unable to log on to SiteScope.

Assign
user role

Select to assign the user the same permissions as the user role. The list displays the
names of all user roles defined in SiteScope. If you select a user role, the Login
disabled, Allowed groups, Allowed template containers, and Permissions
settings are no longer available for selection.
For details on creating a user role, see "New/Edit User Role Profile Dialog Box" on
page 756.
Example: If a Super User Role is created with Add, edit or delete user
preferences permissions and this role is assigned to the user, the user inherits the
super user permissions (User Type is displayed as Inherited from Super User
Role).

Login
disabled

Disables access to SiteScope with this user name and password. Clear the check box
to enable access using the user profile.
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UI
Element
Allowed
groups

Description
Displays the list of groups that can be accessed by this user profile. Click the New
button to open the Select User's Allowed Groups dialog box, and select groups. For
user interface details, see "Select User's Allowed Groups Dialog Box" on page 759.
To remove user access to a group, select the group and click the Delete
is not possible to delete all groups in the list.

button. It

Default value: The SiteScope node is selected to enable access to all groups. To
restrict user access to fewer groups, clear the check box for the SiteScope node and
then select the individual groups below the SiteScope node to which you want to
enable access.
Note: This field is not visible for an Administrator's settings.
Allowed
Displays the list of template containers that can be accessed by this user profile. Click
template
button to open the Select User's Allowed Template Containers dialog
containers the New
box, and select template containers. For user interface details, see "Select User's
Allowed Template Containers Dialog Box" on page 760.
To remove user access to a template container, select the template container and click
the Delete

button. It is not possible to delete all template containers in the list.

Default value: The SiteScope node is selected to enable access to all template
containers. To restrict user access to fewer template containers, clear the check box
for the SiteScope node and then select the individual template containers below the
SiteScope node to which you want to enable access.
Note: This field is not visible for an Administrator's settings.
Permissions
Enables you to determine user action permissions. To grant a permission, select the check box to the
left of the permission or permission group.
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Important
information

l

l

l

l

See also

The Permissions panel is not visible for the administrator's account, since they
have full permissions which cannot be changed.
Only an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions can create or make changes to user settings and
permissions for the current user or for other users.
All the permissions in the Permissions panel are selected by default, except for
the Add, edit or delete user preferences permission which must be granted by
the SiteScope administrator.
The icon displayed to the left of a permission group indicates that not all
permissions contained within that root group have been selected.

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

Groups
User interface elements are described below:
UI Element

Description

Add, edit or
delete
groups

Enables the user to add new groups, rename, copy, and delete existing monitor
groups. For details, see "New SiteScope Group Dialog Box" on page 249.

Refresh
groups

Enables the user to refresh or force all the monitors within a group to run regardless
of their schedule. For details, see "New SiteScope Group Dialog Box" on page 249.

Default value: Selected

Default value: Selected
Disable
groups

Enables the user to disable groups. For details, see "Enable/Disable Monitors in
Group Dialog Box" on page 1049.
Default value: Selected

Monitors
User interface elements are described below:
UI Element

Description

Add, edit or
delete
monitors

Enables the user to add new monitors, edit existing monitor configurations, and
delete monitors. For details, see "Monitors and Groups" on page 244.
Default value: Selected
Note: This option overrides the Edit monitors (cannot create new monitors)
option if both are selected.
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UI Element

Description

Edit or delete
monitors

Enables the user to edit or delete existing monitor configurations without being able
to create new monitors. If you select this option, you must clear the Add, edit or
delete monitors option, otherwise the Add, edit or delete monitors option
prevails and a user can create new monitors.
Default value: Selected
Note: Selecting this option does not prevent users from creating new monitors
when working in template mode, unless Add, edit or delete templates is also
cleared.

Refresh
monitors

Enables the user to refresh or force individual monitors to run regardless of their
schedule. For details, see "Monitors and Groups" on page 244.
Default value: Selected

Acknowledge Enables the user to use the Acknowledge function to comment on monitor status on
monitors
the group detail page. For details, see "Acknowledging Monitor Status" on page
1035.
Default value: Selected
Disable
monitors

Enables the user to disable monitors within a group. "Enable/Disable Monitors in
Group Dialog Box" on page 1049.
Default value: Selected

Alerts
User interface elements are described below:
UI Element

Description

View alerts
list

Enables the user to view the list of currently configured alert definitions on the Alert
List page. This is a root permission that is required to edit, test, or disable alerts
indefinitely. For details, see "SiteScope Alerts Page" on page 1265.
Default value: Selected
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UI Element

Description

Add, edit
or delete
alerts

Enables the user to add a new alert, and edit or delete existing alerts. This option is
dependent on the View alerts list permission. For details on adding or editing alerts,
see "New/Edit Alert Dialog Box" on page 1267.
Default value: Selected
Note:
l

l

Edit or
delete
alerts

Since alert actions are not controlled by alert action preferences permissions, this
permission is not dependent on the View emails, pagers, and SNMP lists
permission.
This option overrides the Edit or delete alerts option if both are selected.

Enables the user to edit or delete existing alert configurations without being able to
create new alerts.This option is dependent on the View alerts list permission. If you
select this option, you must clear the Add, edit or delete alerts option, otherwise the
Add, edit or delete alerts option prevails and a user can create new alerts
Default value: Selected
Note: Selecting this option does not prevent users from creating new alerts when
working in template mode, unless Add, edit or delete templates is also cleared.

Test alerts

Enables the user to test an existing alert definition. This option is dependent on the
View alerts list permission. For details, see "SiteScope Alerts Page" on page 1265.
Default value: Selected

Disable
alerts
indefinitely

Enables the user to disable or enable one or more alerts indefinitely. This option is
dependent on the View alerts list permission. For details, see "New/Edit Alert Dialog
Box" on page 1267.
Default value: Selected

Disable
Enables the user to disable or enable one or more alerts temporarily. For details, see
alerts
"New/Edit Alert Dialog Box" on page 1267.
temporarily
Default value: Selected
Reports
User interface elements are described below:
UI Element

Description

Generate
management report

Enables the user to create a scheduled Management report manually. For
details, see "Management Report" on page 1351.
Default value: Selected
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UI Element

Description

Add, edit or delete
management report

Enables the user to add new report definitions, and edit or delete existing
report definitions. For details, see "Management Report" on page 1351.
Default value: Selected

Generate quick
report

Enables the user to create ad hoc SiteScope management reports. For
details, see "Quick Report" on page 1356.
Default value: Selected

Generate alert
report

Enables the user to create ad hoc or quick alert reports. For details, see
"Alert Report" on page 1363.
Default value: Selected

Generate monitor
summary report

Enables the user to use the Browse Monitor form and the Monitor Summary
Report. For details, see "Monitor Summary Report" on page 1361.
Default value: Selected

Generate server
centric report

Enables the user to create Server-Centric reports. For details, see "ServerCentric Report" on page 1370.
Default value: Selected

Remote Servers
User interface elements are described below:
UI Element

Description

View
remote
servers list

Enables the user to view the list of remote servers configured in SiteScope. This is a
root permission that is required to edit or test remote servers. For details, see
"Remote Servers Properties Page" on page 539.
If this option is not selected, the following entities are not available:
l

Remote servers tree and remote servers page in the Remote Servers context.

l

Add Remote Servers button in the Monitors context.

Default value: Selected
Add, edit or
delete
remote
servers

Enables the user to add remote servers to SiteScope and edit remote server settings.
This option is dependent on the View remote servers list permission. For details,
see "Remote Servers Properties Page" on page 539.
Default value: Selected
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UI Element

Description

Test remote
servers

Enables the user to test remote server connectivity. This option is dependent on the
View remote servers list permission. For details, see "Remote Servers Properties
Page" on page 539.
Default value: Selected

General Preferences
User interface elements are described below:
UI Element

Description

View
general
preferences

Enables the user to view General Preferences. This is a root permission that is
required to edit General Preferences. For details, see "General Preferences" on page
578.
Default value: Selected

Edit
general
preferences

Enables the user to edit General Preferences. This option is dependent on the View
general preferences permission. For details, see "General Preferences" on page
578.
Default value: Selected

Infrastructure Preferences
User interface elements are described below:
UI Element

Description

View
Enables the user to view Infrastructure Preferences. This is a root permission that
infrastructure is required to edit Infrastructure Preferences. For details, see "Infrastructure
preferences
Preferences" on page 608.
Default value: Selected
Edit
Enables the user to edit Infrastructure Preferences. This option is dependent on the
infrastructure View infrastructure preferences permission. For details, see "Infrastructure
preferences
Preferences" on page 608.
Default value: Selected

HP SiteScope (11.31)

Page 749 of 1395

Using SiteScope
Chapter 56: User Management Preferences

Integration Preferences
User interface elements are described below:
UI Element

Description

View
Enables the user to view Integration Preferences. This is a root permission that is
integration required to edit Integration Preferences. For details, see "Integration Preferences
preferences Page" on page 698.
Default value: Selected
Edit
Enables the user to create or edit Integration Preferences. This option is dependent on
integration the View integration preferences permission. For details, see "Integration
preferences Preferences Page" on page 698.
Default value: Selected
High Availability Preferences
User interface elements are described below:
UI Element

Description

View high
availability
preferences

Enables the user to view High Availability Preferences. This is a root permission
that is required to edit High Availability Preferences. For details, see "High
Availability Preferences" on page 597.
Default value: Selected

Edit high
availability
preferences

Enables the user to edit High Availability Preferences. This option is dependent on
the View high availability preferences permission. For details, see "High
Availability Preferences" on page 597.
Default value: Selected

Log Preferences
User interface elements are described below:
UI Element

Description

View log
Enables the user to view Log Preferences. This is a root permission that is required to
preferences edit Log Preferences. For details, see "Log Preferences" on page 700.
Default value: Selected
Edit log
Enables the user to edit Log Preferences. This option is dependent on the View log
preferences preferences permission. For details, see "Log Preferences" on page 700.
Default value: Selected
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Email, Pager, HTTP, and SNMP Preferences
User interface elements are described below:
UI Element

Description

View email, pager,
HTTP and SNMP
lists

Enables the user to view the Email, Pager, HTTP and SNMP profile lists.
This is a root permission that is required to edit or test Email, and SNMP
Preferences.
For details, see "Email Preferences Page" on page 569, "HTTP
Preferences Page" on page 590 and "SNMP Preferences" on page 723.
Default value: Selected

Add, edit or delete
email, pager, HTTP
and SNMP
preferences

Enables the user to create or edit Email, HTTP and SNMP Preferences.
This option is dependent on the View email, pager, HTTP and SNMP
lists permission.
For details, see "Email Preferences Page" on page 569, "HTTP
Preferences Page" on page 590 and "SNMP Preferences" on page 723.
Default value: Selected

Test email, pager,
HTTP and SNMP
preferences

Enables the user to test any preference setting for communicating with an
external service such as email, HTTP or SNMP. This option is dependent
on the View email, pager, HTTP and SNMP lists permission.
For details, see "Email Preferences Page" on page 569, "HTTP
Preferences Page" on page 590 and "SNMP Preferences" on page 723.
Default value: Selected

Common Event Mappings
User interface elements are described below:
UI Element

Description

View common
event mappings

Enables the user to view Common Event Mappings. This is a root permission
that is required to edit Common Event Mappings. For details, see "Common
Event Mappings" on page 547.
Default value: Selected

Add, edit or
delete common
event mappings

Enables the user to edit Common Event Mappings. This option is dependent
on the View common event mappings permission. For details, see
"Common Event Mappings" on page 547.
Default value: Selected
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Schedule Preferences
User interface elements are described below:
UI Element

Description

View schedule
list

Enables the user to view Schedule Preferences. This is a root permission that
is required to edit Schedule Preferences. For details, see "Schedule
Preferences" on page 712.
Default value: Selected

Add, edit or
delete schedule
preferences

Enables the user to create or edit Schedule Preferences. This option is
dependent on the View schedule list permission. For details, see "Schedule
Preferences" on page 712.
Default value: Selected

User Management Preferences
User interface elements are described below:
UI Element

Description

Add, edit
or delete
user
preferences

Enables the user to view, add, edit, or delete user preferences for all other users,
except the SiteScope administrator user. A power user cannot delete his/her own
account. For users who do not have this permission, the New/Edit User Profile dialog
box is displayed as read only, and the settings and root groups for which the current
user has permissions are displayed.
Default value: Not selected

Credential Preferences
User interface elements are described below:
UI Element

Description

View credential
list

Enables the user to view Credential Preferences. This is a root permission that
is required to edit Credential Preferences. For details, see "Credential
Preferences Page" on page 565.
If this option is not selected, the following entities are not available:
l

Credential Preferences tab in the Preferences context.

l

Add Credentials button in the Remote Servers and Monitors context.

Default value: Selected
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UI Element

Description

Add, edit or
Enables the user to create, edit, or delete Credential Preferences. This option is
delete credential dependent on the View credential list permission. For details, see "Credential
preferences
Preferences Page" on page 565.
Default value: Selected
Certificate Management
User interface elements are described below:
UI
Element

Description

View
Enables the user to view the Certificate Management page. This is a root permission
certificates that is required to edit Certificate Management. For details, see "Certificate
list
Management" on page 542.
Default value: Selected
Edit
Enables the user to manage certificates using Certificate Management. This option is
certificates dependent on the View certificates list permission. For details, see "Certificate
list
Management" on page 542.
Default value: Selected
Tags
User interface elements are described below:
UI
Element
View
tags

Description
Enables the user to view the New/ Edit SiteScope Tag dialog box to see a list of defined
tags. This is a root permission that is required to edit tags. For details, see
"Search/Filter Tags" on page 718.
Default value: Selected

Add, edit
or delete
tags

Enables the user to add, edit, or delete search/filter tags and tag values. This option is
dependent on the View tags permission. For details, see "Search/Filter Tags" on page
718.
Default value: Selected
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Templates
User interface elements are described below:
UI Element

Description

View
templates

Enables the user to view templates that exist in the monitor tree. This is a root
permission that is required to edit templates. For details, see "Template Tree" on
page 41.
Default value: Selected

Add, edit or
delete
templates

Enables the user to add, edit, and delete templates. This option is dependent on the
View templates permission. For details, see "Template Tree" on page 41.
Default value: Selected

Dashboard
User interface elements are described below:
UI
Element

Description

Edit
Enables the user to add or delete items in the favorite views list in the SiteScope
favorites Dashboard view. For details, see "Save to Dashboard Favorites Dialog Box" on page
1051 and "Delete Dashboard Favorites Dialog Box" on page 1048.
Default value: Selected
Edit
layout

Enables the user to permanently disable fields in the SiteScope Dashboard. For
example, if you do not want specific users to see IP addresses of monitored servers, you
can permanently hide the Target column in the Dashboard. Users that do not have this
permission cannot see the columns that have been disabled.
Default value: Selected

View
monitor
history

Enables the user to view the recent history report for a monitor. For details, see
"SiteScope Dashboard - Monitor History View" on page 1059.
Default value: Selected

Event Console
User interface elements are described below:
UI Element

Description

View and
edit event
console
preferences

Enables the user to view and edit the Event Console Preferences. For details, see
"Event Console Preferences" on page 574.
Default value: Selected
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UI Element

Description

Assigned
Enables the user to manage events that have been assigned to a user.
Event
Management l Assign event to a user: Enables the user to assign or unassign an event that
has already been assigned using the "Event Details Dialog Box" on page 1085.
l

Edit event details: Enables the user to update attributes of an event which is
currently assigned to a user using the "Event Details Dialog Box" on page 1085.
This permission does not include the ability to update the Assigned User
attribute.

Default value: All permissions are selected
Unassigned Enables the user to manage events that have not been assigned to a user.
Event
Management l Assign event to a user: Enables the user to assign an event which is not
currently assigned using the "Event Details Dialog Box" on page 1085.
l

Edit event details: Enables the user to update attributes of an event which is not
currently assigned to a user using the "Event Details Dialog Box" on page 1085.
This permission does not include the ability to update the Assigned User
attribute.

Default value: All permissions are selected
Other
User interface elements are described below:
UI Element

Description

Use tools

Enables the user to use SiteScope tools in the Tools container to troubleshoot
and diagnose monitor configuration problems. For details, see "SiteScope Tools"
on page 105.
Default value: Selected

View logs

Enables the user to view the raw data reported by SiteScope monitors sent by
alerts, and other SiteScope logs. For details, see "SiteScope Log Files" on page
1177.
Default value: Selected

View server
statistics

Enables the user to view SiteScope internal data that can be used for analyzing
SiteScope server performance, stability, health, and for debugging bottlenecks.
For details, see "SiteScope Server Statistics" on page 1176.
Default value: Selected
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UI Element

Description

Use monitor
tools

Enables the user to use SiteScope tools when configuring or editing particular
monitor types. If a diagnostic tool is available for a monitor type, the Tools
button is enabled in the Dashboard toolbar for that monitor in the group detail
page. For details, see "SiteScope Tools" on page 105.
Note:
l

Diagnostic tools may expose sensitive system information.

l

This option is dependent on the Use tools permission.

Default value: Selected
Download
SiteScope Log
Grabber run
results

Enables the user to download SiteScope Log Grabber run results files. For details
on the SiteScope Log Grabber Tool, see "SiteScope Log Grabber Tool" on page
137.
Note: Since the SiteScope Log Grabber run results files may expose sensitive
configuration information such as encoded passwords, this permission should
not be granted to untrusted users.

New/Edit User Role Profile Dialog Box
This dialog box enables you to create a new user role profile or edit an existing user role profile. User
roles are used to manage groups of SiteScope users when using an external LDAP server.
To access

Select Preferences > User Management Preferences. In the User Management
Preferences page:

l

l

Click the arrow next to the New User
or

button, and select New User Role,

Select an existing user role profile and click the Edit

button.

Important
Only an administrator in SiteScope, or a user granted Edit user preferences
information permissions can create or make changes to user settings and permissions for the
current user or for other users. By default, a regular user does not have Edit user
preferences permissions, which means that they can view only their own user
properties.
Relevant
tasks
See also

"How to enable SiteScope to use LDAP authentication" on page 773

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736
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Main Settings
User interface elements are described below:
UI
Element

Description

Displayed
user role
name

Title for the use role profile. The title is displayed in the list of users.

User role
context

Security group for this user when using LDAP authentication to access the SiteScope
service. The user role context is the profile used by SiteScope to search inside of
LDAP.
Example: uid=testuser,ou=TEST,o=this-company.com

Login
disabled

Disables access to SiteScope with this user name and password. Clear the check box
to enable access using the user role profile.

Allowed
groups

Displays the list of groups that can be accessed by this user role profile. Click the New
button to open the Select User's Allowed Groups dialog box, and select groups.
For user interface details, see "Select User's Allowed Groups Dialog Box" on page
759.
To remove user access to a group, select the group and click the Delete
is not possible to delete all groups in the list.

button. It

Default value: The SiteScope node is selected to enable access to all groups. To
restrict user access to fewer groups, clear the check box for the SiteScope node and
then select the individual groups below the SiteScope node to which you want to
enable access.
Note: This field is not visible for an Administrator's settings.
Allowed
Displays the list of template containers that can be accessed by this user profile. Click
template
button to open the Select User's Allowed Template Containers dialog
containers the New
box, and select template containers. For user interface details, see "Select User's
Allowed Template Containers Dialog Box" on page 760.
To remove user access to a template container, select the template container and click
the Delete

button. It is not possible to delete all template containers in the list.

Default value: The SiteScope node is selected to enable access to all template
containers. To restrict user access to fewer template containers, clear the check box
for the SiteScope node and then select the individual template containers below the
SiteScope node to which you want to enable access.
Note: This field is not visible for an Administrator's settings.
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Permissions
Enables you to determine user role permissions. To grant a permission, select the check box to the left
of the permission or permission group.
For example, to create a Super User Role, select the Add, edit or delete user preferences
permissions. Users of this type can create, edit, or delete other users, except the administrator. They
can also edit, but not delete, their own user role. Both an administrator and a power user can create a
super user role. There may exist any number of super user roles.
For the list and explanation of each permission, see "New/Edit User Profile Dialog Box" on page 741.

Save SiteScope LDAP Users in CSV File Dialog Box
This dialog box enables a SiteScope administrator to save the list of all LDAP users that have
permissions to log on to SiteScope to a CSV file.
To access

Select Preferences > User Management Preferences. In the User Management
Preferences toolbar, select Default Settings > Save allowed LDAP users to CSV.

Important
Only an administrator in SiteScope, or a user granted Add, edit or delete user
information preferences permissions can create or make changes to LDAP user management
settings and permissions. By default, a regular user does not have Add, edit or
delete user preferences permissions, which means that they can view only their
own user properties.
Relevant
tasks
See also

"How to enable SiteScope to use LDAP authentication" on page 773

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

User interface elements are described below:
UI
Element Description
CSV file Name of the CSV file to which to save LDAP users that can log on to SiteScope. This file
contain three columns: user role name, LDAP group (role context), and user identical
attribute (login).
Select

Click the button and select an existing CSV file, or enter the name of a new file to which
to save the list of LDAP users.
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Select User's Allowed Groups Dialog Box
This dialog box enables you to select the groups, subgroups, or both, that the user can access. Select
the box next to individual groups or subgroups to enable access to that group. By default, access is
allowed to all groups. To restrict user access to fewer groups, clear the check box for the SiteScope
node and then select the individual groups below the SiteScope node to which you want to enable
access.
To access

Select Preferences > User Management Preferences. In the User Management
Preferences page, click the New User. In the Main Settings panel, click the New
button next to the Allowed groups box.

Important
information

l

l

Relevant
tasks
See also

Only an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions can create or make changes to user settings and
permissions for the current user or for other users. By default, a regular user does
not have Add, edit or delete user preferences permissions, which means that
they can view only their own user properties.
When selected, each of a group's subgroups are also added to the list of allowed
groups.

"How to enable SiteScope to use LDAP authentication" on page 773

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

User interface elements are described below:
UI
Element Description
Represents an individual SiteScope server.
Default value: The current container and all child elements are selected.
Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
If an alert has been set up for the monitor group or subgroup, the alert
displayed next to the group icon.

symbol is

If a Management report has been set up for the monitor group or subgroup, the report
symbol is displayed next to the group icon.
Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScope monitors.
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Select User's Allowed Template Containers Dialog Box
This dialog box enables you to select the template containers that the user can access. Select the box
next to individual template container or sub-container to enable access to that container. By default,
access is allowed to all template containers. To restrict user access to fewer template containers, clear
the check box for the SiteScope node and then select the individual template containers below the
SiteScope node to which you want to enable access.
To access

Select Preferences > User Management Preferences. In the User Management
Preferences page, click the New User. In the Main Settings panel, click the New
button next to the Allowed template containers box.

Important
information

Only an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions can create or make changes to user settings and
permissions for the current user or for other users. By default, a regular user does
not have Add, edit or delete user preferences permissions, which means that
they can view only their own user properties.

l

When a template container is selected, all of its sub-containers are also added to
the list of allowed template containers.

l

Relevant
tasks
See also

"How to enable SiteScope to use LDAP authentication" on page 773

l

"User Management Preferences" on page 732

l

"User Management Preferences Page" on page 736

User interface elements are described below:
UI Element

Description
Represents an individual SiteScope server.
Default value: The current container and all child elements are selected.
Represents a SiteScope template container or sub-container.
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You can use SiteScope in an Internationalization (I18N) Environment.

Learn About
Multi-Lingual User (MLU) Interface Support
The SiteScope user interface can be viewed in the following languages in your Web browser:
Language

Language Preference in Web Browser

Brazilian Portuguese

Portuguese (Brazil) [pt-BR]

Dutch

Dutch [nl]

English

English

French

French [fr]

German

German [de]

Italian

Italian [it]

Korean

Korean [ko]

Japanese

Japanese [ja]

Russian

Russian [ru]

Simplified Chinese

Chinese (China) [zh-cn]

Spanish

Spanish [es]

Use the language preference option in your browser to select how to view SiteScope. The language
preference chosen affects only the user's local machine and not the SiteScope machine or any other
user accessing the same SiteScope. For details on setting the user interface viewing language, see
"How to View SiteScope User Interface in a Specific Language" on page 764.
Note: The language is determined when you log on to SiteScope. Changing the language
preference in your browser after you have logged in has no effect until you log out and log back in.

Monitors Supported for Internationalization
The following monitors are supported for internationalization. Monitors that have been certified are
indicated by an asterisk (*).
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Monitors Supported for Windows Operating Systems
l

*CPU Monitor

l

Database Counter Monitor

l

*Database Query Monitor

l

*Disk Space Monitor

l

*DNS Monitor

l

*e-Business Transaction Monitor

l

*File Monitor

l

*FTP Monitor

l

Link Check Transaction Monitor

l

*Log File Monitor

l

*Memory Monitor

l

Microsoft IIS Server Monitor

l

Microsoft SQL Server Monitor

l

Microsoft Windows Event Log Monitor

l

Microsoft Windows Performance Counter Monitor

l

Microsoft Windows Resources Monitor

l

Oracle 9i Application Server Monitor

l

*Oracle 10g Application Server Monitor

l

*Oracle Database Monitor

l

*Ping Monitor

l

*Port Monitor

l

*Script Monitor

l

*Service Monitor

l

SNMP Monitor

l

SNMP Trap Monitor
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l

UDDI Monitor

l

*URL Monitor

l

URL Content Monitor

l

URL List Monitor

l

URL Sequence Monitor

l

*VMware Performance Monitor

l

Web Script Monitor

Monitors Supported for UNIX Operating Systems
l

CPU Monitor

l

Database Query Monitor

l

Disk Space Monitor

l

Log File Monitor

l

Port Monitor

l

Script Monitor

l

Service Monitor

l

UNIX Resources Monitor

l

URL Monitor

l

URL Content Monitor

l

URL Sequence Monitor

Tasks
How to Configure SiteScope for a Non-English Locale
This task describes the steps involved in configuring SiteScope for a non-English locale.
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1. Change the locale version setting
In the monitor tree, select Preferences > General Preferences > General Settings. Select
International version, and click Save. Restart SiteScope. This enables SiteScope to work with
multiple character sets.
For user interface details, see General Settings in the "General Preferences" on page 578.
2. Set new locale time and data settings
You can set a new locale time and data settings for SiteScope.
a. Open <SiteScope root directory>\groups\master.config in a text editor.
b. Find the entry _localeCountry=, and assign it an uppercase 2-character ISO-3166 country
code. For example: _localeCountry=US. A list of country codes is available from many
publicly available web sites.
c. Find the entry _localeLanguage=, and assign it a lowercase 2-character ISO-639 language
code. For example: _localeLanguage=en. A list of language codes is available from many
publicly available web sites.
d. Save the file and restart SiteScope.
3. View SiteScope user interface in a specific language
Select a language preference for viewing the SiteScope user interface.
For details on how to perform this task, see "How to View SiteScope User Interface in a Specific
Language" below.
4. Results
SiteScope is configured to work with multiple foreign character sets, the time and data settings are
displayed in a locale-specific format, and the user interface is displayed in a foreign language.

How to View SiteScope User Interface in a Specific Language
This task describes how to select a language preference for viewing the SiteScope user interface.
Note: For a list of supported languages, see "Multi-Lingual User (MLU) Interface Support" on page
761.
1. Install the required language's fonts on your local machine if they have not yet been installed. If
you choose a language in your Web browser whose fonts have not been installed, the SiteScope
user interface uses the default language of your local machine.
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For example, the default language on your local machine is English and the Web browser is
configured to use Japanese. If Japanese fonts are not installed on the local machine, the
SiteScope user interface is displayed in English.
2. If you use Internet Explorer, configure the Web browser on your local machine as follows:
a. Select the language in which you want to view the SiteScope user interface. For details, see
http://support.microsoft.com/kb/306872/en-us.
b. Proceed to step 4.
3. If you use FireFox, configure the Web browser on your local machine as follows:
a. Select Tools > Options > Advanced. Click Edit Languages. The Language dialog box
opens.
b. Select the language in which you want to view SiteScope.
If the language you want is not listed in the dialog box, expand the Select language to add...
list, select the language, and click Add.
c. Click Move Up to move the selected language to the first row.
d. Click OK to save the settings and to close the Language dialog box.
4. Click Logout at the top of the SiteScope window. SiteScope refreshes and the user interface is
displayed in the selected language.

Tips/Troubleshooting
This section contains troubleshooting and limitations for the following issues relating to working with
SiteScope in an internationalization environment.
l

"General Limitations" below

l

"Multi-Lingual User Interface Issues" on the next page

l

"Database Environment Issues" on the next page

l

"Remote UNIX Servers Not Configured For an English Locale" on page 767

General Limitations
l

User name, password, and URLs must be in English characters.

l

The machine on which SiteScope is installed (SiteScope machine) and the monitored machine
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must have the same locale. English is the default locale.
l

l

l

l

l

l

The SiteScope machine can have a non-English locale in addition to English. For example, the
monitored machine supports the German locale while the SiteScope machine supports German and
English. For details on setting a non-English locale, see "How to Configure SiteScope for a NonEnglish Locale" on page 763.
When deploying the Web Script Monitor, script names and transaction names must also be in
English characters.
Script monitor on Red Hat ES4 does not support parameters in any language other than English.
SiteScope always uses "en_US" locale for parsing dates retrieved from remote UNIX machines (for
example, during a File monitor run). If the UNIX machine's default locale is different from en_US, in
the definition of the UNIX remote for this machine, the Initialize Shell Environment field must
contain "LANG=C; export LANG".
SiteScope Management reports do not support non-English labels.
If SiteScope is installed on a non-English operating system, you cannot use the SiteScope
Hardening Tool to configure SiteScope for using TLS. In that case, use the manual procedure
described in the appendix section of the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

Multi-Lingual User Interface Issues
l

l

l

There is no language pack installation. All translated languages are integrated into SiteScope Multilingual User interface (MLU).
Data stays in the language it was entered in, even if the language of the Web browser changes.
Changing the language of the Web browser on your local machine does not change the language of
monitor definitions and configurations.
Names of entities included with the SiteScope installation, such as template examples, solution
templates, views, and health monitors, are in English only.

Database Environment Issues
l

l

When you create a new Oracle instance in an Oracle database, you must specify the character set
for the instance. All character data, including data in the data dictionary, is stored in the instance's
character set.
The Database Query Monitor can connect to an Oracle database but the Oracle user names and
passwords must contain only English characters.
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Remote UNIX Servers Not Configured For an English Locale
l

The File Monitor and Directory Monitor may fail when using UNIX remote servers that are not
configured by default for an English locale or language. Workaround: Add "LANG=C; export
LANG" to the Initialize Shell Environment property of the problematic UNIX remote server.

UNIX Resources Monitor Not Getting all Counters For a Non-English Locale
l

Problem: The UNIX Resources monitor is unable to get counters for file systems or inode cache
objects when monitoring a UNIX remote server running on a Linux operating system with a nonenglish locale.
Resolution: Enter export LANG=en_EN.UTF-8 in the Initialize shell environment field for the
UNIX remote server.
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SiteScope authentication is based on a concept of authentication strategies. Each strategy handles
authentication against a specific authentication service. Only one authentication service can be
configured with SiteScope at any given time.
The default authentication strategy for logging on to SiteScope is the SiteScope internal authentication
service. In addition, SiteScope supports the following Single Sign-On methods: Lightweight Single
Sign-On (LW-SSO) and Lightweight Directory Access Protocol (LDAP).

Learn About
Authentication Strategies Overview
The SiteScope internal authentication service is the default authentication strategy for logging on to
SiteScope. You enter your SiteScope user name and password from the login page, and your
credentials are stored and verified by SiteScope.
SiteScope also supports Single Sign-On (SSO), a method of access control that enables a user to log
on once and gain access to the resources of multiple software systems without being prompted to log
on again. The applications inside the configured group of software systems trust the authentication,
and there is no need for further authentication when moving from one application to another.
SiteScope supports the following SSO authentication strategies:
l

Lightweight Single Sign-On (LW-SSO). This is the default single sign-on authentication strategy
for SiteScope. LW-SSO is embedded in SiteScope and does not require an external machine for
authentication. After installing SiteScope, you should immediately change the default passphrase
string for all HP software applications integrated using LW-SSO. For details on changing the default
SSO value in SiteScope, see "How to change the LW-SSO string in SiteScope" on page 772.
For more details on LW-SSO, including limitations, security warnings, and general reference, see
"LW-SSO Authentication" below.

l

Lightweight Directory Access Protocol (LDAP). You can configure authentication using the
Lightweight Directory Access Protocol (LDAP). This enables you to use an external LDAP server to
store authentication information (user names and passwords). SiteScope uses the LDAP server to
verify a user's credentials. You enable and disable LDAP authentication from User Management
Preferences. For details, see "LDAP Authentication and Authorization" on page 771 .

LW-SSO Authentication
LW-SSO is a method of access control that enables a user to log on once and gain access to the
resources of multiple software systems without being prompted to log on again. The applications inside
the configured group of software systems trust the authentication, and there is no need for further
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authentication when moving from one application to another.
The information in this section applies to LW-SSO version 2.4.
LW-SSO Token Expiration
The LW-SSO Token's expiration value determines the application's session validity. Therefore, its
expiration value should be at least the same value as that of the application session expiration value.
Recommended Configuration of the LW-SSO Token Expiration
Each application using LW-SSO should configure token expiration. The recommended value is 60
minutes. For an application that does not require a high level of security, it is possible to configure a
value of 300 minutes.
GMT Time
All applications participating in an LW-SSO integration must use the same GMT time with a maximum
difference of 15 minutes.
Multi-domain Functionality
Multi-domain functionality requires that all applications participating in LW-SSO integration configure
the trustedHosts settings (or the protectedDomains settings), if they are required to integrate with
applications in different DNS domains. In addition, they must also add the correct domain in the lwsso
element of the configuration.
Get SecurityToken for URL Functionality
To receive information sent as a SecurityToken for URL from other applications, the host application
should configure the correct domain in the lwsso element of the configuration.

LW-SSO System Requirements
The following table lists LW-SSO configuration requirements:
Application

Version

Java

1.5 and higher

HTTP Sevlets API

2.1 and higher

Internet Explorer

6.0 and higher

Browser should enable HTTP session cookie and HTTP
302 Redirect functionality

FireFox

2.0 and higher

Browser should enable HTTP session cookie and HTTP
302 Redirect functionality

JBoss
Authentications

JBoss 4.0.3
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Application

Version

Tomcat
Authentications

Standalone
Tomcat 6.0.29

Acegi
Authentications

Acegi 0.9.0

Spring Security
Authentication

Spring Security
2.0.4

Web Services
Engines

Axis 1 - 1.4

Comments

Acegi 1.0.4

Axis 2 - 1.2
JAX-WS-RI 2.1.1

LW-SSO Security Warnings
This section describes security warnings that are relevant to the LW-SSO configuration:
l

Confidential InitString parameter in LW-SSO. LW-SSO uses Symmetric Encryption to validate
and create a LW-SSO token. The initString parameter within the configuration is used for
initialization of the secret key. An application creates a token, and each application using the same
initString parameter validates the token.
Caution:

l

l

n

It is not possible to use LW-SSO without setting the initString parameter.

n

The initString parameter is confidential information and should be treated as such in terms
of publishing, transporting, and persistency.

n

The initString parameter should be shared only between applications integrating with each
other using LW-SSO.

n

The initString parameter should have a minimum length of 12 characters.

Enable LW-SSO only if required. LW-SSO should be disabled unless it is specifically required.
Level of authentication security. The application that uses the weakest authentication framework
and issues a LW-SSO token that is trusted by other integrated applications determines the level of
authentication security for all the applications.
It is recommended that only applications using strong and secure authentication frameworks issue
an LW-SSO token.

l

Symmetric encryption implications. LW-SSO uses symmetric cryptography for issuing and
validating LW-SSO tokens. Therefore, any application using LW-SSO can issue a token to be
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trusted by all other applications sharing the same initString parameter. This potential risk is
relevant when an application sharing an initString either resides on, or is accessible from, an
untrusted location.
User mapping (Synchronization). The LW-SSO framework does not ensure user mapping
between the integrated applications. Therefore, the integrated application must monitor user
mapping. We recommend that you share the same user registry (as LDAP/AD) among all integrated
applications.

l

Failure to map users may cause security breaches and negative application behavior. For example,
the same user name may be assigned to different real users in the applications.
In addition, in cases where a user logs onto an application (AppA) and then accesses a second
application (AppB) that uses container or application authentication, the failure to map the user will
force the user to manually log on to AppB and enter a user name. If the user enters a different user
name than was used to log on to AppA, the following behavior can arise: If the user subsequently
accesses a third application (AppC) from AppA or AppB, then they will access it using the user
names that were used to log on to AppA or AppB respectively.
Identity Manager. Used for authentication purposes, all unprotected resources in the Identity
Manager must be configured with the nonsecureURLs setting in the LW-SSO configuration file.

l

LW-SSO Demo mode.

l

n

The Demo mode should be used for demonstrative purposes only.

n

The Demo mode should be used in unsecured networks only.

n

The Demo mode may not be used in production. Any combination of the Demo mode with the
production mode should not be used.

LDAP Authentication and Authorization
You can choose to configure authentication using the Lightweight Directory Access Protocol (LDAP).
This enables you to use an external LDAP server to store authentication information (user names and
passwords). SiteScope uses the LDAP server to verify a user's credentials.
Storing information on an LDAP server makes it easier to manage large numbers of users across many
SiteScopes. When using LDAP authentication, you can create user role profiles to make managing
user permissions more efficient. Instead of assigning access permissions to each user one at a time,
you can group users who are assigned the same permissions levels on the same resources to the
same user role profile. For details on user roles, see "User Management Preferences" on page 732.
In addition to creating and assigning user roles and managing users outside of SiteScope, a SiteScope
administrator can also save the list of all LDAP users that have permissions to log on to SiteScope to a
CSV file.
For details on enabling LDAP authentication and creating user roles, see "How to enable SiteScope to
use LDAP authentication" on page 773.

HP SiteScope (11.31)

Page 771 of 1395

Using SiteScope
Chapter 58: Authentication Strategies

Note:
l

l

l

The audit log contains only the user name (Displayed Name), and not the user role or LDAP
group (User role context or LDAP context).
When a user logs on using LDAP authentication, the user is created for one SiteScope session
only. When the session ends, the user is deleted (not saved in persistency).
LDAP authentication does not work in a nested Active Directory environment.

Tip: You can view a guided and narrated demonstration for managing SiteScope users centrally in
LDAP on YouTube: http://www.youtube.com/watch?v=rntIjPOqdJs&feature=plcp.
Silent Authentication
You can also configure authentication via certificates that are stored in the browser or a smart card via
client certificate authentication. This is an automatic process that launches SiteScope without having
to enter the user login name and password in the SiteScope login page.
When you supply the certificate or enter a smart card, SiteScope takes the unique attributes from the
certificate/smart card and uses the LDAP server to verify a user's credentials. When it finds the user, it
logs on automatically using the LDAP user credentials.
For details, see "How to Configure Silent Login When Using LDAP Authentication" on page 775.

Tasks
How to change the LW-SSO string in SiteScope
After installing SiteScope, you should immediately change the default passphrase string for all HP
software applications integrated using LW-SSO.
l

l

In applications other than SiteScope, locate the lwssofmconf.xml file and change the value
directly in that file.
In SiteScope, you can do this directly in the <SiteScope root
directory>\conf\lwsso\lwssofmconf.xml file (only before the first time the service is loaded). You
can also change the value in Preferences > General Preferences > LW SSO Settings > LW
SSO Init String.
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How to enable SiteScope to use LDAP authentication
This task describes the steps involved in using LDAP authentication and authorization for logging on to
SiteScope. For concept details, see "LDAP Authentication and Authorization" on page 771.
Tip: You can view a guided and narrated demonstration for managing SiteScope users centrally in
LDAP on YouTube: http://www.youtube.com/watch?v=rntIjPOqdJs&feature=plcp.
1. Prerequisites
n

When using LDAP to access SiteScope, users must have a user login and security principal
assigned to them on the LDAP server. For details, contact your LDAP server administrator.

n

You must be an administrator in SiteScope, or a user granted Add, edit or delete user
preferences permissions to be able create or make changes to SiteScope LDAP user
management settings and permissions. A regular user does not have Add, edit or delete user
preferences permissions by default. For user interface details, see "New/Edit User Profile
Dialog Box" on page 741.

n

To use LDAP when using an SSL connection, you need to import a certificate from the LDAP
server. (Obtain a digital certificate issued by a Certificate Authority. If your organization does
not currently have a digital certificate for this purpose, you need to make a request to a
Certificate Authority to issue you a certificate.)

2. Enable SiteScope to use LDAP authentication
a. In SiteScope, select Preferences > User Management Preferences, click the arrow next to
Default Settings, and select Edit. The User Management Settings dialog box opens,
displaying the LDAP User Management settings. For user interface details, see "User
Management Settings Dialog Box" on page 739.
Note: When using an SSL connection, you must enter the secure LDAP server URL in
the LDAP server URL box. For example, ldaps://ldap.mydomain.com:636
b. Select the Enable LDAP Authentication check box, and configure the LDAP Authentication
settings.
Tip: We recommend that you contact your LDAP server administrator for assistance
when configuring these settings.
c. To test the LDAP connection, click the arrow next to Default Settings, and select Test. The
test status is returned (if the test is successful, the number of LDAP users is displayed).
Note: All users in this LDAP will get viewer permissions without being part of any viewer
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role if Enable viewer permissions for all LDAP users is selected in the User
Management Settings dialog box.
3. Create an LDAP user role profile
In the User Management Preferences page, click the arrow next to the New User
button,
and select New User Role. Enter the user role name, the LDAP security group (context), select
the groups that can be accessed by this user role profile, and select the permissions granted to
this user role.
For user interface details, see "New/Edit User Role Profile Dialog Box" on page 756.
4. Copy an existing user's permissions to a user role - optional
You can copy an existing SiteScope user's permissions to a new user role. This enables you to
assign the same permissions as the user role when creating or editing a user profile.
a. In the User Management Preferences page, select a user from which you want to copy
permissions to a user role and select Copy > Copy to User Role.
b. In the New User Role Profile dialog box, enter a name and context for the new user role and
save it. For user interface details, see "New/Edit User Role Profile Dialog Box" on page 756.
c. The permissions of the selected user are copied to the user role, which is added to the User
Management Preferences page as a Regular User Role or Super User Role type
(depending on the permissions granted). For user interface details, see "User Management
Preferences Page" on page 736.
5. Log off of SiteScope
Click the Logout button to log out of SiteScope.
6. Log on to SiteScope
When using LDAP to access SiteScope, users can access SiteScope in the usual ways. For
details, see "Log into SiteScope" on page 18.
Note: SiteScope users still need to have a SiteScope login name and password defined,
which they must enter in the SiteScope Login page. (LDAP users have their own LDAP user
name and password for logging on to SiteScope.)
7. Results
After a user enters their login name and password in the SiteScope Login page (or uses silent
login), SiteScope sends a request to LDAP.
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If the request returns confirmation of the user and the user's groups match the user role definition,
the relevant user role permissions are ascribed to the user, and SiteScope opens to the Dashboard
view.

How to Configure Silent Login When Using LDAP Authentication
This task describes the steps involved in configuring silent login to SiteScope via client certificate
authentication.
1. Obtain Client Certificate
Obtain a digital certificate issued by a Certificate Authority. If your organization does not currently
have a digital certificate for this purpose, you need to make a request to a Certificate Authority to
issue you a certificate.
2. Configure the server certificate properties
Enable silent login by making changes to the configuration files used by the Tomcat server.
a. Open the server.xml file that is located in the <SiteScope root directory>\Tomcat\conf
directory.
b. Locate the section of the configuration file that looks like the following:
<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<!-<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />
-->

c. Change this section to the following, and enter the required parameters:
<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
sslProtocol="TLS"
keystoreFile="<Keystore_file_path>"
keystorePass="<Keystore_password>" keystoreType="<Keystore_type>"
keyAlias="<Keystore_alias>"
truststoreFile="<truststore_File>" truststorePass="<truststore_password>"
truststoreType="<truststore_type>"
clientAuth="true" />
/>
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For example:
<!-- Define a SSL HTTP/1.1 Connector on port 8443 -->
<Connector port="8443"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
sslProtocol="TLS"
keystoreFile="c:\myclientstore.p12"
keystorePass="testing" keystoreType="PKCS12" keyAlias="client"
truststoreFile="..\java\lib\security\cacerts"
truststorePass="changeit" truststoreType="JKS" clientAuth="true" />
/>

Note: If there are other HP products installed on the same server as SiteScope, you
might need to change port 8443 to another port to avoid conflict.
Tomcat log output is written to the <SiteScope root dir>\logs\
tomcat.log file. Settings for the log file can be configured from the
<SiteScope root dir>\Tomcat\common\classes\log4j.properties file.
d. After setting up SSL access on port 8443, restrict unsecured access to SiteScope by
commenting out the Define a non-SSL HTTP/1.1 Connector on port 8080 section.
3. Import server certificate to SiteScope
Use Certificate Management to import the Certificate Authority certificate. Select Preferences >
Certificate Management, and click the Import Certificates button. Select File or Host, and enter
the details of the source server.
For user interface details, see "Certificate Management Page" on page 544.
Note: Only a SiteScope administrator user, or a user with View/Edit certificates list
permissions can view, add, or make changes to the certificates keystore on the Certificate
Management page.
4. Configure the LDAP user management settings
a. Configure the settings in the LDAP User Management Settings panel. For user interface
details, see "User Management Settings Dialog Box" on page 739.
b. In the LDAP User Management Advanced Settings panel, you can enter a unique attribute
for the LDAP user in the LDAP activation key identification attribute box (or you can leave
it blank, in which case, the userPrincipalName attribute is used).
5. Results
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When a user attempts to log on to SiteScope using silent login, SiteScope sends a request to
LDAP. If the request returns confirmation of the user and the user's groups match the user role
definition, the relevant user role permissions are ascribed to the user, and SiteScope opens to the
Dashboard view.
The user name displayed in SiteScope is taken from the user's personal name on the user
certificate.
Note:
n

The user is created for one SiteScope session only. When the session ends, the user is
deleted (not saved in persistency).

n

When you log off of SiteScope (by clicking the Logout button), the silent login parameter
(sis_silent_login_type_default) is displayed in the URL. You must remove this
parameter before you can log back on to SiteScope using the refresh action.

Tips/Troubleshooting
This section contains the troubleshooting and limitations for LW-SSO authentication.
l

"LW-SSO Known Issues" below

l

"LW-SSO Limitations" on the next page

l

"LDAP Limitations" on page 780

LW-SSO Known Issues
This section describes known issues for LW-SSO authentication.
l

Security context. The LW-SSO security context supports only one attribute value per attribute
name.
Therefore, when the SAML2 token sends more than one value for the same attribute name, only one
value is accepted by the LW-SSO framework.
Similarly, if the IdM token is configured to send more than one value for the same attribute name,
only one value is accepted by the LW-SSO framework.

l

Multi-domain logout functionality when using Internet Explorer 7. Multi-domain logout
functionality may fail under the following conditions:
The browser used is Internet Explorer 7 and the application is invoking more than three consecutive
HTTP 302 redirect verbs in the logout procedure.
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In this case, Internet Explorer 7 may mishandle the HTTP 302 redirect response and display an
Internet Explorer cannot display the webpage error page instead.
As a workaround, it is recommended to reduce, if possible, the number of application redirect
commands in the logout sequence.

LW-SSO Limitations
Note the following limitations when working with LW-SSO authentication:
Client access to the application.

l

If a domain is defined in the LW-SSO configuration:
n

The application clients must access the application with a Fully Qualified Domain Name (FQDN)
in the login URL, for example, http://myserver.companydomain.com/WebApp.

n

LW-SSO cannot support URLs with an IP address, for example, http://192.168.12.13/WebApp.

n

LW-SSO cannot support URLs without a domain, for example, http://myserver/WebApp.

If a domain is not defined in the LW-SSO configuration: The client can access the application
without a FQDN in the login URL. In this case a LW-SSO session cookie is created specifically for a
single machine without any domain information. Therefore, the cookie is not delegated by the browser
to another, and does not pass to other computers located in the same DNS domain. This means that
LW-SSO does not work in the same domain.
LW-SSO framework integration. Applications can leverage and use LW-SSO capabilities only if
integrated within the LW-SSO framework in advance.

l

Multi-Domain Support.

l

n

Multi-domain functionality is based on the HTTP referrer. Therefore, LW-SSO supports links from
one application to another and does not support typing a URL into a browser window, except when
both applications are in the same domain.

n

The first cross domain link using HTTP POST is not supported.
Multi domain functionality does not support the first HTTP POST request to a second application
(only the HTTP GET request is supported). For example, if your application has an HTTP link to a
second application, an HTTP GET request is supported, but an HTTP FORM request is not
supported. All requests after the first can be either HTTP POST or HTTP GET.

n

LW-SSO Token size:
The size of information that LW-SSO can transfer from one application in one domain to another
application in another domain is limited to 15 Groups/Roles/Attributes (note that each item may be
an average of 15 characters long).
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n

Linking from Protected (HTTPS) to non-protected (HTTP) in a multi-domain scenario:
Multi domain functionality does not work when linking from a protected (HTTPS) to a nonprotected (HTTP) page. This is a browser limitation where the referer header is not sent when
linking from a protected to a non-protected resource.

n

Third-Party cookie behavior in Internet Explorer:
Microsoft Internet Explorer 6 contains a module that supports the "Platform for Privacy
Preferences (P3P) Project," meaning that cookies coming from a third-party domain are by default
blocked in the Internet security zone. Session cookies are also considered third-party cookies by
IE, and therefore are blocked, causing LW-SSO to stop working.
To solve this issue, add the launched application (or a DNS domain subset as *.mydomain.com)
to the Intranet/Trusted zone on your computer (in Microsoft Internet Explorer, select Menu >
Tools > Internet Options > Security > Local Intranet > Sites > Advanced), which causes the
cookies to be accepted.
Caution: The LW-SSO session cookie is only one of the cookies used by the third-party
application that is blocked.
SAML2 token.

l

n

Logout functionality is not supported when the SAML2 token is used.
Therefore, if the SAML2 token is used to access a second application, a user who logs out of the
first application is not logged out of the second application.

n

The SAML2 token's expiration is not reflected in the application's session management.
Therefore, if the SAML2 token is used to access a second application, each application's session
management is handled independently.

l

JAAS Realm. The JAAS Realm in Tomcat is not supported.

l

Using spaces in Tomcat directories. Using spaces in Tomcat directories is not supported.
It is not possible to use LW-SSO when a Tomcat installation path (folders) includes spaces (for
example, Program Files) and the LW-SSO configuration file is located in the common\classes
Tomcat folder.

l

l

Load balancer configuration. A load balancer deployed with LW-SSO must be configured to use
sticky sessions.
Demo mode. In Demo mode, LW-SSO supports links from one application to another but does not
support typing a URL into a browser window, due to an HTTP referrer header absence in this case.
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LDAP Limitations
LDAP authentication does not work in a nested Active Directory environment.
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Part 8: User-Defined Content
SiteScope supports the ability to create and publish reusable templates and content packages,
enabling you to rapidly set up and deploy multiple IT elements with similar monitoring configuration
criteria.
Templates are used to standardize a set of monitor types and configurations into a single structure.
This structure can then be repeatedly deployed as a group of monitors targeting multiple elements of
the monitored environments that share similar characteristics. For details, see "Create Templates" on
page 782.
Content packages are used for sharing user-defined templates that contain Custom monitors or regular
monitors that reference a script or alert template file. You create content packages using the Export
Content Package Wizard. A content package can include one or more templates and their
dependencies. Dependencies are additional files such as jars and configuration files that are required
for running the monitor. For details, see "Create Content Packages" on page 825.
You can export and import templates and content packages for use in other SiteScope installations.
This enables you to replicate standardized monitor configurations across the enterprise. For details,
see "Export and Import Templates and Content Packages" on page 826.
You can also share templates and content packages with other SiteScope users by publishing them to
the HP Live Network. For details, see "Share SiteScope Content on the HP Live Network" on page
892.
After creating a SiteScope monitoring template, you can deploy the templates to a group. For details,
see "Deploy Templates" on page 847. SiteScope also enables you to automatically deploy a SiteScope
template (or solution template) using an XML file external to the SiteScope user interface. For details,
see "Deploy Templates Automatically Using an XML File" on page 861.
After deploying a template, you can make changes to the template and automatically publish those
changes to all SiteScope objects deployed by the template using the Publish Template Changes
Wizard. For details, see "Publish Changes to Templates" on page 877.
For troubleshooting and limitations when working with user-defined templates, see
"Tips/Troubleshooting" on page 784.
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SiteScope templates provide an enterprise solution for standardizing the monitoring of the different IT
elements in your enterprise into a single reusable structure. You use templates to rapidly deploy sets of
monitors that check systems in the infrastructure that share similar characteristics.
This section includes information on user-defined templates. For information on SiteScope's predefined
solution templates that feature built-in domain expertise, see "Solution Templates" on page 895.
Note: SiteScope also contains Monitor Deployment Wizard templates that can be used when
SiteScope is connected to BSM. For details, see the Monitor Deployment Wizard section in the
BSM Application Administration Guide in the BSM Help.

Learn About
Creating Templates Overview
Templates are objects you use to reproduce groups, monitors, servers, and alerts according to a
predefined pattern and configuration (see "Template Objects" on page 787). You can also use variables
within templates as substitution markers for configuration settings that you want to change dynamically
or interactively each time you deploy the template (see "Template Variables" on page 790).
You can create templates using one of the following methods:
l

l

Copy an existing group and monitor hierarchy from a SiteScope to a template and edit the elements
for use as a template. For details, see "How to Create a Template by Copying Existing
Configurations" on page 801.
Manually create template groups, monitors, servers, and alerts in the template. For details, see
"How to Create a Monitoring Structure Using a Template" on page 794.

After you create and configure a template, the template objects are displayed in the template tree. From
there, you can deploy all of the items defined in the template in a single operation by copying the
template to a location in the SiteScope hierarchy. For details on deploying templates, see "Deploy the
template" on page 799.
You can also make changes to the source template, and automatically publish the changes to
SiteScope objects deployed by the template using the Publish Template Changes Wizard. For details
on updating templates, see "Publish Changes to Templates" on page 877.
You can export and import templates and content packages for use in other SiteScope installations
(content packages consist of templates and their dependency files that are required for sharing Custom
monitors with other SiteScope users). This enables you to share content and replicate standardized
monitor configurations across the enterprise. For details, see "Export and Import Templates and
Content Packages" on page 826.
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Tip:
l

l

l

l

Effective development and use of templates requires some planning because you can add
multiple objects types to the template. For more information, see "Planning Templates" on
page 789.
If SiteScope monitoring has not yet been configured and you are not familiar working with
SiteScope monitors and groups, set up some sample groups, monitors, and alerts before you
create templates. This helps familiarize you with the monitor configurations and the relationship
between monitors, groups, and alerts. Afterward, you can copy the structure from the
SiteScope and convert the configurations to a template.
To help you get started with templates, SiteScope provides example templates for monitoring
in Windows and UNIX environments. For details, see "Template Examples" on page 788.
When creating a template which includes monitors that use a Get Counters/Measurements
browser function to monitor measurements specific to the target system, additional steps are
required for selecting counters when deploying templates. For details, see "Select Browsable
Monitor Counters in Monitor Templates" on page 801.

Advantages of Using Templates
l

l

l

l

Templates can be repeatedly deployed as a group of monitors targeting multiple elements of the
monitored environments.
Templates speed the deployment of monitors across the enterprise through the single-operation
deployment of groups, monitors, alerts, remote servers, and configuration settings.
Templates provide the ability to view how the actual monitored deployments comply with the
standardized deployment as defined in the template. This ensures that any changes in the
monitored environment can be quickly updated in the monitoring infrastructure and that the
monitoring infrastructure is still compliant with the standards set in the template.
Templates can be silently deployed in the background without having to wait for the template
deployment process to finish. If SiteScope restarts before all requests in the queue are complete, it
automatically continues the deployment process after the restart.

Benefits of user-defined templates:
l

l

l

You can create and customize your own templates to meet the requirements of your organization.
You can make changes to a template, and publish the changes to all SiteScope objects deployed by
the template. If a change is required to a template object, you can update the template once and
publish the changes to all deployed groups. For details, see "Publish Changes to Templates" on
page 877.
You can deploy multiple templates simultaneously from the SiteScope user interface or from an
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external CSV file. For details, see "Deploy Templates" on page 847. You can also deploy templates
automatically using an XML file external to the SiteScope user interface. For details, see "Deploy
Templates Automatically Using an XML File" on page 861.
l

l

You can share your templates with other SiteScope users by publishing them to the HP Live
Network. For details, see "Share SiteScope Content on the HP Live Network" on page 892.
You can use SiteScope APIs to create, deploy, and manage templates. For details, see "SOAPbased APIs" on page 159.

Tips/Troubleshooting
This section describes tips, troubleshooting and limitations when working with user-defined templates.
l

"User-Defined Templates Tips/Troubleshooting" below

l

"Templates and Template Containers:" below

l

"Template Monitors and Groups:" below

l

"Template Remotes:" on the next page

l

"Template Variables:" on page 786

l

"Template Alerts:" on page 786

l

"Deleting Templates:" on page 786

l

"Reserved Template Group Types" on page 786

User-Defined Templates Tips/Troubleshooting
Templates and Template Containers:
l

l

l

Template containers can be added only to the SiteScope node in the template tree.
A user can only access the template containers for which they have permissions in the Allowed
template containers list (in Preferences > User Management Preferences > <selected_user>
> Main Settings).
A template can have only one template group directly under it (the parent group).

Template Monitors and Groups:
l

Some fields that contain drop-down lists when configuring objects in normal mode, are displayed as
text boxes when configuring the object in template mode.
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l

l

l

l

l

l

l

l

By default, monitors must be created in a template group. You can override this setting in
Preferences > Infrastructure Preferences > Template Settings by selecting Allow creation of
template monitors directly under a template entity.
You can also define a template subgroup so that its content is not a part of the template, and is
ignored, when publishing changes to deployed groups. This enables deploying templates inside
different deployed groups. For details, see Ignore group when publishing changes in General
Settings.
Template monitors are not active monitor instances. Monitors are created and activated based on
these template configurations only when you deploy the template.
Do not use "\\" in the monitor Server field, and in the remote server Name and Server fields.
When using regular expressions to select metrics counters or match thresholds, SiteScope checks
only whether one string is a substring of another, rather than performing an equality check. This
means that the incorrect set of metrics and thresholds could be defined in the monitor after
deployment. This is because SiteScope, by default, treats every metric in the metrics table as a
regular expression, and matches the threshold setting with all metrics that fit this expression. For
example, if the chosen monitor threshold is x/y, and x/yy also matches the regular expression, this
threshold is also defined. To avoid this, add specific regular expressions to meet your exact
requirements.
When adding a Search/Filter tag to a template monitor, you cannot use both actual parameters and
variable parameters in the same tag values group.
When deploying a Script monitor from a template, the case of the remote script name must match
that of the script name in the scripts subdirectory. Otherwise, the selected script is shown as
'none'.
The Network Bandwidth monitor's non-default thresholds are not copied properly to a template.

Template Remotes:
l

l

l

l

You can add only one remote server to a template.
You cannot delete a server from the remote servers list if the server is referenced by a template
monitor. Select a different server in the Server box of the Monitor Settings panel for each monitor
that references the remote server, and then delete the remote server from the remote server list.
You cannot replace an existing monitor target server using the Publish Template Changes wizard or
auto deployment update (see Publishing Template Changes Using the XML), although you can
change property values of the target server itself, if required.
If a remote server is specified with a variable name with no additional characters prefixed or suffixed
to it (for example, %%hostname%%), and the same variable is specified for any field in a monitor, after
deployment the value appears as Remote-## on UNIX and \\<variable_value> on Windows,
instead of just the variable value that was specified on deployment. To avoid this, where a variable
name is used for a remote server, additional characters should be prefixed or suffixed to the name.
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l

l

A template monitor can run on servers that are defined by template servers at the time of template
deployment or on servers defined manually in the Remote Servers container of the remote server
tree. Whichever is the case, the value in the Server box must match the host name of an actual
server at the time that the template is deployed after values have been substituted for the template
variables. If the server name does not match the host name of a real server, the monitor fails. To
automatically retrieve the template remote server name (if one was created), select the Use
already configured template remote under current template check box in the Monitor Settings
field. For user interface details, see "New Template Monitor Dialog Box" on page 821.
If the template monitor was configured with explicit counter selections that can be matched using
the regular expression that was entered, you can delete the extra counter strings by clicking the
Delete Counter button.

Template Variables:
l

l

l

When configuring variables for Frequency and Error frequency in the Monitor Run Settings, the
variable values can only be in time units of seconds.
When a monitor is copied or moved from one template to another, any user-defined variables in the
monitor are also copied or moved.
If you change the name of an assigned template variable, all monitors using that variable are
automatically updated to use the new variable name.

Template Alerts:
l

You cannot select the Disable or Enable Monitors alert action when creating an alert template.
Template alerts are enabled for all the monitors belonging to the object for which they were defined.
For example, if an alert is defined for a monitor, then it is activated on that monitor only. If an alert is
defined for a template, then it is activated for all the monitors in the template.

Deleting Templates:
l

To delete a template or template container after deploying templates, you must first delete each
group to which the templates were deployed in the monitor tree, and then you can delete the
template or template container.

Reserved Template Group Types
The following table shows template types used by the SiteScope application. The templates in these
directories are reserved, and are not used by alerts. For a list of templates used in alerts, see "Alert
Template Directories" on page 1297.
Tip: We do not recommend modifying the templates in these directories without following the
specific procedures provided in the product documentation or as instructed by HP Software
Support.
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Template
Group

Description

Location

MIB

Text used with SNMP traps

<SiteScope root directory>\
templates.mib

Operating
System

Shell commands to be run when monitoring remote
UNIX servers

<SiteScope root directory>\
templates.os

Performance
Monitor

Used for Windows performance monitoring

<SiteScope root directory>\
templates.perfmon

Sound

Audio files used for sound alerts

<SiteScope root directory>\
templates.sound

View

Query and XML/XSL templates

<SiteScope root directory>\
templates.view

Template Objects
Templates are created and stored in a template container in the template tree. The template variable
definitions and SiteScope objects configurable using the template are displayed as objects within the
template.
The following table describes the objects used in templates:
Object
Icon Type

Description

Template A template container enables you to manage your template monitoring solutions.
Container You can add a template to a template container only. For details on configuring
this object, see "New Template Container Dialog Box" on page 810.
Template

The template contains the SiteScope group, monitors, remote servers, variable
definitions, and alerts that make up the template monitoring solution. For details
on configuring this object, see "New Template Dialog Box" on page 811.

Template
Variable

A variable is used to prompt for user input during template deployment. Template
variables are either user-defined or predefined system variables. For details on
configuring this object, see "New Variable Dialog Box" on page 813.

Template
Remote
Server

A template remote server is used to define Windows or UNIX remote server
preferences that are created when the template is deployed. For details on
configuring this object, see "New Template Remote Server Dialog Box" on page
814.
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Object
Icon Type

Description

Template
Group

A template group contains the template monitors and associated alerts. You use
template groups to manage the deployment of monitors and associated alerts in
your infrastructure. For details on configuring this object, see "New Template
Group Dialog Box" on page 816.

Template
Monitor

Template monitors are used to define monitors that are created when the
template is deployed. For details on configuring this object, see "New Template
Monitor Dialog Box" on page 821.

Template
Alert

Template alerts are used to define alerts on groups and monitors that are created
when the template is deployed. If an alert has been set up for the template
monitor or group, the alert symbol is displayed next to the monitor or group icon.
For details on configuring this object, see "New Alert Dialog Box" on page 823.

Template Examples
SiteScope provides template examples for monitoring in Windows and UNIX environments. These
templates are available from the Template Examples folder in the template tree. You can use the
template examples to help familiarize you with using SiteScope templates. Among other things, you
can use it to see the following:
l

How template groups, monitors, and remote servers are used

l

The connection between the template remote server and the monitor using it

l

Variable value usage and system variable usage

The following example shows the Windows basic template. The template contains a template group,
Windows monitors for %%host%%, two template monitors (CPU and Memory), four user-defined
variables (host, user, password, and frequency), and a template remote server.
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Planning Templates
Template planning is important for effective SiteScope management. You should consider the group
and monitor relationships and properties in the template structure and how it fits into the overall
monitoring environment.
The following are things to consider as you plan templates:
Object

Consideration

Variable
Decide which monitor configuration properties vary from one template deployment to
properties another. For example, the target server address or resource to be monitored is a
common variable property. Also consider what naming conventions you want to use for
groups and monitors. You use template variables to enter or select values for variable
properties each time you deploy the template. Not all monitor configuration properties
can be configured using variables. For more information, see "Template Variables" on
the next page.
Servers

Decide which servers are the target servers. This is where the objects being monitored
are located. Template servers are replicated automatically when the template is
deployed. You can also define them manually in the Microsoft Windows Remote
Servers or UNIX Remote Servers container of the remote server tree. For more
information, see "Remote Servers" on page 469.

Monitor
types

Decide which monitor types you want to replicate using templates. These should be
monitor types that monitor multiple systems. For example, CPU, Disk, Memory and
Service monitor types are commonly deployed for each server in the infrastructure. You
can also include multiple instances of the Service Monitor type in a template to monitor
different services or processes running on each server.

Common For configuration properties that should be the same from one template deployment to
properties another, you must decide what the values should be. For example, the Frequency
setting is a required setting for each monitor type. The default setting is 10 minutes.
Depending on what is to be monitored and the overall monitor load, you may want to
change this value so that monitors created using the template run more often.
Group
structure

Decide the group structure you want to use to organize the monitors. The organization
groups and monitors in the template should be compatible with your overall plan for
organizing the monitoring in your environment. The group structure you use may affect
reporting, alerting, and monitoring.

Alerts

Decide if you want to deploy alerts as part of the template. Consider which alert types
and actions you want to associate with the templates and monitors. Alerts deployed as
part of a template have their Alert Targets property set to all monitors defined in the
template (see "SiteScope Alerts Page" on page 1265). For example, a template alert
added to a template group alerts on any monitor belonging to that group. If this does not
fit your alerting plan, you must edit the alert configuration after deployment or add alerts
manually.
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Template Variables
While you can create templates without using template variables, the use of variables is central to the
power and utility of templates. Template variables are substitution markers for monitor configuration
settings. You create template variables to represent monitor configuration settings that you want to be
able to modify whenever you deploy the template. You reference the variable in a text box in one or
more template monitors. Each variable that is referenced in a monitor or group object in a template
prompts the display of a corresponding entry box when the template is deployed. The variable name is
used as a label for the text entry box.
Examples of common uses for template variables are:
l

Server or host addresses

l

Disk drive designators

l

File paths

l

Monitor name descriptions
Note: You can see examples of variables used in templates in the Template Examples folder in
the template tree. For details, see "Template Examples" on page 788.

Learn About
This section contains the following topics:
l

"Guidelines for Using Template Variables" below

l

"Variable Syntax" on the next page

l

"Referencing Template Variables" on page 792

Guidelines for Using Template Variables
l

l

Plan and create the template variables before you create other template objects, such as servers
and monitors. This enables you to enter the references to the variables into the template monitors,
groups, or alerts as you add them to the template. Deleting a template variable that has already
been referenced in a template object requires that the referencing object be deleted from the
template to clear the broken reference. For details on referencing template variables, see
"Referencing Template Variables" on page 792.
Some monitor configuration settings cannot be set using template variables. With the exception of
the remote server selection menu, configuration items that are normally selected using a selection
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drop-down cannot be defined using template variables. Configuration items that are normally
selected using a check box or radio selection cannot be configured using template variables.
l

Template variables are always child elements of the template container in which they reside.
Variables can be referenced and used to define configuration settings for group, monitor, or alert
configuration templates within the template. For information about the types of template variables in
SiteScope and the specific syntax conventions, see "Variable Syntax" below.

Variable Syntax
The following types of template variables are available in SiteScope:
l

l

User-defined variables. They are used to enter text-based values during template deployment.
User-defined variables must have the "%%" symbol either side of the variable name.
System variables. A set of predefined variables you use to access both the list of remote servers
known to SiteScope and system time information. System variables must have the "$$" symbol
either side of the variable name.
Note: User-defined and pre-defined system variables are available in all text fields and text table
cells when configuring templates. To display the list of available variables, type either %% or $$
in the field, and select the relevant variable. The variable is then displayed in the field.

Each type of variable has specific syntax conventions which are described in the following sections:

Syntax for User-Defined Variables
User-defined template variables can contain only alphanumeric characters and the underscore
character. You can create as many variables as you need.
Examples of valid template variable syntax:
description_text
DiskDrive
TARGET_URL
matchExpression
Choose variable names that describe the configuration parameter that is represented. The variable
name is used as a label for the variable entry box on the variable value entry window when you deploy
the template.

Syntax for System Variables
SiteScope recognizes several pre-defined template variables. These are values that are known by the
system, including the list of servers for SiteScope, detected servers such as NetBIOS, and userdefined server connection profiles such as remote UNIX. The syntax and description for the pre-defined
system variables are:
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Syntax for
System
Variables

Description

$$SERVER_ Returns a list from which to select one of all the servers known by the platform. Use
LIST$$
this to enable selection of remote servers for Server or Host Name properties only.
Note: When this variable is used in a template, the template cannot be deployed
using the SiteScope API since it requires user interaction.
$$SERVER_ Derived from the $$SERVER_LIST$$ variable. Returns the name of the current server
NAME$$
with \\ (backslashes) before the name. Use when referencing the server in other
boxes.
$$SERVER_ Derived from the $$SERVER_LIST$$ variable. Returns the name of the current server
NAME_
without \\ (backslashes) before the name. Use when referencing the server in a box
BARE$$
requiring just the name of the server (for example, when deploying CPU monitors or
when referencing the name of the server in a description: "Disk space on server
Mail.")
$$DATE$$

Returns the system date on the server where SiteScope is running. Use to add the
date that a monitor was created to a name or description.

$$TIME$$

Returns the system time on the server where SiteScope is running. Use to add the
time that a monitor was created to a name or description. The value represents the
time that the template is deployed.

Referencing Template Variables
After you have added template variables to a template, you must create references to them in a monitor
or group configuration object. The syntax you use to reference a variable depends on the type of
variable.
Variable
Type
Syntax
UserDefined

%%variable_
name%%
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The reference is case sensitive and syntax sensitive.
Note: User-defined template variables must be created before they can
be referenced in monitor or group configuration templates. Using the %%
symbols with a text string that has not already been added to the
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template variable even if a matching variable name is added later.
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Variable
Type
Syntax
System

Information

$$VARIABLE_ The reference is case sensitive and syntax sensitive.
NAME$$
The $$SERVER_LIST$$ variable must be defined explicitly as a variable
in the template. After this variable is defined, the $$SERVER_NAME$$ and
$$SERVER_NAME_BARE$$ variables may be used in configuration objects
by referencing them using the $$VARIABLE_NAME$$ syntax directly in
the monitor or group configuration object.
The $$TIME$$ and $$DATE$$ variables can also be referenced directly.
For information about system variables, see "Variable Syntax" on page
791.

Example: How to reference user-defined variables and the $$SERVER_LIST$$, and the derived
system variables for a monitor template
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How to Create a Monitoring Structure Using a Template
This task describes the steps for creating and publishing reusable templates, enabling you to deploy
multiple IT elements with similar monitoring configuration criteria. It also includes steps for publishing
changes across the entire enterprise to all SiteScope objects deployed by templates, without the need
for extensive manual updates.
Flowchart of this task:

Tip: We recommend that you create template objects in the order listed. You can skip the steps for
any template objects that you do not require. To help you get started with templates, use the
example templates provided for monitoring in Windows and UNIX environments. For details, see
"Template Examples" on page 788.

1.

2.

Prerequisites
n

To be able to add, edit, and delete templates, you must have the View templates and Add,
edit or delete templates permissions.

n

To deploy a template, regardless of its content, you must have edit permissions on the
deployment target group. You do not need edit permissions on the template objects (monitors,
remotes, and alerts). For details on user permissions, see "Permissions" on page 744.

Create a template container
Create a template container to enable you to manage your monitoring solution.
For user interface details, see "New Template Container Dialog Box" on page 810.

3.

Create a template
Add a template to the template container. This is the container for your monitoring solution, in
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which you create groups, monitors, remote server, variables, and alerts for the monitoring solution.
You can create multiple templates in a template container.
For user interface details, see "New Template Dialog Box" on page 811.
Note: You can also copy an existing group and monitor hierarchy from a SiteScope to the
template and edit the elements for use as a template. For task details, see "How to Create a
Template by Copying Existing Configurations" on page 801.

4.

Create template variables
You can create template variables in the template that enable you to specify a different name for
an object every time that you deploy the template. Variables should be the first objects you create
in a template, because they are referred to when you create groups, monitors, servers, and alerts.
a. Create the template variable in the template. For more information on the user interface, see
"New Variable Dialog Box" on page 813.
b. Reference the variable in one or more configuration objects in the template. For more
information on this topic, see "Referencing Template Variables" on page 792.
Note:

5.

o

If a remote server is specified with a variable name with no additional characters
prefixed or suffixed to it (for example, %%hostname%%), and the same variable is
specified for any field in a monitor, after deployment the value appears as Remote-##
on UNIX and \\<variable_value> on Windows, instead of just the variable value that
was specified on deployment. To avoid this, where a variable name is used for a
remote server, additional characters should be prefixed or suffixed to the name.

o

User-defined and pre-defined system variables are available in all the text fields and
text table cells when configuring templates. To display the list of available variables,
type either %% or $$ in the field, and select the relevant variable. The variable is then
displayed in the field.

Create a template remote server
In the template, you can define a remote Windows or UNIX server where the monitored objects
are located. A template monitor may run on servers that are defined by template servers at the
time of template deployment or on servers defined manually in Remote Servers. Template servers
are added to the remote server tree under Microsoft Windows Remote Servers or UNIX Remote
Servers when the template is deployed.
For user interface details, see "New Template Remote Server Dialog Box" on page 814.
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Note: You can add only one remote server to a template.

Example: A Windows template remote server has been created with the name %%host%%
remote windows.

6.

Create a template group
In the template, create a template group to make the deployment of monitors and associated alerts
manageable and effective for your organization.
For user interface details, see "New Template Group Dialog Box" on page 816.
Note:
n

By default, monitors must be created in a template group. You can override this setting in
Preferences > Infrastructure Preferences > Template Settings by selecting Allow
creation of template monitors directly under a template entity.

n

You can also define a template subgroup so that its content is not a part of the template,
and is ignored, when publishing changes to deployed groups. This enables deploying
templates inside different deployed groups. For details, see "Ignore group when publishing
changes" on page 817 in General Settings.
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n

7.

A template can have only one template group directly under it (the parent group).

Create template monitor instances
a. Select the monitor instances you want to add to the template group. For user interface details,
see "New Template Monitor Dialog Box" on page 821.
b. Enter values for the monitor properties.
o

If you are using template variables, enter the variable syntax for all fields whose values are
to be replaced with a variable. This includes use of the $$SERVER_LIST$$ system
variable. For concept details, see "Syntax for System Variables" on page 791.

o

To enter a variable, type either %% or $$. The list of available variables of that type is
displayed automatically. Click the relevant variable to select it (using the keyboard to
navigate through the list of available variables is not supported). The variable is then
displayed in the field.

Example: Using a variable when configuring a monitor. In this example, the template
monitor (a SiteScope CPU monitor) is configured to run on the template remote server,
%%host%% remote windows.

Note:
l

A template monitor can run on servers that are defined by template servers at the
time of template deployment or on servers defined manually in the Remote Servers
container of the remote server tree. Whichever is the case, the value in the Server
box must match the host name of an actual server at the time that the template is
deployed after values have been substituted for the template variables. If the server
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name does not match the host name of a real server, the monitor fails. To
automatically retrieve the template remote server name (if one was created), select
the Use already configured template remote under current template check box
in the Monitor Settings field. For user interface details, see "New Template Monitor
Dialog Box" on page 821.
l

l

Do not use "\\" in the monitor Server field, and in the remote server Name and
Server fields.
You can add monitor instances directly to the template entity if you select Allow
creation of template monitors directly under a template entity in Preferences >
Infrastructure Preferences > Template Settings.

c. For monitors with browsable counters, select counters to monitor measurements specific to
the target system.
o

Click the Get Counters button, and select a server or enter the connection information for
a server that is running the service or application that you want to monitor.

o

Click the Get Counters button again to retrieve the available counters. The counter
selection dialog box is updated.

o

Select the measurements or counters that you want to monitor. If the specific counters on
the target system vary from one deployment to another, you can use a regular expression
to match a pattern that represents the type or category of counter you want to monitor. For
task details, see "How to Modify Counter Selection Strings to Use Regular Expressions"
on page 805.

d. Configure other monitor settings in the Properties tab, such as:
o

Manually set thresholds for monitors by setting logic conditions that determine the reported
status of each monitor instance. For user interface details, see "Threshold Settings" on
page 291.
Note: After deploying a template, you can also set thresholds for one or multiple
monitors using a baseline. For task details, see "How to Set Monitor Thresholds
Using a Baseline" on page 327.

o

Manually configure calculated metrics to calculate the relation between two or more
metrics for one or more monitors. For user interface details, see "Calculated Metrics
Settings" on page 363.

o

Build dependencies between groups and key monitors to help control redundant alerting.
For concept details, see "Monitoring Group Dependencies" on page 255.
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o

For the complete list of common user settings, see "Common Monitor Settings" on page
283.
Note: If you copy, move, or delete a template containing custom monitors, this affects
the content package folder (created in the <SiteScope root
directory>\packages\workspace directory) as follows:

8.

o

Copy. Makes a copy of the content package folder in the <SiteScope root
directory>\packages\workspace folder.

o

Cut. No change.

o

Delete. If you delete the custom monitor template, the content package folder is
removed from the <SiteScope root directory>\packages\workspace folder of the
SiteScope file system.

Set up monitor and group alerts
Create alerts to send notification of an event or change of status in some element or system in
your infrastructure.
For task details, see "Configure SiteScope Alerts" on page 1243.

9.

Deploy the template
After creating a SiteScope monitoring template, you can deploy templates to a group.
n

You can deploy a single template, or multiple templates simultaneously to a group from the
user interface. For task details, see "How to Deploy Templates Using the User Interface" on
page 848.

n

You can perform mass deployments of a single template using a CSV file external to the
SiteScope user interface. A CSV file is better suited for performing mass deployments, since it
is easier to enter and update all the template variable values in one CSV file. For details, see
"Deploy a Template Using a CSV File" on page 848.

n

You can deploy a template using an XML file external to the SiteScope user interface. For
details, see "Deploy Templates Automatically Using an XML File" on page 861.
Note: If you deploy a template containing a custom monitor, the template and the deployed
monitor both point to the same monitor. If a deployed monitor is copied, the content package
will be copied to the <SiteScope root directory>\packages\workspace folder of the
SiteScope file system.

10.

Results
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SiteScope adds the groups, monitors, and alerts to the specified group in the monitor tree.
For troubleshooting and limitations when configuring user-defined templates, see Troubleshooting
SiteScope Templates.
Example: The template example, Windows basic template, was deployed to a group
container named Lab Test. It contains a CPU monitor and Memory monitor, and was
deployed to monitor resource usage on a server named doors.

11.

Set up monitor and group reports in the monitor view - optional
Create reports to display information about how the servers and applications you are monitoring
have performed over time.
For task details, see "Create SiteScope Reports" on page 1320.

12.

Publish changes to the monitoring solution - optional
You can make changes to deployed templates, for example, by adding or removing monitors or
modifying monitor properties. You do this by editing the template and using the Publish Template
Changes Wizard to publish the changes to all the relevant objects deployed by the template.
For task details, see "How to Publish Template Updates to Related Group Deployments" on page
878.

13.

Share the template with other SiteScope users - optional
You can share templates by sending them to individual SiteScope users, or by publishing them to
the HP Live Network. The HP Live network is an online community providing a central location for
HP customers to share information and learn about add-on content, extensions and related
activities across the HP Software portfolio.
For task details, see "Share SiteScope Content on the HP Live Network" on page 892.
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How to Create a Template by Copying Existing
Configurations
This task describes the steps involved in copying an existing group, monitor, or remote server from a
SiteScope to the template and editing the elements for use as a template.
1.

Prerequisites
Before copying an existing configuration from a SiteScope to a template, the template container
and template into which you want to copy the entity must exist in the template tree.
Note: When copying an existing monitor or remote server to a template, a template group
must also exist in the template.
For details on creating a template container, template, and template group, see "How to Create a
Monitoring Structure Using a Template" on page 794.

2.

Copy the configuration to the template
Right-click the group, monitor, or remote server you want to copy, and select Copy to Template.
In the Copy to template tree dialog box, select the template or template group to which you want to
add the copied configurations.
For user interface details, see "Copy to Template Tree Dialog Box" on page 317.

3.

Edit template variables
If you are using template variables in the new template, edit each copied object by replacing the
applicable configuration field's value with the required variable syntax.
For concept details, see "Referencing Template Variables" on page 792.

4.

Results
SiteScope adds the group, monitor, or remote server to the specified template or template group in
the template tree.

Select Browsable Monitor Counters in Monitor Templates
SiteScope includes a number of application monitor types that are designed to monitor measurements
specific to the target system. These browsable counter monitor types use a Get
Counters/Measurements browser function in the Monitor Settings panel. Configuring these monitor
types manually requires the following steps after selecting the monitor type:
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l

l

Specifying connection properties to the target system and then requesting that SiteScope retrieve
the measurement counters from the remote system.
Selecting the desired counters to be monitored and adding them to the configuration. After this, the
monitor can be added to SiteScope.

Counter Selection for Browsable Monitors Overview
Deploying monitors using templates does not accommodate a separate step for counter selection.
Another mechanism is used to enable the selection of counters for these monitor types using
templates. SiteScope uses text matching or regular expression matching to automate the counter
selection step for template deployment. You use a counter selection step when you create the template
monitor.
The simplest method for counter selection in templates is to select the specific counters explicitly in
the monitor template. This creates an explicit text match used to select the matching counter during
deployment. For information about the steps required to add a browsable counter monitor type with
explicitly selected counters, see the "Create template monitor instances" step in "How to Create a
Monitoring Structure Using a Template" on page 794.
If the specific counters on the target system vary from one deployment to another, you may be able to
use a regular expression to match a pattern that represents the type or category of counter you want to
monitor. For more information, see "Counter Selection Using Regular Expressions" below.
You can modify counter selection strings for template monitors to use regular expressions when you
create the monitor, or you can edit the monitor later. For more information on modifying a template
monitor for regular expression counter matching, see "How to Modify Counter Selection Strings to Use
Regular Expressions" on page 805.

Counter Selection Using Regular Expressions
Many applications have a number of measurement counters that vary according to the system on
which it is running, the configuration of system options, and the components installed. In this case,
selecting explicit counters in a monitor template may not be useful across multiple instances of an
application or system. Some systems have measurement counters that have a similar pattern but may
vary by the name of a node or object context. You can use regular expressions in monitor templates to
help automate the selection of multiple measurement counters.
Note: Use of this regular expression counter matching function requires knowledge of the counters
on the system to be monitored. You should manually set up a monitor of the type you want to add
to the template and carefully review the counters available on the type of system you want to
monitor. Creating a "greedy" regular expression that matches large numbers of counters on a
remote system may adversely affect SiteScope performance.
The steps you use to create a template monitor to use regular expressions are very similar to the
procedure described in the previous section. Instead of selecting all of the counters to be monitored
explicitly, you select one or more counters that are representative of all the counters you want to select.
The counter selections in monitor templates are stored as text strings. You edit these strings to create
patterns that SiteScope uses to find matching counters that are selected when the monitor is deployed.
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Note: When using regular expressions to select measurement counters or match thresholds,
SiteScope checks only whether one string is a substring of another, rather than performing an
equality check. This means that the incorrect set of counters and thresholds could be defined in
the monitor after deployment. For example, if the chosen monitor threshold is x/y, and x/yy also
matches the regular expression, this threshold is also defined.

Regular Expression Examples
l

Example 1. The following is a simple example of how a regular expression can be used for counter
selection for a SNMP by MIB Monitor type in a template:
You want to monitor the following three counters from several SNMP agents in your infrastructure:
iso/org/dod/internet/mgmt/mib-2/system/sysDescr
iso/org/dod/internet/mgmt/mib-2/system/sysUpTime
iso/org/dod/internet/mgmt/mib-2/system/sysName

You could select all three counters explicitly in the template monitor. Alternately, you could select
one of these and then modify the counter string to be a regular expression such as the following:
/iso\/org\/dod\/internet\/mgmt\/mib-2\/system\/sys[DUN][a-zT]*/

In this example, the counter selection string has been edited to add a pair of / slashes before and
after the string. This is necessary to indicate that the string is to be interpreted as a regular
expression. Because the selection string included several / slash characters initially, each of these
characters must be escaped by adding a \ backslash character immediately preceding it. The
[DUN][a-zT]* string includes two character class declarations commonly used in regular expression
syntax. For more information on regular expression syntax, see "Regular Expressions" on page
175.
l

Example 2. The following is an example of how a regular expression can be used for counter
selection for a UNIX Resource Monitor type in a template:
You want to monitor daemon processes running on several UNIX or Linux servers in your
infrastructure. The list of processing running might include the following:
Process\-bash\NUMBER RUNNING
Process\../java/bin/java\NUMBER RUNNING
Process\./ns-admin\NUMBER RUNNING
Process\./ns-proxy\NUMBER RUNNING
Process\./ns-sockd\NUMBER RUNNING
Process\/bin/sh\NUMBER RUNNING
Process\/etc/init\NUMBER RUNNING
Process\/usr/apache/bin/httpd\NUMBER RUNNING

HP SiteScope (11.31)

Page 803 of 1395

Using SiteScope
Chapter 59: Create Templates

Process\/usr/lib/nfs/statd\NUMBER RUNNING
Process\/usr/lib/saf/sac\NUMBER RUNNING
Process\/usr/lib/saf/ttymon\NUMBER RUNNING
Process\/usr/lib/snmp/snmpdx\NUMBERRUNNING
Process\/usr/lib/ssh/sshd\NUMBER RUNNING
...

You can create a regular expression counter selection string to match only those processes that
end with the letter "d". The following is an example regular expression to match this pattern:
/Process[\W\w]{5,18}d[\W]{1,2}NUMBER RUNNING/

As with Example 1, the counter selection string includes / slashes before and after the string to
indicate that the string is a regular expression. The example process strings on the UNIX server
include combinations of \ back slash and / forward slash characters. Because these characters
have special meaning in regular expressions, they would have to be escaped. This can be
complicated because the process strings have many variations and combinations of these and
other symbols.
The example regular expression used here simplifies the expression by using character class
declarations. The [\W] class is used to match punctuation marks. This matches on the \, -, :, and /
characters that appear in some of the process strings without the need to escape the characters
individually. For more information on regular expression syntax, see "Regular Expressions" on page
175.
l

Example 3. The following are more complex examples of how regular expressions can be used for
counter selection for different monitors in a template, where %% <variable name>%% represents a
template variable:
VMware Host Network Monitor:
/%%host%%\/HostSystem\/net\/packetsRx.summation\[.*\]
/ /%%host%%\/HostSystem\/net\/packetsTx.summation\[.*\]/
VMware Datastore Monitor:
/.*\/.*\/accessible/
/.*\/.*\/.*\/capacity/
VMware Performance Monitor on Resource Pool:
/ResourcePool/%%resource_pool_name%% (.*)/Historical\[300 secs\]
/mem/consumed.average\[\]/
/ResourcePool/%%resource_pool_name%% (.*)/Historical\[300 secs\]
/cpu/usagemhz.average\[\]/
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Microsoft Windows Resources Monitor:
/Network Interface\\(.*)\\Packets\/sec/
/Network Interface\\(.*)\\Bytes Total\/sec/ /Network Interface\\(.*)\\Bytes Received\/sec/
/Network Interface\\(.*)\\Current Bandwidth/
/Process\\java(.*)\\% User Time/ /Process\\java(.*)\\ID Process/ /.NET CLR Exceptions\\(.*)
\\# of Exceps Thrown \/ sec/

How to Modify Counter Selection Strings to Use Regular Expressions
This task describes the steps involved in modifying a template monitor to use a regular expression for
measurement counter selection.
Note: This task applies to monitors with browsable counters only.
1. In the template tree, click the monitor template you want to modify to open the template monitor
Properties view.
2. Open the Monitor Settings panel, and in the Measurements or Counters section (depending on
the monitor type), select a counter selection string that is representative of the pattern of counters
you want to configure for the monitor.
3. Modify the counter selection string to be a regular expression by adding a slash ("/") character to
the beginning and end of the string. Modify the string to use other pattern matching syntax as
required.
For counter selection examples, see "Regular Expression Examples" on page 803.
For more information on regular expression syntax, see "Regular Expressions" on page 175.
Note: If the template monitor was configured with explicit counter selections that can be
matched using the regular expression that was entered, you can delete the extra counter
strings by clicking the Delete Counter

button.

Maximum Number of Counters That Can be Saved
Browsable monitors are limited by the number of counters they have. The maximum number of
counters is determined by the _browsableContentMaxCounters parameter in the master.config file
(also in Preferences > Infrastructure Preferences > Monitor Settings > Maximum browsable
counters to be selected). If you create or edit a monitor so that it has more counters than this value,
only the number of counters up to this value is saved.
When a browsable monitor is deployed in a template, the number of counters that match the selected
patterns is limited by the _maxCountersForRegexMatch parameter in the master.config file. If during
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deployment, the number of counters that match the patterns exceeds this value, only the number of
counters up to this value is saved.
The _maxCountersForRegexMatch parameter is also used to limit the number of counters that match
the selected counter patterns when creating and updating dynamic monitors. We recommend using the
same value for both _browsableContentMaxCounters and _maxCountersForRegexMatch
parameters in the master.config file. The default value for both of these parameters is 1000.
When upgrading from earlier versions of SiteScope, the value for both of these parameters is set to the
higher of these two parameter values in the previous version, or to 1000 (whichever is greater).

SiteScope Templates User Interface
This section includes:
l

"SiteScope Templates Page" below

l

"Templates Tree - Properties Page" on the next page

l

"Templates Tree - Alerts Tab" on page 809

l

"New Template Container Dialog Box" on page 810

l

"New Template Dialog Box" on page 811

l

"New Variable Dialog Box" on page 813

l

"New Template Remote Server Dialog Box" on page 814

l

"New Template Group Dialog Box" on page 816

l

"New Template Monitor Dialog Box" on page 821

l

"New Alert Dialog Box" on page 823

l

"Search/Filters Tag Dialog Box" on page 824

SiteScope Templates Page
This page displays the name and description of the selected template container. Use this page to add
template containers, or edit the properties of existing template containers (not Solution Templates).
To access

Open the Templates context. In the template tree, select the SiteScope node.
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Important
information

l

l

l

You can also use the SiteScope API when working with templates. For details,
see "SOAP-based APIs" on page 159.
Only a SiteScope administrator user, or a user granted the appropriate template
permissions can view, add, or edit templates. For details on user permissions, see
"Permissions" on page 744.
A user can only access the template containers for which they have permissions
in the Allowed template containers list. This is set by the SiteScope
administrator in Preferences > User Management Preferences > user_profile
> Main Settings > Allowed template containers.

Relevant
tasks

"How to Create a Monitoring Structure Using a Template" on page 794

See also

"Template Tree" on page 41

User interface elements are described below:
UI Element

Description
New Template Container. Opens the New Template Container dialog box, enabling
you to create a new template container. For user interface details, see "New
Template Container Dialog Box" on page 810.
Edit Template Container. Enable editing the selected template container.
Delete Template. Deletes the template container.

<SiteScope
Templates
table>

Lists the predefined template that come with SiteScope (Template Examples, Monitor
Deployment Wizard Templates, and Solution Templates), and any user-defined
template containers. Double-click a template container to open the template container
page for the selected template.

Name

Name string assigned to the template container.

Description Description of the template container that was assigned when creating or editing the
template container.

Templates Tree - Properties Page
This page displays the name and description of the selected template object. In the template tree,
select a template object (template group, template monitor, template variable) to display properties for
the specific object. Use this page to edit the properties of the template.
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To
access

l

l

Select the Templates context. In the template tree, select a template object to
display properties for the object. The template Properties tab is displayed only when a
template group or monitor is selected.
Only a SiteScope administrator user, or a user granted the appropriate template
permissions can view, add, or edit templates. For details on user permissions, see
"Permissions" on page 744.

Relevant "How to Create a Monitoring Structure Using a Template" on page 794
tasks
See also

"Template Tree" on page 41

Main Settings
User interface elements are described below:
UI Element

Description

Name

The template name.

Description Description of the template.
Last edited
by

SiteScope user that last edited the template. This field is read-only.

Last edited
on

Time and date that the template, or any object within the template, was last edited.
This field is read-only.

Note: This field is displayed only when a template is selected in the template tree.

Note: This field is displayed only when a template is selected in the template tree.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add
Click to add existing tags. The Search/Filters dialog box opens. For details, see
Existing "Search/Filters Tag Dialog Box" on page 824.
Tag
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Templates Tree - Alerts Tab
This tab displays a list of alerts associated with the solution template. Use this page to add, delete, or
edit alerts associated with the template. In the template tree, select a template group or monitor to
display alerts for the selected object.
To
access

Select the Templates context. In the template tree, navigate to the group or monitor to
which you want to view, add, or edit alerts. Click the Alerts tab.

Relevant
tasks
See also

l

"Deploy Solution Templates" on page 896

l

"Configure SiteScope Alerts" on page 1243

l

"Template Tree" on page 41

l

"SiteScope Alerts Page" on page 1265

User interface elements are described below:
UI Element

Description
New Alert. Opens the New Alert dialog box enabling you to define a new alert. For
user interface details, see "New/Edit Alert Dialog Box" on page 1267.
Edit Alert. Opens the Edit Alert dialog box enabling you to edit the alert. For user
interface details, "New/Edit Alert Dialog Box" on page 1267.
Copy Alert. Copies the alert.
Paste Alert. Pastes the alert.
Delete Alert. Deletes the alert.

Name

Name string assigned to the alert definition.

Status

The enabled/disabled status of the alert.
l

l

l
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Enabled. Overrides any disable action on the alert and enables the alert for
execution based on the conditions defined.
Disabled indefinitely. Prevents SiteScope from executing the alert action even if
the alert condition is met until this radio button is cleared and the alert definition is
updated.
Disable on a one time schedule from <Time1> to <Time2>. Prevents
SiteScope from executing the alert action for the time period indicated, even if the
conditions are met. The alerts are disabled at the beginning of the time period and
re-enabled after the time period expires.
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UI Element

Description

Description Description of the alert definition that was assigned when creating or editing the alert.
Action
Name

Name given to the action to be done when the alert is triggered. It is not the name of
the alert.

New Template Container Dialog Box
This dialog box enables you to define a new template container. You use template containers to store
and manage templates. Template containers enable you to group and organize multiple templates in
ways that describe their purpose or classification.
To access

Important
information

Select the Templates context. In the template tree, right-click the SiteScope node or
an existing template container, and select New > Template Container.
l

l

l

l

Relevant
tasks
See also

Template containers can be added only to the SiteScope node in the template
tree.
Templates are displayed with the
icon in the template tree. Template
containers can hold templates only.
To delete a template container after deploying templates, you must first delete
each group to which the templates were deployed in the monitor tree, and then you
can delete the template container.
A user can only access the template containers for which they have permissions
in the Allowed template containers list. This is set by the SiteScope
administrator in Preferences > User Management Preferences > user_profile
> Main Settings > Allowed template containers.

l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Create a Template by Copying Existing Configurations" on page 801

l

"Create Templates" on page 782

l

"Template Examples" on page 788

l

"Template Tree" on page 41

HP SiteScope (11.31)

Page 810 of 1395

Using SiteScope
Chapter 59: Create Templates

Main Settings
User interface elements are described below:
UI Element

Description

Name

Name for the template container.
Maximum length: 250 characters

Description

Description for the template container.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.

New Template Dialog Box
This dialog box enables you to add a template to a template container. An individual template is
comprised of the object definitions of those objects that are created when the template is deployed.
Templates are displayed with the
To access

Important
information

icon in the template tree.

Select the Templates context. In the template tree, right-click a template container,
and select New > Template.
l

l

l
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A template can have one template group only directly under it (the parent group).
Templates can contain a group and subgroups, variables, and a remote server.
They can also contain monitors, provided Allow creation of template monitors
directly under a template entity is selected in Preferences > Infrastructure
Preferences > Template Settings.
To delete a template after deploying it, you must first delete each group to which
the template was deployed in the monitor tree, and then you can delete the
template.
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Relevant
tasks
See also

l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Create a Template by Copying Existing Configurations" on page 801

l

"Create Templates" on page 782

l

"Template Examples" on page 788

l

"Template Tree" on page 41

Main Settings
User interface elements are described below:
UI Element

Description

Name

Name for the template. The name you enter appears in the template tree as a child
node of the template container.
Maximum length: 250 characters.

Description Description for the template.
Last edited
by

SiteScope user that last edited the template. This field is updated only after the
template is created.
Default value: N/A

Last edited
on

Time and date that the template (or any object within the template) was last edited.
This field is updated only after the template is created.
Default value: N/A

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.
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New Variable Dialog Box
This dialog box enables you to add a template variable to a template. A variable is used to enable
prompting for user input during template deployment. Template variables are either user-defined or
predefined system variables that provide access to the list of remote server connections known to
SiteScope. Template variables are displayed with the icon in the template tree.
To access

l

l

l

l

l

l

Important
information

l

l

l

Relevant
tasks
See also

Select the Templates context. In the template tree, right-click a template, and
select New > Variable.
In the Template <monitor> page, click New Variable. For details, see "New
Template Monitor Dialog Box" on page 821.
In the New Template Alert dialog box, click New Variable. For details, see "New
Alert Dialog Box" on page 823.
In the Alert Action dialog box, click New Variable. For details, see "Alert Action
Dialog Box" on page 1278.
In the New Microsoft Windows Remote Server dialog box, click New Variable.
For details, see "New Template Remote Server Dialog Box" on the next page.
In the New UNIX Remote Server dialog box, click New Variable. For details, see
"New Template Remote Server Dialog Box" on the next page.
When configuring variables for Frequency and Error frequency in the Monitor
Run Settings, the variable values can only be in time units of seconds.
When a monitor is copied or moved from one template to another, any userdefined variables in the monitor are also copied or moved.
If you change the name of an assigned template variable, all monitors using that
variable are automatically updated to use the new variable name.

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Create Templates" on page 782

l

"Template Variables" on page 790

l

"Template Examples" on page 788

l

"Template Tree" on page 41
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Main Settings
User interface elements are described below:
UI Element

Description

Name

Name for the template variable. The name you enter is used to identify the variable in
the template in the template tree. This is the name that must be used when referring to
the variable in other template objects.
Note: The name of a variable cannot be edited after the variable has been added. To
change a variable name, delete the variable and create a new one with the correct
name.

Display
name

Display name if you want a different name to be displayed instead of the variable
name on deployment. You must still use the variable name when referencing the
variable in a template object.

Description Description for the variable.
Default
value

Default value to be used for this variable. If you do not enter a value in this box and the
box requires a value, you are prompted to enter a value when deploying the template.
Note: If the Password variable option is selected, the default value is hidden behind
asterisks. If you subsequently clear the check box, the hidden data is deleted.

Display
order in
template

Variable display sequence number. This is the order in which SiteScope prompts you
to enter values for a variable on deployment. Variables are displayed in ascending
order. Variables that have no display number are displayed at the end.
Note: The display order does not change the order of the variables within the template
definition.

Password
variable

Hides the default value and the value entered during deployment behind asterisks. If
you subsequently clear the check box, the hidden data is deleted.
Default value: Not selected
Note: This option is automatically selected for any variable from previous versions of
SiteScope that has a name ending with PASSWORD or password.

Mandatory
variable

The variable field requires a value and prompts you to enter a value when deploying
the template. To set a variable with a non-mandatory value, clear the check box.
When this option is cleared, SiteScope uses an empty String ("") as a value for a nonmandatory variable.
Default value: Selected

New Template Remote Server Dialog Box
This dialog box enables you to create a UNIX or Windows remote server in the template. A template
remote server is used to define remote server preferences that are created when the template is
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deployed. A template remote server is displayed with the
To access

Important
information

Select the Templates context. In the template tree, right-click a template, and select
New > Microsoft Windows/UNIX Remote Server.
l

l

l

l

l

l

l

Relevant
tasks
See also

icon in the template tree.

Enter the actual values for those fields that remain constant throughout the
template deployment. Enter template variables in those fields whose values are
replaced with a variable value when the template is deployed. For details, see
"Referencing Template Variables" on page 792.
You can add only one remote server to a template.
You cannot delete a server from the remote servers list if the server is referenced
by a template monitor. Select a different server in the Server box of the Monitor
Settings panel for each monitor that references the remote server, and then delete
the remote server from the remote server list.
You can add a new variable from the New Template Remote Server dialog box by
clicking the New Variable button, and configuring the variable as described in
"New Variable Dialog Box" on page 813.
You cannot replace an existing monitor target server using the Publish Template
Changes wizard or auto deployment update (see "Publish Template Changes
Using the XML" on page 862), although you can change property values of the
target server itself, if required.
Do not use "\\" in the remote server Name and Server fields, and in the monitor
Server field.
Some fields that contain drop-down lists when configuring objects in normal mode,
are displayed as text boxes in template mode.

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Create Templates" on page 782

l

"Remote Servers" on page 469

l

"Template Examples" on page 788

l

"Template Tree" on page 41

The following user interface element is common to all areas in the page:
UI Element

Description

New
Variable

Click to define a new variable. For details, see "New Variable Dialog Box" on page
813.
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For a description of the elements found in the Microsoft Windows New Remote Server dialog box, see
"New/Edit Microsoft Windows Remote Server Dialog Box" on page 475.
For a description of the elements found in the New UNIX Remote Server dialog box, see "New/Edit
UNIX Remote Server Dialog Box" on page 495.

New Template Group Dialog Box
This dialog box enables you to add a template group to a template, or to an existing template group to
create a subgroup. You use template groups to replicate monitoring deployment to multiple locations in
the infrastructure. Template groups are displayed with the
To access

Important
information

Select the Templates context. In the template tree, right-click a template or template
group, and select New > Group.
l

l

l

Relevant
tasks
See also

icon in the template tree.

A template can have only one template group directly under it (the parent group).
By default, you can create template monitors, alerts, and subgroups in the parent
group or in subgroups only. If you want to create template monitors directly under
a template entity, select the Allow creation of template monitors directly
under a template entity check box in Preferences > Infrastructure
Preferences > Template Settings.
You can add a new variable from the New Template Group dialog box by clicking
the New Variable button, and configuring the variable as described in "New
Variable Dialog Box" on page 813.

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Create Templates" on page 782

l

"Template Examples" on page 788

l

"Template Tree" on page 41

l

"Dependencies When Configuring Template Monitors and Groups" on page 257

The following user interface element is common to all areas in the page:
UI Element

Description

New
Variable

Click to define a new variable. For details, see "New Variable Dialog Box" on page
813.
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General Settings
User interface elements are described below:
UI Element

Description

Group
Name

Name for the template group (preferably using a template variable). A template
variable enables you to specify a different name for the group every time you deploy
the template. If the group name does not include a variable, multiple deployments of
the template in the same directory fail because the group name is not unique. For
details on using template variables, see "Referencing Template Variables" on page
792.
Note:
l

l

Template deployment fails if a template contains multiple groups with the same
name, even if each group has a different parent group.
The group name cannot contain any of the following characters: ` ;" & | < > / \ +

Group
Description for the template group. This can include the most common HTML tags for
Description text styling, such as <BR>, <HR>, and <B>, and hyperlinks. The description is
displayed only when viewing or editing the group's properties in the SiteScope
Dashboard. For details on adding a hyperlink, see "Add URL links to group
descriptions - optional" on page 247.
Note: This field does not support JavaScript/iframes/frames or other advanced
features. HTML code entered in this box is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line).
Ignore
group
when
publishing
changes

(This option is not available for the root group, and is inactive for Solution Templates.)
Changes made to any objects within this subgroup are ignored when publishing
changes to deployed groups.
This option enables you to:
l

l

Deploy a template inside an existing deployed group and publish template
changes to the deployed group without affecting SiteScope objects that are in the
ignored group. This means you can edit or delete monitors, groups, or alerts in a
deployed group without them being affected when publishing changes.
Delete objects in deployed groups that were removed from the source template
(when the Enable delete on update option is selected), without deleting other
objects created in the deployed group that were not part of the source template.

Default value: Not selected
For the effect of this setting when performing different actions, see the table below.
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The following lists the impact of the Ignore group when publishing changes setting when different
actions are performed:
Action

Effect when Ignore group when publishing changes is selected

Rename Deployed Group

The change of name is ignored by the publish changes flow.

Rename Template Group
Delete Deployed Group

The group is recreated when you publish changes.

Delete Template Group

The publish changes flow removes the deployed group when Enable
delete on update is selected.

Copy a template group

The Ignore group when publishing changes setting does not
change when copying a template group and its contents to a template.

Copy to a template

The Ignore group when publishing changes setting is set to false
(cleared) when copying a group and its contents to a template.

Copy between templates

The Ignore group when publishing changes setting is copied along
with the other template group settings.

Import template from a
previous version of
SiteScope

The Ignore group when publishing changes setting is interpreted
as false (cleared).

Export a template

The Ignore group when publishing changes setting does not
change when exporting a template.
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Dependencies
User interface elements are described below:
UI Element
Depends on

Description
Click Depends on
to open the Select Depends On Monitor dialog box, and
select the monitor on which you want to make the running of this monitor
dependent. For details on the Select Depends On Monitor dialog box, see "Select
Depends On Monitor Dialog Box" on page 316.
Use this option to prevent redundant alerting from multiple monitors that are
monitoring different aspects of a single system.
Example: Create a system monitor to check the basic availability of a system and
then create other monitors that perform more detailed tests of that system. Set the
detailed test monitors to be dependent on the status of the monitor checking basic
availability.
If the system monitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also
disables any alerts that would have been generated by the dependent monitors.
Default value: No dependency is set for a monitor instance.
Note: This field is cleared and is not available when Ignore dependencies when
publishing changes is selected.
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UI Element

Description

Depends
condition

If you make this monitor dependent on the status of another monitor (by using the
Depends on setting), use this option to select the status condition of the Depends
on monitor for the current monitor to run normally.
The status categories include:
l

Good

l

Error

l

Available

l

Unavailable

The monitor being configured is run normally as long as the monitor selected in the
Depends on box reports the condition selected in this box.
Example: Select Good and this monitor is enabled only when the monitor selected
in the Depends on box reports a status of Good. The current monitor is
automatically disabled if the monitor selected in the Depends on box reports a
category or condition other than Good. You can also enable dependent monitors
specifically for when a monitor detects an error.
Default value: Good
Ignore
dependencies
when
publishing
changes

When template changes are published to the deployed objects, dependency
settings for the selected template group are ignored and the existing dependency
settings in the deployed objects are preserved. For details, see "Dependencies
When Configuring Template Monitors and Groups" on page 257.
Default value: Not selected
Note: When selected, the Depends on field is cleared and is not available.

Search/Filter Tags
Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote servers,
templates, and preference profiles).
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description
<Tag
name
and
values>

You can either:
l

l

Click the Add existing tag button to open the Search/Filter Tags dialog box where
you can select an existing tag. For details, see "Search/Filters Tag Dialog Box" on
page 824.
Enter values in the Tag Name and Values boxes to create new tags. You can also
use variables as tags and values. For concept details and for details on how to format
the tag names and values, see "Filter Objects in the SiteScope View" on page 74.

The Tag Name and Values boxes display the selected or entered values. The boxes are
empty at first, until you select tags.
Add
Opens the Search/Filters Tag dialog box, enabling you to add existing keyword tags or to
Existing define new tags. For user interface details, see "Search/Filters Tag Dialog Box" on page
Tag
824.

New Template Monitor Dialog Box
This dialog box enables you to add a template monitor to a template group or subgroup. Template
monitors are used as the basis for the creation of actual monitors at the time that the template is
deployed. Template monitors are displayed with the
To access

icon in the template tree.

Select the Templates context. In the template tree, right-click a template group, and
select New > Monitor. Select the monitor type you want to configure for the
template.
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Important
information

l

l

l

l

l

l

l

l

Relevant
tasks
See also

By default, you create template monitors in a template group. To create template
monitors directly under a template entity, select the Allow creation of template
monitors directly under a template entity check box in Preferences >
Infrastructure Preferences > Template Settings. Template monitors can
contain alerts.
Template monitors are not active monitor instances. Monitors are created and
activated based on these template configurations only when you deploy the
template.
Do not use "\\" in the monitor Server field, and in the remote server Name and
Server fields.
When using regular expressions to select metrics counters or match thresholds,
SiteScope checks only whether one string is a substring of another, rather than
performing an equality check. This means that the incorrect set of metrics and
thresholds could be defined in the monitor after deployment. This is because
SiteScope, by default, treats every metric in the metrics table as a regular
expression, and matches the threshold setting with all metrics that fit this
expression. For example, if the chosen monitor threshold is x/y, and x/yy also
matches the regular expression, this threshold is also defined. To avoid this, add
specific regular expressions to meet your exact requirements (see "Select
Browsable Monitor Counters in Monitor Templates" on page 801).
When adding a Search/Filter tag to a template monitor, you cannot use both actual
parameters and variable parameters in the same tag values group.
When deploying a Script monitor from a template, the case of the remote script
name must match that of the script name in the scripts subdirectory. Otherwise,
the selected script is shown as 'none'.
The Network Bandwidth monitor's non-default thresholds are not copied properly
to a template.
The template monitor name cannot contain any of the following characters: " ` < >

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Common Monitor Settings" on page 283

l

"Create Templates" on page 782

l

"Template Examples" on page 788

l

"Template Tree" on page 41
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User interface elements are described below:
UI Element

Description

The settings below are specific to the New Monitor dialog box when working in template mode only.
For settings common to all monitors, see "Common Monitor Settings" on page 283.
Use already configured
template remote under
current template

When selecting the server that you want to monitor, enables using
the template remote server (if one was created) without having to
enter its name.
Default value: Not selected

New Variable

Opens the New Variable dialog box, which enables you to create a
new variable without navigating away from the New Monitor dialog
box. For user interface details, see "New Variable Dialog Box" on
page 813.

New Alert Dialog Box
This dialog box enables you to define alerts for a template group or a template monitor. Template alerts
are used to define alerts on monitors that are created when the template is deployed. If an alert has
been set up for the template group or monitor, the alert
monitor icon.
To access

symbol is displayed next to the group or

Select the Templates context. In the template tree, right-click a template group or
template monitor, and select New > Alert.

Important
You cannot select the Disable or Enable Monitors alert action when creating an
information alert template. Template alerts are enabled for all the monitors belonging to the object
for which they were defined. For example, if an alert is defined for a monitor, then it is
activated on that monitor only. If an alert is defined for a template, then it is activated
for all the monitors in the template.
Relevant
tasks
See also

"How to Create a Monitoring Structure Using a Template" on page 794

l

"Common Monitor Settings" on page 283

l

"Create Templates" on page 782

l

"SiteScope Alerts Page" on page 1265

l

"Template Examples" on page 788

l

"Template Tree" on page 41

The following element is common to all action types:
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UI Element

Description

New
Variable

Click to define a new variable. For details, see "New Variable Dialog Box" on page
813.

For a description of the other elements found in the New Alert dialog box, see "New/Edit Alert Dialog
Box" on page 1267.

Search/Filters Tag Dialog Box
This dialog box enables you to select one or more existing tags or to create a new tag.
To access

Click Add Existing Tag in the Search/Filters Tag panel of template groups, template
monitors, and template alerts.

Relevant
tasks

"How to Create a Monitoring Structure Using a Template" on page 794

See also

"Search/Filter Tags" on page 718

User interface elements are described below:
UI
Element Description
Add
Tag

Click to create a new tag. For details, see "New/Edit Tag Dialog Box" on page 721.

Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors).
Represents a tag.
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Content Packages are used for sharing user-defined content with other SiteScope users. You create
content packages using the Export Content Package Wizard.

Learn About
SiteScope Content Packages Overview
Content packages are required for sharing Custom monitors and monitors that reference a script or alert
extension file.
Package
Type
Custom
Monitor
Content
Package

Where to
Get Details

Description
A Custom monitor content package is created when creating a Custom
monitor (for details, see "Create Custom Monitors" on page 319). This is
a set of files in a predefined folder structure on the SiteScope file system
which can be created and referenced from a Custom monitor. You can
add files to this package that are required for running the Custom monitor.
A content package can include templates and additional dependency
files such as jars and configuration files.
The content package is created under <SiteScope root
directory>\packages\workspace\package_<Package ID>.

Template
Extension
Content
Package

A template extension content package is required for sharing a template
monitor that references script or alert extension files in the SiteScope file
system. The content package is comprised of a template (containing
monitors and variables), and a set of predefined folders, that include the
extension files referenced by monitors in the template.
Script and alert extension files referenced by monitors in the template
should be copied to the relevant folders in the <SiteScope root
directory>\packages\workspace\extensions directory.

"How to
Create,
Export, and
Import a
Custom
Monitor
Content
Package"
on page 828
"How to
Create,
Export, and
Import a
Template
Extension
Content
Package"
on page 833

Tasks
This section includes:
l

"How to Create, Export, and Import a Custom Monitor Content Package" on page 828

l

"How to Create, Export, and Import a Template Extension Content Package" on page 833
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Content Packages
You can export and import SiteScope content packages and user-defined templates for use in other
SiteScope installations. This enables you to share content with other SiteScope users, and to deploy
multiple IT elements with similar monitoring configuration criteria across the enterprise.

Learn About
Exporting and Importing SiteScope Content Overview
You can export templates for use in other SiteScope installations. This enables you to replicate
standardized monitor configurations across the enterprise. When you export a template container that
includes one or more templates, the template container and the templates are exported. After exporting,
the templates still remain in the template container. For details about exporting and importing
templates, see "How to Export and Import a Template" on the next page.
You can also export SiteScope content in content packages for use in other SiteScope installations.
Content packages are used for sharing user-defined templates that contain Custom monitors or regular
monitors that reference a script or alert template file in the SiteScope root directory. For details about
exporting and importing content packages, see "How to Create, Export, and Import a Custom Monitor
Content Package" on page 828 and "How to Create, Export, and Import a Template Extension Content
Package" on page 833.
After exporting to a template or content package, you can share the template or content package by
sending it to individual SiteScope users, or by publishing it to the HP Live Network. For details, see
"Share SiteScope Content on the HP Live Network" on page 892.
You can also export SiteScope templates to HP Operations Manager (HPOM) when SiteScope is
connected to HPOM 9.10 with patch 9.10.210 and hotfix QCCR1A125751, or to HPOM 9.10 with
patches later than 9.10.210. This enables SiteScope templates and monitors to be configured through
the HPOM policy assignment and deployment. For details, see the HP Operations Manager 9.10
documentation.
After exporting a template, you can copy the export file to another SiteScope server and import the
template container that contains the template or templates you want to use. This enables you to
efficiently replicate standardized monitor configurations across the enterprise.
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Tasks
How to Export and Import a Template
This task describes the steps involved in exporting and importing templates for use in other SiteScope
installations.
Note: If the import fails or you no longer see the solution templates in the Solution Templates tree,
you can restore them by copying them from the <SiteScope root directory>\export folder to the
<SiteScope root directory>\persistency\import folder. If the \export folder also contains the
template examples, the template container should be renamed to prevent unique name violations.

1.

2.

Prerequisites
n

To add, edit, and delete templates, you must have Add, edit or delete templates
permissions.

n

To deploy a template, regardless of its content, you must have edit permissions on the
deployment target group. You do not need edit permissions on the template objects (monitors,
remotes, and alerts). For details on user permissions, see "Permissions" on page 744.

Export a template
To export a template for use in other SiteScope installations, right-click the template or template
container object in the template tree that contains the templates you want to export, and select
Export > Template. For details, see "Export Template Dialog Box" on page 837.
After exporting a template, you can share the template by sending it to individual SiteScope users,
or by publishing it to the HP Live Network. For details, see "Share SiteScope Content on the HP
Live Network" on page 892.

3.

Export a template to Operations Manager (HPOM) - Optional
To enable SiteScope templates (not Solution Templates) and monitors to be configured through
the HPOM policy assignment and deployment, right-click the template in the template tree you
want to export, and click Export to OM.
Note: This option is available only when HPOM 9.x or later and SiteScope are installed on the
same machine on a UNIX environment only, and when the Operations Manager integration
has been enabled in SiteScope. For details on configuring the Operations Manager
integration, see Integrating SiteScope with HP Operations Manager Products. You can check
the HP Software Integrations site for the latest version of this guide.
For details on how to manage SiteScope templates with HPOM, see the HPOM documentation.

HP SiteScope (11.31)

Page 827 of 1395

Using SiteScope
Chapter 61: Export and Import Templates and Content Packages

4.

Import a template
After you have exported a template, you can copy the export file to another SiteScope server and
import the template container that contains the template or templates you want to use. Right-click
the template container in the template tree into which you want to import the template or
templates, and click Import > Template. Enter the name and location of the file you want to
import.
For user interface details, see "Template Import Dialog Box" on page 844.
Note: When importing templates to SiteScope that contain deprecated monitors from earlier
version of SiteScope, the deprecated monitors are not displayed in the template tree.

5.

Result
Templates contained in the file are added to the template container. The imported templates can
be used directly or modified as required.

How to Create, Export, and Import a Custom Monitor Content Package
This task describes the steps involved in creating, exporting, and importing a content package to share
Custom monitors with other SiteScope users.
1.

2.

Prerequisites
n

You must have created a Custom monitor. For details, see "Create Custom Monitors" on page
319.

n

To add, edit, and delete content packages, you must have Add, edit or delete templates
permissions.

Copy the monitor to a template
For details, see "How to Create a Template by Copying Existing Configurations" on page 801.

3.

Copy the files used for running the monitor
Copy the files required for running the monitor, such as the additional jars used in the script and
other resource files, to the predefined content package folders in the <SiteScope root
directory>\packages\workspace\package_<Package ID> directory:
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Predefined
Folders
Description
\classes

If you have any compiled java classes that are used by a monitor, copy them with
the entire package folder structure to this folder; this is not required if the class
files were packaged in a jar that was copied to the \lib folder. The class files can
be accessed from the data processing script.

\conf

If you have any configuration or documentation files, copy them to this folder. The
data processing script has read only access to this folder.

\lib

If you have any external jars used by the Custom monitor script, copy them to this
folder. Java classes from the jar files can be accessed from the data processing
script. Note that you can use this monitor without external jars.

\META-INF Contains the manifest file where information about the content package is stored.
The manifest file is created automatically by the export process (see "Export the
content package to a zip file using the Export Content Package Wizard" on the
next page).
\templates

4.

Copy the template files exported from SiteScope that contain the templates with
the Custom monitor(s) to this folder. Each template can contain various types of
monitors; custom and regular.

Copy extension files referenced by the monitor - optional
If the monitor references script or alert extension files in the SiteScope file system, copy them to
the relevant folders in the <SiteScope root directory>\packages\workspace\extensions>
directory:
Predefined
Folders
\scripts

Description
Stores script files that are used to run shell commands or other scripts on the
machine where SiteScope is running.
Note: After importing a content package, file permissions for script files
imported to this folder are changed to 755 (read, write and execution) for all
users working in a Linux environment.

\scripts.remote

Used for storing script files that are used for running a script that is stored on a
remote machine.
Note: After importing a content package, file permissions for script files
imported to this folder are changed to 755 (read, write and execution) for all
users working in a Linux environment.

HP SiteScope (11.31)

Page 829 of 1395

Using SiteScope
Chapter 61: Export and Import Templates and Content Packages

Predefined
Folders

Description

\templates.mail Used for storing the file containing the format and content of alert messages
sent by email.
\templates.
mail.subject

Used for storing the file containing the subject line of alert messages sent by
email.

\templates.mib

Used for storing the MIB files that are used to create a browsable tree that
contains names and descriptions of the objects found during a traversal.
Note: As part of the import process, templates.mib files are edited and the
unique package ID is added to some properties inside the files.

\templates.os

Used for storing the shell commands to be run when monitoring remote UNIX
servers.
Note: As part of the import process, template.os files are edited and the
unique package ID is added to some properties inside the files.

5.

Export the content package to a zip file using the Export Content Package Wizard
Select the Templates context. In the template tree, right-click the template or template container
that you want to export to a content package, and select Export > Content Package.
In the Export Content Package Wizard, enter details of the content package (manifest), and select
the templates and files associated with the templates to include. For Wizard details, see "Export
Content Package Wizard" on page 838.
Note: The Select Files page of the Wizard displays files from the <SiteScope root
directory>\packages\workspace\package_<Package ID> and <SiteScope root
directory>\packages\workspace\extensions> folders listed in steps 3 and 4 above, except
for the \META-INF and \templates folders which are not displayed.

6.

Share Custom monitors with other SiteScope users
You can distribute a content package zip file by sending it to individual SiteScope users.
Alternatively, you can use the HP Live Network (https://hpln.hp.com/group/sitescope) community
for sharing templates and content packages with other users.
For details on publishing content packages to the HP Live Network community, see "How to
Publish Content to the HP Live Network Community" on page 893.
For details on downloading a content package to your SiteScope machine, see "How to Download
Content from the HP Live Network" on page 894.
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7.

Import a Content Package
a. In SiteScope, select the Templates context. In the template tree, right-click the template
container into which you want to import the content package, and click Import > Content
Package.
b. In the Import Content Package dialog box, click Browse, and navigate to the folder containing
the package you want to import (packages are distributed in zip format). Click Open, and then
click OK. The Custom monitor templates are added to the selected template container.
For details, see "Import Content Package Dialog Box" on page 845.
Note:

8.

o

Content packages can contain any type of file from the predefined folders listed in
steps 3 and 4 above. If the content package contains any other folders, an error is
displayed and the import operation fails.

o

Existing SiteScope files cannot be overridden by files from content packages.
However, templates (located in the <SiteScope root
directory>\packages\imported\templates folder) can be overridden if the Override
existing templates check box is selected in the Content Import dialog box. For
details, see "Template Import Dialog Box" on page 844.

o

When importing templates to SiteScope that contain deprecated monitors from earlier
version of SiteScope, the deprecated monitors are not displayed in the template tree.

o

When importing a content package that is too large (the package size limitation
depends on the user VM size), SiteScope displays an error and the path to the
applet.log where the error is written. Since the exception is thrown from the user
interface side, each user can encounter the exception in different package sizes.

o

Do not edit imported files.

Verify the template was imported successfully by checking it was added to the template
tree
a. Check that the content package was copied to the <SiteScope root
directory>\packages\imported folder, and a new folder was created with the name:
<Package/Zip Name>.zip_<Package ID>.
The folder contains:
Folder

Description

\classes

Stores compiled Java classes.
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Folder

Description

\conf

Used for storing configuration files, documentation, and XML files.

\extensions

Stores script and alert files referenced by monitors in the imported
templates.

\lib

Stores external jar files used by the monitor script.

\META-INF

Contains the manifest file where information about the content
package is stored.

\templates

Contains files from which templates in this content package were
imported into SiteScope.

<Package/Zip
Name>

Uncompressed package that contains the above-mentioned
folders.

<Package/Zip
Name>.zip.properties

Descriptor (manifest) file for content packages created in
SiteScope 11.20, that is used in case of rollback, uninstall, or
upgrade. The file contains the ID of the SiteScope template that
was deployed, the location of the files in SiteScope, and other
information about the content package.

The imported templates and dependency files can be used directly or modified as required.
Where script or alert templates are referenced in the user interface, the unique package ID is
added as a suffix.
Example: ShortMail alert action template referenced in the Template field

b. If the template monitors are using extended files, check that these files were copied to the
relevant scripts and/or templates folder in the SiteScope root directory on the SiteScope file
system (folders have the same name as listed in step 4 above).
9.

Managing content packages
After importing a content package, you can copy, move, and delete the imported Custom
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monitors. When doing so, this affects the content package as follows:
Action

File System Impact

Copy Monitor

Copies the content package folder in the <SiteScope root
directory>\packages\workspace folder.

Cut Monitor

No change.

Delete Monitor

Deletes the content package from the <SiteScope root
directory>\packages\imported folder of the SiteScope file system (if
you deleted all the monitors that were imported from the content
package).

Deploy template
with Custom
monitor + content
package

No change.
If a deployed monitor is copied, the content package is copied to the
<SiteScope root directory>\packages\workspace folder of the
SiteScope file system.

How to Create, Export, and Import a Template Extension Content Package
Note: This content package is an extension of the template concept, which enables sharing and
reusing templates with similar monitoring configuration criteria between different SiteScope
deployments.
This task describes the steps involved in creating, exporting, and importing a content package for
sharing a template monitor that references script or alert extension files located in the SiteScope root
directory, where the extension files are used for running the monitor. This content package is applicable
for all monitor types.
1.

Prerequisites
To add, edit, and delete content packages, you must have Add, edit or delete templates
permissions.

2.

Create a SiteScope monitoring template or select an existing user-defined template
from the templates tree
For task details, see "How to Create a Monitoring Structure Using a Template" on page 794.

3.

Copy extension files referenced by the monitor
For template monitors that reference script or alert extension files in the SiteScope root directory
in the SiteScope file system, copy the applicable extension files to the relevant folders in the
<SiteScope root directory>\packages\workspace\extensions> directory:
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Predefined
Folders
\scripts

Description
Stores script files that are used to run shell commands or other scripts on the
machine where SiteScope is running.
Note: After importing a content package, file permissions for script files
imported to this folder are changed to 755 (read, write and execution) for all
users working in a Linux environment.

\scripts.remote

Stores script files that are used for running a script that is stored on a remote
machine.
Note: After importing a content package, file permissions for script files
imported to this folder are changed to 755 (read, write and execution) for all
users working in a Linux environment.

\templates.mail Stores the file containing the format and content of alert messages sent by
email.
\templates.
mail.subject

Stores the file containing the subject line of alert messages sent by email.

\templates.mib

Stores the MIB files that are used to create a browsable tree that contains
names and descriptions of the objects found during a traversal.
Note: As part of the import process, templates.mib files are edited and the
unique package ID is added to some properties inside the files.

\templates.os

Stores the shell commands to be run when monitoring remote UNIX servers.
Note: As part of the import process, template.os files are edited and the
unique package ID is added to some properties inside the files.

Note: When exporting files to a content package, the unique package ID is added to the script
and template files as a suffix (before the file extension) in the <SiteScope root
directory>\packages\imported\ directory, and under the relevant folder in the SiteScope root
directory.

4.

Export the content package to a zip file using the Export Content Package Wizard
Select the Templates context. In the template tree, right-click the template or template container
that you want to export to a content package, and select Export > Content Package.
In the Export Content Package Wizard, enter details of the content package (manifest), and select
the templates and extension files associated with the monitors that you want to include. For
Wizard details, see "Export Content Package Wizard" on page 838.
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5.

Share the template monitor with other SiteScope users
You can distribute a content package zip file by sending it to individual SiteScope users.
Alternatively, you can use the HP Live Network (https://hpln.hp.com/group/sitescope) community
for sharing templates and content packages with other users.
For details on publishing content packages to the HP Live Network community, see "How to
Publish Content to the HP Live Network Community" on page 893.
For details on downloading a content package to your SiteScope machine, see "How to Download
Content from the HP Live Network" on page 894.

6.

Import a Content Package
a. In SiteScope, select the Templates context. In the template tree, right-click the template
container into which you want to import the content package, and click Import > Content
Package.
b. In the Import Content Package dialog box, click Browse and navigate to the folder containing
the package you want to import (packages are distributed in zip format). Click Open, and then
click OK.
For details, see "Import Content Package Dialog Box" on page 845.
Note:

7.

o

Content packages can contain any type of file from the predefined folders listed in
step 3 above. If the content package contains any other folders, an error is displayed
and the import operation fails.

o

Existing SiteScope files cannot be overridden by files from content packages.
However, templates (located in the <SiteScope root
directory>\packages\imported\templates folder) can be overridden if the Override
existing templates check box is selected in the Content Import dialog box. For
details, see "Template Import Dialog Box" on page 844.

o

When importing templates to SiteScope that contain deprecated monitors from earlier
version of SiteScope, the deprecated monitors are not displayed in the template tree.

o

When importing a content package that is too large (the package size limitation
depends on the user VM size), SiteScope displays an error and the path to the
applet.log where the error is written. Since the exception is thrown from the user
interface side, each user can encounter the exception in different package sizes.

o

Do not edit imported files.

Verify the template extension files were imported successfully
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Check that the template extension files were extracted from the content package and copied to
the relevant scripts and/or templates folder in the SiteScope root directory on the SiteScope file
system (folders have the same name as listed in step 3 above).
Note: Content packages that contain a template with no Custom monitors (for example, a
template with CPU monitor only), are no longer saved to the <SiteScope root
directory>\packages\imported folder. You can override this setting if necessary and save a
copy of the package by changing the property Save copy of content package with
extended files only to true in Preferences > Infrastructure Preferences > Custom
Settings.

How to Enable Unicode Font When Exporting to a PDF
This task describes how to configure Unicode font to display characters that differ from the current
locale when exporting a report to a PDF. This also enables you to view text consisting of characters
from multiple languages.
Note: If you are using a machine that has Microsoft Office installed, Arial Unicode MS font is
already installed and you do not need to download or configure the font.
To configure Arial Unicode MS font using the font library:
1. Navigate to the font library on the SiteScope server. For example:
Environment

Font Library

AIX

/usr/lpp/Acrobat3/Fonts

HPUX

/usr/contrib/xf86/xterm/fonts
/usr/lib/X11/fonts/ms.st/typefaces

Linux

/usr/share/fonts/truetype
/usr/share/fonts/local

UNIX

/usr/openwin/lib/X11/fonts/TrueType
/usr/X11/lib/X11/fonts/TrueType
/usr/X11/lib/X11/fonts/Type1

Windows

C:\Windows\Fonts
C:\WINNT\Fonts

2. Download the Arial Unicode MS font into the selected font library. The font is available from
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http://www.microsoft.com/typography/fonts/family.aspx?FID=24.
3. Restart SiteScope.

Import/Export Content User Interface
This section includes:
l

"Export Template Dialog Box" below

l

"Export Content Package Wizard" on the next page

l

"Create Manifest Page" on page 839

l

"Select Templates Page" on page 840

l

"Select Files Page" on page 841

l

"Export Page" on page 843

l

"Summary Page" on page 844

l

"Template Import Dialog Box" on page 844

l

"Import Content Package Dialog Box" on page 845

Export Template Dialog Box
This dialog box enables you to export templates for use in other SiteScope installations. This enables
you to replicate standardized monitor configurations across the enterprise. After exporting, the template
still remains in the template container.
To access

Select the Templates context. In the template tree, right-click the template container
object that contains the template or templates you want to export, and select Export.
You can also right-click a template in the template tree and click Export.

Important
information

l

l

Relevant
tasks

SiteScope templates are stored as binary data. This is different from the textbased monitor sets used in earlier versions of SiteScope. Any changes to
templates must be performed using the SiteScope interface.
The template export and import flow does not contain SNMP Trap Preferences.
Therefore, when exporting and importing a template that contains references to
SNMP trap preferences, you should manually create these preferences, and
manually update the SNMP Traps in the imported template.

"How to Export and Import a Template" on page 827
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See also

l

"Common Monitor Settings" on page 283

l

"Create Templates" on page 782

l

"Export and Import Templates and Content Packages" on page 826

l

"Template Tree" on page 41

User interface elements are described below:
UI
Element
File
Name

Description
1. Click the File Name button to open the Save dialog box where you can browse and
select the location where you want to save the file for export.
2. In the File Name field in the Save dialog box, enter a name that is descriptive of the
template or templates to be exported.
3. Click Save to return to the Export Template dialog box. The path and file name you
selected are displayed in the File Name field in the Export Template dialog box.

Template Select the templates you want to export.
Tree
Default value: No templates within the template container are selected.

Export Content Package Wizard
This wizard enables you to export one or more templates and their dependencies to a content package.
Content packages are required for sharing Custom monitors, or monitors with extension files like
scripts, with other SiteScope users. This enables you to replicate standardized monitor configurations
across the enterprise.
To access

Select the Templates context. In the template tree, right-click the template or
template container that you want to export to a content package, and select Export >
Content Package.
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Important
information

l

l

l

Relevant
tasks

l

l

Wizard
map

Only user-defined templates can be exported to content packages (imported
templates, solution templates, and Monitor Deployment Wizard templates cannot
be exported to content packages).
To be able to export templates to content packages, you must have Add, edit or
delete templates permissions. For details on user permissions, see
"Permissions" on page 744.
The template container from which the export wizard is started, is designated as
the root container for the export. All ancestor containers of a selected template, up
to and including the root container, are exported with the template. A container
which does not have a descendant template cannot be exported. To export a
template without any container, start the export flow by right-clicking the template.
"Export Content Package Wizard" on the previous page
"How to Create, Export, and Import a Template Extension Content Package" on
page 833

This wizard contains:
"Create Manifest Page" below > ("Select Templates Page" on the next page) >
"Select Files Page" on page 841 > "Export Page" on page 843 > "Summary Page" on
page 844.

See also

l

"Create Content Packages" on page 825

l

"Export and Import Templates and Content Packages" on page 826

l

"Create Custom Monitors" on page 319

l

"Share SiteScope Content on the HP Live Network" on page 892

l

"Template Tree" on page 41

Create Manifest Page
This wizard page enables you to create the content package manifest where information about the
content package is stored. This page is part of the Export Content Package Wizard. Refer to "Export
Content Package Wizard" on the previous page for important information on the wizard.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Name

The name of the content package.

Description

Description of the content package.

Provider URL

The URL of the content package provider.
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UI Element

Description

Provider company

The company name of the content package provider.

Version

The version of the content package.

Supported
SiteScope versions

The operating systems on which SiteScope should be installed in order to
support the content in the content package.
Select an operator (">=" greater than or equal to, or "=" equals) , and enter
the version number for determining the supported SiteScope versions
required for the content package.
Note:
l

l

When using the "=" operator, you can enter multiple versions, separated
with a comma (",").
The version number must consist of a minimum of 3 digits.

Example:
l

l

Supported
SiteScope server
operating systems

11.2 or 11.20 indicate that the content package is supported on
SiteScope 11.2x versions.
11.12 indicates that the content package is supported on SiteScope
version 11.12.

The operating systems on which the SiteScope server is supported.
Note: At least one operating system must be selected.
Default value: Windows and UNIX are selected.

Select Templates Page
Note: This page is available when selecting a template container only.
This wizard page enables you to select the user-defined templates to include in the content package.
This page is part of the Export Content Package Wizard. Refer to "Export Content Package Wizard" on
page 838 for important information on the wizard.
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element

Description

<User-defined
templates>

The user-defined templates included in the content package.
By default, all available user-defined templates in the template container
are selected.
To clear the selection, click the Clear Selection

button.

Note: It is not mandatory to select any templates.

Select Files Page
This wizard page enables you to select the files associated with the selected templates to include in
the content package. This page is part of the Export Content Package Wizard. Refer to "Export
Content Package Wizard" on page 838 for important information on the wizard.
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element

Description

<SiteScope The files to include in the content package.
files>
By default, all files from packages associated with the selected templates are
selected. You can add or remove files as required.
To clear the selection, click the Clear Selection
To select all files, click the Select All

button.

button.

Note:
l

l

l

l

l

l

l
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It is not mandatory to select any files.
Only files from packages that you have created (under the <SiteScope root
directory>\packages\workspace directory) are displayed for selection, except
the contents of the \templates and \META-INF folders. Content from packages
that you have imported (under the <SiteScope root
directory>\packages\imported directory) cannot be exported and are not
displayed.
You cannot select files that have identical file names.
If the filename of a file selected for exporting is not in ASCII characters, its name
might be corrupted in the output zip file.
Files selected from the \classes, \conf, or \lib folders from different packages are
all merged into the same \classes, \conf, and \lib folder in the exported content
package.
If you go back and select additional templates from the Select Templates page,
files associated with these templates are not selected by default in the Select
Files tree; you need to manually select the files you want to include from the
corresponding packages in the content package.
The following folders under <SiteScope root directory>\packages\workspace
are also displayed:
n

\scripts

n

\scripts.remote

n

\templates.mail

n

\templates.mail.subject

n

\templates.mib

n

\templates.os
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UI Element

Description
Extension files you select from these folders are included in the exported content
package under a set of identically named folders.

Export Page
This wizard page enables you to select the name and location where you want to save the content
package file. It also enables you to review your selections in the previous pages. This page is part of
the Export Content Package Wizard. Refer to "Export Content Package Wizard" on page 838 for
important information on the wizard.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element

Description

File name

Name and path of the content package file. You can either:
l

l

Enter the path and name of the content package file, or
Click the Browse button, and select the location where you want to save the
content package file for export. In the File Name field in the Open dialog box, enter
a name that is descriptive of the content package to be exported, or select an
existing file to overwrite, and click Open. The path and file name you selected are
displayed in the File name field.

Note:
l

l

l

Manifest

Files are automatically saved in zip format. A '.zip' extension is automatically
appended to the file name by the wizard.
The file path cannot end with a directory separator ('\' or '/'); a legal file name needs
to be appended to the path.
Empty spaces and the following special characters are not supported in the file
name: \ " | > < ^

Displays the content package information that was entered in the Create Manifest
page.

Selected
The templates to be included in the content package (selected in the Select Templates
Templates page).
Selected
Files

The files to be included in the content package (selected in the Select Templates
page).

Export

Exports the selected files to a zip file on the local file system.

HP SiteScope (11.31)

Page 843 of 1395

Using SiteScope
Chapter 61: Export and Import Templates and Content Packages

Summary Page
This wizard page displays the status of the content package, and if the package is successfully
created, it provides a link to content package zip file. This page is part of the Export Content Package
Wizard. Refer to "Export Content Package Wizard" on page 838 for important information on the
wizard.
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<Summary> Reports the export status of the content package.
If the package was successfully exported, it displays a link with the name and path
of the zip file to which the content package was exported. Click the link to open the
folder where the export file was created.
If SiteScope was unable to export the content package, the reasons for failure are
displayed.

Template Import Dialog Box
This dialog box enables you to import template configurations from other SiteScope installations. This
enables you to replicate standardized monitor configurations across the enterprise.
To
access

Relevant
tasks
See also

Select the Templates context. In the template tree, right-click the template container
into which you want to import the template or content package, and click Import >
Template.
l

"How to Export and Import a Template" on page 827

l

"Share SiteScope Content on the HP Live Network" on page 892

l

"Common Monitor Settings" on page 283

l

"Create Templates" on page 782

l

"Export and Import Templates and Content Packages" on page 826

l

"Template Tree" on page 41

l

"Share SiteScope Content on the HP Live Network" on page 892
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User interface elements are described below:
UI
Element
File
Name

Description
The name of the template file to be imported.
Click the Browse button to browse and select the location of the file you want to import.

Override Select this option if you want templates from the imported template file to override
existing
existing templates with the same name.
templates
Note: If a template container in the template tree has the same name as the template
container from the imported file, selecting this option overrides the existing templates
with the same name within the container and merges other templates from the imported
file with existing templates.

Import Content Package Dialog Box
This dialog box enables you to import content packages that may include one or more templates and
their dependencies from other SiteScope installation. Dependencies are additional files such as jars
and configuration files. When exporting a custom monitor, the monitor template and the additional jars
used in the script and other resources are packed into a content package. This enables you to replicate
standardized monitor configurations across the enterprise.
To
access

Relevant
tasks
See also

Select the Templates context. In the template tree, right-click the template container
into which you want to import the template or content package, and click Import
> Content Package.
l

"How to Export and Import a Template" on page 827

l

"Share SiteScope Content on the HP Live Network" on page 892

l

"Common Monitor Settings" on page 283

l

"Create Templates" on page 782

l

"Export and Import Templates and Content Packages" on page 826

l

"Template Tree" on page 41

l

"Share SiteScope Content on the HP Live Network" on page 892
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User interface elements are described below:
UI
Element
File
Name

Description
The name of the content package file to be imported.
Click the Browse button to browse and select the location of the file you want to import.
Note that the file browser displays zip files only. Content packages must contain at
least one template. Each template can contain various types of monitors; custom and
regular.
For more details on content packages, see "Create Content Packages" on page 825.

Override Select this option if you want templates from the imported content package to override
existing
existing templates with the same name.
templates
Note: If a template container in the template tree has the same name as the template
container from the imported file, selecting this option overrides the existing templates
with the same name within the container and merges other templates from the imported
file with existing templates.
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You use templates to rapidly deploy sets of monitors that check systems in the infrastructure that
share similar characteristics. After you create and configure templates, you deploy them in the
SiteScope hierarchy. You can deploy templates directly from the user interface, or you can deploy
templates from an external Comma Separated Value (CSV) file.

To access
Select the Templates context. In the template tree, right-click a template, and select Publish
Changes.

Learn About
Deploying Templates Overview
After creating a SiteScope monitoring template, you can deploy templates to a group in the following
ways:
l

l

l

l

l

You can deploy a single template, or deploy multiple templates simultaneously to a group from the
user interface. For task details, see "How to Deploy Templates Using the User Interface" on the
next page.
You can perform mass deployments of a single template using a CSV file external to the SiteScope
user interface. A CSV file is better suited for performing mass deployments, since it is easier to
enter and update all the template variable values in one CSV file. For details, see "Deploy a
Template Using a CSV File" on the next page
You can deploy a template using an XML file external to the SiteScope user interface. For details,
see "Deploy Templates Automatically Using an XML File" on page 861.
You can also deploy templates from the Web user interface (Unified Console). For details, see
"Manage View" on page 1116.
When SiteScope is integrated with HPOM, you can centrally manage and deploy templates from
multiple SiteScope instances from within HPOM. For details, see the section on Centralized
Template Management from HPOM in Integrating SiteScope with HP Operations Manager
Products in the SiteScope Help. You can check the HP Software Integrations site for the latest
version of this guide.

If you subsequently want to make changes to the source template, you can automatically publish the
changes to SiteScope objects deployed by the template using the Publish Template Changes Wizard.
For details on updating templates, see "Publish Changes to Templates" on page 877.

HP SiteScope (11.31)

Page 847 of 1395

Using SiteScope
Chapter 62: Deploy Templates

Note: When deploying monitors and groups using a template, monitor and group dependencies are
also published. This enables the template to automatically write the groups and monitors into their
proper place in the tree and automatically create any number of dependencies, without you having
to do this manually. For details and recommendations, see "Dependencies When Configuring
Template Monitors and Groups" on page 257.

Deploy a Template Using a CSV File
After you create and configure templates, you deploy them in the SiteScope hierarchy. You can deploy
templates directly from the user interface (see "How to Deploy Templates Using the User Interface"
below), or you can deploy templates from an external Comma Separated Value (CSV) file. The CSV file
is used to deploy the variable values defined in the template.
Advantages of using SiteScope CSV template deployment include:
It is better suited than the user interface for performing mass deployments, since it is easier to enter
and update all the template variable values in one CSV file.

l

You can perform multiple deployments at one time, without having to manually enter variable values
for each deployment in the user interface.

l

The template is deployed silently—the template deployment request is submitted to a queue and
the deployment is handled in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted requests and
their corresponding deployment results are logged to <SiteScope root directory>\logs\silent_
deployment.log.

l

Note: The maximum queue length for silent deployment is 2000 (each line in a CSV file
represents one deployment in the queue).
For details on how to perform this task, see "How to Deploy Templates Using a CSV File" on page 850.

Tasks
How to Deploy Templates Using the User Interface
This task describes the steps involved in deploying SiteScope templates using the user interface.
Tip:
l

l

For mass deployments of a single template, you can also deploy templates using a CSV file.
For concept details, see "Deploy a Template Using a CSV File" above.
You can also deploy templates from the Web user interface (Unified Console). For details, see
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"Manage View" on page 1116.
l

You can also deploy and update the template using an XML file external to the SiteScope user
interface. For topic details, see "Deploy Templates Automatically Using an XML File" on page
861.

1. Prerequisites
n

Create a SiteScope monitoring template or select an existing user-defined template from the
templates tree. For task details, see "How to Create a Monitoring Structure Using a Template"
on page 794.

n

If you intend to deploy monitors to multiple servers at the same time, you must use a variable
as the Host value for the template remote server. On deployment, specify multiple server
names separated by commas (",") for the host variable.

2. Deploy a single template - optional
a. Deploy the template to a group.
o

From the monitor tree, right-click the group into which you want to deploy the template, and
select Deploy Template. In the Select Template dialog box, select the template you want
to deploy. For user interface details, see "Select Template Dialog Box" on page 317.

o

From the template tree, right-click the template you want to deploy, and select Deploy
Template. In the Select Group dialog box, select a group into which you want to deploy the
template. Alternatively, you can click the New Group button and create a new group to
which you can deploy the template. For user interface details, see "Select Group Dialog
Box" on page 855.

b. In the Deployment Values dialog box, enter the required variable values in the entry boxes
displayed. The entry boxes displayed correspond to the template variables used in the
template objects. For user interface details, see "Deployment Values Dialog Box" on page
857.
Example:
If you deploy the Windows basic template from the Template Examples folder in the
template tree to a SiteScope group, the following entry boxes are displayed in the
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Deployment Values input window.

3. Deploy multiple templates - optional
a. From the template tree, right-click any template container, and select Deploy Template. In
the Select Group dialog box, select a group into which you want to deploy the templates.
Alternatively, you can click the New Group button and create a new group to which you can
deploy the template. For user interface details, see "Select Group Dialog Box" on page 855.
b. In the Deploy Multiple Templates dialog box, perform the following:
o

In the left pane, select the templates that you want to deploy to the group. If you select a
template container, all templates within that container are automatically selected.

o

In the right pane, enter the required variable values in the entry boxes displayed.

o

Below the variable values section in the right pane, configure the permanent options for all
the templates being deployed.
For user interface details, see "Deploy Multiple Templates Dialog Box" on page 855.

4. Results
A summary of the template deployment is displayed. If the deployment is successful, the template
objects are added to the monitor tree.
If a template deployment fails, a message displays reasons for the failure. A template monitor
might fail to deploy, for example, in the case of a Disk Space monitor, if the disk drive specified in
the template does not exist on the deployed server.

How to Deploy Templates Using a CSV File
This task describes the steps involved in deploying a SiteScope template using a CSV file.
Tip:
l

Alternatively, you can deploy templates using the user interface. For details, see "How to
Deploy Templates Using the User Interface" on page 848.
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l

l

You can also deploy templates using a CSV file from the Web user interface (Unified Console).
For details, see "Manage View" on page 1116.
You can also deploy and update the template using an XML file external to the SiteScope user
interface. For details on this topic, see "Deploy Templates Automatically Using an XML File"
on page 861.

1. Prerequisites
n

Create a new SiteScope monitoring template or select an existing user-defined or solution
template from the templates tree. For task details, see "How to Create a Monitoring Structure
Using a Template" on page 794.

n

To deploy a solution template using a CSV file, you must first make a copy of the solution
template to a template container, and then make the changes required in the steps below to the
copied template.

n

Make sure that the template group name has a unique value in each deployment instance. You
can do this by using a variable in the group name, and entering a different variable value in each
deployment. You can see an example of this in the Template Examples folder where the group
name in Windows basic template contains the %%host%% variable.

2. Check the template variable display order
Before creating a CSV file, check the template variable display order for each variable. The
column order in the CSV file starts from 0, so make sure the template variable display order also
starts from 0 (instead of 1). This is to ensure that the correct columns from the CSV file are
mapped to the variables on deployment.
To check the template variable display order:
a. Select the Templates context. In the template tree, expand the template container that
contains the template that you want to deploy using a CSV file, and select the template.
b. Select the template variable you want to display first when deploying the template, and check
that the Display order in template value is 0.
c. Repeat for each variable in the template, making sure that the correct display number is used
(incremented by 1 each time).
Note: There must be a display order defined for each variable, otherwise the deployment
fails.
3. Create the CSV File
Open a new text file, and perform the following:
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a. Type a variable value for each variable necessary in the deployment, separated by a comma
(","). You must be familiar with all the variables defined for the template. Enter values in the
order that they are set to be displayed in the Display order in the template field (starting
from the variable with display order 0).
b. Add variable values on a separate line for each deployment instance.
Note:
o

Spaces are considered part of a field and should not be ignored.

o

You do not need to type non-mandatory variables or default variable values in the CSV
file. Instead, type a comma followed by a comma (",,") to represent the variable value.
However, if the deployment of one monitor fails, then the template deployment also
fails.

o

If you want to use a comma in a variable value, for the comma to be handled correctly,
you must type \, otherwise the comma is handled as a new variable. For example, to
deploy an LDAP monitor template with ou=Joe,cn=test,dc=com, type
ou=Joe\,cn=test\,dc=com.

o

If you want to use a backslash in a variable value, for the backslash to be handled
correctly, you must type \\ otherwise the backslash will be skipped. For example, to
deploy a file patch to monitor template with c:\file.txt, type c:\\file.txt.

o

When using credentials, we only recommend using a variable for the credential name,
since passwords cannot be encrypted in the CSV file.

c. Save the file in CSV format. After the template is deployed, a group is created for each line in
the CSV file.
Example:
To deploy the Windows basic template using a CSV file, make sure that the display
order for the variables is set as follows: host (0), user (1), password (2), and frequency
variables (3). The host template variable settings are displayed below.
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Then create a CSV file and enter host, user, password, and frequency values separated
by a comma, for each deployment instance (this is the variable display order used in the
template).

You do not need to enter a value in the CSV file for the Frequency variable (even though it
is a mandatory variable), because a default value has been set for this variable in the
template (provided you want to use the 600 seconds default value).
4. Deploy the template
a. After creating a CSV file for the template, deploy the template to a group.
o

From the monitor tree, right-click the group into which you want to deploy the template, and
select Deploy Template Using CSV. In the Select Template dialog box, select the
template you want to deploy. For user interface details, see "Select Template Dialog Box"
on page 317.

o

From the template tree, right-click the template you want to deploy, and select Deploy
Template Using CSV. In the Select Group dialog box, select a group into which you want
to deploy the template. Alternatively, you can click the New Group button and create a
new group to which you can deploy the template. For user interface details, see "Select
Group Dialog Box" on page 855.
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b. In the Select CSV File dialog box, select the CSV file to use for template deployment. For
user interface details, see "Select CSV File Box Dialog Box" on page 859.
5. Results
If the deployment is successful, the template objects are added to the monitor tree. The monitor
tree updates itself periodically. Click Refresh in the tree toolbar to update the tree and check your
deployment.
You can also check the silent_deployment.log file for a summary of the deployment. For user
interface details, see "Log Files Page" on page 1184.
Note: Typed password values are not displayed in the log file, and instead of the real
password, you see a sequence of asterisks ("****").
Related tasks (from the Web UI - Unified Console): "How to Deploy Monitors from a Template
(Application Owner)" on page 1121.

Tips/Troubleshooting
Notes and Limitations
l

l

l

Template deployment fails if a template contains multiple groups with the same name, even if each
group has a different parent group.
Multiple deployments of a template in the same directory fails if the template group name does not
include a variable, because the group name is not unique.
When deploying a template that uses regular expressions for monitor counters, the Verify monitor
properties with remote server option must be selected, otherwise the monitor deployment fails.

Deploy Templates User Interface
This section includes:
l

"Select Group Dialog Box" on the next page

l

"Deploy Multiple Templates Dialog Box" on the next page

l

"Deployment Values Dialog Box" on page 857

l

"Select CSV File Box Dialog Box" on page 859
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Select Group Dialog Box
This dialog box enables you to select a group in the monitor tree to which you can deploy templates.
Alternatively, you can select the SiteScope node, and create a new group to which you can deploy
templates.
To
access
Relevant
tasks

See also

Select the Templates context. In the template tree, right-click the template you want to
deploy, and select Deploy Template or Deploy Template Using CSV.
l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Publish Template Updates to Related Group Deployments" on page 878

l

"How to Deploy a SiteScope Solution Template" on page 903

l

"Publish Changes to Templates" on page 877

l

"Template Tree" on page 41

User interface elements are described below:
UI
Element Description
Represents the SiteScope root group. You can deploy the templates in the SiteScope
root group, or click the New Group button and create a new group to which you can
deploy the templates.
Represents a SiteScope monitor group or subgroup (with enabled monitors/with no
monitors or no enabled monitors). Select the group to which you want to deploy the
templates, or click the New Group button and create a new group in which you can
deploy the templates.
Represents the collection of available health monitors that are deployed to check proper
functioning of SiteScope monitors.

Deploy Multiple Templates Dialog Box
This dialog box enables you to select multiple templates for deployment to a group simultaneously
(instead of deploying each template separately).
To access

Select the Templates context. In the template tree, right-click any template container
and select Deploy Template. In the Select Group dialog box, select the group in
which you want to deploy the templates and click OK. The Deploy Multiple Templates
dialog box opens.

HP SiteScope (11.31)

Page 855 of 1395

Using SiteScope
Chapter 62: Deploy Templates

Important
information

To deploy monitors to multiple servers at the same time, enter the server names or
addresses separated by a comma (","). When doing this, the value in the Host
property for the template remote server referenced by the monitors must consist of
a variable value, and only one variable is allowed.

l

You can deploy a template, regardless of its content, provided you have edit
permissions on the deployment target group. You do not require edit permissions
on the template objects such as monitors, remotes, and alerts.

l

An error message is displayed if a monitor cannot be deployed. This may occur,
for example, when deploying the Disk Space monitor template, if the disk drive
does not exist on the deployed server.

l

Relevant
tasks

See also

l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Deploy Templates Using the User Interface" on page 848

l

"How to Publish Template Updates to Related Group Deployments" on page 878

l

"Publish Changes to Templates" on page 877

l

"Template Tree" on page 41

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Select Templates (left pane)
<template
tree>

Select the templates that you want to deploy from the template tree.
l

l

When you select a template container, all templates within that container are
selected. If you select the SiteScope root, all templates in the template tree are
selected.
The icon displayed to the left of the SiteScope root or a template container
indicates that not all templates within SiteScope or the specific container have
been selected.

Template Deployment Settings (right pane)
<template
variable
values>

A list of variables used in each selected template is displayed under a label with the
full path of the corresponding template in the right pane. Enter deployment values for
the variables (variables that are mandatory are denoted by a red asterisk).
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UI Element

Description

Silent
Submits the template deployment request to a queue. SiteScope handles the
deployment deployment in the background, enabling you to continue to use SiteScope without
having to wait for the template deployment process to finish. All submitted requests
and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in each template
against the remote servers on which the templates are being deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote servers after the templates
servers
have been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected

Deployment Values Dialog Box
This dialog box enables you to enter variable values when deploying the template.
To access

Important
information

Select the Templates context. In the template tree, right-click the template that you
want to deploy (it must contain variables), and select Deploy Template. In the Select
Group dialog box, select the group in which you want to deploy the template and click
OK. The Deployment Values dialog box opens.
l

l

l
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To deploy monitors to multiple servers at the same time, enter the server names or
addresses separated by a comma (","). When doing this, the value in the Host
property for the template remote server referenced by the monitors must consist of
a variable value, and only one variable is allowed.
You can deploy a template, regardless of its content, provided you have edit
permissions on the deployment target group. You do not require edit permissions
on the template objects such as monitors, remotes, and alerts.
An error message is displayed if a monitor cannot be deployed. This may occur,
for example, when deploying the Disk Space monitor template, if the disk drive
does not exist on the deployed server.
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Relevant
tasks

See also

l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Deploy Templates Using the User Interface" on page 848

l

"How to Publish Template Updates to Related Group Deployments" on page 878

l

"Publish Changes to Templates" on page 877

l

"Template Tree" on page 41

User interface elements are described below:
UI Element

Description

Variable Values
For details of deployment values for SiteScope solution templates, see the documentation for the
specific solution template ("Deploy Solution Templates" on page 896).
<variable
name>

Each variable that is referenced in a template object prompts the display of a
corresponding entry box when the template is deployed. The variable name is
used as a label for the text entry box. Enter deployment values for the variables.
For details on configuring and deploying a specific SiteScope solution template,
see the help for the specific solution template in "Deploy Solution Templates" on
page 896.

Silent
deployment

Submits the template deployment request to a queue, and have SiteScope handle
the deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All
submitted requests and their corresponding deployment results are logged to
<SiteScope root directory>\logs\silent_deployment.log.
Default value: Not selected
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UI Element

Description

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is being deployed.
Note:
l

l

l

When this option is selected, deployment time is slowed due to the remote
connection.
When deploying a template that uses regular expressions for monitor
counters, this option must be selected, otherwise the monitor deployment
fails.
When deploying a template for a customizable monitor, clearing this check
box has no effect, since the monitor configuration properties in the template
must be checked against the remote server on which the template is being
deployed.

Default value: Selected
Test remote
servers

Tests the connection created from the template remote server after the template
has been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Note: This option is displayed only when deploying a template that includes a
remote server.
Default value: Not selected

Select CSV File Box Dialog Box
This dialog box enables you to select the CSV file to use when deploying a template.
To
access

Use one of the following:
l

l

Relevant
tasks
See also

Open the Templates context. In the template tree, right-click the template you want
to deploy, and select Deploy Template Using CSV. In the Select Group dialog box,
select the group to which you can deploy the template, and click OK.
Open the Monitors context. In the monitor tree, right-click the group to which you
want to deploy the template, and select Deploy Template Using CSV. In the Select
Template dialog box, select the template that you want to deploy, and click OK.

l

"How to Create a Monitoring Structure Using a Template" on page 794

l

"How to Deploy Templates Using a CSV File" on page 850

l

"Publish Changes to Templates" on page 877

l

"Template Tree" on page 41
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User interface elements are described below:
UI Element

Description

CSV file

Comma Separated Values (CSV) file to use for deploying the variable values
defined in the template. Click the Select button, and select a CSV file to use
for the template deployment.
Note: You can only use a file with a CSV extension.

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the
remote connection.
Default value: Selected

Test remote
servers

Tests the connection to the template remote server after the template has
been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Note: This option is displayed only when deploying a template that includes a
remote server.
Default value: Not selected
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XML File
SiteScope enables you to create an XML file to use for automatically deploying SiteScope template or
solution template in a highlighted template container. After you generate the XML file, you can edit the
file and use it to deploy the templates from the file directory external to the SiteScope user interface.

To access
Select the Templates context. In the template tree, right-click the template container for which you
want to create an auto deploy XML file, and select Generate XML.

Learn About
Deploying Templates Automatically Overview
SiteScope enables you to create an XML file to use for automatically deploying the templates in the
highlighted template container. After you generate the XML file, you can edit the file and use it to deploy
the templates from the file directory not in the SiteScope user interface.
SiteScope enables you to automatically deploy a SiteScope template or solution template using an
XML file external to the SiteScope user interface. The XML file is used to deploy the objects defined in
the template, which must include a parent group and can include subgroups, monitors, a remote server,
alerts, and variable definitions. You can edit the XML file to assign variable definitions for mandatory,
global, and instance variables.
For details on user-defined templates, see "Create Templates" on page 782. For details on predefined
solution templates, see "Deploy Solution Templates" on page 896.
You can also use the auto template deployment to publish template changes to deployed groups. The
auto template deployment uses the same functionality as the Publish Template Changes Wizard. For
details on how the wizard works, see "Publish Changes to Templates" on page 877.
Auto template deployment is an alternative to using the user interface to deploy templates and publish
template changes to deployed groups. It is better suited than the user interface for working with scripts
and deploying onto multiple SiteScopes. This is because it uses standard XML scripting and can be
deployed onto multiple SiteScopes using one file.

Create and Work with the XML File
Use one of the following options to create the XML file:
l

Generate and edit your XML in any tool that supports text. The file must be based on the XSD file
supplied in the SiteScope file directory. The XSD file is a basic XML file which already includes the
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appropriate tags, elements, and attributes for creating your own version of the deployment XML.
l

Generate the deployment XML file using the SiteScope interface from a template container or
solution template. Each template container and solution template includes the option to generate
this auto template deployment XML file. For details, see "Generate Auto Deployment XML User
Interface" on page 868.

The XML you use, whether generated from the template or solution template, or generated manually,
must be a valid XML and match the ATD schema (XSD). You can use the dedicated tool to validate
your XML file.
Deploying the XML file is dependent on the target SiteScope having the relevant template or solution
template in its monitor tree. You deploy the template or solution template by copying the XML file into
the persistency folder of the target SiteScope with the relevant template or solution template. You can
group several deployments into a single XML file.

Publish Template Changes Using the XML
You can also use the auto template deployment XML to publish template changes to update the values
or structure of a deployed group. If the group's Source Template field is identified as the same
template that the XML is referencing, you can update the values and objects of the group using the auto
template deployment XML.
The XML uses the same functionality as the Publish Template Changes Wizard but without having to
access the user interface. In the XML file, you can identify values for variables to use for publishing the
changes in the template. For details on the wizard and the template update feature, see "Publish
Changes to Templates" on page 877.
You can use auto template deployment to publish the changes made to a template onto the template's
deployed groups in the same way you use the XML to create a group deployment. After the template
has been modified, you create the XML and copy/paste the edited XML into the persistency folder of
the target SiteScope machines.
Update Deployment XML Tag Details
The XML file for updating the values or objects of a deployed group must use the
<sitescope:templateDeploymentUpdate> tag (and not the <sitescope:templateDeployment> tag
used for deploying the template). For details on the elements and attributes to use in the XML file, see
"XML Tag Reference" on page 873.
Within the <sitescope:templateDeploymentUpdate> tag, you can select to give the
enableDeleteOnUpdate attribute a value of yes to make sure that any objects within the deployed
groups that do not appear in the template referenced by the auto template deployment XML are deleted
when updating the deployment with the XML file. Enter a value of no to make sure that all objects
within the group are retained, even if they do not appear in the template referenced by the XML file, after
the updating the deployment. For details on this option in the Publish Template Changes Wizard, see
Enable delete on update in the "Select Deployed Groups Page" on page 884.
To successfully perform the update, you must define the target SiteScope group name of the deployed
group as the value of the deploy:fullPathToDestinationGroup tag. The fullPathToDestination must
end with the root group of the deployment, the equivalent of the template's root group. Each deployment
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section updates one group so if you have multiple groups, you must define separate deployment update
sections for each and define the group name for each.
Template Update Report
After performing the auto template deployment update, a report is available in XML format. The report
file is named with the name of the XML file along with a time stamp and the string_reports. These
reports are available in the following location:
<SiteScope root directory>\persistency\autodeployment\reports.
The report is in XML format and includes the following tags at the beginning:
l

totalNumberOfDeployments

l

totalNumberOfFailedDeployments

l

totalNumberOfSucDeployments

The <publishChangesSummaryPage> section of the XML appears for each deployment instance
listing the details of what has been updated. Unsuccessfully changed deployments are specified first in
the file.
This file is an XML version of the PDF file created by the Publish Template Changes Wizard if using the
SiteScope user interface to update deployed groups. For details on the report, see "Publish Template
Changes Summary Report" on page 888.

Tasks
How to Deploy a Monitoring Structure Using an XML File
This task describes how to perform an auto template deployment. You can follow the same steps for
deploying a Solution Template.
1.

Prerequisites
Each SiteScope into which you want to automatically deploy a template must include the template
within a template container. The template must have a group object at the top level. All other
objects must be created within that group. The template can contain subgroups, monitors, alerts,
one remote server, and variables.
If you are working with multiple SiteScopes:
n

You can create the template in one SiteScope and export it to other SiteScopes using the
Export/Import options in the Template containers context menu. For task details, see "Export
Template Dialog Box" on page 837 and "Template Import Dialog Box" on page 844.

n

If you are working in BSM, you can copy templates from one SiteScope to another using the
Sync SiteScope Wizard in SAM Administration. For user interface details, see Sync
SiteScopes Wizard in the BSM Application Administration Guide in the BSM Help.

HP SiteScope (11.31)

Page 863 of 1395

Using SiteScope
Chapter 63: Deploy Templates Automatically Using an XML File

2.

Create the XML file
You can create the XML file using one of these options:

3.

n

Right-click the template container and select Generate XML in the context menu. When
deploying solution templates, this option appears at the template level. For user interface
details, see "Generate Auto Deployment XML User Interface" on page 868.

n

Create the XML file using a dedicated XML application. The file must be a valid XML file and
based on the XSD files located in the following directories:
o

<SiteScope root directory>\conf\xsds\deploy.xsd

o

<SiteScope root directory>\conf\xsds\sitescope.xsd

Edit the XML file
You must edit the XML file to enter the values necessary for deployment. For details on editing the
file and a sample of the file, see "XML File Example and Variables" on page 870.
For details on the XML file's tags, see "XML Tag Reference" on page 873.
Note: If the XML is generated from the user interface, mandatory variable fields are generated
based on the templates mandatory variables. If you create the XML file, and there are fields
that are mandatory for successful deployment, you must make sure that these fields have
been assigned values before deploying the XML.

4. Specify login details (mandatory if working in a secure environment)
If you are working in a secure environment, you must give a valid user name and password for
each deployment. Login credentials can also be used in the audit.log file to track the identity of
users making template changes.
n

By default, the Access controlled property is set to true in Preferences > Infrastructure
Preferences > Custom Settings which means that SiteScope is used in secure mode. To use
auto template deployment when SiteScope is in secure mode, you must add the following
string to your generated XML file on the SiteScope machine for each deployment (after
</deploy:fullPathToDestinationGroup>):
<deploy:login user="<myUserName>" password="<myPassword>" />
Use the encryption tool and follow the steps in the procedure for encrypting the user name and
password. For details, see the next step.

n

If you use a non-secure environment, this string should look like:
<deploy:login user="" password="" />

n

If you set Access controlled to false, you can use auto template deployment without adding
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the string to your XML file, and it will pass successfully regardless of whether you are using a
secure environment.
Note: XML files generated in earlier versions of SiteScope are supported, provided that
you add the login when working in a secure environment.

5.

Encrypt fields such as passwords - optional
Use the encryption tool for deploying templates that include fields that you do not want to appear in
viewable text. This tool encrypts the field only in the XML; the templates themselves control the
encryption of variables in the persistency directory.
a. Run the following batch file:
o

For Windows: <SiteScope root directory>/tools/AutoDeployment/encrypt_
password.bat

o

For UNIX: <SiteScope root directory>/tools/AutoDeployment/encrypt_password.sh

b. Open a command prompt window.
o

In Windows, drag and drop the file into your command prompt window.

o

In UNIX, you must run the .sh file from its directory.

c. Enter space and the password value (for example Mypassword). Click ENTER.
d. Use the returned string as a value for the encrypted variable in the XML file. You much change
the value of the attribute encrypted to yes and the value of the variable attribute to the
returned string.
For example, the following value was generated by the encryption tool: <deploy:variables
encrypted="yes" name="password" value="(sisp)d5JLOSWaVfE="/>
6.

Validate the XML file
We recommend validating the XML file before it is deployed. If the XML file does not pass
validation when attempting to deploy, the deployment fails.
Use the validation tools located in the following directories:
n

For Windows: <SiteScope root directory>/tools/AutoDeployment/validate_template_
xml.bat

n

For UNIX: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.sh

For concept details, see "XML Validator" on page 873.
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7.

Copy the validated XML to the SiteScope server machines
Copy the XML file into the \persistency\autodeployment directory on each SiteScope machine
where you want to deploy the templates in the XML.
The templates are automatically deployed every two minutes by default. You can change the
frequency in Infrastructure Preferences > Custom Settings in the Auto Deployment Check
Frequency (seconds) field.

8.

Check if deployment was successful
When you copy the XML file, for both deploying and updating, into the persistency folder of the
target SiteScope, the file is copied into one of two directories as follows:
n

<SiteScope root directory>\persistency\autodeployment\successHistory directory
includes those XML files that deployed or updated successfully all instances of the deployed
group.

n

<SiteScope root directory>\persistency\autodeployment\failHistory directory includes
those XML files that failed to deploy or update any instance of the deployed group. If even one
instance failed and all the others succeeded, the XML is published to this folder.

The XML file name is changed to include an underscore and a timestamp added to the original
name of the XML file. For example the XML file named CPUgroups.XML that succeeded in
deploying all its groups and instances is saved to the <SiteScope root
directory>\persistency\autodeployment\successHistory directory and is now named
CPUgroups_1203951216931.xml.
You can also check the SiteScope's Error Log.

How to Update a Deployment
This task describes how to use the auto template deployment XML to update an existing, deployed
group. You can update the structure of the deployment if the template was changed or update object
properties by giving new values to the variables that are declared in the template for those properties.
This task follows the same steps as the previous task to deploy a template with the exceptions and
additional information listed in the steps below.
1.

Prerequisites
The Source Template field of the deployed groups that you want to update must be identical to
the template in the XML deployment update file. This is in addition to the updated template existing
in the target SiteScope.

2.

Create and edit the XML file to update objects and values
When working with the XML file, you must do the following:

HP SiteScope (11.31)

Page 866 of 1395

Using SiteScope
Chapter 63: Deploy Templates Automatically Using an XML File

n

Use the <templateDeploymentUpdate> tag instead of the <templateDeployment> tag.

n

Enter a yes or no value for the enableDeleteOnUpdate attribute of the
<templateDeploymentUpdate> tag.

n

Define the deploy:fullPathToDestinationGroup tag with the group name to be updated as the
value for this tag.

For details on these tags and the update XML file, see Update Deployment XML Tag Details in
"Publish Template Changes Using the XML" on page 862.
3.

Copy the publish template update XML to the target SiteScopes
Copy the publish template update XML to the target SiteScope's persistency directory as you
would when deploying the auto template deployment XML file.

4.

Encrypt text such as a password - optional
For task details, see the encryption step in "How to Deploy a Monitoring Structure Using an XML
File" on page 863.

5.

Validate the publish template update XML
Use the validator tool to validate the edited XML file as you would when deploying the auto
template deployment XML file.

6.

Results report
After deploying the update auto template deployment XML, a results report file is created in XML
format. These reports are available in the following location: <SiteScope root
directory>\persistency\autodeployment\reports.
For user interface details, see Template Update Report in "Publish Template Changes Using the
XML" on page 862.
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UI Descriptions
Generate Auto Deployment XML User Interface
User interface elements are described below:
UI
Element

Description

File
Name

Name of the XML file to create. This is the file you can edit and use to automatically
deploy the templates in this template container.

Path

Location in which the XML file is saved. Accept the default location, or enter a different
location. If the path is empty, the XML file is saved to the root drive where SiteScope is
installed.
Default value: <SiteScope_install_path>\SiteScope\persistency\
autodeployment\drafts
Note: If an XML file has been generated previously using the same File Name and
Path, the previously saved XML file is not overwritten. The previous file is renamed with
the following addition: _bck<number of backup>. For example, if you enter
CPUtemplate as the File Name and accept the default location, the existing file in the
default folder becomes CPUtemplate.xml_bck1 and the current XML file being
generated is saved as CPUtemplate.xml.

Template Templates for which to create the XML file. The XML file's contents are based on the
Tree
objects in the template you select. For each template selected, the generated XML
includes a separate deploy section.

Tips/Troubleshooting
Note: All notes, limitations, and troubleshooting issues that apply to SiteScope templates,
solution templates, and the Publish Template Changes Wizard also apply to the functionality of the
auto template deployment.
This section describes troubleshooting and limitations when working with auto template deployment.
l

"User-Defined Templates" on the next page

l

"Publishing Template Changes to Deployed Groups Using XML" on the next page

l

"Solution Templates" on the next page
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l

"I18N Users" on the next page

l

"Characters Not Permitted in XML" on the next page

User-Defined Templates
l

Unable to Automatically Deploy Template with No Groups.
Problem: If you attempt to automatically deploy a template using an XML file where the template
has no parent group defined (that is to say, the template has monitors directly under the root
template), the deployment fails and the following error is written to the <SiteScope root
directory\logs\>error.log file:
[Autodeployment new XML detection] (XMLAutomationParser.java:294) ERROR Prerequisites of template structure are unmet. Template must be rooted by only
one group.
Note that Automatic deployment fails even if Allow creation of template monitors directly
under a template entity is selected in Preferences > Infrastructure Preferences > Template
Settings.
Workaround: Deploy the template manually (right-click the template in the Template tree, and then
select Deploy Template).

l

Other Issues Related to SiteScopeTemplates.
For other issues related to SiteScope templates, see Troubleshooting SiteScope Templates.

Publishing Template Changes to Deployed Groups Using XML
For limitations on using the auto template deployment XML to update an existing deployment, see
"Publishing Template Changes: Troubleshooting and Limitations" on page 882.

Solution Templates
You cannot perform auto template deployment for the following Solution Templates because the
variables in these solution templates are dynamically created and cannot be given a value in the XML
file:
l

JBoss Application Server 4.x

l

WebLogic Application Server

l

WebSphere 5.x Application Server

l

WebSphere 6.x Application Server
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I18N Users
l

l

Do not edit the XML file using Notepad. The file cannot be parsed because Notepad adds an extra
character to the beginning of the file. This character is not visible but prevents the file from being
parsed when not in English. Use Wordpad or an XML editor instead.
If the path to the SiteScope root directory includes non-English characters, the validation tool
cannot be used to validate the XML before it is copied to the SiteScope's persistency directory. This
means that there is no validation that the XML follows the XSD or that mandatory fields have
values.

Characters Not Permitted in XML
Avoid using the ampersand (&), quote marks ("), and angle brackets (< >) characters, as they are not
permitted in XML attribute values.
To escape illegal XML characters, use a common encoding, (for example, &amp; instead of &), or
enclose the character with the CDATA (character data) section. Information on XML escape
sequences is available from many publicly available web sites.

XML File Example and Variables
For a reference detailing all the XML tags, elements, and attributes included in the auto template
deployment file, see "XML Tag Reference" on page 873.
Each auto template deployment XML must begin with the following declarations:
l

l

<?xml version="1.0" encoding="UTF-8" ?> This states that this is an XML with UTF-8 character
encoding.
<sitescope:sitescopeRoot ...> This is the schema declaration. Despite the URLs mentioned, this
does not try to connect to any location outside of your SiteScope at any time.

Each section of the XML file begins with one of the following tags, with the instruction to perform one of
the following actions:
l

l

<sitescope:templateDeployment> Deploys a template or solution template. You can have
multiple instances within the same XML file.
<sitescope:templateDeployUpdate> Publishes changes to an existing deployment.

Within each action, you must specify the following:
l

l

<deploy:fullPathtoTemplate> The path to the template within the SiteScope tree in the user
interface, not including the SiteScope root node. In the XML file example, this value is
Templates/Windows.
<deploy:fullPathToDestinationGroup> The path, within the SiteScope tree, of the target group
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on which the action is performed. For example, in the XML file example, any template group objects
are created as subgroups within the following group SiteScope/Windows_Monitors.
This section contains the following topics:
l

"XML File Example" below

l

"Variables" below

XML File Example
Here is an example of the auto template deployment XML file. This file was generated from the user
interface.

Variables
After the template and destination have been specified, the next section of the XML file deals with the
template variables and values. The XML file gives you the flexibility of defining variables and their
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values, declaring mandatory variables, and determining if their corresponding values should be applied
globally across the deployment or per instance.
If you generated the XML file from the user interface and if a variable has a defined value, that value is
assigned to the variable in the XML file.

Mandatory Variables
A declaration of any mandatory variables in the template appears in the <deploy:mandatoryFields>
tag. If a variable is declared mandatory, a corresponding value for the variable must be defined in the in
the file.
If you generated the XML from the user interface and if the Mandatory option was selected when
creating or editing a variable, that variable appears in the <deploy:mandatoryFields> tag. You can
also manually add a variable name to this list to declare it mandatory.
In the file example above, group and frequency have been defined as mandatory variables. Values
for these variables must appear within the <deploy:variables> tags for either the
<deploy:globalVariables> or the <deploy:templateInstanceDeployVariables>.

Global Variables or Instance Variables
The optional <deploy:globalVariables> tag includes the default global template variables for the
deployment. Defining global template variables is optional. When you define a global template variable,
you can overwrite the variable's value by identifying a different variable value in the deployment
instance area of the file (<templateInstanceDeployVariables> tag). Global variable values can be
overwritten with a different value in each deployment instance.
Multiple instances of a template that are deployed into the same location onto the same SiteScope, as
seen in the XML file example, must include a variable for the group name. Group name must be made a
mandatory variable and given a different value in each deployment instance. The group template object
must have the same variable defined as its value. The template could include other groups whose
name value is not a variable and those groups would be deployed once.
In the XML file example above, there are two instances of the deployment, so a variable called group
has been defined as mandatory and a different value has been given to it in each instance deployment
(Critical_monitors and Minor_monitors). This results in two groups created under the group
object of the template with the same monitor objects.
The following groups would result from the XML file example being deployed:
l

SiteScope/Windows_Monitors/Critical_monitors in the first instance of the deployment.
Included in this group would be any monitors and alerts defined in the template. Any of the template
monitor objects whose frequency value was defined as the variable frequency would have a value
of 600 seconds (every 10 minutes).

l

SiteScope/Windows_Monitors/Minor_monitors in the second instance of the deployment.
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Included in this group would be any monitors and alerts defined in the template. Any of the template
monitor objects whose frequency value was defined as the variable frequency would have a value
of 6000 seconds (every hour and forty minutes). The connectToServer="no" attribute was added
to this group. This means that the monitor configuration properties in the template will not be verified
against the remote server on which the template is deployed.
The XML file example also contains a login with a user name and password (<deploy:login
user="admin99" password="(sisp)n9JRVALxIsq=" />). It is mandatory to specify a valid user
name and password for each deployment when using a secure environment. You can use the
encryption tool to encrypt the user name and password.
Note: If you have any system variables defined in a template (those defined by $$ and not %%),
they are treated as normal variables in the auto template deployment XML file. The same
limitations that apply to using system variables in templates apply to using them in the XML file.

XML Validator
The XML validator is a utility that validates the XML file against the schemas used by the auto template
deployment. It does not validate the SiteScope deployment itself. The path to the validator file is:
l

For Windows: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.bat

l

For UNIX: <SiteScope root directory>/tools/AutoDeployment/validate_template_xml.sh

This utility checks the structure of the XML against the XSD files to make sure that the contents of the
file are valid XML and correspond to the XSD. It also validates that there have been values defined for
all mandatory variables. The values can be defined either as global variables or deployment instance
variables. If the validation fails, the reason for the failure is printed to screen.

XML Tag Reference
The following tables list all the elements and attributes used in the auto template deployment XML files:
l

"Elements Table" on the next page

l

"Attributes Table" on page 875
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Elements Table
Elements

Description

sitescope:sitescopeRoot

This must be the first tag in the XML file giving the instruction to create
the deployment, the version of XML used, and the location of the XSD
file.
Note: This is the first element in all XML files related to SiteScope.

sitescope:template
Deployment

This tag enables the deployment of the template or solution template,
creating new group structures in the target SiteScope. This is the
default tag used in the XML file when generated from the user interface.

sitescope:template
DeploymentUpdate

This tag enables publishing the changes of a template that has been
updated. These changes can be applied to the monitoring structure of a
group whose Source Template field matches the template identified in
the XML. The XML file also enables you to update the values of the
variables used in the template.
For example, if you want to add alerts or an additional monitor to an
existing group that was created by a template, you can modify the
template and deploy it using this tag.

deploy:fullPathToTemplate This tag gives the full path, within the SiteScope tree, of the template
or solution template to be deployed.
Syntax:<template container name>/<template name>
deploy:fullPathTo
DestinationGroup

This tag gives the full path location within the SiteScope tree of the
group name where the deployed monitoring structure is to be created. If
this tag has no value, the deployment is created at the SiteScope node
level.

deploy:mandatoryFields

The values within this tag are those variables that were selected as
mandatory fields when the template was created. If there are any
values appearing within this tag, they must be given a value in the
<deploy:globalVariables> tag for global variables or the
<deploy:variables> tag for other variables. If there are no
corresponding values for these mandatory fields, the XML fails
validation.

deploy:globalVariables

This tag marks the section of the file that includes the variables that are
deployed across the entire selected template.
Includes attributes. For details, see the Attributes table below.
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Elements

Description

deploy:templateInstance
DeployVariable

This tag marks the section of the file that includes the variables that are
deployed per instance of the selected template.
If the same variable appears in the <deploy:globalVariables>, the
instance variable value overrides the global variable value only for the
instance in which it appears. All other instances have the value entered
in the <deploy:globalVariables> section.
Includes attributes. For details, see the Attributes table below.

deploy:variables

This tag defines the variables and their values.
Includes attributes. For details, see the Attributes table below.

Attributes Table
Parent Element

Attribute

Description

templateDeploymentUpdate

enableDeleteOnUpdat
e

Indicates whether any instances
of objects appearing in a
deployment of a template should
be deleted when not appearing in
the XML file used for updating the
structure of a deployment.
Possible values: yes, no
For details on this option, see
Enable delete on update in the
"Select Deployed Groups Page"
on page 884.
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Parent Element

Attribute

Description

deploy:globalVariables

description

(Optional) User description for the
deployment.

connectTo
Server

(Optional) Verifies the monitor
configuration properties in the
template against the remote
server on which the template is
being deployed. This is the default
behavior (even if this attribute is
not specified). To avoid
connecting to the remote server,
add connectToServer="no" to
the <deploy:globalVariables> or
<deploy:templateInstanceDepl
oy
Variable> tag.

deploy:templateInstanceDeployVariab
le

Possible values: yes, no
For details, see Verify monitor
properties with remote server in
the "Deploy Multiple Templates
Dialog Box" on page 855.
access
Controlled

(Optional) Tests the connection
created from the template remote
server after the template has been
deployed.
Possible values: true, false

deploy:variables

encrypted

Indicates whether the value of the
variable's field is encrypted or not.
Possible values: yes, no
To encrypt a value, use the
encryption tool to provide the
value for the variable. For details,
see "How to Deploy a Monitoring
Structure Using an XML File" on
page 863.
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You can make changes to the template, and publish the changes to all SiteScope objects deployed by
the template using the Publish Template Changes Wizard. If a change is required to a template object,
for example, a threshold value changes or a new monitor or alert is required, you can update the
template once and publish the changes to all deployed groups without having to update each object
individually.
You can also view how the actual monitored deployments comply with the standardized deployment as
defined in the source template using the Publish Template Changes Wizard. This ensures that any
changes in the monitored environment can be quickly updated in the monitoring infrastructure and that
the monitoring infrastructure is still compliant with the standards set in the source template.

To access
Select the Templates context. In the template tree, right-click a template, and select Publish
Changes.

Learn About
Publishing Template Changes Overview
When you deploy a template, the deployed parent group is automatically associated to the source
template. If you subsequently make changes to the source template, you can automatically publish the
changes to SiteScope objects deployed by the template using the Publish Template Changes Wizard.
The wizard enables you to update related deployed groups across the enterprise whenever the source
template is updated without having to update each object individually.
A deployed group consists of the groups, monitors, alerts, variables, and the remote server configured
in the template. For details on how to deploy a template, see the Deploy a Template step in "Deploy the
template" on page 799.
The Publish Template Changes Wizard enables you to update deployed groups in the following ways:
l

l

l

You can publish only the changes in the source template to the deployed groups. This creates
added objects and updates values of existing objects, but leaves other objects not in the source
template intact.
You can publish the changes in the source template to the deployed groups and have SiteScope
make the above changes and delete all other SiteScope objects that are not in the source template
from the deployed groups.
When publishing changes, you can have SiteScope ignore publishing changes to groups under the
root group. This enables:
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n

Deploying a template inside an existing deployed group and publishing template changes to the
deployed group without affecting SiteScope objects that are in the ignored group. This enables
deploying templates inside different deployed groups.

n

Deleting objects in deployed groups that were removed from the source template (when the
Enable delete on update option is selected), without removing other objects created in the
deployed group that were not part of the source template.

n

When deploying monitors and groups using a template, monitor and group dependencies are also
published. This enables the template to automatically write the groups and monitors into their
proper place in the tree and automatically create any number of dependencies, without you having
to do this manually.

l

When publishing changes, monitor and group dependencies are also updated without you having to
do this manually (the template automatically writes the groups and monitors into their proper place
in the tree and automatically create dependencies). If you do not want dependency settings for
selected template monitors and groups to overwrite dependency settings in deployed template
objects, select Ignore dependencies when publishing changes in the Dependencies panel.
Dependency settings for the selected template monitors and groups are ignored and the existing
dependency settings in the deployed objects are preserved. For details, see "Dependencies When
Configuring Template Monitors and Groups" on page 257.

Tasks
How to Publish Template Updates to Related Group Deployments
This task describes the steps involved in publishing template changes to related group deployments
using the Publish Template Changes Wizard.
1.

Prerequisites
You can run the Publish Template Changes Wizard provided you have Add, edit or delete
groups permissions, and only:
n

On groups for which you have permissions in the Allowed groups list.

n

For templates in template containers for which you have permissions in the Allowed template
containers list.

Any deployed groups that are not in your allowed groups list are not displayed in the wizard.
2.

Run the Wizard
In the template tree, right-click a template, and select Publish Changes to run the wizard. On the
first page, select the related template groups that you want to update. You can also select the
following options:
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n

Enable delete on update to delete SiteScope objects from the deployed groups that are not in
the source template.

n

Verify template changes with remote servers to verify the correctness of the monitor
configuration changes in the selected template with the remote servers on which the template
is deployed.
Note: When publishing changes to a custom monitor template, clearing this check box
has no effect, since the monitor configuration properties in the template must be checked
against the remote server on which the template is being deployed.

For user interface details, see "Publish Template Changes Wizard" on page 883.
Example - Select Deployed groups

3.

View the structural and content differences
View the structural differences between the template and the deployed groups. For details on the
Review Compliancy user interface, see "Review Compliancy Page" on page 885.
To view content differences in the template objects, click the View Differences link to open the
Content Changes dialog box. This link appears only for template objects that have content
differences. For details on the Content Changes user interface, see "Content Changes Dialog
Box" on page 886.
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Example - Review Compliancy Page:

Example - Content Changes Page:

4.

Add new variable values
Add values for any new variables in the template. Variable values that are mandatory are indicated
by a red asterisk (*). You can also edit values of existing variables. Click Apply to complete the
wizard and publish the template updates.
For user interface details, see "Modify Variables Page" on page 887.
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Example - Modify Variables Page:

5.

Review the publish template changes results
Review the results of the publish template changes and, if necessary, retry publishing the
changes to the deployed groups that failed to update. For details on the Publish Results Summary
user interface, see "Publish Results Summary Page" on page 888.
Example - Publish Results Summary Page:
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6.

Export the template changes to a summary report - optional
Optionally, you can export the publish template change results to a summary report (PDF file). For
details on the summary report, see "Publish Template Changes Summary Report" on page 888.

Tips/Troubleshooting
Publishing Template Changes: Troubleshooting and Limitations
This section describes troubleshooting and limitations when making changes to user-defined
templates.
l

l

l

l

l

l

l

l

l

l

Monitors added directly under a template (without creating a group in the template) are not
supported by the Publish Template Changes Wizard.
Templates and deployed groups are internally linked by an ID. This means that you can publish
changes even if the name of the template or the root group in a deployed group have changed.
However, if you manually associate a group to a template using the Source template property of
the root group, you cannot publish changes if the root group name was changed in the deployment.
For changes to be published, all changes in the root group hierarchy must succeed. If any changes
to a group fail, all changes to that group are rolled back.
Changes to Search/Filter tag values are not shown in the Review Compliancy page of the Publish
Template Changes Wizard. However, the changes are published to the deployed group.
The Publish Template Changes Wizard does not support regular expressions in threshold settings.
For characters to be displayed in most languages when exporting a report to a PDF, Arial Unicode
MS font must be installed on the machine used to view the PDF. For details, see "How to Enable
Unicode Font When Exporting to a PDF" on page 836.
Properties are displayed in the Publish Template Changes Wizard according to the locale of the
server where SiteScope is installed. The browser locale has no effect on how the properties are
displayed.
You cannot replace an existing monitor target server using the Publish Template Changes wizard or
auto deployment update (see "Publish Template Changes Using the XML" on page 862), although
you can change property values of the target server itself, if required.
To publish changes in browsable monitor counters to deployed groups, there must be a connection
to the remote server on which the monitor groups are deployed.
You can also use the SiteScope API to update groups, monitors, alerts, and remote servers
deployed by a template. For details, see "SOAP-based APIs" on page 159.
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l

l

l

l

When publishing changes to a custom monitor type, the monitor is temporarily disabled before
changes are published and is restored to the enabled state after changes have been made.
Publishing changes to custom topology is not supported (it does not affect the monitor's custom
topology in BSM). To modify topology settings in deployed template monitors, use Global Search
and Replace instead. For details, see "Global Search and Replace" on page 89.
Publishing changes for SiteScope remote servers is not supported.
When using multiple variables in a template object's property, the variables must be separated by a
character or character sequence. It is recommended to use a delimiter character such as # or _ to
ensure that the correct variable values are displayed in the Publish Template Changes Wizard. For
example, if using two variables in the Group name box, you could separate them as follows:
%%firstVar%%#%%secondVar%%.
It is important that the separator should not be a part of the variable’s real value. For example, if the
template’s value consists of %%firstVar%%agf%%secondVar%% and the value in the deployed group
is 11111agf222, then firstVar is defined as 11111 and secondVar as 222 in the publishing
process.
Note that if the template’s value consists of %%firstVar%%agf%%secondVar%% and the value in the
deployed group is 1agf1agf222, then firstVar is defined as 1 and secondVar as 1agf222 in the
publish process, even though the real value of firstVar is 1agf1 and the real value of secondVar is
222.

Publish Template Changes Wizard
This wizard enables you to check deployed groups for template compliancy and to update SiteScope
objects deployed by templates whenever the source template is updated.
To access

Important
information

Select the Templates context. In the template tree, right-click a template, and select
Publish Changes.
l

You can run the Publish Template Changes Wizard provided you have Add, edit
or delete groups permissions, and only:
n

On groups for which you have permissions in the Allowed groups list.

n

For templates in template containers for which you have permissions in the
Allowed template containers list.

Any deployed groups that are not in your allowed groups list are not displayed in
the wizard.
l
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Relevant
tasks

"How to Publish Template Updates to Related Group Deployments" on page 878

Wizard
map

This wizard contains:

See also

"Select Deployed Groups Page" below > "Review Compliancy Page" on the next
page > "Content Changes Dialog Box" on page 886 > "Modify Variables Page" on
page 887 > "Publish Results Summary Page" on page 888 > ("Publish Template
Changes Summary Report" on page 888)
l

"Publish Changes to Templates" on page 877

l

"Template Tree" on page 41

Select Deployed Groups Page
This wizard page enables you to select groups associated with the source template for which you want
to apply template changes. This is part of the Publish Template Changes Wizard. Refer to "Publish
Template Changes Wizard" on the previous page for important information on the wizard.
User interface elements are described below:
UI Element

Description

<List of
groups
associated
with the
selected
template>

Groups associated with the selected template that you want to update with the
template changes.

Enable
delete on
update

Select this option to ensure template compliancy. Deletes all SiteScope objects that
are not in the source template from the deployed groups, except for objects in groups
under the root group where the Ignore group when publishing changes option is
selected. For details on the ignore group setting, see "New Template Group Dialog
Box" on page 816.

Default value: All associated groups and subgroups are selected.

Note: Template groups with the Ignore group when publishing changes option
selected that were deployed and then removed from the template are removed from
the deployment after publishing changes with Enable delete on update selected.
Default value: Not selected
Verify
template
changes
with remote
servers

Verifies the correctness of the monitor configuration changes in the selected template
with the remote servers on which the template is deployed.
Note: Selecting this option slows update performance time due to the remote
connection.
Default value: Not selected
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Review Compliancy Page
This wizard page enables you to view the structural differences between the source template and the
deployed groups, and provides links to content differences in the deployed group objects. This is part of
the Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on page 883 for
important information on the wizard.
Note: Changes to Search/Filter tag values are not shown in the Review Compliancy page of the
Publish Template Changes Wizard. However, they are published to the deployed group.
User interface elements are described below:
UI Element

Description

<N>
deployed
groups
with
structural/
content
differences

Displays the deployed groups and group objects (subgroups, monitors, alerts, and
remote servers) that have structural or content differences to the source template.

<N>
deployed
groups
with no
structural/
content
differences

Displays the deployed groups that have no structural or content differences to the
source template. Groups with no deployment differences are displayed collapsed.
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UI Element

Description

Group
Name

Displays the name of the deployed group and all its objects—subgroups, monitors,
alerts, alert actions, and remote servers. Structural differences in the objects are
displayed in the group tree hierarchy with the following text and color coding:
Added. Indicates a new object to be added to the deployed group. The object is
displayed in green.

l

Does not exist in template (available only when the Enable delete on update
option is not selected in the Select Deployed Groups). Indicates an object that
does not exist in the source template. The object is displayed in blue.

l

Ignored. Indicates a subgroup that has the Ignore group when publishing
changes option selected. Ignored groups are displayed in gray.

l

Removed. (available only when the Enable delete on update option is selected
in the Select Deployed Groups). Indicates an object to be deleted from the
deployed group. The object is displayed in red.

l

Unused. Indicates that the template remote server is not being used. An unused
remote server is displayed in gray.

l

Content
For objects that contain content differences in properties, thresholds, and any other
Differences non-structural differences, the View Differences link is displayed. Click the link to
open the Content Changes dialog box and view differences in the property level for the
deployed group or object. For user interface details, see "Content Changes Dialog
Box" below.
Template remote servers that have been deployed are displayed in the Microsoft
Windows Remote Servers or UNIX Remote Servers section. If a remote server
already exists in Microsoft Windows/UNIX Remote Servers, it is not deployed again
when the template is deployed.

Content Changes Dialog Box
This wizard page enables you to view a list of all properties of the selected object to be updated, the
current and the replacement values, and the property action status. This is part of the Publish Template
Changes Wizard. Refer to "Publish Template Changes Wizard" on page 883 for important information
on the wizard.
User interface elements are described below:
UI Element

Description

Type

Object type (Group, Monitor, Alert, Alert Action, Remote).

Name

Name of the selected object.
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UI Element

Description

Property
Name

Name of the property affected by publishing the change.

Current
Value

Existing property value in the deployed group. This value is empty if the property is
going to be added to the deployed group.
Note: Existing password properties are displayed encrypted.

Replacement Replacement property value in the template. This value is empty if the property is
Value
going to be deleted from the deployed group.
Note:
l

l

Action

Replacement password properties are displayed encrypted.
If you make changes to the Depends on property in a template monitor, the full
path of the template monitor to which there is a dependence is displayed (for
example, SiteScope\tc\template\group\CPU).

Status of the action (Modified, Added, Deleted, Ignored). Ignored status is used
for baseline monitors, if there are no changes to the baseline thresholds.

Modify Variables Page
This wizard page enables you to add values for new variables in the deployed group. You can also edit
existing variable values. This is part of the Publish Template Changes Wizard. Refer to "Publish
Template Changes Wizard" on page 883 for important information on the wizard.
User interface elements are described below:
UI
Element Description
Variable Name of a new or existing variable in the deployed group. A red asterisk indicates that the
Name
variable value is mandatory.
Note: You can expand groups with variable values already filled, and modify the variables
as required. You cannot expand groups that do not contain variables.
Variable Value for new variables added to the deployed group. You can also edit existing variable
Value
values.
Note:
l

l

The variable value for the remote server is read only and cannot be changed.
Hypertext tags in a variable string cause the string to be truncated and be incorrectly
displayed in the Variable Value box (part of the string is displayed in the text label).
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Publish Results Summary Page
This wizard page enables you to view a summary of the published template updates. This is part of the
Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on page 883 for
important information on the wizard.
User interface elements are described below:
UI
Element Description
Export. Exports the results of publishing for each root group to a PDF file. For details,
see "Publish Template Changes Summary Report" below.
Group
Name

Displays the root group name and the group's objects (subgroups and monitors).

Reason

If SiteScope is unable to publish changes to a deployed group, the reason for failure is
displayed for each monitor in the group.

Publish Template Changes Summary Report
This report displays information about the template changes published to the deployed groups. It also
displays information for group objects that failed to update or that were ignored. Results are at the
object level (Group, Monitor, Alert, Alert Action, Remote Server).
This is part of the Publish Template Changes Wizard. Refer to "Publish Template Changes Wizard" on
page 883 for important information on the wizard.
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To access

In the Publish Results Summary Page of the Publish Template Changes wizard, click
the Report

Important
information

l

l

l

Relevant
tasks

button.

General information about this wizard is available here: "Publish Template
Changes Wizard" on page 883.
The Publish Template Changes Summary Report PDF is not supported in Firefox
2.x.
For characters to be displayed in most languages when exporting a report to a
PDF, Arial Unicode MS font must be installed on the machine used to view the
PDF. For details, see "How to Enable Unicode Font When Exporting to a PDF" on
page 836.

"How to Publish Template Updates to Related Group Deployments" on page 878
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Wizard
map

The "Publish Template Changes Wizard" on page 883 contains:

See also

"Publish Changes to Templates" on page 877

"Select Deployed Groups Page" on page 884 > "Review Compliancy Page" on page
885 > ("Content Changes Dialog Box" on page 886) > "Modify Variables Page" on
page 887 > "Publish Results Summary Page" on page 888 > (Publish Template
Changes Summary Report)

Report Content
User interface elements are described below:
UI
Element

Description

<Report
Total number of root groups selected for publishing changes, including the number of
summary> groups that were successfully and unsuccessfully changed.
Deployed
Root
Group
<group
path>

Name of the deployed group and all group objects that were successfully or
unsuccessfully updated with the template changes. The deployed groups that were not
updated are displayed first.

Type

Object type (Group, Monitor, Alert, Alert Action, Remote Server).

Name

Name of the object and its path.

Reason

Publish status for the object (Successfully added, Successfully modified,
Successfully deleted, Failed to add, Failed to modify, Failed to delete,
Ignored, Unchanged).

Message

For deployed group objects that were not updated by the template changes, the reason
for the failure to publish the changes.

Note: For changes to be published, all changes in the root group hierarchy must
succeed. If any changes to a group object fail, all changes to that group are rolled back.
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UI
Element
<Property
details>

Description
For deployed group objects that had content changes:
l

l

l

l

HP SiteScope (11.31)

Property Name. The name of the property that was updated.
Deployment Value (previous). The previous property value in the deployed group.
This value is empty for a property that was added to the deployed group. Previous
password variables are displayed encrypted.
Template Value (current). The replacement property value in the deployed group.
This is the current property value in the template. This value is empty if the property
was deleted from the deployed group. Replacement password variables are
displayed decrypted.
Action on Property Value. The type of change made to the property value
(Successfully modified, Successfully added, Successfully deleted).
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Network
You can use the HP Live network to share custom SiteScope monitors and regular SiteScope monitors
that reference a script or alert template in the SiteScope root directory. By sharing knowledge with other
SiteScope users, you can benefit from extended SiteScope monitor coverage and the development of
new content outside the SiteScope release cycle.

To access
l

SiteScope user community page. Here you can read or participate in discussions in the
SiteScope community forum, get product announcements, and access content and other files
shared with the SiteScope community.
To access this page, enter https://hpln.hp.com/group/sitescope in a Web browser.

l

Community Content for SiteScope page. This area is used for the development and exchange of
SiteScope content. You can share content you developed, download and rate content provided by
other users, and post feedback on the forum.
To directly access the Community Content for SiteScope page, enter
https://hpln.hp.com/group/community-content-sitescope in a Web browser.

Learn About
Content Sharing Overview
After developing a SiteScope monitor, you can copy the monitor to a template, and export it to a
template file which you can share with other SiteScope users. For details on copying a monitor to a
template, see "How to Create a Template by Copying Existing Configurations" on page 801. For
details, on exporting a template, see "How to Export and Import a Template" on page 827.
In addition, when sharing Custom monitors or regular SiteScope monitors that reference a script or alert
template in the SiteScope root directory, you need to copy the files used for creating the monitor and
extension files referenced by the monitor to a content package. For details on creating content
packages, see "Create Content Packages" on page 825.
You can distribute a template or content package by sending it to individual SiteScope users, or by
publishing it to the SiteScope community on HP Live Network. HP Live network is an online
community providing a central location for HP customers to share information and learn about add-on
content, extensions, and related activities across the HP Software portfolio.
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Tasks
This section includes:
l

"How to Publish Content to the HP Live Network Community" below

l

"How to Download Content from the HP Live Network" on the next page

How to Publish Content to the HP Live Network Community
1. Navigate to the Community Content for SiteScope page on the HP Live Network.
a. Prerequisites for accessing the site:
o

Full access to the site is available to HP Customers with current maintenance contracts
for their specific products.

o

For full access, you must have an HP Passport account, and you must have entered your
products Contract identifier (SAID), here:
https://softwaresupport.hp.com/group/softwaresupport/settings

b. Enter https://hpln.hp.com/group/sitescope in a Web browser. From the SiteScope user
community page, click the CONTENT link, and then click the Community Content for
SiteScope link.
Alternatively, you can access the page directly from: https://hpln.hp.com/group/communitycontent-sitescope.
2. In the Community Content for SiteScope page, click the CONTENT link, select the appropriate
folder into which you want to upload the content file (or create a new one), and click
Add
content file.
In the Create File box:
a. Enter a name for the file and select a status for the file (for example, draft, alpha, beta, stable,
released).
b. Enter a description of the file.
c. Select a file type option:
o

Regular file. Click Browse, select the file containing the content you want to upload
(content packages are in zip format), and then click Open.
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o

Link. Enter a link to the file path.

Click Save to upload the content file to the site.
3. To notify other users of the new content, click the ANNOUNCEMENTS link, and add details of
the uploaded content. All users that have subscribed to product announcements are automatically
notified of the new content.

How to Download Content from the HP Live Network
You can download content from the HP Live Network community as follows:
1. Access the Community Content for SiteScope page on HP Live Network
(https://hpln.hp.com/group/community-content-sitescope).
Prerequisites for accessing the site:
n

Full access to the site is available to HP Customers with current maintenance contracts for
their specific products.

n

For full access, you must have an HP Passport account, and you must have entered your
products Contract identifier (SAID), here:

2. Click the CONTENT link, expand the folder from which you want download a file, and then click
the relevant file link.
Note:
n

You can also check the Announcements and Forums pages for discussions and
announcements on SiteScope community content.

n

To receive notifications of product announcements, forum topic posts, and content file
posts, click the relevant Subscribe to link, select the send interval and method, and click
Subscribe.

3. Continue with the steps for importing a content file, as described in the relevant section of the
documentation.
4. After downloaded and using a content file, you can give the download a rating in the Content page,
and post comments in the Forums page.
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Part 9: Solution Templates
SiteScope offers solution templates that feature built-in domain expertise in the form of specialized
monitors, default metrics and thresholds, proactive tests, and best practices for a given application or
component being monitored.
For details on working with solution templates in general, see "Deploy Solution Templates" on page
896.
For details on configuring and deploying a specific template, see the help for the specific solution
template.
Note: Solution Templates are only available in the user interface after acquiring an HP license
edition that supports them. For details on acquiring the necessary license, see the Licensing
section of the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).
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SiteScope solution templates are preconfigured monitor set templates designed to monitor popular
enterprise applications and network systems. Using solution templates, you can rapidly deploy a
combination of standard SiteScope monitor types and solution-specific monitors with settings that are
optimized for monitoring the availability, performance, and health of the target application or system.
Deploying the solution creates a new monitor group container in which the individual solution monitors
are added. You can deploy a solution template for each server in your environment. For solution
templates that use the system variable SERVER_LIST, you can deploy the solution on multiple remote
hosts.

To access
Select the Templates context. In the template tree, expand the Solution Templates container and
select the required template.

Learn About
List of Solution Templates
The following table lists solution templates available for SiteScope. For more information about each
solution, including the solution specific monitor types and the supported versions, see the chapter for
the specific solution template.
Solution
Name

Description

Supported
Versions

Supported Platforms

"Active
Directory
Solution
Templates" on
page 907

Monitors the
performance and
efficiency of Microsoft
domain controllers (with
or with global category)
for Microsoft Windows
servers.

Windows
Windows
Server 2003,
2003 R2,
2008, 2008 R2

"AIX Host
Solution
Template" on
page 910

Monitors performance,
availability, and health
for AIX host machines.

AIX 5.2, 5.3
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Solution
Name

Description

"Apache
Cassandra
Solution
Template" on
page 913

Monitors the health,
availability and
performance of a
Cassandra database
node.

Cassandra
2.0.9

"Apache
Tomcat
Solution
Template" on
page 916

Monitors the health,
availability and
performance of a
Apache Tomcat server.

Standalone
Windows/Linux
Apache
Tomcat
versions
7.0.61, 7.0.62,
8.0.23 and
Tomcat with
SiteScope
11.30
onwards.

"Hadoop
Cluster
Monitoring
Solution
Templates" on
page 919

Monitor the health and
performance statistics
of Hadoop Distributed
File System (HDFS)
and Hadoop
MapReduce master
nodes of the Hadoop
cluster infrastructure.

Hadoop 1.x.

GNU/Linux

"HP Quality
Center Solution
Templates" on
page 923

Monitors performance,
availability, and health
for HP Quality Center
application servers on
Windows and UNIX, HP
Quality Center license
usage and expiration
time on an Oracle
Database server.

HP Quality
Center
Application
Server 9.2,
10.x

Windows / UNIX

Monitors performance,
availability, and health
for HP QuickTest
Professional license
server application and
system availability.

HP QTP
License
Server 7.1.0

"HP QuickTest
Professional
License Server
Solution
Template" on
page 933
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Supported
Versions

Supported Platforms
Windows/Linux

HP Quality
Center Server
License
Server 9.2,
10.x
Windows / UNIX
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Solution
Name

Description

Supported
Versions

Supported Platforms

"HP Service
Manager
Solution
Templates" on
page 936

Monitors HP Service
Manager application
servers availability and
system status on
Windows and UNIX
platforms.

Service
Manager 7.11

"HP Vertica
Solution
Template" on
page 942

Monitors performance,
availability, and health
aspects of the
HP Vertica cluster
infrastructure.

HP Vertica
All
6.0.1, 6.1, 7.0,
7.1.1

"JBoss
Application
Server Solution
Templates" on
page 945

Monitors performance,
JBoss 4.x,
availability, and health
5.x, 6.1.0,
for JBoss environments. 6.3.0, 7.1 - 7.4

All

"Linux Host
Solution
Template" on
page 951

Monitors performance,
Red Hat 7.x,
availability, and health
8.x, 9.x
for Linux host machines.
Red Hat
Enterprise
Linux 3.x, 4.x,
5.2, 5.4, 5.5
(ES/AS)

All

"Microsoft
Exchange
Solution
Templates" on
page 954

Monitors performance,
availability, and usage
statistics for Microsoft
Exchange servers. The
templates include
monitors that check
Windows Event log
entries, Exchange test
operations and
statistics, system
performance counters,
and message system
usage statistics

Microsoft
Exchange
2007 (version
8.0), 2010,
2013 Server

All

"Microsoft IIS
Solution
Templates" on
page 960

Monitors performance,
availability, and health
for Microsoft IIS
environments.

Microsoft IIS
Server 6.0,
7.x, 8.0

Windows
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Solution
Name

Description

Supported
Versions

Supported Platforms

"Microsoft Lync
Server 2010
Solution
Templates" on
page 964

Monitors performance,
availability, and health
for the following
Microsoft Lync Server
2010 Servers: A/V
Conferencing Server,
Archiving Server,
Director Server, Edge
Server, Front End
Server, Lync Server
Event Log, Mediation
Server, Monitoring
Server, and Registrar
Server.

Microsoft
Lync Server
2010 Servers

Windows

"Microsoft
SharePoint
2010 Solution
Templates" on
page 969

Monitors performance,
availability, and health
for Microsoft SharePoint
2010.

Microsoft
SharePoint
2010

Windows

"Microsoft SQL
Server Solution
Templates" on
page 972

Monitors performance,
availability, and usage
statistics for Microsoft
SQL servers.

Microsoft SQL Windows
Server 2005,
2008, 2008
R2, 2012,
2014

"Microsoft
Windows Host
Solution
Template" on
page 978

Monitors performance,
availability, and health
for Microsoft Windows
host machines.

Microsoft
Windows
Server 2003,
2008, 2012,
Windows XP

Windows

".NET Solution
Templates" on
page 981

Monitors performance,
availability, and health
of .NET applications
and environments on
Windows Server
machines.

.NET 1.x, 2.x

Windows

"Oracle
Database
Solution
Templates" on
page 984

Monitors performance,
availability, and usage
statistics for Oracle
databases.

Oracle
Database 9i,
10g, 11g

Windows / UNIX / Linux
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Solution
Name

Description

Supported
Versions

"SAP Solution
Templates" on
page 990

Monitors performance,
availability, and usage
statistics for SAP
system components.

SAP R/3
Windows / Linux / Solaris
servers
(versions 4.5B
and later

"Siebel Solution
Templates" on
page 994

Monitors performance,
availability, and usage
statistics for Siebel
Application Server
installed on Windows
and UNIX operating
systems.

Siebel
Application
Server 6.x,
7.x, 8.x

Windows / UNIX

"Solaris Host
Solution
Templates" on
page 1003

Monitors performance,
availability, and health
for Solaris host
machines.

Solaris 9, 10

All
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Solution
Name
"VMware
Capacity
Management
Solution
Templates" on
page 1006

"VMware Host
Solution
Template" on
page 1014

HP SiteScope (11.31)

Description
Enables SiteScope to
collect data from
VMware monitors and
report it to the data store
on the HP Operations
agent for use in
supported reporting
products, including HP
Service Health
Optimizer (SHO), HP's
capacity management
solution, and Service
Health Reporter (SHR),
HP's service centric
cross-domain reporting
solution.

Supported
Versions
VMware
VirtualCenter
2.x
VMware ESX
3.x, 4.0, 4.1
VMware ESXi
3.5, 4.0, 4.1,
5.0, 5.1

Supported Platforms
vCenter server: Windows XP
Professional, Window Server 2003,
2003 R2, 2008, 2008 R2, 2012, 2012
R2, Virtual Appliance. See VMware
Compatibility Guide
(http://www.vmware.com/
resources/compatibility)
ESX server: own OS

VMware ESX
2.5 via
VirtualCenter
2.x

VMware ESX
3.x via
Monitors CPU, memory, VirtualCenter
3.x
storage, state, and
network performance
VMware
and usage statistics for vSphere 4.0,
the VMware Host server 4.1, 5.0, 5.1
and on guest virtual
(also
machines on the host
supported
server. Use this solution with SSO
template if you just want login), 5.5
to monitor vCenter
without having the
ability to pinpoint
performance problems.
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Solution
Name

Description

Supported
Versions

Supported Platforms

"VMware Host
For
Performance
Troubleshooting
Solution
Template" on
page 1018

Deploys a set of
monitors that follow
VMware's official best
practice scenarios for
performance
troubleshooting of
VMware vSphere.
These monitors use
SiteScope’s Calculated
Metrics to pinpoint
specific performance
problems on the
VMware host, and report
the problematic ESX
host and/or VMs. This
template can also be
used for collecting data
and monitoring the
overall performance and
availability on the
VMware host.

"WebLogic
Solution
Templates" on
page 1023

Monitors performance,
availability, and usage
statistics for Oracle
WebLogic application
servers.

WebLogic
Application
Server 6.x,
7.x, 8.x, 9.x,
10.x

All

"WebSphere
Solution
Templates" on
page 1028

Monitors performance,
availability, and usage
statistics for IBM
WebSphere application
servers.

WebSphere
Application
Server 6.x,
7.x, 8.x

All

Tasks
How to Customize a Solution Templates
Since a solution template is unlikely to match all your system configurations, you can customize the
solution template to meet your system requirements as follows:
l

Copy the solution template to a template container, modify it to suit your system requirements, and
then deploy the modified solution template (see below for deployment details).
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l

Deploy the solution template (see below), and modify it after the deployment to suit your system's
requirements.
For example, when using the HP Quality Center Application Server solution template to monitor the
repository disk variable, and the repository is on a different host to the application server, after
deploying the template, you must change the repository disk utilization monitor to use the other
host.

How to Deploy a SiteScope Solution Template
This task describes the steps involved in deploying a solution template. Deploy a solution template for
each server in your environment.
1.

2.

Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. For details on acquiring the necessary license, see the Licensing section of
the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).

n

An in-depth description of each solution template is provided in the solution template best
practices guides (available from <SiteScope root directory>\sisdocs\pdfs\<solution
template name>_Best_Practices.pdf). These guides (except for Hadoop Cluster Monitoring
and HP Vertica) are password protected; the password is provided after acquiring an HP
license edition that supports solution templates.

Deploy the template
Select the method for deploying the solution template to a group:
n

You can deploy a solution template directly from the user interface. In the template tree, rightclick the solution template you want to deploy, and select Deploy Template. In the Select
Group dialog box, select the monitor group into which you want to deploy the solution template.
For user interface details, see "Select Group Dialog Box" on page 855.
Note: Solutions that provide a number of templates (these are grouped in a template
container), can be deployed to a group individually or simultaneously. For example, when
deploying the Microsoft Exchange 2010 solution, you can select only the templates that
you require, and deploy them against distributed Exchange server installations on separate
servers. For details on deploying multiple templates simultaneously, see the Deploy
multiple templates step in "How to Deploy Templates Using the User Interface" on page
848.

n

You can deploy a solution template using a CSV file that contains the variable values defined in
the template. For details, see "Deploy a Template Using a CSV File" on page 848.
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You can deploy and update the template using an XML file external to the SiteScope user
interface. For details, see "Deploy Templates Automatically Using an XML File" on page 861.

n

3.

Enter variable values for the template deployment (for deployment through the user
interface only)
Complete the items on the Deployment Values page for the selected solution template. For user
interface details, see the UI Descriptions section for the specific solution template.

4.

Configure alerts and reports
Configure alerts and reports for the newly created solution monitors.
For details on configuring alerts, see "Configure SiteScope Alerts" on page 1243.
For details on configuring reports, see "Create SiteScope Reports" on page 1320.

5.

Results
The solution template creates a new monitor group container in which the individual solution
monitors are added. The monitor group container is assigned a name in the format <Solution
Template name> on <server_name> where server_name is the server selected from the Server
box.
You can view, edit, and delete these monitors in the same way as any other monitors in
SiteScope.
Note: If some of the monitors fail to deploy, a message is shown listing the names of the
monitors together with a message describing the error.

UI Descriptions
Solution Templates Page
User interface elements are described below:
UI Element

Description

Name

Name of the solution template (read-only).

Description

Description of the solution template (read-only).
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Tips/Troubleshooting
Notes and Limitations
l

l

l

l

The Search/Filter Tags panel is not available for filtering Solution Template objects.
Errors detected during the creation of monitors using a solution template are independent of the
status returned when the individual monitors are run. This means that the monitors may be created
successfully but that the configuration settings may be incorrect or that the system being monitored
is unavailable.
After some solution templates are deployed, the relevant monitors may be defined with a BSM
reporting level of Disable reporting to BSM. Therefore after deploying a solution template, we
recommend that you check the monitors' reporting level. If you want to change the reporting level for
the deployed monitors, you can use the Global Search and Replace wizard to update the reporting
level option.
Solution templates do not configure any automated alerts or reports for the monitors created. You
may create and associate one or more alert definitions or reports to the monitors or monitor groups
created by solution templates.

Troubleshooting Issues
l

Reinstalling Solution Templates
The installed solution templates are located in the <SiteScope root directory>\persistency
directory. If the contents of this directory are deleted, the solution templates are not displayed in the
template tree. To reinstall the solution templates, you must copy the solution template files back to
the persistency directory.
Note: We do not recommend deleting the persistency directory as this permanently deletes all
SiteScope configuration data and all historical data in BSM (if SiteScope is integrated with
BSM).
To reinstall the solution template files:
a. Locate the solution template files in the following directory:
<SiteScope root directory>\export.
b. Copy the contents of <SiteScope root directory>\export into <SiteScope root
directory>\persistency\import.
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c. Check that the solution templates have been reinstalled by locating them in the Solution
Templates folder in the template tree.
l

Importing Solution Templates
n

When importing templates, if templates already exist with the same name in the same template
container, the import may fail, due to unique name violation. To prevent this, rename the existing
template containers.

n

If the import fails or you no longer see the solution templates in the Solution Templates tree, you
can restore the solution templates as described in Reinstalling the Solution Templates above. If
the \export folder also contains the template examples, the template container should be
renamed to prevent the unique name violations mentioned above.
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You can use the Active Directory solution templates to provide monitoring of domain controller
performance—services on which Active Directory depends—and distributed Active Directory
performance.
The Active Directory solution templates deploy a set of monitors against a particular Domain
Controller. These monitors encompass best practices monitoring for Active Directory. This template
includes Windows Event Log, Service, LDAP, performance counter, and Active Directory Replication
monitors.
The Active Directory solution templates provide comprehensive monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Note: An in-depth description of the Active Directory Solution Template is available in the
SiteScope Active Directory Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Active_Directory_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required Active Directory solution template.

Learn About
Supported Versions
The Active Directory solution templates support Microsoft Windows Server 2003, 2003 R2, 2008, 2008
R2.

Solution Template Monitors
l

l

Domain controller performance. This category refers to the low level health of each domain
controller in the environment. The Active Directory solution template automatically configures
monitors for domain controller health.
Dependent services. Active Directory depends on several key services. Without these services,
Active Directory can become unresponsive or fail altogether. The Active Directory solution template
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automatically configures monitors for a list of important services on which Active Directory
performance is dependent.
l

Distributed Active Directory performance. Perhaps the most important aspect and key indicator
of Active Directory performance is how fast Active Directory is replicating changes out to all domain
controllers. The Active Directory solution template automatically configures monitors for monitoring
and testing replication of changes and updates.

Tasks
How to Deploy Active Directory Solution Templates
This task describes the steps involved in entering variables for the Active Directory solution template.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for user interface deployment only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Active Directory Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

ReplicatingDomain Comma separated list of domain controllers that replicate data from the
Controllers
domain controller selected above.
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UI Element

Description

LDAPSecurity
Principal

LDAP Security Principal of a Domain Admin account. For Active Directory
this is in the format of cn=Domain Admin
User,cn=users,dc=yoursite,dc=com.

LogicalDrive

Logical drive that this Domain Controller is using for its database and log
files.

PASSWORD

Password for the user selected above.

HostName

Host part of the domain controller's host name (do not include the fully
qualified domain name).

Global Catalog
(AD with Global
Catalog only)

Select if the Domain Controller is a Global Catalog server.

SERVER_LIST

Domain Controller that you want to monitor. If the server you want to monitor
is not in the list, you must define a connection profile to the server.

Silent deployment

Submits the template deployment request to a queue, and SiteScope handles
the deployment in the background. This enables you to continue to use
SiteScope without having to wait for the template deployment process to
finish. All submitted requests and their corresponding deployment results are
logged to <SiteScope root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the
template against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the
remote connection.
Default value: Selected

Test remote
servers
(AD 2008 R2 only)

Tests the connection created from the template remote server after the
templates have been deployed. The test is performed in the background,
enabling you to continue to use SiteScope.
Default value: Not selected
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The AIX Host solution template is a template that you can use to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of the AIX host. The
template supports the versions of AIX that are supported by SiteScope. For details, see System
Requirements in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_lib\Get_
Documentation.htm).
For UNIX Resource Monitors, you can create a Server-Centric report which displays data from three
different metrics about the server being monitored. For more information on generating a Server-Centric
report, see "Create Server-Centric Reports" on page 1365.
Tip: We recommend using solution templates when creating the UNIX Resource Monitor,
because the required monitors and metrics are already configured.
The AIX Host solution template provides comprehensive AIX operating system monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the
time to configure and deploy performance monitors, helps identify both real-time performance
bottlenecks and longer term trends, and adds only minimal overhead to production systems.
Note: An in-depth description of the AIX Host Solution Template is available in the SiteScope
Operating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select AIX
Host.

Learn About
Supported Versions
The AIX Host solution template supports AIX 5.2 and 5.3.

Solution Template Monitors
The AIX Host solution template deploys monitors that target the following aspects of AIX performance
and health:
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l

CPU status and utilization details

l

Memory status and utilization details

l

File system status and utilization details

Tasks
How to Deploy Active Directory Solution Templates
This task describes the steps involved in configuring the server environment and entering variables for
the AIX Host solution template.
Note: The AIX Host solution template deploys a UNIX Resource Monitor for each target host. This
is a supplemental monitor that is required for Server-Centric Report support.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The SiteScope server must be able to connect to the target AIX host.

n

The target server must be added to SiteScope as a UNIX remote machine and should pass the
UNIX remote test (Remote Servers > UNIX Remote Servers). For details, see "Configure
SiteScope to Monitor Remote UNIX Servers" on page 492.
Note:
o

The SiteScope server itself can also be monitoring if it runs a supported AIX operating
system.

o

The template supports the AIX versions supported by SiteScope. For details, see
System Requirements in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
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3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
AIX Host Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a UNIX connection profile, see "Configure SiteScope to Monitor Remote UNIX
Servers" on page 492.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The Apache Cassandra solution templates deploy a collection of monitors configured with default
metrics that test the availability, performance, and health of a Cassandra database. The solution
template deploys the monitors only on a specified node of the Cassandra database.
Note: An in-depth description of the Cassandra monitoring solution template is available in the
SiteScope Cassandra Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Cassandra_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expand Solution Templates > Apache
Cassandra and select > Cassandra Node Monitoring.

Learn More
Supported Versions
The Apache Cassandra solution template supports Cassandra version 2.0.9.

Solution Template Monitors
The Apache Cassandra solution template deploys monitors that target the following aspects of
Cassandra server performance and health:
l

Node availability

l

Node compaction

l

Node gossip stage

l

Node latency

l

Node mutation stage

l

Node read stage

l

CPU status and utilization details

l

Head memory usage

l

Physical memory usage
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Tasks
How to Deploy the Apache Cassandra Monitoring Solution Template
This task describes the steps involved in entering variables for the Apache Cassandra Monitoring
solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

Enable JMX remote on the Cassandra node.

2. Deploy the solution template.
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Apache Cassandra Solution Template Page
UI Element

Description

Port

Port that SiteScope should use to access the JMX remote, if set.

JMX User
Name

The user name required to connect to the JMX remote server, if set.

JMX Password The password required to connect to the JMX remote server, if set.
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UI Element

Description

Server_List

Name of the server you want to monitor. If the server you want to monitor is not in
the list, you must define a connection profile to the server. For the steps you use
to create a connection profile, "Configure SiteScope to Monitor Remote Windows
Servers" on page 470 or see "Configure SiteScope to Monitor Remote UNIX
Servers" on page 492.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor
properties
with remote
server

HP SiteScope (11.31)

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Page 915 of 1395

Chapter 70: Apache Tomcat Solution Template
The Apace Tomcat solution template deploys a set of monitors that test the performance and
availability of the Apache Tomcat server. The solution template provides monitors to check availability,
performance, session performance, and thread pool of the Tomcat server.
Note: An in-depth description of the Tomcat monitoring solution template is available in the
SiteScope Tomcat Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Tomcat_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expand Solution Templates > Apache Tomcat
and select Tomcat Monitoring.

Learn More
Supported Versions
The Apache Tomcat solution template supports standalone Apache Tomcat versions 7.0.61, 7.0.62,
8.0.23 and Tomcat versions packaged with SiteScope 11.30 or later.

Tasks
How to Deploy the Apache Tomcat Solution Template
This task describes the steps involved in entering variables for the Apache Tomcat solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

Enable JMX remote on the Tomcat server.

2. Deploy the solution template.
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For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Apache Tomcat Solution Template Page
UI Element

Description

Port

Port that SiteScope should use to access
the JMX remote, if set.

Server-Name

Host name of the Apache Tomcat server.

JMX-Username

The user name required to connect to the
JMX remote, if set.

JMX-Password

The password required to connect to the
JMX remote, if set.

Silent Deployment

Submits the template deployment request
to a queue, and SiteScope handles the
deployment in the background. This enables
you to continue to use SiteScope without
having to wait for the template deployment
process to finish. All submitted requests
and their corresponding deployment results
are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor properties with remote server

Verifies the correctness of the monitor
configuration properties in the template
against the remote server on which the
template is deployed.
Note: When this option is selected,
deployment time is slowed due to the
remote connection.
Default value: Selected

HP SiteScope (11.31)

Page 917 of 1395

Using SiteScope
Chapter 70: Apache Tomcat Solution Template

Tips/Troubleshooting
JMX Timeout Exception
If you encounter a JMX Timeout exception error, increase the timeout interval to 120 seconds or higher.
By default, the timeout interval is 60 seconds.
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You can use the Hadoop Cluster Monitoring solution templates to provide monitoring of the health and
performance statistics of Hadoop Distributed File System (HDFS) and Hadoop MapReduce master
nodes of the Hadoop cluster infrastructure.
The Hadoop Cluster Monitoring solution templates deploy a set of monitors against a specified Hadoop
cluster host. These monitors are designed to manage large, fast-growing volumes of data and provide
fast query performance when used for data warehouses and other query-intensive applications.
These templates includes the Hadoop, UNIX Resources, Memory, and Multi Log monitors.
The Hadoop Cluster Monitoring solution templates provide comprehensive monitoring without requiring
the SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Note: An in-depth description of the Hadoop Cluster Monitoring Solution Template is available in
the SiteScope Hadoop Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Hadoop_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expand Solution Templates > Hadoop Cluster
Monitoring, and select the required template (HDFS or MapReduce).

Learn More
Supported Versions
The Hadoop Cluster Monitoring solution template supports Hadoop 1.x on GNU/Linux.

Tasks
How to Deploy the Hadoop Cluster Monitoring Solution Template
This task describes the steps involved in entering variables for the Hadoop Cluster Monitoring solution
templates.
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1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Description
HDFS (Hadoop Distributed File System) Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

HDFS
master
node

Name of the server which hosts the HDFS master node.
Enter the URL in the format:
service:jmx:rmi:///jndi/rmi://<host>:<port>/jmxrmi

JMX
Domain

Domain that is used to gather Hadoop statistics (optional). If this field is left blank, the
default Hadoop domain filter is used.

JMX Port

JMX port configured for the HDFS master node.

JMX User
name

Login for connecting to the HDFS master node JMX (if configured).

JMX
Password

Password for connecting to the HDFS master node JMX (if configured).

User name
for remote

Login name for the HDFS master node host.

Password

Password for the HDFS master node host.
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UI Element

Description

Frequency

The monitor run frequency (in seconds).
Default value: 600

HDFS logs
folder

Path to the HDFS logs folder.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote server after the templates
servers
have been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected

MapReduce Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

MapReduce Name of the server which hosts the Hadoop MapReduce master node.
master
Enter the URL in the format:
node
service:jmx:rmi:///jndi/rmi://<host>:<port>/jmxrmi
JMX
Domain

Domain that is used to gather Hadoop statistics (optional). If this field is left blank, the
default Hadoop domain filter is used.

JMX Port

JMX port configured for the Hadoop MapReduce master node.

JMX User
name

Login for connecting to the Hadoop MapReduce master node JMX (if configured).
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UI Element

Description

JMX
Password

Password for connecting to the Hadoop MapReduce master node JMX (if
configured).

User name
for remote

Login name for the MapReduce master node host.

Password

Password for the MapReduce master node host.

Frequency

The monitor run frequency (in seconds).
Default value: 600

MapReduce Path to the MapReduce master node logs folder.
logs folder
Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote server after the templates
servers
have been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected
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The HP Quality Center solution templates are templates that you can use to deploy a collection of
monitors configured with default metrics that test the availability of HP Quality Center application
servers, and license status on HP Quality Center database servers.
The HP Quality Center solution templates provide comprehensive HP Quality Center monitoring
without requiring the SiteScope user or the IT organization to be experts on the application. They also
reduce the time to configure and deploy performance monitors, help identify both real-time performance
bottlenecks and longer term trends, and add only minimal overhead to production systems.
Note:
l

l

HP Quality Center Application Server for Windows is not supported on SiteScopes installed on
UNIX platforms.
An in-depth description of the HP Quality Center Solution Template is available in the
SiteScope Quality Center Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_HP_QC_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports
the solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required HP Quality Center solution template.

Learn About
Supported Versions
The HP Quality Center solution templates support:
l

HP Quality Center Application Server 9.2 and 10.x

l

HP Quality Center Server License Server 9.2 and 10.x

Solution Template Monitors
The HP Quality Center solution includes solution templates for monitoring the following key
components:
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l

l

HP Quality Center Application Server for UNIX/Windows. Use this solution template to
monitor the availability and performance of the HP Quality Center application server on the
operating system on which the application is installed.
HP Quality Center 9.2/10.0 License Status. Use this solution template to monitor
HP Quality Center license usage and expiration time on an HP Quality Center database server (the
solution template has been certified on an Oracle and Microsoft SQL database).
Note: The solution template uses the Ping monitor to monitor system availability. If Ping traffic is
blocked on your network, use Port monitor instead.

Monitoring Quality Center Third-Party Applications
We recommend using other SiteScope solution templates, monitors, or both, to monitor Quality Center
third-party components, such as the application server on which Quality Center is deployed, and the
database it uses.
For details on the solutions that are recommended for monitoring Quality Center third-party
components, see the tables below:
Database Server Monitoring
Database Type

Recommended Solution

Oracle

"Oracle Database Solution Templates" on page 984

Microsoft SQL Server

"Microsoft SQL Server Solution Templates" on page 972

LDAP

LDAP Monitor

Application/Web Server Monitoring
Application/Web Server Type

Recommended Solution

Apache Server

Apache Server Monitor

JBoss

"JBoss Application Server Solution
Templates" on page 945

Microsoft IIS

"Microsoft IIS Solution Templates" on page
960
Microsoft IIS Server Monitor

WebLogic 6.x-8.x, 9.x-10.x

"WebLogic Solution Templates" on page 1023

WebSphere 5.x, 6.x

"WebSphere Solution Templates" on page
1028
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Application/Web Server Type

Recommended Solution

Other Web/Application Servers that support JMX
access (JSR 160)

JMX Monitor

Tasks
How to Deploy the HP Quality Center Solution Template
This task describes the steps involved in entering variables and deploying the HP Quality Center
solution templates.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

You must have the following information:

Solution Template
Name
HP Quality Center
Application Server for
Windows

Requirements
n

The SiteScope server must have access to the Quality Center
components.

n

You must have the following information:

n
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o

Quality Center application version (9.2, 10.0)

o

Full host name and login credentials for the application server

o

Quality Center repository disk or repository location if it is
located on another host

o

Port used in the login URL (usually none, which means that port
80 is used)

This solution template is not supported on SiteScopes installed on
UNIX platforms.
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Solution Template
Name
HP Quality Center
Application Server for
UNIX

HP Quality Center
9.2/10.0 License Status

Requirements
n

The SiteScope server must have access to the Quality Center
components.

n

You must have the following information:
o

Quality Center application version (9.2, 10.0)

o

UNIX operating system type

o

Full host name and login credentials for the Application server

o

System file system

o

Quality Center repository disk or repository location if it is
located on another host

o

Port used in the login URL (usually none, which means that port
80 is used)

o

Name of the java process command that runs the Quality
Center application on the UNIX operating system. (you can use
"ps -ef | grep java")

n

The SiteScope server must have access to the Quality Center 9.2
or 10.0 components.

n

You must have the following information on the Quality Center
database:
o

Database host name

o

Type (Oracle, Microsoft SQL, MSDE 2000)

o

Driver (possibly a SiteScope built-in database driver)

o

Database Connection URL

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
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UI Descriptions
HP Quality Center Application Server for Windows
User interface elements (Variable Values) are described below:
UI Element

Description

Application
server host
name

Host name of the Quality Center application server.

Application
server user
name

Login user name for the host on the Quality Center application server.

Application
server
password

Password for the host on the Quality Center application server.

System disk

Logical disk drive where the Quality Center application server is installed.
Default value: C

Repository
disk

Logical disk drive where the Quality Center repository is located. If the repository
is located on another host, enter the system disk drive and alter the Repository
Disk Utilization monitor after you deploy your template.
Default value: D

Site
Suffix for the Quality Center Site Administration URL.
Administration
Default value: qcbin/SiteAdmin.htm (for Quality Center version 9.x, change this
path
to sabin)
Application
port

Port used in the login URLs to the Quality Center application. Usually no port is
specified which means port 80 is used.
Default value: 80

Maximum
Value in milliseconds, used as an error status threshold for a reasonable round trip
round trip time time for getting a response from your application URLs.
(milliseconds)
Default value: 1500 milliseconds
Quality Center
service name
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Name of the Quality Server service.
Default value: HP Quality Center. For Quality Center version 9.x, change this to
Mercury Quality Center.
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UI Element

Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor Verifies the correctness of the monitor configuration properties in the template
properties with against the remote server on which the template is deployed.
remote server
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
Test remote
servers

Tests the connection created from the template remote server after the template
has been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected

HP Quality Center Application Server for UNIX
User interface elements (Variable Values) are described below:
UI Element

Description

Application
server host
name

Host name for the Quality Center application server.

Application
server user
name

Login user name for the host on the Quality Center application server.

Application
server
password

Password for the host on the Quality Center application server.

UNIX
operating
system

UNIX operating system type, such as Solaris, Red Hat Enterprise Linux. The
complete list of UNIX operating system types is available in the Operating
system field of the New/Edit UNIX Remote Server dialog box.
Default value: Linux

System file
system
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File system where the Quality Center application is installed.
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UI Element

Description

Repository file
system

File system where the Quality Center repository is located. If the repository is
located on another host, enter the system disk file system, and alter the
Repository Disk Utilization monitor after you deploy your template.

Site
Suffix for the Quality Center Site Administration URL.
Administration
Default value: qcbin/SiteAdmin.htm (for Quality Center version 9.x, change this
path
to sabin)
Application
port

Port used in the login URLs to the Quality Center application. Usually no port is
specified which means port 80 is used.
Default value: 80

Maximum
Value in milliseconds, used as an error status threshold for a reasonable round trip
round trip time time for getting a response from you application URLs.
(milliseconds)
Default value: 1500 milliseconds
Quality Center
process
unique name

Name used to identify the Quality Center java process from the other processes
running on the system. It can be the Quality Center process name, or a unique
part of it taken from the java process command that runs the Quality Center
application on the UNIX operating system (you can use ps -ef | grep java).

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor Verifies the correctness of the monitor configuration properties in the template
properties with against the remote server on which the template is deployed.
remote server
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
Test remote
servers

Tests the connection created from the template remote server after the template
has been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected

HP Quality Center 9.2/10.0 License Status
User interface elements (Variable Values) are described below:
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UI Element

Description

Site
Host name where the Quality Center Site Administration is installed.
Administration
database host
Database
driver

Database driver used for connecting to your database. If a custom driver is used,
the driver must also be installed in the <SiteScope root directory>\WEB-INF\lib
directory.
Default value: com.inet.ora.OraDriver (supports Oracle Database). For Microsoft
SQL, use: com.mercury.jdbc.sqlserver.SQLServerDriver.

Connection
URL (full)

Quality Center database connection URL.
Examples:
jdbc:inetora:[host]:[port]:[sid] (for Oracle Database)
jdbc:mercury:sqlserver://labm1qcrnd05.devlab.ad:1433;DatabaseName=May22_
2008_db (for Microsoft SQL)

Connection
URL (part 0-3)

If your connection URL is composed of semicolon (;) separated values, enter
each part in a separate field in addition to the full Connection URL (full) field.
Example:
Connection URL (part 0) =
jdbc:mercury:sqlserver://labm1qcrnd05.devlab.ad:1433
Connection URL (part 1) = DatabaseName=May22_2008_db
Otherwise enter your whole connection URL in Connection URL (part 0) for
example:
Connection URL (part 0) = jdbc:inetora:[host]:[port]:[sid]
Note: The reason for this separation is that the connection URL is used as a
Script monitor parameter, and the semicolon (;) character is not permitted for
security reasons.

Database user

User name required for querying the database.
The specified user name must have privileges to run the SELECT queries on the
ADMIN and SESSION_LICENSE tables of the Site Administration database.

Database
password
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UI Element

Description

Database
password encrypted

Encrypted form of the database password. To get the encrypted password, run
the following tool on your password:
<SiteScope root directory>\tools\AutoDeployment\encrypt_password.bat
<password>
For UNIX platforms, run enrypt_password.sh <password>.
Note: The encrypted password is used as a Script monitor parameter, and is
required for security reasons.

Admin table
name

Name of the Quality Center ADMIN table.

Session
license table
name

Name of the Quality Center Session License table.

SiteScope
expiration
error status
(days
remaining)

License expiration error threshold. Each License Expiration Status deployed
monitor is in error status if the number of days until the license expires is less than
the number specified here.

SiteScope
expiration
warning status
(days
remaining)

License expiration warning threshold. Each License Expiration Status deployed
monitor is in warning status if the number of days until the license expires is less
than the number specified here.

Default value: ADMIN (supports Oracle database). For Microsoft SQL database,
use td.ADMIN.

Default value: SESSION_LICENSE (supports Oracle database). For Microsoft
SQL database, use td.SESSION_LICENSE.

Default value: 7 days

Default value: 30 days

Number of free License usage error threshold. Each License Usage Status deployed monitor is in
licenses for
error status if the number of free licenses is less than the number specified here.
error
Default value: 5
Number of free License usage warning threshold. Each License Usage Status deployed monitor
licenses for
is in warning status if the number of free licenses is less than the number
warning
specified here.
Default value: 20
Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.
Default value: Not selected
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UI Element

Description

Verify monitor Verifies the correctness of the monitor configuration properties in the template
properties with against the remote server on which the template is deployed.
remote server
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Note:
l

l

The Quality Center license is in XML format that is stored in the ADMIN table on the Site
Administration database. It contains information about the Quality Center license expiration
and quota for each of the different Quality Center modules (for example, Defects,
Requirements, and so forth). The XML format is different for Quality Center 9.2 and Quality
Center 10.0. Another table named SESSION_LICENSE contains an entry on real time for each
logged in session and the license type used.
To calculate the license usage and expiration, the SiteScope solution template uses a Script
monitor that runs a script (runQCLicenseTool.bat on Microsoft Windows platforms, and
runQCLicenseTool.sh on UNIX platforms). The script queries the Quality Center database,
and returns the following information for the requested license type to the Script monitor:
Total=<total quota>;used=<currently used of this type>;free=<total-free>;exp_
days=<left days for license to expire>.

Troubleshooting and Limitations
Content Match Error
If you encounter monitors that have a content match error after deploying the solution template, it is
possible that your Quality Center does not support this type of license.
l

l

If this is the case, delete the unsupported monitor.
If the monitor is supported, check the log file:
<SiteScope root directory>\scripts\qc_license_tool.log.
To set the log file to debug, open <SiteScope root directory>\conf\
ems\tools\conf\core\Tools\log4j\PlainJava\log4j.properties
and set
loglevel=DEBUG
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Solution Template
The HP QuickTest Professional License Server solution template is a template that you can use to
deploy a collection of monitors configured with default metrics that test the HP QuickTest Professional
license server application and system availability.
The solution template provides comprehensive HP QuickTest Professional License Server monitoring
without requiring the SiteScope user or the IT organization to be experts on the application. They also
reduce the time to configure and deploy performance monitors, help identify both real-time performance
bottlenecks and longer term trends, and add only minimal overhead to production systems.
Note:
l

l

The HP QuickTest Professional License Server solution template is not supported on
SiteScopes installed on UNIX platforms.
An in-depth description of the HP QuickTest Professional License Server Solution Template is
available in the SiteScope Quality Center and QuickTest Professional License Server Best
Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_
HP_QC_Best_Practices.pdf. This is a password protected guide; the password is provided
after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the HP
QuickTest Professional License Server solution template.

Learn About
Supported Versions
The HP QuickTest Professional License Server solution template supports HP QTP License Server
7.1.0.
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Tasks
How to Deploy the HP QuickTest Professional License Server Solution Template
This task describes the steps involved in entering variables and deploying the HP QuickTest
Professional License Server solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

You must have the following information:
o

The SiteScope server must have access to the HP QuickTest Professional License server.

o

You must have the HP QuickTest Professional License server host name and login
credentials.

o

This solution template is not supported on SiteScopes installed on UNIX platforms.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
HP QuickTest Professional License Server
User interface elements (Variable Values) are described below:
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UI Element

Description

QTP
license
server host
name

Host name for the HP QuickTest Professional license server.

QTP
license
server user
name

User name for the HP QuickTest Professional license server system login.

QTP
license
server
password

Password for the HP QuickTest Professional license server system login.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote server after the template has
servers
been deployed. The test is performed in the background, enabling you to continue to
use SiteScope.
Default value: Not selected
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SiteScope's HP Service Manager solution templates enable you to monitor and troubleshoot HP
Service Manager application servers availability and system status on Windows and UNIX platforms.
They measure HP Service Manager load balancer status, shared memory usage, and monitors logs for
fatal errors. They can also be used to monitor HP Service Manager in Horizontal Scaled mode.
The HP Service Manager solution templates provide comprehensive monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy performance monitors, and help identify both real-time performance bottlenecks
and longer term trends.
Note: An in-depth description of the HP Service Manager Solution Template is available in the
SiteScope Service Manager Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_HP_SM_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required HP Service Manager solution template.

Learn About
Supported Versions
The HP Service Manager solution template supports Service Manager 7.11.

Solution Template Monitors
The HP Service Manager solution templates create a dynamic set of monitors that target the
HP Service Manager server performance and health on Windows and UNIX platforms. For details on
the monitors, see the SiteScope HP Service Manager Server Best Practices document.

Tasks
How to Deploy the HP Service Manager Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the HP Service Manager solution template.
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1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The HP Service Manager solution templates supports Service Manager 7.11 only.

n

All processes to be monitored must be up and running when deploying the template. If
SiteScope does not find the processes when it tries to create the target monitor, a "No counters
selected" error is displayed and the monitor is not created.
Workaround: If not all processes are up and running, you can copy the template to your own
template container and delete the processes monitors. You can later create them manually, or
deploy another copy of the template that contains only the processes monitors.

n

For the HP Service Manager for Windows solution template, the sm-lbstatus-win-ssh.bat and
sm-shm-win-ssh.bat scripts must be run on the Microsoft Windows remote server where HP
Service Manager is installed. For details, see the following step.
Note: The HP Service Manager for UNIX solution template uses the sm-shm.txt and smlbstatus.txt files located in <SiteScope root directory>/scripts.remote to run
commands on the remote Service Manager UNIX host.

2. Run the sm-lbstatus-win-ssh.bat and sm-shm-win-ssh.bat scripts (for HP Service Manager for
Windows)
a. Install and configure the SSH Server (OpenSSH). For details, see "How to Configure Remote
Windows Servers for SSH monitoring" on page 525.
b. On the machine where SiteScope is installed, find the file called RemoteNTSSH.zip in the
<SiteScope root directory>\tools directory. Unzip the RemoteNTSSH.zip file on the
remote monitored Service Manager host. Place the contents of the zip file into the scripts
subdirectory in the home directory of the account SiteScope uses to access the remote server
(UNIX and Windows-Windows SSH only). For example, home/sitescope/scripts.
Note: On Window platforms, the path to the user home directory depends on the
particular SSH server. For example, if you install a Cygwin SSH server in C:\Cygwin, the
default path to the home directory for the Administrator user will be
C:\Cygwin\home\Administrator. For additional information, see the documentation for
your SSH server.
c. On the machine where SiteScope is installed, find the file called SM_Scripts_win_ssh.zip in
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the <SiteScope root directory>\tools\ServiceManager directory. Unzip the file on the
remote monitored Service Manager host to the scripts directory in the home directory of the
account SiteScope uses. (The zip contains the sm-lbstatus-win-ssh.bat and sm-shm-winssh.bat files.) Make sure both scripts have execute permissions. If you are running Service
Manager in Horizontally Scaled mode, you need to repeat this on every system.
d. Share the Service Manager logs folder. Right-click the logs folder and select Properties >
Sharing. Select Share this folder, and enter a Share name. Set the share permissions for
the user that SiteScope monitor uses to run the monitors on that machine, and click OK.
3. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
4. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
HP Service Manager for Windows
User interface elements (Variable Values) are described below:
UI Element

Description

SM
installation
partition

Disk drive where HP Service Manager is installed.

Application
server host
name

Name of the application server host.

User name

Login name to access the application server using this profile.

Password

Application server login password for this user.

Installation
path

Path to the directory on which HP Service Manager binary is running.

Log files
path

A shared path to the HP Service Manager \logs directory.

Default value: C

Default value: C:\Program Files\HP\Service Manager 7.11\Server\RUN

Example: \\< HP Service Manager host name>\logs
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UI Element

Description

CPU error
threshold

Threshold for triggering CPU errors.

CPU
warning
threshold

Threshold for triggering CPU warnings.

Memory
error
threshold

Threshold for triggering memory errors.

Memory
warning
threshold

Threshold for triggering memory warnings.

Default value: 90

Default value: 80

Default value: 2202012 KB

Default value: 1782580 KB

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote server after the template has
servers
been deployed. The test is performed in the background, enabling you to continue to
use SiteScope.
Default value: Not selected

HP Service Manager for UNIX
User interface elements (Variable Values) are described below:
UI Element

Description

Application
server host
name

Name of the application server host.
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UI Element

Description

User name

Login name to access the application server using this profile.

Password

Application server login password for this user.

UNIX
operating
system

UNIX operating system on which HP Service Manager is running.

UNIX
connection
method

Method used to connect to the UNIX operating system.

Shell
prompt

Prompt output when the remote system is ready to handle a command (for Telnet or
Rlogin connection method only).

Installation
path

Path to the directory on which HP Service Manager binary is running.

CPU error
threshold

Threshold for triggering CPU errors.

CPU
warning
threshold

Threshold for triggering CPU warnings.

Memory
error
threshold

Threshold for triggering memory errors.

Memory
warning
threshold

Threshold for triggering memory warnings.

Default value: 90

Default value: 80

Default value: 2202012 KB

Default value: 1782580 KB

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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UI Element

Description

Test remote Tests the connection created from the template remote server after the template has
servers
been deployed. The test is performed in the background, enabling you to continue to
use SiteScope.
Default value: Not selected

Tips/Troubleshooting
General Tip/Limitation
If you are running HP Service Manager in Horizontally Scaled mode, you need to deploy and configure
the HP Service Manager solution template on every system.

No counters selected
All processes to be monitored must be up and running when deploying the template. If you get a "no
counters selected" error, it means that some processes are down. To resolve this problem, make a
copy of the template and delete the monitors for which you get errors before deploying the template.

Ping traffic blocked
The solution template uses the Ping monitor to monitor system availability. If Ping traffic is blocked on
your network, use the Port monitor, and use Global Search and Replace to replace the dependency
from the Ping monitor to the Port monitor.

HP SiteScope (11.31)

Page 941 of 1395

Chapter 75: HP Vertica Solution Template
You can use the HP Vertica solution template to provide monitoring of different aspects of the Vertica
cluster infrastructure.
The HP Vertica solution template deploys a set of monitors against a particular Vertica cluster. These
monitors are designed to manage large, fast-growing volumes of data and provide fast query
performance when used for data warehouses and other query-intensive applications.
Vertica can be monitored by SNMP trap, System Tables, and log files.
This template includes the HP Vertica JDBC and SNMP Trap monitors.
The HP Vertica solution template provides comprehensive monitoring without requiring the SiteScope
user or the IT organization to be experts on the application. It also reduce the time to configure and
deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.
Note: An in-depth description of the HP Vertica Solution Template is available in the SiteScope
HP Vertica Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Vertica_Best_Practices.pdf.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the HP
Vertica solution template.

Learn More
Supported Versions
The HP Vertica solution template supports monitoring on Vertica 6.0.1, 6.1, 7.0, and 7.1.1.

Tasks
How to Deploy the HP Vertica Solution Template
This task describes the steps involved in entering variables for the HP Vertica solution template.
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1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

To be able to deploy the HP Vertica solution template on a Vertica 7.0 cluster environment, you
must be a Super User. For details on user types, see "User Types and User Role Types" on
page 733.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Description
HP Vertica Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Database

Name of the Vertica database server.

Host

Name of the host.

Port

Port that SiteScope should use to access the Vertica database server.

Driver

Name of the Vertica JDBC driver to be used by this monitor.
Default value: com.vertica.jdbc.Driver

Username

User name that SiteScope should use to access the Vertica database server.

Password

Password to be used to access the Vertica database server.
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UI Element

Description

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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You can use the JBoss Application Server solution templates to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of JBoss application
servers.
The JBoss Application Server solution templates provide comprehensive JBoss monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the
time to configure and deploy performance monitors, helps identify both real-time performance
bottlenecks and longer term trends, and adds only minimal overhead to production systems.
Note: An in-depth description of the JBoss Solution Template is available in the SiteScope JBoss
Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_JBoss_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required JBoss solution template.

Learn About
Supported Versions
The JBoss Application Server solution templates support JBoss Application Server versions 4.x, 5.x,
7.1 - 7.4.
Red Hat JBoss Enterprise Application Platforms 6.1.0 and 6.3.0 are also supported by the JBoss AS
7.1 - 7.4 solution template.

Solution Template Monitors
The JBoss Application Server solution templates create a dynamic set of monitors that target the
JBoss application server performance and health. The exact monitor set depends on the entities you
select during the solution template deployment. For details on the monitors, see the SiteScope JBoss
Application Server Best Practices document.
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Tasks
How to Deploy the JBoss Application Server Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the JBoss Application Server solution templates.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

You must know the URL for gathering JMX statistics (including the host name and port of the
JMX instance), and the JMX user name and password.

n

SiteScope and the target server can run on the same host.

n

You must start JBoss in a particular way, so that SiteScope can monitor it. For details, see the
following step.

2. Start JBoss
n

For JBoss 4.x only:
To enable SiteScope to monitor JBoss, specify the following options for the JBoss JVM:
-Dcom.sun.management.jmxremote
-Dcom.sun.management.jmxremote.port=12345
(any other port can be used of course; then it must be specified during
ST deployment)
-Dcom.sun.management.jmxremote.ssl=false
-Dcom.sun.management.jmxremote.authenticate=false
-Djboss.platform.mbeanserver
Djavax.management.builder.initial=org.jboss.system.server.jmx.MBeanServer
BuilderImpl

You can perform this using the following batch file:
@echo off

HP SiteScope (11.31)

Page 946 of 1395

Using SiteScope
Chapter 76: JBoss Application Server Solution Templates

set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.port=12345
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.authenticate=false
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote.ssl=false
set JAVA_OPTS=%JAVA_OPTS% Djavax.management.builder.initial=org.jboss.system.server.jmx.MBeanServerBuilderImpl
set JAVA_OPTS=%JAVA_OPTS% -Djboss.platform.mbeanserver
set JAVA_OPTS=%JAVA_OPTS% -Dcom.sun.management.jmxremote
call run.bat -b my-jboss-host

Note:

n

o

run.bat is the default script used to start JBoss AS 4.x.

o

-b option binds JBoss 4.2.2 to the correct network interface (it binds only to local host
by default making it inaccessible from other hosts).

o

You can build a similar script for UNIX.

For JBoss 7.1 - 7.4 only:
Standalone mode
To enable SiteScope to monitor JBoss, perform the following steps:
i. Change all 127.0.0.1 entries to your JBoss server's IP address in the xml configuration
files in the <JBoss_home>\standalone\configuration\ directory, otherwise JBoss will
only be available from the local host.
ii. Change the HTTP port to a different port by editing the <socket-binding name="http"
port="8080"/> property (for example, if you have installed SiteScope and JBoss on the
same server).
iii. You can change the JMX remoting port by editing the
jboss.management.native.port:9999 property.
iv. Add a new Management user using <JBoss_home>\bin\add-user.bat on Windows
platform, or <JBoss_home>/bin/add-user.sh on Linux platform.
v. Start JBoss using <JBoss_home>\bin\standalone.bat on Windows platform, or
<JBoss_home>/bin/standalone.sh on Linux platform.
Domain mode
To enable SiteScope to monitor JBoss, perform the following steps:
i. Change all 127.0.0.1 entries to your JBoss server's IP address in the xml configuration
files in the <JBoss_home>\domain\configuration\ directory, otherwise JBoss will only
be available from the local host.

HP SiteScope (11.31)

Page 947 of 1395

Using SiteScope
Chapter 76: JBoss Application Server Solution Templates

ii. Change the HTTP port to a different port by editing the <socket-binding name="http"
port="8080"/> property (for example, if you have installed SiteScope and JBoss on the
same server).
iii. You can change the JMX remoting port by editing the <socket-binding
name="remoting" port="4447"/> property.
iv. Edit <JBoss_home>\domain\configuration\domain.xml:
For JBoss AS 7.1:
replace <remoting-connector/> with
<remoting-connector use-management-endpoint="false"/>
for JBoss EAP 6.1 - 6.2:
replace <!--<remoting-connector use-management-endpoint="false"/>-->
with <remoting-connector use-management-endpoint="false"/>
v. Add a new Application user using <JBoss_home>\bin\add-user.bat on Windows
platform, or <JBoss_home>/bin/add-user.sh on Linux platform.
vi. Start JBoss using <JBoss_home>\bin\domain.bat on Windows platform, or <JBoss_
home>/bin/domain.sh on Linux platform.
3. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
4. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
JBoss AS 4.x Solution Template Page
User interface elements (Variable Values) are described below:
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UI Element

Description

JMX_URL

URL to gather JMX statistics. Typically the URL is in the format:
service:jmx:rmi:///jndi/rmi://{hostname}:{port}/jmxrmi.
Enter the host name and port of the JMX instance you want to monitor.

USERNAME

User name for connection to the JMX application (optional).

PASSWORD

Password for connection to the JMX application (optional).

Counters

Displays the server performance counters you want to check with this monitor. Use
the Get Counters button to select counters.

Get
Counters

Opens the Get Counters dialog box, enabling you to select the entities you want to
monitor. For each instance, a specific set of monitors and thresholds is created. For
details, see the SiteScope JBoss Application Server Best Practices Guide which
can be found at <SiteScope root directory>\sisdocs\pdfs\
SiteScope_JBoss_Best_Practices.pdf.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

JBoss AS 7.1 - 7.4 Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

JMX URL

URL to gather JMX statistics from the JBoss Application Server. Typically the URL
is in the format: service:jmx:remoting-jmx://<server_name>:<port>.

Hostname

Hostname of machine where is JBoss AS server located. Will be used as hostname
of JBoss CI type for sending topology to the HP BSM.

Login

Login name for connection to the JBoss Application Server.

Password

Password for connection to the JBoss Application Server.
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UI Element

Description

Additional
Classpath

Path for the client JBoss Application Server jar files. File path elements should be
separated by a semicolon (";"). The client files are located in the <SiteScope root
directory>\templates.applications\lib folder.
Default value: ../templates.applications/lib/jbossclient.jar;../templates.applications/lib/jboss-common-core-2.2.17.GA-redhat-2.jar

Timeout

Timeout value for the Dynamic JMX monitors in seconds.
Default value: 120

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The Linux Host solution template is a template that you can use to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of the target Linux
host. The template supports the versions of Linux that are supported by SiteScope. For details, see
System Requirements in the SiteScope Deployment Guide (<SiteScope root directory>\sisdocs\doc_
lib\Get_Documentation.htm).
For UNIX Resource Monitors, you can create a Server-Centric report which displays data from three
different metrics about the server being monitored. For more information on generating a Server-Centric
report, see "Create Server-Centric Reports" on page 1365.
Tip: We recommend using solution templates when creating the UNIX Resource Monitor,
because the required monitors and metrics are already configured.
The Linux Host solution template provides comprehensive Linux operating system monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduces the
time to configure and deploy performance monitors, helps identify both real-time performance
bottlenecks and longer term trends, and adds only minimal overhead to production systems.
Note: An in-depth description of the Linux Host Solution Template is available in the SiteScope
Operating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select Linux
Host.

Learn More
Supported Versions
The Linux Host solution template supports:
l

Red Hat 7.x, 8.x, 9.x

l

Red Hat Enterprise Linux 3.x, 4.x, 5.2, 5.4, 5.5 (ES/AS)

HP SiteScope (11.31)

Page 951 of 1395

Using SiteScope
Chapter 77: Linux Host Solution Template

Solution Template Monitors
The Linux Host solution template deploys monitors that target the following aspects of Linux
performance and health:
l

CPU status and utilization details

l

Memory status and utilization details

l

File system status and utilization details

Tasks
How to Deploy the Linux Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Linux Host solution template.
Note: The Linux Host solution template deploys a UNIX Resource Monitor for each target host.
This is a supplemental monitor that is required for Server-Centric Report support.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The SiteScope server must be able to connect to the target Linux host.

n

The target server must be added to SiteScope as a UNIX remote machine and should pass the
UNIX remote test (Remote Servers > UNIX Remote Servers). For details, see "Configure
SiteScope to Monitor Remote UNIX Servers" on page 492.
Note:
o

The SiteScope server itself can also be monitoring if it runs a supported Linux operating
system.

o

The template supports the Linux versions supported by SiteScope. For details, see
System Requirements in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).
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2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Linux Host Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a UNIX connection profile, see "Configure SiteScope to Monitor Remote UNIX
Servers" on page 492.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The Microsoft Exchange solution templates provide monitoring of performance, availability, and usage
statistics for Microsoft Exchange servers. The templates include monitors that check Windows Event
log entries, Exchange test operations and statistics, system performance counters, and message
system usage statistics.
The Microsoft Exchange solution templates provide comprehensive Microsoft Exchange system
monitoring without requiring the SiteScope user or the IT organization to be experts on the application.
They also reduce the time to configure and deploy monitors, help identify both real-time performance
bottlenecks and longer term trends, and add only minimal overhead to production systems.
Note: An in-depth description of the Microsoft Exchange Solution Template is available in the
SiteScope Microsoft Exchange Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Exchange_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required Microsoft Exchange solution template.

Learn About
Supported Versions
The Microsoft Exchange solution templates support:
l

Microsoft Exchange 2007 Server (version 8.0)

l

Microsoft Exchange 2010 Server

l

Microsoft Exchange 2013 Server

Solution Template Monitors
The Microsoft Exchange solution templates deploy monitors that target the following aspects of
Microsoft Exchange performance and health:
l

Basic server/OS performance. This category refers to the system-level health of a server. The
Microsoft Exchange solution templates automatically configure monitors for server health.
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l

l

Application performance. Application performance is a measure of how well specific Exchange
components are functioning. The Microsoft Exchange solution templates automatically configure
monitors for a list of important Exchange application components.
Exchange Server test operations and statistics. The Microsoft Exchange solution templates can
monitor different tests and statistic command-lets (cmdlets) of the Exchange Server. Cmdlets can
be used to:
Verify:

Test:

Get:

l

n

Exchange ActiveSync (Microsoft Exchange 2013 Solution Template only)

n

Web Services Functionality

n

Anonymous calendar sharing is enabled and worked properly (Microsoft Exchange
2013 Solution Template only)

n

Mailbox Replication Service (Microsoft Exchange 2013 Solution Template only)

n

Required services are running (Microsoft Exchange 2013 Solution Template only)

n

End to End Mail Delivery

n

POP3 Service (Microsoft Exchange 2013 Solution Template only)

n

IMAP4 Service (Microsoft Exchange 2013 Solution Template only)

n

DAG Members (Microsoft Exchange 2013 Solution Template only)

n

Mailbox Databases

n

Mailbox Assistance performance (Microsoft Exchange 2013 Solution Template only)

n

Is Exchange Search currently enabled and is indexing new email messages is a
timely manner

n

Average store usage statistics values (Microsoft Exchange 2013 Solution Template
only)

Usage statistics. The last category related to Microsoft Exchange performance is usage. While
usage in and of itself is not necessarily a key indicator of performance, changes in usage can affect
overall Microsoft Exchange performance. In addition, Microsoft Exchange usage statistics help IT
organizations spot trends and plan for the future. The Microsoft Exchange solution templates
automatically configure monitors for a list of important Microsoft Exchange usage parameters.
Note: Some of the monitor types deployed by the solution templates can only be added to
SiteScope by using the Microsoft Exchange solution templates. See the section for the particular
monitor types for more information.
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Tasks
How to Deploy Microsoft Exchange Solution Templates
This task describes the steps involved in configuring the server environment and entering variables for
the Microsoft Exchange solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

Before deploying a Microsoft Exchange solution template, you must perform specific steps
depending on the solution template you want to deploy.
o

Microsoft Exchange 2007, 2010 solutions. These solution templates make use of the
Microsoft Exchange 2007 and 2010 monitors. Successful deployment of these monitor types
require specific setup configuration. For details, see Microsoft Exchange Monitor in the
SiteScope Monitor Reference Guide.

o

Microsoft Exchange 2013 solutions. These solution templates make use of the Microsoft
Windows Event Log, Microsoft Windows Resources, Microsoft Exchange Base, and
Service monitor. Successful deployment of these monitor types requires specific setup
configuration. For details, see Microsoft Windows Event Log Monitor, Microsoft Windows
Resources Monitor, Microsoft Exchange Base Monitor, and Service Monitor in the SiteScope
Monitor Reference Guide.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
For details on configuring the template monitor, see the documentation for the specific Microsoft
Exchange monitor in the SiteScope Monitor Reference Guide.
Note: The Microsoft Exchange 2010 and Microsoft Exchange 2013 solutions provide a
number of templates in a template container, that can be deployed either individually, or
simultaneously, to a group. This enables you to select only the templates that you require,
and to deploy them against distributed Exchange server installations on separate servers. For
details on deploying multiple templates simultaneously, see "Deploy Multiple Templates
Dialog Box" on page 855.
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3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Microsoft Exchange 2007, 2010 Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Domain
(Exchange
2007 and
2010 only)

Domain to which both the owner of the mailbox being used and the Microsoft
Exchange server belong.

Mailbox

Name (alias) of the mailbox to be used for testing email round trip times using MAPI.
This is often the email account name but it may be a different name.

Note: The owner of the mailbox to be used by this solution must also have
administrative account privileges on the machine where SiteScope is running.
SiteScope also needs user account access to the domain where the Microsoft
Exchange server is running.

Tip: We recommend copying the mailbox name as it appears in the E-Mail Account
properties for the email account you are using for this solution.
SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a Windows connection profile, see "Configure SiteScope to Monitor Remote
Windows Servers" on page 470.

Exchange
PS
Console
File Path
(Microsoft
Exchange
2007 and
2010 only)

Path to the Microsoft Exchange Management Shell PowerShell console file.
Default value: C:\Program Files\Microsoft\Exchange Server\Bin\ExShell.psc1
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UI Element

Description

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Microsoft Exchange 2013 Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Exchange
server name
(ID)

Name (ServerIdParameter) of the Microsoft Exchange Server that you want to
monitor, without the domain.

Exchange
domain

Domain name of the Microsoft Exchange Server that you want to monitor.

Mailbox
account

Name of some existing mailbox for the current Exchange Server.

Remote
Exchange
script file
path

Full path to the Microsoft Exchange Server Management Shell script file.

Timeout
(seconds)

Amount of time to wait, in seconds, for getting a response. You can set the timeout
to no less than 1 second and no more than 15 minutes.

Example: exchange1

Example: some.exchange.domain

Example: Administrator

Default value: C:\Program Files\Microsoft\Exchange
Server\V15\Bin\RemoteExchange.ps1

Default value: 600 seconds
User for
User of the remote server on which the current Exchange Server is installed.
remote server
Example: exchange-domain\Administrator
(domain\user)
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UI Element

Description

Password of
the remote
server's user

Password for user of the remote server on which the current Exchange Server is
installed.

POP3 service
port

Port number for POP3 service on the current Exchange Server.

IMAP4
service port

Port number for IMAP4 service on the current Exchange Server.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.

Default value: 995 (use 995 for SSL; 110 for plain text /TLS)

Default value: 993 (use 993 for SSL; 143 for plain text /TLS)

Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The Microsoft IIS solution templates are templates that you can use to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of Microsoft IIS
servers.
The Microsoft IIS solution templates provide comprehensive IIS monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. It also reduces the time to
configure and deploy performance monitors, helps identify both real-time performance bottlenecks and
longer term trends, and adds only minimal overhead to production systems.
Note: An in-depth description of the Microsoft IIS Solution Template is available in the SiteScope
Microsoft IIS Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_IIS_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required Microsoft IIS solution template (Microsoft IIS 6 or Microsoft IIS 7.x).

Learn More
Supported Versions
The Microsoft IIS solution templates support Microsoft IIS 6.0, 7.x, and 8.0.

IIS Solution Template Monitors
The Microsoft IIS solution templates deploy monitors that target the following services and aspects of
IIS server performance and health:
l

l

l

Active Server Pages (ASP errors, requests, templates, sessions, transactions)
FTP service, Web service, SMTP server, NNTP server, HTTP/HTTPS services, MSMQ Queue
service, IIS Server, Global IIS status, IIS WAS, IIS W3SVC, IIS Windows Log, Indexing services
IIS statistics as a Windows process
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Tasks
How to Deploy the Microsoft IIS Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Microsoft IIS solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The SiteScope server must be able to connect to the target Microsoft IIS host. Use the
Microsoft Windows Resources Monitor to monitor the server performance statistics from
remote Windows servers. The Microsoft Windows Resource monitor may require special
configuration. For details, see Microsoft IIS Server Monitor in the SiteScope Monitor Reference
Guide.

n

The target server must be added to SiteScope as a Windows remote machine and should pass
the Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For
details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on page 475.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope to Monitor a Remote Microsoft Windows Server" on
page 470.
Note: SiteScope and the target IIS server can run on the same host.

2. Configure the server environment (for Microsoft IIS 6 only)
Configure the IIS Server so that it contains the ASP component path in the components tree.
a. In the Control Panel, select Add or Remove Programs > Add/Remove Windows
Components.
b. In Windows Component Wizard, on the Windows Components page, highlight Application
Server, and click Details.
c. In Application Server, select the ASP.NET check box.
d. Highlight Internet Information Services (IIS), and then click Details.
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e. In Internet Information Services (IIS), select the World Wide Web Service check box, and
then click Details.
f. In World Wide Web Service, select the Active Server Pages check box, and then click OK.
g. In Internet Information Services (IIS) click OK.
h. In Application Server, ensure that the Internet Information Services (IIS) check box is
selected, and then click OK to install the components.
i. Click Next, and when the Windows Components Wizard completes, click Finish.
j. To enable ASP.NET, select Administrative Tools > Internet Information Services (IIS)
Manager in the Control Panel.
k. In the console tree, expand the local computer, and then click Web Service Extensions.
l. In the details pane, click ASP.NET, and then click Allow.
3. Configure the server environment (for Microsoft IIS 7.x only)
Configure the IIS Server so that it contains the ASP component path in the components tree.
a. Start the Server Manager (click Start, click Run, and then type CompMgmtLauncher).
b. In the tree view, select Roles, and in the Roles pane click Add Roles.
c. In the Add Roles Wizard, click Select Server Roles, select the Web Service (IIS) check
box, click Next, and then click Next again.
If the "Add features required for Web Server (IIS)?" message is displayed, click Click Add
Required Features.
d. In the Select Role Services window, make sure that the ASP.NET andASP service is
selected (under Application Development).
4. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
5. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
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UI Descriptions
Microsoft IIS Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a Windows connection profile, see "Configure SiteScope to Monitor Remote
Windows Servers" on page 470.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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Templates
You can use the Microsoft Lync Server 2010 solution templates listed below to provide monitoring of
different aspects of the Microsoft Lync Server 2010 server. These templates provide comprehensive
monitoring without requiring the SiteScope user or the IT organization to be experts on the application.
They also reduce the time to configure and deploy monitors, help identify both real-time performance
bottlenecks and longer term trends, and add only minimal overhead to production systems.
For Microsoft Lync Server 2010 monitors, you can create a Server-Centric report which displays data
from three different metrics about the server being monitored.
Note: An in-depth description of the Microsoft Lync Server 2010 Solution Template is available in
the SiteScope Microsoft Lync Server 2010 Best Practices document, available from <SiteScope
root directory>\sisdocs\pdfs\SiteScope_MS_Lync_Server_2010_Best_Practices.pdf. This is
a password protected guide; the password is provided after acquiring an HP license edition that
supports the solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates > Microsoft Lync
Server 2010, and select the required Microsoft Lync Server 2010 solution template.

Learn More
Microsoft A/V Conferencing Server
Monitors the server performance statistics of the Microsoft Lync A/V Conferencing Server. A/V
conferencing enables real-time audio and video A/V communications between your users (provided
they have appropriate client devices such as headsets for audio conferences and web cams for video
conferences). A/V Conferencing Server provides A/V conferencing functionality to your deployment. It
can be collocated with Front End Server, or deployed separately as a single server or A/V Conferencing
Server pool.

Microsoft Archiving Server
Monitors the server performance statistics of the Microsoft Lync Archiving Server. The Archiving
Server enables you to archive instant messaging (IM) communications and meeting content for
compliance reasons. Corporations and other organizations are subject to an increasing number of
industry and government regulations that require the retention of specific types of communications.
With the Archiving Server feature, Microsoft Lync Server 2010 communications software provides a
way for you to archive IM content, conferencing (meeting) content, or both, that is sent through Lync
Server 2010. If you deploy Archiving Server and associate it with Front End pools, you can set it to
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archive instant messages and conferences and specify the users for which archiving is enabled.

Microsoft Director Server
Monitors the server performance statistics of the Microsoft Lync Director Server. A Director is a server
running Microsoft Lync Server communications software that authenticates user requests, but does not
home any user accounts or provide presence or conferencing services. Directors are most useful in
deployments that enable external user access, where the Director can authenticate requests before
sending them on to internal servers. Directors can also improve performance in organizations with
multiple Front End pools.

Microsoft Edge Server
Monitors the server performance statistics of the Microsoft Lync Edge Server. The Edge Server
enables your users to communicate and collaborate with users outside the organization's firewalls.
These external users can include the organization's own users who are currently working offsite, users
from federated partner organizations, and outside users who have been invited to join conferences
hosted on your Lync Server deployment. Edge Server also enables connectivity to public IM
connectivity services, including Windows Live, AOL, and Yahoo!.

Microsoft Front End Server
Monitors the server performance statistics of the Microsoft Lync Front End Server. The Front End
Server is the core server role, and runs many basic Lync Server functions. The Front End Server, along
with the Back End Servers, which provide the database, are the only server roles required to be in any
Lync Server Enterprise Edition deployment.
A Front End pool is a set of Front End Servers, configured identically, that work together to provide
services for a common group of users. A pool provides scalability and failover capability your users.
Front End Server includes the following functionality:
l

User authentication and registration

l

Presence information and contact card exchange

l

Address book services and distribution list expansion

l

IM functionality, including multiparty IM conferences

l

Web conferencing and application sharing (if deployed)

l

l

Application hosting services, for both applications included with Lync Server (for example,
Conferencing Attendant and Response Group application) and third-party applications
Application services for application hosting and hosts applications (for example, Response Group
application, and several others)

Microsoft Mediation Server
Monitors the server performance statistics of the Microsoft Lync Mediation Server. The Mediation
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Server is a necessary component for implementing Enterprise Voice and dial-in conferencing. The
Mediation Server translates signaling and, in some configurations, media between your internal Lync
Server infrastructure and a public switched telephone network (PSTN) gateway, IP-PBX, or a Session
Initiation Protocol (SIP) trunk. On the Lync Server side, Mediation Server listens on a single mutual
TLS (MTLS) transport address. On the gateway side, Mediation Server listens on a single TCP and
single TLS transport address or a single TLS transport address. All qualified gateways must support
TLS, but can enable TCP as well.

Microsoft Monitoring and CDR Server
Monitors the server performance statistics of the Microsoft Lync Monitoring and CDR Server. The
Monitoring Server collects data about the quality of your network media, in both Enterprise Voice calls
and A/V conferences. This information can help you provide the best possible media experience for
your users. It also collects call error records (CERs), which you can use to troubleshoot failed calls.
Additionally, it collects usage information in the form of call detail records (CDRs) about various Lync
Server features, so that you can calculate return on investment of your deployment, and plan the future
growth of your deployment.

Microsoft Registrar Server
Monitors the server performance statistics of the Microsoft Lync Registrar Server. The Lync Server
2010 Registrar is a new server role that enables client registration and authentication and provides
routing services. It resides along with other components on a Standard Edition Server, Enterprise Front
End Server, Director, or Survivable Branch Appliance. A Registrar pool consists of Registrar Services
running on the Lync Server pool and residing at the same site.

Tasks
How to Deploy the Microsoft Lync Server 2010 Solution Templates
This task describes the steps involved in entering variables for the Microsoft Lync Server 2010 solution
template.
1. Prerequisite
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
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3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
Note: The Microsoft Lync Server 2010 solution provides a number of templates in a template
container, that can be deployed either individually, or simultaneously, to a group. This enables
you to select only the templates that you require. For details on deploying multiple templates
simultaneously, see the Deploy multiple templates step in "How to Deploy Templates Using
the User Interface" on page 848.

UI Descriptions
Microsoft Lync Server 2010 Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Host

The host name of the Microsoft Lync Server 2010 instance you want to monitor.

User

The user name with admin credentials on the Microsoft Lync Server 2010 instance.

Password

Password for the user on the Microsoft Lync Server 2010.

Connection
method

The method used to connect to the server. Options are: NetBIOS, WMI, or SSH.

Remote
server
encoding

The encoding of the remote server.

Default value: NetBIOS

Default value: Cp1252

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
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UI Element

Description

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote servers after the templates
servers
have been deployed. The test is performed in the background, enabling you to
continue to use SiteScope.
Default value: Not selected
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You can use the Microsoft SharePoint 2010 solution templates to provide monitoring of SharePoint
environments—to understand how the SharePoint Server 2010 system is running, and to monitor
important events, performance counters, and services, found in SharePoint 2010 products.
The Microsoft SharePoint 2010 solution templates deploy a set of monitors (Microsoft Windows Event
Log, Microsoft Windows Resources, CPU, Disk Space, and SQL) that target services and aspects of
the Microsoft SharePoint 2010 performance and health. These monitors encompass best practices
monitoring for Microsoft SharePoint 2010.
The Microsoft SharePoint 2010 solution templates provide comprehensive monitoring without requiring
the SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Note:
l

l

An in-depth description of the Microsoft SharePoint 2010 Solution Template is available in the
SiteScope Microsoft SharePoint 2010 Best Practices document, available from <SiteScope
root directory>\sisdocs\pdfs\SiteScope_SharePoint_Best_Practices.pdf. This is a
password protected guide; the password is provided after acquiring an HP license edition that
supports the solution template.
The Microsoft SharePoint 2010 solution templates are also supported in SiteScopes that are
running on UNIX versions if the remote server being monitored has been configured for SSH
and the SSH connection method is used in the template. For details, see "Configure Remote
Monitoring Using Secure Shell (SSH)" on page 516.

To access
Select the Templates context. In the template tree, expand Solution Templates > Microsoft
SharePoint 2010, and select the required SharePoint template.

Learn About
SharePoint Environment
The Microsoft SharePoint 2010 solution template deploys monitors that target availability,
performance, and health of the following aspects of a SharePoint environment:
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l

IIS Process

l

InfoPath Service

l

Publishing Service

l

Search Service

l

Service Application

l

SharePoint Server

l

SQL Server

Tasks
How to Deploy the Microsoft SharePoint 2010 Solution Templates
This task describes the steps involved in deploying the Microsoft SharePoint 2010 solution templates.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
Note: The Microsoft SharePoint 2010 solution provides a number of templates in a template
container, that can be deployed either individually, or simultaneously, to a group. This enables
you to select only the templates that you require. For details on deploying multiple templates
simultaneously, see Deploy multiple templates step in "How to Deploy Templates Using the
User Interface" on page 848.
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UI Descriptions
Microsoft SharePoint 2010 Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Host

The host name of the Microsoft SharePoint instance.

User Name

The user name with admin credentials on the monitored Microsoft SharePoint
instance.

Password

Password for the user on the monitored Microsoft SharePoint instance.

Connection
method

The method used to connect to the server. Options are NetBIOS, WMI, and SSH.

Remote
server
encoding:

Encoding for the remote server if the remote server is running an operating system
version that uses a different character encoding than the server on which SiteScope
is running. This enables SiteScope to display encoded content correctly.

Default value: NetBIOS

Default value: Cp1252
Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Test remote Tests the connection created from the template remote servers after the template has
servers
been deployed. The test is performed in the background, enabling you to continue to
use SiteScope.
Default value: Not selected
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The Microsoft SQL Server solution templates are templates that you can use to deploy a collection of
monitors configured with default metrics that test the health, availability, and performance of
Microsoft SQL servers.
The Microsoft SQL Server solution templates provide comprehensive Microsoft SQL server monitoring
without requiring the SiteScope user or the IT organization to be experts on the application. It also
reduces the time to configure and deploy performance monitors, helps identify both real-time
performance bottlenecks and longer term trends, and adds only minimal overhead to production
systems.
Note: An in-depth description of the Microsoft SQL Solution Template is available in the SiteScope
Microsoft SQL Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_MSSQL_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required solution (Microsoft SQL Server 2005, 2008 or Microsoft SQL Server 2008 R2, 2012, 2014).

Learn More
Supported Versions
l

l

Microsoft SQL Server 2005, 2008 solution template supports Microsoft SQL Server 2005 and 2008.
Microsoft SQL Server 2008 R2, 2012, 2014 solution template supports Microsoft SQL Server 2008
R2, 2012, and 2014.

Solution Template Monitors
The Microsoft SQL Server solution templates deploy monitors that target the following aspects of
Microsoft SQL server performance and health:
l

CPU status and utilization details

l

Memory status and utilization details

l

Disk utilization information
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l

SQL Server availability

l

SQL Server objects (Buffer Manager, Databases, Locks, Transactions, Batch request, Cache)

l

l

SQL Server resources (space available, percentage of currently connected users, I/O utilization,
latches, mirroring, replication, data access)
Errors in SQL Server

The Microsoft SQL Server solution makes use of the SiteScope Database Counter monitor, Microsoft
SQL Server monitor, and Microsoft Windows Resources monitor. For detailed information about these
monitors, see Database Counter Monitor, Microsoft SQL Server Monitor, and Microsoft Windows
Resources Monitor.

Tasks
How to Deploy the Microsoft SQL Server Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Microsoft SQL Server solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The SiteScope server must be able to connect to the target Microsoft SQL host. Use the
Microsoft Windows Resources Monitor to monitor the server performance statistics from
remote Windows servers. The Microsoft Windows Resource monitor may require special
configuration. For details, see Microsoft Windows Resources Monitor in the SiteScope Monitor
Reference Guide.

n

The target server must be added to SiteScope as a Windows remote machine and should pass
the Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For
details, see "Configure SiteScope to Monitor Remote Windows Servers" on page 470.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope to Monitor a Remote Microsoft Windows Server" on
page 470.

n

The SQL Server user must have VIEW SERVER STATE permissions on the monitored SQL
Server instance to retrieve data from SQL Server System Views. For more information about

HP SiteScope (11.31)

Page 973 of 1395

Using SiteScope
Chapter 82: Microsoft SQL Server Solution Templates

granting permissions on Microsoft SQL Server, see http://msdn2.microsoft.com/enus/library/ms186717.aspx.
Note: SiteScope and the target Microsoft SQL Server can run on the same host.
n

(For Microsoft SQL Server 2014) Perform the following when using a remote database
instance:
i. Enable the TCP/IP protocol for the database instance.
ii. Enable the firewall (add inbound rule for firewall)
iii. On the Start menu, click All Programs > Microsoft SQL Server 2014 > Configuration
Tool > SQL Server Configuration Manager. In SQL Server Configuration Manager, in
the console pane, expand SQL Server Network Configuration, expand Protocols for
<instance name>, double-click TCP/IP, and then change Enabled to “Yes”.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Microsoft SQL Server 2005, 2008
User interface elements (Variable Values) are described below:
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UI Element

Description

Microsoft SQL
Server URL

URL for the monitored Microsoft SQL Server instance.
l

l

Replace ${host} with the host name on which the Microsoft SQL Server is
running. This must be the same as the host name defined for the Windows
remote machine. For details, see "New/Edit Microsoft Windows Remote
Server Dialog Box" on page 475.
Replace ${port} with the port number on which the Microsoft SQL Server
accepts connections. By default, the port is 1433.

Example: jdbc:mercury:sqlserver://doors:1433
Microsoft SQL
Server
instance name

Name of the SQL Server service instance.

Login to
Microsoft SQL
Server

Login name for the user on the monitored Microsoft SQL Server instance.

Microsoft SQL
Server
password

Password for the user on the monitored Microsoft SQL Server instance.

SERVER_LIST

Name of the server you want to monitor. If the server you want to monitor is not in
the list, you must define a connection profile to the server. For the steps you use
to create a Windows connection profile, see "Configure SiteScope to Monitor
Remote Windows Servers" on page 470.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.

Default value: SQL Server (MSSQLSERVER)

Default value: Not selected
Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Microsoft SQL Server 2008 R2, 2012, 2014
User interface elements (Variable Values) are described below:
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UI Element

Description

Microsoft SQL
Server 2008
R2, 2012, 2014
URL

URL for the monitored Microsoft SQL Server instance.
l

l

Replace ${host} with the host name on which the Microsoft SQL Server is
running. This must be the same as the host name defined for the Windows
remote machine. For details, see "New/Edit Microsoft Windows Remote
Server Dialog Box" on page 475.
Replace ${port} with the port number on which the Microsoft SQL Server
accepts connections. By default, the port is 1433.

Example: jdbc:mercury:sqlserver://doors:1433
Login to
Microsoft SQL
Server 2008
R2, 2012, 2014

Login name for the user on the monitored Microsoft SQL Server instance.

Password to
Microsoft SQL
Server 2008
R2, 2012, 2014

Password for the user on the monitored Microsoft SQL Server instance.

Microsoft SQL
Server 2008
R2, 2012, 2014
agent service
name

Name of the SQL Server agent service.

Microsoft SQL
Server 2008
R2, 2012, 2014
service
instance name

Name of the SQL Server service instance.

Microsoft SQL
Server 2008
R2, 2012, 2014
service name

Name of the SQL Server service.

Microsoft SQL
Server 2008
R2, 2012, 2014
service name
with escaped $
character

Name of the SQL Server service (same as previous field unless the service name
contains the $ character).
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UI Element

Description

SERVER_LIST

Name of the server you want to monitor. If the server you want to monitor is not in
the list, you must define a connection profile to the server. For the steps you use
to create a Windows connection profile, see "Configure SiteScope to Monitor
Remote Windows Servers" on page 470.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope
root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

Tips/Troubleshooting
NTLM Authentication Issue
When using NTLM authentication to deploy a Microsoft SQL Server solution template, you must make
a copy of the template and then remove the user names and passwords from the Database user name
and Database password fields for the following monitors:
l

% Command Queue Length

l

% of lock memory

l

Database User Statistics

l

Database availability

l

Database cache
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The Microsoft Windows Host solution template is a template that you can use to deploy a collection of
monitors configured with default metrics that test the health, availability, and performance of the
Windows host.
For Microsoft Windows Resource monitors, you can create a Server-Centric report which displays data
from three different metrics about the server being monitored. For more information generating a ServerCentric report, see "Create Server-Centric Reports" on page 1365.
Tip: We recommend using solution templates when creating the Microsoft Windows Resource
Monitor, because the required monitors and metrics are already configured.
The Microsoft Windows Host solution template provides comprehensive Windows operating system
monitoring without requiring the SiteScope user or the IT organization to be experts on the application.
It also reduces the time to configure and deploy various performance monitors, helps identify both realtime performance bottlenecks and longer term trends, and adds only minimal overhead to production
systems.
Note: An in-depth description of the Microsoft Windows Host Solution Template is available in the
SiteScope Operating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select
Microsoft Windows Host.

Learn About
Supported Versions
The Microsoft Windows Host solution template supports Microsoft Windows Server 2003, 2008, 2012
and Microsoft Windows XP.

Solution Template Monitors
The Microsoft Windows Host solution template deploys monitors that target the following aspects of
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Microsoft Windows performance and health:
l

High-level CPU status and utilization details

l

High-level Memory status and utilization details

l

Disk utilization information

Tasks
How to Deploy the Microsoft Windows Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Microsoft Windows Host solution template.
Note: The Microsoft Windows Host Solution deploys a Microsoft Windows Resource Monitor for
each target host. This monitor is an additional monitor that is required for Server-Centric Report
support.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The SiteScope server must be able to connect to the target Windows host. Use the Microsoft
Windows Resources Monitor to monitor the server performance statistics from remote
Windows servers. The Microsoft Windows Resource monitor may require special
configuration. For details, see Microsoft Windows Resources Monitor in the SiteScope Monitor
Reference Guide.

n

The target server must be added to SiteScope as a Windows remote machine and should pass
the Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For
details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on page 475.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope to Monitor a Remote Microsoft Windows Server" on
page 470.

n

SiteScope and the target server can run on the same host if SiteScope is installed on a
Windows operating system supported by the template. The template supports Microsoft
Windows XP, Windows Server 2003, and Windows Server 2008.
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2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for user interface deployment only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Microsoft Windows Host Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a Windows connection profile, see "Configure SiteScope to Monitor Remote
Windows Servers" on page 470.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The .NET solution templates enable you to monitor .NET applications of servers that run a Windows
operating system. This solution template deploys a set of monitors that test the health, availability, and
performance of a .NET application and .NET environment on the Windows host.
The .NET solution templates provide comprehensive .NET monitoring without requiring the SiteScope
user or the IT organization to be experts on the application. They also reduce the time to configure and
deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.
Note: An in-depth description of the .NET Solution Template is available in the SiteScope .NET
Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_NET_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required .NET solution template.

Learn More
Supported Versions
The .NET solution templates support .NET 1.x and 2.x running on Windows Server 2003, 2012, and
Windows XP servers.

Solution Template Monitors
The .NET solution templates deploy monitors that target the following aspects of .NET performance
and health:
l

l

l

.NET CLR Data. This category refers to the common language runtime data (environment of .NET
applications). It is designed to check several resource statistics for the .NET CLR for selected
application. The .NET solution template automatically configures monitors for server health.
ASP.NET. This category is designed to check several resource statistics for the ASP.NET. It
gathers common information about application restarts and whole ASP.NET system stability. The
.NET solution template automatically configures monitors for server health.
ASP.NET Applications. This category is designed to check several resource statistics for the
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selected ASP.NET application. It gathers common information about application cache, errors, and
other critical information. The .NET solution template automatically configures monitors for server
health.

Tasks
How to Deploy the .NET Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the .NET solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

SiteScope server must be able to connect to the target Windows host. Use the Microsoft
Windows Resources Monitor to monitor the server performance statistics from remote
Windows servers. The Microsoft Windows Resource monitor may require special
configuration. For details, see Microsoft Windows Resources Monitor in the SiteScope Monitor
Reference Guide.

n

The target server must be added to SiteScope as a Windows remote machine and should pass
the Windows remote test (Remote Servers > Microsoft Windows Remote Servers). For
details, see "New/Edit Microsoft Windows Remote Server Dialog Box" on page 475.
Alternatively, you can set domain privileges to permit SiteScope to access remote servers. For
details, see "How to Configure SiteScope to Monitor a Remote Microsoft Windows Server" on
page 470.

n

SiteScope and the target .NET application can run on the same host if SiteScope is installed on
a Windows operating system supported by the template. The template supports Microsoft
Windows XP and Windows Server 2003.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
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UI Descriptions
.NET Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

Server

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. See "Configure SiteScope to
Monitor Remote Windows Servers" on page 470 for the steps you use to create a
Windows connection profile.

ASP.NET
Application
(ASP.NET
Application
only)

Name of the ASP.NET application you want to monitor. The name must be as it
appears in the Task Manager.

Instance
(.NET CLR
Data only)

Name of the application you want to monitor. The name must be the same as it
appears in the Task Manager, or can be whole system statistics (by default).

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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You can use the Oracle Database solution templates to deploy a set of monitors that test the health,
availability, and performance of an Oracle database. The deployed monitors check general system
statistics, such as cache hit ratios and disk I/O, and include tools that provide diagnostic information
about important aspects of the database.
This solution uses the Database Counter Monitor to collect performance metrics from JDBCaccessible databases. In addition, you can use the Oracle Database solution template to deploy a
collection of monitors configured with default metrics.
Important system metrics are computed with data retrieved from system tables in the Oracle database.
A wide range of Oracle system tables such as V$SYSSTAT, V$LATCH, V$ROLL_STAT, and
V$BUFFER_POOL_STATISTICS are consulted to produce these metrics. In this way, the Oracle
Database Solution implements the equivalent of many of the system monitoring scripts that come
bundled with the Oracle installation.
The Oracle Database solution templates provide comprehensive Oracle database monitoring without
requiring the SiteScope user or the IT organization to be an expert on the application. They also reduce
the time to configure and deploy monitors, help identify both real-time performance bottlenecks and
longer term trends, and add only minimal overhead to production systems.
Note: An in-depth description of the Oracle Database Solution Template is available in the
SiteScope Oracle Database Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Oracle_Database_Best_Practices.pdf. This is a
password protected guide; the password is provided after acquiring an HP license edition that
supports the solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select Oracle
Database 9i and 10g or Oracle Database 11g.

Learn About
Supported Versions
The Oracle Database solution template supports Oracle 9i, 10g, and 11g databases.

Solution Template Monitors
The Oracle Database solution template deploys monitors that target the following aspects of Oracle
performance and health:
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l

l

l

General System Statistics. The most important V$SYSSTAT statistics are monitored by default in
the monitors deployed by the Oracle Database Solution. Where applicable, these metrics are
combined to calculate deltas and rates on a per-second or per-transaction basis. When monitoring
the important metrics from the V$ tables in the database, the Oracle Database Solution is a
replacement for manually generated SQL scripts.
Oracle Logs. Important Oracle log files are monitored for ORA- errors. Users may customize these
monitors to look for specific text in a log file, depending on their database configuration.
Diagnosing Database Problems. In addition to the deployed monitors, Oracle Solution offers
several tools that can be used to gain diagnostic information about a database. Resource-intensive
SQL statements, shared server process contention, and the number of sessions waiting for specific
events are all examples of the diagnostic data that these tools can provide.

Oracle Database Solution Template Tools
The Oracle Database solution template deploys several tools that you can use to gather diagnostic
information about an Oracle database. These tools are deployed to the same group as the monitors that
are deployed by the solution template. They are displayed in much the same way as monitors but they
are set as disabled. These tools are identified by the bold text Solution Tool in the Status field of the
group content table. Although the Solution tools are listed in the monitor table, they are not monitor
instances. They do not run automatically, do not display a status based on action results, nor do they
trigger alerts. They are preconfigured actions that make use of a SiteScope Diagnostic Tool to check
certain statistics from the Oracle database that may indicate a performance problem.
When the user clicks on one of these Solution Tools, SiteScope makes a custom SQL query to the
database by using the Database Connection Test tool. The results of the query are found in a table at
the bottom of the page. From this page, the tool may be run as many times as necessary by clicking the
Connect and Execute Query button. Bear in mind that some tools may incur substantial overhead on
the database, so executing them in quick succession is not recommended.

List of Oracle Database Solution Tools
The following describes tools deployed as part of the Oracle Database Solution:
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Oracle Solution
Tool Name

Description and Usage Guidelines

Top Ten SQL
Statements in
Logical IOs Per
Row

This tool performs a query which is designed to locate the most resourceintensive SQL statements being run in the database. The V$SQL table is
queried for the ten SQL statements which are performing the most logical IOs
per row are displayed in a table.
The statement IDs of these ten statements are displayed in a table, along with
some additional resource-usage data for each statement.
This additional data includes:
l

l

l

l

Physical IO Blocks. The number of disk reads performed on behalf of the
statement.
Logical IOs. The number of buffer gets performed on behalf of the
statement.
Rows Processed. The number of rows processed when executing the
statement.
Logical IOs Per Row. The number of buffer gets performed per row that
was processed when executing the statement.

l

Runs. The number of executions of the statement.

l

Logical IOs Per Run. The number of buffer gets per statement execution.

Note: The action performed can have a significant affect on database
resources and should not be run frequently.
Number of
Sessions Waiting
Per Event

This tool can be used in troubleshooting stuck sessions. When several
sessions become unresponsive, this tool can determine whether the stuck
sessions are all waiting on the same event. The tool action displays a table
containing the number of sessions waiting on specific events.

Shared Server
Process
Contention
(Common Queue
Average Wait
Time)

This tool calculates the average wait time of the shared server message queue
(the Common Queue as recorded in V$QUEUE). A high average wait time may
indicate contention between shared server processes.
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Tasks
How to Deploy Oracle Database Solution Templates
This task describes how to configure the server environment and enter variables for the Oracle
Database solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

You must have CREATE SESSION system privileges to successfully deploy the Oracle
Database 9i and 10g solution template.

n

Before deploying the Oracle Database solution template, consult the documentation for the
Database Counter Monitor and the Log File Monitor for information about some of the
prerequisites and parameters required by the solution template. For example, you find more
information on installing the Oracle JDBC driver needed to communicate with the database and
the format of the log file path parameter.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

How to Run the Oracle Database Solution Tools
This task describes how to run the Oracle Database Solution Tools:
1. Click the group name for the group where the Oracle Solution monitors are deployed. The Group
Detail page opens.
2. Find the Solution Tool for the action that you want to run. See the Name column for the Solution
Tool for a description of the action performed by that tool.
3. Click the Tools link to the right of the tool Name to run the action. The Database Connection Test
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page opens. From this page, the tool may be run as many times as necessary by clicking the
Connect and Execute Query button.
Note: We do not recommend running the tools in quick succession, since some Solution
Tools may create significant overhead on the database depending on the query.
The upper portion of the Database Connection Test page displays the database connection
parameters used for the test. The results of the tool query are found in a table near the bottom of the
page. Review the results based on the Description and Usage Guidelines for that tool.

UI Descriptions
Oracle Database Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

DatabaseConnection
URL

Connection URL to the database you want to connect to. The syntax is
jdbc:oracle:thin:@<server name or IP address>:<database
server port>;sid=<sid>.
Example: To connect to the ORCL database on a machine using port
1521 you would use:
jdbc:oracle:thin:@206.168.191.19:1521:ORCL.
Note: The : and @ symbols must be included as shown.

DatabaseDriver

Name of the JDBC driver to be used by this monitor. Each driver
supports a specific connection URL pattern, so it must match the URL
entered in Database Connection URL.

OracleAlertLogPath

Full path to the Oracle alert log. For Windows machines, this should be
the full UNC path. Enter the full path to the Oracle alert log. Consult
your database administrator or the Oracle documentation for
information about how to access this file.

OracleListenerLog
Path

Full path to the Oracle listener log. For Windows machines, this should
be the full UNC path. Consult your database administrator or the
Oracle documentation for information about how to access this file.

DatabaseUserName

User name that SiteScope should use to connect to the database.

DATABASEPASSWORD

Password for the user name that SiteScope should use to connect to
the database.
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UI Element

Description

Log File Encoding

If the file content to be monitored uses an encoding that is different
than the encoding used on server where SiteScope is running, enter
the code page or encoding to use. This may be necessary if the code
page which SiteScope is using does not support the character sets
used in the target file. This enables SiteScope to match and display the
encoded file content correctly.
Examples: Cp1252, Cp1251, Cp1256, Shift_JIS, or EUC_JP.

SERVER_LIST

Name of the server you want to monitor. If the server you want to
monitor is not in the list, you must define a connection profile to the
server.
For the steps you use to create a connection profile, see "Configure
SiteScope to Monitor Remote Windows Servers" on page 470 or
"Configure SiteScope to Monitor Remote UNIX Servers" on page 492.

Silent deployment

Submits the template deployment request to a queue, and SiteScope
handles the deployment in the background. This enables you to
continue to use SiteScope without having to wait for the template
deployment process to finish. All submitted requests and their
corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor properties Verifies the correctness of the monitor configuration properties in the
with remote server
template against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to
the remote connection.
Default value: Selected
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The SAP solution includes solution templates for the monitoring of key SAP components. The SAP
solution templates deploy a collection of monitors configured with metrics to report on availability and
performance. These monitoring configurations have been researched using best practice data and
expertise from various sources.
The SAP solution templates provide comprehensive SAP monitoring without requiring the SiteScope
user or the IT organization to be experts on the application. They also reduce the time to configure and
deploy monitors, help identify both real-time performance bottlenecks and longer term trends, and add
only minimal overhead to production systems.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required SAP solution template.

Learn About
Supported Versions
The SAP solution templates support SAP R/3 servers (versions 4.5B and later).

Solution Template Monitors
The SAP solution templates deploys monitors that target the following aspects of SAP performance
and health:
l

l

The SiteScope SAP R/3 Application Server solution template provides the tools you use to monitor
the availability, usage statistics, and server performance statistics for SAP R/3 systems. This
solution template deploys a set of monitors that test the health, availability, and performance of
SAP R/3 servers (versions 4.5B and later).
The SiteScope SAP NetWeaver Application Server solution enables you to monitor the availability
and server statistics for SAP Java Web application server clusters. You can use this solution
template to deploy monitors for server-wide resources and metrics.

Tasks
How to Deploy the SAP Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
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the SAP solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

You must have SAP authorization of the remote system user. For details on the minimum SAP
permission required by SiteScope, see the sections on “AAAB - Cross-application
Authorization Objects” and “BC_A - Basis: Administration” in SAP RFC User privileges in the
SAP documentation (http://help.sap.com/saphelp_
nw70ehp1/helpdata/en/49/bb35b8623a489aa63abd9f5ebf2448/content.htm).

n

For SAP R/3 Application Server:
o

SAP Java Connector libraries should be copied to the required SiteScope folders.

o

You must know the user name and password that SiteScope must use to log into the SAP
R/3 server.
For more information on system and configuration requirements, see SAP CCMS Monitor in
the SiteScope Monitor Reference Guide. This monitor is deployed as part of the SAP R/3
solution template.

n

For SAP NetWeaver Application Server:
o

SAP Java Web application server libraries must be copied to the required SiteScope
folders.

o

You must know the user name and password that SiteScope must use to log into the SAP
Java Web application server.
For more information on system and configuration requirements, see SAP Java Web
Application Server Monitor in the SiteScope Monitor Reference Guide. This monitor is
deployed as part of the SAP NetWeaver Application Server solution template.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
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UI Descriptions
SAP R/3 Application Server
User interface elements (Variable Values) are described below:
UI Element

Description

SYSTEM_
NUMBER

System number for the SAP server.

USER_NAME

User name required to connect to the SAP server.

Password

Password required to connect to the SAP server.

CLIENT_
NUMBER

Client to use for connecting to SAP.

APPLICATION_ Address of the SAP server you want to monitor.
SERVER
Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All
submitted requests and their corresponding deployment results are logged to
<SiteScope root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

SAP NetWeaver Application Server
User interface elements (Variable Values) are described below:
UI Element

Description

Password

The password required to connect to the SAP Java Web Application Server.

PORT

Port for the SAP Java Web Application Server.
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UI Element

Description

USER_
NAME

User name required to connect to the SAP Java Web Application Server.

TARGET_
SERVER_
NAME

Address of the SAP Java Web Application Server you want to monitor.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The SiteScope Siebel solution templates provide efficient and thorough monitoring of performance,
availability, and usage statistics for Siebel Application, Gateway, and Web servers installed on
Microsoft Windows and UNIX operating systems. There are separate solution templates for servers
installed on UNIX and Windows platforms.
The primary solution template for Siebel is the Siebel Application Server template. You use this
template to deploy monitoring for the core of the Siebel application. You use the Siebel Gateway Server
and Siebel Web Server templates if these optional components are deployed in the IT environment.
The Siebel solution templates provide comprehensive Siebel monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy various performance monitors, help identify both real-time performance
bottlenecks and longer term trends, and add only minimal overhead to production systems.
Note: An in-depth description of the Siebel Solution Template is available in the SiteScope Siebel
Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_Siebel_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required Siebel solution template.

Learn More
Supported Versions
The Siebel solution templates support Siebel 6.x, 7.x, and 8.x application servers.

Solution Template Monitors
The Siebel Solution includes solution templates for monitoring the following key Siebel components:
l

Siebel Application Server for UNIX/Windows. The SiteScope Siebel Application Server
Solutions enable you to monitor the availability, usage statistics, and server performance statistics
for Siebel Application servers installed on Windows and UNIX platforms. These solution templates
deploy a set of monitors that test the health, availability, and performance of Siebel 6.x, 7.x, and 8.x
application servers.
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l

l

Siebel Gateway Server for UNIX/Windows. The SiteScope Siebel Gateway Server Solutions
enable you to monitor the availability and server statistics for Siebel Gateway Servers installed on
Windows and UNIX platforms. These solution templates deploy a set of monitors that test the
health, availability, and performance of Siebel Gateway Servers. You can use these solution
templates to deploy monitors for server-wide resources and metrics.
Siebel Web Server for UNIX/Windows. The SiteScope Siebel Web Server Solutions enable you
to monitor the availability and server statistics for Siebel Web servers installed on Windows and
UNIX platforms. These solution templates deploy a set of monitors that test the health, availability,
and performance of Siebel Web Servers.

Tasks
How to Deploy the Siebel Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Siebel Solution Template.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
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Solution
Template
Name
Siebel
Application
Server

Requirements
n

The Siebel Server Manager client must be installed only on a Windows
machine where SiteScope is running or that is accessible to the SiteScope
machine (even if the Siebel application server is installed on UNIX). There are
several options for how you can do this. See the documentation for the Siebel
Server Manager Monitor for more information.

n

You must know the install path for the Server Manager client to be able to setup
Siebel Server Manager monitors in SiteScope. If the client is installed on the
machine where SiteScope is running, this is the path on that machine. If the
client is installed on a remote machine, you must know the fully qualified path
to the client executable relative to that machine.

n

You must know the name of the Siebel applications that are available in your
network. For example, call center, sales, and so on.

n

You must know the Siebel database machine name, user name, password,
connection URL, and Database Driver.

n

You must know the user and password that SiteScope uses for logging into the
Siebel server. This user must be granted Siebel Administrator responsibility on
the Siebel server.

n

You must make sure that the following Siebel server component groups are
enabled:

n

o

Siebel Call Center (CallCenter)

o

Siebel Remote (Remote)

o

System Management (System)

o

Auxiliary System Management (SystemAux) - Siebel 8.x only

You need to know a significant list of Siebel system component names and
their corresponding aliases. For a listing of component names and aliases, see
"UI Descriptions" on the next page.
Note: For more information on system and configuration requirements, see the
sections on the Siebel Web Server Monitor and Database Query Monitor.
These monitor types are deployed as part of the Siebel Application Server
solution template.
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Solution
Template
Name
Siebel
Web
Server

Requirements
n

SiteScope server must be able to connect to the machine where the Siebel
Web Server is running.

n

Siebel Web Server Solution is designed for use with Siebel running on
Microsoft Windows platforms.

n

Template assumes that the Siebel Web Server is running on Microsoft Internet
Information Server (IIS).

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
Siebel Solution Template Page
User interface elements (Variable Values) are described below for monitoring Siebel Application Server
6.x, 7.x, and 8.x on Windows and UNIX environments:
UI Element (A-Z)

Description

Application

Siebel Application Server machine name.

CG_Auxilary_System_
Management_Alias
(Siebel 8.x only)

Siebel Auxilary System Management component group alias.

CG_Auxilary_System_
Management_Name
(Siebel 8.x only)

Siebel Auxilary System Management component group name.

CG_Callcenter_Alias

Siebel CallCenter component group alias.

CG_Callcenter_Name

Siebel CallCenter component group name.
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UI Element (A-Z)

Description

CG_System_
Management_Alias

Siebel System Management component group alias.

CG_System_
Management_Name

Siebel System Management component group name.

CP_Callcenter_Alias

Siebel CallCenter component alias.

CP_Callcenter_Name

Siebel CallCenter component name.

CP_Client_
Administration_Alias
(Siebel 6.x-7.x only)

Siebel Client Administration component alias.

CP_Client_
Administration_Nam
(Siebel 6.x-7.x only)

Siebel Client Administration component name.

CP_eService_Alias

Siebel eService component alias.

CP_eService_Name

Siebel eService component name.

CP_File_System_
Manager_Alias

Siebel File System Manager component alias.

CP_File_System_
Manager_Name

Siebel File System Manager component name.

CP_Server_Manager_
Alias

Siebel Server Manager component alias.

CP_Server_Manager_
Name

Siebel Server Manager component name.

CP_Server_Request_
Broker_Alias

Siebel Server Request Broker component alias.

CP_Server_Request_
Broker_Name

Siebel Server Request Broker component name.

CP_Server_Request_
Processor_Alias

Siebel Server Request Broker component alias.

CP_Server_Request_
Processor_Name

Siebel Server Request Processor component name.
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UI Element (A-Z)

Description

Database_Connection_
URL

URL to the database connection.
Example: If the ODBC connection is called test, the URL is
jdbc:odbc:test.
Enter the connection URL to the database you want to connect to. The
syntax is jdbc:oracle:thin:@<server name or IP
address>:<database server port>;sid=<sid>.
Example: To connect to the ORCL database on a machine using port
1521 use:
jdbc:oracle:thin:@206.168.191.19:1521:ORCL.
Note: The colon and @ symbols must be included as shown.

Database_Driver

Driver used to connect to the database.

Database_PASSWORD

Password for the user name used to access the Siebel database.

Database_Username

User name SiteScope should use to access the Siebel database.

Enterprise

Siebel Enterprise server name.

Gateway

Name of the Siebel Gateway server machine.

PASSWORD

Password for the Siebel Client.

SERVER_LIST

Name of the server where the Siebel Application Server is running.

Server_Logical_
Instance_Name

Siebel server logical name.

Server_Manager_Path

Local path to the Siebel server manager client.
Example: D:\sea703\client\bin.

Siebel_Database_
Machine_Name

Siebel database machine name.

Siebel_Disk

Disk drive name where Siebel is installed.

Siebel_Root_Dir

Path of the shared Siebel root directory.
Example: The shared root directory for a Siebel 7.5.2 server would be:
sea752.
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UI Element (A-Z)

Description

Silent deployment

Submits the template deployment request to a queue, and SiteScope
handles the deployment in the background. This enables you to continue
to use SiteScope without having to wait for the template deployment
process to finish. All submitted requests and their corresponding
deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Username

Siebel Client user name.

Verify monitor
properties with remote
server

Verifies the correctness of the monitor configuration properties in the
template against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to
the remote connection.
Default value: Selected

Siebel Gateway Server
User interface elements (Variable Values) are described below:
UI Element (A-Z)

Description

SERVER_LIST

Name of the server where the Siebel Gateway Server is running. Do not
type backslashes (\\), which indicates a UNC path as part of the name
of the server.

Siebel_Disk

Disk drive where the Siebel gateway server is running.

Siebel_Logical_
Instance_Name
(for UNIX only)

Siebel server logical name value (for UNIX only).

Siebel_Root_Dir

Path to the Siebel root directory. This directory should contain at least an
Admin Console installation.

Silent deployment

Submits the template deployment request to a queue, and SiteScope
handles the deployment in the background. This enables you to continue
to use SiteScope without having to wait for the template deployment
process to finish. All submitted requests and their corresponding
deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
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UI Element (A-Z)

Description

Verify monitor
properties with remote
server

Verifies the correctness of the monitor configuration properties in the
template against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to
the remote connection.
Default value: Selected

Siebel Web Server
User interface elements (Variable Values) are described below:
UI Element (A-Z)

Description

Application

Siebel application to monitor.
Example: callcenter_enu. Consult with your Siebel administrator for
information about names of the installed Siebel applications.

Password

Siebel Client password needed to log into the Siebel Web server.

SERVER_LIST

Name of the Siebel Web server machine. Use the choose server to view
the server selection page. Use the Server drop-down menu to select the
server where the Siebel Web server is running.

Siebel_Disk

Disk drive name or drive letter where the Siebel Web server is installed.

Siebel_Logical_
Instance_Name

Siebel server logical name value (for UNIX only).

Siebel_Root_Dir

Name of the shared Siebel root directory.
Example: Siebel root directory on Windows: sea752.

Silent deployment

Submits the template deployment request to a queue, and SiteScope
handles the deployment in the background. This enables you to continue
to use SiteScope without having to wait for the template deployment
process to finish. All submitted requests and their corresponding
deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Username
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UI Element (A-Z)

Description

Verify monitor
properties with remote
server

Verifies the correctness of the monitor configuration properties in the
template against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to
the remote connection.
Default value: Selected
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The Solaris Host solution template is a template that you can use to deploy a collection of monitors
configured with default metrics that test the health, availability, and performance of the Solaris host.
For UNIX Resource Monitors, you can create a Server-Centric report which displays data from three
different metrics about the server being monitored. For more information on generating a Server-Centric
report, see "Create Server-Centric Reports" on page 1365.
Tip: We recommend using solution templates when creating the UNIX Resource Monitor,
because the required monitors and metrics are already configured.
The Solaris Host solution template provides comprehensive Solaris operating system monitoring
without requiring the SiteScope user or the IT organization to be experts on the application. It also
reduces the time to configure and deploy various performance monitors, helps identify both real-time
performance bottlenecks and longer term trends, and adds only minimal overhead to production
systems.
Note: An in-depth description of the Solaris Host Solution Template is available in the SiteScope
Operating System Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_OS_Best_Practices.pdf. This is a password protected
guide; the password is provided after acquiring an HP license edition that supports the solution
template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select Solaris
Host.

Learn About
Supported Versions
The Solaris Host solution template supports Solaris 9 and 10.

Solution Template Monitors
The Solaris Host solution template deploys monitors that target the following aspects of Solaris
performance and health:
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l

CPU status and utilization details

l

Memory status and utilization details

l

File system status and utilization details

Tasks
How to Deploy the Solaris Host Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the Solaris Host solution template.
Note: The Solaris Host solution template deploys a UNIX Resource Monitor for each target host.
This is a supplemental monitor that is required for Server-Centric Report support.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

SiteScope server must be able to connect to the target Solaris host.

n

The target server must be added to SiteScope as a UNIX remote machine and should pass the
UNIX remote test (Remote Servers > UNIX Remote Servers). For user interface details, see
"New/Edit UNIX Remote Server Dialog Box" on page 495.
Note:
o

The SiteScope server itself can also be monitoring if it runs a supported Solaris
operating system.

o

The template supports the Solaris versions supported by SiteScope. For details, see
System Requirements in the SiteScope Deployment Guide (<SiteScope root
directory>\sisdocs\doc_lib\Get_Documentation.htm).

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
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3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page for the Solaris Host solution template. For
user interface details, see the UI Descriptions section below.

UI Descriptions
Solaris Host Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

SERVER_
LIST

Name of the server you want to monitor. If the server you want to monitor is not in the
list, you must define a connection profile to the server. For the steps you use to create
a UNIX connection profile, see "Configure SiteScope to Monitor Remote UNIX
Servers" on page 492.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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You can use the VMware Capacity Management solution templates to enable SiteScope to collect data
from VMware monitors and report it to the data store on the HP Operations agent. This data can then be
used in various supported reporting products, including HP Service Health Optimizer (SHO), HP's
capacity management solution, and Service Health Reporter (SHR), HP's service centric crossdomain reporting solution.
The VMware Capacity Management solution template provides comprehensive monitoring without
requiring the SiteScope user or the IT organization to be experts on the application. It also reduce the
time to configure and deploy monitors, help identify both real-time performance bottlenecks and longer
term trends, and add only minimal overhead to production systems.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required VMware Capacity Management solution template (VMware Datastore, VMware Host,
VMware Resource Pool, VMware Virtual Machine).

Learn More
VMware Datastore Template
The VMware Datastore template uses the VMware Datastore monitor to monitor performance related
resources (connectivity, capacity, free space, and snapshot size) on any VMware datastore virtual
machines (VMs) in the VMware datacenter.
When deploying the template, you need to specify the following template variables: connection_link
(URL of the VMware Datastore), username (of VMware Datastore administrator with view host
permissions), password (of the VMware Datastore), vc_name (VMware Datastore name), and select
the Verify monitor properties with remote server check box during template deployment.
For user interface details, see "VMware Datastore Deployment Values" on page 1010.
Note: The VMware solution template monitors are not configured with threshold settings since the
reporting products require raw data and topology only.

VMware Host Template
The VMware Host template uses VMware Host monitors to monitor performance and configuration
metrics of the VMware host server and its guest virtual machines. The VMware Host solution template
deploys a set of monitors against a particular VMware VirtualCenter. The template must be deployed
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for each host that you want to monitor.
The VMware Host solution template deploys monitors that target the following aspects of VMware
Host performance:
l

VMware Host CPU

l

VMware Host Memory

l

VMware Host Storage

l

VMware Host Network

l

VMware Host State
Note: An in-depth description of the VMware Host Solution is available in the SiteScope VMware
Host Best Practices document, available from <SiteScope
root directory>\sisdocs\pdfs\SiteScope_VMware_Host_Best_Practices.pdf.

The template supports:
l

VMware VirtualCenter 2.x

l

VMware ESX 3.x, 4.0, 4.1

l

VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5

l

VMware ESX 2.5 via VirtualCenter 2.x

l

VMware ESX 3.x via VirtualCenter 3.x

l

VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5

When deploying the template, you need to specify the following template variables: Host name,
connection_link (vCenter or Host URL), username (vCenter or Host username with view host
permissions), password (vCenter or Host password), is vCenter (true if vCenter; false if Host), and
select the Verify monitor properties with remote server check box during template deployment.
For user interface details, see "VMware Host Deployment Values" on page 1010.
The VMware Host monitors also report the following topology to BSM:
l

Cluster -> Host

l

Datacenter -> Host

l

Datacenter -> Cluster

HP SiteScope (11.31)

Page 1007 of 1395

Using SiteScope
Chapter 89: VMware Capacity Management Solution Templates

VMware Resource Pool Template
The Resource Pool template uses the VMware Performance monitor to monitor performance and
configuration metrics for the Resource Pool. This template is per single Resource Pool, and it should
be deployed for all Resource Pools.
When deploying the template, you need to specify the following template variables: resource pool
name, vCenter url, username (vCenter username with view Resource Pool permissions), password
(vCenter password), and select the Verify monitor properties with remote server check box during
template deployment.
For user interface details, see "VMware Resource Pool Deployment Values" on page 1011.
The VMware Performance monitor also reports the following topology to BSM:
l

Cluster -> Resource Pool

l

ESX Host -> VM

l

Cluster -> VM

l

Cluster -> Resource Pool to VMs

VMware Virtual Machine Template
The VM template uses the VMware Performance monitor to monitor performance and configuration
metrics for the VMs. The template must be deployed for each VM you want to monitor.
When deploying the template, you need to specify the following template variables: vm (VM name),
vCenter URL, username (vCenter username with view VM permissions), password (vCenter
password). We recommend clearing the Verify monitor properties with remote server check box
during template deployment. Clearing this option deploys the monitor without connecting to the server,
thereby enabling template deployment on powered on and powered off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered on.
For user interface details, see "VMware Virtual Machine Deployment Values" on page 1012.

Tasks
How to Deploy the VMware Capacity Management Solution Templates
This task describes the steps involved in entering variables for the VMware Capacity Management
solution template.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
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System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
Note for the VMware Host Solution Template:
n

The VMware Host Solution Template allows you to monitor ESX hosts in two ways: via
vCenter or via the ESX host directly. We recommend that you monitor ESX hosts directly
to reduce load on the vCenter machine.

n

When a browsable monitor is deployed in a template, the number of counters that match
the selected patterns is limited by the _maxCountersForRegexMatch parameter in the
<SiteScope root directory>\groups\master.config file (this is in addition to the _
browsableContentMaxCounters parameter which limits the number of counters that
browsable monitors can have). If during deployment, the number of counters that match
the patterns exceeds this value, only the number of counters up to this value is saved. We
recommend using the same value for both these parameters (the default value for both of
these parameters is 1000).

Tip:
We recommend deploying the solution template using a CSV file, since you can perform
multiple deployments at one time, without having to manually enter variable values for each
deployment in the user interface.
You can create a CSV file for the VMware Capacity Management templates using the
vSphere client export to file option (File > Export > Export List). This enables you to export
all VM names, Resource Pool names, and Host names to the CSV file. After creating the file,
you can edit the file and add template variables such as vCenter URL, username, and
password.
For details on deploying using a CSV file, see "How to Deploy Templates Using a CSV File"
on page 850.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
Tip: We recommend clearing the Verify monitor properties with remote server check box
during template deployment. Clearing this option deploys the monitor without connecting to
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the server, thereby enabling template deployment on powered on and powered off VMs. When
this option is selected (the default setting), deployment fails for VMs that are not powered on.

UI Descriptions
VMware Datastore Deployment Values
The VMware Datastore template uses the VMware Datastore monitor to monitor performance related
resources (connectivity, capacity, free space, and snapshot size) on any VMware datastore virtual
machines (VMs) in the VMware datacenter.
User interface elements (Variable Values) are described below:
UI Element

Description

connection_ URL of the VMware Datastore you want to monitor.
link
vc_name

Name of the VMware Datastore you want to monitor.

username

User name of the VMware Datastore administrator with view host permissions.

password

Password of the VMware Datastore.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed. When this option is
selected, deployment time is slowed due to the remote connection.
Note: We recommend clearing this option during template deployment. Clearing this
option deploys the monitor without connecting to the server, thereby enabling
template deployment on powered on and powered off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered on.
Default value: Selected

VMware Host Deployment Values
The VMware Host template uses VMware Host monitors to monitor performance and configuration
metrics for the Hosts. The template must be deployed for each host that you want to monitor.
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User interface elements (Variable Values) are described below:
UI Element

Description

connection_ URL of the vCenter or host server you want to monitor.
link
username

User name of the VMware VirtualCenter or host administrator with view host
permissions.

password

Password of the VMware VirtualCenter or host.

host

Name of the VMware host you want to monitor.

is vCenter

Enter true for vCenter, or false for the ESX host.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed. When this option is
selected, deployment time is slowed due to the remote connection.
Note: We recommend clearing this option during template deployment. Clearing this
option deploys the monitor without connecting to the server, thereby enabling
template deployment on powered on and powered off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered on
Default value: Selected

VMware Resource Pool Deployment Values
The Resource Pool template uses the VMware Performance monitor to monitor performance and
configuration metrics for the Resource Pool. The template must be deployed for each resource pool
that you want to monitor.
User interface elements (Variable Values) are described below:
UI Element

Description

resource_
pool_name

Name of the Resource Pool want to monitor.

vcenter_url

URL of the vCenter you want to monitor.

username

User name of the VMware vCenter with view Resource Pool permissions.
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UI Element

Description

password

Password of the VMware vCenter.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed. This option should always be
selected during template deployment.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

VMware Virtual Machine Deployment Values
The VM template uses the VMware Performance monitor to monitor performance and configuration
metrics for the VMs. The Template is per single VM, and should be deployed for all VMs.
User interface elements (Variable Values) are described below:
UI Element

Description

vm

Name of the VM you want to monitor.

vcenter_url

URL of the vCenter you want to monitor.

username

User name of the VMware vCenter with view VM permissions.

password

Password of the VMware vCenter.

Silent
Submits the template deployment request to a queue, and SiteScope handles the
deployment deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected
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UI Element

Description

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template against
the remote server on which the template is deployed. When this option is selected,
deployment time is slowed due to the remote connection.
Note: We recommend clearing this option during template deployment. Clearing this
option deploys the monitor without connecting to the server, thereby enabling
template deployment on powered on and powered off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered on.
Default value: Selected
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You can use the VMware Host solution template to provide monitoring of different aspects of the
VMware host server. This includes monitoring of CPU, memory, network, state, and storage -related
counters of the VMware host server and its guest virtual machines.
The VMware Host solution template deploys a set of monitors against a particular VMware
VirtualCenter. These monitors encompass best practices monitoring for the VMware host. This
template includes the VMware Host State, VMware Host CPU, VMware Host Memory, VMware Host
Storage, and the VMware Host Network monitors.
The VMware Host solution template provides comprehensive monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. It also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Tip: When to use which VMware Solution Template?
l

l

If you want to monitor the VMware host for data collection and overall performance and
availability, you should use the VMware Host solution template.
If you want to have the ability to find a specific performance problem and the root cause of it
according to VMware's best practices, you should use the "VMware Host For Performance
Troubleshooting Solution Template" on page 1018. This template also includes most of the
metrics included in the VMware Host solution template.

Note: An in-depth description of the VMware Host Solution Template is available in the SiteScope
VMware Host Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_VMware_Host_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
VMware Host solution template.

Learn More
Supported Versions
The VMware Host solution template supports:
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l

VMware VirtualCenter 2.x

l

VMware ESX 3.x, 4.0, 4.1

l

VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5

l

VMware ESX 2.5 via VirtualCenter 2.x

l

VMware ESX 3.x via VirtualCenter 3.x

l

VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5

Solution Template Monitors
The VMware Host solution template deploys monitors that target the following aspects of VMware
Host performance:
l

VMware Host CPU

l

VMware Host Memory

l

VMware Host Network

l

VMware Host Storage

l

VMware Host State

Tasks
How to Deploy the VMware Host Solution Templates
This task describes the steps involved in entering variables for the VMware Host solution template.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
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Tip:
n

The VMware Host solution template allows you to monitor ESX hosts in two ways: via
vCenter or via the ESX host directly. We recommend that you monitor ESX hosts directly
to reduce load on the vCenter machine.

n

We recommend deploying the solution template using a CSV file, since you can perform
multiple deployments at one time, without having to manually enter variable values for
each deployment in the user interface. For details on deploying using a CSV file, see "How
to Deploy Templates Using a CSV File" on page 850.

Note: When a browsable monitor is deployed in a template, the number of counters that
match the selected patterns is limited by the _maxCountersForRegexMatch parameter in
the <SiteScope root directory>\groups\master.config file (this is in addition to the _
browsableContentMaxCounters parameter which limits the number of counters that
browsable monitors can have). If during deployment, the number of counters that match the
patterns exceeds this value, only the number of counters up to this value is saved. We
recommend using the same value for both these parameters (the default value for both of
these parameters is 1000).
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Description
VMware Host Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

connection_ URL of the vCenter or host server you want to monitor (for loaded environments, it is
link
recommended to connect directly using a host server).
username

User name of the VMware VirtualCenter or host administrator with view host
permissions.

password

Password of the VMware VirtualCenter or host.

host

Name of the VMware host server you want to monitor.

is vCenter

Enter true for vCenter, or false for the ESX host.
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UI Element

Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed. Clearing this option
deploys the monitor without having to connect to the server, thereby enabling
template deployment on powered-on and powered-off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered-on.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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Troubleshooting Solution Template
The VMware Host For Performance Troubleshooting solution template deploys a set of monitors that
follow VMware's official best practice scenarios for performance troubleshooting of VMware vSphere.
These monitors use SiteScope’s Calculated Metrics to pinpoint specific performance problems on the
VMware host, and report the problematic ESX host and/or VMs. The template deploys the VMware
Host CPU, Memory, Network, State, and Storage monitors to provide performance troubleshooting forrelated counters on the VMware host server and its guest virtual machines.
The VMware Host For Performance Troubleshooting solution template provides comprehensive
monitoring without requiring the SiteScope user or the IT organization to be experts on the application.
It also reduces the time it takes to configure and deploy monitors, helps identify both real-time
performance bottlenecks and longer term trends, and adds only minimal overhead to production
systems.
Tip: When to use which VMware Solution Template?
l

l

If you want to monitor the VMware host for data collection and overall performance and
availability, you should use the "VMware Host Solution Template" on page 1014.
If you want to have the ability to find a specific performance problem and the root cause of it
according to VMware's best practices, you should use the "VMware Host For Performance
Troubleshooting Solution Template" above. This template also includes most of the metrics
included in the VMware Host solution template.

Note: An in-depth description of the VMware Host For Performance Troubleshooting Solution
Template is available in the SiteScope VMware Host For Performance Troubleshooting Best
Practices document, available from <SiteScope root directory>\sisdocs\pdfs\SiteScope_
VMware_Perf_Troubleshooting_Best_Practices.pdf. This is a password protected guide; the
password is provided after acquiring an HP license edition that supports the solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
VMware Host For Performance Troubleshooting solution template.
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Learn More
Supported Versions
The VMware Host For Performance Troubleshooting solution template supports:
l

VMware VirtualCenter 2.x

l

VMware ESX 3.x, 4.0, 4.1

l

VMware ESXi 3.5, 4.0, 4.1, 5.0, 5.1, 5.5

l

VMware ESX 2.5 via VirtualCenter 2.x

l

VMware ESX 3.x via VirtualCenter 3.x

l

VMware vSphere 4.0, 4.1, 5.0, 5.1 (also supported with SSO login), 5.5

Aspects Covered by VMware Host Best Performance Troubleshooting
The VMware Host For Performance Troubleshooting solution template covers VMware best
performance troubleshooting practice diagrams that target the following aspects of VMware Host
performance:
CPU
l

l

l

l

Active VM Swap
Wait
Guest CPU
Saturation
High CPU Ready
Time on VMs
Running in an UnderUtilized Host
Host CPU
Saturation

Memory
l

l

l

l

l

Active VM Memory
Compression
Active VM Memory
Swapping
High Guest
Memory Demand
High Memory
Demand In a Host

Network
l

l

l

Dropped Receive
Packets
Dropped Transmit
Packets
Random Spikes in
Data Transfer Rate
on Network
Controllers

Storage
l

l

l

l

Overloaded
Storage Device
Slow Storage
Device
Under-Sized
Storage Device
Random Spikes in
I\O Latency On a
Shared Datastore

Past VM Memory
Swapping

For more details on the VMware best performance troubleshooting practice diagrams, see VMware's
Performance Troubleshooting for VMware vSphere 4.1 document
(http://communities.vmware.com/servlet/JiveServlet/downloadBody/14905-102-217952/vsphere41-performance-troubleshooting.pdf).
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The solution template targets VMware host performance by deploying monitors (VMware Host
CPU/Memory/Network/Storage/State) with preconfigured counters and patterns. The patterns use
regular expressions in SiteScope's Calculated Metrics. A pattern represents one or more counters.
Each of the above performance aspects is implemented in a monitor as a separate calculated metric
that returns 100 if a performance problem is encountered (Error state); otherwise it returns 1 (Good
state).
The monitors also have supporting calculated metrics that return problematic ESX, VM, VNIC, or
DataStore names. Supporting calculated metrics have the same name prefix as the diagram’s name
with a relevant postfix (for example, Active VM Memory Compression - VM with Highest
Compression Rate).
All of the calculated metrics have HostSystem as the monitored entity. The monitored entity is set to a
specific HostSystem that was used upon template creation.

Tasks
How to Deploy the VMware Host For Performance Troubleshooting Solution Template
This task describes the steps involved in entering variables for the VMware Host For Performance
Troubleshooting solution template.
1. Prerequisites
Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an Operating
System Instance (OSi) license with sufficient available capacity. For information on licensing,
refer to the Licensing section of the SiteScope Deployment Guide. For license purchase inquiries
(or if you require additional capacity), contact your HP sales representative or use the “Contact
Us” link in the HP SiteScope Product page.
2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
Tip:
n

We recommend deploying the solution template using a CSV file, since you can perform
multiple deployments at one time, without having to manually enter variable values for
each deployment in the user interface. For details on deploying using a CSV file, see "How
to Deploy Templates Using a CSV File" on page 850.

n

When a browsable monitor is deployed in a template, the number of counters that match
the selected patterns is limited by the _maxCountersForRegexMatch parameter in the
<SiteScope root directory>\groups\master.config file (this is in addition to the _
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browsableContentMaxCounters parameter which limits the number of counters that
browsable monitors can have). If during deployment, the number of counters that match
the patterns exceeds this value, only the number of counters up to this value is saved. We
recommend using the same value for both these parameters (the default value for both of
these parameters is 1000).
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
Tip: The VMware Host For Performance Troubleshooting solution template allows you to
monitor ESX hosts in two ways: via vCenter or via the ESX host directly. We recommend
that you monitor ESX hosts directly to reduce load on the vCenter machine.
4. Adjust threshold settings - optional
Error or Warning thresholds are defined for the relevant calculated metrics according to the
severity of the performance problem detected. You can adjust the default threshold settings as
required, and add additional threshold settings.
5. Results
The solution template creates a new monitor group container in the monitor tree in which the
individual solution monitors are added. The monitor group container is assigned a name in the
format VMware Host For Performance Troubleshooting on <server_name> where server_
name is the server selected from the Server box.
You can view, edit, and delete these monitors in the same way as any other monitors in
SiteScope.
When viewing reports on the solution template monitors, you should focus more on the regular
counters and less on the Calculated Metrics.
Note:
n

If a solution template deployment fails, a message displays reasons for the failure.

n

If a calculated metric returns 100 (error state), you should refer to the supporting calculated
metric description (in the user interface or in the Best Practices guide) for more details.
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UI Description
VMware Host For Performance Troubleshooting Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

connection_ URL of the vCenter or host server you want to monitor.
link
username

User name of the VMware VirtualCenter or host administrator with view host
permissions.

password

Password of the VMware VirtualCenter or host.

host

Name of the VMware host server you want to monitor.

is vCenter

Enter true for vCenter, or false for the ESX host.

High_CPU_
Usage

Value set on deployment, as a percentage, that defines high CPU usage for the host
server. If the host server's CPU usage exceeds this value it is considered high.
Default value: 80
Note: This variable value must be below 95.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed. Clearing this option
deploys the monitor without having to connect to the server, thereby enabling
template deployment on powered-on and powered-off VMs. When this option is
selected (the default setting), deployment fails for VMs that are not powered-on.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The WebLogic solution templates are templates that you can use to deploy a collection of WebLogic
Monitors configured with default metrics. The monitors test the health, availability, and performance of
a WebLogic Application Server and its deployed applications and components. The deployed monitors
check server-wide statistics such as memory usage, as well as metrics specific to individual J2EE
components, such as the number of activates and passivates of a particular EJB.
This solution automatically creates several groups by default which monitor important application
server metrics, but it also provides a user interface that enables you to select all or some of the
individual components that are available for monitoring.
The WebLogic Solution monitor deployment process is highly customizable in that it enables you to
select the specific J2EE components on an application server which SiteScope should actively
monitor.
The WebLogic solution templates provide comprehensive WebLogic monitoring without requiring the
SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Note: An in-depth description of the WebLogic Solution Template is available in the SiteScope
WebLogic Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_WebLogic_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required WebLogic solution template.

Learn About
Supported Versions
The WebLogic solution templates support WebLogic 6.x, 7.x, 8.x, 9.x, and 10.x servers.

Solution Template Monitors
The WebLogic solution templates deploy monitors that target the following aspects of WebLogic
performance and health:
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l

l

l

Server Performance Statistics. This category refers to a collection of server-wide resources that
are exposed through the management interface of a WebLogic Application Server.
Application Performance Statistics. Metrics for all of your deployed applications, EJBs, web
applications, and servlets are available for monitoring through the WebLogic Solution. The user is
responsible for selecting which of these J2EE components he would like to have monitors
automatically deployed for. A set of metrics based on WebLogic best practices are monitored for
each selected J2EE component.
WebLogic Solution Metrics. For the list of components that can be monitored, see the SiteScope
WebLogic Best Practices document.

Selecting WebLogic Modules for Monitoring
The WebLogic Solution presents a hierarchical list from which the user can select the modules to
deploy WebLogic Monitors against. This list is broken down into two main sections:
l

Per-server resources

l

J2EE components organized by application

Some of the modules in these categories are automatically selected by default because they represent
critical components in the system (for example, the JVM statistics for the application server). The
remainder of the modules are not automatically selected. This enables you to customize the
deployment of this solution to focus on one application, a particular type of EJB, a set of servlets and
web applications, or some other aspect of the application server.
For the most part, the organization of this list of modules is intuitive. The hierarchy of applications,
EJBs, web applications, and servlets is very similar to the organization of these entities in the
WebLogic Administration Console. In almost every case, selecting a module causes a monitor with all
relevant metrics to be deployed against that part of the WebLogic server. However, when selecting
EJBs to monitor, you notice that they are broken down according to three types of metrics: Pool,
Transaction, and Cache. The reason for this is twofold: (1) it is more useful to be able to monitor one
aspect of a particular EJB instead per WebLogic Monitor for purposes of alerting and organization, and
(2) not all three of these types of metrics are available for all EJBs.
Below is a brief description of the metrics that are monitored for each type of EJB monitoring:
l

l

Per-EJB Transaction Statistics. This category of EJB monitor contains metrics related to
transactions made for the EJB. These metrics include the number of transactions rolled back, the
number of transactions that timed out, and the number of transactions that were successfully
committed.
Per-EJB Pool Statistics. This category of EJB monitor contains metrics related to the pool for the
EJB. When the user selects an EJB under this heading, many useful metrics are monitored,
including the number of times an attempt to get a bean instance from the pool failed, the number of
current available instances in the pool, the number of threads currently waiting for an instance, and
the number of times a bean instance was destroyed due to a non-application exception.
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l

Per-EJB Cache Statistics. The cache statistics include any metrics relating to the caching of the
particular EJB. Metrics like the number of cache hits and misses, and the number of activates and
passivates of the EJB are monitored when an EJB under this heading is selected for monitoring.

Tasks
How to Deploy the WebLogic Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the WebLogic solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The WebLogic solution template deploys a WebLogic Application Server Monitor for each
module that is selected from the user interface. This monitor uses the Java JMX interface to
access Runtime MBeans on the WebLogic server. An MBean is a container that holds the
performance metrics. You may need to set certain permissions on the WebLogic server for
SiteScope to be able to monitor MBeans. For an overview on configuring access to WebLogic
servers for SiteScope monitors, see WebLogic Application Server Monitor in the SiteScope
Monitor Reference Guide.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.
4. Select WebLogic modules for monitoring
For a brief description of the metrics that are monitored for each type of EJB monitoring, see
"Selecting WebLogic Modules for Monitoring" on the previous page.
5. Update the main browser window
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Scroll to the bottom of the Module Selection window and click the Select Modules button. This
updates the main browser window with a list of the modules you selected. You can then review
your selections and remove any modules for which you do not want to create a monitor.
When you are satisfied with the list of selected modules in the main browser window, click
Submit.

UI Descriptions
WebLogic 9.x-10.x
The Main Settings include the following elements:
UI Element

Description

WEBLOGIC_ URL for the WebLogic 9.x or 10.x application server.
URL
Default value: service:jmx:rmi:///jndi/iiop://<local
host>:7001/weblogic.management.mbeanservers.runtime
where <local host> is the name of the machine running WebLogic Application
Server 9.x or 10.x.
Counters

Displays the server performance counters you want to check with this monitor. Use
the Get Counters button to select counters.

Get
Counters

Opens the Get Counters dialog box, enabling you to select the counters you want to
monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected

WebLogic 6.x, 7.x, 8.x
User interface elements (Variable Values) are described below:
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UI Element

Description

WEBLOGIC_ Port number that the WebLogic server is responding on.
PORT
Default value: 7001
WEBLOGIC_ Password required to log into the WebLogic server.
PASSWORD
WEBLOGIC_ User name required to log into the WebLogic server.
USERNAME
WEBLOGIC_ Name or address of the server where WebLogic is running.
SERVER
WEBLOGIC_ Number of seconds to wait for a data request to arrive at the WebLogic server.
TIMEOUT
Default value: 180
WEBLOGIC_ Absolute path to the weblogic.jar file on the SiteScope machine. This file must be
JAR_FILE
installed on the SiteScope server and can be downloaded from the WebLogic
server.
Example:c:\bea\weblogic7\ebcc\lib\ext\weblogic.jar.
Counters

Displays the server performance counters you want to check with this monitor. Use
the Get Counters button to select counters.

Get
Counters

Opens the Get Counters dialog box, enabling you to select the counters you want to
monitor.

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All submitted
requests and their corresponding deployment results are logged to <SiteScope root
directory>\logs\silent_deployment.log.
Default value: Not selected

Verify
monitor
properties
with remote
server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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The WebSphere solution templates are templates that you can use to deploy a collection of
WebSphere Monitors configured with default metrics. The monitors test the availability, server
statistics, and deployed J2EE components for IBM WebSphere Application Servers. You can use this
solution template to deploy monitors for server-wide resources and metrics (for example, thread pool
and JVM metrics). You can also create monitors for the deployed EJBs, Web Applications, and
Servlets using this solution template.
The WebSphere Solution monitor deployment process is highly customizable in that it enables you to
select the specific J2EE components on an application server which SiteScope should actively
monitor.
The WebSphere solution templates provide comprehensive WebSphere monitoring without requiring
the SiteScope user or the IT organization to be experts on the application. They also reduce the time to
configure and deploy monitors, help identify both real-time performance bottlenecks and longer term
trends, and add only minimal overhead to production systems.
Note: An in-depth description of the WebSphere Solution Template is available in the SiteScope
WebSphere Best Practices document, available from <SiteScope root
directory>\sisdocs\pdfs\SiteScope_WebSphere_Best_Practices.pdf. This is a password
protected guide; the password is provided after acquiring an HP license edition that supports the
solution template.

To access
Select the Templates context. In the template tree, expand Solution Templates, and select the
required WebSphere solution template.

Learn About
Supported Versions
The WebSphere solution templates support WebSphere Application Server 6.x, 7.x and 8.x.

Solution Template Monitors
The WebSphere solution templates deploy monitors that target the following aspects of WebSphere
performance and health:
l

Server Performance Statistics. This category refers to a collection of server-wide resources that
are exposed through the management interface of a WebSphere Application Server.
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l

l

Application Performance Statistics. Metrics for all of your deployed applications, EJBs, web
applications, and servlets are available for monitoring through the WebSphere Solution. The user is
responsible for selecting which of these J2EE components he would like to have monitors
automatically deployed for. A set of metrics based on WebSphere best practices are monitored for
each selected J2EE component.
WebSphere Application Server Solution Metrics. For the list of components that can be
monitored, see the SiteScope WebSphere Best Practices document.

Tasks
How to Deploy the WebSphere Solution Template
This task describes the steps involved in configuring the server environment and entering variables for
the WebSphere solution template.
1. Prerequisites
n

Solution Templates are only available in the user interface after acquiring an HP license edition
that supports them. To use the monitors deployed by this template, you must have an
Operating System Instance (OSi) license with sufficient available capacity. For information on
licensing, refer to the Licensing section of the SiteScope Deployment Guide. For license
purchase inquiries (or if you require additional capacity), contact your HP sales representative
or use the “Contact Us” link in the HP SiteScope Product page.

n

The WebSphere server environment must be configured according to the environment being
used. For details, see WebSphere Application Server Monitor in the SiteScope Monitor
Reference Guide.
Note: By default, the WebSphere 6.x Application Server solution template uses the
internal JVM mechanism. Accordingly, when using this solution template, configure the
monitoring environment to use internal Java. For details, see How to configure the
WebSphere 6.0x server environment using internal Java and How to configure the
WebSphere 6.1x server environment using internal Java.

2. Deploy the solution template
For the methods available for deploying a solution template and a detailed overview of the steps
involved, see "How to Deploy a SiteScope Solution Template" on page 903.
Note: If you deploy the WebSphere Application Server solution template using a CSV file,
you need to specify the path using double slashes. For example: C:\\Folder\\WAS_8.5
Perhaps, it need to be described in docs.
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3. Enter deployment values for the solution template (for deployment through the user interface only)
Complete the items on the Deployment Values page as described in the UI Descriptions section
below.

UI Descriptions
WebSphere Solution Template Page
User interface elements (Variable Values) are described below:
UI Element

Description

WEBSPHERE_ Name of the server where the WebSphere Application is running. Do not type
SERVER
backslashes (\\) that indicate a UNC path as part of the name of the server.
WEBSPHERE_ Port number of the WebSphere server.
PORT
Default value: 8880
WEBSPHERE_ User name that SiteScope should use to log on to the WebSphere Application
USER_
server.
NAME
In WebSphere 6.x, Global Security is not supported in the solution template. This
means that you can type in any text however, the text box cannot be left empty. If
you need to work with Global Security, complete this template. Edit the
WebSphere monitor and, in the Monitor Settings panel, update the Global
Security boxes (Trust store, Trust store password, Key store, Key store
password).
WEBSPHERE_ Password that SiteScope should use to log on to the WebSphere server.
PASSWORD
In WebSphere 6.x, Global Security is not supported in the solution template. This
means that you can type in any text however, the text box cannot be left empty. If
you need to work with Global Security, complete this template. Edit the
WebSphere monitor and, in the Monitor Settings panel, update the Global
Security boxes (Trust store, Trust store password, Key store, Key store
password).
WEBSPHERE_ Enter the path of the SSL key store file. This file is typically used to store personal
KEY_STORE_ certificates, including private keys. This file is in the client monitor directory on
FILE
the SiteScope machine.
Default value:
C:\WebSphere\AppServer\profiles\default\etc\DummyClientKeyFile.jks
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UI Element

Description

WEBSPHERE_ Password for the SSL key store file.
KEY_STORE_
Default value: WebAS
PASSWORD
WEBSPHERE_ Enter the path of the SSL trust store file. This file is typically used to store signer
TRUST_
certificates, which specify whether the signer of the server's certificate is trusted.
STORE_FILE
This file is in the client monitor directory on the SiteScope machine.
Default value:
C:\WebSphere\AppServer\profiles\default\etc\DummyClientTrustFile.jks
WEBSPHERE_ Password for the SSL trust store file.
TRUST_
Default value: WebAS
STORE_
PASSWORD
WEBSPHERE_ The client properties file.
CLIENT_
Default value: /properties/soap.client.props
PROPERTIES_
FILE
WEBSPHERE_ Path to the WebSphere directory that contains the /java and /lib subdirectories
DIRECTORY
from the WebSphere Application Server.
In WebSphere 6.x, this directory must also contain /profiles subdirectory. This
subdirectory has all Key Store and Trust Store files needed for Global Security.
The server profile in /profiles subdirectory must be called default. If the server
profile has a different name, rename it to default.
WEBSPHERE_ Select the version of the WebSphere Application server you are monitoring (6.0x,
VERSION
6.1x, 7.0x, 8.0x, 8.5x).
Default value: 6.0x for WebSphere 6.x solution template, 7.0x for WebSphere
7.x solution template, 8.0x for WebSphere 8.x solution template.
WEBSPHERE_
USE_
EXTERNAL_
JV
(WebSphere 6.x
solution only)

Enables using external JVMs for monitoring. By default, the WebSphere monitor
uses internal JVMs. External JVMs consume greater resources, take longer to
start up, and have bad error handling.
Note: You cannot use certificates added using Certificate Management if external
JVMs are used.
Default value: false

Counters

Displays the server performance counters you want to check with this monitor.
Use the Get Counters button to select counters.

Get Counters

Opens the Get Counters dialog box, enabling you to select the counters you want
to monitor.
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UI Element

Description

Silent
deployment

Submits the template deployment request to a queue, and SiteScope handles the
deployment in the background. This enables you to continue to use SiteScope
without having to wait for the template deployment process to finish. All
submitted requests and their corresponding deployment results are logged to
<SiteScope root directory>\logs\silent_deployment.log.
Default value: Not selected

Verify monitor
properties with
remote server

Verifies the correctness of the monitor configuration properties in the template
against the remote server on which the template is deployed.
Note: When this option is selected, deployment time is slowed due to the remote
connection.
Default value: Selected
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Part 10: SiteScope Dashboard
You can view current performance data for the infrastructure elements being monitored by SiteScope in
the SiteScope Dashboard. It displays a table of groups and monitors for the element highlighted in the
monitor tree or listed in the path. You can double-click each group or monitor node to navigate to child
nodes and monitors. You can also perform actions on groups or monitors from the Dashboard. For
details, see "View and Manage Data in the SiteScope Dashboard" on page 1034.
Tip: Alternatively, you can use the Unified Console (a more modern and intuitive Java-free
interface) to simplify the management of large, distributed environments, and to accelerate your
ability to isolate and diagnose problems. It also ideal for displaying enterprise-wide monitoring
status and managing the event lifecycle in a network operations setting. For details, see "Unified
Console" on page 1061.
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Dashboard
The Dashboard displays current performance data for the infrastructure elements being monitored by
SiteScope and provides access to functions you use to define filters. The Dashboard displays a table
of groups and monitors for the element highlighted in the monitor tree or listed in the path. You can
double-click each group or monitor node to navigate to child nodes and monitors.
From the Dashboard, you can access Server-Centric reports, preconfigured reports, acknowledge
monitor status, monitor tools, SiteScope Health Status, monitor history information, and enable/disable
monitors and alerts.

To access
Select the Monitors context. Select an object in the monitor tree, and click the Dashboard tab in the
right pane.

Learn About
SiteScope Dashboard Overview
SiteScope monitoring provides a real-time picture of system availability and performance. You
configure SiteScope monitors to collect metrics from a range of infrastructure components, including
Web, application, database, and firewall servers. The status and metrics are then aggregated for
presentation in SiteScope Dashboard.
Dashboard is linked to the SiteScope monitor tree hierarchy. The data displayed in Dashboard
represents the selected context in the monitor tree. The highest level is the SiteScope node and any
applicable monitor groups. The lowest-level element for display in a Dashboard view is an individual
SiteScope monitor and its measurements.
Dashboard includes functions that you can use to customize the display of monitor information. This
includes defining named filter settings to limit the display of data to those matching a defined criteria.
You can also select various data display options.
Dashboard also includes hyperlinks and menus that you can use to navigate through the hierarchy of
monitor elements, manually run a monitor, disable monitors, and access alert definitions.

Customizing the SiteScope Dashboard
You can customize the display and content of SiteScope Dashboard by setting the layout, configuring
filters, and saving the view to favorites.
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Use the Dashboard filter to filter the monitors that are displayed the Dashboard view. Dashboard filters
are separate from SiteScope tree filters (see "Filter Objects in the SiteScope View" on page 74). You
can use either Dashboard filters or SiteScope tree filters to filter the display of nodes to specific monitor
types. However, Dashboard filters are applied to the results of any currently selected tree filter setting.
If a tree filter setting is active, this may prevent the Dashboard filter from finding monitors that match
the filter criteria, even if such monitors do exist in the SiteScope environment.
Tip: Generally, it is best to use filters together with the Show All Descendent Monitors view
option. Filters remain active until you change or reset the filter criteria in the Dashboard Filter
window.
You can filter the SiteScope Dashboard by the following criteria:
l

Monitor names containing a specific text string.

l

Monitors monitoring a specific host or server.

l

Monitors reporting an error.

l

Measurement results containing a specific text string.

The filter criteria are not applied to groups, alerts, or reports. You can use SiteScope tree filters to filter
other elements.
You can save a filter setting by defining the filter settings and then saving the view as a Dashboard
Favorite.
For task details, see "How to Customize the SiteScope Dashboard" on page 1037.

Acknowledging Monitor Status
The acknowledgment function can be used to track resolution of problems that SiteScope detects in
your system and network infrastructure. With this function, SiteScope keeps a record of when the
problem was acknowledged, what actions have been taken, and by which user.
It also enables you to temporarily disable alerting on the monitors. This is useful to avoid redundant
alerts while a problem is being actively addressed. You can also use the acknowledgment function as a
simple trouble ticket system when more than one person uses SiteScope to manage system
availability.
Note: The acknowledgment function is available in Dashboard view and in Multi-View only. The
acknowledgment icon is displayed only in Dashboard Detailed views.
You can add an acknowledgment to individual monitors or monitor groups. An acknowledgment added
to a monitor applies only to that monitor. Any alert disable condition selected in the acknowledgment
applies only to that monitor instance. Acknowledging a group applies the acknowledgment description
and alert disable conditions to all monitors within the group. Acknowledgments applied to a group can
be edited or deleted individually for monitors in the group.
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Only one acknowledgment can be in force for a monitor or group at any given time. Acknowledgment
comments and acknowledgment indicators continue to be displayed in the interface until they are
deleted, even after any applicable alert disable schedule has expired.
Acknowledgment data and comments are written to a log file on the SiteScope machine. A new log
entry is made each time you add, edit, or delete an acknowledgment. After a problem monitor or group
is acknowledged, or the acknowledged status is cleared, you can view the history in the Acknowledge
Log. The Acknowledge Log for an item can be viewed even if there is no acknowledgment currently in
force.
For task details, see the "Acknowledge monitors" step in "How to Analyze Data in the SiteScope
Dashboard" on page 1040.

Testing Monitor Configuration Using Diagnostic Tools
SiteScope contains a number of tools that can be used to test the monitoring environment. You can use
these tools to query the systems you are monitoring and view detailed results of the action. This may
include simply testing network connectivity or verifying login authentication for accessing an external
database or service.
The Tools
listed below:

button is enabled in the Dashboard when configuring or viewing the monitor instances

Monitor

Tool

Active Directory Replication monitor

"LDAP Authentication Status Tool" on page 118

Cisco Works monitor

"SNMP Browser Tool" on page 139

CPU monitor

"Performance Counters Tool" on page 130

Database Counter monitor

"Database Connection Tool" on page 109

Database Query monitor

"Database Connection Tool" on page 109

DB2 JDBC monitor

"Database Connection Tool" on page 109

Dynamic Disk Space monitor

"Performance Counters Tool" on page 130

DNS monitor

"DNS Tool" on page 113

F5 Big-IP monitor

"SNMP Browser Tool" on page 139

FTP monitor

"FTP Tool" on page 116

LDAP monitor

"LDAP Authentication Status Tool" on page 118

Mail monitor

"Mail Round Trip Tool" on page 125

Memory monitor

"Performance Counters Tool" on page 130
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Monitor

Tool

Microsoft Windows Event Log monitor

"Event Log Tool" on page 114

Microsoft Windows Performance Counter monitor

"Performance Counters Tool" on page 130

News monitor

"News Server Tool" on page 129

Oracle 9i Application Server monitor

"URL Tool" on page 147

Ping monitor

"Ping Tool" on page 132

Port monitor

"Ping Tool" on page 132

Service monitor

"Services Tool" on page 136

SNMP monitor

"SNMP Tool" on page 141

SNMP by MIB monitor

"SNMP Browser Tool" on page 139

SNMP Trap monitor

"SNMP Trap Tool" on page 145

Technology Database Integration monitor

"Database Connection Tool" on page 109

Technology SNMP Trap Integration monitor

"SNMP Trap Tool" on page 145

URL monitor

"URL Tool" on page 147

URL Content monitor

"URL Tool" on page 147

Web Service monitor

"Web Service Tool" on page 152

XML Metrics monitor

"XSL Transformation Tool" on page 157

For task details, see "How to Use SiteScope Diagnostic Tools to Test Monitor Configuration" on page
1039.
For the complete list of diagnostic tools that are available in SiteScope, click the Tools button in the
lower left pane of SiteScope. For details, see "SiteScope Tools" on page 105.

Tasks
How to Customize the SiteScope Dashboard
This task describes the steps involved in customizing the display and content of SiteScope Dashboard
by setting the layout, configuring filters, and saving the view to favorites.
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1. Set the Dashboard layout
a. Prerequisites
You must be an administrator in SiteScope, or a user granted Edit layout permissions to be
able to set the layout fields, and Edit favorites permissions to be able to add or delete items in
the favorite views list in the SiteScope Dashboard view. For details, see "User Management
Preferences" on page 732.
b. Select the Monitors context. In the Dashboard toolbar, click the Dashboard Settings
button.
c. Customize the display of group and monitor information using the settings on the Dashboard
Settings dialog box.
For user interface details, see "Dashboard Settings Dialog Box" on page 1046.
2. Select and set a Dashboard filter - optional
Configure and set a Dashboard filter by entering match criteria and selecting from the options
available on the Dashboard Filter dialog box.
Any combination of filter options can be included in a single filter. For example, the filter definition
can filter on a combination of Monitor type, Monitored target server, and Status.
For user interface details, see "Dashboard Filter Dialog Box" on page 1043.
Example: Dashboard Filter
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3. Save view to favorites
After defining the Dashboard filter and layout settings, you can save them as a named favorite
view in the Favorites list by clicking the arrow next to the Manage Favorites
selecting Save to Favorites.

button, and

For user interface details, see "Save to Dashboard Favorites Dialog Box" on page 1051.

How to Use SiteScope Diagnostic Tools to Test Monitor Configuration
1. Select the Monitors context. In the Dashboard, select a monitor instance for which a diagnostic
tool is available (see "Testing Monitor Configuration Using Diagnostic Tools" on page 1036).
2. Click the Tools
button in the SiteScope Dashboard toolbar to run the tool with the monitor's
existing data as its input. The test results appear in the Results pane. To save the results to a file,
click the Save to File button.
For UI details, see "SiteScope Tools" on page 105.
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How to Analyze Data in the SiteScope Dashboard
This task describes the steps to follow to analyze data in SiteScope Dashboard.
1. Drill down to view monitor and measurement status and availability
When viewing SiteScope data in the Current Status view of Dashboard, you can drill down in the
monitor tree to view monitor and measurement status and availability.
For user interface details, see "SiteScope Dashboard - Current Status View" on page 1051.
Example: Measurement status and availability for a monitor

2. View configured and triggered alerts
You can view data about alerts in the configured alerts and triggered alerts columns. If alerts are
configured for a monitor, you can double-click the Configured Alert
icon to see the list of
configured alerts, and select an alert to view or edit the alert properties.
To assist in troubleshooting, you can check the alert history for the monitor to determine whether
this is a reoccurring issue (all associated alerts are displayed in the alerts section).
For user interface details, see "SiteScope Dashboard - Current Status View" on page 1051.
Example: Configured alerts

3. Disable monitors or monitors in group
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Depending on the diagnosis, you can disable the monitor or monitors in group, or disable alerts
associated with the monitor or group and continue to use the monitor.
For user interface details, see "Enable/Disable Monitors in Group Dialog Box" on page 1049.
4. Acknowledge monitors
To acknowledge monitor status, select a monitor or group and click the Add Acknowledgment
icon or select Add Acknowledgment from the context menu, and enter the details in the
Acknowledge Monitors In Group dialog box.
For user interface details, see "Acknowledge Monitors In Group Dialog Box" on the next page.
Example: Acknowledge Monitors In Group Dialog

5. Monitor your Microsoft Windows/UNIX server's resources
You can create a Microsoft Windows or UNIX Resources monitor to monitor your Windows or
UNIX Server, and generating a Server-Centric report. For task details, see "Create Server-Centric
Reports" on page 1365.
6. View monitor history
You enable and configure monitor history in the General Preferences. For user interface details,
see "Dashboard Monitor History View Options" on page 587.
To view monitor history, click the Monitor History button in SiteScope Dashboard. For user
interface details, see "SiteScope Dashboard - Monitor History View" on page 1059.
Example: Monitor history view
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Acknowledge Monitors In Group Dialog Box
Note: This topic is related to the following: "View and Manage Data in the SiteScope Dashboard"
on page 1034
This dialog box enables you to add or edit an acknowledgment for a monitor or monitor group to track
resolution of the problem.
UI Element

Description

Acknowledge
comment

An acknowledgment comment which is displayed as a tooltip associated with
the acknowledgment icon in the Dashboard view and is recorded in the
Acknowledge Log. You can update the comment as new information becomes
available. The comment is displayed until the acknowledgment is deleted.

Enable all
associated
alerts

Enables all associated alerts (default setting).

Disable all
associated
alerts
indefinitely

Disables alerting immediately and continues suppressing alerting on the
selected monitor or group until this radio button is cleared and the alert definition
is updated.

Disable all
associated
alerts for the
next <time
period>

Disables alerting immediately and continues suppressing alerting on the
selected monitor or group for a duration that you specify.

Disable all
associated
alerts on a one
time schedule
from <timeA> to
<timeB>

Disables alerting during a period of time that you specify. This can be useful if
the system being monitored is expected to be unavailable during a certain period
but you want to continue to run the monitor without triggering an alert.
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Note: Use of this option may result in loss of expected alert capability if the alert
is disabled to accommodate a temporary condition. It is important to review this
status at a later time, and to manually enable the alert definition as necessary.

Page 1042 of 1395

Using SiteScope
Chapter 94: View and Manage Data in the SiteScope Dashboard

UI Element

Description

Disable
description

Description for alert icons associated with the monitors in the acknowledged
context. The text description is added to the tool tip text that is displayed when
the pointer is placed over any alert icon associated with the monitor in the
Dashboard view. This text is displayed only while the alert disable option is in
force. It is not written to the Acknowledge Log.
Undo one-time schedule
Cancel a one-time schedule disable alert.

View
Acknowledge
Log

View all acknowledgment entries for the monitor or group from which you invoke
the acknowledgment dialog box. The log contains the time and date of the
acknowledgment, user name of the acknowledger, the status of the monitor or
group, and the acknowledgment message.

Dashboard Filter Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037
This dialog box enables you to configure a Dashboard filter by entering match criteria and selecting
from the menu options.
To access

Select the Monitors context. In the Dashboard toolbar, click the Dashboard Filter
button.

Important
Any combination of filter options can be included in a single filter. For example, the
information filter definition can filter on a combination of Monitor type, Monitored target server,
and Status.
Relevant
tasks

"How to Analyze Data in the SiteScope Dashboard" on page 1040

Global Settings
User interface elements are described below:
UI Element

Description

Monitor name

Text string or regular expression that matches the name of one of more
monitors. When you apply this filter to the Dashboard view, only the monitors
that match the Monitor name criterion are displayed.
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UI Element

Description

Monitor type

Filters monitors by the selected monitor types.

Monitored target
server

Filters monitors by server name on a particular host or monitored server.

Status

Filters monitors by reported status. The status filter criterion can be defined in
terms of monitor category status.
The following status options are available:
l

Any Status. Show all monitors with any status. This is the default option.
This can be used in combination with the Data Available option to filter out
monitors that are in error due to connectivity or availability factors.

l

Disabled. Show only monitors reported as disabled.

l

Error. Show only monitors reporting an error status.

l

Good. Show only monitors reporting a good or OK status.

l

Good, Warning, or Error. Show all monitors except those reported as
disabled.

l

Warning. Show only monitors reporting a warning status.

l

Warning or Error. Show only monitors reporting a warning or error status.

l

Warning or Good. Show only monitors reporting a warning or good status.

Example: Create a filter that displays only those monitors reporting a warning
or error.
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UI Element

Description

Status (with
Availability)

Creates a compound filter by combining the monitor status category with the
data availability status.
The following data availability status options are available:
l

l

Data Available. Show monitors for which data is available, meaning the
monitor was able to retrieve measurements from the target system.
Data Unavailable. Show monitors for which data is not available, meaning
SiteScope was not able to retrieve measurements from the target system.

Example: Create a filter that displays only those monitors reporting Error and
Data Available. This means that the filter shows monitors that indicate an error
status for which the monitor was able to receive data from the monitored
system as opposed to monitors that are reporting an error because the monitor
was not able to communicate with the monitored system (that is, Data
Unavailable).
Summary text

Filters monitors based on text included in their summary string. You can type a
literal text string or a regular expression to match a text pattern.
For details about regular expressions see "Regular Expressions" on page 175.

Acknowledged

Filters monitors based on their Operator Acknowledgment status. To filter on
monitors that have been acknowledged, select Yes from the drop-down menu.
To filter on unacknowledged monitors, select No from the drop-down menu.

Acknowledgment Filters monitors based on text that may appear in their Operator
notes
Acknowledgment notes. You can type a literal text string or a regular
expression to match a text pattern.
For details about regular expressions see "Regular Expressions" on page 175.
Alerts configured Filters monitors based on whether alerts have been configured on them. To
filter on monitors that have one or more alerts configured on them, select Yes
from the drop-down menu. To filter on monitors that do not have configured
alerts, select No from the drop-down menu.
Alerts triggered

HP SiteScope (11.31)

Filters monitors based on whether they have triggered an alert event. To filter
on monitors that have generated one or more alerts, select Yes from the dropdown menu. To filter on monitors that have not generated alerts, select No from
the drop-down menu.
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Monitor History Settings
User interface elements are described below:
UI Element

Description

Display time period

Time frame for past events.
Default value: Past 1 hour

Monitor run status

Required event status, relational operator, and data availability.
Default value: Any

Dashboard Settings Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037
This dialog box enables you to customize the display of group and monitor data in the Dashboard
views. This enables you to display or suppress the display of monitor measurement details, alert
information, and acknowledgment functions.
To access

Select the Monitors context. In the Dashboard toolbar, click the Dashboard
Settings

Important
information

l

l

button.

Layout options apply only to the Detailed view. They are ignored when using the
Icon view.
You must be an administrator in SiteScope, or a user granted Edit layout
permissions to be able to set the layout fields in the SiteScope Dashboard view.
For details, see "User Management Preferences" on page 732.

Dashboard Properties
User interface elements are described below:
UI Element

Description

Dashboard
refresh rate (in
seconds)

Amount of time, in seconds, to wait between refreshing the Dashboard.
Default value: 60 seconds
Minimum value: 30 seconds
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UI Element

Description

Maximum
dashboard
icons

Maximum number of icons that can be displayed in the Dashboard's Icon View.
Default value: 700
Maximum recommended value: 1500
Note: If the selected element has more icons than the maximum number that can
be displayed, try to create a more restrictive tree filter or configure a Dashboard
filter instead of increasing this setting.

Maximum
dashboard
objects

Maximum number of objects that can be displayed in the Dashboard table for a
selected element.
Default value: 4000
Note: If the selected element has more objects than the maximum number that
can be displayed, create a more restrictive tree filter or configure a Dashboard
filter instead of increasing this setting.

Show monitor
availability

Displays monitor availability icons in the Dashboard that indicate whether
SiteScope was able to connect to a remote system or if a remote system was
unavailable due to a connection problem.
Default value: Selected

Wrap text

Automatically adjusts the row height to make all cell contents visible in the
Dashboard.
Default value: Not selected

Dashboard Table Layout
User interface elements are described below:
UI
Element

Description

Lock
columns

Locks the order of the table's columns. Clear the setting to change the table column
order by dragging the column header to the right or the left.
Default value: Not selected
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UI
Element

Description

Table
Columns displayed in the detailed tables. Your selections are applied to all applicable
Columns group and monitor elements.
The columns available for display are:
l

Type

l

Summary

l

Alerts Triggered

l

Alerts Configured

l

Description

l

Status

l

Target

l

Ack(nowledged)

l

Updated

l

Name

l

Group Name

l

Tag

Default value: All the properties except Group Name and Tag are selected .
For details on the columns, see "SiteScope Dashboard - Current Status View" on page
1051

Delete Dashboard Favorites Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037
This dialog box enables you to delete existing favorite views
To access

Select the Monitors context. In the Dashboard toolbar, click the arrow next to the
Manage Favorites
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Important
You must be an administrator in SiteScope, or a user granted Edit favorites
information permissions to be able to add or delete items in the favorite views list in the SiteScope
Dashboard view. For details on this topic, see "User Management Preferences" on
page 732.
User interface elements are described below:
UI
Element

Description

Existing
Favorites

Select the view or views you want to delete from the list of current favorite views. By
default, the list includes the following preconfigured favorites:
l

All Objects

l

Disabled

l

Errors Only

l

Errors and Warnings

l

Good

l

Good and Warnings

l

No Data

l

Warnings Only

Enable/Disable Monitors in Group Dialog Box
Note: This topic is related to the following: "How to Analyze Data in the SiteScope Dashboard" on
page 1040
This dialog box enables you to select an option for enabling or disabling the monitor or all the monitors in
the group, regardless of the individual monitor setting in the monitor properties tab. If you select
Disable monitor, the monitors are disabled until you return to this dialog box and select Enable
monitor.
To access

Select the Monitors context. In the Dashboard, select a monitor or group, and click
the Enable/Disable Monitor
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Important
If you disable a monitor or group using the Disable monitor option, the Dashboard
information shows disabled manually as the status in the Summary column for the affected
objects. You must enable any object with a disabled manually status before you
can set objects to be disabled for a specific period of time. This is also true at the
group level. For example, if monitors in a group are disabled for a time period and
monitors in a subgroup of that group have the disabled manually status, the
subgroup monitors remain disabled even after the disable time period has lapsed for
the parent group.
See also

"Enable/Disable Monitor" on page 309

User interface elements are described below:
UI Element

Description

Enable
monitor

Enables the monitors if they were previously disabled in the monitor properties.

Enable
temporarily
disabled
monitor only

Enables the monitors if they were previously disabled temporarily in the monitor
properties.

Disable
monitor

When monitors in the group have been disabled, SiteScope continues to schedule
the monitors to run based on the Frequency setting for the monitor but the monitor
action is not run. SiteScope records a monitor data log entry for the monitors when
they were scheduled to be run but reports the monitor status as disabled in the
place of measurement data.

Disable
monitor for
the next
<time
period>

Time period that the monitors should remain disabled. Select Seconds, Minutes,
Hours, or Days to define the disable time period as applicable.

Disable
monitor on a
one time
schedule
from <time>
to <time>

Temporarily disables the monitor for a time period in the future. The time period can
span more than one day.

Disable
description

Descriptive that appears as part of the monitor status in the monitor group display.
The disable status text also includes a string indicating which disable option is in
force for the monitor, for example Disabled manually indicates that the monitor
was disabled using the Disable monitor option.
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Default value: Selected

Enter or select the start time and end time for the disable period using the format:
hh:mm:ss mm/dd/yyyy.
Note: At the group level, this disables all child monitors in the group on a one time
basis. (While this change is displayed in monitor properties, it is not reflected if you
check group properties.)
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Save to Dashboard Favorites Dialog Box
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037
This dialog box enables you to define combinations of Dashboard filter and layout settings (which were
selected using the Dashboard Filter dialog box and the Dashboard Settings dialog box) and save them
as a named favorite view.
To access

Select the Monitors context. In the Dashboard toolbar, click the arrow next to the
Manage Favorites

Important
information

l

l

button, and select Save to Favorites.

Dashboard favorites are limited to settings that are applicable to Dashboard
views. This means that Dashboard favorites do not save user-global view
settings, or the context that was selected in the monitor tree when the favorite
was saved.
You must be an administrator in SiteScope, or a user granted Edit favorites
permissions to be able to add or delete items in the favorite views list in the
SiteScope Dashboard view. For details on this topic, see "User Management
Preferences" on page 732.

User interface elements are described below:
UI
Element Description
Name

Select an option for saving the current Dashboard filter and layout settings to favorites:
l

l

Existing. Enables you to replace one of the existing favorites with the current
settings. Displays a list of the existing favorite views. By default, the list includes all
the preconfigured favorites.
New. Enables you save the current settings to a new favorite view with the display
name that you enter in the box.

SiteScope Dashboard - Current Status View
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037, "How to Analyze Data in the SiteScope Dashboard" on page 1040
Displays current performance data for the infrastructure elements being monitored by SiteScope and
provides access to functions you use to define filters. The Dashboard displays a table of groups and
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monitors for the element highlighted in the monitor tree or listed in the path. You can double-click each
group or monitor node to navigate to child nodes and monitors.
From the Dashboard, you can access Server-Centric reports, preconfigured Quick reports,
acknowledge monitor status, monitor tools, SiteScope Health Status, monitor history information, and
enable/disable monitors and alerts.
To access

Important
information

Select the Monitors context. Select an object in the monitor tree, and click the
Dashboard tab in the right pane.
l

l

l

By default, the maximum number of objects that can be displayed in the
Dashboard table for a selected element is 4000, and the maximum number of
icons that can be displayed in Icon View is 700. You can modify these numbers by
changing the values in the Dashboard Settings dialog box. However, we
recommend that you use the default setting.
If the selected element has more lines than the maximum number that can be
displayed in the Dashboard table, try creating a more restrictive tree filter or
configure a Dashboard filter.
You can copy details from selected rows in the Dashboard using the Ctrl + C
shortcut.

User interface elements are described below:
UI Element

Description

Common Toolbar Elements
Show Child Groups and Monitors. Displays only those elements that are
direct children of the selected node. Subgroups and monitors are displayed in
separate sections in the group and monitor status information area.
Show All Descendent Monitors. Displays all descendent monitors of the
selected node. When the Icon view option is selected, only descendent
monitor icons and names are displayed.
Detailed View. Displays groups and monitors in tabular list format with the
element name, status, and other information arranged in individual table
rows.
Icon View. Displays groups and monitors as an array of status icons with
the name of the element below the icon.
Up. Goes up one level in the monitor tree. This option is not available for
SiteScope (the highest level in the tree).
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UI Element

Description
The Favorite box contains a drop-down list of the existing favorite views of
Dashboard filter and layout settings. You can select the one you want to
display in the Current Status or Monitor History view.
Note: The Favorites filter works on the monitor level which means that it
does not filter groups. When working in the Show Child Groups and
Monitors view, you can see groups that are not in a state that match the
filter. To see only monitors in the filter, use the Show All Descendent
Monitors view instead.
You can select from the following views:
l

l

l

l

l

l

All Objects. Show all monitors with any status, even those reported as
disabled.
Disabled. Show only monitors reported as disabled.
Errors Only. Show only monitors reporting an error or data unavailable
status.
Errors and Warnings. Show only monitors reporting a warning or error
status.
Good. Show only monitors reporting a good status.
Good and Warnings. Show only monitors reporting a warning or good
status.

l

No Data. Show only monitors for which there is no data.

l

Warnings Only. Show only monitors reporting a warning status.

Default value: <None>
Manage Favorites. Click the arrow, and select an option:
l

l

Save to Favorites. Opens the Save to Dashboard Favorites dialog box
which enables you to save the current Dashboard filter and layout
settings as a favorite view. For user interface details, see "Save to
Dashboard Favorites Dialog Box" on page 1051.
Delete Favorites. Opens the Delete Dashboard Favorites dialog box
which enables you to delete existing favorite views. For user interface
details, see "Delete Dashboard Favorites Dialog Box" on page 1048.

Dashboard Filter. Opens the Dashboard Filter dialog box. For user
interface details, see "Dashboard Filter Dialog Box" on page 1043.
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UI Element

Description
Dashboard Settings. Opens the Dashboard Settings dialog box. For user
interface details, see "Dashboard Settings Dialog Box" on page 1046.
Current Status. Displays a table of groups and monitors for the element
highlighted in the monitor tree or listed in the path.
Monitor History. Displays information about monitors, monitor groups, and
alerts over the last 24 hours. This information is filtered by the number of
hours, monitor status, and the number of data entries.
For more information on viewing monitor history, see "SiteScope Dashboard
- Monitor History View" on page 1059.
Run Monitors. Runs the monitor or any monitors configured in the group.
This opens an information window with the results.
Enable/Disable Monitors in Group. Opens the Enable/Disable Monitors in
Group dialog box which enables you to enable or disable the monitor or all the
monitors in the group, regardless of the setting in the monitor properties. If
you select Disable monitor, the monitors are disabled until you return to
this dialog box and select Enable monitor. For details on the
Enable/Disable Monitors in Group user interface, see "Enable/Disable
Monitors in Group Dialog Box" on page 1049.
Enable/Disable Associated Alerts. Opens the Enable/Disable Associated
Alerts dialog box which enables you to enable or disable all alerts associated
with the monitor or all monitors in the group. For more details, see
"Enable/Disable Associated Alerts" on page 310.
Add Acknowledgment. Opens the Acknowledge Monitors In Group dialog
box which enables you to add an acknowledgment to a monitor.
Acknowledgments are used to track resolution of problems that SiteScope
detects in your system and network infrastructure. With this function,
SiteScope keeps a record of when the problem was acknowledged, what
actions have been taken, and by which user.
For details on the Acknowledge Monitors In Group user interface, see
"Acknowledge Monitors In Group Dialog Box" on page 1042.
Delete Acknowledgment. Deletes the monitor's acknowledgment.
Quick Report. Creates a one-time SiteScope management report using
preconfigured settings for the selected monitor. For more details on the
report, see "Quick Report" on page 1356.
Tools. Opens a diagnostic tool to test the selected monitoring environment.
This button is available only for those monitor instances for which there is an
appropriate diagnostic tool. For details on the SiteScope Tools, see "Testing
Monitor Configuration Using Diagnostic Tools" on page 1036.
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UI Element

Description
Export to CSV. Opens the Save dialog box which enables you to export
data from all columns currently displayed in the Dashboard table to a
Comma Separated Value (CSV) file. You can modify the type of data that is
exported by selecting which columns you want to display in Dashboard
Settings. For details, see "Dashboard Settings Dialog Box" on page 1046.
Unified Console. Opens the SiteScope Unified Console which contains the
following views:
l

l

l

Multi-View. Enables you to see and manage the status of everything that
is being monitored in your IT infrastructure in a single view. You can
group objects in different ways to fit the perspective of different
personas: you can display all SiteScope groups and monitors in a
hierarchical tree map, display monitors grouped by target remote server;
or display monitors grouped by custom search/filter tags. For details, see
"Multi-View" on page 1089.
Event Console. Provides a central view for all notification messages
about the performance of your applications and servers. This accelerates
your ability to manage, identify, and resolve performance issues by
analyzing events from a single interface. For details, see "Event
Console" on page 1062.
Ops View. This consolidated view enables you to work with Event
Console and Multi-View simultaneously. Event - monitor wiring identifies
monitors and groups associated with events (and vice versa), which
helps you pinpoint and resolve issues.

Table Elements
Acknowledge column. Indicates that a SiteScope user has acknowledged
the current status of a monitor and may have temporarily disabled alert
actions associated with that monitor. This icon is only displayed in
Dashboard Detailed views. Moving the pointer over the icon displays the
acknowledgment information as a tool tip. Double-click the icon to open the
Edit Acknowledge dialog box. For details on this topic, see "Acknowledging
Monitor Status" on page 1035.
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UI Element

Description
Configured Alerts column. Indicates that one or more alerts are associated
with the group or monitor. If you double-click the icon, a tooltip displays the
configured alerts. Selecting an applicable alert definition name from the list
opens the Edit Alert dialog box enabling you to view or edit the alert
properties. For details on this topic, see "Configure SiteScope Alerts" on
page 1243.
If all associated alerts have been disabled, the icon is displayed in gray.
For details on enabling or disabling alerts associated with specific groups
and monitors (not the alerts themselves), see "Set up monitor alerts optional" on page 264.
For details on enabling or disabling alerts, see "Disable or Enable Monitor
Alerts" on page 1254.
Triggered Alerts column. Indicates that at least one alert has been triggered
in the monitor. If no alert was triggered, the icon is not displayed. If a single
alert was triggered, an icon representing the specific alert type is displayed.
For a list of icons, see "Alert Actions" on page 1270.
If multiple alerts were triggered, an icon representing multiple alerts is
displayed. Clicking the alert icon displays alert details. The Triggered Alert
column only appears for a table that contains monitors. For details on this
topic, see "Configure SiteScope Alerts" on page 1243.

<Objects table>

Lists the groups and monitors for the element highlighted in the monitor tree
or listed in the path. You can double-click each group or monitor node to
navigate to child nodes and monitors. Double-click a monitor to display the
performance counters for that monitor.

Name

A display name (alias) for the monitor instance or group. When a new group
is created, you type its name. When a new monitor is created, you select its
type from the list of available monitors. If you do not override this type in the
Name box, the monitor is identified by the type of monitor. You can then
optionally type an alias that helps you identify this monitor.

Status

A colored icon is displayed for each node in a Dashboard view, representing
the operational status assigned to that component for its current
performance level.
A color-coded arrow is also displayed for each element in a Dashboard view,
representing the data availability status of the monitor.
You can point at the icons to display the monitor status and availability. For a
description of the monitor status and availability icons, see "SiteScope
Dashboard - Current Status View" on page 1051.

Type
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The type of monitor being displayed. You select the monitor type in the New
Monitor dialog box when you create the monitor instance.
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UI Element

Description

Target

Contains the name of the remote server containing the monitored object (if
such a server exists). If, for example, the monitor type is CPU, then the target
would be the name of the server on which the CPU being monitored is
installed.
The name displayed in the Target column can be either the system ID of the
server or the user-assigned name (alias), depending on what was entered in
the Name box when the server was added to the monitor tree.
If the group contains a Microsoft Windows Resources monitor or UNIX
Resources monitor, the server name in the Target column appears as a link.
You can click the link to open the Server-Centric report for the server. For
user interface details, see "Create Server-Centric Reports" on page 1365.

Summary

For monitors, the Summary column displays the most recent measurement
results reported by the monitor. This may include more than one
measurement, depending on the monitor type. For monitor groups, the
summary displays the number of monitors within the group and the number
of monitors, if any, that are reporting an error status.
If a monitor has been disabled, it displays the disabled status (disabled
manually, disabled until x time, or disabled by <Downtime Name>
from BSM).

Updated

The date and time when the last event occurred in the group or monitor.

Description

The Description column can contain either text that describes the monitor or
group or it can contain HTML that performs various actions when you click
the link.
If this field contains text, you can double-click it to open a dialog box that
displays the full description in HTML format.
You can enter information in this column by selecting the monitor or group in
the monitor tree and selecting the Properties tab. In the page that opens,
expand GeneralSettings and enter a description in the Monitor/Group
description box.

Group Name
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Contains the name of the group containing the monitor. This is useful for
seeing the position of the monitor and group in the SiteScope hierarchy,
navigating to parent nodes, and for grouping alerts by group name when
viewing all descendants in the descendant monitor view. Double-click the
Group Name cell to copy the monitor path to the clipboard (useful for
copying/pasting monitor path information).
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Status and Availability Levels
Icon Description
Good Status. All performance measurements are within the Good threshold level.
Warning Status. At least one performance measurement is within the Warning range, but no
measurements are within the Error or Poor range.
Error/Poor Status. At least one performance measurement is within the Error or Poor
range. This indicates either of the following:
l

The performance measurement has a value, but at poor quality level.

l

There is no measurement value due to some error.

Status Not Defined (No Data). There is no data for the group or monitor. This can be caused
by any of the following reasons:
l

A new monitor has not yet run.

l

Monitor counters have not yet been collected.

l

The monitors on which the group or monitor depend are not reporting a Good condition.

No Thresholds Breached Status. No thresholds were defined for the monitor counter, so no
status is assigned.
Disabled Manually. The group or monitor is currently disabled, and no data updates are
being received.
Data Collected Availability. Indicates that SiteScope was able to connect to the remote
system and perform the action defined by the respective monitor configuration. The resulting
monitor status represents the results of the monitor action. If an error or warning is indicated,
it represents an accurate measure of the target system's performance or the availability of the
target resource.
Availability Warning. Indicates that SiteScope has detected a possible problem with the
connectivity to the remote system.
No Data Availability. Indicates that SiteScope was not able to connect to the remote
system. Any resulting error status for the respective monitor may be attributed to the failure to
communicate with a remote server. It does not necessarily mean the target resource has
failed.

Dashboard Shortcut Menu
The following options are available by right-clicking in any column of a group or monitor object row:
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UI Element (A-Z)

Description

Add
Opens the Acknowledge dialog box which enables you to add an
Acknowledgment acknowledgment to a monitor.
Delete
Deletes the monitor's acknowledgment.
Acknowledgment
Enable/Disable
Associated
Alerts

Opens the Enable/Disable Associated Alert dialog box which enables you to
enable or disable all the alerts for all monitors in the group. If you select Disable
monitor, the alerts are disabled until you return to this page and select Enable
monitor.

Enable/Disable
Monitor
Enable/Disable
Monitors in
Group

Opens the Enable/Disable Monitor Settings dialog box which enables you to
enable or disable the monitor or all monitors in the group. If you select Disable,
the monitors are disabled until you return to this page and select Enable. For
user interface details, see "Enable/Disable Monitors in Group Dialog Box" on
page 1049.

Quick Report

Creates a one-time SiteScope management report using preconfigured settings
for the selected monitor. For more details, see "Quick Report" on page 1356.
Note: This menu item is displayed for monitors only.

Run Monitor(s)

Runs the selected monitor or all monitors in the selected group.

Tools

Opens a diagnostic tool that can help you troubleshoot monitor configuration
problems. For details on the available tools, see "SiteScope Tools" on page
105.
Note: This menu item is displayed for monitors only, and is available for
specific monitors only.

SiteScope Dashboard - Monitor History View
Note: This topic is related to the following: "How to Customize the SiteScope Dashboard" on page
1037, "How to Analyze Data in the SiteScope Dashboard" on page 1040
This view displays information about monitors, monitor groups, and alerts collected during the last 24
hours. This information is filtered by the number of hours, monitor status, and the number of data
entries.
To access

Select the Monitors context. In the Dashboard toolbar, click the Monitor History
button.
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Important
information

l

l

l

l

l

You enable this function by selecting Enable Dashboard Monitor History
Viewin Preferences > General Preferences > Dashboard Monitor History
View Options.
You can determine exactly how much data you want saved for this function so
that your database does not get overloaded.
By default, the maximum number of objects that can be displayed in the Monitor
History table for a selected element is 4000, and the maximum number of icons
that can be displayed in Icon View is 70. You can modify these numbers by
changing the values in the Dashboard Settings (select Monitors, click the
Dashboard Settings button, and expand Dashboard Properties). However, we
recommend that you use the default setting. For details, see "Dashboard Settings
Dialog Box" on page 1046.
If the selected element has more lines than the maximum number that can be
displayed in the Monitor History table, try creating a more restrictive tree filter or
configure a Dashboard filter.
The Dashboard Monitor History view is not supported in SiteScope for Load
Testing.

User interface elements are described below:
UI
Element

Description
Triggered Alert. Appears next to any monitor that triggered an alert.

Run
Time

Time the monitor ran.

Name

Name of the monitor.

Status

The monitor's status at runtime (Error, Warning, or Good). For user interface details, see
"SiteScope Dashboard - Current Status View" on page 1051.

Summary Description of the monitor run.
Availability
This box only appears if you have selected Show monitor availability in the Details
View pane of Dashboard Layout.
Group
The name of the group to which the monitor belongs. This box appears only if you have
selected Show all descendants in Dashboard.
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Use the Unified Console to simplify the management of large, distributed environments and to
accelerate your ability to identify and resolve issues. It is also ideal for displaying enterprise-wide
monitoring status in a network operations setting. The Unified Console contains the following views:
l

l

l

l

Event Console. Enables you to track the real time status of your monitored environment,
prioritize and dispatch events, and manage the event lifecycle from a single interface. You can also
see details of historical events, which is useful for tracking the resolution of previous issues, and for
identifying trends and hidden patterns. For details, see "Event Console" on page 1062.
Multi-View. Enables you to see the status of everything that is being monitored in your IT
infrastructure in a single view without losing the hierarchical relationship between the data. You can
group objects in various different ways to fit the perspective of different personas. For details, see
"Multi-View" on page 1089.
Ops View. Combines the Event Console and Multi-View in a single view. Working side-by-side
helps you isolate and diagnose problems by identifying events associated with a selected monitor
or monitor group, or a monitor associated with a selected event, and to drill down and perform
troubleshooting. For details, see "Ops View" on page 1114.
Manage. Provides new self-service monitoring which extends template deployment and the
ability to update monitor configuration to non-admin users (after they have been granted the
necessary permissions), and reduces the amount of monitoring support required from the SiteScope
administrator or monitoring team. For details, see "Manage View" on page 1116.
Tip: You can watch video demonstrations on using Multi-View, using Multi-View and Event
Console, and How to Manage and Track Monitors in Multi-View Using Filters and Tags.
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SiteScope's Event Console
enables you to track the real time status of your monitored
environment, prioritize and dispatch events, and manage the event lifecycle from a single interface.
This simplifies the management of large, distributed environments, and accelerates your ability to
identify and resolve issues.
Example: Unified Console displaying both Multi-View (top) and Event Console

Tip: You can view a guided and narrated demonstration of the Event Console on YouTube:
http://youtu.be/-BFVcF6Kh-k.

To access
The Event Console
is available in the Unified Console. You can access the Unified Console directly
from a browser or from the SiteScope Dashboard.
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l

l

To access the Event Console from a browser, enter the URL in a Web browser in the format:
n

http://<server_name>:<port>/SiteScope/WebMain#/eventconsole (for Event Console
only)

n

http://<server_name>:<port>/SiteScope/WebMain (for Event Console and Multi-View)

To access the Unified Console from the SiteScope Dashboard, select the Monitors context, click
the Dashboard tab, and then click the Unified Console button. The Unified Console opens in Ops
View, which displays both Multi-View and the Event Console. To display only the Event Console,
click Event Console

.

Learn About
This section includes:
l

"Event Console Overview" below

l

"Supported Browsers and Screen Resolutions" on the next page

l

"What is the Difference Between the SiteScope Event Console and the OMi Event Browser?" on
page 1065

l

"What are the User Roles and Required Permissions?" on page 1065

l

"Historical Event Log Files" on page 1067

l

"Capacity Recommendations and Best Practices" on page 1068

Event Console Overview
The Event Console displays information about all events on your monitored systems. It provides the
following views:
l

Live Console. Use to view and manage events on a day-to-day basis, and track event lifecycle
state and resolution progress. It provides a customizable display that enables users to sort, search,
and filter events by various event attributes, enabling them to focus on only the events they need to
see.
In addition, you can use the Event Console in conjunction with Multi-View to assist with problem
diagnosis and resolution. Event-monitor wiring provides the ability to identify events associated
with a selected monitor or monitor group, or a monitor associated with a selected event, and to drill
down and perform troubleshooting.

l

Event History. Use to see details of historical (closed) events. This is useful for tracking the
resolution of previous issues, and for identifying trends and hidden patterns.
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The Event Console is fully supported on big and small screens, making it is ideal for viewing events
and monitor data in a network operations center. It is also supported on iPad and Android tablets.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices
The following browsers are supported:
l

Google Chrome browsers (latest certified version): 42.0.2311.90 m.

l

Mozilla Firefox (latest certified version): 38 ESR

l

Safari (latest certified version): 8.0 for Mac

l

Internet Explorer 9, 10, 11
Note:
n

n

l

Internet Explorer 9 is supported on client machines with the following limitations:
o

It is not supported on Microsoft Windows 7 N Edition.

o

It is not supported on Microsoft Windows Server 2008.

We recommend setting Browser Mode according to the IE version, and Document Mode
to standards mode.

Internet Explorer 8 (in MyBSM only)
Note: While Internet Explorer 8 can be used to access the Multi-View Page in MyBSM, it is no
longer officially supported, and we recommend switching to one of the supported browsers,
since the Event Console and the tab functionality in the Unified Console will not work.

The following mobile devices are supported:
l

iPad 3 with Safari (iOS 7 with latest updates)

l

Android tablet with Chrome 34.0.1847 (Full HD display)

Default Screen Resolution
l

Large Desktop – 1680 x 1050 pixels

l

Laptop – 1280 x 800 pixels

l

iPad – 1024 x 768 pixels
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What is the Difference Between the SiteScope Event Console and the OMi Event Browser?
The SiteScope Event Console provides event management capabilities to mid-sized and enterprise
user groups that have a single SiteScope, or a light deployment without requiring an HPOM integration
(there is no need for a database or RTSM).
The Operations Management (OMi) Event Browser is a market-leading tool for event consolidation and
correlation. It is based on topology (RTSM) capabilities, and it requires integration with BSM and
HPOM products.

What are the User Roles and Required Permissions?
User Permissions
The following permissions are required to perform Event Console actions for SiteScope users working
with SiteScope standalone, and for BSM users that connect to SiteScope from SAM Administration in
BSM.
Permission Required
Action

SiteScope

SAM Admin (in BSM)

View and edit
event
console
preferences

View and edit event console preferences

CHANGE or FULL CONTROL
permissions for SiteScope
Preferences

Manage
events

For unassigned events: Unassigned Event
Management (Assign user/Edit event details)

CHANGE permissions for
SiteScope Dashboard (regardless of
whether an event assigned to a
user)

For assigned events: Assigned Event
Management (Assign user/Edit event details)
View events

A user can view event details for events that
are associated with monitors for which they
have Allowed Groups permissions

User can view events for monitors in
groups for which the user has view
permissions

For details on SiteScope user permissions, see "User Management Preferences" on page 732. For
details on BSM user permissions, refer to the BSM Platform Administration Guide.
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User Roles
The following are some of the roles that are suited to working with the SiteScope Event Console, and
the recommended SiteScope user permissions required for fulfilling these roles:

Persona

Role/Features

Dispatcher/NOC
Operator

Role: Dispatches unresolved events, and tracks overall
status of monitored environment.

(Monitoring
Team)

Features:
l

l

l

Application
Support
Team/SME
(Investigation
Team)

l

l

Displays active event status and resolution progress,
enabling follow-up and escalation.
Customizable display that enables dispatcher to
easily find and display the events they need to see
(such as events with high status, or events that have
not yet been assigned to a user).

Role: Investigates and resolves events.

l

l

Features
l

l

l
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Live Console provides clear view of all open events,
enabling quick dispatch to investigation team.

Recommended
Permissions

Ops View helps investigators to isolate and diagnose
problems by enabling them to see the monitor
associated with the triggered event in different
perspectives (grouped by monitor group, servers, or
tags).

l

View and edit
event console
preferences
Unassigned
Event
Management
(Assign
user/Edit event
details)
Assigned Event
Management
(Assign
user/Edit event
details)
View and edit
event console
preferences
Assigned Event
Management
(Assign
user/Edit event
details)

Multi-View enables investigators to drill down to see
more detailed information on associated groups and
monitors, re-run monitors to check if the problem still
exists, generate reports to view performance and
availability over time, and troubleshoot the problem.
Investigator can update events with resolution
progress, enabling follow-up and escalation.
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Persona

Role/Features

SiteScope
Administrator

Role: Configures and manages the Event Console. This
includes configuring settings for live and historical
events, LDAP server, and special logging configuration,
creating event filters, and defining alert actions that
create an event in the system. Also defines users and
roles, and assigns the required Event Console
permissions.

Recommended
Permissions
All Event Console
permissions

Features: Administrator can:
l

l

Track event resolution results and analyze statistics.
View historical events; this is useful for analyzing
event history, hidden patterns, and the time it took to
resolve events by comparing the event creation time
with the closing time (closing time is available in the
event history log file only).

Historical Event Log Files
You can get information on all closed (non-active) events that were triggered from Event Console alert
actions from the Event History view in the Event Console, or from the event history log files, event_
console_history.log. Each closed event is written to the log, starting with the event closing time, and
followed by the rest of the information that is displayed in the Event Console view and Event Details
dialog box.
SiteScope creates a new log each day to record all events that were closed during that 24 hour period.
The logs are in the format: event_console_history<YYYY_MM_dd>.log. SiteScope retains a
maximum of 40 event history log files. Files older than the log retention period are automatically
deleted.
The log files are available from <SiteScope root directory>\logs, as well as from the Log Files page
(Server Statistics > Log Files).
Events are written to the log (and to the Event History view in the Event Console) when:
1. An event is manually closed by the user.
2. The Submit close key condition check box is selected in the console event mapping (either in a
customized mapping created by user, or in the Default Console Event Mapping template, where it
is selected by default). When selected, a close key pattern of a new event is compared to the keys
of all previous events, and events with keys which match the pattern are automatically closed. For
details, see "New/Edit Event Mappings Dialog Box - General Tab" on page 551.
3. The user configures the Log only setting in the console event mapping (either in the Default
Console Event Mapping template, or any other customized mapping created by user) to:
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n

True. All events are sent or written directly to history as closed events (they are available in the
history log and Event History view).

n

True for normal severity (the default setting). Events triggered for a monitor in normal
severity (fired when the monitor status changes to Good), are written directly to history as
closed events (they are available in the history log and Event History view).

4. An event is automatically closed by SiteScope. This can occur when:
n

The maximum number of live events that can be stored on the server has been reached. When
this occurs, the message (CLOSED BY AUTOMATIC PURGE) is added to the event title.

n

The monitor on which the event was triggered is deleted. When this occurs, the message
(CLOSED BY MONITOR DELETION) is added to the event title.

Capacity Recommendations and Best Practices
The Event Console is designed to display meaningful events on your monitored systems.
The SiteScope server is certified to handle a constant load of up to 40 events per minute and to display
up to 5000 events in the Live Console or Event History views.
The recommended best practice is to configure the alert system to send alerts only on a monitor status
change and not on every monitor run. This should optimize the number of open events in the console,
making it easier for the relevant teams/users to manage and handle them.
You can configure the number of live events that are displayed in the Event Console from Preferences
> Infrastructure preferences > Event Console Settings > Maximum number of live events. The
default setting is 1000 events, with a maximum setting of 5000. Once this limit is reached, the oldest
events are automatically closed and displayed in the Event History view, and are written to the event_
console_history.log with (CLOSED BY AUTOMATIC PURGE) message, which enables you to
identify these events.
You can also configure the maximum number of historical events that can be displayed (Maximum
number of historical events), and the number of previous hours of historical events to display
(Number of previous hours of historical events to retrieve) in the Event History view. By default,
the Event History view can display up to 1000 historical events from the last 48 hours (with a maximum
display of 5000 events from the last 168 hours). Once the display limit is reached, the oldest events are
removed from the Event History view, but they are still available in the event_console_history.log
files (events are never removed from a log file). The number of history files saved is 40 (one per day).
When the 41st day is reached, the oldest file is deleted.
Note:
l

You can configure the number of live events that are displayed in the Event Console from
Preferences > Infrastructure preferences > Event Console Settings > Maximum number
of live events. The default setting is 1000 events, with a maximum setting of 5000. Once this
limit is reached, the oldest events are automatically closed and displayed in the Event History
view, and are written to the event_console_history.log with (CLOSED BY AUTOMATIC
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PURGE) message enabling you to identify these events.
l

You can also configure the maximum number of historical events that can be displayed
(Maximum number of historical events), and the number of previous hours of historical
events to display (Number of previous hours of historical events to retrieve) in the Event
History view. By default, the Event History view can display up to 1000 historical events from
the last 48 hours (with a maximum of displaying 5000 events from the last 168 hours).
Once the display limit is reached, events are no longer displayed in the Event History view, but
they are still available in the event_console_history.log files (events are never removed from
the log files). You can configure the number of logs files that can be saved via the
log4j.properties file.

Tasks
This section includes:
l

"How to Configure and Manage the Event Console (SiteScope Administrator)" below

l

"How to Assign Events (Dispatcher/NOC Operator)" on page 1072

l

"How to Investigate and Resolve Events (Application Support Team)" on page 1073

l

"How to View Historical Events (Administrator/Application Support Team)" on page 1075

l

"How to Manage Events Displayed in the Event Console (Any user)" on page 1075

How to Configure and Manage the Event Console (SiteScope Administrator)
1. Define users and user roles, and assign the required Event Console permissions
Create users and user roles for the different user groups that need to work with the Event Console,
and assign them Event Console permissions as required, as described in "What are the User
Roles and Required Permissions?" on page 1065.
For details on user permissions, see "User Management Preferences" on page 732.
2. Configure the Event Console settings
Select Preferences > Infrastructure Preferences > Event Console Settings, and configure the
following settings (as required):
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Live/Historical Event settings:
n

Enable/disable new triggered events being displayed in the Event Console. When the setting is
cleared, no new events are triggered from Event Console alert actions.

n

Set the maximum number of live events that can be stored on the server and displayed in Live
Events view. This value cannot exceed 5000 (the default value is 1000). Once this limit is
reached, the oldest events are automatically closed and displayed in the Event History view,
and are written to the event_console_history.log with (CLOSED BY AUTOMATIC PURGE)
message enabling you to identify these events.

n

Set the maximum number of historical events that can be retrieved from the server logs for
display in the Event History view. This value cannot exceed 5000 (the default value is 1000).
Once the display limit is reached, the oldest events are removed from the Event History view,
but they are still available in the event_console_history.log files (events are never removed
from a log file). The number of history files saved is 40 (one per day). When the 41st day is
reached, the oldest file is deleted.

n

Set the number of previous hours of historical events to retrieve from the server logs for display
in the Event History view. This value cannot exceed 168 hours, equivalent to 1 week (the
default value is 48 hours).

LDAP settings (if SiteScope is integrated with an LDAP server):
n

You can define the maximum number of LDAP users to retrieve from the LDAP server when
loading the users list to the Event Console. By default, the LDAP server returns up to 400
results (it can be configured to retrieve a maximum of 1000). If you have an Active Directory
domain that exceeds this number of users, you cannot assign an event to an LDAP user that is
not listed in the results retrieved from the LDAP server, even if you manually enter the email
address of the user.

Event Console errors:
n

Enable/disable errors being sent from the Event Console user interface to the log file on the
SiteScope server.

For setting details, see "Event Console Settings" on page 649.
3. Configure Event Console alert actions that, when triggered, create an event in the system
a. To create an alert for a monitor or group of monitors, right-click the monitor/group and select
New > Alert.
b. In the New Alert dialog box:
i. Enter a name for the alert, and select the targets to trigger the alert in the Alert Targets
panel.
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ii. In the Alert Actions panel, click New Alert Action

, and select Event Console.

For user interface details on the New Alert dialog box, see "New/Edit Alert Dialog Box" on
page 1267.
c. In the Alert Action: Event Console dialog box, perform the following:
i. Enter a name for the alert action.
ii. Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. For details, see "Schedule Preferences" on page 712.
iii. Select an event mapping template for the Event Console.
The template contains the mapping between event attributes names\keys and their
content (user can map run time data in each attribute) that is used for sending events to
the Event Console when an alert is triggered.
You can use the default global mapping for all the events sent to Event Console, or
choose the common event mapping per alert action. For details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 551.
iv. Select the status trigger (see "Status Trigger Panel" on page 1293) and the trigger
frequency ("Trigger Frequency Panel" on page 1294).
d. Save the alert settings.
When an alert is created, the

icon is added next to the specified container in the monitor

tree. The alerts icon
is also displayed in the Alerts Configured column in the SiteScope
Dashboard next to each group or monitor that has one or more configured alerts.
When an alert is triggered, the event corresponding to the triggered alert is displayed in the
Event Console.
Notification of the event is also displayed in the SiteScope Dashboard (the Event Console
alert

icon is displayed in the in Alerts Triggered column).

4. Configure Event Console filters
Create event filters to enable different user groups to focus on only the events they need to view.
Select Preferences > Event Console Preferences, and configure the event filters that determine
which events are displayed in the Event Console. By default, SiteScope includes the predefined
"Assigned to Me" event filter, which shows all events assigned to the logged in SiteScope user.
For task details, see "How to Configure Event Filters" on page 574.
For user interface details, see "New/Edit Event Filter Dialog Box" on page 576.
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How to Assign Events (Dispatcher/NOC Operator)
The event dispatcher can view, organize, and assign events to specific users, and can escalate
unresolved issues.
1. Prerequisites
n

To be able to assign users to events and edit event details, you must be an administrator in
SiteScope, or a user granted the appropriate Event console permissions (granted to all users
by default).

n

A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 732.
2. Open the Event Console (for details, see "To access" on page 1062).
By default, the Live Console view is selected which shows all active unresolved events.
Events are sorted according to the time that they are received; the most recent events are
displayed at the top of the list. We recommend sorting the event list by descending status, so that
events in Error status are assigned first.
3. Assign events to specific users.
a. Double-click an event to open the Event Details dialog box. For details, see "Event Details
Dialog Box" on page 1085.
b. Set the following event attributes as required:
o

Severity: Severity assigned to the selected event. The monitor threshold status for
console events in SiteScope is mapped to the event severity level. The severity can be:
Critical, Major, Minor, Warning, Normal, Unknown. For details, see "Severity Mapping
Preferences Dialog Box" on page 577.

o

Priority: Select a priority to which you want to assign to the event. The values can be
None, Lowest, Low, Medium, High, or Highest.

c. Type a user name to search in the Assigned User field, and select a SiteScope user to which
you want to assign the event. You can only assign an event to a user that appears in the list.
If SiteScope is enabled to use LDAP authentication, the list includes LDAP users that are part
of the contexts supplied in the LDAP configuration and user role. LDAP users have
permissions according to the configuration in their assigned User or User Role.
Note: By default, the LDAP server returns up to 400 results (it can be configured to
retrieve a maximum of 1000). If you have an Active Directory domain that exceeds this
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number of users, you cannot assign an event to an LDAP user that is not listed in the
results retrieved from the LDAP server, even if you manually enter the email address of
the user.
When assigning an event to a non-LDAP user, SiteScope validates the existence of the user.
When assigning an event to an LDAP user, it is up to the dispatcher to check the existence of
the LDAP user, since SiteScope cannot validate LDAP users.
4. Send event notifications.
a. Click the Mail To button to open an email with subject line "SiteScope event notification". The
mail body contains a link to the event in the Event Console, with the corresponding monitor on
which the alert was triggered displayed in Multi-View.
b. Enter the email address of the event recipients (the assigned user and any other users that
you want to be notified).
c. Add any other additional details to the mail, and send the mail.
5. Click Save to save changes made to the event details.
If SiteScope is unable to save the changes, place the cursor over the error
message to resolve the issue.

icon, and use the

6. Periodically check the status of assigned issues.
If an issue remains unresolved for a period that exceeds your determined fix by date, you can raise
the event priority, or escalate the event (for example, send an email to the assigned user's
manager).

How to Investigate and Resolve Events (Application Support Team)
1. Prerequisites
n

To be able to assign users to events and edit event details, you must be an administrator in
SiteScope, or a user granted the appropriate Event console permissions (granted to all users
by default).

n

A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 732.
2. When alerted of an event that has been assigned to you (either by email notification from the
dispatcher, or if you track events assigned to you using an event filter), open the event in the
Event Console.
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n

From the email notification, click the Event Link which opens the specific event in the Event
Console, and displays its associated monitor in Multi-View.

n

You can find events that have been assigned to you in the Event Console by using the
Assigned to Me event filter. This filter displays only those events that have been assigned to
you (the logged in user). You can also use other predefined filters to display events that match
the selected criteria.
For more details on how to filter and organize events, see "How to Manage Events Displayed in
the Event Console (Any user)" on the next page.

3. Double-click the event to open the Event Details dialog box, which provides additional details of
the event. For details, see "Event Details Dialog Box" on page 1085.
4. Change the event State field to In Progress.
5. Investigate the event.
You can investigate the event by:
n

Opening the associated (wired) monitor to get details that can help you isolate the cause of the
problem.

n

Navigating to the specific view or perspective in Multi-View to collect more information for the
current investigation (server-related monitors, location-related monitors).

n

Generating monitor reports to see performance trends.

n

Using the monitor instructions to perform certain actions on the problematic monitor.

6. After investigating the issue and taking the appropriate action, update the lifecycle state.
a. In the Event Details dialog box, update the State field, as appropriate. The values can be
Open, In Progress, Resolved, or Closed.
b. You can also add investigation\resolution comments according to the event state and
investigation results, and make changes to the following fields (as necessary):
o

Title. Description of the event.

o

Description. More detailed or supplementary information that describes the event. This
might include information about what threshold has been crossed (or other trigger
conditions), and the current values.

c. Click Save to save your changes. If you change an event to Closed state, the event is
removed from the Live Console view, and displayed in the Event History view.
7. Periodically check the Event Console for new events that might have been assigned to you, or for
existing events that remain unresolved.
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How to View Historical Events (Administrator/Application Support Team)
You can get information on historical (non-active) events from the Event History view in the Event
Console, or from the log files.
1. In the Event Console, select the Event History view. Historical events are displayed according to
their closing time (the most recently closed event is displayed first).
This view displays closed (non-active) events that were triggered from Event Console alert
actions. By default, the Event History view displays up to 1000 historical events from the last 48
hours.
The administrator can modify the maximum number of historical events that can be displayed, and
the number of previous hours of historical events to display in the Event History view in
Preferences > Infrastructure Preferences > Event Console Settings.
Tip: Event History is also included in the event_console_history.log which is available from
(Server Statistics > Log Files), or from the <SiteScope root directory>\logs directory.
2. You can find and organize historical events in the Event History view by sorting the event order,
using the search, or by using the quick status filter as described in "How to Manage Events
Displayed in the Event Console (Any user)" below.
Each event contains all the information that is displayed in the Event Details dialog box. For
details, see "Event Details Dialog Box" on page 1085.
For details of when historical records are written to the Event History view (and to the log files),
see "Historical Event Log Files" on page 1067.
Note:
n

Event attributes in the Event History view are read-only and cannot be modified.

n

Predefined filters are not available in Event History.

How to Manage Events Displayed in the Event Console (Any user)
1. Prerequisites
n

To be able to assign users to events and edit event details, you must be an administrator in
SiteScope, or a user granted the appropriate Event console permissions (granted to all users
by default).
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n

A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 732.
2. Prerequisites
n

To be able to assign users to events and edit event details, you must be an administrator in
SiteScope, or a user granted the appropriate Event console permissions (granted to all users
by default).

n

A user can view event details for events that are associated with monitors for which they have
Allowed Groups permissions.

For details on user permissions, see "User Management Preferences" on page 732.
3. Open the Event Console (for details, see "To access" on page 1062).
By default, the Live Console view is selected which shows all active unresolved events.
4. The events that are displayed differ according to whether you select Event Console or Ops View
(Event Console and Multi-View):
Event Console:
n

When Event Console
is selected, all active events are displayed by default (up to the
maximum number of events that can be stored on the server; set in Maximum number of live
events). You can filter this list using the quick status filter icons, or by selecting a predefined
filter in the filter selection field. For details on configuring event filters, see "Event Console
Preferences" on page 574.

Ops View:
n

When Ops View
is selected, the Event Console is displayed below Multi-View. The Event
Console displays all events that are associated with monitors for which the user has Allowed
Groups permissions. Events are sorted by default according to the time that they are received;
most recent events are displayed at the top of the list.

n

When you select a monitor or group in Multi-View, the Event Console displays only those
events that are associated with the selected monitor or group.

n

When you click an event in the Event Console, Multi-View changes to display the associated
monitor together with its parent group (the associated monitor is highlighted with a blue border).

n

Navigating between view types in Multi-View (Monitors\Servers\Tags) or filtering in Mullti-View
does not change the displayed events until you select a particular monitor or group in MultiView.
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Note: If a monitor or its associated alerts have been disabled, no new events associated with
that monitor are displayed in the console.
5. You can find or organize active events using the following tools:
n

You can sort the event order by clicking the up/down arrow at the top of the relevant column (to
sort by status, severity, priority, state; other columns can be sorted alphabetically/numerically
if the value is a finite number).

n

You can filter events by clicking the Filter
button and selecting a predefined filter (defined
in "Event Console Preferences" on page 574). When a filter is selected , the filter icon changes
to
. To clear the filter, click the button again and select No Filter. SiteScope includes a
predefined "Assigned to Me" event filter, which displays all events assigned to the logged in
SiteScope user.

n

Click the quick status filter icons
to only show those events that have a
particular status. Click the icon again to clear the filter.

n

You can use Quick Search to search events for a specific name or value in any displayed field.

Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l

Unified Console should not be used in SiteScope for Load Testing installations.

l

The maximum number of Unified Consoles that can be open simultaneously is 20.

l

If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to
login back into SiteScope after the restart if you refreshed Unified Console before SiteScope
(session is invalidated and could not be restored after timeout j_security_check).
Workaround: Close all open SiteScope and Unified Console windows, and then reopen SiteScope
and Unified Console.

Event Console Troubleshooting
l

If you get an unsupported browser message when using Internet Explorer, check that Browser
Mode and Document Mode are set correctly for the browser. We recommend setting Browser
Mode according to the IE version, and Document Mode to standards mode. To check the mode,
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press the F12 key to open the developer tools, and the mode is displayed in the menu bar. Change
the mode settings as required.
l

l

If the Event Console is not displaying events, check the following:
n

Predefined event filters are configured correctly (Preferences > Event Console Preferences).

n

The logged in user has the required permissions to view or manage events (Preferences > User
Management Preferences). For details, see "What are the User Roles and Required
Permissions?" on page 1065.

If the Event Console is missing columns, or the Event Details dialog box is corrupted, reset the
MetaData file as follows:
a. Open the Java monitoring and management instrumentation (JConsole) tool. For details, see
"How to Use the JMX Console" on page 63.
b. In JConsole, click the MBeans tab, and open
co.mercury.sitescope\Web\EventConsole\ConsoleMBean\Operations\resetTableMetada
ta.
c. Click the resetTableMetadata button.

l

If a regular expression does not match any event when using a predefined filter, the full list of events
is displayed in the Event Console. You can use the Regular Expression Tool to check your regular
expressions. For details, see "Regular Expression Tool" on page 134.

Exporting Event Data
By default, active events are written to the persistency file and are automatically included in SiteScope
configuration data when importing/exporting data using the SiteScope Configuration Tool.
Historical events are written to the event_console_history.log files (as described in "Historical Event
Log Files" on page 1067). To include historical events when importing or exporting data, you need to
select Include log files in the Import/Export Configuration option of the SiteScope Configuration Tool.
For details on using the SiteScope Configuration Tool, see the SiteScope Deployment Guide
(<SiteScope root directory>\sisdocs\doc_lib\Get_Documentation.htm).

Event Console Error Log Files
You can get information on Event Console errors, client-side and server-side, in the following log files.
The log files are available from <SiteScope root directory>\logs, as well as from the Log Files page
(Server Statistics > Log Files). The event_console.log must first be activated in order to make it
available in the Log Files page (as described below).

HP SiteScope (11.31)

Page 1078 of 1395

Using SiteScope
Chapter 95: Event Console

Log File

Description

event_
console_
ui.log

Lists all error messages that were sent from the Event Console user interface to the
event_console_ui.log on the SiteScope server. For example, it includes "not
authorized" errors when the user does not have the required permissions.
Since SiteScope typically has multiple users, you can identify which error is sent for a
particular user by the error message which starts with <User display name>
<session ID> (such as, SiteScope Administrator
DC8AF1DC325C3E745646AD6FC5C7A23C).
The name of the current log is event_console_ui.log. When the current log reaches
its size limit (by default, 1000 KB), it is closed and a new log is created. Older logs are
named event_console_ui.log.1, event_console_ui.log.2, and so forth. The higher
the number concatenated to the name, the older the log. Parameters for this log are
configured in the log4j.properties file.

event_
Lists all server-side errors relating to the Event Console. To activate the log (and
console.log make it available in the Log Files page), you must add the appender to the
log4j.properties file (by default, the log is opened to debug level). Logs level are
configurable.
To activate the log:
1. Open the log4j.properties.debug file in the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava folder.
2. Search for the "Event Console Appenders and Loggers" section, and copy the
relevant lines (as explained in the log) to the log4j.properties file.
3. Save the changes. A SiteScope restart is not required.

Event Console User Interface
The Event Console enables you to display and manage live and historic SiteScope events from a
centralized location.
To access

l

l
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From the SiteScope Dashboard: In the Monitors context, click the Dashboard
tab, and then click the Unified Console button.
Open a Web browser, and enter the following URL:
http://<server_name>:<port>/SiteScope/WebMain#/eventconsole (for
Event Console only) or
http://<server_name>:<port>/SiteScope/WebMain (for Event Console and
Multi-View).
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Important
information

l

l

To be able to manage events, you must be an administrator in SiteScope, or a
user granted the appropriate Event console permissions (granted to all users by
default). For details on user permissions, see "User Management Preferences" on
page 732.
A user can view event details for events that are associated with monitors for
which they have Allowed Groups permissions. This applies to live and historical
events.

Event Console:
l

l

l

When Event Console
is selected, all active events are displayed by default (up
to the maximum number of events that can be stored on the server; set in
Maximum number of live events). You can filter this list using the quick status
filter icons, or by selecting a predefined filter in the filter selection field. Event
filters are configured in "Event Console Preferences" on page 574.
Double-click an event to display additional details of the selected event, and to
update the event details. For details, see "Event Details Dialog Box" on page
1085.
Events are sorted by default according to the time that they are received; the most
recent events are displayed at the top of the list.

Ops View:
l

l

l

l

See also

When Ops View
is selected, the Event Console is displayed below Multi-View.
The Event Console displays all events that are associated with monitors for which
the user has Allowed Groups permissions. Events are sorted by default
according to the time that they are received; most recent events are displayed at
the top of the list.
When you select a monitor or group in Multi-View, the Event Console displays
only those events that are associated with the selected monitor or group.
When you click an event in the Event Console, Multi-View changes to display the
associated monitor together with its parent group (the associated monitor is
highlighted with a blue border).
Navigating between view types in Multi-View (Monitors\Servers\Tags) or filtering
in Mullti-View does not change the displayed events until you select a particular
monitor or group in Multi-View.

l

"Event Console" on page 1062

l

"Event Console Preferences" on page 574

l

"Multi-View" on page 1089
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Event Console - Live Console and Event History View
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Tabs
Live Console View

This view displays the list of active (non-closed) events that were
triggered from Event Console alert actions. The number of events
displayed is determined by the Maximum number of live events
setting in Preferences > Infrastructure Preferences > Event
Console Settings. When this number is reached, the oldest event is
automatically closed, and removed from the Live Console view.
Discarded events are displayed in the Event History view and are
written to the event_console_history.log.
The number of events currently displayed in the Live Console is
shown in parenthesis in the view header when this view is selected.
Note that this number might not reflect the total number of live events
if a filter has been applied to the view.
Specific event attributes for live events can be modified in the Event
Details dialog box. For details, see "Event Details Dialog Box" on
page 1085.
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UI Element

Description

Event History View

This view displays the list of closed (non-active) events that were
triggered from Event Console alert actions. By default, the Event
History view displays historical events from the last 48 hours. You
can modify the number of previous hours of historical events to
display in the Event History view, and the maximum number of
historical events that can be displayed, in Preferences >
Infrastructure Preferences > Event Console Settings.
The number of events currently displayed in the Event History is
shown in parenthesis in the view header when this view is selected.
Note that this number might not reflect the total number of events in
the Event History view if a filter has been applied to the view.
Records are displayed in the Event History view when:
1. An event is manually closed by the user.
2. An event is automatically closed by SiteScope after the
maximum number of live events that can be stored on the server
has been reached.
3. The problem was reported in another event. A typical example is
where the same event occurs in the next monitor run (and alert
trigger frequency is set to every time the event occurs). In this
scenario, SiteScope closes the previous instance of the reported
event.
Note:
l

l

l

Event attributes in the Event History view are read-only and
cannot be updated.
Historical events are not refreshable; they are retrieved on demand
when switching to Event History view.
Event History is also included in the event_console_history.log
which is available from (Server Statistics > Log Files), or from
the <SiteScope root directory>\logs directory.

Event Console Toolbar
Quick Status Filter. Click the quick status filter icons to only show
those events that have a particular status. Click the icon again to clear
the filter. By default, all active events are displayed.
Quick Search. Enables you to search events for a specific name or
value in any displayed field. Type a string that you want to search for
in the Quick Search box. All events with text that match the search
string are displayed in the Event Console.
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UI Element

Description
Select Columns Select the columns to display in the Event Console.
By default, Status, Time,Title, Host, and State are displayed.
The other columns available for display are: Severity, Priority,
Assigned User, Category, Sub Category, Description, Key, Close
Key.
Filter Events. (Available in Live Console view only) Opens the Event
Filter selector from which you can select a predefined event filter. By
default, SiteScope includes the predefined "Assigned to Me" event
filter, which displays all events assigned to the logged in SiteScope
user.
Additional filters can be defined in Preferences > Event Console
Preferences > Event Filters. For details on defining a filter, see
"How to Configure Event Filters" on page 574.
When a filter is selected, the icon changes color to blue. To clear the
filter, select <No Filter> (icon changes to gray).

Table Columns
Status

Displays the monitor threshold status in SiteScope that corresponds
to the console event.
The following icons indicate event status: Error, Warning, and Good.

Time

The date and time when the event occurred in the monitored
environment.

Title

Description of the event.
Default value: Console Event was triggered due to alert
'<<alertName>>' being fired on monitor '<<fullMonitorName>>'

Host

The target monitoring host related to the event.

State

The state used to describe the lifecycle state of the event.
The values can be Open, In progress, Resolved, or Closed.

Priority

Importance assigned to the selected event by the dispatcher.
The values can be None, Lowest, Low, Medium, High, or Highest.
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UI Element

Description

Severity

Severity of the occurrence related to the event. Severity mappings
correlate the monitor threshold status in SiteScope to the severity
level in console events.
The default event severity mappings can be changed in the Severity
Mapping Preferences dialog box in Preferences > Event Console
Preferences > Default Settings > Edit Severity Settings.For
details, see "Severity Mapping Preferences Dialog Box" on page 577.
The severity values can be:
l

Critical (by default, this corresponds to monitors in Error status)

l

Major

l

Minor (by default, this corresponds to monitors in Warning status)

l

Warning

l

Normal (by default, this corresponds to monitors in Good status)

l

Unknown (by default, this corresponds to monitors in Unavailable
status)

Assigned User

User who is responsible for solving the issue.

Category

The monitor type to which the event belongs (for example, Ping, CPU).

Sub Category

The monitor group path, such as SiteScope\Test\CPU Utilization
on SiteScope Server.

Description

More detailed or supplementing information (in addition to the “Title”)
that describes the event. This might include information about what
threshold has been crossed (or other trigger conditions), and the
current values.

Key

A unique string representing the type of event that occurred. Two
events can have the same key if both events represent the same
situation in the environment (the two events are duplicates). This field
is not editable.

Close Key

Enables the event that is sent to automatically close all the events
whose key attribute matches this expression.
Note: SiteScope always adds "<*>" to the end of your close key
pattern.
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Event Details Dialog Box
The Event Details dialog box displays additional details of the selected event, and enables you to
update the Severity, Title, State, Priority, Assigned User, and Description attributes of the event.
To access

1. Open theUnified Console (http://<server_
name>:<port>/SiteScope/WebMain), and select Ops view
Console and Multi-View, or Event Console

to display Event

to display Event Console only.

2. Double-click an event in the Event Console to open the Event Details dialog box.
Important
information

l

l

l

l

Relevant
tasks
See also

To be able to manage events (assign users to events, edit event details), you
must be an administrator in SiteScope, or a user granted the appropriate Event
console permissions (granted to all users by default). For details on user
permissions, see "User Management Preferences" on page 732.
A user can view event details for events that are associated with monitors for
which they have Allowed Groups permissions.
For default values (and examples) used in console event attributes, see "New/Edit
Event Mappings Dialog Box - General Tab" on page 551.
If there is an error in any of the editable fields, SiteScope is unable to save the
changes. Place the cursor over the error icon, and use the message to help
resolve the issue.

l

"Event Console" on page 1062

l

"Event Console Preferences" on page 574

"Multi-View" on page 1089
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Event Details
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description
Opens an email with subject line "SiteScope event notification". The
email contains a link to the event in the Event Console. The link opens
the Unified Console, and displays the event in the Event Console,
together with the corresponding monitor on which the event was
triggered (and the monitor's parent group) displayed in Multi-View.
Enter the email address of the event recipients (the assigned user and
any other users that you want to be notified), add any other additional
details to the mail, and send the mail.

Status

Displays the monitor threshold status in SiteScope that corresponds to
the console event. The status can be: Error, Warning, Good.
The event status is also indicated by the following icons that are
displayed on the left side of the dialog box:

Severity

Severity assigned to the selected event. The severity can be: Critical,
Major, Minor, Warning, Normal, Unknown. This field is editable.
Note: The monitor threshold status for console events in SiteScope is
mapped to the event severity. The default event severity mappings can
be changed in the Severity Mapping Preferences dialog box in
Preferences > Event Console Preferences > Default Settings >
Edit Severity Settings. For details, see "Severity Mapping
Preferences Dialog Box" on page 577.

Time

The date and time when the event occurred in the monitored
environment.

Title

Description of the event. This field is editable.

Host

The target monitoring host related to the event.
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UI Element

Description

State

The point in the event lifecycle state that the selected event has
reached. This field is editable by selecting one of the following states:
l

l

l

l

Priority

Open. Event is identified for investigation of the problems that
caused the event. It is either not assigned to a user or assigned but
not yet being worked on.
In Progress. Assigned user has started working on the
investigation of the event's underlying problems. The name of the
assigned user appears in the User column.
Resolved. Investigation into the selected event's underlying
problem is found and fixed.
Closed. Event is removed from the list of active events.

Priority assigned to the selected event. This field is editable.
The values can be None, Lowest, Low, Medium, High, or Highest.

Assigned User

Name of the user who is responsible for solving the event's underlying
problem. This field is editable.
To assign a user, type the name of the SiteScope user to which you
want to assign the event in the search box. If SiteScope is enabled to
use LDAP authentication, the list includes LDAP users that are part of
the contexts supplied in the LDAP configuration and user role.
Note: By default, the LDAP server returns 400 results (it can be
configured to retrieve a maximum of 1000). If you have an Active
Directory domain that exceeds this number of users, you cannot assign
an event to an LDAP user that was not listed in the results retrieved
from the LDAP server, even if you manually enter the email address of
the user.
Click the Mail To button to send email notification.

Category

The monitor type to which the event belongs (for example, Ping, CPU).

Sub Category

The monitor group path, such as SiteScope\Test\CPU Utilization
on SiteScope Server.

Description

More detailed or supplementing information (in addition to the “Title”)
that describes the event. This might include information about what
threshold has been crossed and the current values. This field is
editable.

Key

A unique string representing the type of event that occurred. Two
events can have the same key if both events represent the same
situation in the environment (the two events are duplicates).
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UI Element

Description

Close Key

Enables the event that is sent to automatically close all the events
whose key attribute matches this expression. If no close key was
selected, this event will not close other events.

Custom Attributes
Name

Value

Service id

Enables customizing the service name that is sent from SiteScope
events to HPOM by entering the value of the monitor service ID. This is
useful for relating the SiteScope monitor with the HPOM Service
Name.

SiteScopeDrilldownURL Opens the monitor in the SiteScope Dashboard view from which the
event was triggered, enabling you to troubleshoot the issue.
Note: If there are several Network Interface Controllers (NIC) on a
SiteScope server and you want to specify which NIC to use in
SiteScopeDrilldownURL, you can specify the host of the appropriate
NIC by adding _configuredLocalhostName=<host> to the
<SiteScope root directory>\groups\ master.config file.
customerId

The customer ID (1 by default).

Unified Console URL

Opens the Event Console in the Unified Console.
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Multi-View
simplifies the management of large, distributed environments by providing a unified view
into the performance of everything that is being monitored in your IT infrastructure. It fully utilizes the
screen to display the near-real time status of all groups and monitors without losing the hierarchical
relationship between the data. Multi-View is ideal for displaying enterprise-wide monitoring status in a
network operations center.
Using Multi-View, you can group objects in various different ways to fit the perspective of different
personas. For example, you can use it to display all SiteScope groups and monitors in a hierarchical
tree map; display monitors grouped by target remote server; or display monitors grouped by custom
search/filter tags. You can also drill down to see more detailed information on groups and monitors to
facilitate problem diagnosis and troubleshoot server related issues.
You can also use Multi-View side-by-side with the Event Console to display and manage all SiteScope
events from a centralized location.
Example: Multi-View showing the status of all groups and monitors at the root level

Tip: You can view guided and narrated demonstrations on using Multi-View, using Multi-View and
Event Console, and How to Manage and Track Monitors in Multi-View Using Filters and Tags.
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To access
Multi-View is available in the Unified Console. You can access the Unified Console directly from a
browser or from the SiteScope Dashboard.
l

l

To access the Unified Console from a browser, enter the URL in a Web browser in the format:
n

http://<server_name>:<port>/SiteScope/WebMain#/multiview (opens the Unified
Console, with focus on Multi-View)

n

http://<server_name>:<port>/SiteScope/WebMain (opens the Unified Console, with focus
on Multi-View and Event Console)

To access the Unified Console from the SiteScope Dashboard, select the Monitors context, click
the Dashboard tab, and then click the Unified Console button. The Unified Console opens in Ops
View, which displays both Multi-View and the Event Console. To display only Multi-View, click
Multi-View

.

Tip: You can have Multi-View open and focus on:
n

A particular group or monitor selected in the monitor tree. To do so, select the required group
or monitor you want to view, and then click Unified Console.

n

SiteScope objects that meet the criteria that you define in a filter, or on a selected object in
the filter. To do so, select the required filter in the context toolbar of the monitor tree, or an
object in the filtered objects displayed in the monitor tree, and then click Unified Console.

Learn About
This section includes:
l

"Multi-View Overview" below

l

"Supported Browsers and Screen Resolutions" on the next page

l

"Viewing Categories" on page 1092

l

"Configuring Multi-View Settings" on page 1094

Multi-View Overview
Benefits of using Multi-View include:
l

Displays the near-real time status of all SiteScope monitors and groups in a single view, enabling
you to more easily understand the overall impact of problems in your IT infrastructure. Groups and
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monitors are color-coded to provide quick, at-a-glance information on performance status.
l

l

l

l

l

l

l

Displays monitors from different perspectives: grouped by target server view, tags view, and the
standard SiteScope hierarchy perspective. For example, application owners might want to see
SiteScope objects grouped by applications, while system administrators might prefer to have it
grouped by servers. Both personas might need to switch between the different dimensions.
Ability to work side-by-side with the Event Console—a central view for all notification messages
about the performance of your applications and servers—to accelerate your ability to manage,
identify, and resolve performance issues. For details, see "Event Console" on page 1062.
Fully utilizes the screen to display the status of all groups and monitors. Multi-View is fully
supported on big and small screens, making it is ideal for viewing monitor data in a network
operations center. It is also supported on iPad and Android tablets.
Provides filtering and drill down to view more detailed information on groups and monitors, enabling
you to focus only on those groups and monitors you want to view.
Enables you to isolate the root cause of problems and perform troubleshooting actions to mitigate
issues.
Multi-View is HTML-based. It is supported in additional browsers, including Chrome and Safari, and
it runs in web browsers. You can access Multi-View directly using the
http://<SiteScope>:8080/SiteScope/MultiView link. For the list of supported browsers, see
"Supported Browsers and Screen Resolutions" below.
Multi-View is supported in MyBSM when SiteScope is connected to a BSM server, enabling you to
consolidate multiple SiteScope views. The predefined MyBSM Multi-View page also displays the
status of the SiteScope profile CI of all SiteScope servers connected to the BSM system. This
enables you to access and troubleshoot SiteScope without having to drill down to the SiteScope
instance.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices
The following browsers are supported:
l

Google Chrome browsers (latest certified version): 42.0.2311.90 m.

l

Mozilla Firefox (latest certified version): 38 ESR

l

Safari (latest certified version): 8.0 for Mac

l

Internet Explorer 9, 10, 11
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Note:
n

n

l

Internet Explorer 9 is supported on client machines with the following limitations:
o

It is not supported on Microsoft Windows 7 N Edition.

o

It is not supported on Microsoft Windows Server 2008.

We recommend setting Browser Mode according to the IE version, and Document Mode
to standards mode.

Internet Explorer 8 (in MyBSM only)
Note: While Internet Explorer 8 can be used to access the Multi-View Page in MyBSM, it is no
longer officially supported, and we recommend switching to one of the supported browsers,
since the Event Console and the tab functionality in the Unified Console will not work.

The following mobile devices are supported:
l

iPad 3 with Safari (iOS 7 with latest updates)

l

Android tablet with Chrome 34.0.1847 (Full HD display)

Default Screen Resolution
l

Large Desktop – 1680 x 1050 pixels

l

Laptop – 1280 x 800 pixels

l

iPad – 1024 x 768 pixels

Viewing Categories
There are various options for displaying and grouping objects in Multi-View.
These views also enable the same persona to switch between views and see SiteScope data from a
different perspective for problem analysis.
l

Monitors View
Enables displaying all SiteScope groups and monitors in a flattened view as a set of nested
rectangles. The hierarchical relationship between the data is retained, enabling drill down to different
levels.
For task details, see "How to Select and Configure a View" on page 1095.
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l

Servers View
The servers view provides a new grouping option to fit the perspective of different personas viewing
SiteScope data. It enables you to display SiteScope monitors grouped by target servers. This is
useful, for example, for system administrators who might prefer to view monitors grouped by remote
servers.
Note: The Servers view displays only those remote servers that are displayed in the remote
server tree. It does not display the SiteScope server, non-persistence servers used for
URL/Ping monitors, or browsable servers.
For task details, see "How to Select and Configure a View" on page 1095.

l

Tags View
The tags view provides a new grouping option to fit the perspective of different personas viewing
SiteScope data. It enables you to group SiteScope monitors based on monitor tags; each monitor is
displayed under a new group according to its tags. This lets you see the status of your system in
several ways. You can drill down on tags or tag values to display only the monitors to which these
tags or tag values have been assigned.
For example, you can tag monitors by geographic location, application, operating system,
environment type (test/development), and so forth. This provides maximum flexibility for
customizing your viewing perspective. For task details, see "How to Select and Configure a View"
on page 1095 and "How to Assign Custom Search/Filter Tags and View Monitors in the Tags View"
on page 1097.
To tag monitors, you must first define the tags and their values in Preferences > Search/Filter
Tags, and assign these tags to one or more monitors in the monitor tree. When the Tags view is
selected from the drop-down list, only monitors with the selected tag assigned to them are
displayed. For details on creating search/filter tags and assigning them to SiteScope objects, see
"How to Filter the View Using Search/Filter Tags" on page 76.
Note:

l

n

The Tags view is only available to an administrator in SiteScope, or a user granted View
tags permissions. For details on user permissions, see "User Management Preferences" on
page 732.

n

If you choose to display all tags, the view may contain the same monitors more than once if
the monitor has been assigned multiple tags.

Health Monitors
Enables displaying the SiteScope Health group of monitors that are deployed to check the
performance and availability of SiteScope itself. The SiteScope server name and health status to
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left of the SiteScope server name are always displayed in the Multi-View header panel. The icon
shows the status of the SiteScope Health group based on the worst child (taking the worst status of
all health monitors in the group).
You can link to the SiteScope Health group from the SiteScope server name link, or from the
SiteScope Health filter in the Monitors view.
For task details, see "How to View SiteScope Server Health in Multi-View" on page 1098.

Configuring Multi-View Settings
l

l

You can configure the following Multi-View properties in the Multi-View Settings panel of
Infrastructure Preferences. For details, see "Multi-View Settings" on page 638. Changing any of
these settings requires a SiteScope restart.
n

Configuration change refresh frequency (seconds). Amount of time to wait between
refreshing the configuration changes in Multi-View. Configuration data includes adding, deleting,
or moving a group or monitor, and changing a group or monitor name. The default value is 60
seconds (this is also the minimum value).

n

Runtime data refresh frequency (seconds). Amount of time to wait between refreshing the
runtime data in Multi-View. Runtime data includes monitor or group status changes and
enable/disable information. The default value is 5 seconds (this is also the minimum value).

n

Maximum number of Multi-Views. Once the maximum number of open Multi-Views has been
reached, a popup window informs the user, and no additional Multi-Views can be opened. The
default value is 20 (this value must be between 1 and 20). This number is dependent on the
caching frequency; increasing the cache clearing interval reduces the number of views that can
be open simultaneously).

n

Interval before clearing view cache since last used (seconds). Amount of time, in seconds,
to wait since a view was last used, before clearing the cache. This number impacts the number
of Multi-Views that can be open simultaneously; increasing the cache clearing interval reduces
the number of views that can be open simultaneously. The default value is 120 seconds (the
minimum value is 5).

You can configure a mail alert to be sent with a link to the Multi-View URL by adding the
<multiViewUrl> variable to the mail template. For details, see "Configure SiteScope Alerts" on
page 1243.
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Tasks
This section includes:
l

"How to Select and Configure a View" below

l

"How to Assign Custom Search/Filter Tags and View Monitors in the Tags View" on page 1097

l

"How to View SiteScope Server Health in Multi-View" on page 1098

l

"How to Diagnose and Troubleshoot Problems in Multi-View" on page 1098

l

"How to Display Your Corporate Name or Logo in the Multi-View Header" on page 1100

l

"How to Get a URL That Links Directly to a Monitor or Group in Multi-View" on page 1100

How to Select and Configure a View
This task describes how to select and configure a view in Multi-View.
1. Prerequisites.
n

The groups displayed in the SiteScope Multi-View are only those that can be accessed by the
user profile logged on to SiteScope. Similarly, the actions that can be performed on groups and
monitors are dependent on the action permissions assigned to the user account. For details on
user accounts, see "User Management Preferences" on page 732.

n

To use the Tags view, certain prerequisites are required. For details, see "How to Assign
Custom Search/Filter Tags and View Monitors in the Tags View" on page 1097.

2. Open Multi-View (see "To access" on page 1090).
Note: If you opened Multi-View from the SiteScope Dashboard having selected a group or
monitor in the monitor tree, Multi-View focuses on the selected group or monitor.
3. To select or change the view, click the views drop-down list on the upper left side of the Multi-View
window, and select one of the following view categories:
n

Monitors: Displays SiteScope groups and monitors in a flattened view as a set of nested
rectangles. The hierarchical relationship between the data is retained, enabling drill down/up to
different levels.

n

Servers. Displays SiteScope monitors grouped by target server. This provides a new grouping
option to fit the perspective of different personas viewing SiteScope data. It also enables
viewing SiteScope data from a different perspective for problem analysis.
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n

Tags. Displays SiteScope monitors grouped by custom search/filter tags. This provides a new
grouping option to fit the perspective of different personas viewing SiteScope data. It also
enables viewing SiteScope data from a different perspective for problem analysis.

Click Apply to apply the selected view option.
4. To filter objects in Multi-View using filters pre-defined in the SiteScope monitor tree, click the
filters drop-down list (to the right of the views drop-down), and select a filter. The filters list
displays the following:
n

All Monitors. Displays all the groups and monitors that are available in the SiteScope monitor
tree.
Tip: To enhance performance and to maximize the benefits of using Multi-View in loaded
configurations, we recommend that you select a filter, or drill down to those groups and
monitors you want to view instead of displaying all SiteScope objects.

n

<Filter name>. Filters defined in the SiteScope monitor tree (if any). Filters can be defined with
different criteria that can be applied for viewing the data from different user perspectives,
including filtering by monitor name, monitor type, target server, tags, enabled/disabled status of
monitors or alerts, and BSM reporting settings. For details on defining a filter in the monitor tree,
see "Filter Objects in the SiteScope View" on page 74.
Note: When a new filter is created in the monitor tree, it is only visible in Multi-View after
refreshing the view (F5).

n

SiteScope Health. The SiteScope health group of monitors display information about the
performance and availability of SiteScope itself. For details, see "SiteScope Server Health
Monitors" on page 1149.

Click Apply to apply the selected filter option.
5. To display SiteScope groups and monitors that meet a particular status criteria, click the status
drop-down list (to the right of the filters drop-down), and select the status criteria to display: Error,
Error and Warning, Disabled, Warning, No Data, Good and Warning, or Good. For details,
see "Multi-View Toolbar" on page 1101.
Click Apply to apply the selected status criteria.
Tip: You can apply the status filter to a filter selected in the filters drop-down to view only
those monitors that meet the filter criteria and have a particular status.
6. You can drill down to display a selected subgroup within a multi-level context by clicking the
subgroup in the tree map or the appropriate subgroup link in the breadcrumbs. Only the selected
subgroup and its components are displayed in the tree map.
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You can return to previous levels using the breadcrumbs.
Tip: If the Event Console is displayed, you can see all events associated with the selected
monitors or groups.
7. Place the cursor over a group or monitor which you want to view or troubleshoot, and click the
information
icon to open the Group/Monitor Details dialog box. For details, see the "Monitor
Details Dialog Box" on page 1108 or "Group Details Dialog Box" on page 1111.
You can use this information to help diagnose the root cause of problems and perform
troubleshooting, as described in "How to Diagnose and Troubleshoot Problems in Multi-View" on
the next page.
Note: You can modify Multi-View settings from Preferences > Infrastructure Preferences >
Multi-View Settings. For details of the configuration settings, see "Configuring Multi-View
Settings" on page 1094.

How to Assign Custom Search/Filter Tags and View Monitors in the Tags View
Tip: You can view a guided and narrated demonstration on managing and tracking monitors using
filters and tags on YouTube: http://hpsw.co/r5D4GxA.
1. Prerequisites.
The Tags view is available only to an administrator in SiteScope, or a user granted View Tag
permissions. For details on user permissions, see "User Management Preferences" on page 732.
2. Create a search/filter tag.
In SiteScope Preference > Search/Filter Tags, create custom search/filter tags for use in
filtering the display. You define the tags and their values. For example, you define a tag called
Application with the possible values of HR, CRM, and Online Banking.
Note: To be able to add, edit, or delete search/filter tags and tag values, you must be an
administrator in SiteScope, or a user granted Add, edit or delete tags permissions.
3. Assign the search/filter tag to one or more SiteScope monitors.
a. In the SiteScope monitor tree, select the monitor you want to tag.
b. In the Properties tab, expand the Search/Filter Tags panel, and assign a tag and tag values
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to the monitor.
c. Repeat for all monitors to which you want to assign this tag and value.
4. Open Multi-View, and select Tags in the views drop-down list.
5. You can drill down on tags or tag values to display only the monitors to which the selected tag item
has been assigned.
For example, you can filter for all monitors that have the Application tag with the CRM tag value
assigned to them.
Note:
n

The tag group status is based on the worst child rule (taking the worst status of all
monitors in the tag group). You cannot drill down to group details from this icon.

n

The same monitor can be displayed more than once in the tags view if the monitor has
been assigned multiple tags, and those tags are selected in the filter.

How to View SiteScope Server Health in Multi-View
1. Open Multi-View (see "To access" on page 1090).
2. Click the SiteScope server name link at the upper part of the window. The icon to left of the name
shows the status of the SiteScope Health group based on the worst child (taking the worst status
of all health monitors in the group).
(The SiteScope Health monitors can also be accessed from the filters drop-down list in the
Monitors view.)
For details on Health Monitors, see "SiteScope Server Health Monitors" on page 1149.
Note: To return to the monitors and group tree map, select All Monitors in the filters dropdown list and click Apply.
3. Drill down to view problematic monitors as discussed in "How to Diagnose and Troubleshoot
Problems in Multi-View" below.

How to Diagnose and Troubleshoot Problems in Multi-View
You can diagnose the root cause of problems and perform troubleshooting from Multi-View.
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1. Identify the metrics in error
Place the cursor over a monitor which you want to view or troubleshoot, and click the information
icon to open the Monitor Details dialog box. Click the Metrics tab to view the list of monitor
metrics with error or warning status.
2. Rerun the monitor(s) to check if the problem still exists
In the Group/Monitor Details dialog box, click Run Now to verify the problem still exists. This
action reruns the monitor or the monitors in group.
3. Generate a report to view performance and availability over time
In the Details tab, click Generate Report to generate a report for the group/monitor. You can use
this report to help determine the nature of the problem, and to see how long the group or monitor
has been in error.
4. Disable the monitor or alerts to prevent additional notifications being triggered
Depending on the diagnosis, you can disable the monitor or monitors in group, or disable alerts
associated with the monitor or group and continue to use the monitor.
To assist in troubleshooting, you can check the alert history for the monitor to determine whether
this is a reoccurring issue (all associated alerts are displayed in the alerts section).
Note: The triggered alerts table is only displayed for users that have permissions to view
alerts. For details on user permissions, see "Permissions" on page 744.
5. Add an acknowledgment to track resolution of the problem
After reviewing alerts, click the Add Acknowledgment
button and add a comment
acknowledging the monitor status. The acknowledgment comment is displayed (after refreshing
the view) as a tooltip associated with the acknowledgment icon in the SiteScope Dashboard view,
and is recorded in the Acknowledge Log.
Note: Acknowledgments can only be deleted from the Acknowledge Log (available from the
Acknowledge Monitors In Group dialog box in the SiteScope Dashboard). Deleted
acknowledgments are not displayed in the Acknowledgments list in Multi-View.
6. Drill down to group or monitor properties
To investigate the issue further, click Drill Down to Group/Monitor Properties to open the
group or monitor in Manage view in the Unified Console.
Note: For the newly-opened browser to work, you must set -Xss1m in the Runtime
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Parameters column of the Java Runtime Environment Settings dialog box (Java Control
Panel > Java tab > View) on the machine where the SiteScope user interface is opened.

How to Display Your Corporate Name or Logo in the Multi-View Header
1. Prerequisites.
You must be a user with access to the SiteScope server file system.
2. Take a screen capture of the name or logo that you want to appear at the top of the Multi-View
window.
n

We recommend that you use an image with a maximum width of 300 pixels and a height of 40
pixels. If the image exceeds these dimensions, it will not appear correctly in the header.

n

Various image formats are supported, including gif, png, jpg, and bmp.

3. Save images using with the following name format: customLogo*.<image_format>.
4. Copy image files to the <SiteScope root directory>\templates.multiView folder.
Note: Custom images are supported when upgrading SiteScope; the images in the above
folder are included in the SiteScope import/export configuration.
5. After uploading image files, reload the Multi-View page to display the corporate name or logo in the
Multi-View Header.

How to Get a URL That Links Directly to a Monitor or Group in Multi-View
1. In the SiteScope Dashboard view, focus on the relevant group or monitor in the monitor tree, and
then click Unified Console. Multi-View opens in a browser and focuses on the selected group or
monitor.
2. Copy the URL from the browser. You can then use this URL to drill down directly to the relevant
group or monitor in your infrastructure.
See also: "Event Console" on page 1062
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Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l

Unified Console should not be used in SiteScope for Load Testing installations.

l

The maximum number of Unified Consoles that can be open simultaneously is 20.

l

If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to
login back into SiteScope after the restart if you refreshed Unified Console before SiteScope
(session is invalidated and could not be restored after timeout j_security_check).
Workaround: Close all open SiteScope and Unified Console windows, and then reopen SiteScope
and Unified Console.

Multi-View User Interface
Use Multi-View to get an overview of the performance status of everything that is being monitored in
your IT infrastructure in a single view. It provides filtering and drill down to enable you to focus only on
those groups and monitors you want to view, helping you to isolate the root cause of problems and
troubleshooting issues.
To
access

l

l

From the SiteScope Dashboard: In the Monitors context, click the Dashboard tab,
and then click the Unified Console button.
From a browser: Enter the Multi-View URL in a Web browser. The URL should be in
the format: http://<server_name>:<port>/SiteScope/MultiView

Relevant "How to Select and Configure a View" on page 1095
tasks
"How to Assign Custom Search/Filter Tags and View Monitors in the Tags View" on
page 1097
"How to View SiteScope Server Health in Multi-View" on page 1098
"How to Diagnose and Troubleshoot Problems in Multi-View" on page 1098
See also

"Multi-View" on page 1089

User interface elements are described below (unlabeled elements are shown in angle brackets):

Multi-View Toolbar
The Multi-View Toolbar enables you to filter the view according to the needs of different personas, such
as system administrators, application owners, and so on, or to view SiteScope data from a different
perspective for problem analysis.
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User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<SiteScope server name>

Name of the SiteScope server currently displayed in Multi-View.
Click the server name to drill down to the SiteScope Health group
of monitors. The health monitors display information about the
performance and availability of SiteScope itself. For details, see
"SiteScope Server Health Monitors" on page 1149.
The icon to left of the name shows the status of the SiteScope
Health group based on the worst child (taking the worst status of
all health monitors in the group).
Note:
l

l

User

If you do not have view permissions for the Health group, the
server name link is inactive.
To return to the groups and monitors tree map, click the Back
button in your browser, or select All Monitors in the filter list
and then click Apply.

If you enter a user name to log on to SiteScope, it appears on the
upper-right side of the window.
Opens the help for Multi-View.

Logs you out of Multi-View.
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UI Element

Description

<View>

Select a category by which to view objects in the tree map. You
can select a grouping option to fit the perspective of different
personas viewing SiteScope data, or to view SiteScope data from
a different perspective for problem analysis.
l

l

l

Monitors. Groups the objects in tree map (groups and
monitors) in a flattened view as a set of nested rectangles. The
hierarchical relationship between groups and monitors is
retained, enabling drill down/up to different levels. This is the
default setting.
Servers. Groups monitors by target server. The Servers view
displays only those remote servers that are displayed in the
remote server tree. It does not display the SiteScope server,
non-persistence servers used for URL/Ping monitors, or
browsable servers.
Tags. Groups monitors by custom search/filter tags defined in
Preferences > Search/Filter Tags. Only monitors with the
assigned tag are displayed.

For more details on these categories, see "Viewing Categories"
on page 1092.
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UI Element

Description

<Filter>

Enables filtering groups and monitors in Multi-View by:
l

All Monitors. This means that no filter has been selected, and
all SiteScope groups and monitors are displayed in Multi-View.
Tip: To enhance performance and to maximize the benefits of
using Multi-View in loaded configurations, it is recommended
to select a filter, or drill down to those groups and monitors you
want to view instead of displaying all SiteScope objects.

l

<Filter name>. A filter pre-defined in the SiteScope monitor
tree. Only those SiteScope groups and monitors that meet the
criteria of the filter are displayed in Multi-View. Filters can be
defined with different criteria that can be applied for viewing
the data from different user perspectives. This includes
filtering by monitor name, monitor type, target server, tags,
enabled/disabled status of monitors or alerts, and BSM
reporting settings. For details on defining a filter in the monitor
tree, see "Filter Objects in the SiteScope View" on page 74.
Note: When a new filter is created in the monitor tree, it is only
visible in Multi-View after refreshing the view (F5).

l
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UI Element

Description

<Status>

Displays only those SiteScope groups and monitors that meet the
status criteria you select. The group status is based on the worst
child (taking the worst status of all SiteScope monitors in the
group).
Tip: It is recommended to select a status criteria when performing
troubleshooting, and to return to the All Statuses view after
troubleshooting is complete.
l

l

l

l

l

l

l

l

All Statuses. Shows all monitors or groups with any status,
including disabled and no data. This is the default setting.
Error. Show only monitors or groups reporting an error status.
Error and Warning. Show only monitors or groups reporting a
warning or error status.
Disabled. Shows only monitors or groups reported as
disabled.
Warning. Shows only monitors or groups reporting a warning
status.
No data. Shows only monitors or groups for which no data is
reported.
Good and Warning. Shows only monitors or groups reporting
a warning or good status.
Good. Show only monitors or groups reporting a good or OK
status.

For details on status levels, see "Tree Map Area" on page 1107.
SiteScope applies the selected view, filter, and status settings
and the Multi-View display is updated accordingly.
If no items match the filter, or SiteScope is unable to display the
selected view, a message is displayed. If it takes longer than 2
seconds to display the selected view, a Cancel button is
displayed, enabling you to stop the filter. The current view is
displayed until the filter has been successfully applied.
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UI Element

Description

<Breadcrumbs>

Displays the levels through which you have navigated to get to the
current level. Appears horizontally across the top of the tree map.
Each level in the list of breadcrumbs is a clickable link which you
can use to trace your path of navigation, and focus on that level in
the tree map.
Note: Filters remain active until you change the filter criteria.
Therefore, some monitors may not be displayed depending on the
status and filter criteria, and the selected view.
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Tree Map Area
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Status
Icons>

Displays the groups and monitors for the element highlighted in the monitor tree or listed
in the breadcrumbs. Click a group to drill down to that object in the tree view. You can
return to previous levels using the breadcrumbs.
An icon is displayed for each object to represent the operational status assigned to that
object for its current performance level.
l

l

l

Good Status. All performance measurements for the group or monitor are within
the Good threshold level.
Warning Status. At least one performance measurement for the group or monitor
is within the Warning range, but no measurements are within the Error or Poor range.
Error/Poor Status. At least one performance measurement for the group or
monitor is within the Error or Poor range.
This indicates either of the following:

l

l

l

n

The performance measurement has a value, but at poor quality level.

n

There is no measurement value due to some error.

Status Not Defined (No Data). There is no data for the group or monitor. This can
be caused by any of the following reasons:
n

A new monitor has not yet run.

n

Monitor metrics have not yet been collected.

n

The monitors on which the group or monitor depend are not reporting a Good
condition.

Disabled Manually. The group or monitor is currently disabled, and no data
updates are being received.
Group/Monitor Details. When you place the cursor over a group or monitor, the
status icon changes to the information icon. Click the icon to drill down to see details
or troubleshoot the group or monitor. For details, see the "Monitor Details Dialog Box"
on the next page or "Group Details Dialog Box" on page 1111.
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UI
Element Description
<Group
Status>

The group status is based on the worst child (taking the worst status of all SiteScope
monitors in the group). Group status reflects all the monitors in the group, regardless of
whether they are currently displayed (some monitors may not be displayed depending on
the status and filter criteria, or if the user does not have permissions to see all monitors in
the group). As a result, a group might show Error status even though all monitors
displayed in the group are in Good status.
Note:
l

If there is insufficient space to display either:
n

All monitor names in a group, only the monitor status icon is displayed.

n

All monitors in the group, the

icon is displayed next to the group name.

Click the group name to drill down to see all the monitors within that group.
l

If an unfiltered group is empty (it contains no entities), the node has a gray/white
background (depending on the selected background color) with no
status icon is displayed.

l

If a group that contains entities is empty after filtering, the group is color-coded
according to the worst child status of monitors in the group, and the
displayed to indicate that the group contains entities.

l

icon, and the

icon is

Node size is proportionate to the hierarchical level of the group, and not to the number
of objects in the group. The closer the group is to the SiteScope root node, the larger
the node size.

Monitor Details Dialog Box
The Monitor Details dialog box enables you to view details and perform actions on the selected monitor.
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To access

In Multi-View, place the cursor over a monitor. The status icon changes to the
information
monitor.

icon. Click the icon to drill down to see details or troubleshoot the

Important
To perform actions in the Monitor Details dialog box, you must be an administrator in
information SiteScope, or a user granted the necessary permissions. For details on user
permissions, see "Permissions" on page 744.
Relevant
tasks

"How to Diagnose and Troubleshoot Problems in Multi-View" on page 1098

See also

"Multi-View" on page 1089

User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

Details Tab
Status

The status of the monitor (Good, Warning, Error, Disabled, No data).

Summary

Displays the most recent measurement results reported by the monitor. This
may include more than one measurement, depending on the monitor type. If a
monitor is in error status, a description of the error is displayed. If a monitor
has been disabled, it displays the disabled status (disabled manually, disabled
until x time, or disabled by <Downtime Name> from BSM).

Last Run

The date and time of the last monitor run.

Generate Report

Click to create a one-time SiteScope Quick report using pre-configured
settings for the selected monitor. For more details on the report, see "Quick
Report" on page 1356.

Run Now

Click to run the monitor, and update the results in the Summary section. This
button is not available for a monitor in the Disabled state.

Description

Contains information entered in the Monitor Description field of the monitor
properties.
Note: This field is not displayed if the Monitor Description field is empty.
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UI Element

Description

Monitor State

Displays the active state of the monitor (Enabled/Disabled).
l

l

If the monitor is Enabled, the Disable button is displayed. Click to disable
the monitor. The color and icon of the box representing the monitor change
to gray to indicate that the monitor is inactive. Multi-View shows disabled
manually, Disabled from MultiView by user - <user name> in the
Summary field.
If the monitor is Disabled, the Enable button is displayed. Click to enable
the monitor. The color and icon of the box representing the monitor change
according to the monitor status.

For more details on changing monitor state, see "Enable/Disable Monitors in
Group Dialog Box" on page 1049.
Alerts State

Displays the state of alerts associated with the monitor (Enabled/Disabled).
l

l

Enabled. Indicates that alerts associated with the monitor are enabled. To
disable alerts associated with the monitor, click the Disable button.
Disabled. Indicates that alerts associated with the monitor are disabled.
To enable alerts associated with the monitor, click the Enable button.

For more details on changing alert state, see "Enable/Disable Associated
Alerts" on page 310.
Triggered Alerts

Displays details of all alerts triggered. This includes the following:
l

Date. The date and time at which the alert was triggered

l

Type. The type of alert action (for example, Post, Sound).

l

l

Name. Name for this alert definition that is used to identify this alert
definition in the product display.
Summary. Summary of the alert action performed.

Triggered alerts are only displayed for users that have view alerts
permissions.
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UI Element

Description

Acknowledgments Displays details of the last 5 acknowledgment comments added to the
(Last 5)
monitor. They are used to track resolution of problems that SiteScope detects
in your system and network infrastructure. With this function, SiteScope
keeps a record of when the problem was acknowledged, what actions have
been taken, and by which user.
Click the Add Acknowledgment
button to open the Add
Acknowledgment dialog box and add a comment acknowledging the monitor
status. The acknowledgment is displayed after refreshing the view (F5).
Note: Acknowledgments can only be deleted from the Acknowledge Log
(available from the Acknowledge Monitors In Group dialog box in the
SiteScope Dashboard). Deleted acknowledgments are not displayed in the
Acknowledgments list in Multi-View.
Drill Down to
Monitor
Properties

Opens the SiteScope instance in a new window, and drills down to the
selected monitor in Manage view in the Unified Console.
Note: For the newly-opened browser to work, you must set -Xss1m in the
Runtime Parameters column of the Java Runtime Environment Settings
dialog box (Java Control Panel > Java tab > View) on the machine where
the SiteScope user interface is opened.

Metrics Tab
<List of metrics>

Displays the name and value of monitor metrics that are in error or warning
status. You can sort the metrics table by metric name and value.

Group Details Dialog Box
The Group Details dialog box enables you to view details and perform actions on the selected group.
To access

In Multi-View, place the cursor over a group. The status icon changes to the
information
group.

icon. Click the icon to drill down to see details or troubleshoot the

Important
To perform actions in the Group Details dialog box, you must be an administrator in
information SiteScope, or a user granted the necessary permissions. For details on user
permissions, see "Permissions" on page 744.
Relevant
tasks

"How to Diagnose and Troubleshoot Problems in Multi-View" on page 1098

See also

"Multi-View" on page 1089

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Element

Description

Status

The status of the monitors in the group (Good, Warning, Error, Disabled, No
data). The group status is based on the worst child (taking the worst status of
all SiteScope monitors in the group).

Summary

Displays the number of monitors within the group and the number of monitors,
if any, that are reporting an error status.

Last Run

The date and time of the last monitor run.

Generate Report

Click to create a one-time SiteScope Quick report using pre-configured
settings for all monitors in the selected group. For more details on the report,
see "Quick Report" on page 1356.

Run Now

Click to run the monitors in the group, and update the results in the Summary
section. This button is not available for a group that is currently Disabled,

Description

Contains information entered in the Group Description field of the monitor
properties.
Note: This field is not displayed if the Group Description field is empty.

Monitors State

Select the state for all monitors in the group:
l

l

Alerts State

Enable All. Enables all monitors in the group. The status icons and color
change according to the group and monitor status.
Disable All. Disables all monitors in the group. The color and icon of each
monitor in the group change to gray to indicate that the monitor is inactive.
Multi-View shows disabled manually as the status in the Summary
field.

Select the state of alerts associated with monitors in the group:
l

l

Enable All. Enables all alerts associated with monitors in the group.
Disable. Disables indefinitely all alerts associated with monitors in the
group.

For more details on changing alert state, see "Enable/Disable Associated
Alerts" on page 310.
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UI Element

Description

Acknowledgments Displays details of the last 5 acknowledgment comments added to the
(Last 5)
monitor. They are used to track resolution of problems that SiteScope detects
in your system and network infrastructure. With this function, SiteScope
keeps a record of when the problem was acknowledged, what actions have
been taken, and by which user.
Click the Add Acknowledgment
button to open the Add
Acknowledgment dialog box and add a comment acknowledging a monitor
status. The acknowledgment is displayed after refreshing the view (F5).
Note: Acknowledgments can only be deleted from the Acknowledge Log
(available from the Acknowledge Monitors In Group dialog box in the
SiteScope Dashboard). Deleted acknowledgments are not displayed in the
Acknowledgments list in Multi-View.
Drill Down to
Group Properties

Opens the SiteScope instance in a new window, and drills down to the
selected group in Manage view in the Unified Console.
Note: For the newly-opened browser to work, you must set -Xss1m in the
Runtime Parameters column of the Java Runtime Environment Settings
dialog box (Java Control Panel > Java tab > View) on the machine where
the SiteScope user interface is opened.
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Ops View
combines the Event Console and Multi-View in a single view. Working side-by-side with
the Event Console and Multi-View helps you isolate and diagnose problems by enabling you to identify
events associated with a selected monitor or monitor group, or a monitor associated with a selected
event, and to drill down and perform troubleshooting. For details, see "Multi-View" on page 1089 and
"Event Console" on page 1062.
Example: Ops View

To access
You can access Ops View in the Unified Console directly from a web browser or from the SiteScope
Dashboard.
l

To access the Unified Console from a browser, enter the URL in the format:
http://<server_name>:<port>/SiteScope/WebMain#/consolidatedview

l

To access the Unified Console from the SiteScope Dashboard, select the Monitors context, click
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the Dashboard tab, and then click the Unified Console
opens by default.
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The Manage view
in the Unified Console provides self-service monitoring to non-admin users, and
reduces the amount of monitoring support required from the SiteScope administrator or monitoring
team.
After being granted the necessary permissions by the SiteScope administrator, the application owner
can perform common administration actions such as deploy templates, update monitor configurations,
run monitors, view associated alerts, and enable/disable monitors, groups, and alerts.
Example: Manage view in the Unified Console

Note: This is the first version of the management part of the Web user interface that provides
basic flows for self-service monitoring. However, it does not include all capabilities currently
available in the SiteScope Dashboard, which are planned for later versions.
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To access
The Manage view is available in the Unified Console. You can access the Unified Console directly from
a browser or from the SiteScope Dashboard.
l

To access the Manage view directly, open a Web browser, and enter the following URL:
http://<SiteScope server>:<port>/SiteScope/WebMain#/manage/monitors

l

To access the Unified Console from the SiteScope Dashboard, select the Monitors context, click
the Dashboard tab, and then click the Unified Console button. When the Unified Console opens,
click Manage

.

Learn About
This section includes:
l

"Manage View Overview" below

l

"Self-Service Monitoring - Use-Case Scenario" on the next page

l

"Supported Browsers and Screen Resolutions" on page 1119

Manage View Overview
You can perform the following actions in the Manage view of the Unified Console:
l

l

l

Deploy a group of monitors from an existing template (either directly from the user interface, or from
an external Comma Separated Value (CSV) file).
View and edit configuration properties for existing monitors and groups.
View the status and summary for groups and monitors, including details of alerts that have been
configured on these groups and monitors.

l

Run a monitor or group of monitors.

l

Disable and enable groups and monitors.

l

Disable and enable the triggering mechanism for alerts associated with the group or monitor.

Benefits of using Manage view include:
l

It provides self-service monitoring to non-admin users (after being granted the necessary
permissions), and reduces the amount of monitoring support required from the SiteScope
administrator or monitoring team. For details, see "Self-Service Monitoring - Use-Case Scenario" on
the next page.
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l

l

l

l

l

l

A modern and intuitive Java-free interface that provides improved usability and new look and feel
(uses HTML5).
Mobility. Supports iPad and Android tablets, and the most commonly used browsers including
Chrome and Safari. For the list of supported browsers, see "Supported Browsers and Screen
Resolutions" on the next page.
Faster response time than the SiteScope Dashboard.
It is fully supported on big and small screens, making it is ideal for viewing monitor data in a network
operations center.
To assist in troubleshooting, you can copy the link for a selected group or monitor (from the
browser), and send it to other users, enabling them to open the same location in the monitors tree
from Manage view.
Improved navigation. You can navigate back and forward in the browsing history of the monitor tree
using the Back and Forward browser buttons.

Self-Service Monitoring - Use-Case Scenario
Self-service monitoring enables the SiteScope administrator or monitoring team to delegate monitor
creation and maintenance tasks to the application owner, and thereby reduce the monitoring support
they need to provide.
Let’s take a look at a couple of different scenarios.
Note: Both these scenarios presume that the SiteScope administrator has assigned the
application owner the necessary permissions he/she needs for accessing the groups and
templates related to the applications for which he/she is responsible (the administrator grants
these permissions in User Management Preferences).
Scenario 1 - Application Owner Wants to Modify Groups/Monitors under Their Application
Ownership
Peter, an application owner, receives a new critical event on his application. After investigating the
issue, Peter determines that the event was triggered unnecessarily, and that the monitor threshold
should be changed to avoid further false alerts.
Instead of opening a ticket for the SiteScope administrator to change the threshold settings (which
might take a while and does not required any additional expertise), Peter makes the necessary changes
to the monitor threshold settings (for which he was granted permissions).
Peter is able to resolve the issue faster, and reduce the time and effort required from the SiteScope
administrator.
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Scenario 2 - Application Owner Wants to Create New Monitors from Templates Related to
Their Application Ownership
Susan needs to create a new set of monitors to track the availability and performance of a new
application that she owns.
Instead of opening a ticket for the monitoring team to create the monitors with the required settings,
Susan uses an existing template that has the required application monitors already configured (for
which she has permissions), to deploy the monitors.

Supported Browsers and Screen Resolutions
Supported Browsers and Devices
The following browsers are supported:
l

Google Chrome browsers (latest certified version): 42.0.2311.90 m.

l

Mozilla Firefox (latest certified version): 38 ESR

l

Safari (latest certified version): 8.0 for Mac

l

Internet Explorer 9, 10, 11
Note:
n

n

l

Internet Explorer 9 is supported on client machines with the following limitations:
o

It is not supported on Microsoft Windows 7 N Edition.

o

It is not supported on Microsoft Windows Server 2008.

We recommend setting Browser Mode according to the IE version, and Document Mode
to standards mode.

Internet Explorer 8 (in MyBSM only)
Note: While Internet Explorer 8 can be used to access the Multi-View Page in MyBSM, it is no
longer officially supported, and we recommend switching to one of the supported browsers,
since the Event Console and the tab functionality in the Unified Console will not work.

The following mobile devices are supported:
l

iPad 3 with Safari (iOS 7 with latest updates)

l

Android tablet with Chrome 34.0.1847 (Full HD display)
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Default Screen Resolution
l

Large Desktop – 1680 x 1050 pixels

l

Laptop – 1280 x 800 pixels

l

iPad – 1024 x 768 pixels

Tasks
This section includes:
l

l

l

l

"How to Assign Group and Template Permissions to Application Owners (SiteScope Administrator)
" below
"How to Deploy Monitors from a Template (Application Owner)" on the next page
"How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application Owner)" on page
1123
"How to Perform Actions on Multiple Monitors (Administrator/Application Owner)" on page 1124

How to Assign Group and Template Permissions to Application Owners (SiteScope
Administrator)
Define users and user roles, and assign the required permissions for application owners.
1. In Preferences > User Management Preferences, create users and user roles for the different
application owners. For details on user permissions, see "User Management Preferences" on
page 732.
2. Assign permissions for accessing groups and templates to each application owner as required. By
default, a user has permissions to access all groups and templates.
n

In Preferences > User Management Preferences > <application_owner_user> > Main
Settings > Allowed groups, add the groups that can be viewed and modified by the
application owner.

n

In Preferences > User Management Preferences > <application_owner_user> > Main
Settings > Allowed template containers, add the template containers that can be used by
the application owner for creating new monitors.
For details on assigning allowed groups and template container permissions, see "Main
Settings" on page 742.
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How to Deploy Monitors from a Template (Application Owner)
1. Permissions
To deploy monitors using templates, you must have:
n

The ability to view and modify groups of monitors under your application ownership. The
SiteScope administrator determines the groups for which you have permissions in the Allowed
groups list (in Preferences > User Management Preferences > New/Edit User Profile
> Main Settings).

n

The ability to create new monitors from templates related to your application ownership. The
SiteScope administrator determines the template containers for which you have permissions in
the Allowed template containers list (in Preferences > User Management Preferences
> New/Edit User Profile > Main Settings).

For details on user permissions, see "User Management Preferences" on page 732.
2. Deploy monitors directly from the user interface - optional
a. Determine where you want to deploy the template.
o

To deploy a template to the SiteScope root or to an existing group, skip to the next step.

o

To deploy the template to a new group, right-click the location where you want to create a
group (under an existing group or the SiteScope root), select Create > Group, and
configure the group properties. For details, see "Create New Group" on page 1142.

b. Right-click the SiteScope root node or the group in which you want to deploy the template, and
select Deploy Template.
c. In the Select Template page of the Deploy Template wizard, select a template with the
required application monitors, and then click Next.
d. If the template requires that you specify a target remote server (when the SERVER_LIST
system variable is used), the Select Target Server page opens. Select the target host server
or servers on which to deploy the template, and then click Next.
e. If the template contains variables that need to be defined, the User-Defined Template
Properties page opens. Enter the required variable values to use to deploy the template, and
then click Next. For details on template variables, see "Template Variables" on page 790.
f. In the Template Deployment Summary page, preview the template configuration details. Click
Deploy to deploy the template.
Tip: You can use the Previous and Next buttons if you need to make changes to the
selected template, server, or template properties.
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g. A summary of the template deployment is displayed in the Deployment Results page. Click
Exit to close the wizard.
For wizard details, see "Deploy Template Wizard" on page 1144.
3. Deploy monitors using an external Comma Separated Value (CSV) file - optional
a. Determine where you want to deploy the template.
o

To deploy a template to the SiteScope root or to an existing group, skip to the next step.

o

To deploy the template to a new group, right-click the location where you want to create a
group (under an existing group or the SiteScope root), select Create > Group, and
configure the group properties. For details, see "Create New Group" on page 1142.

b. Right-click the SiteScope root node or the group in which you want to deploy the template, and
select Deploy Template.
c. In the select Template page of the Deploy Template wizard, select the Use CSV file check
box, and configure the required settings:
o

Click the Browse or Choose File button (depending on the browser) to select the CSV file
to use for template deployment. (This button is only displayed after you select the CSV
option.)

o

Encoding. Select the encoding for the remote server, if the remote server is running an
operating system version that uses a different character encoding than the server on which
SiteScope is running (the default is windows-1252).

o

Verify monitor properties with Remote Servers. This option verifies the correctness of
the monitor configuration properties against the remote servers on which the changes are
being made (selected by default). When this option is selected, it takes more time to make
changes due to the remote connections.

d. Click the Deploy button to deploy the template (this button is inactive until a CSV file is
selected).
e. A summary of the template deployment is displayed in the Deployment Results page.
You can click the link to check the log file (silent_deployment.log) for a summary of the
deployment. For log file details, see "Log Files Page" on page 1184.
Click Exit to close the wizard. For wizard details, see "Deploy Template Wizard" on page
1144.
For details on deploying a template using a CSV file, see "Deploy a Template Using a CSV File"
on page 848 and "How to Deploy Templates Using a CSV File" on page 850.
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How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application Owner)
1. Prerequisites
For an application owner to be able to access groups and templates, the SiteScope administrator
must assign the application owner the required permissions (see "How to Assign Group and
Template Permissions to Application Owners (SiteScope Administrator)" on page 1120. By
default, a user has permissions to access all groups and templates.
Note: Actions in the context menu for which a user does not have permissions grayed out
(unavailable).
2. Investigate the event
When an alert is triggered on an application, the application owner receives a new event.
Determine whether the application is working correctly (event are sometimes unnecessarily
triggered due to incorrect threshold settings).
a. In Multi-View, select the group or monitor for which an event was sent, and click Drill Down
to Group/Monitor Properties. A new browser opens displaying the properties for the
selected group or monitor in Manage view.
b. Right-click the group or monitor and select Enable/Disable > Disable Alert Triggering to
prevent additional notifications being triggered.
c. Check the group or monitor status and summary.
o

You can view the status of the group or monitor run, which is represented by an icon
(Good, Warning, Error, Disabled or No Data) in the status tree. Check the Monitor Status
Details panel for the specific metrics in error. For details, see "Group Properties" on page
1133 or "Monitor Properties" on page 1135.
Tip: To assist in troubleshooting, you can copy the link for a selected group or monitor
(from the browser), and send it to other users, enabling them to open the same
location in the monitors tree from Manage view.

o

If necessary, you can also disable a group or monitor by selecting Enable/Disable
> Disable Group/Monitor to prevent additional events being triggered. The icon group or
monitor icon changes to
or
to indicate that the group or monitor is inactive.
Disabling a group or monitor also disables all alerts associated with the group or monitor.
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3. Adjust the monitor configuration settings.
If you determine that the event was triggered unnecessarily as a result of incorrect thresholds
settings, you can adjust the monitor thresholds to avoid further false alerts.
a. Make the necessary changes to the Threshold Settings. For details, see "Monitor Properties"
on page 1135.
b. Click Save to save your changes (before navigating away from the page).
4. Re-run the monitor to check the new status.
a. Right-click the monitor, and select Run to re-run the monitor and check if the problem still
exists.
b. After the monitor run has finished, check the run status and details in the Monitor Status
Details panel. For details, "Monitor Properties" on page 1135.
5. Enable the alert triggering mechanism.
a. Right-click the group or monitor and select Enable/Disable > Enable Alert Triggering to
enable the triggering mechanism for alerts associated with the monitor.
b. Check that no additional unnecessary alerts are triggered.
Tip: You can also perform actions (run monitors, enable/disable monitors, enable/disable alert
triggering) on multiple monitors in the monitor tree. For details, see "How to Perform Actions on
Multiple Monitors (Administrator/Application Owner)" below.

How to Perform Actions on Multiple Monitors (Administrator/Application Owner)
You can perform actions (run monitors, enable/disable monitors, enable/disable alert triggering) on
multiple monitors in the monitor tree. To do so, you need to select the required monitors, and add them
to the Selected Monitors list.
1. Place the cursor over a group or monitor icon. The icon for that object swivels and is displayed as
or

.

2. Click the group or monitor icon to select it. The group or monitor is displayed as selected (
) and all the other groups and monitors are shown as selectable (

or

or

). The

Selected Monitors
icon is displayed to the right of the Filter by name box when one or more
monitors, or groups containing monitors, have been selected.
3. Repeat the above steps to add other monitors as required.
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4. Click the Selected Monitors
icon to open the Selected Monitors list. This list displays all
monitors that have been selected in the tree. The number of monitors in the Selected Monitors list
is shown in the orange circle.
5. To perform an action on the selected monitors, right-click in the Selected Monitors list, and select
an action (Run All Monitors, Enable/Disable All Monitors, Enable/Disable Alert
Triggering).
The action is performed on the selected monitors and the list closes.
6. To remove a monitor from the Selected Monitors list, click the
monitors, click the Clear button.

icon. To remove all selected

Tips/Troubleshooting
Unified Console Limitations and Troubleshooting
l

Unified Console should not be used in SiteScope for Load Testing installations.

l

The maximum number of Unified Consoles that can be open simultaneously is 20.

l

If SiteScope is restarted while Unified Console and SiteScope windows are open, you are unable to
login back into SiteScope after the restart if you refreshed Unified Console before SiteScope
(session is invalidated and could not be restored after timeout j_security_check).
Workaround: Close all open SiteScope and Unified Console windows, and then reopen SiteScope
and Unified Console.

Manage View User Interface
Use the Manage view in the Unified Console to see SiteScope group and monitor properties, and to
perform common administration actions.
To access

l

To access the Manage view directly, open a Web browser, and enter the following
URL:
http://<SiteScope
server>:<port>/SiteScope/WebMain#/manage/monitors

l

From the SiteScope Dashboard, select the Monitors context, click the
Dashboard tab, and then click the Unified Console button. When the Unified
Console opens, click Manage
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Important
To perform actions, you must be an administrator in SiteScope, or a user granted the
information necessary permissions. For details on user permissions, see "Permissions" on page
744.
Relevant
tasks

l

l

l

See also

"How to Deploy Monitors from a Template (Application Owner)" on page 1121
"How to Edit Monitor Configurations to Prevent Unnecessary Alerts (Application
Owner)" on page 1123
"How to Perform Actions on Multiple Monitors (Administrator/Application Owner)"
on page 1124

"Manage View" on page 1116

User interface elements are described below (unlabeled elements are shown in angle brackets):

Tree Objects
UI Element

Description
SiteScope root. Represents the SiteScope server and reports the
status based on the worst child rule (taking the worst status of all
monitors in the SiteScope instance).
Note: The status icon is not displayed if all monitor groups have been
disabled.
Group. Represents a SiteScope group or subgroup with enabled
monitors reporting Good, Warning, or Error status.
Represents a SiteScope group or subgroup with no enabled
monitors.
Represents a SiteScope group or subgroup with no monitors.

Represents a group on which an associated alert has been
configured.
Health. Represents the status of monitors that display information
about the performance and availability of SiteScope itself.
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UI Element

Description
Monitor. Represents a SiteScope monitor reporting Good, Warning,
or Error status.
Represents a monitor that has no data or that has been
disabled.

Represents a monitor on which an associated alert has been
configured.
Select Multiple Groups/Monitors. Enables performing actions on
multiple groups and/or monitors (such as running, enabling or
disabling groups or monitors, or alert triggering). To make groups
and/or monitors selectable, place the cursor over a group or monitor
icon (the icon swivels), and select the group or monitor.
A blue check mark is displayed, and all the other displayed groups
and/or monitors become selectable.

Tree Filter
UI Element

Description
Filter. Enables filtering the display to show only the groups
and/or monitors that meet the criteria you define. After
making a selection, the filter icon changes to blue (
l

).

Filter by name. Type a string by which you want to filter
objects appearing in the SiteScope root or a selected
group. The filter runs automatically after a letter is entered
in the box, and displays all matching results in the
selected entity. Delete the string to clear the filter, and
show all groups and/or monitors in the selected entity.
Note:
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n

The filter is case insensitive.

n

Wildcards and boolean operators are not supported.

l

All. Selects all the listed groups and monitors.

l

None. Clears all the selected groups and monitors.
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UI Element

Description
Selected Monitors. Enables you to perform an action (run
monitors, enable/disable monitors, enable/disable alert
triggering) on multiple monitors in the monitor tree. The
Selected Monitors icon is displayed to the right of the Filter
by name box when one or more monitors, or groups
containing monitors, have been selected (indicated by
). To perform an action, right-click in the list, and select
the action.
Click the Selected Monitors icon to open the Selected
Monitors list. This list displays all monitors that have been
selected in the tree. The number of monitors in the Selected
Monitors list is shown in the orange circle.
The Select Monitors list displays the status of each selected
monitor (
,
,
,
). To display monitor
properties for a specific monitor, click the monitor in the list.
"Monitor Properties" on page 1135 are displayed in the right
pane.
To remove a monitor from the Selected Monitors list, click
the
icon. To remove all selected monitors, click the Clear
button.

Object Type

Select the object types by which you want to filter the objects
appearing in the tree:

Status

Select the status criteria by which you want to filter
SiteScope groups and monitors:

HP SiteScope (11.31)

Page 1128 of 1395

Using SiteScope
Chapter 98: Manage View

UI Element

Description

Monitor Types

Select the monitor types by which you want to filter in the
tree. Only monitor types configured on the SiteScope server
are displayed in the list.

You can filter the list of monitor types by typing a string in the
Filter list box. The filter runs automatically after a letter is
entered in the box, and displays all matching results. Select
the monitor types by which you want to filter (a check mark is
displayed next to the each selected monitor type). To refresh
the filter and show the monitor types list, delete the search
string or click the x button.
Note: The Filter list box is only displayed if there are more
than 8 monitor types.
Clear Filter

HP SiteScope (11.31)

Clears the filter selection and shows all groups and/or
monitors in the selected entity. After clearing the filter, the
filter icon is displayed in gray.
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Manage View Context Menu
UI Element

Description

Deploy Template

Opens the Deploy Template wizard which enables you to deploy a
group of monitors from an existing user-defined template. This action
is available on the group entity only.
For details on the wizard, see "Deploy Template Wizard" on page
1144.
Note: This option is not available for a user that does not have the
allowed template permissions.

Create > Group

Enables you to create a new group into which you can deploy
template monitors. This action is available on the group and
SiteScope root entity only.
Note: This option is not available when the logged-in user does not
have permissions to perform this action.

Run

Runs the monitor or all monitors configured in the group. The run
results (status icon and run summary) are shown in "Monitor
Properties" on page 1135 and "Group Properties" on page 1133.
Note: This option is not available when the logged-in user does not
have permissions to perform this action.
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UI Element

Description

Enable / Disable

Monitor/Group. Enables or disables the monitor or all monitors in
the group, regardless of the setting in the monitor properties.
l

If the monitor or group is enabled, the Disable Monitor/Group
option is displayed. Click to disable the monitor or monitors in the
group. The icon representing the monitor or group (and all
monitors in the group) changes to
or
respectively to
indicate that the monitor or group is inactive. Disabling a monitor
or group also disables all alerts associated with the monitor or
group.

l

If the monitor or group is disabled, the Enable Monitor/Group
option is displayed. Click to enable the monitor or group. The icon
representing the monitor or group (and all monitors in the group)
changes to reflect the status of the respective monitor or group.

For details on changing monitor state, see "Enable/Disable Monitors
in Group Dialog Box" on page 1049.
Note: These options are not available when the logged-in user does
not have permissions to perform the particular action.
Alert Triggering. Enables or disables the triggering mechanism for
alerts associated with a group (all monitors in the group) or a monitor,
regardless of the setting in the monitor properties. You can disable
the alert triggering to prevent additional notifications being sent. To
enable or disable alert triggering, right-click a monitor or group, and
select Enable/Disable Alert Triggering.
If the monitor is enabled, only the Disable Monitor option is
displayed (and vice versa when the monitor is disabled). When
selecting a group, both Enable Alert Triggering and Disable Alert
Triggering are displayed.
Note:
l

l

l
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These options are not available at the SiteScope root level or
when the logged-in user does not have permissions to perform
the particular action.
Both options are not available at the SiteScope root level or when
the logged-in user does not have permissions to perform the
particular action.
The alert triggering options are equivalent to the Enable/Disable
Associated Alerts options (under monitor properties) in the
SiteScope Dashboard. For details, see "Enable/Disable
Associated Alerts" on page 310.
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SiteScope Root Properties
Group Status Details
UI Element

Description
The status of the monitors in the SiteScope root (Good, Warning,
Error, Disabled or No data). The SiteScope root status is based on
the worst child (taking the worst status of all SiteScope monitors
within the SiteScope node).
Status details are updated when you run a group, or when you refresh
the tree (by default, the status is refreshed each 5 seconds).

Last Run

The date and time of the last monitor run.

Summary

Displays the number of monitors within the SiteScope node and the
number of monitors, if any, that are reporting an error status.

Alerts
Displays information about all global alerts associated with the SiteScope node. The fields in this panel
are not-editable.
UI Element

Description

Name

The name by which the alert is known in SiteScope.

Status

The status of the alert (Enabled or Disabled).

Description

A description of the alert (if one was provided).

Actions

The alert action type and the name given to the alert action in the "Action Type
Dialog Box" on page 1276.

Notification
Path

Path of the SiteScope node.
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Group Properties
Group Status Details
UI Element

Description
The status of the monitors in the group (Good, Warning, Error,
Disabled or No data). The group status is based on the worst child
(taking the worst status of all SiteScope monitors in the group).

Last Run

The date and time of the last monitor run.

Summary

Displays the number of monitors within the group and the number of
monitors, if any, that are reporting an error status.

General Settings
UI Element

Description

Group
Name

Name that describes the content of the group, or the purpose of the monitors added to
the group. For example, <host_name> or <business_unitresource_name> or
<resource_type>.
Note:
l

l
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The group name cannot contain any of the following characters: ` ; " & | < > / \ + =
The group name is case sensitive. This means that you can have more than one
group with the same name provided they each have a different case structure.
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UI Element

Description

Group
Description of the group. This can include the most common HTML tags for text
Description styling, such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed
only when viewing or editing the group's properties in the SiteScope Dashboard. For
details on adding a hyperlink, see "Add URL links to group descriptions - optional" on
page 247.
Note:
l

l

Source
Template

This field does not support JavaScript/iframes/frames or other advanced features.
HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than
one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected. The following is prohibited HTML content:
n

Tags: script, object, param, frame, iframe.

n

Any tag that contains an attribute starting with on is declined. For example,
onhover.

n

Any attribute with javascript as its value.

If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.

Displays the path of the source template if the group was created from a template.
If you are using deployed templates created in older versions of SiteScope, click the
Browse button, and manually associate the root groups with the source template by
navigating to the source template.
Click the

icon to remove the source template associated with the root group.

Dependencies
UI Element

Description

Depends On The monitor on which you want to make the running of this monitor group dependent.
For concept details, see "Monitoring Group Dependencies" on page 255.
Click the Browse button to open the Select Depends On Monitor dialog box, and
select the monitor on which you want to create a dependency. For user interface
details, see "Select Depends On Monitor Dialog Box" on page 316.
Click the

icon to remove the selected Depends On monitor.

Default: No dependency is set for a monitor group.
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UI Element

Description

Dependency The Dependency Condition that the Depends On monitor should have for the
Condition
current monitor group to run normally. If the selected condition is not satisfied then
the monitor selected in the Depends On box is automatically disabled. The
conditions are:
l

Good

l

Error

l

Available

Alerts
Note: This panel is displayed only if the group has associated alerts.
Displays information about the alerts associated with the selected monitor or group. The fields in this
panel are not-editable.
UI Element

Description

Name

The name by which the alert is known in SiteScope.

Status

The status of the alert (enabled or disabled).

Description

A description of the alert (if one was provided).

Actions

The alert action type and the name given to the alert action in the "Action Type
Dialog Box" on page 1276.

Notification
Path

Path of the group or monitor associated with the alert.

Monitor Properties
Monitor Status Details
UI Element

Description
The status of the monitor (Good, Warning, Error, Disabled or No
data).
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UI Element

Description

Last Run

The date and time of the last monitor run.

Alert Triggering

The status of the triggering mechanism for alerts associated with the
monitor:

Summary

Displays the most recent measurement results reported by the
monitor. This may include more than one measurement, depending
on the monitor type. Click Show All to display all the measurements
if there is insufficient space.
If a monitor is in error status, a description of the error is displayed. If
a monitor has been disabled, it displays the disabled status (disabled
manually, disabled until x time, or disabled by <Downtime Name>
from BSM).
Status details are updated when you run a monitor, or when you
refresh the tree (by default, the status is refreshed each 5 seconds).

General Settings
UI Element

Description

Name

Name that describes the element or system being monitored. Use a useful naming
convention for all monitors to make creating view filters and category assignments
more effective.
Example:<hostname:resource_type> or <business_unit
name monitored_element>

resource_

Note: The monitor name cannot be left blank, or contain any of the following
characters: ` " < >
Monitor
Additional information to describe a monitor. This can include the most common
Description HTML tags for text styling, such as <BR>, <HR>, and <B>. The description is
displayed only when viewing or editing the monitor's properties in the SiteScope
Dashboard.
You can also include HTML tags to enable you to access URLs from the SiteScope
Dashboard. To add a hyperlink, enter the URL (UNC path is supported for Windows
remotes). For example, <a href="http://www.hp.com">My Link</a>. The URL is
displayed in the Description field for the selected monitor in the SiteScope
Dashboard.
Note: This field does not support JavaScript/iframes/frames or other advanced
features.
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UI Element

Description

Report
Optional description for this monitor to make it easier to understand what the monitor
Description does. This description is displayed on each bar chart and graph in Management
Reports.
Example: Network traffic or main server response time.
Monitor Run Settings
UI Element

Description

Monitoring
Frequency

How often SiteScope attempts to run the action defined for the monitor instance.
Each monitor run updates the status of the monitor. Use the drop-down list to
specify increments of seconds, minutes, hours, or days.
Minimum value: 15 seconds

Frequency If
Error

Monitoring interval for monitors that have reported an error condition.
Example: You may want to run the monitor every 10 minutes normally, but as
often as every 2 minutes if an error has been detected. When the monitor's status
is no longer in error, the monitor reverts to the run interval specified in the
Monitoring Frequency setting.
Default value: empty
Note:
l

l
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Increasing the monitor run frequency affects the number of alerts generated by
the monitor.
When configuring this setting in a template, the variable value can only be in
time units of seconds.
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Dependencies
UI Element

Description

Depends On Click Browse to open the Select Dependency dialog box, and select the monitor on
which you want to make the running of this monitor dependent. Use this option to
prevent redundant alerting from multiple monitors that are monitoring different
aspects of a single system.
Example: Create a system monitor to check the basic availability of a system and
then create other monitors that perform more detailed tests of that system. Set the
detailed test monitors to be dependent on the status of the monitor checking basic
availability.
If the system monitor detects that the target system has become unavailable, the
dependency relationship automatically disables the other monitors. This also
disables any alerts that would have been generated by the dependent monitors.
Dependency If you make this monitor dependent on the status of another monitor (by using the
Condition
Depends On setting), use this option to select the status condition of the Depends
On monitor for the current monitor to run normally.
The status categories are:
l

Good

l

Error

l

Available

l

Unavailable

The monitor being configured is run normally as long as the monitor selected in the
Depends On box reports the condition selected in this box.
Example: Select
Good and this monitor is enabled only when the monitor
selected in the Depends On box reports a status of Good. The current monitor is
automatically disabled if the monitor selected in the Depends On box reports a
category or condition other than Good. You can also enable dependent monitors
specifically for when a monitor detects an error.
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Threshold Settings
UI Element

Description

The default status is

Monitor status if the threshold criteria for the monitor instance are not
met. The status categories are:
l

l

l

If unavailable, set

Good
Warning
Error

Status assignment for when the monitor is not available. Select from the
following options:
l

l

l

l

according to Thresholds. The monitor gets a new status according
to the thresholds.
monitor status to Good. The monitor's status is set to Good when it
is unavailable without thresholds being checked.
monitor status to Warning. The monitor's status is set to Warning
when it is unavailable without thresholds being checked.
monitor status to Error. The monitor's status is set to Error when it
is unavailable without thresholds being checked.

Note: A monitor instance can have a status of Unavailable as well as a
status of Good,Warning, or Error. Alerts are triggered according to
availability, status, or both availability and status, depending on how the
alert is configured. For details, see "Configure SiteScope Alerts" on page
1243.
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UI Element

Description

On internal error

Monitor status assignment if a configuration or internal error occurs:
l

l

l

l

l

Add Threshold

set monitor status according to Thresholds. The monitor's status
is set according to its current thresholds if a configuration or internal
error occurs (default setting). It is unreliable to rely on the threshold
since there is no way of knowing at what point the error occurred (and
whether the threshold is based on old data, updated data, or both). For
example, a monitor may remain in its current status even though the
monitor did not run; change status if thresholds were defined that
were not applicable; or trigger false alerts as if a remote was not
available, when in fact, the remote was not contacted.
set monitor status to Error. The monitor's status is set to Error if a
configuration or internal error occurs without thresholds being
checked.
set monitor status to Warning. The monitor's status is set to
Warning if a configuration or internal error occurs without thresholds
being checked.
set monitor status to Good. The monitor's status is set to Good if a
configuration or internal error occurs without thresholds being
checked.
treat monitor as unavailable. The monitor is treated as being
Unavailable if a configuration or internal error occurs without
thresholds being checked.

Creates additional thresholds that determine the monitor status. Select
the status for which you want to add a threshold:

If you select Error, Warning, or Good, for each threshold, select the
metric and operator, and enter a value for the metric.
If you select Default, the default threshold settings are added to the
monitor instance, for the applicable status categories. You can edit any
of the values for the default thresholds.
Trigger
Conditions for the monitor instance to report an Error, Warning, or Good
<Error/Warning/Good> status. For each threshold, select the measurement and operator, and
if
enter a value for the metric.

HP SiteScope (11.31)

Page 1140 of 1395

Using SiteScope
Chapter 98: Manage View

UI Element

Description

<Condition>

Metrics parameter for determining the status of this monitor instance.
The list of metrics is dynamically updated based on the type of monitor
you are configuring.
Default value: Default metrics exist for many monitor types and differ
according to monitor type. For many default metrics, there are
corresponding defaults for the operator and value boxes that are not
editable.

<Operator>

Metrics operator for determining the status of this monitor instance. The
following operators are available:
l

(!=) not equal

l

(<) less than

l

(<=) equal or less than

l

(=) equal

l

(>) greater than

l

(>=) equal or greater than

l

contains - Contains the value entered

l

does not contain - Does not contain the value entered

Note: To indicate data volatility (where current monitor readings
significantly deviate from previous runs), set status thresholds using a
baseline. For details, see "Set Monitor Thresholds Using a Baseline" on
page 326.
<Value>

Value applicable to the metrics parameter.
Note:
l

If a monitor has an activated baseline, its metrics values are noneditable and the Percentiles Table
button is displayed. You can
change baseline threshold values by clicking the button and changing
the current percentile value from the Percentiles Table. For user
interface details, see "Percentile Range Mapping Table" on page 343.

l

HP SiteScope (11.31)

You cannot change the metrics value, operator or schedule for a
baseline threshold condition.

Page 1141 of 1395

Using SiteScope
Chapter 98: Manage View

UI Element

Description

<Select Alert
Schedule>

Range schedule to determine the status of this monitor instance if you
want to define when to check the monitor run result against the threshold.
This is useful, for example, if you want to check the monitor run result
against the threshold only on certain days or during peak hours. The
range schedules created in Schedule Preferences appear in the dropdown list. For more information about creating monitor schedules, see
"Schedule Preferences" on page 712.
Note: When selecting threshold schedules, at least one threshold
schedule must coincide with the Monitor schedule in the Monitor Run
Settings (at least one minute of the monitor run schedule must be
covered by one of the threshold schedules).
Delete. Deletes the selected threshold.

Alerts
Note: This panel is displayed only if the monitor has associated alerts.
Displays information about the alerts associated with the selected monitor or group. The fields in this
panel are not-editable.
UI Element

Description

Name

The name by which the alert is known in SiteScope.

Status

The status of the alert (enabled or disabled).

Description

A description of the alert (if one was provided).

Actions

The alert action type and the name given to the alert action in the "Action Type
Dialog Box" on page 1276.

Notification
Path

Path of the group or monitor associated with the alert.

Create New Group
The Create New Group dialog box enables you to create a new group into which you can deploy
templates.
To access

In Manage view, right-click a group folder or the SiteScope root and select Create >
Group.
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Relevant
tasks

"How to Deploy Monitors from a Template (Application Owner)" on page 1121

See also

"Manage View" on page 1116

General Settings
UI Element

Description

Group
name

Name that describes the content of the group, or the purpose of the monitors added to
the group. For example, <host_name> or <business_unitresource_name> or
<resource_type>.
Note:
l

l

The group name cannot contain any of the following characters: ` ; "& | < > / \ + =
The group name is case sensitive. This means that you can have more than one
group with the same name provided they each have a different case structure.

Group
Description of the group. This can include the most common HTML tags for text
Description styling, such as <BR>, <HR>, and <B>, and hyperlinks. The description is displayed
only when viewing or editing the group's properties in the SiteScope Dashboard. For
details on adding a hyperlink, see "Add URL links to group descriptions - optional" on
page 247.
Note:
l

l
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This field does not support JavaScript/iframes/frames or other advanced features.
HTML code entered in this box is checked for validity and security, and corrective
action is taken to fix the code (for example, code is truncated if it spans more than
one line). If malicious HTML code or JavaScript is detected, the entire field is
rejected. The following is prohibited HTML content:
n

Tags: script, object, param, frame, iframe.

n

Any tag that contains an attribute starting with on is declined. For example,
onhover.

n

Any attribute with javascript as its value.

If the field contains an ampersand (&), less than (<), or greater than (>), they are
automatically escaped, for example, &amp;, &lt;, or &gt;.
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UI Element

Description

Source
Template

Displays the path of the source template if the group was created from a template.
If you are using deployed templates created in older versions of SiteScope, click the
Browse button, and manually associate the root groups with the source template by
navigating to the source template.
Click the

icon to remove the source template associated with the root group.

Dependencies
UI Element

Description

Depends On The monitor on which you want to make the running of this monitor group dependent.
For concept details, see "Monitoring Group Dependencies" on page 255.
Click the Browse button to open the Select Dependency dialog box, and select the
monitor on which you want to create a dependency. For user interface details, see
"Select Depends On Monitor Dialog Box" on page 316.
Click the

icon to remove the selected Depends On monitor.

Default: No dependency is set for a monitor group.
Dependency The Dependency Condition that the Depends On monitor should have for the
Condition
current monitor group to run normally. If the selected condition is not satisfied then
the monitor selected in the Depends On box is automatically disabled. The
conditions are:
l

Good

l

Error

l

Available

Deploy Template Wizard
This wizard enables you to create a group of monitors from an existing user-defined template.
To access

In Manage view, right-click a group folder and select Deploy Template.

Important
To perform actions in the wizard, you must be an administrator in SiteScope, or a user
information granted the necessary permissions. For details on user permissions, see
"Permissions" on page 744.
Relevant
tasks

"How to Deploy Monitors from a Template (Application Owner)" on page 1121

HP SiteScope (11.31)

Page 1144 of 1395

Using SiteScope
Chapter 98: Manage View

See also

"Manage View" on page 1116

User interface elements are described below (unlabeled elements are shown in angle brackets):

Select Template Page
UI
Element

Description

<UserSelect a template to use for deploying monitors. Only user-defined templates are
defined
listed.
templates>
Expand the template container
Use CSV
file

, and select the template

you want to deploy.

Select this check box if you want to deploy the template from an external Comma
Separated Value (CSV) file. The CSV file is used to deploy the variable values defined
in the template. For details on deploying a template using a CSV file, see "Deploy a
Template Using a CSV File" on page 848 and "How to Deploy Templates Using a
CSV File" on page 850.
Click the Browse button (which is only displayed after you select the CSV option),
and select the CSV file to use for template deployment. After selecting a CSV file to
use for template deployment, click the Deploy button to deploy the template.
If the deployment is successful, the template objects are added to the monitor tree.
You can check the silent_deployment.log file for a summary of the deployment. For
user interface details, see "Log Files Page" on page 1184.
Note:
l

l

Encoding

The Use CSV file option is only displayed after you have selected a template.
After you select the CSV option, the Next button is replaced by Deploy button (this
button is inactive until you select a CSV file).

Encoding for the remote server, if the remote server is running an operating system
version that uses a different character encoding than the server on which SiteScope is
running. This enables SiteScope to display encoded content correctly.
Default value: windows -1252

Verify
monitor
properties
with
Remote
Servers

Verifies the correctness of the monitor configuration properties against the remote
servers on which the changes are being made.
Default value: Selected
Note: When this option is selected, it takes more time to make changes due to the
remote connections.
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Select Target Server Page
UI
Element
<Remote
servers>

Description

Displays all remote servers
that have been configured in SiteScope. Select the
target host server or servers on which to deploy the template.
Note: This page is displayed only when using the SERVER_LIST system variable.

User-Defined Template Properties Page
UI Element

Description

<Template Properties>

Displays the variables used in the template objects if the selected
template was defined using template variables. You can use the
predefined values or add your own values. Variable values that are
mandatory are indicated by a red asterisk (*). For details, see
"Template Variables" on page 790.
If the selected template was defined without using template
variables, the properties are automatically filled with the default
values that were defined in template.
Note: This page is displayed only when the template contains
variables that need to be defined.

Template Deployment Summary Page
UI Element

Description

Template

Name of the selected template.

Servers

Lists the target remote servers on which the template is deployed.

Variables

Lists the variable properties and values used in the template
objects.

Verify monitor properties
with remote server

Verifies the correctness of the monitor configuration properties in
the template against the remote server on which the template is
deployed.
Note: When this option is selected, deployment time is slowed
due to the remote connection.
Default value: Selected
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Deployment Results Page
UI Element

Description

Template Name

Name of the deployed template.

Deployment Status

Displays the deployment results.
l

l

. Indicates the deployment was successful, and lists the
number of objects (groups, monitor, alerts, remotes) that were
deployed. When deploying a template using a CSV file, the
results include a link to the log file (silent_deployment.log)
which displays a summary of the deployment. For log file
details, see "Log Files Page" on page 1184.
. Indicates the template deployment failed, and lists reasons
for the failure.

Problems

Lists an error code and a description of the problem.

Groups / Monitors / Alerts /
Remotes Deployed

Lists the number of deployed objects (groups, monitors, alerts,
remote servers) and the deployment status
(Deployed/Deployment Failure) for each object.
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Part 12: SiteScope Server Health
SiteScope provides several key indicators that you can use to monitor the performance of the
SiteScope application.
The SiteScope Server Health is a specially designed group of monitors that display information about
the performance and availability of SiteScope itself. Health monitors retrieve data about SiteScope's
resource usage, key processes, monitor load, server parameters, and the integrity of key configuration
files. For details, see "SiteScope Server Health Monitors" on page 1149.
In addition, you can use the key performance metrics provided in the SiteScope Server Statistics
context for analyzing performance, stability, health, and debugging bottlenecks on the SiteScope
server. This shows load on the SiteScope server, a list of running and recently run monitors, perfex pool
summary, WMI statistics, SSH connections, Telnet connections, and dynamic monitoring statistics. It
also displays the SiteScope log files. For details, see "SiteScope Server Statistics" on page 1176.
You can also get an overview of SiteScope server load and performance statistics directly from the
SiteScope Health Map and Performance Statistics logs without having to open the SiteScope user
interface. For details, see "SiteScope Health Map and Performance Statistics Logs" on page 1238.
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SiteScope Server Health is a specially designed group of monitors that display information about the
performance and availability of SiteScope itself. Health monitors retrieve data about SiteScope's
resource usage, key processes, monitor load, server parameters, and the integrity of key configuration
files.
Tip: You can also get an overview of SiteScope server performance using the "SiteScope Server
Statistics" on page 1176 context or from the "SiteScope Health Map and Performance Statistics
Logs" on page 1238.

To access
Select the Monitors context. In the monitor tree, click the Health container to view the collection of
available health monitors that are deployed.

Learn About
SiteScope Server Health Overview
By default, the daily monitor logs record the SiteScope Health monitoring data and let you can create
reports on SiteScope's performance and operational health. These log files are useful for understanding
SiteScope performance issues, for troubleshooting monitor and alert problems, and for reviewing
SiteScope management actions. For example, SiteScope's audit log contains configuration changes
performed in the new user interface, such as creation of monitors, templates, alerts, and so forth.
Together with the SiteScope Health monitoring, the SiteScope Progress Report provides several key
indicators you use to monitor the performance of the SiteScope application.

SiteScope Health Group
SiteScope Health monitors can monitor several key aspects of its own environment to help uncover
monitor configuration problems as well as SiteScope server load. SiteScope can also monitor its
connectivity and related data events when connected to BSM.
Similar to regular monitors, Health monitors can be edited to reconfigure their frequency and thresholds.
Administrators can enhance the Health group by adding new monitors targeting additional servers and
environments.
The Health monitor group is displayed as a health icon within the main SiteScope container. You view
the contents of the Health monitor group by clicking the Health container.
SiteScope Health monitoring includes the following monitor types:
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Monitor
Type

Description

BAC
Checks the correctness of the configuration between SiteScope and BAC/BSM
Integration
when SiteScope is configured as a data collector for BAC/BSM. For details, see
Configuration "BAC Integration Configuration Monitor" on page 1155.
BAC
Integration
Statistics

Checks the traffic volume between SiteScope and BAC/BSM when SiteScope is
configured as a data collector for BAC/BSM. For details, see "BAC Integration
Statistics Monitor" on page 1158.

Connection
Statistics

Checks the status of SSH and Telnet connections when used to connect to remote
UNIX or Windows servers. Also checks Perfex and Perfex dispatcher statistics and
statuses for each perfex pool. For details, see "Connection Statistics Monitor" on
page 1159.

Dynamic
Monitoring
Statistics

Checks performance of the dynamic monitoring framework when you have dynamic
monitors defined. For details, see "Dynamic Monitoring Statistics Monitor" on page
1163.

Health of
SiteScope
Server

Checks a large number of server process and resources for the server on which
SiteScope is running. For details, see "Health of SiteScope Server Monitor" on page
1165.

License
Usage

Checks the availability and usage of SiteScope OS Instance, URL, and Transaction
licenses. For details, see "License Usage Monitor" on page 1169.

Log Event
Checker

Checks for certain events logged to the SiteScope error log. For details, see "Log
Event Checker Monitor" on page 1171.

Monitor Load
Checker

Checks for data about the number of monitors being run or waiting to run. For details,
see "Monitor Load Checker Monitor" on page 1173.

SSL
Certificates
State

Checks the state of SSL certificates in the default keystore. For details, see "SSL
Certificates State Monitor" on page 1174.

Skipped Monitor Events
A SiteScope monitor is reported as skipped if the monitor fails to complete its actions before it is
scheduled to run again. This can occur with monitors that have complex actions to perform, such as
querying databases, stepping through multi-page URL sequences, waiting for scripts to run, or waiting
for an application that has hung.
For example, assume you have a URL Sequence Monitor that is configured to transit a series of eight
Web pages. This sequence includes performing a search which may have a slow response time. The
monitor is set to run once every 60 seconds. When the system is responding well, the monitor can run
to completion in 45 seconds. However, at times, the search request takes longer and then it takes up to
90 seconds to complete the transaction. In this case, the monitor has not completed before SiteScope
is scheduled to run the monitor again. SiteScope detects this and makes a log event in the
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SiteScopeskip_monitor.log. The SiteScope Log Event Monitor detects this and signals an error
status. For log file details, see "Log Files Page" on page 1184.
A monitor may also skip if it is a monitor type that requires a process from the process pool but the
process pool limit has been reached. Generally, this is not likely to happen but may occur in some
situations with high monitoring load. The SiteScope Health Log Event Monitor also watches for process
pool events. Skipped monitors can cause loss of data when a monitor run is suspended due because a
previous run has not completed or has become hung by a unresponsive application. They can also
cause SiteScope to automatically stop and restart itself, an event that is also monitored by the
SiteScope Health Log Event Monitor. A restart is done in an effort to clear problems and reset monitors.
However, this can also lead to gaps in monitoring coverage and data. Adjusting the run frequency at
which a monitor is set to run or specifying an applicable timeout value can often correct the problem of
skipping monitors.
Note:
l

l

You can enable a setting that automatically disables monitors that exceed the maximum
allowed skip count. If this occurs, SiteScope shuts down with an error and sends an email to
the SiteScope administrator about the skipping monitor to signal the disable event. To enable
this setting: In the preferences view, click Infrastructure Preferences, and expand the Skip
Monitor Settings panel. Select the Shutdown on monitor skips check box. You can also
determine the time period that a monitor is disabled. For details on skipped monitor settings,
see "Infrastructure Preferences" on page 608.
You can control the maximum number of processes available. Only change this setting if
adjustments to monitor configurations do not resolve the monitor performance problems. The
initial value is 200 processes per pool (by default, the maximum processes per pool is 20). To
change this setting: In the preferences view, click Infrastructure Preferences, and expand the
General Settings panel. Configure the number of processes in the Maximum processes per
pool box.

For information on troubleshooting monitor skipping, see "Tips/Troubleshooting" on page 1154.

Tasks
How to Analyze SiteScope Health Monitor Data
This task describes the steps involved in analyzing SiteScope Health monitor data and viewing the
SiteScope log files and server statistics.
1. Prerequisites
To access the log files and the Progress Report, you must have the correct user privileges.
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a. In the left pane, click Preferences and select User Management Preferences.
b. Right-click the user name, and select Edit User.
c. In the Edit User Profile dialog box, expand Permissions.
d. In the Other section, make sure that View server statistics and View logs are selected
(these settings are selected by default).
2. Deploy SiteScope Health monitors
Note: The SiteScope health monitors are normally present, because they are enabled
automatically when SiteScope is deployed.
If the SiteScope Health monitors are not present when you import a SiteScope to System
Availability Management in BSM, you must deploy the monitors.
For task details, see "How to Deploy SiteScope Health Monitors" on the next page.
3. View SiteScope Health monitors
You can view the data collected by the SiteScope Health monitors in the SiteScope Dashboard.
For the list of SiteScope Health monitors, see "SiteScope Health Group" on page 1149.
Example: Health monitors in the SiteScope Dashboard

4. View SiteScope log files
You can view the various SiteScope log files in the Log Files page in the Server Statistics context.
For user interface details, see "Log Files Page" on page 1184.
Example: Log files in the Log Files tab
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5. View monitor performance data
You can view the load on the SiteScope server and a list of the most recently run monitors in the
Server Statistics context.
For concept details, see "SiteScope Server Statistics" on page 1176.

How to Deploy SiteScope Health Monitors
This task describes how to deploy SiteScope Health monitors to a SiteScope installation if the
monitors were not present when you imported a SiteScope to System Availability Management in
BSM.
Note: This task is part of a higher-level task. For details, see "How to Analyze SiteScope Health
Monitor Data" on page 1151.
1. Open the SiteScope container to which you want to display the Health monitors. Confirm that the
SiteScope includes the Health monitor group container.
Note: The Health monitor group container is identified with a health indicator icon.
2. Find the Health Templates in the monitor tree. Click to expand the container contents. The
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available Health monitor templates are displayed.
3. Select the Health monitor template for the operating system on which the SiteScope you want to
monitor is running. The choices are:
n

UNIX Health Monitors

n

Windows Health Monitors

4. Right-click the template icon and select Copy from the action menu.
5. Right-click the Health monitor group container of the SiteScope to which you want to deploy the
Health monitors and select Paste. The monitors in the selected template are then configured and
deployed to the selected SiteScope server.

Tips/Troubleshooting
Troubleshooting Skipped Monitors
Problem: Monitors start skipping and there are a number of Waiting threads in the threads dump.
Possible Cause: This could be caused by the JVM being blocked by an infinite loop problem between
the JVM and libc when using the IPv6 getaddrinfo() libraries with IPv4 addresses. The default is to
prefer the IPv6 stack.
Possible Solution: Configure the java processes to prefer the IPv4 stack by specifying the following
JVM argument:
-Djava.net.preferIPv4Stack=true
This starts the monitor script and restarts SiteScope.

SiteScope on Linux restarts whenever there are more than 10 processes in the defunct
state.
This issue was fixed by adding the _sisDefunctProcessNumber parameter to the <SiteScope
root>\groups\master.config file, which enables you to set the number of defunct processes.

Problems Reporting Data to BSM
SiteScope Health monitors are also configured to report events that indicate a problem with the transfer
of SiteScope monitor and configuration data to a BSM installation.
Notes and limitations on reporting data to BSM:
l

SiteScope reports numeric metric values only to BSM. It does not report metrics containing string
values.
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l

l

Unable to register SiteScope in an HP SaaS environment if its BSM SaaS user contains special
characters, such as the @ sign. The BSM user account should contain alphabetic and/or numeric
characters only.
Due to the complexity of some monitoring deployments and network communications, SiteScope
may be temporarily unable to communicate with the BSM server. SiteScope Health monitoring
includes several monitors for watching connectivity and data transfers to the BSM server.
If SiteScope is unable to connect to the BSM Server, SiteScope continues to record and store
monitor data files locally. After the number of data files exceeds a specified threshold, SiteScope
saves the data files in a cache folder with the syntax <SiteScope root
directory>\cache\persistent\topaz\data<index>.old. It also saves the heartbeat samples to
bus_<index>.old and configuration samples to config_<index>.old. You can configure the
number of data.old folders to keep by modifying the _topazMaxOldDirs property in the
<SiteScope root directory>\groups\master.config file.
Note: By default, the threshold number of data files is set to 1,000 files. You can change this
setting by modifying the _topazMaxPersistenceDirSize property in the master.config file.
After the connection between SiteScope and the Agent Server is restored, you must manually
copy the files from these folders to the <SiteScope
root directory>\cache\persistent\topaz\data folder.
We recommend that you only copy these files when the data folder is empty to avoid
overloading the system with large amounts of data to upload. When the number of data.old
folders exceeds a specified threshold, by default 10 folders, the oldest folders are deleted.

BAC Integration Configuration Monitor
Use the BAC Integration Configuration monitor to track the correctness of SiteScope's integration with
the BAC/BSM configuration. This monitor is useful for viewing the number of groups, monitors, and
measurements reporting to BAC/BSM that have an invalid path, internal name, or ID. It also displays
the number of duplicate Topaz IDs, and instances where the Topaz ID is (-1).
Note: Monitor data is relevant only if SiteScope is integrated as a data collector for BAC/BSM.

To access
Select the Monitors context. In the monitor tree, expand Health and click BAC Integration
Configuration.
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Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BAC/BSM)
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UI Descriptions
BAC Integration Configuration Monitor Settings
User interface elements are described below:
UI
Element
Counters

Description
l

Total Groups. Total number of groups reporting data to BAC/BSM.

l

Total Monitors. Total number of monitors reporting data to BAC/BSM.

l

l

l

l

l

l

l

l

l

Duplicate BAC ID. Number of duplicate BAC IDs reported to BAC/BSM. Every
SiteScope object has a unique BAC ID. If two objects have the same ID, only one of
these objects can send its data to BAC/BSM. For troubleshooting on this subject,
see "Tips/Troubleshooting" on the next page.
BAC ID == (-1). Every SiteScope object has a unique BAC ID. If the ID value for a
SiteScope object is (-1), SiteScope does not send its data to BAC/BSM. For
troubleshooting on this subject, see "Tips/Troubleshooting" on the next page.
Group with invalid path. If the SiteScope group does not have a valid path,
SiteScope does not send the group to BAC/BSM.
Groups with duplicate name. If the SiteScope group does not have a unique
internal name, SiteScope does not send the group to BAC/BSM.
Monitor with invalid path. If the SiteScope monitor does not have a valid path,
SiteScope does not send the monitor to BAC/BSM.
Monitors without internal ID. If the SiteScope monitor does not contain a unique
internal ID, SiteScope does not send the monitor to BAC/BSM.
Monitors without internal name. If the SiteScope monitor does not contain a valid
internal name, SiteScope does not send this monitor to BAC/BSM.
Measurements with wrong category ID. If SiteScope measurements do not
contain a valid category ID, SiteScope does not send the measurements to
BAC/BSM. For troubleshooting on this subject, see "Tips/Troubleshooting" on the
next page.
Target with BSM ID == (-1). Every remote target has a unique BAC ID. If the ID
value is (-1), SiteScope does not send its data to BAC/BSM. For troubleshooting on
this subject, see "Tips/Troubleshooting" on the next page.

Note: For information on configuring setting panels that are common to all monitors, see "Common
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Monitor Settings" on page 283.

Tips/Troubleshooting
General Notes/Limitations
If there are objects with duplicate BAC IDs or with BAC ID == (-1):

l

n

Open a JMX Console (there is one provided in <SiteScope root
directory>\java\bin\jconsole.exe), and enter 28006 (the default port) in the Port field.

n

In the MBeans tab, select com.mercury.sitescope/Integration/Bac/Tools/
BacIntegrationToolsJMX.

n

l

o

For objects with duplicate BAC IDs, activate fixDuplicateBACConfiguration().

o

For objects with BAC ID == (-1), activate fixMinusOneBACConfiguration().

It is also recommended to activate softSync() to send the new configuration to BAC/BSM.
If measurements have the wrong category ID, restart SiteScope.

BAC Integration Statistics Monitor
Use the BAC Integration Statistics monitor to check the health of BSM/BAC. This health monitor
enables you to track the volume of traffic between SiteScope and BAC/BSM. SiteScope sends metrics
to BAC/BSM every minutes.

Note: Monitor data is relevant only if SiteScope is integrated as a data collector for
BAC/BSM.

To access
Select the Monitors context. In the monitor tree, expand Health and click BAC Integration
Statistics.
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Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BAC/BSM)

UI Descriptions
BAC Integration Statistics Monitor Settings
User interface elements are described below:
UI
Element
Counters

Description
l

l

Currently Logging to Business Availability Center. Displays the amount of
metrics currently logging per minute to BAC/BSM.
Number of Topology Scripts in Queue. Displays the number of topology scripts
waiting to be run. These scripts forward topology data to BAC/BSM and must be run
whenever there is a configuration change in SiteScope. The queue can grow when a
SiteScope is first registered to BAC/BSM or when there are many configuration
changes made in the SiteScope.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.

Connection Statistics Monitor
Use the Connection Statistics monitor to collect data on SSH and Telnet connection behavior and
statistics for the Perfex and Perfex dispatcher pool. This provides an overview of global connection
handles which is useful for analyzing connection problems and remote server configuration issues.

To access
Select the Monitors context. In the monitor tree, expand Health and click Connection Statistics
Monitor.
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Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)
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UI Descriptions
Connection Statistics Monitor Settings
User interface elements are described below:
UI Element

Description

SSH
Connection
Counters

l

l

l

l

l

l

l

l

HP SiteScope (11.31)

Total opened. Total number of all opened SSH connections. If this number is
significantly higher than the Currently allocated resources counter, this
indicates a configuration problem. Check the following:

l

n

Connection cache was disabled

n

An incorrect login or password was used

n

The remote server timeout is too short
Total closed. The number of SSH connections closed since the last SiteScope
restart.
Total failed to open V1. The number of SSH connections that failed to open
using SSH version 1. By default, SiteScope tries to connect using V1 before
trying to connect with V2. If this number is high, we recommend selecting the
SSH version 2 only option on the problematic remote server.
Total failed to open V2. The number of SSH connections that failed to open
using SSH version 2. If this number is high, verify the correct login and
password was used for the remote server, and verify the SSH version on the
remote server (V1 or V2).
Reused. The number of reused SSH connections since the last SiteScope
restart.
Currently allocated resources. The number of SSH connections that are
currently open.
Currently in use. The number of SSH connections that are currently open and
in use running monitors.
Average call time for last 10 minutes. Average call time during the last
minutes.
Total Average Call Time. Average call time.
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UI Element

Description

Telnet
Connection
Counters

Total opened. The number of telnet connections opened since the last
SiteScope restart.

l

Total closed. The number of telnet connections closed since the last SiteScope
restart.

l

Reused. The number of reused telnet connections since the last SiteScope
restart.

l

Currently allocated resources. The number of telnet connections that are
currently open.

l

Currently in use. The number of telnet connections that are currently open and
in use running monitors.

l

Perfex/Perfex
dispatcher
Connection
Counters

l

Idle processes. The number of processes currently in idle state.

l

Used processes. The number of processes currently in used state.
Total processes. The total number of processes (idle processes + used
processes).

l

Process pool queue length. The number of monitors currently waiting for an
available perfex. This value can indicate that there are too many monitors
running on perfex, or that the perfex pool is too small.

l

Average wait time for free process. The average amount of time to wait, in
milliseconds, for a process to be available. If this value exceeds 30,000
milliseconds (30 seconds), monitors will start to fail. A high average wait time
indicates that you need to increase the number of processes in the pool.

l

Average run time. The average amount of time, in milliseconds, that a perfex
takes to run. This gives an indication of the following:

l

l

n

Network speed. The amount of time it takes to send a request and receive a
response from the server.

n

Perfex availability. How long it takes on average to complete the run and to
return the perfex to the pool.

n

The number of monitors using perfex.
Processes waiting for server timeout. The number of processes that have
exceeded the call timeout and are waiting for a server timeout to close the
connection, or that are waiting for an answer to return to the pool.

Note: For information on configuring setting panels that are common to all monitors, see "Common
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Monitor Settings" on page 283.

Dynamic Monitoring Statistics Monitor
Use the Dynamic Monitoring Statistics monitor to get an overview of the performance of the dynamic
monitoring framework when you have dynamic monitors defined. It is useful for viewing performance
statistics and for analyzing problems when using the dynamic monitoring mechanism to automatically
update dynamic monitoring counters and thresholds.

To access
Select the Monitors context. In the monitor tree, expand Health and click Dynamic Monitoring
Statistics.
This information is also available from the Server Statistics context by clicking the Dynamic
Monitoring tab.

Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)

UI Descriptions
Dynamic Monitoring Statistics Monitor Settings
User interface elements are described below:
UI Element

Description

Definitions:
*Dynamic task. The periodic action of retrieving counters from the server, and finding among them
the counters that match the patterns defined for the monitor.
**Counters file. Counters are saved to an xml file located under the <SiteScope root
directory>\templates.application folder.
Average task run time
(milliseconds)
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UI Element

Description

Average task run time during last
10 minutes (milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to run during the last 10 minutes.

Average task wait time
(milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to start running since the time it was
received.

Average task wait time during last
10 minutes (milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to start running since the time it was
received, during the last 10 minutes.

Number of clashes between
dynamic monitoring framework
and concurrent user changes
during last 10 minutes

Number of times unable to save dynamic monitoring
framework changes as a result of the user making
concurrent changes (so as not to override user changes),
during the last 10 minutes.

Number of times the maximum
number of matching counters was
exceeded during last 10 minutes

Number of times that the matching counters (for patterns)
from the server exceeded the limit during the last 10
minutes.

Number of times there were no
matching counters from server
during last 10 minutes

Number of times there were no matching counters for
patterns from the server during the last 10 minutes.

Number of times unable to extract
counters from file during last 10
minutes

Number of times unable to extract counters from the
counters file** (during the last 10 minutes.

Number of times unable to retrieve
counters from server during last 10
minutes

Number of times unable to retrieve counters from the server
during the last 10 minutes.

Number of times unable to run
dynamic tasks because of resource
exhaustion during last 10 minutes

Number of times unable to run dynamic tasks* because the
maximum dynamic monitoring framework thread pool and
queue size limits were reached, during the last 10 minutes.
You can configure these settings in Preferences >
Infrastructure Preferences > Dynamic Monitoring
Settings. For details, see "Infrastructure Preferences" on
page 608.

Number of times unable to save
changes during last 10 minutes

Number of times unable to save counter changes to
SiteScope persistency during the last 10 minutes.

Number of unsaved counter files
during last 10 minutes

Number of times unable to delete existing counter files** or
save new counter files during the last 10 minutes.

Note: For information on configuring setting panels that are common to all monitors, see "Common
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Monitor Settings" on page 283.

Health of SiteScope Server Monitor
Use the Health of SiteScope Server monitor to check server resources and process statistics on the
server where SiteScope is running. This includes monitors for CPU, disk space, memory, and key
processes.
A problem with resource usage on the SiteScope server may be caused by monitors with configuration
problems or may simply indicate that a particular SiteScope is reaching it performance capacity. For
example, high CPU usage by SiteScope may indicate that the total number of monitors being run is
reaching a limit. High disk space usage may indicate that the SiteScope monitor data logs are about to
exceed the capacity of the local disk drives. For details on SiteScope data logging options, see "Log
Preferences Overview" on page 700.

To access
Select the Monitors context. In the monitor tree, expand Health and click Health of SiteScope
Server.

Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)

UI Descriptions
Health of SiteScope Server Monitor Settings
User interface elements are described below:
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UI Element

Description

Counters (on UNIX)

Current Monitors Run Per Minute
Current Monitors Running
Current Monitors Waiting
Maximum Monitors Run Per Minute
Maximum Monitors Running
Maximum Monitors Waiting
Used Disk Space on SiteScope Drive (accessible on SiteScope installed
on UNIX)
MegaBytes Available on SiteScope Drive
Physical Memory Free
Physical Memory Free Megabytes
Swap Free
Swap Free Megabytes
Load Avg 5min
SiteScope Process Memory
SiteScope Process Thread Count
SiteScope Process Handle Count
Average CPU
PageIns/sec
PageOuts/sec
SwapIns/sec
SwapOuts/sec
ContextSwitches/sec
Net_TotalPacketsIn/sec
Net_TotalPacketsOut/sec
Net_TotalCollisions/sec
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UI Element

Description

Counters (on
Windows)

Memory
Page Faults/sec
Pool Paged Bytes
Pool Nonpaged Bytes
% Committed Bytes In Use
Available MBytes
System
Context Switches/sec
File Data Operations/sec
System Up Time
Processor Queue Length
Processes
Threads
Processor
_Total
l

% Processor Time
% DPC Time

Process
java
l

Thread Count
Pool Paged Bytes
Pool Nonpaged Bytes
Handle Count

Network Interface
MS TCP Loopback interface
l

Bytes Total/sec
Current Bandwidth
Bytes Received/sec
Bytes Sent/sec
<Ethernet_hardware> (hardware specific to the particular SiteScope
server)
Bytes Total/sec
Current Bandwidth
Bytes Received/sec
Bytes Sent/sec

LogicalDisk
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UI Element

Description
<logical_drive> (hardware specific to the particular SiteScope server)
l

% Free Space
Free Megabytes
Avg. Disk Bytes/Transfer

_Total
l

% Free Space
Free Megabytes
Avg. Disk Bytes/Transfer

PhysicalDisk
_Total
l

Current Disk Queue Length
Disk Transfers/sec

<physical_disk(s)> (hardware specific to the particular SiteScope server)
l

Current Disk Queue Length
Disk Transfers/sec

Server
Bytes Total/sec
Errors Logon
Errors Access Permissions
Errors System
Files Open
Server Sessions

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.

Tips/Troubleshooting
Notes/Limitations
l

l

Process/perfex counters were removed from the SiteScope Server Health monitor and are no longer
supported.
When working in template mode, the maximum number of counters that you can select is 100. If
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you import a template monitor from an earlier version of SiteScope, or perform a copy to template
action, the number of counters is not limited.

License Usage Monitor
Use the License Usage Monitor to check the availability and usage of SiteScope licenses for the local
SiteScope installation. It displays the number of OS Instance, URL, and Transaction licenses
available, being used, and remaining, the total number of license days remaining, and the license status
if the license capacity used by SiteScope exceeds the license capacity available.

To access
Select the Monitors context. In the monitor tree, expand Health and click License Usage Monitor.

Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)
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UI Descriptions
License Usage Monitor Monitor Settings
User interface elements are described below:
UI Element

Description

Threshold

Counters

License days remaining

Error if < 10 days
Warning if < 30 days

License type
OS Instance licenses % remaining

Error if < 10
Warning if < 30

OS Instance licenses remaining
OS Instance licenses total
OS Instance licenses used
Over-licensed status

Error if == 'true'

status

Error if != 'ok'
Good if == 'ok'

Transaction licenses % remaining
Transaction licenses remaining
Transaction licenses total
Transaction licenses used
URL licenses % remaining

Error if < 10
Warning if < 30

URL licenses remaining
URL licenses total
URL licenses used

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.
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Log Event Checker Monitor
Use the Log Event Monitor to monitor the local SiteScope installation error.log file for certain events.
These events include log entries indicating that a monitor has been skipped or there was a problem in
reporting data to another application.
When an error is detected (for example, a monitor skips), the Log Event Health monitor remains in error
status until you click the Reset button in Log Event Health Monitor Settings.

To access
Select the Monitors context. In the monitor tree, expand Health and click Log Event Checker.

Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)

UI Descriptions
Log Event Health Monitor Settings
User interface elements are described below:
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UI
Element
Counters

Description
l

skipped #1. A monitor has skipped its scheduled run once.

l

skipped #2. A monitor has skipped its scheduled run two times.

l

skipped #3. A monitor has skipped its scheduled run three times.

l

skipped #4. A monitor has skipped its scheduled run four times.

l

skipped #5. A monitor has skipped its scheduled run five times.

l

SiteScope is shutting down. SiteScope has been shut down.

l

l

l

l

l

l

l

Reached the limit of processes in the process pool. The number of processes
requested from the process pool exceeds the number of processes available in the
pool.
Error. data reporter failed to report chunk of data. There was a fault in the
transfer of SiteScope monitor measurement data to BSM.
Error. config reporter failed to report chunk of data. There was a fault in the
transfer of SiteScope configuration data to System Availability Management in BSM.
Error. HP Business Service Management failed to process data. BSM reported
a fault in processing data sent from SiteScope.
Error. CacheSender. Got to the max number of cached files. SiteScope has
reached the maximum number of cached data file awaiting transfer to BSM. This
may occur if data transfer between SiteScope and BSM has been interrupted.
Error. CacheSender. Got to the max old dir size. SiteScope has reached the
maximum directory size for cached data file awaiting transfer to BSM. This may
occur if data transfer between SiteScope and BSM has been interrupted.
HP Business Service ManagementSEVERE. BSM reported a data transfer or
processing fault with a status of SEVERE.

l

Commit verification failed.

l

Error loading monitor.

l

Error contacting mirror server.

l

Error: open SSH connections limit reached.

l

Error: failure in baseline process.

l

Error: failed to parse rule.
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UI
Element

Description
l

Reset
counter
values

Topology Reporter failed to report.

Resets the monitor counter values to 0.
Note: When an error is detected (for example, a monitor skips), the Log Event Health
monitor remains in error status until you click the Reset button.

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.

Monitor Load Checker Monitor
Use the Monitor Load Checker monitor to check how many monitors are running and how many are
waiting to be run.
Watching monitor load is important to help maintain monitoring performance and continuity. If the
number of monitors waiting approaches or exceeds the number of monitors running, adjustments
should be made to monitor configurations to reduce the number of monitors waiting to run. Generally,
this can be done by reducing the run frequency of some monitors.

To access
Select the Monitors context. In the monitor tree, expand Health and click Monitor Load Checker.

Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)
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UI Descriptions
Monitor Load Checker Monitor Settings
User interface elements are described below:
UI Element
Counters

Description
l

Current Monitors Run Per Minute

l

Current Monitors Running

l

Current Monitors Waiting

l

Maximum Monitors Run Per Minute

l

Maximum Monitors Run Per Minute Measured On Time

l

Maximum Monitors Running

l

Maximum Monitors Running Measured On Time

l

Maximum Monitors Waiting

l

Maximum Monitors Waiting Measured On Time

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.

SSL Certificates State Monitor
Use the SSL Certificates State monitor to check the state of SSL certificates in the default keystore
(<SiteScope root directory>\java\lib\security\cacerts). This is where client certificates that are
imported for monitoring URL, WebSphere Application Server, or VMware-based servers are stored.

To access
Select the Monitors context. In the monitor tree, expand Health and click SSL Certificates State.
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Tasks
Related tasks
l

l

"How to Analyze SiteScope Health Monitor Data" on page 1151
"How to Deploy SiteScope Health Monitors" on page 1153 (if Health monitors were not present
when you imported a SiteScope to System Availability Management in BSM)

UI Descriptions
SSL Certificates State Monitor Settings
User interface elements are described below:
UI Element

Description

Days before
expiration

If a certificate is due to expire within the specified number of days (but has not yet
expired), it is added to the Certificates expiring soon counter.
Default value: 7 days

Counters

l

l

Expired certificates. Comma-separated list of already expired certificates
Certificates expiring soon. Comma-separated list of certificates that are due to
expire within the period specified in Days before expiration.

l

Number of expired certificates

l

Number of certificates expiring soon

Note: For information on configuring setting panels that are common to all monitors, see "Common
Monitor Settings" on page 283.
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The SiteScope Server Statistics context provides an overview of several key SiteScope server
performance metrics that can be used for analyzing SiteScope performance, stability, health, and for
debugging bottlenecks. It includes statistics that show load on the SiteScope server, a list of running
monitors and the most recently run monitors, perfex pool summary, WMI statistics, SSH connections,
Telnet connections, and dynamic monitoring statistics. It also displays the SiteScope log files. The
Server Statistics context is updated every 20 seconds.
Tip: Alternatively, you can get an overview of SiteScope server performance using the "SiteScope
Health Map and Performance Statistics Logs" on page 1238. These logs provide easy access to
SiteScope load and performance statistics without having to open the SiteScope user interface.

To access
Select the Server Statistics context, and then select the required Server Statistics menu option in the
left pane.

Learn About
Server Statistics Overview
The Server Statistics context includes the following pages:
Page

Description

Dynamic
Monitoring

Displays statistics when using the dynamic monitoring mechanism to automatically
update counters and thresholds for dynamic monitors. For details of the user
interface, see "Dynamic Monitoring Page" on page 1181.

General

Displays key SiteScope server load statistics, including the number of monitors
running and waiting, and a list of running monitors by type. For details of the user
interface, see "General Page" on page 1183.

Log Files

Displays the list of log files in SiteScope that are useful for understanding SiteScope
performance issues, for troubleshooting monitor and alert problems, and for
reviewing SiteScope management actions. For details of the user interface, see
"Log Files Page" on page 1184.

Perfex
Process
Pool

Displays a process manager summary, and statistics tables for the perfex and
perfex_dispatcher pools. For details of the user interface, see "Perfex Process Pool
Page" on page 1190.
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Page

Description

PowerShell
Process
Pool

Displays a statistics tables for the PowerShell process pool which is used by the
Microsoft Exchange Base monitor. For details of the user interface, see "PowerShell
Process Pool Page" on page 1192.

Running
Monitors

Displays a list of which SiteScope monitors are running, and which monitors have
run recently, at what time, and what was the returned status. For details of the user
interface, see "Running Monitors Page" on page 1193.

SSH
Displays SSH statistics and SSH connection summary when using SSH to connect
Connections to remote UNIX or Windows servers. For details of the user interface, see "SSH
Connections Page" on page 1195.
Telnet
Displays telnet statistics when using telnet to connect to remote UNIX or Windows
Connections servers. For details of the user interface, see "Telnet Connections Page" on page
1196.
WMI
Statistics

Displays the process manager summary for Windows Management Instrumentation
(WMI) statistics. For details of the user interface, see "WMI Statistics Page" on
page 1198.

SiteScope Log Files
SiteScope maintains a number of log files that are useful for understanding SiteScope performance
issues, for troubleshooting monitor and alert problems, and for reviewing SiteScope management
actions.
Log files can be accessed using the Log File menu in the Server Statistics context. When you click a
log file, a new browser window opens displaying the text of the log file. You can use the scroll bars to
view the contents of the log or use the browser's text Find utility to locate specific information. For
example, you can search for a unique text string that appears in a monitor's Name property to locate
entries for a particular monitor instance. For details on the various SiteScope log files, see "Log Files
Page" on page 1184 and "Audit Log File" on page 1199.
The log files are written in plain text and stored in the <SiteScope_root_path>\logs directory. In the
default configuration, these log files are tab-delimited text files. Understanding the order and content of
these files is useful for examining particular monitor results or for porting the SiteScope monitor results
to another database. For details, see "SiteScope Log File Columns" on the next page.
Note: SiteScope log files do not support Unicode characters—all non-English characters appear
corrupted in the logs. As a workaround, use a SiteScope server installed on a corresponding
operating system locale. For example, use SiteScope installed on a Japanese Windows operating
system for a Japanese locale.

Accessing SiteScope Log Files
SiteScope maintains a number of log files that are useful for understanding SiteScope performance
issues, for troubleshooting monitor and alert problems, and for reviewing SiteScope management
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actions.
Log files can be accessed using the Log File menu in the Server Statistics context. When you click a
log file, a new browser window opens displaying the text of the log file. You can use the scroll bars to
view the contents of the log or use the browser's text Find utility to locate specific information. For
example, you can search for a unique text string that appears in a monitor's Name property to locate
entries for a particular monitor instance. For details on the various SiteScope log files, see "Log Files
Page" on page 1184 and "Audit Log File" on page 1199.
The log files are written in plain text and stored in the <SiteScope_root_path>\logs directory. In the
default configuration, these log files are tab-delimited text files. Understanding the order and content of
these files is useful for examining particular monitor results or for porting the SiteScope monitor results
to another database. For details, see "SiteScope Log File Columns" below.
Note: SiteScope log files do not support Unicode characters—all non-English characters appear
corrupted in the logs. As a workaround, use a SiteScope server installed on a corresponding
operating system locale. For example, use SiteScope installed on a Japanese Windows operating
system for a Japanese locale.

SiteScope Log File Columns
When SiteScope runs a monitor instruction to test the availability of components in the infrastructure,
the monitor results are written to data log files. The first six columns of each log entry in a SiteScope
monitor data log are the same for each monitor type. After the first six columns of each log entry, the
content of each column is specific for each monitor type (see specific monitor listed below).
Note: Field names change dynamically according to your SiteScope monitor configuration. To
manually generate a list of field names for data logged to a database, see "How to Generate Field
Names for Data Logged to a Database" on page 702.
The following table describes the content of these columns. The columns in each log file are written as
tab-delimited text.
Column Data in Column
1

Time and date the sample was recorded.

2

Category (for example, good, error, warning, nodata).

3

Monitor group name where the monitor defined (also called ownerID).

4

Monitor title text.

5

stateString (this is the status string that shows up on the Group details page).

6

id:sample number (a unique ID for this monitor where group + id is a unique key for a
monitor). The sample number is a unique sample number for that monitor.

For log file columns for specific monitors, see "Monitor Specific Log Column Content" on page 1206.
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Interpreting SiteScope Server Load Statistics
Monitoring Load can be a key indicator of SiteScope scaling problems, monitor configuration problems,
or network performance issues. The following is a brief explanation of the SiteScope monitor execution
model and interpreting the server performance data in the context of this model.
A SiteScope monitor instance is essential as an instruction set that is run by the SiteScope application
on a regularly scheduled interval. While a monitor instance is defined, SiteScope queues the monitor for
execution based on the run (update) frequency and schedule options. If the monitor instance is marked
as disabled, it is still scheduled in the queue but the normal instructions are not run.
As a Java-based application, SiteScope makes use of multi-threading to accomplish parallel execution
of monitor tasks. Each monitor instance scheduled for execution is assigned a thread. Once it is
assigned a thread, the monitor instance becomes a Monitor Running. It remains bound to the thread
until the monitor execution instruction has either received a result or the timeout value, if applicable,
has been reached.
Even in this model, monitor execution is not instantaneous and there is a finite limit to the number of
monitor threads that can be run in parallel. If not more threads are available, a monitor that is queued for
execution becomes a Monitor Waiting for an execution thread.
It is difficult to assign specific values and limits to SiteScope Monitoring Load because the specifics of
the server capacity and network deployment can vary widely. The monitoring load may also vary
significantly over time simply due to transient network traffic issues or SiteScope monitor configuration
problems.
One key warning signal for interpreting monitoring load is the ratio of Monitors Waiting to Monitors
Running. Generally, having some monitors waiting for execution is not a problem unless the ratio of
Monitors Waiting to Monitors Running is consistently 1:2 or higher. For example, if the number of
monitors running is at the maximum of 100 and there are 50 monitors waiting, this represents a ratio of 1
monitor waiting for every two running.
Note: The initial maximum number of monitor execution threads for the _maxMonitorsRunning=
setting controlled by the <SiteScope root directory>\groups\master.config file is 400 (the
default value is 30 in master.xml).
The graph below presents a visualization of the relationship between Monitors Running and Monitors
Waiting. This graph is based on the _maxMonitorsRunning setting of 100 monitors. The green region
shows that SiteScope can run all queued monitors until the number of queued monitors exceeds 100.
At that level, additional monitors that are scheduled to run are given the status of Monitor Waiting. The
red region represents an area where the number of monitors waiting is more than twice the number of
monitors running. This is a certain indication that your SiteScope monitor configurations are not well
aligned with the capacity of the server and network.
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You can adjust the following monitor configuration settings if there are consistently too many monitors
waiting:
l

l

Frequency. This is the basic schedule parameter for every monitor type. A large number of
Monitors Running and Monitors Waiting can often be explained by a large number of monitors set to
run (or update) at short intervals. The minimum update interval is 15 seconds. Depending on a
number of system factors, there are several monitor actions which may take more than 15 seconds
to complete. For example, Web transactions, database queries, logging onto remote servers, and
some regular expression matches may delay monitor completion. Use the "Monitor Summary
Report" on page 1361 to check the Frequency setting for groups of monitors and consider
increasing the value for some monitors.
Verify error. Regular or extensive use of this option has the effect of rapidly increasing the monitor
run queue whenever the applicable SiteScope monitors detect an error condition. While this option
has its purpose, it should not be used by default on every monitor. Use the "Monitor Summary
Report" on page 1361 to list monitors that may have the Verify error setting enabled.

For details on SiteScope server performance data, see "Running Monitors Page" on page 1193.
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Tasks
How to Analyze SiteScope Server Statistics from the SiteScope user interface
This task describes the steps involved in analyzing SiteScope server statistics and log files.
1. Prerequisites
To access the Server Statistics context, you must be an administrator in SiteScope, or a user
granted View server statistics permissions (this settings is selected by default).
For details on user permissions, see "Permissions" on page 744.
2. View SiteScope server statistics
You can view the load on the SiteScope server, a list of running and most recently run monitors,
perfex process pool, WMI, SSH connections, telnet connections, and dynamic monitoring
statistics in the Server Statistics context.
See below for user interface details.
3. View SiteScope log files
You can view the various SiteScope log files in the Log Files page in the Server Statistics context.
For user interface details, see "Log Files Page" on page 1184.

Dynamic Monitoring Page
This page displays statistics when using the dynamic monitoring mechanism to automatically update
dynamic monitoring counters and thresholds. This is useful for viewing performance and for analyzing
problems in dynamic monitoring.
To access
Important
information

Select Server Statistics context > Dynamic Monitoring
l

l

Only an administrator, or a user granted View server statistics permissions, can
view the monitor performance data pages. For details on user permissions, see
"User Management Preferences" on page 732.
This information is also available from the Monitors context (expand the Health
folder and click Dynamic Monitoring Statistics).

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface"
above

See also

"SiteScope Server Statistics" on page 1176
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User interface elements are described below:
Parameter

Description

Definitions:
*Dynamic task. The periodic action of retrieving counters from the server, and finding among them
the counters that match the patterns defined for the monitor.
**Counters file. Counters are saved to an xml file located under the <SiteScope root
directory>\templates.application folder.
Average task wait time during last
10 minutes (milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to start running since the time it was
received, during the last 10 minutes.

Average task wait time
(milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to start running since the time it was
received.

Average task run time during last
10 minutes (milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to run during the last 10 minutes.

Average task run time
(milliseconds)

Average amount of time, in milliseconds, it took for a
dynamic task* to run.

Number of unsaved counter files
during last 10 minutes

Number of times unable to delete existing counter files** or
save new counter files during the last 10 minutes. .

Number of clashes between
dynamic monitoring framework
and concurrent user changes
during last 10 minutes

Number of times unable to save dynamic monitoring
framework changes as a result of the user making
concurrent changes (so as not to override user changes),
during the last 10 minutes.

Number of times the maximum
number of matching counters was
exceeded during last 10 minutes

Number of times that the matching counters (for patterns)
from the server exceeded the limit during the last 10
minutes.

Number of times unable to extract
counters from file during last 10
minutes

Number of times unable to extract counters from the
counters file** during the last 10 minutes.

Number of times unable to save
changes during last 10 minutes

Number of times unable to save counter changes to
SiteScope persistency during the last 10 minutes.

Number of times unable to run
dynamic tasks because of resource
exhaustion during last 10 minutes

Number of times unable to run dynamic tasks* because the
maximum dynamic monitoring framework thread pool and
queue size limits were reached, during the last 10 minutes.
You can configure these settings in Preferences >
Infrastructure Preferences > Dynamic Monitoring
Settings. For details, see "Infrastructure Preferences" on
page 608.

HP SiteScope (11.31)

Page 1182 of 1395

Using SiteScope
Chapter 100: SiteScope Server Statistics

Parameter

Description

Number of times unable to retrieve
counters from server during last 10
minutes

Number of times unable to retrieve counters from the server
during the last 10 minutes.

Number of times there were no
matching counters from server
during last 10 minutes

Number of times there were no matching counters (for
patterns) from the server during the last 10 minutes.

Total number of unsaved counter
files

Total number of times unable to delete existing counter files
or save new counter files.

Total number of clashes between
dynamic monitoring framework
and concurrent user changes

Total number of times unable to save dynamic monitoring
framework changes as a result of the user making
concurrent changes (so as not to override user changes).

Total number of times the
maximum number of matching
counters was exceeded

Number of times that the matching counters (for patterns)
from the server exceeded the limit.

Total number of times unable to
extract counters from file

Total number of times unable to extract counters from the
counters file**.

Total number of times unable to
save changes

Total number of times unable to save counter changes to
SiteScope persistency.

Total number of times unable to
run dynamic tasks because of
resource exhaustion

Total number of times unable to run dynamic tasks*
because the maximum dynamic monitoring framework
thread pool and queue sizes limits were reached.
You can configure these settings in Preferences >
Infrastructure Preferences > Dynamic Monitoring
Settings. For details, see "Infrastructure Preferences" on
page 608.

Total number of times unable to
retrieve counters from server

Total number of times unable to retrieve counters from the
server.

Total number of times there were
no matching counters from server

Total number of times there were no matching counters (for
patterns) from the server.

General Page
This page enables you to view an overview of several key SiteScope server performance statistics,
including the current and maximum number of running monitors, waiting monitors, and monitor runs per
minute. It also displays a list of monitor types that are currently running, and the number of running
instances for each type.

HP SiteScope (11.31)

Page 1183 of 1395

Using SiteScope
Chapter 100: SiteScope Server Statistics

To access

Select Server Statistics context > General

Important
Only an administrator in SiteScope, or a user granted View server statistics
information permissions, can view the monitor performance data pages. For details on user
permissions, see "User Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176

User interface elements are described below:
UI
Element

Description

Overall Statistics
Monitors
running

Current column. Displays the number of monitors queued for execution, based on their
update frequency or schedule, that currently have execution threads. This means they
are being run.
Maximum and Measured on columns. Display the maximum number of monitors that
ran and when they ran.

Monitors
waiting

Current column. Displays the number of monitors queued for execution, based on their
update frequency or schedule, that currently are awaiting execution threads. This
means they are not being run.
Maximum and Measured on columns. Display the maximum number of monitors that
were waiting at any one time and when this occurred.

Monitors
run per
minute

Current column. Displays a rolling average of the last 10 minutes of monitoring, and
tracks the rate (per minute) at which monitors are being run.
Maximum and Measured on columns. Display the maximum number of monitors
running per minute at any one time and when they ran.

Running Monitors by Type
<running
monitors
list>

Displays a list of monitor types that are currently running and the number of running
instances for each type.

Log Files Page
This page enables you to inspect the SiteScope log files.
To access

Select Server Statistics context > Log Files.

HP SiteScope (11.31)

Page 1184 of 1395

Using SiteScope
Chapter 100: SiteScope Server Statistics

Important
information

l

l

Relevant
tasks

l

See also

SiteScope log files do not support Unicode characters—all non-English characters
appear corrupted in the logs. As a workaround, use a SiteScope server installed
on a corresponding operating system locale. For example, use SiteScope installed
on a Japanese Windows operating system for a Japanese locale.
To create a dedicated log for a specific monitor, see "Logging Settings" on page
314. To disable separate monitor logging for all monitors, see "Disable separate
logging for monitors" on page 704.
"How to Analyze SiteScope Server Statistics from the SiteScope user interface"
on page 1181

l

"How to Configure the Audit Log" on page 1205

l

"SiteScope Log Files" on page 1177

l

"Monitor Specific Log Column Content" on page 1206

l

"Audit Log Entries" on page 1200

l

"SiteScope Health Map and Performance Statistics Logs" on page 1238

Log Files Table
User interface elements are described below:
UI
Element

Description
Changes the sort order in the columns by clicking the arrow in the column title. A small
up or down arrow is displayed to the left of the arrow which indicates the sort order.
Note: Clicking the arrow in the Type column title opens the list of log types, which
enables you to filter the list by the log type you want to display. To clear the filter, click
the arrow again, and select (All).

Type

The log file type. For details on the different types of log files, see "Log File Types" on the
next page.

Log File

The name of the log file. Double-click a log file link to open the file in your Web browser.

Size

The size of the log file.

Last
The time and date on which the log file was last modified.
Modified
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Log File Types
User interface elements are described below:
UI Element

Description

Audit Logs

Logs containing all configuration changes that were performed from
the user interface, such as creation of monitors, templates, alerts
and so on. For details on audit logs, see "Audit Log File" on page
1199.

BSM Integration Logs

Contain information about connectivity and monitor data transfer
when SiteScope is configured to report to BSM. These logs are
stored in the <SiteScope root>\logs\bac_integration folder.
l

l

l

l

l
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bac_integration.log. Contains all messages registered by the
BSM integration framework.
bac_integration_tools.log. Contains messages generated by
tools which check BSM integration consistency on every
SiteScope restart.
discovery.log. Contains messages generated by the topology
reporting module,
eti_resolver.log. Contains messages generated by the module
responsible for resolving health indicator to metric (counter)
mappings.
quota_control.log. Not currently used.
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UI Element

Description

Daily Logs

Contains links to the logs containing individual monitor
measurements. SiteScope creates a new monitor log each day to
record all monitors run during that 24 hour period. These logs are the
basis for SiteScope Reports.
The daily logs are in the format:
l

l

SiteScope<YYYY_MM_DD>.v2.log. These logs contain more
detailed monitor run results than the legacy logs.
SiteScope<YYYY_MM_DD>.log. The legacy daily log files.

Note:
l

l

l

Error Logs

The monitor logs can become very large depending on the
monitor environment. This may make it impractical to view them
using a Web browser.
By default, both types of daily log file are generated. If you are not
using baselining, it is recommended to disable the legacy daily
log by setting the property _shouldLogToLegacyDailyLog= to
false in the <SiteScope root>\groups\master.config file.
To disable logging to both types of daily log files, change the
property _dailySiteScopeLogs=true in the <SiteScope
root>\groups\master.config file to _dailySiteScopeLogs=.
When disabled, a log file named SiteScope.log is created
instead, which is updated each day; this means that there is no
historical data of monitor run results for SiteScope reports. (For
daily log files, you can determine the number of logs of monitoring
data to keep in the Daily logs to keep setting in Preferences >
Log Preferences. Once a day, SiteScope deletes any logs that
exceed the specified number of logs to keep.)

Contains a variety of messages relating to the operation of
SiteScope. This includes a record of errors that SiteScope may have
encountered when trying to perform monitor actions or data
communication actions. It also includes messages indicating when
SiteScope was stopped or started and if there are monitors that are
skipping because they are unable to complete their task. This is the
default log file for any messages, which were not routed to a special
log file.
The name of the current error log is error.log. When the current error
log reaches its size limit, it is closed and a new log is created. Older
logs are named error.log.1, error.log.2, and so forth. The higher the
number concatenated to the name, the older the log.
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UI Element

Description

Run Monitor Logs

Contains information about specific monitor runs and actions related
to managing monitors. This can be useful in troubleshooting
monitors.

Other Logs
Contains various different log file types, such as:
alert.log

Records alert information whenever SiteScope generates an alert.
This can be used to troubleshoot alert actions and to confirm that
alerts were sent.

amazon_ec2_
integration.log

Contains information relating to the Amazon EC2 Integration log
(empty if no integration defined).

baselining.log

Contains errors and informational messages that occurred during the
baseline thresholds calculation.

data_integration.log

Contains messages for the Generic Data Integration (empty if no
integration defined) .

downtime.log

Contains messages generated by monitors disabled by the BSM
CI Downtime feature.

dynamic_monitoring_
changes.log

Contains scheduled actions for all of the dynamic monitors.

event_console_history.log

Contains messages of all closed (non-active) events that were
triggered from Event Console alert actions. For details on when
messages are written to this log, see "Historical Event Log Files" on
page 1067.

event_console_ui.log

Contains messages of events triggered from Event Console alert
actions that are displayed in the Event Console.

ha.log

Contains messages generated by the SiteScope Failover Manager
shared disk solution (deprecated since SiteScope 11.20).

health_map.log

Contains a summary status of SiteScope performance. It includes
the following performance metrics: number of running monitors,
number of waiting monitors (monitors queue size), monitor average
run time (per monitor type), number of currently open SSH. For
details, see "SiteScope Health Map and Performance Statistics
Logs" on page 1238.

high_availability.log

Contains messages generated during SiteScope Failover mirroring
operations.
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UI Element

Description

HPSiteScopeOperations
ManagerIntegration.log

System log for event integration with the HP Operation Manager
Agent.

HPSiteScopeOperations
System log for event integration with the HP Operation Manager
ManagerIntegration.HA.log Agent for SiteScope Failover configuration.
monitorCount.log

Counts the total number of monitors and license instances used in
SiteScope. It also specifies the number and license usage for each
type of server health monitor. This log is updated once a day when
SiteScope starts (and not on every change). You can refresh the log
file at any time by selecting Help > About SiteScope.

mirror.log

Contains messages generated by SiteScope Failover and initial
configuration information.

oa_metric_integration.log

Contains information relating to the integration with the HP
Operations agent.

Operator.log

An optional log file used to record SiteScope operator actions,
primarily information from use of the Acknowledgment function. This
log is created when an acknowledgment is added to one or more
monitors.

Post Log File

An optional log file used to record HTTP Post requests made to the
SiteScope server. This can be used to track administrative actions
performed. This log is enabled only when the _postLogFile=true
setting exists in the <SiteScope
root directory>\groups\master.config file.

remotes_multi_test

Displays the remote server connection test results when the test
was performed for multiple remotes.

request_statistics.log

Displays the Tomcat request statistics filter.

server_statistics.log

Contains information about used memory and system resources.

server_statistics_raw.log

When the log level is changed to DEBUG, this file contains detailed
information about used process and perfex pools.

silent_deployment.log

Records details on submitted requests for silent deployments and
their corresponding deployment results. It also includes error
messages for silent deployments that fail. This log is updated once a
day when SiteScope starts (and not on every change).
Note: When deploying a template using a CSV file, non-English
characters used in the CSV file are not supported in the silent_
deployment log file. The deployment values are displayed correctly
in the user interface if the correct encoding option is selected.
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UI Element

Description

SiteScope_<group>_
<monitorName>.log

Contains log data for a selected monitor instance in the <SiteScope
root directory>\logs\monitor_runs folder. This folder contains one
file per monitor instance. The format of log file names is determined
according to the monitor path in the SiteScope tree, as follows:
SiteScope_<group>_<monitorName>.log
This log is enabled after a monitor run when separate monitor logging
is enabled. To enable separate monitor logging, see "Logging
Settings" on page 314.

skip_monitor.log

Contains information about skipped monitor runs. For every skip
occurrence, a line is added with the date and time of the skip, name
(and ID) of the monitor, server name, number of skips, and the
monitor status (if the monitor was disabled).

template_persistency_
upgrade.log

Contains messages that occurred while importing templates to
persistency.

upgrade.log

Contains messages that occurred while working with the upgrader.

Perfex Process Pool Page
This page displays the process manager summary, and pool statistics and statuses for each perfex
pool. Perfex is a command line interface used to process event counters. Perfex prints the values of
various hardware performance counters after the given command is complete. Perfex_dispatcher is a
process used for Microsoft Windows Resources monitors.
To access
Important
information

Select Server Statistics context > Perfex Process Pool
l

l

Only an administrator, or a user granted View server statistics permissions, can
view the monitor performance data pages. For details on user permissions, see
"User Management Preferences" on page 732.
In environments that have load capacity issues, you might need to change the _
internalKillProcessOnTimeout property value to =true in the <SiteScope
root>\groups\master.config file. However, you should not use this parameter
without first consulting with HP support.

Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176
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User interface elements are described below:
UI Element

Description

Process Manager Summary
Calls per
minute

The number of process calls on the SiteScope server, per minute.

Double
failures

The number of times SiteScope failed to connect to a remote server, after making
two consecutive connection attempts. For connection failure details, check the run
monitor and error logs.

Stopped
processes

The number of processes that stopped due to error, for example, if the process
timed out, since the last SiteScope restart.

Created
processes

The number of processes created by SiteScope for all pools since the last restart.
If there is a large number of created processes and stopped processes, increase
the perfex timeout value in Preferences > Infrastructure Preferences > General
Settings > Perfex timeout (seconds).

Cleaned
processes

SiteScope cleans processes if they exceed the maximum idle time. The default
time before cleaning idle processes is 10 minutes. You can change the idle
processes maximum time in Preferences > Infrastructure Preferences >
General Settings > Maximum idle time for perfex process in minutes.
Cleaning processes improves the memory footprint on the SiteScope machine.
Cleaning processes is especially important during a network slowdown when
perfexes take longer to finish. As a result, more perfexes are created, but they are
not used.

Pool Statistics - perfex/perfex_dispatcher
Process pool
queue length

The number of monitors currently waiting for an available perfex. This value can
indicate that there are too many monitors running on perfex, or that the perfex pool
is too small.

Average wait
time for free
process
(milliseconds)

The average amount of time to wait, in milliseconds, for a process to be available.
If this value exceeds 30,000 milliseconds (30 seconds), monitors will start to fail. A
high average wait time indicates that you need to increase the number of
processes in the pool.

Average run
The average amount of time, in milliseconds, that a perfex takes to run. This gives
time
an indication of the following:
(milliseconds)
l
Network speed. The amount of time it takes to send a request and receive a
response from the server.
l

l
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UI Element

Description

Idle
processes

The number of processes currently in idle state.

Used
processes

The number of processes currently in used state.

Total
processes

The total number of processes (idle processes + used processes).

Maximum
process pool
size

The maximum number of processes allowed per process pool. The default value is
200. You can change the maximum process pool size in Infrastructure
Preferences > General Settings > Maximum processes per pool.

Processes
waiting for
server
timeout

The number of processes that have exceeded the call timeout and are waiting for a
server timeout to close the connection, or that are waiting for an answer to return to
the pool.

PowerShell Process Pool Page
This page displays a statistics tables for the PowerShell process pool which is used by the Microsoft
Exchange Base monitor. You can impact Microsoft Exchange Base monitor performance by changing
PowerShell pool parameters in Preferences > Infrastructure Settings > General Settings.
You can also see these statistics in <SiteScope root directory>\logs\server_statistics.log. When
you use the Microsoft Exchange Base Monitor, statistics lines for the PowerShell pool look like the
following in the log file:
[StatisticsLogger] INFO - PoolName=PowerShellPool active processes:1; idle
processes:0; total processes:1; max pool size:20; pool utilization:5.00%
To access

Select Server Statistics context > PowerShell Process Pool

Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176
"Infrastructure Preferences" on page 608
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User interface elements are described below:
UI Element

Description

PowerShell Pool Statistics
Active
processes

The number of PowerShell processes that are currently being used.

Idle
processes

The number of PowerShell processes which are not currently being used, but maintain
a connection with a Microsoft Exchange Server.

By default, the maximum number of active PowerShell processes (per key) is 20. You
can change this value in Infrastructure Preferences > General Settings >
PowerShell pool: maximum number of active processes (per key).

By default, the maximum number of idle PowerShell processes (per key) is 8. You can
change this value in Infrastructure Preferences > General Settings > PowerShell
pool: maximum number of idle processes (per key).
The maximum wait time until a new or idle PowerShell process is available is 1000
milliseconds by default. You can change this value in Infrastructure Preferences >
General Settings > PowerShell pool: maximum wait time until new or idle
process is available (milliseconds).
The minimum amount of time that an object can sit idle in the pool before the object is
eligible for eviction is 5 minutes by default. You can change this value in
Infrastructure Preferences > General Settings > PowerShell pool: minimum
idle time for processes (milliseconds).
By default, the eviction thread checks for idle objects every 15 minutes. You can
change this value in Infrastructure Preferences > General Settings > PowerShell
pool: minimum idle time for processes (milliseconds).
Total
processes

The total number of PowerShell processes that exist in the PowerShell pool at the
current time (idle processes + active processes).

Maximum
The maximum number of PowerShell processes which can be in the pool
PowerShell simultaneously.
pool size
The default value is 20. You can change the maximum number of PowerShell
processes which can be in the pool simultaneously in Infrastructure Preferences >
General Settings > PowerShell pool: maximum number of processes.
PowerShell The percentage of PowerShell pool utilization.
pool
utilization
(%)

Running Monitors Page
This page enables you to view a list of which SiteScope monitors are running, and which monitors have
run recently, at what time, and what was the returned status.
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To access

Select Server Statistics context > Running Monitors

Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176

User interface elements are described below:
UI
Element Description
Running Monitors
Run
Time

The run time, in seconds, for the monitor that is currently being run.

Skips

The number of skips for the monitor that is currently being run. A SiteScope monitor is
reported as skipped if it fails to complete its actions before it is scheduled to run again.

Group
Name

The group to which the monitor that is currently being run belong.

Monitor
Name

The name of the SiteScope monitor that is currently being run. Clicking the monitor name
link opens the Dashboard page for the selected monitor. Monitors with longer run time or
skips are colored in red.

Current
Status

The status returned by the monitor that is currently being run.

Recent Monitor Runs
Time
and
Date

The date and time the monitor ran. The monitors are displayed in the order that have most
recently completed running.

Group
Name

The group to which the monitor belongs.

Monitor
Name

The name of the monitor that SiteScope ran.

Current
Status

The status returned by the monitor (good, warning, error) and measurement summary
details.
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SSH Connections Page
This page displays Secure Shell (SSH) statistics and a summary of SSH connections when using SSH
to connect to remote UNIX or Windows servers.
To access

Select Server Statistics context > SSH Connections

Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176

User interface elements are described below:
UI Element Description
SSH Statistics
Total
opened

Total number of all opened SSH connections. If this number is significantly higher than
the Currently allocated resources counter, this indicates a configuration problem.
Check the following:
l

Connection cache was disabled

l

An incorrect login or password was used

l

The remote server timeout is too short

Total
closed

The number of SSH connections closed since the last SiteScope restart.

Total
cleaned

The number of SSH connections cleaned since the last SiteScope restart.

Total failed The number of SSH connections that failed to open using SSH version 1. By default,
to open V1 SiteScope tries to connect using V1 before trying to connect with V2. If this number is
high, we recommend selecting the SSH version 2 only option on the problematic
remote server.
Total failed The number of SSH connections that failed to open using SSH version 2. If this
to open V2 number is high, verify the correct login and password was used for the remote server,
and verify the SSH version on the remote server (V1 or V2).
Reused

The number of reused SSH connections since the last SiteScope restart.
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UI Element Description
Currently
allocated
resources

The number of SSH connections that are currently open.

Currently
in use

The number of SSH connections that are currently open and in use running monitors.

Average
Call Time
for Last 10
Minutes

The average SSH call time during the last 10 minutes.

Total
Average
Call Time

The average call time.

SSH Connections Summary
<Host
name>

For each target remote server, there is a row that displays the following information:
l

l

l

l

l

l

l

l

Machine Name. The name of the monitored remote server.
Sessions in Use. The number of open SSH sessions on the monitored remote
server.
Idle Sessions. The number of idle SSH sessions on the monitored remote server.
Maximum Sessions. The maximum number of SSH sessions (idle or in use) on
the monitored remote server.
Queue Length. The number of SSH sessions in the queue.
Average Wait Time. The average amount of time to wait, in milliseconds, for a
free SSH session.
Average Call Time for Last 10 Minutes. The average SSH call time during the
last 10 minutes.
Total Average Call Time. The total of average call time.

Note: SiteScope has a limit of 500 concurrent SSH connections.

Telnet Connections Page
This page displays telnet statistics when using telnet to connect to remote UNIX or Windows servers.
To access

Select Server Statistics context > Telnet Connections
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Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176

User interface elements are described below:
Parameter

Description

Telnet Statistics
Total opened

The number of telnet connections opened since the last SiteScope restart.

Total closed

The number of telnet connections closed since the last SiteScope restart.

Reused

The number of reused telnet connections since the last SiteScope restart.

Currently allocated
resources

The number of telnet connections that are currently open.

Currently in use

The number of telnet connections that are currently open and in use running
monitors.

Telnet Connections Summary
<Host name>

For each target remote server, there is a row that displays the following
information:
l

l

l

l

l

l

Machine Name. The name of the monitored remote server.
Sessions in Use. The number of open telnet sessions on the monitored
remote server.
Idle Sessions. The number of idle telnet sessions on the monitored
remote server.
Maximum Sessions. The maximum number of telnet sessions (idle or in
use) on the monitored remote server.
Queue Length. The number of telnet sessions in the queue.
Average Wait Time. The average amount of time to wait, in
milliseconds, for a free telnet session.

Note: SiteScope has a limit of 500 concurrent telnet connections.
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WMI Statistics Page
This page displays the process manager summary for Windows Management Instrumentation (WMI)
statistics. You can use WMI to access system counter data from objects in the performance libraries.
This is the same performance data that appears in the Perfmon utility.
To access

Select Server Statistics context > WMI Statistics

Important
Only an administrator, or a user granted View server statistics permissions, can
information view the monitor performance data pages. For details on user permissions, see "User
Management Preferences" on page 732.
Relevant
tasks

"How to Analyze SiteScope Server Statistics from the SiteScope user interface" on
page 1181

See also

"SiteScope Server Statistics" on page 1176

User interface elements are described below:
UI
Element

Description

Process Manager Summary
Calls per
minute

The number of process calls on the SiteScope server, per minute.

Double
failures

The number of times SiteScope failed to connect to a remote server, after making two
consecutive connection attempts. For connection failure details, check the run monitor
and error logs.

Stopped
processes

The number of processes that stopped due to error, for example, if the process timed
out, since the last SiteScope restart.

Created
processes

The number of processes created by SiteScope for all pools since the last restart. If
there is a large number of created processes and stopped processes, increase the
perfex timeout value in Preferences > Infrastructure Preferences > General
Settings > Perfex timeout (seconds).

Cleaned
processes

SiteScope cleans processes if they exceed the maximum idle time. The default time
before cleaning idle processes is 10 minutes. You can change the idle processes
maximum time in Preferences > Infrastructure Preferences > General Settings >
Maximum idle time for perfex process in minutes. Cleaning processes improves
the memory footprint on the SiteScope machine. Cleaning processes is especially
important during a network slowdown when perfexes take longer to finish. As a result,
more perfexes are created, but they are not used.
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UI
Element

Description

Processes The number of processes that have exceeded the call timeout and are waiting for a
waiting
server timeout to close the connection, or that are waiting for an answer to return to the
for server pool.
timeout

Audit Log File
SiteScope's audit log provides you with a record of actions performed in SiteScope, the time they were
performed, and by whom. It includes details of changes made by a user to the SiteScope configuration,
and for every change (where applicable) it displays the value before and after the change. It is also lists
the full path of the entity being audited.

To access
You can access the current audit log from <SiteScope root directory>\logs\audit.log or through the
SiteScope application. For details on viewing the audit log, see "Log Files Page" on page 1184.

Learn About
Audit Log File Overview
The audit log contains configuration changes performed in the new user interface, such as:
creation/update/copy/deletion of monitors, groups, templates, alerts, reports and so forth. An entry is
also made for user login/logout, user password changes, preference setting changes, and for monitors
that are run manually. To help a user determine performance issues when generating SiteScope
reports, the audit log also includes details of the report type, its targets, and the user that generated the
report.
As each operation is performed, an entry is made in the audit log. Operations that involve several steps
typically have a separate start and end entry line.
Example:
2011-11-10 08:04:41 - User: SiteScope Administrator. Operation performed: UPDATE Monitor
'SiteScope\autosanity\cpu' start:
2011-11-08 14:43:56 - User: SiteScope Administrator. Operation performed: Monitor
'SiteScope\autosanity\cpu' update: '_alertDisabled' updated from '-1' to ''.
2011-11-08 14:43:56 - User: SiteScope Administrator. Operation performed: UPDATE Monitor
'SiteScope\autosanity' end.
The name of the current audit log is audit.log. When the current audit log reaches its size limit, it is
closed and a new log is created. Older logs are named audit.log.1, audit.log.2, and so forth. The
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higher the number concatenated to the name, the older the log. For details on setting the size limit and
the maximum number of backup audit logs to be kept, see "How to Configure the Audit Log" on page
1205.
Most operations performed in the monitor tree are recorded in the audit log. For details on audit log
entries, see "Audit Log Entries" below.
For a list of operations that are not recorded in the audit log, see "Tips/Troubleshooting" on page 1205.

Audit Log Entries
Each line of the audit log describes an operation performed in SiteScope. Operations that involve
several steps typically have a separate start and end entry line.
The audit log lists a record of actions for the following changes performed in SiteScope:
Entity Changed
Group/Monitor/Template
Entities

Actions Logged in the Audit Log
l

l

Preferences

update: 'entity' from '<x>' to '<y>'. The entity that a user updated,
and the values before and after the update.

l

deleted from. The location where the user deleted an entity.

l

copied to. The user copied information from one entity to another.

l

moved to. The user moved information from one entity to another.

l

created. The user created the preference.

l

deleted. The user deleted the preference.

l

Templates

created in. The location where the user created an entity.

l

l

l

update: 'entity' from '<x>' to '<y>'. The entity that a user updated,
and the values before and after the update.
DEPLOY template. The template that was deployed, including the
deployed objects (groups, monitor, remote server).
REDEPLOY template.The changes that were published to deployed
groups/monitors after a template has been updated.
IMPORT template.Template configurations imported from external
files.

This section also includes:
l

"Actions Recorded for Monitor/Group/Alert/Report/Template/Remote Entities" on the next page

l

"Actions Recorded for SiteScope Preferences" on page 1203
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l

"Actions Recorded for Other SiteScope Operations Entered in the Audit Log" on page 1204

Actions Recorded for Monitor/Group/Alert/Report/Template/Remote Entities
This table lists the actions performed on SiteScope entities that are entered in the audit log :
Entity

Action

Group

l

Create

(monitor/template
mode)

l

Update

l

Delete

l

Copy/Cut/Paste

l

Copy to template (monitor mode only)

l

Global Search and Replace (monitor mode only)

l

Manual run of all child monitors (monitor mode only)

Monitor

l

Create

(monitor/template
mode)

l

Update

l

Delete

l

Copy/Copy to Template (template mode)

l

Move (Cut/Paste)

l

Enable/Disable

l

Manual run (monitor mode only)

l

Global Search and Replace (monitor mode only)

l

Add

l

Edit

l

Delete

Monitor
Acknowledgment
(monitor mode only)
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Entity
Template
(template mode only)

Action
l

Create

l

Delete

l

Copy/Cut/Paste

l

Deploy

l

Publish changes

l

Import through user interface or by putting files in the <SiteScope root
directory>\persistency\import folder

l

Update contained entities

l

Create

l

Update

l

Delete

l

Copy/Cut/Paste

l

Create

l

Update

l

Delete

l

Copy/Cut/Paste

Alert

l

Create

(monitor/template
mode)

l

Update

l

Delete

l

Copy/Cut/Paste

l

Enable/Disable (monitor mode only)

l

Global Search and Replace (monitor mode only)

Template Variable
(template mode only)

Template Container
(template mode only)
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Entity

Action

Alert Action

l

Create

(monitor/template
mode)

l

Update

l

Delete

l

Copy

l

Global Search and Replace (monitor mode only)

l

Create

l

Update

l

Delete

l

Copy

l

Global Search and Replace

l

Create

l

Update

l

Delete

l

Copy/Cut/Paste

Report
(monitor mode only)

Remote Server
(remote
servers/template
mode)

Actions Recorded for SiteScope Preferences
This table lists the actions performed on SiteScope preferences that are entered in the audit log:
Preference

Action

General Preferences

Update

Infrastructure Preferences

Update

Log Preferences

Update

Email/Pager/SNMP/Common Events Mapping (default)

Update

Email/Pager/SNMP/Common Events Mapping (instance)

HP SiteScope (11.31)

l

Create

l

Update

l

Delete

Page 1203 of 1395

Using SiteScope
Chapter 100: SiteScope Server Statistics

Preference

Action

Schedule Preferences

User Management Preferences

Credential Preferences

Search/Filter Tags

Certificate Management

l

Create

l

Update

l

Delete

l

Create

l

Update

l

Delete

l

Create

l

Update

l

Delete

l

Create

l

Update

l

Delete

l

Create

l

Delete

Actions Recorded for Other SiteScope Operations Entered in the Audit Log
This table lists other SiteScope operations that are recorded in the audit log:
Other
Downtime

Health Logging

BSM Integration
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l

Add

l

Update

l

Delete

l

Enable

l

Disable

l

Register

l

Unregister
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Other
Authentication

Licensing

External files

Action
l

Login

l

Logout

l

Import

l

Remove

Import

Tasks
How to Configure the Audit Log
This task describes the steps involved in configuring the maximum size of the audit log.
1. Open the log4j.properties file located in the <SiteScope root
directory>\conf\core\Tools\log4j\PlainJava\ directory.
2. Set MaxFileSize to the maximum number of lines in the log.
3. Set MaxBackupIndex to the maximum number of backup audit logs to be kept before the oldest
audit log is deleted.
Example: If MaxBackupIndex is 5, no more than 5 backup audit logs are kept. If 5 backup
log files exist, then after the current audit.log file reaches MaxFileSize size, audit.log.5
is deleted, audit.log.4 is renamed to audit.log.5, audit.log.3 to audit.log.4 and so
forth. The current audit.log is renamed audit.log.1 and a new audit.log is created.

Tips/Troubleshooting
General Notes/Limitations
l

l

Audit log entries can be created only in English. This means that audit log entries are also displayed
only in English, regardless of what language you use to view SiteScope.
When template changes are published to SiteScope objects, the audit log shows which objects
were updated, but it does not show the before and after values.

l

Downtime changes are logged in the audit log without the before and after values.

l

There is no enhanced auditing when configuration changes are made through SOAP methods.
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Monitor Specific Log Column Content
After the first six columns of each log entry, the content of each column may vary according to the
monitor type. The following tables display the data written to the monitor results log for the indicated
monitor types.
Apache Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 2 Value

9

Counter 3 Value

10

Counter 4 Value

11

Counter 5 Value

12

Counter 6 Value

13

Counter 7 Value

14

Counter 8 Value

15

Counter 9 Value

16

Counter 10 Value

17

Counter 11 Value

18

Counter 12 Value

19

Counter 13 Value

20

Counter 14 Value

21

Counter 15 Value
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Column

Data in Column

22

Counter 16 Value

23

Counter 17 Value

24

Counter 18 Value

25

Counter 19 Value

26

Counter 20 Value

ASP Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

BroadVision Application Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Browsable Windows Performance Counters Monitor
Column

Data in Column

1

data

2

category
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Column

Data in Column

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Check Point Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 2 Value

9

Counter 3 Value

10

Counter 4 Value

11

Counter 5 Value

12

Counter 6 Value

13

Counter 7 Value

14

Counter 8 Value

Cisco Works Monitor
Column

Data in Column

1

data

2

category

3

ownerID
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Column

Data in Column

4

Title

5

stateString

6

_ id

7

counters in error

Citrix Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

ColdFusion Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

Composite Monitor
Column

Data in Column

1

data

2

category

3

ownerID
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Column

Data in Column

4

Title

5

stateString

6

_ id

7

counters in error

8

% items in error

9

% items in warning

10

items in error

11

items in warning

12

items ok

13

items checked

CPU Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

utilization

8

utilization cpu # 1

9

utilization cpu # 2

Note: The number of individual CPU utilization counters (utilization cpu # 1, utilization cpu # 2, and
so forth) may vary depending on the environment and the monitor settings.
Database Counter Monitor
Column

Data in Column

1

data
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Column

Data in Column

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Database Query Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

9

result column 1

10

result column 2

11

rows

12

content match

DB2 JDBC Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title
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Column

Data in Column

5

stateString

6

_ id

7

counters in error

Directory Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

number of files

8

total of file sizes

9

directory exists

10

access permitted

11

time since modified

Disk Space Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

8

MB free
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DNS Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

9

statusText

e-Business Transaction Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

% items ok

8

% items in error

9

% items in warning

10

items in error

11

items in warning

12

items ok

13

items checked
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F5 Big-IP Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

File Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

size

8

file age

9

content match

Formula Composite Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id
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Column

Data in Column

7

Result

8

status

FTP Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

9

size

Health of SiteScope Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

IPMI Monitor
Column

Data in Column

1

data

2

category
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Column

Data in Column

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

LDAP Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

Link Check Transaction Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

link errors

8

total links

9

total graphics

10

average
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Log Event Health Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

.*skipped #1.*

8

.*skipped #2.*

9

.*skipped #3.*

10

.*skipped #4.*

11

.*skipped #5.*

12

.*SiteScope shutting down.*

13

.*Reached the limit of processes in the process pool.*

14

.*Error. data reporter failed to report chunk of data.*

15

.*Error. config reporter failed to report chunk of data.*

16

.*Error. Topaz failed to process data.*

17

.*Error. CacheSender. Got to the max number of cached files.*

18

.*Error. CacheSender. Got to the max old dir size.*

19

.*Topaz SEVERE.*

20

.*Commit verification failed.*

21

.*target not found in LDAP.*

22

Counter 16 Value

23

Counter 17 Value

24

Counter 18 Value

25

Counter 19 Value

26

Counter 20 Value
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Log File Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

matches/min

8

lines/min

Mail Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

round trip time

8

status

9

content match

10

Send time

11

Receive time

MAPI Monitor
Column

Data in Column

1

data

2

category

3

ownerID
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Column

Data in Column

4

Title

5

stateString

6

_ id

7

Round Trip

Memory Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

percent used

8

MB free

9

pages/sec

10

virtual memory used %

11

virtual memory MB free

12

physical memory used %

13

physical memory MB free

Microsoft IIS Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id
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Microsoft SQL Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

Microsoft Window Dial-Up Monitor (Deprecated)
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

total time

8

% monitors good

9

monitorCount

10

monitorErrorCount

11

monitorWarningCount

12

time to connect

13

time to authorize

Microsoft Windows Event Log Monitor
Column

Data in Column

1

data

2

category

3

ownerID
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Column

Data in Column

4

Title

5

stateString

6

_ id

7

match count

8

records examined

9

matches in interval

Microsoft Windows Media Player Monitor (Deprecated)
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 2 Value

9

Counter 3 Value

10

Counter 4 Value

11

Counter 5 Value

12

Counter 6 Value

13

Counter 7 Value

14

Counter 8 Value

15

Counter 9 Value

16

Counter 10 Value

17

Counter 11 Value

18

Counter 12 Value
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Column

Data in Column

19

Counter 13 Value

20

Counter 14 Value

21

Counter 15 Value

22

Counter 16 Value

23

Counter 17 Value

24

Counter 18 Value

25

Counter 19 Value

26

Counter 20 Value

Microsoft Windows Media Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

Microsoft Window Performance Counter Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 1 Percent Derivation
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Column

Data in Column

9

measurement0

10

lastMeasurement0

11

Counter 2 Value

12

Counter 2 Percent Derivation

13

measurement1

14

lastMeasurement1

15

Counter 3 Value

16

Counter 3 Percent Derivation

17

measurement2

18

lastMeasurement2

19

countersInError

Microsoft Windows Resources Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Microsoft Windows Services State Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title
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Column

Data in Column

5

stateString

6

_id

7

Number of Services Currently Not Running

8

Number of Services Currently Running

9

Number Changed to Running

10

Number Changed to Not Running

11

Number of Services Added

12

Number of Services Deleted

13

Services Changed to Not Running

14

Services Changed to Running

15

Services Added

16

Services Deleted

Network Bandwidth Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

News Monitor
Column

Data in Column

1

data

2

category
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Column

Data in Column

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

9

number of articles

Oracle 9i Application Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 2 Value

9

Counter 3 Value

10

Counter 4 Value

11

Counter 5 Value

12

Counter 6 Value

13

Counter 7 Value

14

Counter 8 Value

15

Counter 9 Value

16

Counter 10 Value

17

Counter 11 Value
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Column

Data in Column

18

Counter 12 Value

19

Counter 13 Value

20

Counter 14 Value

21

Counter 15 Value

22

Counter 16 Value

23

Counter 17 Value

24

Counter 18 Value

25

Counter 19 Value

26

Counter 20 Value

Oracle Database Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Ping Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id
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Column

Data in Column

7

status

8

round trip time

9

% packets good

Port Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

Radius Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time

Real Media Player Monitor (Deprecated)
Column

Data in Column

1

data
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Column

Data in Column

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

Counter 1 Value

8

Counter 2 Value

9

Counter 3 Value

10

Counter 4 Value

11

Counter 5 Value

12

Counter 6 Value

13

Counter 7 Value

14

Counter 8 Value

15

Counter 9 Value

16

Counter 10 Value

17

Counter 11 Value

18

Counter 12 Value

19

Counter 13 Value

20

Counter 14 Value

21

Counter 15 Value

22

Counter 16 Value

23

Counter 17 Value

24

Counter 18 Value

25

Counter 19 Value

26

Counter 20 Value
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Real Media Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

SAP Performance Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

Script Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

round trip time
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Service Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

processes

9

cpu

10

memory

SNMP Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

status

8

value

SNMP Trap Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title
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Column

Data in Column

5

stateString

6

_ id

7

matches/min

8

matches/min

9

value

10

value2

11

value3

12

value4

SNMP by MIB Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

SunONE Web Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error
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Sybase Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

TUXEDO Monitor (Deprecated)
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error

UNIX Resources Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error
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URL Content Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

status

8

round trip time

9

statusText

10

size

11

age

12

dns time

13

response time

14

download time

15

connect time

16

content match

17

matchValue2

18

matchValue3

19

matchValue4

20

matchValue5

21

matchValue6

22

matchValue7

23

matchValue8

24

matchValue9

25

matchValue10
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URL List Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

duration

8

errors

9

good

10

left

URL Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

status

8

round trip time

9

statusText

10

size

11

age

12

content match

13

dns time

14

response time
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Column

Data in Column

15

download time

16

connect time

17

overall status

18

total errors

URL Sequence Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

status

8

round trip time

9

statusText

10

step 1 connect time

11

step 1 dns time

12

step 1 download time

13

step 1 response time

14

step 1 roundtrip time

15

step 2 connect time

16

step 2 dns time

17

step 2 download time

18

step 2 response time

19

step 2 roundtrip time

Note: The number of URL Sequence step parameters (step 1 *** time, step 2 *** time, and so forth)
may vary depending on the environment and the monitor settings.
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WebLogic Application Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

counters in error

Web Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

hits

8

bytes transferred

9

hits/min

10

bytes/min

WebSphere Application Server Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString
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Column

Data in Column

6

_id

7

counters in error

WebSphere Performance Servlet Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_id

7

counters in error

XML Metrics Monitor
Column

Data in Column

1

data

2

category

3

ownerID

4

Title

5

stateString

6

_ id

7

counters in error
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Chapter 101: SiteScope Health Map and Performance
Statistics Logs
You can view SiteScope server load and performance statistics by accessing the SiteScope Health
Map and Performance Statistics Logs. This provides access to SiteScope load and performance
statistics directly from log files without having to open the SiteScope user interface.
Tip: You can also view this information using the "SiteScope Server Health Monitors" on page
1149 or from the "SiteScope Server Statistics" on page 1176 context.

To access
Navigate to the <SiteScope_root_path>\logs directory, and open the health_map.log or perf_
statistics.csv file.
Note: The health_map.log is also available from the Log Files page in the Server Statistics
context. For details, see "Log Files Page" on page 1184.

Learn About
Health Map and Performance Statistics Logs Overview
You can use the following log files to get a summary of SiteScope server performance:
l

l

health_map.log. Provides an overview of SiteScope server load statistics for the following
performance metrics: number of running monitors, number of waiting monitors (monitor queue size),
monitor average run time (per monitor type), and number of currently open SSH connections. It
provides an aggregate of performance statistics over different time periods (for example, monitor
run average time over the last hour). You can check the same metrics over different time frames by
shifting the time between performance metrics.
perf_statistics.csv. Enables you to generate a report that represents SiteScope performance over
time. The report includes the following performance metrics: timestamp, number of running
monitors, number of waiting monitors (monitors queue size), monitor average run time (per monitor
type), and number of currently open SSH connections. This log is in CSV format; therefore it can be
converted into a graph that enables you to compare SiteScope performance statistics over time
(see the task that follows). You can change the log reporting frequency in the <SiteScope root
directory>\groups\master.config file.
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Tasks
How to Get a Status Summary of SiteScope Performance Using a Log File
This task describes the steps involved in getting an overview of SiteScope server load and
performance statistics without opening the SiteScope user interface.
1. Navigate to the <SiteScope root directory>\conf\core\Tools\log4j\PlainJava directory and
open the log4j.properties file.
2. Search for the HealthMapLogger definition, and change the log level to DEBUG.
After the log level is changed, the health map is updated every 60 seconds with SiteScope server
load data in the following format:
[MONITOR COUNT] [MIN AVG] [MIN MAX] [HOUR AVG] [HOUR MAX] [DAY AVG] [DAY MAX]
[# RUNNING]
[# WAITING]
[# SSH CONNECTIONS]
[RUN AVG TYPE 1]
…
[RUN AVG TYPE N]

The log reporting frequency value for health map is hard-coded and cannot be changed.
3. View SiteScope server performance data in the log file.
Example of health_map.log

Note: Monitor runtime average units are milliseconds.
For more information on log files, see "Log Files Page" on page 1184.

How to Generate a Report Representing SiteScope Performance Over Time Using a Log File
This task describes the steps involved in getting an overview of SiteScope server load and
performance statistics without opening the SiteScope user interface.
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1. Navigate to the <SiteScope root directory>\conf\core\Tools\log4j\PlainJava directory and
open the log4j.properties file.
2. Search for the PerformanceStatisticsLogger definition, and change the log level to DEBUG.
After the log level is changed, the current performance statistics are updated every 60 seconds
with SiteScope server load data in the following format:
[TIMESTAMP],[#RUNNING MONITORS],[#WAITING MONITORS],[# SSH CONNECTIONS],[RUN AVG TYPE
1],…,[RUN AVG TYPE N]

You can change the log reporting frequency by modifying the _statisticsReportFrequencyMillis
property value in the <SiteScope root directory>\groups\master.config file.
Note: The _statisticsReportFrequencyMillis property affects the report frequency of all
statistics loggers (monitor statistics, pool statistics, and memory statistics).
3. View SiteScope server performance data in the log file.
Example of perf_statistics.csv
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4. Convert the log data into a graph (optional)
You can open the .csv file in Excel and convert the log file data into a graph. This enables you to
compare SiteScope performance statistics over time.
Example of performance statistics log converted into a graph
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Part 13: Alerts
SiteScope can be configured to send alerts to notify key personnel and have SiteScope initiate
corrective actions whenever it detects a problem in the IT infrastructure. For details on SiteScope
alerts, see "Configure SiteScope Alerts" on page 1243.
You can alter the content and format of alert messages by customizing SiteScope alert templates. You
can also customize alert templates tag styles if you have a parser that needs a specific delimiter or to
change the bracket delimiters used to identify variables. For details, see "Customize Alert Templates"
on page 1296.
You customize the alert templates by adding or removing text, by adding property variables (as listed in
the "Properties Available in Alerts, Templates, and Events" on page 1305), or changing the order of text
or property variables that are included in the template.
There are several types of alert actions, such as sending email messages or SNMP traps. SiteScope
can also be configured to automatically run recovery scripts or batch files when an error or warning
status is detected. This is normally done by creating a Script Alert that acts as a trigger for the script.
For details about writing scripts for script alerts, see "Write Scripts for Script Alerts" on page 1301.
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SiteScope alerts are notification actions that are triggered when the conditions for the alert definition are
detected. You use an alert to send notification of an event or change of status in an infrastructure
element or system. For example, an alert can be triggered when a SiteScope monitor detects a change
from Good to Error indicating that the monitored system has stopped responding.
Alerts are also used with Preventative Analytics to send notification when a business monitor has
crossed the baseline threshold. For details, see "Configure Predictive Analytics" on page 1375.
Note: You can also use the SiteScope API when working with alerts. For details, see "SOAPbased APIs" on page 159.

To access
Select the Monitors context. In the monitor tree, right-click the SiteScope object for which you want to
generate an alert, and select New > Alert.

Learn About
SiteScope Alerts Overview
An alert definition contains settings that tell SiteScope what monitors can trigger the alert, what
condition to watch for, what information to send, and who should be the recipients of the alert. For
example, you can create an alert that includes instructions for SiteScope to send the specific server
address and error code to your pager or email when an error condition is detected on a particular
system. You can also have SiteScope respond to problems by automatically initiating recovery or
action scripts with Script Alert. For example, you can configure a Script Alert to run a script to restart a
server if a monitor detects that a system is no longer responding and CPU utilization has reached
100%. For details on the alert types, see "Action Type Dialog Box" on page 1276.
SiteScope alerts can be configured in several ways. Alerts can be associated with one or more
individual monitors, with one or more groups of monitors, a combination of monitors and groups, or
globally for all monitors and groups. Global and group-wide alerting is generally the most efficient but
may not provide the needed control.

Alert Actions
When you create an alert scheme in SiteScope, you create alert actions to be triggered when the alert
conditions are met. You create alert actions using the Alert Action dialog box. While in the dialog box,
you determine the following:
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l

l

l

l

The type of alert action. For a detailed list of available alert actions, see "Action Type Dialog Box"
on page 1276.
The settings for the type of alert being sent. For example, you can define the recipients and their
addresses for an email alert action.
The status condition that triggers the alert. For example, you can instruct SiteScope to trigger an
alert action when a monitor's status changes to error or unavailable.
The trigger settings that determine when the alert is triggered and when it is sent. For details, see
"Understand When SiteScope Alerts Are Sent" on page 1250.

You can create multiple alert actions for an alert scheme.
l

l

l

Multiple methods of delivery. You can create an alert action to send a sound alert and another
alert action to send an email alert. Both are sent when the alert is triggered.
Schedule-dependent delivery. You can also set different schedules for the different actions within
the same alert definition. For example, you can schedule an email alert action to be sent during
regular working hours and an SMS alert action for evening and night hours. Both are triggered by the
same change in condition but are sent at different times, depending on when the alert is triggered.
Action dependencies. You can also make one alert action dependent on another alert action. This
enables you to instruct SiteScope to send one type of alert when the trigger condition is first met
and send another type of alert only when the first type of alert has been sent a number of times.

You can copy an alert action into other monitors or groups for use by other alerts. To use alert actions
for other alerts, you must copy the alert and paste it into another monitor or group. All the alert actions
for the alert are copied into the new alert. You can then edit the alert to be triggered for the new target
monitor or group.
For details on working with different alert types, see "Action Type Dialog Box" on page 1276.

Alert Filters
You can use the Filter Settings function on each alert definition page to create filter criteria to control
global and group alerts to more specific criteria. Filter criteria can be used to restrict the alert to only
monitors of a certain type, that contain a certain text string, tag, or other filter criteria. For example,
creating a global alert with a filter criteria for CPU Monitor creates an alert that is triggered only for the
CPU monitor type. You can also control individual monitor alerts using tags. For example, you can
create an individual monitor alert with a filter criteria for selected tags that is triggered only if the monitor
contains one of these tags. If you set up a global or root alert and assign tags to it, and assign the same
tags to a group, an alert is not triggered for this group of monitors if none of the monitors in the group
contain the same tags as in the alert.

Alert Types
When you create an alert scheme in SiteScope, you create alert actions to be triggered when the alert
conditions are met. You create alert actions using the Alert Action dialog box. SiteScope includes the
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following alert types:
l

"Disable or Enable Monitors Alert Properties" on page 1281

l

"Email Alert Properties" on page 1282

l

"Event Console Alert Properties" on page 1284

l

"Log Event Alert Properties" on page 1284

l

"Post Alert Properties" on page 1286

l

"Script Alert Properties" on page 1287

l

"SNMP Trap Alert Properties" on page 1290

l

"Sound Alert Properties" on page 1292

l

"Trigger Properties" on page 1292

Alert Associations and Considerations
The table below displays an overview of the different alert associations and considerations.
Alert
Class

Description

Global
Alerts

Alerts that are triggered when any monitor on a given SiteScope reports the category
status defined for the alert.
New groups and monitors added after the alert definition is created are automatically
associated with the alert.
The following display is an example of a global alert associated with the SiteScope node.
All monitors can trigger this alert.

Note: We do not recommend creating a global alert because the alert can potentially be
triggered by every group and monitor within SiteScope.
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Alert
Class

Description

Group
Alerts

Alerts that are triggered when any monitor within the associated group or groups reports
the category status defined for the alert.
The following is an example of a group alert. Any monitor or subgroup within the group
WebServers can trigger this alert.

A
icon displayed to the left of a group in the Alert Targets panel indicates that all
monitors and subgroups contained within that group have been selected. New subgroups
and monitors added within the associated group or groups after the alert definition is
created are automatically associated with the alert ("all selected" status).

A icon displayed to the left of a group indicates that not all monitors and subgroups
contained within that group have been selected ("partially selected" status). If you
remove a monitor from Alert targets defined for a group that is in the "all selected"
status, the group changes to the "partially selected" status, and any monitors that you
subsequently add to the group are not automatically associated with the alert. If you
delete all monitors from the group that are not associated with the alert, the group
automatically reverts to the "all selected" status and behaves accordingly (see previous
paragraph).
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Alert
Class

Description

Individual Alerts that are triggered when an associated monitor reports the category status defined
Monitor
for the alert.
Alerts
The following is an example of an individual monitor alert. Only the associated monitor
can trigger this alert.

New monitors added after the alert definition is created are not automatically associated
with the alert but can be added by editing the alert definition.

Tip: While you can create as many SiteScope alert definitions as required, you should plan and
consolidate alerts to keep the number of alert definitions to a minimum. This facilitates alert
administration and helps reduce redundant alert messages or actions.

Tasks
How to Configure an Alert
This task describes the steps involved in configuring an alert definition.
1. Prerequisites
Only a SiteScope administrator user, or a user granted the appropriate alerts permissions can
view, create, or edit alerts. For details on user permissions, see "Permissions" on page 744.
2. Create an alert
You can create a new alert or copy an existing alert into any group or monitor container in the
SiteScope tree.
n

Create a new alert. Right-click the container to which you want to associate the alert, and
select New > Alert. Enter a name for the alert, select the targets to trigger the alert, and
configure an alert action (in the Alert Actions panel, click New Alert Action to start the Alert
Action wizard). For each alert scheme, you can create one or more alert actions. For user
interface details, see "New/Edit Alert Dialog Box" on page 1267.
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n

Copy an Alert Definition. In the Alerts tab, select the alert you want to copy, and paste it into
the desired group or monitor container. The alert target automatically changes to the group or
monitor into which the alert is copied.
Note: The option to create alerts using the Pager or SMS action type is no longer
available, and we plan to remove support for these alert action types in the next version of
SiteScope.

Caution: If you copy an alert definition from one group container to another, the Alert
targets for the pasted alert are automatically reset to include all of the children of the
container into which the alert is pasted. After pasting an alert, edit the alert definition
properties to be sure that the assigned Alert targets are appropriate to the new alert
context and your overall alerting plan.
3. Test the alert
Select the alert in the Alerts tab of the monitor tree and click Test. Select the monitor instance you
want to test and click OK. A dialog box opens with information about the alert test.
Note: The monitor you select does not have to be reporting the same status category that is
selected to trigger the alert to test the alert. For example, the monitor does not have to
currently be reporting an error to test an alert that is triggered by error conditions.
4. Customize an alert's message content and template tag style
You can customize SiteScope alert templates to alter the content and format of alert messages.
For details, see "How to Customize an Alert's Message Content" on page 1298.
You can also customize SiteScope alert templates tag styles if you have a parser that needs a
specific delimiter or to change the bracket delimiters used to identify variables. For details, see
"How to Customize Alert Template Tag Styles" on page 1300.
5. Results
An alert is added to the specified container in the monitor tree (indicated by the

icon). The alerts

icon
is also displayed in SiteScope Dashboard next to each group or monitor that has one or
more configured alerts.
Example:
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6. Disable an alert - optional
You can disable alerts from the Alerts tab. Select the alerts that you want to disable, and click the
Disable button. Alerts disabled from the Alerts tab cannot be triggered; this overrides the
associated alerts status set for a monitor in the monitor Properties tab or Dashboard.
Note: For details on disabling alerts associated with specific groups and monitors (not the
alerts themselves), see "Set up monitor alerts - optional" on page 264.

Tips/Troubleshooting
Tips for Reducing False Alerts Resulting from Network Connectivity Issues
l

l

l

Alerting strategy: Make sure you are using the most appropriate trigger frequency for the system
being monitored. This enables you to control when alerts are sent in relation to when a given
condition is detected. For details, see "Understand When SiteScope Alerts Are Sent" on the next
page.
Protect against false alarms. Create dependencies to prevent redundant alerting from multiple
monitors that are monitoring different aspects of a single system (for example, making dependency
on a dedicated network health monitor such as Ping). For details, see "Monitoring Group
Dependencies" on page 255.
Adjust the timeout values according to the specific connection method used for gathering data from
the remote servers (SSH, WMI, NetBIOS and so forth) and according to the specific monitor types
used.

Exporting Alert Configurations to a Report
You can export alert configurations to an Excel file in order to analyze it (to understand which monitors
have alerts and which do not).
To export the Alerts table content to Excel:
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1. Select all rows in the Alerts table.
2. Press CTRL + C.
3. Paste to an Excel file.
Note: While most of the column values appear as string values as in the user interface, some may
contain internal IDs.

Understand When SiteScope Alerts Are Sent
SiteScope triggers the alert as soon as any monitor it is associated with matches the alert trigger
condition. The trigger settings options in the Alert Action dialog box enable you to control when alerts
are sent in relation to when a given condition is detected. For example, you can choose to have
SiteScope send an alert only after an error condition persists for a specific interval corresponding to a
given number of monitor runs. This is useful for monitors that run frequently that monitor dynamic,
frequently changing environment parameters. In some cases, a single error condition may not warrant
any intervention. For details about configuring trigger settings, see "Trigger Frequency Panel" on page
1294.
The following examples illustrate how different alert configurations send alerts after the error condition
has persisted for more than one monitor run. It is important to note that the sample interval corresponds
to how often the monitor is run. If a monitor runs every 15 seconds and the alert is set to be sent after
the third error reading, the alert is sent 30 seconds after the error was detected. If the monitor run
interval is once every hour with the same alert setup, the alert is not sent until 2 hours later.

Example 1 - Always, after the condition has occurred at least N times:
Example 1a. An alert is sent for each time monitor is in error after condition persists for at least
three monitor runs. Compare this with Example 1b below.
Alert setup

Always, after the condition has occurred at least 3 times

sample interval

0

1

2

3

4

5

6

7

8

c=0

c=1

c=2

c=3
alert!

c=4
alert!

c=5
alert!

c=0

c=1

c=2

status
count

Example 1b. An alert is sent for each time monitor is in error after condition persists for at least
three monitor runs. Shows how the count is reset when the monitor returns one non-error reading
between consecutive error readings. Compare this with Example 1a above.
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Alert setup

Always, after the condition has occurred at least 3 times

sample interval

0

1

2

3

4

5

6

7

8

c=0

c=1

c=2

c=0

c=1

c=2

c=3
alert!

c=0

c=0

status
count

Example 2 - Once, after the condition has occurred exactly N times:
An alert is sent only once if monitor is in error for at least three monitor runs, regardless of how long
the error is returned thereafter.
Alert setup

Once, after the condition has occurred exactly 3 times

sample interval

0

1

2

3

4

5

6

7

8

c=0

c=1

c=2

c=3
alert!

c=4

c=5

c=6

c=7

c=8

status
count

Example 3 - Initially, after X times, and repeat every Y times:
Example 3a. An alert is sent on the fifth time monitor is in error and for every third consecutive
error reading thereafter. Compare this with Example 3b below.
Alert setup

Initially, after 5 times, and repeat every 3 times

sample interval

0

1

2

3

4

5

6

7

8

c=0

c=1

c=2

c=3

c=4

c=5
alert!

c=6

c=7

c=8
alert!

status
count

Example 3b. An alert is sent on the third time monitor is in error and for every fifth consecutive
error reading thereafter. Compare this with Example 3a above.
Alert setup

Initially, after 3 times, and repeat every 5 times

sample interval

0

1

2

3

4

5

6

7

8

status
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Alert setup

Initially, after 3 times, and repeat every 5 times

count

c=0

c=1

c=2

c=3
alert!

c=4

c=5

c=6

c=7

c=8
alert!

Example 4 - Configuring Multiple Alerts:
Because you can create multiple alerts and associate more than one alert to a monitor, you can tell
SiteScope to take more than one action for a given situation. For example, you can create one alert
that tells SiteScope to page you whenever any monitor returns an error status. You can then create
another alert that tells SiteScope to run a script file to delete files in the /tmp directory on your
server if your Disk Space Monitor returns an error. If your disk becomes too full, SiteScope would
page you because of the first alert definition and would run the script to delete files in the /tmp
directory because of the second alert definition.
SiteScope alerts are generated when there is a change in state for a monitor reading. Thus you can
set an alert for OK or warning conditions as well as error conditions. One way to take advantage of
this is to add two alerts, one alert on error, and one alert on OK. Set alerts to be sent after the
condition is detected 3 time. For the OK alert, check the box marked Only alert if monitor was
previously in error at least 3 times. This prevents unmatched OK alerts, such as when a monitor
was disabled for any reason (manually, by schedule, or by depends on) and then starts up again.
This can also be used so that an OK alert is only sent after a corresponding error alert was sent.
With these two alerts, you get a page when a link or service goes down (monitor detects change
from OK to error), and another when it comes back up (monitor detecting change from error to
OK).
The following is an example of using two alerts with a monitor. An Alert on error sent once for
error after condition persists for at least three monitor runs. Alert on OK sent once for good status
after at least one error or warning interval.
Alert on Error
Setup

On
Error

Alert on OK Setup

On
OK

Sample Interval

0

Once, after the condition has occurred exactly 3 times
Once, after the condition has occurred exactly 1 times
and
Only alert if monitor was previously in error at least 3
times
1

2

3

4

5

6

7

8

c=3
alert!

c=4

c=5

c=6

c=7

c=1
alert!

Status
Count

c=0 c=1 c=2

After the monitor's status changes, the relevant status count is reset to zero.
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Database Alerts
Database alerts can forward system fault data and other status information to any SQL-compliant
database.
The following diagram illustrates the Database alert:

You need the following to be able to use the Database alert type:
l

l

l

l

Access to a SQL compliant database.
The applicable database connection URL which the SiteScope server uses to connect to the
database.For examples of common database connection URLs, see the "Setup Requirements and
User Permissions" section for the relevant database monitor.
Installation of the applicable database middleware driver that the SiteScope application uses to
communicate with the database on the SiteScope server. For examples of common database driver
strings, see the "Setup Requirements and User Permissions" section for the relevant database
monitor.
Database tables that have been created and structured to match the corresponding SQL statement
that SiteScope uses to enter the alert into the database.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
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Disable or Enable Monitor Alerts
Disable or Enable Monitor alerts can turn off and turn on the triggering of alerts for monitors. This is
useful for times when server maintenance or other activities are being performed that would logically
result in errors for some monitors and cause unnecessary alerts to be generated.
The following diagram illustrates an example of this alert type used to disable several monitors based
on the condition reported to one monitor.

This alert type provides a functionality similar to the Depends on function for building group
dependencies between monitors and monitor groups. One important difference is that monitors
disabled by this type of alert are not automatically re-enabled when the status of the subject monitor or
group changes back to the original state. You can create one alert with an Alert Category of Error that
disables monitors. You can then create a second alert with an Alert Category of Good that enables
the same monitors.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

Email Alerts
Email alerts send event notifications from SiteScope to a designated email address as seen in the
following diagram.
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You need the following to be able to use the Email alert type:
l

Access to an active email server

l

One or more email accounts that can receive the email alerts

l

SiteScope Email Preferences set to work with the external email server

For more information on configuring SiteScope email recipients, see "Email Preferences" on page 568.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
Note: Email alerts are in plain text format. To receive email alerts with a line break between each
monitor listed in the alert, you must configure Microsoft Outlook not to remove line breaks.

Event Console Alerts
Event Console alerts are used to send event notification to an event console. This enables you to view
and manage all SiteScope events from a centralized location; SiteScope Dashboard, Multi-View, or
from a standalone Event Console.
For more information on configuring SiteScope to use Event Console alerts, see "Event Console Alert
Properties" on page 1284.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
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Log Event Alerts
Log Event alerts can be used to extend the types of events that are logged to a Windows Application
Event Log. This provides a way to forward event data to log query systems that may not normally be
logged by the Windows operating system.
The following diagram illustrates the Log Event alert:

You need the following to be able to use the Log Event alert type:
l

l

Access to the Windows Event Log service. By default, this is the Event Log on the machine where
SiteScope is running. The alert definition can be configured to send log events to another server.
SiteScope running on a Microsoft Windows platform.
Caution: If you are using SiteScope's Microsoft Windows Event Log Monitor, you must use care
when using the Log Event alert type because it is possible create an endless loop condition that
can fill your Event log file. This can happen when a Microsoft Windows Event Log Monitor detects
an event that triggers a Log Event alert, which in turn puts an new event into the event log, which
the Event Log Monitor then detects, and then triggers the Log Event alert, and so forth. To avoid
this, Log Event alert types should not be associated with Microsoft Windows Event Log Monitors.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
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Pager Alerts (Deprecated)
Note: This alert action type is no longer available, and HP plans to remove support for it in the next
version of SiteScope. For backward compatibility, this alert action type can be enabled by adding
the property _enableDeprecatedAlertActions=pager to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated
by a comma if other values are listed.
Pager alerts can be used to send event notification to electronic pagers. This is particularly useful when
access to email may not be available. Depending on the type of pager you use and the capabilities of
the pager service, you can configure the Pager Alert to send a pager message with an abbreviated
description of the problem or detected condition.
The following diagram illustrates the Pager alert:

You need the following to be able to use the Pager alert type:
l

Access to an active pager service

l

A modem which the SiteScope server can use to connect to the pager service

l

One or more pagers that can receive the pager alerts

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
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Post Alerts
Post alert use the Common Gateway Interface protocol to forward POST data to a CGI enabled
program. This can be used to forward event data to CGI script on another server that is a front-end for a
trouble ticket system or reporting database. This alert type also provides a way of sending alert
information through a firewall using HTTP or HTTPS without having to make other security changes.
The following diagram illustrates the Post alert:

You need the following to be able to use the Post alert type:
l

HTTP access between the SiteScope server and the server running the CGI script or server.

l

Format and syntax of the CGI POST request to the applicable CGI script or server.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

Script Alerts
Script alerts can automatically initiate recovery scripts. You can configure a Script alert to run a
command to restart a server or a service.
The most important components of Script Alerts are:
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l

The script definition itself.

l

The monitor or monitors that are assigned to trigger the alert.

l

The script to be run by the alert.

The alert message template and resulting alert message file may also need to be considered depending
what the script needs to do. You can use a script template, together with the Parameters setting to
pass data to your script.
The following diagram illustrates the general concept of the script alert for both a local script and a
script on a remote host.

The script alert definition or instance and the monitor or monitors that trigger the alert are handled as
with other alerts or monitors in SiteScope. For example, you may create a monitor to watch a Web
server running on a remote UNIX server. You can create a Script Alert associated with that monitor that
runs a script to kill and restart the Web server process if the monitor reports an error.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.
This section also includes:
l

"Managing Script Files" on the next page

l

"Passing Data to a Script" on the next page

l

"Running Different Types of Scripts" on page 1261

l

"Troubleshooting Scripts" on page 1261
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Managing Script Files
Creating the script file to be called or run by the Script Alert definition is another key step in using this
automation capability in SiteScope. The specific commands and actions taken by the script are up to
you. The script file should be written as a plain text file compatible with the operating system where the
script is to be run. This may be the same server where SiteScope is running or it may be on a remote
machine to which SiteScope has access.
To run a script on the machine where SiteScope is running, the script file must be saved in the
<SiteScope root_directory>\scripts directory on the SiteScope machine where the Script Alert is
defined.
To run a script on a remote machine, you must save the script in a directory called \scripts in the home
directory tree for the user account that SiteScope has execute permissions for on the remote machine.
The current execution directory when a script is run is <SiteScope root directory>\classes\ and not
the <SiteScope root directory>\scripts\ directory. For commands run by the script itself, the relative
execution directory is <SiteScope root directory>\classes\. Use full paths for any other file system
commands or programs called by your script so that you do not need to worry about the current
directory. Also, the server system environment variables may not have been set up for the script
execution. This is another reason to use full paths for executables called by the script. If a script works
when you run it from the command line but not from SiteScope, then you must determine what the error
is.

Passing Data to a Script
SiteScope passes a number of parameters to the script as command line arguments. You can use this
option to pass data to a script that can be used to modify a script's action. This adds versatility to the
Script Alert. By default, a SiteScope Script Alert passes seven command line arguments to a script.
These are:
l

The path of the scripts directory.

l

The name of the monitor that caused the alert.

l

The current status of the monitor.

l

The path to the Alert Message File.

l

The ID code of the monitor.

l

The group the monitor is in.

l

Any additional parameters specified on the Parameters text box in the alert form.

Two of these default arguments enable the script to access even more data. One is the Alert Message
File and the other is the Parameters text box. The Alert Message File is a temporary text file created by
SiteScope based on the alert template chosen for the Script Alert instance. Depending on the template
you create or use, the Alert Message File may contain custom information as well as data specific to
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the monitor that triggered the alert. By passing the path to the Alert Message File to the script, you can
have the script access this data.
You use the Parameters text box to specify individual monitor parameter data to be passed to the
script. You can include multiple parameters by separating the parameters with spaces. This effectively
enables you to increase the total number of parameters passed to the script.
The path of the scripts directory can be useful in setting a execution path to another program as well as
setting a directory path for any output written by the script.
For more information and examples of passing parameters and data to scripts, see "Write Scripts for
Script Alerts" on page 1301.

Running Different Types of Scripts
You can run non-batch scripts, for example VBScript or Perl scripts, without wrapping them into a batch
file.
l

l

You can see scripts with any extensions by adding the _scriptMonitorExtensions property to the
<SiteScope root directory>\groups\master.config file. For example, to see .pl, .py, or .php
scripts, use the following format:
_scriptMonitorExtensions=.pl;.py;.php
You can run script interpreters with script extensions by adding the _scriptInterpreters property
to the <SiteScope root directory>\groups\master.config file as follows: _
scriptInterpreters=pl=c:/perl/perl.exe;py=c:/python/python.exe;php=c:/php/
php.exe

Troubleshooting Scripts
This section describes troubleshooting and limitations when working with SiteScope scripts.
l

l

l

The scripts are run with the permissions of the account used by the SiteScope service. Some
scripts may need extra permissions and you must use the Services control panel to change the
login account for SiteScope and then stop and start SiteScope. For example, scripts that restart
services or reboot remote machines or scripts that copy protected files.
Because the script is run by the SiteScope service, anything done as part of your login may not
have occurred in the script. For example, you cannot rely on mapped drives, environment variables,
or other login script items. In addition, it cannot receive any interactive input from a keyboard or
other input device. Any script action or command that requires a user confirmation or input would
cause the script to hang. Do not include any interactive commands requiring a user action as part of
the script. Also, opening a WIN32 application (for example, Notepad) also causes the script to hang
because it is waiting for the user to exit or close the application before continuing with the script
execution.
If there are quotation marks in the Script Alerts status summary, SiteScope doubles the quotation
marks in the Script Alert results. Take this into account when defining a content match filter.
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SMS Alerts (Deprecated)
Note: This alert action type is no longer available, and HP plans to remove support for it in the next
version of SiteScope. For backward compatibility, this alert action type can be enabled by adding
the property _enableDeprecatedAlertActions=SMS to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated
by a comma if other values are listed.
SMS alerts are designed to transmit the name of the SiteScope monitor that has reported an event
condition and the status of that monitor as the content of the message. It is an alternative to the Pager
alert for communicating event notifications to mobile users without using email.
Note: At present, the SMS alert can only be sent from SiteScope by using the hardware specified
in this section. For alternative ways of sending SMS messages using SiteScope, see the HP
Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result). To enter the knowledge
base, you must log on with your HP Passport ID.
The following diagram illustrates the SMS Alert:

You need the following to be able to use the SMS alert type:
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l

l

l

l

An available serial communications port on the SiteScope machine that is sending the SMS alerts.
A serial-to-wireless device interface cable, RS-232 Adapter Cable Nokia DLR-3P to connect the
wireless transmitting device to the machine where SiteScope is running.
An SMS-enabled wireless device connected to the SiteScope machine that is sending the alerts
(that is, the Nokia 6310 phone using the interface cable).
The necessary software to enable the SMS Alert (normally included with SiteScope 7.6c1 and
later).
Note: Make sure that you do not have Nokia Data Suite, Palm Hot Sync, or any PDA software
running on the server where SiteScope is running. These programs can bind the COM ports and
prevent the dialer from working correctly.

For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

SNMP Trap Alerts
SNMP Trap alerts forward event data from any type of SiteScope monitor to an SNMP enabled host or
management system. This means that SiteScope can be used to monitor and report events for
applications and systems that do not have their own SNMP agent. For example, this can be used to
send measurement data from a SiteScope Microsoft Windows Performance Counter based monitor
type or a URL monitor in the form of an SNMP trap.
The following diagram illustrates the SNMP Trap Alert.
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You need the following to be able to use the SNMP trap alert type:
l

Access to the applicable SNMP network ports

l

SiteScope SNMP Preferences set to work with the applicable SNMP management console

Encoding for outgoing SNMP Trap Alerts can be determined by configuring the _snmpTrapEncoding
parameter in the <SiteScope root directory>\groups\master config file.
For more information on configuring SiteScope to use SNMP alerts, see "SNMP Preferences" on page
723.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

Sound Alerts
Sound alerts play a sound or audio file on the machine on which SiteScope is running when an alert is
generated. The alert is effective only if the SiteScope server is in an area regularly occupied by support
staff and the server is equipped with a sound card capable of processing the associated sound file.
Alternatively, SiteScope can be configured to embed an alert audio file into the Web pages served by
SiteScope. This audio file is included with any SiteScope page that includes an error status for any
monitor, such as the main pane or group detail pages. While this enables audio notification to all
SiteScope clients through the user interface, it is not a true SiteScope alert and thus does not enable
the same configuration options as the Sound Alert.
For details on how to configure SiteScope to play sounds through the browser to indicate when an
event occurs in the user interface, see the "How to Configure SiteScope to Play Sounds for User
Interface Events (Not for Monitor Status)" on page 1299.
For other information on sound alerts, refer to the HP Software Self-solve Knowledge Base
(https://softwaresupport.hp.com/group/softwaresupport/search-result). To enter the knowledge base,
you must log on using your HP Passport ID.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

Trigger Alert
The Trigger alert triggers an alert without invoking any specific action. It should be used when you want
the alert to send event information to HPOM or BSM without performing any additional action. Note that
Send events in the HP Operations Manager Integration Settings panel of the alert must be selected.
For details on how to configure an alert, see "Configure SiteScope Alerts" on page 1243.

SiteScope Alerts User Interface
This section includes:
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l

"SiteScope Alerts Page" below

l

"New/Edit Alert Dialog Box" on page 1267

l

"Action Type Dialog Box" on page 1276

l

"Alert Action Dialog Box" on page 1278

l

"Action Type Settings Panel" on page 1278

l

"Status Trigger Panel" on page 1293

l

"Trigger Frequency Panel" on page 1294

SiteScope Alerts Page
This page displays information about the alerts associated with the selected monitor or group. It also
includes Analytics alerts configured when using Preventative Analytics (see "Configure Predictive
Analytics" on page 1375). Use this page to add, edit, or delete alert definitions.
To access

Important
information

In the monitor or template tree, select a group or monitor that has the alert symbol
displayed next to it. In the right pane, click the Alerts tab to display the alerts
configured for the object.
l

l

l

l

l

Alerts created for a specific monitor or group are displayed in the object's Alerts
on Monitor/Group list. Targeted monitors or groups are displayed in the Alerts
Associated with Monitor/Group list.
Each table column can be sorted in ascending or descending order by rightclicking the column title. An up or down arrow indicates the sort order.
You can also use the SiteScope API when working with alerts. For details, see
"SOAP-based APIs" on page 159.
You can copy details from selected rows in the Alerts tableusing the Ctrl + C
shortcut.
You manage Analytics alerts from this page.

Relevant
tasks

"Configure SiteScope Alerts" on page 1243

See also

"Configure SiteScope Alerts" on page 1243
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User interface elements are described below:
UI Element

Description
Show Child Alerts. Displays only those alerts that are direct children of the selected
node.
Show All Descendent Alerts. Displays all descendent alerts of the selected node.
New Alert. Opens the New Alert dialog box enabling you to configure an alert, and
add it to the selected SiteScope group or monitor. For user interface details, see
"New/Edit Alert Dialog Box" on the next page.
Note: This button is available in the Alerts on Monitor/Group table only
Edit Alert. Opens the Edit Alert dialog box enabling you to edit the properties of the
selected alert. For user interface details, see "New/Edit Alert Dialog Box" on the next
page.
Copy. Makes a copy of the alert.
Note:
l

This button is available in the Alerts on Monitor/Group table only.

l

Analytics alerts cannot be copied to another target monitor or group.

Paste. Pastes the alert to a selected location in the tree.
Note: This button is available in the Alerts on Monitor/Group table only.
Delete Alert. Deletes the alert from the tree.
Enable. Enables the alert associated with the monitor/group.
Disable. Disables the alert associated with the monitor/group.
Test. Tests the alert definition on a selected server.
Select All. Selects all listed alerts.
Clear Selection. Clears the selection.
Name

The name by which the alert is known in SiteScope.

Status

The enabled/disabled status of the alert.

Description A description of the alert.
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UI Element

Description

Action
Name

The alert action type and the name given to the alert action in the "Action Type Dialog
Box" on page 1276.

Path

Path of the group or monitor associated with the alert.

New/Edit Alert Dialog Box
This dialog box enables you to define alerts for a SiteScope, a group, or a monitor.
To access

Right-click the SiteScope, group, or monitor for the alert, and select New > Alert,
or select an existing alert in the Alerts tab (monitor or template view) and click the
Edit Alert

Important
information

l

l

l

Relevant
tasks
See also

button.

Only a SiteScope administrator user, or a user granted the appropriate alerts
permissions can view, create, or edit alerts. For details on user permissions,
see "Permissions" on page 744.
The option to create alerts using the Pager or SMS action type is no longer
available, and we plan to remove support for Pager and SMS Alert action types
in the next version of SiteScope.
If the name or description field contains an ampersand (&), less than (<), or
greater than (>), they are automatically escaped, for example, &amp;, &lt;, or
&gt;.

"How to Configure an Alert" on page 1247

l

"Configure SiteScope Alerts" on page 1243

l

"Action Type Dialog Box" on page 1276

l

"Alert Action Dialog Box" on page 1278

l

"Common Event Mappings" on page 547

This dialog box includes the following panes:
l

"General Settings" on the next page

l

"Alert Targets" on page 1269

l

"Alert Actions" on page 1270

l

"HP Operations Manager Integration Settings" on page 1272
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l

"Enable/Disable Alerts" on page 1273

l

"Filter Settings" on page 1274

l

"Search/Filter Tags" on page 1275

General Settings
User interface elements are described below:
UI Element

Description

Name

Name for this alert definition. This name is used to identify this alert definition in the
product display.
Note: The alert name cannot contain any of the following characters: ' "

Alert
description

Description of the alert. This description does not appear in any other context. It
appears only when editing the alert.
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Alert Targets
User interface elements are described below:
UI
Elemen
t
Alert
targets

Description
Use the context menu tree to select the groups, monitors, or both, to trigger this alert. The
context menu includes the currently selected object and all of the child objects. To select
an object, select the check box to the left of the object name. Any combination of groups
or monitors can be selected.
Alternatively, you may select the SiteScope root and then define an alert filter rule in the
Filters Settings to limit alerting to those objects that match the conditions set in the filter.
For details, see "Filter Settings" on page 1274.
l

A
icon displayed to the left of a group indicates that all monitors and subgroups
contained within that group have been selected ("all selected" status).

New subgroups and monitors added within the associated group or groups after the
alert definition is created are automatically associated with the alert.
l

A icon displayed to the left of a group indicates that not all monitors and subgroups
contained within that group have been selected ("partially selected" status).

If you remove a monitor from Alert targets defined for a group that is in the "all
selected" status, the group changes to the "partially selected" status, and any
monitors that you subsequently add to the group are not automatically associated with
the alert. If you delete all monitors from the group that are not associated with the
alert, the group automatically reverts to the "all selected" status and behaves
accordingly (see previous bullet).
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Alert Actions
User interface elements are described below:
UI
Element

Description
New Alert Action. Opens the Action Type dialog box enabling you to define an action to
be done when an alert is triggered. For user interface details, see "Action Type Dialog
Box" on page 1276.
Edit Alert Action. Opens the Action Type dialog box enabling you to edit the alert
action. For user interface details, see "Action Type Dialog Box" on page 1276.
Delete Alert Action. Deletes the alert action. It does not disable the associated
monitors.
Duplicate. Duplicates the alert action.
Select All. Selects all listed alert actions.
Clear Selection. Clears the selection.
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UI
Element
<Alert
Action
Type
icon>

Description
Indicates the type of action defined in the alert.
Database. Sends an alert message with a description of the problem as a record to a
SQL database.
Disable or Enable Monitors. Manually controls the generation of alerts.
Email. Sends an email message to one or more email addresses with a description
of the error or warning.
Log Event. Logs events to the Microsoft Windows Event Log
Post. Submits a CGI POST containing a description of a monitor condition to a CGI
script, servlet, or other CGI-enabled program.
Script.SiteScope can run scripts or batch files when the alert trigger condition is
detected. The script or batch file that is called can run a system command or a program
in any language that can be called from a command line entry.
SNMP Trap. Sends an SNMP trap to an SNMP host or management console.
Sound. Plays a sound or audio file on the machine on which SiteScope is running
when an event has been detected.
Trigger. Triggers an alert without invoking any specific action. It should be used when
you want the alert to send event information to HPOM or BSM without performing any
additional action. Note that Send events in the HP Operations Manager Integration
Settings panel of the alert must be selected.

Name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Category

The category selected in the Status Trigger panel that triggers the alert action. For
details on the Status Trigger user interface, see "Status Trigger Panel" on page 1293.

When

The schedule selected in the Trigger Frequency panel for when the alerts are sent. For
details on the Trigger Frequency user interface, see "Trigger Frequency Panel" on page
1294.

Schedule The daily or weekly schedule selected in the Action Type Settings panel. For details on
the Action Type Settings user interface, see "Alert Action Dialog Box" on page 1278.
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UI
Element
Target

Description
Contains target data for the action type. Below you can see the content of the target
column according to type:
l

Database. Contains the URL entered in the Database connection URL box.

l

Disable or Enable. Contains the targets selected in the Targets list.

l

Email. Contains the email recipients selected in the Send email to section.

l

Log Event. Contains the log event recipients selected in the Send email to section.

l

Post. Contains the URL entered in the Post to url form box.

l

Script. Contains the script selected in the Script box.

l

SNMP Trap. Contains the SNMP traps selected in the SNMP Trap list.

l

Sound. (The column is empty)

l

Trigger. (The column is empty)

HP Operations Manager Integration Settings
Note: The HP Operations Manager Integration Settings panel is available only if the
HP Operations agent is installed and connected to an HPOM/BSM server, and Enable sending
events is selected in the HP Operations Manager Integration dialog box (Preferences >
Integration Preferences > HP Operations Manager Integration > HP Operations Manager
Integration Main Settings). For details, see "How to Enable SiteScope to Send Events to HPOM
or OMi" in Integrating SiteScope with HP Operations Manager Products in the SiteScope Help.
You can check the HP Software Integrations site for the latest version of this guide.
User interface elements are described below:
UI
Element
Send
events

Description
Enables sending events to the HPOM/BSM server when an alert is triggered.
Default value: Selected
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UI
Element

Description

Use
If selected, when an alert is triggered, SiteScope sends an event using the event
monitor's mapping template associated with the monitor that triggered the alert.
event
If cleared, SiteScope sends an event using the alert event attribute values. These
mapping
values are filled according to the selected alert event mapping preference. The Event
mapping setting below is available only when alert event mapping is used.
Default value: Not selected
Event
mapping

The event mapping template that is used for sending events for the monitor instance.
The template contains mappings between SiteScope runtime data of the alert and the
monitor that triggered the alert (metric level runtime data is not available) and the
attribute values that are used for sending events.
Select the desired event mapping template, or use the default mapping. Click New or
Edit to open the Common Event Mappings dialog box and configure a new events
preference or modify an existing one. For user interface details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 551 and "New/Edit Event Mappings
Dialog Box - Custom Attributes Tab" on page 557.
Note: This setting is active only when Use monitor's event mapping is cleared.

Event
type
indicator

You can enter an event type indicator for the alert that is sent with this event. This is the
mapping between the measurement and its indicator. This is optional, and events
without an indicator are still sent.
Manually entering an indicator is useful since the CI type of a triggered alert is not
always known when the alert is configured (for group alerts or alerts for monitors
reporting CI type per metric).
Note: The indicator cannot be resolved automatically, since the alert instance might be
associated with more than one monitor or be triggered by more than one counter.

Event
type
indicator
state

You can enter the event type indicator state that is sent with this event. This is the event
severity level (Unknown, Normal, Warning, Minor, Major, Critical) that is mapped to the
threshold that caused this status change. This field is optional, and events without an
indicator state are still sent.
Note: The indicator state cannot be resolved automatically, since the alert instance
might be associated with more than one monitor or be triggered by more than one
counter.

Enable/Disable Alerts
Use to manually control the generation of alerts. This can be useful when the systems being monitored
are off-line for maintenance or if the recipient of the alerts is unavailable for a period of time.

HP SiteScope (11.31)

Page 1273 of 1395

Using SiteScope
Chapter 102: Configure SiteScope Alerts

User interface elements are described below:
UI Element

Description

Enable alert

Overrides any disable action on the alert and enables the alert for execution
based on the conditions defined.

Disable alert
indefinitely

Prevents SiteScope from executing the alert action even if the alert condition is
met until this radio button is cleared and the alert definition is updated.
Note: Use of this option may result in loss of expected alert capability if the
alert is disabled to accommodate a temporary condition. It is important to
review this status at a later time, and to manually enable the alert definition as
necessary.

Disable alert for
the next <time
period>

Prevents the execution of the alert action for the time period you type, even if
the alert condition is met. The alerts are disabled immediately and re-enabled
when the time period expires.

Disable on a one
time schedule
from <time1> to
<time2>

Prevents SiteScope from executing the alert action for the time period
indicated, even if the conditions are met. The alerts are disabled at the
beginning of the time period and re-enabled after the time period expires.

Disable
description

(Optional) Description of the purpose of the disable operation.

Filter Settings
Creates filter conditions to limit the alert action to only those monitors that match the criteria you
entered. You can define alerts for a large number of monitors and then apply a filter so that only specific
monitors within the selected list trigger the alert. This can simplify the creation of alert definitions and
alert management. To disable alert filtering, clear the applicable fields and update the alert definition.
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User interface elements are described below:
UI
Element Description
Name
match

Suppresses the alert for all associated groups or monitors except those with a specific
text appearing as part of their name.
l

l

Enter a regular expression in this text box to match a name string pattern. For details,
see "Regular Expressions" on page 175.
Enter all or part of the monitor name string you want to use as a filter criteria. For
example, entering the string URL: limits this alert to monitors whose name contains
the string URL:.

Note: The match is case sensitive.
Status
match

Suppresses the alert for all associated monitors except those returning a specific status
text.
l

l

Enter a string that you expect to appear in the status text for the monitor you want to
trigger this alert. For example, if you type the text timeout, an alert is only triggered
by a monitor associated with this alert that also has a status of timeout.
Enter a regular expression in this text box to match a status string pattern. For details,
see "Regular Expressions" on page 175.

Note: The match is case sensitive.
Monitor
type
match

Limits the alert action to a monitor type from the set of monitors associated with this alert.
Select the monitor types you want to include from the Monitor Type List and move them
to the Selected Monitor Type List button.

Tags
match

Limits the alert action to only those monitors associated with this alert that have the tag
values selected. Select the tags you want to include.

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.
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UI
Element Description
Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.

Action Type Dialog Box
This dialog box enables you to select the action to be done when an alert is triggered.
To access

1. Right-click the SiteScope, group, or monitor for the alert, and select New >
Alert, or select an existing alert in the Alerts tab (monitor or template view) and
click the Edit Alert

button.

2. In the Alert Actions section of the New/Edit Alert dialog box, click the New Alert
Action
Important
information

l

l

l

Relevant
tasks
See also

button.

You can select only one type of alert at a time.
If you are editing an alert, you cannot change the action type. For example, if an
alert's action type was Email, you cannot change it to Sound.
The option to create alerts using the Pager or SMS action type is no longer
available, and we plan to remove support for Pager and SMS Alert action types in
the next version of SiteScope.

"How to Configure an Alert" on page 1247

l

"Configure SiteScope Alerts" on page 1243

l

"New/Edit Alert Dialog Box" on page 1267

l

"Alert Action Dialog Box" on page 1278

User interface elements are described below:
UI
Element

Description

Sends an alert message with a description of the problem as a record to a SQL
Database database. You can then use database tools to provide more advanced recording, sorting,
and reporting on your monitoring data. For details on Database Alerts, see "Database
Alert Properties" on page 1279.
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UI
Element

Disable
or
Enable
Monitors
Email

Event
Console
Log
Event

Description
Automatically enables or disables monitors or monitor groups based on a change of
state in another monitor.
Note: This action is not available when creating a template alert. For details on
Disable/Enable Monitor Alerts, see "Disable or Enable Monitors Alert Properties" on
page 1281.
Sends an email message to one or more email addresses with a description of condition
that triggered the alert. For details on Email Alerts, see "Email Alert Properties" on page
1282.
Sends events to the SiteScope Event Console. For details on Event Console Alerts, see
"Event Console Alert Properties" on page 1284.

Logs events to the Microsoft Windows Event Log.
Entries in the event log can then be viewed with the Event Viewer and/or used by other
software utilities that perform centralized alerting from the event log. For details on Log
Event Alerts, see "Log Event Alert Properties" on page 1284.

Post

Submits a CGI POST message to a CGI script, servlet, or other CGI-enabled program.
The message contains a description of a monitor condition. For details on Post Alerts,
see "Post Alert Properties" on page 1286.

Script

SiteScope can run scripts or batch files when the alert condition is met. The script or
batch file can run a system command or a program in any language that can be called
from a command line entry.
You can use this alert to run recovery scripts that automatically respond to critical
conditions or failures (for example, to reboot a server or to copy files). For details on
Script Alerts, see "Script Alert Properties" on page 1287.

SNMP
Trap

Sends an SNMP trap to an SNMP management console or host. This enables SNMP
reporting of system parameters not normally supported by SNMP agents. For details on
SNMP Trap Alerts, see "SNMP Trap Alert Properties" on page 1290.

Sound

Plays a sound or audio file on the machine on which SiteScope is running when an event
has been detected. For details on Sound Alerts, see "Sound Alert Properties" on page
1292.

Trigger

Triggers an alert without invoking any specific action. It should be used when you want
the alert to send event information to HPOM or BSM without performing any additional
action. Note that Send events in the HP Operations Manager Integration Settings panel
of the alert must be selected. For details on Trigger Alerts, see "Trigger Properties" on
page 1292.
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Alert Action Dialog Box
Use the Alert Action dialog box to define the settings that are specific to the alert type and to configure
actions to be taken when an alert is triggered.
To access

1. Right-click the SiteScope, group, or monitor for the alert, and select New >
Alert, or select an existing alert in the Alerts tab (monitor or template view) and
click the Edit Alert

button.

2. In the Alert Actions section of the New/Edit Alert dialog box, click the New Alert
Action
Important
information

Relevant
tasks
See also

button. In the Action Type dialog box, select an action type.

The Action Alert dialog box consists of three panes:

l

n

Action Type Settings. The Action Type settings vary according to the type of
alert action you selected in the "Action Type Dialog Box" on page 1276. For
details of action type properties, see "Action Type Settings Panel" below.

n

Status Trigger. For details, see "Status Trigger Panel" on page 1293.

n

Trigger Frequency. For details, see "Trigger Frequency Panel" on page 1294.

"How to Configure an Alert" on page 1247

l

"Configure SiteScope Alerts" on page 1243

l

"New/Edit Alert Dialog Box" on page 1267

The following element is common to all action types:
UI
Element
New
Variable

Description
Click to define a new variable. For details, see "New Variable Dialog Box" on page 813.
This button is available only from New/Edit Alert Dialog Box and New Action Dialog
Box for template alerts.

Action Type Settings Panel
The contents of this panel depend on the action type you selected in the Action Type dialog box.
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To access

Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click the Edit
Alert

button. In the Alert Actions section of the New/Edit Alert dialog box, click

the New Alert Action
type.

button. In the Action Type dialog box, select an action

Important
The option to create alerts using the Pager or SMS action type is no longer available,
information and we plan to remove support for Pager and SMS Alert action types in the next
version of SiteScope.
Relevant
tasks

"Configure SiteScope Alerts" on page 1243

See also

"Alert Action Dialog Box" on the previous page

This section includes:
l

"Database Alert Properties" below

l

"Disable or Enable Monitors Alert Properties" on page 1281

l

"Email Alert Properties" on page 1282

l

"Event Console Alert Properties" on page 1284

l

"Log Event Alert Properties" on page 1284

l

"Post Alert Properties" on page 1286

l

"Script Alert Properties" on page 1287

l

"SMS Alert Properties" on page 1289

l

"SNMP Trap Alert Properties" on page 1290

l

"Sound Alert Properties" on page 1292

l

"Trigger Properties" on page 1292

Database Alert Properties
User interface elements are described below:
UI Element Description
Action
name

The name given to the action to be done when the alert is triggered. It is not the name
of the alert.
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UI Element Description
Database
Enter the URL to a database connection.
connection
Example: In Windows, use the ODBC Data Sources manager in the Settings control
URL
panel to create a connection called test and then type jdbc:odbc:test as the
database connection URL.
Note for using Windows Authentication: If you want to access the database using
Windows authentication, type jdbc:mercury:sqlserver://<server name or
IP address>:1433;DatabaseName=<database name>;
AuthenticationMethod=type2 as the connection URL, and
com.mercury.jdbc.sqlserver.SQLServerDriver as your database driver. Leave
the Database user name and Database password boxes empty, because the
Windows user credentials of the account from which the SiteScope service is running
are used to establish a connection to the database.
Database
driver

Enter the Java class name of the JDBC database driver.

SQL
statement

Enter the SQL statement used to add the alert to the database.

SiteScope uses the same database driver for both primary and backup database
connections. If a custom driver is used, the driver must also be installed in the
<SiteScope root directory>/java directory. For more information about setting up
database drivers for SiteScope, see "Database Query Monitor".

Items enclosed in angle brackets (< and >) are replaced with fields from the monitor
that triggered the alert.
Default value: INSERT INTO SiteScopeAlert VALUES('<time>', '<group>',
'<name>', '<state>')

Database
user name

Enter the user name to connect to the database if required.

Database
password

Enter the password to connect to the database if required.

Backup
If a backup database for SiteScope alert logging is required, enter the URL to the
database
backup database connection to use if the main database connection fails.
connection
Example: If the ODBC connection for the backup database connection is called
URL
testdb2, the URL would be jdbc:odbc:testdb2.
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UI Element Description
Schedule

Select the daily and weekly schedule to perform the alert action if the alert conditions
are met and the alert is triggered. The schedule helps prevent alert actions being
performed at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from
7:00 to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
You can also use variables in this field. To do so, enter %% to display the list of
available variables.
Default value: Every day, all day

Disable or Enable Monitors Alert Properties
User interface elements are described below:
UI Element

Description

Action name

The name given to the action to be done when the alert is triggered. It is not the
name of the alert.

Group/Monitors Select whether this alert action disables or enables a monitor when the alert is
action
triggered.
Default value: Disable
Targets

Select the groups and monitors that should be affected by the action of this alert.
The Targets list includes all groups and monitors configured for the SiteScope.
You can select any groups or monitors running in any group for this alert action
and add them to the Selected Targets list.
Example: This alert action is being configured for a Disk Space monitor. An alert
triggered for this monitor can disable all CPU monitors monitoring the same
server.
Default value: None selected
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UI Element

Description

Schedule

Select the daily and weekly schedule to perform the alert action if the alert
conditions are met and the alert is triggered. The schedule helps prevent alert
actions being performed at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be
performed between the hours of 7:00-22:00 only, select a range schedule that is
enabled from 7:00 to 22:00. You can select an existing schedule that has been
created in Schedule Preferences, or you can create a new schedule. For details,
see "Schedule Preferences" on page 712.
Default value: Every day, all day

Apply action to
subgroups of
the selected
groups

If selected, the alert action also applies to subgroups of the selected groups.
Default value: Not selected

Email Alert Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name
of the alert.
Example: If you want to configure an alert to check the CPU of all Solaris machines
and send an email message when some alert is triggered, you could define the alert
name in General Settings to be Solaris_CPU and the action name to be send_email.

Recipients Select one or more Email recipients for the alert from the Email Alert Recipients list.
The list displays the recipients that have been configured in Mail Preferences. For
details, see "Email Preferences" on page 568.
Default value: None selected
Note: Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 571.
Addresses Enter one or more email addresses separated by a comma (","). The addresses are
checked for valid syntax according to the official standard RFC 2822, but not for other
errors (for example, that the email user exists).
Note: If the Addresses box contains data, selections from the Email Alert Recipients
list are ignored.
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UI
Element
Subject

Description
Select the subject field template for the email alert action message. The Typical
template includes the following values:
l

the subject of the message (SiteScope Alert)

l

the category of the monitor alert (error, warning, ok, or no data)

l

the name of the monitor or monitor title

l

the status returned by the monitor

l

the address, in parenthesis, of the SiteScope installation that sent the alert

Default value: Typical
Example: SiteScope Alert, error, URL: http://gate.company.com, unknown host name
(gate.company.com)
Schedule

Email recipients have a predefined schedule.

Template

Select the template for the email alert action.
In an Email alert action, select the ShortMail template for a shorter email message.
Other options enable you to choose the level of detail to include in Email alerts.
Default value: Typical. This template includes the following values: Monitor:
<groupID>:<name>; Tags <tag>; Group: <group>; Status: <state>; Sample #:
<sample>; Time: <time>
Note: You can add additional templates into the <SiteScope
root directory>\templates.mail directory. For details on the available templates, you
can open the files in this directory in a text editor to see what values are sent with each
option. For details, see "Customize Alert Templates" on page 1296.

Mark this
action to
close alert

When the status changes and the alert trigger condition is no longer true, this action
closes the alert and sends a close notification by adding the word Close to the
message sent.
Default value: Not selected
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Event Console Alert Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. The schedule helps prevent alert actions being performed
at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
You can also use variables in this field only for template alerts. To do so, enter %% to
display the list of available variables.
Default value: Every day, all day
Event
Mapping

Select an event mapping template for the Event Console, or create a new event
mapping. The template contains the mappings between SiteScope run time data and the
attribute values that are used for sending events to the event console when a metrics
status change event is triggered. For user interface details, see "New/Edit Event
Mappings Dialog Box - General Tab" on page 551 and "New/Edit Event Mappings Dialog
Box - Custom Attributes Tab" on page 557.

Log Event Alert Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Send to

Enter the name of the Windows machine where the event is to be appended to the event
log.
Default value: localhost (the machine where SiteScope is running).
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UI
Element

Description

Template

Select the template for the log event type alert action.
Default value: Typical
Note: You can view the contents of the existing templates or add additional templates in
<SiteScope root directory>\templates.eventlog. For more details on alert templates,
see "Customize Alert Templates" on page 1296.

Message

Enter the message prefix to be sent to the event log.
You can add a link to open SiteScope in the context of the alerted monitor by entering
the following string:
Login: <sitescopeurl>/servlet/Main?activeid=<_internalId>
&activerighttop=dashboard&view=new&dashboard_view=
Details&dashboard_model=true&dashboard_favorite=test.

Event
source

Enter the string used to set the <Source> field of the logged event.
Syntax: must be text.
Default value:SiteScope

Event ID

Enter the number used to set the <ID> field of the event that is logged.
Syntax: must be numeric.
Default value: 1000

Event
type

Select the event type used for the event.

Event
category
ID

Enter a number to be used as the <category ID> for the event created by this alert.

Default Value: Use monitor status. This means that the Event Type is Error for an
Error status, Warning for Warning, and Informational for monitors reporting a status of
Good.

Default value: 0
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UI
Element

Description

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered.
You can also use variables in this field. To do so, enter %% to display the list of
available variables. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
Default value: Every day, all day
Mark this
action to
close
alert

When the status changes and the alert trigger condition is no longer true, this action
closes the alert and sends a close notification by adding the word Close to the message
sent.
Default value: Not selected

Post Alert Properties
User interface elements are described below:
UI Element

Description

Action name

The name given to the action to be done when the alert is triggered. It is not the
name of the alert.

Post to URL
form

Enter the URL of the CGI script that SiteScope should submit to the alert. For
example,
http://admindb.server.net/cgi-bin/error.pl.
Syntax: You must include the string http://. There is syntax checking for a valid
URL address.

Template

Select the template for the post alert action type.
Default value: Typical
Note: You can view the contents of the existing templates or add additional
templates in the <SiteScope root directory>\templates.post directory. For more
details on alert templates, see "Customize Alert Templates" on page 1296.
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UI Element

Description

Authorization Enter the user name to access the URL of the CGI script in a Post Alert. Not all
user name
CGI scripts require a user name.
Alternatively, leave this entry blank and type the user name in the Default
authentication user name section in the General Settings (Preferences >
General Preferences). Use this method to define common authentication
credentials for use with multiple monitors.
Authorization Enter the password for the Authorization user name in a Post Alert.
password
Alternatively, leave this entry blank and type the password in the Default
authentication password section in the Preferences > General Preferences.
Use this method to define common authentication credentials for use with multiple
monitors.
HTTP proxy

Enter the domain name and port of an HTTP Proxy Server used to access the URL
of the CGI script.

Proxy server
user name

Enter the user name to access the URL of the CGI script, if required by the proxy
server.
Your proxy server must support Proxy-Authenticate.

Proxy server
password

Enter the password to access the URL of the CGI script, if required by the proxy
server.
Your proxy server must support Proxy-Authenticate.

Schedule

Select the daily and weekly schedule to perform the alert action if the alert
conditions are met and the alert is triggered. The schedule helps prevent alert
actions being performed at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be
performed between the hours of 7:00-22:00 only, select a range schedule that is
enabled from 7:00 to 22:00. You can select an existing schedule that has been
created in Schedule Preferences, or you can create a new schedule. For details,
see "Schedule Preferences" on page 712.
Default value: Every day, all day

Script Alert Properties
User interface elements are described below:
UI Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name
of the alert.
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UI Element

Description

Server

Select the server on which the script should be run.
The scripts directory must be in the directory tree of the remote login account that
enables remote scripts to be run by SiteScope.
Default value: SiteScope Server
Note when working in template mode: The drop-down list is displayed as a text
box to enable using a template variable in this field.

Script

Select the script to run in response to the selected condition.
You can create as many custom scripts as you need. Place them in <SiteScope root
directory>\scripts directory or the applicable scripts directory on a remote machine.
SiteScope lists all files found in this directory on the selected server in the drop-down
list.
Default value: restartServer.bat

Parameters Additional monitor parameters that you can pass to your script, such as:
l

path of the scripts directory

l

name of the monitor that caused the alert

l

current status of the monitor

l

path to the alert message file

l

ID of the monitor

l

monitor group

These parameters are sent as the seventh, eighth, ninth, and so forth, command line
arguments respectively.
The parameters available to be passed to the script are dependent on the type of
monitor that triggers the alert.
Syntax: Surround the property name variable in the properties list with angle brackets
(< >). For example, to pass the server name to the script, type <_machine> in the text
box. To pass more than one extra parameter, separate the parameters with a single
space. This is the same way the arguments would be added on the command line.
Default value: No value. The Script Alert always passes the above parameters to a
script as command line arguments. They do not need to be listed here.
Output
encoding

Select the encoding of the script output. This enables SiteScope to match and display
the encoded file content correctly.
Default value: windows-1252
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UI Element

Description

Template

Select the template for the script alert action type.
Default value: Typical
Note: You can view the contents of the existing templates or add additional templates
in the <SiteScope root directory>\templates.script directory. For more details on
alert templates, see "Customize Alert Templates" on page 1296.

Schedule

Select the daily and weekly schedule to perform the alert action if the alert conditions
are met and the alert is triggered.
You can also use variables in this field. To do so, enter %% to display the list of
available variables. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from
7:00 to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
Default value: Every day, all day

Timeout
(seconds)

Amount of time, in seconds, to wait for the script to run successfully before timing out.
Default value: -1 (no timeout)

SMS Alert Properties
Note: The option to create alerts using the SMS action type is no longer available, and HP plans to
remove support for it in the next version of SiteScope.However, this alert action type can be
enabled for backward compatibility by adding the property _
enableDeprecatedAlertActions=SMS to the <SiteScope root
directory>\groups\master.config file. The value is not case-sensitive, and should be separated
by a comma if other values are listed.
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.
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UI
Element

Description

SMS
number

Enter the telephone number required by the SMS service that identifies the destination
for the message.
Syntax: Numeric only. Maximum of 16 digits.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered.
You can also use variables in this field. To do so, enter %% to display the list of
available variables. The schedule helps prevent alert actions being performed at
inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
Note: This alert is available only in the Windows platform. In the Schedule field for this
template action, you can use variables.
Default value: Every day, all day

SNMP Trap Alert Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

SNMP
Trap

Select one or more SNMP Traps to trigger an alert.
Default value: None selected
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UI
Element

Description

Template

Select a template for the SNMP trap alert action type.
Each line in the template is sent as a separate SNMP variable. The template file can
also be modified using:
l

[Agent Host: <hostname-or-ip-address>] as the first line of the template, to
send the trap with that hostname or IP address as the source of the trap. By default,
the IP address of the machine that SiteScope is running on is used as the source of
the trap.

l

[Command: <command name>] to override the default command.

l

[Type: <var-type>] to override the default type of the object.

[OID: <object id>] to change the default object id. For example, use this to change a
var-binding variable object id.
Default value: Typical
Note: You can view the contents of the existing templates or add additional templates in
the <SiteScope root directory>\templates.snmp directory. For more details on alert
templates, see "Customize Alert Templates" on page 1296.
Message

Enter an optional prefix to be added to the SNMP trap sent by this alert.

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. The schedule helps prevent alert actions being performed
at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
You can also use variables in this field only for template alerts. To do so, enter %% to
display the list of available variables.
Default value: Every day, all day
Mark this
action to
close
alert

When the status changes and the alert trigger condition is no longer true, this action
closes the alert and sends a close notification by adding the word Close to the message
sent.
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Sound Alert Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.

Sound
file

Select the sound to be played from <SiteScope root directory>\templates.sound
directory. Additional sounds can be added to the directory in AU format (8 bit,
&#micro;law, 8000 Hz, one-channel) with an .au suffix.
Default value: Default

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. The schedule helps prevent alert actions being performed
at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
You can also use variables in this field. To do so, enter %% to display the list of
available variables.
Default value: Every day, all day

Trigger Properties
User interface elements are described below:
UI
Element

Description

Action
name

The name given to the action to be done when the alert is triggered. It is not the name of
the alert.
Example: If you want to configure an alert to check the CPU of all Solaris machines and
send a notification to HP Operations Manager when some alert is triggered, you could
define the alert name in General Settings to be Solaris_CPU and the action name to be
notify OM.
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UI
Element

Description

Schedule Select the daily and weekly schedule to perform the alert action if the alert conditions are
met and the alert is triggered. The schedule helps prevent alert actions being performed
at inappropriate times or outside business hours.
For example, if you want monitors to run 24/7, but want alert actions to be performed
between the hours of 7:00-22:00 only, select a range schedule that is enabled from 7:00
to 22:00. You can select an existing schedule that has been created in Schedule
Preferences, or you can create a new schedule. For details, see "Schedule
Preferences" on page 712.
You can also use variables in this field. To do so, enter %% to display the list of
available variables.
Default value: Every day, all day

Status Trigger Panel
Use the Status Trigger panel to select the status of the object type that triggers an alert action. Alerts
are triggered when the status changes from one state to another. Select the category that triggers the
alert action.
To
access

Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click the Edit
Alert

button. In the Alert Actions section of the New/Edit Alert dialog box, click the

New Alert Action

button. In the Action Type dialog box, select an action type.

Note: Analytic alerts can be configured for monitors only, and from the monitor view
only.
Relevant "Configure SiteScope Alerts" on page 1243
tasks
See also

"Alert Action Dialog Box" on page 1278

User interface elements are described below:
UI Element

Description

Unavailable Alerts are triggered if the monitored machine was previously available and is currently
no longer available.
Error

Alerts are triggered if the monitor was previously reporting a different status (default
option for regular alerts).

Warning

Alerts are triggered if the monitor was previously reporting a different status.
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UI Element

Description

Good

Alerts are triggered if the monitor was previously reporting a different status.

Analytics

(Available for Analytics alerts only) Alerts are triggered if the baseline threshold for the
monitor is crossed (default option for analytics alerts). For details, see "Configure
Predictive Analytics" on page 1375.

Trigger Frequency Panel
Use the Trigger Frequency panel to select the trigger frequency.
To access

Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or
select an existing alert in the Alerts tab (monitor or template view) and click the Edit
Alert

button. In the Alert Actions section of the New/Edit Alert dialog box, click

the New Alert Action
type.
Important
information

l

l

button. In the Action Type dialog box, select an action

The available options vary according to what you chose in the "Status Trigger
Panel" on the previous page.
For more detailed information on the options here, see "Understand When
SiteScope Alerts Are Sent" on page 1250.

Relevant
tasks

"Configure SiteScope Alerts" on page 1243

See also

"Alert Action Dialog Box" on page 1278

User interface elements are described below:
UI Element

Description

Escalate, after
action <>
occurred exactly
<N>times

Select this option if the alert action you are creating is dependent on another
alert action. You must select the name of the alert action on which this alert
action is dependent and the number of times the first alert action is triggered
before this alert action is triggered.
Example: You created an alert action to send a sound alert when a certain
condition is met. You want an Email alert to be sent when the sound alert action
has been triggered 3 times. Select the name of the sound alert action and 3.
Note: This option is displayed only if another alert action has been defined for
the alert.
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UI Element

Description

Always, after the
condition has
occurred at least
<N> times

After the alert conditions have occurred at least N times, the alert is triggered
every time the alert conditions are met again after the initial trigger.
Enter the minimum number of times the alert condition must be met before the
alert is triggered the first time.
Syntax: numeric only
Range: 1-99

Once, after the
condition has
occurred exactly
<N> times

The alert is triggered only once after the alert condition is met for the Nth time.
Enter the number of times the alert conditions must be met before the alert is
triggered.
Default value: Selected
Syntax: numeric only
Range: 1-99

Initially after
<X> times, and
repeat every <Y>
times

The alert is triggered after the alert condition occurs X consecutive times, and
then the alert is triggered every consecutive Y occurrences that the alert
conditions are met. For example, if X is set to 3, and Y is set to 4, then the alert
action would be done on the 3rd, 7th, 11th, and so forth, occurrences of the alert
condition.
Syntax: numeric only
Range: 1-99

Once, after <N>
group errors

This is displayed if you chose Error in the Status Trigger panel.
The alert is triggered only after any monitor in the group has reported the alert
condition exactly N consecutive times.
Note: This option is available only for SiteScope groups.

Once, after all
monitors in this
group are in
error

This is displayed if you chose Error in the Status Trigger panel.
The alert is triggered the first time all monitors in the group are in error (the alert
does not include monitors of subgroups).
Note: This option is available only for SiteScope groups.

Only alert if
monitor was
previously in
error/warning at
least <N> times

This is displayed if you chose Good or Warning in the Status Trigger panel.
This option suppresses the triggering of the alert until the subject monitor or
group has reported a status of either of the following:
l

l
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SiteScope uses templates when generating alert messages and reports. In most cases, you select the
template you want to use in the Alert page when you create an alert. You can customize the existing
templates or create your own by making a copy of an existing template. You customize the alert
templates by adding or removing text, by adding property variables (as listed in the "Properties
Available in Alerts, Templates, and Events" on page 1305), or changing the order of text or property
variables that are included in the template.

Learn About
Customizing Alert Template Overview
To make a custom alert template available to SiteScope, you must save any customized alert
templates into the directory containing the templates for the applicable alert type. For the list of
directory names containing SiteScope alert templates you can copy and customize, see "Alert
Template Directories" on the next page.
The templates in these groups are text files that include property variable markers. You use a text editor
to create or modify these templates. The new templates saved into the directories shown become
available to the applicable alert on the Alert page.
The following is an example of the default template used for the Email Alert. The first section is the alert
header. The first line in the alert header includes a link to the SiteScope installation which sent the
problem. This provides you with a way to access the SiteScope installation reporting the problem.
Below the link is a block of text that further summarizes what caused the alert. This includes:
l

The name of the monitor that triggered the alert.

l

The group to which the monitor belongs.

l

The alert status reported by the monitor.

l

l

The sample ID number indicating how many times the monitor ran before the condition was
reported.
The time of day when the error occurred.
This alert is from SiteScope at <SiteScopeURL>
Monitor: <groupID>:<name>
Group: <group>
Status: <state>
Sample #: <sample>
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Time: <time>
----------------------Detail --------------------<mainParameters>
<mainStateProperties>

The names that appear within <brackets> are property variable markers. When the alert is generated,
SiteScope replaces these markers with the corresponding values of the variable for the monitor or
monitor group that has triggered the alert.
You add or edit the text portions of the template. For example, you could change the first line of the
template above to read:
A Web monitoring alert was generated by the SiteScope installation found at
<SiteScopeURL>

Alert Template Directories
The following is a list of the directory names containing SiteScope alert templates you can copy and
customize.
Template
Group

Description

Location

Event Log

Format and content of data written into event logs.

<SiteScope root directory>\
templates.eventlog

History

Format and content of email messages that notify
recipients that a report has been generated.

<SiteScope root directory>\
templates.history

Email

Format and content of alert messages sent by email.

<SiteScope root directory>\
templates.mail

Template

Group, Description, Location, Pager Format, and content
of pager alerts.

<SiteScope root directory>\
templates.page

Post

Format and content of messages submitted to a CGI
script by a post alert.

<SiteScope root directory>\
templates.post

Script

Format and content of messages sent to a script when a
script alert is triggered.

<SiteScope root directory>\
templates.script

SNMP

Format and content of messages sent by SNMP when a
SNMP trap is triggered.

<SiteScope root directory>\
templates.snmp
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Tasks
How to Customize an Alert's Message Content
This task describes how to customize SiteScope alert templates to alter the content and format of alert
messages.
1. Open a text editor that has access to the alert template directories on the SiteScope machine.
For a list of the directory names containing SiteScope alert templates, see "Alert Template
Directories" on the previous page.
2. Open an existing template file of the alert type you want to customize within a text editor.
3. Make changes to the template. Depending on the alert type, you can add or remove text, change
the order of text or property variables, or add other property variables. To add specific properties,
add the applicable property variable name between < > bracket pairs to the template.
For a list of specific property variables, see "Properties Available in Alerts, Templates, and
Events" on page 1305.
4. Save the changes to a unique filename within the directory for the applicable alert type. The new
template is added to the Action Type Settings Template drop-down list.

How to Shorten an Email Alert Message
You can shorten the length of an email alert by removing properties that provide unneeded information.
For example, if there is no added value in reporting the time of a specific alert, you can remove the
<time> property from the template.
Tip: We recommend that you use the Typical template (the default setting) as a base for your
customized template.
1. In the <SiteScope root directory>\templates.mail directory, open the Typical template file.
Remove the line Time: <time>.
2. Save the changes to a new file name.

How to Change an SNMP Alert Message
You can change the SNMP Alert message from displaying the SNMP monitor's status to displaying a
list of counters that are in Error state along with their values. This causes the message to only contain
counters that breached the Error threshold and to omit all other counters.
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1. In the <SiteScope root dir>\templates.SNMP directory, open the Default template file in a text
editor. The file contains the line:
SiteScope\<group>\<name>\<sample>\<state>\
2. Replace the string <state> with the string <errorOnly>. The angle brackets (<,>) must remain
around the text.
Note: If you want to display a list of counters that are in Warning state, replace the string
<state> with the string <warningOnly>.
3. Edit <SiteScope root dir>\groups\master.config file and add the line
_errorOnlyDelimiter=,
with other similar error definitions.
In this example, the delimiter is a comma (,), but you can also use a space (" ") or a tab (\t). The
added line in master.config looks something like:
_errorSoundURL=
_errorOnlyDelimiter=,
_errorOnlyNewlineFormat=true
Note:
n

If you used the string <warningOnly>, you must use the string _
warningOnlyDelimiter=<delimiter> in master.config.

n

If no _errorOnlyDelimiter is defined in master.config, the default delimiter is a space
(" ").

How to Configure SiteScope to Play Sounds for User Interface Events (Not for Monitor Status)
You can configure SiteScope to play sounds in the browser to indicate when an event occurs in the
user interface. If the parameter _errorSoundURL is configured, you will hear the error sound if an error
occurs in the user interface. For example, an alert sound will be played if you leave the name field
empty when creating a group, or if you create a schedule which you associate with a few monitors, and
then you try to delete the schedule. You can change the alert sound that is played, by changing the _
warningSoundURL= or _goodSoundURL= setting.
Note: The alert sound is not played when there is a change in monitor status.
1. Open the <SiteScope root directory>\groups\master.config file in a text editor.
2. Find the _errorSoundURL setting.
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3. Change the setting to:
_errorSoundURL=http://<SiteScope host>:<SiteScope port>/
SiteScope/templates.sound/alarm.au
4. Save the master.config file.
5. Stop and start SiteScope.
6. After this change, any time an event occurs in the user interface, SiteScope plays an alarm sound
(in this case, Alarm.au from the <SiteScope>\templates.sound directory). You can change the
sound that is being played by modifying the source in the tag above. If you want to add sound for
warning or good event, then you can similarly change the _warningSoundURL= or _
goodSoundURL= setting.

How to Customize Alert Template Tag Styles
This task describes how to change the delimiter between items in the list if, for example, you have a
parser that processes alert messages and needs a specific delimiter. You can also change the bracket
delimiters that are used to identify variables. This is useful if you want the message read by XML and a
variable replaced by an XML string.
1. Edit the template file for which you want to change the bracket delimiter. For example:
<SiteScope root directory>\templates.mail\.
2. Use a text editor to add the following lines to the top of the relevant file:
[Tag-Style:{}]
Enter the characters after the colon (in this example {}) that should be used as the delimiter instead
of the html brackets (<>).
3. Edit the relevant variables to be bracketed by the new characters defined in the Tag-Style string.
For example: {state}.

Tips/Troubleshooting
Tips
We recommend that you create custom alert templates using new file names. If you modify one of the
default templates provided with SiteScope and save the changes to the same file, the changes that you
make may be lost if you reinstall SiteScope or upgrade the SiteScope installation.
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SiteScope has the ability to run scripts or batch files when an error or warning status is detected. This
is normally done by creating a Script Alert that acts as a trigger for the script. The script or batch file can
run any system command or call other programs written in any language. You can use this to create
recovery scripts to automatically respond to critical conditions or failures.

Learn About
Working with Scripts in SiteScope
The script file that a SiteScope Script alert uses to run must be located in the <SiteScope root
directory>\scripts folder or on a remote UNIX machine (for remote scripts). For example, if SiteScope
is installed in the directory C:\SiteScope and your script is called actionTest.bat, SiteScope tries to
run the following command line in response to Script Alerts you have created:
C:\SiteScope\scripts\actionTest.bat C:\SiteScope\scripts monitor_name
where C:SiteScope\scripts is the first command line parameter, monitor_name is the second
command line parameter, and so forth.
Note: While the local script run by the Script Alert must reside in <SiteScope
root directory>\scripts, the execution path is <SiteScope root directory>\classes directory.
You should use full paths for any file system commands or programs called by the script to avoid
problems with defining the current execution directory.
The action taken by a script is determined by the creator of the script. SiteScope passes several
command line arguments to each script called by a Script Alert. You can use this to have program
scripts take action based on information sent from SiteScope. By default, SiteScope passes the
following parameters to each Script alert as command line arguments:
l

The path of the scripts directory.

l

The name of the monitor that caused the alert.

l

The current status of the monitor.

l

The path to the alert message file.

l

The ID code of the monitor.

l

The group in which the monitor is located.

l

Any additional parameters specified in the Parameters box in the alert form.
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These command line arguments can be accessed by the target script using the normal command line
variable conventions. These conventions are %1, %2, %3 and so forth, for Windows systems, and $1,
$2, $3 and so forth, for UNIX scripts (depending on the scripting shell or language used). The first six
parameters (that is, %1 through %6) are passed by default to each script. To pass other parameters,
the property variables or parameters must be added to the Script Alert Settings in the Parameters box
to make them available to the script (see "Script Alert Properties" on page 1287). The first variable or
text entered in the Parameters box is then accessible as %7 by the script, the second parameter is
accessed as %8, and so forth.
An example script written in Perl to access Script Alert parameters:
print
print
print
print
print
print

"pathname to scripts directory: $ARGV[0]\n";
"name of monitor causing alert: $ARGV[1]\n";
"current status monitor: $ARGV[2]\n";
"pathname to alert message file: $ARGV[3]\n";
"id code of monitor: $ARGV[4]\n";
"group for the monitor: $ARGV[5]\n";

The following is an example batch file for Microsoft Windows to echo the parameters passed to the
script:
echo
echo
echo
echo
echo

pathname to scripts directory: %1
name of monitor causing alert: %2
current status monitor: %3
pathname to alert message file: %4
id code of monitor: %5 echo group for the monitor: %6

In addition to the default parameters, there are two other mechanisms for passing parameters and data
to scripts. One is to use the additional Parameters box in the Script Alert Settings. The seventh default
parameter passed to the script, which is any additional parameters specified on the alert form, enables
you to specify one or more custom parameters to be sent to the script. The other is to access the Alert
Message file. For details, see "How to Pass Parameters and Data to Scripts.Using the Script Alert
Settings" below and "How to Pass Parameters and Data to Scripts Using the Alert Message File" on
the next page.

Tasks
How to Pass Parameters and Data to Scripts.Using the Script Alert Settings
This task describes the steps involved in passing parameters and data to scripts using the script alert
settings. This is the simplest way to send additional custom parameters and data to a script.
1. Right-click the SiteScope, group, or monitor for the alert, and select New > Alert, or select an
existing alert in the Alerts tab (monitor or template view) and click the Edit Alert
Alert Actions section of the New/Edit Alert dialog box, click the New Alert Action
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2. In the Action Type dialog box, select the Script action type, and configure the script alert as
described in "Script Alert Properties" on page 1287.
Specify additional custom parameters and data to script is to use in the Parameters box.
These parameters can be hard-coded values. You can include multiple parameters by separating
the individual parameters by spaces. For example, assume you want to pass the four text strings
shown below to a script. To do this you type them in the Parameters box as follows:

These would then become the seventh (7th) through tenth (10th) command line parameters sent to
the script. The following Windows batch file script would print the default parameters as well as
the additional example custom parameters entered in the Parameters box of the Action Types
Settings Page:
echo pathname to scripts directory: %1
echo name of monitor causing alert: %2
echo current status monitor: %3
echo pathname to alert message file: %4
echo id code of monitor: %5
echo group for the monitor: %6
echo seventh parameter(customA): %7
echo eighth parameter(customB): %8
echo ninth parameter:(customC) %9
shift
echo tenth parameter(customD): %9

Note: To use tenth parameter (or more), you must use the "shift" command.

How to Pass Parameters and Data to Scripts Using the Alert Message File
This task describes passing parameters and data to scripts using the Alert Message file. This is a file
that is created by SiteScope using the alert template specified in the Alert Action dialog box ("Action
Type Settings Panel" on page 1278). You can create your own custom alert templates and pass
custom text strings or any of the SiteScope parameters available.
The following shows the default NTEventLog template included with SiteScope. The parameters
marked with < > brackets are replaced with the applicable values to and written to the Alert Message
file each time the applicable Script Alert is triggered.
For a list of the common properties found in SiteScope alert templates, see "Properties Available in
Alerts, Templates, and Events" on page 1305.
The NTEventLog Script Alert Template
Type: <eventType>
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Event Time: <eventTime>
Source: <event>
Source ID: <eventID>
Category: <eventCategory>
Machine: <eventMachine>
Message: <eventMessage>
Monitor: <name>
Group: <group>
Sample #: <sample>
Time: <time>
<mainParameters>
<mainStateProperties>

To use this data in a script, your script needs to access the Alert Message file at the pathname location
specified by the fourth default command line parameter (see "Working with Scripts in SiteScope" on
page 1301). Then the script has to parse the content of the Alert Message file to extract the data you
want to use in your script.
For more examples of how to write recovery scripts, look at the script files in the
<SiteScope root directory>\scripts directory. You can use the actionTest.bat example template to
create your own script. The perlTest.pl example shows how to call a Perl script. The restartIIS.bat,
restartService.bat, and restartServer.bat scripts implement common recovery actions.
For the UNIX environment, the examples scripts are called action Test.sh and perlTest.pl.
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The following properties can be found or used in SiteScope alerts, alert and email templates, and
common event mappings for sending events to management consoles.
This section includes:
l

"Alerts, Alert Template, and Event Properties" below

l

"Common Event Template Properties" on page 1316

l

"Microsoft Windows Event Log Monitor Properties" on page 1317

l

"Email Report Properties" on page 1317

Alerts, Alert Template, and Event Properties
The following is a list of the common properties found in SiteScope alerts, alert templates, and
attributes used in common event mappings (for monitor and alert events).
Note:
l

l

l

Attributes in event mappings have an additional left ("<") and right (">") angle bracket which is
not shown in the table below.
a indicates whether properties can be used in alerts and/or common event mappings
(associated with a monitor or an alert).
Where properties are included in specific alert templates, the relevant templates are listed in
the Included in Alert Template column.

Available
Properties
<alertHelpURL>

Description
URL of the SiteScope help
including the alert topic.

Events

Included in
Alert
Templates

Alert
s

Monito
r

Aler
t

NoDetails

a

a

a

Traceroute
WithDiagnosti
c
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Available
Properties
<alertShortAnalyticsResult
s>

Description
Correlation that shows the monitor
status of the 5 highest counters of
the Analytics Target monitors.

Included in
Alert
Templates

Events
Alert
s

Monito
r

a

Aler
t
a

This property is supported for alert
events (monitor status change
only) in the SiteScope Event
Console and OMi. It is not
supported in Generic Event
Integration or for metrics status
changes events (monitor events).
<alert::actionID>

The ID for the alert action.

a

<alert::actionName>

The name of the alert action.

a

<alert::description>

Text description for the alert
definition.

a

<alert::disable
Description>

Description of the purpose of the
disable operation.

a

<alert::id>

The alert ID.

a

<alert::name>

The name of the alert.

a

<all>

All of the properties of the monitor.

a

a

a

<allThresholds>

Returns all the thresholds in the
monitor in the email alert.

a

a

a
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Available
Properties
<analyticsResults>

Description
Shows a summary of analytics
results, which includes:
l

l

l

l

Included in
Alert
Templates

Events
Alert
s

Monito
r

Aler
t

a

a

a

AnalyticsMail

Name of analyzed monitor and
name of analytics object.
All correlation results or top 500
best fitting ones per analyzed
(source) monitor metric.
For an alert triggered by a static
threshold: metrics that are in the
status for which the alert was
triggered.
For an alert triggered by
Analytics: metrics of the monitor
which are out of the baseline
sleeve.

This property is not supported in
events; for alert events (monitor
status change); use the
<alertShortAnalyticsResults>
property instead.
<bacMonitorID>

The monitor's BSM ID.

a

<bacSessionID>

The BSM profileID.

a

<category>

The monitor category.

<changedToErrorOnly>

Shows only the metrics that have
changed to error status.

a

a

a

<changedToWarningOnly>

Shows only the metrics that have
changed to warning status.

a

a

a

<changedToGoodOnly>

Shows only the metrics that have
changed to good status.

a

a

a

<classifier>
(or _<classifier>)

Returns the first threshold in the
monitor in the email alert.

a

a

a

<currentTime>

The time that the alert is run.

a

a

a

<customerId>

Customer ID for SAAS environment

a

a

a
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Available
Properties

Description

Included in
Alert
Templates

Events
Alert
s

Monito
r

Aler
t

a

a

a

a

a

a

a

a

a

a

a

a

a

a

a

<_description>

Displays the description entered in
the Report description field of the
monitor's General Settings that
makes it easier to understand what
the monitor does. This description
is displayed on each bar chart and
graph in Management Reports.

<diagnosticText>

Calculates a string from other
properties that the monitor is able
to return. The translation can be
different for different types of
monitors because every monitor
can choose a different value
combination for this property.

Default User

<diagnosticTrace
Route>

This tag is filled only for warning
and error conditions when the
Traceroute Email template is used
with the URL Content monitor.

Traceroute

<errorCounterOnly>

List of the monitor counters in error
status (returns counter name only).

<errorOnly>

List of the monitor counters in error
status (returns counter name and
counter value).

<firstgroupdescription>

Partial group description. Only the
first description from several
different ones.

a

a

a

<fullgroupdescription>

Full group’s description.

a

a

a

<FullGroupId>

Full path from the SiteScope root
directory to the group,
exclude\SiteScope.

a

a

a

<fullMonitorName>

Full path from the SiteScope root
directory to the monitor. For
example,
\SiteScope\MyGroup\MyCPUMonit
or.

a

a

a
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Available
Properties
<gethostname>

Description

Included in
Alert
Templates

Events
Alert
s

Monito
r

Aler
t

a

Displays the host name for the
monitor. This is used to prevent the
wrong host name being displayed
in alerts where it does not have the
target server name. For a URL
monitor, this property displays the
URL in the format: www.<host
address or domain name>/
(without the resource prefix and
path).
Note: This property does not show
the host name if the target server is
the localhost machine (the
machine where SiteScope is
running).

<goodCounterOnly>

List of the monitor counters in good
status (returns counter name only).

Typical

a

a

a

<goodOnly>

List of the monitor counters that are
in good status.

Typical

a

a

a

<group>

Name of the group in which the
monitor is located.

AllErrors

a

a

a

a

a

a

AnalyticsMail
Default
Default User
lr-Default_
mail_
template
NoDetails
NTEventlogt
PagerMail
ShortMail
Traceroute
Typical
WithDiagnosti
c
XMLMail

<groupdescription>
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Available
Properties

Description

Included in
Alert
Templates

<groupID>

ID of the group.

Default

Events
Alert
s

Monito
r

Aler
t

a

a

a

a

a

Typical
WithDiagnosti
c
XMLMail
<group.propertyname>

Property of the group in which the
monitor is located. Group
properties that can be used in the
tags include: _externalId, _
dependsCondition, _name, and _
topazId.

a

<group.parent.
propertyname>

Property of the parent group of the
group in which the monitor is
located. Group properties that can
be used in the tags include: _
externalId, _
dependsCondition, _name, and _
topazId.

a

<_httpPort>

Port number used to access
SiteScope (as in Email Report
Properties)

NTEventlog

a

a

a

<id>

Current monitor’s ID number. It
identifies the monitor within the
group

XMLMail

a

a

a

<mainParameters>

List of the main monitor properties
that are set as parameter.

Default

a

a

a

a

a

a

Default User
NTEventlog
WithDiagnosti
c

<mainStateProperties>

List of main monitor properties that
are set as state properties. These
are the result statistics that are
shown on the Reports.

Default
Default User
NTEventlog
WithDiagnosti
c
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Available
Properties

Description

Included in
Alert
Templates

Events
Alert
s

Monito
r

Aler
t

a

a

a

<matchedLine>

Use for Multi Log monitor when the
"For each log entry matched"
option is selected in Run alerts.
When this property is used, the
monitor status displays the whole
line instead of just the matched
content and the file where it was
found.

<monitorClass>

The monitor’s class name.

<monitorDrilldownUrl>

Creates a hyperlink in the event to
the monitor URL.

a

a

a

<monitorDrilldown
Url
Secured>

Creates a hyperlink in the event to
the monitor URL without login
information in the link itself.

a

a

a

<_monitorDescription>

Displays the description of the
monitor entered in the Monitor
description field of the monitor's
General Settings.

a

a

a

<monitorName>

Name of the monitor.

a

a

a

(same as "<name>")
<<monitorServiceId>>

Enables customizing the service
name that is sent from SiteScope
events to HPOM by entering the
value of the monitor service ID.
This is useful for relating the
SiteScope monitor with the HPOM
Service Name.

a

a

a

<monitorType>

The type of monitor, such as CPU.

a

a

a

<monitorTypeDisplay
Name>

The Monitor’s class Topaz name

a

a

a

<monitorUUID>

Monitor’s UUID

a

a

a

<mountName>

Returns mount names. This is
applicable when monitoring remote
UNIX servers while using the
Dynamic Disk Space monitor.

a

a

a

<multiViewUrl>

Creates a hyperlink to the
SiteScope Multi-View URL.

a

a

a
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Available
Properties

Description

Included in
Alert
Templates

<name>

Name of the monitor.

AnalyticsMail

(same as "<monitorName>")

Default

Events
Alert
s

Monito
r

Aler
t

a

a

a

a

a

a

Default User
lr-Default_
mail_
template
NoDetails
NTEventlog
PagerMail
ShortestMail
ShortMail
ShortSubject
Traceroute
Typical
WithDiagnosti
c
XMLMail
<newSiteScopeURL>

URL of the SiteScope server.

Default
Typical

<processtext>

Process Stats, only relevant if the
object has a machine.

a

a

a

<remoteMachineName>

Displays the name of the
configured remote server used by
the monitor.

a

a

a
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Available
Properties

Description

Included in
Alert
Templates

<sample>

Sample #

AllErrors

Events
Alert
s

Monito
r

Aler
t

a

a

a

AnalyticsMail
Default
Default User
NoDetails
NTEventlog
PagerMail
ShortMail
Traceroute
Typical
Typical.mail
WithDiagnosti
c
XMLMail
<sitescopeurl>

URL of the SiteScope server with
extra account information.

a

a

a

<siteScopeBaseUrl>

URL of the SiteScope server in a
different format.

a

a

a

<siteScopeHost>

URL of the SiteScope host name.

a

a

a

<secondaryParameters>

Lists the main state properties and
other internal properties.

a

a

a

<secondaryState
Properties>

Lists the main state properties and
other internal properties.

a

a

a

<sitescopeURL>

The URL to the main page of
SiteScope for admin access.

a

a

a

a

a

a

AllErrors
Default User
NoDetails
Traceroute
WithDiagnosti
c

<sitescopeuserurl>
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Available
Properties
<state>

Description
Status string reported by the
monitor.
(same as stateString)

Events

Included in
Alert
Templates

Alert
s

Monito
r

Aler
t

AllErrors

a

a

a

a

a

a

AnalyticsMail
Default
Default User
lr-Default_
mail_
template
NoDetails
PagerMail
ShortestMail
ShortMail
ShortSubject
Traceroute
Typical
WithDiagnosti
c
XMLMail

<tag>

Tags of the monitor (if exists).

AnalyticsMail
Default
Default User
lr-Default_
mail_
template
NoDetails
NTEventlog
PagerMail
ShortestMail
ShortMail
ShortSubject
Traceroute
Typical
WithDiagnosti
c
XMLMail
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Available
Properties
<tag:[tagName]>

Description

Included in
Alert
Templates

Displays the value or values of the
Search/Filter tag with the
[tagName] assigned to the monitor
that triggered the alert.

Events
Alert
s

Monito
r

Aler
t

a

a

a

Example: You have a tag named
AppServer with value Apache
assigned to a monitor, and you
include <tag:AppServer> in the
alert template configured for that
monitor. If an alert is triggered, the
new property is replaced with
Apache in the alert text.
<targetHost>

Name of the target host.

a

a

a

<targetIP>

IP of the target host.

a

a

a

<targetIPAsHEX>

IP of the target host in HEX fomat.

a

a

a

<targetIPVersion>

Retrieves monitor host IP version
(IPV6 or IPV4).

a

a

a

<templateDeployPath>

Displays the path of the template
group from which the monitor was
deployed.

a

a

a

<time>

Time that the monitor completed
the last run.

a

a

a

a

a

a

AllErrors
AnalyticsMail
Default
Default User
lr-Default_
mail_
template
NoDetails
NTEventlog
Traceroute
Typical
WithDiagnosti
c
XMLMail

<time-date>
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Available
Properties

Description

Included in
Alert
Templates

Events
Alert
s

Monito
r

Aler
t

<time-time>

The time portion of the time that the
monitor completed.

a

a

a

<warningCounterOnly>

List of the monitor counters in
warning status (returns counter
name only).

a

a

a

<warningOnly>

List of the monitor counters in
warning status (returns counter
name and counter value).

a

a

a

<unifiedConsoleUrl>

Opens the Ops View in the Unified
Console, which displays Multi-View
and the Event Console.

a

a

<_webserverAddress>

IP address for the SiteScope
Server (as in Email Report
Properties)

a

a

Typical

NTEventlog

a

Common Event Template Properties
The following metric specific properties are resolved from the monitor‘s counter data and should be
used in the Common Event Template for monitor events only.
These properties are relevant for monitor events because they are triggered by a specific metric
change. They are not relevant for alert events because they are triggered by a status change, which is a
single state that can be resolved from several metric changes.
Available Properties

Description

<metric>

The name of the counter that triggered the alert.

<metricValue>

The ETI value associated with the threshold that has been crossed.

<newStatus>

Current status of the metric.

<oldStatus>

Previous status of the metric.

<etiValue>

The ETI value associated with the threshold that has been crossed.

<etiType>

The ETI type associated with the counter that crossed the threshold that
created the event.

<thresholdCrossed>

The display name of the threshold setting that was crossed.

<thresholdCrossedFull> The full string representation of the threshold setting that was crossed. It
also contains the ETI value and the status associated with this threshold,
which uniquely identifies the threshold.
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Available Properties

Description

<severity>

Severity of the occurrence that the event relates to.

<ciHint>

Information about the CI that is related to the event. This attribute is for
providing one or several hints that enables the event processing to find the
correct "related CI".

<subCiHint>

Information used to identify a subcomponent of a CI. This CI
subcomponent is used to calculate an aggregated status within BSM's
Service Health for selected CIs.
If an HI is populated by events from multiple components, you can
specify a component name in this field in order to ensure the correct
calculation of the HI state.
Example: If you have a Computer CI with two CPUs, cpu #1 and cpu #2,
events from both CPUs will be sent to the same CPU Load HI. By
default, the events will overide each other and create an incorrect HI
state. To prevent this, you can populate ComponentCi with values "cpu
#1" and "cpu #2" which will cause the HI state to be calculated as an
aggregated state between the two events.

<alertName>

The name of the alert.

Microsoft Windows Event Log Monitor Properties
The following properties can only be used in the Microsoft Windows Event Log monitor. They can be
used in SiteScope alerts, alert templates, and common event mappings (monitors and alerts).
Available Properties

Included in Templates

<eventCategory>

NTEventlog

<eventID>

NTEventlog

<eventMachine>

NTEventlog

<eventSource>

NTEventlog

<eventType>

NTEventlog

Email Report Properties
The following properties are applicable to the email templates stored in the
<SiteScope>\templates.history directory:
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Available Properties

Description

_httpPort

Port number used to access SiteScope

_webserverAddress

IP address for the SiteScope Server

basicAlertSummary

Basic information on what alerts have been triggered

detailAlert Summary

More detailed information on alerts

reportIndexURL

URL to the index page for the management report

reportPeriod

Time period for this report

reportURL

URL to the HTML version of the management report

summary

Summary and measurement information

textReportURL

URL to the comma-delimited file generated by SiteScope

userReportIndexURL

URL to the index page for a user-accessible report

userTextReportURL

URL to the comma-delimited file generated by a user-accessible report

userXMLReportURL

URL to the XML file generated by a user-accessible report

xmlReportURL

URL to the XML file generated by the management report
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Part 14: Reports
SiteScope reports display information about how the servers and applications you are monitoring have
performed over time. SiteScope reports are important tools in monitoring and troubleshooting
operational performance and availability and reviewing the monitored environment.
You can create a report for a single monitor, several monitors, or even a number of monitor groups.
Report definitions include report content options such as tables of specific monitor measurements,
summaries of results, and graphs. For details, see "Create SiteScope Reports" on page 1320.
You can also create a Server-Centric report for Microsoft Windows and UNIX Resources monitors,
which displays data from three different metrics about the remote server being monitored. For details,
see "Create Server-Centric Reports" on page 1365.
SiteScope reports can be valuable to many people in your organization, including management
personnel in Sales, Marketing, Customer Support, and Operations. User accounts can be created to
enable these users restricted access to the SiteScope service to view reports. For more information,
see "User Management Preferences" on page 732.
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SiteScope can collect multiple preselected metrics from a specific server and combine them into a
single graph—giving you quick access to key performance monitoring data for any server in your
environment. One of the key benefits of server-based reporting is the ability to drill down into reports to
troubleshoot server related issues.

To access
Select the Monitors context. In the monitor tree, select the SiteScope object for which you want to
generate a report, and click the Reports tab.

Learn About
SiteScope Report Types
The following describes the report types that are available in SiteScope and their usage.
Report Type

Description

Alert Reports

Alert reports provide information about SiteScope alerts generated during a
specified period of time. You create an Alert report on an ad hoc basis. As a result,
Alert report settings are not saved to the SiteScope configuration data for later use.

BSM
Configuration
Changes
Report

Displays statistics about the configuration reporting to BSM. It should be used for
troubleshooting purposes only. The report is generated from BSM. If there are
multiple SiteScopes reporting to BSM, the information displayed in this report
includes information not only for the specific SiteScope selected. The report logs
exceptions, such as a failure to enter data into the profile database.
Note: The report is available only when accessing SiteScope from SAM
Administration and if the user has permission to view SiteScope logs.

Management
Reports
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Management reports provide a summary of infrastructure availability and
performance data for a given period of time. Management reports are generated
automatically based on their preset schedule from data collected by SiteScope
monitors. According to the preset schedule, SiteScope reads the applicable log
files and generates the report based on the monitor metrics for the time interval
specified. You can save the report data in a file suitable for exporting to third-party
applications. For more details, see "SiteScope Management Reports" on the next
page.
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Report Type

Description

Monitor
Reports

Monitor reports enable you to review configuration properties and settings for
existing monitors. You create a Monitor report on an ad hoc basis. As a result,
Monitor report settings are not saved to the SiteScope configuration data for later
use.

Quick
Reports

Quick reports enable you to view monitor data for specific monitors or groups of
monitors during specific time periods. You create a Quick report on an ad hoc
basis. As a result, Quick report settings are not saved to the SiteScope
configuration data for later use.

ServerCentric
Reports

For Microsoft Windows and UNIX Resources monitors, you can create a ServerCentric report which displays data from three different metrics (CPU utilization,
memory utilization, and network utilization) about the remote server being
monitored. For more details, see "Create Server-Centric Reports" on page 1365.

SiteScope Management Reports
Reports are added as elements to the Reports tab in the monitor view. They can be added as a child to
the SiteScope node, to a group, or to an individual monitor. Reports are displayed in the left menu tree
by a icon next to the group or monitor for which it was created, as shown in the example below.

Reports have a scope based on the container to which they are added. You add a report to the container
or element that contains all of the monitors whose data you want to include in the report. You then use
the Report Targets panel to narrow the selection of monitors to be included in the report.
When you select a node with a report icon, the Report tab displays two tables. The Reports on table
displays the reports created on this node. The Reports Associated with table displays the reports
created on an ancestor node and applied to this node using the target selection.
You can create as many SiteScope report definitions as you want. However, you should plan and
consolidate reports to keep the number of report definitions to a minimum. This can facilitate report
administration and help reduce redundant report messages or actions. When creating a report for a
large number of monitors, consider making separate reports based on the type of monitor or
measurement. For example, when reporting on system resources for 20 different remote servers,
consider making one report with monitors that measure numeric values such as CPU or disk space and
another report for monitors that report basic availability such as services or processes.
By default, SiteScope keeps the 10 most recently generated reports. This means that hourly reports are
available for the last 10 hours, daily reports are available for 10 days, weekly reports are available for 10
weeks, and so forth. You can change this report storage period by changing the value of the _
maximumReports setting in the <SiteScope root directory>\groups\master.config file.
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Deleting a Management report definition discontinues the generation of applicable report. Previously
generated reports continue to be available until the underlying data is removed.
You can copy and paste a report definition. The report definition settings are pasted to the new location
with the exception of the Report targets setting, which are automatically reset to include all of the
children of the container into which the report is pasted. After pasting a report, edit the report definition
properties to be sure that the assigned Report targets are appropriate to the new report context and
your overall reporting plan.
You can add a banner to a Management report by entering the text/HTML in the Description field of the
report. To create a banner and apply it to all reports that are created, add the _reportHeaderHTML=
property and the banner text to the <SiteScope root>\groups\master.config file. For example: _
reportHeaderHTML=<p><b>MY CUSTOM BANNER</b></p>

SiteScope Monitor Data Log Files
SiteScope monitor data available for generating reports is limited to the amount of log data stored on the
SiteScope server. By default, SiteScope retains monitor data log files for 40 days. The log files are
rotated and files older than the log retention period are automatically deleted.
Note:
l

l

Keeping monitor data logs for longer periods can cause a data storage problem for the
SiteScope server depending on the total number of monitors configured and how often the
monitors run per day. You should monitor the size of log files in the
<SiteScope root directory>\logs directory to estimate the data accumulation rate.
We recommend allocating a minimum of 10 GB storage space on the SiteScope server, and
30 GB for a high load environment (16,000 monitors configured at 2,000 monitor runs per
minute).

You can change the length of time that SiteScope retains monitor data using the log preferences. You
can configure SiteScope to export monitor data to an external SQL-compliant database to maintain
monitor data for longer periods or to make the data available to other reporting applications. For details,
see "Log Preferences" on page 700.

Customizing Reports
You can customize the look and feel of SiteScope reports by adding CSS rules to a custom CSS file.
CSS, or Cascading Style Sheets, is a style sheet language used for describing the look and for
formatting a document written in a markup language.
To do so, add CSS rules to the reports-style-custom.css file is located in <SiteScope root
directory>\conf\custom_css\report.
You can find some examples below. To use any of these examples, just copy and paste them into the
reports-style-custom.css file. Note that these are only examples, and you can add your own rules to
adjust the style of reports as you choose.
Examples:
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/*change header style:*/
H2 {
color: #0096d6;
font-weight:500;
margin:0;
font-size:28px;
}
/*change table style:*/
.data-table th, .data-table td {
color: #404040;
font-size: 14px;
border:1px solid #e5e5e5;
height:17px;
line-height:34px;
padding: 1px 2px 2px 1px;
text-align:center;
padding-left: 5px;
padding-right: 5px;
background-color:white;
}
/*change table header style:*/
.data-table th {
background-color:#efefef;
font-weight:700;
}
/*change table title style:*/
H3,table.data-table caption{
margin:0;
padding:5px;
padding-left:0px;
padding-right:0px;
color:#0096d6;
font-weight:700;
font-size:18px;
text-align:left;
}

Tasks
How to Create a Report
This task describes the steps involved in creating a SiteScope report.
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1. Prerequisites
To be able to generate or manage reports, you must be an administrator in SiteScope, or a user
granted the required reports permissions in User Management Preferences. For details on user
permissions, see "User Management Preferences" on page 732.
2. Select a report type
Right-click the group or monitor container in which you want to create a report, and click Reports,
or create a new report from the Reports tab. Select the report type you want to add or generate
(only the Management report is added; all other reports are ad hoc and are not saved in
SiteScope).
For details of report types, see "SiteScope Report Types" on page 1320.
3. Configure the report settings
Select the monitors to include in the report and configure the report settings.
For details on configuring the various reports, see "Create SiteScope Reports" on page 1320.
Note: By default, a report includes data from all monitors within the selected container. For
Alert Reports, you cannot remove any of the monitors in the selected container from the
report.
4. Results
Management reports are added to the selected container in the monitor tree (indicated by a report
symbol). All other reports are generated and displayed in your Web browser. For details, see
"Create SiteScope Reports" on page 1320.
Note: For information about troubleshooting and limitations of SiteScope reports, see
"Troubleshooting and Limitations" below.

Tips/Troubleshooting
Troubleshooting and Limitations
l

When formatting a Monitor report in .csv format, SiteScope replaces some special characters in
monitor properties with different characters. For example, it replaces a comma (,) with a blank
space, a double quotation mark (") with a single quotation mark ('), and other special HTML
characters are replaced with their entities.
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l

l

l

l

l

Monitor reports can only be sent by email via the standard SMTP port (25).
To view certain report elements on SiteScope for UNIX/Linux, it is necessary that an X Window
system be installed and running on the server where SiteScope is running.
To be able to open reports generated in SiteScope version 9.0 and later after upgrading the
SiteScope installation, create a manual backup of the reports folder <SiteScope root
directory>\htdocs, and copy it to the new installation directory.
Indicator values are not displayed in SiteScope reports.
The <SiteScope root directory>\groups\master.config file no longer supports adding your own
styling keys to customize reports. If necessary, you can add styling keys to a custom .css file
located in <SiteScope root directory>\conf\custom_css\report\reports-style-custom.css as
described in "Customizing Reports" on page 1322.

SiteScope Reports User Interface
This section includes:
Creating Reports:
l

"New/Edit SiteScope Management Report Dialog Box" on the next page

l

"New SiteScope Quick Report Dialog Box" on page 1334

l

"New SiteScope Monitor Report Dialog Box" on page 1339

l

"New SiteScope Alert Report Dialog Box" on page 1343

l

"Create Server-Centric Reports" on page 1365

l

"Graph Metrics Options" on page 1348

l

"Mail Details Dialog Box" on page 1348

Viewing Reports:
l

"Reports Page" on page 1350

l

"Management Report" on page 1351

l

"Quick Report" on page 1356

l

"Monitor Summary Report" on page 1361

l

"Alert Report" on page 1363

l

"Server-Centric Report" on page 1370
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New/Edit SiteScope Management Report Dialog Box
This dialog box enables you to create a report that provides a summary of system availability data for a
given time period.
To access

Select the Monitors context, and in the monitor tree:
l

l

Important
information

l

l

l

l

Relevant
tasks
See also

Right-click the SiteScope node, a monitor group, or a monitor, and select Reports
> Management, or
Select the SiteScope object for which you want to generate a report, and in the
Reports tab, select Create New Report > Management.
To be work with Management reports, you must be an administrator in SiteScope,
or a user granted the Add, edit, or delete management report and Generate
management report permissions in User Management Preferences. For details
on user permissions, see "User Management Preferences" on page 732.
You can add a banner to a Management report by entering the text/HTML in the
Description field of the report. To create a banner and apply it to all reports that
are created, add the _reportHeaderHTML= property and the banner text to the
<SiteScope root>\groups\master.config file. For example: _
reportHeaderHTML=<p><b>MY CUSTOM BANNER</b></p>
Since data for reports is taken from the daily log files (and it takes time for this
data to be written to the log file), there might be a slight gap in this data being
correctly represented in reports. Therefore, we recommend waiting about a minute
between generating reports with different Measurement Graph drop down values
to avoid incorrect data being displayed.
HTML code entered in report text boxes is checked for validity and security, and
corrective action is taken to fix the code (for example, code is truncated if it spans
more than one line). If malicious HTML code or JavaScript is detected, the entire
field is rejected. The following is prohibited HTML content:
n

Tags: script, object, param, frame, iframe.

n

Any tag that contains an attribute starting with on is declined. For example,
onhover

n

Any attribute with javascript as its value.

"Create SiteScope Reports" on page 1320

l

"Reports" on page 1319

l

"Reports Page" on page 1350

l

"Management Report" on page 1351
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This section includes:
l

"General Settings" below

l

"Report Targets" below

l

"Display Settings" on the next page

l

"Filter and Scheduling Settings" on page 1330

l

"Report Distribution" on page 1331

l

"Calculation Method" on page 1333

l

"Management Settings" on page 1333

l

"Search/Filter Tags" on page 1333

General Settings
User interface elements are described below:
UI Element

Description

Report title

Enter a title for this Management Report. This name is used to identify this
Management Report definition in the product display.

Description (Optional) Use this text box to describe other information about this report definition.
For example, include information about the purpose, target, setup date, or audience
for this report.
Note: If this field contains an ampersand (&), less than (<), or greater than (>), they
are automatically escaped, for example, &amp;, &lt;, or &gt;.

Report Targets
User interface elements are described below:
UI
Element Description
Report
targets

Select the groups, monitors, or both, to be included in this report in the context menu tree.
The context menu includes the currently selected container and all of the child containers.
Default value: The current container and all child elements are selected.
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Display Settings
User interface elements are described below:
UI Element

Description

Thresholds
All thresholds

Creates a table of monitor error, warning, and good threshold settings for all of the
monitors included in the report. If selected, this table is displayed as the first report
section.
Default value: Not selected

Error
thresholds

Creates a table of individual error readings recorded by the monitors during the
report period.
Default value: Selected

Warning
thresholds

Creates a table of individual warning readings recorded by the monitors during the
report period.
Default value: Selected

Good
thresholds

Creates a table of individual good readings recorded by the monitors during the
report period.
Default value: Selected

Uptime and Readings
Uptime
Summary and
Measurement
Summary
tables

Creates two report tables: Uptime Summary and Measurement Summary. For
details of the data included in these tables, see "Management Report" on page
1351.

Uptime:
Include
warnings

Includes any monitor readings that are reported as warnings in the overall Uptime
calculation.

Uptime:
Ignore
warnings

Suppresses monitor readings reported as warnings from the overall Uptime and
Readings Summary section.

Default value: Selected

Default value: Not selected

Note: This option only suppresses the display of the Warning % column in the
table; it does not change the calculation of the Uptime %.
Default value: Not selected
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UI Element

Description

Uptime:
Ignore errors

Suppresses monitor readings reported as errors from the overall Uptime and
Readings Summary section.
Note: This option only suppresses the display of the Error % column in the table; it
does not change the calculation of the Uptime %.
Default value: Not selected

General
Measurements
graph

For graph reports, use the drop-down list to choose a graphical measurement to be
included in the report. For details of the options, see "Graph Metrics Options" on
page 1348.

Monitor
readings

Creates a table of individual readings recorded by the monitors during the report
period, including all readings (error, good, and warning). This report table may also
include blank "buckets" depending on the period of the report and how often the
monitors ran during the period.
Default value: Selected

Alerts table

Select an option to include a table of alerts sent for the monitors in the report. The
options for the alerts table level are:
l

l

l

l

Detailed
monitor
information

No alerts table. No table of alerts is included in the report (default)
Basic alerts table. Displays the time and summary information for each alert
sent.
Show detailed alerts table for all alerts. Displays detailed alert information
for each alert in the report.
Show detailed alerts table for failed alerts. Displays the time and summary
information for each alert, and a full diagnostics breakdown for each failed
alert.

Displays all of the information gathered for each monitor on the report. Otherwise,
only the primary data is displayed for each monitor.
Default value: Not selected
Example: If this box is checked on a URL Sequence Monitor, the timing
information for each step in the sequence is displayed in the report.

Time in error

Creates a table summary listing each monitor selected for the report with a
summary of how many minutes the monitor status was calculated as being in error
for the period of the report.
Default value: Not selected
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Filter and Scheduling Settings
User interface elements are described below:
UI
Element
Monitor
filter

Description
Select a subset of those monitors to be shown in the report —those that have had the
specified status sometime during the report's time frame. You can select only monitors
in error or warning, monitors in error, monitors in warning, monitors that were OK, or all
monitors.
Default value: Show all monitors
Example: Choosing Show only monitors in error displays report data only if that
monitor had spent time in error sometime during the time interval of the report.

Schedule Select a schedule filter option for showing only a subset of the data in the report—those
filter
monitors that have samples during the time period of the schedule.
Default value: The report shows data for the full period of the report (Every day, all day).
Example: Choosing Weekdays, 09:00-18:00 displays report data for the selected
monitors with samples from the 9am to 6pm time period, Monday through Friday. Only
this data is used for all the calculations.
Time
Select the time period for which you want to view monitoring data. You can choose to
period
report on data for a set number of hours, for the last day, the last several days, the past
for report week, past month, or month-to-date for the current calendar month.
Daily and month-to-date reports are generated every day at the scheduled time. Weekly
reports are generated on Sundays at the scheduled time, and monthly reports are
generated on the first day of the month following the current month so that they contain
an entire month's worth of data.
Default value: Last day
End of
report
period

Choose an end time for the report by selecting a time from the drop-down list. For
example, you may want to have your reports run from midnight to midnight.
Default value: At time report is run (SiteScope generates reports starting at the
indicated time and ending at the time the report was generated)
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Report Distribution
User interface elements are described below:
UI
Element
HTML
format

Description
Select if you want the reports sent in HTML format. Use this option to include the
SiteScope report graphics. If you do not select this option only a text summary of the
report is sent.
Default value: Not selected

Send
report to
email
address

To have the report forwarded by email when it is generated, enter the email addresses to
which this report should be sent each time its generated. To send the reports to multiple
email addresses, separate the email addresses with commas. The report is sent as an
.HTML file attached to the email.
Note: Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 571.

Format
template

Select a template for SiteScope to use to create the email message. You can choose
from the following templates or make a copy of one of these and customize it to meet
your own needs.
l

l

l

l

l

HistoryLongMail - Choose this option to send a detailed history report. It contains
both user and administration links.
HistoryLongXMLMail - Choose this option to send a detailed history report. It
contains both user and administration links for reports & XML files.
HistoryMail - Choose this option to send a history report. This is the default option.
HistoryMailAlertDetail - Choose this option to have all alerts included in the report
that is sent by email.
HistoryMailNoLinks - Choose this option to send the report without any links in it.
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UI
Element

Description

Comma- Select to save a generated management report to a comma-delimited text file which you
delimited can then import into a spreadsheet application.
file
SiteScope automatically saves these files in the <SiteScope root directory>\htdocs
directory. To find the exact location of the saved file on your machine, click the View
Report tab for the report, and move the pointer over the text link for the report in the
Information For column. The full path to the file is listed in the status bar of your Web
browser. To open the saved file on your machine, click the text link to go to the Report
page. If you enter an email address in the Email text box, SiteScope sends a copy of
the comma-delimited file to that address.
Default value: Not selected
Note: The comma-delimited file creates two columns for each monitor reading; one
containing the value with units, and the other containing just the value. This is to make it
easier to import the comma-delimited data into a third-party application which may not
automatically separate data values from the text describing the units.
Send
If you enter an email address in the text box, SiteScope sends a copy of the file to that
commaaddress.
delimited
file by
email
XML file

Select this box to save a generated management report to an XML text file. SiteScope
automatically saves these files in the <SiteScope root directory>\htdocs directory.
To find the exact location of the saved file on your machine, click the View Report tab
for the report, and move the pointer over the xml link for the report in the Information
For column. The full path to the file is listed in the status bar of your Web browser. To
open the saved file on your machine, click the xml link to go to the Report page. If you
enter an email address in the Email text box, SiteScope sends a copy of the commadelimited file to that address.
Default value: Not selected
Note: The XML file creates two columns for each monitor reading; one containing the
value with units, and the other containing just the value. This is to make it easier to
import the XML data into a third-party application which may not automatically separate
data values from the text describing the units.

Send
XML file
by email

If you enter an email address in the text box, SiteScope sends a copy of the XML file to
that address.
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Calculation Method
User interface elements are described below:
UI
Element
Time
between
samples

Description
Use this time scale option to choose the time interval between monitor readings. You
can choose intervals that range from once every minute to once a day, or you can use
the automatic scaling. When automatic scaling is used, SiteScope determines how
many readings were taken over the chosen time period for the given monitors and then
selects an appropriate interval for the management report.
Default value: Automatic time scale

Maximum Select a vertical scale option to choose the maximum value displayed on a graph.
graph
Choosing a specific scale value makes it easier to compare graphs from different
value
monitors and times.
Default value: Automatic vertical scale

Management Settings
User interface elements are described below:
UI
Element

Description

Disable
report

Select to temporarily disable the generation of this report. To enable the report again,
clear the box.
Default value: Not selected

Generate The time that you want SiteScope to create this management report. The report contains
report at information for the last day, week, or month, ending at the time the report is run. For
(HH:MM) example, if a daily report is generated at 18:00 (6:00 p.m.), it contains data generated
between 18:00 the previous day and 18:00 of the current day. The default value is 00:00
which represents midnight.
Default value: 04:00
Tip: Try to schedule reports to be generated during off-peak hours relative to overall
monitoring tasks and load, since report generation may temporarily affect overall
SiteScope performance and responsiveness (depending on the number of monitors and
time period of the report). If you are generating many reports each day, consider
staggering the Generate report at value for different reports

Search/Filter Tags
User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Element Description
<Tag
name
and
values>

Keyword tags are used to search and filter SiteScope objects (groups, monitors, remote
servers, templates, and preference profiles). If no tags have been created for the
SiteScope, this section appears but is empty. If tags have been created, they are listed
here and you can select them as required.
For concept details, see "Filter Objects in the SiteScope View" on page 74.

Add
Tag

Opens the New Tag dialog box, enabling you to add new keyword tags. For user interface
details, see "New/Edit Tag Dialog Box" on page 721.

Note: A bar graph is generated using standard HTML, so it can be printed from all browser types.
Line graphs are generated using a java applet and may not print directly from all browsers.

New SiteScope Quick Report Dialog Box
This dialog box enables you to create a one-time SiteScope management report for any monitor or
group of monitors over a given time period.
To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
monitor group, or a monitor, and select Reports > Quick. (Alternatively, select the
SiteScope object for which you want to generate a report, and in the Reports tab,
select Create New Report > Quick). Configure the report properties, and click
Generate Report.
You can also create a report using preconfigured settings by selecting a monitor and
clicking the Quick Report

Important
information

l

l

l

l
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button in the SiteScope Dashboard.

The time interval for a Quick report is not incremented automatically. This means
that a Quick report always contain the data for the absolute Report period
interval defined in the report definition. To view more recent data using a Quick
report, edit the Report period setting.
To generate a report, you must be an administrator in SiteScope, or a user granted
the Generate quick report permission in User Management Preferences. For
details on user permissions, see "User Management Preferences" on page 732.
Since data for reports is taken from the daily log files (and it takes time for this
data to be written to the log file), there might be a slight gap in this data being
correctly represented in reports. Therefore, we recommend waiting about a minute
between generating reports with different Measurement Graph drop down values
to avoid incorrect data being displayed.
When working in BSM, Quick Report definitions in SAM Administration are stored
only with the BSM context. Quick Report definitions are not stored in, and do not
persist on the SiteScope server.

Page 1334 of 1395

Using SiteScope
Chapter 106: Create SiteScope Reports

Relevant
tasks

"Create SiteScope Reports" on page 1320

See also

l

"Reports" on page 1319

l

"Quick Report" on page 1356

This section includes:
l

"Report Targets" below

l

"Display Settings" below

l

"Filter and Scheduling Settings" on page 1338

l

"Report Format" on page 1338

l

"Report Distribution" on page 1339

l

"Calculation Method" on page 1339

Report Targets
User interface elements are described below:
UI
Element Description
Report
targets

Select the groups, monitors, or both, to be included in this report in the context menu tree.
The context menu includes the currently selected container and all of the child containers.
Default value: The current container and all child elements are selected.

Display Settings
User interface elements are described below:
UI Element

Description

Thresholds
All thresholds

Creates a table of monitor error, warning, and good threshold settings for all of the
monitors included in the report. If selected, this table is displayed as the first report
section.
Default value: Not selected

HP SiteScope (11.31)
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UI Element

Description

Error
thresholds

Creates a table of individual error readings recorded by the monitors during the
report period.
Default value: Selected

Warning
thresholds

Creates a table of individual warning readings recorded by the monitors during the
report period.
Default value: Selected

Good
thresholds

Creates a table of individual good readings recorded by the monitors during the
report period.
Default value: Selected

Uptime and Readings
Uptime
Summary and
Measurement
Summary
tables

Creates two report tables: Uptime Summary and Measurement Summary. For
details of the data included in these tables, see "Quick Report" on page 1356.

Uptime:
Include
warnings

Includes any monitor readings that are reported as warnings in the overall Uptime
calculation.

Uptime:
Ignore
warning

Suppresses monitor readings reported as warnings from the overall Uptime and
Readings Summary section.

Default value: Selected

Default value: Not selected

Default value: Not selected
Note: This option only suppresses the display of the Warning % column in the
table; it does not change the calculation of the Uptime %.

Uptime:
Ignore errors

Suppresses monitor readings reported as errors from the overall Uptime and
Readings Summary section.
Default value: Not selected
Note: This option only suppresses the display of the Error % column in the table; it
does not change the calculation of the Uptime %.

General
Measurements
graph

For graph reports, use the drop-down list to choose a graphical measurement to be
included in the report. For details of the options, see "Graph Metrics Options" on
page 1348.
Default value: Bar Graph - one graph per measurement

HP SiteScope (11.31)
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UI Element

Description

Monitor
readings

Creates a table of individual readings recorded by the monitors during the report
period, including all readings (error, good, and warning). This report table may also
include blank "buckets" depending on the period of the report and how often the
monitors ran during the period.
Default value: Selected

Alerts table

Select an option to include a table of alerts sent for the monitors in the report. The
options for the alerts table level are:
l

l

l

l

Detailed
monitor
information

No alerts table. No table of alerts is included in the report (default).
Basic alerts table. Displays the time and summary information for each alert
sent.
Show detailed alerts table for all alerts. Displays detailed alert information
for each alert in the report.
Show detailed alerts table for failed alerts. Displays the time and summary
information for each alert, and a full diagnostics breakdown for each failed
alert.

Displays all of the information gathered for each monitor on the report. Otherwise,
only the primary data is displayed for each monitor.
Example: If this box is checked on a URL Sequence Monitor, the timing
information for each step in the sequence is displayed in the report.
Default value: Not selected

Time in error

Creates a table summary listing each monitor selected for the report with a
summary of how many minutes the monitor status was calculated as being in error
for the period of the report.
Default value: Not selected

HP SiteScope (11.31)
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Filter and Scheduling Settings
User interface elements are described below:
UI
Element
Monitor
filter

Description
Select a subset of those monitors to be shown in the report —those that have had the
specified status sometime during the report's time frame. You can select only monitors
in Error or Warning, monitors in Error, monitors in Warning, monitors that were OK, or all
monitors.
Default value: Show all monitors
Example: Choosing Show only monitors in error displays report data only if that
monitor had spent time in error sometime during the time interval of the report.

Schedule Select a schedule filter option for showing only a subset of the data in the report—those
filter
monitors that have samples during the time period of the schedule.
Default value: The report shows data for the full period of the report (Every day, all day).
Example: Choosing Weekdays, 09:00-18:00 displays report data for the selected
monitors with samples from the 9am to 6pm time period, Monday through Friday. Only
this data is used for all the calculations.
Report
period

Specify the time period for which you want to view monitoring data. Enter the time from
which you want the report coverage to start in the From boxes and the time to which you
want to cover in the To boxes.
Default value: The time period is from one hour before the time that the Quick Report is
generated until the current time. You can set the default time period for including
monitoring data in the Quick report by configuring the Default time length for report
(hours) setting in Preferences > Infrastructure Preferences > Report Settings.
Note: Times should be entered in 24-hour format.

Report Format
User interface elements are described below:
UI
Element
Report in

Description
Select the format to be used in displaying the report: HTML format, Text format or XML
format.
Default value: HTML format

HP SiteScope (11.31)
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Report Distribution
User interface elements are described below:
UI
Element Description
Send
report
to email
address

To have the report forwarded by email when it is generated, enter the email addresses to
which this report should be sent each time its generated. To send the reports to multiple
email addresses, separate the email addresses with commas. The report is sent as a
.HTML file attached to the email.
Note: Emails are sent securely via SSL SMTP servers if SMTP SSL is selected in the
"Email Preferences Default Settings Dialog Box" on page 571.

Calculation Method
User interface elements are described below:
UI
Element
Time
between
samples

Description
Use this time scale option to choose the time interval between monitor readings. You
can choose intervals that range from once every minute to once a day, or you can use
the automatic scaling. When automatic scaling is used, SiteScope determines how
many readings were taken over the chosen time period for the given monitors and then
selects an appropriate interval for the management report.
Default value: Automatic time scale

Maximum Select a vertical scale option to choose the maximum value displayed on a graph.
graph
Choosing a specific scale value makes it easier to compare graphs from different
value
monitors and times.
Default value: Automatic vertical scale

New SiteScope Monitor Report Dialog Box
This dialog box enables you to create a report that provides detailed information about the monitors
defined in one or more monitor groups.
To access

Select the Monitors context, and in the monitor tree:
l

l
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Right-click the SiteScope node, a monitor group, or a monitor, and select Reports
> Monitor, or
Select the SiteScope object for which you want to generate a report, and in the
Reports tab, select Create New Report > Monitor.
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Important
To generate a report, you must be an administrator in SiteScope, or a user granted the
information Generate monitor summary report permission in User Management Preferences.
For details on user permissions, see "User Management Preferences" on page 732.
Relevant
tasks
See also

"Create SiteScope Reports" on page 1320

l

"Reports" on page 1319

l

"Monitor Summary Report" on page 1361

This section includes:
l

"Monitor Report Toolbar" below

l

"Monitor Report Table Toolbar" on page 1342

Monitor Report Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI
Element Description
Collapse report filter. Click to collapse or expand the report filter.
When the report filter is selected, the SiteScope monitor tree is displayed. Select the
groups, monitors, or both, to be included in this report. The tree includes the currently
selected container and all of the child containers.
Default value: The current container and all child elements are selected.
Run. After you have selected the groups and monitors to include in the report, click the
Run button to run the report.

HP SiteScope (11.31)
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UI
Element Description
Format report data as... Click to display the options available to format the report. Once
the report is formatted you can save it to your local machine.
Select the format for the file:
Printer-Friendly. Formats the report so it is ready to be send to a printer.

l

Tip: Before printing, ensure that printer settings are set to print the selected frame,
and not to print frames as laid out on screen.
To obtain optimal print results if you are using Microsoft Internet Explorer, enable the
Print background color and images option (Tools > Internet Options > Advanced
tab > Printing).
l

PDF. Formats the report using the PDF format. To enable displaying characters in
all languages in your PDF file, you must make sure the Arial Unicode MS font file is
available on your server as follows:
1. Navigate to the font library on your system. For example, in Windows:
C:\Windows\Fonts
2. Download the Arial Unicode MS font into the selected font library. The font is
available from: http://www.microsoft.com/typography/fonts/family.aspx?FID=24.
3. Restart the server.

l

l

l

l
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CSV. Formats the report using the .csv format.
Excel. Formats the report using the Excel format.
XML. Formats the report using the XML format.
Help. Accesses the online help for this menu option.
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UI
Element Description
Export report to... Displays the options available to export the report.
l

Email. Opens the Mail Details dialog box where you can configure how to send
the report using email. For details on the user interface, see "Mail Details Dialog Box"
on page 1348.
Note:
n

SiteScope is unable to export the report to email if the mail server is defined to use
SSL SMTP (in the "Email Preferences Default Settings Dialog Box" on page 571).

n

Monitor reports can only be sent by email via the standard SMTP port (25).

l

Help. Accesses the online help for this menu option.

Monitor Report Table Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<Report targets>

Displays the monitors to be included in this report, and the
information selected in the Select Columns dialog box.
Reset Column Width. Resets the table columns' width to its
default setting. You can adjust the width of the table's columns
by dragging the borders of the column to the right or the left.
Select Columns. Select the monitor information to display in
the report columns. Data is shown in the report table for the
selected parameters only if the particular option has been
selected, such as Disabled and Frequency, or if a value has
been supplied, such as Monitor Description. If the option or
value has not been defined in the particular monitor setup, the
column is blank for that parameter for that monitor.
Note: Hold down the SHIFT key to select a set of adjacent
groups. Use CTRL-click to select non-adjacent items.

HP SiteScope (11.31)
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UI Element

Description
Divides a table of data or a list of reports into pages. You move
from page to page by clicking the relevant button:
l

l

<Monitor information columns>

To view the next/last page in the report, click the Next/Last
page button.
To view previous/first page in the report, click the Previous
page/First page buttons.

Displays the SiteScope monitors to be included in this report,
and the information for the selected columns. For the list of
available columns and descriptions, see "Monitor Summary
Report" on page 1361.
To sort a report by a specific column, click the column header.
If the column is sortable, a small arrow icon is displayed. The
direction of the arrow indicates the column's sorting direction
(ascending/descending).
Click the

icon to change the sorting direction.

When a column is used to sort the report, the column header is
colored a darker blue.

New SiteScope Alert Report Dialog Box
This dialog box enables you to create a report used to display SiteScope alerts sent over a given time
period.
To access

Select the Monitors context, and in the monitor tree:
l

l

Right-click the SiteScope node, a monitor group, or a monitor, and select Reports
> Alert.
Select the SiteScope object for which you want to generate a report, and in the
Reports tab, select Create New Report > Alert.

Important
To generate an alert report, you must be an administrator in SiteScope, or a user
information granted the Generate alert report permission in User Management Preferences. For
details on user permissions, see "User Management Preferences" on page 732.
Relevant
tasks
See also

"Create SiteScope Reports" on page 1320

l

"Reports" on page 1319

l

"Alert Report" on page 1363

HP SiteScope (11.31)
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This section includes:
l

"Alert Report Toolbar" below

l

"Alert Report Table Toolbar" on page 1347

Alert Report Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description
Filter/Collapse report filter. Click to collapse or expand the report filter.
When the report filter is selected:
l

l

l

HP SiteScope (11.31)

Select a time-range that you want the report to cover from the Time-range
bar (described below).
Select the groups, monitors, or both, to be included in this report from the
left pane. The tree includes the currently selected container and all of the
child containers. By default, the current container and all child elements
are selected.
Select the Alert types to be included in this report from the right pane. By
default, all alert types are selected.
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UI Element

Description
<Time-range bar> The report's granularity includes: the time-range and the
time-unit.
l

l

l

View. Select a time-range that you want the report to cover: Past hour,
Past day, Past week, Hour, Day, Week, or Custom (a user-defined time
period)
Use the buttons as follows:
n

Back. Displays the report one time frame earlier than the currently
displayed time frame.
For example, if the value of the View box is Day, clicking this button
displays data for one day earlier than the currently displayed report.

n

Forward. Displays the report one time frame later than the
currently displayed time frame.
For example,if the value of the View box is Hour, clicking this button
displays data for one hour later than the currently displayed report.

From-To. Click the links to display a calendar where you can configure
the start and end date and time for the report.The calendar contains the
following buttons:
n Current. Selects today's date in the calendar.
n

Cancel. Closes the calendar without making any changes.

n

OK. Updates the date link for the selected date and closes the
calendar.

Run. After you have selected the time-range, groups, monitors, and alert
types to include in the report, click the Run button to generate the report.

HP SiteScope (11.31)
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UI Element

Description
Format report data as... Displays the options available to format the report.
Once the report is formatted you can save it to your local machine.
Select the format for the file:
l

Printer-Friendly. Formats the report so it is ready to be send to a
printer.
Tip: Before printing, ensure that printer settings are set to print the
selected frame, and not to print frames as laid out on screen. To obtain
optimal print results if you are using Microsoft Internet Explorer, enable the
Print background color and images option (Tools > Internet Options >
Advanced tab > Printing).

l

PDF. Formats the report using the PDF format. To enable displaying
characters in all languages in your PDF file, make sure the Arial Unicode
MS font file is available on your server as follows:
1. Navigate to the font library on your system. For example, in Windows:
C:\Windows\Fonts
2. Download the Arial Unicode MS font into the selected font library. The
font is available from the following web site:
http://www.microsoft.com/typography/fonts/family.aspx?FID=24.
3. Restart the server.

l

CSV. Formats the report using the .csv format.

l

Excel. Formats the report using the Excel format.

l

XML. Formats the report using the XML format.

l

Help. Accesses the online help for this menu option.

Export report to... Displays the options available to export the report.
l

Email. Opens the Mail Details dialog box where you can configure how
to send the report using email. For details on the user interface, see "Mail
Details Dialog Box" on page 1348.
Note: SiteScope is unable to export the report to email if the mail server is
defined to use SSL SMTP (in the "Email Preferences Default Settings
Dialog Box" on page 571).

l
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Help. Accesses the online help for this menu option.
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Alert Report Table Toolbar
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description
Reset Column Width. Resets the table columns' width to its
default setting. You can adjust the width of the table's columns
by dragging the borders of the column to the right or the left.
Select Columns. Select the monitor information to display in
the report columns. Data is shown in the report table for the
selected parameters only if the particular option has been
selected, such as Disabled and Frequency, or if a value has
been supplied, such as Monitor Description. If the option or
value has not been defined in the particular monitor setup, the
column is blank for that parameter for that monitor.
Note: Hold down the SHIFT key to select a set of adjacent
groups. Use CTRL-click to select non-adjacent items.
Divides a table of data or a list of reports into pages. You move
from page to page by clicking the relevant button:
l

l

<Alert information columns>

To view the next/last page in the report, click the Next/Last
page button.
To view previous/first page in the report, click the Previous
page/First page buttons.

Displays information about SiteScope alerts generated during a
specified period of time for the monitors and alert types
selected in the filter. The information displayed corresponds to
the fields selected in the Select Columns dialog box. For the
list of available columns and descriptions, see "Alert Report"
on page 1363.
Note: The report includes all alerts, including alerts from parent
groups that target the selected object.
To sort a report by a specific column, click the column header.
If the column is sortable, a small arrow icon is displayed. The
direction of the arrow indicates the column's sorting direction
(ascending/descending).
Click the

icon to change the sorting direction.

When a column is used to sort the report, the column header is
colored a darker blue.

HP SiteScope (11.31)
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Graph Metrics Options
This table includes a description of the graph metrics options that can be included in the report:
Graph

Description

None - no
graph

No graphs are included in the report. The report only includes the tabular data
contents you have selected.

Bar graph one graph per
measurement

This bar graph option displays a single type of metric per graph and per monitor
during the specified time frame. For reports on multiple monitors, this results in the
most number of graphs with one bar graph generated for each type of metric for
each monitor.

Line Graph one graph per
measurement

This line graph option displays a separate line graph for each type of metric for a
single monitor. Like the bar graph option, this results in the most number of line
graphs with one line graph generated for each type of metric for each monitor
selected for the report regardless of any compatibility of metric type.

Line Graph group per
monitor
instance

This line graph option attempts to group all metrics from a single monitor instance
into a single graph per monitor. The number of line graphs generated depends on
whether the monitor records multiple metrics per monitor run (for example, the
Microsoft Windows Resources or UNIX Resources monitor types) and whether
the metrics types are compatibility with one another. Separate graphs are
generated if the metrics types are not compatible.

Line Graph group same
measurement
types

Select this option to plot the same metrics types gathered by several different
monitor instances into single graphs. A line graph is generated for each set of
compatible metrics types regardless of the number of monitors selected for the
report.

Line Graph group
compatible
measurements

Select this option to display all compatible metrics from the selected monitors on a
single graph. The option is intended to minimize the total number of line graphs
generated. The number of graphs generated is still dependent on the compatibility
of the selected monitor types and the metrics types collected by those monitors. If
all of the monitors selected for the report are of the same type, for example URL
monitors, then a single graph is generated with a colored line for each of the
monitors.

Note: A bar graph is generated using standard HTML, so it can be printed from all browser types.
Line graphs are generated using a java applet and may not print directly from all browsers.

Mail Details Dialog Box
This dialog box enables you to configure a report to be sent via email.

HP SiteScope (11.31)
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To access

Click Export report to...

and select

Email.

Important
If you choose to use a mail option that displays the report content in the email client,
information verify that the email client does not employ security restrictions which prevent the
running of scripts contained in HTML mail. Email clients that do employ such
restrictions may be unable to properly display all the report's content.
Relevant
tasks
See also

"Create SiteScope Reports" on page 1320

l

"Reports" on page 1319

l

"New SiteScope Monitor Report Dialog Box" on page 1339

l

"Monitor Summary Report" on page 1361

User interface elements are described below:
UI Element

Description

Subject

Enter a descriptive subject, or accept the default value.

To

Enter an email address to which you want to send the report.

Reply-to

Enter an email address for receiving replies.

Comments

Enter relevant comments, if required.

Send report
as

Specify the format in which you want to send the report. Choose from the following
options:
l

l

HTML mail. The report is displayed in the email client (the email client must
support, and be configured to display, HTML).
HTML attachment. The report is displayed in HTML format in a browser.
Note: You must have a connection to a SiteScope machine to enable you to
view the attachment.

Include
Images

Select the option to include all report resources (for example, graphics) in the
email.
Clear the option to remove the images from the email. In such a case, the images
are located on SiteScope servers, and you need a network connection to
SiteScope to access the servers and view the report images.
Note: This option is displayed only when HTML mail has been selected in the
Send report as field.
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UI Element

Description

Send as
Internet
Explorer
Archived
HTML (.mht)

Select for all report resources (for example, graphics) to be displayed in the
browser, which must support MHT format (such as Microsoft Internet Explorer). It
is not necessary to have a connection to a SiteScope machine to enable you to
view the attachment.

Zipped
Attachment

Select to send the attachment in zipped format.

Note: This option is displayed only when HTML attachment has been selected in
the Send report as field.

Note: This option is displayed only when HTML attachment has been selected in
the Send report as field.

Reports Page
This page displays information about the reports defined in SiteScope. Use this page to add, edit, or
delete report definitions. If a report has been set up for a SiteScope object (group or monitor), the report
symbol is displayed next to the object icon in the monitor tree.
To access

Important
information

Select the Monitors context. In the monitor tree, select the SiteScope object for
which you want to generate a report, and click the Reports tab.
l

l

Relevant
tasks

Reports created for a specific monitor or group are displayed in the object's
Reports on Monitor/Group list. Targeted monitors or groups are displayed in the
Reports Associated with Monitor/Group list.
Only a SiteScope administrator user, or a user granted the appropriate report
permissions can generate reports and add or edit management reports. For details
on user permissions, see "Permissions" on page 744.

"Create SiteScope Reports" on page 1320

User interface elements are described below:
UI Element

Description
Show Child Reports. Displays only those reports that are direct children of the
selected node.
Show All Descendent Reports. Displays all descendent reports of the selected
node.

HP SiteScope (11.31)
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UI Element

Description
New Report. Enables you to select the type of report you want to configure. Only
Management reports are added to the Reports tab (all other report types are created
on an ad hoc basis, and are not saved in SiteScope). For user interface details, see
"New/Edit SiteScope Management Report Dialog Box" on page 1326.
Note: This button is available in the Reports on Monitor/Group table only.
Edit Report. Enables you to edit the properties of the selected Management report.
For details on the Edit Management Report user interface, see "New/Edit SiteScope
Management Report Dialog Box" on page 1326.
Copy Report. Makes a copy of the selected report.
Note: This button is available in the Reports on Monitor/Group table only.
Paste Report. Pastes the report to the selected location in the tree.
Note: This button is available in the Reports on Monitor/Group table only.
Delete Report. Deletes the selected Management report from the Reports tab.
Generate Report. Generates a Management report for a selected monitor or group.
For user interface details, see "Management Report" below.
Select All. Selects all listed reports.
Clear Selection. Clears the selection.

Type

Indicates the report type.

Title

The name by which the report is known in SiteScope.

Description A description of the report.
Enabled

Indicates whether the generation of this report is enabled.

Path

Displays a link to the ancestor node that is targeting this object.
Note: This column is available in the Reports associated with table only.

Management Report
This report displays a summary and specific details of infrastructure availability and performance data
for monitors and monitor groups over a given period of time. Use Management reports to detect
emerging trends and correct potential problems before they become a crisis.
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To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
monitor group, or a monitor container, and select Reports > Management. Configure
the report properties, and click OK. In the Reports tab, select the report and click the
Generate Report
button. Click the date-coded link for the report period you want
to view. If no reports have been generated, or if you want to create an updated report,
click the Generate button.
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Important
information

l

Management reports do not support non-English labels.

l

Indicator values are not displayed in SiteScope reports.

l

l

Relevant
tasks
See also

When setting counters for Custom monitors with a string (not numeric) or using
browsable-based monitor counters that contain a string (not numeric) value, the
maximum and average values in the Measurement Summary table are shown as
'n/a'. This also occurs if you change the counter value type (for example, if you set
the counter with a numeric value, and later change it to a string value or visa
versa).
Since data for reports is taken from the daily log files (and it takes time for this
data to be written to the log file), there might be a slight gap in this data being
correctly represented in reports. Therefore, we recommend waiting about a minute
between generating reports with different Measurement Graph drop down values
to avoid incorrect data being displayed.

"Create SiteScope Reports" on page 1320

l

"New/Edit SiteScope Management Report Dialog Box" on page 1326

l

"Reports Page" on page 1350

This section includes:
l

"Report Content - Index Page" below

l

"Report Content - Management Report Page" on the next page

Report Content - Index Page
The following elements are included in the Management report index page (unlabeled elements are
shown in angle brackets):
UI Element

Description

<License
details>

License details are displayed at the bottom of the page. It includes the active
license edition, and a summary of the capacity types available, being used, and
remaining.

Most Recent
Report

Click to display the most recent Management report available for the currently
selected monitor or group.

Information
For <report
time and
data>

Click to display the Management report for the time period specified in the link for
the currently selected monitor or group. For details on the Management Report
page, see Report Content - Management Report Page.
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UI Element

Description

Generate

Click to create a new report for the currently selected monitor or group, regardless
of when the report was normally scheduled to be generated.

Report Content - Management Report Page
The following elements are included in the Management report page (unlabeled elements are shown in
angle brackets):
UI Element

Description

Table Format

Click the Table Format link to go to the measurements data in table format in the
currently selected report.

Error List

Click the Error List link to go to the list of monitors with error status in the
currently selected report.

Warning List

Click the Warning List link to go to the list of monitors with warning status in the
currently selected report.

Good List

Click the Good List link to go to the list of monitors with good status in the
currently selected report.

Index of
Reports

Click the Index of Reports link to go to the index of Management reports. For
details on the Management Report index page, see "Management Report" on page
1351.

Uptime
Summary

This table includes the following:
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l

Name. The name of monitors included in the report.

l

Uptime %. The percentage of monitor readings reported as good.

l

Warning %. The percentage of monitor readings reported as warning.

l

Error %. The percentage of monitor readings reported as error.

l

Last. The last reading of the monitor for the report period.
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UI Element

Description

Measurement
Summary

This table includes the following:
l

Name. The name of monitors included in the report.

l

Measurement. The parameter being monitored (for error condition).

l

Max. The maximum value recorded for the Measurement parameter during the
report period.

l

Avg. The average value of the readings recorded for the report period.

l

Last. The last reading of the monitor for the report period.

<Measurement Measurement data in graph format for each monitored instance for the report
Graphs>
period.
Bars highlighted in red or yellow indicate that the measurement exceeded the error
or warning status threshold for the monitor; green indicates the measurement was
in good status (below left).
If part of the bar is displayed in gray (below right), this shows the maximum value
of the measurement where the bar is an average value based on the aggregation of
several data samples. (This is configured using the Time between samples
option in the Calculation Method section of the New/Edit SiteScope
Management Report dialog box.) Graphs typically show raw data (without the gray
bar) for short period reports (where Time between samples is set to "Automatic
time scale" and it is possible to display raw data for the time range selected), and
aggregated data for longer period reports
Example:
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UI Element

Description

<Measurement Measurement data in table format, shown at 30 minute increments, for each
Tables>
monitored instance for the report period. Entries highlighted in red or yellow
indicate that the measurement exceeded the error or warning status threshold for
the monitor. Blue indicates that the monitor was disabled.
<Error List
Table>

Lists the monitor instances that exceeded the error status threshold for the
monitor. Entries are highlighted in red.

<Warning List
Table>

Lists the monitor instances that exceeded the warning status threshold for the
monitor. Entries are highlighted in yellow.

<Good List
Table>

Lists the monitor instances that were in the good status threshold for the monitor.
Entries are highlighted in green.

Quick Report
This report displays a summary and specific details of infrastructure availability and performance data
for monitors and monitor groups over a given period of time. Quick reports are generated on an ad hoc
basis and are not saved to the SiteScope configuration data.
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To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
monitor group, or a monitor container, and select Reports > Quick. Configure the
report properties, and click Generate Report.
Alternatively, you can create a report using preconfigured settings, by selecting a
monitor and clicking the Quick Report
toolbar.

HP SiteScope (11.31)

button in the SiteScope Dashboard
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Important
information

l

l

l

The time interval for a Quick report is not incremented automatically. This means
that the report always contains the data for the absolute Report Period interval
defined in the report definition. To view more recent data using a Quick report, edit
the Report Period setting.
Since data for reports is taken from the daily log files (and it takes time for this
data to be written to the log file), there might be a slight gap in this data being
correctly represented in reports. Therefore, we recommend waiting about a minute
between generating reports with different Measurement Graph drop down values
to avoid incorrect data being displayed.
When working in BSM, Quick Report definitions in SAM Administration are stored
only with the BSM context. Quick Report definitions are not stored in and do not
persist on the SiteScope server.

Relevant
tasks

"Create SiteScope Reports" on page 1320

See also

"New SiteScope Quick Report Dialog Box" on page 1334

Report Content
User interface elements are described below (unlabeled elements are shown in angle brackets):
UI Element

Description

<License
details>

License details are displayed at the bottom of the page. It includes the active
license edition, and a summary of the capacity types available, being used, and
remaining.

Table Format

Click to go to the measurements data in table format in the currently selected
report.

Error List

Click to go to the list of monitors with error status in the currently selected report.

Warning List

Click to go to the list of monitors with warning status in the currently selected
report.

Good List

Click to go to the list of monitors with good status in the currently selected report.
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UI Element

Description

Uptime
Summary

This table includes the following:

Measurement
Summary

l

Name. The name of monitors included in the report.

l

Uptime %. The percentage of monitor readings reported as good.

l

Warning %. The percentage of monitor readings reported as warning.

l

Error %. The percentage of monitor readings reported as error.

l

Last. The last reading of the monitor for the report period.

This table includes the following:
l

Name. The name of monitors included in the report.

l

Measurement. The parameter being monitored (for error condition).

l

HP SiteScope (11.31)

Max. The maximum value recorded for the Measurement parameter during the
report period.

l

Avg. The average value of the readings recorded for the report period.

l

Last. The last reading of the monitor for the report period.
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UI Element

Description

<Measurement Measurement data in graph format for each monitored instance for the period of the
Graphs>
report.
Bars highlighted in red or yellow indicate that the measurement exceeded the error
or warning status threshold for the monitor; green indicates the measurement was
in good status (below left).
If part of the bar is displayed in gray (below right), this shows the maximum value
of the measurement where the bar is an average value based on the aggregation of
several data samples. (This is configured using the Time between samples
option in the Calculation Method section of the New/Edit SiteScope
Management Report dialog box.) Graphs typically show raw data (without the gray
bar) for short period reports (where Time between samples is set to "Automatic
time scale" and it is possible to display raw data for the time range selected), and
aggregated data for longer period reports.
Example:

<Measurement Measurement data in table format, shown at 30 minute increments, for each
Tables>
monitored instance for the period of the report. Entries highlighted in red or yellow
indicate that the measurement exceeded the error or warning status threshold for
the monitor. Blue indicates that the monitor was disabled.
<Error List
Table>

Lists the monitor instances that exceeded the error status threshold for the
monitor. Entries are highlighted in red.

<Warning List
Table>

Lists the monitor instances that exceeded the warning status threshold for the
monitor. Entries are highlighted in yellow.

<Good List
Table>

Lists the monitor instances that were in the good status threshold for the monitor.
Entries are highlighted in green.
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Monitor Summary Report
This report displays information about the configuration and current settings of monitors in the groups
you have selected to include in the report. Use this report to view setup information on monitors as well
as the organization and makeup of groups of monitors.
For example, you can check and compare monitor run frequencies (the Frequency setting) if you are
having problems with monitor skips. For details on monitor skips, see "SiteScope Server Health
Monitors" on page 1149.
You can also use the report to check for monitor dependencies that can impact alerting. For details on
dependencies, see "Monitoring Group Dependencies" on page 255.

To
access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
monitor group, or a monitor container, and select Reports > Monitor. Configure the
report settings, and click the Run button to generate the report.

Relevant "Create SiteScope Reports" on page 1320
tasks
See also

"New SiteScope Monitor Report Dialog Box" on page 1339
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Report Content
User interface elements are described below:
UI Element

Description

Monitor Title

Display name for the monitor.

Monitor Type

The type of monitor being displayed.

Group

The group name to which the monitor belongs.

Frequency

The frequency at which the monitor is set to run.

Depends on

Lists any dependent monitors, if the running of this monitor is dependent on the
status of other monitors.

URL

Any URL being monitored.

Host

The name of the remote server containing the monitored object.

Machine

Machine name.

OID

The Object ID of the parameters being monitored.

Disabled

Indicates whether the monitor is disabled.

Schedule

The monitor schedule, if a schedule other than the default schedule is selected.

Error
Frequency

If the Error frequency option is selected, the monitoring interval, in seconds, for
monitors that have reported an error condition.

Timeout

The timeout setting for the monitor.

Verify Error

Displays On if the Verify error option is selected. This option automatically runs
the monitor again if it detects an error.

Report
Description

The text description for the report if entered in the report Description box.

Monitor
Description

The text description for the monitor if entered in the Monitor Description box.

User Name

User name if required for authentication.

Proxy

Proxy server name, if used.

Thresholds

The threshold conditions for the monitor instance.

Tags

Search/filter tags assigned to a monitor.

Parameters

List of property objects and their values which are marked as parameters.
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UI Element

Description

Report
monitor and
related CI
topology

Indicates whether SiteScope reports monitor and related CI topology data to
BSM's RTSM (Run-time Service Model).

Topology type The monitor's topology that is used for reporting data to BSM's RTSM. Typically,
the default CI type for the monitor is used (for most monitors, this is Computer).
Custom CI
type

CI type key attributes are displayed according to the CI type selected (only where
the non-default CI type for the monitor is selected).

Custom
Topology
Properties

Displays the key attribute values for the selected CI type:
l

l

l

l

Name. Name of the CI (for BusinessApplication, BusinessService, Computer,
DB2, InfrastructureService, JBoss AS, Oracle, Oracle iAS, SQL Server,
Sybase, WebLogic AS, and WebSphere AS CI types).
Server. Container CI for the selected CI. This attribute is required for DB2,
JBoss AS, Oracle, Oracle iAS, SQL Server, Sybase, WebLogic AS,
WebSphere AS, and Windows CI types.
Organization Type. Identifier used to differentiate levels within an
organization. This attribute is required for BusinessApplication,
BusinessService, and InfrastructureService CI types.
Organization Name. Name of the organization. This attribute is required for
BusinessApplication, BusinessService, and InfrastructureService CI types.

Send events

Indicates whether SiteScope sends events to HPOM or Operations Management
when there is a metric status change for the monitor instance.

Report
metrics to
agent

Indicates whether SiteScopereports metrics for the monitor instance to the
HP Operations agent, from which HPOM and Operations Management can collect
the data.

Event
Mapping

The template used for mapping SiteScope runtime data to the attribute values that
are used for sending events for the monitor instance.

BSM Service
Health
affected by

The preference (events or metrics) for influencing BSM's Service Health when
both SiteScope events and metrics are reported to Service Health (since indicators
for SiteScope events and metrics both affect CIs).
Note: This field is empty when there is no integration with BSM.

Alert Report
This report displays information about SiteScope alerts generated during a specified period of time for
the monitors in the selected container.
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Important
When generating a report for a monitor, the report does not include alerts from parent
information groups that target the selected monitor.
To access

Select the Monitors context. In the monitor tree, right-click the SiteScope node, a
monitor group, or a monitor container, and select Reports > Alert. Configure the
report settings, and click the Run button to generate the report.

Relevant
tasks

"Create SiteScope Reports" on page 1320

See also

"New SiteScope Alert Report Dialog Box" on page 1343

Report Content
User interface elements are described below:
UI
Element

Description

Monitor

The name of the monitor on which the alert was triggered.

Type

The type of alert action (for example, Mailto, Sound).

Status

The status of the alert (for example, Pass, Failed).

Message The type of message in the alert (for example, Default, alarm).
Date

The date and time at which the alert was triggered.

Group

The name of the group on which the alert was triggered.

Detail

Displays detailed alert information for each alert in the report. This includes a full
diagnostics breakdown for each failed alert.
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You can create a Server-Centric report for Microsoft Windows and UNIX Resources monitors, which
displays data from three different metrics about the remote server being monitored.
The report includes tables listing the top five processes by CPU utilization and memory consumption.
You can navigate the graph and change the time of the data displayed in the tables. This enables you to
focus in on a problematic period in the graph to locate the processes running at that time.

To access
Select the Monitors context. In the monitor tree, right-click the selected monitor, group, or the
SiteScope root, and select Reports > Server-Centric.

Learn About
Server-Centric Reports Overview
The Server-Centric Report displays the following metrics on the same graph:
l

l

l

CPU Utilization. For UNIX Resource Monitors, this metric is calculated as an average of three
counters: system processing utilization, user processing utilization, and input/output processing
utilization. For Microsoft Windows Resources Monitors, the metric is calculated as processing
capacity used out of total processing capacity.
Memory Utilization. Calculated as memory used out of total available memory.
Network Utilization. Calculated by system-specific counters. Calculating network utilization is
supported only for Windows servers.

Each metric is displayed by a separate line of a unique color on the graph. The report enables you to
easily make a visible correlation between the different metrics.

Server-Centric Report Measurements
The following table displays the counters which must be selected when defining the monitor for the
Server-Centric report manually:
Operating System Type (Platform)

Server-Centric Mandatory Counters

Microsoft Windows Resource Monitor

Memory\% Committed Bytes In Use
Processor\_Total\% Processor Time
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Operating System Type (Platform)

Server-Centric Mandatory Counters

UNIX Resource Monitor (on Solaris platform)

CPU utilization\%sys
CPU utilization\%usr
CPU utilization\%wio
Memory\swap_avail
Memory\swap_resv

UNIX Resource Monitor (on AIX platform)

Processor\Total\%sys
Processor\Total\%usr
Processor\Total\%wio

UNIX Resource Monitor (on Linux platform)

Memory\MemFree
Memory\MemTotal
Processor\Total\System
Processor\Total\User
Processor\Total\User low

Tasks
How to Create a Server-Centric Report
This task describes the steps involved in creating a monitor to monitor your Windows and UNIX server,
and generating a Server-Centric report.
1. Prerequisites
To be able to generate Server-Centric reports, you must be an administrator in SiteScope, or a
user granted the Generate server centric report permission in User Management Preferences.
For details on user permissions, see "User Management Preferences" on page 732.
2. Create a Microsoft Windows or UNIX Resources monitor
To monitor your Microsoft Windows or UNIX server, you must create a Microsoft Windows or
UNIX Resources monitor. You can create the monitor manually, or by using solution templates
(recommended).
n

For details on manually creating a Microsoft Windows Resources or UNIX Resources monitor,
see:
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o

Microsoft Windows Resources Monitor

o

UNIX Resources Monitor
Note: When defining the monitor manually, you must perform the following:

n

o

Select Enable Server-Centric report in the required monitor settings page.

o

Select the required metrics for the monitors, according to the table in "Server-Centric
Report Measurements" on page 1365.

For details on creating a monitor using solution templates (this is recommended because the
templates contain all the required measurement counters, see:
o

"Microsoft Windows Host Solution Template" on page 978

o

"AIX Host Solution Template" on page 910

o

"Linux Host Solution Template" on page 951

o

"Solaris Host Solution Templates" on page 1003

3. Generate the Server-Centric report
You can generate the report using either of the following:
n

Navigate to the SiteScope Dashboard, display the data for the applicable Microsoft Windows
or UNIX Resources monitor, and click the server name in the Target column in the row that
corresponds to your resources monitor.

n

In the monitor tree, right-click the selected monitor, group, or the SiteScope root, and select
Reports > Server-Centric. In the Server-Centric Report dialog box, select the remote target
(Windows/UNIX Resources monitor with Enable Server-Centric Report check box selected)
for which you want to generate a report, and click the Run button.

For user interface details, see "Server-Centric Report" on page 1370.
4. Analyze data in the report
The report enables you to view three different metrics of your server in the same graph – CPU
utilization, memory utilization, and network utilization. It also lists the top five processes by CPU
utilization and memory consumption. You can drill down to specific times by clicking a data point
on the graph.

How to Create a Server-Centric Report – Use-Case Scenario
This use-case scenario describes how to create a Server-Centric report.
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1. Background
David Foster, a SiteScope user at Acme Company, wants to create a report that provides data on
CPU utilization, memory utilization, and network utilization for a monitored server, Apollo.
2. Configuring a remote server
Before he creates the report, David configures SiteScope to monitor the remote Windows server,
Apollo, and configures the server in Microsoft Windows Remote Servers.

3. Deploying a Microsoft Windows Host solution template
After enabling SiteScope to monitor data on Apollo, David deploys the Microsoft Windows Host
solution template into the selected group container, and selects Apollo as the server to monitor.
David uses the solution templates when creating the Microsoft Windows Resource monitor,
because the required monitors and metrics for generating a Server-Centric report are already
configured.
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After David deploys the solution template, SiteScope creates a group named Windows monitors
for Apollo that contains the Microsoft Windows Resources monitor.

4. Creating a Server-Centric report
David generates the Server-Centric report for Apollo from the Current Status view of Service
Health.

The Server-Centric report opens, displaying the CPU Utilization, Memory Utilization, and Network
Utilization metrics on the same graph. David can use this data to view the top processes by CPU
utilization and memory consumption during different times, and focus in on problematic periods to
locate the processes running at that time.
Example: Measurement status and availability for a monitor
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UI Descriptions
Server-Centric Report
This report displays the metrics CPU utilization, memory utilization, and network utilization for a
selected server.
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Important
information

l

l

l

l

This report is available only on those servers being monitored by a Microsoft
Windows Resources monitor or UNIX Resources monitor with Enable ServerCentric Report selected.
We highly recommend that you deploy these monitors using the applicable
solution templates for these monitors. The templates are pre-configured with the
correct measurement counters and options already selected.
The Server-Centric report is not supported in Firefox 2.x.
If a monitor encounters a problem and returns non-applicable data, that data point
is skipped. Thus, you may see missing data points in the graph.

Report Settings
User interface elements are described below:
UI
Element

Description
Filter/Collapse report filter. Click to display/hide the time range settings for the
report.
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UI
Element

Description
Run. Creates a report for the date range displayed in the date links (Filter).
Format. Formats the report data to a file for exporting. Select the format for the file. The
options are printer-friendly, CSV, Excel, or XML.
Export. Exports the report data in an email. Select the option for sending the file. The
options are HTML mail, HTML attachment, or PDF.
Note:
l

l

To use the export functionality, you must add the SiteScope machine to the trusted
sites.
SiteScope is unable to export the report to email if the mail server is defined to use
SSL SMTP (in the "Email Preferences Default Settings Dialog Box" on page 571).

Back. Displays the report one time frame earlier than the currently displayed time
frame.
Example: If the value of the View box is Day, clicking this button displays data for one
day earlier than the currently displayed report.
Forward. Displays the report one time frame later than the currently displayed time
frame.
Example: If the value of the View box is Day, clicking this button displays data for one
day later than the currently displayed report.
View

From/To
<date
links>

Time range for which you want to view the report. Available time ranges include the
following:
l

Custom (enables you to configure any range)

l

Hour, Day, Week

l

Past hour, Past day, Past week

Click the From link to configure a start date and time for the report. Click the To link to
configure an end date and time for the report. The calendar contains the following
buttons:
l

OK. Updates the date link for the selected date and closes the calendar.

l

Current. Selects today's date in the calendar.

l

Cancel. Closes the calendar without making any changes.
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Report Content
User interface elements are described below:
UI Element

Description

<Tooltip>

Hold the pointer over any data point on the graph to display a tooltip showing the
value at the selected time of the utilization for the selected metric, as well as the
date and time.
You can click on a data point in the graph to focus in on a shorter timer range. The
data tables are updated to show results for the time of the data point you selected
(clicking any of the three data points for the same time updates the report in the
same way).
You can return to the Server-Centric summary report using the breadcrumbs at the
top of the page.

Server name

Name of the server appears above the Utilization graph.

Utilization
graph

Displays utilization over time. The different colored lines represent CPU utilization,
memory utilization, and network utilization. All three metrics are scaled as percents
(that is, out of 100% utilization).
You can click on a data point in the graph to focus in on a shorter timer range. The
data tables are updated to show results for the time of the data point you selected
(clicking any of the three data points for the same time updates the report in the
same way). This is useful when you notice a point with particularly high utilization.
By clicking on the point, you can determine the cause of the high utilization.
Note: Network utilization is supported for Windows servers only.

Top 5 CPU
Utilization
Processes
table

Displays the top five processes in terms of CPU utilization at any point in the
graph. The table displays the process name and the CPU utilization value as a
percent of total available CPU processing potential.

Top 5
Displays the top five processes in terms of memory consumption at any point in the
Memory
graph. The table displays the process name and the memory consumption value in
Consumption kilobytes.
Processes
table
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Part 15: Predictive Analytics
Predictive Analytics helps protect businesses from the impact of IT issues by predicting potential
problems in critical applications and informing you of issues that can affect the business flow.
SiteScope uses baseline and correlation calculations to analyze system problems and provide details
to assist with root cause analysis so that you can anticipate issues before business flows are
impacted.
For details, see "Configure Predictive Analytics" on page 1375.
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Predictive Analytics enables SiteScope to anticipate potential problems on business monitors and alert
users of issues in critical applications before they occur. It uses a run-time analytics engine that can
predict IT problems by analyzing abnormal system behavior, and alerting IT managers of business flow
degradation before an issue impacts their business. It also uses a correlation calculation to identify
similar trends between system and business metrics around the time that the event occurred, and
provides details to assist with root cause analysis to help expedite problem resolution.
Tip: You can view a guided and narrated demonstration on how to anticipate potential problems in
applications using SiteScope Analytics on YouTube: http://hpsw.co/Ln5i6C9.

To access
Select the Monitors context. In the monitor tree, right-click the SiteScope monitor for which you want
to use predictive analytics, and select Predictive Analytics > New Predictive Analytics.
Alternatively, select the monitor, click the Analytics tab in the right pane, and then click New
Predictive Analytics.

Learn About
Definitions
Predictive Analytics relies on SiteScope's ability to monitor both business application transactions and
the infrastructure layer of the business IT environment.
l

l

Source Monitor. This is the monitor you want to analyze. Typically, this would be a business or
application monitor (such as URL, Database, or JMX) that is used to monitor performance on your
business critical application. This is the monitor against which metrics from the selected target
monitors are correlated. By default, some monitor types cannot be defined as the source monitor for
analytics.
Target Monitors. Metrics from these monitors will be correlated with metrics from the source
monitor around the time that an issue is detected in the business application, in order to identify
similar trends and to pinpoint the cause of the problem in the application. While these would
typically be system infrastructure monitors (such as CPU, Ping, or Memory), any monitor type can
be defined as a target for the analytics calculation. By default, you can select up to 700 target
monitors. You can increase (or decrease) this value according to your system's hardware capacity
in Maximum number of target monitors in "Analytics Settings" on page 644.

Key Features of Predictive Analytics
SiteScope's Predictive Analytics offers the following key features:
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l

l

l

l

Anticipates potential IT problems before they occur - SiteScope detects behavioral changes
(anomalies) on the application monitor metrics, and sends predictive alerts before a problem starts
to affect your business.
Speeds up problem resolution by providing details to assist with root cause analysis SiteScope identifies the impact of system infrastructure monitors on the business application and
provides the details beneficial to assist with root cause analysis based on this correlation in
predictive alerts.
Prevents or reduces downtime - Potential issues are identified, and reported before their full
effects are felt in the IT systems. This gives you vital time to take action before IT systems and
services are impaired.
Provides a new view displaying an impact tree - This is a filtered view within Multi-View that
displays the business monitor and its correlated target system monitors in a single view. This helps
you to examine more closely the impact of system infrastructure monitors on the business
application and to diagnose the root cause of issues.

Who Can Benefit from Predictive Analytics?
l

l

l

Application Support Team - Reduces the time to resolve problems using root cause analysis
information. As soon as SiteScope detects an anomaly on the source monitor (before the static
threshold is crossed), it provides details which can assist you to identify the cause of the problem.
Monitoring Team - Provides enhanced services with proactive issue detection. It also enables the
SiteScope administrator to invest less time on application monitoring configuration (defining static
thresholds), since application monitor thresholds are automatically calculated and updated using a
baseline.
Application Owner/Users - Provides an improved user experience to application owners and
users. Earlier problem detection helps make the application more robust and stable.

Predictive Analytics - How it Works
Every time an end user performs an action on a business application, this impacts the application in
some way—for example, the application's business metrics might be inserted into a database or logged
to a file. Since SiteScope is able to monitor business metrics (such as transaction count, round trip
time) and system metrics (such as CPU, free MB), any time a user performs an action on the
application, SiteScope analytics can track the impact of system performance on the business
application.
If SiteScope detects abnormal behavior in the application, it performs a correlation calculation to
identify similar trends between system and business metrics around the time that the event occurred,
and sends this information to users as a predictive alert. The alert contains the anomalies in the
application metrics (to help users anticipate upcoming problems on the monitored business
applications), and lists all correlated system monitors that might be the cause of the problem in the
application (to assist troubleshooting).
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Predictive Analytics Flow
Predictive Analytics uses the following mechanism to anticipate, and notify you of potential problems in
your infrastructure, so that you can deal with them before they impact the business:
1. Calculates an analytics baseline for the business application monitor
When analytics is started, SiteScope collects metrics data from the business monitor over a
period of time. After enough data has been collected, SiteScope creates a baseline sleeve that
determines whether future metric values are normal.
2. Predictive Analysis stage: Anticipates potential problems before the static threshold is
crossed
SiteScope uses the baseline calculation results (from the previous step) to predict upcoming
problems. It uses an algorithm that recognizes variations in business metrics, and allows for the
detection and forecast of abnormal events, performance, and availability issues. Because of this,
SiteScope might warn you of an anomaly in a business metric that needs addressing, but is still
not categorized as requiring immediate attention, since that particular anomaly has no effect on
the business application.
When an anomaly is identified, SiteScope triggers an alert that informs users of a potential issue in
the business application. This can provide an early warning of a critical event before the full impact
is felt by the business.
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When is the baseline calculation performed?
The baseline calculation is performed once a week only, using data collected during the previous
month (these settings are configurable in Baseline calculation frequency (milliseconds) and
Baseline calculation data period (milliseconds) in "Analytics Settings" on page 644).
Note: A minimum of 50 monitor samples is required for the baseline calculation. If there are
insufficient metrics in the daily logs, SiteScope waits until enough metrics data has been
accumulated before it starts the first baseline calculation. If you change the baseline
calculation period, you may also need to change the Baseline results aging period
(milliseconds) (in "Analytics Settings" on page 644) to enable the baseline calculation to be
activated immediately after the SiteScope restart.
3. Root Cause Analysis stage: Provides details to assist with the cause of the problem after
the analytics baseline is crossed
When an issue is detected in the business application (after application metrics have crossed the
analytics baseline), SiteScope searches for a correlation between the application monitor and
system monitors that you defined, and provides a list of all correlated system monitors that might
be the cause of the problem in the application. It uses a correlation algorithm to identify similar
trends between system and business metrics around the time that the event occurred. This is
configurable in the Correlation data retention period (hours) setting in "Analytics Settings" on
page 644.
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When is the correlation calculation performed?
The correlation calculation is first performed after analytics is configured, and an initial alert is sent
after the calculation has finished if Send alert when correlation calculation has finished is
selected in the Analytics Alerts panel.
Thereafter, the correlation calculation is performed when an analytics alert is triggered (each time
the business monitor crosses the analytics baseline), and when there is a change to the analytics
target monitor (for example, if a target monitor is added or removed from the analytics targets tree
in the Analytics tab).
How much data is included in the calculation?
The correlation calculation is performed on the last 10 hours of samples (configurable in
Correlation data retention period (hours) in the "Analytics Settings" on page 644). New
correlation calculation results override previous correlation results.
How is the correlation calculated?
Metric correlations is calculated using an algorithm that searches for metrics whose values go up
or down at more or less the same rate and time. The linear correlation compares the metrics of the
source and target monitors, and finds parallels between different metrics for a specific time frame.
Metric correlations are calculated by comparing selected base metrics from the business monitor
with metrics from the system monitors. Metric correlations can be viewed in the Correlations table
in the Analytics tab.
What samples are used in the correlation results?
The correlation results are calculated using all the metrics in the selected monitors area.
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n

The correlation calculation takes each metric for each business monitor, and performs the
correlation for 10 metrics (first 10 lexicographically).

n

For each of the above metrics a maximum of 25,000 scores will be computed (selected from
the respective target monitor metrics).

n

In the alert email, up to 500 scores will be displayed for each of the 10 metrics of the business
monitor. If there are more than 500 scores per business metric, the ones with the highest value
will be selected.

What correlation results are displayed in the Analytics tab and in the Analytics alert?
If the selected business monitor metric has crossed the analytics baseline, the correlation
calculation results are displayed. The Correlation table in the Analytics tab displays the correlation
score per monitor, while the alert provides more detailed results which show the correlation score
per metric.
Only target metrics that have a correlation score above the Correlation score threshold (%) (by
default, 60%) are considered correlated, and are displayed in the Analytics tab and in the analytics
alert. Metrics with a score lower than this value are not considered correlated, and are excluded
from the results. This setting can be modified in "Analytics Settings" on page 644.
Example: Correlation calculation results in the Analytics tab
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Example: Analytics alert triggered by the business application monitor crossing the analytics
baseline

Automatic Detection
SiteScope periodically receives data from samples that monitor the business application.
SiteScope detects anomalies and sends predictive alerts based on the following:
l

l

Metrics. A metric represents the time/value combinations provided for a specific field in a sample.
When analytics is started, SiteScope collects metric data from incoming samples over a period of
time.
Metrics Baseline Sleeve. After sufficient metric data has been collected, SiteScope creates a
baseline for the metric and calculates the mean and standard deviation. The mean and standard
deviation values are used to create the baseline sleeve which determines whether future metric
values are considered normal. By default, the baseline sleeve is calculated using a coefficient of +
or - 3 times the standard deviation from a metric's mean value.
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Once the baseline sleeve for a metric is created, a metric is considered to be abnormal if its value is
higher or lower than the mean value, plus or minus the metric's standard deviation multiplied by the
coefficient.
Note: Since SiteScope Analytics is based on mathematical and statistical algorithms, this
might result in encountering mathematical skews. You should take this into consideration and
test your Analytics alerts to find the most suitable sleeve coefficient for your business
monitors.

Automatic Tagging
Tags are used to enable filtering of the source monitor and its target monitors, so that these monitors
can be displayed in a single Impact view in SiteScope's Multi-View, and within the monitor tree filter
(when filtering by tags).
SiteScope automatically generates an analytics tag value for each analytics configuration and assigns
it to the source monitor. If the source monitor encounters a problem and an analytics alert is triggered,
SiteScope takes this tag and assigns it to the target monitors that are considered correlated (where the
correlation score is higher than 60%). The tag value is in the format analytics_<monitor_name>,
followed by a number in parenthesis if there is more than one monitor with the same name.
When an analytics alert is triggered (and the AnalyticsMail template is used), the email alert contains a
link to Multi-View, filtered to include the source monitor and its correlated target system monitors only.
For details, see "Multi-View" on page 1089.
You can also manually create custom tags for source and target monitors, and then assign them as
required in order to display monitors grouped by this custom tag in Multi-View. For details, see "How to
Manually Assign Tags to Analytics Monitors" on page 1389.

Understanding Analytics Alerts
When is an analytics alert triggered?
1. The first time analytics is configured for a monitor.
A dummy alert is sent after the initial correlation calculation has finished (provided Send alert
when correlation calculation has finished is selected in the Analytics Alerts panel).
2. When a business application monitor crosses the analytics baseline.
If SiteScope detects behavioral changes (anomalies) on the application monitor metrics, it sends
predictive alerts about potential issues before a problem starts to affect the business (provided the
Alert status trigger setting is set to Analytics). This occurs before the business application
monitor crosses the static threshold.
3. When a business application monitor crosses the static threshold.
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If the Alert status trigger setting is set to Good/Warning/Error, an alert is triggered after the
business application monitor crosses the static threshold and the status changes to the selected
trigger status.
Analytics Alert Details
Tip: For an example of an Analytics alert, see "What correlation results are displayed in the
Analytics tab and in the Analytics alert?" in "Predictive Analytics - How it Works" on page 1376.
The Analytics email alert provides a summary of analytics results, which includes the following:
l

l

l

l

l

Analyzed monitor details. This includes the name and description of the analyzed (source) monitor,
the analyzed monitor type, a list of the most recent measurement results reported by the monitor,
and the date and time of the last monitor run.
Alert reason. Reason for the alert being sent (one of the three reasons listed above).
Links to Impact View. This is a filtered view that displays only the analyzed monitor and its target
monitors in a single view, enabling you to more easily analyze and diagnose the root cause of the
event. For task details, see "How to Diagnose and Troubleshoot Problems" on page 1387.
Status. This is the status of all metrics on the analyzed monitor (according to which alert type was
triggered).
n

For an alert triggered by Analytics (analytics baseline was crossed), displays analyzed monitor
metrics which are out of the baseline sleeve.

n

For an alert triggered by a static threshold, displays analyzed monitor metrics that are in the
status for which the alert was triggered.

Highest correlation scores. Contains up to 500 best-fitting correlation scores for each analyzed
monitor metric. The correlation score represents a percentage value above which a correlation
result is considered correlated. The score determines what results are displayed in the analytics
alert. Metrics with a score lower than this value are not considered correlated, and are excluded
from the results. For details on the correlation calculation, see "What samples are used in the
correlation results?" in "Predictive Analytics - How it Works" on page 1376.
Note: To benefit from analytics alerts, the alert action type, template, and status trigger settings
must be configured as described in "How to Configure Predictive Analytics" on page 1385.
If you selected any trigger status other than Analytics, an alert is triggered only when the status
changes to the selected status.

Diagnose and Troubleshoot Issues from Impact View
You can view the impact of the correlation calculation for an analyzed monitor in Impact View. This is a
filtered view within Multi-View that displays the business monitor and its correlated target system
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monitors in a single view.
You can perform the following to diagnose and troubleshoot problems:
l

l

l

You can drill down on a monitor to view more detailed information, enabling you to focus only on
those monitors you want to view.
Examine the behavior of an abnormal metric. For example different metrics might exhibit abnormal
behavior at about the same time, indicating that the abnormal metrics are symptoms of the same
problem. Other metrics might be connected logically, for example they may be part of the same data
collector, application, or location.
Examine more closely the correlation between different metrics. Close correlation results between
base metrics and selected metrics, might indicate that the selected metric is an additional symptom
of the same problem, or it might be a metric that you should investigate further to find the root cause
of the problem.

For task details, see "How to Diagnose and Troubleshoot Problems" on page 1387.
Note: Because an analytics alert is a predictive alert that is triggered even though the business
monitor did not cross the static thresholds, the business monitor can be displayed in green (OK)
status while its correlated system monitors are in red (error) status.
Example: Predictive alert showing the CPU monitor in error before the business application
monitor has crossed the static threshold.
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Performance Impact of Predictive Analytics
l

It supports analyzing and tracking of up to 100 business monitors, with correlation of 700 system
monitors for each business monitor.

l

It has no impact on CPU or network resources.

l

It uses less than 5% on disk throughput consumption, and less than 100 MB memory consumption.

Tasks
How to Configure Predictive Analytics
Tip: You can view a guided and narrated demonstration on how to anticipate potential problems in
applications using SiteScope Analytics on YouTube - http://hpsw.co/Ln5i6C9.
This task describes the steps involved in configuring predictive analytics.
1. Prerequisites
n

Make sure you have the necessary permissions for viewing groups and monitors and
performing actions on them. To add or edit analytics and analytics alerts, you must have edit
monitor permissions for the selected source monitor. For details on user permissions, see
"Permissions" on page 744.

n

Configure a monitor to monitor your business application. For details on configuring a monitor,
see "How to Create and Deploy a Monitor" on page 262.

2. Select the monitor to be analyzed
a. In the monitor tree, right-click the monitor you want to analyze, and select Predictive
Analytics > New Predictive Analytics. The New Predictive Analytics dialog box opens.
b. In the General Settings panel, enter the name that describes the monitor being analyzed, or
use the default name (Analytics for monitor:<monitor name>). Enter a description for
the monitor being analyzed if required.
3. Select the target monitors
In the Analytics Targets panel, select the target monitors or groups (typically, system
infrastructure monitors). Metrics from the target monitors will be correlated with metrics from the
source monitor around the time that an issue is detected in the business application, in order to
identify similar trends which can help pinpoint the cause of the problem in the application.
4. Define analytics alerts
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In the Analytics Alerts panel, configure an alert that will be invoked each time metrics from the
source monitor cross the analytics threshold. This includes selecting the type of alert action and
the settings for the type of alert being sent.
Note: You must configure at least one alert for each monitor being analyzed.

a. In the Analytics Alerts panel, click New Alert

. The New Alert dialog box opens.

b. In the Alert Actions panel, click New Alert Action

, and select an alert action type.

We recommend using the Email alert action type because it uses a customized analytics
template that provides details to assist with root cause analysis for source monitors that cross
the threshold.
c. Enter the required settings in the Action Type Settings panel. For details, see "Action Type
Settings Panel" on page 1278.
If you selected the Email alert action, we recommend using the AnalyticsMail template
(selected by default). The analytics email alert includes the following details to assist with root
cause analysis for source monitors that cross the threshold:
o

A link to the correlated system monitors.

o

Correlation score (percentage).

o

A list of the system monitors that crossed their baseline.

d. In the Status Trigger panel, use the Analytics option for triggering predictive alerts (selected
by default). When this option is selected, an email alert is sent every time the baseline of the
business monitor is crossed. For details on the Analytics email alert, see "Understanding
Analytics Alerts" on page 1382.
Note: If you select one of the other statuses (Unavailable/Error/Warning/Good), an
alert is sent according to the static threshold and the alert action configuration in Trigger
Frequency settings.
e. In the Trigger Frequency panel, configure the trigger settings that determine when the alert is
triggered and when it is sent.
For details, see "Trigger Frequency Panel" on page 1294.
f. Click OK to save the alert action settings, and then click OK to save the new alert settings.
g. You can test the analytics alert by selecting the alert in the Alert Actions panel, and clicking
the Test
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Note: The monitor you select does not have to be reporting the same status category that
is selected to trigger the alert to test the alert. For example, the monitor does not have to
currently be reporting that the analytics threshold has been crossed to test an alert that is
triggered by analytics conditions.
5. Define analytics tags - Optional
SiteScope automatically generates an analytics tag value for each analytics configuration which
it assigns to the business monitor. This tag enables the analytics email alert to include a link to
Multi-View, filtered to include the relevant business monitor's tag.
You can also manually create a custom tag and assign it to different source monitors. This
enables you to display multiple source monitors grouped by this custom tag in Multi-View. For
details, see "How to Manually Assign Tags to Analytics Monitors" on page 1389.
6. Save the analytics settings
Click Save to save the settings and start the analytics mechanism.
When the calculation is finished, an initial alert is sent if Send alert when correlation
calculation has finished is selected in the Analytics Alerts panel. In the Correlation table, you
can see system monitor metrics that are correlated to the business monitor. You can see a
correlation value (%) for each system monitor. For details, see "Analytics Tab / New Predictive
Analytics Dialog Box" on page 1390.

How to Diagnose and Troubleshoot Problems
1. Analyze information in the analytics alert
When business application monitor metrics cross the static or analytics threshold, an alert is
triggered.
Analyze the information in the alert (according to which threshold was crossed).
n

For an alert triggered by business monitor metrics crossing the static threshold, the alert
displays all the metrics that are in the status for which the alert was triggered. For example, all
metrics whose status changed to error.

n

For an alert triggered by business monitor metrics crossing the analytics baseline, the alert
displays all business metrics that crossed the analytics baseline threshold. This includes the
metric name, metric value, and the metric's upper and lower baseline band.

n

Highest correlation scores. Contains up to 500 best-fitting correlation scores for each analyzed
(source) monitor metric. The correlation score represents a percentage value above which a
correlation result is considered correlated. The higher the score, the closer the correlation. This
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helps to identify the impact of system infrastructure monitors on the business application and
provides the details beneficial to assist with root cause analysis.
For a description of the information contained in the alert, see "Understanding Analytics Alerts" on
page 1382.
2. Diagnose the root cause of problems using Impact View
a. Open Impact View
Click the link in the analytics alert to open Impact View. This is a filtered view within MultiView that displays the business monitor and its correlated target system monitors.
b. Identify the metrics in error
Place the cursor over a monitor which you want to view or troubleshoot, and click the
information
icon to open the Monitor Details dialog box. Click the Metrics tab to view the
list of monitor metrics with error or warning status.
c. Rerun the monitor to check if the problem still exists
In the Group/Monitor Details dialog box, click Run Now to verify the problem still exists. This
action reruns the monitor or the monitors in group.
d. Generate a report to view performance and availability over time
In the Details tab, click Generate Report to generate a report for the group/monitor. You can
use this report to help determine the nature of the problem, and to see how long the group or
monitor has been in error.
e. Disable the monitor or alerts to prevent additional notifications being triggered
Depending on the diagnosis, you can disable the monitor or monitors in group, or disable alerts
associated with the monitor or group and continue to use the monitor.
To assist in troubleshooting, you can check the alert history for the monitor to determine
whether this is a reoccurring issue (all associated alerts are displayed in the alerts section).
Note: The triggered alerts table is only displayed for users that have permissions to view
alerts. For details on user permissions, see "Permissions" on page 744.
f. Add an acknowledgment to track resolution of the problem
After reviewing the alerts, you can click the Add Acknowledgment
button and add a
comment acknowledging the monitor status. The acknowledgment comment is displayed
(after refreshing the view) as a tooltip associated with the acknowledgment icon in the
SiteScope Dashboard view, and is recorded in the Acknowledge Log.

HP SiteScope (11.31)

Page 1388 of 1395

Using SiteScope
Chapter 108: Configure Predictive Analytics

Note: Acknowledgments can only be deleted from the Acknowledge Log (available from
the Acknowledge Monitors In Group dialog box in the SiteScope Dashboard). Deleted
acknowledgments are not displayed in the Acknowledgments list in Multi-View.
g. Drill down to group or monitor properties
To investigate the issue further, click Drill Down to Group/Monitor Properties to open the
group or monitor in Manage view in the Unified Console. For details, see "Manage View" on
page 1116.

How to Fine Tune Analytics Settings
You can modify the default analytics baseline and correlation calculation settings in Preferences >
Infrastructure Preferences > Analytics Settings. For details, see "Analytics Settings" on page 644.
Tip: For optimal SiteScope performance, we recommend that you use the default settings. If you
are unsure of the settings to use, contact SiteScope customer support.

How to Manually Assign Tags to Analytics Monitors
Note: SiteScope automatically generates an analytics tag value for each analytics configuration
which it assigns to the business monitor. For details, see "Automatic Tagging" on page 1382.
You can manually create custom tags for business and system monitors. Tags are used to enable
viewing the business monitor and its correlated target system monitors in a single view in SiteScope
Multi-View, and for filtering the monitor tree by tag filter. For details, see "Multi-View" on page 1089 and
"Filter Objects in the SiteScope View" on page 74.
For example, you could define a tag called Analytics with the possible values of Business
monitors, System monitors, and Application monitors, and then assign them as required in order
to display monitors grouped by this custom tag in Multi-View. For details, see "How to Assign Custom
Search/Filter Tags and View Monitors in the Tags View" on page 1097.
In addition, you can create a new tag in the Analytics tab and this tag will automatically be assigned to
the correlated monitors once correlation is triggered.

How to Remove Predictive Analytics from a Source Monitor
To delete predictive analytics for a monitor, right-click the monitor in the monitor tree, and select
Predictive Analytics > Delete Predictive Analytics.
When deleting predictive analytics from a source monitor, all related objects are delete. This includes
correlation and baseline objects, analytics alerts associated with the monitor, and analytics tags on the
source and target monitors.
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UI Descriptions
Analytics Tab / New Predictive Analytics Dialog Box
The New Predictive Analytics dialog box enables you to add, edit, or delete analytics for a monitor.
The Analytics tab enables you to add or edit analytics definitions, and displays analytics settings that
have been configured for the monitor instance. It also displays correlation results which identify similar
trends between the source and target monitor metrics that can assist with root cause analysis.
User interface elements are described below:
UI Element

Description

Correlation Results
(Not available in the New Predictive Analytics dialog box)
Opens the New Predictive Analytics dialog box, enabling you to configure
analytics for the selected monitor. (All settings in the New Predictive
Analytics dialog box are described in this table.)
Note:
l

l

This Monitor's Metric
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This button is not displayed if analytics has been configured for the
monitor.
This button is grayed out if analytics has been disabled, or if the
monitor is of a type excluded for analytics (configurable in Excluded
monitor types in "Analytics Settings" on page 644).

Lists metrics from the business monitor. Select the metric for which you
want to see correlation results in the Correlation table.
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UI Element

Description

Correlation Results
(Not available in the New Predictive Analytics dialog box)
Correlation table

Displays correlation results above the configured threshold if a correlation
was found for the selected metric. This information helps to identify the
impact of system infrastructure monitors on the business application and
provides the details beneficial to assist with root cause analysis.
The correlation calculation is first performed after analytics are configured.
Thereafter, it is calculated each time the business monitor crosses the
baseline, and when there is a change to the analytics target. If the
selected business monitor metric has not crossed the baseline threshold,
no correlation results are displayed.
If the selected business monitor metric has crossed the baseline
threshold, the correlation calculation results for that business metric are
displayed. Only target metrics that have a correlation score above the
Correlation score threshold (%) (configured in "Analytics Settings" on
page 644) are displayed here. Metrics with a score lower than this value
are not considered correlated, and are excluded from the results.
l

l

Target Monitor. Displays a list of metrics from the target system
monitors that are correlated to the selected business monitor metric
that have a correlation score above the correlation threshold score.
Correlation Score. The result is displayed as a correlation
percentage value for the highest metric score in granularity from the
target monitor; it does not display a metric for each target metric as it
does in the alert.

The panel displays the last time that the correlation results were
calculated.
Note: This table is only displayed when analytics is configured. Results
are displayed after the required number of hours of historical data has
been collected (configurable in Correlation calculation data retention
period (hours) in "Analytics Settings" on page 644).
General Settings
Analytics name

Name that describes the monitor being analyzed. Use a useful naming
convention for all monitors to make creating view filters more effective.
Default value: SiteScope creates a default name in the format:
Analytics for monitor:<monitor name>.
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UI Element

Description

Correlation Results
(Not available in the New Predictive Analytics dialog box)
Analytics description

Description of the monitor being analytics (if required). This description
does not appear in any other context. It appears only when editing the
analytics properties.

Analytics Targets
Select Monitors

Click to open the Select Monitors Form, and select the target system
monitors or monitor groups to be analyzed. Metrics from the target
monitors will be correlated with metrics from the business application
monitor around the time that an issue is detected in the business
application, in order to identify similar trends, and to help pinpoint the
cause of the problem in the application.
The Targets list includes all groups and monitors (except Health monitors
and the monitor instance selected for analytics) configured for the
SiteScope.
After making a selection, the target monitors and groups are displayed
with a in the Analysis Targets list.
Use the following in the Select Monitors Form to find and select the
system monitors to be analyzed:
Collapse All. Collapses all branches in the tree.
Expand All. Expands all branches in the tree.
Select All. Selects all listed monitors
Clear Selection. Clears the selection.
Quick Search. Enables you to search for monitors by name or
that contain a specific value that you enter in this field. For details, see
"Quick Search" on page 73.

Selected monitors

Displays tree of all target monitors that have been selected for analysis.
The total number of selected targets is displayed beneath the tree
(maximum 700 counters).
Default value: None selected.

Analytics Alerts
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UI Element

Description

Correlation Results
(Not available in the New Predictive Analytics dialog box)
Send alert when
correlation
calculation has
finished

Sends an email alert to notify you that the first correlation calculation has
finished.

<Alerts associated
with monitor>

Lists all the analytics alerts associated with this monitor.

Default value: Not selected

New Alert Action. Opens the Action Type dialog box enabling you to
define an action to be done when an alert is triggered. For user interface
details, see "Action Type Dialog Box" on page 1276.
Edit Alert Action. Opens the Action Type dialog box enabling you to edit
the alert action. For user interface details, see "Action Type Dialog Box"
on page 1276.
Delete Alert Action. Deletes the alert action. It does not disable the
associated monitors.
Enable. Enables the alert associated with the monitor.
Disable. Disables the alert associated with the monitor.
Test. Tests the alert definition on a selected server.
Select All. Selects all listed alerts.
Clear Selection. Clears the selection.
Name

The name by which the alert is known in SiteScope.

Status

The enabled/disabled status of the alert.

Description

A description of the alert.

Action Name

The name given to the alert action in the "Action Type Dialog Box" on
page 1276.

Analytics Tags
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UI Element

Description

Correlation Results
(Not available in the New Predictive Analytics dialog box)
Analytics Auto Tags

Tagging enables monitors grouped by the same tag to be displayed in a
single Impact View in SiteScope's Multi-View.
SiteScope automatically generates an analytics tag value for each
analytics configuration and assigns to the source monitor. If the source
monitor encounters a problem and an analytics alert is triggered,
SiteScope takes this tag and assigns it to the target monitors. The tag
value is in the format analytics_<monitor_name>, followed by a number
in parenthesis if there is more than one monitor with the same name.
In addition to using the a Analytics Auto Tag, you can create and assign
additional tag values to a source monitor, so that you can display only the
monitors to which these tags or tag values have been assigned. For
details on creating custom tags, see "How to Assign Custom
Search/Filter Tags and View Monitors in the Tags View" on page 1097.

Add Tag

Opens the New Tag dialog box, enabling you to add new keyword tags.
The tag that is manually created in the Analytics tab is dynamically
assigned to business and system (correlated) monitors every time
correlation is calculated.
For user interface details, see "Search/Filter Tags" on page 718.

Tips/Troubleshooting
Notes and Limitations
l

l

Settings in the Analytics tab are grayed out if analytics have not been configured for the monitor
instance.
Settings in the Analytics tab are unavailable if:
n

The Analytics enabled setting has been disabled in Infrastructure Preferences > Analytics
Settings. (Analytics are enabled by default.)

n

The selected monitor is listed as an excluded monitor type in Infrastructure Preferences >
Analytics Settings > Excluded monitor types list.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Using SiteScope (SiteScope 11.31)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to SW-doc@hpe.com.
We appreciate your feedback!
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